# Table of Contents

## Customer Service Management

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Service Management</td>
<td>1</td>
</tr>
<tr>
<td>Exploring Customer Service Management</td>
<td>6</td>
</tr>
<tr>
<td>Configuring Customer Service Management</td>
<td>7</td>
</tr>
<tr>
<td>Integrating Customer Service Management with other applications</td>
<td>323</td>
</tr>
<tr>
<td>Using Customer Service Management</td>
<td>797</td>
</tr>
<tr>
<td>Analytics and reporting for Customer Service Management</td>
<td>915</td>
</tr>
<tr>
<td>Customer Service Management reference</td>
<td>1103</td>
</tr>
<tr>
<td>Vaccine Administration Management</td>
<td>1232</td>
</tr>
<tr>
<td>Install Vaccine Administration Management</td>
<td>1235</td>
</tr>
<tr>
<td>Components installed with Vaccine Administration Management</td>
<td>1239</td>
</tr>
<tr>
<td>Configuring Vaccine Administration Management</td>
<td>1243</td>
</tr>
<tr>
<td>Using Vaccine Administration Management</td>
<td>1284</td>
</tr>
<tr>
<td>Domain separation and Vaccine Administration Management</td>
<td>1302</td>
</tr>
<tr>
<td>Workforce Optimization for Customer Service</td>
<td>1302</td>
</tr>
<tr>
<td>Exploring Workforce Optimization for Customer Service</td>
<td>1303</td>
</tr>
<tr>
<td>Configuring Workforce Optimization for Customer Service</td>
<td>1327</td>
</tr>
<tr>
<td>Using Workforce Optimization for Customer Service</td>
<td>1387</td>
</tr>
<tr>
<td>Communities</td>
<td>1435</td>
</tr>
<tr>
<td>Activate Communities plugins</td>
<td>1437</td>
</tr>
<tr>
<td>Properties installed with Communities</td>
<td>1438</td>
</tr>
<tr>
<td>Communities roles</td>
<td>1450</td>
</tr>
<tr>
<td>Community setup guide for admins</td>
<td>1452</td>
</tr>
<tr>
<td>Domain separation and Communities</td>
<td>1454</td>
</tr>
<tr>
<td>Quick start tests for Communities</td>
<td>1454</td>
</tr>
<tr>
<td>Configure a community</td>
<td>1456</td>
</tr>
<tr>
<td>Moderate a community</td>
<td>1507</td>
</tr>
<tr>
<td>Use a community</td>
<td>1518</td>
</tr>
<tr>
<td>Gamification</td>
<td>1570</td>
</tr>
</tbody>
</table>
Customer Service Management

Resolve complex issues end-to-end. Proactively fix problems and drive action to solve common requests more quickly and efficiently.

Drive customer loyalty with connected digital workflows

In today’s service-based economy, keeping customers loyal is paramount to growing and sustaining your business. ServiceNow helps you drive customer loyalty with connected digital workflows which join customer service with other departments using AI and workflow to assign, manage, and resolve complex issues end-to-end.

Monitor trends as well as products and services to notify your customers when they are affected by issues. In addition, proactively fix issues before customers know they have them. Deliver a personalized customer experience while increasing agent efficiency, driving action to instantly take care of common customer requests using resources like the portal, service catalog, virtual agent, and online communities.

View and download the full infocard for a highlight of Customer Service Management features.

<table>
<thead>
<tr>
<th>Make it easy for customers to engage</th>
<th>Assign tasks across the enterprise</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provide effortless customer service across any channel at any time.</td>
<td>Connect customer service with engineering, field service, finance, and other teams.</td>
</tr>
</tbody>
</table>
Monitor for issues and create cases automatically

Proactively monitor customers’ products and services and take action on potential issues and outages.

Prevent future calls

Fix underlying issues to eliminate calls, drive knowledge-base content changes, preemptively notify customers when there are issues, and act on trends revealed in ServiceNow Performance Analytics.

Reduce case volume with self-service

Encourage customers to help themselves with a self-service catalog, communities, knowledge base, and portal.

Make it easy for customers to engage

Give your customers the choice of connecting through email, phone, chat, social media, or mobile - anytime, anywhere, and from any device. Omni-channel advanced work assignment automatically assigns customer cases to the most appropriate agent based on capacity, skills, and case context.
Assign tasks across the enterprise

Connect customer service to other departments with the visual task board, workflow, and automation to resolve cases quickly. Identify issues in customer service and assign them directly to field service, engineering, operations, finance, legal, and other departments and track those issues to resolution. Additionally, you’ll gain visibility to more efficiently manage assets, projects, and costs, when Customer Service Management is deployed with Asset Management and Project Portfolio Management.

Monitor for issues and create cases automatically
Proactively identify and alert your customers to possible issues. Send preemptive alerts only to potentially affected customers, notifying them of a solution when available and preventing their need to contact customer service. With access to real-time operational health of customers’ products and services, agents receive alerts of potential issues before customers are even aware.

**Prevent future calls**

Monitor current and prior performance to identify areas for improvement of products, services, and processes using Performance Analytics for Customer Service Management. Predict trends to drive actionable improvements, such as automating the most frequently recurring problem resolutions.

**Reduce case volume with self-service**
Empower your customers with fast, personalized self-service. Customer Service Management provides your customers with a number of self-service options, including the Customer Service Portal for a customizable online service experience, conversational answers from a chatbot, knowledge base articles, and an online community of peers and experts.

Get started

- Work with an implementation specialist to streamline your setup process. To learn more, see the Customer Success Center.
- Sign up for the ServiceNow Customer Service Management fundamentals training program and certification to learn about core functionality and release-specific features.
- For information on how to request Customer Service Management and to begin setup, see Activate Customer Service Management.

Applications and features

Key capabilities

- Customer Service Management
- Workforce Optimization for Customer Service
- Customer data management
- Case management
- Major issue management
- Omni-channel
- Outsourced Customer Service
- Communities
- Proactive Customer Service Operations
- Machine learning solutions for Customer Service Management
- Workspaces in Customer Service Management
- Mobile experience for Customer Service Management
- Virtual Agent
- Walk-up Experience for Customer Service Management

Integrations

- Field Service Management
- Service Management applications
• Financial Management
• Continual Improvement Management with CSM
• Customer Project Management
• IT Operations Management
• Knowledge Management

Other applications and tools
• Visual task assignment
• Visual workflow and automation
• Surveys

Customer Service Management
The ServiceNow® Customer Service Management application enables you to provide service and support for your external customers through communication channels such as web, email, chat, telephone, and social media. Create cases as needed and route cases to available customer service agents with the necessary skill sets.

Customer Service Management overview
Video providing an overview of Customer Service Management

<table>
<thead>
<tr>
<th>Explore</th>
<th>Configure</th>
<th>Integrate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Learn about how customers, agents, and managers use CSM.</td>
<td>Plan and configure your implementation.</td>
<td>Extend CSM capabilities by integrating with other applications.</td>
</tr>
</tbody>
</table>
### Use

- Work on customer cases, and manage case loads and assignments.

### Analytics and Reporting Solutions

- Coordinate work and improve processes with dashboards and reports.

### Reference

- Get details about components like fields, tables, and properties.

## Additional resources

- Customer Service Management API on the ServiceNow® Developer Site
- Customer Service Management forum on the Now Community

## Exploring Customer Service Management

Whether you’re starting or expanding your implementation of Customer Service Management, learn more about available features to help create a seamless experience for your customers, agents, and managers to resolve issues and fulfill requests.

### Customer self-service and omni-channel support

Empower customers to help themselves or easily get help from your teams by configuring multiple entry points for assistance.

- Chat with support
- Email support
• Call support
• Self-help on the Service Portal
• Virtual Agent assistance on the Service Portal
• Walk-up Experience for Customer Service Management

To learn more about these features for providing customer support, see these topics:

• Omnichannels for communicating with customers
• Customer and consumer self-service portals
• Walk-up Experience for Customer Service Management

Proactive Customer Service Operations

With the ServiceNow® Proactive Customer Service Operations feature, proactively create cases for impacted services. You can activate Proactive Customer Service Operations by itself or as an integration with the ServiceNow® Event Management application.

When a Network Operations Center (NOC) operator detects an impacted service, they can review details and then create a case for customer service to review and start working with affected customers.

For more information, see Proactive Customer Service Operations.
Workspace and automated processes for case resolution

Help agents resolve issues and fulfill requests more quickly by automating processes and providing a single workspace with all the resources needed to communicate with customers and work on cases.

Agent Workspace

With the ServiceNow® Agent Workspace platform, configure a single interface for agents to complete all their tasks. The Agent Workspace platform takes the agent functionality available on the Now Platform® and puts these features in a multi-tab interface. The optimized layout helps agents efficiently manage multiple cases, accounts, customers, and consumers.

Intelligent routing

Use Advanced Work Assignment with Agent Workspace to automatically assign work items to agents based on their availability, capacity, and skills.

Integrated communication channels

From the workspace, agents can call or chat with customers in real time to get information and provide updates.

Case management

Create and route cases, manage customer information and interactions, monitor case activity (including case status and SLAs), and work to resolve customer issues. Use response templates and search tools to search the knowledge base and community.
and provide timely, informative responses to customers.

**Predictive Intelligence**

With the ServiceNow® Predictive Intelligence application, use predictive intelligence solution definitions to assist agents with a variety of tasks. Create solutions to help agents create, assign, and resolve cases more efficiently. Use machine learning to predict fields during case creation, such as the category, priority, and assignment group.

**Customer data management**

Provide your agents with a view of customer accounts and contacts, consumers, entitlements, contracts, products, assets, and install bases.

**Customer Central**

With Customer Central, agents can view information about a customer in one central place. It enables them to quickly zoom in on issues and provide efficient and supportive service to customers.

**Major issue management**

If a current case impacts multiple customers on a wide scale, escalate it to a major case. A child case is then created for each affected customer for tracking and providing updates. With major case management, proactively identify impacted customers, provide information to these customers, and manage the resolution process.
These are just a few of the many features that you can provide agents. For details on these features and more, see these topics:

- Case management
- Customer data management
- Workspaces in Customer Service Management
- Intelligent routing
- Customer Central
- Machine learning solutions for Customer Service Management
- Additional Customer Service Management features

Dashboards and reports to monitor and improve business processes

Analytics and Reporting Solutions contain prepackaged dashboards and reports to provide your team with data for managing their work and improving their performance.

Reports for key insights

Numerous reports are available to provide you with data on cases, affected customers, customer satisfaction, and open backlogs.

Dashboards for different roles

Separate dashboards are available for the agents, managers, and executives on your team so they only see the data that is relevant to them.

For details on all available dashboards and reports, see Analytics and reporting for Customer Service Management.
Mobile experience for Customer Service Management

With the Customer Service Management mobile application, agents and managers can perform routine tasks from anywhere. They can stay connected and access information in real time to complete tasks quickly.

For more information, see Mobile experience for Customer Service Management.

Omnichannels for communicating with customers

Meet customers where they feel most comfortable by providing omni-channel support. Give them the option to email, call, or chat with you.

Provides an overview of omni-channel support capabilities within the Now Platform.

Note: Customers can also use various consumer messaging apps such as the WhatsApp app and the LINE app to message you. To learn more, see Integrate with consumer messaging apps.
Chat channel

From the Customer Service Portal and Consumer Service Portal, customers can start a chat with a virtual or live agent for help.

Chatting with an agent

The chat communication channel uses the ServiceNow® Connect Support feature to provide chat capability. You can also enable the ServiceNow® Virtual Agent application to create or use predefined chatbot topics (conversations) for your users.

The chat request from the customer is either routed to a virtual agent or to an available agent with the required skill set. The agent can respond to the customer and, if necessary, create a new case or link the discussion to an existing case.

An agent can also initiate a Zoom meeting from a chat to resolve issues faster. For more information, see Chat Zoom Connector.

If a case is created as the result of a chat, the customer can later find and view the case from the portal for updates. The customer service agent can also link a chat discussion to an existing case. Details from the chat discussion are copied to the case form.

For more information, see Connect Support and Configuring the chat channel.

When a support agent of the assignment group associated with the chat queue ends a chat with a user, a survey is available in the chat window for the users. Users can take the survey to give feedback about the interaction with an agent. The survey is not captured in the transcript in the agent’s interactions page.
Email channel

With an email channel, customers can send emails to create new cases and update current cases. They can also receive email updates from customer service agents as cases progress.

Creating, viewing, and updating cases

Customers can create a new case by sending an email to a designated address. They can also create a new case for a specific product by sending an email to a designated address and including the product name in the subject line. Or, if a channel configuration has been created, customers can send an email to a designated address regardless of the information included in the subject line.

After submitting a case, the customer receives a confirmation email with the assigned case number and a link to the Case form. When an agent updates a case, the customer receives an email with the details.

Customers can update an existing case in the following ways:

- By replying directly to an email from a customer service agent.
- By creating an email and including the Case: prefix followed by the case number in the subject line. For example, Case:CS0000011.

Note: Note: If the case number in the subject line is incorrect, a new case is created.
Accepting and rejecting solutions

When an agent proposes a solution to a case, the customer receives an email with instructions for accepting or rejecting the solution. The customer can reply and include **Accept** or **Reject** in the first line of the email, or the customer can click the **Accept** or **Reject** link in the email.

When an agent closes a case, two emails are sent to the customer: the first states that the case has been closed and the second provides a link to a customer satisfaction survey.

*i* **Note:** If a customer accepts a solution or closes a case from the Customer Service Portal, they are automatically routed to the survey. They do not receive the survey email.

To get started with the email channel, see Configuring the email channel.

### Phone channel

External customers can reach out to customer service agents by phone. The Customer Service Management application uses both Computer Telephony Integration (CTI) and OpenFrame to provide phone support for customers.

**Computer Telephony Integration (CTI)**

CTI provides a way to integrate the Now Platform with telephony providers to support inbound and outbound calls. With this integration, customer service agents can place and accept calls from customers, quickly identify customers and account information, and capture case-related information.
Note: The CTI integration with the Twilio Voice product requires activation of the Notify plugin.

OpenFrame

OpenFrame is a tool that enables CTI capability with telephony service providers. OpenFrame provides a communication frame that agents use to place and receive customer calls.

To get started with the phone channel, see Configuring the phone channel.

Self-service for Customer Service Management

Provide service for your customers through self-service portals that are integrated with knowledge articles, community forums, service catalogs, and chatbots.

Customer and consumer self-service portals

With the ServiceNow® Service Portal application, create portals that empower customers to resolve issues and submit cases and requests for themselves. To help direct customers to the right portal resources, you can also activate the ServiceNow® Virtual Agent application for CSM.

Portal types

There are two types of portals that you can configure to support your customers and consumers.

• Customer Service Portal to support your business-to-business (B2B) customers
• Consumer Service Portal to support your business-to-consumer (B2C) customers

Both portals offer the same self-service and Virtual Agent assistance features.
Self-service on portals

You can configure your Customer Service Portal or Consumer Service Portal with the following self-service features.

Service catalog

With the ServiceNow® Service Catalog application, you can create service catalogs where customers can request items such as service and product offerings. Enable customers to request items from the portal by associating one or more service catalogs with the portal. Customers can also track the status of open requests from the portal.

Knowledge base

With the ServiceNow® Knowledge Management application, you can create knowledge bases with articles to share information with customers on the portal. Customers can search the knowledge bases for information such as troubleshooting or task resolution to resolve issues and answer questions.

Community

With the ServiceNow® Communities application, create forums for agents and customers to connect, engage, and collaborate with each other. On the portal, customers can search for community content that could provide the solutions and answers they need.

Chat
With the ServiceNow® Virtual Agent platform, design and build automated conversations that help your customers get the help they need.

As customers answer questions and select options presented by Virtual Agent, they are directed to a self-service resource.

If customers want to chat with an agent, Virtual Agent hands them off to a live agent. To provide this resource, use the ServiceNow® Connect Support feature.

To get started with the portals, see Configure the Customer and Consumer Service Portals.

Walk-up Experience for Customer Service Management

The ServiceNow® Walk-up Experience for Customer Service Management application enables you to set up a contact channel to support both online check-in and onsite check-in to a pre-established walk-up service center.

Walk-up Experience aims to support users and significantly improve their satisfaction through a fast in-person support. Employees and business guests can get real-time, in-person help with their issues.

User personas and roles are defined as follows:

**Requesters**

Users access the Walk-up Experience application in several ways.

- Online:
  - Quickly check in online to the nearest available walk-up venue using the **Walk-up Check In** option on the Service Portal using your computer.

  **Note:** Walk-up Experience application automatically routes you to the nearest walk-up queue using the IP address of your computer. You can change the location, if desired.

  - Join the queue and view your queue position.
Schedule appointments for support and receive appointment reminders, as well as cancel or reschedule appointments from links in the reminder or from the online check-in interface.

Schedule only one appointment per walk-up location queue at a time.

**Note:** Even with a scheduled appointment, you can still check into a walk-up location queue online or in person onsite.

Receive email notifications when your request is assigned to a technician when your position in the queue is close to being served and when your walk-up request has been closed or abandoned, should you decide not to attend the queue.

- Onsite at the Walk-up Experience location:
  - Check into a queue at the physical walk-up location by manually entering your name, email, and contact details.
  - Observe queue activities on a large monitor that displays both walk-in requesters and those with appointments.
  - View the monitor displaying how many people are currently in the queue, guest positions in the queue, who is being served, and estimated wait times.
  - Answer an available single-question survey which captures your user sentiment after a visit.

**Technicians or Agents**

Customer support uses Walk-up Experience application to meet the demand of urgent issues or requests from the requesters.

- Walk-up Experience technicians manage daily operations at the walk-up queue locations. They resolve customer service issues.
- Technicians can accept and close Walk-up Experience interactions through the Agent Workspace interface. Agent Workspace contains a personal inbox where walk-up interactions, if configured in Advanced Work Assignment, are automatically pushed for assignment.
- Agents can manage all aspects of Walk-up Experience fulfillment using Agent Workspace. Based on their capacity, and if records are on-hold, they can work on multiple transactions at the same time and promote interactions to cases.
• Technicians can view and accept scheduled appointments in their Agent Workspace personal inbox. Appointments are routed to the inbox according to agent availability. Alternatively, agents can pick and choose appointments manually.

• If necessary, technicians can work with anyone in the queue at any time. Technicians can manually assign themselves to a walk-up interaction, by accepting the interaction from a list of unassigned interactions in Agent Workspace.

Managers

Managers supervise the walk-up location technicians and oversee daily operations.

• Walk-up managers can observe and capture operational and performance data by monitoring the walk-up dashboard.

• Walk-up managers can use the application to increase customer satisfaction, provide customer service in a timely manner, and report performance data to upper management.

Administrators

Configure and maintain walk-up related systems, such as the walk-up location branding and text, queue locations and schedules, appointments, advanced work assignments, and notifications, and CSAT surveys.

Walk-up Experience User Roles

<table>
<thead>
<tr>
<th>Role Name</th>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_walkup.walkup_login</td>
<td>Store representative</td>
<td>A user with this role helps requesters check in at the walk-up location.</td>
</tr>
<tr>
<td>sn_csm_walkup.walkup_technician</td>
<td>CSM walk-up technician</td>
<td>A user with this role fulfills user demands at the CSM walk-up location.</td>
</tr>
<tr>
<td>sn_csm_walkup.walkup_manager</td>
<td>CSM walk-up manager</td>
<td>A user with this role manages the team at the walk-up location.</td>
</tr>
<tr>
<td>sn_csm_walkup.walkup_administrator</td>
<td>CSM walk-up administrator</td>
<td>A user with this role administers walk-up</td>
</tr>
</tbody>
</table>
Walk-up Experience User Roles (continued)

<table>
<thead>
<tr>
<th>Role Name</th>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>interactions, location queues, and walk-up reasons.</td>
</tr>
</tbody>
</table>

Configuring Walk-up Experience for Customer Service Management

To get started with Walk-up Experience for Customer Service Management, see Configure Walk-up Experience for Customer Service Management.

Walk-up Experience for guest users

The Walk-up Experience application can enable guest users to manage walk-up appointments online from the Consumer Service Portal or Customer Service Portal home page.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Requirements to use Walk-up Experience for guest users

Note the following requirements for guest users to be able to use Walk-up Experience:

• The Guest Walk-up Experience for Customer Service store app must be installed. For more information on installing the store application, see Install a ServiceNow Store application.

• The com.snc.walkup_for_csm plugin must be activated. For more information on activating a plugin, see Activate a plugin.

• The Walk-up Check-in widget must be configured. For more information, see Add a Walk-up Experience online check-in link on the Service Portal home page.

Data management for Customer Service Management

Organize and manage data for both internal users and external customers. Provide managers and agents with a view of customer data, including account and contact information, products, assets, contracts, and entitlements.
Customer service business models

Customer Service Management provides different business models that you can use to support your business needs. Select a business model based on the type of services and support that you provide to your customers.

**Business-to-business (B2B) model**

In the business-to-business (B2B) model, an account is a supported external customer and a contact is an employee of that account. With the B2B model, you can support accounts and contacts and also set up:

- Customer relationships
- Account teams

**Business-to-consumer (B2C) model**

With the business-to-consumer (B2C) model, you can support individual consumers.

**Industry data models**

The industry data models framework expands the business-to-business (B2B) and business-to-consumer (B2C) models and provides the flexibility and security needed to support:

- Business organizations with internal and external locations
- Households and consumers
- The relationships that exist between these entities

**Contributor users**

The contributor user model provides unified customer support for internal and external customers. With this model, you can engage middle office teams resolve customer issues and requests.

- Enable employees to request support for themselves and external customers.
- Enable service organizations to serve one another and external customers.
- Assign tasks to middle office agents who work on specific tasks that are required to resolve a case.
Customer Data Models for B2B2C

The Customer Data Models for B2B2C supports complex business models with multi-level customer relationships. This model can be used to support employees of a business customer or end consumers of a business customer.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Overview

Organizations have complex business models with multi-level relationships. These complex structures often exist between an organization and the end consumers. In the B2B model, while organizations do business directly with other organizations (business customers), the users of the service provided can be different. A user can be a direct customer (B2C), or a business customers’ customer (B2B2C), or a business customer’s employee (B2B2E).

With the business-to-business-to-consumer (B2B2C) model, you can support business customers and third-party channel partners who, in turn, support the end consumers. This model can be used to support:

- Employees of a business customer.
- End consumers of a business customer.
Benefits

- Enable service providers to manage all interactions and cases when the end consumer needs customer service.
- Enable service provider to have a complete view of the end consumers where they hold the relationship as direct customers (B2C) or through a business customer (B2B2C).

To get started with this application, see Configure Customer Data Models for B2B2C.

To use this application, see Using Customer Data Models for B2B2C.

Industry data models overview

Industry data models provide a framework that customers can use to create structured and flexible data models that represent their business needs.
The industry data models framework expands the Customer Service Management data model, including the install base model. It provides the flexibility and security needed to support business organizations with internal and external locations, households and consumers, and the relationships that exist between these entities.

Use the industry data models framework to model the service organization structure that is involved in supporting your end customers. With this framework, you can:

- Create a service organization structure that includes internal business locations.
- Assign customer service agents to internal business locations and provide access to the cases and customer information in their business location hierarchy.
- Establish relationships between agents and specific customers that enable agents to manage cases and information for those customers.
- Create households and add consumers as members of those households.
- Establish relationships between consumers, including consumers who are members of the same household.

Entities included with industry data models

The industry data models feature includes the following entities.

<table>
<thead>
<tr>
<th>Entity</th>
<th>Definition</th>
<th>Examples</th>
</tr>
</thead>
</table>
| Service organizations   | The internal and external entities that are involved in providing a service to customers. A service organization provides the base framework that supports the customer service value chain. This includes internal and external service organizations. You can extend the service organization to create new entities as needed. | • Financial service organizations with multiple branches  
   • Automobile manufacturers with multiple dealerships  
   • Government agencies with multiple office locations |
<table>
<thead>
<tr>
<th>Entity</th>
<th>Definition</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal service organizations</td>
<td>The internal entities that belong to a service organization and are involved in providing goods and services. The internal structure models how company is organized to support customers.</td>
<td>• Stores</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Branches</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Centers</td>
</tr>
<tr>
<td>External service organizations</td>
<td>The external entities that belong to a business organization and are involved in providing goods and services.</td>
<td>• Franchises</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Contractors</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Outsourced providers</td>
</tr>
<tr>
<td>Customers (B2B)</td>
<td>The external customers in the business-to-business model who use goods and services.</td>
<td>• Accounts</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Contacts</td>
</tr>
<tr>
<td>Customers (B2C)</td>
<td>The external customers in the business-to-consumer model who use goods and services.</td>
<td>• Consumers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Households</td>
</tr>
<tr>
<td>Employees and staff members</td>
<td>The people who work at internal and external service organizations and assist customers.</td>
<td>• Internal employees</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• External agents</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• External staff</td>
</tr>
<tr>
<td>Roles</td>
<td>Job functions that are performed by various users in the service organization.</td>
<td>• Location managers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Location agents</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Location consumer agents</td>
</tr>
<tr>
<td>Responsibility definitions</td>
<td>Definitions of the responsibilities that an agent can perform for a customer or that a consumer can perform for another consumer. Use these responsibilities</td>
<td>• Account managers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Relationship managers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Authorized representatives</td>
</tr>
<tr>
<td>Entity</td>
<td>Definition</td>
<td>Examples</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>to create relationships between agents and customers or between consumers.</td>
<td>• Relationships between an employee or staff member and a customer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Relationships between two consumers</td>
</tr>
<tr>
<td>Relationships</td>
<td>Relationships that are created between agents and customers or between two consumers, are based on specific responsibilities. Use these relationships to provide additional access to data.</td>
<td></td>
</tr>
</tbody>
</table>

**Plugins for industry data models**

Users with the system administrator role can activate the following plugins to enable industry data model features.

**Business Location**

Activate the Business Location plugin (com.snc.business_location) to enable support for businesses that interact with customers through physical channels such as stores and branches. This plugin automatically activates the following plugins:

- Service Organization (com.snc.service_organization)
- Customer Service Base Extension Entities (com.snc.cs_base_extension)

**Customer Service Household**

Activate the Customer Service Household plugin (com.snc.household) to manage customer service for households. This plugin enables you to create households, define the members of a household, and identify relationships between household members.

This plugin automatically activates the Customer Service Base Extension Entities plugin (com.snc.cs_base_extension).

**Customer Service Base Extension Entities**

Activate the Customer Service Base Extension Entities plugin (com.snc.cs_base_extension) to provide granular access control through relationships and roles. With this plugin, you can use
the Authorized Relationship responsibility definition to create relationships between consumers.

**Related information**

Configure Industry Data Model

**Industry data model responsibilities**

A responsibility, or responsibility definition, describes a role or a function that supports a customer. Use responsibility definitions to create relationships between an agent and a customer or between two consumers.

When you create a relationship, you select the users involved in the relationship and the responsibility that one user performs on behalf of another. The responsibility that is assigned to a relationship provides access to customer cases and information.

Industry data models includes responsibility definitions that you can use to create relationships:

- Between agents and accounts, households, or consumers.
- Between two consumers.

The following responsibilities are provided with the industry data model plugins.

ℹ️ **Note:** Responsibilities are stored in the Responsibility Definition [sn_customerservice_responsibility_def] table.

<table>
<thead>
<tr>
<th>Responsibility</th>
<th>Used in relationship</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Manager</td>
<td>• Account Team Member</td>
<td>Use the Account Manager responsibility to create a relationship between an agent and an account. With this relationship, the agent can:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Create and manage cases for their accounts.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View account information, including the related entities for an account.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Create and manage contacts and additional addresses for their accounts.</td>
</tr>
<tr>
<td>Responsibility</td>
<td>Used in relationship</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>--------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Relationship Manager</td>
<td>• Consumer Team Member</td>
<td>Use the Relationship Manager responsibility to create a relationship between:</td>
</tr>
<tr>
<td></td>
<td>• Household Team Member</td>
<td>• An agent and a consumer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• An agent and a household.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>With this relationship, the agent can do the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• For a consumer:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ Create and manage cases for the consumer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ View household information, including the related entities for that consumer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• For a household:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ Create and manage cases for the household.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ View household information, including the related entities for that household.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ Create and manage household members.</td>
</tr>
<tr>
<td>Authorized Representative</td>
<td>• Consumer to Consumer Relationship</td>
<td>Use the Authorized Representative responsibility to create a relationship between two consumers, regardless of household, or between two consumers within the same household.</td>
</tr>
<tr>
<td></td>
<td>• Household Member Relationship</td>
<td>With this relationship, a consumer can:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Create and manage cases for another consumer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View the information of another consumer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View the install base information of another consumer and create cases for:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ Sold products</td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ Install base items</td>
</tr>
</tbody>
</table>

**Customizing responsibility definitions**

You can use the responsibility definitions provided with industry data models plugins. You can also modify these definitions or create your own definitions to meet your business requirements.
Note: If you modify the existing definitions or create new definitions, you may also need to update ACLs to reflect the changes.

If you have an existing account manager responsibility definition, you may need to evaluate the functionality of the account manager responsibility definition provided with the industry data model plugins.

Note: Creating and using responsibility definitions is a feature available in releases prior to Paris. Customers can create responsibility definitions using the Responsibility Definition (sn_customerservice_responsibility_def) table and use those definitions to create account teams using the Account Team Member (sn_customerservice_team_member) table. For more information, see Create account teams.

Creating a responsibility definition
Users with the system administrator role can create responsibility definitions.

2. Click New and fill in the fields on the Responsibility Definition form.

In the Type field, select User if this responsibility is to be used in the following relationships:
- Account Team Member
- Consumer Team Member
- Household Team Member

If this responsibility is to be used in the following consumer relationships, set the Type field to None.
- Consumer to Consumer
- Household Member

For more information, see Create a responsibility definition.

Creating a unique responsibility definition
A responsibility definition can be unique, meaning that the responsibility can only be assigned to one user. To make a responsibility definition unique:

2. Select a responsibility definition.
3. Enable the Unique check box on the Responsibility Definition form.
4. Click Update.
When creating or updating records in the following tables, the system checks for and enforces unique responsibilities.

- Household Team Member [sn_customer_rel_household_to_user]
- Consumer Team Member [sn_customer_rel_consumer_to_user]
- Account Team Member [sn_customerservice_team_member]

For example:

<table>
<thead>
<tr>
<th>Table</th>
<th>Responsibility Example</th>
<th>Unique behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Team Member</td>
<td>Account Manager</td>
<td>An account can have only one account manager but a user with the Account Manager responsibility can manage multiple accounts.</td>
</tr>
<tr>
<td>Consumer Team Member</td>
<td>Relationship Manager</td>
<td>A consumer can have only one Relationship Manager but a user with the Relationship Manager responsibility can manage multiple consumers.</td>
</tr>
<tr>
<td>Household Team Member</td>
<td>Relationship Manager</td>
<td>A household can have only one Relationship Manager but a user with the Relationship Manager responsibility can manage multiple households</td>
</tr>
</tbody>
</table>

Note: The unique behavior of a responsibility definition is not enforced when the responsibility is used for relationships between consumers or household members.

Related information

Create a responsibility definition

Industry data model relationships

Create relationships between an agent and a customer or between two consumers that provide additional access to customer data.

With the industry data model feature, you can create relationships between the following users:

- Between an internal user and an account, household, or consumer.
- Between two consumers.
Relationships are based on responsibilities, or responsibility definitions. When you create a relationship, you select the users involved in the relationship and the responsibility that one user performs on behalf of another. The responsibility that is assigned to a relationship provides access to customer cases and information. The following relationships are provided with the industry data model plugins.

<table>
<thead>
<tr>
<th>Relationship</th>
<th>Responsibility used in the relationship</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Team Member</td>
<td>Account Manager [sn_customerservice_team_member]</td>
<td>Create a relationship between an internal user and an account.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> The internal user in this relationship must also be assigned the relationship agent role (sn_customerservice.relationship_agent).</td>
</tr>
<tr>
<td>Consumer Team Member</td>
<td>Relationship Manager [sn_customer_rel_consumer_to_user]</td>
<td>Create a relationship between an internal user and a consumer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> The internal user in this relationship must also be assigned the relationship agent role (sn_customerservice.relationship_agent).</td>
</tr>
<tr>
<td>Household Team Member</td>
<td>Relationship Manager [sn_customer_rel_household_to_user]</td>
<td>Create a relationship between an internal user and a household.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> The internal user in this relationship must also be assigned the relationship agent role (sn_customerservice.relationship_agent).</td>
</tr>
</tbody>
</table>
### Relationships between internal users and customers

Internal users can have relationships with accounts, consumers, and households. These relationships provide internal users with additional access to customer cases and information. An internal user with a relationship to a customer can create and manage cases on behalf of that customer.

Relationships are created using responsibilities. Use the following responsibilities to create relationships between internal users and customers:

- **Account Manager**: use this responsibility to create a relationship between a staff member and an account.
- **Relationship Manager**: use this responsibility to create a relationship between a staff member and a household or a consumer.

Relationships that you create are added to the following related lists:

- Account Staff Relationships on the Business Location form
- Consumer Staff Relationships on the Business Location form
- Household Staff Relationships on the Business Location form
- Account Team on the Consumer form
- Consumer Team on the Consumer form
- Household Team on the Household form

### Relationships between consumers

Consumers can have relationships with other consumers. These relationships enable consumers to view and manage cases and information on behalf of other consumers.

Relationships are created using responsibilities. Use the Authorized Representative responsibility to create relationships between consumers. With this responsibility, you can:

---

**Table: Relationships**

<table>
<thead>
<tr>
<th>Relationship</th>
<th>Responsibility used in the relationship</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Consumer to Consumer</td>
<td>Authorized Representative</td>
<td>Create a relationship between two consumers, regardless of household.</td>
</tr>
<tr>
<td>Household Member Relationships</td>
<td>Authorized Representative</td>
<td>Create a relationship between two consumers within a household.</td>
</tr>
</tbody>
</table>

---

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
• Create a relationship between two consumers, regardless of household.
• Create a relationship between two consumers within a household.

Relationships that you create are added to the following related lists:
• Member Relationships on the Household form
• Consumer Relationships on the Consumer form

Deleting relationships
When a relationship definition is deleted, all of the relationships that use the definition are also deleted.
When a consumer is deleted, all of the relationships to which the consumer belonged are also deleted.
When a household is deleted, all of the relationships created for the household are also deleted.
When a consumer stops being a current member of a household, all of the relationships created for the consumer within the household are also deleted.

Industry data model tables
Tables that are included with or modified by the plugins that enable the industry data model feature.

The industry data model feature adds new tables or modifies existing tables when you activate the following plugins:
• Business Location (com.snc.business_location)
• Customer Service Household (com.snc.household)
• Service Organization (com.snc.service_organization)
• Customer Service Base Extension Entities (com.snc.cs_base_extension)
• Customer Service Install Base Management (com.snc.install_base)

Business Location plugin
The Business Location plugin adds the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
</table>
| Business Location  
[sn_csm_business_location] | Extends the Service Organization  
[sn_customer_service_organization] table. |
### Table Description

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A business location is one type of service organization. This table stores business location records.</td>
<td></td>
</tr>
<tr>
<td>Internal Business Location</td>
<td>Extends the Business Location [sn_csm_business_location] table. This table stores internal business location records.</td>
</tr>
<tr>
<td>[sn_csm_business_location_internal]</td>
<td>☑️ <strong>Note:</strong> An internal business location is a business location with the <strong>Internal</strong> field set to true.</td>
</tr>
</tbody>
</table>

#### Customer Service Household plugin

The Customer Service Household plugin adds or modifies the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Household [csm_household]</td>
<td>Stores consumer household records.</td>
</tr>
<tr>
<td></td>
<td>For the industry data model feature, this table is updated to support the head of household.</td>
</tr>
<tr>
<td>Household Member [csm_household_member]</td>
<td>Stores records of the consumers who have been added to households.</td>
</tr>
<tr>
<td>Household Team Member [sn_customer_rel_household_to_user]</td>
<td>Stores records for each of the household team member relationships that have been created between an internal user and a household.</td>
</tr>
<tr>
<td>Household Member Relationship [sn_customer_rel_household_member_relationship]</td>
<td>Extends the Consumer to Consumer Relationship [sn_customer_rel_consumer_to_consumer] table. This table stores records for each of the relationships that have been created between two consumers who belong to the same household.</td>
</tr>
</tbody>
</table>

#### Service Organization plugin

The Service Organization plugin adds the following tables.
<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Organization [sn_customer_service_organization]</td>
<td>Extends the Company [core_company] table. Stores records for service organizations, including business locations and internal business locations.</td>
</tr>
<tr>
<td>Service Organization Member [sn_csm_service_organization_member]</td>
<td>Stores records for the users who belong to internal service organizations.</td>
</tr>
<tr>
<td>Service Organization External Staff [sn_csm_service_organization_external_staff]</td>
<td>Extends the User [sys_user] table. Stores records for the users who belong to external service organizations.</td>
</tr>
</tbody>
</table>

**Customer Service Base Extension Entities plugin**
The Customer Service Base Extension Entities plugin adds the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Consumer to Consumer Relationship [sn_customer_rel_consumer_to_consumer]</td>
<td>Stores records for each of the relationships that have been created between two consumers, regardless of household.</td>
</tr>
<tr>
<td>Consumer Team Member [sn_customer_rel_consumer_to_user]</td>
<td>Stores records for each of the consumer team member relationships that have been created between an internal user and a consumer.</td>
</tr>
</tbody>
</table>

**Customer Service Install Base Management plugin**
The Customer Service Install Base Management plugin adds the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Consumer Sold Product [sn_install_base_m2m_consumer_sold_product]</td>
<td>Stores records for each sold product (products and components) that have been sold to a consumer.</td>
</tr>
</tbody>
</table>
### Existing tables used by industry data models

This table lists the tables from existing plugins that are used by the industry data models feature to support customers.

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Table</th>
<th>New columns</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Service (com.sn_customerservice)</td>
<td>Responsibility Definition [sn_customerservice_responsibility]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Account Team Member [sn_customerservice_team_member]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Case [sn_customerservice_case]service_organization</td>
<td>household</td>
</tr>
<tr>
<td>Customer Service Base Entities (com.snc.cs_base)</td>
<td>Contract (ast_contract) household</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Entitlement [service_entitlement]</td>
<td>household</td>
</tr>
<tr>
<td>Customer Service Install Base Management (com.snc.install_base)</td>
<td>Sold Product [sn_install_base_sold_product]</td>
<td>household</td>
</tr>
<tr>
<td>Customer Service Management for Orders (com.snc.csm.order)</td>
<td>Order [csm_order] household</td>
<td>service_organization</td>
</tr>
</tbody>
</table>

### Industry data model roles

Roles that are included with the plugins that enable the industry data model feature.

The system administrator can assign these roles to internal users.

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location agent [sn_customerservice.svc_location_agent]</td>
<td>Create and fulfill cases for the accounts and contacts in the agent’s business location.</td>
<td>• sn_fsm_servicedesk_agent • sn_esm_location_agent</td>
</tr>
<tr>
<td>Role</td>
<td>Description</td>
<td>Contains roles</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Location consumer agent</td>
<td>Create and fulfill cases for the consumers and households in the agent's</td>
<td>• sn_fsm_servicedesk_agent</td>
</tr>
<tr>
<td>[sn_customerservice.svc_location_consumer_agent]</td>
<td>business location.</td>
<td>• sn_esm_location_agent</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Location manager</td>
<td>Create and update cases for accounts, contacts, consumers, and households</td>
<td>• sn_fsm_servicedesk_agent</td>
</tr>
<tr>
<td>[sn_customerservice.svc_location_manager]</td>
<td>that work with the business locations within their location hierarchy.</td>
<td>• sn_customerservice.svc_location_agent</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• sn_customerservice.svc_location_consumer_agent</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• email_client_quick_message_author</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• sn_templated_snip.template_snippet_writer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• sn_shn.admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• approver_user</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• sn_publication.approver</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Relationship agent</td>
<td>This role restricts an agent's access to only those cases for the accounts,</td>
<td>• agent_workspace_user</td>
</tr>
<tr>
<td>[sn_customerservice.relationship_agent]</td>
<td>contacts, consumers, and households that they have a relationship with.</td>
<td>• snc_internal</td>
</tr>
<tr>
<td></td>
<td>This includes the following relationships that are provided with the</td>
<td>• sn_shn.editor</td>
</tr>
<tr>
<td></td>
<td>industry data model plugins:</td>
<td>• email_composer</td>
</tr>
<tr>
<td></td>
<td>• Account Manager: creates a relationship between an internal user and an</td>
<td>• sn_fsm_servicedesk_agent</td>
</tr>
<tr>
<td></td>
<td>account.</td>
<td>• sn_customerservice.csm_workspace_user</td>
</tr>
<tr>
<td></td>
<td>• Relationship Manager: creates a relationship between an internal user</td>
<td>• sn_templated_snip.template_snippet_writer</td>
</tr>
<tr>
<td></td>
<td>and a consumer or a household.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Service Management agent</td>
<td>A service management agent role for a business location</td>
<td>• sn_lookup_verify_user</td>
</tr>
<tr>
<td>[sn_esm_location_agent]</td>
<td></td>
<td>• assignment_workbench</td>
</tr>
</tbody>
</table>
Industry data model table access by role

The user roles that can access the industry data model tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Create</th>
<th>Read</th>
<th>Update</th>
<th>Delete</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Organization [sn_customer_service_organization]</td>
<td></td>
<td>• CSM manager</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• customer agent</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• consumer agent</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Business Location [sn_csm_business_location]</td>
<td></td>
<td>• CSM manager</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• customer agent</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• consumer agent</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• location manager</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Industry data model table access by role (continued)

<table>
<thead>
<tr>
<th>Table</th>
<th>Create</th>
<th>Read</th>
<th>Update</th>
<th>Delete</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>• location agent</td>
<td>• CSM manager</td>
<td>• CSM manager</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• location consumer agent</td>
<td>• customer agent</td>
<td>• location manager</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• consumer agent</td>
<td>• location manager</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• location agent</td>
<td>• location manager</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• location consumer agent</td>
<td>• location manager</td>
</tr>
</tbody>
</table>

**Internal Business Location**

- [sn_csm_business_location_internal]

**Service Organization Member**

- [sn_csm_service_organization_member]

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Table</th>
<th>Create</th>
<th>Read</th>
<th>Update</th>
<th>Delete</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>• location consumer agent (their locations only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Household</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>[csm_household]</td>
<td></td>
<td>• CSM manager</td>
<td>CSM manager</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• consumer agent</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• location manager</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• location consumer agent</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• relationship agent (for households they have relationships with)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• consumer (for their households)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Household Member</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>[csm_household_member]</td>
<td></td>
<td>• CSM manager</td>
<td>CSM manager</td>
<td>relationship agent (for households they have relationships with)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• consumer agent</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• location manager</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• location consumer agent</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• relationship agent (for)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Create</td>
<td>Read</td>
<td>Update</td>
<td>Delete</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>--------</td>
<td>----------------------------------------------------------------------</td>
<td>--------------</td>
<td>--------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>households they have relationships with)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• consumer (for households where they are head of household or for consumers that they represent)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Consumer to Consumer Relationship</td>
<td>CSM manager</td>
<td>• CSM manager</td>
<td>CSM manager</td>
<td></td>
</tr>
<tr>
<td>[sn_customer_rel_consumer_to_consumer]</td>
<td></td>
<td>• consumer agent</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• location manager</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• location consumer agent</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Household Member Relationship</td>
<td>CSM manager</td>
<td>• CSM manager</td>
<td>CSM manager</td>
<td></td>
</tr>
<tr>
<td>[sn_customer_rel_household_member_relationship]</td>
<td></td>
<td>• consumer agent</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• location manager</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• location consumer agent</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Create</td>
<td>Read</td>
<td>Update</td>
<td>Delete</td>
</tr>
<tr>
<td>-----------------------------------------------------------</td>
<td>-----------------------------------------------------</td>
<td>----------------------------------------------------</td>
<td>-----------------------------------------------------</td>
<td>-----------------------------------------------------</td>
</tr>
<tr>
<td>Account Team Member [sn_customerservice_team_member]</td>
<td>• CSM manager (for their hierarchy)</td>
<td>• CSM manager</td>
<td>• CSM manager (for their hierarchy)</td>
<td>• CSM manager (for their hierarchy)</td>
</tr>
<tr>
<td></td>
<td>• location manager</td>
<td>• location manager (for their hierarchy)</td>
<td>• location manager (for their hierarchy)</td>
<td>• location manager (for their hierarchy)</td>
</tr>
<tr>
<td></td>
<td>• customer agent</td>
<td>• location agent (for their locations)</td>
<td>• location agent (for their locations)</td>
<td>• location agent (for their locations)</td>
</tr>
<tr>
<td></td>
<td>• location manager (for their hierarchy)</td>
<td>• relationship agent (for accounts that they have relationships with)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Consumer Team Member [sn_customer_rel_consumer_to_user]</td>
<td>• CSM manager (for their hierarchy)</td>
<td>• CSM manager</td>
<td>• CSM manager (for their hierarchy)</td>
<td>• CSM manager (for their hierarchy)</td>
</tr>
<tr>
<td></td>
<td>• location manager</td>
<td>• location manager (for their hierarchy)</td>
<td>• location manager (for their hierarchy)</td>
<td>• location manager (for their hierarchy)</td>
</tr>
<tr>
<td></td>
<td>• consumer agent</td>
<td>• location manager (for their locations)</td>
<td>• location agent (for their locations)</td>
<td>• location agent (for their locations)</td>
</tr>
<tr>
<td></td>
<td>• location manager (for their hierarchy)</td>
<td>• relationship agent (for consumers)</td>
<td>• relationship agent (for consumers)</td>
<td>• relationship agent (for consumers)</td>
</tr>
</tbody>
</table>
### Industry data model table access by role (continued)

<table>
<thead>
<tr>
<th>Table</th>
<th>Create</th>
<th>Read</th>
<th>Update</th>
<th>Delete</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>that they have relationships with)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Household Team Member</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>[sn_customer_rel_household_to_user]</td>
<td>• CSM manager</td>
<td>• CSM manager</td>
<td>• CSM manager</td>
<td>• CSM manager</td>
</tr>
<tr>
<td></td>
<td>• location manager (for their hierarchy)</td>
<td>• consumer agent</td>
<td>• location manager (for their hierarchy)</td>
<td>• location manager (for their hierarchy)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• location manager (for their hierarchy)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• location consumer agent (for their locations)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• relationship agent (for households that they have relationships with)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Industry data model modules

The industry data model plugins add several modules to the application navigator.

### Business location modules

- Service Organizations > Business Locations: lists the business locations that have been created.

**Note:** This module is available in Agent Workspace and in the platform interface.

Users with the following roles have access to these modules:
Household modules

- Customer > Households: lists the households that a user has access to.
- Customer > Household Members: lists the consumers that have been added to households.

⚠️ Note: These modules are available in Agent Workspace and in the platform interface.

Users with the following roles have access to these modules:

- sn_customerservice_manager
- sn_customerservice.consumer_agent
- sn_customerservice.svc_location_consumer_agent
- sn_customerservice.relationship_agent

Customer relationship modules

- Customer Relationships > Consumer Team Members: lists the relationships that have been created between an internal user and a consumer.
- Customer Relationships > Household Team Members: lists the relationships that have been created between an internal user and a household.
- Customer Relationships > Consumer Relationships: lists the relationships that have been created between two consumers, regardless of household.
- Customer Relationships > Household Relationships: lists the relationships that have been created between two consumers who are members of the same household.

⚠️ Note: These modules are only available in the platform interface. You can view relationships in Agent Workspace in related lists. Customer service managers and location managers can also modify account, consumer, and household team member relationships in Agent Workspace.

Users with the following roles have access to these modules:
• sn_customerservice_manager
• sn_customerservice.consumer_agent
• sn_customerservice.svc_location_manager
• sn_customerservice.svc_location_consumer_agent

Industry data model cases
Location agents and location consumer agents at a business location can create cases for accounts, contacts, consumers, and households.

Staff members with the location agent or location consumer agent role can do the following:
• View information for the customers at their location.
• Create cases for accounts, contacts, households, and consumers.
• Update cases created at their location.
• Create consumers.

Case location
A case belongs to a business location. When a case is created by a location agent or manager, the Service Organization field on the Case form is automatically updated with the business location to which the agent or manager belongs. If the case is reassigned, this field is updated to that of the new agent or manager.

If the location agent or manager belongs to multiple locations, the Service Organization field may be left blank. When you fill in this field, select carefully as the service organization controls a location agent's access to cases.

⚠️ Note: A case can belong to only one business location.

The Service Organization can be set manually for a new case or changed for an existing case. Changing the Service Organization does not change the assigned agent.

Case access
Case access is controlled by the business location in the Service Organization field on the Case form. The following users can access cases:
• Staff members at the business location with the location agent or location consumer agent role.
• Managers at the business location with the location manager role.
Cases for a business location are added to the Cases related list on the Internal Business Location form.

- When a case is created, the service organization on the case is the service organization of the user who creates the case.
- When a case is assigned to an agent, the service organization on the case is updated to the service organization of the assigned agent.

### Case access for consumers

<table>
<thead>
<tr>
<th>Consumer type</th>
<th>Case access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Consumer</td>
<td>Can manage their own cases.</td>
</tr>
<tr>
<td>Head of household</td>
<td>Can manage cases for all of the household members.</td>
</tr>
<tr>
<td>Authorized representative, regardless of household</td>
<td>Can manage cases for the consumer they represent.</td>
</tr>
<tr>
<td>Authorized representative, inside of household</td>
<td>Can manage cases for the consumer they represent as long as both are current members of the household.</td>
</tr>
</tbody>
</table>

### Case access for users

<table>
<thead>
<tr>
<th>User</th>
<th>Required role</th>
<th>Case access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location manager</td>
<td>Location manager</td>
<td>Can manage the cases in their location hierarchy.</td>
</tr>
<tr>
<td>Location staff member</td>
<td>Location agent</td>
<td>Can manage the cases in their locations.</td>
</tr>
<tr>
<td>Location staff member</td>
<td>Location consumer agent</td>
<td></td>
</tr>
<tr>
<td>Account manager</td>
<td>Relationship agent</td>
<td>Can manage cases for their accounts.</td>
</tr>
<tr>
<td>Consumer relationship manager</td>
<td>Relationship agent</td>
<td>Can manage cases for their consumers.</td>
</tr>
<tr>
<td>Household relationship manager</td>
<td>Relationship agent</td>
<td>Can manage cases for their households.</td>
</tr>
</tbody>
</table>
Industry data model business locations

Use the business location entity to create an organizational structure that includes internal business locations such as stores and branches.

A business location is an extension of a service organization. The business location entity enables you to model the internal organizational structure involved in supporting customers. It also enables you to give agents the right level of visibility into customer data.

With the business location entity you can:

• Create internal business locations using a hierarchy, with parent and child locations.
• Associate internal users (users with the snc_internal role) with a business location, which makes them staff members of that location.
• Provide staff members at a business location with access to the customer cases and information for that location.
• Create teams of staff members to support accounts, consumers, and households.
• Provide the staff members on those teams with access that enables them to manage cases for their accounts, consumers, and households.

Creating a business location

To create a business location, see Create an internal business location.

A business location can have one assigned manager and multiple assigned staff members. The manager and staff members for a business location are the internal employees (users with the snc_internal role) who work at that location. To assign these users:

• Add the name of the manager in the Manager field on the Internal Business Location form.
• Add staff members to the Members related list on the Internal Business Location form.

Accessing business locations

Managers have access to their business location and to the business locations that are designated as child locations in the hierarchy.

• When a user is added to the Manager field, the sn_customerservice.svc_location_manager role is automatically added to that user.
• You can add a user as the manager for multiple business locations.
Staff members with the location agent role or location consumer agent role can perform the following actions:

- Create cases for customers in their business locations.
- Access cases where the location in the Service Organization field on the Case form matches their business locations.

**Create an internal business location**

Create an internal business location.

**Before you begin**

Role required: admin

**About this task**

A business location has a manager. When you create a business location, you add a user to the Manager field on the Internal Business Location form. This user is automatically assigned the location manager role (sn_customerservice.svc_location_manager).

**Note:** Only internal users can be added as managers for internal business locations.

The manager of a business location can access all of the cases in the location hierarchy, including cases for child locations. The manager can also:

- Add staff members to business locations in the location hierarchy.
- Create account team or consumer team relationships with staff members from the location hierarchy.
- View customer information.
- Update cases created in the location hierarchy.
- Create cases for customers in the location hierarchy.

**Procedure**

2. Click New on the Business Locations list.
3. Fill in the fields on the Internal Business Location form.
4. Click Submit.

The location is added to the Business Locations list.

After creating a business location, you can add staff members to the location and create relationships between staff members and accounts, households, and consumers.
Related reference

Industry data model business locations

Add staff members to an internal business location

Add users as staff members to an internal business location so that they can support accounts, contacts, consumers, and households.

Before you begin

Role required: sn_customerservice.svc_location_manager, sn_customerservice_manager, admin

About this task

You can add internal users with the snc_internal role as staff members to an internal business location.

- Administrators and customer service managers can add staff members to any internal business location.
- Location managers can add staff members to the internal business locations that they have access to.

Note: An internal user can be added as a staff member to one internal business location.

Procedure

2. Select a business location.
3. In the Members related list, click Edit.
4. Select the desired users and add them to the Members List.
5. Click Save.

Create an account team member relationship

Create a relationship between a staff member at an internal business location and an account.

Before you begin

Role required: sn_customerservice.svc_location_manager, sn_customerservice_manager, admin

About this task

You can assign internal users who have been added as staff members to an internal business location to an account relationship.
• Administrators and customer service managers can assign a staff member from any location.
• Location managers can assign staff members from the locations that they have access to.

Relationships are based on responsibilities. A responsibility definition describes a role or a function that supports a customer or consumer. To create an account team member relationship, use the Account Manager responsibility.

Procedure
2. Select a business location.
3. In the Account Staff Relationships related list, click New. This related list shows the accounts that have a relationship with any staff member at that location.
4. In the Account field, select the account to which the staff member is assigned.
5. In the Responsibility field, select Account Manager.
6. In the User field, select the staff member to fulfill the responsibility.
7. Click Submit. The relationship is added to the Account Staff Relationships related list.

Create a consumer team member relationship
Create a relationship between a staff member at an internal business location and a consumer.

Before you begin
Role required: sn_customerservice.svc_location_manager, sn_customerservice_manager, admin

About this task
Internal users who have been added as staff members to an internal business location can be assigned a consumer relationship.
• Administrators and customer service managers can assign a staff member from any location.
• Location managers can assign staff members from the locations that they have access to.
Relationships are based on responsibilities. A responsibility definition describes a role or a function that supports a customer or consumer. To create a consumer relationship, use the Relationship Manager responsibility.

**Procedure**

1. Navigate to **Customer Service > Service Organizations > Business Locations**.
2. Select a business location.
3. In the Consumer Staff Relationships related list, click **New**. This related list shows the consumers that have a relationship to any staff member for the location.
4. In the **Consumer** field, select the consumer to which the internal user is assigned.
5. In the **Responsibility** field, select the **Relationship Manager** responsibility.
6. In the **User** field, select the staff member to fulfill the responsibility.
7. Click **Submit**. The relationship is added to the Consumer Staff Relationships related list.

**Create a household team member relationship**

Create a relationship between a staff member at an internal business location and a household.

**Before you begin**

Role required: sn_customerservice.svc_location_manager, sn_customerservice_manager, admin

**About this task**

Internal users who have been added as staff members to an internal business location can be assigned a household relationship.

Relationships are based on responsibilities. A responsibility definition describes a role or a function that supports a customer or consumer. To create a household relationship, use the Relationship Manager responsibility.

**Procedure**

1. Navigate to **Customer Service > Service Organizations > Business Locations**.
2. Select a business location.
3. In the Household Staff Relationships related list, click **New**. This related list shows the households that have a relationship to any staff member for the location.
4. In the **Household** field, select the consumer to which the internal user is assigned.

5. In the **Responsibility** field, select the **Relationship Manager** responsibility.

6. In the **User** field, select the staff member to fulfill the responsibility.

7. Click **Submit**.
   
The relationship is added to the Household Staff Relationships related list.

---

**Create and manage cases for a business location**

Staff members with the location agent role can create and manage cases for their business location.

**Before you begin**

Role required: `sn_customerservice.svc_location_agent`, `sn_customerservice.svc_location_manager`

**About this task**

Staff members with the location agent role can do the following:

- View information for the customers at their location.
- Create cases for the accounts, contacts, households, and consumers at their location.
- Create consumers.
- Update cases created at their location.

A case belongs to one business location. When a case is created by a location agent or manager, the **Service Organization** on the Case form is automatically updated with the business location to which the agent or manager belongs. If the case is reassigned, this field is updated to that of the new agent or manager.

If the location agent or manager belongs to multiple locations, the **Service Organization** field may be left blank. When you fill in this field, select carefully as the service organization controls a location agent’s access to cases.

The **Service Organization** can be set manually for a new case or changed for an existing case. Changing the **Service Organization** does not change the assigned agent.

Location agents and managers can create cases for business locations without adding an account or contact or a consumer. The location agent or manager who creates the case is added to the **Opened by** field.
Procedure

1. Navigate to Customer Service > Cases and click Create New.
2. Optional: Select the type of case that you want to create.
3. Fill in the fields on the Case form.
4. Click Submit.

Related reference

Industry data model cases

Industry data model households
The household entity represents a group of consumers that usually share a common address and use services as a group.

A household is made up of consumers who have been added as members of that household.

Note: A household has an address and consumers have their own addresses. These addresses do not need to be the same in order to add a consumer as a member to a household.

With the household entity, you can:

• Create households and add consumers as household members.
• Create cases for households and household members.
• Create relationships between household members. These relationships authorize one household member to manage cases on behalf of another member.
• Create relationships between staff members and households or household members that enable the staff members to manage cases for those households and members.
• Track information for households, including sold products, contracts, and entitlements.

Head of household

A household can have one member designated as the head of household. A consumer who is added as the head of household is automatically added as a member of the household.

The head of household has access to all of the cases and information for the household and the other household members. The head of household can also see:
• The sold products for the household.
• The sold products and install base items for household members.

**Household information**

Households can have multiple members. These members can be either consumers or consumer users. Consumers can also belong to multiple households.

Membership in a household is defined by the **Start Date** and **End Date** on the Household Member form. A household member is considered to be a current member if:

• The **Start Date** field is empty or is filled in with today’s date.
• The **Start Date** field is filled in with a past date and the **End Date** field is empty or is filled in with today’s date or a future date.

Only one record with current membership dates is allowed for each consumer in a household. A consumer can leave and rejoin a household multiple times. This information is recorded using the start and end dates.

As members are added or removed from a household, the member history is retained. You can find this information in the following related lists on the Household form.

• **Current Members**: the consumers currently in the household.
• **All Members**: current and past members of a household. This list provides a history of the household. Members can appear multiple times in this list.

On the Household form, you can also find information about household cases and products in the following related lists:

• **Cases**: the cases that have been created for all of the members within a household
• **Sold Products**: the products owned by the household. These products can be owned or shared by multiple household members.

**Household member relationships**

The following types of relationships can be created for households and household members. These relationships are included in the following related lists on the Household form:

• **Member Relationships**: relationships that have been established between household members. These relationships are created using the Authorized Representative responsibility. Household members that have an Authorized
Representative relationship with another household member can act on behalf of that member and can manage cases and information for that member.

- **Household Team**: relationships that have been established between an agent and a household. These relationships are created using the Relationship Manager responsibility. Agents that have a Relationship Manager relationship with a household can manage all of the cases for that household.

**Consumer relationships**
The following types of relationships can be created for consumers.

- **Consumer Relationships**: relationships that have been established between two consumers, regardless of household. These relationships are created using the Authorized Representative responsibility. Consumers that have an Authorized Representative relationship with another consumer can manage cases for that consumer.

- **Consumer Team**: relationships that have been established between an agent and a consumer. These relationships are created using the Relationship Manager responsibility. Agents that have a Relationship manager relationship with a consumer can access all of the cases for that consumer.

### Create or update a household
Create a household.

**Before you begin**
Role required: sn_customerservice_manager, admin

**About this task**
A household is made up of a group of consumers who live at a common address and share products and services.

A household can have a designated head of household and multiple current members. The head of household has access to all of the cases and information for the other household members.

A user with the system administrator role can create a household. This user can also delete a household. When a household is deleted, the system clears the references and associations to the household, including members, sold products, cases, and work orders, but does not delete these associated entities.

**Procedure**

1. Navigate to **Customer Service > Customers > Households**.
2. Click **New** on the Households list.
3. Fill in the fields on the **Household** form.

4. Click **Submit**. The household is added to the Households list.

**Related reference**
- Industry data model households
- Industry data model relationships

**Add consumers to a household**
Add consumers as members of a household.

**Before you begin**
Role required: sn_customerservice_manager, admin

**About this task**
You can add existing consumers from the Consumer table to a household.

- A household can have multiple consumers.
- A consumer can belong to multiple households. One household can be designated as the primary household for that consumer.

Household member records are added to the Household Member table. When a consumer is added to a household, the consumer is assigned a unique household member number that begins with the prefix HM.

The Household form includes the following related lists for household members:
- Current Members: consumers that belong to the household as of the current date.
- All Members: current members and past members. The customer service manager or admin can indicate that a consumer no longer belongs to the household by adding a date to the **End Date** field. A consumer that has left a household can be added back to that household.

**Procedure**
1. Navigate to **Customer Service > Customer > Households**.
2. Select a household.
3. In the Current Members related list, click **New**.
4. Add a user from the Consumer table in the **Consumer** field. The **Household** field is automatically updated with the household selected in step 2.
5. **Optional:** If desired, add the date that the consumer was added to the household in the **Start Date** field. The **End Date** field can be added if the consumer is removed from the household.

6. Click **Submit**.
   The consumer is added to the Current Members related list. On the Consumer form for this consumer, the household is added to the following related lists:
   - Current Households
   - All Households

   **Note:** You may need to configure the Consumer form to display these related lists. For more information, see [Configure industry data models](#).

---

**Create a relationship between household members**
Create a relationship between two consumers who are current members of the same household.

**Before you begin**
Role required: sn_customerservice_manager, admin

**About this task**
Relationships are based on responsibilities. A responsibility definition describes a role or a function that supports a customer or consumer. To create a relationship between two consumers in a household, use the Authorized Representative responsibility.

**Procedure**
1. Navigate to **Customer Service > Customer > Households**.
2. Select a household.
3. In the Member Relationships related list, click **New**.
   This related list shows the current relationships that exist between consumers in this household. When you click **New**, a new Household Member Relationship is displayed with the **Household** field already filled in.
4. In the **Consumer is** field, select the consumer in the household to fulfill the responsibility on behalf of another consumer within the same household.
5. In the **Responsibility** field, select the **Authorized Representative** responsibility.
6. In the **of Consumer** field, select the consumer who is being represented by the consumer in the **Consumer is** field.
7. Click **Submit**.
   The relationship is added to the Member Relationships related list.

**Create a relationship between two consumers**
Create a relationship between two consumers, regardless of household.

**Before you begin**
Role required: sn_customerservice.svc_location_manager, sn_customerservice_manager, admin

**About this task**
Relationships are based on responsibilities. A responsibility definition describes a role or a function that supports a customer or consumer. To create a relationship between two consumers, use the Authorized Representative responsibility.

**Procedure**
1. Navigate to **Customer Service > Customer > Consumers**.
2. Select a consumer.
3. In the Consumer Relationships related list, click **New**.
   This related list shows the current relationships that exist for the selected consumer. When you click **New**, a new Consumer to Consumer Relationship form is displayed with the **Consumer is** field filled in.
4. In the **Responsibility** field, select the **Authorized Representative** responsibility.
5. In the **of Consumer** field, select the consumer who is being represented by the consumer in the **Consumer is** field.
6. Click **Submit**.
   The relationship is added to the Consumer Relationships related list.

**Create and manage cases for a consumer or household**
Staff members with the location agent role can create and manage cases for consumers and households.

**Before you begin**
Role required: sn_customerservice.svc_location_agent, sn_customerservice.svc_location_consumer_agent, sn_customerservice.svc_location_manager

**About this task**
Staff members at a business location who have either the location agent or consumer location agent role can create cases for households and consumers.
Staff members or internal users who have a relationship with a household (based on the Relationship Manager responsibility) can create cases for that household and its members. Users with relationships to a household are listed in the following locations:

• The Household Team related list on the Household form.
• The Household Team Members list.

Relationship managers can perform the following actions on the cases that they can access:

• Add comments and work notes.
• Add attachments.
• Close cases.

When a consumer case is created or updated, the consumer receives an email notification. If a household is added to a case, the head of household is also notified when the case is created or updated.

Procedure
1. Navigate to Customer Service > Cases and click Create New.
2. Optional: Select the type of case that you want to create.
3. Perform one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a consumer.</td>
<td>Select a consumer in the Consumer field.</td>
</tr>
<tr>
<td></td>
<td>• If the consumer belongs to only one household, the Household field is</td>
</tr>
<tr>
<td></td>
<td>automatically updated.</td>
</tr>
<tr>
<td></td>
<td>• If the consumer belongs to more than one household, select a household</td>
</tr>
<tr>
<td></td>
<td>from the households that a consumer belongs to in the Household field.</td>
</tr>
<tr>
<td></td>
<td>• If the consumer does not belong to a household, you can leave the</td>
</tr>
<tr>
<td></td>
<td>Household field empty.</td>
</tr>
<tr>
<td>Add a household.</td>
<td>Select a household in the Household field.</td>
</tr>
</tbody>
</table>
4. Fill in the remaining fields on the Case form.

5. If desired, add other members of the household to the watch list.
   If a user with a Relationship Manager relationship is creating a case for a household or household member, this user is automatically added to the watch list.

6. Click Submit.
   The case is added to the Cases related list on the Household form.

Related reference

Industry data model cases

Create entitlements for a household

Create entitlements for a household so that all household members are covered under the same terms and conditions.

Before you begin
Role required: sn_customerservice_manager, admin

About this task
System administrators and customer service managers can create entitlements for a household. These entitlements apply to the current members of that household.

When a case is created for a household or a consumer, the Entitlement field on the Case form lists the available entitlements:

<table>
<thead>
<tr>
<th>If these fields are filled in</th>
<th>The Entitlement field lists these entitlements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Household and Consumer</td>
<td>Entitlements for both the consumer and household.</td>
</tr>
<tr>
<td>Household</td>
<td>Entitlements for the household.</td>
</tr>
<tr>
<td>Consumer</td>
<td>Entitlements for the consumer</td>
</tr>
</tbody>
</table>
Procedure

2. Click New.
3. Select a household in the Household field.
   When you select a household, the head of household is automatically added to the Consumer field.

   Note: You may need to configure the form layout and add the Household field.

4. Optional: If desired, select a different household member in the Consumer field.

5. Fill in the remaining fields on the Entitlement form.
   For more information, see Create entitlements for CSM entities.

6. Click Submit.
   The entitlement is added to the Entitlements related list on the Household form.

Create service contracts for a household

Create service contracts for a household so that all household members are covered under the same terms and conditions.

Before you begin
Role required: sn_customerservice_manager, admin

About this task
System administrators and customer service managers can create contracts for a household. These contracts apply to the current members of that household.

When a case is created for a household or a consumer, the Contract field on the Case form lists the available contracts:

- If the Household and Consumer fields are filled in, the Contract field lists the contracts for both the consumer and household.
- If only the Household field is filled in, the Contract field lists the contracts for the household.
- If only the Consumer field is filled in, contracts field lists the contracts for the consumer

Procedure

2. Click New.
3. Select a household in the **Household** field.
   When you select a household, the head of household is automatically added to the **Consumer** field.

   **Note:** You may need to configure the form layout and add the **Household** field.

4. **Optional:** If desired, select a different household member in the **Consumer** field.

5. Fill in the remaining fields on the Contract form.
   For more information, see [Create service contracts](#).

6. Click **Submit**.
   The contract is added to the Contracts related list on the Household form.

**Consumer Service Portal changes**

Activating the Customer Service Household plugin enables you to view households and household members on the Consumer Service Portal as well as view and create cases for household members.

**Viewing multiple households on the portal**

Consumers can belong to multiple households and can have one primary household. When the Customer Service Household plugin is activated, consumers who are logged in to the Consumer Service Portal can see the following information on their user profile page:

- The consumer’s primary household in the **Primary Household** field.
- The households that the consumer belongs to in the **Households** list.

**Viewing household members on the portal**

For consumers who are the head of household, the Support menu includes the **Household Members** menu item, which lists all current members of the household.

Selecting this menu item displays a page that lists the members of the households where the logged-in consumer is the head of household.

**Creating cases for other members of a household or other consumers**

A consumer can create cases for another consumer in the following instances:
• A consumer who is the head of a household can create cases for other members of the household.

• A consumer who is an authorized representative for another consumer can create cases on behalf of that consumer.

When creating a case, the head of household or authorized representative can select the household member in the **Consumer** field on the record producer.

• If the logged-in consumer belongs to only one household, the household is automatically added to the case when it is submitted.

• If the logged-in consumer belongs to more than one household, the correct household can be selected in the **Household** field on the record producer.

• If the household is selected first, the consumers listed in the **Consumer** field are restricted to the current members of the household.

The default selections for the **Household** and **Consumer** fields on the record producer include the primary household and the logged-in consumer.

**Viewing and updating cases on the portal**

The logged-in consumer can see the following cases on the portal:

• All Cases: all of the cases that belong to their household or that belong to consumers with which they are an authorized representative.

• My Cases: the cases created by the logged-in consumer.

The head of household or authorized representative can perform the following actions for the cases that belong to their household:

• Add comments and attachments.

• Accept or reject a solution.

• Close a case.

**Consumer case information**

When the Customer Service Household plugin is activated, the Ticket Fields details tab includes the **Consumer** field.

**Contributor users**

With contributor user roles, you can engage both internal and external users to assist in resolving customer issues and requests.
The contributor users feature provides unified customer support for internal and external customers. With this feature, you can serve internal and external customers through shared service teams and service organizations:

• Enable service organizations to serve one another and external customers.
• Enable employees to request support for themselves and for external customers.
• Enable middle office agents to work on specific tasks that are required to resolve cases.

Overview of contributor user roles

The contributor users feature includes several roles that you can assign to users to control access to cases, case tasks, and case-related information. These roles can be assigned to users based on different business needs. In some cases, these roles also provide access to the parent cases and associated customer information. The following diagram and table provide an overview of these users and roles.

<table>
<thead>
<tr>
<th>Requester type</th>
<th>Description</th>
<th>Capabilities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requester for any customer</td>
<td>A requester who can create cases on behalf of any customer.</td>
<td>This user can:</td>
</tr>
<tr>
<td>Requester type</td>
<td>Description</td>
<td>Capabilities</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>This user:</td>
<td>• Works with accounts and contacts or consumers.</td>
<td>• Search knowledge articles and catalog items.</td>
</tr>
<tr>
<td></td>
<td>• Uses the Customer or Consumer Service Portal to assist customers.</td>
<td>• Create cases for customers who visit a business location, including cases for catalog items (requests).</td>
</tr>
<tr>
<td>Roles:</td>
<td></td>
<td>• Create cases from communication channels available to customers including phone, web, chat, Virtual Agent, and messaging.</td>
</tr>
<tr>
<td></td>
<td>• Account contributor (sn_customerservice.account_contributor)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Consumer contributor (sn_customerservice.consumer_contributor)</td>
<td>If also an internal user on a case, this user can:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Add additional comments and attachments</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Accept or reject a solution</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Close a case</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Receive notifications of case updates</td>
</tr>
<tr>
<td>Requester for my customers</td>
<td>A requester who can create cases on behalf of customers with whom they have an established relationship.</td>
<td>This user can:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Search knowledge articles and catalog items.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Create cases on behalf of customers with whom they have a relationship.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Create cases from communication channels available to customers including phone, web, chat, Virtual Agent, and messaging.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View all cases created for customers with whom they have a relationship.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Update customer data such as adding contacts and addresses.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Update cases:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ Add additional comments and attachments</td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ Accept or reject a solution</td>
</tr>
<tr>
<td>Requester type</td>
<td>Description</td>
<td>Capabilities</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Relationship contributor</td>
<td>A requester who can create cases on behalf of their business location.</td>
<td>◦ Close a case&lt;br&gt; ◦ Receive notifications of case updates</td>
</tr>
<tr>
<td></td>
<td>This user:&lt;br&gt; ◦ Works with accounts and contacts, consumers, and households.&lt;br&gt; ◦ Uses the Customer or Consumer Service Portal to assist customers.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Role:&lt;br&gt; ◦ Service organization contributor (sn_customerservice.service_organization_contributor)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Requester for service organization</td>
<td>A requester who can create cases on behalf of their business location.</td>
<td>This user can:&lt;br&gt; ◦ Search knowledge articles and catalog items.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ Create cases on behalf of their business location, including cases for catalog items (requests), and follow up on those cases.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ Create cases from communication channels available to customers including phone, web, chat, Virtual Agent, and messaging.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ View and follow up on other cases created for the user's business location.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If also an internal user on a case, this user can:&lt;br&gt; ◦ Add additional comments and attachments&lt;br&gt; ◦ Accept or reject a solution&lt;br&gt; ◦ Close a case&lt;br&gt; ◦ Receive notifications of case updates</td>
</tr>
<tr>
<td>Requester for self</td>
<td>A requester who can create cases for themselves.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>This requester accesses cases through a unified employee portal, if provided by their organization.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Role:&lt;br&gt; ◦ Service organization contributor (sn_customerservice.service_organization_contributor)</td>
<td></td>
</tr>
<tr>
<td>Requester type</td>
<td>Description</td>
<td>Capabilities</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
<td>--------------</td>
</tr>
</tbody>
</table>
| Self contributor | • Follow up on the cases that they created from themselves:  
◦ Add additional comments and attachments  
◦ Accept or reject a solution  
◦ Close a case  
◦ Receive notifications of case updates |

| Case task agent | A fulfiller, such as a middle office agent, who works on a specific set of tasks required to resolve a case. These case tasks:  
• Are assigned to the agent or to their department or group.  
• Focus on a specific function or expertise of the department or group.  
This agent typically uses a workspace to complete these tasks.  
Role:  
• Case task agent (sn_customerservice.case_task_agent) | This user can:  
• View and work on the case tasks assigned to them or to their group or department.  
• View the parent cases for the case tasks that they can access.  
• Communicate with agents on the parent case through work notes and additional comments.  
• Communicate with agents on other case tasks for the parent case through work notes and additional comments.  
• Access customer information needed to complete a case task.  
• Make changes to a case task that causes an update to the state or stage of the parent case.  
• Search for knowledge articles to assist with the case task. |

The contributor user roles are available with different CSM plugins. For a more detailed description of these user roles, see Contributor user roles.

**Fields added to the Case form**  
The contributor users feature adds two fields to the Case form that are used to identify the customer for a case. These fields are used in addition to the Account and Consumer fields.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Requesting Service Organization | This field displays the name of a service organization. If this field is filled in, and the **Account** and **Consumer** fields are empty, the customer for the case is a service organization.  
  
  🔄 **Note:** This field is included with the Service Organization plugin (com.snc.service_organization).                                                                                                                                                                                                                                                                                                                                                           |
| Internal User                 | This field displays the name of an internal user. If this field is filled in and the **Account**, **Consumer**, and **Requesting Service Organization** fields are empty, the customer for the case is an employee.  
  
  🔄 **Note:** This field is included with the Customer Service plugin (com.sn_customerservice).                                                                                                                                                                                                                                                                                                                                                           |

The Customer Service plugin adds two fields to the Notes section of the Case form for contributor users.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Contributor Users   | When a user with the case task agent role is assigned to a case task, the user is added to the **Contributor Users** field.  
  
  If a user is removed from the **Assigned to** field on the Case Task form, and they are not assigned to any other tasks for the case, they are also removed from the **Contributor Users** field.                                                                                                                                                                                                                                                                                                                                                           |
| Contributor Groups  | When a user with the case task agent role is assigned to a case task, the user's assignment group is added to the **Contributor Groups** field.  
  
  If a user is removed from the **Assigned to** field on the Case Task form, and no other member of their assignment group is assigned to any other tasks for the case, the assignment group is removed from the **Contributor Groups** field.                                                                                                                                                                                                                                              |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignment group</td>
<td>If a group is removed from the Assignment group field on the Case Task form, and the group is not assigned to any other tasks for the case, the assignment group is removed from the Contributor Groups field.</td>
</tr>
</tbody>
</table>

**Create Case for Customer record producer**

The contributor users feature adds a record producer that contributor users can access from the Customer and Consumer Service Portals and use to create cases. When creating a case, this record producer presents different options for the customer in the **Who are you creating this case for?** field, depending on the roles assigned to the logged-in user.

![Create Case for Customer record producer](image)

When the contributor user selects an option, additional fields related to that customer type are displayed.
<table>
<thead>
<tr>
<th>Customer option</th>
<th>Additional fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>• <strong>Reported by</strong>: the logged-in user with the account contributor role.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Account</strong>: the name of the account.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Contact</strong>: the contact for the account.</td>
</tr>
<tr>
<td>Consumer</td>
<td>• <strong>Reported by</strong>: the logged-in user with the consumer contributor role.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Consumer</strong>: the name of the consumer.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Household</strong>: the household that the consumer belongs to.</td>
</tr>
<tr>
<td>Business Location</td>
<td>• <strong>Reported by</strong>: the logged-in user with the service organization contributor role.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Requesting Business Location</strong>: the name of the service organization requesting assistance.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Requesting support from Business Location</strong>: the name of the service organization from which the Requesting Business Location is asking assistance.</td>
</tr>
<tr>
<td>Myself</td>
<td>• <strong>Reported By</strong>: the logged-in user with the self contributor role.</td>
</tr>
</tbody>
</table>

Additional fields on the record producer that are common to all customer options include **Priority, Channel, Subject**, and **Description**.

**Viewing record lists on the Customer and Consumer Service Portals**

The My Lists widget on the Customer and Consumer Service Portals includes different filters for viewing records.
My Lists widget on the Customer Service Portal

Depending on the roles assigned to the logged-in user, this widget displays the following filters.

<table>
<thead>
<tr>
<th>Contributor user</th>
<th>My Lists filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account contributor</td>
<td>• Cases for Accounts</td>
</tr>
<tr>
<td>Consumer contributor</td>
<td>• Cases for Consumers</td>
</tr>
</tbody>
</table>
| Service organization contributor        | • My Cases for Business Locations: cases created by the contributor user on behalf of their business locations.  
• All Cases for Business Locations: all cases created on behalf of the contributor's business locations, independent of who created the case. |
| Self contributor                        | • Cases for myself                                                                |
| Relationship contributor                | Displays filters depending on the relationships established for this user.        |
• My Cases for Accounts: cases created by the contributor user on behalf of accounts where the user is an Account Manager.  
• All Cases for Accounts: all cases created on behalf of accounts where the user is an Account Manager, independent of who created the case.
Access to case tasks

Users with the case task agent role can view and access case tasks in lists, on dashboards, and on landing pages.

Use widgets to display case tasks on dashboards and landing pages.

<table>
<thead>
<tr>
<th>Widget</th>
<th>Task information displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Case Tasks</td>
<td>This widget includes the following information for each case task:</td>
</tr>
<tr>
<td></td>
<td>• Task number</td>
</tr>
<tr>
<td></td>
<td>• Status</td>
</tr>
<tr>
<td></td>
<td>• Subject</td>
</tr>
<tr>
<td></td>
<td>• Priority</td>
</tr>
<tr>
<td></td>
<td>• Case number</td>
</tr>
<tr>
<td></td>
<td>• Case short description</td>
</tr>
<tr>
<td>My Group's Case Tasks</td>
<td>This widget includes the following information for each case task:</td>
</tr>
<tr>
<td></td>
<td>• Task number</td>
</tr>
<tr>
<td></td>
<td>• Status</td>
</tr>
<tr>
<td></td>
<td>• Subject</td>
</tr>
<tr>
<td></td>
<td>• Priority</td>
</tr>
<tr>
<td>Widget</td>
<td>Task Information displayed</td>
</tr>
<tr>
<td>--------</td>
<td>---------------------------</td>
</tr>
<tr>
<td></td>
<td>• Assigned to</td>
</tr>
<tr>
<td></td>
<td>• Case number</td>
</tr>
<tr>
<td></td>
<td>• Case short description</td>
</tr>
</tbody>
</table>

**Note:** If a playbook is available, the system opens the case task within in the playbook. If no playbook is available, the system opens the Case Task form.

Depending on assigned roles, contributor users can see different modules in CSM Agent Workspace and CSM Configurable Workspace.

<table>
<thead>
<tr>
<th>Role</th>
<th>Modules</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case task agent</td>
<td>Users with the case task agent role have access to these modules:</td>
</tr>
<tr>
<td>[sn_customerservice.case_task_agent]</td>
<td>• <strong>Case Task:</strong> includes the case tasks that the user has access to.</td>
</tr>
<tr>
<td></td>
<td>◦ My Case Tasks</td>
</tr>
<tr>
<td></td>
<td>◦ My Open</td>
</tr>
<tr>
<td></td>
<td>◦ Unassigned for my groups</td>
</tr>
<tr>
<td></td>
<td>◦ My Accessible Tasks</td>
</tr>
<tr>
<td></td>
<td>• <strong>Customers:</strong> Includes read-only access to customer information.</td>
</tr>
<tr>
<td></td>
<td>◦ Accounts</td>
</tr>
<tr>
<td></td>
<td>◦ Partners</td>
</tr>
<tr>
<td></td>
<td>◦ Contacts</td>
</tr>
<tr>
<td></td>
<td>◦ Consumers</td>
</tr>
<tr>
<td></td>
<td>◦ Households</td>
</tr>
<tr>
<td></td>
<td>◦ Household members</td>
</tr>
<tr>
<td>Case task viewer</td>
<td>Users with the case task viewer role have access to these modules:</td>
</tr>
<tr>
<td>[sn_customerservice.case_task_viewer]</td>
<td>• <strong>Case Task:</strong> Includes all case tasks.</td>
</tr>
<tr>
<td></td>
<td>◦ All</td>
</tr>
<tr>
<td>Role</td>
<td>Modules</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Case contributor viewer</td>
<td><strong>Users with the case contributor viewer role have access to these modules:</strong></td>
</tr>
<tr>
<td>[sn_customerservice.case_contributor_viewer]</td>
<td>• <strong>Case Task</strong>: Includes the case tasks that the user has access to.</td>
</tr>
<tr>
<td></td>
<td>◦ <strong>My Contributing Tasks</strong></td>
</tr>
<tr>
<td>Case viewer</td>
<td><strong>Users with the case viewer role have access to these modules:</strong></td>
</tr>
<tr>
<td>[sn_customerservice.case_viewer]</td>
<td>• <strong>Cases</strong>: Includes the cases that the user has access to.</td>
</tr>
</tbody>
</table>

**Case task agent access to customer information**

Users with the case task agent role have read-only access to some of the customer information for the parent case.

- For B2B cases: Account and contact records, including addresses, sold products, and install base.
- For B2C cases: Consumer and household records, including addresses, sold products, install base, and head of household.
- For business location cases: Service organization records, including internal contact information.

**Related reference**

Contributor user roles

**Related information**

Configure Contributor Users

**Contributor user roles**

The contributor user data model uses several roles that can be assigned to users to control access to cases, case tasks, and case-related information based on different business needs.

These roles are included with several different plugins:

- Customer Service (com.sn_customerservice)
- CSM Contributor User (com.snc.csm_contributor_user)
- Business Location (com.snc.business_location)
- CSM Base Extension Entities (com.snc.cs_base_extension)
See the following tables for detailed role descriptions.

**Roles included with the Customer Service plugin**

The following contributor roles are included with the Customer Service plugin (com.sn_customerservice).

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Case task agent [sn_customerservice.case_task_agent] | This role provides access to case tasks and related case information. A user with this role can work on the following case tasks:  
• Tasks that are assigned to the user or to the user’s assignment groups.  
• Tasks that have been created by the user.  
With this role, the user can:  
• View and update case tasks.  
  ◦ Add work notes, comments, and attachments.  
  ◦ Update the status.  
  ◦ Perform additional actions from a case task such as sending email.  
• Create case tasks and assign those task to other users.  
With this role, users have read-only access to | • sn_customerservice.csm_workspace_user  
• sn_customerservice.customer_data_viewer  
• sn_customerservice.case_contributor_editor |
<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>contains roles for the case:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Account and contact records (for B2B cases)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Consumer and household records (for B2C cases)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Service organization records (business location cases)</td>
<td></td>
</tr>
<tr>
<td>Case task viewer</td>
<td>This role provides read-only access to all case tasks.</td>
<td></td>
</tr>
<tr>
<td>[sn_customerservice.case_task_viewer]</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Note: When combined with the case viewer role (sn_customerservice.case_viewer), a user can access all customer service cases and all case tasks.</td>
<td></td>
</tr>
<tr>
<td>Case viewer</td>
<td>This role provides read-only access to all cases.</td>
<td></td>
</tr>
<tr>
<td>[sn_customerservice.case_viewer]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Case contributor editor</td>
<td>This role provides limited write access to some of the fields on the Case form if the user has read access to the case through another role. Limited write access is available for the following fields:</td>
<td></td>
</tr>
<tr>
<td>[sn_customerservice.case_contributor_editor]</td>
<td>• Work notes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Additional comments</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Attachments</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• State or stage changes</td>
<td></td>
</tr>
</tbody>
</table>
### Role Description

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Contributor users</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Contributor groups</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Watchlist</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Work notes list</td>
<td></td>
</tr>
</tbody>
</table>
| Case contributor viewer [sn_customerservice.case_contributor_viewer] | This role provides read access to all of the tables associated with a case if the user has read access to the case through another role. With this role, a user can access the following modules in CSM Agent Workspace:  
  • All tasks I participate in | • sn_shn.user  
  • wm_read |

### Roles included with the CSM Contributor User plugin

The following contributor roles are included with the CSM Contributor User plugin (com.snc.csm_contributor_user).

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account contributor</td>
<td>This role enables users to create cases for any account.</td>
<td>• sn_customerservice.case_contributor_creator</td>
</tr>
<tr>
<td>Consumer contributor</td>
<td>This role enables users to create cases for any consumer.</td>
<td>• sn_customerservice.case_contributor_creator</td>
</tr>
<tr>
<td>Self contributor</td>
<td>This role enables users to create cases for themselves.</td>
<td>• sn_customerservice.case_contributor_creator</td>
</tr>
</tbody>
</table>
| Case contributor creator | This role enables users to create cases and is included in the top-level contributor roles.                                                                                                              | • sn_customerservice.account_contributor  
  • sn_customerservice.consumer_contributor  
  • sn_customerservice.self_contributor |
### Roles included with the Business Location plugin

The following contributor roles are included with the Business Location plugin (com.snc.business_location).

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service organization contributor</td>
<td>[sn_customerservice.service_organization_contributor]</td>
<td>• sn_customerservice.case_contributor_creator</td>
</tr>
<tr>
<td></td>
<td>This role enables users to create cases for their service organization</td>
<td></td>
</tr>
<tr>
<td></td>
<td>(business location).</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> A service organization contributor must be a member of a service</td>
<td></td>
</tr>
<tr>
<td></td>
<td>organization in order to create cases on its behalf.</td>
<td></td>
</tr>
</tbody>
</table>

### Roles included with the CS Base Extension Entities plugin

The following contributor roles are included with the CSM Base Extension Entities plugin (com.snc.cs_base_extension).

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relationship contributor</td>
<td>[sn_customerservice.relationship_contributor]</td>
<td>• sn_customerservice.case_contributor_creator</td>
</tr>
<tr>
<td></td>
<td>This role enables users to create cases for customers with which they</td>
<td></td>
</tr>
<tr>
<td></td>
<td>have an established relationship.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> A relationship contributor must be a member of an account, contact,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>or household team in order to create cases on their behalf.</td>
<td></td>
</tr>
</tbody>
</table>
## Additional roles

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case data viewer</td>
<td>This role provides read access to customer data, including account, consumer, and household data, and the information included in the related lists.</td>
<td></td>
</tr>
<tr>
<td>[sn_customerservice.case_data_viewer]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Workspace user</td>
<td>This role provides access to case tasks from the following modules in the CSM workspaces:</td>
<td>• agent_workspace_user&lt;br&gt;• canvas_user&lt;br&gt;• sn_templated_snip.template_snippet_reader&lt;br&gt;• email_composer</td>
</tr>
<tr>
<td>[sn_customerservice.csm_workspace_user]</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Users can also:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Use Agent Assist to search for knowledge articles (if the User Criteria is set to provide access to knowledge).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Create email (if the user has write access to the record and the email_composer role).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• View response templates (if response templates have been configured for the record).</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>By default, this role is added to the case task agent role ([sn_customerservice.case_task_agent]).</td>
<td></td>
</tr>
</tbody>
</table>
Business Stakeholder for Customer Service Management

Business Stakeholder for Customer Service Management includes plugins and roles that provide access to business stakeholder features.

Customers who have purchased the Customer Service Management Subscription product may provide Business Stakeholder users with the rights to the following actions:

- Create cases on behalf of a customer or a service organization.
- View cases, case tasks, and customer data.
- View and drill through reports.
- Approve requests.

Roles for business stakeholder users

You can assign the following roles to any user who is a business stakeholder.

Create cases on behalf of customers

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Contains roles</th>
<th>Plugin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account contributor [sn_customerservice.account_contributor]</td>
<td>This role enables users to create cases for any account.</td>
<td>sn_customerservice.case_contributor_creator</td>
<td>CSM Contributor User (com.snc.csm_contributor_user)</td>
</tr>
<tr>
<td>Consumer contributor [sn_customerservice.consumer_contributor]</td>
<td>This role enables users to create cases for any consumer.</td>
<td>sn_customerservice.case_contributor_creator</td>
<td>CSM Contributor User (com.snc.csm_contributor_user)</td>
</tr>
<tr>
<td>Relationship contributor [sn_customerservice.relationship_contributor]</td>
<td>This role enables users to create cases for those customers with which they have an established relationship.</td>
<td>sn_customerservice.case_contributor_creator</td>
<td>CSM Base Extension Entities (com.snc.cs_base_extension)</td>
</tr>
</tbody>
</table>
### Create cases as proxy contact

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Plugin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Proxy contact</td>
<td>This role enables employees to create cases for customer accounts and contacts.</td>
<td>CSM Extension for Proxy Contacts (com.snc.csm_proxy_contacts)</td>
</tr>
</tbody>
</table>

For more information about the proxy contact role, see Create cases as a proxy contact.

### Create cases on behalf of service organizations

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Contains roles</th>
<th>Plugin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service organization contributor</td>
<td>This role enables users to create cases for their business location.</td>
<td>sn_customerservice.case_contributor_creator (com.snc.business_location)</td>
<td></td>
</tr>
</tbody>
</table>

### View cases, case tasks, and customer data

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case viewer</td>
<td>This role provides read-only access to all cases.</td>
</tr>
<tr>
<td>Case task viewer</td>
<td>This role provides read-only access to all case tasks. <strong>Note:</strong> When combined with the case viewer role (sn_customerservice.case_viewer), a user can access all customer service cases and all case tasks.</td>
</tr>
<tr>
<td>Customer data viewer</td>
<td>This role provides read access to customer data, including account, consumer, and household data, and the information included in the related lists.</td>
</tr>
</tbody>
</table>
View and drill into reports and dashboards

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance Analytics viewer</td>
<td>This role can:</td>
</tr>
<tr>
<td>[pa_viewer]</td>
<td>• View Analytics Hub.</td>
</tr>
<tr>
<td></td>
<td>• Create thresholds and targets for indicators.</td>
</tr>
<tr>
<td></td>
<td>• Read, update, and delete thresholds and targets that they created.</td>
</tr>
<tr>
<td></td>
<td>• View text analytics widgets on dashboards.</td>
</tr>
</tbody>
</table>

Related information

- Business stakeholder role for PPM
- Business stakeholder role for APM
- Installed with Business Stakeholder

Internal user data

Internal user data includes information about the users who are internal to your organization, such as managers, agents, and other employees. Internal users can also belong to user groups.

A user is an individual who can access your instance and a group is a set of users who share a common purpose. The users associated with a group are listed as group members.

User roles provide access to customer service features, capabilities, and data. The following user roles are available in the Customer Service Management application for internal users:

- Customer service agent [sn_customerservice_agent]
- Consumer service agent [sn_customerservice.consumer_agent]
- Customer service manager [sn_customerservice_manager]

For detailed descriptions about user roles, see Roles installed with Customer Service Management.

Customer data

Customer data includes information about customers who are external to your organization, including accounts, contacts, and consumers.
Accounts

An account is a supported external customer and a contact is a user who is an employee of an account. There are two types of accounts: customer accounts and partner accounts.

- A partner is a supported external customer that sells to and supports other customers. A partner can report and manage cases on behalf of customers. A partner can also be a customer.
- An account can be a customer account, a partner account, or both. The **Customer** and **Partner** fields on the Account form denote the account type.

Contacts

A contact is an employee of an account. An account can have multiple contacts but a contact can be associated with only one account. A contact can have one or more associated assets and service contracts. A contact can also have a user ID and can log in to the Customer Service Portal.

Consumers

A consumer is a customer in the business-to-consumer (B2C) business model.

Product data

Product data includes information about the products and services that you provide to your customers. Product data can include products and product models, assets, sold products, installed products, and install base items.

Product models

A product is a type of good or service that your company sells and supports. Product models identify different types of products, such as service, hardware, software, or consumables.

Assets

An asset is a specific product or instance that is supported for a customer. Assets can have serial numbers or asset tag numbers and can be allocated to individual accounts or to a contact within an account. Assets can also have associated support contracts.

Sold products

The products and components that have been sold to an account or a consumer.

Install base items
Items that represent the instances that have been installed or provisioned for a customer.

**Installed products**

Provide information on the sold products and how they are deployed or installed. Use installed products to create an association between sold products and install base items.

**Case management for Customer Service Management**

Use a variety of features available with Customer Service Management to manage cases for your customers.

**Playbooks for Customer Service Management**

Playbooks provide step-by-step guidance for resolving specific types of customer service cases, including onboarding, complaint, and product support cases.

Playbooks enable agents to easily manage the lifecycle of cases by guiding them through sequences of tasks. The workflows that are associated with a specific type of case and the activities that need to be completed to resolve cases of this type are detailed in the playbook. Playbooks also help users to visualize the entire lifecycle of a workflow.

Several applications are available that enable you to create and use playbooks with Customer Service Management. See Playbook plugins below for detailed plugin and dependency information.

### Customer Service Management playbook applications

<table>
<thead>
<tr>
<th>Application</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Playbooks for Customer Service Management</td>
<td>Use this application to create playbooks based on your individual business needs. Create playbooks that support case types or the base customer service case.</td>
</tr>
<tr>
<td>Case Playbook for Onboarding</td>
<td>Use this application to manage the process for taking on new customers or enrolling customers in new products.</td>
</tr>
<tr>
<td>Case Playbook for Complaints</td>
<td>Use this application to manage the process for handling customer complaints.</td>
</tr>
</tbody>
</table>
Customer Service Management playbook applications (continued)

<table>
<thead>
<tr>
<th>Application</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case Playbook for Product Support</td>
<td>Use this application to guide agents through the steps that are needed to resolve product issues.</td>
</tr>
</tbody>
</table>

Case Playbook for Onboarding in CSM Configurable Workspace

Playbook overview

A playbook visualizes a workflow in a simple, task-oriented view. The workflow for a playbook is typically created using Process Automation Designer.

A playbook takes a workflow and breaks it into multiple stages or lanes. Each stage in a playbook includes one or more activities, or steps, for an agent to complete. Stages can also include automated activities, such as sending an email to a customer when a stage or activity is complete. When using a playbook, agents can:

- View the playbook stages and activities.
- Select an activity and perform the work necessary to complete that activity.
- Mark an activity as complete and move to the next activity or stage.
- Complete the stages and activities necessary to resolve the case.

Playbook capabilities introduced in the Rome release enable agents to quickly resolve customer issues. These capabilities work together to provide agents with
a better overall experience when using playbooks to resolve customer issues. See the following table for details.

### Playbook capabilities introduced in the Rome release

<table>
<thead>
<tr>
<th>Capability</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use a playbook for an entire workflow starting with new record creation</td>
<td>Customer service agents can create a record using a playbook instead of a record form. Creating a record opens the playbook and initiates the first activity. The agent can complete this activity while creating the record. For example, an agent can create a case and gather the necessary information about the customer and the issue as the first activity in the playbook. For more information about configuring this feature, see <a href="https://workspace.playbooksetup.com/">Playbook record generator</a> in the Workspace Playbook setup documentation.</td>
</tr>
</tbody>
</table>
| See the entire lifecycle of a workflow, including the current stage and activity | The playbook lifecycle and the Focused activity view enable agents to see:  
  - The end-to-end lifecycle of a workflow.  
  - The current stage and activity within the lifecycle, including progress indicators and prioritized activities.  
  - Details of the current activity displayed in the playbook work area.  
  For more information about configuring the playbook activity view, see [Select a Playbook activity view](https://workspace.playbooksetup.com/). |
| Use the contextual side panel to view additional information | Playbooks can display the following information in the contextual side panel: |
Playbook capabilities introduced in the Rome release (continued)

<table>
<thead>
<tr>
<th>Capability</th>
<th>Description</th>
</tr>
</thead>
</table>
| • Activity stream  
• Ribbon information such as the case overview, customer details, timeline, and SLAs  
• Dynamic related records (see below for more information) | |

**Note:** The activity stream and ribbon information are available in CSM Configurable Workspace only.

For more information, see:

• Using the activity stream in the contextual side panel  
• Viewing ribbon information in the contextual side panel  
• Viewing related records in the contextual side panel

---

| Use the contextual side panel to display dynamic related records | Use this feature to display records in the contextual side panel that dynamically change based on the context of the current record or playbook activity.  
For more information, see Dynamic related records.  
**Note:** The dynamic related records feature is available in CSM Configurable Workspace only. |
| --- | --- |

---

<table>
<thead>
<tr>
<th>Use a playbook in compact mode</th>
<th>Compact mode moves the playbook from a tab in the Workspace to the contextual side panel. Agents can complete playbook activities in the side panel while viewing other tabs in the record page.</th>
</tr>
</thead>
</table>
### Playbook capabilities introduced in the Rome release (continued)

<table>
<thead>
<tr>
<th>Capability</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>For more information about configuring this feature, see <a href="#">Integrate Playbook with Workspace</a>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Compact mode is available in CSM Configurable Workspace only.</td>
</tr>
<tr>
<td>View the SLA widget on playbook activity cards</td>
<td>Activity cards in the playbook work area can display an SLA widget in the upper right corner. The widget appears on the activity card when the playbook activity has an SLA. This includes activities in the following stages:</td>
</tr>
<tr>
<td></td>
<td>- Triage</td>
</tr>
<tr>
<td></td>
<td>- Research</td>
</tr>
<tr>
<td></td>
<td>- Respond</td>
</tr>
<tr>
<td></td>
<td>The color of the widget indicates the time remaining for the SLA:</td>
</tr>
<tr>
<td></td>
<td>- Green: 0–50%</td>
</tr>
<tr>
<td></td>
<td>- Yellow: 50–75%</td>
</tr>
<tr>
<td></td>
<td>- Orange: 75–99%</td>
</tr>
<tr>
<td></td>
<td>- Red: 100% or breached</td>
</tr>
</tbody>
</table>

### Playbook plugins

The Playbooks for Customer Service Management plugin (sn_csm_playbook) is available from the ServiceNow Store starting with the Rome release. Use this application to create new playbooks or customize existing playbooks.

The Playbooks for Customer Service Management plugin requires the following plugins:

- Customer Service (com.sn_customerservice)
- Dynamic Related Records (com.snc.uib.sn_dyn_rel_rec)
- Playbook Experience (com.playbook_experience)
The following playbooks are available for use with Customer Service Management from the ServiceNow store:

- Case Playbook for Onboarding
- Case Playbook for Complaints
- Case Playbook for Product Support (com.sn_csm_product_caseflow)

These playbooks require the following plugins:

- Playbooks for Customer Service Management (com.sn_csm_playbook)
- Customer Service Case Types (com.snc.csm_case_types)

Install any ServiceNow Store applications by requesting them from the ServiceNow Store. Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

### Configuring playbooks

Playbook experiences are used to customize the look and feel of a playbook. Settings in a playbook experience control how UI Builder renders a playbook in CSM Configurable Workspace. System administrators can configure settings in the playbook experience record that determine the playbook stage and activity visibility.

Within UI Builder, system administrators can configure playbook component settings such as:

- Selecting a playbook experience
- Selecting an activity view
- Enabling compact mode

For more information, see Configuring playbooks for Customer Service Management.

### Using playbooks

Use the following playbooks, available for Customer Service Management from the ServiceNow Store, to work on and resolve different types of cases.

**Case Playbook for Onboarding**

Use the Case Playbook for Onboarding to manage the process for taking on new customers or enrolling customers for new products. An onboarding case captures the details of the new customer, including their selection of products and services. The onboarding
A playbook provides an end-to-end lifecycle for the tasks performed during the onboarding process and serves as the channel of communication with the customer.

Case Playbook for Complaints

Use the Case Playbook for Complaints to manage the process for handling customer complaints. A complaint case captures the details of the problem reported by the customer and the expected resolution. The complaint playbook provides an end-to-end lifecycle for the tasks performed during the complaint handling process, from the time a complaint is logged to the final resolution, and serves as the channel of communication with the customer.

Case Playbook for Product Support

Use the Case Playbook for Product Support to guide customer service agents through the steps that are needed to resolve product issues. A product support case captures information about the customer, the product, and the reported issue. The product support playbook provides an end-to-end lifecycle for the tasks needed to research and resolve the product issue and also serves as a channel of communication with the customer.

For more information, see Install a ServiceNow Store application.

Related information
- Set up a custom Playbook user experience
- Interact with Playbook
- Configure Playbooks for Customer Service Management
- Using Playbooks for Customer Service Management

Playbook layout and activity view

A playbook is made up of several areas, including the playbook lifecycle, the playbook work area, and the contextual side panel. The activity view determines how the stages and activities appear in the playbook.

Playbook layout

For case types that are configured to use a playbook, the playbook appears in the Playbook tab for a case record in CSM Configurable Workspace and CSM Agent Workspace.

Note: In CSM Configurable Workspace, the system administrator can also configure the playbook to use compact mode, which moves the playbook to the contextual side panel.
## Playbook layout with focused activity view

### Playbook area

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Playbook header</strong></td>
</tr>
</tbody>
</table>
| • Appears at the top of the playbook lifecycle.  
  • Shows the title of the playbook.  
  • Includes a filter that you can use to filter activities by the assigned user or the activity status.  
  • Includes the Playbook Actions menu that you can use to select playbook-level and activity-level actions. |
| **Playbook lifecycle** |
| • Appears in a panel on the left side of the playbook.  
  • Displays either the playbook stages or the stages and activities, depending on the configured activity view (Focused or Stacked).  
  • Can be collapsed to increase the size of the playbook work area. |
<table>
<thead>
<tr>
<th>Playbook area</th>
<th>Description</th>
</tr>
</thead>
</table>
| Playbook work area    | • Appears in the middle of the playbook.  
• Displays either a list of activities for a stage or the card for the current activity, depending on the configured activity view. |
| Contextual side panel | • Appears on the right side of the playbook.  
• Includes tabs that the agent can use to display different information, such as:  
  ◦ Case or case task activity stream  
  ◦ Ribbon information such as the case overview, customer details, timeline, and SLAs  
  ◦ Dynamic related records |

**Playbook activity view**  
The activity view determines how the stages and activities are displayed in the playbook.  

- **Focused**: Displays the stages and activities in the playbook lifecycle panel and the current activity in the playbook work area.  
- **Stacked**: Displays the stages in the playbook lifecycle panel and cards for each of the activities in the current stage in the playbook work area.
The system administrator can configure the playbook activity view in UI Builder. For more information, see Select a playbook activity view.

**Playbook lifecycle**

The playbook lifecycle displays either the stages or the stages and activities included in the playbook, depending on the configured activity view. Use the playbook lifecycle to gain an overview of the work to be completed for a given type of case.

The playbook lifecycle provides context as to where an agent is within the playbook, including information for each stage and activity and any dependencies between stages. For stages with multiple activities, the playbook lifecycle provides step-by-step guidance for completing the stage. Administrators can configure the visibility of activities within the lifecycle.

![Playbook lifecycle using the Focused activity view](image)
The stages and activities in a playbook lifecycle are configured using Process Automation Designer (PAD). Each playbook stage is mapped to a PAD lane and each playbook activity is mapped to a PAD activity. For more information, see Process Automation Designer lanes and activities.

**Playbook stages**
Playbook stages contain one or more activities. For playbooks using the Focused activity view, each playbook stage includes the following elements:

- An icon or progress indicator that shows if the stage is complete, in process, or pending.
- Chevrons for expanding and collapsing the stage.
- A header that includes the stage name.
- A sub-header that shows the stage status:
  - For completed stages, the sub-header shows **Complete**.
  - For the current stage, the sub-header includes counters that show the number of activities remaining and the number of prioritized activities.

When an agent opens a record and accesses a playbook, the current stage is expanded by default and the current activity is highlighted.

**Playbook activities**
For playbooks using the Focused activity view, stages in the playbook lifecycle can be expanded and collapsed. In an expanded stage, agents can see:

- The activities in the stage.
- Icons and progress indicators that show if an activity is complete, in process, or pending.
- Indicators that denote prioritized activities.

**Playbook actions**
The Playbook Actions menu in the playbook header includes actions that agents can perform at the playbook level and the activity level. Click the Playbook Actions icon (‡) to access this menu.

The Playbook Actions menu includes the following playbook-level actions:

- **Expand All Stages**: Expands all of the stages in the playbook.
- **Collapse All Stages**: Collapses all of the stages in the playbook.
- **Request Info**: Displays a pop-up window that the agent can use to communicate with the customer and request information about a case or case task. This action also saves the details to the case or case task activity.
stream. Using this action changes the state of the case or case task to Awaiting Info and pauses the SLAs and any timers.

- **Info Received**: Returns the case or case task to the previous state and restarts the SLAs and any timers.

> **Note**: The Request Info action can be configured to appear on case task activity cards.

Activity-level actions can vary depending on the type of activity and in which stage it appears. For example, actions are available to accept cases, create related cases, create case tasks, and propose solutions.

**Navigating playbook stages and activities**

Agents can use the playbook lifecycle to navigate between stages and activities as assigned roles or activity security configurations permit. For example, activities such as case tasks can be assigned to different users. A user with the case task agent role can only see the case tasks that are assigned to them.

When an agent opens a playbook, it opens to the current stage and highlights the current activity. For stages with multiple activities, the current activity is the first available activity. An available activity is an activity that has a state other than Complete.

When an agent clicks an available activity, it becomes the current activity. An agent can navigate stages and activities in any order as long as there is at least one available activity to select. Agents can navigate between stages and activities that are marked as:

- Complete
- Open
- Pending (when the visibility of pending stages and activities is enabled)

> **Note**: The playbook configuration determines the visibility and accessibility of pending stages and activities. For more information, see Configure playbook stage and activity visibility.

**Using keyboard navigation in a playbook**

Use the following keyboard keys to navigate playbook stages and activities.

- **Tab key**: Use the Tab key to initiate navigation and move between stages, activities, and the playbook work area.
- **Arrow keys**: Use the left, right, up, and down arrow keys to navigate the fields on a playbook activity card.
- **Enter key**: Use the Enter key to select buttons on a playbook activity card.
Filtering playbook activities
Agents can filter playbook activities and see those activities that match the filter conditions in the expanded stages.

• To filter playbook activities, click the filter icon (✓) at the top of the playbook and select one or more of the following:
  ◦ The assigned user
  ◦ The activity state
• To clear the filter, click the filter icon again and remove the selections.

Collapsing the playbook lifecycle panel
Collapse and expand the lifecycle panel in CSM Configurable Workspace by using the left and right chevrons on the panel divider. Collapsing the navigation panel provides agents with more space for content in the playbook work area.

Configuring stage and activity visibility
Users with the system administrator role can configure the visibility of playbook stages and activities, including:
• Showing or hiding stages and activities that are pending.
• Showing or hiding stages and activities where a user does not have access.

The system administrator configures these settings in the Playbook Experience record. For more information, see Configure playbook stage and activity visibility.

Case Playbook for Onboarding
Use the Case Playbook for Onboarding to manage the process for taking on new customers or enrolling customers for new products.

An onboarding case manages the process for taking on new customers or enrolling customers for new products. The onboarding playbook provides the activities and tasks that agents can perform during the onboarding process. Agents can also create and assign tasks as needed and use the playbook to communicate with the customer.

The Case Playbook for Onboarding can be used with cases that are created using the onboarding case type. This playbook is available for both CSM Configurable Workspace and CSM Agent Workspace. In the CSM Workspaces, the playbook appears in the Playbook tab on the case record.
Note: System administrators can configure a playbook to use compact mode in CSM Configurable Workspace. Compact mode moves the playbook from a tab in the Workspace to a tab in the contextual side panel.

Case Playbook for Onboarding application

The Case Playbook for Onboarding 3.0 application (com.sn_csm_onboarding_caseflow) is available from the ServiceNow store. For more information, see Playbook plugins.

Case Playbook for Onboarding PAD process definition

The Case Playbook for Onboarding 3.0 includes a new Process Automation Designer (PAD) process definition: onboarding_playbook_v1. This process definition contains optimized stages and activities for the onboarding playbook.

Process definitions are stored in the Process Definitions table (sys_pd_process_definition). To view a list of processes:

1. Enter `sys_pd_process_definition.list` in the application navigator.
2. Configure the list to show the Name field.

Only one PAD process per playbook should be active at a time. For more information, see Process definitions.

Case Playbook for Onboarding features

The Case Playbook for Onboarding 3.0 includes the following features and enhancements.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create an onboarding case using the Case Playbook for Onboarding</td>
<td>Creating an onboarding case opens the onboarding playbook and initiates the first activity in the Initiate stage: Gather customer information. The agent can complete and save this activity to create the record. For more information, see Create a record using a playbook.</td>
</tr>
<tr>
<td>Focused activity view</td>
<td>The activity view determines how the stages and activities appear in the playbook.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>The Case Playbook for Onboarding uses the Focused activity view, which enables agents to see:</td>
</tr>
<tr>
<td></td>
<td>• The end-to-end lifecycle of the onboarding workflow in the playbook lifecycle panel.</td>
</tr>
<tr>
<td></td>
<td>• The current stage expanded and the current activity highlighted within the playbook lifecycle panel.</td>
</tr>
<tr>
<td></td>
<td>• Details of the current activity displayed in the playbook work area.</td>
</tr>
<tr>
<td>Contextual side panel</td>
<td>The Case Playbook for Onboarding displays the following information in the contextual side panel:</td>
</tr>
<tr>
<td></td>
<td>• Activity stream</td>
</tr>
<tr>
<td></td>
<td>• Ribbon information such as the case overview, customer details, timeline, and SLAs</td>
</tr>
<tr>
<td></td>
<td>• Dynamic related records (see below for more information)</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The activity stream and ribbon information are available in CSM Configurable Workspace only.</td>
</tr>
<tr>
<td></td>
<td>For more information about using the contextual side panel, see:</td>
</tr>
<tr>
<td></td>
<td>• Using activity stream in the contextual side panel</td>
</tr>
<tr>
<td></td>
<td>• Viewing the ribbon information in the contextual side panel</td>
</tr>
<tr>
<td></td>
<td>• Viewing dynamic related records in the contextual side panel</td>
</tr>
<tr>
<td>Activity visibility</td>
<td>The Case Playbook for Onboarding uses the following settings to control activity visibility:</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
|                               | • Hide the activities in a stage that the logged-in user cannot access.  
• Hide the pending activities in a stage.                                                                                                      |
<p>|                               | For more information about configuring this feature, see <a href="#">Configure playbook stage and activity visibility</a>.                                                          |
| Compact mode                  | Compact mode moves the playbook from a tab in the Workspace to the contextual side panel. Agents can complete playbook activities in the side panel while viewing other tabs in the record page. |
|                               | <strong>Note:</strong> Compact mode is available in CSM Configurable Workspace only.                                                                        |
|                               | Users with the system administrator role can configure a playbook to use compact mode in the playbook component configuration in UI Builder. For more information about configuring this feature, see <a href="#">Integrate Playbook with Workspace</a>. |
| Dynamic related records       | Display records in the contextual side panel that dynamically change based on the context of the current record or playbook activity.            |
|                               | From the Related Records tab in the contextual side panel, agents can:                                                                         |
|                               | • Filter the list of related records                                                                                                          |
|                               | • Open the list in a new tab                                                                                                                  |
|                               | • Create new records                                                                                                                           |</p>
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
</table>
| SLA widget       | Activity cards in the playbook work area can display an SLA widget in the upper right corner. The widget appears on the activity card when the playbook activity has an SLA. This includes activities in the following stages:  
• Pre-approval (duration is 3 days)  
• Data capture (duration is 5 days)  
• Due diligence (duration is 15 days)  
• Resolution (duration is 20 days)  
The color of the widget indicates the time remaining for the SLA:  
• Green: 0–50%  
• Yellow: 50–75%  
• Orange: 75–99%  
• Red: 100% or breached |

**Using the playbook lifecycle to navigate stages and activities**

The playbook lifecycle enables agents to see the entire lifecycle of the complaint workflow. To navigate the playbook stages and activities:

• Expand and collapse stages to show or hide activities.

• Use the filter in the playbook header to filter activities by the assigned user or the activity state.

• Click an activity to display the details in the playbook work area.

• Collapse the playbook lifecycle panel to create more screen space.
Using the Playbook Actions menu

The Playbook Actions menu in the playbook header includes actions that agents can perform at the playbook and activity levels. Click the Playbook Actions icon (📷) to access this menu.

The Playbook Actions menu includes the following playbook-level actions:

- **Expand All Stages**: Expands all of the stages in the playbook.
- **Collapse All Stages**: Collapses all of the stages in the playbook.
- **Request Info**: Displays a pop-up window that the agent can use to communicate with the customer and request information about a case or case task. This action also saves the details to the case or case task activity stream. Using this action changes the state of the case or case task to Awaiting Info and pauses the SLAs and any timers.
- **Info Received**: Returns the case or case task to the previous state and restarts the SLAs and any timers.

**Note:** The Request Info and Info Received actions can also be configured to appear on case task activity cards.

Activity-level actions can vary depending on the type of activity and in which stage it appears. For example, actions are available to accept cases, create related cases, create case tasks, and propose solutions.

**Onboarding playbook stages and activities**

The Case Playbook for Onboarding includes the following stages and activities that agents can use to onboard new customers or products.

<table>
<thead>
<tr>
<th>Stage</th>
<th>Activity</th>
<th>Activity Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Initiate</em></td>
<td>Collect customer information</td>
<td>When an agent creates an onboarding case, the workspace opens the Create New Onboarding Case form, launches the onboarding playbook, and uses the first activity to gather customer information. Enter information about the channel, the account and contact or the consumer, and the product. Agent actions:</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Stage</th>
<th>Activity</th>
<th>Activity Details</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td><strong>Continue</strong>: This action creates the onboarding case and adds the case number to the record tab. It also marks the first activity as complete and moves to the second activity.</td>
</tr>
<tr>
<td></td>
<td>Add additional members</td>
<td>Agents can use this activity to add additional members to the onboarding case.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1. Click <strong>Add new</strong> to open the Create New Related Party form in a new tab.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. In the <strong>Type</strong> field, select the related party with the correct entity type, such as a beneficiary who is a customer contact.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Select the <strong>User</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. Click <strong>Save</strong> to add the user to the Member Information list on the activity card.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Agent actions:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Assign to me</strong>: Available if the case is not yet assigned. Assigns the case to the logged-in user.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Add new</strong>: Add a user to the Member Information list (see steps above).</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Send for Pre Approval</strong>: Completes the Initiate stage and moves to the Pre-approval stage.</td>
</tr>
<tr>
<td></td>
<td>Notify customer</td>
<td>This activity displays the details of the email that was automatically sent to the customer at the completion of the Initiate stage.</td>
</tr>
<tr>
<td>Pre approval</td>
<td>Check approval status</td>
<td>This activity includes a list of approvals and approvers.</td>
</tr>
<tr>
<td>Stage</td>
<td>Activity</td>
<td>Activity Details</td>
</tr>
<tr>
<td>-------</td>
<td>----------</td>
<td>------------------</td>
</tr>
<tr>
<td></td>
<td>Automates the pre-approval process for the customer.</td>
<td><strong>Note:</strong> This activity shows the list of approvals if an approval workflow is manually configured for an onboarding case. The approval workflow configuration is not provided out of box. If no approval workflow is configured, this activity completes automatically.</td>
</tr>
</tbody>
</table>
|       | Update customer information | Agents can use this activity to verify the account and contact or consumer information for the onboarding case. Agent actions:  
  - **Save:** Saves any changes made to the customer information. |
|       | Complete pre approval | Agents can use this activity to provide additional information and add notes or attachments. Agent actions:  
  - **Request info:** Request additional information from the customer. This action changes the state of the case task to Awaiting Info.  
  - **Post:** Posts the comment or the work note to the case task record activity stream.  
  - **Initiate Data Capture:** Marks the activity and the Pre approval stage as complete. |
|       | Notify customer | This activity displays the details of the email that was automatically sent to the customer at the completion of the Pre approval stage. |
|       | Data capture  
  Organizes the collection | Verify document checklist | This activity displays a document checklist. Agents can check off the necessary documents and provide comments or work notes. |
<table>
<thead>
<tr>
<th>Stage</th>
<th>Activity</th>
<th>Activity Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>of customer information.</td>
<td></td>
<td>✉️ <strong>Note:</strong> If the customer type changes after the case is created, a new checklist of the appropriate type replaces the original checklist.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Agent actions:</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Request info:</strong> Request additional information from the customer. This action changes the state of the case task to Awaiting Info.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Post:</strong> Posts the comment or the work note to the case task record activity stream.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Submit for Review:</strong> Marks the activity and the Data capture stage as complete.</td>
</tr>
<tr>
<td>Notify customer</td>
<td></td>
<td>This activity displays the details of the email that was automatically sent to the customer at the completion of the Data capture stage.</td>
</tr>
<tr>
<td>Due diligence</td>
<td>Perform background check</td>
<td>Agents can use this activity to perform background checks on the customer.</td>
</tr>
<tr>
<td>Displays case tasks for completing due diligence.</td>
<td></td>
<td><strong>Agent actions:</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Request info:</strong> Request additional information from the customer. This action changes the state of the case task to Awaiting Info.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Post:</strong> Posts the comment or the work note to the case task record activity stream.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Review Complete:</strong> Marks the activity as complete.</td>
</tr>
<tr>
<td>Initiate legal verification</td>
<td></td>
<td>Agents can use this activity to initiate the legal verification process for a customer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Agent actions:</strong></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Stage</th>
<th>Activity</th>
<th>Activity Details</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>• <strong>Request info</strong>: Request additional information from the customer. This action changes the state of the case task to Awaiting Info.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Post</strong>: Posts the comment or the work note to the case task record activity stream.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Review Complete</strong>: Marks the activity as complete.</td>
</tr>
<tr>
<td>Review</td>
<td>Request credit history</td>
<td>Agents can use this activity to review a customer's credit history.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Agent actions:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Request info</strong>: Request additional information from the customer. This action changes the state of the case task to Awaiting Info.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Post</strong>: Posts the comment or the work note to the case task record activity stream.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Review Complete</strong>: Marks the activity and the Due Diligence stage as complete.</td>
</tr>
<tr>
<td>Notify</td>
<td>Notify customer</td>
<td>This activity displays the details of the email that was automatically sent to the customer at the completion of the Due Diligence stage.</td>
</tr>
<tr>
<td>Resolve</td>
<td>Propose resolution</td>
<td>This activity shows the fields from the Resolution Notes section on the Case form. Add the resolution details and click <strong>Propose solution</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the customer rejects the resolution, the agent can return to the Resolve stage and propose another solution.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Agent actions:</td>
</tr>
</tbody>
</table>
### Stage Details

<table>
<thead>
<tr>
<th>Stage</th>
<th>Activity</th>
<th>Activity Details</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Propose solution</td>
<td>Proposes the solution to the customer and marks the Resolve stage as complete.</td>
</tr>
<tr>
<td></td>
<td>Change solution</td>
<td>This action appears after the agent proposes a solution.</td>
</tr>
<tr>
<td>Close</td>
<td>Notify customer</td>
<td>This activity displays the details of the email that was automatically sent to the customer at the completion of the Resolve stage.</td>
</tr>
<tr>
<td></td>
<td>Close case</td>
<td>When the customer accepts the resolution, the Resolve stage completes and the Close stage is also marked as complete.</td>
</tr>
</tbody>
</table>

### Case Playbook for Complaints

Use the Case Playbook for Complaints to guide agents through the steps that are needed to resolve customer complaints.

A complaint case captures information about the customer, the product, and details about the customer’s complaint. The complaint playbook provides the activities and tasks that agents can perform to research and resolve the complaint. Agents can also create and assign tasks as needed and use the playbook to communicate with the customer.

The Case Playbook for Complaints can be used with cases that are created using the complaint case type. This playbook is available for both CSM Configurable Workspace and CSM Agent Workspace. In the CSM Workspaces, the playbook appears in the Playbook tab on the case record.

**Note:** System administrators can configure a playbook to use compact mode in CSM Configurable Workspace. Compact mode moves the playbook from a tab in the Workspace to a tab in the contextual side panel.
Case Playbook for Complaints application

The Case Playbook for Complaints 3.0 application (com.sn_csm_complaint_caseflow) is available from the ServiceNow store. For more information, see Playbook plugins.

Case Playbook for Complaints PAD process definition

The Case Playbook for Complaints 3.0 includes a new Process Automation Designer (PAD) process definition: `complaint_playbook_v1`. This process definition contains optimized stages and activities for the complaint playbook.

Process definitions are stored in the Process Definitions table (sys_pd_process_definition). To view a list of processes:

1. Enter `sys_pd_process_definition.list` in the application navigator.
2. Configure the list to show the Name field.

Only one PAD process per playbook should be active at a time. For more information, see Process definitions.

Case Playbook for Complaints features

The Case Playbook for Complaints 3.0 includes the following features and enhancements.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a complaint case using the Case Playbook for Complaints</td>
<td>Creating a complaint case opens the complaint playbook and initiates the first activity in the Intake stage: Gather complaint details. The agent can complete and save this activity to create the record. For more information, see Create a record using a playbook.</td>
</tr>
<tr>
<td>Focused activity view</td>
<td>The activity view determines how the stages and activities appear in the playbook. The Case Playbook for Complaints uses the Focused activity view, which enables agents to see:</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>• The end-to-end lifecycle of the complaint workflow in the playbook lifecycle panel.</td>
</tr>
<tr>
<td></td>
<td>• The current stage expanded and the current activity highlighted within the playbook lifecycle panel.</td>
</tr>
<tr>
<td></td>
<td>• Details of the current activity displayed in the playbook work area.</td>
</tr>
<tr>
<td>Contextual side panel</td>
<td>The Case Playbook for Complaints displays the following information in the contextual side panel:</td>
</tr>
<tr>
<td></td>
<td>• Activity stream</td>
</tr>
<tr>
<td></td>
<td>• Ribbon information such as the case overview, customer details, timeline, and SLAs</td>
</tr>
<tr>
<td></td>
<td>• Dynamic related records (see below for more information)</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The activity stream and ribbon information are available in CSM Configurable Workspace only.</td>
</tr>
<tr>
<td></td>
<td>For more information about using the contextual side panel, see:</td>
</tr>
<tr>
<td></td>
<td>• Using activity stream in the contextual side panel</td>
</tr>
<tr>
<td></td>
<td>• Viewing the ribbon information in the contextual side panel</td>
</tr>
<tr>
<td></td>
<td>• Viewing dynamic related records in the contextual side panel</td>
</tr>
<tr>
<td>Activity visibility</td>
<td>The Case Playbook for Complaints uses the following settings to control activity visibility:</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
|                                      | • Hide the activities in a stage that the logged-in user cannot access.  
• Hide the pending activities in a stage.  
For more information about configuring this feature, see Configure playbook stage and activity visibility. |
| Compact mode                         | Compact mode moves the playbook from a tab in the Workspace to the contextual side panel. Agents can complete playbook activities in the side panel while viewing other tabs in the record page.  
\[Note: Compact mode is available in CSM Configurable Workspace only.\]  
Users with the system administrator role can configure a playbook to use compact mode in the playbook component configuration in UI Builder. For more information about configuring this feature, see Integrate Playbook with Workspace. |
| Dynamic related records              | Display records in the contextual side panel that dynamically change based on the context of the current record or playbook activity.  
From the Related Records tab in the contextual side panel, agents can:  
• Filter the list of related records  
• Open the list in a new tab  
• Create new records |
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong></td>
<td>The dynamic related records feature is available in CSM Configurable Workspace only. For more information, see Viewing related records in the contextual side panel.</td>
</tr>
</tbody>
</table>
| SLA widget     | Activity cards in the playbook work area can display an SLA widget in the upper right corner. The widget appears on the activity card when the playbook activity has an SLA. This includes activities in the following stages:  
• Triage  
• Research  
• Respond  

The color of the widget indicates the time remaining for the SLA:  
• Green: 0–50%  
• Yellow: 50–75%  
• Orange: 75–99%  
• Red: 100% or breached |

**Using the playbook lifecycle to navigate stages and activities**  
The playbook lifecycle enables agents to see the entire lifecycle of the complaint workflow. To navigate the playbook stages and activities:  
• Expand and collapse stages to show or hide activities.  
• Use the filter in the playbook header to filter activities by the assigned user or the activity state.  
• Click an activity to display the details in the playbook work area.  
• Collapse the playbook lifecycle panel to create more screen space.
Using the Playbook Actions menu

The Playbook Actions menu in the playbook header includes actions that agents can perform at the playbook and activity levels. Click the Playbook Actions icon (†) to access this menu.

The Playbook Actions menu includes the following playbook-level actions:

• **Expand All Stages**: Expands all of the stages in the playbook.

• **Collapse All Stages**: Collapses all of the stages in the playbook.

• **Request Info**: Displays a pop-up window that the agent can use to communicate with the customer and request information about a case or case task. This action also saves the details to the case or case task activity stream. Using this action changes the state of the case or case task to Awaiting Info and pauses the SLAs and any timers.

• **Info Received**: Returns the case or case task to the previous state and restarts the SLAs and any timers.

⚠️ Note: The Request Info and Info Received actions can also be configured to appear on case task activity cards.

Activity-level actions can vary depending on the type of activity and in which stage it appears. For example, actions are available to accept cases, create related cases, create case tasks, and propose solutions.

Complaint playbook stages and activities

The Case Playbook for Complaints includes the following stages and activities that agents can use to resolve customer issues.

<table>
<thead>
<tr>
<th>Case Playbook for Complaints stages and activities</th>
<th>Stage</th>
<th>Activity</th>
<th>Activity Details</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Intake</td>
<td>Gather complaint details</td>
<td>When an agent creates a complaint case, the workspace opens the Create New Complaint Case form, launches the complaint playbook, and uses the first activity to gather complaint details. Enter information about the customer, the complaint, and the expected outcome for the case. As you enter the complaint details, additional fields</td>
</tr>
</tbody>
</table>
### Case Playbook for Complaints stages and activities (continued)

<table>
<thead>
<tr>
<th>Stage</th>
<th>Activity</th>
<th>Activity Details</th>
</tr>
</thead>
</table>
|                |                           | appear on the activity card such as the **Category** and **Subcategory** fields. Agent actions:  
|                |                           | • **Continue**: This action creates the complaint case and adds the case number to the record tab. It also marks the first activity as complete and moves to the second activity.  
|                | Add involved parties     | Agents can use this activity to add involved parties to the complaint case.  
|                |                           | 1. Click **Add new** to open the Create New Related Party form in a new tab.  
|                |                           | 2. In the **Type** field, select the related party with the correct entity type, such as a co-complainant who is a customer contact.  
|                |                           | 3. Select the **User**.  
|                |                           | 4. Click **Save** to add the user to the Involved Parties list on the activity card. Agent actions:  
|                |                           | • **Assign to me**: Available if the case is not yet assigned. Assigns the case to the logged-in user.  
|                |                           | • **Add new**: Add a user to the Involved Parties list (see steps above).  
|                | Verify primary address   | This activity shows the fields from the Primary Correspondence Address form section on the Details tab. Agents can accept this address or select a different address. Agent actions:  
<p>| | | |
|                |                           | |</p>
<table>
<thead>
<tr>
<th>Stage</th>
<th>Activity</th>
<th>Activity Details</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Save</strong></td>
<td>Saves updates to the Primary Correspondence Address fields.</td>
</tr>
<tr>
<td></td>
<td><strong>Move to triage</strong></td>
<td>Completes the Intake stage, marks the activities in the stage as complete, and moves to the next stage in the complaint playbook.</td>
</tr>
<tr>
<td>Notify customer</td>
<td></td>
<td>This activity displays the details of the email that was automatically sent to the customer at the completion of the Intake stage.</td>
</tr>
<tr>
<td><strong>Triage</strong></td>
<td>Verify complaint</td>
<td>Agents can use this case task to review any available related search results in the contextual side panel and add notes or attachments. Agent actions:</td>
</tr>
<tr>
<td></td>
<td><strong>Request info</strong></td>
<td>Request additional information from the customer. This action changes the state of the case task to Awaiting Info.</td>
</tr>
<tr>
<td></td>
<td><strong>Post</strong></td>
<td>Posts the comment or the work note to the case task record activity stream.</td>
</tr>
<tr>
<td></td>
<td><strong>Submit for review</strong></td>
<td>Marks the case task and the Triage stage as complete.</td>
</tr>
<tr>
<td>Notify customer</td>
<td></td>
<td>This activity displays the details of the email that was automatically sent to the customer at the completion of the Triage stage.</td>
</tr>
<tr>
<td><strong>Research</strong></td>
<td>Review legal implications</td>
<td>Agents can assign this case task to a different user for legal review. To assign the task:</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. 
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
## Case Playbook for Complaints stages and activities (continued)

<table>
<thead>
<tr>
<th>Stage</th>
<th>Activity</th>
<th>Activity Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>office teams for follow-up.</td>
<td>1. Click the View Task icon in the upper right corner of the activity card. This opens the case task in a new tab. 2. Select the user in the <strong>Assigned to</strong> field. 3. Add information to the other fields on the Case Task form as needed and click <strong>Save</strong>. Agent actions: • <strong>Request info</strong>: Request additional information from the customer. This action changes the state of the case task to Awaiting Info. • <strong>Post</strong>: Posts the comment or the work note to the case task record activity stream. • <strong>Review complete</strong>: Marks the case task as complete.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Product owner review for other similar issues</td>
<td>Agents can assign this case task to a different user for a review of similar issues. To assign the task: 1. Click the View Task icon in the upper right corner of the activity card. This opens the case task in a new tab. 2. Select the user in the <strong>Assigned to</strong> field. 3. Add information to the other fields on the Case Task form as needed and click <strong>Save</strong>. Agent actions:</td>
</tr>
</tbody>
</table>
### Case Playbook for Complaints stages and activities (continued)

<table>
<thead>
<tr>
<th>Stage</th>
<th>Activity</th>
<th>Activity Details</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Request info</td>
<td>Request additional information from the customer. This action changes the state of the case task to Awaiting Info.</td>
</tr>
<tr>
<td></td>
<td>Post</td>
<td>Posts the comment or the work note to the case task record activity stream.</td>
</tr>
<tr>
<td></td>
<td>Review complete</td>
<td>Marks the case task as complete.</td>
</tr>
<tr>
<td>Verify check entitlement</td>
<td></td>
<td>Agents can assign this case task to a different user for an entitlement review.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To assign the task:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1. Click the View Task icon in the upper right corner of the activity card. This opens the case task in a new tab.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Select the user in the <strong>Assigned to</strong> field.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Add information to the other fields on the Case Task form as needed and click <strong>Save</strong>.</td>
</tr>
<tr>
<td>Billing review for any refunds</td>
<td></td>
<td>Agents can assign this case task to a different user for a billing review.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To assign the task:</td>
</tr>
</tbody>
</table>
## Case Playbook for Complaints stages and activities (continued)

<table>
<thead>
<tr>
<th>Stage</th>
<th>Activity</th>
<th>Activity Details</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Agent actions:</strong></td>
<td><strong>Request info:</strong> Request additional information from the customer. This action changes the state of the case task to Awaiting Info.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Post:</strong> Posts the comment or the work note to the case task record activity stream.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Review complete:</strong> Marks the case task and the Research stage as complete.</td>
</tr>
<tr>
<td></td>
<td>Notify customer</td>
<td>This activity displays the details of the email that was automatically sent to the customer at the completion of the Research stage.</td>
</tr>
</tbody>
</table>
| **Respond** | Compose email | Agents can use this activity to communicate with the customer.-Agent actions:  
**Request info:** Request additional information from the customer. This action changes the state of the case task to Awaiting Info. |
<table>
<thead>
<tr>
<th>Stage</th>
<th>Activity</th>
<th>Activity Details</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Post</td>
<td>• Post: Posts the comment or the work note to the case task record activity stream.</td>
</tr>
<tr>
<td></td>
<td>Review complete</td>
<td>• Review complete: Marks the case task and the Respond stage as complete.</td>
</tr>
<tr>
<td>Resolve</td>
<td>Propose resolution</td>
<td>This activity shows the fields from the Resolution Notes section on the Case form. Add the resolution details and click Propose solution. If the customer rejects the solution, the agent can return to the Resolve stage and propose another solution.</td>
</tr>
<tr>
<td></td>
<td>Agent actions:</td>
<td>• Propose solution: Proposes the solution to the customer and marks the Resolve stage as complete.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Change solution: This action appears after the agent proposes a solution.</td>
</tr>
<tr>
<td></td>
<td>Notify customer</td>
<td>This activity displays the details of the email that was automatically sent to the customer at the completion of the Resolve stage.</td>
</tr>
<tr>
<td>Close</td>
<td>Close case</td>
<td>When the customer accepts the resolution, the Resolve stage completes and the Close stage is also marked as complete.</td>
</tr>
<tr>
<td></td>
<td>Notify customer</td>
<td>This activity displays the details of the email that was automatically sent to the customer at the completion of the Close stage.</td>
</tr>
</tbody>
</table>
Case Playbook for Product Support

Use the Case Playbook for Product Support to guide agents through the steps that are needed to resolve product issues.

A product support case captures information about the customer, the product, and the reported issue. The product support playbook provides the activities and tasks that agents can perform to research and resolve the issue. Agents can also create and assign tasks as needed and use the playbook to communicate with the customer.

The Case Playbook for Product Support is available for both CSM Configurable Workspace and CSM Agent Workspace. In the CSM Workspaces, the playbook appears in the Playbook tab on the case record.

**Note:** System administrators can configure a playbook to use compact mode in CSM Configurable Workspace. Compact mode moves the playbook from a tab in the Workspace to a tab in the contextual side panel.

Case Playbook for Product Support application

The Case Playbook for Product Support 3.0 application (com.sn_csm_product_caseflow) is available from the ServiceNow store. For more information, see [Playbook plugins](#).

Case Playbook for Product Support PAD process definition

The Case Playbook for Product Support 3.0 includes a new Process Automation Designer (PAD) process definition: `product_playbook_v1`. This process definition contains optimized stages and activities for the product support playbook.

Process definitions are stored in the Process Definitions table (sys_pd_process_definition). To view a list of processes:

1. Enter `sys_pd_process_definition.list` in the application navigator.
2. Configure the list to show the **Name** field.

Only one PAD process per playbook should be active at a time. For more information, see [Process definitions](#).

Case Playbook for Product Support features

The Case Playbook for Product Support 3.0 includes the following features and enhancements.
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Focused activity view</strong></td>
<td>The activity view determines how the stages and activities appear in the playbook.</td>
</tr>
<tr>
<td></td>
<td>The Case Playbook for Product Support uses the <strong>Focused activity view</strong>, which enables agents to see:</td>
</tr>
<tr>
<td></td>
<td>• The end-to-end lifecycle of the product support workflow in the playbook lifecycle panel.</td>
</tr>
<tr>
<td></td>
<td>• The current stage expanded and the current activity highlighted within the playbook lifecycle panel.</td>
</tr>
<tr>
<td></td>
<td>• Details of the current activity displayed in the playbook work area.</td>
</tr>
<tr>
<td><strong>Contextual side panel</strong></td>
<td>The Case Playbook for Product Support displays the following information in the contextual side panel:</td>
</tr>
<tr>
<td></td>
<td>• Activity stream</td>
</tr>
<tr>
<td></td>
<td>• Ribbon information such as the case overview, customer details, timeline, and SLAs</td>
</tr>
<tr>
<td></td>
<td>• Dynamic related records (see below for more information)</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The activity stream and ribbon information are available in CSM Configurable Workspace only.</td>
</tr>
<tr>
<td></td>
<td>For more information about using the contextual side panel, see:</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>• Using activity stream in the contextual side panel</td>
<td></td>
</tr>
<tr>
<td>• Viewing the ribbon information in the contextual side panel</td>
<td></td>
</tr>
<tr>
<td>• Viewing dynamic related records in the contextual side panel</td>
<td></td>
</tr>
<tr>
<td>For more information about configuring this feature, see Configure playbook stage and activity visibility.</td>
<td></td>
</tr>
<tr>
<td>Activity visibility</td>
<td>The Case Playbook for Product Support uses the following settings to control activity visibility:</td>
</tr>
<tr>
<td></td>
<td>• Hide the activities in a stage that the logged-in user cannot access.</td>
</tr>
<tr>
<td></td>
<td>• Hide the pending activities in a stage.</td>
</tr>
<tr>
<td>Compact mode</td>
<td>Compact mode moves the playbook from a tab in the Workspace to the contextual side panel. Agents can complete playbook activities in the side panel while viewing other tabs in the record page.</td>
</tr>
<tr>
<td></td>
<td>Note: Compact mode is available in CSM Configurable Workspace only.</td>
</tr>
<tr>
<td>Users with the system administrator role can configure a playbook to use compact mode in the playbook component configuration in UI Builder. For more information about configuring this feature, see Integrate Playbook with Workspace.</td>
<td></td>
</tr>
<tr>
<td>Dynamic related records</td>
<td>Display records in the contextual side panel that dynamically change based on the context of the current record or playbook activity.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| From the Related Records tab in the contextual side panel, agents can: | • Filter the list of related records  
• Open the list in a new tab  
• Create new records  

**Note:** The dynamic related records feature is available in CSM Configurable Workspace only.  
For more information, see Viewing related records in the contextual side panel. |
| SLA widget | Activity cards in the playbook work area can display an SLA widget in the upper right corner. The widget appears on the activity card when the playbook activity has an SLA.  
The color of the widget indicates the time remaining for the SLA:  
• Green: 0–50%  
• Yellow: 50–75%  
• Orange: 75–99%  
• Red: 100% or breached |

**Using the playbook lifecycle to navigate stages and activities**  
The playbook lifecycle enables agents to see the entire lifecycle of the product support workflow. To navigate the playbook stages and activities:  
• Expand and collapse stages to show or hide activities.  
• Use the filter in the playbook header to filter activities by the assigned user or the activity state.  
• Click an activity to display the details in the playbook work area.  
• Collapse the playbook lifecycle panel to create more screen space.
Using the Playbook Actions menu

The Playbook Actions menu in the playbook header includes actions that agents can perform at the playbook level. Click the Playbook Actions icon ( ) to access this menu.

The Playbook Actions menu includes the following playbook-level actions:

- **Expand All Stages**: Expands all of the stages in the playbook.
- **Collapse All Stages**: Collapses all of the stages in the playbook.
- **Request Info**: Displays a pop-up window that the agent can use to communicate with the customer. Also saves the details to the case activity stream. Using this action changes the state of the case to Awaiting Info and pauses the SLAs and any timers on the case.
- **Info Received**: Returns the case to the previous state and restarts the SLAs and any timers on the case.

Activity-level actions can also appear in the Playbook Actions menu. These actions vary depending on the type of activity and in which stage it appears. For example, actions are available to accept cases, create related cases, create case tasks, and propose solutions.

**Case Playbook for Product Support stages and activities**

The Case Playbook for Product Support includes the following stages and activities that agents can use to resolve customer issues.
<table>
<thead>
<tr>
<th>Stage</th>
<th>Activity</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Investigate</td>
<td>Review case details</td>
<td>A case is in the Investigate stage when the case state is New or Open. This activity displays information about the case, including the customer and product details and any contracts or entitlements. The agent can add details about the issue and review the information and related search results, such as knowledge articles or similar cases. Agent actions:</td>
</tr>
</tbody>
</table>
|                  |                     | • **Assign to me**: Assigns the case to the current agent.  
|                  |                     | • **Accept**: Enables the agent to accept the case.  
|                  |                     | • **Save**: Saves any changes made to the case details.  
|                  |                     | • **Mark Complete**: Saves the information, marks the activity as complete, and moves to the next activity or stage.  |
| Work in progress | Create case tasks   | A case is in the Work in progress stage when the agent completes the initial research and begins working on the issue. This activity includes a list of case tasks. Agents can create tasks as needed to complete the work for a case. Agent actions:  |
Case Playbook for Product Support stages and activities (continued)

<table>
<thead>
<tr>
<th>Stage</th>
<th>Activity</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>• <strong>Add New</strong>: Creates a case task. Add information to the task and click <strong>Save</strong> to add the task to the Case Tasks list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Mark Complete</strong>: Marks the activity as complete and moves to the next activity or stage.</td>
</tr>
<tr>
<td><strong>Resolve and close</strong></td>
<td>Resolve</td>
<td>Case tasks are complete and the agent is ready to propose a solution to the customer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Add details to the <strong>Resolution code</strong> and <strong>Resolution notes</strong> fields on the activity card and click <strong>Save</strong>. This information is added to the case record.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Agent actions:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Propose Solution</strong>: Notifies the customer of the proposed solution.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Change Solution</strong>: Appears after the agent proposes a solution. Use this action to add information to the case resolution fields.</td>
</tr>
<tr>
<td></td>
<td>Close case</td>
<td>This activity shows the following read-only fields:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Closed by</strong>: the agent who closed the case.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Closed</strong>: the date and time that the case was closed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The system closes the case when the customer accepts the resolution or when the agent clicks <strong>Close Case</strong>.</td>
</tr>
</tbody>
</table>

**Dynamic related records**

Display related records in the contextual side panel in CSM Configurable Workspace that dynamically change based on the context of the current record or playbook activity.
The dynamic related records feature provides customer service agents with easy access to the information they need when they need it. Agents can view related records in the contextual side panel without navigating away from the current tab and searching for information in other related lists. This feature also enables users to display related records without requiring any type of reference or parent-child relationship.

Different types of agents can use dynamic related records to see different information. For example:

- A front-line agent creating a new case can see similar, recently opened cases.
- A middle-office agent reviewing a complaint case can see active contracts for the customer.
- A back-office agent can view emails for a selected playbook activity.

To view related records, click the Related Records tab in the contextual side panel in CSM Configurable Workspace. Records appear in the Related Records list as read-only cards.
Configuring dynamic related records
System administrators can configure the dynamic related records feature and define the following information:

- Context records that specify the type of record for which related records are displayed, such as a case record or a playbook activity. A context can also specify any conditions for the record type that must be met in order for related records to be displayed.
- Definitions for each specific type of related record to display, such as SLAs or contracts.
- Relationships between context records and their associated definition records.
System administrators can also configure the related record card format. For more information, see Configuring dynamic related records.

Using dynamic related records

Agents can search the Related Records list by entering text in the search field or filter the list to display records of a specific type, such as SLAs or active customer contracts. Agents can expand a card to show more a more detailed view or open the list in a sub-tab. If agents have create permission, they can also create new related records of the selected type.

For more information about these agent actions, see Using the Related Records tab in the contextual side panel.

Dynamic related records plugin

Users with the system administrator role can activate the Dynamic Related Records for Configurable Workspace plugin (com.snc.uib.sn_dyn_rel_rec).

This plugin provide agents with access to related information based on the context of the current record. System administrators can configure related record definitions that make data available in context to the action that the agent is performing.

This plugin adds the Dynamic Related Record menu and the following modules to the application navigator:

- Related Record Contexts
- Related Record Definitions

This plugin also adds several related record definitions. For more information, see Related record definitions included with the plugin.

Using dynamic related records with Playbooks for Customer Service Management

The Playbooks for Customer Service Management plugin (sn_csm_playbook) adds the dynamic related records feature to CSM Configurable Workspace. It also includes the Case context record and several related record definitions.

The Case Playbook for Onboarding, Case Playbook for Complaints, and Case Playbook for Product Support applications include additional context records and related record definitions.

Related information

Configure dynamic related records
Using the Related Records tab in the contextual side panel
Using the Related Records tab in the contextual side panel

Agents can view, search, and sort the records in the Related Records tab in the contextual side panel.

The Related Records tab displays related records that dynamically change based on the context of the current record or playbook activity. The records that are displayed in the Related Records tab depend on the following settings:

• The related record contexts and definitions that have been configured for a record or playbook activity.
• The agent’s access permissions to data.

<table>
<thead>
<tr>
<th>Task</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>View related records in the contextual side panel</td>
<td>Click the Related Records tab (Ξ) to view the Related Records list.</td>
</tr>
<tr>
<td></td>
<td>Related records appear in the list in a card format. The initial set of records displayed in the list is determined by the record type selected in the filter at the top of the list.</td>
</tr>
<tr>
<td>Select the type of related record to view</td>
<td>Use the filter at the top of the Related Records list to select the type of related records to view. Agents can also use the filter to see the current selection.</td>
</tr>
<tr>
<td></td>
<td>1. Click the filter icon (🔍).</td>
</tr>
<tr>
<td></td>
<td>2. Select a record type from the dropdown menu.</td>
</tr>
<tr>
<td></td>
<td>The dropdown menu includes the related lists that have been configured for the parent record.</td>
</tr>
<tr>
<td>Search the related records list</td>
<td>Use the search field at the top of the Related Records list to perform a text search. Records that match the search text are highlighted.</td>
</tr>
<tr>
<td></td>
<td>1. Enter the search text in the search field at the top of the Related Records list.</td>
</tr>
<tr>
<td></td>
<td>2. Click the search icon.</td>
</tr>
<tr>
<td>Task</td>
<td>Steps</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Open a related record in a sub-tab</strong></td>
<td>Click a card in the Related Records list to open the record in a sub-tab under the parent record. In the sub-tab, the agent can view the record details and perform available actions.</td>
</tr>
<tr>
<td><strong>Open the related record list in a list view in a sub-tab</strong></td>
<td>Click the list view icon (⥀) to display the related records in a list view in a sub-tab under the parent record.</td>
</tr>
<tr>
<td><strong>Create a new record for the selected related list</strong></td>
<td>Create a new record for the record type currently selected in the Related Records list. This action opens a new record form in a sub-tab under the parent record.</td>
</tr>
<tr>
<td></td>
<td>1. Click the create record icon (➕) at the top of the Related Records list.</td>
</tr>
<tr>
<td></td>
<td>2. Fill in the fields on the record form and click Save.</td>
</tr>
</tbody>
</table>

### Related records shared page

The Related Records shared page enables users to view records that are related to the current record or playbook activity in the contextual side panel.

Users with the ui_builder_admin role or system administrator role can configure a record page in UI Builder and use the Related Records shared page to add a Related Records tab on the contextual side panel. The Related Records tab shows the list of related records in card format.

Use the Related Records shared page to display records from tables that have a configured relationship to the main record. This can include multiple types of related records such as SLAs, active contracts, and emails.

The Related Records shared page:

- Is part of the Base Agent Workspace app shell.
- Is a public page that is available in the page templates.
- Is a generic page that can be embedded in the contextual side panel for any page.
For more information about the Related Records shared page, see the Related Records component information and specifications on the Developer site.

**Dynamic related record tables**

The dynamic related records feature uses different tables to store context and definition information.

The following tables support the configuration of the dynamic related records feature. These tables extend the `sys_metadata` table.

**Related Record Context table**

Records in the Related Record Context `[sn_related_record_context]` table define the context in which related records appear in the Related Records tab. This includes the following information:

- The selected table. You can create context records for source records (such as customer service cases) or playbook activities (such as adding additional members to an onboarding case).

- Additional conditions that apply to the selected table. These conditions determine when the related record definitions for the selected table are executed.

- The related record definitions to execute. These definitions identify the data to be retrieved, such as SLAs or emails.

**Related Record Context table fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The unique name of the context record.</td>
</tr>
<tr>
<td>Applies to table</td>
<td>The table that stores the record type for the context record.</td>
</tr>
<tr>
<td></td>
<td>To display related records for a source record, select the table that stores the source record. For example, Case <code>[sn_customerservice_case]</code>.</td>
</tr>
<tr>
<td></td>
<td>To display related records for a playbook activity, select the table that stores the activities: Activity Execution <code>[sys_pd_activity_context]</code>.</td>
</tr>
<tr>
<td>Primary reference field</td>
<td>The primary field from the <strong>Applies to table</strong> that is passed to the Context Related Record Definition for evaluation. The value is used by the scripted query in the definition.</td>
</tr>
<tr>
<td></td>
<td>The following data types are supported:</td>
</tr>
</tbody>
</table>
### Related Record Context table fields (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
|                        | • Sys ID  
|                        | • Doc ID  
|                        | • Reference                                                                                                                                  |
| Secondary reference    | The secondary field from the **Applies to table** that is passed to the Context Related Record Definition for evaluation. The value is used by the scripted query in the definition. The following data types are supported:  
| field                  | • Sys ID  
|                        | • Doc ID  
|                        | • Reference                                                                                                                                  |
| Application            | The application to which the context record applies. This is a read-only field.                                                             |
| Active                 | Enables the context record.                                                                                                                 |
| Inherited              | When enabled, the context record also considers tables that extend from the **Applies to table**.                                             |
| Conditions             | Conditions that are applied to the records in the **Applies to table**.                                                                      |

### Related Record Definition table

Records in the Related Record Definition [sn_related_record_definition] table identify one type of data to be retrieved, such as active contracts, case tasks, or SLAs. A definition record includes:

- The display label, which appears in the filter dropdown list in the Related Records tab.
- The table to be queried from. For example, the Email [sys_email] table.
- If needed, primary and secondary reference tables.
- Scripted conditions that further specify which fields to query from.

You can create definition records for each type of data to include in the Related Records tab and then associate the definitions with one or more context records.
### Related Record Definition table fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display label</td>
<td>The unique name of the related record definition. This label appears in the filter list in the Related Records tab.</td>
</tr>
</tbody>
</table>
| Primary reference table| The primary table used in the definition script. At runtime, the script expects to get passed a record of this type.  
If you entered a data type in the **Primary reference field** in the related record context, enter the table for that data type. |
| Secondary reference table| The secondary table used in the definition script. At runtime, the script expects to get passed a record of this type.  
If you entered a data type in the **Secondary reference field** in the related record context, enter the table for that data type. |
| Application            | The application to which the definition record applies. This is a read-only field.                                                          |
| Queries from           | The table that stores the related record data to be retrieved.                                                                                |
| Active                 | Enables the definition record. A definition must be active for the related records of that type to be displayed in the Related Records tab.  |
| Script                 | Create a script that defines which records are retrieved based on the context.                                                               |

### Context Related Record Definition table

The Context Related Record Definition [sn_m2m_context_related_record_defn] table defines the relationship between a context record and its associated definition records.

When you open a context record, you can see the associated definition records in the Context Related Record Definitions related list.
### Field Descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Related record context</td>
<td>The context record.</td>
</tr>
<tr>
<td>Related record definition</td>
<td>The name of the related record definition associated with the context record. The system uses this definition to determine which records to retrieve.</td>
</tr>
<tr>
<td>Application</td>
<td>The application to which the context record applies. This is a read-only field.</td>
</tr>
<tr>
<td>Order</td>
<td>The order determines where the related record type appears in the filter list in the Related Records tab. The order for this related record definition is compared with the order of the other definitions associated with the Related record context to determine the order of appearance in the filter list. If more than one context applies to a record, the system evaluates the order for all of the related record types. If there is a duplicate related record type, the system takes the record type with the lowest order value.</td>
</tr>
<tr>
<td>Active</td>
<td>Enables the Related record definition for this context record.</td>
</tr>
</tbody>
</table>

## Guided Decisions for Customer Service Management

Resolve complex cases faster and more efficiently by guiding customer service agents through a structured troubleshooting process.

### Guided decisions

Guided Decisions is a decision authoring and execution capability in Customer Service Management. A guided decision guides customer service agents through a troubleshooting process based on the context of the case they are working on. It asks them questions based on previous answers and gives guidance on the next step they should take in the resolution process.

Using Guided Decisions has the following benefits:
• Improve first contact resolution: Dynamically guide customer service agents along the optimal path to resolve complex cases.

• Shift to digital faster: Author decision trees and guide customer service agents to take the next optimal action.

• Improve customer service agent productivity: Surface contextual recommendations in the CSM workspace.

Guided decisions consist of decision trees. A decision tree is a multi-step process consisting of a series of questions, answers, and guidances.

Decision trees contain decision tree nodes, which represent one or more questions and the associated decision or guidance paths. Based on the answers, each decision tree leads to an outcome. The outcome can be a guidance, a follow-on question, or another decision tree.

The following is an example of a decision tree:

structure.
The following is an example of the configuration behind the Decision Trees structure.

Decision strategists, who are typically subject matter experts or knowledge authors, author decision trees. Once a decision tree is created, the guided decision can be added to a playbook or to a next best action.

Customer service agents interact with decision trees as part of a playbook within a case or as part of a next best action.

Based on the conditions set up, the playbook containing the guided decision is displayed in the case. Customer service agents work through the guided decision and complete actions suggested in the guidance.
Activation information
Activate the following plugins, as required.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Guided Decisions</td>
<td>Enables the framework and execution engine for creating guided decisions.</td>
</tr>
<tr>
<td>[com.snc.guided_decisions]</td>
<td></td>
</tr>
<tr>
<td>Guided Decisions - Guidance</td>
<td>Enables the framework for creating a guidance for guided decisions.</td>
</tr>
<tr>
<td>[com.snc.guided_decisions_guidance]</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Guided Decisions - Guidance Global Entities</td>
<td>Contains all of the global artifacts required for the guided decisions feature and enables global scope access.</td>
</tr>
<tr>
<td>Guided Decisions Experience</td>
<td>Enables the Guided Decision experiences in Playbook, Next Best Action, etc.</td>
</tr>
<tr>
<td>Guided Decision - Next Best Action</td>
<td>Enables the framework and related files needed to define rules that recommend relevant actions for a given context.</td>
</tr>
<tr>
<td>Next Best Action for Customer Service</td>
<td>Provides the Next Best Action and Guided Decision configurations and features specific to Customer Service Management.</td>
</tr>
</tbody>
</table>

**Roles**

Ensure that users can perform all the necessary actions by assigning roles.

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_gd_guidance.guidance_user</td>
<td>Read access to guidances.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This role is automatically given to customer service agents.</td>
</tr>
<tr>
<td>sn_gd_guidance.guidance_manager</td>
<td>Create, read, update, delete access to guidances. Guidance managers create guidances that are given as an outcome to a series of questions in a decision tree.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This role is automatically given to customer service managers.</td>
</tr>
<tr>
<td>sn_gd_core.decision_tree_user</td>
<td>Read access to decision trees.</td>
</tr>
<tr>
<td>Role</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>sn_gd_core.decision_tree_author</strong></td>
<td>Create, read, update, delete decision trees. Decision authors define decision trees that provide a series of questions to the customer service agent to answer.</td>
</tr>
<tr>
<td><strong>pd_content_author</strong></td>
<td>Add decision trees and guidance to a new or existing playbook for customer service agents to access on Agent Workspace.</td>
</tr>
</tbody>
</table>

**Related information**

Configure Guided Decisions for Customer Service Management

Use guided decisions to resolve cases

**Guidance outputs and nested decision trees**

Nest and invoke decision trees from decision nodes when specific conditions are met. Use guidance output and nested trees to execute complex troubleshooting.

Guided decisions consist of decision trees. A decision tree is a multi-step process consisting of a series of questions, answers, and guidances.

Decision trees contain decision tree nodes, which represent one or more questions and the associated decision, guidance, or linking node. Based on the answers to the questions, each decision tree leads to an outcome. The outcome can be a guidance, a follow-on question, or another decision tree.

In the Paris release, a decision tree executes until it reaches a guidance. The decision tree ends with the guidance presented to the agent. In the Quebec release, a decision tree can continue executing following a guidance.

For example, a guided decision can ask an agent some questions and provide a guidance, such as running a test. Based on the result of the test, the guidance continues with additional questions to further troubleshoot the problem and work toward a resolution.
Decision tree node types

A decision tree node can be one of the following types: decision, guidance, or linking.

<table>
<thead>
<tr>
<th>Node type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decision</td>
<td>A decision node asks a question. The answer to the question leads to an outcome, which can be a guidance, another question, or another decision tree. Decision nodes can be answered by an agent. If configured, decision nodes can also be answered automatically with values from previous decision nodes. Configuring a decision node to be answered automatically uses a mapping functionality where the answer of a previous decision node can be mapped to the current decision node. If a decision node is in the same decision tree and is executed before the current decision node, the values from the previous node can be mapped to the current node. If the mapped values from the previous node fulfill the requirements of the current node, it automatically answers the current node.</td>
</tr>
<tr>
<td>Guidance</td>
<td>A guidance node has a reference to a guidance, which provides a recommendation to the agent. Examples of a guidance include recommending a knowledge article or creating a work order. A guidance node can have a next node. If a next node is configured, the execution of the decision tree continues after the agent performs the guidance and the guidance history is marked as complete. A next node is a decision tree node of type decision. A guidance can have outputs, which drive further decision making. For a guidance, you can: • Define output variables. • Define values for the output variables. These values are mapped in the Automation Plan flow for the guidance by the Assign Guidance Outputs flow action. • Connect the guidance to the guidance node's next node. • Map the outputs of the guidance to inputs for the guidance node's next node.</td>
</tr>
</tbody>
</table>
Node type | Description
---|---
Linking | A linking node includes a reference to another decision tree. This linking connects the execution of the primary decision tree to another decision tree when a specific condition is met.

Linking to another decision trees is useful for complex troubleshooting or for troubleshooting that requires multiple stages.

A linking node includes the following elements:

- A linked decision tree, where the execution of the primary decision tree continues once this node is reached.
- An Output Mappings related list, which maps the inputs from the node preceding the linking node to the start node of the linked decision tree.
- A linking path, which connects the decision node to the linking node of the next tree.

Related information

Guided Decisions for Customer Service Management
Configure Guided Decisions for Customer Service Management
Use guided decisions to resolve cases

Using subflows to create simplified guidance for your agents

As a business analyst, you can create guidance for your customer service agents so that they can handle issues quickly and efficiently. By configuring metadata, you can provide a standardized experience for your agents.

Your agents can act on what the system determines is the best thing to do or by answering a few questions to get to the right action. Your guidance can have multiple actions for your agents. For example, your agent may attach a knowledge article or propose a solution to a customer to help resolve an issue.

To create guidance, you configure the inputs, outputs, and actions that take place when the guidance is accepted by the agent. By using a simplified guidance framework, you can create an automation plan with minimal or no coding efforts. With this plan, you create a subflow that defines the guidance life cycle and actions for your agents.

Related information

Configure guidance for your agents
**Next Best Action**

Enhance guided decisions by recommending next best actions to customer service agents. Agents can take advantage of recommendations provided in the CSM Configurable Workspace to troubleshoot complex issues and resolve a case.

Administrators or Business Analysts can create new guidances by configuring rules to show decision trees and guidances as next best actions. For more information, see *Configuring the next best actions for your agents*.

**Activation information**

Activate the following plugins to use the Next Best Action feature. For more information, see *Activate a plugin*.

- Next Best Action for Customer Service - com.snc.cs_next_best_action
- Guided Decisions - com.snc.guided_decisions
- Customer Service - com.sn_customerservice
- Guided Decisions Experience - com.snc.guided_decisions_playbook_experience

You must activate the Next Best Action orchestrator for Case flow to generate recommendations for the case type. Navigate to *Customer Service > Flow Designer*, click *Next Best Action orchestrator for Case*, and click *Activate*.

**Related information**

- Configure the next best action conditional rules within a context
- Use Next Best Action recommendations to resolve cases

**Configuring the next best actions for your agents**

You can provide guidance, such as decision trees and the next best actions to take, to your customer service agents so that they can resolve customer issues more efficiently. You can also fine-tune the guidance by assigning weights to the actions by frequency of issues and order of priority.

By configuring the next best actions for your agents, your organization gets the following benefits:

- Your agents resolve issues faster by following the guidance and guided decision trees as the next best actions.
- Your agents' productivity improves because their next best actions are dynamically ranked by the frequency of issues and order of priority.
- You can develop new guidance for your agents faster.
You may have guidance that you have already created or you may want to create guidance without writing any code. Currently, only the guidance for attaching a knowledge article, creating a work order, and providing resolution is available. For more information about creating guidance for your agents, see Using subflows to create simplified guidance for your agents.

You can specify the rules for a context entity such as a case, account, or interaction. This way, the agent can view the prioritized list of the next best actions in the workspace side panel. For more information, see Configure the next best action conditional rules within a context.

An arbitration engine helps to rank the guidance that an agent sees. You can configure the weights that are assigned to the frequency of issues and the order by priority for this guidance. However, for most business use cases, you can use the default values. These default values ensure that the relevant next best actions are visible to your agent for a given context. The next best actions that are in a new state are ranked by the arbitration engine. The scores are calculated and based on the frequency and priority of the rule. For more information, see Configure the next best action arbitration parameters.

**Proactive Customer Service Operations**

Proactively trigger case workflows and notify customers of any issues to resolve issues faster and lower inbound call volume.

Proactive Customer Service Operations enables you to track the digital services sold to and in use by your customers. This is referred to as install base.

If you identify any service disruptions to a customer's install base, you can proactively create a case to notify them.

These cases are resolved and closed in the same way as customer-reported cases. When multiple customers are affected, you can use the major issue management process.

You can also associate outage information to a case to keep your customers informed about the impact of the outage and the status of the resolution. It also gives customers visibility into planned service disruptions, enhancing transparency and reducing the number of customer-reported cases.

Your customers can use the Customer Service Portal to view proactive cases that you opened on their behalf, any outages associated with their install base, and interact with you using the proactive case.

Before you begin
Meet with your stakeholders to define your requirements. Depending on your requirements, you can activate either the Proactive Customer Service Operations plugin or the Proactive Customer Services with Event Management plugin.

Note: The Proactive Customer Service Operations with Event Management plugin provides all the features included in the Proactive Customer Service Operations plugin as well as additional features from the Event Management console in IT Operations Management.

Activation information

To enable Proactive Customer Service Operations with Event Management, activate the Proactive Customer Services with Event Management plugin (com.snc.proactive_cs_itom)

For detailed steps on getting started with Proactive Customer Service Operations, see Configure Proactive Customer Service Operations.

Related information
- Major issue management overview
- Configure install base

Outage tracking for install base
Provide visibility into any current or upcoming outages affecting a customer's install base, enhancing transparency and reducing the number of customer-reported cases.

Outage definition
An outage refers to a time period that a service delivering value to a customer is unavailable or experiencing performance issues.

A customer can experience the following types of outages:

• Unplanned outage: Outages such as those caused by hardware or network issues.
• Planned outage: Outages caused by planned maintenance or upgrades.
• Degradation: Problems affecting a service that does not result in a disruption of that service.
Outage tracking overview

Inform your customers proactively if they are affected by a planned or unplanned service disruption by associating outages to a case. In doing so, your customers are aware of the impact of the outage and have visibility into status of the resolution. They can then use this information to assess the business impact of different outage types over a period of time and calculate any charge backs, if required.

Outages are typically created automatically when an alert is created for a service or by service fulfillers when working on an incident.

An outage specifies the outage type, impacted service as well as the begin and end time. Multiple services used by a customer can be associated with an outage.

Roles

As a major issue manager or customer service manager, you can create, associate, and track all outages related to a case. Customer service managers can also view reports of business impact by outage type.

As a customer service agent, you can view any outages associated to the case.

Your customers can view outage information on the Customer Service Portal.

Activation information

This feature requires the Proactive Customer Service Operations Management plugin (com.snc.proactive_cs_ops).

Related information

- Associate an outage to a major case
- Create an outage from a major case
- Track outages for install base items
- Proactive Customer Service - Advanced dashboard
- View install base information from the Customer Service Portal

Integration with Event Management

Create cases proactively from alerts either manually or through automation. Track the accounts and health status of the corresponding install base items affected by the alert to better correlate customer issues and provide faster responses.

Customer Service Management provides an integration with the Event Management console in IT Operations Management, which enables you to improve the customer experience by breaking down the silos that exist between
the processes and systems used by front line customer service and back-office operations teams. By monitoring issues and creating cases proactively, you can be one step ahead of your customers and solve issues faster.

Network Operations Center (NOC) operators monitor alerts from the Operator Workspace. For more information, see Monitor service health.

When alerted to a service disruption, they can identify the accounts and corresponding install base items affected and create a case for customer service to review. Customer service can view the customers affected and notify them.

Customer service agents and managers can also track the service health status of install base items for an account to provide faster and more accurate support to customers.

This graphic provides an overview of Proactive Customer Service Operations with Event Management.
Learn about Proactive Customer Service Operations with Event Management from the following video tutorial.

Note: This video was recorded in the New York release.
Proactive Customer Service Operations with Event Management

Activation information

Service health status for install base
View the real-time health status of a customer's install base. Correlate customer issues with the operational health of their install base to provide more informed responses to your customers.

Service health tracking overview
The integration between Customer Service Management and the Event Management console in IT Operations Management enables you to track the service health status of a customer's install base.

When an issue affects one or more install base items and an alert is created, the severity of the alert is calculated in Event Management. It is calculated according to alert impact calculation rules. Based on the severity of the alert, the service health status of each install base item is calculated. Customer service agents can view the service health status of install base items in an account or a case in Customer Service Management.

For more information about how the severity of an alert is calculated, see Alert impact calculation.

To provide the service health status for an install base item in Customer Service Management, the following fields are mapped.

<table>
<thead>
<tr>
<th>Event Management (em_impact_status table)</th>
<th>Customer Service Management (sn_install_base_item table)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Service</td>
<td>Service Context</td>
</tr>
<tr>
<td>Element Identifier</td>
<td>Configuration Item</td>
</tr>
<tr>
<td>Severity</td>
<td>Health Status</td>
</tr>
</tbody>
</table>

Note: The service health status is displayed only if the install base item has both a Configuration Item (CI) and a service context associated with it. Service context is the business service associated with the underlying CI for impact calculation in Event Management. For more information about business services, see Lesson 2 of the Event Management operator guide.
The service health status is displayed in Customer Service Management as follows.

<table>
<thead>
<tr>
<th>Severity of alert (Event Management)</th>
<th>Service health status on Account and Case forms (Customer Service Management)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Critical</td>
<td>Critical: Resource is either not functional or critical problems are imminent.</td>
</tr>
<tr>
<td>Major</td>
<td>Major: Major functionality is severely impaired or performance has degraded.</td>
</tr>
<tr>
<td>Minor</td>
<td>Minor: Partial, non-critical loss of functionality or performance degradation occurred.</td>
</tr>
<tr>
<td>Warning</td>
<td>Warning: Attention is required, even though the resource is still functional.</td>
</tr>
<tr>
<td>Info</td>
<td>Normal: No severity. An alert is created. The resource is still functional.</td>
</tr>
<tr>
<td>Clear</td>
<td>Normal</td>
</tr>
<tr>
<td>Empty/Null</td>
<td>Not Available</td>
</tr>
</tbody>
</table>

For more information about alert severity, see Lesson 1 of the Event Management operator guide.

**Roles**

As a system administrator, configure form views to add the **Service Context**, **Health Status**, and **Health Status Last Updated** fields to the relevant forms.

As a customer service agent, view the service health status of install base items on the Account or Case form.

**Activation information**

This feature requires the Proactive Customer Service Operations with Event Management plugin (com.snc.proactive_cs_itom).
Customer Service Case Types

A case type represents the processes and the data that are needed to resolve a specific type of customer issue. Use the case types feature to create and configure the different types of customer service cases that your organization needs.

Customers can use case types to support a wide variety of end-user needs, including:

- Diverse industries and products
- Complex processes, events, and systems
- Collaboration with multiple users

A good example of an industry that benefits from multiple case types is the banking industry. Within a bank, customer service agents can use this feature to create case types for different customer needs such as loan processing, credit card processing, or managing complaints.

Case types overview

System administrators configure this feature by creating a table for the new case type that extends the Case table and then setting up a number of different processes and components for the case type.

- The Case Types Guided Setup section below provides an overview of these setup steps.
- See Configure customer service case types for details about the case types guided setup tasks.

Once a case type has been created, system administrators can view the case types, manage settings, and update the configuration. For more information, see Manage customer service case types.

Agents can use this feature when creating cases for customers by selecting from a list of configured case types. For more information, see Using case types to create cases below.
Customer service case types plugin

Users with the system administrator role can activate the Customer Service Case Types plugin (com.snc.csm_case_types).

Activating this plugin adds the **Customer Service > Case Types** module to the application navigator. The system administrator can use this module to create and manage case types.

Customer service case types applications

The following applications for specific case types are available from the ServiceNow Store.

<table>
<thead>
<tr>
<th>Application</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case Playbook for Onboarding (sn_csm_onboarding)</td>
<td>Provides an onboarding case type to capture the details when onboarding customers for a product or service and a playbook that provides step-by-step guidance through the lifecycle of the onboarding process.</td>
</tr>
<tr>
<td>Case Playbook for Complaints (sn_csm_complaint)</td>
<td>Provides a complaint case type to capture the details for a customer complaint and a playbook that provides step-by-step guidance through the lifecycle of the complaint.</td>
</tr>
</tbody>
</table>

For more information, see Install a ServiceNow Store application.

**Note:** These applications have dependencies on the following plugins:

- Customer Service Case Types (com.snc.csm_case_types)
- Customer Service Case Action Status (com.snc.csm_action_status)

Case Types Guided Setup

Activating the Customer Service Case Types plugin adds the Case Types section to the Customer Service Management Guided Setup. Navigate to **Customer Service > Administration > Guided Setup > Case Types** and use the tasks in this section to create and configure a case type.

You can configure a number of different processes and components for a customer service case type, including client scripts and business rules; views, roles, and ACLs; and notifications and record producers.
To create and configure a new case type:

- Create a table for the new case type that extends the Case table (sn_customerservice_case).
- Configure UI actions, UI policies, and client scripts for the new case type.
- Configure views and view rules, roles and ACLs, business rules and more for the new case type.
- Set up processes for the case type, including record producers, state flows, and special handling notes.
- Create a case type definition record for the new case type and add it to the Case Type table (sn_case_type).
- Configure the Get Case Types flow and modify the conditions that determine visibility for a case type.

For more information, see Configure customer service case types.

**Using case types to create cases**

Customers can extend the Case table to handle different types of cases. Each extended case type can support multiple types of requests. For example, if a customer creates a case type for Credit Card Services, this case type can support requests such as applying for a new card and reporting a lost or stolen card.

When creating cases, customer service agents select the case type that corresponds to the customer issue.

- In CSM Agent Workspace and CSM Configurable Workspace, agents select a case type from the Select Case Type pop-up window.
- In the platform interface, agents select a case type from an interceptor.

In CSM Configurable Workspace, there are two options available to agents when creating cases of a specific type: multi select and single select. In CSM Agent Workspace, agents can use the multi select option.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multi select</td>
<td>The Select Case Type pop-up window displays the <strong>Case Type</strong> and <strong>Category</strong> fields. A third field for a subtype can also be configured. This field can be a choice list field or a reference field from the Case Type table.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>When creating a case, the agent selects a case type and can optionally select a category and a subtype to further narrow the available choices.</td>
</tr>
<tr>
<td>Note:</td>
<td>If a subtype has not been configured for a case type, the third field for the subtype is not displayed.</td>
</tr>
<tr>
<td>Single select</td>
<td>The Select Case Type pop-up window displays the <strong>Case Type</strong> field. The agent can select from a defined list of case types and quickly create a case with one click. The system uses configured field mapping to fill in some of the fields on the Case form.</td>
</tr>
<tr>
<td>Note:</td>
<td>The single select option is only available in CSM Configurable Workspace.</td>
</tr>
</tbody>
</table>

The case type multi select option is the default functionality. The single select option requires the system administrator to enable the `sn_cmos_case_types.case_type_single_field_select` property and configure the selections available in the Select Case Type pop-up window.

**Related information**

- Configure customer service case types
- Manage customer service case types
- Enable the case type single select property
- Create a configuration for the case type single select option
- Create a customer service case of a specific type

**Onboarding case type**

Overview of the onboarding case type.

Agents can use the onboarding case type to capture the details when onboarding customers for a product or service.

The onboarding case type includes a playbook that provides step-by-step guidance through the lifecycle of the onboarding process.
Onboarding cases use the ONB prefix in the case number. For example, ONB0001007. Onboarding cases appear in the Onboarding Cases module in the following lists:

• My Onboarding Cases
• All Onboarding Cases
• Unassigned Onboarding Cases
• Escalated Onboarding Cases

When creating a new case, agents can select Customer Onboarding from the list of available case types.

Creating onboarding cases for new or existing customers

Customer service agents can create cases to onboard new customers or to onboard existing customers for new products.

The onboarding case form includes the New customer check box. Agents can enable this check box to display the New Customer Information section on the Case form. This form section includes fields that you can use to collect information and create a new customer record.

⚠️ Note: A new customer does not have an existing account, contact, or consumer record.

If an existing case already has the Account and Contact or Consumer fields populated, then the New customer check box is disabled.

When saving an onboarding case:

• If the New customer check box is enabled, the Account and Contact or Consumer fields are not required to save the case.
• If the New customer check box is disabled, the Account and Contact or Consumer fields are required to save the case.

New Customer Information form section

The New Customer Information form section includes fields that agents can use to collect information. This information is then used to create a customer record. These fields include:

• Customer Type: either Business or Individual
• Business Name: required when the customer type is Business
• User Name: required when the customer type is Individual
• Phone number
• Email

**Additional members**

The onboarding case type includes the Additional Members related list on the Case form. Agents can use this related list to create the users or business entities that should be included in the onboarding case.

Additional members can be any of the following:

• Accounts
• Contacts
• Consumers

Agents select information from the following fields when adding a member to an onboarding case:

• Type: the type of user to be added. For example, a joint owner or a beneficiary or a sub-account.
• Name: the name of the contact or consumer or account.

**Note:** If using the onboarding playbook, the user is also added to the Member Information card in the Add additional members step of the Initiate stage.

**Onboarding case type stages and states**

An onboarding case moves through several stages and states as the agent works to case resolution.

An onboarding case has six stages:

• Initiate
• Pre approval
• Data capture
• Due diligence
• Resolve
• Close

As an onboarding case moves through the stages listed above and toward a resolution, the case status is updated. Stage and status are related to each other as described in the following table.
<table>
<thead>
<tr>
<th>Stage</th>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initiate</td>
<td>New</td>
<td>An onboarding case is created in the <strong>Initiate</strong> stage with a status of <strong>New</strong>. An onboarding case can only be in the <strong>New</strong> state during the Initiate stage.</td>
</tr>
<tr>
<td>Initiate</td>
<td>Open</td>
<td>The state of an onboarding case state changes to <strong>Open</strong> when the case is assigned to an agent.</td>
</tr>
</tbody>
</table>
| Pre approval | Open, Awaiting Info | In the Pre-Approval stage, an onboarding case can be in either the **Open** or **Awaiting Info** states.  
The case moves to the **Awaiting Info** state when an agent clicks **Request Info**. |
| Data capture | Open, Awaiting Info | In the Data Capture stage, an onboarding case can be in either the **Open** or **Awaiting Info** states.  
The case moves to the **Awaiting Info** state when an agent clicks **Request Info**. |
| Due diligence | Awaiting Info, Under Review | In the Due Diligence stage, an onboarding case can be in the **Awaiting Info** or **Under Review** states.  
The case moves to the **Awaiting Info** state when an agent clicks **Request Info**.  
The case moves to the **Under Review** state when an agent clicks **Submit for Review**. |
| Resolve  | Review Complete, Resolved | In the Resolve stage, an onboarding case can be in either the **Review Complete** or **Resolved** states.  
The case moves to the **Review Complete** state when an agent clicks **Review Complete**.  
The case moves to the **Resolved** state when an agent clicks **Propose Solution**. |
| Close    | Closed   | The case is closed.                                                         |
**Customer Service case digests**

Use the case digests feature to provide periodic updates and resolution information about high priority customer service cases to customers and internal stakeholders.

With this feature, you can send periodic case updates while a case is in progress using a case action summary. Once a case has been resolved, you can provide a post case review document that captures details about the issue, root cause, resolution, and preventive measures.

The case digests feature uses a configuration for case action summaries and post case reviews. The configuration determines the information from a customer service case that is captured as part of the case action summary or the post case review document. The configuration also identifies the template that is used to create the summaries and review documents.

**Case action summaries**

Use a case action summary to provide updates to customers and internal stakeholders while a case is in progress.

Customer service agents typically use case action summaries to communicate information about high priority cases and mass outage cases. Case action summaries can include both internal content and customer-visible information. The summaries available to customers include only the customer-visible information. The summaries available to internal users include both customer-visible information and internal content.

Customer service agents can:

- Create case action summaries for cases that are in progress.
- Preview summaries prior to publishing.
- Publish summaries to customers and internal stakeholders or publish to customers and send email notifications to internal stakeholders.
- Update and re-send summaries as needed.

Customer service agents use the Send Case Action Summary UI action to create a case action summary. This action creates a case action summary record and adds the record to the Related Records section on the Case form in the Case Action Summary field.

Customer service agents can preview a case action summary before publishing it to a case. In the preview, internal content appears after the customer-visible information and is identified with a message: The following content is not visible to customers.
When publishing a case action summary, agents have two options.

- When an agent clicks **Publish to Case**, the system takes the following actions:
  - Adds the information from the customer-visible fields to the Additional comments field.
  - Adds the information from all fields to the Work notes field.

- When an agent clicks **Publish to Case & Notify**, the system also sends an email notification with the case action summary to the internal users included in the recipient list selected in the Additional internal recipients field.

  Note: The Publish to Case & Notify UI action is available when a list has been selected in the Additional internal recipients field.

Closing a case automatically closes the corresponding case action summary.

**Related information**

Create a case action summary

**Post case reviews**

Use a post case review document to capture details about a resolved case, including a summary of the issue, affected assets, root cause, resolution, and any preventive measures.

Customer service agents use the **Create Post Case Review** UI action to create a post case review document. This action creates a case action summary record and adds the record to the Related Records section on the Case form in the Post Case Review field.

The configuration selected for post case review documents identifies the information from the customer service case that is captured and populated in post case review record. The configuration also specifies the template that the system uses to create the post case review document.

Before publishing a post case review document to a case, agents can preview the document and, if necessary, have it reviewed and approved. Agents can add an approval group or approval users to the Post Case Review record and then request approval. The system sends an email notification to the approvers with a link to the post case review document. The approvers can either approve the document or suggest changes by adding them to the Work notes field on the Post Case Review record.

When an agent publishes a post case review document, the system adds a link to a PDF of the document in the Additional comments field on the Case form. The system also adds the record to the Related Records section on the Case form.
form in the **Post Case Review** field. If the document is available to customers, the link is visible from the Customer and Consumer Service Portals.

If a case is closed while the post case review document is in progress, agents can still update the **Additional comments** on the Case form with the post case review document link. Once a case is closed, the Post Case Review form displays a message that the associated case has been closed.

Customer service roles can perform the following actions for post case review documents.

<table>
<thead>
<tr>
<th>Role</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer service agent</td>
<td>• Create and preview one post case review document for a resolved case.</td>
</tr>
<tr>
<td></td>
<td>• Request approval using an optional approval workflow.</td>
</tr>
<tr>
<td></td>
<td>• Publish a post case review document to a case.</td>
</tr>
<tr>
<td></td>
<td>• Reopen and edit a published post case review document.</td>
</tr>
<tr>
<td>Customer service manager</td>
<td>Review, approve, and suggest changes to post case review documents.</td>
</tr>
<tr>
<td>Major issue manager</td>
<td>• Create and publish post case review documents for resolved major cases.</td>
</tr>
<tr>
<td></td>
<td>• Copy the documents to the associated child cases.</td>
</tr>
<tr>
<td>Customer</td>
<td>View post case review documents from the Customer and Consumer Service Portals.</td>
</tr>
</tbody>
</table>

**Post case reviews for major cases**

Customer service managers and major issue managers can create and publish post case review documents for resolved major cases. These documents capture the case data specified in the configuration but do not include account-specific information. The customer service manager can also copy a post case review document to the associated child cases. The system adds the
account-specific information when it generates the document for each child case.

The system administrator can enable post case review documents for major cases by setting the `sn_customerservice.parent_child_case_sync` system property to true.

**Note:** Setting this property to true disables the Create Post Case Review UI action for child cases.

### Related information
- Create a post case review
- Create a post case review for a major case

### Post case review record states
Post case review records can be in a number of different states as they are created, approved, and published.

<table>
<thead>
<tr>
<th>State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>A case review record has been created but is not yet assigned to an agent.</td>
</tr>
<tr>
<td>In Progress</td>
<td>A case review record has been created and is assigned to an agent.</td>
</tr>
<tr>
<td>Awaiting Approval</td>
<td>An agent created a case review document from the case review record and sent it to one or more approvers.</td>
</tr>
<tr>
<td>Approved</td>
<td>The case review document has been approved by one or more approvers.</td>
</tr>
<tr>
<td>Closed</td>
<td>The case review record has been closed.</td>
</tr>
</tbody>
</table>

### Post case review approvals
Enable an optional approval process for post case review documents.

In the case digest configuration, the system administrator can:
• Enable the approval process by selecting an approval workflow.
• Use a condition builder to define the conditions that determine the post case review documents that require approval.

One approval workflow, **Post Case Review - Default Approval**, is provided with the Case Digests plugin. This workflow reads the approvers from the **Approval group** and **Approval Users** fields on the Post Case Review form and sends an approval request notification to each user.

Approvers receive an email notification with a link to the post case review document. Approvers can either approve the document or suggest changes by adding them to the **Work notes** field on the Post Case Review form. The agent receives a notification when an approver approves the case review document or suggests changes.

• If the approver suggests changes, the agent can see the changes in the **Work notes** field.
• If the approver approves the document, the status of the post case review record changes to **Approved**.

**Case action summary and post case review assignment rules**

Use assignment rules to assign case action summaries and post case review documents to customer service agents.

The Case Digests plugin includes two assignment rules:

• **Auto assign the CAS to case agent**
• **Auto assign the PCR to case agent**

When an agent clicks either **Send Case Action Summary** or **Create Post Case Review** on a case record, the system creates the corresponding record and automatically assigns it to that agent.

The system administrator can modify these assignment rules or define different rules to assign case action summary and post case review records. The system populates the **Assigned to** field on the Case Action Summary or Post Case Review form with the user determined by the assignment rule. If there are no active assignment rules, the **Assigned to** field remains blank and the record can be assigned manually.

If using the provided assignment rules that auto assign the records to the same agent:
• The agent clicks **Send Case Action Summary** or **Create Post Case Review** on the Case form.

• The corresponding record opens with the agent's name in the **Assigned to** field.

• The record state is **In Progress**.

If using assignment rules that do not auto-assign the records to the same agent:

• The agent clicks **Send Case Action Summary** or **Create Post Case Review** on the Case form.

• The corresponding records are created but are not displayed.

• If assigned to another agent, the **Assigned to** field displays the agent's name and the state updates to **In Progress**.

• If unassigned, the record remains in the **New** state.

**Create a case action summary**

Create a case action summary for a customer service case.

**Before you begin**

Role required: sn_customerservice_agent, sn_customerservice_manager, or admin

**About this task**

You can send case action summaries for customer service cases that are in any states other than **New** or **Closed**.

After creating a case action summary, the record is added to the Case form in the Related Records form section. Closing a case automatically closes the corresponding case action summary.

**Procedure**

1. Open a customer service case.

2. To create a case action summary, do one of the following:

   • Agent Workspace: Click the More UI Actions icon (*** and select **Send Case Action Summary**.

   • Platform interface: Click the form context menu icon and select **Send Case Action Summary**.

This opens a new Case Action Summary form with a status of **In progress**. Depending on the table map configuration defined for the case action summary, some of the information from the case is copied to the Case Action
Summary form. With the CAS Configuration, this includes the information from the Short description field.

**Note:** The Short description field on the Case Action Summary form can be edited in the platform interface but cannot be edited in Agent Workspace.

3. In the Case Action Summary form, enter any necessary information in the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional internal recipients</td>
<td>Select a recipient list. When an agent clicks <strong>Publish to Case &amp; Notify</strong>, the system sends an email notification to the internal users in the selected list.</td>
</tr>
<tr>
<td>Short description</td>
<td>The short description from the case.</td>
</tr>
<tr>
<td>Case summary</td>
<td>A brief summary of the case.</td>
</tr>
<tr>
<td>Actions taken</td>
<td>Details about actions taken so far to resolve the case.</td>
</tr>
<tr>
<td>Next steps</td>
<td>The steps that the agent is planning to take in order to resolve the case. This field is not customer visible.</td>
</tr>
<tr>
<td>Internal notes</td>
<td>Other internal information that the agent wants to share regarding the case. This field is not customer visible.</td>
</tr>
</tbody>
</table>

4. Click **Preview** to generate the case action summary and view it in the Preview Document pop-up window.

5. **Optional:** Make any desired changes to the fields on the Case Action Summary form and click **Preview** again.

6. Click **Update** to save the changes to the case action summary.

7. Publish the case action summary using one of the following actions.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publish to Case</td>
<td>Updates the case with the case action summary.</td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Information from the customer-visible fields on the case action summary is added to the <strong>Additional comments</strong> field on the Case form.</td>
<td></td>
</tr>
<tr>
<td>Information from the case action summary is added to the <strong>Work notes</strong> field on the Case form.</td>
<td></td>
</tr>
<tr>
<td>Publish to Case &amp; Notify</td>
<td>Updates the case with the case action summary as described above and sends an email with the case action summary to the internal stakeholders in the recipient list selected in the <strong>Additional internal recipients</strong> field.</td>
</tr>
</tbody>
</table>

### Create a post case review

Create a post case review document for a resolved case that captures the configured case information.

#### Before you begin
Role required: sn_customerservice_agent, sn_customerservice_manager, or admin

#### About this task
You can create post case review documents for customer service product cases that are in the **Resolved** state. Creating a review document is a multi-step process that involves:

- Creating a post case review record from a case.
- Previewing the generated review document and making any corrections.
- Requesting approval, if necessary.
- Publishing the review document so that it is available to customers, internal stakeholders, or both.

You can create one post case review document per case. If this document has already been created, the **Create Post Case Review** menu option is not
available. You can view and edit the post case review document from the Related Records form section.

If a case is closed while the post case review is in progress, you can still update the Additional comments field on the Case form with the Post Case Review document link. When the case is closed, the system displays a message about the case closure on the Post Case Review form.

Procedure
1. Open a customer service case in the Resolved state.
2. To create a post case review record, do one of the following:
   - Agent Workspace: Click the More UI Actions icon (…) and select Create Post Case Review.
   - Platform interface: Click the form context menu icon and select Create Post Case Review.
3. In the Post Case Review form, enter any necessary information in the following fields.
   Some information is copied from the Case form to the Post Case Review form, such as the short description and the resolution information.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The automatically assigned post case review record number.</td>
</tr>
<tr>
<td>Case number</td>
<td>The case number from which this post case review record was created.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The agent assigned to the post case review record.</td>
</tr>
<tr>
<td>Commitment Date</td>
<td>The expected completion date of the post case review.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>The group assigned to the post case review record.</td>
</tr>
<tr>
<td>Approval group</td>
<td>The group assigned to review and approve the post case review record.</td>
</tr>
<tr>
<td></td>
<td>This field is visible if an approval workflow is selected in the case digest configuration.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Approval users</td>
<td>The users assigned to review and approve the post case review record. This field is visible if an approval workflow is selected in the case digest configuration.</td>
</tr>
<tr>
<td>Short description</td>
<td>Copied from the Short description field on the Case form.</td>
</tr>
<tr>
<td>Summary</td>
<td>A summary of the issue.</td>
</tr>
<tr>
<td>Symptoms</td>
<td>Specific symptoms or problems created by the issue.</td>
</tr>
<tr>
<td>Root Cause Analysis</td>
<td>Copied from the Cause field in the Resolution Information section on the Case form.</td>
</tr>
<tr>
<td>Solution Provided</td>
<td>Copied from the Resolution notes field in the Resolution Information section on the Case form.</td>
</tr>
<tr>
<td>Preventive Measures Taken</td>
<td>Any measures taken to prevent the issue from happening.</td>
</tr>
<tr>
<td>Work notes list</td>
<td>Internal users who receive a notification about this case when work notes are added.</td>
</tr>
<tr>
<td>Work notes</td>
<td>Information about how to resolve a customer service case, or steps taken to resolve it, if applicable.</td>
</tr>
<tr>
<td>Activities</td>
<td>Records all activity associated with this record.</td>
</tr>
</tbody>
</table>

4. Click **Preview** to generate the review document and view it in the Preview Document pop-up window.

5. **Optional:** Make any desired changes to the fields on the Post Case Review record and click **Preview** again.
   You can edit the content in the Post Case Review record if the state is **New** or **In Progress**. Clicking **Preview** creates a preview of the document with the latest record information.

6. **Optional:** If approval is required, complete the following steps:
a. Add an Approval group.
b. Add one or more Approval users.
c. Click Request Approval.

(Optional) You can request approval for a post case review document before sharing it with customers or internal stake holders. When approval is requested, the status of the post case review moves to Awaiting Approval and the record is locked for edits.

An email is sent to the approvers with a link to the post case review document. The approvers can either approve the document or suggest changes by adding them to the Work notes field on the Post Case Review record. The agent receives a notification when an approver approves the case review document or suggests changes.

• If the approver suggests changes, the agent can see the changes in the Work notes field.
• If the approver approves the document, the status of the post case review record changes to Approved.

7. Click Save.

8. Click Publish to Case to update the case with the Post Case Review document.
   The document is included as a link in the Additional comments field on the Case form. If the document is available to customers, the link is visible from the Customer and Consumer Service Portals.

Create a post case review for a major case

Create a post case review document for a resolved major case that captures the configured case information.

Before you begin
Role required: sn_customerservice_manager,
   sn_majorissue_mgt.major_issue_manager, or admin

About this task
You can create a post case review document for a resolved major case if the
   sn_customerservice.parent_child_case_sync is set to true.

>Note: Setting this property to true disables the Create Post Case Review UI action for child cases.
Procedure

1. Open a major case in the **Resolved** state.
2. Complete steps 2 through 7 in the **Create a post case review** topic.
3. Select one of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Publish to Case</strong></td>
<td>The system performs the following actions:</td>
</tr>
<tr>
<td></td>
<td><strong>a.</strong> Syncs the child case PCR record with the parent case PCR record.</td>
</tr>
<tr>
<td></td>
<td>(If the child case PCR record is not present, the system creates a new</td>
</tr>
<tr>
<td></td>
<td>child case PCR record.) The following fields are synced:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Assigned To</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Case Digest Configuration</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Short Description</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Root Cause Analysis</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Solution Provided</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Summary</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Symptoms</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Preventive Measures Taken</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Commitment Date</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Assignment Group</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>State</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Approval Users</strong></td>
</tr>
<tr>
<td></td>
<td><strong>b.</strong> Generates a PDF document for all of the child case PCR records with</td>
</tr>
<tr>
<td></td>
<td>customer-specific information.</td>
</tr>
<tr>
<td></td>
<td><strong>c.</strong> Adds a link to the PCR document to the <strong>Additional Comments</strong> field</td>
</tr>
<tr>
<td></td>
<td>on the child case form.</td>
</tr>
<tr>
<td><strong>Copy to Child Cases</strong></td>
<td>The system syncs the child case PCR record with the parent case PCR record.</td>
</tr>
<tr>
<td></td>
<td>(If the child case PCR record</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| is not present, the system creates a new child case PCR record.) The following fields are synced: | • Assigned To  
• Case Digest Configuration  
• Short Description  
• Root Cause Analysis  
• Solution Provided  
• Summary  
• Symptoms  
• Preventive Measures Taken  
• Commitment Date  
• Assignment Group  
• State  
• Approval Users |

**Review and approve a post case review document**

Review and approve a post case review document for a resolved case.

**Before you begin**
Role required: sn_customerservice_manager or admin

**About this task**
When a customer service agent creates a post case review document that requires an approval, the system sends an email notification to the list of approvers. This email contains the following information:

• A short description of the case and the agent assigned to the case.
• Links to the post case review and case records.
• A link to download the post case review document.
• Links to approve the document or suggest changes.

When a post case review record is in the **Awaiting Approval** state, approvers can access the **Approve** and **Suggest Changes** UI actions.
Procedure
1. Click the link in the email to download the post case review document.
2. Review the document.
3. To suggest changes to the document:
   a. Click the link in the email to suggest changes. Alternately, click the link to open the post case review record and then click Suggest Changes.
   b. Add the information in the Work notes field on the Post Case Review record.
4. To approve the document:
   • Click the link in the email to approve the document.
   • Click the link to open the post case review record and then click Approve. The state of the post case review record changes to Approved.

Re-open a post case review document
Re-open an approved post case review document if you need to make changes or update information.

Before you begin
Role required: sn_customerservice_agent, sn_customerservice_manager, admin

About this task

Procedure
1. Open a customer service case.
2. In the Related Records form section, access the record in the Post Case Review field.
3. Click Re-open on the Post Case Review form. The status of the record reverts to In Progress.
4. Make the necessary changes to the fields on the Post Case Review form.
5. Click Preview to generate the review document and view it in the Preview Document pop-up window.
6. Optional: Click Request Approval.
7. Click Publish to Case.

Withdraw post case review approval
Withdraw a post case review document after sending it for approval.
Before you begin
Role required: sn_customerservice_manager or admin

Procedure
1. Navigate to Case Digest > My Post Case Reviews.
2. Click and open a post case review which is in Awaiting Approval state.
3. Click Withdraw.
   The post case review document is now in In Progress state and approvers are notified by email that the request for approval is no longer required. You can edit the post case review document and resend it for approval.

Cancel post case review
Cancel a post case review that has not been approved, rejected or no longer requested state.

Before you begin
Role required: sn_customerservice_manager or admin

Procedure
1. Navigate to Case Digest > My Post Case Reviews.
2. Click and open a post case review that you want to cancel.
3. Click Cancel.

   Note: If the post case review state was awaiting approval, approvers are notified by email that the post case review has been cancelled and approval is no longer required.

   The post case review document is now in Cancelled state.

Related information
Re-open a post case review document

Components installed with case digests
Several types of components are installed with the Case Digests plugin.

Tables
The Case Digests plugin adds the following tables:
• Case Digest Configuration (sn_csm_case_digest_config)
• Case Digest (sn_csm_case_digest_task)
• Post Case Review (sn_csm_case_digest_pcr)
• Case Action Summary (sn_csm_case_digest_cas)

The Customer Service Document Template plugin adds the following table:
• CS Document Template (sn_csm_doctemplate_template)

**Extension points**

The Case Digests plugin includes the following extension points. Customers can use these extension points to customize the publish action.

<table>
<thead>
<tr>
<th>Extension point</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_csm_case_digest.CASPublish</td>
<td>Use this extension point to alter the functionality of publishing a case action summary to a case.</td>
</tr>
<tr>
<td>sn_csm_case_digest.PCRPublish</td>
<td>Use this extension point to alter the functionality of publishing a post case review document to a case.</td>
</tr>
<tr>
<td>sn_csm_case_digest.MajorPCRPublish</td>
<td>Use this extension point to alter the functionality of publishing a post case review document to a major case.</td>
</tr>
</tbody>
</table>

**Case and account escalation**

Users with the escalation requester role can request and manage case and account escalations. Users with the de-escalator role can de-escalate cases and accounts.

You can use the escalation feature to highlight specific cases or accounts and raise awareness of important customer issues.

Escalating cases or accounts facilitates communication about an issue and enables users to track progress toward a resolution. An escalation provides increased attention to a customer issue and provides a way to track the progress made in resolving the issue. Escalation is an internal process that is not exposed to customers.

**Related information**

Case and account escalation
**Escalate a case or an account**

Users with the escalation requester role can escalate a case or account.

**Before you begin**

Role required: sn_customerservice.escalation_requester or sn_customerservice.deescalation_requester

**Procedure**

1. Navigate to the desired case or account.
2. Click the **Escalate Case** or the **Escalate Account** related link.
3. Fill in the fields on the Escalation form, as needed.

<table>
<thead>
<tr>
<th><strong>Escalation form fields</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Number</td>
</tr>
<tr>
<td>Source Record</td>
</tr>
<tr>
<td>Request Source</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Reason</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Escalation Severity</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Escalation Template</td>
</tr>
<tr>
<td>Watch List</td>
</tr>
</tbody>
</table>
4. Click **Submit**.
   If the escalation template includes an approval workflow, the approvers review the escalation request and either approve or deny the request (provide a reason).

### Manage an escalated case or account

Manage and document the progress for an escalation using the case or account escalation record.

<table>
<thead>
<tr>
<th>Before you begin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Role required: sn_customerservice_agent or sn_customerservice.consumer_agent</td>
</tr>
</tbody>
</table>

### About this task

Perform tasks such as changing the escalation severity (which may trigger a different SLA), update the escalation trend, add or remove users from the watch list, and add comments.

- **Case escalations**: When managing a case escalation, the customer service agent typically performs most of the problem resolution work directly in the case record and the escalation record is primarily used for status reporting purposes. For example, updating the escalation trend and comments to escalation stakeholders. All updates to the case escalation record are automatically replicated to the case record as work notes. The escalation SLA is also associated with the case record rather than the escalation record because that is where the agent provides regular updates.

- **Account escalations**: For account escalations, the escalation record takes on a more important role because account escalations are more serious and are often associated with multiple underlying cases. An account escalation

---

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>For account escalations, you can <strong>Add account team members to watch list.</strong></td>
<td>For account escalations, the assignment group for this account escalation.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>For account escalations, the assignment group for this account escalation.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>For account escalations, the customer service agent assigned to this account.</td>
</tr>
<tr>
<td>Request By</td>
<td>The user who requested the escalation.</td>
</tr>
<tr>
<td>Escalation Justification</td>
<td>Additional information that explains why this escalation is needed.</td>
</tr>
</tbody>
</table>
is typically assigned to an account escalation manager who works closely with multiple case owners to resolve the customer escalation. The account escalation manager can consolidate the status across the underlying cases and provide regular updates using the escalation record. Therefore, the SLA is associated with the escalation record.

**Procedure**
1. Navigate to the desired case or account escalation record.
2. Update the fields on the escalation form as needed.
3. Click **Update**.

**De-escalate a case or an account**

Users with the de-escalation requester role can de-escalate cases or accounts when the cause of the escalation is resolved.

**Before you begin**

Role required: sn_customerservice.deescalation_requester

**About this task**

**Procedure**
1. Navigate to the desired escalation record.
2. Click **De-escalate** in the form header.
   - This opens the De-escalate Case pop-up window.
3. Enter the necessary information in the **De-escalation Justification** field.
4. Click **De-escalate** on the window.
   - The state of the escalation record changes to **Closed**.

**Create cases as a proxy contact**

The proxy contact role enables employees to create cases for customer accounts and contacts. Employees can also be proxy case contacts on behalf of customers.

Assign the proxy contact role (sn_customerservice.proxy_contact) to employees in your company who are not fulfillers or do not have other CSM-specific roles.

**Note:** This role requires licensing for access to CSM applications. The proxy contact cannot co-exist with the contributor roles.

Employees with the proxy contact role can do the following:
• Create cases on behalf of customers by email, phone, chat, Virtual Agent, and from the Customer Service Portal.
• Create requests on behalf of customers from the Customer Service Portal.

When creating a case, the employee can select a customer contact or a partner contact as the case contact. The employee is also added to the case as the internal contact.

From the Customer Service Portal, employees can do the following for the cases where they are the internal contact:
• View a list of cases.
• View case details.
• Add comments or attachments to a case.
• Accept or reject a case resolution.
• View a list of related work orders.
• Check the status of a case using Virtual Agent.

Customer service agents can create cases and designate an employee with the proxy contact role as the internal contact.
• From Agent Workspace, agents can create cases for employees from interaction records.
• From connect chat sessions with employees, agents can create cases that add the employee to the Internal contact field on the Case form.

Plugin information
Activate the CSM Extension for Proxy Contacts (com.snc.csm_proxy_contacts) plugin to enable this feature. This plugin adds the following to Customer Service Management:
• The sn_customerservice.proxy_contact role.
• The ProxyContactHelper script include.
• The Internal contact field on the Case form.
• The Opened for field on the Interaction form.

Note: You need to configure the Interaction form to display the Opened for field and the Case form to display the Internal contact field.
Configure the Customer 360 ribbon component in Agent Workspace

With the workspace administrator role (workspace_admin), you can configure the Customer 360 ribbon component to display the internal contact for a case.

- If the **Contact** field (the primary field) is populated on the Case form, the Customer 360 component displays the contact information.
- If the **Consumer** field (the secondary field) is populated on the Case form, the Customer 360 component displays the consumer information.
- If the **Internal contact** field (the tertiary field) is populated on the Case form, and the **Contact** and **Consumer** fields do not contain any data, the Customer 360 component displays the internal contact (employee) information.

For more information about configuring the Customer 360 ribbon component, see Configure ribbon component attributes.

Internal contact field on Case form

When an employee with the sn_customerservice.proxy_contact role creates a case for a customer account, the **Internal contact** field on the Case form is populated with the employee’s name. This field determines case visibility for the employee. From the Customer Service Portal, employees can see cases that they have created and are identified as the internal contact.

⚠️ **Note:** This field appears on the Case form in both the platform interface and Agent Workspace.

When an agent creates a case, they can select an employee with the sn_customerservice.proxy_contact role in the **Internal contact** field.

Creating a case from the Customer Service Portal

An employee with the proxy contact role can create a case for a customer from the Customer Service Portal. As part of creating a case, the employee:

- Selects an account.
- Selects a contact from the available contacts for the account.
- Selects an asset or product for the account.
- Enters a subject and description for the case.

When the case is created, the employee is added to the **Internal contact** on the Case form.
Creating a case from an interaction record
An agent can create a case for an employee by clicking Create Case on the Interaction form. On the resulting Case form, the Internal contact field:

- Is set to the value from the Opened for field if the employee has the proxy contact role.
- Remains blank if the user in the Opened for field does not have the proxy contact role.

Creating a case via email
Employees can create a case by sending an email to the inbound email address. When the email is received, the system checks to see if the user has the proxy contact role.

- If yes, the case is created and the employee is added to the Internal contact field. The content of the email is logged in the case activity stream.
- If no, the case is not created.

Initiating a chat from the Customer Service Portal
Employees with the proxy contact role can initiate a chat with an agent directly from the Customer Service Portal or using Virtual Agent. This creates a chat request card with the employee’s name in the agent’s inbox.

- Agent Workspace: when the agent accepts the chat, the interaction record displays the employee name in the Opened for field.
- Platform: when the agent accepts the chat and creates a case a case from the chat session, the employee name is added to the Case form in the Internal contact field.

Check the status of a case using Virtual Agent
Employees with the proxy contact role can use Virtual Agent to check the status of a case where they are the internal contact.

After logging in to the Customer Service Portal and initiating Virtual Agent, use the options available with the Check Case Status topic.

Viewing work orders
From the Customer Service Portal, employees with the sn_customerservice.proxy_contact role can see work orders for the cases where they are the internal contact. Employees can also add attachments to the work orders.

In the portal header, click Support > Work Orders.
Employee notifications
The system sends an email notification to the employee in the Internal contact field on the Case form when:

- The case is opened or closed.
- Comments are added to the case.

Configure the AWA queues for the proxy contact role
Modify the Advanced Work Assignment queues and add routing conditions that support the proxy contact role and the Internal contact field on the Case form.

Before you begin
Role required: admin

About this task
Modify the following AWA queues:

- For the Case service channel: Customer Service Cases
- For the Chat service channel: Customer Service

Procedure
1. Navigate to Advanced Work Assignment > Queues.
2. Select the Customer Service Cases queue.
3. In the Work item routing condition field, add the following OR condition: Internal Contact is not empty.
4. Click Update.
5. Select the Customer Service queue.
6. In the Work item routing condition field, add the following OR condition: Roles is sn_customerservice.proxy_contact.
7. Click Update.

Outsourced Customer Service
Outsourcing is a business practice in which an enterprise hires another company or individuals to perform tasks, handle operations, or provide services that were executed by the enterprise's own employees.

Outsourced Service Providers (OSPs) are organizations that an enterprise engages to provide customer service to external customers for reasons such as regional support, different languages, seasonal availability and so on. Benefits of outsourcing services are as follows:
• Cost savings
• Increase support coverage
• Access to skilled expertise

Plugin
Users with the system administrator role can activate the Outsourced Customer Service plugin (com.snc.outsourced_service_provider).

⚠️ Note: This plugin requires the Customer Service plugin (com.sn_customerservice).

The Outsourced Customer Service plugin adds the Customer Service > Outsourced Customer Service module to the application navigator. Users with the administrator role can access this module. The administrator can assign the following roles to users:

• sn_csm_ocs.ext_manager (external OSP manager)
• sn_csm_ocs.ext_agent (external OSP agent)
• sn_csm_ocs.manager (internal OSP manager)

Outsourced Customer Service Guided Setup
Activating the Outsourced Service Provider plugin adds the Outsourced Customer Service Guided Setup section. Navigate to Outsourced Customer Service > Guided Setup and use the tasks in this section to configure Outsourced Service Providers.

Related information
Outsourced Customer Service dashboard
Configure Outsourced Customer Service
Using Outsourced Customer Service

Outsourced Customer Service dashboard
The Outsourced Customer Service dashboard lets you see the number of SLAs breached, unassigned open and resolved cases, average resolution time taken to resolve cases and so on. Use the information on this dashboard to spot problem areas and plan your case management strategy going forward. You can select and view the dashboard by choosing the OSP name.
Dashboard of all Outsourced Service Providers

<table>
<thead>
<tr>
<th>% of Open SLAs Breached</th>
<th>Average Resolution Time</th>
<th>Average CSAT</th>
<th>% of Transferred Cases</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apr 2020 19% (Δ 0.1%)</td>
<td>Apr 2020 1 days (Δ 0.2%)</td>
<td>Apr 2020 4</td>
<td>Apr 2020 241% (Δ 0.8%)</td>
</tr>
</tbody>
</table>

Dashboard with Outsourced Service Provider selected

<table>
<thead>
<tr>
<th>% of Open SLAs Breached</th>
<th>Average Resolution Time</th>
<th>Average CSAT</th>
<th>% of Transferred Cases</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apr 2020 21% (Δ 1.3%)</td>
<td>Apr 2020 1 days (Δ 0.2%)</td>
<td>Apr 2020 3</td>
<td>Apr 2020 241% (Δ 0.8%)</td>
</tr>
</tbody>
</table>

End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>External OSP Manager</td>
<td>sn_csm_ocs.ext_manager</td>
</tr>
<tr>
<td>Internal OSP Manager</td>
<td>sn_csm_ocs.manager</td>
</tr>
</tbody>
</table>

Indicators

**Outsource cases: Unassigned open cases**

Number of open cases that are unassigned to the OSP agents.

**Outsourced cases: open cases with breached SLAs**

Number of cases that have remained open past the time required by the Service Level Agreement (SLA).
Outsource cases: open cases
   Number of cases that are in open state.

Outsourced cases: Average overall CSAT
   Average customer satisfaction based on survey results. For more information about CSAT, see Customer service satisfaction surveys.

Outsourced cases: Number of resolved cases
   Number of cases that the OSP agent has worked on and moved to resolved state.

Outsourced cases: Summed duration of resolved cases
   The total time taken by the OSP agents to resolve the cases.

Outsourced cases: Number of transferred cases
   Number of cases that are transferred to a ServiceNow internal agent when an OSP agent could not resolve the case.

Breakdowns
   The Outsourced Service Provider dashboard uses the Case Assignment Group breakdown. Select one or more groups to view data for only those groups. By default, data from all groups is shown on the dashboard.

Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unassigned Open Cases</td>
<td>42</td>
<td>The number of cases that are in open state and is not yet assigned to an OSP agent. In this report, for example, there are 42 cases that are yet to be assigned. The OSP manager views the number of such cases at a glance and assigns them.</td>
</tr>
<tr>
<td>Active SLAs Breached</td>
<td>42</td>
<td>This report shows all breached SLAs that are still active. In this report, for example, there are 42 such active</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>SLAs. The OSP manager views the number of breached SLAs at a glance which helps in taking immediate action.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Targeted communications**

The Targeted Communications application provides the ability to create and send articles and emails to internal and external customers.

Users with the publications author (sn_publications.author) and publications administrator (sn_publications.admin) roles can use the Targeted Communications application to author publication articles and emails for employees, customer contacts and accounts, and consumers. Articles are available for viewing from the self-service portals and can also be sent out as email notifications.

Each publication article includes content and a specified list of recipients. Articles can also include optional email notification. Recipients lists can be created dynamically by using a condition builder to identify the desired conditions, by running scripts, or by manual file upload. Recipients can be added to or removed from a list manually and lists can have both dynamically generated and manually added records of the same type.

When creating an article, publication authors specify a publish date and an expiration date. The system uses these dates to automatically publish and expire the article. Authors can also request a review prior to publishing an article. Articles can include an optional email notification that is sent to all recipients in the recipients list when the article is published. In this email notification, all of the recipients are included in a **bcc** list to maintain privacy.

The process of publishing articles is based on workflows and two default workflows are provided: one to publish articles instantly and one that requires approval prior to publishing. Publication administrators can update workflows and add users with the publications approver (sn_publications.approver) role to perform reviews. Both authors and administrators can monitor publications and see which users have received and viewed the information.

Customer contacts and consumers can view publications by logging in to the Customer Service Portal or the Consumer Service Portal and clicking the **Publications** link in the portal header. Employees can view these publications by navigating to **Targeted Communications > Publications** in the application navigator.
Publication article stages

Publication articles progress through several stages which are displayed in a process flow formatter on the Publication form.

### Publication stages

<table>
<thead>
<tr>
<th>Stage</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Author</td>
<td>The initial state of the publication creation process.</td>
</tr>
<tr>
<td>Review</td>
<td>Publications that are waiting for review. A publication cannot be updated when it is in the <strong>Review</strong> stage.</td>
</tr>
<tr>
<td>Ready To Publish</td>
<td>Publications that have been reviewed and are ready to be published.</td>
</tr>
<tr>
<td>Published</td>
<td>Publications that have reached their <strong>Publish Date</strong>.</td>
</tr>
<tr>
<td>Expired</td>
<td>Publications that have reached their <strong>Expiry Date</strong> or that have been manually expired.</td>
</tr>
<tr>
<td>Cancelled</td>
<td>Pending publications that have been cancelled.</td>
</tr>
</tbody>
</table>

States are shown in a process flow formatter at the top of the Publication form. The current state is indicated by a blue underline. States that have been completed are indicated by a blue check mark.

### Publication lists

The Targeted Communications application menu includes several views of publication records.

#### Publications lists

<table>
<thead>
<tr>
<th>State</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Publications</td>
<td>Includes publications in the following stages:</td>
</tr>
<tr>
<td></td>
<td>• Author</td>
</tr>
<tr>
<td></td>
<td>• Review</td>
</tr>
<tr>
<td></td>
<td>• Ready to Publish</td>
</tr>
<tr>
<td></td>
<td>• Published</td>
</tr>
<tr>
<td>Draft Publications</td>
<td>Includes publications that have been created and sent for review.</td>
</tr>
</tbody>
</table>
Publications lists (continued)

<table>
<thead>
<tr>
<th>State</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expired Publications</td>
<td>Includes publications that have reached their <strong>Expire Date</strong> or have been set to <strong>Expired</strong>.</td>
</tr>
</tbody>
</table>

**Recipients lists**

Create recipients lists for active publications.

The list of recipients for an article can include internal users, accounts, contacts, and consumers. When an article is published, the recipients on this list can view the article on the Customer or Consumer Service Portal. Recipients can also receive optional email notifications.

Recipients lists are also used by the Major Issue Management application to create child cases for a major case.

Recipients lists are created in the following ways:

- By creating a list of imported users.
- By creating a dynamic list based on selected conditions.
- By creating a script.

Recipients lists can have both dynamically generated and manually added records of the same type.

The system administrator can manage a scheduled job to refresh recipient lists. This scheduled job, **Targeted Communications Refresh recipient list**, adds new recipients to each of the active published articles. The new recipients receive email notification of the article and are granted access to view the article on the portal.

**Create a recipient list by importing contact information**

Create a recipient list by importing contact information. For contacts, supported file types include xls and csv.

Multiple files can be imported into the same recipient list, with new recipients appended to the recipient list file. The system checks that the accounts and contacts exist in the system and only imports those that exist. Duplicate entries are not created. At the end of the import process, the system displays a status with the number of records imported and rejected.
The system uses the sys_id and the email address attributes to match contacts. It first looks for a matching sys_id match. If not found, it then looks for a matching email address. If neither are found, the record is rejected.

**Create a recipient list by importing account, consumer, or internal user information**

Create a recipient list by importing account, consumer, or internal user information. The supported file type is xls.

The system uses the following attributes to match the imported records:

- **Account**: Uses the sys_id and the account number. Attempts to match the sys_id. If not found, then attempts to match using the account number. If neither are found, the record is rejected.

- **Consumer and User**: Uses the sys_id or the email address. Attempts to match the sys_id. If not found, then attempts to match the email address. If neither are found, the record is rejected.

**Create a recipient list using a script**

Create a recipient list using a script with these supported entities: contact, company/account, consumer, and internal user. The output of the script is an array of sys_ids of the corresponding entity. After creating the recipient list, the system shows the total number of records identified, added to the list, and rejected.

To create a recipient list using a script, select Dynamic Condition in the Method field on the Recipients List form and enable the Show Script check box. Then create your script in the Script field.

**Add or remove an approver**

Add or remove an approver to a publication workflow.

**Before you begin**
Role required: sn_publications.admin

**Procedure**

1. Navigate to **Targeted Communications > Publication Workflow**.
2. Select a workflow.
   The approvers assigned to the workflow are displayed in the Approvers field.
3. To add an approver, click Edit Approvers next to the Approvers field and select an approver from the Users list.
This list includes users with the sn_publications.approver role. The selected user is added to the Approvers field.

4. To remove an approver, click Edit Approvers next to the Approvers field and select the approver's name. Then click Remove. The approver's name is removed from the Approvers field.

5. Click Update.

Create a recipients list
Create and save a list of users to receive targeted communications.

Before you begin
Role required: sn_publications.author, sn_publications.admin, sn_customerservice_agent, sn_customerservice_manager, sn_majorissue_mgt.major_issue_manager

About this task
A recipient list can include internal users, accounts, contacts, or consumers. Create a recipient list using any of the following methods:

- By importing a list of users.
- By creating a dynamic list based on selected conditions.
- By creating a script.

Recipients lists can have both dynamically generated and manually added records of the same type.

Note: You must create at least one recipient list before creating a publication.

Procedure
1. Navigate to Targeted Communications > Recipients Lists.
2. Click New.
3. Fill in the fields on the Recipients List form.

<table>
<thead>
<tr>
<th>Recipients List form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Type</td>
</tr>
<tr>
<td>Field</td>
</tr>
<tr>
<td>--------------</td>
</tr>
</tbody>
</table>
|             | • Contacts (customer_contacts)  
|             | • Internal Users (sys_user)  
|             | • Consumers (csm_consumer)  
|             | • Accounts (customer_account)  
| State        | The state of the recipient list.  
|             | • **New**: the list has not yet been generated. Click **Refresh Recipient List**.  
|             | • **In Progress**: the list is currently being generated. (You may only see this state when generating a very large list of recipients.)  
|             | • **Complete**: the list has been generated.  
| Method       | The method used to generate the recipient list.  
|             | • **Upload File**: create a list by uploading user information from a selected Excel .xlsx file.  
|             | • **Dynamic Condition**: create a list by selecting conditions in the condition builder or by adding a script.  
|             | ☑ **Note**: To exclude inactive users from receiving emails, use the condition builder to exclude inactive users from the recipients list.  
| Choose File  | If the **Method** is **Upload file**, download an Excel template and then select an .xlsx file that contains the user information.  
|             | The templates vary based on the entity selected in the **Type** field. For accounts, the template includes columns for sys_id and account number values. For contacts, consumers, and internal users, the template includes columns for sys_id and email values.  
| Show Script  | If the **Method** is **Dynamic Condition**, enable this check box to create a recipients list using a script. Enabling this check box displays the **Script** field.  
| Script       | The script used to create a recipients list.  
| Table        | The table that stores the user information. Depending on the selection in the **Type** field, this field displays:  
|             | • Contact [customer_contact]  
|             | • User [sys_user]  

© 2021 ServiceNow, Inc. All rights reserved.  
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.  
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Field | Description
--- | ---
• Consumer [csm_consumer]  
• Account [customer_account]  

**User Field**  
The field that references the user record in the User (sys_user) table.  
For the following types of recipient lists, this is the sys_id:  
• Contacts (customer_contacts)  
• Internal Users (sys_user)  
• Consumers (csm_consumer)

**Account Field**  
The field in the selected table that stores the account information.  
This field is displayed for the following types of recipients lists: **Accounts**.

**Conditions**  
Use the buttons in this field to build one or more conditions on the selected table. A condition is made up of a selected field, an operator, and a value. Add conditions using the AND and OR buttons. Delete conditions by clicking the Delete button to the right of a condition.

---

4. Click **Submit**.  
For recipients lists created by file upload, clicking **Submit** validates the records in the Excel file. Following validation, the system displays a pop-up window with the upload results, including valid and invalid user records.

---

**Edit a recipients list**

Edit a list of users to receive targeted communications.

**Before you begin**

Role required: sn_publications.author, sn_publications.admin, sn_customerservice_agent, sn_customerservice_manager, sn_majorissue_mgt.major_issue_manager

**About this task**

The **Recipients** related list includes the **Dynamically Added** column which displays either True or False, depending on how a record was added:
• True for records that are dynamically generated, either by using the condition builder or by running a script.

• False for records that are added manually, either by using the Edit button on the Recipients related list or by file upload.

The **Active Communication** column is set to True by default for both dynamically and manually added records. This field indicates whether or not the recipient requires active communication.

**Procedure**

1. Navigate to **Targeted Communications > Recipients Lists**.
2. Select the desired list.
3. In the **Recipients** related list, click **Edit**.
4. Use the arrows to add or remove records.
5. Click **Save**.

**Create a publication**

Create a publication with optional email notification to send to customers.

**Before you begin**

Role required: sn_publications.author or sn_publications.admin

**About this task**

Two options to consider when creating a publication:

• Include the optional email notification (default)

• Select the type of content: HTML or Wiki

After creating an article, there are two publishing options:

• **Submit**: sets the stage to **Author** and saves the publication record.

• **Send for review**: sets the stage to **Review** and sends the publication to the approver.

**Procedure**

1. Navigate to **Targeted Communications > Create New Publication**.
2. Fill in the fields on the Publication form.
## Publication form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The automatically generated publication number.</td>
</tr>
</tbody>
</table>
| Content Type  | The type of data included in the publication. Select one of the following:  
- HTML: this content can include Rich Text formatted (RTF) text, images, attachments, and links. Enter the publication data in the **Content** field.  
- Wiki: this content can include plain text. Enter the publication data in the **Wiki** field.  
The default selection is HTML. |
| Category      | If desired, select a category for the publication. The following categories are available:  
- Defect  
- Outage  
- Information |
| Recipient Lists | Select a predefined list to target specific customers. Recipient lists are created by the publication author or administrator. |
| Short Description | A brief description or title of the publication.                                                                                         |
| Publish Date  | Select the publication date as any future date. Publications are sent automatically when the publish date and time are reached.        |
| Expiry Date   | Select the expiration date. This date must be at least one day after the **Publish Date**. Publications are automatically expired when the expiry date and time are reached. |
| Skip Notification | Enable this check box if you do not want to use email notification with this publication.  
Enabling this check box disables the **Email Template** field and hides the **Include Attach Links** field. |
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong></td>
<td>If email notification is selected, all users receive the publication in an email, including consumers who do not have a login ID for the Consumer Service Portal.</td>
</tr>
<tr>
<td>Email Template</td>
<td>Select a template to use for email notification. The <strong>Publication Default</strong> email template is provided with the Targeted Communications application. Users with the sn_publications_admin role can create additional email templates.</td>
</tr>
<tr>
<td>Include Attach Links</td>
<td>Include links to any attachments in the email notification preview.</td>
</tr>
<tr>
<td>Content</td>
<td>This field appears when you select <strong>HTML</strong> as the <strong>Content Type</strong>. Enter the text of the publication in this field. HTML content can include Rich Text formatted (RTF) text, images, attachments, and links.</td>
</tr>
<tr>
<td>Wiki</td>
<td>This field appears when you select <strong>Wiki</strong> as the <strong>Content Type</strong>. Click the Wikitext button and enter the text of the publication in this field. Wiki content can include plain text.</td>
</tr>
</tbody>
</table>

3. Click one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Submit</strong></td>
<td>The stage is set to <strong>Author</strong> and the publication record is saved.</td>
</tr>
<tr>
<td><strong>Send for Review</strong></td>
<td>The stage is set to <strong>Review</strong> and the publication is sent to the approver for review. Approvers can navigate to <strong>Self-Service &gt; My Approvals</strong> to see a list of review requests.</td>
</tr>
</tbody>
</table>

**Publish a publication**

Automatically publish a publication with an optional email notification to send to customers.
Before you begin
Role required: sn_publications.author or sn_publications.admin

About this task
Publications are automatically published on the date and time selected in the Publish Date field on the Publication form. When creating a publication, set the Publish Date and the Expiry Date fields to control when the publication is automatically published and expired.

Tip: A UI action to manually publish a publication is not available out of box. If needed, the system administrator can Create a UI action and add it to the Publication form.

When creating a publication, you can also include an optional email notification that is sent to all recipients in the recipients list when the publication is published. In this email notification, all of the recipients are included in a bcc list to maintain privacy.

Tip: To exclude inactive users from receiving emails, use the condition builder to exclude inactive users from the recipients list.

Procedure
1. Navigate to Targeted Communications > Active Publications.
2. Select the desired publication.
3. View the date in the Publish Date field.
   The system automatically publishes the publication on this date and time and sends an email notification to the recipients in the recipients list.

   Tip: If the system administrator has configured a UI action, you can use this UI action to manually publish the publication.

Create a recurring publication
Use an existing publication as a template to create multiple copies of a new publication.

Before you begin
Role required: sn_publications.author or sn_publications.admin

About this task
You can specify the recurrence interval and the recurrence start and end date. The number of copies that are created are based on these settings and appear in the Publications related list on the original publication form. Each copy has a
different publish date, which is based on the interval. Each copy gets reset to the Author state and each one goes through its own workflow.

**Procedure**

1. Do one of the following:
   - Navigate to Targeted Communications > Active Publications, open the desired publication, and click the Setup Recurrence related link.
   - Navigate to Targeted Communications > Recurrences and click New.

2. Fill in the fields on the Recurrence form.

   **Recurrence form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short Description</td>
<td>A brief description or title of the publication.</td>
</tr>
<tr>
<td>Publication Template</td>
<td>The number of the publication being used as a template.</td>
</tr>
<tr>
<td></td>
<td>• If you clicked the Setup Recurrence related link, this field displays</td>
</tr>
<tr>
<td></td>
<td>the original publication number.</td>
</tr>
<tr>
<td></td>
<td>• If you clicked Recurrences in the Targeted Communications menu, select</td>
</tr>
<tr>
<td></td>
<td>a publication from the Publications list.</td>
</tr>
<tr>
<td>Recurrence Start</td>
<td>Select a date for the first occurrence of the recurring publications.</td>
</tr>
<tr>
<td>Recurrence End</td>
<td>Select a date for the last occurrence of the recurring publications.</td>
</tr>
<tr>
<td>Recurrence Interval</td>
<td>Select an interval for the recurring publications:</td>
</tr>
<tr>
<td></td>
<td>• Daily</td>
</tr>
<tr>
<td></td>
<td>• Weekly</td>
</tr>
<tr>
<td></td>
<td>• Biweekly</td>
</tr>
<tr>
<td></td>
<td>• Monthly</td>
</tr>
<tr>
<td></td>
<td>• Custom</td>
</tr>
<tr>
<td>Custom Interval in Days</td>
<td>This field appears when you select Custom as the Recurrence Interval.</td>
</tr>
<tr>
<td></td>
<td>Enter the number of days for the interval.</td>
</tr>
</tbody>
</table>

3. Click Submit.
The recurring publications are created based on the selected dates and the recurrence interval and the stage for each copy is set to Author. The copies appear on the Publications related list on the original publication form, as well as on the Active Publications and the Draft Publications lists. From any of these lists you can open each publication and change the information as necessary. Each copy lists the publication template number in the Recurrence field.

A record of the recurrence appears on the Recurrences list.

Preview an email notification

Preview an email notification for a publication before it is sent to customers.

Before you begin
Role required: sn_publications.author or sn_publications.admin

About this task
Preview the following information for an email notification:

- The recipient list
- The subject of the publication
- The text of the publication and any attachments.

Procedure

1. Navigate to one of the following:
   - Targeted Communications > Active Publications
   - Targeted Communications > Draft Publications
2. Select the desired publication.
3. Click the Preview Target Email related link.
4. View the email notification in the Notification Preview window.
5. If desired, view the publication on the customer portal by clicking the link in the body of the email.
6. Close the Notification Preview window.
   Once the publication has been published, the customers in the recipient list should receive the email.

Update a publication

You can make changes to a publication that is in the Author or Review stages.
Before you begin
Role required: sn_publications.author or sn_publications.admin

Procedure
1. Navigate to one of the following:
   • Targeted Communications > Active Publications
   • Targeted Communications > Draft Publications
2. Open the desired publication.
   The stage of the publication must be either Author or Review.
3. Make the desired changes.
4. Click Update.

Send a publication for review
You can send a publication for review if it is in the Author stage.

Before you begin
Role required: sn_publications.author or sn_publications.admin

Procedure
1. Navigate to one of the following:
   • Targeted Communications > Active Publications
   • Targeted Communications > Draft Publications
2. Select a publication in the Author stage.
3. Click Send For Review.
   The publication stage is set to Review and the approvers are added to the Approvers related list on the Publication form.
   
   Approvers can navigate to Self-Service > My Approvals to see a list of review requests. Approvers also receive an email notification about the review request.

Review a publication
Users with the publications approver role that have been added as approvers to the publication workflow can review a publication.

Before you begin
Role required: sn_publications.approver or sn_customerservice_manager
About this task
After reviewing, an approver can either accept or reject a publication. If an approver does not review a publication before the Publish Date, the publication cannot be approved. The Approve button is not displayed and the approver sees a message that the publish date and time has passed. The approver can only reject the publication, which returns it to the Author stage.

The Approvers related list displays a list of approval tasks and includes most recent comment from each approver.

Procedure
1. Navigate to Self-Service > My Approvals.
2. Select a publication for review from the Approvals list that has a state of Requested.
3. Review the publication summary at the bottom of the approval form.
4. Add review comments to the Comments field.
5. Click one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approve</td>
<td>The review state changes to Approved on the Approvals list and the publication stage is set to Ready To Publish. For other approvers of this article, the review state changes to No Longer Required.</td>
</tr>
<tr>
<td>Reject</td>
<td>The review state changes to Rejected on the Approvals list and the publication stage is set to Author.</td>
</tr>
</tbody>
</table>

View the list of approvers for a publication
If a publication article has been sent for review, you can see the assigned approvers on the Publication form.

Before you begin
Role required: sn_publications.author or sn_publications.admin
Procedure
1. Navigate to one of the following:
   - Targeted Communications > Active Publications
   - Targeted Communications > Draft Publications
2. Open the desired publication.
3. Click the tab for the Approvers related list.
   The Approvers list includes the users with the publications approver role that have been added as approvers to the publication workflow.

Track a publication
Access a list of recipients for a publication and see which recipients have viewed the content.

Before you begin
Role required: sn_publications.author or sn_publications.admin

About this task

Procedure
1. Navigate to Targeted Communications > Active Publications.
2. Open the desired publication.
3. Click the Publication Recipients related list.
   For each recipient on this list, you can see if the customer has viewed the article.

Expire a publication
Expire a published article before it reaches the Expiry Date.

Before you begin
Role required: sn_publications.author or sn_publications.admin

Procedure
1. Navigate to Targeted Communications > Active Publications.
2. Select an article that has been published.
3. Click **Expire**.
   The publication **Expiry Date** is set to the current date. The publication is removed from the Active Publications list and appears on the Expired Publications list.

**Cancel a publication**

Cancel a pending publication before it reaches the publish date.

**Before you begin**
Role required: sn_publications.author or sn_publications.admin

**About this task**
You can cancel a publication in any of the following stages: **Author**, **Review**, or **Ready to Publish**.

**Procedure**

1. Navigate to one of the following:
   - **Targeted Communications > Active Publications**
   - **Targeted Communications > Draft Publications**
2. Select the desired publication.
3. Click **Cancel**.
   The stage of the publication changes to **Cancelled**.

**View a publication**

Internal customers can view the details of a publication from the Targeted Communications menu.

**Before you begin**
Role required: none

**Procedure**

1. Navigate to **Targeted Communications > My Publications**.
2. Select a publication from the Publications list.

**Workspaces in Customer Service Management**

A workspace is a suite of tools that provides customer service agents with the tools they need to help answer customer questions and resolve customer issues.
A workspace is a collection of tasks and workflows in a single focused working area that enables a user to efficiently complete an entire job. It includes tools that a user can employ to quickly and easily assist customers and resolve questions and issues. A workspace also includes features that enable a user to be more efficient, including a multi-tab interface for managing multiple cases and a contextual display that provides quick orientation to the current task.

Customer Service Management provides the following workspaces:

- CSM Configurable Workspace
- CSM Agent Workspace

These workspaces operate the same way and provide an identical user experience. The main difference between the two workspaces is the underlying architecture and that they are built using different technology. For more information, see Selecting a CSM Workspace interface.

**Workspace in action**

Here’s how agents use Workspace.

Workspace overview.

**Get started**

Select a tile to get started.

<table>
<thead>
<tr>
<th>Explore CSM Workspaces</th>
<th>Admins using Workspace</th>
<th>Agents using Workspace</th>
</tr>
</thead>
<tbody>
<tr>
<td>Learn about CSM Workspace concepts and features</td>
<td>Set up CSM Workspaces and features</td>
<td>Use CSM Workspaces to assist customers</td>
</tr>
</tbody>
</table>

**Exploring CSM Workspaces**

Get an overview of workspace so you can understand how to set it up and use it for your organization.
Support for different types of agents

Workspace is a single-pane view that tier 1 agents use to respond to all task types, view the full context of an issue, and get relevant recommendations to resolve issues.

Customer service agents can use the CSM workspaces to interact with customers, respond to inquiries, and resolve issues. The intuitive interface supports customer service agents that work in different types of environments including:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Chat/SMS agents</td>
<td>Handle customer chat and SMS requests.</td>
</tr>
<tr>
<td>Phone agents</td>
<td>Handle customer phone inquiries.</td>
</tr>
<tr>
<td>Case agents</td>
<td>Handle cases that are created from the Customer or Consumer Portals or from inbound emails.</td>
</tr>
<tr>
<td>Location agents</td>
<td>Handle cases that are created from walk-up interactions.</td>
</tr>
</tbody>
</table>

Key features

Single-pane view

See all details that are related to a case in one place.
**Multi-tab view**

Open multiple cases and related records in multiple tabs and sub-tabs. Switch easily between these tabs to handle multiple chats, calls, or inquiries from customers.

**Integrated communication channels**

Communicate in real time with customers by chat, phone, SMS, or walk-up in the same interface.
**Integrated email client**

Agents can compose emails while also having access to the activity stream.
Agent assistance

Resolve cases faster with AI-assisted recommendations.

Playbook

Accomplish business process workflows in a simple, task-oriented view.
Selecting a CSM workspace interface

You can choose to configure and use either CSM Configurable Workspace, CSM Agent Workspace, or both.

Consider the following benefits to determine which workspace is the right choice for your agents.

**CSM Configurable Workspace**

If you need to configure and extend the workspace provided with CSM, or if you need to theme your workspace for different brands within the same instance, consider using the CSM Configurable Workspace. With this workspace, you can:

- Quickly configure page layouts and components in UI Builder.
- Extend and deploy custom components into the workspace.
- Leverage UI Builder components to build additional solutions.

UI Builder is a WYSIWYG web user interface builder that enables you to quickly build pages for workspace and portal web-based experiences. The CSM Configurable Workspace is built using UI Builder functionality.
For more information about this tool, see UI Builder.

For more information about working with components in UI Builder, see Work with components.

For more information about available components, see https://developer.servicenow.com/dev.do#!/reference/now-experience/rome/components.

CSM Agent Workspace

If you need to integrate Customer Service Management with other ServiceNow applications, such as ITSM, ITOM, or PPM, consider using the CSM Agent Workspace.

CSM Agent Workspace enables you to integrate Customer Service Management with the following applications:

- **IT Service Management (ITSM):** Use this integration to create request, incident, problem, and change records from customer service cases and enable external users to view these records from the Customer and Consumer Service Portals.

- **IT Operations Management (ITOM):** Use this integration to create cases proactively from alerts either manually or through automation and track the accounts and the corresponding install base items affected by the alert.

- **Customer Project Management (CPM):** Use this integration to create projects and project tasks for your customer accounts and provide end users with visibility into their projects and tasks from the Customer Service Portal.

**Note:** To use the tasks and workflows provided with these integrations, be sure to configure CSM Agent Workspace.

CSM workspace features

There are several features available in the Customer Service Management workspaces that agents can use to assist customers and resolve cases.

CSM workspace interface features

Use these topics to get an overview of the CSM workspace interface, landing pages, and forms.
## Feature

### CSM workspace interface overview
Provides an overview of the CSM workspace interface and the different areas and components that make up the interface.

### CSM Workspace landing pages
Provides customer service agents with an overview of their new, assigned, and high priority cases, plus the cases assigned to their groups.

### CSM workspace form features
Provides an overview of form headers, agent actions, account hierarchy, special handling notes, related lists, and Agent Assist.

### CSM workspace form ribbon and components
Provides agents with a quick overview of the case details. Components in the form ribbon display relevant information about the case, including a contact or consumer summary, a timeline, and SLA details.

## Additional features

A number of additional features are available for use with CSM workspaces.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AWA for CSM</td>
<td>Use Advanced Work Assignment (AWA) to automatically assign work items to agents based on their availability, capacity, and skills.</td>
</tr>
<tr>
<td>Workforce Optimization for Customer Service</td>
<td>Use Workforce Optimization to manage and maintain the productivity of your workforce. Efficiently route work to your team, manage your team’s skills and schedules, and monitor their performance.</td>
</tr>
<tr>
<td>Customer Central</td>
<td>Use Customer Central to provide agents with all of the information about a customer in one central location. This feature enables agents to quickly zoom in on the customer</td>
</tr>
</tbody>
</table>
### Feature | Description
--- | ---
Customer Service Case Types | Use case types to handle different types of customer issues. A case type identifies the processes and the data needed to resolve a specific type of issue, such as a lost or missing credit card.
Proactive Customer Service Operations | Use this feature to track the digital services used by your customers and to proactively create cases for service disruptions.
Playbooks for Customer Service Management | Use playbooks to provide step-by-step guidance for completing the tasks needed to resolve specific types of customer service cases.
Guided Decisions for Customer Service Management | Use guided decisions to resolve complex cases faster and more efficiently by guiding customer service agents through a structured troubleshooting process.
Lookup and verify | Use this feature to enable agents to quickly look up contacts or consumers using information such as the name, phone number, or record number.
Case action status | Use the case action status feature so that agents can easily identify cases that need attention.
Estimated time to resolve a case | Use machine learning to predict the estimated time to resolve a case (ETTR) based on case attributes such as the short description, category, priority, and assignment group.

### CSM workspace interface overview
Get an overview of the CSM workspace and how it works.
Features

Manage multiple cases, accounts, and customers using these features available in both CSM Configurable Workspace and CSM Agent Workspace.

<table>
<thead>
<tr>
<th>Number</th>
<th>Workspace feature</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1      | Multi-tab interface | Use tabs to easily navigate between multiple open records.  
• Case records open in top-level tabs.  
• Associated records, such as accounts and contacts, open in sub-tabs below the top-level tab. |
<p>| 2      | Form header       | Configurable fields in the form header give you a quick summary of case, account, and contact information. |
| 3      | UI actions        | Use these buttons to perform actions such as creating a case or requesting information. |
| 4      | Ribbon            | Configurable ribbon components display a contact or consumer summary, a timeline, and active SLAs. |</p>
<table>
<thead>
<tr>
<th>Number</th>
<th>Workspace feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>Custom ribbon components</td>
<td>Create your own ribbon components and add them to the workspace. This example includes a custom component called Customer Insights.</td>
</tr>
<tr>
<td>6</td>
<td>Related lists</td>
<td>Click a tab to see the related information.</td>
</tr>
<tr>
<td>7</td>
<td>Form fields</td>
<td>The Details tab displays the form fields. For the Case form, the default layout displays case details side-by-side with the activity stream.</td>
</tr>
<tr>
<td>8</td>
<td>Activity stream</td>
<td>The activity stream displays a chronological record of case activities. For the Case form, the activity stream occupies a central location in the default layout, making it easy for agents to scroll through the case history.</td>
</tr>
<tr>
<td>9</td>
<td>Agent Assist</td>
<td>Search for information across multiple sources such as resolved cases, knowledge bases, and community sites. With Predictive Intelligence, agents can also view similar cases and recommendations about major issues and major cases. For more information, see Similar case recommendation.</td>
</tr>
</tbody>
</table>

**CSM workspace landing pages**

Landing pages provide customer service agents with an overview of their new, assigned and high priority cases, plus the cases assigned to their groups. Landing pages can also include analytics. Customer service agents use these pages to quickly scan and access cases.

The CSM Landing Page includes components that display case information, plus visualizations that further break down the component data. Each visualization is connected to a data source. For example, the My High Priority Cases component includes visualizations for P1 and escalated cases. This landing page does not require a Performance Analytics license.

To add Performance Analytics information to the CSM Landing Page, activate the Performance Analytics - Content Pack - Customer Service Management - Advanced plugin (com.snc.pa.customer_service_advanced). This plugin adds
a section for *My Organization's Performance*, which includes analytics for **CSAT** and **New vs Closed Cases**.

From the **CSM Landing Page**, agents can:

- View the case information presented in each component.
- Drill into each component to see the case list behind the single score.
- Navigate to individual records from the case lists.

From the CSM Landing Page (PA version), which includes analytics, agents can also:

- View a single score component.
- View a time series component.

---

**Create a landing page for CSM Configurable Workspace**

Use UI Builder to create landing pages for your agents. For more information, see the following topics:

- Create a CSM Configurable Workspace landing page
- Creating custom landing pages for workspaces
- Create a custom landing page in UI Builder

**Create a landing page for CSM Agent Workspace**

With the CSM Agent Workspace administrator role (workspace_admin) or the system administrator role (admin), you can create landing pages for different
agents and teams by cloning the existing **CSM Landing Page**. After cloning this page, you can add or edit containers, visualizations, and page and container layout.

For more information, see the detailed steps in **Create a CSM Agent Workspace landing page**.

**Create multiple landing pages**

You can create multiple landing pages. However, only a single landing page is displayed for a user. The landing page that is displayed for a user depends on the following settings:

- The setting of the **Active** field. This field must be set to true for a landing page to be displayed.
- The **Order** of the landing page. Pages with a lower order value take precedence over pages with a higher order value.
- If permissions are defined, users can see a landing page if they have the required role or are a member of the required assignment group. Multiple roles and assignment group conditions are treated as OR conditions.

**CSM workspace form features**

Workspace form features include form headers, agent actions, related lists, account hierarchy, and special handling notes.

**Form headers**

Form headers provide a quick glance of case, account, or contact information. Form headers include a primary header and several secondary or subheaders.

You can configure the information included in the header for the Case, Account, and Contact forms.
<table>
<thead>
<tr>
<th>Form</th>
<th>Primary Header</th>
<th>Secondary Headers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case</td>
<td>Short description</td>
<td>• Account and contact (B2B)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Consumer (B2C)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Priority</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• State</td>
</tr>
<tr>
<td>Account</td>
<td>Account</td>
<td>Primary contact</td>
</tr>
<tr>
<td>Contact</td>
<td>Contact</td>
<td>Account</td>
</tr>
</tbody>
</table>

For more information about configuring form headers:

- **CSM Agent Workspace**: See Set up form headers in workspace.
- **CSM Configurable Workspace**: See Set up a form header in CSM Configurable Workspace.

**Note**: One form header configuration, **CSM/FSM Configurable Workspace Header Config**, is included with CSM Configurable Workspace.

**Account hierarchy**

From the Account form, customer service agents can click the open hierarchy icon (🔍) in the **Name** field to see the parent-child account relationships in the Account Hierarchy pop-up window. The account hierarchy is available for accounts that have a parent or child account.

*CSM workspace Account Hierarchy pop-up window*

**Account Hierarchy**

- **Parent View**
  - [ ]

- **Boxeo**
  - **Boxeo EMEA (Current Account)**
  - Boxeo Canada
  - Boxeo USA

The account hierarchy uses a tree structure to show the parent, child, and sibling accounts. The parent view displays the current account, the parent account (if
applicable), and any child or sibling accounts. The full view displays the entire structure of the organization from the root account. The current account is highlighted in the account structure.

Customer service agents can:

• Expand and collapse the tree structure.
• Switch between the parent view and the full view of the account hierarchy.
• Click an account to open the Account form in a sub tab.

For information about creating an account hierarchy, see Account hierarchy.

Special handling notes

Special handling notes bring important information about individual records to the attention of the customer service agent. If special handling notes are available for a record, these notes are displayed in a pop-up window when the record is opened in a CSM workspace. Notes can also be displayed in an embedded list or a related list on a record form. Notes are ordered by priority in the pop-up window and in lists.

Agents can see the priority, short description, and message for each note. A note can be assigned one of the following priorities, which also have associated colors.

• Priority 1 — red
• Priority 2 — orange
• Priority 3 — purple
• Priority 4 — gray
Agents can:

- Dismiss individual notes. When all notes are dismissed, the pop-up window closes.
- Close the window.

In the Special Handling Notes module on the platform interface:

- Users with the sn_shn.admin role can configure special handling notes and specify properties.
- Users with the sn_shn.admin or sn_customerservice_manager roles can create special handling notes.

For more information about configuring the special handling notes feature, see Special handling notes overview.

Agent actions

Actions available to customer service agents appear in the form header as buttons or menu items.
• For CSM Agent Workspace, actions must be enabled for each form by the workspace administrator. For more information, see Set up custom UI actions in Workspace.

• For CSM Configurable Workspace, you can link UI actions to form actions. For more information, see Set up a form action in CSM Configurable Workspace.

The Create Knowledge action requires the following setup:
• Activate the Knowledge Management Advanced Installer plugin (com.snc.knowledge_advanced.installer).
• Set the sn_customerservice.enable_knowledge_kcs property to true.
• Set the KCS Article template to true (navigate to Knowledge > Administration > Article Templates).

Related lists
The Interaction form includes the following related lists in CSM Agent Workspace. Clicking a record in a related list opens that record in a sub tab.
• Details
• Related Tasks: includes the cases and case tasks that have been created for this interaction.
• Recent Interactions: includes interactions that have been created for the current contact or consumer.
• Open Cases: includes open cases that have been created for the current contact or consumer.

The Case form includes the following related lists in CSM Agent Workspace. Clicking a record in a related list opens that record in a sub tab.
• Details
• SLAs
• Tasks
• Interactions: stores the channel and direction of each interaction associated with the case, either inbound or outbound. This related list also appears on the Account, Contact, and Consumer entity records.
• Emails
• Task Skills
• Attached Knowledge
• Escalations
• Special Handling Notes List
• Requests
• Appointments
• Social Logs
• Blocked by

Agent Assist
Agent Assist is available on the Interaction form in CSM Agent Workspace. Users with the customer service agent role (sn_customerservice_agent) can use Agent Assist to search for information from an interaction. By default, the available search sources include Knowledge articles, Service Catalog, and Now Community blogs and posts.

For more information, see Set up Agent Assist.

CSM workspace form ribbon and components
The form ribbon provides agents with a quick overview of the case details. The form ribbon includes components that display relevant information about the case. These components can include a contact or consumer summary, a timeline, and SLA details.

In addition to viewing case information, agents can use links in the ribbon components to place phone calls or create email messages. Agents can also show or hide the ribbon as needed by clicking a button at the top of the ribbon.

Customer Service Management ribbon components
For Customer Service Management, you can configure the ribbon for the Case form to include one or more of the available ribbon components:
• Customer 360
• Timeline
• Active SLAs
• Time to resolve component

Customer 360 ribbon component
The Customer 360 component displays customer information such as the contact or consumer name, email address, and phone numbers.
You can configure the Customer 360 component to display different fields, such as the fields described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header</td>
<td>The header includes customer information.</td>
</tr>
<tr>
<td></td>
<td>• For B2B customers: Displays either the Primary Contact or Contact.</td>
</tr>
<tr>
<td></td>
<td>• For B2C customers: Displays the Consumer.</td>
</tr>
<tr>
<td></td>
<td>• For internal contacts with the proxy contact role (sn_customerservice.proxy_contact): Displays the Internal contact.</td>
</tr>
<tr>
<td></td>
<td>⚠️ Note: Requires the CSM Extension for Proxy Contacts (com.snc.csm_proxy_contacts) plugin.</td>
</tr>
<tr>
<td>Avatar</td>
<td>A graphic representation of the customer's identity, such as an image or icon.</td>
</tr>
<tr>
<td>Name</td>
<td>The customer's name.</td>
</tr>
<tr>
<td>Title</td>
<td>The customer's title.</td>
</tr>
<tr>
<td>Account</td>
<td>For B2B customers, the account associated with the contact.</td>
</tr>
<tr>
<td>Phone numbers</td>
<td>• For contacts: Mobile phone and Business phone</td>
</tr>
<tr>
<td></td>
<td>• For consumers: Mobile phone and Home phone</td>
</tr>
<tr>
<td>Email address</td>
<td>The customer's email address.</td>
</tr>
</tbody>
</table>
If you configure the Customer 360 ribbon component to display information from a dot-walked field, the label for that field shows the Column name instead of the Table.Column name.

Note: For B2B customers, the Customer 360 component can also include colored tags that indicate Very Important Person (VIP) accounts and escalated accounts.

From the Customer 360 ribbon component, agents can perform the following actions.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Email a contact or consumer | Agents click the address in the Email field to send an email to the contact or consumer. This action opens a new email in the email editor with the following fields auto-populated:  
  • To: the contact or consumer email address  
  • Subject: the case number and short description |
| Call a contact or consumer | If phone integration is enabled, agents click a number in one of the phone number fields to call the contact or consumer. The OpenFrame window displays information about the contact or consumer name and the account. |
| View the account record | Agents click the Account link to open the account record. |

**Timeline ribbon component**

The timeline component displays a chronological summary of case activities, including case state changes and interactions between the agent and the requester (typically the customer). It also shows how much time that the fulfiller and requester spent on the case.

Note: The workspace administrator can select the agent role when configuring the timeline component attributes.
The timeline uses icons to display events and colors to show ranges of time, such as when the case is with the agent or the customer. Agents can point to event icons in the timeline to display tooltips with additional information.

**Note:** The timeline component uses the resolution shaper configuration for the selected entity table, for example, the Case table.

The timeline includes the following features:

<table>
<thead>
<tr>
<th>Timeline feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global start and end dates</td>
<td>The global start date is the date that the case was created. The global end date is the date that the case was closed.</td>
</tr>
</tbody>
</table>
| Start and end dates    | The start and end dates that identify a specific window of time on the timeline. The default window is one week.  
  - The default end date is the current date.  
  - The default start date is the current date minus 7 days. |
<p>| Header                 | A configurable title for the timeline. With the system administrator role, you can add a title in the Name field on the Ribbon Setting form. |
| Legend                 | Click Show Details to display event and range summary information. |</p>
<table>
<thead>
<tr>
<th>Timeline feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Events</strong></td>
<td>Events are represented on the timeline using icons. Each type of event has a corresponding unique icon. The time that an event occurred is also captured so that events are displayed on the timeline in chronological order.</td>
</tr>
<tr>
<td><strong>Grouped events</strong></td>
<td>Events that occur close together can be grouped and represented using a group icon. When events are grouped, the timeline displays a badge icon with the number of events in the group.</td>
</tr>
<tr>
<td><strong>Event summaries</strong></td>
<td>Event summaries appear in the timeline legend. Each summary lists the event and the number of times it occurred.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> An event summary includes occurrences of the event over the life of the object visualized on the timeline.</td>
</tr>
<tr>
<td><strong>Time ranges</strong></td>
<td>Time ranges are represented on the timeline using colors. Each range has a corresponding unique color and a start and end time. The following default ranges include:</td>
</tr>
<tr>
<td></td>
<td>• Blue: with the agent</td>
</tr>
<tr>
<td></td>
<td>• Green: with the customer</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Events</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📢 Agent Action</td>
<td>5</td>
</tr>
<tr>
<td>🔴 Customer Action</td>
<td>3</td>
</tr>
<tr>
<td>✅ Case Closed</td>
<td>1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Ranges</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🟰 New</td>
<td>2 hours</td>
</tr>
<tr>
<td>🟠 Time With Agent</td>
<td>11 hours</td>
</tr>
<tr>
<td>🟢 Time With Customer</td>
<td>2 days</td>
</tr>
<tr>
<td>Timeline feature</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Time range summaries</td>
<td>Time range summaries appear in the timeline legend. Each summary lists the range, the corresponding color, and the total duration.</td>
</tr>
<tr>
<td>Note:</td>
<td>A range summary includes occurrences of the range over the life of the object visualized on the timeline.</td>
</tr>
<tr>
<td>Tooltips</td>
<td>Point to event icons to display additional information.</td>
</tr>
<tr>
<td>Zoom</td>
<td>Zoom in on the timeline to see more details in a smaller time window or zoom out to see more events in a larger time window.</td>
</tr>
<tr>
<td></td>
<td>• Click the zoom in or zoom out icons on the timeline.</td>
</tr>
<tr>
<td></td>
<td>• Use the zoom in and zoom out features on the keyboard (Ctrl + + and Ctrl + -).</td>
</tr>
<tr>
<td></td>
<td>• Use the zoom in and zoom out features on the cursor.</td>
</tr>
<tr>
<td>Pan</td>
<td>Pan left and right to view newer or older events.</td>
</tr>
<tr>
<td></td>
<td>• Pan left in the timeline to view older events by clicking the left caret icon (&lt;). Panning to the left stops when the timeline reaches the specified global start date.</td>
</tr>
<tr>
<td></td>
<td>• Pan right in the timeline to view newer events by clicking the right caret icon (&gt;). Panning to the right stops when the timeline reaches the specified global end date.</td>
</tr>
<tr>
<td>Reset the timeline</td>
<td>Click <strong>Now</strong> to reset the timeline to the default view after panning or zooming. The timeline resets using the</td>
</tr>
</tbody>
</table>
### Timeline feature

<table>
<thead>
<tr>
<th>Timeline feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>time that the button was clicked as the end date and time.</td>
<td></td>
</tr>
</tbody>
</table>

**Messages**

The timeline displays messages for the following events:
- There is no data to be displayed.
- The timeline experiences a loading error.

### Active SLA component

The Active SLA component displays active SLAs for the case, including time remaining, the SLA state, and any breaches. If a case has multiple SLAs, the SLA with the most imminent deadline is shown first. Pointing to the SLA component displays left and right navigation arrows that agents can use to view the other SLAs.

### SLA ribbon component

Color coding within the component indicates the time remaining for the SLA:
- **Green**: 0–50%
- **Yellow**: 50–75%
- **Orange**: 75–99%
- **Red**: 100% or breached

### Time to resolve component

The time to resolve component displays the estimated time required for an agent to resolve the case.
Note: The time to resolve component requires the Predictive Intelligence for Customer Service Management plugin (com.snc.csm_ml). For more information, see Estimated time to resolve a case.

In this image, the estimated time that the agent will need to resolve the opened case is 0 to 2 days. Hence, the upper bound value is displayed. The estimated time is calculated from the time the case was created. If the range for example, is between 2 to 4 days, both the lower and upper bound values are displayed.

The Time to resolve component also displays the prediction for SLA breach if the case is attached to an SLA.

Following are a list of SLA messages displayed and the action required when they appear.

<table>
<thead>
<tr>
<th>SLA messages</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>No resolution SLA exists for this case</td>
<td>Set the value in the Target field to Resolution in the SLA Definition form.</td>
</tr>
<tr>
<td>Repair resolution SLA to add breach time</td>
<td>Click Repair on the Task SLA form.</td>
</tr>
<tr>
<td>Highly likely to breach resolution SLA</td>
<td>None</td>
</tr>
<tr>
<td>Highly unlikely to breach resolution SLA</td>
<td>None</td>
</tr>
<tr>
<td>Likely to breach resolution SLA</td>
<td>None</td>
</tr>
<tr>
<td>Unlikely to breach resolution SLA</td>
<td>None</td>
</tr>
</tbody>
</table>

Configuring ribbon components
You can configure ribbon components as follows:

• For CSM Agent Workspace, you can configure the ribbon layout if you have the workspace administrator role (workspace_admin). This includes the components to display in the ribbon, the order in which the components appear, and the component width. You can also configure display attributes
for some of the components. For more information about ribbon configuration, see Configure Agent Workspace ribbon settings.

For some of the components, you can also configure attributes, such as the fields to include in the Customer 360 component. For more information about configuring component attributes, see Configure ribbon component attributes.

• For CSM Configurable Workspace, you can create a ribbon setting and add that setting to a ribbon configuration. For more information, see Set up a ribbon configuration in CSM Configurable Workspace.

> **Note:** One ribbon configuration, CSM/FSM Configurable Workspace Ribbon Config, is included with CSM Configurable Workspace.

Ribbon configurations in CSM workspaces support domain separation.

**AWA for CSM**

Use the ServiceNow® Advanced Work Assignment (AWA) for Customer Service Management feature to automatically assign work items to agents based on their availability, capacity, and skills. AWA for CSM pushes work to qualified agents using work item queues, routing conditions, and assignment criteria that you define. Agents see their assignments in their Agent Workspace inbox.

**Plugins**

The Advanced Work Assignment for CSM is available with the Customer Service plugin (com.sn_customerservice).

To use the shift-based assignment feature for customer service cases, you must enable the Workforce Optimization for Customer Service plugin (com.snc.wfo.csm) in addition to the Advanced Work Assignment plugin (com.glide.awa). For more information, see Activate Workforce Optimization for Customer Service.

To use the chat feature with Advanced Work Assignment for CSM, you must also activate the Agent Chat plugin (com.glide.interaction.awa).

For more information, see Activate related plugins for Advanced Work Assignment.

**Inbox layouts**

Three chat inbox layouts are included with the Chat service channel.

<table>
<thead>
<tr>
<th>Chat Layout</th>
<th>Included Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Chat Layout</td>
<td>Short description</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Chat Layout

<table>
<thead>
<tr>
<th>Included Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact Chat Layout</td>
</tr>
<tr>
<td>Consumer Chat Layout</td>
</tr>
</tbody>
</table>

Two case inbox layouts are included with the Case service channel.

### Case Layout

<table>
<thead>
<tr>
<th>Included Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Case Layout</td>
</tr>
<tr>
<td>Consumer Case Layout</td>
</tr>
</tbody>
</table>

### Variable work item sizing

Organizations may like to size cases based on the complexity of the case, time and effort required to complete work. This helps in estimating agent utilization accurately. Advance work assignment currently treats every case as one unit of work. However, sometimes, certain cases may require more work than others. These cases may account for a greater share of an agent’s capacity. Work item sizing allows to size the case differently based on the case attributes. For more information, see Service channel capacity and utilization.

### Agent affinity

Agent Affinity is an Advanced Work Assignment enhancement that enables you to streamline the routing of work items. Advanced Work Assignment automatically assigns work items based on historical, task-based, or account team affinity. For more information about agent affinity, see Agent Affinity.

### Related information

- Advanced Work Assignment

### Customer Central

Customer Central provides customer service agents with all the information about the customer in one central place. It enables them to quickly zoom in on the customer issue and provide efficient and supportive service to their customers.

Customer service agents or location agents can view customer central on the interaction record if using CSM Agent Workspace or on the interaction, case, account, contact, or consumer records on the CSM Configurable Workspace in the form of two views: Customer Information and Customer Activity.
Customer Information view
The Customer Information view displays key information about the customer and a view of all recent customer touch points with the service organization. It contains a number of predefined lists, records, reports, and report groups that are highly configurable, or you can create your own. You can also configure the number of days to display the data for.

Customer Activity view
The Customer Activity view displays all the recent customer touch points with the service organization in the form of an activity feed. On the left hand side, there are facets, or categories of information. The data in the activity feed is displayed based on the facet you select. It contains a number of predefined facets and activities that are highly configurable, or you can create your own. You can also configure the number of days to display the data for.
Related information

Configure Customer Central
Use Customer Central

Lookup and verify

The lookup and verify feature enables customer service agents to quickly look up contacts or consumers using information such as the name, phone number, or record number.

This feature simplifies the process of looking up and verifying contact or consumer information. Agents can use it as follows:

- If an interaction record is already populated with contact or consumer information from a chat or phone call, the agent can review the information and confirm that it is correct.

- If no customer or consumer information is available, the agent can search for this information, select and confirm the information, and populate the interaction record.

Note: If this information has already been verified, such as through a customer portal login or authentication by Virtual Agent or by an IVR, the Verified check box on the interaction record is checked.

Agents can access the search window on the interaction record as follows:
• CSM Configurable Workspace: By clicking the Verify Contact icon (_USERS) or the Verify Consumer icon (USERS) in the contextual side panel.

• CSM Agent Workspace: By clicking the Lookup Contact and Lookup Consumer buttons.

Agents can perform a type-ahead search across multiple configurable fields such as name, phone number, email address, and record number. From the search results list, agents can select a result to display detailed information for the contact or consumer in a verification card. Once verified, the system adds the information to the interaction record and checks the Verified check box.

Plugins
The lookup and verify feature is included with the Customer Service (com.sn_customerservice) plugin. This plugin provides the configuration for contact and consumer lookup as well as Lookup Contact and Lookup Consumer UI actions that can be added to the interaction record in CSM Agent Workspace.

! Note: These actions are not enabled by default. The workspace admin can enable these actions as part of the lookup and verify feature configuration.

Contact and consumer configurations
Two lookup and verify configurations are provided with the feature, one for contacts and one for consumers. Navigate to Workspace Experience > Lookup and Verify > Configuration to access the Lookup and Verify Configurations list.

! Note: To see the contact and consumer lookup and verify configurations, you must activate the CSM Lookup and Verify plugin (com.snc.sn_csm_lookup_verify).

For each configuration, the workspace administrator can:
• Enable the configuration and display the related UI action on the interaction record.
• Enter the minimum number of characters to start the type-ahead search.
• Enter the maximum number of search results returned.
• Select the primary and secondary fields to include in the search results.
• Select the fields to display on the verification card.
• View the lookup tables.
**Note:** Customers can contact ServiceNow to make changes to the search fields.

**Using Lookup and verify in CSM workspaces**
Agents can use the lookup and verify feature in CSM workspaces.

- CSM Configurable Workspace: agents search for contact or consumer information using the contextual side panel.
- CSM Agent Workspace: agents search for contact or consumer information using the Verify Contact or Verify Consumer pop-up windows on the interaction form.

The search field provides type ahead search that displays results in a list and narrows the results as more characters are entered. Selecting a result from the list displays more detailed information about the contact or consumer in a verification card.

The search feature searches multiple configured fields such as name, account, phone number, and record number.
- For phone numbers and record numbers, it uses an "exact match" search.
- For other fields, it uses a "starts with" search.

**Verification cards**
After selecting a search result, detailed information about the contact or consumer is displayed in a verification card. From this card, the customer service agent can review and confirm the information by clicking **Verified**.

**Tables**
The lookup and verify feature uses the following tables:
- Lookup and Verify Configurations (sn_lookup_verify_config)
- Lookup Tables (sn_lookup_verify_search_on_table)

**Related information**
- Set up lookup and verify in Workspace
- Look up and verify a contact or consumer

**Case action status in Workspace**
Customer service agents can use the case action status feature to easily identify cases that need attention.
**Action Status column**

This feature enables customer service agents to easily identify cases that need attention and quickly prioritize their work. Visual indicators in the Action Status column on the My Cases and My Open lists highlight case status:

- A blue indicator highlights cases that need attention, such as cases that have been updated by customers or internal users and are waiting for input or review.

- A red indicator highlights cases that are blocked, such as cases that have open related task records or are waiting for customer feedback. Blocked cases can have the following status:
  - Blocked internally
  - Blocked by customer
  - Blocked internally and by customer

In addition to the colored indicators, the Action Status column also displays a brief status message.

**Blocked by related list**

The case action status feature adds the Blocked by related list to the workspace view of the Case form. Blocking tasks for a case appear in this list. When the system adds a blocking task to a case, it also adds one of the following blocking reasons:

- Need information from the customer
- Need task resolution
- Need PRB workaround
- Other

Note: When a problem is associated with a case, the blocking reason is set to Needs task resolution. The agent can update this reason to Need PRB workaround if necessary.

When a blocking task is resolved:

- The Unblocked By field displays the user who performed the unblocking action.
- The Unblocked On field displays the date that the blocking task was resolved.
- The Needs Attention field for the case is enabled.
Notifications
Agents can receive notifications on their preferred channel when a blocking task for an assigned case is resolved. Agents can also receive notifications when the Needs Attention field for an assigned case is enabled.

Note: Notifications are not sent to the user who updated the record.

Users with the admin role can configure notification triggers by navigating to Agent Workspace > Notification Triggers > Case Action Status Trigger.

Related information
Case action status overview

Third-party data integration for CSM
The third-party data integration feature enables you to retrieve data from third-party applications and display the data in Agent Workspace for CSM without having to store it in your ServiceNow instance.

Many enterprise customers use ServiceNow applications as part of their IT ecosystems. In these environments, ServiceNow applications coexist with other applications and exchange data through different types of integrations. For customer service agents who typically use a wide variety of applications, this can create a fragmented experience that impacts agent productivity and increases customer wait time.

A frequent integration takes place between ServiceNow and Salesforce applications. In this integration, customers use Salesforce to manage pre-sales activities and ServiceNow to manage post-sales activities. These post-sales activities represent service assurance.

To provide high quality service, agents using the Customer Service Management (CSM) application need a complete understanding of the customer’s context, and this includes access to customer data maintained in other systems. A common example of this integration is enriching a CSM customer profile by providing a list of opportunities related to the customer’s account. These opportunities are retrieved from Salesforce in real time and are presented in Agent Workspace for CSM.

Using the third-party data integration feature, data from third-party applications can be retrieved as needed. Agents can view the data in lists and forms. This feature uses remote tables to store the third-party data in memory on the application server. Remote tables are useful for data that changes frequently because the data is retrieved in real-time when a user accesses the data from the Now Platform.
Activating third-party data integration

The following plugins are required to implement third-party data integration:

- Remote Tables (com.glide.script.vtable): Adds the Remote Table Script Definition table (sys_script_vtable) and adds the Remote Table flag to the Tables (sys_db_object) table. Active on the base instance.

- OAuth 2.0 (com.snc.platform.security.oauth): Adds the OAuth-related tables and extension points needed to support OAuth 2.0 – JWT Bearer grant type. Active on the base instance.

- IntegrationHub (com.glide.hub.integrations): Provides the ability to build reusable integrations with third-party systems and call them from anywhere in the platform. IntegrationHub requires subscription and is available in several subscription packages. Different packages allow for different levels of automation and provide different subsets of predefined third-party integrations, or spokes. For more information, see Request IntegrationHub and IntegrationHub available spokes.

- Customer Service (com.sn_customerservice)

Configuring third-party data integration

Users with the system administrator role can configure the necessary components to enable third-party data integration for Agent Workspace for CSM. At a high level, the configuration steps include:

- Setting up the OAuth 2.0 – JWT Bearer grant type, which provides the connection between the ServiceNow instance and the third-party application.

- Setting up aliases to manage connection information and credentials when integrating with external systems and providing alias reference to the IntegrationHub action.

- Creating a remote table to store the third-party data.

- Creating a remote table script definition that maps the data from the third-party application table to the remote table.

- Configuring ACLs for the remote table to provide user access to the third-party data.

- Configuring the lists and forms that display data from the remote table.

For more information, see Configure third-party data integration for CSM.

Using third-party data integration

Within Agent Workspace for CSM, agents can use this feature to:
• View read-only data from third-party applications in lists and forms.
• View data from multiple third-party applications in one browser tab.
• View data from third-party applications in pop-up windows, sub tabs, and related items using iframes.
• Open links to third-party application records from forms.

**Domain separation**
Remote table script definitions are domain separated. If users do not have access to the same domain as the remote table script definition record, they cannot access records from the remote table specified in the script definition. The data within the remote table is not domain separated.

For more information, see [Domain separation and remote tables](#).

**Related documentation**
• Authentication and credentials
  ◦ Set up OAuth provider with JWT Bearer grant type
  ◦ Credentials and connection information
• IntegrationHub
• Flow Designer
• Retrieving external data using remote tables and scripts
• Salesforce spoke

**Third-party data integration solution overview**
A typical enterprise ecosystem includes enterprise resource planning (ERP), sales management, and service management systems. There are multiple options for implementing the integrations between these systems.

In this example, the ERP system manages customer data (for example, Accounts).
When a new account is acquired, it is created first in the ERP system and then account data is transferred to Salesforce and ServiceNow (1).

During this process, new accounts are created in Salesforce and ServiceNow. The ServiceNow account record is updated with the Salesforce account ID attribute that holds the reference to the Salesforce account record. The Salesforce account ID is later used to match account records between ServiceNow and Salesforce and also to retrieve opportunity data from Salesforce.

When an agent accesses an account in Agent Workspace for CSM, a list of related opportunities for this account is retrieved from Salesforce in real-time (2) and presented to the agent.

This example assumes that the flow (1) has been implemented and executed and that the ServiceNow account records contain valid Salesforce account IDs. This example also uses the following configuration:

- Connectivity between a ServiceNow and Salesforce.
- Integration using IntegrationHub and remote tables.

Integration architecture

ServiceNow integrates with Salesforce through the OAuth 2.0 Bearer Token Flow.
Integration architecture

Remote tables and IntegrationHub architecture

Third-party data integration components

These components require configuration by the system administrator to use third-party data integration with Agent Workspace for CSM.

OAuth 2.0 – JWT Bearer grant type

JWT Bearer is the OAuth 2.0 grant type supported for the third-party data integration feature. It allows server-to-server API interactions between the ServiceNow instance and external API providers without requiring any user intervention.

The third-party application admin is used as the subject claim of the JWT that the ServiceNow instance creates and passes to the third-party application instance.
This is done to get the access token which is used to make the REST API call to fetch records from the third-party application table.

**Credentials and connections**

IntegrationHub takes advantage of aliases to manage connection information and credentials when integrating with external systems. Using an alias eliminates the need to configure multiple credentials and connection information profiles when using multiple environments. IntegrationHub only requires an alias, which then resolves to use the correct credentials and connection information during runtime.

For more information, see the following topics:

- Introduction to credentials, connections, and aliases
- Create connection attributes for IntegrationHub

**Remote tables**

The Tables (sys_db_object) table contains a record for each table in the database, including remote tables. For remote table records, the Remote Table flag is checked on the record form.

The columns in a remote table are mapped to the columns in a third-party application table from which the data is being pulled. The remote table script definition stores this information. Table definitions for remote tables reside on the Now Platform. The table rows, or external records, are stored in memory while a user views the data in a list or form.

For more information about remote tables, see Create a remote table.

When creating a remote table for use with IntegrationHub, pay special attention to the caching interval and choose an interval based on your workflow and the volatility of the third-party data. If the caching interval is too short, this can result in unnecessary connections to the third-party application. If the caching interval is too long, this can result in out-of-date third-party data being presented in Agent Workspace for CSM.

**Remote table script definitions**

Use a script definition to retrieve and cache data for a remote table by running the script against an external data source. Remote table script definitions store the following information:

- Name
- Active
- Table
- Script
Cache TTL
Domain
Domain path

For more information about script definitions, see Create a script definition for a remote table.

**Third-party data integration sample script**

The remote table script can be designed to pull records from a third-party application. This script is called when a query to access data in the remote table is made.

In order to use a remote table with IntegrationHub, you need to identify the IntegrationHub spoke that works with the third-party application. The spoke consists of the Flow Designer actions that were created to bring various subsets of the data from that application.

For example, if you need to bring account information from the Salesforce application, you would use the Salesforce spoke and the **Get All Accounts** action. See below for an example of the remote table script that accesses this action.

```javascript
(function executeQuery(v_table, v_query) {
  try {
    // prepare inputs for the spoke actions
    // Get All Accounts action does not have any inputs).
    var inputs = {};

    // call spoke action
    var outputs = sn_fd.FlowAPI.executeAction(
      "sn_salesforce_spok.get_all_accounts", inputs);

    // check if Action was completed successfully
    if (outputs.status != "Success") {
      throw new Error(outputs.errorMessage);
    }

    // extract payload from the action outputs
    var accounts = outputs.accounts.data;

    // map action output data to the remote table columns and Sys Id
    for (var i = 0; i < accounts.length; i++) {
      v_table.addRow({
```
"u_sf_account_id": accounts[i].name,
"u_sf_account_name": accounts[i].label,
// assign remote table Sys Id to the primary key of the third-party
// record
"sys_id": accounts[i].name,
});
}

// process errors
} catch (error) {
    gs.addErrorMessage("Error trying to retrieve Salesforce Accounts." +

    "Please contact System Administrator.");
    gs.addErrorMessage("System Error: " + error.message);
}
})(v_table, v_query);

Note: Not all IntegrationHub actions can be invoked from the remote table scripts. Specifically, Data Stream Actions cannot be called from the scripts. If the action you would like to use is a Data Stream Action, you might need to create your own action based on the REST step. An easy way to create an action is to copy an existing action and then modify it to accomplish your goal. You can find an example of custom spoke actions in this topic: Create Salesforce spoke actions to retrieve Opportunities for use in the remote table definition.

Configure third-party data integration for CSM

Configure the required components to enable the third-party data integration feature for Agent Workspace for CSM.

Before you begin
Role required: admin

Procedure

1. Identify the third-party application.
   a. Verify that it has the corresponding IntegrationHub spoke and that it is activated on your instance.
   b. Follow the setup instructions specific to the spoke. For example, for the Salesforce spoke, follow the instructions in the Set up Salesforce spoke topic.

2. Identify the spoke action that retrieves the desired third-party data.
   You can find the list of available actions in the spoke documentation. If an action that performs the desired task does not exist, you can create your own
action by copying an existing action and modifying it to suit your needs. You can find an example of the custom spoke actions in Create Salesforce spoke actions to retrieve Opportunities for use in the remote table definition.

ℹ️ Note: Data Stream Actions cannot be used with the remote table.

3. Create the remote table on your ServiceNow instance to expose the data from the application through the GlideRecord interface. Then create the remote table script definition to map the data from the third-party table to the remote table.

a. Configure error messages if the spoke action call results in an error. This error is picked up by the form, list, and field elements and is displayed for the end user when an error occurs. These error messages distinguish between cases where the response from the third-party application has no data and an error while fetching data from the third-party application.

b. Configure ACLs on the remote table to provide users and roles with read access to the third-party data.

c. Configure ACLs to revoke CREATE, WRITE, and DELETE access on the remote table for all users.

4. Configure the lists, forms, and fields that pull data from the remote table. Once the remote table is set up, you can access data using the GlideRecord interface.

a. Use Agent Workspace components to embed third-party pages and reports in iframes as popups or related items.

b. Configure UI actions on forms to create deep links to the records in the third-party application.

5. Perform some lightweight data synchronization prior to using the feature. For example, pull in account data from a third-party application using an import set. In the example provided, the Account (customer_account) table has an Account Id column, which is populated with the Id of the account in the third-party application instance. This column is used as the foreign key to pull opportunities for the corresponding account on the third-party application instance.

Reference Salesforce integration using remote tables

In this example, the Customer Account table is extended to include an associated Salesforce Account ID which, in turn, is used to retrieve Salesforce
opportunities associated with this account. The remote table is used to hold the retrieved opportunity data.

Use the steps and the examples in the following topics to create a reference Salesforce integration using remote tables.

- **Using the IntegrationHub Salesforce spoke.**
- **Using remote tables and the Salesforce spoke.** Identify or create an IntegrationHub action that you can use to test the third-party data integration. Then use this action in the remote table definition.
- **Using a related list to create the connection between the customer account and the Salesforce opportunities.**

**Using remote tables and the Salesforce spoke**

Create Salesforce spoke actions that you can use to test the third-party data integration. Then use these actions in the remote table definition.

**Using the IntegrationHub Salesforce spoke**

Use the Salesforce spoke to integrate a Salesforce account with your ServiceNow instance.

**Before you begin**

Role required: admin

**Procedure**

To configure the Salesforce spoke, follow the instructions in Set up Salesforce spoke.

**Related information**

- Using remote tables and the Salesforce spoke
- Using a related list to create the connection between the Customer Account and Salesforce Opportunities

**Create Salesforce spoke actions to retrieve opportunities for use in the remote table definition**

The Salesforce spoke provides actions to retrieve metadata of the opportunity record and create a new opportunity.

Other than Data Stream Actions, there is no action to get a set of the opportunity records based on a given search criteria. You need to create your own actions to accomplish the stated goal of the reference example. See Reference Salesforce integration using remote tables.
To create a new action, copy an existing action and modify it to suit your needs. For example, you can copy the **Get All Accounts** action and modify it to retrieve opportunity records.

For this example, you will create three new Salesforce spoke actions:

- Get All Opportunities
- Get Opportunities for Account Id
- Get Opportunity Details

Each action includes three steps:

1. A pre-processing script step that creates a query.
2. A REST step that executes the query.
3. A post-processing script step that evaluates the response from the query.

<i>Note:</i> You can test all actions from the Flow Designer before you attempt to connect them to the remote table.

**Get All Opportunities custom action**

The **Get All Opportunities** action retrieves opportunity records from the Salesforce application. This action is invoked when the user views the remote Opportunity table.

**Action inputs**

The **Get All Opportunities** action takes a single integer parameter that identifies the maximum number of records to be returned by the query. The REST-based actions cannot accommodate pagination and, for this reason, it is important to limit the number of records returned from the third-party application. It is not recommended to place more than 1,000 records in the remote table. The default number of records is 500.
Pre-processing step

The pre-processing script step takes the action input as its own.

The pre-processing script creates a SELECT query for all opportunities limited by the maximum number of records allowed. This query is based on the Salesforce Object Query Language (SOQL).

```javascript
(function execute(inputs, outputs) {

    outputs.query = "query/?q=SELECT+Name,Id,AccountId,CloseDate,Amount," +
                    "StageName,Probability,Type+FROM+Opportunity";

    outputs.query = outputs.query +
                    "+LIMIT+" + inputs.max_number_of_opportunity_records;

})(inputs, outputs);
```

You need to specify the fields from the opportunity records that you are interested in. This example uses the following fields: Name, Id, Account Id, Close Date, Amount, Stage Name, and Probability. To see the full list of available fields, use the Get Opportunity Fields action.

You can also control the ordering of the query search by adding the ORDERED BY keyword and value for ASC or DESC order direction. For example, you can add the following line to the script before the line specifying the LIMIT. It makes the query return first 500 records with the most recent Close Date.

```javascript
outputs.query = outputs.query + "+ORDERED+BY+CloseDate+DESC";
```

The pre-processing output is a query.
REST step

The REST step is a standard REST step from the Salesforce spoke REST-based actions. You do not need to make any changes. Make sure that it points to the correct Connection Alias.

Post-processing step

The post-processing script step takes the action input and REST step output as its inputs.
The post-processing script checks the query response for errors, sets the error message if needed, extracts opportunity data from the response body, and creates an information message to indicate that not all data was retrieved from the Salesforce due to the number of records limitation.

```javascript
(function execute(inputs, outputs) {
  try{
    var response = JSON.parse(inputs.res_body);
  } catch(e) {
    outputs = errorHandler(inputs, outputs);
  }

  function createOutputJson(inputs, outputs) {
    try{
      outputs.records = { data: response.records };    
      outputs.status = "Success";
    } catch(e) {
      outputs = errorHandler(inputs, outputs);
    }

    if ( outputs.records.data.length ==
         inputs.max_number_of_opportunity_records ) {
      outputs.info_message = "Opportunity retrieve operation was " +
                             "limited to" +
                             inputs.max_number_of_opportunity_records +
                             " records.";
    }
  
  } catch(e) {
    outputs = errorHandler(inputs, outputs);
  }

  return outputs;
}
```
function errorHandler(inputs, outputs) {
    outputs.status = "Error";
    outputs.error_message = "Unknown Error. " +
                          "Please check error log for more information";

    if(inputs.res_body.contains("message"))
        outputs.error_message = response[0].message;

    return outputs;
}

if(inputs.status_code == "200")
    outputs = createOutputJson(inputs, outputs);
else
    outputs = errorHandler(inputs, outputs);

}) (inputs, outputs);

The following are outputs of the post-processing step.

Output Variables

<table>
<thead>
<tr>
<th>Label</th>
<th>Name</th>
<th>Type</th>
<th>Mandatory</th>
</tr>
</thead>
<tbody>
<tr>
<td>records</td>
<td>records</td>
<td>JSON</td>
<td></td>
</tr>
<tr>
<td>error_message</td>
<td>error_message</td>
<td>String</td>
<td></td>
</tr>
<tr>
<td>info_message</td>
<td>info_message</td>
<td>String</td>
<td></td>
</tr>
<tr>
<td>status</td>
<td>status</td>
<td>String</td>
<td></td>
</tr>
</tbody>
</table>

Action outputs

Action outputs consist of the query status, error and information messages, and opportunity records. See the above screenshot for the action outputs.

Get Opportunities for Account Id custom action

The Get Opportunities for Account Id action retrieves opportunity records for the specific Salesforce account. This action is invoked when the agent views
a Salesforce opportunity available for the customer account based on the Salesforce account associated with it.

This action is very similar to the **Get All Opportunities** action.

**Action inputs**

In addition to the maximum number of records to be returned by the query, this action also takes a Salesforce Account Id as input to be used as a query parameter. The value of this parameter is provided by the relationship that links the customer account and the Salesforce opportunity through the associated Salesforce Account Id. For more information, see Create defined related lists.

The specific relationship needed for the reference example is also described in the **Using related list to create the connection between Customer Account and Salesforce Opportunities** topic.

The Salesforce Account Id action input parameter has no default value.

---

### Pre-processing step

The pre-processing script step takes the action input as its own.
The Pre-Processing step script creates a SELECT query similar to the one created for the **Get All Opportunities** action with the addition of the check against the Salesforce Account Id:

```javascript
(function execute(inputs, outputs) {
    outputs.query = "query/?q=SELECT+Name,Id,AccountId,CloseDate,Amount," +
    "StageName,Probability,Type+FROM+Opportunity" +
    "WHERE+AccountId='" + inputs.salesforce_account_id + "" +
    "LIMIT" + inputs.max_number_of_opportunity_records;
})
```

The pre-processing output is a query, similar to the **Get All Opportunities** action.

**REST step, post-processing step, and action outputs**

These steps and outputs are the same as for the **Get All Opportunities** action.

**Get Opportunities Details custom action**

The **Get Opportunities Details** action retrieves a single Opportunity record from the Salesforce application based on the record Id. This action is invoked when the user opens the form for the Opportunity record in the remote table.

**Action inputs**

The **Get Opportunities Details** action takes a single integer parameter that identifies the Salesforce Account ID. This parameter is set by the form based on the sys_id that was provided to the remote table in the remote table script. For more information, see Example script that queries the Opportunity table.
Pre-processing step

The pre-processing script step takes the action inputs as its own.

As with other actions, the pre-processing step creates an opportunity query for the specific parameter. In this case, the match is done against the opportunity record Id. Do not worry about the LIMIT in this query because it returns at maximum a single record.

```javascript
(function execute(inputs, outputs) {

    outputs.query = "query/?q=SELECT+Name,Id,AccountId,CloseDate,Amount," +
    "StageName,Probability,Type+FROM+Opportunity" +
    "+WHERE+Id='" + inputs.salesforce_opportunity_record_id + "';

})(inputs, outputs);
```

The pre-processing output is a query similar to the other custom actions.
REST step, post-processing step, and action outputs

These steps and outputs are the same as for the other custom actions except there is no maximum number of records parameter and no information message.

Remote tables and definition

Once you have the spoke custom actions working, you need to create a remote table that describes the schema for the data to be retrieved from the Salesforce Opportunity table.

Create a remote table as shown in the following example.

Create the script definition for the remote table (u_st_salesforce_opportunity), which does the following:

- Uses the spoke custom actions to pull data from the Opportunity table in the Salesforce instance.
- Maps the response from Salesforce into the remote table columns.

Example script that queries the Opportunity table

This example script queries the opportunity table using the Get All Opportunities, Get Opportunities for Account Id, and Get Opportunity Details custom actions.
The example script consists of three distinct parts:

1. The first part selects the correct custom action and prepares inputs for it.
2. The second part makes a call to the action.
3. The third part processes the outputs of the action.

Selecting a spoke action and preparing the inputs

In this section of the script, select one of the three custom actions that you prepared to get opportunities from the Salesforce application:

- **Get All Opportunities**
- **Get Opportunities for Account Id**
- **Get Opportunity Details**

You can decide which action to call based on the parameters included in `v_query` function argument.

```javascript
/******** Choose action and prepare action inputs *******/
var action = null;
var inputs = {};

// look up opportunity by salesforce record id
if (v_query.isGet()) {
    action = "get_opportunity_details";
    inputs.salesforce_opportunity_record_id = v_query.getSysId();
}

// look up opportunities by salesforce account id
} else if (v_query.getParameter("u_sf_account_id")) {
    if (v_query.getParameter("u_sf_account_id") == "undefined") {
        gs.addInfoMessage("Opportunities cannot be retrieved because " +
                           "this "Account does not have associated " +
                           "Salesforce Account. Please contact System " +
                           "Administrator.");
        return;
    }
    action = "get_opportunities_for_account_id";
    inputs.salesforce_account_id = v_query.getParameter("u_sf_account_id");
}

// look up all opportunities
```
Note that this script configures an information message if the Salesforce account is undefined when it is required by the action. The undefined value comes from the relationship that is described in Using a related list to create the connection between the Customer Account and the Salesforce Opportunities.

When the Salesforce account is undefined, there is nothing to query for in this case and the function returns without calling the spoke action.

### Calling the spoke action

In this section of the script, call the action using the names of the Salesforce spoke and the selected action and store the outputs of the call.

```javascript
/*** Call action *****/
var outputs =
    sn_fd.FlowAPI.executeAction("sn_salesforce_spok." + action, inputs);
```

### Processing the action output

In this section of the script, process the outputs starting with the check for errors.

```javascript
/*** Process action outputs *****/
if (outputs.status != "Success") {
    throw new Error(outputs.error_message);
}
```

If the query does not return any errors, the script needs to process the returned records and add them as rows into the remote table. Map the Salesforce Opportunity fields into the remote table columns.

```javascript
var opportunities = outputs.opportunities.data;

for (var i = 0; i < opportunities.length; i++) {
    var opportunity = opportunities[i];
    v_table.addRow({
        "u_sf_amount": opportunity.Amount,
        "u_sf_close_date": opportunity.CloseDate,
        "u_sf_name": opportunity.Name,
        "u_sf_probability": opportunity.Probability + ",\%",
        "u_sf_account_id": opportunity.AccountId,
        "u_sf_stage": opportunity.StageName,
        "u_sf_type": opportunity.Type,
        "sys_id": opportunity.Id,
    });
}
Note that the Salesforce opportunity record Id is assigned to the remote table sys_id. This ensures that lists and forms for the remote table function properly and that we are able to extract the record Id using `v_query.getSysId()` the next time that the remote table script is invoked.

Then display the information message if it was passed by the query.

```javascript
if (outputs.info_message) {
    gs.addInfoMessage(outputs.info_message);
}
```

### Putting the remote table script sections together

The three sections of the script are included in the try-catch block to provide for error handling.

```javascript
(function executeQuery(v_table, v_query) {
    try {
        // place code here from: <Selecting a spoke action and preparing the inputs>

        // place code here from: <Calling the spoke action>

        // place code here from: <Processing the action output>
    } catch (error) {
        gs.addErrorMessage("Error retrieving Salesforce Opportunities. " +
        "Please contact System Administrator.");
        gs.addErrorMessage("System Error: " + error.message);
    }
})(v_table, v_query);
```

### Using a related list to create the connection between the Customer Account and Salesforce Opportunities

Use a related list to establish the connection between the Customer Account table that holds the Salesforce Account Id and the Salesforce Opportunity remote table that holds the same Salesforce Account Id.

In this example, create a relationship called Opportunities. Choose the Account table in the `Applies to table` field and the remote opportunity table in the `Queries from table` field. For more information, see Create defined related lists.
Add the following code in the \textbf{Query with} field:

```javascript
(function refineQuery(current, parent) {
    var sf_account_id = new String(parent.u_salesforce_account_id);
    if (sf_account_id.length == 0)
        sf_account_id = "undefined";
    current.addQuery("u_sf_account_id", sf_account_id);
})(current, parent);
```

This code checks for the presence of the Salesforce Account Id in the Account table and, if it is missing in the record, sets it to \textit{undefined}. The code also includes a query for the Opportunity table column that holds the Salesforce Account Id for the value of this Id from the Account table. This query is invoked when the user opens the list of opportunities associated with the customer account. To see how it is used in the remote table script, see Selecting a spoke action and preparing the inputs.

\textbf{Machine learning solutions for Customer Service Management}

Machine learning in Customer Service Management helps with case creation, assignment, and resolution.

You can use predictive intelligence solution definitions to assist agents with a variety of tasks. Solution definitions predict one or more output fields based on a configured input field.

\textbf{Creating cases}

Use solution definitions to predict the category, priority, and assignment for customer service cases based on the information entered in the short description.

\textbf{Grouping cases into topics}
Use clustering solution definitions to cluster similar cases into topics based on the information entered in the short description.

**Routing and assigning cases**

Use solution definitions to predict the assignment group for customer service cases based on the information entered in the short description.

**Recommending similar cases**

Use solution definitions to recommend similar cases based on the information entered in the short description. These recommendations can help agents with case investigation and resolution.

**Recommending similar knowledge articles**

Use solution definitions to recommend similar knowledge articles by comparing knowledge article text to the case short description.

**Detecting major issues**

Use solution definitions to identify similarities across open cases that can proactively detect major issues.

**Predictive Intelligence for CSM solution definitions**

Use your instance records to build Customer Service Management-specific solutions.

**Solution definitions**

These solution definitions are available as templates on instances where both Predictive Intelligence and Customer Service Management are active. Create your own solution definition records to customize the behavior.

<table>
<thead>
<tr>
<th>Solution Definition</th>
<th>Solution Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSM Case Assignment</td>
<td>Classification</td>
<td>Predicts the Assignment group field from the Short description.</td>
</tr>
<tr>
<td>CSM Case Categorization</td>
<td>Classification</td>
<td>Predicts the Category field from the Short description.</td>
</tr>
</tbody>
</table>
## Solution Definitions for Customer Service Management (continued)

<table>
<thead>
<tr>
<th>Solution Definition</th>
<th>Solution Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSM Case Prioritization</td>
<td>Classification</td>
<td>Predicts the <strong>Priority</strong> field from the <strong>Short description</strong>.</td>
</tr>
<tr>
<td>Grouping of Cases into Topics</td>
<td>Clustering</td>
<td>Clusters similar cases into topics based on the <strong>Short description</strong>.</td>
</tr>
<tr>
<td>All Similar Cases</td>
<td>Similarity</td>
<td>Recommends similar cases based on the <strong>Short description</strong> that can help customer service agents with case investigation and resolution processes.</td>
</tr>
<tr>
<td>Recommended Open Cases</td>
<td>Similarity</td>
<td>Recommends similar open cases based on the <strong>Short description</strong>.</td>
</tr>
<tr>
<td>Recommended Resolved Cases</td>
<td>Similarity</td>
<td>Recommends similar resolved cases based on the <strong>Short description</strong>.</td>
</tr>
<tr>
<td>Major Issue Detector</td>
<td>Similarity</td>
<td>Provides recommendations for major issues based on the <strong>Short description</strong>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Recommends one or more major cases, if available.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Otherwise, recommends similar cases that are not linked as child cases to a major case.</td>
</tr>
<tr>
<td>Similar Knowledge Articles</td>
<td>Similarity</td>
<td>Recommends similar knowledge articles by comparing the <strong>Text</strong>, <strong>Short description</strong>, and <strong>Description</strong> fields of knowledge articles to the</td>
</tr>
</tbody>
</table>
### Solution Definitions for Customer Service Management (continued)

<table>
<thead>
<tr>
<th>Solution Definition</th>
<th>Solution Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Similar Knowledge Articles All</td>
<td>Similarity</td>
<td>Recommends similar knowledge articles by comparing the fields in the Knowledge View database view [sn_customerservice_knowledge_view] to the <strong>Short description</strong> of the customer service case.</td>
</tr>
</tbody>
</table>

**Note:** This solution definition is used in the Auto-Responder feature. For more information, see Train the similarity solution for finding Auto-Responder notification content.

### Business rules for classification solutions

These business rules apply only to the CSM Case Assignment, CSM Case Categorization, and CSM Case Prioritization solution definitions and are available only on instances where both Predictive Intelligence and Customer Service Management are active. Create your own business rules on the Case [sn_customerservice_case] table to customize prediction and reporting behaviors.

### Business rules for Customer Service Management

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Case Based Prediction</td>
<td>Case [sn_customerservice_case]</td>
<td>Generates prediction results from the active Customer Service Management solutions.</td>
</tr>
</tbody>
</table>
Business rules for Customer Service Management (continued)

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update Prediction Results</td>
<td>Case [sn_customerservice_case]</td>
<td>Updates the solution precision and coverage statistics. Runs when a case record is closed.</td>
</tr>
</tbody>
</table>

**Upgrade Information**

If your instance is running on the Kingston release and you are upgrading to the Rome release:

- Use the Default Case Based Prediction business rule template to create a new business rule. This rule includes a Solution variable that gets all active solutions retrieved by the findActiveSolution(solutionName) method.

- In a global domain environment, use the solutionNames array variable which requires that you explicitly provide the solutions that are called by the business rule.

- In a domain-separated environment, such as an MSP environment, refer to the commented code in the business rule template for easy customization.

- The business rule template calls the applyPredictionForSolution() method to predict regardless of any changes to the default value.

**Maintaining prediction accuracy**

You can manage prediction drift by retraining, modifying, or creating new solutions to reflect changes in your business conditions. Test and modify your business rule over time to ensure it works as desired across multiple consumption points and user Personas.

**Related information**

Similar case/recommendation

**Predictive Intelligence for case management**

Assist agents with case creation by requiring a minimum of information, such as the short description, and predicting values for the category, priority, and assignment group.

From either Agent Workspace or the platform interface, agents can use this feature when creating cases by providing the short description. Based on the
information entered in the Short description field, the Predictive Intelligence feature predicts the category, priority, and assignment group, and routes the case to the correct queue.

Plugin

The Predictive Intelligence for Customer Service Management plugin (com.snc.csm_ml) provides Predictive Intelligence capabilities for Customer Service Management. This plugin enables customers to leverage machine learning algorithms for searching related cases in CSM. This plugin requires:

- Customer Service (com.sn_customerservice)
- Predictive Intelligence for Contextual Search (com.snc.contextual_search_ml)

The Predictive Intelligence for Customer Service Management plugin is activated automatically for new Orlando customers. Existing customers upgrading to the Orlando release must manually activate this plugin.

Solution definitions

Predictive Intelligence includes the following solution definitions for case management:

- CSM Case Categorization
- CSM Case Assignment
- CSM Case Prioritization

A solution definition predicts one or more output fields based on a configured input field. At least one solution definition must be active to use Predictive Intelligence with Customer Service Management.

For more information, see Predictive Intelligence for CSM solution definitions.

Business rules

Predictive Intelligence also includes business rules for Customer Service Management:

- Default Case Based Prediction
- Update Prediction Results

For more information, see Predictive Intelligence for CSM solution definitions.

Extension points

The Predictive Intelligence feature for Customer Service Management includes the CSMPredictionService extension point. This extension point contains a method that returns the following information:
• The list of solution definitions that are used to predict field values during case creation.
• The treatment of the predicted fields based on the values of the input fields.

The system administrator can use this extension point to customize the solution definitions.

Configure Predictive Intelligence for case management

Activate the Predictive Intelligence plugin and enable the related system property and client script to use Predictive Intelligence with Customer Service Management.

Before you begin
Role required: admin

Procedure
1. Activate the Predictive Intelligence plugin (com.glide.platform_ml).
2. Enable the Enable/Disable the prediction for case property
   (sn_customerservice.case.mlpredictor.enable).
   b. Enable the Enable/Disable the prediction for case check box.
   c. Click Save.
3. Enable the Predict Case Values client script.
   a. Navigate to System Definition > Client Scripts.
   b. Click Predict Case Values in the Client Scripts list.
   c. Enable the Active check box.
   d. Click Update.

Use Predictive Intelligence for case management

Agents can use Predictive Intelligence to predict values for configured fields when creating a customer service case.

Before you begin
Role required: sn_customerservice_agent, sn_customerservice_manager or admin

About this task
When you create a case, the Predictive Intelligence feature predicts values for the configured fields based on the short description.
**Note:** If you update the case, the values for these fields are not predicted again.

**Procedure**

1. Create a case.

2. Enter information in the **Short description** field and then tab to the next field. Based on this information, the system predicts the values for the **Priority**, **Assignment group**, and **Category** fields.

   **Note:** If the system cannot predict values based on the short description, these fields remain blank.

3. Optional: Change the values in the predicted fields if needed or enter values for fields where Predictive Intelligence has skipped prediction. The system does not overwrite user-entered values for the predicted fields.

**Update cases with missing field predictions**

View the list of open cases for which the prediction of category, priority, or assignment group was skipped by the Predictive Intelligence feature.

**Before you begin**

Role required: sn_customerservice_agent, sn_customerservice_manager or admin

**About this task**

In the event that Predictive Intelligence cannot predict one or more case attributes for a case, customer service agents and administrators can update this information after a case is created. For example, the short description might not include enough detail to make a prediction.

**Procedure**

1. Navigate to **Customer Service > Cases > Cases Skipped by Predictive Intelligence**.

2. Select a case from the list.

3. Provide the missing information and click **Update**.

**Trending case topics**

Resolve cases more efficiently and proactively using Predictive Intelligence to identify clusters of cases with similar issues and pinpoint factors that drive up case volume. Each cluster of cases represents a trending case topic.

Using trending case topics has the following benefits:
• Increase manager productivity: Quickly identify clusters of cases that point to similar underlying issues and act to resolve them.

• Improve customer experience: Proactively resolve issues by analyzing patterns in customer service data.

• Enhance operational excellence: Reduce the backlog of open cases by resolving similar cases at once.

System administrators train solution definitions to cluster similar cases and identify similar major cases for the clustering.

Major issue managers use trending case topic lists to analyze the backlog of cases. Using the lists, they can quickly identify any existing major cases that the backlog could be linked to or create a new major case.

**Activation information**

The trending case topics feature requires the Predictive Intelligence for CSM (com.snc.csm_ml) plugin and the Major Issue Management (com.sn_majorissue_mgt) plugin.

**Related information**

- Configure trending case topics
- View trending case topics
- Add trending case topics to existing major cases
- Create major cases for trending case topics

**Similar case recommendations**

The similar case recommendation feature enables customer service agents to easily find similar cases that can provide helpful information about a current case. This feature can also provide recommendations about cases that may be related to major issues.

The similar case recommendation feature uses the following components:

**Additional search resources for contextual search**

Additional search resources are provided for contextual search. These additional resources enable customer service agents to search open or resolved cases for information related to the current case.

**Predictive Intelligence similarity solution definitions**

Several of the additional search resources have an associated Machine Learning (ML) similarity solution definition. These additional
resources perform a contextual search based on the case short
description and return a list of similar records.

**Predictive Intelligence in Agent Workspace**

Predictive Intelligence can provide agents with a list of cases that are similar to the current case. These similar cases may provide helpful details or resolution information for the current case. Predictive Intelligence can also provide recommendations about potential major issues and major cases.

With the similar case/recommendation feature, customer service agents can:

- Find cases that are similar to the current case.
- Copy resolution notes and codes from resolved cases to the current case.
- Link the current case to a similar case.
- View a list of open cases similar to the current case and submit the current case as a major case candidate.
- View one or more similar major cases and link the current case as a child to a major case.

Major issue managers can search for cases that are similar to a major case and add them as child cases.

**Using the feature in Agent Workspace and in the platform interface**

With Agent Workspace, agents can:

- Perform a search in Predictive Intelligence using the additional search resources.
- Create a link from the current case to a selected case in the search results.
- Copy resolution information from a selected case to the current case. This includes the resolution code and the resolution notes (the agent must then save the case).
- View a list of similar cases that do not include major cases. This is a way to see that the current case might be a major case candidate.
- View a list of similar cases that include one or more major cases. The major cases are displayed first in the list of results. Agents can use an available action to add the current case as a child of a major case.

With the platform interface, agents can:
Perform a search in the Related Search Results section on the Case form using the additional search resources. Agents can select these additional resources from a list by the Related Search field.

Create a link from the current case to a selected case in the search results.

Plugins

The configuration for the similar case/recommendation feature is included with the Customer Service plugin (com.sn_customerservice).

The similar case/recommendation feature has a dependency on the Contextual Search plugin (com.snc.contextual_search). Activate the Contextual Search plugin to use contextual search and the additional search resources.

To use similar case/recommendation with the following features, activate the associated plugins:

- Major Issue Management – activate the Major Issue Management plugin (com.sn_majorissue_mgt)
- Predictive Intelligence – activate the Predictive Intelligence plugin (com.glide.platform_ml)
- Problem Management – activate the Problem Management Best Practice – Madrid – State Model (com.snc.best_practice.problem.madrid.state_model)

Related information

Machine learning solutions for Customer Service Management

Additional search resources

The similar case recommendation feature uses additional search resources, which are configured using the Contextual Search application.

Navigate to Contextual Search > Additional Resources to view the Search Resources (Additional Resources view) list. Two types of additional search resources are available: Table and Predictive Intelligence Similarity.

Table resources

Additional search resources of the type Table are based on a selected table and have specific conditions that must be met for a record to be included in the search results.

The following Table additional search resources are included with the Customer Service plugin:
• Open Cases
• Resolved Cases
• Open Major Issues

The following **Table** additional search resources are included with the Problem Management Best Practice - Madrid - State Model plugin:

• Open Problems
• Resolved Problems

<table>
<thead>
<tr>
<th>Table type additional search resources</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Additional Resource</strong></td>
</tr>
<tr>
<td>-------------------------</td>
</tr>
</tbody>
</table>
| Open Cases              | Case      | Returns a list of open cases created in the last three months that are not major cases or child cases of a major case. Actions available:
|                         |           | - **Link to Case**: the current case becomes a child of the case selected from the search results. |
| Resolved Cases          | Case      | Returns a list of cases created in the last six months that have a state of resolved or closed and the resolution code is one of the following:
|                         |           | - Solved - Fixed by support/Guidance provided
|                         |           | - Fixed by closing related PRB
|                         |           | - Workaround provided based on open PRB
|                         |           | Actions available: |
### Table type additional search resources (continued)

<table>
<thead>
<tr>
<th>Additional Resource</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>• <strong>Link to Case</strong>: the current case becomes a child of the case selected from the search results.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Copy Resolution Information</strong>: copies the resolution notes and resolution code from the selected case to the current case.</td>
</tr>
<tr>
<td>Open Major Issues</td>
<td>Case</td>
<td>Returns a list of open major cases. Actions available:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Link to Case</strong>: the current case becomes a child of the case selected from the search results.</td>
</tr>
<tr>
<td>Open Problems</td>
<td>Problem</td>
<td>Returns a list of open problems. Actions available:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Link to Case</strong>: adds the selected record as the Problem reference on the current case.</td>
</tr>
<tr>
<td>Resolved Problems</td>
<td>Problem</td>
<td>Returns a list of problems that have a state of Resolved or Closed. Actions available:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Link to Case</strong>: adds the selected record as the Problem reference on the current case.</td>
</tr>
</tbody>
</table>

### Predictive Intelligence Similarity resources

Additional search resources of the type Predictive Intelligence Similarity are associated with a Machine Learning (ML) similarity solution definition. Search resources of this type require the Predictive Intelligence plugin (com.glide.platform_ml). The resources listed in the following table are included with the Predictive Intelligence plugin.

In addition to the associated similarity solution definition, Predictive Intelligence Similarity resources can have configured properties. These properties identify conditions that must be met for cases to be included in the search results.
### Predictive Intelligence Similarity type additional search resources

<table>
<thead>
<tr>
<th>Additional Resource</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recommended Resolved Cases</td>
<td>Case</td>
<td>Returns a list of resolved similar cases created in the last six months. Associated with the Recommended Resolved Cases similarity solution definition.</td>
</tr>
<tr>
<td>Recommended Open Cases</td>
<td>Case</td>
<td>Returns a list of open similar cases created in the last six months. Associated with the Recommended Open Cases similarity solution definition.</td>
</tr>
<tr>
<td>All Similar Cases</td>
<td>Case</td>
<td>Returns a list of all similar cases created in the last six months. Associated with the All Similar Cases similarity solution definition.</td>
</tr>
</tbody>
</table>

### Major case agent assist recommendations

The Major Case agent assist recommendations is used for recommending major cases.

The agent assist provides a recommendation for each of the two major case scenarios:

- **Major case found**: returns a list with one or more major cases created in the time-frame indicated in the solution definition that are similar to the current case. Cases are listed by similarity score. The default time-frame is set to the start of yesterday.

- **No major case found**: returns a recommendation based on the number of cases created in the time-frame indicated in the solution definition that are similar to the current case (does not include any major cases). The default time-frame is set to the start of yesterday.
To configure the time-frame for the solution definition threshold, refer to Update your similarity score threshold.

If the Major Case agent assist recommendations find one or more major cases similar to the current case, the Predictive Intelligence tab displays these cases ranked by similarity score. The case with the highest score is highlighted with a white box and the title **Major Case** and includes a user action to link the current case to the major case.

If the Major Case agent assist recommendations find cases similar to the current case, but no major cases, the Predictive Intelligence tab displays a recommendation highlighted with a blue box. It includes the option to propose the current case as a major case candidate.
The Major Case agent assist recommendations:

- Uses the Major Case agent assist recommendations ML solution definition.
- Includes some properties that provide customers with customization options, such as the recommendation title and message that appears in the Predictive Intelligence tab.
- Includes the **Potential Major Case** trend definition.

This definition sets the threshold for:

- Finding the number of distinct accounts that cases need to belong to for a major issue recommendation. The default value is 3.
- The number of similar cases that need to be returned by the solution definition for a major issue recommendation using a script. The default value is 10.

**Similarity solution definitions**

The similar case recommendation feature uses several Predictive Intelligence solution definitions for similarity models.
Navigate to **Predictive Intelligence > Similarity > Solution Definitions**. The following solution definitions are provided with the similar case/recommendation feature.

- All Similar Cases (ml_sn_global_all_similar_cases)
- Recommended Resolved Cases (ml_sn_global_recommended_resolved_cases)
- Recommended Open Cases (ml_sn_global_recommended_open_cases)
- Major Issue Detector (ml_sn_global_major_issue_detector)

Several of the additional contextual search resources used by the similar case/recommendation feature are associated with these solution definitions. Agents can select these search resources and access the cases returned by these similarity solution definitions.

**Related information**

Create and train a similarity solution

**Similar case user actions**

Customer service agents and major issue managers can use the similar case recommendation feature to link cases, copy resolution information, propose major case candidates, and add cases to existing major cases.

<table>
<thead>
<tr>
<th>User Action</th>
<th>Description</th>
<th>UI Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer service agent can link the current case to a similar case</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• <strong>Agent Workspace:</strong> the Predictive Intelligence tab shows a list of similar cases ordered by the similarity score.</td>
<td><strong>Agent Workspace:</strong> click the More UI Actions menu and select <strong>Link to Case</strong>.</td>
<td>The current case is linked as a child of the similar case.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• <strong>Platform:</strong> the Related Search Results section of the case form shows a list of</td>
<td>• <strong>Platform:</strong> click the desired case in the search results list, then click <strong>Link to Case</strong>.</td>
<td></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>User Action</th>
<th>Description</th>
<th>UI Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>similar cases ordered by the similarity score.</td>
<td>Agent Workspace: the Predictive Intelligence tab shows a list of resolved similar cases ordered by the similarity score.</td>
<td>Agent Workspace: click the More UI Actions menu and select <strong>Copy Resolution</strong>.</td>
<td>Copies the resolution code and resolution notes from the similar case to the current case.</td>
</tr>
<tr>
<td>Customer service agent can copy resolution information from a resolved case to the current case</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td><a href="#">Note: Be sure to save the current case record.</a></td>
<td></td>
</tr>
<tr>
<td>Customer service agent can propose a major case candidate</td>
<td></td>
<td>The current case is proposed as a major issue.</td>
<td></td>
</tr>
<tr>
<td><a href="#">Note: The Major Issue Detector similarity solution definition must be active.</a></td>
<td>Agent Workspace: the Predictive Intelligence tab shows a major issue recommendation with the following message: &quot;We noticed that (x) similar cases have been created for (y) different accounts in the last (z) hours. Propose this as a major issue?&quot;</td>
<td>Agent Workspace: click the Propose Major Case link.</td>
<td></td>
</tr>
<tr>
<td>Major issue manager can associate the current case to a major case</td>
<td>Agent Workspace: the Predictive Intelligence tab lists one or more major cases similar to the current</td>
<td>Agent Workspace: click the More UI Actions menu and select <strong>Link to this major issue</strong>.</td>
<td>The current case is added as a child to the major case.</td>
</tr>
</tbody>
</table>
Estimated time to resolve a case

Machine learning in Customer Service Management helps with case resolution by predicting the estimated time to resolve a case.

Machine learning predicts the estimated time to resolve a case (ETTR) based on attributes of a case such as its short description, category, priority, assignment group, and so on. For more information about configuring the machine learning regression definition for ETTR, see Configure the default estimated time to resolve a case regression definition.

Activation

This feature is available with activation of the Predictive Intelligence for Customer Service Management plugin (com.sn_csm_ml). For more information, see Activate Predictive Intelligence.

Agents must activate the Time to resolve ribbon component, which displays the ETTR, to view it in the CSM Agent Workspace or in the CSM Configurable Workspace. For more information, see Display the Time to resolve ribbon component and Estimated time to resolve.

Mobile experience for Customer Service Management

Manage customer service cases from a mobile device with the Customer Service Management mobile application. Stay connected and access information in real time to complete tasks quickly.

Customer service agents and managers can use the Customer Service Management mobile application to review case details and quickly complete case tasks. Agents and customer service managers can perform routine actions and approvals effectively anytime and anywhere. Activate the Customer Service Mobile Plugin (com.sn_cs_mobile) to use the available features. For using the change request feature, Customer Service with Service Management (com.sn_cs_sm) plugin is required. For activating plugins, see Activate a plugin.
Note: The Customer Service Management mobile application supports product cases.

With the customer service agent role (sn_customerservice_agent), you can:

• Get a quick overview of your case load, including new cases, critical cases, and those that need attention.
• Accept and reassign cases.
• Add comments or work notes to cases.
• Review case details, activity stream, and related information such as SLAs, case tasks, and child cases.
• Edit case information such as priority.
• Propose major cases.
• Receive push notifications for assigned or updated cases.
• Search for cases using keywords

With the system administrator role, you can configure the Customer Service Management mobile application in the following ways:
• Configure pages to display the desired data.
• Configure the functions associated with swipe actions and top menu actions.
• Configure and create push notifications.

With the customer service manager role (sn_customerservice_manager) you can:
• Search for cases using keywords
• Review and approve change requests
• Approve escalations

Activate the Customer Service Mobile plugin

The Customer Service Management mobile application runs on the ServiceNow® mobile platform.

To use the Customer Service Management mobile application, activate the Customer Service Mobile plugin (com.sn_csm_mobile). This plugin activates the following plugins:

• Mobile Agent Native Client plugin (com.glide.sg.agent_native_client)
• Customer Service (com.sn_customerservice)
• Customer Service Case Action Status (com.sn.csm_action_status)

To provide support for major cases, you can activate the optional Major Issue Management plugin (com.sn_majorissue_mgt).

Once the Customer Service Management mobile application is activated and configured, agents can download the ServiceNow Agent mobile app on their mobile devices and access ServiceNow instances.

⚠️ Note: You can activate the Customer Service Mobile plugin (com.sn_csm_mobile) from the Customer Service Management guided setup.

For more information, see Activate a plugin.

Related information

Getting started with ServiceNow Agent

Customer Service mobile application overview

Customer service agents and managers can use the applet launcher and applets in the Customer Service mobile application to view notifications and manage customer service cases.

Applet launchers

Applet launchers serve as landing pages or home pages. When you log in to your instance, you see an applet launcher and the applets configured to display on that launcher. The system administrator configures the applet
launcher and applets for the Customer Service Management mobile application.

**Navigation bar**
The navigation bar appears at the bottom of the mobile application screen. This bar includes the following tabs that you can use to access different applets and application launch pages:

- **Cases**: displays the main case page. Use this applet launcher to access case management functionality.
- **Notifications**: view a list of the notifications that have been pushed to the agent. Tap a notification in the list to see the details, then tap the details open the case.
- **Settings**: manage settings for the mobile application.

**Applets and cards**
Select an applet from the applet launcher screen. Each applet contains one or more screens used to display records that correspond to the applet function. The Active Cases applet, for example, displays a list of all active case records. The cases in the list are displayed as cards, with the case status displayed at the top of the card. To use the cards:

- Swipe a card left or right to see the available actions, then tap the desired action.
- Tap a card to see the record details such as activity, related list, and escalations if any.
- In the detail view:
  - Tap the top menu to see additional actions, then tap the desired action.
  - Select the back button to return to the list.

Applets provide a filter option if there is more than one case in the list. When you tap the applet, you see a list of filters that you can use to narrow down the list of cases.

**Agent applets**
Customer service agents have access to the following set of applets.

<table>
<thead>
<tr>
<th>Applet</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Cases</td>
<td></td>
</tr>
<tr>
<td>Applet</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Needs Attention Cases</td>
<td>Cases that are waiting for the agent to take action. Includes cases in the Open, Awaiting Info, and Resolved states.</td>
</tr>
<tr>
<td>Active Cases</td>
<td>Cases that are assigned to the agent. Includes cases Open, Awaiting Info, and Resolved states.</td>
</tr>
<tr>
<td>New Cases</td>
<td>Cases in the New state.</td>
</tr>
<tr>
<td>Active Critical Cases</td>
<td>Priority 1 cases in the Open, Awaiting Info, and Resolved states.</td>
</tr>
</tbody>
</table>

Tip: Cases in these lists are sorted by the last updated date in descending order, with the most recent updated case displayed first.

**Customer service card layout**

In a list view, case cards display the following information:

- Case state
- Case number
- Short description
- Contact
- Account

In the major case list view, case cards display the following information:

- Major case state
- Case number
- Short description
- Account

**Case form related lists**

Customer service agents can access the following Case form related lists.

<table>
<thead>
<tr>
<th>Related list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLAs</td>
<td>Displays a list of SLAs for a case. View the following information for SLAs included in this list:</td>
</tr>
<tr>
<td>Related list</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
|              | • Task  
|              | • SLA Stage  
|              | • SLA Definition  
|              | • Actual Elapsed Percentage  
|              | • Actual Elapsed Time  

ℹ️ **Note:** Detail view is not available from the SLA related list.

**Tasks**

Displays a list of case tasks. View the following information for case tasks included in this list:

• State  
• Number  
• Subject  
• Assigned to  
• Priority

ℹ️ **Note:** Detail view is not available from the Tasks related list.

**Child Cases**

Displays a list of child cases for a case. View the following information for child cases included in this list:

• Case number  
• State  
• Short description  
• Account  
• Contact

Click a child case to view additional details on the Case form.

---

**Notifications**

Agents can receive notifications in the Customer Service mobile application when cases are assigned, are commented, or need attention. The following notifications are available:
<table>
<thead>
<tr>
<th>Notification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case assignment</td>
<td>When a case is assigned to an agent by someone else, a notification is sent to the agent selected in the <strong>Assigned to</strong> field. The notification includes the case number, state, priority, and short description.</td>
</tr>
<tr>
<td>Case comments</td>
<td>When information is added to a case in the <strong>Additional comments</strong> or <strong>Work notes</strong> fields by someone other than the assigned agent, a notification is sent to the user selected in the <strong>Assigned to</strong> field. The notification includes the case number, priority, and short description.</td>
</tr>
<tr>
<td>Needs attention flag is checked</td>
<td>When the <strong>Needs attention</strong> flag is checked on the Case form, a notification is sent to the agent in the <strong>Assigned to</strong> field. The notification includes the case number, state, priority, and short description.</td>
</tr>
<tr>
<td>Case escalation</td>
<td>When an escalation is raised, users who are part of the group that has permissions to approve are notified. The approvers review and approve them.</td>
</tr>
<tr>
<td>Change requests</td>
<td>When a change request is raised, users who are part of the group that has permissions to approve are notified. The approvers review and approve them.</td>
</tr>
</tbody>
</table>

**Related information**

- Applet launcher
- Navigation bar
- Mobile push notifications
Get started with the Customer Service mobile application

Use the ServiceNow Agent mobile app to access the Customer Service mobile application. Then log in to an instance as an agent or manager and work on your customer service cases.

Before you begin
Role required: sn_customerservice_agent or sn_customerservice_manager

About this task

Procedure
1. Depending on your device, go to the Apple App Store or the Google Play Store and download the ServiceNow Agent mobile app.
2. Log in to an instance.
3. Tap **Customer Service** to open the application and display the applet launcher.
4. Manage your customer service cases based on your role. For more information about the agent and manager tasks, see *Use mobile application to perform agent and manager tasks*.

Related information

Agent mobile app

Use mobile application to perform agent and manager tasks

Customer service agents manage cases and real-time notifications help in taking immediate action. Customer service managers can approve escalations and perform tasks on major issues with a swipe.

Agents (sn_customerservice_agent) and customer service managers (sn_customerservice_manager) can perform routine actions and approvals effectively anytime and anywhere.

### Agent tasks

<table>
<thead>
<tr>
<th>Agent tasks</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept a case</td>
<td>Swipe left and tap <strong>Accept</strong>.</td>
<td>Accept a case that has been assigned to you.</td>
</tr>
</tbody>
</table>
### Agent tasks (continued)

<table>
<thead>
<tr>
<th>Agent tasks</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add comments to a case</td>
<td>• Swipe right and tap Add Comments.</td>
<td>Add information to the case Work Notes or Additional Comments fields.</td>
</tr>
<tr>
<td></td>
<td>• Tap the top menu and select Add Comments.</td>
<td></td>
</tr>
<tr>
<td>Assign a case to another agent</td>
<td>• Swipe left and tap Assign.</td>
<td>This action is available for unassigned cases. Select to display the Assignment Group and Assigned To fields and make the assignments.</td>
</tr>
<tr>
<td></td>
<td>• Tap the top menu and select Assign.</td>
<td></td>
</tr>
<tr>
<td>Assign a case to yourself</td>
<td>• Swipe left and tap Assign to me.</td>
<td>Assign an unassigned case to yourself.</td>
</tr>
<tr>
<td></td>
<td>• Tap the top menu and select Assign to me.</td>
<td></td>
</tr>
<tr>
<td>Close a case</td>
<td>Tap the top menu and select Close Case.</td>
<td>Select to display the Resolution Code and Resolution Notes fields, which are mandatory fields for completing this action. Enable the check box to add the resolution code to the Additional Comments field.</td>
</tr>
<tr>
<td>Edit a case</td>
<td>Tap the top menu and select Edit Case.</td>
<td>You can edit the following fields in the Case form:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Short description</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Account</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Contact</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Needs attention</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Priority</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Product</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Asset</td>
</tr>
</tbody>
</table>
## Agent tasks (continued)

<table>
<thead>
<tr>
<th>Agent tasks</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td><strong>• Assignment group:</strong> selecting an assignment group clears the value in the Assigned to field.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>• Assigned to:</strong> if a group is selected in the Assignment group field, the list of available users belong to that group.</td>
</tr>
<tr>
<td>Open a case</td>
<td>Tap the top menu and select <strong>Open Case.</strong></td>
<td>Open a case and change the state from <strong>Awaiting info</strong> or <strong>Resolved</strong> to <strong>Open</strong>.</td>
</tr>
<tr>
<td>Propose a case as a major case</td>
<td>Tap the top menu and select <strong>Propose Major Case.</strong></td>
<td>Propose a case as a major case candidate.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> This action is available if the Major Issue Management plugin is activated.</td>
</tr>
<tr>
<td>Propose a solution for a case</td>
<td>Tap the top menu and select <strong>Propose Solution.</strong></td>
<td>Select to display the <strong>Resolution Code</strong> and <strong>Resolution Notes</strong> fields, which are mandatory fields for completing this action. Enable the check box to add the resolution code to the <strong>Additional Comments</strong> field.</td>
</tr>
<tr>
<td>Reassign a case to another agent</td>
<td>Swipe left and tap <strong>Reassign.</strong></td>
<td>Available for assigned cases. Select to display the <strong>Assignment Group</strong> and <strong>Assigned To</strong>.</td>
</tr>
</tbody>
</table>
Agent tasks (continued)

<table>
<thead>
<tr>
<th>Agent tasks</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Request more information</td>
<td>• Swipe left and tap Request Info. • Tap the top menu and select Request Info.</td>
<td>Add the request to the Additional Comments field.</td>
</tr>
<tr>
<td>Search for a case using keywords (role: sn_customerservice_agent or sn_customerservice_manager)</td>
<td>Enter search keyword in the search bar.</td>
<td>All cases except those in &quot;Closed&quot; state are listed. From the top menu, you can request for information, escalate a case, propose a solution and so on.</td>
</tr>
<tr>
<td>Escalate a case (role: sn_customerservice_agent or sn_customerservice.escalation_requester)</td>
<td>• Tap the top menu and select Escalate Case and fill in the required information.</td>
<td>Enter the following information and click Submit.</td>
</tr>
<tr>
<td>View escalation</td>
<td>Click Escalations tab.</td>
<td>You can view details of the escalation such as escalation justification and the requester's name.</td>
</tr>
<tr>
<td>View change request (role: sn_customerservice_agent and sn_change_read)</td>
<td>Click on Change Request field on the case form.</td>
<td>The Change Request form view displays details about the schedule, planning, conflicts, and details of the change activity.</td>
</tr>
</tbody>
</table>
# Manager tasks

<table>
<thead>
<tr>
<th>Manager tasks</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approve escalations (role: approver_user)</td>
<td>• Navigate to <a href="#">My Approvals &gt; Escalations</a></td>
<td>• Pending approvals are displayed based on the oldest request.</td>
</tr>
<tr>
<td></td>
<td>• Tap the top menu or swipe left.</td>
<td>• Click the <strong>Approved</strong> tab to check the escalation you approved.</td>
</tr>
<tr>
<td></td>
<td>• Click <a href="#">Reject</a> or <a href="#">Approve</a>.</td>
<td><strong>Note:</strong> When an escalation is raised, users who are part of the group that has permissions to approve are notified. The approvers review and approve them.</td>
</tr>
<tr>
<td>Note: Agents with the approver_user role can also</td>
<td></td>
<td></td>
</tr>
<tr>
<td>approve escalations and change requests.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Review and approve change requests (role: approver_user)</td>
<td>• Navigate to <a href="#">My Approvals &gt; Change Requests</a> on the case form.</td>
<td>A change request requires team members or a manager to assess the change request. They evaluate the request and approve or reject.</td>
</tr>
<tr>
<td>Note: Agents with the approver_user role can also</td>
<td>• Approve or Reject the change request that is in Assess state on the</td>
<td><strong>Note:</strong> When a change request is raised, users who are part of the group that has permissions to approve are notified. The approvers review and approve them.</td>
</tr>
<tr>
<td>approve escalations and change requests.</td>
<td>Change Requests form.</td>
<td></td>
</tr>
</tbody>
</table>
Additional Customer Service Management features

The Customer Service Management application has a number of additional features that you can use to manage customer service cases. Some of these features require plugin activation.

Agent calendar

Customer service agents and field service technicians can use the agent calendar to see work schedules and assignments. They can add personal events such as meetings or appointments.

The agent calendar provides a tool for maintaining different work schedules or shifts. You can assign agents and technicians to shifts for specific time periods. The calendar has the flexibility to accommodate work schedules that are fixed or varied, and shifts that rotate by week, month, or other patterns. The agent calendar administrator creates the calendar configuration, including a schedule configuration for each calendar user and the types of tasks to display on the calendar.

The schedule information stored in the agent calendar is used by other ServiceNow applications and features, such as the assignment workbench, central dispatch, and auto assignment. The assignment workbench uses agent availability when evaluating predefined criteria and recommending agents for case assignment. Agent availability is based on upcoming work schedules and personal time off, Auto assignment in Service Management core applications, such as Field Service Management and Facilities Service Management, evaluate agent work schedules before assigning tasks.

The agent calendar administrator has access to the Agent Schedule menu in the application navigator. This menu includes the following modules:

- Event Configuration: Creates a configuration for each type of event or task displayed on the agent calendar.
- Work Schedule: Creates one or more work schedules for each calendar user.
- Agent Personal Events: Creates personal schedules for each agent and adds events to those schedules.
- Schedule: Creates or modify schedules. For more information, see Schedules.

Viewing the calendar

Customer service agents and field service technicians with the agent_schedule_user role can access their personal calendars in the following ways:
• Customer service agents navigate to Customer Service > My Schedule.
• Field service technicians navigate to Field Service > Agent > My Schedule.

ℹ️ Note: The agent calendar is supported in the mobile application and the mobile web.

The calendar can display a single day, a week, or a month. Buttons in the calendar header allow you to switch views as well as go backward or forward in time. An agent’s scheduled work hours are highlighted in gray and the current day is highlighted in blue. The agent calendar displays work or tasks assigned to the agent as well as personal events. Each type of event is displayed on the calendar using a different color.

Agents can add events to their calendars by double-clicking a specific time slot and entering the details in the New Event pop-up window or by clicking and dragging. Agents can also move events by dragging them. Agents can click an event to display a pop-up window with event details, and they can double-click an event to open the event record.
Plugins

The Agent Schedule plugin (com.snc.agent_schedule) is activated as part of the Customer Service Management and Field Service Management plugins.

Tables

The Agent Schedule plugin adds the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent Work Schedule [agent_work_schedule]</td>
<td>Stores one or more work schedules for each agent, including the date range for the schedule and the schedule type.</td>
</tr>
<tr>
<td>Agent Personal Schedule [agent_events]</td>
<td>Stores personal calendar events for each agent, such as training, personal time off, or meetings.</td>
</tr>
<tr>
<td>Event Configuration [agent_schedule_task_config]</td>
<td>Stores a configuration for each type of task displayed on the agent calendar, such as case tasks or work order tasks.</td>
</tr>
<tr>
<td>Agent Schedule User Config [agent_schedule_user_pref]</td>
<td>Stores the agent’s personalization data for the calendar. A user configuration is created automatically when a user with the agent_schedule_user role accesses their personal calendar.</td>
</tr>
<tr>
<td>Agent Schedule Relationship [agent_schedule_task_config_rel_user_pref]</td>
<td>Stores the relationships between agent configurations and event configurations. Relationship entries are created automatically based on a user's read access to the task tables selected in the event configurations.</td>
</tr>
<tr>
<td>Agent Schedule Definition Theme [agent_schedule_definition_theme]</td>
<td>Stores the colors used to display different types of tasks on the agent calendar.</td>
</tr>
</tbody>
</table>

User Roles

The Agent Schedule plugin adds the following user roles.
### Role Description

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent schedule administrator</td>
<td>Sets up the Agent Calendar configuration. Contains the following roles:</td>
</tr>
<tr>
<td>[agent_schedule_admin]</td>
<td>• agent_schedule_user</td>
</tr>
<tr>
<td></td>
<td>• schedule_admin</td>
</tr>
<tr>
<td>Agent schedule user</td>
<td>Allows customer service agents and field service technicians to access and</td>
</tr>
<tr>
<td>[agent_schedule_user]</td>
<td>update their personal calendars.</td>
</tr>
</tbody>
</table>

**Related information**

Creating and using schedules

**Configuring the agent calendar**

Users with the agent calendar administrator role can perform several calendar configuration tasks. These tasks include creating schedule configurations for each calendar user, creating an event configuration for each type of event, and creating a work schedule to assign to an agent.

If necessary, agent calendar administrators can create personal events for a calendar user although the users themselves typically perform these tasks.

**Create an event configuration for the agent calendar**

Create configurations for each type of entry displayed on the agent calendar. Entries could include case tasks, work order tasks, appointments, or schedule entries.

**Before you begin**

The following types of schedule entries for event type configurations are available by default:

- Event — Appointment
- Event — Excluded
- Event — Meeting
- Event — Phone
- Event — Time Off
- Event — Other

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Each configuration displays as a separate event type on the team calendar. These configurations are inactive by default. You can activate a configuration by doing the following:

1. Navigate to **Agent Schedule > Event Configuration**.
2. Select the event type configuration that you would like to activate.
3. Set the **Active** field to **true**.

Role required: agent_schedule_admin

**About this task**
The schedule entry uses the Schedule Span [cmn_schedule_span] table to store different types of events.

**Procedure**
1. Navigate to **Agent Schedule > Event Configuration**.
2. To create a configuration, do one of the following actions:

<table>
<thead>
<tr>
<th>Option</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>To create a configuration from an existing event configuration</td>
<td>a. Select the desired configuration.</td>
</tr>
<tr>
<td></td>
<td>b. Right-click the form header and click <strong>Insert and Stay</strong>.</td>
</tr>
<tr>
<td></td>
<td>A copy of the selected event type configuration is created.</td>
</tr>
<tr>
<td>To create a new event configuration</td>
<td>Click <strong>New</strong>.</td>
</tr>
</tbody>
</table>

3. On the form, fill in the fields.

**Event Configuration form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Descriptive name for this configuration.</td>
</tr>
<tr>
<td>Config Label</td>
<td>Name displayed for this event in the agent calendar.</td>
</tr>
<tr>
<td>Color theme</td>
<td>Color used to display this type of schedule on the agent calendar.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Setup</th>
<th>Setup method for this configuration. Choices are as follows:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>• <strong>Simple</strong>: Uses the condition builder to set up this configuration.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Scripted</strong>: Uses advanced scripts to set up this configuration.</td>
</tr>
<tr>
<td>Table</td>
<td>Table where the tasks for this type of configuration are stored.</td>
</tr>
<tr>
<td>Filter</td>
<td>Desired conditions for the selected task type. Use the condition builder to create these conditions.</td>
</tr>
<tr>
<td></td>
<td>For example, the event configuration for Case Tasks includes a filter on the task <strong>State</strong> field to display only those tasks that are open.</td>
</tr>
<tr>
<td>User Field</td>
<td>A field from the <strong>Table</strong> that provides the user assigned to the task.</td>
</tr>
<tr>
<td></td>
<td>For example, the event configuration for Case Tasks uses the <strong>Assigned To</strong> field from the Task table [sn_customerservice_task]. When a case task is assigned, it appears on the agent calendar for the user selected in this field.</td>
</tr>
<tr>
<td>Event type</td>
<td>Type of schedule entry.</td>
</tr>
<tr>
<td>Display Field</td>
<td>A field from the <strong>Table</strong> that provides the information to be displayed for this event type on the agent calendar.</td>
</tr>
<tr>
<td></td>
<td>For example, the event configuration for Case Tasks uses the <strong>Subject</strong> field from the Task table [sn_customerservice_task]. When a case task is assigned, the subject of the task appears on the agent calendar.</td>
</tr>
<tr>
<td>Start Date Field</td>
<td>A field from <strong>Table</strong> that provides the start date for the task.</td>
</tr>
<tr>
<td></td>
<td>For example, the event configuration for Case Tasks uses the <strong>Expected start</strong> field from the Task table [sn_customerservice_task]. When a case task is assigned, it appears on the agent calendar starting on the date and time specified in this field.</td>
</tr>
<tr>
<td>End Date Field</td>
<td>A field from <strong>Table</strong> that provides the end date for the task.</td>
</tr>
<tr>
<td></td>
<td>For example, the event configuration for Case Tasks uses the <strong>Due date</strong> field from the Task table [sn_customerservice_task]. When a case task is assigned,</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>From Date</td>
<td>it appears on the agent calendar ending on the date and time specified in this field.</td>
</tr>
<tr>
<td>Note:</td>
<td>Because the agent schedule administrator can select any fields from the Task Table for the <strong>Start Date Field</strong> and the <strong>End Date Field</strong> fields, it is possible that the end date may be earlier than the start date. In this event, the task is displayed on the agent calendar between the two points in time.</td>
</tr>
<tr>
<td>Script</td>
<td>Advanced scripts that create the event configuration.</td>
</tr>
<tr>
<td>Note:</td>
<td>This field is available when <strong>Scripted</strong> is selected from the <strong>Setup</strong> field.</td>
</tr>
</tbody>
</table>

4. To save the configuration, perform one of the following actions:
   - If you created the configuration from an existing configuration, click **Update**.
   - If you created a new configuration, click **Submit**.

**Create a work schedule for an agent or technician**

Create one or more work schedules for a customer service agent or a field service technician.

**Before you begin**
Role required: agent_schedule_admin

**About this task**
A work schedule includes a date range and a schedule type, such as day shift or evening shift. Agents and technicians can have multiple work schedules.

**Procedure**
1. Navigate to **Agent Schedule > Work Schedule**.
2. Click **New**.
3. On the form, fill in the fields.

**Agent Work Schedule form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Date</td>
<td>First day of the work schedule.</td>
</tr>
</tbody>
</table>
Create a personal event for an agent or technician

Create personal events that appear on an agent’s personal calendar.

Before you begin
Role required: agent_schedule_admin

About this task
Agents and technicians typically add personal events to their own calendars. Administrators can also add events for agents and technicians.

Procedure
1. Navigate to Agent Schedule > Agent Personal Events.
2. Select the personal schedule for the desired agent.
3. In the Schedule Entries related list, click New.
4. On the form, fill in the fields.

Schedule Entry form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the event.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of event:</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>• Time off</td>
<td></td>
</tr>
<tr>
<td>• Appointment</td>
<td></td>
</tr>
<tr>
<td>• Meeting</td>
<td></td>
</tr>
<tr>
<td>• Phone call</td>
<td></td>
</tr>
<tr>
<td>• Excluded</td>
<td></td>
</tr>
<tr>
<td>• On call</td>
<td></td>
</tr>
<tr>
<td>• Time off - in approval</td>
<td></td>
</tr>
<tr>
<td>• Time off - rejected</td>
<td></td>
</tr>
<tr>
<td>Show as</td>
<td>Show this event on the agent’s personal calendar as one of the following ways:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Busy</strong>: Excludes the block of time from agent availability calculations for the auto assignment and the case assignment workbench</td>
</tr>
<tr>
<td></td>
<td>• <strong>Free</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Tentative</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>On call</strong></td>
</tr>
<tr>
<td>When</td>
<td>Start date and time of the personal event.</td>
</tr>
<tr>
<td>To</td>
<td>End date and time of the personal event.</td>
</tr>
<tr>
<td>All day</td>
<td>Option to make the event last all day.</td>
</tr>
<tr>
<td>Repeats</td>
<td>How often the event repeats. Options are as follows:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Does not repeat</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Daily</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Every Weekday (Mon-Fri)</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Every Weekend (Sat, Sun)</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Every Mon, Wed, Fri</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Every Tue, Thu</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Weekly</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Monthly</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Yearly</strong></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Depending on the selection, other fields are required to complete the frequency information.</td>
</tr>
<tr>
<td>Repeat every</td>
<td>Frequency of the repeated event.</td>
</tr>
<tr>
<td>Repeat on</td>
<td>Day of the week for weekly events.</td>
</tr>
<tr>
<td>Monthly type</td>
<td>Times for repeating monthly events. Choices are as follows:</td>
</tr>
<tr>
<td></td>
<td>• Day of the month</td>
</tr>
<tr>
<td></td>
<td>• Day of the week</td>
</tr>
<tr>
<td></td>
<td>• Last day of the month</td>
</tr>
<tr>
<td></td>
<td>• Last week of the month</td>
</tr>
<tr>
<td></td>
<td>These selections use the day and date in the When field as the basis for repetition.</td>
</tr>
<tr>
<td>Yearly type</td>
<td>Times for repeating yearly events. Choices are as follows:</td>
</tr>
<tr>
<td></td>
<td>• Day of the year: Uses the day and date in the When field as the basis for repetition.</td>
</tr>
<tr>
<td></td>
<td>• Floating: For this selection, complete the Float week, Float day, and Float month fields.</td>
</tr>
<tr>
<td>Repeat until</td>
<td>End date of the repeated event.</td>
</tr>
<tr>
<td>Float week</td>
<td>Week for a floating yearly repeating event.</td>
</tr>
<tr>
<td>Float day</td>
<td>Float day for a floating yearly repeating event.</td>
</tr>
<tr>
<td>Float month</td>
<td>Float month for a floating yearly repeating event.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Create a schedule to use with the agent calendar**

Create a schedule to use with the agent calendar.

**Before you begin**

Role required: agent_schedule_admin
About this task
Creating a schedule for the agent calendar uses the schedule feature. For more information, see Schedules.
Schedules are configured with the following types of records:

- Schedule records: Specify a time zone, a type of schedule, and use one or more schedule entries. Schedule records are saved in the Schedule [cmn_schedule] table.

- Schedule entry records: Specify the time periods that are included or excluded from a schedule. Schedule entries are saved in the Schedule Entry [cmn_schedule_span] table.

Procedure
1. Navigate to Agent Schedule > Schedule.
2. Click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the schedule.</td>
</tr>
<tr>
<td>Time Zone</td>
<td>Time zone for the schedule. If you select Floating, the time zone will be relative to whoever is accessing the schedule at any given time.</td>
</tr>
<tr>
<td>Parent</td>
<td>Parent schedule that constrains the new schedule.</td>
</tr>
</tbody>
</table>
| Type      | Label that describes the purpose of the schedule. You can also use one of these system terms to determine how to process certain schedules:  
- **excluded**: Excludes time periods from SLA counts.  
- **maintenance**: Specifies time periods where change management activities are allowed. A schedule containing maintenance schedule entries cannot also contain blackout schedule entries.  
- **blackout**: Excludes time periods from change management schedules. A schedule containing blackout schedule entries cannot also contain maintenance schedule entries. |
| Description | Description of the schedule. |
Note: The Schedule form displays a warning message if there are no active entries defined for the current schedule. If your schedule is a child schedule that only contains exclusions, ignore the message because exclusions are non-active entries.

4. Right-click the header bar and click Save.

Note: If you create a schedule of type maintenance and save the record, a UI policy hides the Type field from the form. To view or change the value for the Type field, do the following:
   a. View the list of schedules rather than the schedule form.
   b. Add the Type column.
   c. Double-click the cell for the value in the Type column, and modify from the list view.

5. Configure one or more schedule entries.

6. Click Submit.

Using the agent calendar

Agents with the agent calendar user role can add events to their personal calendar. They can configure the calendar to show or hide different types of events.

Add an event to the agent calendar

Add events to your personal calendar.

Before you begin
Role required: agent_schedule_user

Procedure

1. To go to your calendar, navigate to one of the following locations:
   • Customer Service > My Schedule
   • Field Service > Agent > My Schedule

2. To create an event on the calendar, either double-click a timeslot or click and drag over a timeslot.
   The New Event form is opened.

3. On the form, fill in the fields.
## New Event form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the event.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of event. Choices are as follows:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Time off</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Appointment</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Meeting</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Phone call</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Excluded</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>On call</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Time off - in approval</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Time off - rejected</strong></td>
</tr>
<tr>
<td>Show as</td>
<td>Your status during this event. Choices are as following: as one of the following:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Busy</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Free</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Tentative</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>On call</strong></td>
</tr>
<tr>
<td></td>
<td>If you select <strong>Busy</strong>, this block of time is excluded from agent availability calculations for auto-assignment and for the case assignment workbench.</td>
</tr>
<tr>
<td>When</td>
<td>Start date and time of the personal event.</td>
</tr>
<tr>
<td>To</td>
<td>End date and time of the personal event.</td>
</tr>
<tr>
<td>All day</td>
<td>Option to make the event last all day.</td>
</tr>
<tr>
<td>Time zone</td>
<td>Time zone of the event. If you have selected a specific time zone in your user profile, then that time zone is displayed here and is used as the time zone for this event. Subsequent changes to the <strong>Time zone</strong> field in the user profile do not change the time zone designation for this event.</td>
</tr>
<tr>
<td>Repeats</td>
<td>Frequency of when this event repeats. Choices are as follows:</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Does not repeat</td>
<td></td>
</tr>
<tr>
<td>Daily</td>
<td></td>
</tr>
<tr>
<td>Every Weekday (Mon-Fri)</td>
<td></td>
</tr>
<tr>
<td>Every Weekend (Sat, Sun)</td>
<td></td>
</tr>
<tr>
<td>Every Mon, Wed, Fri</td>
<td></td>
</tr>
<tr>
<td>Every Tue, Thu</td>
<td></td>
</tr>
<tr>
<td>Weekly</td>
<td></td>
</tr>
<tr>
<td>Monthly</td>
<td></td>
</tr>
<tr>
<td>Yearly</td>
<td></td>
</tr>
</tbody>
</table>

- **Repeat every**: Number for the frequency of the repeated event.
- **Repeat on**: Day of the week when the weekly event is repeated.
- **Monthly type**: Day of the month when the monthly event is repeated. Choices are as follows:
  - Day of the month
  - Day of the week
  - Last day of the month
  - Last week of the month
  These selections use the day and date in the **When** field as the basis for repetition.
- **Yearly type**: Day of the year when the yearly event is repeated. Choices are as follows:
  - **Day of the year**: Uses the day and date in the **When** field as the basis for repetition.
  - **Floating**:
- **Repeat until**: Date for the end of the repeated event.
- **Float week**: Float week for a floating event that repeats yearly. This field appears only when **Floating** is selected from the **Yearly type** field.
- **Float day**: Float day for a floating event that repeats every year. This field appears only when **Floating** is selected from the **Yearly type** field.
4. Click **Submit**.

**Results**
The new event appears on the agent calendar and on the Schedule Entries related list on the Agent Personal Schedule form.

**Move an event on the agent calendar**
Move events on your personal calendar.

**Before you begin**
Role required: agent_schedule_user

**Procedure**
1. To go to your calendar, navigate to one of the following locations:
   - **Customer Service > My Schedule**
   - **Field Service > Agent > My Schedule**
2. To move an event, use one of the following methods.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use the calendar</td>
<td>a. Click an event.</td>
</tr>
<tr>
<td></td>
<td>b. Drag the event to a new day or time</td>
</tr>
<tr>
<td>Use the event record</td>
<td>a. Double-click an event to open the event record.</td>
</tr>
<tr>
<td></td>
<td>b. Change the date and time information in the <strong>When</strong> and <strong>To</strong> fields.</td>
</tr>
<tr>
<td></td>
<td>c. Click <strong>Submit</strong>.</td>
</tr>
</tbody>
</table>

**Results**
The event appears on the calendar with a new time in a new location.
Show or hide event types on the agent calendar

Personalize your calendar to show or hide different types of events.

Before you begin
Role required: agent_schedule_user

Procedure
1. To go to your calendar, navigate to one of the following locations:
   - Customer Service > My Schedule
   - Field Service > Agent > My Schedule
2. In the calendar header, click the configuration icon. The Schedule Configuration list is displayed.
3. Enable or disable the toggle switches for the different types of events. An option is enabled when the switch is moved to the right and appears with a green background.
4. To hide the Schedule Configuration menu, click the configuration icon again.

Results
The calendar displays the enabled task types.

Time recording for Customer Service Management

Record time worked on cases and case tasks. Time worked entries automatically generate time cards and time sheets for manager approval.

Customer service agents (users with the sn_customerservice_agent role) can record time worked on case-related activities, create time cards and time sheets, and submit for approval. Managers can approve time sheets, define cost rates for different types of activities, and convert to expense lines.

The time recording feature extends the functionality of the Time Card Management application to Customer Service Management. Agents can record time worked on cases and tasks directly from the Case or Case Task form and time spent on other activities, such as meetings or training, from the Time Worked form. Time worked entries automatically create time cards for each task and selected work category. Time cards are automatically included in a weekly time sheet.

The time recording feature also extends the functionality of the Cost Management application to Customer Service Management. Customer service managers can create labor rate cards, which define different cost rates for different activities. Time sheets use labor rate cards to determine costs and to generate expense lines.
Agents can modify the hours recorded on time cards. Once a time sheet is approved and a time card is processed, the agent can still go back and modify the time worked. The time sheet reverts to the Pending state and new time cards are created. If an agent adds more time worked records to an approved time sheet for the same week, a new time sheet record is created for the current week.

Managers can view time worked records, time cards, and time sheets for agents in their assignment groups, as well as approve and reject time sheets. After a time sheet is approved, the system processes the time cards and uses rate cards based on the time card category to create expense lines.

Time recording plugin

The time recording feature requires the Customer Service Management plugin (com.sn_customerservice) and the Time Recording for Customer Service plugin (com.snc.csm_time_recording).

User roles

The time recording feature adds the following roles.

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time card user</td>
<td>Record time worked on cases and tasks. View, modify, and delete time worked entries on time cards and submit time sheets for approval. Users with the customer service agent (sn_customerservice_agent) role inherit the timecard_user role.</td>
</tr>
<tr>
<td>[timecard_user]</td>
<td></td>
</tr>
<tr>
<td>Note: This role restricts access to the time sheets, time cards, and time worked records created by the agent.</td>
<td></td>
</tr>
<tr>
<td>Time card administrator</td>
<td>Review, approve, and reject time sheets for customer service agents. Users with the customer service manager role (sn_customerservice_manager) inherit the timecard_admin, timecard_approver, and timecard_manager roles.</td>
</tr>
<tr>
<td>[timecard_admin]</td>
<td></td>
</tr>
</tbody>
</table>
Role | Description
--- | ---
| **Note:** This role restricts access to the time sheets, time cards, and time worked records created by the agents in a manager's assigned groups.

System properties
The time recording feature adds the following properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.time_card.time_worked</td>
<td>Enables the time recording feature for Customer Service Management. The default setting is <strong>false</strong>.</td>
</tr>
<tr>
<td>com.snc.time_card.default_rate</td>
<td>The default hourly rate used when processing time cards if a rate from a labor rate card is not available.</td>
</tr>
</tbody>
</table>

Time Sheet policy
The time recording feature uses the **Default time sheet policy**.

For users with the sn_customerservice_agent role, creating time worked records automatically creates or modifies time cards regardless of the setting for the com.snc.time_card.time_worked system property. The time sheet policy controls this functionality. The system administrator can disable the auto-creation of time cards for a specific user with the sn_customerservice_agent role by creating a separate time sheet policy for that user.

Labor rate cards
The time recording feature provides one labor rate card: **CSM Rate Card (Default)**.

If needed, system administrators can create additional labor rate cards. Navigate to **Cost > Costs > Labor Rate Cards** and click **New** to create a labor rate card.

Record time worked for a case or activity
Customer service agents can record time worked on a case or case task as well as time spent on other activities.
Before you begin
Role required: sn_customerservice_agent

About this task
Agents can record time worked from a case or case task. Time worked can be recorded regardless of the case or task state. Agents can also record time worked from the Time Sheets module by navigating to Time Sheets > Time Recording > My Time Worked.

When an agent creates a time worked record, a time card and time sheet are automatically created for the week based on the work date. The time card is created for the task and the category type. The total hours recorded on each time card are recorded on the current time sheet in the Time Cards related list.

Procedure
1. To record time worked from a Case form or Case Task form:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Platform interface</td>
<td>Navigate to a case or task and click Record Time.</td>
</tr>
<tr>
<td></td>
<td>Navigate to a case or task, click the more UI actions icon (***), and click Record Time.</td>
</tr>
<tr>
<td>Agent Workspace</td>
<td></td>
</tr>
</tbody>
</table>

This action opens a Time Worked form with the Task and User fields already populated.

2. To record time worked from the Time Sheets module:

a. Navigate to Time Sheets > Time Recording > My Time Worked and click New. This action opens a Time Worked form with the User field already populated.

b. Select a task number in the Task field.

3. Select the Work Date.

4. Select a Category for the time being recorded.

5. Fill in the Time worked.

6. Provide any additional information in the Comments field.

7. Click one of the following actions:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Platform interface</td>
<td>Click Submit.</td>
</tr>
<tr>
<td>Agent Workspace</td>
<td>Click Save.</td>
</tr>
</tbody>
</table>

The Time Worked form is saved and added to the following lists:

- The **Time Worked** related list on the Case or Case Task form.
- The **Time Cards** related list on the current Time Sheet form.
- The Time Worked list in the Time Sheets module.

If this entry is the first time worked entry for the selected category, a time card is created for that category. If a time card for the category already exists, the time worked record is added to that card.

### Review time worked for a case or activity

Customer service agents can review time worked on cases and case tasks.

**Before you begin**

Role required: sn_customerservice_agent

**About this task**

The **Time Worked** related list on the Case and Case Task form displays the time worked records that have been created for the case or task. From this related list, agents can review their recorded time, add new time worked records, and also delete records.

**Procedure**

1. Navigate to the desired case or case task.
2. Go to the **Time Worked** related list.
3. To view a time worked record, click the **Comments** for that record.

### Modify or delete time worked entries for cases or activities

Agents can modify and delete existing time worked entries and create new entries after a time sheet has been approved.

**Before you begin**

Role required: sn_customerservice_agent
About this task
An agent can modify or delete time worked entries for an approved time sheet. Any changes to these entries update existing time cards, creates new time cards if needed, and generates an updated time sheet.

Note: Do not manually edit time cards. Edit the original time worked entries, which generate updated time cards and time sheets.

Procedure
1. To modify or delete a time worked entry:
   • Navigate to the desired case or case task, click the Time Worked related list, and click the desired entry.
   • Navigate to Time Sheets > My Time Worked and click the desired entry.
2. To modify the entry, change the desired fields and click Update.
3. To delete the entry, click Delete.

Review a time card
Customer service agents can review time cards created from time worked records.

Before you begin
Role required: sn_customerservice_agent

About this task
The Time Worked related list on the Case and Case Task form displays the time worked records that have been created for the case or task. This list also displays the time cards created from the time worked records.

Procedure
1. Navigate to the desired case or case task.
2. Go to the Time Worked related list.
3. To view a time card, click the Time Card for that record.
   The time card provides a breakdown of the time worked for this case or case task by day.

Review and submit a time sheet for a customer service agent
Agents can review and submit time sheets to managers for approval.
Before you begin
Role required: sn_customerservice_agent

About this task
The total hours worked for each category are recorded on the time card and on the time sheet. From the time sheet, you can see total hours by day and by category.

Procedure
2. If desired, review the time cards associated with the time sheet in the Time Cards related list.
3. Click Submit Time Sheet.
   The time sheet is submitted to the manager for approval. The state of the time sheet changes from Pending to Submitted and the form becomes read-only. The state of the associated time cards also changes to Submitted.

Review and approve time sheets for customer service agents
Managers can review time cards and time sheets for agents in their assignment groups.

Before you begin
Role required: sn_customerservice_manager

About this task
When a time sheet is approved, the time cards are processed and used to create expense lines that reference the defined labor rate cards.

Procedure
1. Navigate to Customer Service > Manager > Time Sheets - Pending Approval.
2. Select a time sheet.
3. If necessary, review the time cards associated with this time sheet in the Time Cards related list.
4. Click one of the available actions:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approve</td>
<td>The state of the time sheet and the associated time cards changes to</td>
</tr>
</tbody>
</table>
### Customer Service Management for Orders

This feature adds support for orders and order line items to the Customer Service Management application.

Customer Service Management for Orders enables customers and consumers to do the following through a self-service portal:

- View orders
- View and create cases for orders
- Contact a customer service agent to report an issue

Customer service agents can respond to customer and consumer requests and create cases for orders.

### Plugins

To add support for orders to the Customer Service Management application, activate the Customer Service Management for Orders plugin (com.snc.csm.order). This plugin requires the Customer Service plugin (com.sn_customerservice).
This plugin adds the following modules to the Customer Service menu:

- **Orders**: displays a list of customer orders. Click an order to display the Order form.
- **Order Line Items**: displays a list of the individual items within each order in the Orders list. Click an item to display the Order Line Item form.

**Creating a case for an order**
When creating a case from the Customer or Consumer Service Portals, the end user can select the type of case to create. Based on the selection, the Create Case form includes fields specific to the selected case type.

- **Create Product Case**: includes the **Asset** and **Product** fields.
- **Create Order Case**: includes the **Order** field.

When creating a case from the Customer Service Management application, the customer service agent can select the type of case to create:

- **Product**: opens a new Case form for a product that includes the **Product** and **Asset** fields.
- **Order**: opens a new Case form for an order that includes the **Order** field.

**Tables installed with Customer Service Management for Orders**
Customer Service Management for Orders adds the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orders [csm_order]</td>
<td>Stores the orders associated with an account and contact or with a consumer.</td>
</tr>
<tr>
<td>Order Line Items</td>
<td>Stores the individual line items within orders.</td>
</tr>
<tr>
<td>[csm_order_line_item]</td>
<td></td>
</tr>
<tr>
<td>Order Cases [csm_order_case]</td>
<td>Stores information about customer service cases related to orders.</td>
</tr>
<tr>
<td>Order Case Line [csm_order_case_line]</td>
<td>Stores information about customer services cases related to orders and order line items.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Engagement Messenger for Customer Service Management (CSM)
By using the ServiceNow® Engagement Messenger application, your customers use self-service to find the information or service that they need from your third-party web applications that are outside of the ServiceNow environment.

Request apps from the ServiceNow Store
Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

Engagement Messenger benefits
With the Engagement Messenger application, you can manage how your customers use your web applications and services from one central location. You can also configure the behavior and styling of the messenger and deploy the configuration on the websites or mobile sites of your choice.

Engagement Messenger provides the following benefits:
• Let your customers access your services from within an integrated messenger in your third-party websites.
• Integrate customer support capabilities via a no or low-code configuration.
• Meet your customer needs faster with these pre-packaged features:
  ◦ Case management including case types
  ◦ Service catalog requests
  ◦ Virtual and live agent chat
  ◦ Field service management
  ◦ Appointment booking for field service
  ◦ Walk-up appointment booking
  ◦ Knowledge article search that is powered by ServiceNow® AI Search

For more information about the Engagement Messenger application, see Features of Engagement Messenger.

To get started with the Engagement Messenger application, see Setting up Engagement Messenger.

Features of Engagement Messenger
Understand what the Engagement Messenger application can provide to your customers.
After you create and configure an Engagement Messenger module, you can customize it for your customers. For example, you can change the display order of any of these features on the home page of the messenger. Also, you can enable or disable any of these features to suit your customer's needs.
Greeting

You can display the user greeting, which also includes a greeting message, on the header of the messenger. You can customize the way you want to greet your guest users and the users who sign in to your website.

Knowledge

You can select a knowledge base for your search results or choose to display featured articles on the home page of the messenger. You can also add multiple knowledge bases to suit your customer base.

Note: To add knowledge bases to the Engagement Messenger module, you must manually assign the knowledge_admin role to the Engagement Messenger admin [sn_csm_ec_ec_admin] user.

Search

The ServiceNow® AI Search capability that is used in the Engagement Messenger application uses the knowledge bases that you selected for your messenger.

When a customer searches for information using the Search widget on the messenger, the displayed results are from the articles in the knowledge bases that are associated to your messenger module.

Customers can open the articles from the search results to get the information they need. They can also provide feedback to the article directly from the messenger to indicate whether the article was helpful or not. This feedback helps you to understand which articles are the most helpful so that you can improve those articles that were not helpful.
Note:

- If the Service Portal - Restricted Pages plugin (com.glide.service-portal.pages.restricted) is activated in your ServiceNow instance, AI Search functionality will not work in Engagement Messenger for unauthenticated users. If this plugin is not activated, then the AI Search functionality works for both unauthenticated and authenticated users.

- You must configure AI Search in your ServiceNow instance and then enable Typeahead Search and AI Search Assist widgets so that the unauthenticated users can use the AI search feature from Engagement Messenger.

For more information on enabling Typeahead Search and AI Search Assist widgets for Engagement Messenger, see Enabling AI search in the Customer and Consumer Service Portals for unauthenticated users.

For more information of AI Search configuration, see Configuring AI Search.

Case management

You can manage your customer cases on the messenger. This feature is available only for authenticated users of your website.

By using the Cases widget on the messenger, your customers can submit a case to request help with something or to report an issue. Submitted cases can be assigned to a customer service agent and tracked to a resolution.

Whenever your customers return to the customer portal and log in, they are notified of any updates to the cases that they created.
They can also view the details of all the cases and requests that they have previously submitted and track their status.

Some cases would require action from the submitted user, asking them to provide more information about the help they need or to review a solution that the support team has provided. Customers can perform all these actions directly from within the messenger.

**Catalogs**

You can associate pre-defined catalogs with your Engagement Messenger. Customers can browse through the list of available catalog items. From this list of catalog items, they can choose to request a service or create a ticket. The requests that the customer makes can be tracked to a resolution using the case management feature.

Whenever your customers return to the customer portal and log in, they are notified of any updates to the requests that they have previously submitted.

**Field service management**

The field service feature enables your customer to request a technician visit to service their issue. By selecting a product or service that they need help with and their location, customers can submit a request for a technician visit. While submitting the request, customers can also add any supporting attachments that they think might help the support team understand the issue before a technician is allotted for the visit.

All technician requests are stored as work orders in your ServiceNow instance so that they can be tracked to completion.
The Work Order will have the location where the customer has raised a request. Geo-location services must be enabled for the technicians so that customers can track the live location and know the estimated time of arrival (ETA) of their technician. For more information, see Field service feature configuration.

Note:
- Ensure that the Field Service Management - Customer Experience plugin (com.snc.fsm_customer_experience) is active in your ServiceNow instance.
- The field service feature is available only for users who log in to the Engagement Messenger and not for guest users.

Walk-up appointments

The walk-up feature enables your customers to book an appointment to visit one of your stores, service centers, and the like. Customers can view the support centers near them and select one to schedule an appointment to visit. Once an appointment is scheduled, customers receive a confirmation email.

Customers who log in into your website can view a list of scheduled appointments directly from this widget on the Engagement Messenger home page. They can modify or cancel existing appointments. They also receive notification emails on the following status of their walk-up appointment:
- They are ready to be assisted by an associate of the support center
- A walk-up interaction is assigned to an associate of the support center
- A walk-up interaction is closed

Customers who do not log in can use the confirmation email to view and modify their appointments.

Note: To enable walk-up feature for your customers, ensure that you activate the following plugins in your ServiceNow instance:
- Walk-up for CSM plugin (com.snc.walkup_for_csm) for authenticated users
- Guest Walk-up Experience for Customer Service plugin (sn_guest_walkup_cs) for unauthenticated users
Virtual and live agent chat

Customers can use the Chat widget on the messenger to interact with a virtual or live customer support agents in your organization. This way, your customers can get immediate responses to their queries or issues.

Live agent chat

Engagement Messenger also provides contextual chat functionality. From any case details page, your customers can directly start a chat that opens with the context of that specific case.

Note: Chat is available when you activate the Glide Virtual Agent plugin (com.glide.cs.chatbot) and set the com.glide.cs.embed.csp_frame_ancestors system property value to 'self' <your website URL>.

Proactive updates and reminders
Engagement Messenger provides your customers updates and reminders in the following scenarios so that you can keep your customers updated even if they are not accessing the messenger directly.

- Reminder for an upcoming walk-up appointment, as per the walk-up feature configuration
- Reminder for an upcoming technician visit
- Updates on a case
- Update on a chat

According to the configuration of Engagement Messenger behavior, the count of the updates is displayed on the messenger widget on your customer support webpage. If the customer navigate away from your website, the count of updates is also displayed on the browser tab.

To learn how to start configuring Engagement Messenger for your third-party website, see Setting up Engagement Messenger.

Related information

- Exploring AI Search
- Case management for Customer Service Management
- Virtual Agent
- Using Walk-up Experience
- Knowledge Management
- Field Service Management

Chat Zoom Connector

Resolve issues quickly and engage better with customers with video and screen sharing options in Zoom using the ServiceNow® Chat Zoom Connector application.

Request apps on the Store

Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.
Overview

The Chat Zoom Connector application integrates the chat communication channel with the Notify communication channel by managing and initiating a Zoom meeting directly from a chat. An interaction record is created for each Zoom meeting initiated from a chat.

As an agent, you can use the Chat Zoom Connector application to initiate Zoom meetings from a customer chat and optionally record the meeting.

As an agent manager, you can access an interaction record of type Zoom to view the meeting details such as the meeting URL, participants, and recording.

To get started with the Chat Zoom Connector application, see Configure Chat Zoom Connector.

Key features

- Initiate Zoom meetings using the Quick Actions list in chats.
- Track Zoom meetings as interactions on the ServiceNow platform.
- Track participants in Zoom meetings.
- Post the meeting recording to the interaction activity stream.

Example scenario

The following example scenario shows the use of the Chat Zoom Connector application in resolving a configuration issue with an agent initiating a Zoom meeting directly from a customer chat.

Agent resolving a customer issue over Zoom
1. A customer engages with Support over chat to report an issue for a product.
2. An agent receives the chat request and realizes that the issue can be resolved through a minor configuration change.
3. The agent initiates a Zoom meeting using the Quick Actions list in the chat and invites the customer to join the meeting.
4. The customer shares the screen over Zoom and the agent guides the customer on updating the configuration and resolves the issue.

**Pre-chat surveys**

Use pre-chat surveys to capture preliminary information from a customer. From the responses received, Advanced Work Assignment (AWA) routes chat conversations to appropriate queues and groups. Before entering into a chat conversation, the assigned agent can review the context of the issue.

**Pre-chat features**

Pre-chat surveys provide the following advantages that help agents efficiently handle chat conversations:

- **Preconfigured pre-chat surveys**
  Pre-chat surveys determine the pre-chat questions presented to users. Preconfigured surveys are activated by default in the base system, but in order to avoid conflicts with previous configurations, customers who have upgraded have to manually activate them. These preconfigured surveys are:
  - CSP Pre-Chat Survey - Collects preliminary information for logged-in customers.
  - CSP Anonymous Pre-Chat Survey – Collects preliminary information for users who are not logged in.

  You can define a different survey or modify these predefined surveys. For more information, see [Define pre-chat survey configurations](#).

- **Routing chats to the correct queue**
  Advanced Work Assignment (AWA) leverages information captured through pre-chat surveys to route a chat to the right queue. For more information, see [Work item queues](#).

- **Identifying topics related to the chat issue**
  When customers enter a response to the standard pre-chat question "Please briefly describe your issue," Natural Language...
Understanding can help determine the appropriate Virtual Agent conversation topic. Relevant topics are automatically displayed to end users (requesters) rather than prompting them to choose from a list of conversation topics. For more information, see Configure context topic intent.

**Configuring Pre-chat if you have upgraded**
Some settings need to be configured if you have upgraded your ServiceNow® instance. For more information, see Configure Pre-chat after upgrading.

**Plugins**
You must activate the Consumer Service Portal (com.glide.service-portal.consumer-portal) and Glide Conversation Server (com.glide.cs) plugins. To activate the plugins, see Activate a plugin.

**Related information**
- Pre-chat from the Consumer Service Portal

**Messaging Service for Customer Service Management (CSM)**
The ServiceNow Messaging Service application is a subscription service. The Messaging Service provides the capability to send and receive SMS messages from your instance of the Messaging Service to third parties via a supported service provider.

To deploy the Messaging Service, use the following high-level steps:

1. **Purchase a phone number.**
2. **Look up SID and auth token.**
3. **Download and configure the SMS adapter**
4. **Configure the webhook.**

The following catalog items are available to be used as needed:
- Port a phone number.
- Release a phone number.
- View currently assigned phone numbers and mapped instances.

The following image explains the messaging service flow.
Conversational Appointment Booking

Book, reschedule, and cancel appointments from Virtual Agent conversations. The ServiceNow® Conversational Appointment Booking application uses Natural Language Understanding (NLU) to communicate with customers.

Booking an appointment

The appointment booking flow works as follows:

• The logged-in user contacts your business via your portal.
• The user enters their appointment booking request into the chat, and the Virtual Agent uses Natural Language Understanding (NLU) to understand the request.
• The Virtual Agent asks the user to share their location. If the user shares their location, the available appointment locations are displayed.
• The user chooses a location.
• The user chooses the purpose of the appointment.
• The user chooses a date and time slot for the appointment.
• The appointment booking is complete.

The following image illustrates the appointment booking flow.
Rescheduling an appointment
The appointment rescheduling flow works as follows:

- The logged-in user contacts your business via your portal.
- The user enters their appointment booking request into the chat, and the Virtual Agent uses Natural Language Understanding (NLU) to understand the request.
- The user chooses an appointment to reschedule, and enters an email ID if needed.
- The user chooses the date and time for the rescheduled appointment.
- The appointment rescheduling is complete.

The following image illustrates the appointment rescheduling flow.

Cancelling an appointment
The appointment cancellation flow works as follows:

- The logged-in user contacts your business via your portal.
- The user enters their appointment booking request into the chat, and the Virtual Agent uses Natural Language Understanding (NLU) to understand the request.
- The user chooses an appointment to cancel.
- The appointment cancellation is complete.
The following image illustrates the appointment cancellation flow.

![Appointment Cancellation Flow](image)

**Related information**

Configure Conversational Appointment Booking

Using Conversational Appointment Booking

**Configuring Customer Service Management**

Use the Customer Service Management guided setup to configure the features, components, and integrations that you need to provide service and support to your customers.

**Planning your Customer Service Management implementation**

These questions about business models, customers, products and services, and the structure of your customer service organization can help you determine your customer service requirements.

<table>
<thead>
<tr>
<th>What type of services and support do you provide?</th>
<th>Customer Service Management supports these business models:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Business-to-business (B2B)</td>
</tr>
<tr>
<td></td>
<td>• Business-to-consumer (B2C)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>What type of customers do you support?</th>
<th>With the business-to-business (B2B) model, you can support accounts and contacts. Additionally, you can set up the following:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Customer relationships</td>
</tr>
<tr>
<td></td>
<td>• Account teams</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>What type of products do you support?</th>
<th>With the business-to-consumer (B2C) model, you can support individual consumers.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>What type of products do you support?</th>
<th>With Customer Service Management, you can support:</th>
</tr>
</thead>
<tbody>
<tr>
<td>How is your customer service organization structured?</td>
<td>Customer Service Management can provide the following structure:</td>
</tr>
<tr>
<td>------------------------------------------------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>• Agent groups and group managers</td>
</tr>
<tr>
<td></td>
<td>• Skills required by agent groups</td>
</tr>
<tr>
<td>How do you route cases to your customer service agents?</td>
<td>Customer Service Management provides the following routing options:</td>
</tr>
<tr>
<td></td>
<td>• Matching rules</td>
</tr>
<tr>
<td></td>
<td>• Assignment rules</td>
</tr>
<tr>
<td></td>
<td>• Assignment workbench</td>
</tr>
<tr>
<td></td>
<td>• Advanced Work Assignment (AWA) for Workspace</td>
</tr>
<tr>
<td>How do your customers communicate with customer service agents?</td>
<td>Customer Service Management provides the following communication channels:</td>
</tr>
<tr>
<td></td>
<td>• Chat</td>
</tr>
<tr>
<td></td>
<td>• Phone</td>
</tr>
<tr>
<td></td>
<td>• Email</td>
</tr>
<tr>
<td></td>
<td>• Self-service web portals</td>
</tr>
<tr>
<td></td>
<td>◦ Customer Service Portal (B2B)</td>
</tr>
<tr>
<td></td>
<td>◦ Consumer Service Portal (B2C)</td>
</tr>
<tr>
<td>How do you capture and share knowledge with your customers?</td>
<td>With Customer Service Management, you can use:</td>
</tr>
<tr>
<td></td>
<td>• Knowledge bases</td>
</tr>
<tr>
<td></td>
<td>• Knowledge search</td>
</tr>
</tbody>
</table>

**Activate Customer Service Management**

You can activate the Customer Service plugin (com.sn_customerservice) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.
**Before you begin**
Role required: admin

**About this task**
The Customer Service Management plugin activates these related plugins if they are not already active.

## Plugins automatically activated with Customer Service Management

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assessment [com.snc.assessment_core]</td>
<td>Enables you to evaluate, score, and rank items, and provide normalized or weighted results from any table in the system.</td>
</tr>
<tr>
<td>Asset Management [com.snc.asset_management]</td>
<td>Manage your assets, consumables, and software licenses.</td>
</tr>
<tr>
<td>Assignment Workbench [com.snc.assignment_workbench]</td>
<td>Customer service managers can use the workbench to evaluate agents based on configurable criteria, such as skills and availability, and then assign tasks to the desired agents.</td>
</tr>
<tr>
<td>Connect Support [com.glide.connect.support]</td>
<td>Builds on the Connect messaging platform and enables chat in a support queue. Agents can use chat to provide assistance to end users.</td>
</tr>
<tr>
<td>Connect Support Routing [com.glide.connect.support.routing]</td>
<td>Enables the routing of Connect Support requests to the appropriate chat queue.</td>
</tr>
<tr>
<td>Consumer Service Portal [com.glide.service-portal.consumer-portal]</td>
<td>This plugin enables the Consumer Service Portal, a web-based portal based on the Service Portal application that you can use to provide information and support to consumers. The Consumer Service Portal plugin activates these related plugins if they are not already active.</td>
</tr>
<tr>
<td>CSM Workspace [com.snc.agent_workspace.csm]</td>
<td>Enables Agent Workspace for Customer Service Management, a configurable service</td>
</tr>
<tr>
<td>Plugin</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Customer Service Portal</td>
<td>This plugin enables the Customer Service Portal, a version of the web portal based on the Service Portal application.</td>
</tr>
<tr>
<td>[com.glide.service-portal.customer-portal]</td>
<td></td>
</tr>
<tr>
<td>Customer Service Social Integration</td>
<td>Adds the necessary data schema changes for social integration scenarios.</td>
</tr>
<tr>
<td>[com.sn_cs_social]</td>
<td></td>
</tr>
<tr>
<td>Customer Service Spoke</td>
<td>Provides actions for flow designers to use when creating Customer Service Management business processes.</td>
</tr>
<tr>
<td>[com.snc.customer_service.spoke]</td>
<td></td>
</tr>
<tr>
<td>Explicit Roles</td>
<td>Adds the snc_external and snc_internal roles. For more information, see <a href="#">Explicit roles in CSM</a>.</td>
</tr>
<tr>
<td>[com.glide.explicit_roles]</td>
<td></td>
</tr>
<tr>
<td>Glide Conversation Server</td>
<td>Enables the Virtual Agent web clients, Connect Support, conversation branding settings, and Live Agent conversation settings.</td>
</tr>
<tr>
<td>[com.glide.cs]</td>
<td></td>
</tr>
<tr>
<td>Openframe</td>
<td>An interface used to integrate external communication systems with the Now Platform. This plugin provides a UI frame that is accessible and available anywhere within ServiceNow application screens.</td>
</tr>
<tr>
<td>[com.sn_openframe]</td>
<td></td>
</tr>
<tr>
<td>Process Flow Formatter</td>
<td>Provides a graphical summary of the stages in a process. The formatter is typically shown at the top of forms that are part of a process.</td>
</tr>
<tr>
<td>[com.snc.process_flow_formatter]</td>
<td></td>
</tr>
<tr>
<td>Resource Matching Engine</td>
<td>Provides a tool for rule-based, task-to-resource matching.</td>
</tr>
<tr>
<td>[com.snc.matching_rule]</td>
<td></td>
</tr>
<tr>
<td>Skills Management</td>
<td>Implements user and user group skills; based on the same principle as roles management.</td>
</tr>
<tr>
<td>[com.snc.skills_management]</td>
<td></td>
</tr>
</tbody>
</table>
Plugins automatically activated with Customer Service Management (continued)

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
</table>
| Special Handling Notes         | Activates the Special Handling Notes application, which enables users to quickly view brief messages about records. These notes can be displayed in an embedded list or related list on a record form or in a pop-up window. This plugin is installed with the Customer Service Management and Field Service Management applications. To use special handling notes with other tables:  
  • Configure the table and any related fields to use special handling notes.  
  • Configure the form to show special handling notes. |
| State Flows                    | Customize transitions from one state to another in tables derived from the Task [task] table and configure the system to perform work during transitions to specific states. |
| Subscriptions and Activity Feed Framework | Provides a generic set of artifacts to handle subscriptions for any defined subscribable object.  
  Any entity can be defined as a subscribable object and a set of subscribers can subscribe to the objects. When an event occurs related to the subscribable object, activities can be tracked and subscribers can be notified. |
| Task Activities                | Enables support for activities on task tables.                                                                                           |
| Virtual Agent Service Portal Widgets | Activates the Service Portal as a Virtual Agent web client.                                                                                |
Procedure

1. Navigate to **System Applications > All Available Applications > All.**

2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.

3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: *Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.*

What to do next

You can activate several related plugins after activating the Customer Service Management plugin (com.sn_customerservice). For details, see Additional plugins for Customer Service Management.

**Additional plugins for Customer Service Management**

After Customer Service Management is activated, you can activate additional plugins that provide demo data and enable various features.

You must have the admin role to activate these additional plugins. For details, see Activate a plugin.

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent Schedule [com.snc.agent_schedule]</td>
<td>Enables customer service agents and field service technicians to see work schedules and assignments and also add personal events such as meetings or appointments.</td>
</tr>
<tr>
<td>Anonymous Connect Support [com.glide.connect_anonymous_support]</td>
<td>Enables consumers to chat with consumer service agents from the Consumer Service Portal without logging in.</td>
</tr>
<tr>
<td>Case Assignment Workbench Demo [com.snc.case_assignment_workbench_demo]</td>
<td>Provides demo data, such as sample cases and users, so that the Assignment Workbench product features can be demonstrated on a non-production instance.</td>
</tr>
<tr>
<td>Plugin</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Case Digests</td>
<td>Enables users to send case status updates and root cause analysis to customers and key internal stakeholders.</td>
</tr>
<tr>
<td>[com.sn_csm_case_digest]</td>
<td></td>
</tr>
<tr>
<td>CSM Extension for Proxy Contacts</td>
<td>Enables users who are internal to an organization to be the proxy case contact on behalf of customers.</td>
</tr>
<tr>
<td>[com.snc.csm_proxy_contacts]</td>
<td></td>
</tr>
<tr>
<td>CTI Softphone</td>
<td>This plugin is a demo application that enables Twilio integration using the Notify application and OpenFrame to provide soft phone functions and call center capabilities. The application includes the capabilities to make, receive, transfer, hold, and mute calls. The Customer Service Management and Incident Management applications provide Computer Telephony Integration (CTI) demo workflows. Activate the respective applications to run the workflows. The CTI Softphone plugin activates these related plugins if they are not already active:</td>
</tr>
<tr>
<td>[com.snc.cti]</td>
<td></td>
</tr>
<tr>
<td>Customer Central</td>
<td>Enables customer service agents to access all customer information and activity in a single, centralized view on Agent Workspace.</td>
</tr>
<tr>
<td>[com.sn_csm_customer_central]</td>
<td></td>
</tr>
<tr>
<td>Plugin</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Customer Communities [com.sn_customer_communities]</td>
<td>Enables users to connect, engage, and collaborate with employees, customers, partners, and prospects. Available to customers who are licensed for Customer Service Management.</td>
</tr>
<tr>
<td>Customer Service Case Action Status [com.snc.csm_action_status]</td>
<td>Provides a Customer Service-specific application of the Action Status Automation feature. Use this plugin to display and track blocking tasks for customer service cases.</td>
</tr>
<tr>
<td>Customer Service CTI Demo Data [com.snc.customerservice_cti_demo]</td>
<td>Provides demo data for the CTI Softphone application.</td>
</tr>
<tr>
<td>Customer Service Document Template [com.sn_csm_doc_template]</td>
<td>Enables you to configure the fields from a table record that are included in an output document.</td>
</tr>
<tr>
<td>Customer Service Install Base Management [com.snc.install_base]</td>
<td>Enables customers to capture the current state of a customer's install base and establish the relationship to any downstream entities that might impact their functioning.</td>
</tr>
<tr>
<td>Customer Service Management for Orders [com.snc.csm.order]</td>
<td>Extends Customer Service Management to support order-related issues by integrating with order management systems to create and resolve customer requests.</td>
</tr>
<tr>
<td>Customer Service Virtual Agent Conversations [com.sn_csm.virtualagent]</td>
<td>Provides predefined Customer Service Virtual Agent topics (chatbot conversations) designed to help your customers complete common self-service tasks.</td>
</tr>
<tr>
<td>Plugin</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Customers and consumers can view case-related work orders from the Customer Service and Consumer Service Portals. In the Field Service Management application, users can view account and contact information on work orders and work order tasks.</td>
<td></td>
</tr>
<tr>
<td>Customer Service with Service Portfolio Management [sn_csm_spm]</td>
<td>Provides an integration between the Customer Service Management and the Service Portfolio Management (SPM) application. This integration gives customer service managers, customer service agents, and service owners visibility into sold products and their service offerings.</td>
</tr>
<tr>
<td>Incident Assignment Workbench Demo (com.snc.incident_assignment_workbench_demo)</td>
<td>Intelligent agent recommendation through dynamic matching rules/criteria.</td>
</tr>
<tr>
<td>Guided Decisions [com.snc.guided_decisions]</td>
<td>Enables the framework and execution engine for creating guided decisions.</td>
</tr>
<tr>
<td>Guided Decisions - Guidance [com.snc.guided_decisions_guidance]</td>
<td>Enables the framework for creating a guidance for guided decisions.</td>
</tr>
<tr>
<td>Guided Decisions for Playbook in Workspace [com.snc.guided_decisions_playbook_experience]</td>
<td>Enables activity types, definitions, and UI components for the display of guided decisions in a playbook on Workspace.</td>
</tr>
<tr>
<td>Knowledge Product Entitlements</td>
<td>This plugin enables customer service administrators to restrict customer access to</td>
</tr>
<tr>
<td>Plugin</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>[com.snc.kb_product_entitlements]</td>
<td>Designated knowledge bases and knowledge articles on the customer self-service portal. This plugin adds the Knowledge Product Entitlements menu to the application navigator.</td>
</tr>
<tr>
<td><strong>Major Issue Management</strong> [com.sn_majorissue_mgt]</td>
<td>A set of capabilities used to manage customer-facing communications and resolution processes for common issues.</td>
</tr>
<tr>
<td><strong>Outsourced Customer Service</strong> [com.snc.outsourced_service_provider]</td>
<td>The Outsourced Customer Service plugin adds the Outsourced Customer Service module to the application navigator. Users with the administrator role can access this module.</td>
</tr>
<tr>
<td><strong>Performance Analytics - Context Sensitive Analytics for Customer Service</strong> [com.snc.pa.cs.context_sensitive_analytics]</td>
<td>This plugin you to open context-sensitive dashboards in customer service forms based on UI actions.</td>
</tr>
<tr>
<td>Plugin</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Note:</strong> You can activate Performance Analytics solutions on instances that do not have Performance Analytics to evaluate the functionality. However, to collect scores for indicators you must license Performance Analytics.</td>
<td></td>
</tr>
<tr>
<td>Performance Analytics Premium for Customer Service [com.snc.pa.premium.cs]</td>
<td>Installing this plugin removes the limitations of the out of box Performance Analytics.</td>
</tr>
</tbody>
</table>
| Predictive Intelligence for Customer Service Management [com.snc.csm_ml] | Enables customers to leverage machine learning algorithms for searching related cases in Customer Service Management. Activation of this plugin on production instances may require a separate license. Contact ServiceNow for details. The Predictive Intelligence for Customer Service Management plugin activates these related plugins if they are not already active:  
  - Customer Service plugin (com.sn_customerservice)  
  - Predictive Intelligence for Contextual Search plugin (com.snc.contextual_search_ml)  
  - Email Notification Script for Contextual Search Results plugin (com.snc.adv_cxs_results_email_script) |
<p>| Proactive Customer Service Operations [com.snc.proactive_cs_ops] | Enables customers to create cases proactively from alerts either manually or through automation and track the accounts and the corresponding install base items affected by the alert. |
| Process Optimization Content Pack for CSM [com.snc.csm_process_optimization] | Provides pre-configured process optimization models and improvement initiatives for the CSM Processes. |
| Self-Service Analytics for Customer Service [com.snc.pa.self_service_analytics_csm] | Tracks case reduction (deflection) metrics and self-service KPIs using performance analytics dashboards. Activation of this plugin on production instances may require a separate |</p>
<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plugin</td>
<td>Description</td>
</tr>
<tr>
<td>Self Service Password Reset</td>
<td>This plugin allows locally authenticated users to request a temporary password if they forget their current one. Customer contacts can request a new password from the customer self-service portal. The Self Service Password Reset plugin activates the Password Reset plugin (com.glideapp.password_reset) if it is not already active.</td>
</tr>
<tr>
<td>Special Handling Notes Demo Data</td>
<td>Provides demo data for the Special Handling Notes application.</td>
</tr>
<tr>
<td>Targeted Communications Demo Data</td>
<td>Provides a tool for publishing and distributing content and articles to both internal and external customers.</td>
</tr>
</tbody>
</table>
Customer Service properties
Use system properties to customize the Customer Service Management application.

These properties control settings for several different features, including email communication, asset contact relationships, and the Consumer Service Portal. To access these properties, navigate to Customer Service > Administration > Properties.

Related reference
Properties installed with Customer Service Management
Components installed with additional plugins for Customer Service Management

Related information
Using Auto-Responder for case deflections

Configure foundation data
With Customer Service Management, you can import or create customer information including names, addresses, and phone numbers; account details; products and assets; and service contracts. You can also assign roles to users and create customer relationships.

Before you begin
Role required: admin

About this task
Foundation data includes all of the data that you need to configure in order to support your customers. This includes information about:

• Customers (external users)
• Customer relationships
• Users (internal users such as agents and employees)
• Customer and user roles
• Products and assets
• Service contracts and entitlements

You can import and configure most of this foundation data using the Customer Service Management guided setup. This feature takes you through the entire setup and configuration process.

To create new data, such as adding new accounts and contacts, you can use the Customer Service Management application.
Procedure

1. Navigate to Customer Service > Administration > Guided Setup.

2. On the Getting Started page of the guided setup, click Get Started.

   The guided setup reopens with a page of different categories of Customer Service Management features that you can configure.

3. In the Foundation Data category, click Get Started.

   The Foundation Data page opens with a list of tasks to configure the different types of customer information.

4. To perform a task, click Configure.

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Accounts</td>
<td>In the business-to-business (B2B) model, an account is a supported external customer. Import and verify existing account data.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> After importing customer account data, you must also set the account code system property.</td>
</tr>
<tr>
<td>Import Contacts (B2B)</td>
<td>A contact is a user who is an employee of an account. Import and verify existing contact data.</td>
</tr>
<tr>
<td>Import Consumers (B2C)</td>
<td>A consumer is a customer in the business-to-consumer (B2C) business model. Import and verify existing consumer data.</td>
</tr>
<tr>
<td>Import Users</td>
<td>A user is an individual who can access your instance. Import and verify existing user data.</td>
</tr>
<tr>
<td>Import Groups</td>
<td>A group is a set of users who share a common purpose. Import and verify existing group data.</td>
</tr>
<tr>
<td>Import Group Members</td>
<td>The users associated with a group are listed as group members. Import and verify existing group member data.</td>
</tr>
<tr>
<td>Task</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Assign Roles                              | Roles control access to features and capabilities. The Customer Service Management application provides two types of roles:  
• Internal roles for agents and managers  
• External roles for customers, customer partners, and consumers  
Assign the necessary roles to internal and external users. |
| Create Customer Relationships             | Create relationships between partners, contacts, and customers to make account and asset management easy and flexible. You can create the following types of relationships:  
• Bi-directional account relationships  
• Account hierarchy  
• Contact relationships                                                                                                        |
<p>| Import Product Models                     | A product is a type of good or service that your company sells and supports. Product models identify different types of products, such as service, hardware, software, or consumables. |
| Import Sold Products                      | Sold products are products and components that have been sold to an account or a consumer. Importing sold products provides an overview of the complete product sold to an account or consumer.                        |
| Create product model and catalog items relationships | Enable self-service for customers to request services on products by creating relationships between product models and catalog items.                                                                                   |
| Import Install Base Items                 | Install base items represent the instances that have been configured                                                                                                                                       |</p>
<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Installed Products</td>
<td>Installed products create an association between sold products and install base items. Installed products also provide information on the sold products and how they are deployed or installed.</td>
</tr>
<tr>
<td>Import Assets</td>
<td>An asset is a specific product or instance that is supported for a customer. There are different types of assets and information for each type of asset is stored in a different table.</td>
</tr>
<tr>
<td>Create Asset Contact Relationships</td>
<td>Assign assets to the customer contacts who are responsible for managing those assets. If desired, enable a property that limits access to asset information to just the assigned contacts.</td>
</tr>
<tr>
<td>Create Service Contracts</td>
<td>A service contract contains information about the type of support that is provided to a customer and can include coverage for specific assets. It can also include multiple service entitlements and SLAs.</td>
</tr>
<tr>
<td>Create Entitlements</td>
<td>An entitlement defines the type of support that a customer receives as well as the supported communication channels. Entitlements are counted and tracked using two types of units: cases and hours.</td>
</tr>
<tr>
<td>Create Account Teams</td>
<td>Account teams are made up of employees who fulfill specific jobs or roles for a particular account. Create these roles, or responsibility definitions, and then assign them to employees and contacts.</td>
</tr>
</tbody>
</table>
Configure accounts and contacts

An account is a supported external customer and a contact is a user who is an employee of an account.

Before you begin
Role required: admin

About this task
There are two types of accounts: customer accounts and partner accounts. The Customer and Partner fields on the Account form denote the account type. An account can be a customer account, a partner account, or both.

A partner is a supported external customer that sells to and supports other customers. A partner can report and manage cases on behalf of customers. A partner can also be a customer.

Note: After importing customer account data, you must also set the account code system property.

An account can have multiple contacts but a contact can be associated with only one account. A contact can have one or more associated assets and service contracts. A contact can also have a user ID and can log in to the customer portal.

Note: A contact is a user in the system. If you create a contact, that person is also added to the User table (sys_user).

Procedure

• You can import existing accounts and contacts using guided setup.
• You can create new accounts and contacts using the Customer Service Management application.

Import accounts and contacts with guided setup

Use Customer Service Management guided setup to import existing accounts and contacts.

Before you begin
Role required: admin

About this task
After importing customer account data, you must also set the account code system property.
Procedure

1. Navigate to Customer Service > Administration > Guided Setup and click Get Started.
2. In the Foundation Data category, click Get Started.
3. Click one of the following:
   • Import Accounts
   • Import Contacts
4. Upload data from an external data source into an import set.
5. Create a transform map.
6. Execute the transform map to transfer the data.
7. Verify that the data records are imported into the target table.

Set the account code property

After importing customer account information, update the com.snc.cs_base.last.generated.code.tree.path property with the correct account code value.

Before you begin

Role required: admin

About this task

The com.snc.cs_base.last.generated.code.tree.path system property stores the Account Code value for the most recently created customer account in the Account (customer_account) table.

When you create a new customer account record, the system uses this property to determine a unique account code value for the account. The property is then updated with this latest assigned value so that the next account code value can be set as a unique value for the next account record insert.

The value of the com.snc.cs_base.last.generated.code.tree.path property must match the value of the Account Code field for the last inserted customer account record. When you create customer account records by importing data from other sources or instances, these values can get out of sync. If these values do not match, the system generates an error upon creation of the next new record in the Account table:

java.sql.BatchUpdateException: Duplicate entry for key account_path

Use the steps below to fix this error.
Create customer accounts

An account is a supported external customer. Use the Customer Service Management application to create account records.

Before you begin
Role required: sn_customerservice_manager or admin

About this task
There are two types of accounts: customer accounts and partner accounts. The Customer and Partner fields on the Account form denote the account type. An account can be a customer account, a partner account, or both.

A partner is a supported external customer that sells to and supports other customers. A partner can report and manage cases on behalf of customers. A partner can also be a customer.

Procedure

1. Navigate to Customer Service > Customer and click one of the following actions:
   - To create a customer account, click Accounts.
   - To create a partner account, click Partners.
2. Click New and fill in the fields on the Account form.
3. Click Submit.

Create additional account addresses

An account can have multiple addresses, such as a main address as well as shipping and billing addresses.

Before you begin
Role required: sn_customerservice_manager or admin

About this task
The main address for an account is stored in fields on the Account form. Shipping and billing addresses for an account are created and stored in the
Addresses related list. An account can have multiple shipping and billing addresses.

Procedure
2. Click the number of the desired account.
3. In the Addresses related list, click New.
4. Fill in the fields on the Location form.
5. Select an address type, either Billing or Shipping.
6. Optional: Enable the Primary field.
   If you have multiple billing or shipping addresses, use this field to designate one as the primary address.
7. Click Submit.

Create customer contacts
A contact is a user who is an employee of an account. Use the Customer Service Management application to create contact records.

Before you begin
Role required: sn_customerservice_manager or admin

About this task
An account can have multiple contacts but a contact can be associated with only one account. A contact can have one or more associated assets and service contracts. A contact can also have a user ID and can log in to the customer portal.

Note: A contact is a user in the system. If you create a contact, that person is also added to the User table (sys_user).

Procedure
2. Click New and fill in the fields on the Contact form.
3. Enter the contact information, such as the name, email address, and phone number.
4. Enter the name of the contact’s company in the Account field.
5. Select the Timezone.
7. Select a **Notification** setting.

8. Click **Submit**.

After a registration request is approved, the customer contact receives an email with a user ID and temporary password. When logging in for the first time, the contact is asked to change the password.

**Configure consumers**

A consumer is a customer in the business-to-consumer (B2C) business model.

**Before you begin**

Role required: admin

**About this task**

Consumers can have multiple addresses, one of which is the primary address.

**Procedure**

- You can import existing consumers using guided setup.
- You can create new consumers using the Customer Service Management application.

**Import consumers with guided setup**

Use Customer Service Management guided setup to import existing consumers.

**Before you begin**

Role required: admin

**About this task**

Consumers can have multiple addresses, one of which is the primary address.

**Procedure**

1. Navigate to **Customer Service > Administration > Guided Setup** and click **Get Started**

2. In the Foundation Data category, click **Get Started** and then click **Import Consumers (B2C)**.

3. Upload data from an external data source into an import set.

4. Create a transform map.

5. Execute the transform map to transfer the data.

6. Verify that the data records are imported into the target table.
Create consumers

A consumer is a customer in the business-to-consumer (B2C) business model. Use the Customer Service Management application to create consumer records.

Before you begin
Role required: sn_customerservice.consumer_agent, sn_customerservice_manager, or admin

About this task
Consumers can have multiple addresses, one of which is the primary address.

Procedure
2. Click New and fill in the fields on the Consumer form.
3. Enter the consumer information, such as the name, email address, and phone numbers.
4. Fill in the fields on the Primary Address tab.
   A consumer can have multiple addresses but only one primary address. The primary address is stored in the Primary Address tab on the Consumer form and in the Addresses related list.
5. Optional: Set the desired fields on the Preferences tab.
6. Click Submit.
   The record is added to the Consumers table (csm_consumer). The primary address is added to the Addresses related list and the Primary field is set to true.

Create additional consumer addresses

Consumers can have multiple addresses, including one primary address.

Before you begin
Role required: sn_customerservice.consumer_agent, sn_customerservice_manager, or admin

About this task
The primary address is stored in the Primary Address tab on the Consumer form and in the Addresses related list. When you fill in the fields in the Primary Address tab and click Submit, this information is added to the Addresses related list as the primary address, with the Primary field set to true. Any changes made to the Primary Address fields are also updated in the related list. A consumer can have only one primary address.
Other addresses, such as billing or shipping addresses, can be created and stored in the **Addresses** related list. For these other addresses, the **Primary** field is set to **false**.

**Procedure**

1. Navigate to **Customer Service > Customer > Consumers**.
2. Click the number of the desired consumer.
3. In the **Addresses** related list, click **New**.
4. Fill in the fields on the **Location** form.
5. To denote this address as the primary address for the consumer, enable the **Primary** check box.
   A consumer can have multiple addresses but only one primary address.
6. Click **Submit**.

**Configure users and groups**

A user is an individual who can access your instance and a group is a set of users who share a common purpose. The users associated with a group are listed as group members.

**Before you begin**

Role required: admin

**About this task**

Group information is used across most processes in the Now Platform for assigning work to teams and requesting approvals.

Any rule that is applied to a group is automatically assigned to group members; for example, roles and assignment rules.

**Procedure**

- You can import existing users and groups using guided setup.
- You can create new users and groups using the Now Platform user administration feature.
  - Create a user
  - Create a user group
  - Add a user to a group
Assign roles to CSM users

Roles control access to features, capabilities, and data in the Customer Service Management application.

Before you begin
Role required: admin
Before you can assign roles to your users, make sure that these users have already been configured.
• Configure users and groups
• Configure accounts and contacts
• Configure consumers

About this task
You can assign roles to individual users or groups. Apply roles to groups and the members of those groups inherit those roles.

The Customer Service Management application provides two types of roles: internal roles for agents and managers and external roles for customers, customer partners, and consumers.

<table>
<thead>
<tr>
<th>Internal Roles</th>
<th>External Roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>• sn_customerservice_agent</td>
<td>• sn_customerservice.customer</td>
</tr>
<tr>
<td>• sn_customerservice_manager</td>
<td>• sn_customerservice.customer_admin</td>
</tr>
<tr>
<td><strong>Business-to-consumer (B2C)</strong></td>
<td><strong>Business-to-business (B2B) Partner</strong></td>
</tr>
<tr>
<td>• sn_customerservice.consumer_agent</td>
<td>• sn_customerservice.partner</td>
</tr>
<tr>
<td>• sn_customerservice_manager</td>
<td>• sn_customerservice.partner_admin</td>
</tr>
<tr>
<td><strong>Business-to-consumer (B2C)</strong></td>
<td><strong>Business-to-consumer (B2C)</strong></td>
</tr>
<tr>
<td>• sn_customerservice.consumer</td>
<td>• sn_customerservice.consumer</td>
</tr>
</tbody>
</table>

Procedure
• You can assign roles to users and groups using guided setup.
• You can also assign roles to users and groups using the Now Platform user administration feature.
- Assign a role to a user
- Assign a role to a group

**Related reference**

Roles installed with Customer Service Management

**Create customer relationships**

The Customer Service Management application provides the ability to establish different types of relationships between partners, customers, and contacts. These relationships make account and asset management easy and flexible. The table below describes the available customer relationships.

<table>
<thead>
<tr>
<th>Relationship</th>
<th>Description</th>
<th>Benefit</th>
</tr>
</thead>
</table>
| Bi-directional account relationship | Create a relationship between:  
• A partner account and a customer account.  
• Two customer accounts. | A bi-directional account relationship is created using a defined account relationship type. An account relationship allows partner account contacts with the partner role or the partner administrator role to create and manage cases for their partner account. |
| Account hierarchy           | Create a parent-child relationship between accounts.                                            | An account hierarchy allows an account contact with the customer administrator role to manage the child accounts.                      |
| Contact relationship        | Add a contact from a third account to either of the accounts in an account relationship.        | A contact relationship allows a contact with the customer role or customer administrator role to manage the account.                    |
Bi-directional account relationships

A bi-directional account relationship is a relationship that exists between two accounts. You can create account relationships between two customer accounts or between a partner account and a customer account.

A bi-directional account relationship is based on a defined account relationship type. Creating a bi-directional account relationship is a two-step process that involves:

- Defining the types of relationships that exist between your partners and customers.
- Using these relationship types to create relationship records between selected accounts.

You can view relationship records on the Account form for either account in the relationship. These records are stored in the Account Relationships related list.

For relationships between a partner account and a customer account, partner account contacts with the partner role or the partner administrator role can create and manage cases for their customer accounts.

Account relationship types

An account relationship type defines a relationship that can exist between accounts. Users with the system administrator role can define the following account relationship types:

- Account to account
- Partner to account

When creating an account relationship type, you define the following information on the Account Relationship Type form:

- The type of source account (account or partner).
- The type of target account (account or partner).
- The relationship between the source account and the target account.
- The reverse relationship between the source account and the target account.
Note: One default account relationship type is provided for partner accounts.

Account relationship records
Once an account relationship type has been defined, users with the customer service manager role can use it to create relationship between specific accounts or partners. An account relationship record includes the following information:

- A source account, selected in the Account From field.
- A target account, selected in the Account To field.
- The account relationship type that this relationship record is based on.
- The relationship and the reverse relationship of the selected accounts.

View a relationship record from either account:
- The relationship (Account From > Account To) appears in the Account Relationships related list on the source account record.
- The reverse relationship (Account To > Account From) appears in the Account Relationships related list on the target account record.

Select the account relationship record from either account to see the Account Relationship form.
You can also view account relationship records that use a specific account relationship type. This information appears as a related list on the Account Relationship Type form. This list shows the source account (Account From field) and the target account (Account To field) for each account relationship record.

Create an account relationship type
Create an account relationship type by defining the types of source and target accounts and providing a name for the relationship between these accounts.

Before you begin
Role required: admin

About this task
Use the steps below to create an account relationship type.

You can edit an existing account relationship type by changing the types of source and target accounts and the name of the relationship that exists between these accounts. If that account relationship type is currently being used by any account relationship records, the Relationship and Reverse relationship fields in those records are automatically updated.

You can also delete an existing account relationship type.
• If there are no account relationship records that use the account relationship type, then it is simply deleted.

• If there are active account relationship records that use the account relationship type, an attempt to delete that relationship type results in a warning message. Deleting an account relationship type also deletes the relationship records based on that type.

Account relationship types can be set to inactive at any time.

Procedure
1. Navigate to Customer Service > Administration > Account Relationship Types.
2. Click New.
3. Fill in the fields on the Account Relationship Type form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relationship type</td>
<td>A unique name that identifies the type of relationship. For example, Service Provider.</td>
</tr>
<tr>
<td>From</td>
<td>The type of source account for this relationship type; can be either an account or a partner.</td>
</tr>
<tr>
<td>Relationship relationship</td>
<td>A text field where you can name the relationship from the source account to the target account. For example, Service provider for.</td>
</tr>
<tr>
<td>To</td>
<td>The type of target account for this relationship type; can be either an account or a partner.</td>
</tr>
<tr>
<td>Reverse relationship</td>
<td>A text field where you can name the reverse relationship from the target account to the source account. For example, Customer of.</td>
</tr>
<tr>
<td>Active</td>
<td>Sets the account relationship type as active or inactive. Active account relationship types can be used to create account relationship records. An account relationship type can be set to inactive at any time.</td>
</tr>
</tbody>
</table>

4. Click Submit.
   The new account relationship type appears on the Account Relationship Types list.
Create an account relationship record

Create an account relationship record by selecting the account relationship type and then selecting the accounts involved in the relationship.

Before you begin
Role required: sn_customerservice_manager or admin

About this task
The system administrator can create a relationship record for an account from the Account Relationships related list on the Account Relationship Type form.

The customer service manager and the system administrator can create a relationship record for an account from the Account Relationships related list on the account or partner record.

Deleting a relationship record for an account also deletes the reverse relationship record.

Note: Deleting a relationship record does not have any impact on customer service cases that refer to the relationship record.

Procedure
1. Navigate to Customer Service > Customer > Accounts or Partners.
2. Select an account.
3. From the Account Relationships related list, click New.
4. Fill in the fields on the Account Relationship form.

Account Relationship form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account From</td>
<td>The source account for this relationship. If you are creating the relationship from an account or partner record, this field is automatically filled in; otherwise, make a selection from the Accounts list.</td>
</tr>
<tr>
<td>Relationship Type</td>
<td>Select the account relationship type for this record. If you are creating the record from an Account Relationship Type form, this field is automatically filled in. Otherwise, make a selection from the Account Relationship Types list, which shows all active account relationship types.</td>
</tr>
<tr>
<td>Account To</td>
<td>The target account for this relationship.</td>
</tr>
</tbody>
</table>
5. Click Submit.
   Once a relationship record has been created, it appears in two places:
   • The relationship appears in the Account Relationships related list on the source account record.
   • The reverse relationship appears in the Account Relationships related list on the target account record.

Account hierarchy
Use the account hierarchy feature to create a parent-child relationship between accounts.

An account hierarchy represents the legal entity structure of the accounts and their relationships. It also represents an account’s customers, assets, and service entitlements.

Customer administrators can do the following for all of the accounts in the hierarchy:
• View and create cases.
• View assets and users.
• View and manage contacts.

Contacts of the parent account can also access all of the child accounts.

The system administrator defines the hierarchy between accounts on the Account form. From the Account form for the child account, select the parent in the Parent Account field. If this field is not filled in, the account is a top-level account.

After the account hierarchy has been defined, it is displayed on the Account form for the parent account. If a parent account is updated or deleted, the hierarchy for any child accounts is also updated.

View the account hierarchy
The account hierarchy uses a tree structure to show the parent, child, and sibling accounts. Two different views of the account hierarchy are available. In both views, the current account is highlighted in the account structure.
• The parent view displays the current account, the parent account (if applicable), and any child or sibling accounts.
• The full view displays the entire structure of the organization from the root account.

Customer service agents can:
• Expand and collapse the tree structure.
• Switch between the parent view and the full view.
• Click an account to open the related Account form.

**Account hierarchy in CSM Agent Workspace**

From the Account form, customer service agents can click the open hierarchy icon ( glyphicon glyphicon-tree leaf ) in the *Name* field to see the parent-child account relationships in the Account Hierarchy pop-up window. The account hierarchy is available for accounts that have a parent or child account.

**Account Hierarchy**

Parent View

- Boxeo
  - Boxeo EMEA (Current Account)
    - Boxeo Canada
    - Boxeo USA

**Account hierarchy in the platform interface**

Customer service agents can view account information in the Account Hierarchy section on the Account form.
Create an account hierarchy
Create a parent-child relationship between two accounts.

Before you begin
Role required: admin

Procedure
2. Select the desired child account.
3. Select the parent for this account in the Parent Account field.
4. Click Update.
   The account hierarchy is displayed in a tree map on the Account form for the parent account.

Contact relationships
Use a contact relationship to add a contact from a different account to either of the accounts in an established account relationship.

A contact relationship allows a contact with the customer role or customer administrator role to manage the account for which the contact relationship has been established. These contacts can view information and perform actions on behalf of the accounts, such as creating or updating cases from the customer portal.

When you create a contact relationship, you select a user from the Contact field. This field displays the contacts from:
- Both accounts in the account relationship
- All accounts in the account hierarchy

Then you select a responsibility for the contact. The responsibilities available for selection are those responsibility definitions created with a type of Contact.

⚠️ Note: A contact can only be assigned one responsibility per account.

The contact name, account, and responsibility appear in the Contact Relationships related list on the Account form.

Customer service managers can create and delete contact relationships for accounts. Managers and agents can view a list of contact relationships for an account.
Create a contact relationship for an account

Create a contact relationship for an account by selecting a contact and then assigning a responsibility to that contact.

Before you begin
Role required: sn_customerservice_manager or admin

About this task
A contact can only be assigned one responsibility per account.

Procedure
1. Navigate to Customer Service > Customer > Accounts or Partners.
2. Select an account.
3. In the Contact Relationships related list, click New.
4. Fill in the fields on the Contact Relationship form.
5. Click Submit.
   The contact name, account, and responsibility are added to the Contact Relationships related list.

Configure products

Configure product data including product models, sold products, install base items and installed products.

Before you begin
Role required: admin

About this task

• **Product models**: A product is a type of good or service that your company sells and supports. Product models identify different types of products, such as service, hardware, software, or consumables.

  **Note**: Product models require the Model Management plugin (com.snc.model).

• **Sold products**: The products and components that have been sold to an account or a consumer.

• **Install base items**: Items that represent the instances that have been installed or provisioned for a customer.

• **Installed products**: Provide information on the sold products and how they are deployed or installed. Use installed products to create an association between sold products and install base items.
Procedure

• You can import the following product data using guided setup.
  ◦ Import product models with guided setup
  ◦ Import sold products with guided setup
  ◦ Import install base items with guided setup
  ◦ Import installed products with guided setup

• You can create new product data using the Customer Service Management application.
  ◦ Create a product model
  ◦ Create sold products
  ◦ Create install base items
  ◦ Create installed products

• You can configure the following relationships and associations after importing or creating product data:
  ◦ Product models
    ■ Associate service offerings to product models
    ■ Configure product model and catalog item relationships
  ◦ Sold products
    ■ Associate service offerings with sold products
    ■ Associate sold products with contracts

Import product models with guided setup

A product is a type of good or service that your company sells and supports. Product models identify different types of products, such as service, hardware, software, or consumables.

Before you begin
Role required: admin

About this task
Information for each type of product model is stored in a different table. For example, service product models are stored in the Service Model [cmdb_service_product_model] table.

Note: Product models require the Model Management plugin (com.snc.model).
Procedure

1. Navigate to Customer Service > Administration > Guided Setup and click Get Started.

2. In the Foundation Data category, click Get Started and then click Import Product Models.

3. Upload data from an external data source into an import set.

4. Create a transform map.

5. Execute the transform map to transfer the data.

6. Verify that the data records are imported into the target table.

Create a product model

Create a record for a type of product that your company sells and supports.

Before you begin

Ensure that the Model Management plugin (com.snc.model) is installed.
Role required: model_manager

About this task

A product model is a specific version or configuration of a product. Build hierarchical product models that represent the set of products that your organization offers to its customers and define relationships between different product models. Define whether a product is tracked as an asset, a CI or both as well as identifying or creating the CI and asset class that captures the configuration information for product models.

Product models provide customer service agents and customers with a common understanding of the products being used by a particular customer. Customers can view the products purchased on the Customer Service Portal and can open cases for any issues they are facing.

Procedure


2. Click New.

3. Select the type of product model to create:

   • Application Model
   • Consumable Model
   • Contract Model
   • Facility
• Hardware
• Service
• Software

4. Fill in the fields for the selected product model, as appropriate. See Model form fields for field descriptions.

5. Click Submit.

Note: In the Sold Product related list, you can see all the accounts and consumers that the product model has been sold to.

Related information
Create a service model

Associate service offerings to product models
Associate service offerings to product models to enable customers to choose service offerings for products.

Before you begin
Role required: sn_customerservice_manager or admin

About this task
One service model can have multiple service offerings.

Procedure
2. Click a product model.
3. On the Service Offering related list, click New or Edit to add an existing service offering to the product model.

Related information
Create a service offering

Configure product model and catalog item relationships
Enable self-service for customers to request services on products by creating relationships between product models and catalog items.

Before you begin
Role required: sn_customerservice_manager or admin
**About this task**
Create relationships between product models and catalog items. You can associate multiple catalog items to a product model.

**Procedure**
1. Navigate to **Customer Service > Administration > Guided Setup**.
2. On the Getting Started page of the guided setup, click **Get Started**.
3. In the Foundation Data category, view the list of tasks to configure the feature.

### Product model and catalog item relationships

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign roles</td>
<td>If customer service managers need to edit or create catalog items, assign a role specific to the Service Catalog Management application, such as catalog_manager or catalog_admin.</td>
</tr>
</tbody>
</table>
|                        | **Note:** Customer service managers are automatically assigned these roles:  
|                        | • sn_product_catalog_admin (create, edit, delete access)  
|                        | • sn_product_catalog_viewer (read access)  
| Configure form views  | Add the Catalog Items Relationships related list to any of the Product Model forms, for example, service model, in the product catalog.       |
|                        | **a.** Navigate to **Customer Service > Products > Product Models**.  
|                        | **b.** Click a product model.  
<p>|                        | <strong>c.</strong> Add the Catalog Items Relationships related list to the Product Model form to enable customer service managers to create relationships between product models and catalog items. |</p>
<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add the Catalog Items Relationships related list to the Service Model form to enable customer service managers to create relationships between service models and catalog items.</td>
<td>d.</td>
</tr>
</tbody>
</table>

Create or associate catalog items to product models

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navigate to Customer Service &gt; Products &gt; Product Models.</td>
<td>a.</td>
</tr>
<tr>
<td>Click a product model.</td>
<td>b.</td>
</tr>
<tr>
<td>In the Catalog Items Relationships related list, click New or Edit.</td>
<td>c.</td>
</tr>
<tr>
<td>Fill out the fields on the Catalog Item form.</td>
<td>d.</td>
</tr>
<tr>
<td>Click Submit.</td>
<td>e.</td>
</tr>
</tbody>
</table>

4. To perform a task, click Configure.
   This button opens the page in your instance where the configuration is completed.

**Related information**

View product information from the Customer Service Portal

**Configure install base**

Track which products and services have been purchased by a customer, how they have been installed or provisioned, along with the detailed configuration for each installed item.

**Before you begin**

Role required: admin

**About this task**

Install base requires the Customer Service Install Base Management plugin (com.snc.install_base).

Capture the install base for a customer by creating sold products, install base items, and installed products to enable customer service agents to easily trace issues back to the right product, instances of that product, and other entities that might impact their functioning.
Before setting up your install base, create your product data by creating or importing product models. For more information, see Configure products.

There are three parts to setting up your install base.

<table>
<thead>
<tr>
<th>Sold Products</th>
<th>Create a sold product to provide customers, consumers, and customer service agents with a view into the products and services that have been sold to an account or a consumer.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install Base Items</td>
<td>Create an install base item to track instances that have been provisioned for an account or consumer.</td>
</tr>
<tr>
<td></td>
<td>An install base item can be any configuration item that has been made accessible to customers. For Software as a Service (SaaS) products, an install base item refers to an application service configuration item.</td>
</tr>
<tr>
<td>Installed Products</td>
<td>Create an installed product to track information on the instances that a sold product is deployed on at an account or consumer.</td>
</tr>
<tr>
<td></td>
<td>A sold product can have multiple installed product records depending on the number of instances of the product in use.</td>
</tr>
</tbody>
</table>

You can create sold products, install base items, and installed products as individual records, import them in bulk, or create them from an Account or Consumer record.

Customer service agents can view install base information in Agent Workspace. Customers can view install base information on the Customer Service Portal.

Procedure

1. Navigate to Customer Service > Administration > Guided Setup.
2. On the Getting Started page of the guided setup, click Get Started.
3. In the Foundation Data category, view the list of tasks to configure the feature.
Install base

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Sold Products</td>
<td>Import sold products to track the products or services sold to an account or consumer.</td>
</tr>
<tr>
<td>Import Install Base Items</td>
<td>Import install base items that represent the items installed or provisioned for a customer.</td>
</tr>
<tr>
<td>Import Installed Products</td>
<td>Import installed products to create an association between sold products and install base items.</td>
</tr>
</tbody>
</table>

4. To perform a task, click **Configure**.

   This button opens the page in your instance where the configuration is completed.

**Import sold products with guided setup**

Sold products are products and components that have been sold to an account or a consumer. Use guided setup to import sold products so that you can track the products or services sold to an account or consumer.

**Before you begin**

Role required: admin

**About this task**

This provides an overview of the complete product sold to an account or consumer. A sold product can have child and parent sold items in a hierarchical structure.

**Procedure**

1. Navigate to Customer Service > Administration > Guided Setup and click **Get Started**.
2. In the Foundation Data category, click **Get Started** and then click **Import Sold Products**.
3. Upload data from an external data source into an import set.
4. Create a transform map.
5. Execute the transform map to transfer the data.
6. Verify that the data records are imported into the target table.
Import install base items with guided setup

Install base items represent the instances of the product that have been configured for a customer.

Before you begin
Role required: admin

About this task
Each install base item references the configuration item record for the customer.

Procedure
1. Navigate to Customer Service > Administration > Guided Setup and click Get Started.
2. In the Foundation Data category, click Get Started and then click Import Install Base Items.
3. Upload data from an external data source into an import set.
4. Create a transform map.
5. Execute the transform map to transfer the data.
6. Verify that the data records are imported into the target table.

Import installed products with guided setup

Installed products provide information on the sold products and how they are deployed or installed. Import installed products to create an association between sold products and install base items.

Before you begin
Role required: admin

Procedure
1. Navigate to Customer Service > Administration > Guided Setup and click Get Started.
2. In the Foundation Data category, click Get Started and then click Import Installed Products.
3. Upload data from an external data source into an import set.
4. Create a transform map.
5. Execute the transform map to transfer the data.
6. Verify that the data records are imported into the target table.
Create sold products

Create a sold product to track the products or services sold to an account or consumer.

Before you begin

Ensure that the Customer Service Install Base Management (com.snc.install_base) and Customer Service with Service Portfolio Management (SPM) (com.snc.csm_spm) plugins are installed. Role required: sn_customerservice_manager or admin

About this task

Sold products are products and components that have been sold to an account or a consumer. It provides an overview of the complete product sold to an account or consumer. A sold product can have child and parent sold products in a hierarchical structure. If issues arise with a configuration item, customer service agents can trace which sold product is affected on the Case form. From the Sold Products form, you can edit install base items, create entitlements and cases, and add contracts.

Procedure

1. Navigate to Customer Service > Products > Sold Products.
2. Click New.
3. Fill out the fields on the form.

Sold product form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the product or service sold.</td>
</tr>
<tr>
<td>Parent Sold Product</td>
<td>Parent sold product, if applicable.</td>
</tr>
<tr>
<td>Account</td>
<td>Account associated with the sold product.</td>
</tr>
</tbody>
</table>

Note: If you enter an account, the Consumer field is hidden. The Consumer field is active only when the B2B2C plugin is installed.

Consumer | Consumer associated with the sold product.
### Field | Description
--- | ---
| | **Note:** This field is active only when the B2B2C plugin is installed.
| Product | Product model the sold product belongs to.
| Service Offering | Service offering associated with the sold product.

**Note:**
- The **Service Offering** field may not appear by default in the user interface. If this happens, add **Service Offering** field using the form layout.
- If the product model already has a service offering associated with it, this field is automatically populated.

4. Right-click the form header and select **Save**. The **Child Sold Products**, **Install Base Items**, **Cases**, **Entitlements**, and **Contracts** related lists are displayed.

5. Fill out the related lists as required.

**Sold product related lists**

<table>
<thead>
<tr>
<th>Related list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Child Sold Products</td>
<td>Click <strong>New</strong> to create a child sold product.</td>
</tr>
<tr>
<td>Install Base Items</td>
<td>Click <strong>Edit</strong> to edit an install base item.</td>
</tr>
<tr>
<td>Cases</td>
<td>Click <strong>New</strong> to add a case to the sold product. The system displays any open cases that are related to the sold product automatically.</td>
</tr>
<tr>
<td>Entitlements</td>
<td>Click <strong>New</strong> to add an entitlement for the sold product.</td>
</tr>
<tr>
<td>Related list</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Note:</strong> Customer service managers create entitlements. Customer service agents can view entitlements.</td>
<td></td>
</tr>
</tbody>
</table>
| Contracts | Click **Edit** to associate a contract with the sold product.  
**Note:** You can also associate a contract with a sold product from the Service Contracts form.  
Customer service managers associate contracts to sold products. Customer service agents can view contract information. |

6. **Click Update.**  
The sold product is added to the account or consumer selected. Click an account or consumer to see a list of all sold products related to the account or consumer. You can also view a list of sold products per product model.  

**Note:** You can also create sold products directly from an account or a consumer.  

b. Click an account or a consumer.  
c. Click the **Sold Products** related list.  
d. Click **New**.

**Associate service offerings with sold products**  
Associate a service offering with a sold product giving customer service agents visibility into sold products and their service offerings.  

**Before you begin**  
Ensure that the Customer Service with Service Portfolio Management (SPM) plugin (com.snc.csm_spm) is installed.  
Role required: sn_customerservice_manager or admin
Procedure
1. Navigate to Customer Service > Products > Sold Products.
2. Click a sold product.
3. In the Service Offering field, select an existing service offering.

   Note: The Service Offering field may not appear by default in the user interface. If this happens, add Service Offering field using the form layout.
4. Click Update.

Related information
   Create a service offering

Associate sold products with contracts
Capture complete information on a customer’s install base by associating sold products to contracts.

Before you begin
Role required: sn_customerservice_manager or admin

About this task
Associate sold products to contracts so that your customer service agents working on cases can:

• Check a sold product and view any contracts that exist for the sold product.
• View which products have been sold to the customer under the contract.
• Track when sold products were added to the contract, and how long they are covered for.

You can also associate a sold product with a contract from the Sold Product form.

A sold product can be part of multiple contracts. If a sold product is deleted, it is also deleted from any associated contracts. If a contract is deleted, the sold product remains.

Procedure
2. Click a contract you want to add a sold product to.
3. On the Products Covered related list, click Edit to associate sold products to the contract.
   The list of sold products is filtered based on the account.
Click **Run filter** to see a list of all sold products. You can only add the sold products that belong to the account selected or to the account hierarchy.

4. Click **Save**.

5. On the **Products Covered** related list, click the **Add All Child Sold Products** related list action to add all child sold products to the contract without having to select each item individually.

6. Click **Update**.

**Create install base items**
Create an install base item that represents the instance of the product that has been configured for a customer.

**Before you begin**
Ensure that the Customer Service Install Base Management plugin (com.snc.install_base) is installed.
Role required: sn_customerservice_manager or admin

**About this task**
An install base item is any configuration item that has been made accessible to customers. For Software as a Service (SaaS) products, an install base item refers to an application service configuration item. Each install base item references the configuration item record for the customer. If issues arise with a configuration item, customer service agents can trace which install base items the case is affecting.

**Procedure**
1. Navigate to **Customer Service > Products > Install Base Items**.
2. Click **New**.
3. Fill out the fields on the form.

**Install Base Item form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique Id of the install base item. This system automatically fills out this field, but you can change it.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the install base item.</td>
</tr>
<tr>
<td>Configuration Item</td>
<td>Configuration item associated with the install base item.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Account</strong></td>
<td>Account associated with the install base item.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>If you enter an account, the <strong>Consumer</strong> field is hidden. The <strong>Consumer</strong> field is active only when the B2B2C plugin is installed.</td>
</tr>
<tr>
<td><strong>Contact</strong></td>
<td>Account contact primarily responsible for the install base item.</td>
</tr>
<tr>
<td><strong>Consumer</strong></td>
<td>Consumer associated with the install base item.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This field is active only when the B2B2C plugin is installed.</td>
</tr>
<tr>
<td><strong>Owned by</strong></td>
<td>Business manager of the install base item. If the business manager is entered in the configuration item, this field is automatically entered with information from the configuration item.</td>
</tr>
<tr>
<td><strong>Supported by</strong></td>
<td>If the configuration item contains this information, this field is automatically entered with the information from the configuration item.</td>
</tr>
<tr>
<td><strong>Service Context</strong></td>
<td>Service associated to the underlying CI for calculating impact severity from Event Management. For more information, see Service health status for install base.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This field is only available if you have the Proactive Customer Service Operations with Event Management plugin installed. The health status of an install base item only displays if an install base item has a CI and a service context associated to it.</td>
</tr>
</tbody>
</table>

4. Right-click the form header and select **Save**.

The ** Sold Products, Entitlements, and Cases** related lists are displayed.
5. Fill out the related lists as required.

### Install base item related lists

<table>
<thead>
<tr>
<th>Related list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sold Products</td>
<td>Click <strong>Edit</strong> to edit a sold product.</td>
</tr>
<tr>
<td>Entitlements</td>
<td>Click <strong>New</strong> to add an entitlement for the install base item.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Customer service managers can create entitlements. Customer service agents can view entitlements.</td>
</tr>
<tr>
<td>Cases</td>
<td>Click <strong>Edit</strong> to edit a case related to the install base item. Any open cases that are related to the install base item are displayed automatically.</td>
</tr>
</tbody>
</table>

6. Click **Update**.

   The install base item is added to the account or consumer selected. Click an account or consumer to see a list of all install base items related to the account or consumer.

   **Note:** You can also create install base items directly from an account or a consumer.

   a. Navigate to **Customer Service > Customer > Accounts** or **Customer Service > Customer > Consumer**.
   b. Click an account or a consumer.
   c. Click the **Install Base Items** related list.
   d. Click **New**.

### Create installed products

Create an installed product to create an association between sold products and install base items. Installed products provide information on the instances that a sold product is deployed on.

**Before you begin**

Ensure that the Customer Service Install Base Management plugin (com.snc.install_base) is installed.

Role required: sn_customerservice_manager or admin
Procedure

1. Navigate to Customer Service > Products > Installed Products.
2. Click New.
3. Fill out the fields on the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install Base Item</td>
<td>Instance the sold item is deployed on.</td>
</tr>
<tr>
<td>Sold Product</td>
<td>Sold product deployed to the customer.</td>
</tr>
</tbody>
</table>

4. Click Submit.

Configure assets

An asset is a specific product or instance that is supported for a customer.

Before you begin
Role required: admin

About this task
Assets can have serial numbers or asset tag numbers and can be allocated to individual accounts or to a contact within an account. Assets can also have associated support contracts.

Note: Customer Service Management leverages the Asset Management application to create and maintain assets. Ensure that the Asset Management plugin (com.snc.asset_management) is activated.

Procedure

- You can import existing assets using guided setup.
- You can create new assets using the Customer Service Management application.

Import assets with guided setup

Use Customer Service Management guided setup to import existing assets.

Before you begin
Role required: admin
About this task
There are different types of assets and information for each type of asset is stored in a different table. For example, hardware assets are stored in the Hardware [alm_hardware] table.

Procedure
1. Navigate to Customer Service > Administration > Guided Setup and click Get Started
2. In the Foundation Data category, click Get Started and then click Import Assets.
3. Upload data from an external data source into an import set.
4. Create a transform map.
5. Execute the transform map to transfer the data.
6. Verify that the data records are imported into the target table.

Create an asset
Create a record for a specific instance of a product.

Before you begin
Role required: sn_customerservice_manager or admin

Customer Service Management leverages the Asset Management application to create and maintain assets. Ensure that the Asset Management plugin (com.snc.asset_management) is activated.

Procedure
2. Click New.
3. Select the type of asset to create:
   • Hardware
   • Software License
   • Consumable
   • License
   • Facility
4. Fill in the fields for the selected asset type on the Asset form, as appropriate.
5. Click Submit.
Create asset contact relationships

Assign an asset to a customer contact who is responsible for managing that asset.

Account and partner contacts can see all of the assets related to an account. To limit access to an asset, you can create an asset contact relationship and assign the asset to one or more contacts. Then you can enable the associated property to restrict access to the asset information to the assigned contacts.

The system administrator can add a primary contact to an asset by selecting a user in the Primary Contact field on the Asset form. This field references the Contacts table and is filtered by the asset’s account.

The system administrator can also create relationships with additional contacts from the Asset Contacts related list on the Asset form. When you create an asset contact relationship, you can select contacts from:

- The account that the asset belongs to.
- The partner of the account that the asset belongs to.
- Any contacts added to these accounts using contact relationships.

After adding contacts to an asset, enable the related property to limit access. When enabled, the following access is limited from the customer portal:

- When a user clicks My Assets, the list shows only those assets for which the user is a contact.
- When a user clicks Create Case, the Asset field on the Create Case form shows only those assets for which the user is a contact.

Assign a primary contact to an asset

Users with the system administrator role can assign a primary contact to an asset.

Before you begin
Role required: admin

Procedure
2. Click the desired asset.
3. Select a Primary Contact.
   This field references the Contacts [customer_contact] table and is filtered by the account selected in the Account field.
Assign a contact to an asset

Users with the system administrator role can assign a contact to an asset.

Before you begin
Role required: admin

About this task
Users with the sn_customerservice.customer_admin can also assign a contact to an asset from the Customer Service Portal.

Procedure

2. Click the desired asset.
3. Click New in the Asset Contacts related list.
   This displays a new Asset Contact form. The Asset field displays the selected asset and is read-only.
4. Select a Contact.
   The contacts available for selection are the contacts from the asset’s account.
5. Click Submit.
   The contact is added to the Asset Contacts related list.

Enable the asset contact relationship property

Limit access to asset information to the assigned contacts by enabling the associated property.

Before you begin
Role required: admin

Procedure

1. Navigate to Customer Service > Administration > Properties.
2. Enable the Restrict Assets based on Contacts assigned to the assets property.
3. Click Save.
Create service contracts

Service contracts define the type of support that customers receive.

Before you begin
Role required: sn_customerservice_manager or admin

About this task
A contract can include an account and contact or a consumer and the specific assets that are covered. A contract can also include multiple service entitlements and SLAs.

Procedure
2. Click New.
3. Fill in the fields on the Contract form, as appropriate.

Contract form

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The automatically created contract number.</td>
</tr>
<tr>
<td>Account</td>
<td>The name of the account associated with this contract.</td>
</tr>
<tr>
<td>Consumer</td>
<td>The name of the consumer associated with this contract.</td>
</tr>
<tr>
<td>Contract administrator</td>
<td>The individual who is responsible for managing the contract.</td>
</tr>
<tr>
<td>Approver</td>
<td>The user who approves or rejects the contract.</td>
</tr>
<tr>
<td>Contract number</td>
<td>The number assigned to the contract by the customer.</td>
</tr>
<tr>
<td>State</td>
<td>The current state of the contract:</td>
</tr>
<tr>
<td></td>
<td>• Draft</td>
</tr>
<tr>
<td></td>
<td>• Active</td>
</tr>
<tr>
<td></td>
<td>• Expired</td>
</tr>
<tr>
<td></td>
<td>• Canceled</td>
</tr>
<tr>
<td>Starts</td>
<td>The date that the contract starts.</td>
</tr>
<tr>
<td>Ends</td>
<td>The date that the contract ends.</td>
</tr>
</tbody>
</table>
### Field 
**Definition**

| Name | A name for the contract. |

4. Right-click the form header and select **Save**.

The **Entitlements**, **Assets Covered**, **Terms and Conditions**, **Contracts**, **Cases**, and **Products Covered** related lists are displayed.

5. On the **Products Covered** related list, click **Edit** to associate sold products to the contract.

The list of sold products displayed is filtered based on the account. Click **Run filter** to see a list of all sold products, but you can only add the sold products that belong to the account selected or to the account hierarchy.

6. Click **Submit**.

You can also click **Submit For Review** to place the contract in the **Draft** state and send an email to the **Approver** to review the contract.

Customer service agents can view contract information in Agent Workspace and customers can view contract information on the Customer and Consumer Service Portals.

#### Configure entitlements

An entitlement defines the type of support that a customer receives as well as the supported communication channels.

**Before you begin**

Role required: sn_customerservice_manager or admin

**About this task**

You can associate an entitlement with a product, an asset, an account, or a contract. An entitlement check is performed when a case is opened. This check takes into consideration the existing cases for the specific account, product, asset, and service contract. Entitlements can also have associated workflows that drive recommended activities for a case.

Entitlements are counted on a per unit basis. The **Unit** field on the Service Entitlement form defines the unit type, either cases or hours.

The **Total Units** field defines the total number of cases or hours available for this entitlement and the **Remaining Units** field tracks the number of units remaining. These counters are active if the **Per Unit** field is enabled.

The **Remaining Units** field is updated using business rules.
• When using cases as the unit type, the **Update case entitlement on Close** business rule updates this field when a case for a product, asset, company, or contract that has an associated entitlement is closed.

• To use hours as the unit type, customers must create a separate business rule. For example, create a rule that is applied to the amount of time an agent spends on a case. When a case is resolved, deduct the hours spent from the total service hours available in the entitlement.

Keep these guidelines in mind as you create entitlements.

• **Product entitlements**: when creating an entitlement for a product, select the product from the **Product** field. If you select only a product and not a company, contract, or asset, this creates a generic entitlement and the entitlement counter fields cannot be used.

• **Asset entitlements**: when creating an entitlement for an asset, select a company first and then the only assets that are shown are those belonging to that company.

• **Contract entitlements**: when creating an entitlement for a contract, select the contract and then the assets that are covered as a contract line item. The resulting contract entitlement is valid for the assets listed within that contract.

**Procedure**

• Create entitlements for customer service entities

• Associate entitlements with customer service entities

**Create entitlements for CSM entities**

Create an entitlement for a Customer Service Management entity such as an account, a consumer, or a product.

**Before you begin**

Role required: sn_customerservice_manager or admin

**Procedure**

1. Navigate to **Customer Service > Contracts > Entitlements**. You can also create an entitlement from the **Entitlements** related list on the Account and Contract forms.

2. Click **New** at the top of the Entitlements list.

3. Fill in the fields on the Entitlement form.
## Service Entitlement form

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the entitlement.</td>
</tr>
<tr>
<td>Product</td>
<td>The product model associated with this entitlement.</td>
</tr>
<tr>
<td>Account</td>
<td>The name of the account associated with this entitlement.</td>
</tr>
<tr>
<td>Consumer</td>
<td>The name of the consumer associated with this entitlement.</td>
</tr>
<tr>
<td>Contract</td>
<td>The contract number associated with this entitlement.</td>
</tr>
<tr>
<td>Asset</td>
<td>The asset tag number or the serial number of the asset associated with this entitlement.</td>
</tr>
<tr>
<td>Active</td>
<td>Check this box to enable the entitlement. Active entitlements are available for selection when creating a new case.</td>
</tr>
<tr>
<td>Channel</td>
<td>One or more communication channels associated with this entitlement.</td>
</tr>
<tr>
<td></td>
<td>• Email</td>
</tr>
<tr>
<td></td>
<td>• Web</td>
</tr>
<tr>
<td></td>
<td>• Phone</td>
</tr>
<tr>
<td></td>
<td>• Chat</td>
</tr>
<tr>
<td>Install Base Item</td>
<td>The install base item associated with the entitlement. Configure the form layout to add the <strong>Install Base Item</strong> field.</td>
</tr>
<tr>
<td></td>
<td>Note: This field is only available if the Customer Service Install Base Management plugin (com.snc.install_base) is installed.</td>
</tr>
<tr>
<td>Sold Product</td>
<td>The sold product associated with the entitlement. Configure the form layout to add the <strong>Sold Product</strong> field.</td>
</tr>
<tr>
<td></td>
<td>Note: This field is only available if the Customer Service Install Base Management plugin (com.snc.install_base) is installed.</td>
</tr>
<tr>
<td>Business hours</td>
<td>The schedule associated with this entitlement.</td>
</tr>
<tr>
<td>Start date</td>
<td>The start date for this entitlement.</td>
</tr>
<tr>
<td>End date</td>
<td>The end date for this entitlement.</td>
</tr>
</tbody>
</table>
### Field | Definition
--- | ---
**Total Units** | The total number of units designated for this entitlement. This field is active if the **Per unit** check box is enabled.

**Remaining Units** | The number of available units that are remaining for this entitlement. This field is active if the **Per unit** check box is enabled. This field is updated using business rules.
- When using cases as the unit type, the **Update case entitlement on Close** business rule updates this field when a case for a product, asset, company, or contract that has an associated entitlement is closed.
- To use hours as the unit type, customers must create a separate business rule. For example, create a rule that is applied to the amount of time an agent spends on a case. When a case is resolved, deduct the hours spent from the total service hours available in the entitlement.

**Unit** | The type of unit being measured for this entitlement: **Cases** or **Hours**.

**Per unit** | Select this check box to enable unit counters. If enabled, the **Total Units** and **Remaining Units** fields are activated.

### 4. Click **Submit**.

### Associate entitlements with CSM entities

Associate an entitlement with a Customer Service Management entity such as an account, contract, asset, product, or install base item.

**Before you begin**
Role required: sn_customerservice_manager or admin

**Procedure**

1. Navigate to **Customer Service > Contracts > Entitlements**.
2. Select an entitlement from the Entitlements list.
3. Click the lookup icon to the right of one of the **Product**, **Account**, **Contract**, **Asset**, or **Install Base Item** fields.
4. Select the desired entity from the list.
Note: If you select an entity in more than one of the fields listed above, the selections available in subsequent fields are filtered by the selections already made.

5. Click Update.

Customer service case entitlement calculation

When a customer service agent creates a case, the system uses a configurable method to derive the entitlement based on several fields related to the case record.

These fields include:
- Account
- Consumer
- Product
- Asset
- Contract
- Case Channel

If the Proactive Customer Service Operations plugin (com.snc.proactive_cs_ops) is active, the system also considers these fields:
- Sold Product
- Install Base

Relative weights are assigned to each field. Entitlements are calculated based on the weight and precedence. The entitlement with the highest score is assigned to the case.

<table>
<thead>
<tr>
<th>Field</th>
<th>Weight/Precedence Assigned</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account / Consumer</td>
<td>1</td>
</tr>
<tr>
<td>Product</td>
<td>2</td>
</tr>
<tr>
<td>Asset / Sold Product / Install Base item</td>
<td>3</td>
</tr>
<tr>
<td>Contract</td>
<td>4</td>
</tr>
</tbody>
</table>

The entitlement calculation uses the `global.CSManagementUtils` script and the `getFirstEntitlement` method.
Create account teams
Account teams are made up of both employees and customer contacts who fulfill specific jobs or roles for a particular account.

Before you begin
Role required: sn_customerservice_manager or admin

About this task
These roles are created using responsibility definitions. A responsibility definition describes a role or a function that is needed to support a customer account.

The system administrator creates the responsibility definitions, or roles, as needed. The system administrator can create two types of responsibility definitions: one for an employee and one for a contact.

Note: The system administrator can delete definitions that are no longer used. A definition can only be deleted if it has no entries.

Once these definitions, or roles, are created, the customer service manager can use these roles to:

• Build an account team by selecting an account and then selecting roles and assigning them to employees.
• Add contact relationships to an account by selecting an account and then selecting roles and assigning them to contacts.

The users who have been assigned to this role are displayed in the Account Team Members related list on the Responsibility Definition form.

Procedure
• Create a responsibility definition.
• Assign a team member to an account.

Create a responsibility definition
Define a role or responsibility needed to support an account.

Before you begin
Role required: admin

About this task
Create responsibility definitions that you can use to create account teams or contact relationships.
If you are using the industry data models feature, you can also create responsibility definitions to use in customer and consumer relationships.

**Procedure**

1. Navigate to **Customer Service > Administration > Responsibility Definitions**.
2. Click **New**.
3. Fill in the fields on the Responsibility Definition form.

### Responsibility Definition form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the role or responsibility.</td>
</tr>
</tbody>
</table>
| Unique| Select this check box if this role should only be assigned to one employee or contact. Enabling this check box prevents the creation of duplicate entries for a role.  
**Note:** The unique behavior of a responsibility definition is not enforced when the responsibility is used for industry data model relationships between consumers or household members. |
| Type  | The type of role:  
• Select **User** if this role should be performed by an employee. When assigning this role, the list of available users comes from the Users [sys_users] table.  
• Select **Contact** if this role should be performed by a customer contact. When assigning this role, the list of available users comes from the Contacts [customer_contact] table.  
• Select **None** if this responsibility definition is to be used when creating relationships between consumers.  
**Note:** Only responsibility definitions with **Type** set to **User** can be used in the following industry data model relationships:  
• Account Team Member  
• Consumer Team Member  
• Household Team Member |

4. Click **Submit**.
Related reference

Industry data model responsibilities

Assign a team member to an account
Assign a team member to an account by selecting the employee and the employee’s role or responsibility.

Before you begin
Role required: sn_customerservice_manager or admin

About this task
The system administrator can assign a team member to an account from the Account Team Members related list on the Responsibility Definition form.
The customer service manager can assign a team member to an account from the Account Team Members related list on the account or partner record.

Procedure
1. Navigate to Customer Service > Customer > Accounts or Partners.
2. Select an account.
3. From the Account Team Members related list, click New.
4. Fill in the fields on the Account Team Member form.

Account Team Member form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>The account to which the user is assigned. If you are assigning a user from an account or partner record, this field is automatically filled in; otherwise, make a selection from the Accounts list.</td>
</tr>
<tr>
<td>Responsibility</td>
<td>The role or responsibility selected for this employee.</td>
</tr>
<tr>
<td>User</td>
<td>The employee selected to fulfill the role or responsibility.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Fix external user role assignments
You may have external users (contacts or consumers) on your instance that have been assigned internal roles. If so, you can use the Customer Service Management guided setup to evaluate and correct these role assignments as needed.
Because external users with internal roles can result in access issues, it is recommended that external users only be assigned external roles.

Use the tasks in the Fix External User Role Assignment category guided setup category to evaluate the contacts and consumers with the following role assignments:

- The snc_internal role only.
- The snc_internal role and one or more external roles.
- The snc_internal role and one or more additional internal roles.
- The snc_internal role and one or more additional internal and external roles.

Review the list of users in each group and tag those users with incorrect role assignments. Then run the scheduled job to fix the role assignments.

**Note:** You can also review and update external user roles using a query-based list. For more information, see KB0829930.

**Using guided setup to fix external user role assignments**
With the system administrator role, you can use guided setup to fix external user role assignments.

1. Navigate to Customer Service > Administration > Guided Setup.
2. On the Getting Started page of the guided setup, click Get Started.
3. In the Fix External User Role Assignment category, click Get Started.
   The Fix External User Role Assignment page opens with a list of tasks to evaluate groups of external users.
4. To perform a task, click Configure.
   This button opens the page in your instance where the configuration is completed.

**Fix External User Role Assignment tasks**
The following table describes the different configuration tasks in the Fix External User Role Assignment category.

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
</table>
| External users with possible non-intentional internal role assignment | This is a set of contacts and consumers with the following role assignments:
### Fix External User Role Assignment tasks (continued)

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Task</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Fix the SNC_INTERNAL role only.</td>
<td>• The snc_internal role only.</td>
</tr>
<tr>
<td>Fix the SNC_INTERNAL role and one or more external roles.</td>
<td>• The snc_internal role and one or more external roles. It is recommended that you do not assign internal roles to external users. Review the contacts in this list and fix the role assignment as needed.</td>
</tr>
<tr>
<td>Fix external users with possible intentional internal role assignments</td>
<td>This is a set of contacts and consumers that have the following role assignments: • The snc_internal role and one or more additional internal roles. • The snc_internal role and one or more additional internal and external roles. It is recommended that you do not assign both internal and external roles to the same user. Review the users in this list and fix the role assignment as needed.</td>
</tr>
<tr>
<td>Fix external users with intentional internal role assignments</td>
<td>This is a set of contacts and consumers that have: • The snc_internal role that is contained by another role. It is recommended that you do not assign internal roles to external users. Review the users in this list and fix the role assignments as needed.</td>
</tr>
<tr>
<td>Avoid such role assignments in future</td>
<td>To prevent external users from being assigned the snc_internal role in the future, enable the following property: glide.security.explicit_roles.enable_internal_user_blacklist.</td>
</tr>
</tbody>
</table>
Fix External User Role Assignment tasks (continued)

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Click <strong>Configure</strong> to navigate to the property and verify that the value is true. If false, set the value to true.</td>
</tr>
</tbody>
</table>

Fix roles for external users with possible non-intentional internal role assignments

Review and fix roles for external users that may have non-intentional internal role assignments.

**Before you begin**

Role required: admin

**About this task**

It is recommended that you do not assign internal roles to external users. Use this procedure to review and fix the contacts and consumers that may have the following role assignments:

- snc_internal role only
- snc_internal role and one or more external roles

**Note:** This guided setup task uses scheduled jobs to identify and fix role assignments. When fixing role assignments, the scheduled job fixes 3000 users at a time. If there are more than 3000 users in this group, change the configuration of the job so that it runs periodically.

**Procedure**

1. Navigate to **Customer Service > Administration > Guided Setup** and click **Get Started**.
2. In the Fix External User Role Assignment category, click **Get Started** and then click **External users with possible non-intentional internal role assignment**.
3. Run the scheduled job to tag users that may have non-intentional user role assignments. Users are tagged with the **Ext-user-non-intentional** tag.
4. Review the list of tagged users and remove the tag from any users for which you do not need to fix role assignments. If necessary, configure the list to display the Tag column.
5. Run the scheduled job to fix the role assignments for the users with the **Ext-user-non-intentional** tag. This scheduled job makes the following changes:
• For users with the snc_internal role only, it removes the snc_internal role and adds the snc_external role.
• For users with the snc_internal role and one or more external roles, it removes the snc_internal role.

This scheduled job runs all of the insert/delete business rules on the User Role [sys_user_has_role] table.

**Fix roles for external users with possible intentional internal role assignments**

Review and fix roles for external users that may have intentional internal role assignments.

**Before you begin**

Role required: admin

**About this task**

It is recommended that you do not assign internal roles to external users. Use this procedure to review and fix the contacts and consumers that may have the following role assignments:

• snc_internal role and one or more additional internal roles
• snc_internal role and one or more additional internal and external roles

**Note:** This guided setup task uses scheduled jobs to identify and fix role assignments. When fixing role assignments, the scheduled job fixes 3000 users at a time. If there are more than 3000 users in this group, change the configuration of the job so that it runs periodically.

**Procedure**

1. Navigate to Customer Service > Administration > Guided Setup and click Get Started.
2. In the Fix External User Role Assignment category, click Get Started and then click External users with possible intentional internal role assignments.
3. Run the scheduled job to tag users that may have intentional user role assignments.
   Users are tagged with the Ext-user-intentional tag.
4. Review the list of tagged users and remove the tag from any users for which you do not need to fix role assignments.
   If necessary, configure the list to display the Tag column.
5. Run the scheduled job to fix the role assignments for the users with the Ext-user-intentional tag.
This scheduled job makes the following changes:

- For users with the snc_internal role and one or more additional internal roles, it removes the snc_internal role and all other internal roles, and adds snc_external role.
- For users with the snc_internal role and one or more additional internal and external roles, it removes the snc_internal role and all other internal roles.

This scheduled job runs all of the delete business rules on the User Role [sys_user_has_role] table.

Fix roles for external users with intentional internal role assignments

Review and fix roles for external users that have intentional internal role assignments.

Before you begin
Role required: admin

About this task
It is recommended that you do not assign internal roles to external users. Use this procedure to review and fix the contacts and consumers that have the following role assignments:

- snc_internal role that is contained by another role

Procedure
1. Navigate to Customer Service > Administration > Guided Setup and click Get Started.
2. In the Fix External User Role Assignment category, click Get Started and then click External users with intentional internal role assignments.
3. Run the scheduled job to tag users that have intentional user role assignments. Users are tagged with the Ext-user-contained-role tag.
4. Review the list of tagged users.
5. Manually fix the role assignments for the desired users.

Prevent future internal role assignments for external users

Enable a property to prevent external users from being assigned the snc_internal role.

Before you begin
Role required: admin
Procedure
1. Navigate to Customer Service > Administration > Guided Setup and click Get Started.
2. In the Fix External User Role Assignment category, click Get Started and then click Avoid such role assignments in future.
3. Set the glide.security.explicit_roles.enable_internal_user_blacklist property to true.

Configure Industry Data Model
Configure the industry data model feature to enable a foundational data model framework. You can use this framework to create structured and flexible data models that represent your business needs.

Before you begin
Role required: admin

About this task
Industry data model provides the core framework and guidance for building and modeling the entities that are involved in the customer service value chain. This framework introduces new entities, such as service organizations, internal business locations, and households. It also introduces roles and relationships that provide both flexibility and control in granting access to customer cases and information.

With the industry data model plugins, you can support:
• Internal business locations and staff members
• Households and household members

For more information about this feature, see Industry data model overview.

Procedure
1. Navigate to Customer Service > Administration > Guided Setup.
2. On the Getting Started page of the guided setup, click Get Started.
3. In the Industry Data Model category, view the list of tasks to configure the feature.

Customer central configuration tasks

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate Plugins</td>
<td>Activate the plugins:</td>
</tr>
<tr>
<td>Task</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>• Business Location</td>
<td>(com.snc.business_location)</td>
</tr>
<tr>
<td>• Customer Service Household</td>
<td>(com.snc.household)</td>
</tr>
<tr>
<td>Configure Forms and Lists</td>
<td>Configure forms to add the fields and related lists that support the business location and household models.</td>
</tr>
<tr>
<td>Assign Roles</td>
<td>Roles control access to features, capabilities, and data. The industry data model plugins add roles that you can assign to internal and external users in your organization.</td>
</tr>
<tr>
<td>Create Relationships</td>
<td>Use relationships to provide internal and external users with additional access to customer data.</td>
</tr>
<tr>
<td></td>
<td>Relationships are based on responsibility definitions. When you create a relationship, you select the users involved in the relationship and the responsibility that one user performs on behalf of another.</td>
</tr>
<tr>
<td></td>
<td>The industry data model plugins provide both relationships and responsibility definitions that you can use to create relationships between users.</td>
</tr>
</tbody>
</table>

4. To perform a task, click **Configure**.
   This button opens the page in your instance where the configuration is completed.

**Activate Business Location**

Activate the Business Location plugin to manage customer service for internal business locations.

**Before you begin**

Role required: admin
About this task
The Business Location plugin (com.snc.business_location) enables support for businesses that interact with customers through physical channels such as stores and branches. This plugin automatically activates the following plugins:

- Service Organization (com.snc.service_organization)
- Customer Service Base Extension Entities (com.snc.cs_base_extension)

The Service Organization plugin enables support for internal and external entities in your customer service structure. The Customer Service Base Extension Entities plugin provides granular access control through relationships, user profile attributes, and roles.

Procedure
1. Navigate to **System Definition > Plugins**.
2. Search for the plugin com.snc.business_location.
3. Click **Activate**.

Activate Customer Service Household
Activate the Customer Service Household plugin to manage customer service for households.

Before you begin
Role required: admin

About this task
The Customer Service Household plugin (com.snc.household) enables you to create households, define the members of a household, and identify relationships between household members. This plugin automatically activates the Customer Service Base Extension Entities plugin (com.snc.cs_base_extension), which provides granular access control through relationships, user profile attributes, and roles.

Procedure
1. Navigate to **System Definition > Plugins**.
2. Search for the plugin com.snc.household.
3. Click **Activate**.
Configure forms and related lists

Configure forms to add the fields and related lists that are necessary to support the business location and household data models.

Before you begin
Role required: admin

Procedure

1. Navigate to Customer Service > Administration > Guided Setup and click Get Started.
2. In the Industry Data Model category, click Get Started.
3. Click Configure Forms and List.
4. Add the following related lists to the Consumer form for these views: Case and Workspace.
   - Current Households
   - Household Member > Consumer (All Households)
   - Consumer Relationships
   - Household Relationships
   - Consumer Team Member > Consumer (Consumer Team)
   - Sold Products
5. Add the Service Organization field to the Case form for these views: Case and Workspace.
6. Add the Requesting Service Organization field to the Case form for these views: Case and Workspace.
7. Add the Updated by field to the Case form for these views: Case and Workspace.
8. Add the Household field to the Case form for these views: Case and Workspace.
9. Add the Primary Household (Household) field to the Consumer form for these views: Case and Workspace.

   Note: After the Household field is added to the Consumer form for both case and workspace views, observe the following behavior: the form for a new consumer does not have a Primary Household field.

10. Add the following related lists to the Sold Products form for these views: Case and Workspace.
• All Consumers
• More Consumers

11. Add the **Household** field to the Entitlement form for these views: Case and Workspace.

12. Add the **Household** field to the Contract form for these views: Case and Workspace.

13. Add the **Household** field to the Sold Product form for these views: Case and Workspace.

14. Add the following related lists to the Service Organization form for these views: Case and Workspace.
   - Members
   - Cases > Service Organization (Cases)
   - Account Staff Relationships
   - Consumer Staff Relationships
   - Household Staff Relationships

15. Add the following related lists to the Household form for these views: Case and Workspace.
   - Current Members
   - Household Member > Household (All Members)
   - Household Member Relationship > Household (Member Relationships)
   - Household Team Member > Household (Household Team)
   - Case > Household (Cases)
   - Entitlement > Household (Entitlements)
   - Contract > Household (Contracts)
   - Sold Product > Household (Sold Products)

**Assign roles**

Assign roles to your internal and external users to provide the right access to service organizations, business locations and households.

**Before you begin**

Role required: admin
About this task
The industry data model plugins add the following roles to Customer Service Management.

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location agent</td>
<td>Create and fulfill cases for the accounts and contacts in the agent's business location.</td>
</tr>
<tr>
<td>[sn_customerservice.svc_location_agent]</td>
<td></td>
</tr>
<tr>
<td>Location consumer agent</td>
<td>Create and fulfill cases for the consumers and households in the agent's business location.</td>
</tr>
<tr>
<td>[sn_customerservice.svc_location_consumer_agent]</td>
<td></td>
</tr>
<tr>
<td>Location manager</td>
<td>Create and update cases for accounts, contacts, consumers, and households that work with the business locations within their location hierarchy.</td>
</tr>
<tr>
<td>[sn_customerservice.svc_location_manager]</td>
<td></td>
</tr>
<tr>
<td>Relationship agent</td>
<td>Manage cases for the accounts, contacts, consumers, and households that the agent has relationships with. This includes the following relationships that are provided with the industry data model plugins:</td>
</tr>
<tr>
<td>[sn_customerservice.relationship_agent]</td>
<td>• Account Manager: creates a relationship between an internal user and an account.</td>
</tr>
<tr>
<td></td>
<td>• Relationship Manager: creates a relationship between an internal user and a consumer or a household.</td>
</tr>
<tr>
<td>Service Management location agent</td>
<td>A service management agent role for a business location.</td>
</tr>
<tr>
<td>[sn_esm_location_agent]</td>
<td></td>
</tr>
</tbody>
</table>

Procedure
• You can assign roles to users using the industry data model guided setup.
• You can also assign roles to users using the Now Platform user administration feature: Assign a role to a user
Create relationships

Use relationships to provide internal and external users with additional access to customer data.

Before you begin
Role required: admin

About this task
With the industry data model feature, you can create relationships between the following users:
- Between an internal user and an account, household, or consumer.
- Between two consumers.

Relationships are based on responsibility definitions. These definitions describe a role or a function that supports a customer. When you create a relationship, you select the users involved in the relationship and the responsibility that one user performs on behalf of another.

The industry data model plugins provide:
- Relationships that you can create between users.
- Responsibility definitions that you can assign to a user in a relationship.

<table>
<thead>
<tr>
<th>Responsibility</th>
<th>Used in relationship</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Manager</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Account Team Member</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Use the Account Manager responsibility to create a relationship between an internal user and an account. With this relationship, the internal user can:
- Create and manage cases for their accounts.
- View account information, including the related entities for an account.
- Create and manage contacts and additional addresses for their accounts.
<table>
<thead>
<tr>
<th>Responsibility</th>
<th>Used in relationship</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relationship Manager</td>
<td>• Consumer Team Member</td>
<td>Use the Relationship Manager responsibility to create a relationship between:</td>
</tr>
<tr>
<td></td>
<td>• Household Team Member</td>
<td>• An internal user and a consumer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• An internal user and a household.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>With this relationship, the internal user can do the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• For a consumer:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ Create and manage cases for the consumer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ View household information, including the related entities for that consumer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• For a household:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ Create and manage cases for the household.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ View household information, including the related entities for that household.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ Create and manage household members.</td>
</tr>
<tr>
<td>Authorized Representative</td>
<td>• Consumer to Consumer Relationship</td>
<td>Use the Authorized Representative responsibility to create a relationship between two consumers, regardless of household, or between two consumers within the same household.</td>
</tr>
<tr>
<td></td>
<td>• Household Member Relationship</td>
<td>With this relationship, a consumer can:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Create and manage cases for another consumer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View the information of another consumer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• View the install base information of another consumer and create cases for:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ Sold products</td>
</tr>
<tr>
<td></td>
<td></td>
<td>◦ Install base items</td>
</tr>
</tbody>
</table>

**Procedure**

1. Navigate to **Customer Service > Customer Relationships**.

2. Select the desired relationship.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Team Members</td>
<td>Create a relationship between an internal user and an account.</td>
</tr>
<tr>
<td>Consumer Team Members</td>
<td>Create a relationship between an internal user and a consumer.</td>
</tr>
<tr>
<td>Household Team Members</td>
<td>Create a relationship between an internal user and a household.</td>
</tr>
<tr>
<td>Consumer Relationships</td>
<td>Create a relationship between two consumers, regardless of household.</td>
</tr>
<tr>
<td>Household Relationships</td>
<td>Create a relationship between two consumers within a household.</td>
</tr>
</tbody>
</table>

3. From the selected relationship list, click **New**.
4. Fill in the following fields for the selected relationship.

<table>
<thead>
<tr>
<th>Form</th>
<th>Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Team Member</td>
<td>• <strong>Account</strong>: select the account to which the internal user is assigned.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Responsibility</strong>: select the <strong>Account Manager</strong> responsibility.</td>
</tr>
<tr>
<td></td>
<td>• <strong>User</strong>: select the internal user to fulfill the responsibility.</td>
</tr>
<tr>
<td>Consumer Team Member</td>
<td>• <strong>Consumer</strong>: select the consumer to which the internal user is assigned.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Responsibility</strong>: select the <strong>Relationship Manager</strong> responsibility.</td>
</tr>
<tr>
<td></td>
<td>• <strong>User</strong>: select the internal user to fulfill the responsibility.</td>
</tr>
<tr>
<td>Household Team Member</td>
<td>• <strong>Household</strong>: select the household to which the internal user is assigned.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Responsibility</strong>: select the <strong>Relationship Manager</strong> responsibility.</td>
</tr>
<tr>
<td></td>
<td>• <strong>User</strong>: select the internal user to fulfill the responsibility.</td>
</tr>
<tr>
<td>Form</td>
<td>Fields</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Consumer to Consumer Relationship |  • **Consumer is**: select the consumer to fulfill the responsibility on behalf of another consumer.  
  • **Responsibility**: select the **Authorized Representative** responsibility.  
  • **of Consumer**: select the consumer who is being represented by the consumer in the **Consumer is** field. |
| Household Member Relationship  |  • **Household**: select the desired household.  
  • **Consumer is**: select the consumer in the household to fulfill the responsibility on behalf of another consumer within the same household.  
  • **Responsibility**: select the **Authorized Representative** responsibility.  
  • **of Consumer**: select the consumer who is being represented by the consumer in the **Consumer is** field. |

5. Click **Submit**.  
The relationship is added to the relationship list.  
Account, Consumer, and Household Team Member relationships are also added to the corresponding related lists on the Business Location form.

- Account Staff Relationships
- Consumer Staff Relationships
- Household Staff Relationships

Consumer to Consumer and Household Member relationships are added to the following related lists:

- Household form > Member Relationships
- Consumer form > Consumer Relationships

**Related reference**

- Industry data model responsibilities

**Related information**

- Create a responsibility definition
Configure Customer Data Models for B2B2C

Configure the Customer Data Models for B2B2C application to enable business customers to support their end consumers by creating cases and tracking the services for products and services consumers use.

Before you begin
Role required: admin

About this task
The business-to-business (B2B) model supports customer accounts and the contacts within those accounts. The business-to-consumer (B2C) model supports individual consumers.

With the business-to-business-to-consumer (B2B2C) model, you can support business customers and third-party channel partners who, in turn, support the end consumers. This model can be used to support:

• Employees of a business customer.
• End consumers of a business customer.

Procedure
2. Configure the Account and Consumer forms.
3. Configure the Install Base Items and Sold Products lists.
4. Configure the Case list.

Activate Customer Data Models for B2B2C

You can activate the Customer Data Models for B2B2C plugin (com.sn_csm_b2b_consumers) for Customer Data Models for B2B2C if you have the admin role. The application includes demo data and installs related ServiceNow® Store applications and plugins if they are not already installed.

Before you begin
• Customer Data Models for B2B2C requires the following plugin. Ensure that the plugin is activated before you install Customer Data Models for B2B2C.

  Required ServiceNow plugin

  Customer Service Install Base Management (com.snc.install_base)

  The Customer Data Models for B2B2C plugin provides the following roles:
Account consumer (sn_acct_consumer.consumer)

Account consumer agent
(sn_acct_consumer.agent)

When the plugin is activated, customer service agents inherit the account consumer agent role. Consumers who are added as account consumers are given the account consumer role.

About this task
The following items are installed with Customer Data Models for B2B2C:

- Business rules
  - Mandatory account or consumer

- UI policies
  - Table: Case
  - Table: Interaction
  - Table: Sold Product
  - Table: Install Base Items

- Reference qualifiers
  - Table: Case
  - Table: Interaction
  - Table: Sold Produce
  - Table: Install Base Items

Procedure
1. Navigate to System Applications > All Available Applications > All.


   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.
3. Click **Install**, and then in the Activate Plugin dialog box, click **Activate**.

   **Note:** When domain separation and delegated admin are enabled in an instance, the administrative user must be in the **global** domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for `<plugin name>`.

**Configure the Account and Consumer forms for B2B2C**

Enable account consumers to view the Account Consumers related list for the Case and Workspace views.

**Before you begin**
Role required: admin

**Procedure**

1. Navigate to **Customer Service > Accounts**.
2. Select an account.
3. Add the **Account Consumer>Account** related list to the Account form for the Case and Workspace views.
   a. Select **View > Case** from the menu.
   b. Select **Configure > Related Lists** from the Additional actions menu.
   c. Select **Account Consumer>Account** in the Available column and move it to the Selected column.
   d. Click **Save**.
   e. Select **View > Workspace** from the Additional actions menu.
   f. Repeat steps 3b–3d.
4. Navigate to **Customer Service > Consumers** and select a consumer.
5. Add the **Account Consumer>Account** related list to the Consumer form for the Case and Workspace views.
   a. Select **View > Case** from the List controls menu.
   b. Select **Configure > Related Lists** from the Additional actions menu.
   c. Select **Account Consumer > Account** in the Available column and move it to the Selected column.
   d. Click **Save**.
e. Select View > Workspace from the List controls menu.
f. Repeat steps 5b–5d.

Configure the Install Base Items and Sold Products lists
Enable account consumers to view the Account, Contact, and Consumer fields for the Self-Service view.

Before you begin
Role required: admin

Procedure
1. Navigate to Customer Service > Products > Install Base Items.
2. Select View > Self-Service from the List controls menu.
3. Click the Personalize List icon.
4. Select the Account, Contact, and Consumer fields in the Available column and move them to the Selected column.
5. Click OK.
7. Repeat steps 2–5.

Configure the Case list for B2B2C
Enable account consumers to view the Account, Contact, and Consumer fields for the Customer Self Service view.

Before you begin
Role required: admin

Procedure
1. Navigate to Customer Service > Cases > All.
2. Select View > Customer Self Service from the List controls menu.
3. Click the Personalize List icon.
4. Select the Account, Contact, and Consumer fields in the Available column and move them to the Selected column.
5. Click OK.
Configure customer service case types

Configure case types to handle different types of customer issues. A case type identifies the processes and the data needed to resolve a specific type of issue.

About this task
For each case type, you create a table that extends the Case table and configure a number of items, such as business rules and client scripts, that drive customer issues of this type from creation to resolution. When creating cases, agents can select the case type that corresponds to the customer issue.

There are a sequence of tasks that enable you to configure case types for Customer Service Management. To configure Proactive Customer Service Operations, use the Customer Service guided setup. The guided setup takes you through the entire setup and configuration process.

Procedure
1. Navigate to Customer Service > Administration > Guided Setup.
2. On the Getting Started page of the guided setup, click Get Started
3. In the Case Types category, view the list of tasks to configure the feature.

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Case Types</td>
<td>The first step in creating a case type is to create a table for the case type that extends the Case table (sn_customerservice_case).</td>
</tr>
<tr>
<td></td>
<td>✋ Note: This table should be created in a scope other than global.</td>
</tr>
<tr>
<td></td>
<td>You can create a table for the case type using one of these methods:</td>
</tr>
<tr>
<td></td>
<td>• Guided Application Creator</td>
</tr>
<tr>
<td></td>
<td>• Platform table creation feature (navigate to System Definition &gt; Table and click New)</td>
</tr>
<tr>
<td></td>
<td>The extended table for the case type inherits most of the functionality of the Case table.</td>
</tr>
<tr>
<td>Task</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Set Up View Rules</td>
<td>View rules determine the form views that are available to users. Create view rules that determine the conditions for when the system displays the Case Type table in a specified view.</td>
</tr>
<tr>
<td>Set Up States for State Flows</td>
<td>State flows enable you to customize transitions from one state to another in tables derived from the Task [task] table, including the Case [sn_customerservice_case] table and tables extended from Case. You can configure the system to perform work during transitions to specific states. Create choice records for each of the states to be used in state flows for the case type. When creating your desired states, set the <strong>Table</strong> field to the table for the case type and the <strong>Element</strong> field to State.</td>
</tr>
<tr>
<td>Set Up UI Policies</td>
<td>UI policies dynamically change the behavior of information on a form, such as setting a field to read-only or making a field mandatory. The case type inherits the following UI policies from the Case table:   * Show or hide major case information section   * Make Partner Contact Read only If Partner is empty You can configure additional UI policies for the Case Type form.</td>
</tr>
<tr>
<td>Set Up Client Scripts</td>
<td>Client scripts allow the system to run JavaScript on the client when client-based events occur, such as when a form loads or when a field changes value. The case type inherits the following client scripts from the Case table:</td>
</tr>
<tr>
<td>Task</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Empty Partner Contact on Partner Change</td>
<td></td>
</tr>
<tr>
<td>Empty Case Form on Account Change</td>
<td></td>
</tr>
<tr>
<td>Hide Request Related List</td>
<td></td>
</tr>
<tr>
<td>Hide SM section and list if no plugin</td>
<td></td>
</tr>
<tr>
<td>Hide Related Records Section</td>
<td>You can configure additional client scripts for the case type.</td>
</tr>
<tr>
<td>Set Up Business Rules</td>
<td>A business rule is a server-side script that runs when a record is displayed, inserted, updated, or deleted, or when a table is queried. Use business rules to accomplish tasks like automatically changing values in form fields when certain conditions are met, or to create events for email notifications and script actions. You can set up the desired business rules for the Case Type table.</td>
</tr>
<tr>
<td>Set Up Case Type UI Actions</td>
<td>UI actions include the buttons, links, and context menu items that appear on lists and forms. A case type inherits the UI actions from the Case table. You have the following options when setting up UI actions for a case type:</td>
</tr>
<tr>
<td></td>
<td>• Create new UI actions for the case type. If you create a new UI action, select the Case Type table in the Table field on the UI Action form.</td>
</tr>
<tr>
<td></td>
<td>• Use any of the inherited case UI actions.</td>
</tr>
<tr>
<td></td>
<td>• Use a combination of the two. You can also block any inherited case UI actions that you do not want. To block an action, update the CSUIActionsimpl script include.</td>
</tr>
<tr>
<td>Task</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Set Up Case Types           | Register a newly created case type by creating a case type definition record. This record is stored in the Case Type table (sn_case_type) and includes the following information:  
  - The name of the case type  
  - The table created for the case type  
  - An optional category  
  - An optional subtype  
  - A short description  
  - A field for setting the case type to active  
  The Case Type table extends the Application File table (sys_metadata). This table includes a **Domain** column that customers can use to add their own logic.  
  To create a case type definition record, navigate to **Customer Service > Manage Case Types** and click **New.**  
  After creating and saving the case type definition record, you can configure the following process information for the case type using the related lists on the Case Type form:  
  - State flows  
  - Special handling notes  
  - SLAs  
  - Email templates  
  - Quick messages  
  - Reports |
<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong></td>
<td>These related lists only display information for the new case type. They do not include information for the base case.</td>
</tr>
<tr>
<td>Set Up Notifications</td>
<td>Notifications keep users informed about different activities and events. You can determine the conditions when a notification appears by creating a record in the Notification table.</td>
</tr>
<tr>
<td>Set Up Roles</td>
<td>Create one or more roles to control access to the case type features and capabilities. Then grant these roles access to the desired applications and modules. For agents to work on a case type, configure the case type role to contain the sn_customerservice_agent role.</td>
</tr>
<tr>
<td>Set Up ACLs</td>
<td>Use Access Control List rules (ACLs) to restrict access to data. These rules require users to pass a set of requirements before they can interact with data. For external customers to see a case type, add ACLs that provide read or create access for external users.</td>
</tr>
<tr>
<td>Set Up Case Type Selection Conditions</td>
<td>When creating a case of a specific type, an agent clicks <strong>Create Case</strong> and then selects from a list of available case types. The system presents the case types that have been configured for the agent’s role. To set up case type selection conditions, use Flow Designer to configure the <strong>Get Case Types</strong> flow and modify the conditions that determine visibility for a case type.</td>
</tr>
<tr>
<td>Task</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>There are two different implementations of the Create Case UI action:</td>
</tr>
<tr>
<td></td>
<td>• The Customer Service plugin provides a Create Case UI action that agents can use as follows:</td>
</tr>
<tr>
<td></td>
<td>◦ To create a base case.</td>
</tr>
<tr>
<td></td>
<td>◦ To create a case for one specific case type. For example, if your organization always creates the same type of case and you have created only one extension of the Case table, you can modify this UI action to create a case of that specific case type.</td>
</tr>
<tr>
<td></td>
<td>• The Customer Service Case Types plugin also provides a Create Case UI action that agents can use to create a case based on a selected case type. After clicking this UI action to create a case, the agent selects the desired case type from a list of multiple available case types.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> It is recommended that you configure one of the Create Case UI actions but not both to avoid confusion.</td>
</tr>
<tr>
<td>Set Up Record Producers</td>
<td>A record producer is a specific type of catalog item that enables users to create task-based records, such as case records, from the service catalog. Create a record producer that exposes the new case type on the Customer Service Portal.</td>
</tr>
<tr>
<td>Set Up Case Digest for Case Types</td>
<td>The case digest feature enables agents to proactively communicate with customers and internal...</td>
</tr>
</tbody>
</table>
Task | Description
--- | ---

stakeholders about cases. While a case is in progress, agents can send periodic case summaries that describe actions taken, next steps, and other case-related information. When the work on a case has been completed, agents can create a post case review that includes information such as the root cause, mitigation plan, and preventive actions.

Note: Using case types with the case digest feature requires the Customer Service Case Types plugin (com.snc.csm_case_types) and the Case Digests plugin (com.sn_csm_case_digest).

Cases that are created from a selected case type can use Case Action Summaries and Post Case Reviews. To create the mapping that identifies the case type fields that are copied to Post Case Review and Case Action Summary records:

1. Create a configuration for the desired case type. Navigate to Case Digests > Configuration and click New.

2. Create new records in the CSM Table Map table (csm_table_map) to map the Send Case Action Summary and Create Post Case Review UI actions.

The Case Digests related list on the Case Type form shows the case action summaries and post case review configurations for a case type.
<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Up Contextual Search for Case Types</td>
<td>Navigate to <strong>Contextual Search</strong> &gt; <strong>Table Configuration</strong> and create a table configuration record to add contextual search to the case type. In this record, configure the <strong>Table</strong> field as the case type and the <strong>Search Context</strong> field as Case Knowledge Base Search.</td>
</tr>
</tbody>
</table>
| Set Up Agent Workspace for Case Types | To configure Agent Workspace differently for each case type, follow the Agent Workspace Guided Setup. You can configure the following features specific to each case type:  
- Workspace lists  
- Notifications  
- Highlighted values  
- Ribbon settings  
- Form headers  
- Action assignments |
| Set Up Portal View for Case Types | Configure the fields that a customer can see when they view a case on the Customer or Consumer Service Portals. Create a new record to configure the fields for each case type.  
For more information about the Ticket Configuration form, see **Configure the standard ticket page**. |

4. To perform a task, click **Configure**.  
This button opens the page in your instance where the configuration is completed.

**Related information**
- Manage customer service case types  
- Enable the case type single select property  
- Create a configuration for the case type single select option
Configure ribbon settings for case types

Create a new ribbon configuration for a case type or enable ribbon configurations to be inherited by the case type.

Before you begin
Role required: admin

About this task
In the Customer Service Management application, a case type represents the data and processes that are needed to resolve a specific type of customer issue. The system administrator can create a table for a new case type that extends the Case table (sn_customerservice_case). The extended table for the case type inherits most of the functionality of the Case table.

As part of configuring forms, you can configure ribbon settings for case types. The ribbon appears at the top of the form and includes components that display customer and case information, such as Customer 360, Timeline, and Active SLA. Each component has a ribbon setting that stores configuration information about that component.

Case types that are extended from the Case table can display these components in the ribbon on the Case form. For case types, you can do the following:

• Create new ribbon settings for case extensions, or
• Modify existing ribbon settings so that the case extensions inherit the ribbon component behavior.

To create new ribbon settings, see Set up ribbons in workspace.
To modify ribbon component behavior, use the procedure below.

Procedure
1. Navigate to Workspace Experience > Forms > Ribbon Settings.
2. Click the component name in the Ribbon Settings list. For example, click Customer 360.
3. On the Ribbon Setting form for the selected component, enable the Inherit check box.
4. Click Update.
5. Repeat steps 2 to 4 for each component to be displayed in the ribbon.
Configure case management

Configure the Customer Service Management features and components that agents and managers use to create and resolve cases.

About this task

The customer service case is the primary entity of the customer service application. An agent creates a new case to identify a customer's question or issue and to track the activities related to resolving the issue. An agent also uses a case to track all of the communication to and from the customer, including the communication channels being used.

Case activities include any action that is taken to resolve an issue. This can include phone calls or emails, knowledge base research, conversations with subject matter experts, and dispatch requests to field service agents, as well as other activities.

From the Case form, an agent can associate and store the related information, such as the customer's name, phone number, and company; account information; product and asset information; service contract and entitlement details, and any associated service level agreements (SLAs).

Note: These steps may also apply to case type configuration.

To configure case management, use the Customer Service guided setup. The guided setup takes you through the entire setup and configuration process.

Procedure

1. Navigate to Customer Service > Administration > Guided Setup.
2. On the Getting Started page of the guided setup, click Get Started.
3. In the Case Management category, view the list of tasks to configure the feature.

Case Management configuration tasks

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create the Case Form View</td>
<td>The Case form displays detailed information about a customer issue or problem. Create a Case form view to display the desired fields.</td>
</tr>
<tr>
<td>Create SLA Definitions</td>
<td>Customer Service Management uses service level agreements (SLAs) with customer service cases. An SLA can be attached to a service contract, to</td>
</tr>
<tr>
<td>Task</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>a company, and to a product</td>
<td>a company, and to a product and can be configured to start, pause, and stop based on any customer service case attributes.</td>
</tr>
<tr>
<td>can be configured to start,</td>
<td>After creating the necessary SLAs, associate them with customer service cases from the SLAs related list on the Case form.</td>
</tr>
<tr>
<td>pause, and stop based on</td>
<td></td>
</tr>
<tr>
<td>any customer service case</td>
<td></td>
</tr>
<tr>
<td>attributes.</td>
<td></td>
</tr>
<tr>
<td>Case Routing and Assignment</td>
<td>The case routing feature uses matching rules and assignment rules to identify cases that meet certain conditions and then route those cases to customer service agents.</td>
</tr>
<tr>
<td>The case routing feature</td>
<td>Create matching rules to identify cases and then create assignment rules to route cases to agents.</td>
</tr>
<tr>
<td>uses matching rules and</td>
<td></td>
</tr>
<tr>
<td>assignment rules to</td>
<td></td>
</tr>
<tr>
<td>identify cases that meet</td>
<td></td>
</tr>
<tr>
<td>certain conditions and then</td>
<td></td>
</tr>
<tr>
<td>route those cases to</td>
<td></td>
</tr>
<tr>
<td>customer service agents.</td>
<td></td>
</tr>
<tr>
<td>Assignment Workbench</td>
<td>The assignment workbench uses configurable criteria, such as skills and availability, to evaluate the agents in a selected group and provide an overall ranking. Managers can view these results and click one button to assign a task.</td>
</tr>
<tr>
<td>The assignment workbench</td>
<td>To configure the assignment workbench:</td>
</tr>
<tr>
<td>uses configurable criteria,</td>
<td>• Create matching criteria.</td>
</tr>
<tr>
<td>such as skills and availability,</td>
<td></td>
</tr>
<tr>
<td>to evaluate the agents in a</td>
<td>• Create an assignment workbench configuration.</td>
</tr>
<tr>
<td>selected group and provide</td>
<td></td>
</tr>
<tr>
<td>an overall ranking. Managers</td>
<td></td>
</tr>
<tr>
<td>can view these results and</td>
<td></td>
</tr>
<tr>
<td>click one button to assign a</td>
<td></td>
</tr>
<tr>
<td>task.</td>
<td></td>
</tr>
<tr>
<td>Special Handling Notes</td>
<td>Use special handling notes to bring important case information to an agent’s attention. Create a configuration for the Case [sn_customerservice_case] table and then configure the form layout to display the notes in a pop-up window or a related list.</td>
</tr>
<tr>
<td>Escalation Management</td>
<td>Escalating a case or account raises awareness about important customer</td>
</tr>
<tr>
<td>Task</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>creates escalation templates and severity definitions to control the escalation process.</td>
</tr>
<tr>
<td>Major Issue Management</td>
<td>Major issue management enables customer communication for issues that impact a wider audience. Use this feature to proactively identify impacted customers, create cases for these customers, provide information, and manage the resolution process.</td>
</tr>
<tr>
<td>Case Action Status</td>
<td>The case action status feature enables customer service agents to easily identify cases that need attention and quickly prioritize their work. Visual indicators in the Action Status column on the case list highlight case status.</td>
</tr>
<tr>
<td>Auto Close Resolved Cases</td>
<td>Automatically close cases in the Resolved state if customers do not take any action.</td>
</tr>
<tr>
<td>Case Digests</td>
<td>Case digests enable agents to proactively communicate with customers and internal stakeholders about cases.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Summaries: while a case is in progress, agents can send periodic case summaries that describe actions taken, next steps, and other case-related information.</td>
</tr>
<tr>
<td></td>
<td>• Post case reviews: when the work on a case has been completed, agents can create a post case review that includes information such as the root cause, mitigation plan, and preventive actions.</td>
</tr>
</tbody>
</table>
4. To perform a task, click **Configure**.
   
   This button opens the page in your instance where the configuration is completed.

**Configure a Case form view**

The Case form contains detailed information about a customer issue or problem. Configure a Case form view to display the desired fields and related lists.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **Customer Service > Cases > Create New**.
2. Configure the form layout to add the fields you require.
   
   **Note:** If you are using Customer Service Install Base Management and Proactive Customer Service Operations, add the **Sold Product** field.
3. Configure the form layout to add the related lists you require.
   
   **Note:** If you are using Customer Service Install Base Management and Proactive Customer Service Operations, add the **Affected Install Base Items** related list.
4. Click **Submit**.

**Related information**

- Create and delete views

**Add the Internal User field to the Case form**

Add the **Internal user** field to the Case form for the Case view and the Workspace view.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **Customer Service > Administration > Guided Setup** and click **Get Started**.
2. In the Case Management category, click **Get Started**.
3. Click **Add Internal User Field to the Case Form View**.
4. Add the **Internal user** field to the Case form for these views: Case and Workspace.

**Related information**

- **Create and delete views**

**Create SLA definitions for customer service cases**

A service level agreement (SLA) specifies the time within which service must be provided. Configure SLA definitions that include the necessary information to create and progress SLAs for customer service cases.

**Before you begin**

Role required: admin

**About this task**

The Customer Service Management application uses service level agreements with customer service cases. An SLA can be attached to a service contract, to a company, and to a product and can be configured to start, pause, and stop based on any customer service case attributes.

An SLA is automatically associated to a case when the case is created or updated based on the conditions that have been set up in the SLA definition. The specific record that gets attached to a case is the Task SLA record, which tracks the SLAs for that particular case. The Task SLA table [task_sla] stores Task SLA records.

For more information, see **Create an SLA definition**.

**Configure case routing and assignment**

The case routing feature uses matching rules and assignment rules to identify cases that meet certain conditions and then route those cases to customer service agents.

**Before you begin**

Role required: admin

**About this task**

Matching rules are based on two defined sets of conditions: one that identifies specific case attributes and another that identifies the agent resources best suited to handle cases with these attributes.
Assignment rules automatically assign tasks to users and groups when the conditions in a matching rule are met. Create an assignment rule for a matching rule using the Create assignment rule related link on the Matching Rule form.

Procedure
1. Navigate to Customer Service > Administration > Guided Setup.
2. On the Getting Started page of the guided setup, click Get Started.
3. In the Case Management category, view the list of tasks to configure the feature.

Case Routing and Assignment

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create matching rules for case routing</td>
<td>Matching rules are based on two defined sets of conditions, one that identifies specific case attributes and another that identifies the agent resources best suited to handle cases with these attributes.</td>
</tr>
<tr>
<td>Create assignment rules for case routing</td>
<td>Assignment rules automatically assign tasks to users and groups when the conditions in a matching rule are met.</td>
</tr>
</tbody>
</table>

4. To perform a task, click Configure.
   This button opens the page in your instance where the configuration is completed.

Related reference
Routing and assigning customer service cases
Create a matching rule for case routing
Create a matching rule for a customer service case that identifies the case attributes as well as the agent resources.

Before you begin
Role required: admin
Procedure

1. Navigate to Routing and Assignment > Matching Rules.
2. Click New.
3. Fill in the fields on the Matching Rule form.
   This form contains the following sections:
   • Basic rule information
   • Applies to: use this section to create rule conditions
   • Resource: use this section to create agent and agent group conditions

Matching Rule form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the matching rule.</td>
</tr>
<tr>
<td>Execution</td>
<td>The order in which this matching rule is to be executed. Similar to</td>
</tr>
<tr>
<td>order</td>
<td>business rules, matching rules are processed based on execution</td>
</tr>
<tr>
<td></td>
<td>order, from the lowest to the highest.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable this check box to activate the matching rule.</td>
</tr>
<tr>
<td>Applies To</td>
<td>The table that stores the task for which the matching rule is being</td>
</tr>
<tr>
<td></td>
<td>created. The default is the Case [sn_customerservice_case] table.</td>
</tr>
<tr>
<td>Table</td>
<td>Use the buttons in this field to build one or more conditions on the</td>
</tr>
<tr>
<td></td>
<td>selected table. A condition is made up of a selected field, an operator,</td>
</tr>
<tr>
<td></td>
<td>and a value. Add conditions using the AND and OR buttons. Delete conditions</td>
</tr>
<tr>
<td></td>
<td>by clicking the X to the right of a condition.</td>
</tr>
<tr>
<td>Conditions</td>
<td>The type of resource matching method to use for this rule: Simple,</td>
</tr>
<tr>
<td></td>
<td>Advanced, Scripted, Selection Criteria. Select Simple to assign a task to</td>
</tr>
<tr>
<td></td>
<td>a specific user.</td>
</tr>
<tr>
<td></td>
<td>a. Click the lookup icon next to the Resource field.</td>
</tr>
<tr>
<td></td>
<td>b. Select a Table name.</td>
</tr>
<tr>
<td></td>
<td>c. Select a Document from the table.</td>
</tr>
<tr>
<td></td>
<td>d. Click OK.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Select</strong></td>
<td><strong>Advanced</strong> to create a specific set of resource conditions. Then use the condition builder in the Resource field to identify these conditions.</td>
</tr>
<tr>
<td><strong>Select</strong></td>
<td><strong>Scripted</strong> to create a customized script for identifying resources, with the goal of returning a list of users that have the same skills as the task. The task under consideration is set in the context of the script. For example:</td>
</tr>
<tr>
<td>//current has the task record for which the rule is being executed.</td>
<td>var task = current; var skills = task.getValue(&quot;skills&quot;); var skillUtil = new global.SkillsUtils(); var skilledUsers = skillUtil.getAllSkilledUserIds(skills); return skilledUsers;</td>
</tr>
<tr>
<td><strong>Select</strong></td>
<td><strong>Selection Criteria</strong> to create a matching rule for use with the assignment workbench. Create then rule and then add matching criteria using the Select Criteria related list on the Matching Rule form.</td>
</tr>
<tr>
<td><strong>Resource</strong></td>
<td>This field changes depending on the resource matching type selected in the Matching field.</td>
</tr>
<tr>
<td><strong>Schedule based filtering</strong></td>
<td>For <strong>Simple</strong> matching, use this field to select a table and a user. For <strong>Advanced</strong> matching, use the condition builder in this field to build one or more conditions to identify a resource. These conditions can be based on user role, agent group, specific skills, work load, or agent availability.</td>
</tr>
<tr>
<td><strong>Script</strong></td>
<td>For <strong>Scripted</strong> matching, use this field to create a customized script for identifying resources. An example script is included. The expected return from a customized script is an array of resource sys_ids.</td>
</tr>
</tbody>
</table>

**4.** Click **Submit**. The rule appears in the Matching Rules list.  
**5.** Open the newly created rule from the Matching Rules list and add the desired matching criteria.  
**6.** From the Select Criteria related list, click **New**.
7. Select a **Criterion**.
8. In the **Use for** field, specify how you want the matching criterion to be used.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ranking and display</td>
<td>Use the criterion to determine agent ranking and displays it in a column on the workbench.</td>
</tr>
<tr>
<td>Display only</td>
<td>Displays the criterion in a column on the workbench but does not use it to determine agent ranking.</td>
</tr>
<tr>
<td>Ranking only</td>
<td>Uses the criterion to determine agent ranking but does not display it on the workbench.</td>
</tr>
</tbody>
</table>

9. Select a **Ranking Method**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>More is better</td>
<td>For example, more availability is better when determining the agent ranking.</td>
</tr>
<tr>
<td>Less is better</td>
<td>For example, fewer assigned cases are better when determining agent ranking.</td>
</tr>
</tbody>
</table>

10. Click **Submit**.
The criterion appears on the Matching Rule form in the **Select Criteria** related list.

11. **Optional**: From the **Select Criteria** related list, set a **Threshold** for the criterion. A threshold sets a minimum requirement for a criterion. If necessary, personalize the list and add the **Threshold** field.

**Create an assignment rule for case routing**
Create a rule that assigns those cases that meet the matching rule criteria to a customer service agent.

**Before you begin**
Role required: admin
Procedure

1. Open the desired matching rule.

2. Click the **Create assignment rule** related link.
   You can also create an assignment rule by navigating to **Routing and Assignment > Assignment Rule** and clicking **New**.

3. Fill in the fields on the Assignment Rule form.

### Assignment Rule form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the assignment rule.</td>
</tr>
<tr>
<td>Application</td>
<td>The name of the application to which this assignment rule belongs. The default application is <strong>Global</strong>.</td>
</tr>
<tr>
<td>Order</td>
<td>The order in which this assignment rule is executed. Similar to business rules, assignment rules are processed based on execution order, from the lowest to the highest.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable this check box to activate the matching rule. Only active assignment rules take effect.</td>
</tr>
</tbody>
</table>

### Applies To

- **Table**
  
  The table that stores the task for which the assignment rule is being created.
  This list shows only those tables and database views that are in the same scope as the assignment rule. If you select a custom table that extends the task table, you must clear the instance cache by navigating to [https://<instance_name>.service-now.com/cache.do](https://<instance_name>.service-now.com/cache.do) in order for the assignment rule to work.

  **Note:** Clearing the system cache can affect overall performance, and degrade system response times. Do not run cache flushes during business hours, and do not trigger cache flushes automatically.

- **Conditions**
  
  The conditions in which the assignment rule will apply.
  Use the buttons in this field to build one or more conditions on the selected table. A condition is made up of a selected field, an operator, and a value. Add conditions using the **AND** and **OR** buttons. Delete conditions by clicking the **X** to the right of a condition.
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign To</td>
<td>The user to be assigned to the task.</td>
</tr>
<tr>
<td>User</td>
<td>The user to be assigned to the task.</td>
</tr>
<tr>
<td>Group</td>
<td>The assignment group to be assigned to the task.</td>
</tr>
<tr>
<td>Script</td>
<td>A script to determine advanced assignment rule functionality. Scripts provide access to current.variable_pool variables.</td>
</tr>
</tbody>
</table>

4. Click **Update**.

### Related information

- Define assignment rules

### Configure assignment workbench

The assignment workbench uses configurable criteria, such as skills and availability, to evaluate the agents in a selected group and provide an overall ranking. Managers can view these results and click one button to assign a task.

### Before you begin

**Role required:** admin

### About this task

There are three types of matching criteria available for selection:

- Simple match
- Aggregate
- Scripted

After creating matching criteria, create a configuration for the assignment workbench by creating a matching rule of the type **Selection criteria** and selecting the desired matching criteria.

If necessary, set the assignment workbench properties.

### Procedure

1. Navigate to **Customer Service > Administration > Guided Setup**.
2. On the Getting Started page of the guided setup, click **Get Started**
3. In the Case Management category, view the list of tasks to configure the feature.
Configure Assignment Workbench

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create assignment workbench matching criteria</td>
<td>The assignment workbench uses configurable matching criteria, such as skills and availability, to evaluate agents in a selected group and provide an overall ranking. To create matching criteria, select the type and then use the fields related to that type to build the query.</td>
</tr>
<tr>
<td>Create an assignment workbench configuration</td>
<td>After creating matching criteria, create a configuration for the assignment workbench by creating a matching rule of the type Selection criteria and selecting the desired matching criteria.</td>
</tr>
<tr>
<td>Configure assignment workbench properties</td>
<td>Configure the properties related to the assignment workbench display.</td>
</tr>
</tbody>
</table>

4. To perform a task, click **Configure**.

This button opens the page in your instance where the configuration is completed.

**Related information**

- Assignment workbench overview
- Matching criteria for case assignment
- Matching rules for case assignment

**Create assignment workbench matching criteria**

Create one or more matching criteria that can be used in an assignment workbench configuration.

**Before you begin**

Role required: admin

**About this task**

The assignment workbench uses configurable matching criteria, such as skills and availability, to evaluate agents in a selected group and provide an overall ranking. The Matching Criteria [matching_dimension] table stores the individual
criterion that can be added to a matching rule to create an assignment workbench configuration.

**Procedure**

1. Navigate to **Routing and Assignment > Criteria**.
2. Click **New**.
3. Enter a **Name** and a **Description** for the criterion.
4. Select the **Type** of matching criterion.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple Match</td>
<td>Creates a one-to-one match. For example, match the time zone of an agent with the time zone of a task location.</td>
</tr>
<tr>
<td>Aggregate</td>
<td>Takes a simple query as an input and provides aggregate results. The query returns a set of users.</td>
</tr>
<tr>
<td>Scripted</td>
<td>Includes a scripted query which returns a list of users.</td>
</tr>
</tbody>
</table>

5. To create a **Simple Match** criterion, fill in the following fields.

<table>
<thead>
<tr>
<th>Simple match criterion fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applies to</td>
<td>The type of task that this criterion applies to.</td>
</tr>
<tr>
<td>Field</td>
<td>The field from the selected task table that you want to match.</td>
</tr>
<tr>
<td>Resource Table</td>
<td>The table that stores the resource to use for this matching criterion.</td>
</tr>
<tr>
<td>Resource Matching Field</td>
<td>The field from the resource table that you want to match.</td>
</tr>
<tr>
<td>Resource Field</td>
<td>The resource field to be displayed for the task records that match the resource records.</td>
</tr>
</tbody>
</table>

6. To create an **Aggregate** criterion, fill in the following fields.
### Aggregate criterion fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aggregate Table</td>
<td>The type of task that this criterion applies to.</td>
</tr>
<tr>
<td>Aggregate Filter</td>
<td>Use the condition builder to create a query that returns a set of users from the selected task table. For example, create a query that returns customer service cases with the following states: New, Open, Awaiting info.</td>
</tr>
<tr>
<td>Aggregate Field</td>
<td>The field from the selected task table to be displayed for the task records that match the query conditions.</td>
</tr>
</tbody>
</table>

7. To create a **Scripted** criterion, fill in the following fields.

### Scripted criterion fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Script</td>
<td>Create a customized script which returns a list of users. An example script is included. The expected return from a customized script is an array of resource sys_ids.</td>
</tr>
<tr>
<td>Aggregate Field</td>
<td>The field from the selected task table to be displayed for the task records that match the query conditions.</td>
</tr>
</tbody>
</table>

8. **Optional:** Enter a **Display Name**.

9. **Optional:** Enable the **Use Reference** field. If you use a reference field, fill in the following fields.

### Reference fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference Table</td>
<td>The table that stores the referenced information.</td>
</tr>
<tr>
<td>Reference Filter</td>
<td>Add filter conditions to return the desired reference information.</td>
</tr>
<tr>
<td>Reference Field</td>
<td>The field from the selected reference table to be displayed for the records that match the filter conditions.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>UI Filter</td>
<td>The label for this field that appears on the assignment workbench</td>
</tr>
<tr>
<td>Label</td>
<td></td>
</tr>
</tbody>
</table>

10. Click **Submit**.

**Related information**

**Matching criteria for case assignment**

**Create an assignment workbench configuration**

Use a matching rule to create a configuration for the assignment workbench.

**Before you begin**

Role required: admin

**About this task**

The assignment workbench configuration is stored in a matching rule that is based on the **Selection criteria** matching type. The default configuration uses the **Recommendation for Case Assignment** matching rule, which includes three of the four default matching criteria:

- Availability Today
- Matching Skills
- Assigned Cases

You can modify or create matching criteria and then modify the **Recommendation for Case Assignment** matching rule as needed or you can create your own configuration.

**Procedure**

1. Navigate to **Routing and Assignment > Matching Rules** to access the Matching Rules list.
2. Click **New**.
3. Enter a **Name** for the matching rule.
4. If desired, enter an **Execution Order** for the matching rule.
   This is the order in which this matching rule is to be executed. Similar to business rules, matching rules are processed based on execution order, from the lowest to the highest.
5. In the **Applies To** tab, select the **Table** that stores the task for which the matching rule is being created.
6. Use the **Conditions** field to build one or more conditions on the selected table. A condition is made up of a selected field, an operator, and a value. Add conditions using the **AND** and **OR** buttons. Delete conditions by clicking the **X** to the right of a condition.

7. In the **Resource** tab, select **Selection Criteria** in the **Matching** field.

8. Click **Submit**.

9. From the Matching Rules list, open the matching rule that you just created.

10. In the **Select Criteria** related list, click **New**. This opens the Select Criterion form.

11. Select a **Criterion** from the Matching Criteria list.

12. Select how the criterion is to be used in the **Use for** field.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ranking and Display</strong></td>
<td>Uses the criterion to determine agent ranking and displays it in a column on the workbench.</td>
</tr>
<tr>
<td><strong>Display Only</strong></td>
<td>Displays the criterion in a column on the workbench but does not use it to determine agent ranking.</td>
</tr>
<tr>
<td><strong>Ranking and No Display</strong></td>
<td>Uses the criterion to determine agent ranking but does not display it on the workbench.</td>
</tr>
</tbody>
</table>

13. Select a **Ranking Method**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>More is better</strong></td>
<td>A higher value is better. For example, more availability is better when determining the agent ranking.</td>
</tr>
<tr>
<td><strong>Less is better</strong></td>
<td>A lower value is better. For example, fewer cases are better when determining the agent ranking.</td>
</tr>
</tbody>
</table>

14. Click **Submit**.

15. Repeat steps 10 through 14 for each criterion to add to the matching rule.

16. If desired, change the weight of a criterion by double-clicking the **Weight** field in the **Select Criteria** related list and entering a new weight.
Each matching criterion has an assigned weight. By default, the matching criteria in the Recommendation for Case Assignment matching rule have an assigned weight of 10. You can assign a higher weight to the criteria that are more important.

17. If desired, set the threshold for a criterion by double-clicking the Threshold field in the Select Criteria related list and entering a threshold number. A threshold sets a minimum requirement for a criterion. It may be necessary to personalize the list and add the Threshold column.

18. If desired, set a criterion active or inactive by double-clicking the Active field in the Select Criteria related list and selecting true or false. Changing this setting has an immediate impact on the agent ranking. It may be necessary to personalize the list and add the Active column.

Configure assignment workbench properties
Configure the properties related to the assignment workbench display.

Before you begin
Role required: admin

Procedure
1. Navigate to Routing and Assignment > Properties.
2. Set the following properties, as needed.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title for the macro button</td>
<td>Creates the title for the macro button on the task form. The default is Find Agents.</td>
</tr>
<tr>
<td>[assignment_workbench.find.agents.title]</td>
<td></td>
</tr>
<tr>
<td>When enabled opens the assignment workbench in a new window</td>
<td>Opens the assignment workbench in a new window. The default is False.</td>
</tr>
<tr>
<td>[assignment_workbench.new.window]</td>
<td></td>
</tr>
<tr>
<td>Number of agents per page</td>
<td>Set this property to 20, 30, or 50 agents. To get better performance, do not use more than 50 agents per page. The default is 30.</td>
</tr>
<tr>
<td>[assignment_workbench_no_of_agents]</td>
<td></td>
</tr>
</tbody>
</table>

3. Click Save.
Configure special handling notes

Use special handling notes to bring important case information to an agent’s attention.

Before you begin
Role required: admin

About this task
Configure the desired entity tables to use special handling notes and then configure the corresponding forms to display either the Special Handling Notes list or pop-up window.

Procedure
1. Navigate to Customer Service > Administration > Guided Setup.
2. On the Getting Started page of the guided setup, click Get Started.
3. In the Case Management category, view the list of tasks to configure the feature.

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure an entity table to use special handling notes</td>
<td>Configuring an entity to use special handling notes adds the Create Special Handling Notes related link to the corresponding form.</td>
</tr>
<tr>
<td>Configure a form to show special handling notes in a list or pop-up window</td>
<td>Configure a form to display special handling notes in either a list or a pop-up window.</td>
</tr>
<tr>
<td>Configure the necessary properties to display special handling notes</td>
<td>Configure properties that determine the frequency and the number of special handling notes that are displayed.</td>
</tr>
</tbody>
</table>

4. To perform a task, click Configure.
   This button opens the page in your instance where the configuration is completed.

Related information

Special handling notes overview
Configure an entity table to use special handling notes

Configure an entity table to use special handling notes.

**Before you begin**
Role required: sn_shn.admin

**About this task**
Configuring an entity to use special handling notes adds the Create Special Handling Notes related link to the corresponding form.

**Procedure**
1. Navigate to Special Handling Notes > Configuration.
2. Click New.
3. Select a table in the Table name field.
4. If desired, select one or more Related Fields.
   You can also display notes from related entities by including those fields in the configuration. For example, you can display notes for the account and contact associated with a customer service case by selecting the Account and Contact fields on the Case form.
5. Click Submit.
   The configuration is added to the Special Handling Configuration list.

Configure a form to show special handling notes

Display special handling notes on a form in a list or pop-up window.

**Before you begin**
Role required: sn_shn.admin

**Procedure**
1. Navigate to a form.
2. Right-click the form header and select Configure > Form Layout.
3. Select one of the following from the Available column and move it to the Selected column.
   - Special Handling Notes List
   - Special Handling Notes Pop Up
4. Click Save.
Configure special handling notes properties

Configure the necessary properties to display special handling notes.

**Before you begin**
Role required: sn_shn.admin

**About this task**

**Procedure**

1. Navigate to Special Handling Notes > Properties.
2. Configure the following properties.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display special handling notes only once per session</td>
<td>Special handling notes are displayed each time you access a record. Enable this property to display special handling notes only once per session.</td>
</tr>
<tr>
<td>Maximum number of notes displayed in the Special Handling Notes pop-up window</td>
<td>Increase or decrease this number as desired. The default is 20 alerts.</td>
</tr>
<tr>
<td>Width of the Special Handling Notes pop-up window in pixels</td>
<td>The width of the pop-up window in pixels. The default width is 500. If you specify less than 300, the window automatically uses the default width.</td>
</tr>
</tbody>
</table>

3. Click Save.

Configure escalation management

Escalating a case or account raises awareness about important customer issues, facilitates communication, and enables users to track progress toward a resolution.

**Before you begin**
Role required: admin

**About this task**
An escalation provides increased attention to a customer issue and provides a way to track the progress made in resolving the issue. Create escalation templates and severity definitions to control the escalation process.
Procedure

1. Navigate to Customer Service > Administration > Guided Setup.
2. On the Getting Started page of the guided setup, click Get Started.
3. In the Case Management category, view the list of tasks to configure the feature.

<table>
<thead>
<tr>
<th>Escalation Management</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task</td>
</tr>
<tr>
<td>------------------------</td>
</tr>
<tr>
<td>Create escalation templates</td>
</tr>
<tr>
<td>Create escalation severity definitions</td>
</tr>
</tbody>
</table>

4. To perform a task, click Configure.

   This button opens the page in your instance where the configuration is completed.

Related information

Case and account escalation

Create a case or account escalation template

Create a template for each type of case or account escalation.

Before you begin

Role required: admin

About this task

An escalation template determines how an escalation request is processed and includes the type of escalation (case or account); an approval list or workflow (if approval is required), and an escalation watch list.
Procedure
2. Click New.
3. Fill in the fields on the Escalation Template form, as needed.

### Escalation Template form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the escalation template.</td>
</tr>
<tr>
<td>Skip Escalation Approval</td>
<td>Enable this check box to skip the need for approval. If skipped, escalations are automatically approved.</td>
</tr>
<tr>
<td>Use Default Approval Workflow</td>
<td>Enable this check box to use the default approval workflow (Escalation - Approval) provided with the escalation feature. If using the default approval workflow, select an Approval Group.</td>
</tr>
<tr>
<td>Add Case Assignment Group Manager to Approvers</td>
<td>For case escalation, enable this check box to add the manager of the case assignment group to the list of approvers.</td>
</tr>
</tbody>
</table>
| Approval Group | If the Use Default Approval Workflow check box is enabled:  
  • For the Case Escalation type, you can select an additional approval group.  
  • For the Account Escalation type, you must select an approval group.  
  
  ! **Note:** If there are no approvers, escalation requests are automatically approved. |
| Escalation Approval Workflow | The workflow used to approve escalation requests. Use the default Escalation-Approval workflow or select a different workflow. |
| Type | The type of escalation:  
  • Case Escalation  
  • Account Escalation |
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Escalation Watch List</td>
<td>Add users to the escalation template watch list. These users receive notifications for all escalations that use this escalation template. For an account escalation, the account team is automatically added to the watch list.</td>
</tr>
</tbody>
</table>

**Note:** Users can also be added to the watch list on the escalation record.

4. Click **Submit**.

## Create a case or account escalation severity

The escalation severity defines the type of escalation and the color used to represent the cases and accounts of this escalation severity in the user interface.

**Before you begin**

Role required: admin

**About this task**

The assigned severity allows agents to easily identify escalated cases and accounts on lists and forms. The escalation feature provides two escalation severity definitions:

- **High Severity**: escalated records are highlighted in red.
- **Medium Severity**: escalated records are highlighted in orange.

The user interface determines which fields are highlighted for escalated cases and accounts:

- **Agent Workspace**: Field indicators and field highlights appear on the **Short description** field for escalated cases and on the **Name** field for escalated accounts.

  **Note:** You can move indicators and highlights to any field that is not a hyperlinked field.

- **Platform interface**: Escalated case and account numbers are indicated with a colored dot on a list and a colored background on a form.

**Procedure**

1. Navigate to **Customer Service > Escalation Severity**.
2. Click **New**.
3. Enter a **Name** for the severity.

4. In the **Style** field, enter a color.
   To configure additional escalation severity records, the system administrator must configure a new style with the desired color. For more information, see Highlight list fields.

5. Click **Submit**.

**Configure major issue management**

Major issue management enables customer communication for issues that impact a wider audience. Use this feature to proactively identify impacted customers, provide information to these customers, and manage the resolution process.

**Before you begin**

Role required: admin

**About this task**

This feature enables you to efficiently manage the communication and resolution process for issues that impact multiple customers. With major issue management, you can identify impacted customers who have not yet reported an issue and proactively create cases for these customers.

**Procedure**

1. Navigate to **Customer Service > Administration > Guided Setup**.
2. On the Getting Started page of the guided setup, click **Get Started**
3. In the Case Management category, view the list of tasks to configure the feature.

### Major Issue Management

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate Major Issue Management</td>
<td>Activate the Major Issue Management (com.sn_majorissue_mgt) plugin.</td>
</tr>
<tr>
<td>Configure Customer Service Properties</td>
<td>Enable a system property to synchronize data between parent and child cases.</td>
</tr>
</tbody>
</table>
4. To perform a task, click **Configure**.
   This button opens the page in your instance where the configuration is completed.

**Related information**

**Major issue management overview**

**Activate Major Issue Management**

Activate the Major Issue Management plugin to use the major issue management feature.

**Before you begin**

Role required: admin

**About this task**

This plugin requires:

- Customer Service [com.sn_customerservice]
- Targeted Communications [com.sn_publications]
- Task Communications Management [com.snc.task_communication_management]

Major issue management uses the Targeted Communications recipients lists feature to identify impacted customers.

⚠️ **Note:** If you have installed the Proactive Customer Service Operations plugin, the Major Issue Management plugin is activated by default.

**Procedure**

1. Navigate to **System Definition > Plugins**.
2. Search for the plugin com.sn_majorissue_mgt.
3. Click **Activate**.

**Configure case synchronization**

Configure the major issue management system properties to enable synchronization between major cases and associated child cases.

**Before you begin**

Role required: admin
Procedure
1. Navigate to Customer Service > Administration > Properties.
2. Enable the Synchronize fields from parent to child case property.
3. In the Comma separated list of fields that synchronize from parent to child cases property, add a comma-separated list of fields that synchronize from the major case to each of the associated child cases.
4. Optional: The Processes SLA asynchronously during parent to child case creation and synchronization property is enabled by default. Set this property to false to process the SLA synchronously.
5. Click Save.

Configure case action status
The case action status feature enables customer service agents to easily identify cases that need attention and quickly prioritize their work.

Before you begin
Role required: admin

About this task
Visual indicators in the Action Status column on the case list highlight case status:

- A blue indicator highlights cases that require attention, such as cases that have been updated by customers or internal users and are waiting for input or review.
- A red indicator highlights cases that are blocked, such as cases that have open related task records or are waiting for customer feedback.

Procedure
1. Navigate to Customer Service > Administration > Guided Setup.
2. On the Getting Started page of the guided setup, click Get Started
3. In the Case Management category, view the list of tasks to configure the feature.

Case Action Status

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate Case Action Status</td>
<td>Activate the Case Action Status plugin (com.snc.csm_action_status)</td>
</tr>
<tr>
<td>Task</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Configure actionable case flows</td>
<td>Enable or disable the actionable case flows that are provided with the Case Action Status plugin.</td>
</tr>
</tbody>
</table>

4. To perform a task, click **Configure**.

This button opens the page in your instance where the configuration is completed.

**Related information**
- Case action status overview

**Activate Case Action Status**

Activate the Case Action Status plugin to use the case action status feature.

**Before you begin**
Role required: admin

**About this task**
Case action status provides a Customer Service-specific application of the Action Status Automation feature, which tracks blocking tasks created for customer service cases and updates the action status indicators.

**Procedure**

1. Navigate to **System Definition > Plugins**.
2. Search for the plugin com.snc.csm_action_status.
3. Click **Activate**.

**Configure actionable case flows**
The Case Action Status plugin provides several actionable case flows that create and resolve blocking tasks for different case-related actions.

**Before you begin**
Role required: admin

**About this task**
These case flows are enabled by default. If you do not want to create blocking tasks for a specific action, disable the associated flow.
Note: The Case Action Status plugin provides case flows that create and resolve blocking tasks for problems associated with cases. To get complete functionality, you must also activate the Customer Service with Service Management plugin (com.sn_cs_sm). For more information, see Integrate with Service Management.

Procedure
1. Navigate to Customer Service > Administration > Actionable Case Flows.
2. Review the list of case flows.
3. Set the Active field to false for the desired case flows.

Related reference
Actionable case flows

Configure auto close resolved cases
Use the auto close resolved cases feature to automatically close cases in the Resolved state if customers do not take any action.

Before you begin
Role required: admin

About this task
Enable this feature by activating the Auto Close Resolved Cases Flow Designer flow. You can also create a configuration that enables both the system and agents to exclude cases from auto closure.

Procedure
1. Navigate to Customer Service > Administration > Guided Setup.
2. On the Getting Started page of the guided setup, click Get Started.
3. In the Case Management category, view the list of tasks to configure the feature.

Auto Close Resolved Cases

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate Auto Close Resolved Case Flow</td>
<td>Activate the Auto Close Resolved Cases Flow Designer Flow, which identifies cases in the Resolved state that are waiting for a customer</td>
</tr>
<tr>
<td>Task</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>response and takes the following actions:</td>
</tr>
<tr>
<td></td>
<td>• Sends a reminder notification to the customer after 5 days with no response that the case is pending solution acceptance.</td>
</tr>
<tr>
<td></td>
<td>• Closes the case and sends a reminder notification to the customer after 10 days that the case has been auto closed.</td>
</tr>
<tr>
<td>Configure Business Rules for Auto Close Field</td>
<td>Configure the following business rules to enable or disable the <strong>Auto Close</strong> field on the Case form:</td>
</tr>
<tr>
<td>Configure Auto Close Flag</td>
<td>The <strong>Auto Close Resolved Cases</strong> Flow Designer flow uses the <strong>Auto Close</strong> flag to exclude cases from auto closure. This flag is hidden by default. To use this flag, configure the Case form to display the <strong>Auto Close</strong> field.</td>
</tr>
</tbody>
</table>

4. To perform a task, click **Configure**.  
   This button opens the page in your instance where the configuration is completed.

**Related information**

**Automatically close customer service cases**

**Configure case digests**

The case digests feature enables you to provide periodic updates and resolution information about high priority customer service cases to customers and internal stakeholders.

**Before you begin**

Role required: admin

**About this task**

The case digests feature includes two types of case communication:
• **Case action summary**: while a case is in progress, agents can send periodic case updates that describe actions taken, next steps, and other case-related information.

• **Post case review**: when the work on a case has been completed, agents can a post case review document that captures details about the issue, such as the root cause, mitigation plan, and preventive actions.

**Procedure**
1. Navigate to **Customer Service > Administration > Guided Setup**.
2. On the Getting Started page of the guided setup, click **Get Started**
3. In the Case Management category, view the list of tasks to configure the feature.

<table>
<thead>
<tr>
<th>Case Digests</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Task</strong></td>
</tr>
<tr>
<td>Activate Case Digests</td>
</tr>
</tbody>
</table>
| Create Assignment Rules | Assignment rules automatically assign tasks to users and groups when the rule conditions are met. Two rules are provided with the case digests feature that assign the post case review and case action summary records to the case agent:  
  • Auto assign the CAS to case agent  
  • Auto assign the PCR to case agent  
  For more information, see Case action summary and post case review assignment rules. |
<p>| Create Approval Workflows | The case digests feature includes one approval workflow that triggers the approval process for post case reviews. This workflow provides a one-step process that obtains a list of approvers from the Approval group and Approval users fields on the Post Case Review form. |</p>
<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Document Templates</td>
<td>Document templates identify, organize, and format the content from the case digest record that is included in generated documents. Two document templates are provided with the case digests feature, one for post case reviews and one for case action summaries.</td>
</tr>
<tr>
<td>Create a Case Digest Configuration</td>
<td>Case digest configurations handle different types of case review processes based on business needs.</td>
</tr>
<tr>
<td>Create Mapping for Case Types</td>
<td>Create the mapping that identifies the case type fields that are copied to post case reviews and case action summaries.</td>
</tr>
</tbody>
</table>

4. To perform a task, click **Configure**.

This button opens the page in your instance where the configuration is completed.

**Related information**

Customer Service case digests

**Activate Case Digests**

Activate the Case Digests plugin to use the case digests feature.

**Before you begin**

Role required: admin

**About this task**

The Case Digests plugin automatically activates the following plugins:

- Customer Service (com.sn_customerservice)
- Customer Service Document Template (com.sn_csm_doc_template)
- ServiceNow Document Viewer (com.snc.documentviewer)
- Targeted Communications (com.sn_publications)

The Case Digests feature uses the recipient lists feature from the Targeted Communications plugin (sn_publications).
When creating a case action summary record, users with the sn_esm_agent role can select a recipient list of the type Internal Users. Selecting the **Publish to Case & Notify** UI action on the Case Action Summary form sends an email notification to the users included in the selected recipient list.

> **Note:** The **Publish to Case & Notify** UI action is available when a list has been selected in the **Additional internal recipients** field.

For more information, see [Recipient lists](recipient_lists).

**Procedure**

1. Navigate to **System Definition > Plugins**.
2. Search for the plugin `com.sn_csm_case_digest`.
3. Click **Activate**.

**Create a document template**

Create a template to use for generating case action summaries or post case review documents.

**Before you begin**

Role required: admin

**About this task**

Document templates identify the information to be included in case action summaries and post case review documents. Create a document template to select, organize, and format the content included in the generated documents. You can create a new template or modify an existing template. Two document templates, **CAS Template** and **PCR Template**, are included with the Case Digests plugin.

**Procedure**

1. Navigate to **Case Digest > Administration > Document Templates**.
2. Click **New** to create a template.
   
   You can also modify an existing template by clicking the template name and opening the template form.

3. Fill in the following fields on the CS Document Template form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The template name.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Table Name</td>
<td>The table that contains the fields to include in the document template.</td>
</tr>
<tr>
<td></td>
<td>• Case Action Summary [sn_csm_case_digest_cas]</td>
</tr>
<tr>
<td></td>
<td>• Post Case Review [sn_csm_case_digest_pcr]</td>
</tr>
<tr>
<td>Header Image</td>
<td>Click to add an image file to use in the document header.</td>
</tr>
<tr>
<td>Footer Text</td>
<td>Text to include in the document footer.</td>
</tr>
<tr>
<td>Header Position</td>
<td>The position of the image within the header:</td>
</tr>
<tr>
<td></td>
<td>• Left</td>
</tr>
<tr>
<td></td>
<td>• Center</td>
</tr>
<tr>
<td></td>
<td>• Right</td>
</tr>
<tr>
<td>Body</td>
<td>The content to include in the generated case action summary or post case review document.</td>
</tr>
<tr>
<td></td>
<td>Add content by selecting fields from the table identified in the <strong>Table Name</strong> field. Selected fields are added to the text editor.</td>
</tr>
<tr>
<td>Internal content</td>
<td>The content in the case action summary that is for internal users only.</td>
</tr>
<tr>
<td></td>
<td>This field is available if the Case Action Summary table is selected in the <strong>Table name</strong> field.</td>
</tr>
</tbody>
</table>

4. Click **Submit** or **Update**.

**Create a case digest configuration**

Create case digest configurations to handle different types of case review processes.

**Before you begin**

Role required: admin
About this task
As part of creating a case digest configuration, you can define the specific information from a customer service case that needs to be captured as part of the review. Two configurations are included with the Case Digests plugin:

- CAS Configuration
- PCR Configuration

Procedure
1. Navigate to Case Digest > Administration > Configuration.
2. Click New to create a new configuration.
   You can also modify an existing configuration by clicking the configuration name and opening the configuration form.
3. Fill in the following fields on the Case Digest Configuration form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The configuration name.</td>
</tr>
</tbody>
</table>
| Table name       | The table that contains the fields to include in the configuration.
|                  | • Case Action Summary [sn_csm_case_digest_cas] |
|                  | • Post Case Review [sn_csm_case_digest_pcr] |
| Order            | Determine the order for the configuration. When multiple configurations match for a case, the configuration with the lowest order number is used. |
| Document template| Select a template to use when creating a case action summary from the Case Action Summary form or a post case review document from the Post Case Review form. You can select from a list of templates that have been defined for the table selected in the **Table name** field. |
Create a case digest table map

Create a table map to configure the fields that are copied from the case record to the post case review or the case action summary records.

Before you begin
Role required: admin

About this task
Two table maps are included with the Case Digests plugin. The **PCR Map** uses the Case (sn_customerservice_case) table as the source table and the Post Case Review (sn_csm_case_digest_pcr) table as the target table. The **PCR Map** maps the following fields.

<table>
<thead>
<tr>
<th>Case field</th>
<th>Post Case Review field</th>
</tr>
</thead>
<tbody>
<tr>
<td>sys_id</td>
<td>Case number</td>
</tr>
<tr>
<td>Short description</td>
<td>Short description</td>
</tr>
<tr>
<td>Cause</td>
<td>Root Cause Analysis</td>
</tr>
<tr>
<td>Close notes</td>
<td>Solution provided</td>
</tr>
</tbody>
</table>

The **CAS Map** uses the Case (sn_customerservice_case) table as the source table and the Case Action Summary (sn_csm_case_digest_cas) table as the target table. The **CAS Map** maps the following fields.

4. Click **Submit** or **Update**.
Procedure

1. To access the CSM Table Map list, navigate to `csm_table_map_list.do`.

2. Click **New** to create a new table map.
   You can also modify an existing table map by clicking the map name to open the map form.

3. Fill in the following fields on the CSM Table Map form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mapping name</td>
<td>The table map name.</td>
</tr>
<tr>
<td>Application</td>
<td>Read only. The application for this table map.</td>
</tr>
<tr>
<td>API Name</td>
<td>Read only. The API for this table map.</td>
</tr>
<tr>
<td>Advanced Field Mapping</td>
<td>Enables advanced field mapping.</td>
</tr>
<tr>
<td>Source Table</td>
<td>The source table for the map.</td>
</tr>
<tr>
<td>Target Table</td>
<td>The target table for the map.</td>
</tr>
<tr>
<td>Active</td>
<td>Enables the mapping from the source to the target tables.</td>
</tr>
<tr>
<td>Use Advanced Condition</td>
<td>Enables advanced condition mapping, which uses a script.</td>
</tr>
<tr>
<td></td>
<td>If enabled, add a script in the <strong>Advanced Condition</strong> field.</td>
</tr>
<tr>
<td>Advanced Condition</td>
<td>The script to use if the <strong>Use Advanced Condition</strong> field is enabled.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Use the condition builder to select the conditions that apply to the table map.</td>
</tr>
<tr>
<td>Order</td>
<td>Order of priority for processing multiple matching map definitions</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>simultaneously to resolve dependencies.</td>
</tr>
<tr>
<td></td>
<td>• If there is only one matching table map, the system uses that map.</td>
</tr>
<tr>
<td></td>
<td>• If there are multiple matching table maps with the same order, the system uses the map with the older created date.</td>
</tr>
<tr>
<td></td>
<td>• If there are multiple matching table maps with different orders, the system uses the map with the highest order.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

5. From the CSM Table Map list, select the table map created in step 2.

6. In the Basic Field Mapping form section, click **New**.

7. Select a **Source Field** and a **Target Field**.

8. Enable the **Active** check box.

9. Enter a number in the **Order** field

10. Click **Submit**.

11. Repeat steps 7 through 10 for each field to be mapped.

12. Click **Update** on the CSM Table Map form.

---

**Create a table map for case types**

Create table maps to configure the case type fields that are copied from a case record to the post case review or the case action summary records.

**Before you begin**

Role required: admin

**About this task**

Case Type tables extend from the Case table but do not inherit the table mappings.
Procedure

1. Access the CSM Table Map list by navigating to `csm_table_map_list.do`.

2. Create two new table map records in the Case Digest scope, one for the post case review mapping and one for the case action summary mapping.

3. In the first record:
   a. Select the desired Case Type table in the **Source Table** field.
   b. Select the Post Case Review (sn_csm_case_digest_pcr) table in the **Target Table** field.
   c. Click **Submit**.

4. In the second record:
   a. Select the desired Case Type table in the **Source Table** field.
   b. Select the Case Action Summary (sn_csm_case_digest_cas) table in the **Target Table** field.
   c. Click **Submit**.

5. For the two new case type table map records, map the fields from the source table to the target table in the Basic Field Mapping form section. For details, see Create a case digest table map.

6. Click **Update**.

Configure Proactive Customer Service Operations

Configure various aspects of Proactive Customer Service Operations based on the specific requirements of your organization.

About this task

There are a sequence of tasks that enable you to configure Proactive Customer Service Operations. You can perform these tasks based on which plugin or application you have installed. This is noted at the top of each task.

**Note:** To use integration with Event Management, install the Proactive Customer Service Operations with Event Management plugin and the Event Management application from the ServiceNow store.

Event Management integration is only available if you are using the CSM Agent Workspace or the Now Platform interface.

To configure Proactive Customer Service Operations, use the Customer Service guided setup. The guided setup takes you through the entire setup and configuration process.
Procedure

1. Navigate to **Customer Service > Administration > Guided Setup**.
2. On the Getting Started page of the guided setup, click **Get Started**
3. In the Proactive Customer Service Operations category, view the list of tasks to configure the feature.

### Proactive Customer Service Operations configuration tasks

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install the Event Management application.</td>
<td>Install the Event Management application from the ServiceNow store.</td>
</tr>
<tr>
<td>Configure form views</td>
<td>Configure the form layout and related lists for the different views of the Case, Install Base Item, and Account forms to display the fields you require.</td>
</tr>
<tr>
<td>Activate an alert rule to automatically create a proactive case from an alert</td>
<td>Configure an alert rule to automatically create a proactive case when an incident is created from an alert that has one or more affected install base items.</td>
</tr>
<tr>
<td>Note: This task is only applicable if you are using the integration with Event Management.</td>
<td></td>
</tr>
<tr>
<td>Configure proactive case flows</td>
<td>Automate workflows for proactive case creation to improve your</td>
</tr>
<tr>
<td>Task</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>operational efficiency and respond to customer issues faster.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This task is only applicable if you are using the integration with Event Management.</td>
</tr>
</tbody>
</table>

4. To perform a task, click **Configure**.

This button opens the page in your instance where the configuration is completed.

**Related information**

- Using Proactive Customer Service Operations
- View install base information from the Customer Service Portal
- Create a case for install base from the Customer Service homepage
- View install base information in CSM workspaces
- View sold product information in CSM workspaces

**Activate Proactive Customer Service Operations**

Activate the Proactive Customer Service plugin to use Proactive Customer Service Operations.

**Before you begin**

Role required: admin

**About this task**

Proactive Customer Service Operations is only available for customers who are licensed for the Customer Service Management application.

To activate Proactive Customer Service Operations, activate the Proactive Customer Service Operations Management plugin (com.snc.proactive_cs_ops). This plugin is not active by default.

Procedure
1. Navigate to System Definition > Plugins.
2. Search for the plugin com.snc.proactive_cs_ops.
3. Click Activate.

Activate Proactive Customer Service Operations with Event Management

Before you begin
Role required: admin

About this task
Proactive Customer Service Operations with Event Management is only available for customers who are licensed for the Customer Service Management application.

To activate Proactive Customer Service Operations with Event Management, activate the Proactive Customer Service with Event Management plugin (com.snc.proactive_cs_itom). This plugin is not active by default.

Activating this plugin also activates the Proactive Customer Service Operations (com.snc.proactive_cs_ops) and Event Management (com.glideapp.itom.snac) plugins.

Procedure
1. Navigate to System Definition > Plugins.
2. Search for the plugin com.snc.proactive_cs_itom.
3. Click Activate.

Configure form views for Proactive Customer Service Operations
Configure the form layout and related lists for the different views of the Case, Install Base Item, and Account forms to display the fields you require.

Before you begin
Certain fields on the forms can only be added if you have activated the Proactive Customer Service Operations with Event Management plugin. This is noted in the following table.
Role required: admin
Procedure

2. Add the following fields to forms and related lists, as required.

Configure form views

<table>
<thead>
<tr>
<th>Form</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case</td>
<td>a. Click Cases &gt; Proactive.</td>
</tr>
<tr>
<td></td>
<td>b. Add the Proactive field to the Proactive Case and Workspace view, and other views as required:</td>
</tr>
<tr>
<td></td>
<td>• Proactive</td>
</tr>
<tr>
<td></td>
<td>• Alert</td>
</tr>
<tr>
<td></td>
<td>• Note: The Alert field is only available if you have activated the Proactive Customer Service Operations with Event Management plugin.</td>
</tr>
<tr>
<td></td>
<td>c. Note: This only applies if you have activated the Proactive Customer Service Operations with Event Management plugin.</td>
</tr>
<tr>
<td></td>
<td>Add the following fields to the Affected Install Base Items related list, Proactive Case and Workspace view, and other views as required.</td>
</tr>
<tr>
<td></td>
<td>• Health Status</td>
</tr>
<tr>
<td></td>
<td>• Health Status Last Updated</td>
</tr>
<tr>
<td>Account</td>
<td>a. Click Customer &gt; Accounts.</td>
</tr>
<tr>
<td></td>
<td>b. Add the following fields to the Install Base Items related list for the Case and Workspace views, and other views as required.</td>
</tr>
<tr>
<td></td>
<td>• Note: This only applies if you have activated the Proactive Customer Service Operations with Event Management plugin.</td>
</tr>
</tbody>
</table>
### Health Status

- **Health Last Updated**

<table>
<thead>
<tr>
<th>Install Base Item</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Note:</strong> This only applies if you have activated the Proactive Customer Service Operations with Event Management plugin.</td>
</tr>
<tr>
<td></td>
<td>a. Click <strong>Products</strong> &gt; <strong>Install Base Items</strong>.</td>
</tr>
<tr>
<td></td>
<td>b. Add the <strong>Service Context</strong> field to the <strong>Default</strong> and <strong>Workspace</strong> views.</td>
</tr>
</tbody>
</table>

### Activate an alert rule to automatically create a proactive case from an alert

Configure an alert rule to automatically create a proactive case when an incident is created from an alert that has one or more affected install base items.

#### Before you begin
- **Role required:** evt_mgmt_admin

#### About this task
- **Note:** This task is only applicable if you are using the integration with Event Management.

#### Procedure

1. Navigate to **Event Management** > **Rules** > **Alert Management**.
2. Click **Create Proactive Case**.
3. Select the **Active** check box.
4. Click **Update**.
   - When an incident is created from an alert that contains affected install base items, a case is automatically created. The case number is added to the **Case** field on the Alert form.

### Configure proactive case flows

Automate workflows for proactive case creation to improve your operational efficiency and respond to customer issues faster.

#### Before you begin
- **Role required:** admin
About this task

Note: This task is only applicable if you are using the integration with Event Management.

Configure the flow designer to automate the next steps in processing a proactive case. You can automate that a proactive case is proposed to a major case or is directly promoted to a major case. If promoted directly to a major case, child cases are automatically created when multiple customers are impacted.

If a single account is affected, you can also automate that an account and primary contact are associated to a case.

Procedure

1. Navigate to Customer Service > Administration > Proactive Case Flows.
2. Click the Process Proactive Cases Created from Alerts flow.
3. Click the Process Proactive Cases for Single and Multiple Accounts subflow.
4. In the Major Case Status field, set the initial status of the major case for multiple accounts.
   By default, this field is set to None. Based on your selection, the proactive case is either Proposed, Accepted, or None. If you set the status to Accepted, child cases are created automatically.
5. In the Affected Account Threshold field, enter the number of affected accounts required for a proactive case to be eligible for major case processing.
   The default is two.
6. Select the Process Case for Single Account check box to associate an account and primary contact to the case if a single account is affected.
   This also applies if multiple install base items from the same account are affected.
7. Click Done.

Configure Skills Management

Manage skill data in a central location for customer service agents and work items.

Before you begin
Role required: admin
About this task
To configure skills management, use the Customer Service guided setup. The guided setup takes you through the entire setup and configuration process.

Procedure
1. Navigate to Customer Service > Administration > Guided Setup.
2. On the Getting Started page of the guided setup, click Get Started.
3. In the Skills Management category, view the list of tasks to configure the feature.

Skills Management configuration tasks

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage skills</td>
<td>Organize skills data of agents and work items in a centralized location.</td>
</tr>
<tr>
<td>Assign skills to work items</td>
<td>Create rules to identify skills and automatically associate them with work items.</td>
</tr>
<tr>
<td>Assign skills to customer service agents</td>
<td>Identify skills each agent has to work on tasks and assign it to the agent.</td>
</tr>
</tbody>
</table>

Mandatory skills
Mandatory skills are skills that are required for agents and technicians to work on customer service cases and field service work orders and tasks. You can identify these skills, and then assign cases and tasks to agents and technicians who have those required skills.

Not every case has mandatory skills. For a given case, the mandatory skills are listed in Mandatory Skills Added list on the assignment workbench.

When assigning cases, work orders, and work order tasks, the assignment tools consider the mandatory skills, filter out agents and technicians who do not have these skills, and then ranks the remaining agents. Agents are assigned or identified in the following way:

- If agents with all the mandatory skills are available, then the cases and tasks are assigned to these agents.
- If there are no agents that have all the mandatory skills, then the agents are ranked based on how many skills they have and other criteria. The agent with the highest rank is assigned to the case or task.
To specify skills or mandatory skills, you need one of the following roles:

- Field service dispatchers (wm_dispatcher)
- Field service technicians (wm_agent)
- Customer service managers (sn_customerservice_manager)
- Customer service agents (sn_customerservice_agent)

**Related information**

*Use the assignment workbench*

**Configuring the mandatory skills feature**

Configure the mandatory skills feature with the Customer Service Management and Field Service Management applications.

The Mandatory skills feature is an optional feature included with the Customer Service Management and Field Service Management plugins. Use the steps below to configure this feature with the desired application.

**Customer Service Management configuration**

To configure the mandatory skills feature for use with Customer Service Management, do the following:

- In the Case form, do one of the following:
  - Configure the form layout to use the Task Skills [task_m2m_skill] table.
  - In the Task Skills table, set the **Mandatory** field to **True** to identify skills that are mandatory to complete a task.

  **Note:** The Case form should use either the **Skills** field or the Task Skills table, but not both.

- [Optional] For existing cases that have data populated in the **Skills** field on the Case form, run the **Migrate Skills to Task Skill M2M** script to move this data to the Task Skills table. By default, this fix script migrates the skills from existing entries in the Case, Work Order, and Work Order Task tables to the Task Skills table. For more information, see **Migrate skills to the Task Skill table**.

- If you are using the **assignment workbench**, replace the **Matching Skills** matching criteria with the **Matching Skills - Mandatory Skills Support** matching criteria. For more information, see **Matching rules for case assignment**.

**Field Service Management configuration**

To configure the mandatory skills feature for use with Field Service Management, do the following:
• Enable the `work.management.use.mandatory.skills` system property.

• Configure the Work Order form and the Work Order Task form to use the Task Skills `[task_m2m_skill]` table.

• [Optional] For existing work orders and tasks that have data populated in the `Skills` field on the Work Order and Work Order Task forms, run the `Migrate Skills to Task Skill M2M` script to move this data to the Task Skills table. By default, this fix script migrates the skills from existing entries in the Case, Work Order, and Work Order Task tables to the Task Skills table and configures them as optional skills. For more information, see `Migrate skills to the Task Skill table`.

• If you are using dynamic scheduling, update the task filter for the dynamic scheduling configuration and replace the `Matching Skills for Dynamic Scheduling` matching criteria with the `Matching Mandatory Skills for Dynamic Scheduling` matching criteria. For more information, see `Create a task filter`.

For configuring optional skills, navigate to `Field Service > Administration > Configuration`, click the `Assignment` tab, and set `Auto-selection of agents for tasks requires them to have skills` to one of the following:

• All - indicates that the agent must have all the optional skills listed in the task for task assignment.

• Some - indicates that the agent must have at least one optional skill listed in the task for task assignment.

• None - indicates that the agent is not required to have any optional skill.

**Mandatory Skills system properties**

The `Migrate Skills to Task Skill M2M` script migrates skills from existing tasks to the Task Skills `[task_m2m_skill]` table. Configure the task tables included in the migration using the `skills_management.migration` system property.

The mandatory skills feature adds the following system properties.

> **Note:** To open the System Property `[sys_properties]` table, enter `sys_properties.list` in the navigation filter.

<table>
<thead>
<tr>
<th>System parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>work.management.use.mandatory.skills</td>
<td>Enables the mandatory skills feature. Indicating that the Task Skills <code>[task_m2m_skill]</code> table is being used for work orders and work order tasks.</td>
</tr>
</tbody>
</table>
### System parameter

<table>
<thead>
<tr>
<th>System parameter</th>
<th>Definition</th>
</tr>
</thead>
</table>
| skills_management.migration | Lists the task tables to migrate to the Task Skills \{task\_m2m\_skill\} table when an admin runs the **Migrate Skills to Task Skill M2M** script.  
  - Type: list  
  - Default value: `wm_task,customerservice_case,wm_order` |
| com.snc.skills_management.task_skill_migrated_tables | Contains a list of tables for which the Skills field has already been migrated to the Task Skills \{task\_m2m\_skill\} table. If the table name is listed in this property, the data has been migrated and will not be migrated again.  
  - Type: list  
  - Default value: none |

---

### Migrate skills to the Task Skill table

Migrate data from the **Skills** field to the Task Skills table. By migrating the skills, you can utilize mandatory skills support for executing tasks in a case or work order.

**Before you begin**

Role required: `wm_admin`, `admin`

**About this task**

The Task Skills \{task\_m2m\_skill\} table stores skills and mandatory skills. This table is used instead of the **Skills** field for the following applications:

- In the Customer Service Management application, the assignment workbench uses the Task Skills table to display agents based on the evaluation criteria for task assignments.

- In the Field Service Management application, the work order task assignments use the Task Skills table to assign agents for task assignments.
Procedure

1. Add a system property to a table in either the Customer Service Management or Field Service Management.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Create a system property for a table in the Customer Service Management application. | a. Make sure that you are logged in to the Customer Service Management application.  
   b. Configure the System Properties form to display the Suffix field.  
   c. In the Suffix field, enter <table_name>_migrate_skills, where <table_name> is the name of the case task table from which the skills need to be copied. |
| Create a system property for a table in the Field Service Management application. | a. Make sure that you are logged in to the Global application.  
   b. In the Name field, enter <table_name>_migrate_skills, where <table_name> is the name of the work order or work order task table from which the skills need to be copied. |

2. Set the Type field to true.
3. Click Update.
4. Navigate to System Definition > Fix Scripts.
5. Run the Migrate Skills to Task Skill M2M fix script.

Results

The skills are copied to the task_m2m_skill table from the original table. The name of the original table is appended to the com.snc.skills_management.task_skill_migrated_tables system property. When the script is run again, the script ignores all tables from which skills have already been migrated.
Configure communication channels

Configure communication channels to provide users with options to email, call, or chat with your teams for help. You can also integrate with social media.

Before you begin
Role required: admin

About this task
You have the following options for setting up communication channels:

Procedure

- Set up the Customer Service email channel.
  Customers can send emails to create new cases and update current cases as well as receive email updates from agents as cases progress. Customer Service Management uses the ServiceNow email accounts feature to create and maintain email accounts.
  - Configure one or more email addresses.
  - Configure an email address for a product.
  - Configure an email subject line prefix.
  - Set email communication channel properties.
  - Create an email client template.
  - Create quick messages.
  - Configure signatures in quick messages and email client templates.
  - Create rules for incoming emails and create and assign cases.

- Set up the Customer Service phone channel.
  External customers can reach out to customer service agents using the phone communication channel. Customer Service Management uses both Computer Telephony Integration (CTI) and OpenFrame to provide phone support for customers, as well as the Notify application and the Twilio Voice product. OpenFrame is included with Customer Service Management. The CTI Softphone plugin (com.snc.cti) and the Customer Service CTI Demo Data (com.snc.customerservice_cti_demo) plugin must be activated separately. The Notify plugin (com.snc.notify) is activated as part of the CTI Softphone plugin.
  - Set up the phone communication channel.
  - Associate a phone number with a workflow.
  - Create an OpenFrame configuration.
• Set up the Customer Service chat channel. The chat communication channel uses the Connect Support feature to provide chat capability from the Customer Service Portal and Consumer Service Portal. You can also enable Virtual Agent to create or use predefined chatbot topics (conversations) for your users.
  ◦ Configure the customer service chat queue.
  ◦ Add an agent to the chat support assignment group.
  ◦ Activate Virtual Agent for CSM
  ◦ Activate Customer Service Virtual Agent conversations.
  ◦ Integrate Customer Service Virtual Agent with Facebook Messenger.

• Set up the social media integration feature to support case resolution through social media channels.
  ◦ Create a social media profile for an account, contact, or consumer.
  ◦ Create a social media log entry for a case.

Configuring the chat channel
Configure the chat channel with the ServiceNow® Connect Support feature. You can also enable Virtual Agent to create or use predefined chatbot topics (conversations) for your users. You can also give users the option of switching to a live agent from a virtual agent.

Agents must be added to the Customer Service chat support assignment group before they can receive chat requests. This assignment group is used by the Customer Service chat queue to route the chat requests.

Configure the customer service chat queue
Define the customer service agents, default chat messages, schedule, and escalation path for the customer service chat queue.

Before you begin
Role required: admin

About this task
The Customer Service Management chat communication channel uses the ServiceNow Connect Support feature.
Procedure

1. Navigate to Collaborate > Administration > Queues.
2. Select Customer Service from the Chat Queues list.
3. Fill in the fields, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the queue.</td>
</tr>
<tr>
<td>Active</td>
<td>Not used in Connect.</td>
</tr>
<tr>
<td>Assignment group</td>
<td>User group that contains the support staff for the queue. Any user in the group can view the queue in the Connect sidebar and accept chats. No other users can access the queue. This field must be populated.</td>
</tr>
<tr>
<td>Average wait time</td>
<td>Average time it takes for an agent to accept a chat in the queue. This value is automatically calculated. Do not manually edit.</td>
</tr>
<tr>
<td>Confirm problem</td>
<td>Not used in Connect.</td>
</tr>
<tr>
<td>Escalate to</td>
<td>Different queue to which an agent can escalate a chat. For example, there is a queue for high priority support chats. When a queue is defined in this field, agents can access the Escalate option in conversations.</td>
</tr>
<tr>
<td>Initial agent response</td>
<td>Message that users see when an agent accepts their chat. For example, Thank you for contacting support. We are looking into your question now and will be with you shortly.</td>
</tr>
<tr>
<td>Not available</td>
<td>Message that users see when they attempt to start a chat outside the defined queue Schedule. You can use HTML to format the message and include links or media.</td>
</tr>
<tr>
<td>Question</td>
<td>Initial phrase that users see when they start a new chat in the queue. For example, How can I help you?</td>
</tr>
<tr>
<td>Schedule</td>
<td>Schedule that defines when the queue is available. Leave the field blank to make the queue available all the time. Users cannot start a new conversation in the queue outside the schedule hours.</td>
</tr>
</tbody>
</table>

4. Click Submit.
**Related information**

Connect Support

**Activate Virtual Agent for CSM**

Activate Virtual Agent for CSM to use the predefined Customer Service Virtual Agent topics (chatbot conversations) designed to help your customers complete common self-service tasks.

**Before you begin**

The Virtual Agent plugin (com.glide.cs.chatbot) must be activated. If Virtual Agent is not currently activated, contact ServiceNow to activate it.

Role required: admin

**Procedure**

Activate the Customer Service Virtual Agent Conversations plugin (com.sn_csm.virtualagent) to access the predefined Customer Service topics.

**Customer Service Virtual Agent conversations**

Predefined Customer Service Virtual Agent chatbot conversations enable your customers to get help with the product. Integrating Natural Language Understanding (NLU) models with your virtual agent chatbot topics enables chatbots to analyze, understand, and navigate the user to the right topic based on the inferred intent.

A conversation topic defines the dialog between the Virtual Agent (chatbot) and the user to accomplish a specific goal.

**Activating Virtual Agent conversations**

The system administrator or a virtual agent admin must do the following to enable the chatbot conversations:

- Enable the Glide Virtual Agent plugin (com.glide.cs.chatbot).
- Enable the Customer Service Virtual Agent Conversations plugin (com.sn_csm.virtualagent).
- Publish the following read-only pre-defined virtual agent chatbot topics and topic blocks:

  - **Check Case Status (Template)**
    
    Users can search cases and check the status of an existing case.

  - **Note:** You can duplicate a topic and then customize it.
Get Help with a Product (Template)
Users can get help on an issue with a product, search relevant knowledge articles, or create a case for the issue.

Get Help (Template)
This topic is for users who are not logged in and want to chat anonymously. Users can use keywords and search relevant knowledge articles or choose to be transferred to a live agent. You can integrate this topic with the Virtual agent - Facebook messaging integration to enable chat using your messaging application.

Get Help with an Order (Template)
Users can get help on an issue with an existing order, search relevant knowledge articles, or create a case for the issue.

Submit Request (Template)
Users can submit a request for searching and using one of the catalog items.

Create Case
Creates a case from Virtual Agent when no relevant topics for the issue you have are displayed.

Update Case
Users can update a case from Virtual agent.

Your users can run the published topics in your chat support client.

Activating Virtual Agent conversations with NLU

- The Customer Service NLU Model for Virtual Agent Conversations (com.sn_csm.nlu) plugin is automatically enabled when you enable the Customer Service Virtual Agent Conversations plugin (com.sn_csm.virtualagent).

After you enable the plugin, you can view the following read-only intents for the Customer Service NLU for VA models in Studio:

- CheckCaseStatus
- GetHelp
- GetHelpWithProduct
- GetHelpWithOrder
- SubmitRequest
Each intent corresponds to a chatbot topic. To customize an intent, you can import an existing intent from the Customer Service NLU for Virtual Agent model and then link the NLU model with the associated intent for the topic.

- Enable ServiceNow NLU in the general settings.

Related information
- Get help using virtual agent conversations
- Natural Language Understanding in Virtual Agent

Integrate Customer Service Virtual Agent with Facebook Messenger (Legacy)

Integrate the Customer Service Virtual Agent with Facebook Messenger to enable bot conversations in the messenger.

Before you begin
- Install the Customer Service (com.sn_customerservice) plugin.
- Install the Customer Service Virtual Agent Conversations plugin (com.sn_csm.virtualagent).
- Make sure Virtual Agent is integrated with Facebook Messenger.
- Make sure you have the token and secret for the messenger.

For information on integrating the Virtual Agent with Facebook Messenger and for retrieving the messenger token and secret, see Virtual Agent integration for consumer messaging apps.

Role required: virtual_agent_admin or admin

About this task
With this integration, you can get help using Virtual Agent chatbot conversations. For more information on getting help, see Customer Service Virtual Agent conversations.

Procedure
1. In the application navigator, enter
   `sys_cs_adapter_configuration_page_messenger_list.do`
2. Select sample-fb-messenger-app.
   You have to be in the Customer Service Virtual Agent Conversations application to edit the record.
3. In the Messenger Page ID field, enter your company’s Facebook page ID.
4. Right-click and select Save.
5. In the **Provider Auth** field, click the information icon and open the **Message Auth** record:
   - Go to the **Outbound message creation** field, click the information icon and open the **Token Verification** record.
   - In the **Token** field, enter the token for the messenger application.
   - Click **Update**.

6. In the **Message Auth** record:
   - Go to the **Inbound message verification** field, click the information icon, and open the **Hash Message Verification** record.
   - In the **Secret** field, enter the app secret for the messenger application.
   - Click **Update**.

**Configure Pre-chat after upgrading**

If you have upgraded, some settings need to be configured to use Pre-chat effectively.

**Before you begin**
Role required: admin

**About this task**
For information about using pre-chat surveys to capture preliminary information from a customer, see **Pre-chat surveys**. If you have upgraded, you must manually adjust some settings to use Pre-chat most effectively.

**Procedure**

1. Make the predefined pre-chat surveys active.
   a. Navigate to **Conversational Interfaces > Pre-Chat Survey**.
   b. Select the CSP Pre-Chat Survey, which collects preliminary information for logged-in customers.
   c. In the form, select **Active**.
   d. Click **Submit**.
   e. Repeat this process for the CSP Anonymous Pre-Chat Survey, which collects preliminary information for users who are not logged in.

2. Disable the legacy form-based chat widget from appearing in the portal header.
   a. Type `sys_properties_list.do` from your instance.
   b. Search for the **csp.legacy_chat** property.
3. Include the chat widget to appear on the Consumer Service Portal page.
   b. Click CSP Chat.
   c. Select Active.
   d. Click Submit.
   The Chat option from the portal header is disabled.

Configuring the email channel
Set up email addresses that customers can use to submit cases to your team. To help direct cases to specific teams, you can designate email addresses to specific product. As agents work on the cases, they can also email customers with updates and proposed solutions.

Customer Service Management uses the Email Accounts application to create and maintain email accounts. The system administrator can create multiple incoming email addresses that customers can use to communicate with customer service agents. The system administrator can also create one outgoing email address.

After the incoming and outgoing email addresses are created, the system administrator can set these properties for the email communication channel:

- Establish one of the incoming email addresses to automatically create a case.
- Enable a prefix to include in the subject line of an email to any of the incoming email addresses that automatically creates a case.
- Create cases for customers who are not currently in the system.

The system administrator can also create a channel configuration to associate any of the incoming email addresses with specific products.

Related information
- Email accounts

Configure an email address for a product
Users with the system administrator role can configure an email address that creates a case for a specific product.
Before you begin
Role required: admin

About this task
Create a configuration that links a product to a specific email address. This configuration is created in the Channel Configuration (sn_customerservice_channel_config) table.

Procedure
1. Navigate to Customer Service > Administration > Channels.
2. Click New.
3. Fill in the fields, as appropriate.

<table>
<thead>
<tr>
<th>Channel Configurations form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>Channel Type</td>
</tr>
<tr>
<td>Product</td>
</tr>
<tr>
<td>Active</td>
</tr>
<tr>
<td>Email address</td>
</tr>
</tbody>
</table>

4. Click Submit.

Configure an email subject line prefix
Users with the system administrator role can configure a prefix to include in an email subject line that creates a case.

Before you begin
Role required: admin

Procedure
1. Navigate to Customer Service > Administration > Properties.
2. In the Email subject prefix format for new case field, enter the prefix.
The default prefix is *Case*.

3. Click **Save**.

**Customer service email properties**

Users with the system administrator role can set several properties for the Customer Service Management email communication channel.

After creating the incoming and outgoing email addresses that customers use to communicate with customer service agents, the system administrator can set the following email-specific properties. Navigate to **Customer Service > Administration > Properties** to access these properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Case email address</strong></td>
<td>One of the incoming email addresses that automatically creates a customer service case. For incoming email, the system checks the address to see if it matches the address in the <strong>Case email address</strong> property. If yes, the system creates a customer service case. If it does not match, or if this property is not set, the system then checks the <strong>Email subject prefix format for new case</strong> property.</td>
</tr>
<tr>
<td><strong>Email subject prefix format for new case</strong></td>
<td>The prefix included in the subject line of an email to any of the incoming email addresses that automatically creates a customer service case. <strong>Case</strong>: is the default prefix.</td>
</tr>
<tr>
<td><strong>Create case for non matched user</strong></td>
<td>Enable the creation of new customer service cases when emails are received from users with email addresses that do not currently exist in the system.</td>
</tr>
</tbody>
</table>

**Configure signatures in quick messages and email client templates**

Configure signatures in quick messages and email client templates to include attributes of the logged-in user such as name, phone number, or designation. Ensuring that customers receive emails with uniform signatures enhances the user experience.
You can create predefined content in quick messages or email client templates. Including `${current_user}` and `${current_user.title}` in the message body substitutes the agent name and designation when an agent replies to a customer. The agent saves time when the signature is automatically appended. Following is an example of the message body text template.

```
Hi ${consumer.name}${contact.name},

Thank you for writing to us.

<<<Please type your response here before sending this email>>> 

We hope this information was helpful.
For any further information, please reply to this email.

Regards,
${current_user}
${current_user.title}
```

When an agent replies to the customer with the template that you have predefined, the following message is automatically filled. The `${current_user}` is replaced by John Jason, which is the agent name and `${current_user.title}` is replaced by the agent designation.

```
Hi Amy Chen, 

Thank you for writing to us.

<<<Please type your response here before sending this email>>> 

We hope this information was helpful.
For any further information, please reply to this email.

Regards,
John Jason 
Customer Service Representative 
```

Similarly, you can refer to the attributes in the sys_user table such as the address or phone number.

The following video provides an overview of configuring signatures in quick messages and email client templates.

Provides an overview of the inbound email flow process and quick message setup
Related information

Create an email template
Define a quick message

Disable email responses from the case activity stream

By default, customer service agents can respond to cases using options within a customer email thread instead of having to use another email client. Admins may disable this option for a business manager who does not want agents to interact with customers directly.

Before you begin
Role required: admin

About this task
Agents can use the **Reply**, **Reply All**, and **Forward** buttons in the case activity stream to respond to customer emails. This feature is enabled by default. Users with the system administrator role can disable this feature and hide these buttons if needed from the Agent Workspace application.

Procedure

1. Select the gear icon in the banner frame to access the System Settings window.
2. Click **Developer**.
3. Select **Agent Workspace** under **Application**.
4. Create a system property `sn_agent_workspace.activity_email_options_enabled`.
5. Set the property value to false.
   - As an agent, you will be unable to reply or forward emails.

Creating rules for incoming emails that create and assign cases

Create your email-related business processes using Inbound Email Flows. Once you receive an email on a specified support email address, you can define rules to create cases and assign the cases to specific teams.

In previous releases, incoming emails were processed through inbound email actions. Admins created separate email actions to support different business flows using scripts.

**Inbound Email Flows** provide powerful configuration capabilities to manage emails along with your customer service processes through a visual **Flow Designer** interface. Business managers can define inbound email flows without having to depend on admins or developers to write complex scripts. Email flows use conditional logic to incorporate multiple business processes in one flow.
The following example email flows are available by default once you activate the Customer Service Management plugin. Enable the email flows for activating the email processing rules to automatically create and update cases.

- Create case from email
- Update case using Reply

**: Note:**

- The execution order of the inbound email flows take a higher precedence than inbound actions (that is if an email flow executes, it prevents execution of inbound actions).
- The user who sends an email should have the necessary roles to perform operations specified in the flow, else the operation stops while executing.

The following example email flows are installed with the platform. These flows are not required for any of the CSM email processing rules:

- Handle email replies
- Logging a problem

**Related information**

Define rules to process incoming emails and to create and assign cases

Activate Customer Service Management

**Define rules to process incoming emails and to create and assign cases**

Define your email-related business processes using Inbound Email Flows, which enables you to manage emails along with your customer service processes through a visual **Flow Designer** interface without having to design or request complex scripts.

**Before you begin**

Role required: admin, sn_customerservice_manager

**About this task**

Email flows use conditional logic to incorporate multiple business processes in one flow. When designing inbound email flows, note the following:

- The execution order of the inbound email flows take a higher precedence than inbound actions (that is if an email flow executes, it prevents execution of inbound actions).
- The user who sends an email should have the necessary roles to perform operations specified in the flow or the operation will stop.
Procedure

1. Navigate to **Customer Service > Flow Designer > Inbound Email Flows**.
2. Select a default flow.
   - The available flows are:
     - Create case from email when a user sends a new email
     - Update a case when you use the reply option
3. Click the **Inbound Email** trigger.
4. Modify the default email filter conditions or select **New Criteria** to add conditions.
5. Select a Reply Record Type table.
6. Click **Done**.
7. Click an existing action and expand it.
8. Provide information for the action or click + to add a new action, flow logic, or subflow.
9. Click **Done**.
10. Verify the email flow and modify it if necessary.
11. Click **Save**.
12. Click **Activate**.
    - The defined inbound email flow is activated.

Related information

- Flows
- Action Designer

Configuring the phone channel

Configure phone support for customers with Computer Telephony Integration (CTI) and OpenFrame.

Related information

- Notify

Create an OpenFrame configuration

This configuration specifies the OpenFrame window settings as well as the URL to be launched within OpenFrame.
Before you begin
Role required: admin

About this task
As part of the OpenFrame configuration, users with the admin role can select one or more user groups. Access to the configuration is limited to the users that have the openframe user role and that belong to the selected groups.

Procedure
1. Navigate to **OpenFrame > Configurations** to display the OpenFrame Configurations list.
2. Click **New**.
3. Fill in the fields, as appropriate.

### OpenFrame Configuration form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the OpenFrame configuration.</td>
</tr>
<tr>
<td>Title</td>
<td>The title that appears in the OpenFrame window header.</td>
</tr>
<tr>
<td>Subtitle</td>
<td>The subtitle that appears in the OpenFrame window header.</td>
</tr>
<tr>
<td>Order</td>
<td>The order number for the configuration. If users have multiple OpenFrame configurations, they can only access the configuration with the lowest order number.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When upgrading, the <strong>Order</strong> field for the existing default OpenFrame configuration is set to 1.</td>
</tr>
<tr>
<td>Enable collapsed view</td>
<td>Enables the expand and collapse capability for the OpenFrame window. When collapsed, users can still access call control actions. The default setting is <strong>False</strong>.</td>
</tr>
<tr>
<td>Show presence indicator</td>
<td>Enables the indicator that displays agent availability.</td>
</tr>
<tr>
<td>User Group</td>
<td>The user groups selected for this configuration. Access to this configuration is limited to the users that have the openframe user role and that belong to the selected groups.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you do not select any groups, the configuration is available to all users with the openframe user role.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL</td>
<td>The URL to be launched within OpenFrame. This URL can be an absolute path or a path that is relative to the ServiceNow instance.</td>
</tr>
<tr>
<td>Active</td>
<td>Denotes this configuration as active.</td>
</tr>
<tr>
<td>Width</td>
<td>The width of the OpenFrame window.</td>
</tr>
<tr>
<td>Height</td>
<td>The height of the OpenFrame window, not including the OpenFrame header height.</td>
</tr>
<tr>
<td>Icon Class</td>
<td>The class of icons used for the OpenFrame window (retina-icons.css). Only supports icon-phone and icon-video values.</td>
</tr>
<tr>
<td>Title Icon</td>
<td>The icon displayed on the OpenFrame window header.</td>
</tr>
<tr>
<td>Configuration</td>
<td>Can be used to store any JSON encoded string.</td>
</tr>
</tbody>
</table>

#### Note:
Several fields on the OpenFrame Configuration form can also be set by using the OpenFrame API. These fields include: **Title**, **Subtitle**, **Width**, **Height**, and **Title Icon**.

4. Click **Submit**.

**Related information**
- openFrameAPI - Client

**OpenFrame events for work items, agent presence, and interactions**

Use OpenFrame events to achieve better integration between Advanced Work Assignment (AWA) and Computer telephony integration (CTI) and aide in improved call routing.

OpenFrame events are enabled by default when your administrator installs the Openframe plugin (com.sn_openframe) and Advanced Work Assignment for CSM plugin (com.sn_csm.awa).

#### Note:
The Advanced Work Assignment for CSM (com.sn_csm.awa) plugin is automatically installed with the Customer Service plugin (com.sn_customerservice).

As a CTI developer, ensure that you subscribe to the following events by using the subscribe method of the openFrameAPI. For more information, see openFrameAPI - Client.
### OpenFrame events

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>openframe_awa_agent_presence</td>
<td>Events are sent to OpenFrame when an agent's presence state changes.</td>
</tr>
<tr>
<td>openframe_awa_workitem_offered</td>
<td>Events are sent to OpenFrame when a work item is offered to an agent.</td>
</tr>
<tr>
<td>openframe_awa_workitem_accepted</td>
<td>Events are sent to OpenFrame when a work item is accepted by an agent.</td>
</tr>
<tr>
<td>openframe_awa_workitem_rejected</td>
<td>Events are sent to OpenFrame when a work item is rejected by an agent.</td>
</tr>
<tr>
<td>openframe_agent_off_interaction</td>
<td>Events are sent to OpenFrame indicating the presence of an agent on chat as off or available.</td>
</tr>
</tbody>
</table>

Add and activate an OpenFrame configuration by navigating to **OpenFrame > Configurations**. For more information, see [Create an OpenFrame configuration](#).

### Sample payloads

Refer to the sample payloads for each event as described in the following table.

<table>
<thead>
<tr>
<th>Event</th>
<th>Sample payload</th>
</tr>
</thead>
</table>
| openframe_awa_agent_presence         | {
|                                      |   "result": {
|                                      |     "presence": {
|                                      |       "name": "Available",
|                                      |         "sys_id": "0b10223c57a313005baaa65ef94f970",
|                                      |         "available": true,
|                                      |         "channels": [
|                                      |             {
|                                      |                 "name": "Case",
|                                      |                 "available": true,
|                                      |             "sys_id": "d4a675e3739713004a905ee515f6a7e7",
|                                      |         ]
|                                      |   }
|                                      | }
|                                      | }                                                                               |
### Events and their sample payloads (continued)

<table>
<thead>
<tr>
<th>Event</th>
<th>Sample payload</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>&quot;restrict_update&quot;:false</td>
</tr>
<tr>
<td></td>
<td>}</td>
</tr>
<tr>
<td></td>
<td>{</td>
</tr>
<tr>
<td></td>
<td>&quot;name&quot;:&quot;Phone&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;available&quot;:true,</td>
</tr>
<tr>
<td></td>
<td>&quot;sys_id&quot;:&quot;f6281cc39335330090813a53177ffb32&quot;</td>
</tr>
<tr>
<td></td>
<td>},</td>
</tr>
<tr>
<td></td>
<td>{</td>
</tr>
<tr>
<td></td>
<td>&quot;name&quot;:&quot;Chat&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;available&quot;:true,</td>
</tr>
<tr>
<td></td>
<td>&quot;sys_id&quot;:&quot;27f675e3739713004a905ee515f6a7c3&quot;</td>
</tr>
<tr>
<td></td>
<td>},</td>
</tr>
<tr>
<td></td>
<td>&quot;restrict_update&quot;:false</td>
</tr>
<tr>
<td></td>
<td>}</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>openframe_awa_workitem_offered</td>
<td>{</td>
</tr>
<tr>
<td></td>
<td>&quot;result&quot;:{</td>
</tr>
<tr>
<td></td>
<td>&quot;workItem&quot;:{</td>
</tr>
<tr>
<td></td>
<td>&quot;sys_id&quot;:&quot;ade107591bf66410b8e3ea06624bcbce&quot;</td>
</tr>
<tr>
<td></td>
<td>},</td>
</tr>
<tr>
<td></td>
<td>&quot;size&quot;:1</td>
</tr>
<tr>
<td></td>
<td>&quot;serviceChannel&quot;:{</td>
</tr>
<tr>
<td></td>
<td>&quot;name&quot;:&quot;Case&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;sys_id&quot;:&quot;d4a675e3739713004a905ee515f6a7e7&quot;</td>
</tr>
<tr>
<td></td>
<td>},</td>
</tr>
<tr>
<td></td>
<td>&quot;document&quot;:{</td>
</tr>
</tbody>
</table>
### Events and their sample payloads (continued)

<table>
<thead>
<tr>
<th>Event</th>
<th>Sample payload</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>&quot;sys_id&quot;: &quot;37a187591bf66410b8e3ea06624bcbef&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;table&quot;: &quot;sn_customerservice_case&quot;</td>
</tr>
<tr>
<td></td>
<td>}</td>
</tr>
<tr>
<td></td>
<td>}</td>
</tr>
<tr>
<td></td>
<td>}</td>
</tr>
<tr>
<td>openframe_awa_workitem_accepted</td>
<td>{</td>
</tr>
<tr>
<td></td>
<td>&quot;result&quot;: {</td>
</tr>
<tr>
<td></td>
<td>&quot;workItem&quot;:</td>
</tr>
<tr>
<td></td>
<td>&quot;sys_id&quot;: &quot;ade107591bf66410b8e3ea06624bcbce&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;size&quot;: 1,</td>
</tr>
<tr>
<td></td>
<td>&quot;serviceChannel&quot;: {</td>
</tr>
<tr>
<td></td>
<td>&quot;name&quot;: &quot;Case&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;sys_id&quot;: &quot;d4a675e3739713004a905ee515f6a7e7&quot;</td>
</tr>
<tr>
<td></td>
<td>},</td>
</tr>
<tr>
<td></td>
<td>&quot;document&quot;: {</td>
</tr>
<tr>
<td></td>
<td>&quot;sys_id&quot;: &quot;37a187591bf66410b8e3ea06624bcbef&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;table&quot;: &quot;sn_customerservice_case&quot;</td>
</tr>
<tr>
<td></td>
<td>}</td>
</tr>
<tr>
<td></td>
<td>}</td>
</tr>
<tr>
<td>openframe_awa_workitem_rejected</td>
<td>{</td>
</tr>
<tr>
<td></td>
<td>&quot;payload&quot;: {</td>
</tr>
<tr>
<td></td>
<td>&quot;workItem&quot;:</td>
</tr>
<tr>
<td></td>
<td>&quot;sys_id&quot;: &quot;66c4071d1bf66410b8e3ea06624bc59&quot;</td>
</tr>
</tbody>
</table>
### Events and their sample payloads (continued)

<table>
<thead>
<tr>
<th>Event</th>
<th>Sample payload</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>&quot;size&quot;:1,</td>
</tr>
<tr>
<td></td>
<td>&quot;serviceChannel&quot;:{</td>
</tr>
<tr>
<td></td>
<td>&quot;name&quot;:&quot;Case&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;sys_id&quot;:&quot;d4a675e3739713004a905ee515f6a7e7&quot;,</td>
</tr>
<tr>
<td></td>
<td>},</td>
</tr>
<tr>
<td></td>
<td>&quot;document&quot;:{</td>
</tr>
<tr>
<td></td>
<td>&quot;sys_id&quot;:&quot;b6a4c31d1b66410b8e3ea06624bcb93&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;table&quot;:&quot;sn_customerservice_case&quot;</td>
</tr>
<tr>
<td></td>
<td>},</td>
</tr>
<tr>
<td></td>
<td>&quot;rejection&quot;:{</td>
</tr>
<tr>
<td></td>
<td>&quot;reason&quot;:&quot;Not my expertise&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;sys_id&quot;:&quot;31e3fa29b38023002e7b6e5f26a8dc17&quot;</td>
</tr>
<tr>
<td></td>
<td>}</td>
</tr>
<tr>
<td>openframe_agent_off_interaction</td>
<td>{</td>
</tr>
<tr>
<td></td>
<td>&quot;result&quot;:{</td>
</tr>
<tr>
<td></td>
<td>&quot;interaction&quot;:{</td>
</tr>
<tr>
<td></td>
<td>&quot;sys_id&quot;:&quot;da1dc9651bbe6410b8e3ea06624bcb51&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;number&quot;:&quot;IMS0000050&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;type&quot;:&quot;chat&quot;,</td>
</tr>
<tr>
<td></td>
<td>&quot;reason&quot;:&quot;INTERACTION_INACTIVE&quot;</td>
</tr>
<tr>
<td></td>
<td>}</td>
</tr>
<tr>
<td></td>
<td>}</td>
</tr>
</tbody>
</table>

### Related information

**OpenFrame overview**
Social media integration

Support case resolution through social media communication channels.

When working with customers or consumers to create and resolve cases, agents can select Social as the communication channel and add a social profile to the Case form. Any communication with customers or consumers that takes place through social media is recorded on the Case form in the Social Logs related list.

Customer service managers can create one or more social profiles for a user by recording a user's social profile information on a specific social media channel such as Twitter or Facebook. Managers can create social profiles for accounts, contacts, and consumers from the Social Profiles related list on the entity form. Agents have read-only access to these profiles.

Integration with Customer Service Management

The social media communication channel is integrated with the following Customer Service Management forms: Case, Account, Contact, and Consumer.

On the Case form, the Channel field includes the Social option. Selecting this option adds the Social Profile field to the Case form, in which you can select a specific social media channel. The Social Logs related list captures the details of social media conversations.

The Account, Contact, and Consumer forms include the Social Profiles related list. Customer service managers can create one or more profiles for each of these entities.

Plugins

The Customer Service Social Integration plugin (com.sn_cs_social) is activated as part of the Customer Service Management plugin.

Tables

The Customer Service Social Media plugin adds the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Social Channels</td>
<td>Stores the social channels, which are brought in by the social integration tool.</td>
</tr>
<tr>
<td>[sn_app_cs_social_social_channel]</td>
<td></td>
</tr>
<tr>
<td>Social Profiles</td>
<td>Stores the social profiles created for each customer contact or consumer.</td>
</tr>
<tr>
<td>[sn_app_cs_social_social_profile]</td>
<td></td>
</tr>
<tr>
<td>Social Logs</td>
<td>Stores the details of social media conversations related to cases.</td>
</tr>
<tr>
<td>[sn_app_cs_social_social_log]</td>
<td></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logos, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc. in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Configure the Customer and Consumer Service Portals

Configure the Customer and Consumer Service Portals to provide information and support for your customers.

Before you begin
Role required: admin

About this task

Use the portals to provide information and support for your customers. The portals provide a basic format that customers can use to search for information or request assistance from a customer service agent. They include the following features:

- A header with links for different customer activities.
- A search feature that customers can use to search for information from several repositories.
- Links to information sources such as the knowledge base, the user community, and customer support.

Note: The Customer Service Portal is automatically installed when you activate the Customer Service plugin.

To activate the Consumer Service Portal, activate the Consumer Service plugin.

Procedure

1. Navigate to Customer Service > Administration > Guided Setup.
2. On the Getting Started page of the guided setup, click Get Started.
3. In the Customer Service Portal (B2B) or the Consumer Service Portal (B2C) category, view the list of tasks to configure the feature.

Customer and Consumer Service Portal configuration tasks

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customize the Customer Service Portal</td>
<td>Customize the Customer Service Portal to meet your needs.</td>
</tr>
</tbody>
</table>
### Task and Description

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate the Consumer Service Portal</td>
<td>Activate the Consumer Service Portal plugin.</td>
</tr>
<tr>
<td>Customize the Consumer Service Portal</td>
<td>Customize the Customer Service Portal to meet your needs.</td>
</tr>
</tbody>
</table>

### 4. To perform a task, click **Configure**.

This button opens the page in your instance where the configuration is completed.

### Related information

**Service Portal**

### Activate the Consumer Service Portal

Activate the Consumer Service Portal plugin to use the Consumer Service Portal.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **System Definition > Plugins**.
3. Click **Activate**.

### Customize the Customer and Consumer Service Portals

Customize the Customer and Consumer Service Portals to meet your needs.

**Before you begin**

Role required: admin

**Procedure**

Navigate to **Service Portal > Service Portal Configuration**.

Some of the components that you can customize include:

- **Branding**: Configure the portal branding to give your Customer Service Portal its own look and feel.
- **Menus**: Configure the portal header menu to set up the main menu, one of the main navigation controls for your users.
- **Homepage**: Assign a homepage to the portal.
- **Widgets**: Use Service Portal widgets to define the content in your portal.
- **Roles**: Configure page security by role to either set up pages to be public (no login required) or to filter them by user role.

### Enabling AI search in the Customer and Consumer Service Portals for unauthenticated users

An administrator activates the AI search widgets so that guest users logging in to the Customer and Consumer Service Portals can use the AI search feature.

**Before you begin**
Role required: admin
You must configure AI Search for the Customer and Consumer Service Portals. For more information, see Configure AI Search for the Customer and Consumer Service Portals.

**About this task**
You must enable the Typeahead Search and AI Search Assist widgets for the unauthenticated users to use the AI search feature. For more information on the widgets, see Typeahead Search widget and AI Search Assist widget

**Procedure**
1. Navigate to Service Portal > Widgets.
2. Search for Typeahead Search.
3. Click Typeahead Search.
4. Select the Public check box.
5. Click Update.
6. Repeat the steps for the AI Search Assist widget.

### Activate the standard ticket page for upgrade customers

If you have upgraded your instance, redirect the ticket page to standard_ticket page in the Service Portal and view requests on the standard ticket page.

**Before you begin**
Role required: admin or sp_admin

**About this task**
For new customers, the standard ticket page is enabled by default. For upgrade customers, you must enable it.
Procedure
1. Navigate to **Service Portal > Page Route Maps**.
3. Set the value to **true** in the **Active** column.
4. Click the name of the page route map.
5. Click **here** to edit the record.
6. Select the **Active** check-box.
7. Click **Update**.

Related information
- Standard ticket page

**Configure the standard ticket page for cases**
You can configure the standard ticket page for customer service cases from where users can view the details of a case in the Service Portal.

**Before you begin**
Role required: admin or sp_admin

Procedure
1. Navigate to **Standard Ticket > Standard Ticket Configuration**.
2. Click **sn_customerservice_case**, **csm_order case**, **sn_customerservice_task**, or **customer_project_task** which is available by default.

   **Note:** You can add your own case types and add new configurations for the required tables. For more information, see **Configure the standard ticket page**.

3. Click **here** to edit the record.
4. Edit the fields on the Ticket Configuration form as required. For example, you can add tabs to the existing **Activity** and **Attachments** tabs in the **Info fields** field under the Info Region tab.

5. Click **Update**.

Related information
- Configure the standard ticket page
**Consumer Service Portal properties**

Properties that the system administrator can set to limit the number of registered products per consumer, the number of open cases per consumer, and the number of attachments per consumer record.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>consumer_max_attachments_per_record</td>
<td>Maximum consumer attachable items per record.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value:</strong> 5</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location:</strong> Customer Service &gt; Administration &gt; Properties</td>
</tr>
<tr>
<td>consumer_max_new_cases_daily</td>
<td>Maximum new cases that a consumer can create per day.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value:</strong> 10</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location:</strong> Customer Service &gt; Administration &gt; Properties</td>
</tr>
<tr>
<td>consumer_max_comments_per_case_daily</td>
<td>Maximum comments that a consumer can post per day on a case.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value:</strong> 25</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location:</strong> Customer Service &gt; Administration &gt; Properties</td>
</tr>
<tr>
<td>consumer_max_products</td>
<td>Maximum registered products per consumer.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value:</strong> 25</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location:</strong> Customer Service &gt; Administration &gt; Properties</td>
</tr>
<tr>
<td>create_case.description.enable_html_editor</td>
<td>Enable the flag to add description using the HTML editor on the Create Case form page.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Type: boolean</td>
<td></td>
</tr>
<tr>
<td>Default value: True for new customers and False for upgrade customers.</td>
<td></td>
</tr>
<tr>
<td>Location: Customer Service &gt; Administration &gt; Properties</td>
<td></td>
</tr>
</tbody>
</table>

**Portal usage calculation**

Portal usage enables you to track how your customers and employees are using the portal. The Customer Portal Usage dashboard provides information about portal visits resulting in session counts.

To view the Customer Portal Usage dashboard, navigate to **Customer Service > Administration > Portal Usage**.

ℹ️ **Note:** You can ignore the bot session usage that is captured as part of this dashboard.

A user session is a period of activity on the Customer or Consumer Service Portal by one of the following users:

- **External**: an external user, typically a customer or consumer, who is logged in.
- **Anonymous**: a user who is not logged in.

A user session times out after a specific period of inactivity.

User access to the self-service portals is tracked as follows: per session, per day, and per portal. If the same user logs in from multiple browsers or devices, each login is counted as a separate visit. Each first call of a portal page starts a session and, at midnight (server time), the system restarts another session. This means that a user cannot have a session longer than 24 hours.

The default session timeout is 30 minutes. This setting can be adjusted using a system property. For more information about modifying the session timeout setting, see **Manage user sessions**.

**Site visit calculation examples**

A user logs in, logs out, and then logs in again:
A user logs in and continues the session past midnight:

<table>
<thead>
<tr>
<th>Step</th>
<th>User activity</th>
<th>Billable count incremented</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>User visits the portal as an anonymous or guest user</td>
<td>Yes</td>
</tr>
<tr>
<td>2</td>
<td>User logs in</td>
<td>No</td>
</tr>
<tr>
<td>3</td>
<td>User session continues past midnight</td>
<td>Yes</td>
</tr>
<tr>
<td>4</td>
<td>User logs out</td>
<td>No</td>
</tr>
</tbody>
</table>

**Customer Service Portal user roles**

Several different roles allow customers to create and edit cases and manage users from the customer portal.

<table>
<thead>
<tr>
<th>User role</th>
<th>What this user can do on the Customer Service Portal</th>
</tr>
</thead>
</table>
| Customer [sn_customerservice.customer] | • Create a case for this user's account.  
• View a list of cases created by this user.  
• Edit cases created by this user.  
• View a list of assets belonging to this user's account.  
• Search for information. |
### Customer Service Portal user roles (continued)

<table>
<thead>
<tr>
<th>User role</th>
<th>What this user can do on the Customer Service Portal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer case manager</td>
<td>• Create a case for this user's account and for child accounts.</td>
</tr>
<tr>
<td>[sn_customerservice.customer_case_manager]</td>
<td>• View a list of cases created by this user and view cases for child accounts.</td>
</tr>
<tr>
<td></td>
<td>• Edit cases created by this user and edit cases for child accounts.</td>
</tr>
<tr>
<td></td>
<td>• View a list of assets belonging to this user's account and to child accounts.</td>
</tr>
<tr>
<td></td>
<td>• Search for information.</td>
</tr>
<tr>
<td></td>
<td>• Create a case on behalf of another contact in this account.</td>
</tr>
<tr>
<td></td>
<td>• View a list of cases belonging to this account.</td>
</tr>
<tr>
<td></td>
<td>• Edit cases belonging to the account.</td>
</tr>
<tr>
<td><strong>Note:</strong> The customer case manager role is not automatically added to the <code>sn_customerservice.contact_role_assignment</code> system property. To expose this role to customer and partner administrators, navigate to Customer Service &gt; Administration &gt; Properties and add it to this property.</td>
<td></td>
</tr>
</tbody>
</table>

| Customer administrator                        | • Create a case for this user's account. |
| [sn_customerservice.customer_admin]          | • Create a case on behalf of another contact for this account. |
|                                                | • View a list of cases belonging to this account. |
|                                                | • Edit cases belonging to this account. |
|                                                | • View a list of assets belonging to this user's account. |
|                                                | • Search for information. |
|                                                | • Manage users for this account. |
## Customer Service Portal user roles (continued)

<table>
<thead>
<tr>
<th>User role</th>
<th>What this user can do on the Customer Service Portal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partner</td>
<td>• Create a case for this user's account.</td>
</tr>
<tr>
<td>[sn_customerservice.partner]</td>
<td>• Create a case on behalf of customer accounts.</td>
</tr>
<tr>
<td></td>
<td>• View a list of cases belonging to this user.</td>
</tr>
<tr>
<td></td>
<td>• Edit cases belonging to this user.</td>
</tr>
<tr>
<td></td>
<td>• View a list of assets belong to this user's account.</td>
</tr>
<tr>
<td></td>
<td>• Search for information.</td>
</tr>
<tr>
<td>Partner administrator</td>
<td>• Create a case for this user's account.</td>
</tr>
<tr>
<td>[sn_customerservice.partner_admin]</td>
<td>• Create a case on behalf of customer accounts.</td>
</tr>
<tr>
<td></td>
<td>• View a list of cases belonging to this account and to customer accounts.</td>
</tr>
<tr>
<td></td>
<td>• View a list of assets belong to this account and to customer accounts.</td>
</tr>
<tr>
<td></td>
<td>• Edit cases belonging to this account and to customer accounts.</td>
</tr>
<tr>
<td></td>
<td>• Manage users for this account and for customer accounts.</td>
</tr>
</tbody>
</table>

### Limit access to product model data on the Customer Service Portal

Use a system property to limit customer access to data in the Product Models table.

From the Customer Service Portal, product model data can be accessed by external users with the sn_esm_user role. System administrators can use the `csm_cmos_model.customer_visible_flag` system property and the **Customer Visible** field on the Product Models table (cmdb_model) and child tables to limit this access.

The `csm_cmos_model.customer_visible_flag` system property enables the **Customer Visible** field for the tables listed below. By default, this property is set to false. When set to true, the system uses the setting in the **Customer Visible** field to determine access to product model data on the Customer Service Portal.
• Product Models table (cmdb_model)
• Software Models table (cmdb_software_product_model)
• Application Models table (cmdb_application_product_model)
• Consumable Models table (cmdb_consumable_product_model)
• Facility Models table (cmdb_facility_product_model)
• Hardware Models table (cmdb_hardware_product_model)

The Model Categories table (cmdb_model_category) does not have a Customer Visible field. Access to model categories data is restricted by using the Customer Visible field on the Product Model table. Only the categories for the products which are visible in the Product Model table will be visible in the Model Categories table.

For upgrades from Jakarta to madrid, the Customer Visible field is added to each record in the Product Models table and set to false.

To limit access:
1. Set the `csm_cmdb_model.customer_visible_flag` system property to true.
2. Customize the Product Models table (cmdb_model) and add the Customer Visible column.
3. Set the value of the Customer Visible field to true for the product models that should be visible to external customers.

External users can see these product using these product models if the products are linked to the customer account.

**View the number of bot-based sessions**

CSM portal usage sessions are billable to customers, but sometimes customers are unnecessarily charged for sessions generated due to bots, crawlers, and DDOS attacks. You can view the number of bot-based sessions to ensure that customers are not incorrectly billed.

**Before you begin**
Role required: admin, usage_admin

**About this task**
For all new portals you create, bot sessions are captured in the Service Portal Bot Sessions [ua_sp_bot_session] table and all session types are captured in the Service Portal Usage [ua_sp_usage] table.
Procedure
1. Navigate to Reports > View/Run.
2. Search for customer portal usage.
3. Click the Customer Portal Usage report.
   The report shows the session count for all sessions and a separate count of sessions generated due to bots, crawlers, and DDoS attacks.

Multi-factor authentication for Customer and Consumer Service Portals
Multi-factor authentication, also known as two-step verification, is a security requirement that asserts a user enter more than one set of credentials.

Enable multi-factor authentication for Customer and Consumer Service Portal users so that access to the self-service web portals is more secure from potential vulnerabilities. For more information, see Multifactor authentication (MFA).

Multi-factor authentication properties
Use properties to enable role-based multi-factor authentication criteria and configure the behavior.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Multi-factor authentication</td>
<td>Select this check box to allow users and administrators to use this feature.</td>
</tr>
<tr>
<td>[glide.authenticate.multifactor]</td>
<td>• <strong>Type</strong>: enabled</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: enabled</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: Multi-factor Authentication &gt; Properties</td>
</tr>
<tr>
<td>Number of times a user can bypass setting up multi-factor authentication</td>
<td>Enter a number that represents how many times a user can choose to skip the additional passcode requirement. This gives your users the ability to still log in the instance if they do not have their mobile device with them. If you disable this feature and then re-enable it, the counter starts over again.</td>
</tr>
<tr>
<td>[glide.authenticate.multifactor.setup.bypass.count]</td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| • **Type**: string  
• **Default value**: 3  
• **Location**: Multi-factor Authentication > Properties  
The time in minutes, the one time code sent to user's email address is valid for [glide.multifactor.onetime.code.validity] | Enter a number in minutes that specifies how long the reset code is valid. See Log on with multi-factor authentication.  
• **Type**: string  
• **Default value**: 10  
• **Location**: Multi-factor Authentication > Properties  
Additional time in seconds for which the code will be valid to accommodate for the clock skew. Max value is 60 seconds. [glide.authenticate.multifactor.clock_skew] | Enter a number in seconds with a maximum of 60. By default, the instance validates the code entered by the user against the single app-generated code generated at whatever the current time is. You can skew the time window with this property and allow one or more codes generated during a time window to be considered valid. The property's value is used in the following calculation: current time - x/2 and current time + x/2, where 'x' is the value of this property. If you use the value of 10, for example, the instance considers any codes generated by the app between the time range [the current time - 5 seconds] and [current time + 5 seconds] to be valid. Use this property to prevent log in issues where the user is unable to enter the correct code in the default time allotted. |
Configure roles for multi-factor authentication
Add the following external roles to the multi-factor roles:

• sn_customerservice.customer
• sn_customerservice.consumer

Users with these roles will be required to use multi-factor authentication. For more information, see Configure user-based multi-factor criteria.

Set up Workspaces in Customer Service Management
Select a workspace to use with Customer Service Management, either CSM Configurable Workspace or CSM Agent Workspace, and follow the setup instructions.

After completing the workspace setup, you can select and configure different features to use in your CSM workspace.

Note: If you are currently using CSM Agent Workspace and want to implement CSM Configurable Workspace, see Migrating to Configurable Workspace.

Set up CSM Configurable Workspace
Set up CSM Configurable Workspace for your agents so they can engage with customers, answer questions, create cases, and resolve issues.

Complete the following tasks to set up CSM Configurable Workspace:

1. Activate the Customer Service plugin (com.sn_customerservice).
2. Set up CSM Configurable Workspace using guided setup.
3. Set up the necessary communication channels and routing.
4. Set up additional components specific to CSM Configurable Workspace.

Activate the plugin
The Customer Service plugin (com.sn_customerservice) provides the CSM Configurable Workspace functionality. For more information, see Activate Customer Service Management.

Activating the Customer Service plugin activates the following plugins:

• CSM and FSM Configurable Workspace Foundation (com.snc.uib.cwf_workspace)
• CSM Configurable Workspace (com.snc.uib.csm_agent_workspace)
• CSM Configurable Workspace Lookup and Verify (com.snc.uib.lookup_verify)
• CSM Configurable Workspace Special Handling Notes (com.snc.uib.special_handling_notes)

Additional plugins are required for phone integration. For details, see:
• Workspace phone integration with OpenFrame and computer telephony integration (CTI)
• Configure Agent Chat for Workspace

Set up CSM Configurable Workspace using guided setup

You can set up CSM Configurable Workspace by using the Customer Service Management Guided Setup. To use the guided setup, navigate to Customer Service > Administration > Guided Setup > CSM Configurable Workspace.

The CSM Configurable Workspace category takes you to the Configurable Workspace Guided Setup, which provides a sequence of workspace configuration tasks. Use these tasks to configure:

• Branding and themes
• Tab settings
• Lists and forms
• Search sources
• Notifications
• Advanced Work Assignment (AWA)
• Agent chat
• Playbooks

You can use UI Builder to configure the following CSM Configurable Workspace pages:

• CSM Landing Page
• Customer Central – Customer Information tab

For more information, see the Work with pages topic in the UI Builder documentation.

Set up communication channels and routing

Enable agents to chat with customers or to receive and place customer calls. You can also set up routing that automatically directs chats to the appropriate
agents. For more information about communication channels, see Phones and chat in Workspace.

<table>
<thead>
<tr>
<th>Channel</th>
<th>Description</th>
<th>Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chat</td>
<td>CSM Configurable Workspace uses Agent Chat to enable customers to ask questions and receive information through live or automated chat.</td>
<td>Configure Agent Chat for Workspace</td>
</tr>
<tr>
<td>Phone</td>
<td>CSM Configurable Workspace uses a combination of OpenFrame and computer telephony integration (CTI) to enable third-party phone integration.</td>
<td>Workspace phone integration with OpenFrame and computer telephony integration (CTI)</td>
</tr>
</tbody>
</table>

**Set up additional CSM Configurable Workspace components**

Complete these tasks to set up the components that are specific to CSM Configurable Workspace.

**Create or modify a landing page**

The landing page is an agent's initial view of the workspace. The **CSM Landing Page** is included with the Customer Service plugin. You can modify this landing page or you can create and modify a page variant in UI Builder.

**Set up a ribbon configuration in CSM Configurable Workspace**

The form ribbon includes components that display information about a record. You can add the Customer 360, Timeline, and SLA components to the Case form ribbon. You can also configure attributes for the Customer 360 and Timeline components.

**Set up a form header in CSM Configurable Workspace**

Configure form headers that provide a quick summary of case, account, or contact information.

**Set up a highlighted value in a form header in CSM Configurable Workspace**

Configure fields that appear as highlighted values in form headers in CSM Configurable Workspace.

**Set up a form action in CSM Configurable Workspace**

Create form actions that link to UI actions so that you can use the UI actions in CSM Configurable Workspace.
Configure service catalogs for CSM workspaces

Customer service agents use service catalogs to fulfill catalog item requests. You can configure the Service Workspace Portal to use the catalogs that contain the desired items.

Create a CSM Configurable Workspace landing page

Create landing pages for different agents and teams by creating a page variant and adding or modifying containers and components.

Before you begin
Role required: workspace_admin, ui_builder_admin, admin

About this task
A landing page is the page that an agent sees when they open their workspace. One landing page for CSM Configurable Workspace is included with the Customer Service plugin (com.sn_customerservice). This page, the CSM Landing Page, gives agents an overview of their new, assigned and high priority cases, plus the cases assigned to their groups.

You can create a variant of this page in UI Builder, a WYSIWYG web user interface builder, and modify it as needed.

Note: It is important to create a variant of the CSM Landing Page to prevent issues with upgrades.

For example, you can use UI Builder to perform these tasks:

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change the page layout</td>
<td>The layout governs the slots that are available on a page, how the slots are positioned, and what CSS rules apply to them. For more information about layouts and layout systems, see Work with layouts.</td>
</tr>
<tr>
<td>Add components to the page</td>
<td>Components are the base elements of your page. Components range from core elements like buttons and labels to more complex experience components like lists and forms. For more information, see Work with components.</td>
</tr>
</tbody>
</table>
### Task Description

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>☢️ Note: You can also find information about UI Builder components on the ServiceNow developer site. For more information, see the component documentation on <a href="http://www.devportaldocs.service-now.com/">www.devportaldocs.service-now.com/</a>.</td>
<td></td>
</tr>
</tbody>
</table>

#### Connect data resources to the components

- Connect data resources to dynamically expose data from tables, records, or other elements on your page. For more information, see [Work with data resources](#).

### Procedure

1. Navigate to **Now Experience Framework > UI Builder.**
2. In the **My experiences** section, click **CSM/FSM Configurable Workspace.**
3. In the **Page** drop-down menu, select **Landing Page.**
4. In the **Variants** list, select **CSM Landing Page.**
5. Create a landing page variant.
   
   a. Click the additional actions menu next to the **CSM Landing Page** variant and select **Duplicate.**
   
   b. In the Create a variant pop-up window, add a **Variant name.**
   
   c. Click **Create.**
   
   d. If desired, specify the audience and display conditions for the page variant. The audience determines who can see the page. An audience is a collection of user roles. For more information, see [Understanding your audiences](#).

   The **Order** field determines which page is displayed. The page with the lowest order number is displayed first.
   
   e. Click **Save.**

6. Add or modify containers and components for the landing page variant. See the UI Builder documentation for details about adding or modifying containers and components.
Add components to a page: Beginning with step 4, use this task to add a component to a container and to configure the component properties and event handlers. This task also contains information about adding additional containers.

Add styling to a component: Beginning with step 3, set CSS styles for a component to change its default appearance.

Add a modal to a component: Beginning with step 5, add a window that appears when a user clicks a component. For example, if you add a button component that deletes a record, you can add a modal that asks the user to confirm the record deletion.

7. Click Save to save the page variant.

Set up a ribbon configuration in CSM Configurable Workspace
You can create a ribbon setting and add that setting to a ribbon configuration for CSM Configurable Workspace.

Before you begin
Role required: workspace_admin, ui_builder_admin, admin

About this task
After creating a new ribbon setting, such as creating another version of the Customer 360 ribbon component, you must link the setting to the ribbon configuration if you want it to appear in CSM Configurable Workspace.

Note: You can also use ribbon settings from CSM Agent Workspace in CSM Configurable Workspace if you link the setting to the ribbon configuration.

One ribbon configuration, CSM/FSM Configurable Workspace Ribbon Config, is included with CSM Configurable Workspace. This configuration includes the Customer 360, Timeline, and Active SLA ribbon components. You can use this configuration out of the box without completing any additional configuration steps.

Procedure
1. Create a ribbon setting.


   b. Click New.
c. Fill in the fields on the Ribbon Setting form. For field descriptions, see Set up ribbons in workspace.

d. Click Submit.

2. Add the ribbon setting to the ribbon configuration.

a. Navigate to Now Experience Framework > Configuration Settings > UX Ribbon Configurations.

b. Select the configuration from the UX Ribbon Configurations list.

c. In the Ribbon Configuration Settings related list, click New.

   Note: You may need to configure the form to display the related list.

d. Select a table in the Table field.

e. Select the ribbon setting in the Ribbon field.

f. Click Submit.

Set up a form header in CSM Configurable Workspace

You can create a form header for use in CSM Configurable Workspace.

Before you begin
Role required: workspace_admin, ui_builder_admin, admin

About this task
After creating a form header, you must link it to a form header configuration if you want it to appear in CSM Configurable Workspace.

   Note: You can also use form headers from CSM Agent Workspace in CSM Configurable Workspace if you link the setting to the form header configuration.

One form header configuration, CSM/FSM Configurable Workspace Header Config, is included with CSM Configurable Workspace. You can use this configuration out of the box without completing any additional configuration steps.
Procedure

1. Create a form header.
   a. Navigate to Now Experience Framework > Configuration Settings > UX Form Header.
   b. Click New.
   c. Fill in the fields on the Ribbon Setting form. For field descriptions, see Set up form headers in workspace.
   d. Click Submit.

2. Add the form header to the form header configuration.
   a. Navigate to Now Experience Framework > Configuration Settings > UX Header Configurations.
   b. Select the header configuration.
   c. In the Workspace Form Headers related list, click Edit.
      Note: You may need to configure the form to display the related list.
   d. Move the desired form header from the left column to the right column to add it to the header configuration.
   e. Click Save.

Set up a highlighted value in a form header in CSM Configurable Workspace
You can configure fields that appear as highlighted values in a form header in CSM Configurable Workspace.

Before you begin
Role required: workspace_admin, ui_builder_admin, admin

About this task
After creating a highlighted value, you must link it to a highlighted value configuration if you want it to appear in CSM Configurable Workspace.
Note: You can also use highlighted values from CSM Agent Workspace in CSM Configurable Workspace if you link the value to the highlighted value configuration.

One highlighted value configuration, **CSM/FSM Configurable Workspace Highlighted Value Config**, is included with CSM Configurable Workspace. You can use this configuration out of the box without completing any additional configuration steps.

**Procedure**

1. Create a highlighted value.
   
a. Navigate to **Now Experience Framework > Configuration Settings > UX Highlighted Values**.

   b. Click **New**.

   c. Fill in the fields on the Highlighted Value form and click **Submit**. For field descriptions, see **Highlight values in the form header**.

   d. In the Highlighted Values list, click the record you just created.

   e. In the Highlighted Value Conditions related list, click **New**.

   f. Fill in the fields on the Highlighted Value Condition form. For field descriptions, see **Highlight values in the form header**.

   g. Click **Submit**.

2. Add the highlighted value to the highlighted value configuration.
   
a. Navigate to **Now Experience Framework > Configuration Settings > UX Highlighted Values Configurations**.

   b. Select the configuration.

   c. In the Highlighted Values related list, click **Edit**.

   d. Move the desired value from the left column to the right column to add it to the selected configuration.

   e. Click **Save**.
Set up a form action in CSM Configurable Workspace

Create a form action that links to a UI action so that you can use the UI action in CSM Configurable Workspace.

**Before you begin**
Role required: workspace_admin, ui_builder_admin, admin

**About this task**
In order to use UI actions in CSM Configurable Workspace, each UI action must have a corresponding form action.

**Procedure**
1. Navigate to Now Experience Framework > Actions and Events > UX Form Actions.
2. Click New.
3. Enter a name for the form action in the Name field.
   It is recommended that you give the form action the same name as the UI action.
4. In the Action Type field, select UI Action.
5. Select the UI action in the UI Action field.
6. Click Submit.

Display the form ribbon and form header secondary values in the Contextual side panel

Configure the form ribbon and the secondary values that appear in a form header to display in the Contextual side panel in CSM Configurable Workspace.

**Before you begin**
Role required: workspace_admin, ui_builder_admin, admin

**About this task**

⚠️ Note: This task applies to CSM Configurable Workspace.

The form ribbon includes components that provide agents with an overview of case details, such as a customer summary and a case timeline.

The form header for the Case form can display two levels of field values from the Case table. The primary value is the case short description. The secondary values include the account and contact or consumer, the case priority, and the case state.
You can use properties to determine where the form ribbon and secondary values are displayed: at the top of the record or in the Contextual side panel. Two properties are available for the standard record page and two are available for the interaction record.

These properties can operate independently. For example, you can display the form ribbon in the Contextual side panel and the secondary values in the form header.

⚠️ **Note:** The form ribbon properties apply to pages that have active ribbon configurations. If a page does not have a ribbon configuration, or has an inactive ribbon configuration, there is no information for the system to display in either location.

**Procedure**

1. Navigate to **Now Experience Framework > Experiences > CSM/FSM Configurable Workspace**.
2. In the UX Page Properties list, click the desired property.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ribbonLocation</td>
<td>Controls where to display the form ribbon on a standard record page: header or sidebar. For example, the Case record page. Default is sidebar.</td>
</tr>
<tr>
<td>record_secondary_values_location</td>
<td>Controls where to display the form header secondary field values on a standard record page: header or sidebar. For example, the Case record page. Default is sidebar.</td>
</tr>
<tr>
<td>ribbonLocation_interaction</td>
<td>Controls where to display the form ribbon on an interaction record: header or sidebar. Default is sidebar.</td>
</tr>
<tr>
<td>interaction_secondary_values_location</td>
<td>Controls where to display the form header secondary field values on an interaction record: header or sidebar. Default is sidebar.</td>
</tr>
</tbody>
</table>

3. In the **Value** field for the selected property, enter one of the following values.
<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
</table>
| header | Displays the selected component in the following location:  
- Ribbon: at the top of the record.  
- Secondary values: at the top of the record, in the form header below the primary value. |
| sidebar | Displays the selected component in the Contextual side panel. |

4. Click **Update**.

**Display field values as interaction record tab titles**

Display field values, such as contact or consumer names, as titles on interaction record tabs in CSM Configurable Workspace.

**Before you begin**

Role required: workspace_admin, ui_builder_admin, admin

**About this task**

⚠ **Note:** This task applies to CSM Configurable Workspace.

Configure the `sessionTabTitle` property to identify the fields that can be used in interaction record tab titles. Enter fields in this property as a comma separated string.

The system evaluates these fields in the order that they appear in the string. The first field that has a value is used as the interaction record tab title. If none of the fields in the string have values, the system displays the record number as the tab title.

⚠ **Note:** Configured fields must appear on the interaction record.

**Procedure**

1. Navigate to **Now Experience Framework > Experiences > CSM/FSM Configurable Workspace**.
2. In the UX Page Properties list, click the `sessionTabTitle` property.
3. In the **Value** field, enter the fields to use in interaction record tab titles. Enter the fields as a comma separated string. The default string is `contact, consumer, number`. 
Note: Configured fields must appear on the interaction record.

4. Click **Update**.

**Set up CSM Agent Workspace**

Set up CSM Agent Workspace for your agents so they can engage with customers, answer questions, create cases, and resolve issues.

To set up CSM Agent Workspace:

1. Activate the Customer Service plugin (com.sn_customerservice).
2. Set up Agent Workspace.
3. Set up the necessary communication channels and routing.
4. Set up additional components specific to CSM Agent Workspace.

**Activate Customer Service**

The Customer Service plugin (com.sn_customerservice) provides the CSM Agent Workspace functionality. For more information, see **Activate Customer Service Management**.

Additional plugins are required for phone integration. For details, see:

- Agent Workspace phone integration with OpenFrame and computer telephony integration (CTI)
- Configure Agent Chat for Agent Workspace

The FSM Agent Workspace (com.snc.agent_workspace.fsm) plugin activates Field Service for CSM Agent Workspace. Enable this plugin to perform field service tasks in CSM Agent Workspace, such as creating work orders for cases and managing work orders and tasks.

Note: The FSM Agent Workspace plugin activates the Agent Workspace (com.agent_workspace) plugin.

**Set up Workspace**

You can set up Workspace either by using Workspace Guided Setup or by following the setup instructions in the Workspace documentation. For details, see **Set up Workspace**.

**Set up communication channels and routing**

Enable agents to chat with customers or to receive and place customer calls. You can also set up routing that automatically directs chats to the appropriate
agents. For more information about communication channels, see Phones and chat in Workspace.

<table>
<thead>
<tr>
<th>Channel</th>
<th>Description</th>
<th>Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chat</td>
<td>CSM Agent Workspace uses Agent Chat to enable customers to ask questions and receive information through live or automated chat.</td>
<td>Configure Agent Chat for Agent Workspace</td>
</tr>
<tr>
<td>Phone</td>
<td>CSM Agent Workspace uses a combination of OpenFrame and computer telephony integration (CTI) to enable third-party phone integration.</td>
<td>Agent Workspace phone integration with OpenFrame and computer telephony integration (CTI)</td>
</tr>
</tbody>
</table>

### Set up CSM Agent Workspace components

Complete these tasks to set up the components that are specific to CSM Agent Workspace.

**Create or modify a landing page**

The landing page is an agent's initial view of the workspace. The CSM Landing Page is included with the Customer Service plugin. You can modify this landing page or you can clone this page to create a new page.

**Configure ribbon components and ribbon component attributes**

The form ribbon includes components that display information about a record. You can add the Customer 360, Timeline, and SLA components to the Case form ribbon. You can also configure attributes for the Customer 360 and Timeline components.

**Configure service catalogs for CSM Agent Workspace**

Customer service agents use service catalogs to fulfill catalog item requests. You can configure the Service Workspace Portal to use the catalogs that contain the desired items.

**Create a CSM Agent Workspace landing page**

Create landing pages for different agents and teams by cloning the CSM Landing Page and adding or modifying components and visualizations.

**Before you begin**
Role required: workspace_admin, admin
About this task

The **CSM Landing Page** is included with the Customer Service plugin (com.sn_customerservice). You can add Performance Analytics information to this landing page by activating the Performance Analytics - Content Pack - Customer Service Management - Advanced plugin (com.snc.pa.customer_service_advanced). This plugin adds a section for **My Organization's Performance**, which includes analytics for **CSAT** and **New vs Closed Cases**.

Procedure

1. Navigate to **Workspace Experience > Administration > Landing Pages**.
2. Click the **CSM Landing Page**.
3. Click **Clone Page**.

   ✔ **Note:** The **Clone Page** action is available when the application scope is CSM Workspace.

4. Fill out the form.

   The settings in the **Layout** and **Available Child Slots** fields determine how the content renders on the page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of your landing page.</td>
</tr>
<tr>
<td>Component</td>
<td>The component defaults to sn-page and is read-only.</td>
</tr>
<tr>
<td>Order</td>
<td>The order for the landing page. If you have multiple landing pages, the order determines the landing page precedence. Pages with a lower order value take precedence over pages with a higher order value.</td>
</tr>
<tr>
<td>Active</td>
<td>Determines whether the landing page is active. This field must be enabled for a landing page to be displayed.</td>
</tr>
<tr>
<td>Optional Page Title</td>
<td>A title to display on the page.</td>
</tr>
<tr>
<td>Available Child Slots</td>
<td>A predefined style of child slots.</td>
</tr>
</tbody>
</table>
5. Click **Update** to save your landing page.

6. **Optional:** Configure permissions for users to access the landing page.
   a. Click the **UX Page Element Permissions** related list.
   b. Click **New**.
   c. Select the role or group for the landing page to be visible.
   d. Click **Submit** to save your permissions.
   Any page element (including sub elements) can have a restriction to a given set of roles or groups. If there are no element permissions set on roles or groups, then all users see the element. If there are some element permissions set, then a user needs just one role or group assignment to see the element.

7. Configure a container:
   a. Click the **UX Page Elements** related list.
   b. Click **New Container** or select an existing container.
   c. Fill out the form.

### Container attributes and layout

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of your container.</td>
</tr>
<tr>
<td>Component</td>
<td>The component defaults to sn-page-container and is read-only.</td>
</tr>
<tr>
<td>Parent element</td>
<td>The landing page your container resides.</td>
</tr>
<tr>
<td>Slot</td>
<td>The component placement within the parent element's slot configuration.</td>
</tr>
<tr>
<td>Order</td>
<td>The order the page shows.</td>
</tr>
<tr>
<td>Border</td>
<td>Enable if you want a border around your container.</td>
</tr>
<tr>
<td>Optional Container Title</td>
<td>A title to display on the container.</td>
</tr>
</tbody>
</table>
8. Configure a widget:
   
   a. Click **New Visualization** or select an existing widget.
   
   b. Fill out the form.

**Widget attributes and layout**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of your widget.</td>
</tr>
<tr>
<td>Component</td>
<td>The component defaults to sn-page-widget-visualization and is read-only.</td>
</tr>
<tr>
<td>Parent element</td>
<td>The container that your widget resides in.</td>
</tr>
<tr>
<td>Slot</td>
<td>The component placement within the parent element's slot configuration.</td>
</tr>
<tr>
<td>Order</td>
<td>The order the component shows.</td>
</tr>
</tbody>
</table>
| Report          | Select the report you want to render:  
   - Single score  
   - Trend by  
   - List  

Note: Choose and populate either **Report** or **PA Widget**, but you cannot display both.

| PA Widget       | Select the PA widget you want to render:  
   - Single score  
   - Time series |
### Field | Description
--- | ---
**Note:** Choose and populate either Report or PA Widget, but you cannot display both.

<table>
<thead>
<tr>
<th>Optional Widget Label</th>
<th>A label to display on the widget.</th>
</tr>
</thead>
</table>
| Size Variant          | Select the size of the widget. Choices include:  
  - Small  
  - Medium  
  - Large  
  - Extra Large  
  **Note:** Not all size variants apply to all widgets.  

<table>
<thead>
<tr>
<th>Border</th>
<th>Check if you want a border around your widget.</th>
</tr>
</thead>
</table>
| Refresh Interval      | Determines the number of minutes before a widget refreshes with new data. The interval begins when a user navigates away from a landing page, and ends when the user comes back to the landing page.  
  **Note:** There is no auto-refresh, but a user can click a refresh button at any time. |
| Additional Details    | Any additional information to note about the widget. |
| Visualization SysID [Read Only] | Designated ID for the widget. |
| Report Type [Read Only] | The type of report that renders. |

9. Click **Update** or **Submit** to save changes to the page element.

10. Click **Update** to save changes to the landing page.

**Configure ribbon components**

Configure ribbon components to give your agents only the information they need.
Before you begin
Role required: workspace_admin
You can configure attributes for the following Customer Service Management ribbon components:

- **Customer 360**: displays customer information such as the contact or consumer name, email address, and phone numbers. This component includes fields for both a primary user and a secondary user. If the system does not find a valid primary user in the configured table, it then queries for the secondary user.

  Note: With the CSM Extension for Proxy Contacts (com.snc.csm_proxy_contacts) plugin, a tertiary user, the internal contact, is also available.

- **Timeline**: displays a summary of case activities, including case state changes and interactions between the agent and the customer. It also shows how much time that the agent and customer, or requester, spent on the case. The timeline ribbon component uses the resolution shaper configuration for the selected entity table, for example, the Case table.

  Note: If the Resolution Shaper Configs table (sys_resolutionshaper_config) does not have a record for the selected entity table, the timeline component displays a message that a configuration is not available.

Procedure
1. Navigate to **Workspace Experience > Forms > Ribbon Settings** and then click the desired component.
2. To configure the Customer 360 component, click **Customer 360**, fill in the fields in the Ribbon Component Attributes section of the form, and click **Update**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary user</td>
<td>The reference field from the table selected in the <strong>Table</strong> field that provides customer information for the primary user. For example, <strong>Contact</strong>.</td>
</tr>
<tr>
<td>Primary reference table</td>
<td>The table that stores information for the <strong>Primary user</strong> field.</td>
</tr>
<tr>
<td>Primary fields</td>
<td>The reference fields from the <strong>Primary reference table</strong> that provide additional information for the <strong>Primary user</strong>.</td>
</tr>
</tbody>
</table>
### Table: Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secondary user</td>
<td>The reference field from the table selected in the <strong>Table</strong> field that provides customer information for the secondary user. For example, <strong>Consumer</strong>.</td>
</tr>
<tr>
<td>Secondary reference table</td>
<td>The table that stores information for the <strong>Secondary user</strong> field.</td>
</tr>
<tr>
<td>Secondary fields</td>
<td>The reference fields from the <strong>Secondary reference table</strong> that provide additional information for the <strong>Secondary user</strong>.</td>
</tr>
<tr>
<td>Tertiary user</td>
<td>The reference field from the table selected in the <strong>Table</strong> field that provides customer information for the tertiary user. For example, <strong>Internal contact</strong>.</td>
</tr>
<tr>
<td>Note:</td>
<td>The fields for the tertiary user are available with the CSM Extension for Proxy Contacts (com.snc.csm_proxy_contacts) plugin.</td>
</tr>
<tr>
<td>Tertiary reference table</td>
<td>The table that stores information for the <strong>Tertiary user</strong> field.</td>
</tr>
<tr>
<td>Tertiary fields</td>
<td>The reference fields from the <strong>Tertiary reference table</strong> that provide additional information for the <strong>Tertiary user</strong>.</td>
</tr>
</tbody>
</table>

3. To configure the timeline component:

   a. Click **Timeline**.

   b. In the Ribbon Component Attributes section of the form, select a role in the **Fulfiller role** field.

   All of the case activities that are performed by the user with the selected fulfiller role are displayed in the timeline component as from the fulfiller. The other case activities are displayed as from customers. For CSM, the default fulfiller role is **sn_esm_agent**.

   The timeline ribbon component uses the resolution shaper configuration for the selected entity table. In this configuration, you can set the labels for the fulfiller and requester fields that appear in the timeline.

   The **Fulfiller Label** on the Resolution Shaper Config form should match the timeline component **Fulfiller role** attribute. For example, if the **Fulfiller role** is set to **sn_esm_agent**, which is an agent role, the **Fulfiller Label** should refer to an agent.
For more information about the resolution shaper configuration, see Customer service case timeline.

Note:
Changes that you make to the resolution shaper configuration affect both Agent Workspace and the platform interface.

c. Click Update.

Configure service catalogs for CSM Workspaces
Customer service agents use service catalogs to fulfill catalog item requests. You can configure the Service Workspace Portal to use the catalogs that contain the desired items.

Before you begin
Role required: sp_admin, admin

Procedure
1. Navigate to Service Portal > Portals.
2. Click Service Workspace Portal.
3. Click the Catalogs related list and then click Edit.

Note: If you are not able to edit the Catalogs related list, make sure you are in the Service Catalog - Service Workspace application.
4. Add the desired catalogs to the Catalogs list (for example, Customer Service).
5. Click Save.
The catalog items belonging to the configured service catalogs are shown in CSM workspaces.

Set up CSM workspace features
You can set up additional features for use in CSM workspaces. These features typically require plugin activation and some configuration.
You can set up the following features for use in CSM workspaces.
CSM workspace features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
</table>
| Customer Central | Customer Central provides customer service agents with all the information about the customer in one central place.  
• The Customer Information view displays key information about the customer.  
• The Customer Activity view displays recent customer touch points in an activity feed.  
Use Customer Service guided setup to Configure Customer Central. |
| Customer Service Case Types | Configure case types to handle different types of customer issues. A case type identifies the processes and the data needed to resolve a specific type of issue, such as a lost or missing credit card.  
Use Customer Service guided setup to Configure customer service case types. |
| Proactive Customer Service Operations | Use this feature to track the digital services used by your customers and to proactively create cases for service disruptions.  
| Playbooks for Customer Service Management | Playbooks provide step-by-step guidance for completing the tasks needed to resolve specific types of customer service cases.  
The following playbooks are available for Customer Service Management from the ServiceNow Store:  
• Case playbook for onboarding  
• Case playbook for complaints  
• Case playbook for product support |
| Guided Decisions for Customer Service Management | Resolve complex cases faster and more efficiently by guiding customer service agents through a structured troubleshooting process. |
CSM workspace features (continued)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>For details, see Configure Guided Decisions for Customer Service Management.</td>
</tr>
<tr>
<td>Lookup and verify</td>
<td>This feature enables customer service agents to quickly look up contacts or consumers using information such as the name, phone number, or record number. For details, see Set up lookup and verify in Workspace.</td>
</tr>
<tr>
<td>Estimated time to resolve a case</td>
<td>Use machine learning to predict the estimated time to resolve a case (ETTR) based on case attributes such as the short description, category, priority, and assignment group. For details, see Configure estimated time to resolve a case.</td>
</tr>
</tbody>
</table>

Migrating to Configurable Workspace

If you are currently using CSM Agent Workspace, you can implement CSM Configurable Workspace and continue using some of your existing CSM Agent Workspace configurations.

Some configurations can be used by both CSM workspaces while others need to be configured specifically for CSM Configurable Workspace. Of these CSM Configurable Workspace-specific configurations, some are accomplished in the platform interface using lists and forms, while others are accomplished using the Now® Experience UI Builder.

Use the topics in the following table to explore CSM Configurable Workspace features. Then follow the steps to implement CSM Configurable Workspace and migrate your existing CSM Agent Workspace configurations.

<table>
<thead>
<tr>
<th>Explore</th>
<th>Migrate</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Explore CSM Configurable Workspace</td>
<td>1. Set up CSM Configurable Workspace</td>
</tr>
<tr>
<td>• Workspaces in Customer Service Management</td>
<td>2. Migrate to CSM Configurable Workspace</td>
</tr>
<tr>
<td>• Selecting a CSM workspace interface</td>
<td></td>
</tr>
</tbody>
</table>
Explore CSM Configurable Workspace

CSM Configurable Workspace is a workspace that can easily be configured and extended using Now® Experience UI Builder.

UI Builder is a drag-and-drop web user interface builder that you can use to build and configure CSM Configurable Workspace pages and components.

UI Builder

Working in UI Builder enables you to preview the final interface of the workspace you’re building and to see the effects of different configurations. For CSM Configurable Workspace, some configurations are also performed in lists and forms.

Working in UI Builder

A page in a workspace is made up of components that enable your users to accomplish one or more tasks. For example, you can create a page to solve employee software issues at your company.

You build out the functionality within the page by adding the components that you need for your user experience. Components are elements like buttons and data visualizations. UI Builder comes with a library of components you can add to the page.
After the components are on your page, you can change the layout any way you want. For example, you can use themes to make a page match your company’s styles and standards. All you have to do is configure your themes in an Experience by using JSON-formatted CSS.

Add an event mapping to a component. Event mapping is an important process within UI Builder. When you build pages with components, you need those pages to actually perform actions for users. For example, you can map a button to an event handler to perform a button action when a user selects that button. Another example may be adding a data resource such as a form. You could set up an event handler to notify a user when the page succeeds in loading the form.

UI Builder is as powerful as you need it. You can build simple web experiences, or you can create complex data-driven experiences.

**Related information**

Now Experience UI Builder

**Migrate to CSM Configurable Workspace**

Follow the instructions in this topic to migrate from CSM Agent Workspace to CSM Configurable Workspace.

If you are currently using CSM Agent Workspace and want to migrate to CSM Configurable Workspace, you can continue using most of your existing configurations. Some features, however, need to be configured specifically for CSM Configurable Workspace. You can migrate some of the configurations using lists and forms and others using the UI Builder tool.

<table>
<thead>
<tr>
<th>Workspace configurations</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configurations that work in both CSM Agent Workspace and CSM Configurable Workspace</td>
<td>• Ribbons</td>
</tr>
<tr>
<td></td>
<td>• Forms</td>
</tr>
<tr>
<td>Configurations that are different for CSM Configurable Workspace.</td>
<td>• Lists</td>
</tr>
<tr>
<td></td>
<td>• List categories</td>
</tr>
</tbody>
</table>

Also, be aware that some configuration changes made for one workspace can also affect the other. For example, changes to the CSM Agent Workspace configuration may impact CSM Configurable Workspace. The same applies to changes to the CSM Configurable Workspace configuration, which may impact CSM Agent Workspace.
Note: For customers who are not currently using CSM Agent Workspace and want to implement CSM Configurable Workspace:

- Use the CSM Configurable Workspace guided setup by navigating to Customer Service > Administration > Guided Setup > CSM Configurable Workspace. Clicking Configure in this category takes you to the Configurable Workspace guided setup. The information and instructions in the different guided setup categories can help you set up a new implementation of CSM Configurable Workspace.

- For additional information, see Setting up Workspace

Workspace features
This section provides information, parameters, and steps to complete the migration of CSM Agent Workspace configurations to CSM Configurable Workspace.

Select the feature that you want to migrate from the following list.

Activity Stream
Learn about how the CSM Agent Workspace Activity Stream functions in CSM Configurable Workspace.

Activity Stream enables agents to communicate with requesters and make internal notes about the work done on a record. Configure the Activity Stream and Activity Stream Compose components in UI Builder to set up Activity Stream in CSM Configurable Workspace.

Activity Stream corresponding parameters
CSM Agent Workspace Activity Stream matched with CSM Configurable Workspace parameters.

Note: Not every CSM Configurable Workspace component parameter has a corresponding CSM Agent Workspace (legacy) parameter.

<table>
<thead>
<tr>
<th>Component</th>
<th>Legacy component name</th>
<th>Legacy component parameter name</th>
<th>UIB component parameter name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity Stream</td>
<td>now-activity-stream-connected</td>
<td>table</td>
<td>table</td>
</tr>
<tr>
<td></td>
<td></td>
<td>sysID</td>
<td>sysID</td>
</tr>
<tr>
<td></td>
<td></td>
<td>isNewRecord</td>
<td>isNewRecord</td>
</tr>
<tr>
<td></td>
<td></td>
<td>title</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>view</td>
<td></td>
</tr>
<tr>
<td>Component</td>
<td>Legacy component name</td>
<td>Legacy component parameter name</td>
<td>UIB component parameter name</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------</td>
<td>---------------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>showConversationFilter</td>
<td>showConversationFilter</td>
</tr>
<tr>
<td></td>
<td></td>
<td>showTileAvatars</td>
<td>showTileAvatars</td>
</tr>
<tr>
<td></td>
<td></td>
<td>showTileIcons</td>
<td>showTileIcons</td>
</tr>
<tr>
<td></td>
<td></td>
<td>events</td>
<td>events</td>
</tr>
<tr>
<td></td>
<td></td>
<td>supplemental</td>
<td>supplemental</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ambChannels</td>
<td>ambChannels</td>
</tr>
<tr>
<td></td>
<td></td>
<td>filterOptions</td>
<td>filterOptions</td>
</tr>
<tr>
<td></td>
<td></td>
<td>timestamp</td>
<td>timestamp</td>
</tr>
<tr>
<td>Activity Stream</td>
<td>now-activity-stream-compose-connected</td>
<td>table</td>
<td>table</td>
</tr>
<tr>
<td>compose</td>
<td></td>
<td>sysID</td>
<td>sysID</td>
</tr>
<tr>
<td></td>
<td></td>
<td>isNewRecord</td>
<td>isNewRecord</td>
</tr>
<tr>
<td></td>
<td></td>
<td>fields</td>
<td>Fields</td>
</tr>
<tr>
<td></td>
<td></td>
<td>title</td>
<td>title</td>
</tr>
<tr>
<td></td>
<td></td>
<td>useTabs</td>
<td>useTabs</td>
</tr>
</tbody>
</table>

**Agent assist**

Learn about how the CSM Agent Workspace Agent assist functions with CSM Configurable Workspace.

Agent assist provides agents with automatic search results that show possible solutions for records they open. Configure Agent assist in CSM Configurable Workspace by configuring a record page with a Glide form data source and a Contextual Sidebar. For more information, see [Agent assist UIB setup](#).

**Agent Chat**

Learn how the CSM Agent Workspace Agent Chat functions with CSM Configurable Workspace.

Agent Chat enables agents to interact with customers, create incident or case records, or transfer chats to another agent or queue. CSM Agent Workspace Agent Chat configurations work with CSM Configurable Workspace.
Agent Chat corresponding parameters
Parameters that are hidden in UI Builder (UIB) are not configurable in UIB. These parameters are used for specific customer workflow use cases.

<table>
<thead>
<tr>
<th>Component</th>
<th>Legacy component name</th>
<th>Legacy component parameter name</th>
<th>UIB component parameter name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent Chat</td>
<td>sn-chat</td>
<td>Interaction - Active</td>
<td>• Interaction Sys ID - Active (Hidden in UIB)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• User isUxf (Hidden in UIB)</td>
</tr>
</tbody>
</table>

Branding and theming
Learn about branding and theming for your CSM Configurable Workspace.
Branding and theming enables you to customize your CSM Configurable Workspace to your company branding and theming. Configure your CSM Configurable Workspace branding and theming in UI Builder to brand and theme your CSM Configurable Workspace. For more information, see Workspace branding and theming settings.

Email Composer and Email Viewer
Learn about how the Email Composer and Email Viewer function with CSM Configurable Workspace.

Email Composer
The Email Composer enables requestors and fulfillers to use email to communicate.

<table>
<thead>
<tr>
<th>Email Composer corresponding tables</th>
</tr>
</thead>
<tbody>
<tr>
<td>Legacy table name</td>
</tr>
<tr>
<td>No corresponding table</td>
</tr>
</tbody>
</table>

Configure the Email Composer in UI Builder.

Email Viewer
The Email Viewer enables customer service agents to view emails in the Agent workspace.
Configure the Email Viewer in UI Builder.

**Customer Central**

Learn about how CSM Agent Workspace Customer Central functions with CSM Configurable Workspace.

Customer Central displays all the touch points that a customer has had with a contact center in the form of information cards. CSM Agent Workspace Customer Central configurations function in CSM Configurable Workspace. Configuration changes at the sn_customercentral_cust_info_config and sys_declarative_action_assignment and their related lists, however, can be configured in CSM Configurable Workspace.

- Set up the Customer Information view in CSM Configurable Workspace using Guided Setup.
- Set up the Customer Information view in CSM Agent Workspace using Guided Setup.

**Declarative actions**

Learn how the CSM Agent Workspace declarative actions function with CSM Configurable Workspace.

Declarative actions add custom functionality to your Workspace forms, fields, lists, and related lists without writing custom scripts or learning APIs. Declarative actions include: list actions, related list actions, and field decorators.
Declarative actions corresponding tables (continued)

<table>
<thead>
<tr>
<th>Legacy table name</th>
<th>UIB table name</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>UX Add-on Event Mapping</td>
</tr>
<tr>
<td></td>
<td>[sys_ux_addon_event_mapping]</td>
</tr>
</tbody>
</table>

To migrate a declarative action, convert your custom declarative actions to new UXF Client Action type, and then define the corresponding add-on event mapping. For more information, see Custom Playbook actions.

Forms

Learn how the CSM Agent Workspace form functions with CSM Configurable Workspace.

The form is the user interface where agents do most of their work. CSM Agent Workspace form configurations work without modification in CSM Configurable Workspace, but the configurations may affect the functioning of your CSM Configurable Workspace.

Form parameters

Form mapping doesn’t directly correspond between CSM Agent Workspace form components and CSM Configurable Workspace form components. CSM Agent Workspace components are hard-coded with the form and incorporate everything on the form including the form header, UI action bar, Activity Stream, the sidebar, etc. In CSM Configurable Workspace, these features are separate components.

Form headers

Learn how CSM Agent Workspace form headers function with CSM Configurable Workspace.

Form headers provide an overview of the record.

Form header corresponding tables

<table>
<thead>
<tr>
<th>Legacy table name</th>
<th>UIB table name</th>
</tr>
</thead>
<tbody>
<tr>
<td>sys_aw_form_header</td>
<td>sys_aw_form_header</td>
</tr>
<tr>
<td></td>
<td>sys_ux_header_config</td>
</tr>
<tr>
<td></td>
<td>sys_ux_m2m_workspace_header_ux_header_config</td>
</tr>
</tbody>
</table>

To migrate your CSM Agent Workspace form header to CSM Configurable Workspace, add an additional step in custom form headers to the CSM Configurable Workspace form header setup.
• An additional form header configuration is provided out of box, CSM/FSM Configurable Workspace Header Config.

• Legacy form headers function without modification, but may affect the functionality of CSM Configurable Workspace.

• Add the Form header component to your CSM Configurable Workspace for additional functionality.

For additional information, see Set up a form header in CSM Configurable Workspace.

Global Search
Learn about how the CSM Agent Workspace Global Search functions with CSM Configurable Workspace.

Global Search provides users with the ability to search for information within the defined search sources.

<table>
<thead>
<tr>
<th>Legacy table name</th>
<th>UIB table name</th>
</tr>
</thead>
<tbody>
<tr>
<td>sys_aw_global_search_config</td>
<td>sys_ux_page_property</td>
</tr>
</tbody>
</table>

Update the Global Search property in CSM Configurable Workspace
Update the custom Global Search property in CSM Agent Workspace to migrate to CSM Configurable Workspace.

Before you begin
Role required: admin

Procedure
1. Obtain the Global Search Sys ID from your CSM Agent Workspace.
   a. In your CSM Agent Workspace enter `sys_aw_global_search_config.list` in the Filter navigator.
   b. Select **Workspace search settings** from the list.
   c. Right-click the form header, and select **Copy sys_id**.
2. Enter the Global Search Sys ID into your CSM Configurable Workspace.
a. In your CSM Configurable Workspace, enter sys_ux_page_property.list
b. Select global_search_configurations from the list.
c. In the Value field, replace the Sys ID with the Sys ID copied from your CSM Agent Workspace.

3. Select Update.

Highlights
Learn how CSM Agent Workspace highlights function with CSM Configurable Workspace.

Highlights provide background color that visually expresses the status of a highlighted value. The status you choose determines the color highlight

<table>
<thead>
<tr>
<th>Highlight corresponding tables</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Legacy table name</strong></td>
</tr>
<tr>
<td>sys_highlighted_value</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

To migrate your highlights, add an extra step in the custom highlighted values to CSM Configurable Workspace.

An additional highlighted value configuration is provided out of box, CSM/FSM Configurable Workspace Highlighted Value Config.

- Legacy highlighted values in form headers work without modification, but may affect the functionality of CSM Configurable Workspace.
- Highlighted values must be added to a highlighted value configuration to appear in CSM Configurable Workspace.

For more information, see Set up a highlighted value.

Lists
Learn about how CSM Agent Workspace lists function with CSM Configurable Workspace.

The list view displays filtered lists of records, such as All tasks, Open tasks, and My tasks. By setting up list categories and filtered lists, you help your agents quickly find the records they need to work on. Configure your Workspace lists setups in CSM Configurable Workspace.
List Menu Configuration
The Menu Configuration is a container that houses the default configurations of the list menu which consists of categories and filters.

<table>
<thead>
<tr>
<th>Legacy table name</th>
<th>UIB table name</th>
</tr>
</thead>
<tbody>
<tr>
<td>No corresponding table</td>
<td>sys_ux_list_menu_config</td>
</tr>
</tbody>
</table>

The List Menu setup is added by default to CSM Configurable Workspace. Associate your list and list categories with this configuration.

List categories
List categories enable you to group records so that agents can find the records they need to work on.

<table>
<thead>
<tr>
<th>Legacy table name</th>
<th>UIB table name</th>
</tr>
</thead>
<tbody>
<tr>
<td>sys_aw_list_category</td>
<td>sys_ux_list_category</td>
</tr>
</tbody>
</table>

List category data lives in a new UIB table. For more information about setting up list categories, see List categories.

Filtered lists
Filtered lists enable you to group records that help agents do their work more efficiently.

<table>
<thead>
<tr>
<th>Legacy table name</th>
<th>UIB table name</th>
</tr>
</thead>
<tbody>
<tr>
<td>sys_aw_list</td>
<td>sys_ux_list</td>
</tr>
</tbody>
</table>

List filter data lives in a new UIB table. For more information about setting up list filters, see List filters.

Note: Roles and groups are defined in the UIB table and are not applicable.
Role and Access
Roles and access enable you to define the audience of each of the lists defined in the list filters.

Role and Access corresponding tables

<table>
<thead>
<tr>
<th>Legacy table name</th>
<th>UIB table name</th>
</tr>
</thead>
<tbody>
<tr>
<td>sys_aw_list</td>
<td>sys_ux_applicability_m2m_list</td>
</tr>
</tbody>
</table>

To migrate roles and access, select a filtered list and choose the audience.

Ribbons
Learn how CSM Agent Workspace ribbons function with CSM Configurable Workspace.

Ribbons help agents quickly scan relevant information about a record, such as a timeline, a user, or a customer summary.

Ribbon corresponding tables

<table>
<thead>
<tr>
<th>Legacy table name</th>
<th>UIB table name</th>
</tr>
</thead>
<tbody>
<tr>
<td>sys_aw_ribbon_setting</td>
<td>sys_aw_ribbon_setting</td>
</tr>
<tr>
<td></td>
<td>sys_ux_ribbon_config</td>
</tr>
<tr>
<td></td>
<td>sys_ux_ribbon_config_setting</td>
</tr>
</tbody>
</table>

Legacy ribbon widgets work in CSM Configurable Workspace, but not the legacy ribbon configurations. Add ribbon settings to a ribbon configuration to appear in CSM Configurable Workspace.

For more information, see Set up a ribbon configuration in Configurable Workspace.

UI Action Bar
Learn how the CSM Agent Workspace UI Actions component functions with CSM Configurable Workspace.

UI actions include custom buttons, menu items, and limiting access to forms based on user role. The UI Action Bar component replaces the UI Actions component in CSM Agent Workspace Workspace.
## UI Action Bar corresponding tables

<table>
<thead>
<tr>
<th>Legacy table name</th>
<th>UIB table name</th>
</tr>
</thead>
<tbody>
<tr>
<td>sys_ui_action</td>
<td>sys_ui_action sys_ux_form_action</td>
</tr>
</tbody>
</table>

To migrate UI actions, each UI action must have a corresponding form action to use UI actions in CSM Configurable Workspace.

For more information, see [Set up a form action in CSM Configurable Workspace](#).

### Configure Playbooks for Customer Service Management

Configure different playbook settings, such as selecting the activity view and determining activity visibility.

Some of the configuration for a playbook is performed in UI Builder as part of the playbook component configuration. Additional settings can be configured in the playbook experience configuration record. These settings include selecting the playbook activity view and configuring playbook stage and activity visibility.

#### Selecting a playbook activity view

The activity view determines how the stages and activities are displayed in the playbook.

- **Stacked**: Displays the stages in the playbook lifecycle panel and cards for each of the activities in the current stage in the playbook work area.
- **Focused**: Displays the stages and activities in the playbook lifecycle panel and the current activity in the playbook work area.

Users with the system administrator role can select a playbook activity view in the playbook component configuration in UI Builder.

#### Configuring playbook stage and activity visibility

The following fields control the visibility of playbook stages and activities.

- **Hide Inaccessible Activity**: Accessibility is determined by user permissions. When enabled, the user cannot see an activity if they do not have permissions to view the data associated with the activity. If all activities in a stage are inaccessible to the user, the stage is also hidden.
- **Control Activity Display**: Pending activities are those activities that have not yet been triggered. Select one of the options in this field to show or hide pending activities.

Users with the system administrator role can configure playbook stage and activity visibility in the playbook experience configuration record.
Configuring a playbook to use compact mode

Compact mode moves the playbook from a tab in the Workspace to the contextual side panel. Agents can complete playbook activities in the side panel while viewing other tabs in the record page.

Users with the system administrator role can configure a playbook to use compact mode in the playbook component configuration in UI Builder. For more information about configuring this feature, see Integrate Playbook with Workspace.

Previewing a playbook

Users with the playbook experience admin role (playbook_experience.admin) can preview a playbook in real time within a non-production environment. With this feature, playbook experience administrators can easily see and test different playbook settings. For more information, see Preview a playbook in the Workspace administrator documentation.

Selecting a playbook experience

A playbook experience is a defined set of configurations that determines how the system renders a playbook in Workspace. You can use playbook experiences to customize the look and feel of a playbook, map user actions, and override activities.

The Playbook Experience plugin (com.playbook_experience) includes the Global Playbook Experience record, which defines a default playbook configuration.

The Playbooks for Customer Service Management plugin (com.sn_csm_playbook) includes the following additional playbook experience records:

- CSM Configurable Workspace Playbook
- CSM Agent Workspace Playbook

Users with the system administrator role can select a playbook experience when adding a playbook to a page in UI Builder.

Different playbooks for the same record type can use different playbook experiences. For example, if a complaint case uses two playbooks, each playbook can use a different playbook experience.

For more information, see the following topics in the Workspace administrator documentation:

- Create Playbook experience configurations
- Preview a playbook
Select a playbook activity view

The activity view determines how the stages and activities are displayed in the playbook.

Before you begin
Role required: admin

About this task
Users with the system administrator role can select the playbook activity view in the playbook component configuration in UI Builder.

Procedure
1. Navigate to UI Builder and open the playbook component.
2. Click the playbook component.
3. In the Config tab, select a view in the Activity View field.

<table>
<thead>
<tr>
<th>Choice</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stacked</td>
<td>Displays the stages in the playbook lifecycle panel and cards for each of the activities in the current stage in the playbook work area.</td>
</tr>
<tr>
<td>Focused</td>
<td>Displays the stages and activities in the playbook lifecycle panel and the current activity in the playbook work area.</td>
</tr>
</tbody>
</table>

4. Click Save.

Configure playbook stage and activity visibility

Configure the visibility of playbook stages and activities that are pending or that a user cannot access.

Before you begin
Role required: admin

About this task
Use the following fields in the playbook experience configuration record to control the visibility of playbook stages and activities.
• **Hide Inaccessible Activity**: Accessibility is determined by user permissions. When enabled, the user cannot see an activity if they do not have permissions to view the data associated with the activity. If all activities in a stage are inaccessible to the user, the stage is also hidden.

• **Control Activity Display**: Pending activities are those activities that have not yet been triggered. Select one of the options in this field to show or hide pending activities.

**Procedure**

1. Navigate to **Playbook Experience > Playbook Experiences**.
2. Select a Playbook experience.
3. In the Configurations related list, click the desired configuration.
4. Enable the **Hide Inaccessible Activity** check box to hide the activities in a stage that the logged-in user cannot access.
   The default value for this field is false.
5. In the **Control Activity Display** field, select one of the following options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Show all activities</strong></td>
<td>• Shows all activities in a stage.</td>
</tr>
<tr>
<td></td>
<td>• Pending activities are grayed out.</td>
</tr>
<tr>
<td></td>
<td>• Default setting.</td>
</tr>
<tr>
<td><strong>Hide pending activity</strong></td>
<td>• Hides the pending activities in a stage.</td>
</tr>
<tr>
<td></td>
<td>• If all activities are pending and hidden, the stage is grayed out.</td>
</tr>
<tr>
<td><strong>Hide pending lane and activity</strong></td>
<td>• Hides the pending activities in a stage.</td>
</tr>
<tr>
<td></td>
<td>• If all activities are pending and hidden, the stage is also hidden.</td>
</tr>
</tbody>
</table>

6. Click **Update**.

**Related information**

Create Playbook experience configurations
Configure Customer Central

Provide customer service agents with all the information about a customer in one central place by configuring the Customer Information and Customer Activity views for Customer Central.

Before you begin
Role required: admin

About this task
Customer Central provides customer service agents with all the information about the customer in one central place. It enables them to quickly zoom in on the customer issue and provide efficient and empathetic service to their customers.

Customer Central consists of two views, Customer Information and Customer Activity.

Note: If you are using CSM Agent Workspace, Customer Central is displayed on the Interaction record. If you are using CSM Configurable Workspace, Customer Central is displayed on the interaction, account, contact, or consumer records. Both views are highly configurable and can be adapted to suit the needs of your business.

For more details, see Customer Central.

Procedure
1. Navigate to Customer Service > Administration > Guided Setup.
2. On the Getting Started page of the guided setup, click Get Started.
3. In the Customer Central - Customer Information or Customer Central - Customer Activity category, view the list of tasks to configure the feature.

Customer central configuration tasks

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate Customer Central</td>
<td>Activate the Customer Central plugin to use customer central.</td>
</tr>
<tr>
<td>Configure the Customer Information view</td>
<td>Configure the display of the customer information view.</td>
</tr>
<tr>
<td>Configure the Customer Activity view</td>
<td>Configure the display of the customer activity view.</td>
</tr>
</tbody>
</table>
4. To perform a task, click **Configure**. This button opens the page in your instance where the configuration is completed.

**Activate Customer Central**

Activate the Customer Central plugin to use Customer Central.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **System Definition > Plugins**.
2. Search for the plugin com.sn_csm_customer_central.
3. Click **Activate**.

*i Note:* To use Customer Central demo data, activate the Customer Service Management Demo Data (com.snc.customerservice.demo) plugin.

**Create data for Customer Central**

When upgrading from an existing release, customers must run a fix script to create data for Customer Central.

**Before you begin**

Role required: admin

**About this task**

This task applies to customers who are upgrading their release version and installing Customer Central for the first time. Running the fix script creates data in the Activities table for Customer Central.

**Procedure**

1. Navigate to **System Definition > Fix Scripts**.
2. Click the **Create activities for last N days data** fix script.
3. Click **Run Fix Script**.

**Configure Customer Central properties**

Set how many days you want to display data from in Customer Central.
Before you begin
Role required: admin

About this task
This property applies to both the Customer Information and Customer Activity views.

Procedure
1. Navigate to Customer Central > Administration > Properties.
2. Enter the number of days you want to display data from in Customer Central. The default is set to 30.

Configure the Customer Information view using CSM Agent Workspace
Configure the display of the Customer Information view.

Before you begin
Role required: admin

About this task
The Customer Information view displays all touch points that a customer has had with a contact center in the form of information cards.

Note: The following steps can be used to configure the Customer Information view in the CSM Agent Workspace. This is the workspace that is configured using the Now Platform interface.

Procedure
1. Navigate to Customer Service > Administration > Guided Setup.
2. On the Getting Started page of the guided setup, click Get Started.
3. In the Customer Central - Customer Information category, view the list of tasks to configure the feature.

Customer Central - Customer Information configuration tasks

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure your settings for the Customer Information view</td>
<td>Set the Customer Central properties as required.</td>
</tr>
<tr>
<td>Configure customer information lists</td>
<td>Configure the lists to display on the Customer Information view. For example, a list can be recent cases or recent chat interactions.</td>
</tr>
<tr>
<td>Task</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Configure customer information reports</td>
<td>Configure which reports to display on the Customer Information view.</td>
</tr>
<tr>
<td>Configure customer information records</td>
<td>Configure the records to display on the Customer Information view. For example, a record could provide information on the contact or consumer.</td>
</tr>
<tr>
<td>Configure customer information report groups</td>
<td>Configure the groups of reports to display in a single section on the Customer Information view.</td>
</tr>
<tr>
<td>Configure customer information contexts</td>
<td>Associate each list, record, report, and report group configuration you created with a consumer or contact context, depending on who you want to display the information for.</td>
</tr>
</tbody>
</table>

4. To perform a task, click **Configure**.

This button opens the page in your instance where the configuration is completed.

**Configure lists for the Customer Information view**

Configure lists for the Customer Information view.

**Before you begin**

Role required: admin

**About this task**

Lists are displayed in the Customer Information view in Agent Workspace.
Procedure

1. Navigate to **Customer Central > Customer Information > List Configurations**.
2. Click **New**.
3. Fill out the fields, as required.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Enter a title for the list configuration.</td>
</tr>
<tr>
<td>Context table</td>
<td>Select a context table.</td>
</tr>
<tr>
<td>Relationship</td>
<td>Enter the relationship between the context and the list.</td>
</tr>
<tr>
<td></td>
<td><strong>a.</strong> To create a new relationship, click the Lookup icon and then New.</td>
</tr>
<tr>
<td></td>
<td><strong>b.</strong> Enter a name for the relationship.</td>
</tr>
<tr>
<td></td>
<td><strong>c.</strong> In the Applies to table, select either the contact or consumer context table.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td>d.</td>
<td>In the Queries from table select the table from which this list retrieves data.</td>
</tr>
<tr>
<td>e.</td>
<td>In <strong>Query with</strong>, type a script to specify the records to include from the table for the relationship queries. For example:</td>
</tr>
<tr>
<td></td>
<td>current.addQuery(&quot;contact&quot;, parent.sys_id);</td>
</tr>
<tr>
<td>&quot;contact&quot;</td>
<td>is the name of the column in the list table that stores the context ID, for example, contact ID.</td>
</tr>
<tr>
<td>&quot;parent.sys_id&quot;</td>
<td>is the unique key in the contact table that holds the contact record.</td>
</tr>
<tr>
<td>Note:</td>
<td>If building a new relationship, ensure that the exact column name from the list table that stores the context ID is specified here.</td>
</tr>
<tr>
<td>View</td>
<td>Select the name of the view that has the set of columns to display for this list. For information on how to create a view, see Configure the list layout.</td>
</tr>
<tr>
<td>List limit</td>
<td>Enter the number of records to display in the list. You can access the remaining records using pagination.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Configure reports for the Customer Information view**

Configure which reports to display on the Customer Information view.

**Before you begin**
Role required: admin

**About this task**
Reports are displayed in the Customer Information view in Agent Workspace.
Procedure

2. Click New.
3. Fill out the fields, as required.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Enter a title for the report.</td>
</tr>
<tr>
<td>Context table</td>
<td>Select a Context table.</td>
</tr>
<tr>
<td></td>
<td>Note: For example, enter Contact if you want to display all the information about a customer contact.</td>
</tr>
<tr>
<td>Report</td>
<td>Select a report.</td>
</tr>
<tr>
<td></td>
<td>Note: Only pie charts, doughnuts, and single score charts are supported.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Relationship | Enter the relationship between the context and the report.  
- **a.** To create a new relationship, click the Lookup icon and then New.  
- **b.** Enter a name for the relationship.  
- **c.** In the Applies to table, select either the contact or consumer context table.  
- **d.** In the Queries from table select the table from which this list retrieves data.  
- **e.** In **Query with**, enter a script to build the relationship between the context table and the report table. You can also specify any filter conditions if needed. For example: |

```javascript
current.addQuery("contact", 
parent.sys_id);
```

- **"contact"** -> is the name of the column in the report table that stores the context ID, for example, contact ID.  
- **"parent.sys_id"** -> is the unique key in the contact table that holds the contact record.  

Note: If building a new relationship, ensure that the exact column name from the report table that stores the context ID is specified here.

4. **Click Submit.**

**Configure records for the Customer Information view**

Configure the records to display on the Customer Information view. For example, a record could provide information on the contact or consumer.

**Before you begin**

Role required: admin

---

540
About this task
Records are displayed in the Customer Information view in Agent Workspace.

Procedure
1. Navigate to Customer Central > Customer Information > Record Configurations.
2. Click New.
3. Fill out the fields, as required.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Enter a title for the record.</td>
</tr>
<tr>
<td>Context table</td>
<td>Select a Context table.</td>
</tr>
<tr>
<td></td>
<td>Note: For example, enter Contact if you want to display all the information about a customer contact.</td>
</tr>
<tr>
<td>Relationship</td>
<td>Enter the relationship between the context and the record.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>a.</td>
<td>To create a new relationship, click the Lookup icon and then New.</td>
</tr>
<tr>
<td>b.</td>
<td>Enter a name for the relationship.</td>
</tr>
<tr>
<td>c.</td>
<td>In the Applies to table, select the table on which the list appears.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Enter either contact or consumer.</td>
</tr>
<tr>
<td>d.</td>
<td>In the Queries from table select the table from which this list retrieves data.</td>
</tr>
<tr>
<td>e.</td>
<td>In <strong>Query with</strong>, enter a script to build the relationship between the context table and the record table. You can also specify any filter conditions if needed. For example:</td>
</tr>
</tbody>
</table>

```javascript
current.addQuery('sys_id',
    parent.sys_id);
```

“sys_id” => is the name of the column in the record table that stores the context ID, for example, contact ID. “parent.sys_id” => is the unique key in the contact table that holds the contact record. 

**Note:** If building a new relationship, ensure that the exact column name from the record table that stores the context ID is specified here.

| Fields | Select the fields to display on the record. |

4. Click **Submit**.

**Configure report groups for the Customer Information view**

Configure the groups of reports to display in a single section on the Customer Information view.
Before you begin
Role required: admin

About this task
Report groups are displayed in the Customer Information view in Agent Workspace.

Procedure
2. Click New.
3. Fill out the fields, as required.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Enter a title for the report group.</td>
</tr>
<tr>
<td>Context table</td>
<td>Select a Context table.</td>
</tr>
</tbody>
</table>
Configure customer information contexts for the Customer Information view

Associate each list, record, report, and report group configuration you created with a consumer or contact context, depending on who you want to display the information for.

Before you begin
Role required: admin

About this task
Configure customer information cards to display each of the list, record, or report configurations for a consumer or contact. Each customer information card corresponds to a card on the Customer Information view.

Procedure
1. Navigate to Customer Central > Customer Information > Customer Information Contexts.
2. Click the contact or consumer record that you want to add your configuration to.
3. On the Customer Information Cards related list, click New.
4. Add your configuration to create a customer information card.
5. Click Submit.

Note: Repeat these steps for every configuration that you want to add to the contact or consumer record. You can also change the layout and order in which to display the cards on the Customer Information view.

Configure the Customer Information view using the CSM Configurable Workspace

Configure the display of the Customer Information view using the CSM Configurable Workspace.
Before you begin
Role required: admin

About this task
The Customer Information view displays all touch points that a customer has had with a contact center in the form of information cards.

Note: The following steps can be used to configure the Customer Information view in the CSM Configurable Agent Workspace. This is the workspace that is configured using UI Builder, introduced in the Quebec release.

Procedure
1. Navigate to Customer Service > Administration > Guided Setup.
2. On the Getting Started page of the guided setup, click Get Started
3. In the Customer Central - Customer Information for CSM Configurable Workspace category, view the list of tasks to configure the feature.

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure your settings for the Customer Information view</td>
<td>Set the Customer Central properties as required.</td>
</tr>
<tr>
<td>Configure customer information lists</td>
<td>Configure the lists to display on the Customer Information view. For example, a list can be recent cases or recent chat interactions.</td>
</tr>
<tr>
<td>Configure customer information reports</td>
<td>Configure which reports to display on the Customer Information view.</td>
</tr>
<tr>
<td>Configure customer contact cards</td>
<td>Configure the contact card to display contact information on the Customer Information view. For example, a contact card could provide information on the contact, consumer, or account.</td>
</tr>
</tbody>
</table>

4. To perform a task, click Configure.
   This button opens the page in your instance where the configuration is completed.
Configure the Customer Activity view

Configure the display of the Customer Activity view.

Before you begin
Role required: admin

About this task
The Customer Activity view provides customer service agents an overview of all interaction that a customer has had with a contact center in the form of an activity feed.

There are two panels on the Customer Activity view. On the left, the facets categorize the customer touch points and a customer service agent can filter to display the data they want. On the right, the activity feed displays more detailed information on each of the facets in reverse chronological order.

Procedure
1. Navigate to Customer Service > Administration > Guided Setup.
2. On the Getting Started page of the guided setup, click Get Started
3. In the Customer Central - Customer Activity category, view the list of tasks to configure the feature.

Customer Activity - Customer Information configuration tasks

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure component attributes for the Customer Activity view</td>
<td>Set the Customer Activity view component attributes as required.</td>
</tr>
<tr>
<td>Configure activity types</td>
<td>Create an activity type to display in the activity feed on the Customer Activity view.</td>
</tr>
<tr>
<td>Configure activity groups</td>
<td>Create an activity group and then add activity types to the activity group.</td>
</tr>
<tr>
<td>Configure activity type templates</td>
<td>Create an activity type template to define how to display the activity type data on each of the activity tiles in the activity feed.</td>
</tr>
<tr>
<td>Configure activity contexts</td>
<td>Add the activity groups and activity types you created to an activity context, depending on who you</td>
</tr>
</tbody>
</table>
4. To perform a task, click **Configure**.

   This button opens the page in your instance where the configuration is completed.

**Configure component attributes for the Customer Activity view**

Set the Customer Activity view component attributes, as required.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **Customer Central > Administration > Related Items**.
2. Click Customer Activity.
3. Click **Advanced View**.
4. Click the Component Attributes tab.
5. Set the following component attributes, as required.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>childFacetsListSize</td>
<td>Number of child facets to display. Default value is 3.</td>
</tr>
<tr>
<td>activitiesListSize</td>
<td>Number of activities to display in the activity feed. Default value is 10.</td>
</tr>
</tbody>
</table>

**Note:** Avoid making changes to the other component attributes in this list.

**Configure activity types for the Customer Activity view**

Create an activity type to display in the activity feed on the Customer Activity view.

**Before you begin**

Role required: admin
About this task
An activity type is an action that a contact or consumer performs. These actions are displayed in the activity feed on the Customer Activity view. Activity types are displayed in the Customer Activity view in Agent Workspace.

Learn more about configuring activity types from the following video tutorial.

Configure activity types

Procedure
1. Navigate to Customer Central > Feed Configuration > Activity Types.
2. Click New.
3. Fill out the fields, as required.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Enter a name for the activity.</td>
</tr>
<tr>
<td>Activity message</td>
<td>Enter the message that is displayed on the activity tile in the activity feed.</td>
</tr>
</tbody>
</table>

Note: If the message is not yet defined, you can create a message. Refer to the video above on how to create a message.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity source</td>
<td>Enter the table on which the activity is performed. For example, if creating a case is the activity, the Case table is the Activity Source.</td>
</tr>
<tr>
<td>Actor</td>
<td>Enter the person performing the activity.</td>
</tr>
<tr>
<td>Object</td>
<td>Select an Object, which is the unique key that identifies the object on which the activity is performed.</td>
</tr>
<tr>
<td>Filter conditions</td>
<td>Specify any condition that must be met for the activity to be displayed in the activity feed.</td>
</tr>
<tr>
<td>Active</td>
<td>Deselect the Active check box to not display the activities corresponding to this type in the activity feed.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you deselect this check box, deselect the corresponding facet. If not, the facet displays with no data.</td>
</tr>
<tr>
<td>Verb</td>
<td>Select a verb that describes the activity performed.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If the verb is not yet defined, you can create a verb. Refer to the video above on how to create a verb.</td>
</tr>
<tr>
<td>Target</td>
<td>Select the second person involved in the activity. Not all activities have a second person.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Note:** Once you create a new activity type, a new business rule is created.

5. In the notification message, click the link to the business rule.
**Note:** The business rule is required to create a record in a central activity table each time the action is performed. The central activity table improves the performance of rendering the feed during runtime. Create a business rule for each activity type.

6. In the Advanced tab, update the script.
   The following is an example script.

   ```javascript
   var actSubCtx = global.ActivitySubscriptionContext.getContext();
   if (current.contact) {
     actSubCtx.getActivityService().createActivity(current, verb, "", "", "", module);
   }
   ```

   - `current`: current variable in business rules holds the GlideRecord of the table on which the business rules is triggered. If this business rule is on Case table, `current` will hold the GlideRecord of the case.
   - `verb`: verb that is configured in the Verb field of the created activity type
   - `module`: module that is configured in the Module field of the created activity type

   Note: If there is already a Create Activity business rule, a notification message will also be displayed. You can update the script as required.

---

**Configure activity groups for the Customer Activity view**

Create an activity group and then add activity types to the activity group.

**Before you begin**

Role required: admin

**About this task**

An activity group is a logical grouping of activity types. An activity group is displayed in the activity feed based on the facet selected.

Activity groups are displayed in the Customer Activity view in Agent Workspace.
Learn more about configuring activity groups from the following video tutorial. Configure activity groups

**Procedure**

1. Navigate to **Customer Central > Feed Configuration > Activity Groups**.
2. Click **New**.
3. Fill out the fields, as required.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Select a name for the activity group.</td>
</tr>
<tr>
<td>Table name</td>
<td>Select the table that stores the object on which the activities in this group are performed. Usually, it is the same as the Activity Source selected in the Activity Type.</td>
</tr>
</tbody>
</table>

4. Once you have created an activity group, select it from the Activity Group list and add the activity types to the group.
5. On the Activity Types related list, click **New**.
6. Fill out the fields, as required.
Configure activity type templates for the Customer Activity view

Create an activity type template to define how to display the activity type data on each of the activity tiles in the activity feed.

**Before you begin**
Role required: admin

**About this task**
You can define which fields are displayed, where it is displayed on the tile, and the order of the display.
Learn more about configuring activity type templates from the following video tutorial. Configure activity type templates

**Procedure**
1. Navigate to Customer Central > Feed Configuration > Activity Type Templates.
2. Click New.
3. Fill out the fields, as required.

4. Click Submit.
5. Once you have created an activity type template, select it from the Activity Type Template list to configure the fields and order of fields to display.

6. Click New to create template fields for the activity type.

7. Fill out the fields, as required.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Select a Type to determine whether you want to select fields from the activity source or activity group table.</td>
</tr>
<tr>
<td>Field</td>
<td>Select the field you want to add.</td>
</tr>
<tr>
<td><img src="#" alt="Note:" /> You cannot configure HTML fields for display in the subheader on the activity tile.</td>
<td></td>
</tr>
<tr>
<td>Show label</td>
<td>Select this check box to show the field label on the activity tile.</td>
</tr>
<tr>
<td>Position</td>
<td>Select the Position to determine whether the field should appear as content or as a sub-header on the activity tile.</td>
</tr>
<tr>
<td><img src="#" alt="Note:" /> Only one field is displayed as content on the activity tile.</td>
<td></td>
</tr>
<tr>
<td>Order</td>
<td>Select the order the field should appear on the activity tile.</td>
</tr>
<tr>
<td>Enable link to activity group record</td>
<td>Select this check box to display the field as a link to the activity group record.</td>
</tr>
<tr>
<td>Display as time ago</td>
<td>Select this check box to display the field in time ago format.</td>
</tr>
<tr>
<td><img src="#" alt="Note:" /> This only applies to fields including time or date information.</td>
<td></td>
</tr>
</tbody>
</table>

8. Click **Submit**.
Associate activity groups and activity types to activity contexts

Add the activity groups and activity types you created to an activity context, depending on who you want to display the information for.

**Before you begin**
Role required: admin

**About this task**
An activity context is the person or user who is interacting with the customer service agent. There are two predefined activity contexts: consumer and contact. Add the activity groups and activity types you created to an activity context, depending on who you want to display the information for.

Learn more about associating an activity group to an activity context from the following video tutorial. Associate an activity group to an activity context

Learn more about associating an activity type to an activity context from the following video tutorial. Associate an activity type to an activity context

**Procedure**

1. Navigate to Customer Central > Customer Activity > Activity Contexts.
2. Open the contact or consumer record that you want to add your configuration to.
3. On the Activity Context Groups related list, click New.
4. Add the activity group.
5. On the Activity Context Types related list, click New.
6. Fill out the fields, as required.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity type</td>
<td>Add the activity type.</td>
</tr>
<tr>
<td>Fetch from activities</td>
<td>Deselect Fetch from Activities if a business rule is not defined for this activity type.</td>
</tr>
<tr>
<td>Filter conditions</td>
<td>Add filter criteria to apply filter conditions on the source table.</td>
</tr>
<tr>
<td>Source mapping field</td>
<td>Select the field in the Source table that is related to the context.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Context mapping field</td>
<td>Select the field in the Context table to map to the field selected in <strong>Source mapping</strong> field.</td>
</tr>
<tr>
<td>Advanced mapping</td>
<td>Select Advanced Mapping and write a script in the <strong>Advanced mapping script</strong> field if the source and context mapping is not sufficient.</td>
</tr>
</tbody>
</table>

7. **Click Submit.**

**Create facets for activity contexts**
Create facets to group the data and enable customer service agents to filter and display the data they want to see in the activity feed.

**Before you begin**
Role required: admin

**About this task**
An activity context is the person or user who is interacting with the customer service agent. There are two predefined activity contexts: consumer and contact. Facets group the data, which enables customer service agents to filter and display the data they want to see in the activity feed. Each facet represents an activity group.
Facets are displayed in the Customer Activity view in Agent Workspace. Dynamic facets display record details associated with the facet.
Static facets display a subcategorization of the facets without any record details.

Learn more about configuring facets from the following video tutorial. Configure facets
Procedure
1. Navigate to Customer Central > Customer Activity > Activity Contexts.
2. Open the contact or consumer record that you want to create facets for.
3. On the Facets related list, click New.
4. Fill out the fields, as required.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a Name for the facet. This is the name of the facet that appears on the Customer Activity view.</td>
</tr>
<tr>
<td>Activity context group</td>
<td>Add an activity context group for the facet.</td>
</tr>
<tr>
<td>Facet type</td>
<td>Select whether the facet is dynamic or static. Dynamic displays record details associated with the facet. Static displays a subcategorization of the facets without any record details. Static facets can also be associated to a facet group.</td>
</tr>
<tr>
<td>Order</td>
<td>Enter the order the facet should appear in.</td>
</tr>
<tr>
<td>Facet group</td>
<td>If you selected facet type Static, associate the facet to a group. If you associate the facet to a facet group, this facet becomes a subcategory of the facet group you selected.</td>
</tr>
<tr>
<td>Icon</td>
<td>Select an icon for the facet.</td>
</tr>
<tr>
<td>Facet title</td>
<td>If you selected facet type Dynamic, choose the field of the record to display as the facet title.</td>
</tr>
</tbody>
</table>
5. Click Submit.

Configure dynamic related records

System administrators can configure the dynamic related records feature to display related records in the contextual side panel in CSM Configurable Workspace. These records dynamically change based on the context of the current record or playbook activity.

Configuring the dynamic related records feature involves several types of records. See the following table for details about these record types.

- Related record contexts
- Related record definitions
- Context related record definitions

<table>
<thead>
<tr>
<th>Record type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Related record context</td>
<td>Defines the context in which related records appear in the Related Records tab. You can create a related record context for the following types of records:</td>
</tr>
<tr>
<td></td>
<td>• A source record, such as a customer service case</td>
</tr>
<tr>
<td></td>
<td>• A playbook activity, such as adding additional members to an onboarding case</td>
</tr>
<tr>
<td></td>
<td>A context record identifies the following information:</td>
</tr>
<tr>
<td></td>
<td>• The table that contains the type of record for which related records are being configured.</td>
</tr>
<tr>
<td></td>
<td>• Additional conditions that apply to the selected table. These conditions determine if the related record</td>
</tr>
<tr>
<td>Record type</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Related record definition</td>
<td>Identifies one specific type of data to be retrieved, such as SLAs or active contracts. You can create a related record definition for each type of data to include in the Related Records tab and then associate one or more definitions with a context record.</td>
</tr>
<tr>
<td>Context related record definition</td>
<td>Defines the relationship between a context record and its associated definition records. When you open a context record, you can see the associated definition records in the Context Related Record Definitions related list.</td>
</tr>
</tbody>
</table>

For more information about these tables, including field descriptions, see [Dynamic related record tables](#).

**How the context and definition records work**

The context record defines the context in which related records appear in the Related Records tab. This includes conditions to apply to the selected record type. For example, to create a context record for an onboarding playbook activity:

1. Select the table that stores the activity: **Activity Execution**
   
   `[sys_pd_activity_context]`.

2. Define additional conditions that apply to the selected table:
   
   - `[Activity.Process definition] [is] [Onboarding playbook]`
   - `[Activity] [is] [Add additional members]`

   These conditions determine if the related record definitions for the selected table are executed at runtime. If the conditions evaluate to true, the definitions are executed. If false, the definitions are ignored. If a context has no conditions, this evaluates to true.

3. Select the related record definitions to execute: **Additional Members**
At runtime, the system checks to see if there are related record contexts that match the current record or playbook activity.

- When it finds a match, the system evaluates the conditions defined in the context.
- If the conditions evaluate to true, the system executes the related record definitions for the context.

To continue with the example above, an agent using the Case Playbook for Onboarding is currently working on the activity to add additional members. The system performs the following actions to display the correct related records:

- Checks the active contexts and finds **Onboarding Additional Members**.
- Evaluates the conditions in the context and determines that they evaluate to true.
- Executes the **Additional Members** related record definition.
- Retrieves and displays the correct set of records from the table identified in the **Additional Members** related record definition. In this case, the Related Party [sn_customerservice_related_party] table.

The definition record uses a script to define which related records are retrieved based on the context. This record also includes the table where the related record data is stored. At runtime, the script evaluates the context of the current record or playbook activity, along with any conditions, and dynamically displays the related record data.

**Dynamic related record configuration tasks**
Configuring the dynamic related records feature includes the following tasks:

- Configure the related record contexts and definitions to identify which related records to display in the Related Records tab.
- Configure the card layout for the records displayed in the Related Records tab.
- Configure the maximum number of related records to display.

**Related Records list card layout**
Records appear in the Related Records tab in a card format. This format is created with **Entity View Action Mapper** (EVAM), a Now Platform application that standardizes how different data sources display in cards and lists.

EVAM uses view configurations and view templates to determine how information for each type of related record is displayed.
• EVAM view configuration: Combines conditions, the table and table fields, and declarative actions with an associated view template.

• EVAM view template: Contains the JSON used to give the necessary information for the card display and use.

EVAM view configurations can be grouped together to create configuration bundles. The Dynamic Related Records for Configurable Workspace plugin includes a configuration bundle, `dynamic_related_records_bundle`, which contains view configurations and view templates for the dynamic related records feature.

The system administrator can modify the view configurations in the `dynamic_related_records_bundle` or create new view configurations. This includes selecting the fields that are displayed on the card for each type of record. For more information, see:

- Define an EVAM view configuration
- Define an EVAM view template

**Related record definitions included with the plugin**

The Dynamic Related Records for Configurable Workspace plugin includes several related record definitions for case records. To view a list of definitions, navigate to Dynamic Related Record > Related Record Definitions.

The system administrator can make any of these definitions available to agents by adding them to the related records shared page in UI Builder.

<table>
<thead>
<tr>
<th>Related record definition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLAs</td>
<td>Displays SLAs for a case, including information from the following fields:</td>
</tr>
<tr>
<td></td>
<td>• Stage</td>
</tr>
<tr>
<td></td>
<td>• SLA definition</td>
</tr>
<tr>
<td></td>
<td>• Start time</td>
</tr>
<tr>
<td></td>
<td>• Business time left</td>
</tr>
<tr>
<td>Emails</td>
<td>Displays emails for a case, including information from the following fields:</td>
</tr>
<tr>
<td></td>
<td>• Notification type</td>
</tr>
<tr>
<td></td>
<td>• Subject</td>
</tr>
<tr>
<td>Related record definition</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>• Recipient</td>
<td></td>
</tr>
<tr>
<td>• Date created</td>
<td></td>
</tr>
<tr>
<td>Escalations</td>
<td>Displays escalations for a case or for the account and contact or consumer, including information from the following fields:</td>
</tr>
<tr>
<td>• State</td>
<td></td>
</tr>
<tr>
<td>• Number</td>
<td></td>
</tr>
<tr>
<td>• Escalation severity</td>
<td></td>
</tr>
<tr>
<td>• Source record</td>
<td></td>
</tr>
<tr>
<td>Blocked By</td>
<td>Displays blocking tasks for a case, including information from the following fields:</td>
</tr>
<tr>
<td>• Blocking task</td>
<td></td>
</tr>
<tr>
<td>• Blocking reason</td>
<td></td>
</tr>
<tr>
<td>Child Cases</td>
<td>Displays child cases related to a case, including information from the following fields:</td>
</tr>
<tr>
<td>• Number</td>
<td></td>
</tr>
<tr>
<td>• Short description</td>
<td></td>
</tr>
<tr>
<td>• Account and contact</td>
<td></td>
</tr>
<tr>
<td>• Consumer</td>
<td></td>
</tr>
</tbody>
</table>

**Configure related record contexts**

This type of configuration record defines the context in which related records appear in the Related Records tab.

**Before you begin**

Role required: admin

**About this task**

In a related record context, the system administrator configures the following information:
• The table that stores the record type for the context. You can create a context for a source record, such as a case, or for a playbook activity.

• Conditions to apply to the selected table. These conditions determine if the related record definitions associated with this context are executed at runtime.
  ◦ If the conditions evaluate to true, the system executes the related record definitions.
  ◦ If the conditions evaluate to false, the system ignores these definitions.

⚠ Note: If a context has no conditions, this evaluates to true.

• The related record definitions to execute. Associate a definition for each type of related record to display for this context.

Procedure
1. Navigate to Dynamic Related Record > Related Record Contexts.
2. Click New.
3. Enter a Name for the context record.
4. Select the table that stores the record type for the context in the Applies to table field.
5. In the Primary reference field, select the field from the Applies to table that is passed to the Context Related Record Definition for evaluation. The following data types are supported:
  • Sys ID
  • Doc ID
  • Reference
6. Optional: If desired, select another reference field from the Applies to table in the Secondary reference field.
7. Enable the Inherited field if you want the context record to also consider tables that extend from the Applies to table.
8. Use the condition builder to select conditions that are applied to the records in the Applies to table.
   For example, if you are creating a context for a playbook activity, you can use the condition builder to identify the playbook and then the specific activity within that playbook.
9. Click Submit.
   The context is added to the Related Record Contexts list.
Associate related record definitions with a related record context

Associate the desired related record definitions with a context record to determine which related records appear for the selected record type.

**Before you begin**
Role required: admin

**About this task**
A related record context includes the following information:

- The table that stores the record type for the context (source record or playbook activity).
- Conditions to apply to the selected table which determine if the associated related record definitions are executed at runtime.
- The related record definitions to execute.

**Procedure**
1. Navigate to **Dynamic Related Record > Related Record Contexts**.
2. Click the desired context.
3. In the Context Related Record Definitions related list, click **New**.
   You may need to change the application in order to see the **New** button:
   a. Click the system settings icon in the upper right corner.
   b. Click **Developer**.
   c. Select the **Application** and close the pop-up window.
4. Click the lookup icon in the **Related record definition list**.
5. Select a definition from the Related Record Definitions list.
6. Assign an order number to the definition in the **Order** field.
   The order determines where the related record type appears in the filter list in the Related Records tab.
7. Click **Submit**.

**Configure related record definitions**
Related record definitions identify the types of records that the dynamic related records feature can display in the Related Records tab.

**Before you begin**
Role required: admin
About this task
The system administrator can create relate definitions and associate the desired definitions with a related record context. For example, the admin can associate SLA and escalation definitions with the Case related record context. Definitions can be associated with multiple contexts.

The Dynamic Related Records for Configurable Workspace plugin includes several related record definitions for case records. For more information, see Related record definitions included with the plugin.

Procedure
1. Navigate to Dynamic Related Record > Related Record Definitions.
2. Click New.
3. Enter a name for the definition in the Display label field. This label appears in the filter dropdown list in the Related Records tab. Agents click the filter icon and select the type of related record to view in the Related Records list.
4. In the Queries from field, select the table that stores the related record data to be retrieved.
5. Select a table in the Primary reference table field. The primary table used in the definition script. At runtime, the script expects to get passed a record of this type. If you entered a data type in the Primary reference field in the related record context, enter the table for that data type.
6. Optional: If desired, select a table in the Secondary reference table field. The secondary table used in the definition script. At runtime, the script expects to get passed a record of this type. If you entered a data type in the Secondary reference field in the related record context, enter the table for that data type.
7. Use the Script field to define which records are retrieved based on the context. At runtime, the script evaluates the current record's context, along with any selected conditions, and dynamically displays the related records.
8. Click Submit.

Configure the maximum number of related records to display
Configure the maximum number of related records to display in the Related Records tab in the contextual side panel in CSM Configurable Workspace.
Before you begin
Role required: ui_builder_admin, admin

About this task
As part of configuring the Related Records shared page, the administrator can define the maximum number of related records that are displayed in the Related Records tab in the contextual side panel. This is defined as part of the UI Builder data transform configuration. The default value is 100 records.

Procedure
1. Navigate to Now Experience Framework > UI Builder.
2. In the My experiences list, click the desired workspace.
3. In the Page menu, select Record.
   The Page menu is in the upper left corner of the UI Builder interface.
4. Click Edit in original scope.
5. In the Content list below the Page menu, click the Contextual sidebar component.
6. In the contextual sidebar configuration panel on the right side of the UI Builder interface, click the Config tab.
7. In the Tabs list, click Related Record.
8. Click Edit Content.
9. Click the Data icon in the bar on the left side of the UI Builder interface.
10. Under Local data resource instances, click Look Up Related Records.
11. In the Configuration tab for the data resource, enter a value in the Max results field.
12. Click Save.

Configure the Customer Service mobile application
Configure the Customer Service mobile application and customize it for agents who use the application instance on their mobile devices.

Before you begin
Role required: admin

About this task
The Customer Service Mobile plugin (com.sn_csm_mobile) enables the Customer Service mobile application.
**Procedure**

1. Navigate to **System Applications > Studio**.

2. In the **Select Application** pop-up window, click **Customer Service Mobile**. The Customer Service mobile application opens in the Studio, which is a guided app creator. For more information about using the Studio, see **Getting started with mobile app creation using the guided app creator**.

3. Customize the application to display the desired applets and data and configure agent actions and notifications.

**Related information**

- **ServiceNow mobile app configuration**

**Configure Guided Decisions for Customer Service Management**

Configure decision trees and guidances to create a guided decision.

**Before you begin**

Role required: admin, sn_gd_guidance.guidance_manager, or sn_gd_core.decision_tree_author

**About this task**

A guided decision is a structured troubleshooting process for customer service agents to work through. For more details, see **Guided Decisions for Customer Service Management**.

Access the Guided Decision menus and use the modules to configure guided decisions.

**Procedure**

1. Navigate to **Guided Decisions**.

2. Complete the following tasks to configure the feature.

<p>| Task                  | Description                                                                 |</p>
<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure guidances</td>
<td>Customize default guidances to display as outcomes of decision trees.</td>
</tr>
<tr>
<td>Add guided decisions to playbooks</td>
<td>Add the guided decision to a playbook, so customer service agents can access the guided decision in cases they are working on.</td>
</tr>
</tbody>
</table>

**Activate Guided Decisions for Customer Service Management**

Activate the Guided Decisions for Playbook in Workspace plugin to use Guided Decisions.

**Before you begin**
Role required: admin

**Procedure**
1. Navigate to System Definition > Plugins.
2. Search for the plugin com.snc.guided_decisions_playbook_experience.
3. Click Activate.

**Configure guidance for your agents**
Create guidance for your customer service agents by configuring the text that is displayed to the agent, the labels of the buttons that are displayed, and the actions that your agents should take to resolve issues. You can also add tokens and current records that will be replaced with values at run time.

**Before you begin**
Role required: sn_gd_guidance.guidance_manager

**Procedure**
1. Navigate to Guided Decisions > Guidances.
2. Click New.
3. On the form, fill in the fields.
### Guidance form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name that you want to give to the guidance. For example, you could use &quot;Attach article&quot; if you are creating the guidance to attach an article to a case.</td>
</tr>
<tr>
<td>Automation Plan</td>
<td>Default Guidance Automation Plan that is selected by default.</td>
</tr>
<tr>
<td>Guidance Message</td>
<td>Message that appears when guidance is recommended to an agent in the workspace. You can use the variables (guidance inputs) while creating a message.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the guidance.</td>
</tr>
</tbody>
</table>

4. Under the Guidance Input related list, click **New**.
5. Insert rows and provide inputs in the specified columns.
   In the following example, a knowledge article for a case is provided as a guidance input.

![Guidance Inputs](image)

1. **Note**: If the **Is form field** is set to true, the field is visible in the workspace for an agent to provide an input.
6. Click **Update**.
7. Under the Guidance Output related list, click **New**.
8. Insert new rows and provide values for each column.
9. Click **New** next to **Guidance Actions**.
10. On the form, fill in the fields.
### Guidance Action form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Label</td>
<td>Button name.</td>
</tr>
<tr>
<td>Guidance</td>
<td>Prefilled guidance name that you specified while creating that guidance.</td>
</tr>
<tr>
<td>Application</td>
<td>Prefilled with Guided Decisions - Guidance by default.</td>
</tr>
<tr>
<td>Guidance Action Automation</td>
<td>Flow that is executed when the button is clicked.</td>
</tr>
</tbody>
</table>

11. In the **Automation Flow Inputs** tab, click the data pill picker icon (ภาพ) against each field.

   - **Note:** The fields displayed are based on the guidance inputs that you created earlier.

12. Map the guidance inputs to the subflow inputs.

13. Click **Guidance Outputs**.

14. Click the data pill picker icon (ภาพ).

15. Map the subflow outputs to the guidance outputs.

16. Click **Submit**.

### Configure decision trees

Create a decision tree that customer service agents can use in a guided decision to troubleshoot solutions to cases.

**Before you begin**

Role required: admin, sn_gd_core.decision_tree_author

**About this task**

A decision tree is a multi-step process consisting of a series of questions and answers. Based on the answers, each question leads to an outcome. The outcome is either a guidance or a follow-on question.

Decision trees contain decision tree nodes and paths that link the nodes. Each decision tree has a root node called the start node.

Decision tree nodes represent one or more questions and the associated paths that link the nodes, which can be decision paths or guidance paths.
A decision tree node with decision paths leads to one or more decision tree nodes. A decision tree node with guidance paths leads to a guidance and provides a solution.

Each decision tree node consists of:

- **Decision inputs:** A decision input is a question. For each question, you configure input options that a customer service agent can use to answer the question.
- **Input mappings:** Input mappings enable you to reuse values that you have used in other decision tree nodes by mapping from one decision tree node to another.
- **Paths:** A path provides possible outcomes of the decision tree node.
  - A decision path links one decision tree node to the next decision tree node of type decision.
  - A guidance path links one decision tree node to a decision tree node of type guidance.

### Decision Trees

![Decision Tree Diagram](diagram.png)

**Procedure**

1. Navigate to **Guided Decisions > Decision Trees**.
2. Click **New**.
3. Enter a name and description for the decision tree.
   
   _Note:_ This is the start node for your decision tree.
4. Click **Submit**.
Create decision inputs

Create decision inputs for each decision node. These appear in the form of a question on Agent Workspace.

Before you begin
Role required: admin, sn_gd_core.decision_tree_author

About this task
In decision inputs, you define the questions for the customer service agent to answer. Decision inputs can be one or multiple questions. Configure the input variables and conditions for each decision node. You can also map inputs among different decision tree nodes within a decision tree.

Procedure
1. Navigate to Guided Decision > Decision Trees.
2. Click the decision tree you want to add decision inputs to.
3. In Decision Tree Nodes, click the start node of your decision tree.
4. Click **Create Input**.
5. In the **Type** field, select the type of the decision input.

**Note:** Use one of the following recommended types:
- String
- Integer
- True/False
- Choice
- Reference
- Date
- Date/Time

6. In the **Label** field, enter the text to appear on Agent Workspace.
7. Enter the choices or default values, as required.
8. Click **Submit**.

### Create decision paths

Create decision paths to set the conditions for when the next question is displayed.

**Before you begin**
Role required: admin, sn_gd_core.decision_tree_author

**About this task**

Based on the answer the customer service agent provides to a question in one decision node, a decision path guides them to the next decision node for the next question.

**Procedure**

1. Navigate to **Guided Decisions > Decision Trees**.
2. In Decision Tree Nodes, click the start node of your decision tree.
3. Click **Create Decision Path**.
4. In the **Label** field, enter a label for the decision path.
5. Set the conditions for when to display the next question.
6. Click **Update**.

   **Note:** You can create as many decision paths as required.

**Create guidance paths**
Create guidance paths to set the conditions for when a guidance is displayed.

**Before you begin**
Role required: admin, sn_gd_core.decision_tree_author

**About this task**
Based on the answers the customer service agent gives to a question in one decision node, a guidance path takes them to the next decision node to provide guidance.

**Procedure**
1. Navigate to **Guided Decisions > Decision Trees**.
2. In Decision Tree Nodes, click the start node of your decision tree.
3. Click **Create Guidance Path**.
4. In the **Label** field, enter a label for the guidance path.
5. Set the conditions for when to display the guidance.
6. Click **Update**.

   **Note:** You can create as many guidance paths as required.

**Associate guidances to guidance paths**
Associate a guidance to a guidance path so customer service agents can view a recommendation on what to do next.

**Before you begin**
Role required: admin, sn_gd_core.decision_tree_author

**About this task**
A guidance is an outcome of a decision tree.
Select one of the three guidances that are delivered by default to attach to your guidance path:

- Provide Resolution
- Create Work Order
- Attach Knowledge Article
You can then enter guidance inputs, as required.

**Procedure**

1. Navigate to **Guided Decisions > Decision Trees**.
2. In Decision Tree Nodes, click the guidance path you created.
3. Select the guidance to include in your guidance path.
4. Depending on the guidance you selected, enter guidance inputs, as required.

  **Note:** If you selected the Attach Knowledge Article guidance, enter the knowledge article to link to.

  If you selected the Provide Resolution guidance, enter the case, resolution notes, and a resolution code.

  If you selected the Create Work Order guidance, enter the task to link to.

5. Click **Create Input Mapping** to link the task associated to the guidance to the task in the start node.

6. Click **Update**.
Create input mappings
Create input mappings to reuse values from one decision node input in another decision node input.

Before you begin
Role required: admin, sn_gd_core.decision_tree_author

About this task
You can create input mappings for each decision input you create. Input mapping copies the values from the source input of the source node you select, to the destination input of the destination node.

Procedure
1. Navigate to **Guided Decisions > Decision Trees**.
2. In Decision Tree Nodes, click the decision tree node you want to copy the decision input values from.
3. Click **Create Input Mapping**.
4. In the **Source Node** field, enter the decision input node you want to copy from.
5. In the **Source Input** field, enter the source input to copy.

   **Note:** The **Destination Node** is automatically filled with the value of the decision node you are creating the input mapping from.
6. In the **Destination Input** field, select the destination input that contains the decision input you want to copy the values to.
7. Click **Submit**.

Add guided decisions to playbooks
Add the guided decision to a playbook, so customer service agents can work through it to resolve cases more efficiently.

Before you begin
Role required: admin, pd_content_author

About this task
A playbook is set of steps that defines a process. A decision tree can be added as one of the steps within a playbook.

Playbooks are displayed in cases on Agent Workspace based on trigger definitions defined for each playbook in the Process Automation Designer. For more details, see **Process Automation Designer**. Based on the context of
the case the customer service agent is working on, the playbook and any associated guided decisions are displayed.

For more details on playbooks for Customer Service Management, see Playbooks for Customer Service Management.

Procedure
2. Click the playbook you want to add the decision tree to.
3. Click Add an activity.
5. In the Label field, enter a name for the guided decision.
6. Enter a description.
7. Select a start rule.
8. Click Configure activity.
9. Select the decision tree you want to add to the guided decision.
10. Click Update.
11. Click Save.

The decision tree is added to the playbook. Depending on the context of the case, customer service agents can access the guided decision from cases on Agent Workspace.

Configure the next best action conditional rules within a context

Configure the next best action conditional rules within a context, which is a container for all the next best action rules for a specific entity type. By configuring these rules, you provide guidance that helps your agents to resolve issues quickly and more efficiently.

Before you begin
Role required: sn_nb_action.next_best_action_admin or sn_nb_action.next_best_action_author

About this task
A rule context consists of one or many rules. A rule is a condition that is based on the rule context table. For example, if you are working a case record, the case becomes the context. A rule context includes one or more next best action rules.
Procedure

1. Navigate to Guided Decisions-Next Best Action Rule Contexts.
2. Click Case Context, which is available by default in the Next Best Rule Context Case Context page.
3. Optional: To create a new context such as an incident, interaction, or for a specific domain, click New.
4. Under the Next Best Action Rules related list, click New.
5. Click Condition Based Next Best Action Rule.
6. On the form, fill in the fields.

Condition Based Next Best Action Rule form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the new rule.</td>
</tr>
<tr>
<td>Rule Context</td>
<td>Case context that is selected by default.</td>
</tr>
<tr>
<td>Roles</td>
<td>Rules that are executed for users with specified roles.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the rule.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions that are based on the rules that are executed.</td>
</tr>
<tr>
<td>Active</td>
<td>Rule that is active and is selected by default.</td>
</tr>
<tr>
<td>Apply to tables extended from the context table</td>
<td>Rule that also applies to the tables that are extended from the current context table.</td>
</tr>
<tr>
<td>Order</td>
<td>Order in which the rule is executed. Lowest order indicates the highest priority.</td>
</tr>
</tbody>
</table>

7. Click Submit. The Next Best Action Rule Context page appears.
8. Click the rule that you have created in the Next Best Action Rules related list.
9. To create recommended next best actions for the rule, click New.
10. On the form, fill in the fields.
### Recommended Next Best Action form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rule</td>
<td>Rule name that you have selected.</td>
</tr>
<tr>
<td>Short Description</td>
<td>Description of the action.</td>
</tr>
<tr>
<td>Action Type</td>
<td>Type of recommendation such as Guidance or Guided Decision Tree.</td>
</tr>
<tr>
<td>Action</td>
<td>Table name and document. For example, Guidance: Attach Article.</td>
</tr>
<tr>
<td>Active</td>
<td>Option that is selected by default.</td>
</tr>
<tr>
<td>Order</td>
<td>Order of the recommendation within a rule. The west order indicates the highest priority.</td>
</tr>
</tbody>
</table>

11. **Optional:** To recommend the next best actions where the action inputs are defined dynamically, select **Action Inputs Dynamically**. For more information, see [Set up the action inputs with dynamic values to provide guidance](#).

12. **Click** Save.  
The Action Input form appears. You can set up action inputs for a guidance either by using static or dynamic values.

### What to do next
You can perform any of the following tasks next:

- Set up the action inputs with static values to provide guidance  
- Set up the action inputs with dynamic values to provide guidance

### Set up the action inputs with static values to provide guidance

Set up the action inputs with static values for the guidance that you provide your agents with. Static values are predetermined inputs that are set by the next best action author.

**Before you begin**
Role required: sn_nb_action.next_best_action_admin or sn_nb_action.next_best_action_author

**About this task**
Providing guidance to your agents requires that you set up action inputs and provide an action input generator, such as a subflow. The action input
generator is required only for guidance and not for guided decision tree action types. The generator uses the outputs of the input generator subflows to generate inputs for actions. Fields that appear in the Action Input form vary based on the action that you have selected on the Recommended Next Best Action form. Based on the data type, the appropriate action input fields appear. If the data type is a reference or Boolean pill picker, the fields appear for you to key in the values. For example, if you select Guidance: Attach Article, then the Article and Task fields appear.

After you create and save a recommended next best action, the Action Input form appears. For more information, see Configure the next best action conditional rules within a context).

Procedure

1. On the Action Input form, enter the knowledge article number and select the task information, such as the case context.
   You can use the context pill picker to select the task information of the current context information.

   Note: You can also use the flow pill picker to fill in the fields. To use the flow pill picker, you must first create the input generator. For more information, see Create an action input generator.

2. Click Update.

Set up the action inputs with dynamic values to provide guidance

Set up the action inputs with dynamic values for the guidance that you provide your agents with. Using dynamic values enables you to select an input generator that refers to a subflow that provides inputs for guidance.

Before you begin
Role required: Role required: sn_nb_action.next_best_action_admin or sn_nb_action.next_best_action_author

About this task
Create an action input generator after you create the recommended next best actions for a rule. The action input generator is required only for guidance and not for guided decision tree action types. The generator uses the outputs of the input generator subflows to generate inputs for actions.
Procedure

1. On the Recommended Next Best Action form, select **Action Inputs Dynamically**. For more information, see Configure the next best action conditional rules within a context.

2. In the Input Generator field, select an input generator either by creating one or by selecting an existing input generator.
   For more information on how to create an input generator, see Create an action input generator and to learn how to use an existing input generator, see Use an existing action input generator. After you create or select an existing input generator, the Generator Input form expands. Based on the subflow inputs, the action input generator fields appear.

3. In the action input generator fields, enter the values or click the data pill picker icon (🔍) that is next to the fields.

4. Click **Update**.

Related information

Create an action input generator
Use an existing action input generator

Create an action input generator

Create an action input generator to configure a subflow that returns outputs that can be used in the action inputs of a recommended next best action.

Before you begin
Role required: sn_nb_action.next_best_action_author

About this task

An action input generator calls a subflow. This process is required if there are certain inputs for an action that must be computed during runtime. The inputs for a subflow can be passed as inputs for a recommended action record or as inputs for a subflow in an action input generator record in two ways:

- Static inputs can be passed as subflow inputs
- Context inputs can be passed dynamically when you select them through the pill picker
Procedure

1. On the Recommended Next Best Action form, click **Create Action Input Generator**.
   The fields that display are based on the action that you selected previously while you were creating a recommended next best action. You are now redirected to a new Next Best Action Input Generator page.

2. To create a new subflow, click **Create New Input Generator Flow**.
   A new tab opens.

3. On the Subflow properties form, fill in the fields.

4. Define the subflow inputs and outputs.
   The following example is of an action input generator where the subflow configuration suggests knowledge articles for the agents to help solve an issue. These articles are based on the short description of a case.

5. Click **Submit**.

6. Click **Save**.

7. Click **Publish**.

8. Close the tab.
   You next go to the Next Best Action Input Generator page.

9. In the **Short Description** field, enter a short description.
10. In the **Input Generator Flow** field, select an input generator flow.

11. Click **Save**.

**Results**
The Generator Input form opens.
Next, see step 3 in **Set up the action inputs with dynamic values to provide guidance** to learn how to complete the task.

**Use an existing action input generator**
Use an existing action input generator to call a subflow after you create the recommended next best actions for a rule.

**Before you begin**
Role required: sn_nb_action.next_best_action_author

**About this task**
By default, an input generator flow is available for you to use. An action input generator allows calling a subflow which is required if there are certain inputs for an action that must be computed during runtime.

**Procedure**
1. Navigate to **Next Best Action Input Generator**.
2. In the **Short Description field**, enter a short description.
3. In the **Input Generator Flow** field, select an existing input generator flow.
4. Click **Save**.
   The Generator Input form expands. Based on the subflow inputs, the action input generator fields appear.
5. Enter the values in the fields that appear or click the data pill picker icon ( next to the fields to pass the current case information.
6. Click **Update**.

**Results**
The Generator Input form opens.
Next, see step 3 in **Set up the action inputs with dynamic values to provide guidance** to learn how to complete the task.

**Configure the next best action arbitration parameters**
Configure the next best actions by the frequency of issues or by the order of priority so that your agents get the guidance that they need to help resolve customer issues.
Before you begin  
Role required: sn_nb_action.next_best_action_author

About this task  
A mathematical formula determines the priority of the next best actions that are displayed to the agents. For most cases, you should use the default values to ensure that the relevant next best actions are available for a given context. If you want to alter the frequencies, you can modify the values. The next best actions in the New state appear by ranking. For example, the score for these next best actions is calculated by the order of frequency and the priority order of the rule.

Procedure  
1. Navigate to **Guided Decisions-Next Best Action Arbitration Configuration** > ..  
2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rule Order Weight (sn_nb_action.arbitration_inter_rule_step)</td>
<td>Guided decisions that display guidance based on rules with a lower-order value. The default value is 0.9.</td>
</tr>
<tr>
<td>Recommendation Order Weight (sn_nb_action.arbitration_intra_rule_step)</td>
<td>Guided decisions that display guidance with a lower-order value and also from rules with a lower-order value. The default value is 0.9.</td>
</tr>
<tr>
<td>Frequency Weight (sn_nb_action.arbitration_frequency_step)</td>
<td>Number of times that guidance is displayed to the agent based on the rules that are triggered. The default value is 1.5.</td>
</tr>
</tbody>
</table>

3. Click **Save**.

Configure trending case topics  
Train solution definitions to identify clusters of cases that point to similar underlying issues and find any related major cases for the clusters.

Before you begin  
Role required: admin
About this task
Access the menus and use the modules to train the solution definitions to identify trending case topics.
For more details, see Trending case topics.

Procedure
1. Navigate to Predictive Intelligence and then either Similarity > Solution Definitions or Clustering > Solution Definitions.
2. Complete the following tasks to train the solution definitions for trending case topics.

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Train the clustering solution definition to automatically group similar cases into topics</td>
<td>Configure a clustering solution definition to cluster similar cases into groups.</td>
</tr>
<tr>
<td>Train the similarity solution definition to find similar existing major cases</td>
<td>Configure a similarity solution definition to find similar major cases for the clusters.</td>
</tr>
</tbody>
</table>

Train the clustering solution definition to automatically group similar cases into topics
To enable clustering of similar cases into topics, you must first update and train the clustering solution definition.

Before you begin
Activate the Predictive Intelligence for Customer Service Management plugin (com.snc.csm_ml).
Role required: admin

About this task
By default, a clustering solution definition for clustering groups of cases into topics is already available. A clustering solution definition groups similar records into clusters so you can address them collectively or identify patterns.
You can modify the fields, filters, update frequency, and training frequency.
Procedure

1. Navigate to **Predictive Intelligence > Clustering > Solution Definitions**.

2. In the Clustering Definitions list, search for and select the Grouping of Cases into Topics solution definition (ml_sn_sn_csm_ml_global_grouping_of_cases_into_topics).

3. On the Clustering Definition form, verify the default field values.

4. Change the fields and filters, as required.

5. To change the frequency with which the model for clustering solution definition must be rebuilt, edit the **Update Frequency** field.

6. To change the frequency with which to include new records in the model for the clustering solution definition, edit the **Training Frequency** field.

7. In the Training Request Schedule related list, view the schedule for training the Grouping of Cases into Topics solution definition.

8. Click **Update & Retrain**.

9. Open the Grouping of Cases into Topics solution definition.

10. In the ML Solutions related list, view the training solution progress in the **Progress** column.

   **Note:** Alternatively, you can click the link for the solution in the **Active** column. On the ML Solution form, click the **Show training progress** related link to check the training solution progress.

11. Click the **Cluster Visualization** tab.
    The clusters that were formed for the given solution are displayed in a tree map in descending order of size from top left to bottom right. Each node is colored from red to green depending on the cluster quality.

**Train the similarity solution definition to find similar existing major cases**

To enable finding related major cases in a cluster, you must first update and train the similarity solution definition.

**Before you begin**

Activate the Predictive Intelligence for Customer Service Management plugin (com.snc.csm_ml).

Role required: admin

**About this task**

By default, a similarity solution definition for finding similar existing major cases in a cluster is already available. A similarity solution definition collects and compares your existing records to new similar records.
You can modify the fields, filters, update frequency, and training frequency.

**Procedure**

1. Navigate to **Predictive Intelligence > Similarity > Solution Definitions**.

2. In the Similarity Definitions list, search for and select the Major Issue Detector solution definition (ml_sn_global_major_issue_detector).

3. On the Similarity Definition form, verify the default field values. For more information about the Similarity Definition form fields, see **Create and train a similarity solution**.

4. Change the fields and filters, as required.

5. To change the frequency with which the model for similarity solution definition must be rebuilt, edit the **Update Frequency** field.

6. To change the frequency with which to include new records in the model for the similarity solution definition, edit the **Training Frequency** field.

7. In the Training Request Schedule related list, view the schedule for training the Major Issue Detector solution definition.

8. Click **Update & Retrain**.

9. Open the Major Issue Detector solution definition.

10. In the ML Solutions related list, view the training solution progress in the **Progress** column.

   **Note:** Alternatively, you can click the link for the solution in the **Active** column. On the ML Solution form, click the **Show training progress** related link to check the training solution progress.

**View the estimated time to resolve values for older case records after upgrading**

After upgrading, configure some settings to view the **Time to Resolve Numeric Value** column in the case report for older cases and determine the information that is displayed.

**Before you begin**

You must have a trained default estimated time to resolve a case regression solution. For more information, see **Configure the default estimated time to resolve a case regression definition**.

Role required: admin
Procedure

1. Navigate to **System Definition > Fix Script**.

2. Select the **Populate Numeric TTR values** fix script.

3. Optional: Modify the default parameter values.
   - **LookBackPeriodInMonths**: The number of past months of cases to examine. The default value is 15 months.
   - **report.setLimit**: The maximum number of records to examine. The default value is 150,000.

4. Click **Run Fix Script** to populate the estimated time values taken to resolve older cases.

5. Either run the script on screen or run it in the background.
   - To display the script running on the screen, click **Proceed**.
   - To run the script in the background, click **Proceed in Background**.

Configure the default estimated time to resolve a case regression definition

The Estimated Time to Resolve a Case regression definition is available by default. You can modify the default values of case fields, the case timeline, and the training frequency.

**Before you begin**
Role required: admin, ml_admin

**About this task**
The Estimated Time to Resolve a Case definition is available by default. You can train this available definition to complete a solution and make predictions. You can change some of the default settings such as the fields, a filter, and the training frequency. For more information on creating and training a solution, see **Create and train a regression solution**.

**Procedure**

1. Navigate to **Predictive Intelligence > Regression > Solution Definitions**.

2. Click **Estimated Time to Resolve a Case**.
   In the Regression Definition screen, the **Table** field is autopopulated with the Case Report [sn_customerservice_case_report] table. The **Output Field** field is autopopulated with the time taken to resolve a case in seconds.
Note: If you have upgraded, you have to run a fix script in order to show the Time to Resolve Numeric Value column to display values for older cases. For more information, see View the estimated time to resolve values for older case records after upgrading.

3. To edit, add, or delete case attributes, modify the default values in the Fields field.
The default case attributes are Short Description, Category, Assignment group, Assigned to, Priority, Product, Channel, Account, Service, Contact, Contract, and Description. These details are taken from the case record.

4. Edit the Filter field if you want to modify the number of past months of cases to examine.
The default value is 15 months.

5. Edit the Training Frequency field if you want to modify the frequency of training.
The default value is every 30 days.

6. Either update the changes you made or update and retrain the solution.
   - To update the changes you made, click Update.
   - To update and retrain the solution, click Update and Retrain.

Display the Time to resolve ribbon component
Activate the ETTR Experience Card so that you can display the Time to resolve ribbon component in your CSM workspaces.

Before you begin
Role required: admin

About this task
The Time to resolve ribbon component is available by default and can be displayed in both CSM Agent Workspace and CSM Configurable Workspace. You must activate the component in CSM Agent Workspace before you activate it in CSM Configurable Workspace.

Procedure
1. Navigate to Workspace Experience > Forms > Workspace Ribbon Settings.
2. Click any record that has the table value Case [sn_customerservice_case].
3. Increase or decrease the values in the width column to make the total combined width of all the components to 12 or less. If the total is already exceeding 12, decrease the values for the other components before modifying the value of ETTR Experience Card.
4. Click **ETTR Experience Card**.

5. Select **Active**.

6. In the Ribbon Component Attributes form section, modify components such as the **Card title** and **Info message** as required. You can see that the Solution name is pre-filled with the default name.

   **Note:** The same procedure applies to activate the **ETTR Experience Card** in the CSM Configurable Workspace. You must activate the **ETTR Experience Card** in the CSM Agent Workspace before activating it in the CSM Configurable Workspace. Navigate to **User Experience Framework > Ribbon Configuration Settings** and activate. The **Ribbon Component Attributes** section is not available for modifying.

**Configure Outsourced Customer Service**

Configure various components of Outsourced Customer Service based on the specific requirements of your organization.

**Setup Outsourced Customer Service**

Configure various aspects of Outsourced Customer Service based on the specific requirements of your organization.

**Before you begin**

Role required: admin

**About this task**

There are a sequence of tasks that enable you to configure Outsourced Customer Service. You can perform these tasks based on the plugin you activated. Certain setup tasks apply only if you activated the Outsourced Customer Service plugin and this is noted at the top of each task. To configure Outsourced Customer Service, use the Customer Service guided setup. The guided setup takes you through the entire setup and configuration process.

**Procedure**

1. Navigate to **Customer Service > Outsourced Customer Service > Guided Setup**.

   The Outsourced Customer Service Guided Setup page is displayed.

2. On the Onboarding Outsourced Service Provider (OSP) window, click **Get Started**.

3. View the list of tasks to configure the feature.
Onboarding Outsourced Service Provider configuration tasks

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setup Outsourced Service Provider</td>
<td>Creates an OSP by specifying the internal manager and setting up transfer group.</td>
</tr>
<tr>
<td>Setup Outsourcing Criteria</td>
<td>Defines outsourcing criteria based on account, consumer, asset, and sold product. OSP agents can view all the cases matching the outsourcing criteria. For example, consumer based criteria can be defined for all Spanish speaking consumers and all consumers based out of Australia.</td>
</tr>
<tr>
<td>Onboard Manager</td>
<td>Onboard OSP manager for managing cases and agents. Once onboarding is complete, a password reset email is sent to the manager's email id.</td>
</tr>
<tr>
<td>Setup Assignment Groups</td>
<td>Creates a group and associates it to an OSP manager. OSP manager assigns cases to the agents assigned to the group.</td>
</tr>
<tr>
<td>Onboard Agent</td>
<td>Onboard agents for an OSP for fulfilling cases. Once onboarding is complete, a password reset email is sent to the agents email id.</td>
</tr>
</tbody>
</table>

5. On the Case Routing and Assignment window, click **Get Started**.
6. View the list of tasks to configure the feature.

Case Routing and Assignment configuration tasks

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Matching Rules</td>
<td>Rules to identify customer service cases that meet certain conditions.</td>
</tr>
<tr>
<td>Task</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Create Assignment Rules</td>
<td>Cases that meet certain conditions based on the rules created are routed to customer service agents.</td>
</tr>
</tbody>
</table>

7. To perform a task, click **Configure**. This button opens the page in your instance where the configuration is completed.

**Define outsourcing criteria**

OSP managers and agents view cases based on the defined outsourced criteria. Defining outsourcing criteria can be based on account, asset, consumer, or sold product. For example, consumer based criteria could be defined for all Spanish speaking consumers and all consumers based out of Australia.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **Customer Service > Outsourced Service Providers**.
2. Click the OSP name.
3. Click **Outsourcing Criteria** related list.
4. Click **New**.
5. Fill in the fields on the new record form, as appropriate.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Description</strong></td>
<td>Description for the outsourcing criteria.</td>
</tr>
<tr>
<td><strong>Table</strong></td>
<td>The table that stores the task for which the outsourcing criteria is created. Select either <strong>Account</strong>, <strong>Asset</strong>, <strong>Consumer</strong>, or <strong>Sold Product</strong> tables.</td>
</tr>
<tr>
<td><strong>Condition</strong></td>
<td>The conditions in which the outsourcing criteria will apply. Use the buttons in this field to build one or more conditions on the selected table. A condition is made up of a selected field, an operator, and a</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>------------------------------------</td>
</tr>
<tr>
<td>Name</td>
<td>The OSP group name.</td>
</tr>
<tr>
<td>Group email</td>
<td>Group email distribution list or the email address of the group's point of contact, such as the group manager.</td>
</tr>
<tr>
<td>Manager</td>
<td>The OSP manager's name.</td>
</tr>
<tr>
<td>Type</td>
<td>Category for this group. For example, a group designated as type catalog is a service catalog group and can</td>
</tr>
</tbody>
</table>

6. Click **Submit**.

OSP managers and agents can now view assigned cases which meet the condition under **All Cases, Unassigned Cases, My Cases, and Open Cases**. For example, if an OSP organization has been created with outsourcing criteria with consumer table selected, an agent belonging to this OSP can view cases created by a consumer.

**What to do next**
Create groups and set assignment rules for the OSPs.

**Create groups and assignment rules**
An administrator creates groups and associates it to an OSP. This group is the default group to which the case is assigned to when an OSP agent transfers the unresolved case back to an enterprise.

**Before you begin**
Role required: admin

**Procedure**
1. Select an OSP you have created.
2. Go to **Groups** related list.
3. Click **New**.
4. Fill in the fields on the Outsourced Service Provider form, as appropriate.
Onboard Outsourced Service Provider staff

An administrator creates OSPs after which OSP managers and agents must be onboarded to manage and fulfill cases. As an administrator you can onboard both the OSP managers and agents.

Before you begin
Role required: admin

Procedure

2. Click on an existing OSP.
3. Click Onboard Staff related link.
4. Fill in the fields on the Outsourced Service Provider form, as appropriate.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td>The first name of the OSP manager or agent.</td>
</tr>
<tr>
<td>Last Name</td>
<td>The last name of the OSP manager or agent.</td>
</tr>
<tr>
<td>User ID</td>
<td>A unique ID for the OSP manager or agent.</td>
</tr>
<tr>
<td>Email</td>
<td>The OSP manager or agent’s email address.</td>
</tr>
</tbody>
</table>
Create Outsourced Service Provider

An enterprise creates Outsourced Service Providers to provide customer service to external customers.

**Before you begin**
Role required: admin

**Procedure**

1. Navigate to Customer Service > Administration > Outsourced Service Providers.
2. Click New.
3. Fill in the fields on the Outsourced Service Provider form, as appropriate.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The OSP's name.</td>
</tr>
<tr>
<td>Service Provider Type</td>
<td>Customer or Field service provider.</td>
</tr>
<tr>
<td>Manager</td>
<td>The OSP's manager name.</td>
</tr>
<tr>
<td>Website</td>
<td>The OSP's URL.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Notes</td>
<td>Any note regarding the OSP.</td>
</tr>
<tr>
<td>Contact</td>
<td>Enter Phone or Fax phone number.</td>
</tr>
<tr>
<td>Address</td>
<td>The OSP’s postal address.</td>
</tr>
<tr>
<td>Case Transfer</td>
<td>Search and select the <strong>Case transfer group</strong> which is the default group to which the case is assigned when an OSP agent transfers the case.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

What to do next
Define outsourcing criteria so that cases matching the criteria are visible to the OSP managers and agents.

Configure the Performance Analytics components for the Outsourced Customer Service dashboard
Run diagnostics, review and customize components, and start collecting data.

Before you begin
A Now Platform administrator must have installed the content pack plugins or ServiceNow Store application for this Analytics and Reporting Solution.
Role required: `pa_admin`

Procedure
1. Run all diagnostics on all records, as described in **Performance Analytics diagnostics**. These diagnostics can catch many mismatches between the configuration of your Analytics and Reporting Solutions and your tables.
2. Navigate to **Performance Analytics > Administration Console**.
3. Click the **Dashboards** link in the **Explore and Manage** tile.
4. Verify the names of the dashboards that have been installed with this Analytics and Reporting Solution
5. Open the **Indicator Sources** tab.
6. For each dashboard included in this Analytics and Reporting Solution:
a. Filter the indicator sources on the dashboard name.

Example
This screenshot shows the indicator sources filtered on the Outsourced Service Provider dashboard from the Self-Service Analytics for CSM Analytics and Reporting Solution.

b. Review the facts table, conditions, and frequency of the indicator sources compared to the data structure on your own instance.

c. If necessary, open an indicator source and make corrections.

d. If you are editing an indicator source record, go to the Indicators related list and review the Conditions field for each indicator. Changing the indicator source can also affect the additional conditions on the individual indicators.

7. If you changed the time field stamps in any indicator sources, also change any related Performance Analytics scripts. For more information, see Update Performance Analytics scripts.

8. Open the Breakdown Sources tab.

9. For each dashboard included in this Analytics and Reporting Solution:
   a. Filter the breakdown sources on the dashboard name.
   b. Review the conditions on the breakdown source as described in Review the breakdown sources.

11. Set up and run the historical job for this Analytics and Reporting Solution, "name of historical job". Follow the procedure in Run historical data collection for an Analytics and Reporting Solution.

12. Edit and activate the scheduled data collection job for this Analytics and Reporting Solution, "name of scheduled job". Follow the procedure in Schedule data collection for an Analytics and Reporting Solution.

Related information
Using Outsourced Customer Service

Configure Walk-up Experience for Customer Service Management
Configure various aspects of Walk-up Experience based on the specific requirements of your organization. Walk-up Experience users with the sn_csm_walkup.walkup_admin role and administrators can activate and configure the application to meet specific requirements.

About this task
There is a sequence of tasks that enable you to configure CSM Walk-up Experience. Perform these tasks based on the plugin you activated.

You can configure appointments, decide when to send notifications to users, establish and configure physical queue locations and operating schedules, integrate with CSAT surveys, and associate stockrooms with queue locations.

You can also customize your Walk-up Experience portal with a unique logo and branding.

To configure CSM Walk-up Experience, use the configuration tasks listed in the table below which takes you through the entire configuration process.

Procedure
1. Navigate to CSM Walk-up Experience > Administration.
2. Complete the following tasks to configure the CSM Walk-up Experience feature.

<table>
<thead>
<tr>
<th>CSM Walk-up Experience configuration tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task</td>
</tr>
<tr>
<td>Activate CSM Walk-up Experience.</td>
</tr>
<tr>
<td>Task</td>
</tr>
<tr>
<td>------</td>
</tr>
<tr>
<td><strong>Note:</strong> This plugin includes demo data.</td>
</tr>
</tbody>
</table>

Click **Walk-up Locations** for configuring locations. Create walk-up location queues with custom schedules, assignment groups, average wait time, and more. For more information about configuring locations, see Configure Walk-up Experience locations.

Click **Schedules**. View, create, or modify walk-up venue schedules, such as 8-5 weekdays, and associate them to the walk-up location queues. For more information about configuring schedules, see Configure Walk-up Experience schedules.

Click **Appointment Configurations** for configuring appointments. Create service configurations for individual walk-up queue locations. You can configure schedules, number of appointments allowed per day, how far in the future users can book appointments, and more. For more information about configuring appointments, see Configure appointment booking.

Click **Portal Configurations** for configuring a portal. Create and modify custom Walk-up Experience online and on-site service portals. For more information about configuring the portal, see Configure the Walk-up Experience portal.

Click **Notifications** for configuring notifications. Access and configure alerts that keep users and fulfillers informed of events that concern them. For more information about configuring notifications, see Configure Walk-up Experience notifications.

**Surveys**

Access customer satisfaction surveys and enable public access to the surveys, set survey trigger conditions.
Domain separation and the CSM Walk-up Experience application

This section is an overview of domain separation as it pertains to the CSM Walk-up Experience application and how it relates to Service Portal pages, interaction queues, and configurations. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

Support level: Basic

- Business logic: Ensure that data goes into the proper domain for the application’s service provider use cases.
- The application supports domain separation at run time. The domain separation includes separation from the user interface, cache keys, reporting, rollups, and aggregations.
- The owner of the instance must set up the application to function across multiple tenants.

Sample use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.

For more information on support levels, see Application support for domain separation.

Overview

Domain separation in the CSM Walk-up Experience application is supported at the Basic level. However, the application depends on the Service Portal, which is not supported for domain separation. Domain separation pertains to the CSM Walk-up Experience application in the following ways:

- Walk-up location queues support domain separation to define which end users can access each location queue.
- The Interaction table supports standard domain separation for data security. Interaction tickets are opened for a specific domain.
• Walk-up location queues and interactions support domain separation. Therefore, fulfillers also work within a domain-separated environment when addressing interaction tickets associated with a location queue.

• Management and administration configurations reside in the walk-up location queue records. Therefore, those configurations are available to the respective domain managers and admins.

• While the Service Portal pages are not domain separated, the CSM Walk-up Experience application’s portal pages retrieve data within the user’s specific domain. Therefore, those pages can be reused across different service portals designed and configured for separate domains. The admins must build each portal themselves.

• The **Domain** field is available on the `wu_location_queue` table. Setting domain here ensures users only see queues that are part of their domains during online check-in.

• For Advanced Work Assignment routing to operate, each `wu_location_queue` must include a work item routing condition. This condition explicitly adds a reference to the domain the queue is part of.

  **Note:** The appointment booking feature is not domain separated. Since Appointment [itil_appointment] table data is not domain separated, list views could reveal data across domains.

**How domain separation works in the CSM Walk-up Experience application**

For this application to be the most effective, walk-up administrators should configure walk-up locations accordingly. Configure the `wu_location_queue` record to meet a user need, which affects the requester experience. Each domain configured to the location queue record has its own set of rules. The same applies to other tables within the Walk-up application as well.

  **Note:** Elements of the Service Portal platform such as settings, portals, and widgets cannot be domain separated. However, the data within the widgets displays based on how the domain is configured. The recommended approach is to set up separate portals for each MSP customer.

Elements of the Service Portal that are used as part of the walk-up experience are as follows:

- **Portal (Walk-up)**
- **Pages** (`walkup_online_checkin, walkup_queue_on_site, walkup_home, walkup_survey, walkup_check_in`)
• Theme (Walk-up theme)
• Widgets (Online check-in experience, walk-up queue on site, walk-up check-in, walk-up exit survey, walk-up home, walk-up schedule)

To learn more, see Domain separation and Service Portal.

For data separation, the CSM Walk-up Experience application uses the walk-up user (Requester/Walkup login user) domain to determine in which domain the requester data should be placed.

• Requesters can check in only in locations for which they have visibility.
• Requesters are able to select the Reasons that belong only to their own domain.
• Interaction records are created in the Requester’s domain.

For the Fulfiller side, the application uses the domain of the walk-up user (walk-up technician/manager/admin) to determine which records are visible.

• By domain separation rules, Fulfillers can work only on interactions that are visible to them.
• Fulfillers are able to configure only walk-up location records that belong to their domain, are in the global domain, or have the parent-child hierarchy.
• The same visibility rules apply for the Many to Many \([wu_m2m_location_queue_reason]\) tables that control the mapping between a location and reason.
• The walk-up context records also have domain separation support. This support ensures technicians to view detailed requester information only for the records that are visible by domain separation rules.

**Domain-separated tables**

As part of the CSM Walk-up Experience, records in the following tables can be domain separated.

• Walk-up location queues \([wu_location_queue]\)
• Walk-up reasons for visit \([wu_reason]\)
• Walk-up reasons \([wu_m2m_location_queue_reason]\)
• Walk-up contexts \([wu_context]\)
• Interactions \([interaction]\)
CSM Walk-up Experience portal security and access

Security is built into the application to prevent end-user facing devices at the Walk-up Experience onsite portal from offering elevated role privileges to users. The Walk-up Experience onsite portal is accessed by an account containing only the sn_walkup.walkup_login role.

Understanding Walk-up Experience portal security

Accessing the onsite Walk-up Experience portal requires the singularly assigned sn_walkup.walkup_login role. The user record with this role cannot contain any other roles. Since most user records contain multiple roles, the sn_walkup.walkup_login role is assigned to a user record account, not a human user. The security feature prevents the onsite portal check-in device from permitting users who may try accessing the portal with an elevated privilege role.

The sn_walkup.walkup_login role is granted to a user record for an account used to log in to the check-in device. Device can typically be a tablet, at the onsite Walk-up Experience portal. It is not an actual human being with an assigned role, but an account with a role. For example, a technician opening the onsite Walk-up portal for business logs in to the check-in device using the user record that contains the sn_walkup.walkup_login role. Again, the portal can only be accessed by a user record that contains this role only. A user cannot access the portal with the admin role or if the user record contains roles other than the sn_walkup.walkup_login role.

Access to Walk-up Experience

Technicians opening up the onsite Walk-up location for business, or joining the support team during operation hours, access the user record account. Technicians with sn_walkup.walkup_login role can log in to the Walk-up Experience portal. Internal and external users can access the onsite Walk-up Experience portal via a check-in device, typically a tablet, to enter a queue. Internal, authenticated users can also access an online queue check-in via desktop.

Configure the Walk-up Experience portal

Create engaging walk-up center service portals featuring your logo, portal theme, desired catalog, links to a knowledge base and social community, and more.

Before you begin

Walk-up Experience includes a complete base-system Walk-up Portal with theme. The Walk-up Portal pages are meant to be used as built. You can create custom portal pages to meet your needs by copying the portal pages and
associated widgets and making changes to the copies. You can configure both an online check-in portal and a physical check-in portal for your walk-up locations.

There are several ways to configure the Walk-up service portal:

- **Service Portal** application: Modular user interface framework for quick and easy building and customization of application portals.
- Service Portal Walk-up form: Requires CSS and HTML experience.

Role required: admin or sn_walkup.walkup_admin

**Procedure**

1. To configure the Walk-up service portal using the **Service Portal** application, navigate to **Service Portal > Service Portal Configuration**. The Service Portal configuration page opens.

2. To customize the base-system walk-up portal with your unique branding, title, logo, theme colors, layout, properties, widgets, and more, or to create a new walk-up portal, refer to **Service Portal** for detailed information.

3. Alternatively, to configure the Walk-up service portal using the Service Portal Walk-up form, navigate to **CSM Walk-up Experience > Administration > Portal Configurations**. The Service Portals list opens.

4. In the Service Portals list, click Walk-up or search for it in the list header search box.

5. Click the form menu icon  and select **Configure > Form Design**. The form designer opens.

6. In the form designer header drop-down list select or search for any of the configurable walk-up forms to customize your portal appearance.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Walk-up context [wu_context]</td>
<td>Configure an online check-in channel for users to join a walk-up queue before physically arriving at the walk-up location. Identifies a walk-up user and the description of the associated interaction.</td>
</tr>
<tr>
<td>Walk-up Location Queue [wu_location_queue]</td>
<td>Configure the physical walk-up location interaction queue to manage and administer the service center. You can establish walk-up locations,</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>set hours of operation, enable online check-in, determine assignment groups, associate stockrooms, as well as design the queue time display and position notification system.</td>
<td></td>
</tr>
<tr>
<td><strong>Walk-up Reason [wu_m2m_location_queue_reason]</strong></td>
<td>Define various common reasons why a user needs walk-up support.</td>
</tr>
<tr>
<td><strong>Walk-up Reason for Visit [wu_reason]</strong></td>
<td>Specify the order in which reasons for a visit should be prioritized at a walk-up location.</td>
</tr>
</tbody>
</table>

The associated form opens. To modify form content to meet your portal requirements, refer to Form configuration for detailed information.

**Configure Walk-up Experience service channel**
Configure the Walk-up Experience service channel to meet the needs of your walk-up agents. You can configure the way the tasks are assigned and manage interactions in the Agent Workspace.

**Before you begin**
Role required: admin or sn_csm_walkup.walkup_admin

**About this task**
The Walk-up Experience service channel is viewed and configured through Advanced Work Assignment. You can modify default values and conditions as required.

**Procedure**
1. Navigate to Advanced Work Assignment > Service Channels. The Service Channels list displays.
2. Select Walk-up to open the Walk-up Experience service channel.
3. Refer to Configure a service channel for detailed information regarding the Service Channel Walk-up form values and conditions. For more information regarding Advanced Work Assignment service channels configuring capacity and utilization, inbox layout, and overriding agent capacity for selected agents, see Service channels.
Configure Walk-up Experience notifications

As an administrator you can create and use notifications to notify requesters about events that impact them while they are getting their issue addressed through walk-up experience. Requesters are notified of online appointments they have taken or when their issue is assigned to a store representative by email.

Before you begin
Role required: admin or sn_csm_walkup.walkup_admin

About this task
Walk-up Experience includes several base-system notifications that you can use or customize to notify walk-up visitors about specific information and interactions, including:

<table>
<thead>
<tr>
<th>Notification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Walk-up Abandoned</td>
<td>Notifies when a walk-up interaction is closed.</td>
</tr>
<tr>
<td>Walk-up Threshold Notification</td>
<td>Notifies visitors when they are close to being next in line for support.</td>
</tr>
<tr>
<td>Walk-up Assigned</td>
<td>Notifies when an interaction is assigned to a technician.</td>
</tr>
<tr>
<td>Walk-up Closed</td>
<td>Notifies when a walk-up location is closed.</td>
</tr>
</tbody>
</table>

Procedure
1. Navigate to **CSM Walk-up Experience > Administration > Notifications**.
2. Click an available walk-up notification to view basic properties, as well as information about when to send it, who will receive it, and what the notification will contain.
   The walk-up notification form appears.
3. To modify a walk-up notification, edit any of the form fields.
4. To create a new walk-up email or push notification, click **New** and refer to Create an email notification or Create a push message.

For complete information regarding using the System Notification application, refer to **Notifications**.
Configure Walk-up Experience schedules

Once you know the hours of operation for your Walk-up Experience location, you can either access the base-system default schedules or create new schedules to associate with your walk-up location.

Before you begin
Role required: admin or sn_csm_walkup.walkup_admin

Procedure

1. Navigate to CSM Walk-up Experience > Administration > Schedules.
   The Schedules list opens. You can view all available base-system default schedules, such as 8-5 weekdays excluding holidays.

2. To modify an existing base-system schedule, click the schedule name, otherwise click New to create a schedule if none of the default schedules apply for your walk-up location.

3. Complete the Schedule New record form or modify fields on an existing form.
   To complete this process and for detailed information on creating, modifying, and using schedules in the system, including a definition of all form fields, refer to Schedules.

Walk-up Experience appointment booking

With the CSM Walk-up Experience appointment booking feature, walk-up users can view available appointment windows. The users can also select and book an appointment for a walk-up location using the online Walk-up Check-in feature.

Create time windows for walk-up queue locations enabling requesters to book service appointments.

The Appointment Booking plugin (com.snc.appointment_booking) must be activated to use the application. Appointment booking adds the Appointment Booking menu to the application navigator and the following modules:

- Appointment Booking Configuration: Use this module to create an appointment booking. Configure an application and then configure each service within that application.

- Appointment Bookings: Use this module to view a list of appointments that have been booked for services. This list includes the work orders associated with each appointment.
Appointment booking requires configuration at both the application level, in this case, Walk-up Experience, and at the walk-up queue service level, represented by the actual location of the walk-up queue.

The Walk-up Experience application configuration contains settings that apply to all the service locations within the application that support appointment booking.

A service configuration is required for each of the walk-up queue locations within the application that offer scheduled appointments. A service configuration includes settings that apply only to that specific walk-up queue service location.

⚠️ Note: Both the application configuration and the service configuration must be active to book appointments.

For detailed information about the Appointment Booking application, refer to Appointment booking.

Configure appointment booking

Create or modify appointment booking configurations for Walk-up Experience services. A service is defined as the actual physical location of a walk-up queue. The information stored in the Walk-up Experience application configuration applies to all services or queue locations within the application.

Before you begin
Role required: admin or sn_csm_walkup.walkup_admin

Procedure

1. Navigate to CSM Walk-up Experience > Administration > Appointment Configurations.

2. Click New to create a new service configuration. Alternatively, you can click an existing service configuration to modify data.

3. In the Appointment Booking Service Configuration form, fill in the following fields as needed.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the service configuration.</td>
</tr>
<tr>
<td>Active</td>
<td>Activates appointment booking for the service.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>General Information</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Configuration</strong></td>
<td>The name of the appointment booking configuration to which this service belongs.</td>
</tr>
<tr>
<td><strong>Availability table</strong></td>
<td>The table calculates appointment availability. For Walk-up Experience, choose Walk-up Appointment [wu_appointment].</td>
</tr>
<tr>
<td><strong>Holiday Schedule</strong></td>
<td>The holiday schedule to use when determining availability. Appointment booking evaluates the holiday schedule when determining the number of available appointments and excludes any day in the schedule that is set to Exclude. Click the lookup icon and select a schedule from the Schedules list. Note: Holiday schedules are useful when you set the assignment method for tasks to manually, which does not consider agent schedules.</td>
</tr>
<tr>
<td><strong>Catalog Information</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Catalog item</strong></td>
<td>The service in the service catalog for which you are creating this appointment booking configuration. Click the lookup icon and select the associated service from the Record Producers list. You must create a record producer for each walk-up service location. Note: The catalog item must exist in the service catalog. Note: If you are using appointment booking with work orders, create a work order template before you configure appointment booking.</td>
</tr>
<tr>
<td><strong>Location</strong></td>
<td>The field on the record provider that determines the appointment location.</td>
</tr>
</tbody>
</table>

*i* **Note:** If deactivated, customers cannot schedule appointments for the service but can still create work orders.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong> Ensure the <strong>Location</strong> field on both this form and the Walk-up Location Queue (wu_location_queue) form are configured in alignment. contains the location reference variable, which is a Location (cmn_location) record. Selecting <strong>Location</strong> from the search list icon ensures you are aligning with the same time zone as the walk-up location you are configuring for. When you select <strong>Location</strong>, the online appointment scheduling calendar displays in the user time zone. If you leave this field empty or if you have not configured the user preference for the instance to have an associated time zone, the appointment scheduling calendar defaults to display in the user time zone. If a user in Europe has User preferences for <strong>Time zone</strong> configured for <strong>Europe/Brussels</strong> and the Appointment Booking Configuration for the <strong>Location</strong> field is set to a cmn_location with the time zone <strong>US/Pacific</strong>, then the appointment scheduling calendar displays in the US/Pacific time zone. When a user creates an appointment, the system defaults to use the schedule associated with the Walk-up Location Queue (wu_location_queue), regardless of the <strong>Location</strong> field value of this record producer.</td>
<td></td>
</tr>
<tr>
<td>Appointment is mandatory</td>
<td>Enable this check box if it is required for a customer to create an appointment when requesting this service.</td>
</tr>
<tr>
<td></td>
<td>• If enabled, the <strong>Appointment</strong> field appears on the record producer and the user must select an available appointment before submitting the service request.</td>
</tr>
<tr>
<td></td>
<td>• If disabled, the user can submit the service request without selecting an appointment.</td>
</tr>
<tr>
<td>User contact</td>
<td>The field on the record producer that determines for whom the appointment was created. Set this field to <strong>Contact</strong>. This is a reference field that looks for a sys_user variable on the record producer.</td>
</tr>
<tr>
<td>Booking</td>
<td></td>
</tr>
<tr>
<td>Appointments per window</td>
<td>The number of available appointments for each configured appointment time slot. This number determines the number</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>of available appointments</td>
<td>of available appointments displayed on the Select Appointment window. Enter a number in this field if the assignment method for tasks is set to manually. If set to either using auto-assignment or using dynamic scheduling, this setting does not apply, unless a location is not provided. Then the configuration defaults to the number of appointments per window.</td>
</tr>
<tr>
<td>Lead time</td>
<td>The number of hours or days from the current time after which you have booked an appointment for this service. Define the lead time in hours or days. The default is 4 hours.</td>
</tr>
<tr>
<td>Future bookable max days</td>
<td>The number of days before the current day for which an appointment can be booked for this service. The default is 14 days.</td>
</tr>
<tr>
<td>Reschedule / Cancel by time</td>
<td>The number of hours or days prior to an appointment start time that are required for cancelling an appointment or rescheduled. If a user attempts to cancel or reschedule an appointment within this number of hours, the Cancel button is not available. Define the time in hours or days. The default is 4 hours.</td>
</tr>
<tr>
<td>Appointments</td>
<td></td>
</tr>
<tr>
<td>Appointment window</td>
<td>The length or duration of the appointment window.</td>
</tr>
<tr>
<td>Work duration</td>
<td>The amount of time required to complete all tasks created by the record producer. You set the duration for a task when it is created which is used to determine availability. The default is 1 hour.</td>
</tr>
<tr>
<td>Travel duration (round trip)</td>
<td>An estimated value of the average travel time required for the agent performing the task. Set the value to 0 since the work is performed onsite and travel time is not needed.</td>
</tr>
<tr>
<td>Daily Schedule</td>
<td></td>
</tr>
<tr>
<td>Bookable days</td>
<td>The days of the week for which appointments can be booked. The default is Monday through Friday. Bookable days should reflect the appointment schedule.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Daily start time</td>
<td>The start of the work day and the earliest start time for an appointment window. The default is 9:00.</td>
</tr>
<tr>
<td>Daily end time</td>
<td>The end of the work day and the latest end time for an appointment window. The default is 18:00 PM.</td>
</tr>
<tr>
<td>Include daily break</td>
<td>Enable this check box to schedule a break for each bookable day, then select the break start and end times. Can define one break which applies to all days.</td>
</tr>
<tr>
<td>Appointment booking preview</td>
<td>Provides a preview of the appointment windows and times based on the selected start and end times, break time, and appointment window.</td>
</tr>
</tbody>
</table>

#### Note:
Appointment schedules are separate from the walk-up queue location schedule but should be the same days and hours as the walk-up queue location schedule.

4. Click **Submit**.

**Walk-up Experience appointment booking administration**

Create or modify and enable the CSM Walk-up Experience application configuration and the individual service location configurations for the **Appointment Booking** feature.

Administrators can create, modify, and enable the Walk-up Experience application configuration. Appointment booking administrators (appointment_booking_admin) can create, modify, and enable configurations for service locations within the Walk-up Experience application.

**Walk-up Experience** is an application level configuration provided with the base system appointment booking feature. You can include as many service level configurations as needed. The service level configurations apply to the individual walk-up queue locations that exist. Administrators can modify these configurations as needed or use them as examples to create new configurations.

For detailed information on appointment booking administration, refer to **Administer appointment booking**.

**Enable Walk-up Experience appointment-booking**

Enable or disable the appointment booking feature for Walk-up Experience as well as for the individual walk-up service locations available to customers.
Before you begin
Role required: admin or sn_csm_walkup.walkup_admin

About this task
The Appointment Booking plugin (com.snc.appointment_booking) must be activated to use the application.
When you enable appointment booking, the Schedule an appointment tab appears on the online check-in page. Users choose a reason for the appointment and select a date and time from the available appointments.

Procedure
1. Navigate to Appointment Booking > Appointment Booking Configuration.
2. Click Walk-up Experience.
   The Walk-up Experience configuration is provided with the base system Appointment Booking feature.
3. Click Active to enable appointment booking for the Walk-up Experience application. Alternatively, if the feature is active you can deactivate it by clicking Active.
4. In the Appointment Booking Service Configuration related list, click the name of a service.
   For Walk-up Experience, the physical location of a walk-up queue defines a service. Every walk-up queue associated with your application is a service that you must configure for appointment booking.
   The Appointment Booking Service Configuration form for the selected service opens.
5. Click Active to set the field to true.
6. Click Update.

Walk-up Experience appointment booking configuration
Create or modify appointment booking configurations for the Walk-up Experience. You can view or modify the Walk-up Experience application appointment booking configuration and create or modify related service appointment configurations.

The base system Walk-up Experience application includes a default appointment booking configuration that can be modified. By default, the information stored in the Walk-up Experience application appointment booking configuration applies to all services within that application. Services within the Walk-up Experience application are defined as the actual walk-up queue locations. You can create new appointment booking service configurations for the Walk-up Experience application or modify existing configurations.
For example, you may want to configure one walk-up queue to accept appointment booking every day from Monday to Friday, but for another queue, you only want appointment booking available on Monday, Wednesday, and Friday. By configuring appointment booking at the service level, you can achieve this goal.

Specific Walk-up Experience set-up criteria for appointment booking include the following configurations:

- Define different appointment schedules and time windows per queue location.
- Define the time window in which you want to support appointments. For example, 15 minutes v. 30 minutes.
- Define the time window capacity. For example, the maximum number of appointments per time window.

View or modify a Walk-up Experience appointment booking configuration

View the base system default appointment booking configuration to determine if the criteria meets your walk-up appointment booking requirement. You can modify the configuration to manage appointment booking. The information stored in the Walk-up Experience appointment booking configuration applies to all the services within the application.

Before you begin
Role required: admin or sn_csm_walkup.walkup_admin

About this task
The Walk-up Experience configuration is provided with the Appointment Booking feature.

Procedure
1. Navigate to Appointment Booking > Appointment Configurations.
2. To view the Walk-up Experience configuration, click the configuration name.
3. In the Appointment Booking Configuration form, view or modify the following fields as needed.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the application configuration.</td>
</tr>
</tbody>
</table>
### Task Table
Appointments are created for the tasks in the selected table. The Walk-up Appointment [wu_appointment] table is the default table for the **Walk-up Experience** configuration.

### Availability Method
Use one of two methods to determine appointment availability.

- **Number of appointments per slot**: Define a specific number of appointments per time slot. Use this method if the task assignment is set to *manually* which is the default setting.
- **Scripted**: Use this configuration setting to determine availability if the task assignment method is set to using *auto assignment* or *dynamic scheduling*.

### Active
Activates the application configuration and enables appointment booking.

### Auto acceptance
If the application configuration setting for **Process lifecycle** is set to *task-driven*, an agent must accept or reject an assigned task. Enable the **Auto acceptance** check box to override this configuration setting for appointment booking.

### Portal View
Display available appointments for a single day or for a week on the online **Self Service Walk-up Check-in** portal or from the **Service Portal**.

4. Click **Submit**.

**Create or modify a Walk-up Experience appointment booking service configuration**

Create or modify appointment booking configurations for Walk-up Experience services. A service is defined as the actual physical location of a walk-up queue. The information stored in the Walk-up Experience application configuration applies to all services, or queue locations, within the application.

**Before you begin**
Role required: admin or sn_apptmmt_booking.appointment_booking_admin

**About this task**
To use the appointment booking feature, administrators must create a configuration for each service, or queue location, that is available to walk-up customers. Service configurations are created within the **Walk-up Experience** application configuration, as part of the **Appointment Booking** application.
Procedure

1. Navigate to Appointment Booking > Appointment Booking Configuration.

2. Click Walk-up Experience.

3. In the Appointment Booking Service Configuration related list, click New to create a new service configuration. Alternatively, you can click an existing service configuration to modify data.

4. In the Appointment Booking Service Configuration form, fill in the following fields as needed.

Appointment booking service configuration fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Activates appointment booking for the service.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If deactivated, customers cannot schedule appointments for the service but can still create work orders.</td>
</tr>
<tr>
<td>General Information</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>The name of the service configuration.</td>
</tr>
<tr>
<td>Configuration</td>
<td>The name of the appointment booking configuration to which this service belongs.</td>
</tr>
<tr>
<td>Availability table</td>
<td>The table that is used to calculate appointment availability. For Walk-up Experience, choose Walk-up Appointment [wu_appointment].</td>
</tr>
<tr>
<td>Holiday Schedule</td>
<td>The holiday schedule to use when determining availability. Appointment booking evaluates the holiday schedule when determining the number of available appointments and excludes any day in the schedule that is set to Exclude. Click the lookup icon and select a schedule from the Schedules list.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Holiday schedules are useful when the assignment method for tasks is set to manually, which does not consider agent schedules.</td>
</tr>
<tr>
<td>Catalog Information</td>
<td></td>
</tr>
<tr>
<td>Catalog Item</td>
<td>The service in the service catalog for which this appointment booking configuration is being created. Click the lookup icon and select a service from the Record Producers list.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong> The catalog item must exist in the service catalog.</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> If you are using appointment booking with work orders, create a work order template before you configure appointment booking.</td>
<td></td>
</tr>
<tr>
<td>Location</td>
<td>The field on the record provider that determines the appointment location.</td>
</tr>
<tr>
<td>Appointment is mandatory</td>
<td>Enable this check box if it is mandatory that a customer create an appointment when requesting this service.</td>
</tr>
<tr>
<td></td>
<td>• If enabled, the Appointment field appears on the record producer and the user must select an available appointment on the Select Appointment window before submitting the service request.</td>
</tr>
<tr>
<td></td>
<td>• If disabled, the user can submit the service request without selecting an appointment.</td>
</tr>
<tr>
<td>User contact</td>
<td>The field on the record provider that determines who the appointment is being created for. This is a reference field that looks for a sys_user variable on the record producer, for example, Contact.</td>
</tr>
<tr>
<td>Timezone</td>
<td>The appointment window based on the Timezone field specified in the user contact record or the location where the appointment for the task is scheduled.</td>
</tr>
<tr>
<td>Booking</td>
<td>The number of available appointments for each configured appointment time slot. This number determines the number of available appointments that are displayed on the Select Appointment window. Enter a number in this field if the assignment method for tasks is set to manually. If set to either using auto-assignment or using dynamic scheduling, this setting does not apply, unless a location is not provided. Then the configuration defaults to the number of appointments per window.</td>
</tr>
<tr>
<td>Lead time</td>
<td>The number of hours or days from the current time after which an appointment can be booked for this service. Define the lead time in hours or days. The default is 4 hours.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Future bookable max days</strong></td>
<td>The number of days in advance of the current day for which an appointment can be booked for this service. The default is 14 days.</td>
</tr>
<tr>
<td><strong>Reschedule / Cancel by time</strong></td>
<td>The number of hours or days prior to an appointment start time that are required for an appointment to be canceled or rescheduled. If a user attempts to cancel or reschedule an appointment within this number of hours, the <strong>Cancel</strong> button is not available. Define the time in hours or days. The default is 4 hours.</td>
</tr>
<tr>
<td><strong>Appointments</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Appointment window</strong></td>
<td>The length or duration of the appointment window.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Allow enough time for the work to be started and completed within this window.</td>
</tr>
<tr>
<td><strong>Work duration</strong></td>
<td>The amount of time required to complete all tasks created by the record producer. This duration is set for a task when it is created. Used to determine availability. The default is 1 hour.</td>
</tr>
<tr>
<td><strong>Travel duration (round trip)</strong></td>
<td>An estimated value of the average travel time required (round trip) for the agent performing the task. Set the value to 0 since the work is performed onsite and travel time is not needed.</td>
</tr>
<tr>
<td><strong>Daily Schedule</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Bookable days</strong></td>
<td>The days of the week for which appointments can be booked. The default is Monday through Friday. Bookable days should reflect the appointment schedule.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Appointment schedules are separate from the walk-up queue location schedule but should be the same days and hours as the walk-up queue location schedule.</td>
</tr>
<tr>
<td><strong>Daily start time</strong></td>
<td>The start of the work day and the earliest start time for an appointment window. The default is 9:00.</td>
</tr>
<tr>
<td><strong>Daily end time</strong></td>
<td>The end of the work day and the latest end time for an appointment window. The default is 18:00 PM.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Include daily break</td>
<td>Enable this check box to schedule a break for each bookable day, then select the break start and end times. Can define one break which applies to all days.</td>
</tr>
<tr>
<td>Appointment booking preview</td>
<td>Provides a preview of the appointment windows and times based on the selected start and end times, break time, and appointment window.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Configure daily schedules for Walk-up Experience service appointment booking**

Specify different daily hours of operation for your Walk-up Experience location appointment booking.

**Before you begin**
Role required: admin or sn_apptmmt_booking.appointment_booking_admin

**About this task**
Create a unique appointment booking schedule for each day of the week or for specific days of the week. For example, you can set the appointment booking availability schedule to run all day, from 9:00am to 5:00pm, Monday, Wednesday, and Friday. Tuesday and Thursday appointment availability schedule can run from 9:00am to 12:00pm. You can completely remove appointment booking for a specific day of the week, for example, Friday.

⚠️ **Note:** To specify unique daily booking schedules, while using your associated appointment booking configuration, create new Schedule Entries to exclude the hours appointment booking is not available.

**Procedure**

1. To configure, for example, Tuesday and Thursday appointment availability schedule from 9:00am to 12:00pm, navigate to **Walk-up Experience > Schedules**.

2. Select the schedule you use, for example, the **8-5 weekdays excluding holidays** schedule.

3. In the Schedule Entries related list, click **New**.
   The Schedule Entry New record form appears.

4. Name the new record **Excludes** and fill in the form to create a unique daily booking schedule for Tuesday and Thursday appointments.
Schedule Entry Excludes configuration fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name the record. For example, name the record <strong>Excludes</strong> to indicate the hours excluded from appointment booking.</td>
</tr>
<tr>
<td>Type</td>
<td>Choose <strong>Excluded</strong> as the type.</td>
</tr>
<tr>
<td>Show as</td>
<td>Choose <strong>Busy</strong> as the reason for the exclusion.</td>
</tr>
<tr>
<td>When</td>
<td>Indicate the date to begin using this booking availability schedule. Also indicate the time to exclude booking availability for this date. For example, the hours of 12:00pm through 5:00pm.</td>
</tr>
<tr>
<td>Repeats</td>
<td>Indicate the recurrence for this availability schedule. For example, <strong>Weekly on Tue and Thu</strong>.</td>
</tr>
<tr>
<td>Repeat until</td>
<td>Specify how long you want this availability schedule to run by selecting an end date.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

6. To verify that Tuesday and Thursday appointment booking is only available from 9:00am to 12:00am, navigate to your online Walk-up Check-in application.
   If configured for view, You can access the online Walk-up Check-in application from the **Service Portal Home** page or under **Self-Service** in the left navigation bar.

7. Select the walk-up location for which you are verifying the schedule.

8. Click **Schedule an appointment** and select a reason for the visit.

9. Select a date for the appointment.
   The **Select Appointment** window displays the first available appointment, by week and day.
10. Determine that appointments are only available on Tuesdays and Thursdays from 9:00am to 12:00pm.

Activate and configure appointment booking reminders for Walk-up Experience

Configure scheduled appointment reminders for Walk-up Experience users. Reminders ensure users attend appointments in a timely manner or reschedule or cancel an appointment if they can no longer attend.

Before you begin
Role required: admin or sn_csm_walkup.walkup_admin

About this task
In order for appointment booking reminders to operate, you must activate the Appointment Booking Reminders Scheduled Job, which is not active by default. In addition, the Appointment reminder field does not appear on the Appointment Booking Service Configuration form by default. You must add it to the form and configure reminders. Reminders are inactive unless a configuration is set.

Procedure
1. To activate the Appointment Booking Reminders Scheduled Job, navigate to System Definition > Scheduled Jobs.
2. Search for Appointment Booking Reminders by name and click to open.
3. Click the Active field to activate the scheduled job.
4. Click Update.
5. To add the Appointment reminder field to the Appointment Booking Service Configuration form, navigate to Walk-up Experience > Administration > Appointment Configurations.
6. Select a Walk-up Experience service configuration from the list. The **Appointment Booking Service Configuration** form opens.

7. Click the menu button (≡) and scroll to Configure > Form Layout.

8. Select **Appointment reminder** from the **Available** list and move it to the **Selected** list using the add button.

9. Click **Save**.

The **Appointment Booking Service Configuration** form displays with the **Appointment reminder** field.

10. To configure an appointment reminder, choose an amount of time, in hours, from the **Appointment reminder** field drop-down list. The hour or hours you choose represents the amount of time before a scheduled appointment that you want to send a reminder, for example, 2 hours before a scheduled appointment.

11. Click **Update** to add the appointment reminder configuration.

**Configure Walk-up Experience locations**

Administrators define walk-up locations while setting up walk-up experience for an organization. This information will be shown to requesters when they schedule their appointment or check-in at a service store.

**Before you begin**

Role required: admin or sn_csm_walkup.walkup_admin

**About this task**

The administrators can configure the following for CSM locations:

- create, modify, or remove (mark inactive) walk-up location queues
- allocate schedule for appointments, AWA conditions
- set conditions to automatically route work items
- location unavailable temporarily
- location address and picture
- specify reasons-for-visit options
- configure how interactions display for each walk-up location

**Procedure**

1. Navigate to **CSM Walk-up Experience > Administration > Walk-up Locations**.

2. Click **New**.

3. Complete the form.
<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Provide a detailed name for the location, such as the city or building it is located at.</td>
</tr>
<tr>
<td>Description</td>
<td>Provide a description of the location, if desired.</td>
</tr>
<tr>
<td>Schedule</td>
<td>Select a schedule for operation days and hours.</td>
</tr>
<tr>
<td>Appointment Booking</td>
<td>Add and configure an appointment booking schedule for the walk-up location.</td>
</tr>
<tr>
<td>Service Channel</td>
<td>Search for and choose the <strong>Walk-up</strong> service channel.</td>
</tr>
<tr>
<td>Define condition here</td>
<td>Select whether or not to automatically route work items to this queue using a condition.</td>
</tr>
<tr>
<td>Condition mode</td>
<td>Choose either <strong>Simple</strong> mode or <strong>Advanced</strong> mode to automatically route work to the queue. Simple mode is the default. With simple mode you can select from pre-built conditions. For example, select <strong>Location is X</strong> [search and select location]. With advanced mode you can provide your own scripting and code.</td>
</tr>
<tr>
<td>Work item routing condition</td>
<td>Configure and specify who will provide customer support at a walk-up location. Location is determined by physical address.</td>
</tr>
<tr>
<td>Active</td>
<td>Check to make this queue location active.</td>
</tr>
<tr>
<td>Enable away state</td>
<td>Check to allow an away state.</td>
</tr>
<tr>
<td>Away message</td>
<td>Specify a display message for when the location is temporarily closed. This is for hours other than the scheduled closed times.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stockroom</td>
<td>Select a stockroom to supply assets for the location.</td>
</tr>
<tr>
<td>Location</td>
<td>Select the physical address of your location.</td>
</tr>
<tr>
<td>Location image</td>
<td>Click to add an image of your location. For example, this can be an image of the city or building where the walk-up location is located.</td>
</tr>
<tr>
<td>Access Type</td>
<td>Select external or both types of users so that the appropriate walk-up locations are visible to users.</td>
</tr>
</tbody>
</table>

4. Click the **Management** tab to complete the Management section of the form.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position notification</td>
<td>Select the queue position that triggers a notification to visitors when they are close to being assisted at the location. For example, when a visitor is third in line to be assisted.</td>
</tr>
<tr>
<td>Last check-in</td>
<td>Specify the last available check-in time in minutes. For example, 30 minutes before closing.</td>
</tr>
<tr>
<td>Enable online check-in</td>
<td>Allow visitors to check in to the location remotely from a laptop or mobile phone.</td>
</tr>
<tr>
<td>Enable appointment delegation</td>
<td>Enable users to book an appointment for someone else.</td>
</tr>
<tr>
<td>Fields</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong> When you enable appointment delegation, the <strong>Appointment delegation group</strong> field appears. Select a group to allow appointment delegation. Add a new group of users if an appropriate group does not exist. Only users in this group will have the choice of scheduling for themselves or another user when they book an appointment.</td>
<td></td>
</tr>
<tr>
<td>Name configuration</td>
<td>Select a name configuration to display visitor information on the onsite queue TV monitor and online check-in screen. The first name will always display. However, you can show first and last name, first name with last name initial only, or first name only.</td>
</tr>
<tr>
<td>Appointment routing time</td>
<td>Specify the amount of time, in minutes, to route the work item to an agent prior to an appointment time.</td>
</tr>
<tr>
<td>Hold time</td>
<td>Enter an amount of time, in minutes, that you want to put an interaction on hold before attempting to route it again to a technician. For example, entering 5 will put the interaction on hold for 5 minutes before rerouting.</td>
</tr>
<tr>
<td>Show estimated wait time</td>
<td>Enable the estimated wait time to show for walk-up queues.</td>
</tr>
<tr>
<td>Fields</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The wait time is calculated from the average wait time of the queue and how many users are currently in the queue. All estimated wait times are rounded to the nearest whole minute.</td>
</tr>
<tr>
<td></td>
<td>The estimated wait time calculation requires the use of Service Owner Workspace to calculate the average wait time. Service Owner Workspace uses the Advanced Work Assignment queueing system to obtain the average wait time.</td>
</tr>
<tr>
<td></td>
<td>Estimated wait times display in the following places:</td>
</tr>
<tr>
<td></td>
<td>• Online check-in.</td>
</tr>
<tr>
<td></td>
<td>• Onsite check-in and onsite queue screen (TV).</td>
</tr>
<tr>
<td></td>
<td>• <strong>Status</strong> widget on the Service Portal</td>
</tr>
</tbody>
</table>

**Audio Playback**

Specify when the audio confirmation will play, for example, when a requester checks into an onsite queue, when a requester checks in online, or both. The default mode is **None**.

**Audio File**

Specify an audio file to play when a requester checks into a queue. The base-system default file is walkup_checkin.mp3.

**Note:** Only mp3 file formats are supported across all browsers.

You may need to provide additional browser permissions to use an audio file on the Safari browser.
5. Click the **Administration** tab to complete the administration section of the form.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Queue time display</td>
<td>Chose from <strong>None</strong>, <strong>Check-in time</strong>, or <strong>Time waited</strong> to be displayed on the location wall monitor.</td>
</tr>
<tr>
<td>Queue message</td>
<td>Specify a welcome message for your location wall monitor.</td>
</tr>
<tr>
<td>Check-in greeting</td>
<td>Create a check-in message to guide visitors to sign into the queue at the designated check-in monitor.</td>
</tr>
<tr>
<td>Closed message</td>
<td>Create a message to alert visitors that it is outside the hours of operation and the location is closed.</td>
</tr>
<tr>
<td>Closed phone number</td>
<td>Select your country from the drop-down menu to display the Customer Support phone number.</td>
</tr>
<tr>
<td>Closed record producer</td>
<td>Search for and select a record producer to display and link to during closed hours, such as <strong>Create incident</strong>.</td>
</tr>
<tr>
<td>Closed image</td>
<td>Click to add an image indicating the walk-up location is closed. The image displays on the wall monitor to alert walk-in visitors that the location is closed.</td>
</tr>
<tr>
<td>Max search results</td>
<td>Specify how many search results to provide for contextual searches.</td>
</tr>
<tr>
<td>Contextual search config</td>
<td>Configure which search context will provide results at the location.</td>
</tr>
<tr>
<td>Enable unregistered user entry</td>
<td>Check to allow users who do not have a user name in the system to check in to the location for support. For example, guests visiting the location (opposed to employees).</td>
</tr>
<tr>
<td>Enable lookup user entry</td>
<td>Check so that when users begin typing their names they can quickly see and select their names from a list.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Enable technician info</td>
<td>Check to allow the display of available technician names on the location wall monitor.</td>
</tr>
<tr>
<td>Enable technician avatar</td>
<td>Check to allow the display of technician avatars on the location wall monitor.</td>
</tr>
<tr>
<td>Header logo</td>
<td>Click to add a header logo. The header logo is location specific. If no logo is specified, by default, the Walk-up Portal logo is used.</td>
</tr>
<tr>
<td>Queue logo</td>
<td>Click to add a logo for the designated walk-up location wall monitor. Design this logo to work correctly with a black background. If no logo is specified for the queue, by default, the Header logo is used. If no Header logo is specified, the Walk-up Portal logo is used.</td>
</tr>
</tbody>
</table>

6. Right-click in the form header and select **Save**. Several tabs appear.
   - **Interactions**
   - **Walk-up Appointments**
   - **Reasons for Visit**
   - **Assignment Eligibility**
   - **Work Item Sort Order**

7. Click the **Interactions** tab to view interactions or configure how the walk-up Interactions list should display. You can use the filter icon (🔍) and the personalize list icon (⚙️) to modify.

8. Click the **Walk-up Appointments** tab to view appointments or configure how the Walk-up Appointments list should display. You can use the filter icon (🔍) and the personalize list icon (⚙️) to modify.

9. Click the **Reasons for Visit** tab to view, modify, or create a reason for visit option.
   The base system includes three active reasons:
   - I need something
   - Something is not working
- Laptop refresh
- Other

10. Click the Assignment Eligibility tab to view, modify, or create an assignment rule for your walk-up queue locations. Assignment rules are configured in the Advanced Work Assignment product.

11. Click the Work Item Sort Order tab to view, modify, or create an Work Item Sort Orders for your walk-up queue locations.

12. Click Update to save the new or modified location queue.

Configure Walk-up Experience locations for guest users
Configure walk-up locations for guest-users so they can select a location while making appointments.

Before you begin
Role required: admin

Procedure
1. Navigate to CSM Walk-up Experience > Administration > Appointment Configurations.
2. Select a location that the guest user needs access to.
3. Click the Preview this record icon ( располагаете ) next to the Catalog item field.
4. In the Record Producer window, click Open Record.
5. Under Related Links, click the Available For tab.
6. Click Edit.
7. Move Any Guest User from the Collection list to the Available For list and click Save.
8. Under Related Links, click the Variable Sets tab.
9. Select sn_appointment_variable_set and set permissions for each of its variables.
   a. In the notice at the top of the form about the current application, click here to access the CSM Walkup Experience application record.
   b. Select the sn_appointment variable.
   c. Click the Permission tab.
   d. For the Read roles and Write roles, move the public, snc_internal, and snc_external roles from the Available list to the Selected list.
e. Click Done.
f. Repeat these actions for the **sn_appointment_macro** variable.

10. Repeat step 9 to set permissions for the **sn_walkup_variable_set** variable set.

Results
The configured walk-up locations are now available for guest users.

**Remove a Walk-up Experience location**
If you permanently close down a physical Walk-up Experience location, you can also remove the location from the Walk-up Location Queues table.

**Before you begin**
Role required: admin or sn_csm_walkup.walkup_admin

**Procedure**
1. Navigate to **CSM Walk-up Experience > Administration > Walk-up Locations**.
2. Click the name of the walk-up location you want to remove to open the location queue record.
3. Click Delete in the form header.
   A confirmation pop-up appears ensuring you want to delete the record.
4. Click Delete.
   The Walk-up Experience location queue is removed from the application.

**CSM Walk-up Experience customer satisfaction surveys**
With Walk-up Experience surveys, users can rate their satisfaction with walk-up location interactions, providing management with feedback to improve the walk-up experience.

Two base-system predefined Walk-up Experiences surveys are provided:

- **Walk-up CSAT survey**: Onsite one-click sentiment-analysis survey where the user can quickly rate service based on a 1 - 3 scale, where 1 is a negative experience and 3 is a positive experience. The survey uses an image scale of three faces with different sentiments (sad, neutral, and smiling).
• **Walk-up Experience Satisfaction Survey**: A survey link is sent via email when walk-up interactions are closed. It uses sentiment analysis for the overall experience, wait-time experience, technician experience, technician professionalism, and additional comments. This survey is based on a 1 - 5 numeric rating scale, where 1 is very unsatisfied and 5 is very satisfied.

Walk-up administrators and managers can modify these surveys and the associated trigger conditions. Managers and administrators can review responses by question and see a scorecard for each survey on the *Walk-up Experience Dashboard* module. User comments provide feedback that is used to improve the performance of walk-up interactions.

For more detailed information about working with surveys, sentiment analysis, trigger conditions, and survey questions, see [Survey Management](#).

**Configure Walk-up Experience survey**

Define surveys so that requesters can provide feedback on their satisfaction with the service quality received at a location.

**Before you begin**

Role required: admin or sn_csm_walkup.walkup_admin

**About this task**

Creating a new customer satisfaction survey requires that you first define a new survey and then use the Survey Designer to design, configure, and make it available to users.

**Procedure**

1. To view and use a base-system predefined survey in the Walk-up Experience application, navigate to **CSM Walk-up Experience > Administration > Surveys**. The Assessment Metric Types list opens displaying the available walk-up surveys.
2. To modify an existing walk-up survey, click the survey name, otherwise navigate to **Survey > View Surveys** and click **New** to define a new survey if none of the base-system surveys are optimal for your walk-up location. The Survey Definition New record form opens.

3. To modify or complete the form, refer to **modify a survey definition**.

**System properties for configuring Walk-up Experience for guest users**

System properties enable you to configure the Walk-up Experience for guest users so they can access the Walk-up Check-in widget from the Service Portal Home Page and schedule appointments online.

**Properties to configure Walk-up Experience application**

As an admin, in your instance, enter `sys_properties.list` in the filter navigator and add the following properties. The default values are listed.

<table>
<thead>
<tr>
<th>Property</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_guest_walkup_cs.guest_user_walkup_enabled</td>
<td>true</td>
<td>Enables or disables Walk-up Experience for guest user.</td>
</tr>
<tr>
<td>sn_guest_walkup_cs.captcha.enabled</td>
<td>true</td>
<td>Enables or disables the CAPTCHA validation from the welcome page.</td>
</tr>
<tr>
<td>sn_guest_walkup_cs.max_confirmation_validity_in_minutes</td>
<td>15 mins</td>
<td>The time to confirm the appointment booking.</td>
</tr>
<tr>
<td>sn_guest_walkup_cs.max_otp_validity_in_minutes</td>
<td>5 mins</td>
<td>The time that the one-time password the user receives to modify or cancel the appointment is valid.</td>
</tr>
<tr>
<td>sn_guest_walkup_cs.max_guest_appointments_per_location</td>
<td>0</td>
<td>The number of appointments the guest user can book per location.</td>
</tr>
<tr>
<td>sn_guest_walkup_cs.captcha.timeout</td>
<td>10 mins</td>
<td>The time after which the CAPTCHA validation on the welcome page times out.</td>
</tr>
</tbody>
</table>

**Add a Walk-up Experience online check-in link on the Service Portal home page**

Configure a Walk-up Experience link to enable guest users to check in online to a walk-up location via Service Portal.
Before you begin
Service Portal for Enterprise Service Management (com.glide.service-portal.esm) must be activated.
Role required: admin and sp_admin

Procedure
1. In your instance, enter `sp_page.list` in the filter navigator.
2. Select ID from the Search drop-down list and enter `csm_index` in the Search field.
3. Click `csm_index`.
4. Scroll down and click the Open in Designer related link.
5. Drag the walk-up check-in link from the Widgets list in the left pane and drop it on the Service Portal home page where you want the link to appear.

Related reference
- System properties for configuring Walk-up Experience for guest users

Configure Auto-Responder notifications
Configure the Auto-Responder feature for sharing relevant content in email notifications for deflecting cases.

Before you begin
Activate the Predictive Intelligence for Customer Service Management plugin (com.snc.csm_ml). For more information, see Activate a plugin and Predictive Intelligence for CSM solution definitions.
Role required: admin

About this task
When you install and activate the Predictive Intelligence for Customer Service Management plugin (com.snc.csm_ml), the following related plugins are also activated:

- Customer Service plugin (com.sn_customerservice)
- Predictive Intelligence for Contextual Search plugin (com.snc.contextual_search_ml)
- Email Notification Script for Contextual Search Results plugin (com.snc.adv_cxs_results_email_script)
You can also configure the Auto-Responder feature for tasks other than customer service cases. For more information, see [Configure Auto-Responder for tasks other than cases](#).

**Procedure**

1. **Enable Auto-Responder.**
2. **Train the similarity solution for finding Auto-Responder notification content.**
3. **Optional:** Configure the search context for Auto-Responder.
4. **Optional:** Limit the number of articles in Auto-Responder notifications for cases.
5. **Optional:** Include advanced contextual search results in Auto-Responder notifications.

   **Note:** By default, any knowledge articles viewed in the last 30 days by the user are not included in the email notification. You can use the `getViewedContent` extension point to modify the filter out by the duration of the last viewed content.

6. **Optional:** Enable text search recommendations in Auto-Responder notifications.
7. **Optional:** Include cases logged using specified communication channels in Auto-Responder notifications.
8. **Optional:** Include knowledge articles from custom portals in Auto-Responder notifications.

   **Note:** When you configure the Auto-Responder feature to use a custom portal, the default configuration for the customer service portal and consumer service portal are not used. Ensure that you use this configuration when you have your own custom portal and don’t want to use the customer service portal or consumer service portal.

**Related information**

- [Using Auto-Responder for case deflections](#)

**Enable Auto-Responder**

Enable the Auto-Responder feature to include content suggested for deflecting cases in email notifications.
Before you begin
Activate the Predictive Intelligence for Customer Service Management plugin (com.snc.csm_ml). For more information, see Activate a plugin and Predictive Intelligence for CSM solution definitions.

Role required: admin

Procedure
1. Navigate to Customer Service > Administration > Properties.
2. In the Auto-Responder Recommendations section, select the check box for the Enable auto-responder recommendations property (sn_customerservice.case.autoresponder.enable).
3. Click Save.

Train the similarity solution for finding Auto-Responder notification content
Update and train a similarity solution definition to enable the Auto-Responder feature to suggest content by comparing the short description of a customer service case with those of existing knowledge articles.

Before you begin
Activate the Predictive Intelligence for Customer Service Management plugin (com.snc.csm_ml). For more information, see Activate a plugin and Predictive Intelligence for CSM solution definitions.

Role required: admin

About this task
A similarity solution definition collects and compares your existing records to new similar records. The Similar Knowledge Articles All similarity solution selects knowledge articles for customer service cases from the predefined knowledge bases in the consumer service portal and customer service portal. To select knowledge articles from any custom knowledge base in a portal or from a knowledge base in any custom portal, you must modify this similarity solution. For a similarity solution to work correctly, the Knowledge [kb_knowledge] table in the Knowledge View [sn_customerservice_knowledge_view] database view must have at least the required number of records set in the configuration of your ServiceNow instance. The default minimum number required is 10,000.

If the Knowledge Management Advanced plugin (com.snc.knowledge_advanced) is activated, the tables for knowledge article templates (such as FAQ, How to, What Is, KCS Article) are also added to the Knowledge View [sn_customerservice_knowledge_view] database view. For a similarity solution to show results from each template type, each of the tables for the template type must have at least the required number of records. If a
table doesn't have the required number of records, you might not see the results from that table. For more information, see Database View support for Predictive Intelligence.

**Procedure**

1. Navigate to **Predictive Intelligence > Similarity > Solution Definitions**.
2. In the Similarity Definitions list, search for and select the Similar Knowledge Articles All solution definition (ml_sn_sn_customerservice_global_similar_knowledge_view_articles).
3. On the Similarity Definition form, verify the default field values for knowledge articles.

   **Note:** If the application scope isn't set to Customer Service application, you cannot edit the form and a warning message appears. To make the form editable, click the word **here** at the end of the message.

**Similarity Definition form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Unique name for your similarity solution.</td>
</tr>
<tr>
<td>Word Corpus</td>
<td>Defines which knowledge articles and cases are selected. By default, the All Articles and Cases word corpus is available to search for knowledge articles similar to a customer service case short description.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Modify the word corpus to use the knowledge base defined for your portal. If you have defined custom tables for knowledge articles and article templates, you must include their fields in the word corpus content. For more information about the word corpus and word corpus content, see Create a word corpus.</td>
</tr>
<tr>
<td>Table</td>
<td>Table or database view that contains the knowledge article records. Set the value to the Knowledge View [sn_customerservice_knowledge_view] database view unless you use a different table or database view for storing knowledge articles. This database view joins the Knowledge [kb_knowledge], What Is [kb_template_what_is], How To [kb_template_how_to], FAQ [kb_template_faq], and KCS Article [kb_template_kcs] tables for viewing all fields in a knowledge article.</td>
</tr>
<tr>
<td><strong>Field</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>----------</td>
<td>----------------</td>
</tr>
<tr>
<td>Field</td>
<td>After you assign a table value, the number of records that match the filter conditions is displayed as a link.</td>
</tr>
</tbody>
</table>

**Note:** The What Is [kb_template_what_is], How To [kb_template_how_to], FAQ [kb_template_faq], and KCS Article [kb_template_kcs] tables are available only if the Knowledge Management Advanced plugin is activated. For more information, see Activate the Knowledge Management Advanced plugin.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Fields from the Knowledge View [sn_customerservice_knowledge_view] database view selected for similarity comparison with the case short description. The fields must be the same as the fields you define for the Word corpus content.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter</td>
<td>Filter conditions applied on the database view to filter knowledge article records for Auto-Responder recommendations. Click <strong>Add Filter Condition</strong> to apply conditions to the Field records you're using as a base to retrieve your similarity results. For example, for the customer service portal, you would set a [Workflow] [is] [Published] AND [Knowledge base] is [Customer Service] filter condition. For a custom portal, you select the knowledge base of the custom portal in the [Knowledge base] condition.</td>
</tr>
<tr>
<td>Test Table</td>
<td>Table that contains the case records that you want to compare with knowledge article records. Set the value to the Case [sn_customerservice_case] table unless you use a different table for storing case records.</td>
</tr>
<tr>
<td>Test Fields</td>
<td>Fields from the case selected for similarity matching with knowledge article fields. By default, the short description field of a customer service case is used for the similarity match with knowledge article fields.</td>
</tr>
<tr>
<td>Processing Language</td>
<td>Dominant language of the dataset you're training on the solution definition. By default, English processing is applied to all datasets. For example, if you select Italian, the system processes the data in both English and Italian.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Note:</td>
<td>The term &quot;processing&quot; indicates some of the language-specific steps used as part of training a solution. These steps might include tokenizing words, removing stop words, and stemming.</td>
</tr>
<tr>
<td>Stopwords</td>
<td>Common terms in the processing language that are excluded from the search, for example, prepositions. When you select your processing language, the system automatically adds a Stopwords list that uses the same language. For example, if your processing language is Italian, the Default Italian Stopwords list appears. The Default English Stopwords list appears by default.</td>
</tr>
<tr>
<td>Training Frequency</td>
<td>Frequency with which the model for the similarity solution definition must be retrained.</td>
</tr>
<tr>
<td>Update Frequency</td>
<td>Frequency with which to include new records in the model for the similarity solution definition.</td>
</tr>
</tbody>
</table>

For more information, see Create and train a similarity solution.

4. **Optional:** In the Training Request Schedule related list, update the schedule for training the Similar Knowledge Articles All solution definition. By default, the training request schedule is *Periodically* and runs after every 30 days.

5. Click **Update & Retrain**.

6. Open the Similar Knowledge Articles All solution definition (ml_sn_sn_customerservice_global_similar_knowledge_view_articles) and in the ML Solutions related list, view the training solution progress in the **Progress** column.

   When **Progress** is 100%, in the ML Solutions related list, you can include more useful content in the Auto-Responder notification by reviewing the similarity examples based on the similarity score and updating the similarity score threshold value.

7. **Optional:** Update the similarity score threshold.

   a. In the **Active** column, click the link for the solution.

   b. Review the similarity examples by clicking the **Similarity Examples** related link on the ML Solution form.

   For more information, see Review solution similarity examples.
c. In the Solution Statistics related list on the ML Solution form, enter the required value in the **Similarity Score Threshold** field, right-click the ML Solution form, and then click **Save**.
For more information, see **Update your similarity score threshold**.

**Results**
When the solution is complete, the knowledge articles similar to the fields selected for a customer service case are sent as Auto-Responder recommendations.

**Related information**
- Knowledge article templates

**Configuring the search context for Auto-Responder**
You can configure the predefined search context for customer service cases to include relevant search resources in Auto-Responder email notifications.

The Predictive Intelligence for Customer Service Management plugin (com.snc.csm_ml) includes the predefined **Case Email Autoresponder KB search** search context for customer service cases configured for use in the Auto-Responder feature. This search context uses the predefined Search Knowledge Articles searcher that provides knowledge articles as search results.

By default, the **Case Email Autoresponder KB search** search context includes contextual search results based on Predictive Intelligence. You can edit this search context to include any additional resources. For more information, see **Define a search context**.

ℹ️ **Note:** To provide other relevant recommendations to resolve a customer service case when Predictive Intelligence results are insufficient or unavailable, you can also enable the text search recommendations in the Auto-Responder email notification. For more information, see **Enable text search recommendations in Auto-Responder notifications**.

**Limit the number of articles in Auto-Responder notifications for cases**
Send the most relevant knowledge articles in Auto-Responder notifications for customer service cases by limiting the number of knowledge articles that are included.
Before you begin

• Activate the Predictive Intelligence for Customer Service Management plugin (com.snc.csm_ml). For more information, see Activate a plugin and Predictive Intelligence for CSM solution definitions.

• Set the application scope to Customer Service using the application picker. For more information, see Application picker.

Role required: admin

Procedure

1. Navigate to **Contextual Search > Table Configuration**.

2. Search for **Case [sn_customerservice_case]**.

3. Click the **Case [sn_customerservice_case]** link in the **Name** column corresponding to the row containing the **Case Email Autoresponder KB Search** search context.

4. In the Email Configurations related list, double-click the value in the **Limit** column for the **Case auto-responder recommendations** row.

5. Enter the maximum number of knowledge articles you want to include in the Auto-Responder email notifications for customer service cases and click the save icon (✔).

   The maximum allowed limit value is 20. If you enter a limit value of more than 20, the Auto-Responder email notification includes up to 20 articles only.

6. On the Table Configuration form, click **Update**.

Include advanced contextual search results in Auto-Responder notifications

Use scripted extension points to include the advanced contextual search results in email notifications for content suggested by the Auto-Responder feature.

Before you begin

• Activate the Predictive Intelligence for Customer Service Management plugin (com.snc.csm_ml). For more information, see Activate a plugin and Predictive Intelligence for CSM solution definitions.

• Set the application scope to Email Notification Script for Contextual Search Results. For more information, see Application picker.

Role required: admin
About this task
The Email Notification Script for Contextual Search Results plugin (com.snc.adv_cxs_results_email_script) installs the csm_AdvancedEmailSearchResults script, CSMAdvancedEmailSearchResults script include and CSMAdvancedEmailSearchResultsExtensionPoint extension points.

The csm_AdvancedEmailSearchResults Script is preconfigured for the customer service portal and consumer service portal.

Using extension points makes it easier to integrate customizations without actually altering the base code. You can extend standard base functionality using customized scripts. For more information, see Using extension points to extend application functionality.

An implementation is available in the base system for scripted extension points. You can modify the data and add additional fields.

Procedure
1. Navigate to System Extension Points > Scripted Extension Points.
2. In the API Name column, search for and click sn_adv_emailscript.CSMAdvancedEmailSearchResultsExtensionPoint.
3. On the Extension Point form, select a script include to use the CSMAdvancedEmailSearchResultsExtensionPoint extension points.
   - Modify the existing script by going to the Implementations related list and clicking CaseAutoresponder.
   - Create and register a custom script include.
     For more information, see Register a custom script include.
4. Modify the script to use the extension points available through the CSMAdvancedEmailSearchResults script include.
   You can create multiple implementations for each extension point and provide an order number for each implementation. The implementation that has the lowest order number is executed first.

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Implementation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include a custom portal and search for knowledge articles from the knowledge base associated with the custom portal.</td>
<td>Modify the updateSearchRequestConfig extension point to include the custom portal for your tasks other than customer service cases.</td>
</tr>
<tr>
<td>Configuration</td>
<td>Implementation</td>
</tr>
<tr>
<td>---------------</td>
<td>----------------</td>
</tr>
<tr>
<td>🔄 <strong>Note:</strong> Applies only to tasks other than customer service cases.</td>
<td></td>
</tr>
<tr>
<td>Filter out the content by the duration of the last viewed content.</td>
<td>Modify the <code>getViewedContent</code> extension point by entering the last viewed content duration in days.</td>
</tr>
<tr>
<td>🔄 <strong>Note:</strong> By default, any knowledge articles viewed in the last 30 days by the user are not included in the email notification.</td>
<td></td>
</tr>
<tr>
<td>Define the layout of the email notifications.</td>
<td>Modify the <code>printSearchResults</code> extension point to specify a custom layout for the Auto-Responder email notifications.</td>
</tr>
</tbody>
</table>

5. On the Extension Point form, click **Update**.

**Enable text search recommendations in Auto-Responder notifications**

Configure the Auto-Responder feature to send recommendations that match a text search of a case short description to resolve a customer service case when Predictive Intelligence results are insufficient or unavailable.

**Before you begin**

- Activate the Predictive Intelligence for Customer Service Management plugin (com.snc.csm_ml). For more information, see [Activate a plugin and Predictive Intelligence for CSM solution definitions](#).
- Set the application scope to Email Notification Script for Contextual Search Results using the application picker. For more information, see [Application picker](#).

Role required: admin

**About this task**

By default, the Auto-Responder feature is configured to send contextual search results based on Predictive Intelligence. Knowledge articles that have significant text similarity with the short description of a case are sent as Auto-Responder recommendations.

You can configure the Auto-Responder feature to send knowledge article recommendations that match a text search of the case short description when
the recommendations sent through the Predictive Intelligence feature aren’t sufficient or the feature is disabled.

Procedure
1. In the navigation filter, enter `sys_properties.list`.
2. Search for the `sn_adv_emailscript.textsearch.enable` property.
3. In the Value field, enter `true`.
4. Click Update.

Include cases logged using specified communication channels in Auto-Responder notifications
Send Auto-Responder email notifications for customer service cases logged using a communication channel.

Before you begin
- Activate the Predictive Intelligence for Customer Service Management plugin (com.snc.csm_ml). For more information, see Activate a plugin and Predictive Intelligence for CSM solution definitions.
- Set the application scope to Customer Service using the application picker. For more information, see Application picker.
- Ensure that the required channel is already set up for use. For more information, see Configure communication channels.

Role required: admin

About this task
By default, the Case auto-responder recommendations notification is configured to send Auto-Responder email notifications for customer service cases logged using emails. You can configure it to include other communication channels such as web, phone, chat, social, community, alert, and virtual agent.

Procedure
1. Navigate to System Notification > Notifications.
2. Search for Case auto-responder recommendations.
3. In the Name column, click the Case auto-responder recommendations link.
4. In the Conditions field, click Add Filter Condition or Add "Or" Clause to set the filter condition for a communication channel.
Note: The default filter condition is `[Channel] [is] [Email] AND [Active] [is] [true].

For example, to send Auto-Responder notifications for customer service cases logged using a mobile phone in addition to email, you would click Add Filter Condition and create the condition `[Channel] [is] [Phone] AND [Active] [is] [true].

Include knowledge articles from custom portals in Auto-Responder notifications

Configure the Auto-Responder feature to suggest knowledge articles from a custom portal.

Before you begin

Activate the Predictive Intelligence for Customer Service Management plugin (com.snc.csm_ml). For more information, see Activate a plugin and Predictive Intelligence for CSM solution definitions.

Role required: admin

About this task

By default, the Auto-Responder feature is configured to suggest knowledge articles from customer service portal and consumer service portal. Use this procedure only when you have your own custom portal and don’t want to use the default customer service portal or consumer service portal.

Procedure

1. Navigate to Customer Service > Administration > Properties.
2. In the text box for the Custom portal URL containing the knowledge article parameter property (`sn_customerservice.case.autoresponder.customportal`), enter your custom portal URL containing a knowledge article parameter such as `sys_kb_id` or `kb_number`. Example format: `https://<instance-name>.service-now.com/csm?id=kb_article_view&sys_kb_id=<sys_kb_id>`
3. Click Save.

What to do next

After you configure the `sn_customerservice.case.autoresponder.customportal` property, you must configure the Similar Knowledge Articles All similarity solution definition to use the knowledge base of the custom portal. For more information, see Train the similarity solution for finding Auto-Responder notification content.
Configure Auto-Responder for tasks other than cases

Configure the Auto-Responder feature to send helpful resources for tasks other than customer service cases.

Before you begin

- Activate the Email Notification Script for Contextual Search Results plugin (com.snc.adv_cxs_results_email_script). For more information, see Activate a plugin.
- Set the application scope to the scope of your task table using the application picker. For more information, see Application picker.
- Ensure that you have defined a search context for your task to include recommended resources in the Auto-Responder email notifications. For more information, see Define a search context.
- Ensure that you have configured a table for the search context associated with your task. For more information, see Configure table for a contextual search.

Role required: admin

Procedure

1. Configure the Notification [sysevent_email_action] table for your task to use the csm_AdvancedEmailSearchResults script.

   a. Navigate to System Notification > Notifications.

   b. Select the Notification [sysevent_email_action] table for your task.

   c. In the What will it contain related list, enter

      \$\{mail_script:csm_AdvancedEmailSearchResults\} in the Message HTML field.

   d. Optional: Ensure that notifications are not sent if there are no search results by entering the hasResults() function in the Advanced condition field of the When to send related list. The hasResults() function checks whether search results exist. You can use the return value of the function to prevent the system from sending an email notification if there are no search results. For more information, see Advanced conditions for email notifications.
Tip: Refer to the Case auto-responder recommendations notification that uses the `hasResults()` function for returning the search results value. To view a notification, navigate to System Notification > Notifications.

e. Click Update.

2. Map your task table configuration with the email notification for your task.

a. Navigate to Contextual Search > Table Configuration.

b. Click the task table configuration link in the Name column corresponding to the row containing the search context for your task.

c. In the Email Configurations related list, link your task table configuration with the Notification [sysevent_email_action] table.
   - To create another email configuration for a user field, click New.
   - To edit an existing email configuration, click the preview email configuration for email notification icon (预备), and then in the Email Configuration window, click Open Record.

d. On the Email Configuration form, verify the default field values for your task, or fill in the values for a custom configuration.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email notification</td>
<td>Select the email notification for your task.</td>
</tr>
<tr>
<td>User field</td>
<td>Reference field that helps narrow down the search results sent as recommended resources in Auto-Responder email notifications. For example, if you select Caller for the Incident [incident] table, the resources associated only with callers are added to the Auto-Responder email notifications.</td>
</tr>
<tr>
<td>Limit</td>
<td>Maximum number of resources you want to include in the Auto-Responder email notifications for your task. The maximum allowed limit value is 20. If you enter a value more than 20, the Auto-Responder email notification includes up to 20 resources only.</td>
</tr>
</tbody>
</table>
e. Update or submit the Email Configuration form.
   • For a new configuration, click **Submit**.
   • For an existing configuration, click **Update**.

3. **Optional:** Enable contextual search results based on text searches in addition to search results based on Predictive Intelligence to be included in Auto-Responder notifications.
   For more information, see Enable text search recommendations in Auto-Responder notifications.

4. **Optional:** Configure a custom portal and include advanced contextual search results in email notifications.
   For more information, see Include advanced contextual search results in Auto-Responder notifications.

**Configure Customer Service Analytics and Reporting Solutions**

Enable Customer Service Performance Analytics Analytics and Reporting Solutions to view preconfigured dashboards with actionable data visualizations to improve your business processes.

**Before you begin**
Role required: admin

**Procedure**

1. Navigate to **Performance Analytics > Guided Setup**.
2. On the Getting Started page of the guided setup, click **Get Started**.
3. In the Customer Service category, view the list of tasks to configure the feature.

**Performance Analytics for z configuration tasks**

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate Performance Analytics for Customer Service Management</td>
<td>Activate the Performance Analytics - Content Pack - Customer Service (com.snc.pa.customer_service) plugin to add Performance Analytics configuration records to your instance.</td>
</tr>
<tr>
<td>Review Indicator Sources</td>
<td>Review the provided indicator sources to ensure they match your</td>
</tr>
<tr>
<td>Task</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Customer Service application table structure.</td>
<td>Review Indicators Review the provided indicators to ensure that the metrics you want to measure are tracked.</td>
</tr>
<tr>
<td>Review Breakdown Sources</td>
<td>Review the provided breakdown sources to ensure they match your table structure and include the elements you want.</td>
</tr>
<tr>
<td>Review Breakdowns</td>
<td>Review breakdowns to ensure that you can filter scores by the appropriate elements.</td>
</tr>
<tr>
<td>Collect Data</td>
<td>Run historical data collection once to collect scores on existing data, and enable scheduled data collection to begin collecting scores on new data automatically.</td>
</tr>
<tr>
<td>View Analytics Hub</td>
<td>View the Analytics Hub for indicators that you collected data for to begin exploring your scores.</td>
</tr>
<tr>
<td>View Dashboards</td>
<td>View the provided dashboards to get an overview of your scores and view multiple metrics in a single location.</td>
</tr>
</tbody>
</table>

4. To perform a task, click **Configure**. This button opens the page in your instance where the configuration is completed.

**Configure the Performance Analytics components for the Outsourced Customer Service dashboard**

Run diagnostics, review and customize components, and start collecting data.

**Before you begin**

A Now Platform administrator must have installed the content pack plugins or ServiceNow Store application for this Analytics and Reporting Solution.

Role required: pa_admin
Procedure

1. Run all diagnostics on all records, as described in Performance Analytics diagnostics. These diagnostics can catch many mismatches between the configuration of your Analytics and Reporting Solutions and your tables.

2. Navigate to Performance Analytics > Administration Console.

3. Click the Dashboards link in the Explore and Manage tile.

4. Verify the names of the dashboards that have been installed with this Analytics and Reporting Solution.

5. Open the Indicator Sources tab.

6. For each dashboard included in this Analytics and Reporting Solution:
   a. Filter the indicator sources on the dashboard name.

Example

This screenshot shows the indicator sources filtered on the Outsourced Service Provider dashboard from the Self-Service Analytics for CSM Analytics and Reporting Solution.

b. Review the facts table, conditions, and frequency of the indicator sources compared to the data structure on your own instance.

c. If necessary, open an indicator source and make corrections.
d. If you are editing an indicator source record, go to the Indicators related list and review the **Conditions** field for each indicator. Changing the indicator source can also affect the additional conditions on the individual indicators.

7. If you changed the time field stamps in any indicator sources, also change any related Performance Analytics scripts. For more information, see **Update Performance Analytics scripts**.

8. Open the Breakdown Sources tab.

9. For each dashboard included in this Analytics and Reporting Solution:
   
   a. Filter the breakdown sources on the dashboard name.
   
   b. Review the conditions on the breakdown source as described in **Review the breakdown sources**.

10. Navigate to **Performance Analytics > Jobs**.

11. Set up and run the historical job for this Analytics and Reporting Solution, `<name of historical job>`. Follow the procedure in **Run historical data collection for an Analytics and Reporting Solution**.

12. Edit and activate the scheduled data collection job for this Analytics and Reporting Solution, `<name of scheduled job>` Follow the procedure in **Schedule data collection for an Analytics and Reporting Solution**.

### Related information

**Using Outsourced Customer Service**

**Outsourced Customer Service dashboard**

The Outsourced Customer Service dashboard lets you see the number of SLAs breached, unassigned open and resolved cases, average resolution time taken to resolve cases and so on. Use the information on this dashboard to spot problem areas and plan your case management strategy going forward. You can select and view the dashboard by choosing the OSP name.
Dashboard of all Outsourced Service Providers

<table>
<thead>
<tr>
<th>% of Open SLAs Breached</th>
<th>Average Resolution Time</th>
<th>Average CSAT</th>
<th>% of Transferred Cases</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apr 2020 19%</td>
<td>Apr 2020 1 days</td>
<td>Apr 2020 4</td>
<td>Apr 2020 241%</td>
</tr>
</tbody>
</table>

Resolved Cases

<table>
<thead>
<tr>
<th>Apr 2020 42</th>
<th>% of Unassigned Open Cases</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apr 2020 27%</td>
<td></td>
</tr>
</tbody>
</table>

Outsourced cases: Unassigned open cases

Number of open cases that are unassigned to the OSP agents.

Outsourced cases: open cases with breached SLAs

Number of cases that have remained open past the time required by the Service Level Agreement (SLA).

End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>External OSP Manager</td>
<td>sn_csm_ocs.ext_manager</td>
</tr>
<tr>
<td>Internal OSP Manager</td>
<td>sn_csm_ocs.manager</td>
</tr>
</tbody>
</table>
Outsource cases: open cases
Number of cases that are in open state.

Outsourced cases: Average overall CSAT
Average customer satisfaction based on survey results. For more information about CSAT, see Customer service satisfaction surveys.

Outsourced cases: Number of resolved cases
Number of cases that the OSP agent has worked on and moved to resolved state.

Outsourced cases: Summed duration of resolved cases
The total time taken by the OSP agents to resolve the cases.

Outsourced cases: Number of transferred cases
Number of cases that are transferred to a ServiceNow internal agent when an OSP agent could not resolve the case.

Breakdowns
The Outsourced Service Provider dashboard uses the Case Assignment Group breakdown. Select one or more groups to view data for only those groups. By default, data from all groups is shown on the dashboard.

Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unassigned Open Cases</td>
<td>42</td>
<td>The number of cases that are in open state and is not yet assigned to an OSP agent. In this report, for example, there are 42 cases that are yet to be assigned. The OSP manager views the number of such cases at a glance and assigns them.</td>
</tr>
<tr>
<td>Active SLAs Breached</td>
<td>42</td>
<td>This report shows all breached SLAs that are still active. In this report, for example, there are 42 such active</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>SLAs. The OSP manager views the number of breached SLAs at a glance which helps in taking immediate action.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Configure the Analytics and Reporting Solution for Self-Service Analytics for Customer Service**

Run diagnostics, review and customize components, and start collecting data.

**Before you begin**
A Now Platform administrator must have installed the content pack plugins or ServiceNow Store application for this Analytics and Reporting Solution.

Role required: pa_admin

**Procedure**

1. Run all diagnostics on all records, as described in Performance Analytics diagnostics. These diagnostics can catch mismatches between the configuration of your Analytics and Reporting Solutions and your tables.

2. Navigate to Performance Analytics > Admin Console.

3. Click the Dashboards link in the Explore and Manage tile.

4. Verify the names of the dashboards that have been installed with the Self-Service Analytics Analytics and Reporting Solution.
   - Self-Service Analytics

5. Open the Indicator Sources tab.

6. For each dashboard included in this Analytics and Reporting Solution:
   a. Filter the indicator sources on the dashboard name.

**Example**
This screenshot shows the indicator sources filtered on the Self-Service Analytics dashboard from the Self Service Analytics
b. Review the facts table, conditions, and frequency of the indicator sources compared to the data structure on your own instance.

**Important:** Pay particular attention to time stamp fields such as Resolved or Created that are referenced in the **Conditions** field. You may need to use different time stamp fields.

c. If necessary, open an indicator source and make corrections.

d. If you are editing an indicator source record, go to the Indicators related list and review the **Conditions** field for each indicator. Changing the indicator source can also affect the additional conditions on the individual indicators.

7. If you changed the time field stamps in any indicator sources, also change any related Performance Analytics scripts. For more information, see Update Performance Analytics scripts.

8. Open the Breakdown Sources tab.

9. For each dashboard included in this Analytics and Reporting Solution:
   a. Filter the breakdown sources on the dashboard name.
   b. Review the conditions on the breakdown source as described in Review the breakdown sources.

10. Navigate to **Performance Analytics > Jobs**.
11. Set up and run the historical job for this Analytics and Reporting Solution, [SSA] Self-Service Analytics Data Collection. Follow the procedure in Run historical data collection for an Analytics and Reporting Solution.

12. Edit and activate the scheduled data collection job for this Analytics and Reporting Solution, [SSA] Self-Service Analytics Data Collection. Follow the procedure in Schedule data collection for an Analytics and Reporting Solution.

Related information
- Analytics and Reporting Solutions for Self-Service Analytics for Customer Service
- Self-Service Analytics

Activate the Analytics and Reporting Solution for Self-Service Analytics for Customer Service
Activate the content pack plugins or ServiceNow Store application for the Analytics and Reporting Solution.

Before you begin
Activate the full, subscription version of Performance Analytics on the instance where you are activating this Analytics and Reporting Solution. You can activate Performance Analytics on a sub-production instance without purchasing a subscription. For more information, see Activate your Performance Analytics subscription.

Note: The data for the Communities and Virtual Agent tabs on the Self-Service Analytics dashboard are generated when the Communities plugin (com.sn_communities) and Glide Virtual Agent plugin (com.glide.cs.chatbot) are activated respectively.

Role required: admin

Procedure
1. Navigate to System Definition > Plugins.
3. Install the application.
   When you install this application, you also activate the following plugins:
• Customer Service (com.sn_customerservice)
• Self-Service Analytics PA (com.snc.pa.self_service-analytics)
• Self-Service Analytics Core (com.snc.self-service-analytics_core)

Related information
List of plugins (Paris)

Configure Chat Zoom Connector
Install and set up the Chat Zoom Connector application to interact with customers using Zoom meetings initiated from a chat.

About this task
This task provides general steps to set up the Chat Zoom Connector application for initiating Zoom meetings from a chat.

Procedure
1. Integrate the Zoom account of your company with your ServiceNow instance using the Zoom spoke.
   For more information, see Set up the Zoom spoke.
2. Set up the Notify Zoom connector in Zoom for associating the Notify communication channel with Zoom meetings.
   The conference call details of the Zoom meetings are stored in the Notify Conference Calls [notify_conference_call] table. For more information, see Set up Notify Zoom connector.
3. Install the Chat Zoom Connector application.
   For more information, see Install a ServiceNow Store application.

   Note: The Chat Zoom Connector application installs the CSMZoomInteractionImpl script include, which is preconfigured for the Customer Service application. It also installs the sn_chat_zoom.ZoomInteractionExtPoint extension point, which enables the copying of any application-specific fields from the parent chat interaction record to the Zoom interaction record. For more information, see Configure application-specific field values for Zoom interactions.
4. Activate the Zoom quick action.
   For more information, see Activate the quick action for Zoom meetings.
Related information

Chat Zoom Connector
Using Chat Zoom Connector

Configure application-specific field values for Zoom interactions

Use scripted extension points to enable the copying of application-specific field values to interaction records for Zoom meetings initiated from chats.

Before you begin
Install the Chat Zoom Connector application. For more information, see Install a ServiceNow Store application.

Role required: admin

About this task
You can enable the copying of any application-specific fields from a parent chat interaction record to its Zoom interaction record by using the sn_chat_zoom.ZoomInteractionExtPoint extension point. The parent chat is the chat from which the Zoom meeting was initiated.

By using extension points, you can easily integrate customizations without having to alter the base code. You can extend standard base functionality using customized scripts. For more information, see Using extension points to extend application functionality.

An implementation is available in the base system for scripted extension points. You can modify the data and add additional fields.

Procedure

1. Navigate to System Extension Points > Scripted Extension Points.
2. In the API Name column, search for and click sn_chat_zoom.ZoomInteractionExtPoint.
3. On the Extension Point form, select a script include to use the sn_chat_zoom.ZoomInteractionExtPoint extension point.
   • Create and register a custom script include.
     For more information, see Register a custom script include.
• Modify the existing script include by going to the Implementations related list and clicking a script include in the Class column. The script includes are displayed in the Class column.

Note: By default, the ZoomInteractionExtPoint and CSMZoomInteractionImpl script includes that use the sn_chat_zoom.ZoomInteractionExtPoint extension point are available for Global and Chat Zoom Connector applications.

- The ZoomInteractionExtPoint script include for the Global application copies the field values from the parent chat interaction record to the Zoom interaction record.
- If the Customer Service application is installed, the CSMZoomInteractionImpl script include for the Chat Zoom Connector application copies the value of the Consumer, Account, and Contact fields from the interaction record of the parent chat to the Zoom interaction record. The CSMZoomInteractionImpl script include is available only when the Customer Service application is installed.

4. Include application-specific fields by adding the sn_chat_zoom.ZoomInteractionExtPoint extension point in the script include. You can create multiple implementations for an extension point and provide an order number for each implementation. The implementation that has the lowest order number is executed first.

5. On the Extension Point form, click Update.

Activate the quick action for Zoom meetings
Activate the Zoom quick action to initiate Zoom meetings using the quick action from a chat.

Before you begin
Install the Chat Zoom Connector application. For more information, see Install a ServiceNow Store application.

Role required: admin

About this task
By default, the Zoom quick action is inactive. Activate this quick action to enable agents to initiate Zoom meetings from a chat.

Procedure
1. Navigate to Quick Actions > Actions.
2. In the Name column, search for and select Zoom.
3. On the Quick Action form, select the **Active** check box.
4. Click **Update**.

**Results**
By default, the Zoom quick action is associated with chats when the Chat Zoom Connector application is installed. In addition, if the Conversational SMS service channel application is installed, the quick action is also associated with SMS conversations. For more information, see Conversational SMS service channel and Quick actions in Workspace Agent Chat.

**Configure Contributor Users**
The CSM Contributor User plugin enables you to engage middle office teams in resolving customer issues and requests.

**About this task**
With the provided roles, relationships, and user profile attributes, contributors can report and collaborate on cases created for customers, service organizations, or themselves.

**Procedure**
1. Activate the CSM Contributor User plugin (com.snc.csm_contributor_user).
2. Assign the contributor user roles to middle office users.
3. Create relationships.
4. Set up user profile attributes.
5. Ensure CSM Query Rules plugin is active and `sn_cs_queryrules.use_query_rules` property is set to true

**Set up an Advanced Work Assignment service channel for assigning case tasks**
Set up an Advanced Work Assignment (AWA) service channel that you can use to assign case tasks to available users.

**Before you begin**
Role required: admin

You can use the Advanced Work Assignment (AWA) feature to automatically assign work items to users based on their availability and capacity.

AWA assigns work items using assignment groups so it’s important that your users and groups are set up correctly.
• Determine the assignment group to use in the AWA service channel configuration and add users to this group.

• Add the Assignment Group field to the Case Task form view and make the field mandatory.

• Ensure that the users in the assignment group have access to case tasks.

**Note:** By default, CSM uses assignment groups to control visibility to case tasks. Therefore the logic to assign a case task to the correct assignment group is triggered when a case task is created.

**About this task**
Setting up a service channel involves multiple steps, including:

1. Creating the service channel.
2. Creating the inbox card layout.
3. Creating a queue for the service channel.
4. Creating an assignment rule for the queue.
5. Creating a group for the queue.
6. Associating the assignment rule with the queue.
7. Activating the service channel.

These steps are detailed in the following procedure. Once the service channel setup is complete, you can use AWA to assign newly created case tasks that:

• Are unassigned.
• Satisfy the conditions specified in the service channel.
• Have the configured AWA assignment group selected in the Assignment Group field on the Case Task form.

**Procedure**

1. Create the case task service channel.

   a. Navigate to Advanced Work Assignment > Service Channels and click New.

   b. Fill in the fields on the Service Channel form.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the service channel that you are configuring. For example, Case Task.</td>
</tr>
<tr>
<td>Inbox order</td>
<td>Order in which channel items appear in the user inbox.</td>
</tr>
<tr>
<td>Application</td>
<td>Name of the application. For the Case Task channel, select Customer Service.</td>
</tr>
<tr>
<td>Active</td>
<td>Option for activating the service channel. When you select this option, the associated queues for the service channel can start accepting work items.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the service channel.</td>
</tr>
<tr>
<td>Table</td>
<td>Table that stores the service channel records. To route case tasks, select the Task (sn_customerservice_task) table.</td>
</tr>
<tr>
<td>Assign to field</td>
<td>Field that references the user that the item is assigned to. For the Task table, this field is the Assigned to (assigned_to) field.</td>
</tr>
<tr>
<td>Assignment group field</td>
<td>Field that references the assignment group that the item is assigned to. For the Task table, this field is the Assignment group field.</td>
</tr>
<tr>
<td>Advanced condition</td>
<td>If enabled, the advanced conditions that apply to the channel. For case tasks, the parent case is active:</td>
</tr>
<tr>
<td></td>
<td>• [Active] [is] [true]</td>
</tr>
<tr>
<td>Default work item size</td>
<td>Amount of a user’s capacity that is used if this work item is assigned. The default is 1.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Default capacity</td>
<td>Number of items automatically assigned to agents (pending overrides). The default for this field depends on the type of work item.</td>
</tr>
<tr>
<td>Utilization condition</td>
<td>Condition that determines what constitutes an active item that counts toward user workload/capacity. For case tasks:</td>
</tr>
<tr>
<td></td>
<td>• [State] [is not] [Closed]</td>
</tr>
</tbody>
</table>

c. Click **Submit**.
The system adds the Case Task channel to the Service Channels list.

For more information about creating an AWA service channel, see Create a service channel.

2. Configure the layout for the case task inbox card.

   a. Click **Case Task** in the Service Channel list to open the record.

   b. In the Inbox Layout related list, click **Default Case Task layout**.

   c. Add the following fields to the card layout.

      • **Field 1**: Number
      • **Field 2**: Subject
      • **Field 3**: Parent Number

   d. Click **Update**.

      For more information about configuring the card layout, see Create or modify an inbox layout.

3. Create a queue for the case task service channel.

   a. In the Queue related list, click **New**.

   b. Fill in the following fields on the Queue form.
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the queue. For example, Case Task Assignment.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief explanation of the queue. For example, Assign case tasks to middle office users.</td>
</tr>
</tbody>
</table>

c. **Click Submit.**

For more information about configuring a queue, see Create a work item queue.

4. Create an assignment rule for the Case Task Assignment queue.

a. Navigate to Advanced Work Assignment > Assignment Rules and click **New**.

b. Fill in the fields on the Assignment Rule form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the assignment rule.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the assignment rule. For example, Assign the case tasks based off this configuration.</td>
</tr>
<tr>
<td>Assign by</td>
<td>Type of assignment. Select <strong>Most Capacity</strong>, which routes a work item to the user who has the greatest availability for handling the work.</td>
</tr>
<tr>
<td>Allow agents to reject</td>
<td>In the Rejection handling form section, enable this check box to enable users to reject work items in their inbox.</td>
</tr>
</tbody>
</table>

c. **Click Submit.**

For more information about creating an assignment rule, see Configure agent assignment rules.

5. Create a group for the Case Task Assignment queue.
a. Navigate to **Advanced Work Assignment > Management > Groups** and click **New**.

b. Fill in the fields on the Group form and click **Submit**.

c. Click the group to display the Group form.

d. In the Group Members related list, add users to the group.
   The users that you add to the group for the Case Task Assignment queue require the following roles:
   
   - Case task agent (sn_customerservice.case_task_agent)
   - AWA agent (awa_agent)

   For more information about creating a group, see [Create or modify groups for Advanced Work Assignment queues](#).

6. Associate the assignment rule with the Case Task Assignment queue.

   a. Navigate to **Advanced Work Assignment > Settings > Queues** and click the Case Task Assignment queue.

   b. In the Assignment Eligibility related list on the Queue form, click **New**.

   c. Select the case task assignment rule in the **Agent assignment rule** field.

   d. Select the case task assignment group in the **Groups** field.

   e. Click **Submit**.

7. Activate the service channel.

   a. Navigate to **Advanced Work Assignment > Settings > Presence States**.

   b. Click the **Available** presence state and add the case task service channel to the **Selected** column.

   c. Click **Update**.

---

**Administer Customer Service Management**

Use a number of features and tools to administer the Customer Service Management application.

**Anonymous chat**

Consumers can chat with a consumer service agent without logging in to the Consumer Service Portal.
From the Consumer Service Portal, guest users can click the Live Chat link in the portal header to initiate a chat session with a consumer service agent. Clicking this link opens a form that requests some basic information, including the user’s name, email address, and type of issue. Completing and submitting the form creates a chat request that is routed to the appropriate agent queue based on the selected issue type. Once the assigned agent accepts the request, a chat session is established. If necessary, the agent can create a consumer record or a case for the guest user, or transfer the chat to another agent.

**Setting up anonymous chat**

Setting up the anonymous chat feature involves the following steps.


2. Modify the default anonymous chat record producer or create a new record producer.

3. Create one matching rule for each agent queue.

4. Configure anonymous chat properties.

5. If necessary, modify the Connect actions to provide the desired functionality for consumer service agents in chat conversations. The anonymous chat feature includes these actions: Create Case for Guest and Create Consumer and Case for Guest. For more information, see Administer Connect Actions.

**Anonymous chat plugins**

The anonymous chat feature requires two plugins which are activated as part of the Consumer Service Portal plugin:

- Anonymous Connect Support (com.glide.connect.anonymous_support): enables the anonymous chat feature for Connect.

- Connect Support Routing (com.glide.connect.support.routing): routes Connect Support requests to the appropriate chat queue.

**Anonymous chat record producer**

The form used to request information from a guest user is a configurable record producer based on the Consumer Interaction table (sn_customerservice_customer_interaction), which is a new table in the Istanbul release. When a guest user submits the form, the information provided is stored as a record in the Customer Interaction table. This record is used for routing the chat request.

The default anonymous chat record producer, What can we help you with?, is located at Service Catalog > Catalog Definition > Record Producers. This is a public record producer. You can modify this record producer or create your
own. If you choose to create your own, see Section 3 in the Making a record producer and catalog item public on a CMS page [KB0551300] article. You must also set the glide.sc.use_user_criteria property to false.

For more information, see Record Producer.

Anonymous chat routing

Information provided by the guest user assists with routing and also provides the context of the request to the consumer service agent. The chat request is routed to the appropriate agent queue based on the type of issue selected. The routing for anonymous chat requests uses matching rules. Create one matching rule for each queue and tie a chat request to a chat queue based on the selected issue type. Matching rules for anonymous chat are based on the Customer Interaction table.

The following matching rules are provided:

• Anonymous Connect - Billing Support
• Anonymous Connect - Order Support
• Anonymous Connect - Product Support

These rules are based on the selections in the Issue Type field on the default anonymous chat record producer.

Anonymous chat properties

There are two properties related to the anonymous chat feature. Set these properties to limit the number of chat requests created by guest users.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>connect.support.max_guest_sessions_per_hour</td>
<td>Limit maximum number of guest conversations created in the last hour.</td>
</tr>
</tbody>
</table>

• Type: integer
• Default value: 200
• Location: Collaborate > Connect
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| connect.support.guest_sessions_rate_limit_reached_message | Message shown to user when rate limit for guest conversations is breached.  
- **Type**: string  
- **Default value**: Guest Chat is currently not available, please retry later.  
- **Location**: Collaborate > Connect Support > Support Administration > Properties |

**Related reference**
Routing and assigning customer service cases

**Related information**
Record Producer  
Connect Support

**Modify the anonymous chat record producer**
Modify the default anonymous chat record producer to gather the desired information from guest users.

**Before you begin**
Role required: admin
About this task
This record producer requests information from a guest user on the Consumer Service Portal and stores the information as a record in the Consumer Interaction table (sn_customerservice_customer_interaction). The record is then used for routing the chat request.

Procedure
1. Navigate to Service Catalog > Catalog Definition > Record Producers.
2. Click What can we help you with?.
3. Modify the record producer as necessary, including the variables in the Variables related list.
   For more information, see Create a record producer.
4. Click Update.

Create a matching rule for anonymous chat
Create one matching rule for each agent queue.

Before you begin
Role required: admin

About this task
A chat request is tied to a chat queue based on the selected issue type.

Procedure
1. Navigate to Routing and Assignment > Matching Rules.
2. Click New.
3. Enter a Name for the matching rule.
4. In the Table field, select Customer Interaction.
5. In the Conditions field, use the condition builder to create the following conditions.

<table>
<thead>
<tr>
<th>Field</th>
<th>Operator</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel</td>
<td>is</td>
<td>Chat</td>
</tr>
<tr>
<td>Category</td>
<td>is</td>
<td>Select one of the categories created for anonymous users to</td>
</tr>
</tbody>
</table>
6. Click **Submit**.

**Configure anonymous chat properties**

Users with the system administrator role can set properties to limit the number of chat requests created by guest users.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **Collaborate > Connect Support > Support Administration > Properties**.

2. Set the following properties.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Limit maximum number of guest conversations created in the last hour. [connect.support.max_guest_sessions_per_hour]</td>
<td>Limits the number of guest chat requests that can be created in a one-hour timeframe. The default value is 200.</td>
</tr>
<tr>
<td>Message shown to user when rate limit for guest conversations is breached. [connect.support.guest_sessions_rate_limit_reached_message]</td>
<td>The message that is displayed on the Consumer Service Portal when the limit on the number of guest chat requests has been reached.</td>
</tr>
</tbody>
</table>

3. Click **Save**.

**Respond to an anonymous chat request**

Select a chat request from the chat queue and respond to a guest user’s question or comment.
Before you begin
Role required: sn_customerservice.consumer_agent, sn_customerservice_manager, or admin

Procedure
1. Navigate to Collaborate > Connect Chat.
   The Connect workspace opens in a new tab.
2. Click the support tab of the Connect sidebar, indicated by a headset icon.
   The support tab displays Queues to which you belong. It also displays your open support conversations under Cases. When a consumer starts a support conversation or an agent transfers a conversation to a queue, any agent who belongs to the associated queue has the option to accept the conversation. An agent can also request to transfer a conversation directly to you.
3. Accept a conversation in one of the following ways.
   • Accept a conversation from a queue
   • Accept a transfer request
4. Respond to the guest user and help resolve the issue.
   By default, your messages are added to the conversation record as comments and are visible to the user.

What to do next
If necessary, you can create a consumer record for a guest user and create a consumer service case from the conversation to track the issue. You can also transfer the conversation to a different agent or queue, or escalate the conversation to a higher priority queue. For more information, see Connect Support.

Customer Service Management Flow Designer actions
Use Flow Designer actions as building blocks to create Customer Service Management business processes.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get Case</td>
<td>Retrieve a case record using the case number. If multiple records are found, only the first record is returned.</td>
</tr>
<tr>
<td>Create Case</td>
<td>Create a case using one or more attributes. This action mimics the structure of the Case table</td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>(sn_customerservice_case)</td>
<td>(sn_customerservice_case) and exposes all of the fields present on the Case table.</td>
</tr>
<tr>
<td>Create Quick Case</td>
<td>Create a case using the customer, description, channel, priority, and category attributes.</td>
</tr>
<tr>
<td>Create Task on Case</td>
<td>Create a case task and optionally associate it with a case.</td>
</tr>
<tr>
<td>Update Case</td>
<td>Update a case by providing the case reference and the fields that you want to update.</td>
</tr>
<tr>
<td>Assign Case</td>
<td>Assign a case using matching rules. To use this action, you must first define the matching rules that match cases with resources (assignment groups, agents).</td>
</tr>
<tr>
<td>Escalate Case</td>
<td>Request case escalation. This action does not automatically approve escalation. Approval is based on the selected escalation template.</td>
</tr>
<tr>
<td>Escalate Account</td>
<td>Request account escalation. This action does not automatically approve escalation. Approval is based on the selected escalation template.</td>
</tr>
<tr>
<td>Add Work Note to Task</td>
<td>Add a work note to a task or to task extended objects (for example, a case or case task).</td>
</tr>
<tr>
<td>Add Comment to Task</td>
<td>Add a comment to a task or to task extended objects (for example, a case or case task).</td>
</tr>
</tbody>
</table>

**Related information**

Flow Designer
Action Designer
Domain separation and Customer Service Management

Domain separation is supported in Customer Service Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

Support level: Basic

- **Business logic**: Ensure that data goes into the proper domain for the application’s service provider use cases.
- The application supports domain separation at run time. The domain separation includes separation from the user interface, cache keys, reporting, rollups, and aggregations.
- The owner of the instance must set up the application to function across multiple tenants.

Sample use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.

For more information on support levels, see [Application support for domain separation](#).

Overview

Domain separation for Customer Service Management is designed for:

- **Customers using the application in a domain-separated environment or in a hybrid environment**. With domain separation, a customer can grant access to end users (contacts or consumers) to other entities in addition to customer service cases. For example, contacts or consumers can access problems, changes, or projects. System administrators can synchronize the CSM account model with the domain structure and maintain data separation for entities that do not have account-based data separation enabled.

- **Managed service providers (MSPs) using the application to provide customer support**. In this scenario, an MSP can provide support to multiple customers, where domains are necessary to contain all relevant customer data and processes. For example, an MSP providing support to customers related to billing questions, contract renewals, or other non-service operations.

- **Managed service providers offering the application as a service that customers can provide to their customers**. In this scenario, an MSP can offer Customer Service Management as a service to customers who, in turn, use the...
application to support their end customers. This scenario requires additional
configuration due to domain support for some of the core entities in the
platform such as Product Model.

How domain separation works in Customer Service Management

Domain separation for Customer Service Management aligns each customer
account to one domain. To use domain separation with the application, all
customer accounts must be assigned to a domain.

The customer account is the main entity within Customer Service Management.
All entities related to the account, such as contacts and cases, are created
in the same domain as the account. This rule also applies for all entities on
customer service cases, including addresses, assets, and contacts.

When a new account is created, a domain of the same name is also created
and assigned to the account. All related entities for an account, such as
contacts and cases, must reside in the same domain. When a related entity for
a domain separated account is created, the entity is assigned to the account
domain.

Setting up domain separation for Customer Service Management

Domain separation for Customer Service Management requires the domain
separation plugin. Contact ServiceNow to activate domain separation.

Domain separation for Customer Service Management also requires enabling
the csm_auto_account_domain_generation property. This property is installed
with Customer Service Management and is available only after the domain
separation plugin is active. Contact ServiceNow to enable this property.

When the csm_auto_account_domain_generation property is enabled, the
Customer Service Management application automatically creates a domain of
the same name when a new account is created.

Note: Enabling the csm_auto_account_domain_generation property
does not add domains for existing accounts. It only creates domains for
newly created accounts. Adding domains for existing accounts requires
a migration script. You can request for the migration script from the
ServiceNow Professional Services team.

Changes to Customer Service Management tables

Domain separation for Customer Service Management adds the Domain and
Domain Path fields to the Account [customer_account] table. These fields are
not exposed by default. Customers can customize lists and forms to view these
fields.
Account domains and related entities

When creating related entities for an account, the domain for the related entities is set to the account domain. Related entities include:

- Contacts
- Cases
- Assets
- Contracts
- Entitlements
- Addresses
- Social profiles
- Escalations
- Sold Products
- Installed Products
- Install Base Items
- Affected Install Base Items
- Sold Product Covered

Changing the domain for an account also changes the domain for all the account’s related entities.

Domain visibility for customer service agents and managers

Users with the customer service agent (sn_customerservice_agent) and customer service manager (sn_customerservice_manager) roles must be manually assigned to the TOP/MSP/Default domain. Agents and managers cannot see case or account details until they are assigned to the TOP domain.

Domain separation for case and account escalation

Escalation template records and escalation severity records are domain separated. By default, these records reside in the global domain. Users can configure the Escalation Template and Escalation Severity forms to display the Domain field and set the domain as needed.

When an escalation record is created from a case or account, it is created in the account domain.

Related information

Domain separation for service providers
Domain separation and entity relationships

With domain separation in Customer Service Management, you can further control visibility and access to data by using contact, partner, and parent-child relationships.

Partner-customer account relationships

In partner-customer account relationships, the partner account can see data in the customer account’s domain. When setting up an account relationship, the domain visibility direction is From > To. The account in the From field contains the domain of the account in the To field.

When a partner admin creates a case for a customer account, the case is created in the customer account’s domain so that all relevant parties can access the case.

In partner-customer account relationships where the customer account has child relationships, the partner admin can create a case for the customer account but not for the child accounts. The partner admin can only create cases for the account with which the relationship has been established.

Contact relationships

In contact relationships, the contact included in the relationship can see data for the specified account domain.

Parent-child relationships

The account hierarchy feature creates a parent-child relationship between accounts. This relationship is defined by selecting the parent in the Parent Account field on the Account form for the child account. Domain hierarchy is also achieved using the Parent Account field. In parent-child account relationships, parent domains can see data in child domains.

To provide access from the child account to the parent account, you need to set domain visibility. Navigate to the child account and set visibility in the Visibility Domains related list (sys_user_visibility) by connecting the user to the domain.

Extension points in Customer Service Management

Use extension points to call custom scripts in the Customer Service Management application.

To access the available extension points, type sys_extension_point.list in the application navigator and press Enter. Click the desired extension point to view the record details.
You can create multiple implementations for each extension point and provide an order number for each implementation. The implementation that has the lowest order number is the implementation that is executed.

<table>
<thead>
<tr>
<th>Extension point</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_customerservice.CSMService</td>
<td>Defines the default value logic for case objects. Available with the Customer Service (com.sn_customerservice) plugin.</td>
</tr>
</tbody>
</table>
| sn_customerservice.CSMCaseSync        | Use this extension point to customize the logic for parent-child case synchronization. This extension point can be used in one of two ways:  

  • Define the conditions for parent case records that can be considered for synchronization to child cases. The default functionality is based on the `sn_customerservice.parent_child_case_sync` system property. Customers can add additional conditions using this extension point.  

  • Customize the logic for parent-child case synchronization based on the state of the child case. By default, if the child case is in the **Resolved**, **Closed**, or **Cancelled** state, there is no sync from the parent case.  

  This extension point is used by the `CSCaseSyncHelper` script include. Available with the Customer Service (com.sn_customerservice) plugin. |
<p>| sn_majorissue_mgt.MajorCase           | Available with the Major Issue Management (com.sn_majorissue_mgt) plugin. |
| sn_action_status.NeedsAttentionAccessUtil | Enables each application to choose the user roles that can enable and... |</p>
<table>
<thead>
<tr>
<th>Extension point</th>
<th>Description</th>
</tr>
</thead>
</table>
|                                                  | disable the **Needs Attention** field on a case form.  
|                                                  | Available with the Customer Service Case Action Status plugin (com.snc.csm_action_status).                                                |
| sn_cs_sm.CSMChangeIntegrations                   | Creates the logic for mapping the **Change Request** field on the case record.  
|                                                  | Available with the Customer Service with Service Management (com.sn_cs_sm) plugin.                                                          |
| sn_cs_sm.CSIMincidentIntegrations                | Creates the logic for mapping the **Incident** field on the case record.  
|                                                  | Available with the Customer Service with Service Management (com.sn_cs_sm) plugin.                                                          |
| sn_cs_sm.CSMProblemIntegrations                  | Creates the logic for mapping the **Problem** field on the case record.  
|                                                  | Available with the Customer Service with Service Management (com.sn_cs_sm) plugin.                                                          |
| sn_cs_sm_request.CSMRequestIntegrations          | Creates the logic for mapping the **Request** field on the case record.  
|                                                  | Available with the Customer Service with Request Management (com.sn_cs_sm_request) plugin.                                                   |

**Related information**

- Using extension points to extend application functionality
- Using scripted extension points in server-side scripts
- Using UI extension points in server-side UI macros
- Using client extension points in client-side UI scripting
Knowledge product entitlements

The Knowledge Product Entitlements application enables administrators to designate the knowledge bases and knowledge articles that customers can view from the Customer Service Portal.

Limit access on the Customer Service Portal to the following:

- The knowledge bases and articles for the products that a customer’s company has purchased.
- The knowledge bases and articles for which a customer’s company has entitlements.

The Knowledge Product Entitlements plugin (com.snc.kb_product_entitlements) must be activated to use this application. Installing this plugin adds the Related Products field to the Knowledge Base form and to the Knowledge form. The knowledge information available on the customer portal is limited to the products selected in this field.

Additional controls are available by enabling properties that allow you to:

- Limit access to knowledge bases based on product entitlements.
- Enable access if no products are specified in the Related Products fields.

Add a related product to a knowledge base or knowledge article

Add a product to a knowledge base or knowledge article using the Related Products field on the corresponding form.

Before you begin
Role required: admin

About this task

Note: To access knowledge bases and articles associated with a product, a user must have read or contribute access and have the product included in the user’s account as an asset. For more information about assets, see Configure assets.

Procedure

1. Navigate to one of the following:
   - Knowledge > Administration > Knowledge Bases
   - Knowledge > Articles > All
2. Select the desired knowledge base or knowledge article.
3. Add one or more products in the **Related Products** field.
4. Click **Update**.

**Set knowledge product entitlement properties**

Set various properties to allow customers to access knowledge bases and knowledge articles on the Customer Service Portal.

**Before you begin**

Role required: admin

**Procedure**

1. Navigate to **Knowledge Product Entitlements > Properties**.
2. Set the following properties, as needed.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable access control of Knowledge Bases based on product entitlements</td>
<td>If enabled, customers can access all of the knowledge bases related to the products for which they have entitlements.</td>
</tr>
<tr>
<td>Allow access to Knowledge Bases with empty related_products</td>
<td>If enabled, customers can access all knowledge bases even if no products have been specified in the <strong>Related Products</strong> field on the Knowledge Base form.</td>
</tr>
<tr>
<td>Enable access control of Knowledge Articles based on product entitlements</td>
<td>If enabled, customers can access all of the knowledge articles related to the products for which they have entitlements.</td>
</tr>
<tr>
<td>Allow access to Knowledge Articles with empty related_products</td>
<td>If enabled, customers can access all knowledge articles even if no products have been specified in the <strong>Related Products</strong> field on the Knowledge form.</td>
</tr>
</tbody>
</table>

3. Click **Save**.

**Limit knowledge base access to internal users**

Limit access to the information in a knowledge base to internal users.
Before you begin
Role required: admin

About this task
The articles in a knowledge base are available to both internal users, such as customer service agents, and to external users (customers and partners). If the articles in a knowledge base are intended for internal users only, the system administrator can restrict access by customizing the knowledge base form.

Procedure
1. Navigate to Knowledge > Administration > Knowledge Bases.
2. Click the desired knowledge base.
3. Right-click the form header and select Configure > Related Lists.
4. Select Cannot Contribute from the Available column and move it to the Selected column.
5. Click Save.
6. On the selected knowledge base form, click the Cannot Contribute related list.
7. Click Edit.
8. Click All Customer Contacts in the left column and move it to the right column.
9. Click Save.

Quick start tests for Customer Service Management
Validate that the Customer Service Management application still works after you make any configuration change such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.

All Customer Service Management quick start tests require activating the Customer Service Management Demo Data plugin (com.snc.customerservice.demo). Some quick start tests also require activating the following plugins:

- Consumer Service Portal (com.glide.service-portal.consumer-portal)
- Customer Service Management for Orders (com.snc.csm.order)
- Customer Service Portal (com.glide.service-portal.customer-portal)
- Customer Service with Request Management (com.sn_cs_sm_request)
- Customer Service with Service Management (com.sn_cs_sm)
- Customer Service Household (com.snc.household)
• Business Location (com.snc.business_location)
• CSM Extension for Proxy Contacts (com.snc.csm_proxy_contacts)
• Case Playbook for Complaints (sn_complaint)
• Case Playbook for Onboarding (sn_onboarding)
• Major Issue Management (com.sn_majorissue_mgt)
• Proactive Customer Service Operations with Event Management (com.snc.proactive_cs_itom)
• Skill Determination (com.snc.skill_determination)

# CSM: Case Management test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSM: Create Product Case</td>
<td>Create a case for a product.</td>
<td>Madrid</td>
</tr>
<tr>
<td>CSM: Assign Case to an Agent</td>
<td>Create a case and assign it to a customer service agent.</td>
<td>Madrid</td>
</tr>
<tr>
<td>CSM: Assign Asset on Case</td>
<td>Assign an asset to a case.</td>
<td>Madrid</td>
</tr>
<tr>
<td>CSM: Assign Entitlement</td>
<td>Assign an entitlement to a case.</td>
<td>Madrid</td>
</tr>
<tr>
<td>CSM: Escalate an Account</td>
<td>Escalate an account.</td>
<td>Madrid</td>
</tr>
<tr>
<td>CSM: Escalate a Case</td>
<td>Escalate a case.</td>
<td>Madrid</td>
</tr>
<tr>
<td>CSM: Create Special Handling Notes</td>
<td>Create special handling notes for a case.</td>
<td>Madrid</td>
</tr>
<tr>
<td>CSM: Close a Case</td>
<td>Close a case.</td>
<td>Madrid</td>
</tr>
<tr>
<td>CSM: Time Recording</td>
<td>Record the time worked on a case.</td>
<td>Madrid</td>
</tr>
<tr>
<td>CSM: Create CHG from Case</td>
<td>Create a change record from a case.</td>
<td>Madrid</td>
</tr>
<tr>
<td>CSM: Create Incident from Case</td>
<td>Create an incident record from a case.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Test</td>
<td>Description</td>
<td>Release version</td>
</tr>
<tr>
<td>---------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>CSM: Create Order Case</td>
<td>Create a case for an order.</td>
<td>Madrid</td>
</tr>
<tr>
<td></td>
<td>☐ Note: Requires Customer Service Management for Orders.</td>
<td></td>
</tr>
<tr>
<td>CSM - Create Order Case as Customer from CSM Portal</td>
<td>Create an order case as a customer from the Customer Service Portal.</td>
<td>Madrid</td>
</tr>
<tr>
<td></td>
<td>☐ Note: Requires Customer Service Portal. Also requires that the test be run as admin.</td>
<td></td>
</tr>
<tr>
<td>CSM: Create Problem from Case</td>
<td>Create a problem record from a case.</td>
<td>Madrid</td>
</tr>
<tr>
<td>CSM - Create Proactive Case by NOC Operator</td>
<td>Verify whether a proactive case is created.</td>
<td>New York</td>
</tr>
<tr>
<td></td>
<td>☐ Note: Requires Proactive Customer Service Operations with Event Management.</td>
<td></td>
</tr>
<tr>
<td>CSM - Employee creating case OBO customer</td>
<td>As an employee with the proxy contact role (sn_customerservice_proxy_contact), create a case from the self-service portal on behalf of a customer.</td>
<td>New York</td>
</tr>
<tr>
<td></td>
<td>☐ Note: Requires the CSM Extension for Proxy Contacts.</td>
<td></td>
</tr>
<tr>
<td>Test</td>
<td>Description</td>
<td>Release version</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>CSM - Lookup Type Skill Determination Rule Test</td>
<td>Create a lookup type skill determination rule.</td>
<td>New York</td>
</tr>
<tr>
<td></td>
<td>Note: Requires Skill Determination.</td>
<td></td>
</tr>
<tr>
<td>CSM - Manager creating request OBO customer from CSM portal</td>
<td>As a user with the case manager role, create a case on behalf of a customer from the Customer Service Portal.</td>
<td>New York</td>
</tr>
<tr>
<td></td>
<td>Note: Requires Customer Service Request Integration.</td>
<td></td>
</tr>
<tr>
<td>CSM - Simple Type Skill Determination Rule Test</td>
<td>Create a simple type skill determination rule.</td>
<td>New York</td>
</tr>
<tr>
<td></td>
<td>Note: Requires Skill Determination.</td>
<td></td>
</tr>
<tr>
<td>CSM: Register New Case Type</td>
<td>Register a case type and verify the record is created.</td>
<td>Orlando</td>
</tr>
<tr>
<td>CSM - Project Manager create Project for an Account</td>
<td>Project Manager creates project for an account.</td>
<td>Orlando</td>
</tr>
<tr>
<td></td>
<td>Note: Requires Customer Project Management.</td>
<td></td>
</tr>
<tr>
<td>CSM - Project Manager identify Project Contact</td>
<td>Project manager identifies customers to a project.</td>
<td>Orlando</td>
</tr>
<tr>
<td></td>
<td>Note: Requires Customer Project Management.</td>
<td></td>
</tr>
<tr>
<td>CSM - Project Manager create project task and assign to a customer</td>
<td>Project manager creates project task and assigns to a customer.</td>
<td>Orlando</td>
</tr>
</tbody>
</table>
CSM: Case Management test suite (continued)

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSM - Create Case from Project</td>
<td>Create a case from project.</td>
<td>Orlando</td>
</tr>
<tr>
<td>CSM - Create Case from Project Task</td>
<td>Create a case from a project task.</td>
<td>Orlando</td>
</tr>
<tr>
<td>CSM: Create Task from Case</td>
<td>Create a case task from a case.</td>
<td>Orlando</td>
</tr>
<tr>
<td>CSM: Agent Creating Request for Customer</td>
<td>As a customer service agent, create a request for a customer.</td>
<td>Orlando</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires Customer Service Request Integration.</td>
<td></td>
</tr>
<tr>
<td>CSM - Agent Create Cases from a Project</td>
<td>As a customer service agent, create a case from a project.</td>
<td>Orlando</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires Customer Project Management.</td>
<td></td>
</tr>
<tr>
<td>CSM - Agent Create Cases from a Project task</td>
<td>As a customer service agent, create a case from a project task.</td>
<td>Orlando</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires Customer Project Management.</td>
<td></td>
</tr>
<tr>
<td>CSM - Agent Create Change Requests for a project</td>
<td>As a customer service agent, create a change request for a project.</td>
<td>Orlando</td>
</tr>
<tr>
<td>CSM: Create Major Case and its Child Cases</td>
<td>Create a major case and the associated child cases for the customer</td>
<td>Orlando</td>
</tr>
</tbody>
</table>
### CSM: Case Management test suite (continued)

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>accounts in the recipient list.</td>
<td>Orlando</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires Major Issue Management.</td>
<td></td>
</tr>
<tr>
<td>CSM: Advanced Type Skill Determination Rule Test</td>
<td>Create an advanced type skill determination rule.</td>
<td>Orlando</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires Skill Determination.</td>
<td></td>
</tr>
<tr>
<td>CSM - Service Contracts covered under Sold Product</td>
<td>Create sold products and service contracts and associate service contracts to a sold product. Verify the association between the active contracts and the sold product.</td>
<td>Orlando</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires Customer Service Install Base Management.</td>
<td></td>
</tr>
<tr>
<td>AWA - Create New Service Channel</td>
<td>Create a new service channel in the Advanced Work Assignment application.</td>
<td>Orlando</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires Advanced Work Assignment for CSM.</td>
<td></td>
</tr>
<tr>
<td>CSM-ITOM - Create Child Cases for Proactive Major Case</td>
<td>Create a child case for a proactive major case using recipient list.</td>
<td>Orlando</td>
</tr>
</tbody>
</table>
### CSM: Case Management test suite (continued)

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Note: Requires Proactive Customer Service Operations with Event Management." /></td>
<td>CSM - Create Outage from Case Validate if newly created outage is linked to a case.</td>
<td>Paris</td>
</tr>
<tr>
<td><img src="image" alt="Note: Requires Customer Service Install Base Management and Customer Service Household with Load demo data enabled." /></td>
<td>CSM: Create Sold Product on Household Create a sold product on a household and its member.</td>
<td>Quebec</td>
</tr>
<tr>
<td><img src="image" alt="Note: Requires Customer Service Install Base Management and Customer Service Household with Load demo data enabled." /></td>
<td>CSM: View Health Status of Install Base Item from Account and Case pages Validates the functionality of the Refresh Install Base Health button on the Account and Case record pages.</td>
<td>Quebec</td>
</tr>
<tr>
<td><img src="image" alt="Note: Requires Customer Service Install Base Management and Customer Service Household with Load demo data enabled." /></td>
<td>CSM: Assign Case Task to Case Task Agent The customer service agent creates and assigns a case task to a case task agent.</td>
<td>Rome</td>
</tr>
<tr>
<td><img src="image" alt="Note: Requires Customer Service Install Base Management and Customer Service Household with Load demo data enabled." /></td>
<td>CSM: Case Task Agent views assigned Case Task Verifies that the case task agent can view an assigned case task.</td>
<td>Rome</td>
</tr>
<tr>
<td><img src="image" alt="Note: Requires Customer Service Install Base Management and Customer Service Household with Load demo data enabled." /></td>
<td>CSM: Case Task Agent Completes Assigned Task The case task agent completes an assigned case task.</td>
<td>Rome</td>
</tr>
</tbody>
</table>
### CSM: Case Management test suite (continued)

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSM: Report a knowledge gap from a case in Agent Workspace</td>
<td>Verify that a knowledge gap related to a case was reported in Agent Workspace</td>
<td>Rome</td>
</tr>
<tr>
<td>CSM-Create a case using 'Create a case (POST)' API</td>
<td>Create a case using 'Create a case (POST)' API</td>
<td>Rome</td>
</tr>
<tr>
<td>CSM-Query a case using 'Query a case (GET)' API</td>
<td>Query a case using 'Query a case (GET)' API</td>
<td>Rome</td>
</tr>
<tr>
<td>CSM: OCS Manager creating New OSP</td>
<td>Verify that a new Outsourced Service Provider (OSP) is created by OCS internal manager.</td>
<td>Rome</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires Outsourced Customer Service.</td>
<td></td>
</tr>
<tr>
<td>CSM: Case Creation by OCS Agent</td>
<td>Verify that an Outsourced Customer Service agent is able to create a case.</td>
<td>Rome</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Requires Outsourced Customer Service.</td>
<td></td>
</tr>
</tbody>
</table>

### CSM: Case Types - Complaint

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a Complaint Case</td>
<td>Tests that a user can create a case that is of type complaint in the sn_complaint_case table.</td>
<td>Paris</td>
</tr>
<tr>
<td>Escalate a Complaint Case</td>
<td>Tests that a user can escalate a case that</td>
<td>Paris</td>
</tr>
<tr>
<td>Test</td>
<td>Description</td>
<td>Release version</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Create an Onboarding Case</td>
<td>Tests that a user can create a case that is of type onboarding in the sn_onboarding_case table.</td>
<td>Paris</td>
</tr>
<tr>
<td>Escalate an Onboarding Case</td>
<td>Tests that a user can escalate a case that is of type onboarding in the sn_onboarding_case table.</td>
<td>Paris</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>awa_admin_operations_dashboard</td>
<td>Verify whether user with role awa_admin is able to view Advanced Work Assignment menu under Operations Dashboard and unassigned interactions and unassigned task work items modules.</td>
<td>Orlando</td>
</tr>
<tr>
<td>awa_manager_operations_dashboard</td>
<td>Verify whether user with role awa_manager is able to view Advanced Work Assignment menu under Operations Dashboard and unassigned interactions</td>
<td>Orlando</td>
</tr>
</tbody>
</table>
## CSM: Operations Dashboard test suite (continued)

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>and unassigned task work items modules.</td>
<td></td>
</tr>
</tbody>
</table>

## CSM: Portal test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSM - Create Product Case as Customer from CSM Portal</td>
<td>Create a product case as a customer from the Customer Service Portal.</td>
<td>Madrid</td>
</tr>
<tr>
<td>CSM - Create Product Case as Partner from CSM Portal</td>
<td>Create a product case as a partner from the Customer Service Portal.</td>
<td>Madrid</td>
</tr>
<tr>
<td>CSM - Search on Homepage</td>
<td>Search for information from the Customer Service Portal. The search includes cases, Knowledge articles, and Community threads.</td>
<td>New York</td>
</tr>
<tr>
<td>CSM - Update Support Profile</td>
<td>Update a contact's profile from the Customer Service Portal.</td>
<td>New York</td>
</tr>
<tr>
<td>CSM - Provide requested info on case</td>
<td>From the Customer Service Portal, the contact can provide information for a case</td>
<td>New York</td>
</tr>
</tbody>
</table>
## CSM: Portal test suite (continued)

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSM - Accept Proposed Solution On Case</td>
<td>Accept a proposed solution for a case from the Customer Service Portal.</td>
<td>New York</td>
</tr>
<tr>
<td>CSM - Provide Feedback on Survey</td>
<td>Provide feedback on a survey after a case is closed from the Customer Service Portal.</td>
<td>New York</td>
</tr>
<tr>
<td>CSM - View All Desktop Notifications</td>
<td>View all Customer Service Management specific desktop notifications.</td>
<td>Orlando</td>
</tr>
<tr>
<td>CSM - View Publications on CSM Portal</td>
<td>View publications on Customer Service Management portal.</td>
<td>Orlando</td>
</tr>
<tr>
<td>CSM - Create Contact on CSM Portal</td>
<td>Create contacts on Customer Service Management portal.</td>
<td>Orlando</td>
</tr>
<tr>
<td>CSM: Validate Outage widgets in CSM Portal</td>
<td>Validates various types of outages and the corresponding widgets shown on the Customer Service Portal home page and the Install Base page.</td>
<td>Quebec</td>
</tr>
</tbody>
</table>

## CSP: Portal test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSP - Create Product Case as Consumer from CSP Portal</td>
<td>Create a product case as a consumer from the Consumer Service Portal.</td>
<td>Madrid</td>
</tr>
</tbody>
</table>
### CSP: Portal test suite (continued)

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSP - Search on Homepage</td>
<td>Search for information from the Consumer Service Portal. The search includes cases, Knowledge articles, and Community threads.</td>
<td>New York</td>
</tr>
<tr>
<td>CSP - Update Support Profile</td>
<td>Update a consumer's profile from the Consumer Service Portal.</td>
<td>New York</td>
</tr>
<tr>
<td>CSP - Register Your Product</td>
<td>Register a product from the Consumer Service Portal.</td>
<td>New York</td>
</tr>
<tr>
<td>CSP - Provide requested info on case</td>
<td>From the Consumer Service Portal, the consumer can provide information for a case that was requested by the agent.</td>
<td>New York</td>
</tr>
<tr>
<td>CSP - Accept Proposed Solution On Case</td>
<td>Accept a proposed solution for a case from the Consumer Service Portal.</td>
<td>New York</td>
</tr>
<tr>
<td>CSP - Provide Feedback on Survey</td>
<td>Provide feedback on a survey after a case is closed from the Consumer Service Portal.</td>
<td>New York</td>
</tr>
<tr>
<td>CSP - View Publications on CSP Portal</td>
<td>View publications on Customer Service portal.</td>
<td>Orlando</td>
</tr>
</tbody>
</table>

**Note:** Requires Consumer Service Portal. Also requires that the test be run as admin.
### TC: Targeted Communications test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>TC - Create Recipient List</td>
<td>Create a recipient list with the required parameters. Verify the new recipient list in the related list &quot;Recipients&quot;.</td>
<td>Orlando</td>
</tr>
<tr>
<td>TC - Create Publication</td>
<td>Create a publication. The publication is published based on the publication date and verify if an user in the recipient list gets the publication.</td>
<td>Orlando</td>
</tr>
</tbody>
</table>

### CSM Agent Workspace test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSM - Create Problem from Case in Workspace</td>
<td>Tests the creation of a problem record from a case by a customer service agent in CSM Agent Workspace.</td>
<td>Quebec</td>
</tr>
<tr>
<td>CSM - Escalate a Case from Agent Workspace</td>
<td>Escalates a customer service case from CSM Agent Workspace.</td>
<td>Quebec</td>
</tr>
<tr>
<td>CSM - Create a Case and Propose Solution</td>
<td>Creates a customer service case and proposes a solution for the case from CSM Agent Workspace.</td>
<td>Quebec</td>
</tr>
<tr>
<td>CSM - Create Case and Assign this Case to Agent from Agent Workspace</td>
<td>Verifies the ability to create a customer service case and assign the case to an agent in CSM Agent Workspace.</td>
<td>Quebec</td>
</tr>
</tbody>
</table>
CSM Agent Workspace test suite (continued)

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSM - Approve Major Case Candidate from Agent Workspace</td>
<td>Verifies the ability to approve a major case candidate on a case from CSM Agent Workspace.</td>
<td>Quebec</td>
</tr>
<tr>
<td>CSM - Create Child Case for a Major Case from Agent Workspace</td>
<td>Verifies the ability to create a child case from a major case using the recipient list from CSM Agent Workspace.</td>
<td>Quebec</td>
</tr>
<tr>
<td>CSM - Create a Business Location from Agent Workspace</td>
<td>Creates a new business location in Agent Workspace.</td>
<td>Rome</td>
</tr>
<tr>
<td><strong>Note:</strong> Requires Business Location.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CSM - Create Household in Workspace</td>
<td>Creates a new household in Agent Workspace.</td>
<td>Rome</td>
</tr>
<tr>
<td><strong>Note:</strong> Requires Customer Service Household.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CSM - Create Knowledge Gap from Case</td>
<td>Creates a knowledge gap from a case in Agent Workspace.</td>
<td>Rome</td>
</tr>
</tbody>
</table>

Routing and assigning customer service cases

The case routing feature uses matching rules and assignment rules to identify customer service cases that meet certain conditions and then route those cases to customer service agents.

Create one or more matching rules that establish specific conditions that a case must meet before it can be routed to an agent. Then use an assignment rule to route those cases to agents based on product knowledge and availability. You can also invoke the MatchingRuleProcessor API to execute the matching rules and return a list of users (sys_ids).
Watch this five-minute video to learn about creating an assignment rule, the assignment workbench, and advanced work assignment. This video covers various aspects of configuration for routing and assignment including creating assignment rules, the assignment workbench and advanced work assignment.

**Matching Rules**

Matching rules are based on two defined sets of conditions, one that identifies specific case attributes and another that identifies the agent resources best suited to handle cases with these attributes. Matching rules are created using the Matching Rule form.

To identify case attributes, select a table that stores the task type (for example, the Case table) and then use a condition builder to create one or more conditions that a case must meet before being routed. For example, you can build conditions for a specific account and product or for a specific product and priority level.

To identify an agent resource, use one of the following resource matching methods:

- **Simple**: select the resource name from a list of users.
- **Advanced**: build conditions that filter the available agent resources. These conditions can be based on user role, agent group, specific skills, work load, or agent availability.
- **Scripted**: create a customized script to identify agent resources.

Another resource matching method, Selection Criteria, can be used to create a matching rule with selected matching criteria for use with the assignment workbench.

**Assignment Rules**

Use assignment rules to automatically assign task to users and groups. Create an assignment rule for a matching rule by clicking the Create assignment rule related link on the Matching Rule form. When the matching rule conditions are met, a case can be routed to a user or a group using the assignment rule. The assignment rule is applied only if the task is not already assigned to another user or group.

⚠️ **Note**: Matching rules and assignment rules are independent records with no synchronization. If you make a change in the Applies to component of the matching rule, it is not reflected in the assignment rule.

When you create an assignment rule, you select the following:
• The table for the task type and the conditions that must be met before the task is assigned.
• The user or the group to which the task is assigned.

Alternately, you can create a script to further customize the assignment rule.

**Related information**
> Assignment rules module

**Invoke the MatchingRuleProcessor API**

After you create one or more matching rules, you can invoke the MatchingRuleProcessor API and run the rules.

**Before you begin**
Role required: sn_customerservice_agent, sn_customerservice_manager, admin

**About this task**
The matching engine can be invoked using the `processAndGetCandidates` method of the `matchingRuleProcessor` class. Pass in the task record and the number of resources. The result is an array of resource sys_ids.

The matching rules are processed based on the number stored in the **Execution Order** field for each rule.

The result is a list of users (sys_ids), which you can use for case routing and assignment.

**Reverse matching**

Reverse matching uses the same matching rules to match tasks to a resource rather than resources to a task.

**Before you begin**
Role required: sn_customerservice_agent, sn_customerservice_manager, admin

**About this task**
The resource matching engine can match resources and tasks in two ways:

• **Forward:** matches resources for a task
• **Reverse:** matches tasks for a resource

The same matching rule can be used for both forward and reverse matching. In the customer service application, you can use reverse matching to determine which call the next available agent should take. Reverse matching returns a list
of case sys_ids instead of user sys_ids. When using reverse matching, you can also limit the cases returned to a specific set.

The following example shows how to use reverse matching.

```java
MatchingRuleProcessor.processAndGetCandidates(resource, taskLimit, 
    "sn_customerservice_case", "reverse", false, [<array of cases to consider>])
```

**Limit the number of task sys_ids returned for reverse matching rules**

Reverse matching rules return a list of case sys_ids. Limit the number of cases returned by configuring the number in the reverse.matchingrule.entity.limit system property.

**Before you begin**

Role required: admin

**Procedure**

1. In the navigation filter, type `sys_properties.list`.
2. Search for the reverse.matchingrule.entity.limit system property.
3. In the number field, change the number of cases returned. The default number is 30.

**Results**

If the number of cases returned is more than the value listed in the system property, the reverse matching rule does not run for Scripted and Selection Criteria matching rules.

**Assignment workbench overview**

The assignment workbench enables customer service managers to assign tasks to agents efficiently and intelligently. The workbench uses configurable criteria, such as skills and availability, to evaluate the agents in a selected group and provide an overall ranking. Managers can view these results and click one button to assign a task.

The assignment workbench displays all the relevant information for task assignment, including:

- A list of the agents in the task assignment group.
- The matching criteria used to evaluate the agents.
• An overall ranking for each agent in the assignment group.
• A filter with the current assignment group and the skills identified for the task, including any mandatory skills.

Assignment Workbench

Agents are ranked from 1 to any number based on the criteria configured for the workbench. The more criteria that matches, the higher an agent’s rank. When the criteria for two agents is the same, the agents have the same rank. Point to an agent’s rank to display the details.

Use the filter to change the assignment group and to add or remove skills. Changes to the assignment group or to the skills lists are reflected immediately in the workbench:
• Changing the assignment group displays a different list of agents.
• Adding or removing skills can change the agent ranking.

If you are using the mandatory skills feature, the agents displayed in the assignment workbench are filtered by the skills in the Mandatory Skills Added list and then ranked by the other matching criteria.

⚠️ Note: Agents cannot add or remove mandatory skills or make a skill not mandatory.

Configuring the assignment workbench
The assignment workbench configuration is stored in a matching rule that is based on the Selection criteria matching type. The default configuration uses
the **Recommendation for Case Assignment** matching rule, which includes three of the four default matching criteria:

- Availability Today
- Matching Skills
- Assigned Cases

Based on these matching criteria, the workbench calculates and displays an overall rank for each agent in the group. You can modify or create matching criteria and the **Recommendation for Case Assignment** matching rule as needed or you can create your own configuration following these steps:

1. Create one or more matching criteria.
2. Create a matching rule with the **Selection criteria** matching type.
3. Open the matching rule and add the desired matching criteria.

If you are using mandatory skills, you must replace the **Matching Skills** criterion in this matching rule with the **Matching Skills - Mandatory Skills Support** criterion to match agents with mandatory skills required for a case.

**Using the assignment workbench**

Access the assignment workbench by clicking the Find Agents icon (🔍) next to the **Assigned to** field on the task form.

⚠️ **Note:** The state of the current record determines the availability of the Find Agents icon. The icon is available for records in the **Open**, **Awaiting**, and **Cancelled** states, and if the user has write access for the **Assigned to** field. The icon is not available for records in the **New** or **Closed** states or when the **Assigned to** field is read-only for the current user.

Sort the list of agents by any of the matching criteria by clicking the desired column header, which reorders the suggested agents based on the selected criteria.

Select a different assignment group from the **Group** list in the filter. The list of agents is updated based on the selection. If the selected group does not contain any agents, a message is displayed to select another group.

Add or remove skills from the **Skills** list in the filter. These selections are reflected in the **Matching Skills** column.

Skills that have been identified as mandatory for a task are displayed in the **Mandatory Skills Added** list. These selections are also reflected in the **Matching Skills** column. You cannot add or remove skills from this list.
Select an agent and click **Assign** to assign the task. The workbench closes and returns to the Case form. The **Assigned to** field is updated with the selected agent. Click **Save** on Case form to save this assignment.

**Plugins**

The Assignment Workbench plugin (com.snc.assignment_workbench) is activated as part of Customer Service Management.

The Case Assignment Workbench Demo plugin (com.snc.case_assignment_workbench_demo) provides demo data for the workbench.

**Tables**

Assignment Workbench adds the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Matching Criteria</td>
<td>Stores the matching criteria that can be used to create a configuration for the assignment workbench.</td>
</tr>
<tr>
<td>[matching_dimension]</td>
<td></td>
</tr>
<tr>
<td>Select Criteria</td>
<td>Stores the matching criteria for an assignment workbench configuration matching rules.</td>
</tr>
<tr>
<td>[matching_dimension_for_assignment]</td>
<td></td>
</tr>
<tr>
<td>Matching Rule</td>
<td>Stores matching rules, including the matching rules that configurations for the assignment workbench.</td>
</tr>
<tr>
<td>[matching_rule]</td>
<td></td>
</tr>
</tbody>
</table>

**User Roles**

Assignment Workbench adds the following roles.

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignment workbench [assignment_workbench]</td>
<td>Provides access to the assignment workbench for customer service agents and consumer service agents.</td>
<td>• skill_user</td>
</tr>
</tbody>
</table>

**Properties**

Assignment Workbench adds the following properties.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>assignment_workbench.find.agents.title</td>
<td>Title for the macro button.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: string</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: Find Agents</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: Routing and Assignment &gt; Properties</td>
</tr>
<tr>
<td>assignment_workbench.new.window</td>
<td>When enabled, opens the assignment workbench in a new window.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: true</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: false</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: Routing and Assignment &gt; Properties</td>
</tr>
<tr>
<td>assignment_workbench_no_of_agents</td>
<td>Number of agents per page. (To get better performance, do not use more than 50 agents per page.)</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: choice list</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: 30</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: Routing and Assignment &gt; Properties</td>
</tr>
</tbody>
</table>

Related information

Configure assignment workbench

Matching criteria for case assignment

The assignment workbench uses configurable matching criteria, such as skills and availability, to evaluate the agents in a selected group and provide an overall ranking.

There are three types of matching criteria:

- **Simple Match**: creates one-to-one matching, such as matching the time zone of an agent with the time zone of a task location.
- **Aggregate**: uses a simple query and returns an aggregate result. For an aggregate type, select a table and create a filter, and then select an
aggregate field such as the **Assigned to** field. This type of query returns a set of users.

- **Scripted**: uses a scripted query which returns a list of users.

Several matching criteria are provided with the assignment workbench:

- **Availability Today**: Availability is calculated based on the agent's work schedule, assigned work, and personal time off. The more availability an agent has, the higher the contribution to the agent's overall rank.

- **Matching Skills**: The number of agent skills that match the skills required for the case. The more skills that match, the higher the contribution to the agent's overall rank.

- **Matching Skills - Mandatory Skills Support**: Calculates the number of agent skills that match the mandatory skills. It does this by filtering out all agents who do not have the mandatory skills and ranks the remaining agents. The more skills that match, the higher the contribution to the agent's overall rank.

  **Note**: If using the mandatory skills feature, use the **Matching Skills - Mandatory Skills Support** criterion to match agents with the *mandatory skills* identified for a case.

- **Assigned Cases**: The number of cases already assigned to this agent. The more cases assigned, the lower the contribution to the agent's overall rank.

- **Last Assigned**: For the sake of balancing assigned work, prioritized the agent based on the last assigned work.

To create matching criteria, select the type and use the fields related to that type to build the query. After creating matching criteria, you can create a configuration for the assignment workbench by creating a matching rule of the type **Selection criteria** and selecting the desired matching criteria.

As part of selecting the matching criteria for the workbench configuration, you can specify the following settings for each individual criterion:

- ranking and display usage
- ranking method
- ranking weight
- threshold
- active/inactive

**Ranking and display usage**

In the **Use for** field, specify how you want that matching criterion to be used:
• Ranking and display: uses the criterion to determine agent ranking and displays it in a column on the workbench.

• Display only: displays the criterion in a column on the workbench but does not use it to determine agent ranking.

• Ranking only: uses the criterion to determine agent ranking but does not display it on the workbench.

**Ranking method**

There are two ranking methods:

• More is better: for example, more availability is better when determining the agent ranking.

• Less is better: for example, fewer assigned cases are better when determining agent ranking.

**Weight**

Each matching criterion has an assigned weight. By default, the matching criteria in the Recommendation for Case Assignment matching rule have an assigned weight of 10. You can assign a higher weight to the criteria that are more important.

**Threshold**

A threshold sets a minimum requirement for a criterion. For example, set the threshold of the Matching Skills criterion to 3 if you want to see only those agents who have at least three of the required skills for a task. For availability, set the threshold to the desired number of hours to display only those agents who have that minimum number of work hours available. You can set the threshold in the Select Criteria related list on the Matching Rule form. If necessary, personalize the list and add the Threshold column.

**Active/Inactive**

There can be several matching criteria associated with the matching rule that determines the assignment workbench configuration. Each individual criterion can be set to active or inactive. Changing this setting has an immediate impact on the agent ranking. You can make this change in the Select Criteria related list on the Matching Rule form. If necessary, personalize the list and add the Active column.

**Calculating the agent ranking**

The assignment workbench adds the values of the matching criteria and their respective weights and uses these values to determine the overall agent ranking.
1. Calculate a number for each criterion.
2. Multiply that number by the criterion weight.
3. Divide the result by the total of all criterion.
4. Repeat for each criterion and add the results.

The following example shows how the ranking is determined for an agent with these matching criteria values:

- Matching Skills with Mandatory Skills Support: 5/6
- Availability Today: 7 hours
- Assigned Cases: 2

Calculations:

- **Matching Skills**: \( \frac{2}{3} = 0.666 \) (with 3 being the maximum number of skills)
- **Availability Today**: \( \frac{7}{8} = 0.875 \) (with 8 being the maximum number of hours)
- **Assigned Cases**: \( \frac{2}{26} = 0.0769 \) (with 26 being the total number of tasks in the table)
- **Weight**: each matching criteria has an equal weight of 10

\[
\left( \frac{0.666 \times 10}{10} \right) + \left( \frac{0.875 \times 10}{10} \right) + \left( \frac{0.0769 \times 10}{10} \right)
\]

\[
\frac{6.66}{30} + \frac{8.75}{30} + \frac{0.769}{30}
\]

\[
0.222 + 0.291 + 0.0256 = 0.53
\]

This calculation is performed for each agent in the assignment group. Agents are ranked based on the value of this calculation, with the highest number earning the highest ranking.

**Matching rules for case assignment**

Use a matching rule to create a configuration for the assignment workbench.

The assignment workbench configuration is stored in a matching rule that is based on the **Selection criteria** matching type.

The default configuration uses the **Recommendation for Case Assignment** matching rule, which uses three of the four default matching criteria:
• Availability Today
• Matching Skills
• Assigned Cases

Note: If using the mandatory skills feature, use the Matching Skills - Mandatory Skills Support criterion to match agents with the mandatory skills identified for a case.

You can customize this matching rule to meet your specific need for calculating agent recommendations. This matching rule can also be used for auto assignment if you create an assignment rule.

Special handling notes overview

Use the Special Handling Notes application to create notes that bring important information about individual records to the user’s attention.

Create special handling notes for specific records or for a set of records that meet one or more conditions. You can also configure the Special Handling Notes application to display any special handling notes from related records, such as the account or the product associated with a customer service case.

Users with the sn_shn.admin role can configure the desired entity tables to use special handling notes and then configure the corresponding forms to display either the list or pop-up window. Users with the sn_shn.admin role can create, view, update, and delete notes. Users with the sn_shn.editor role can view and update notes and users with the sn_shn.user role can view notes.

Once created, special handling notes can be displayed in different ways: in an embedded list or a related list on a record form or in a pop-up window that displays when you access a form.

In addition to a message, a special handling note also has a status, an assigned priority, and an expiration date. The status of a note can be one of the following:

<table>
<thead>
<tr>
<th>Status</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>The note is active.</td>
</tr>
<tr>
<td>Active notes appear on the Special Handling Notes list or pop-up window.</td>
<td></td>
</tr>
<tr>
<td>Active notes remain on the list until they are set to <strong>Inactive</strong> or <strong>Expired</strong>.</td>
<td></td>
</tr>
<tr>
<td>Active notes remain on the pop-up window until dismissed or until they are set to <strong>Inactive</strong> or <strong>Expired</strong>.</td>
<td></td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Status Table

<table>
<thead>
<tr>
<th>Status</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inactive</td>
<td>The note is no longer active. Users with the sn_shn.admin or sn_shn.editor role can set a note to <strong>Inactive</strong> if the information in the note is no longer useful. When a note is set to Inactive, it is removed from the Special Handling Notes list or pop-up window. Inactive notes can be viewed by navigating to <strong>Special Handling Notes &gt; Special Handling Notes</strong>.</td>
</tr>
<tr>
<td>Expired</td>
<td>The note has reached it's expiration date or it has been expired manually. If a note is expired, the form becomes read-only for all user roles other than the system administrator. A note is expired automatically by a scheduled job when it reaches it's expiration date. The scheduled job also sets any inactive notes to expired if the inactive notes have reached their expiration date.</td>
</tr>
</tbody>
</table>

When creating a special handling note, you can make it effective right away or you can select a date when it becomes effective. You can also select an expiration date.

A note can be assigned one of the following priorities:

- 1 - Critical
- 2 - High
- 3 - Moderate
- 4 - Low

Each priority has an associated color, which is displayed as a colored bar in the pop-up window and as a colored circle in the **Priority** field in a list. The platform interface and the CSM workspace interface use different colors to represent priority.

<table>
<thead>
<tr>
<th>Priority</th>
<th>Platform interface</th>
<th>CSM workspace interface</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - Critical</td>
<td>Red</td>
<td>Red</td>
</tr>
<tr>
<td>2 - High</td>
<td>Orange</td>
<td>Orange</td>
</tr>
<tr>
<td>3 - Moderate</td>
<td>Green</td>
<td>Purple</td>
</tr>
<tr>
<td>4 - Low</td>
<td>Blue</td>
<td>Gray</td>
</tr>
</tbody>
</table>
Special handling notes in the CSM workspace interface

Special Handling Notes

- 1 - Critical
  Urgent issue
  Follow up immediately.

- 2 - High
  Urgent issue reported
  There is an urgent issue reported for this account.

- 3 - Moderate
  Update contact numbers

Special handling notes list
Special handling notes can be displayed on a form in an embedded or related list. Users with the sn_shn.admin role can configure a form to display the Special Handling Notes list. This list appears on a form when there are one or more active notes for a record. The Special Handling Notes list displays the following information for a note:

- Message
- Expiration date
- Priority
- Table

Special handling notes are displayed on the list unless you configure additional properties to display notes in a pop-up window.

Special handling notes pop-up window
Special handling notes can be displayed on a form in a pop-up window. Users with the sn_shn.admin role can configure a form to display the Special Handling Notes pop-up window. This window appears when you access a record that has one or more active notes. The pop-up window displays the following information for each note:
• Message
• Priority

To display special handling notes in a pop-up window, navigate to Special Handling Notes > Properties and set the related properties.

To dismiss a note, click **Dismiss**. Once you dismiss a note, it no longer appears in the pop-up window. To close the Special Handling Notes pop-up window, click **X**.

**Expiring special handling notes**
The **Deactivate Special Handling Notes** scheduled job, which runs daily at midnight, checks the dates in the **Effective on** and **Expires on** fields for each note.

- If a special handling note has reached its **Effective on** date, the scheduled job sets the status of the note to **Active**.
- If a special handling note has reached its **Expires on** date, the scheduled job sets the status of the note to **Expired**.

**Case and account escalation**
Use the escalation feature to highlight specific cases or accounts and raise awareness of important customer issues.

Escalating a case or an account provides the following benefits:
- Increases attention about a customer issue.
- Facilitates communication about that issue.
- Provides a way to track progress toward a resolution.

**Case and account escalation differences**
While the escalation process is similar for cases and accounts, there are some important differences to note.

- **Case escalations**: A customer service agent typically manages a case escalation and works directly with the escalated case to resolve the issue.
- **Account escalations**: An escalation manager typically manages an account escalation, which can include multiple associated cases, and records details in the escalation record.

For more information, see **Case and account escalation differences**.
Configuring case and account escalation

The following table includes an overview of case and account escalation configuration tasks. Users with the system administrator role can perform these tasks.

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure escalation management</td>
<td>Configure case and account escalation using Customer Service Management guided setup.</td>
</tr>
<tr>
<td>Create a case or account escalation</td>
<td>Escalation templates determine how an escalation request is processed, including the type of escalation and an optional approval process.</td>
</tr>
<tr>
<td>template</td>
<td></td>
</tr>
<tr>
<td>Create a case or account escalation</td>
<td>Create definitions for different levels of escalation severity and select color indicators to highlight escalated cases and accounts in the user interface.</td>
</tr>
<tr>
<td>severity</td>
<td></td>
</tr>
</tbody>
</table>

Using case and account escalation

The following table includes an overview of case and account escalation user tasks.

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Escalate a case or an account</td>
<td>Escalate cases or accounts, either on behalf of customers or for internal purposes. Escalating a case or account creates an associated escalation record.</td>
</tr>
<tr>
<td></td>
<td>Role required: escalation requester</td>
</tr>
<tr>
<td>Manage an escalated case or account</td>
<td>Manage a case or account through the escalation process using the escalation record. The system identifies cases and accounts on lists and forms with color indicators that correspond to the escalation severity: red (high) or orange (medium).</td>
</tr>
<tr>
<td></td>
<td>Role required:</td>
</tr>
</tbody>
</table>
## Task and Description

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>De-escalate a case or an account</td>
<td>De-escalate cases or accounts when the cause of the escalation is resolved. Role required: de-escalation requester</td>
</tr>
<tr>
<td>Use an optional escalation approval process</td>
<td>Include an optional approval step for approvers to review a request and either approve or reject an escalation. When using the optional approval step, the system creates the escalation record upon approval and associates it with the case or account.</td>
</tr>
</tbody>
</table>

### Case and account escalation differences

An overview of the differences between case escalations and account escalations.

- **Case escalations**: A customer service agent typically manages a case escalation and performs most of the problem resolution work, which is recorded in the case record. For case escalations, the escalation record is used primarily for status reporting purposes. The escalation SLA is also associated with the case record rather than the escalation record because that is where the agent provides regular updates.

- **Account escalations**: An account escalation manager typically manages an account escalation because it is associated with multiple underlying cases. An account manager works with multiple case owners to resolve the customer escalation and uses the escalation record to consolidate the status of the associated cases and provide regular updates. Therefore, the SLA is associated with the escalation record.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Case Escalation</th>
<th>Account Escalation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relationships</td>
<td>Corresponds one-to-one to a case.</td>
<td>Corresponds one-to-one to an account. Users can link specific cases to the escalation record to</td>
</tr>
<tr>
<td>Feature</td>
<td>Case Escalation</td>
<td>Account Escalation</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>---------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Features</td>
<td>indicate which cases are causing the escalation.</td>
<td></td>
</tr>
<tr>
<td>Templates</td>
<td>Uses case escalation templates.</td>
<td>Uses account escalation templates.</td>
</tr>
<tr>
<td>Approval workflow</td>
<td>Includes an option to automatically add the manager of the case assignment group to the approver list when using the default approval workflow.</td>
<td>Does not include an option to automatically add the manager of the case assignment group to the approver list because an account escalation can be associated with multiple cases.</td>
</tr>
<tr>
<td>Escalation assignment</td>
<td>Does not include a separate assignment. A case escalation corresponds to an individual case and the customer service agent manages the escalation.</td>
<td>Includes a separate assignment. An account escalation can have multiple associated cases that are assigned to different agents so the escalation record includes an Assigned to field. An account escalation is typically assigned to an escalation manager because account escalations are typically more serious than case escalations.</td>
</tr>
<tr>
<td>Watch list</td>
<td>Does not include an option to automatically add an account team to the escalation watch list.</td>
<td>Includes an option to automatically add an account team to the escalation watch list.</td>
</tr>
<tr>
<td>Escalation updates added to case</td>
<td>Updates to the escalation record are also added to the Work notes field on the corresponding case record.</td>
<td>Updates to the escalation record are not added to the account record.</td>
</tr>
</tbody>
</table>
### Case and account escalation process

The case and account escalation process follows several steps from request to completion.

1. A user with the escalation requester role requests an escalation for a case or account. As part of the request, the user provides the following information:
   - The reason for the request
   - Justification for the escalation
   - The escalation severity
   - The escalation template
   - The watch list for the escalation

2. If approval is required, the approval workflow or approvers identified in the escalation template review the request and accept or reject the escalation.

3. Following approval, the agent manages the escalation as it progresses using the escalation form. For example, the agent can add users to the watch list and update the escalation trend.

   **Note:** Updates to the escalation form send email notifications to the current user and to users on the watch list.

4. When the issue has been resolved, a user with the de-escalation requester role can de-escalate a case or an account.

### Case and account escalation components

The roles, modules, and tables installed with the case and account escalation feature.

#### Roles

Roles included with the case and account escalation feature.
### Role and Description

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Escalation requester</td>
<td>Can request an escalation for a case or account.</td>
</tr>
<tr>
<td>(sn_customerservice.escalation_requester)</td>
<td></td>
</tr>
<tr>
<td>De-escalation requester</td>
<td>Can de-escalate a case or account. This role contains the sn_customerservice.escalation_requester role.</td>
</tr>
<tr>
<td>(sn_customerservice.deescalation_requester)</td>
<td></td>
</tr>
</tbody>
</table>

### Escalation modules

The case and account escalation feature adds the Escalations module to the Customer Service menu:

- **All**: lists all escalation records for cases and accounts.
- **Escalation Templates**: lists the case and account escalation templates.
- **Escalation Severity**: lists the types of escalation severity.

This feature also adds a list of escalated cases to the Customer Service menu: **Customer Service > Cases > Escalated**

### Tables

Tables included with the case and account escalation feature:

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Escalation Templates</td>
<td>Stores escalation template records.</td>
</tr>
<tr>
<td>[sn_customerservice_escalation_template]</td>
<td></td>
</tr>
<tr>
<td>Escalations</td>
<td>Stores records created for escalated cases and accounts.</td>
</tr>
<tr>
<td>[sn_customerservice_escalation]</td>
<td></td>
</tr>
<tr>
<td>Escalation Severities</td>
<td>Stores escalation severity definition records.</td>
</tr>
<tr>
<td>[sn_customerservice_escalation_severity]</td>
<td></td>
</tr>
</tbody>
</table>

### Case and account escalation form

Customer service agents use the Escalation form to manage escalations for cases and accounts.

The Escalation form includes information about the escalation, such as the associated case or account, and the reason and justification for the escalation.
It also includes information about the escalation as it progresses, including the trend and notes about the work being done to resolve the issue.

An escalation record can contain one or more associated cases. When updating escalation records, customer service agents can enter comments or work notes. For case escalations, updates are replicated to the case activity history as work notes so they are not visible to the customer.

The Escalation form has a Related Cases related list that includes the related cases for account escalations. The user can associate specific cases using this related list to indicate which cases are causing the escalation. The Escalation form also includes has Task SLAs and Approvers related lists.

### Escalation form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The number automatically assigned to the escalation request.</td>
</tr>
<tr>
<td>Source Record</td>
<td>The case or account for which escalation is requested.</td>
</tr>
<tr>
<td></td>
<td>Note: The case or account form for the source record includes an Escalations related list.</td>
</tr>
<tr>
<td>State</td>
<td>The current state of the escalation:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Requested</strong>: an agent with the escalation requester role has requested an escalation for the case or account.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Escalated</strong>: the escalation request has been approved.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Declined</strong>: the escalation request has been not been approved.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Closed</strong>: the reason for the escalation has been resolved and the escalation has been closed.</td>
</tr>
<tr>
<td></td>
<td>- <strong>De-escalation Requested</strong>: an agent with the de-escalation requester role has requested that an escalation request be removed from the case or account.</td>
</tr>
<tr>
<td>Request Source</td>
<td>The source of the case escalation request:</td>
</tr>
<tr>
<td></td>
<td>- Customer requested</td>
</tr>
<tr>
<td></td>
<td>- Internally requested</td>
</tr>
<tr>
<td>Reason</td>
<td>The reason for requesting the case escalation:</td>
</tr>
<tr>
<td></td>
<td>- Inactivity</td>
</tr>
<tr>
<td></td>
<td>- Lack of Progress</td>
</tr>
<tr>
<td></td>
<td>- Customer Imposed Deadline</td>
</tr>
</tbody>
</table>
**Escalation form fields (continued)**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Watch List</strong></td>
<td>The watch list for this particular escalation record. For account escalations, you can <strong>Add account team members to watch list</strong>. Users added to the watch list for a case, account, or escalation record receive email notification when the case or account has been escalated and when updates are made to the escalation record.</td>
</tr>
<tr>
<td><strong>Assignment group</strong></td>
<td>For account escalations, the assignment group for this account.</td>
</tr>
<tr>
<td><strong>Assigned to</strong></td>
<td>For account escalations, the customer service agent assigned to this account.</td>
</tr>
<tr>
<td><strong>Request By</strong></td>
<td>The user who requested the escalation.</td>
</tr>
<tr>
<td><strong>Approved By</strong></td>
<td>If approved, the user who approved the escalation request.</td>
</tr>
<tr>
<td><strong>Declined By</strong></td>
<td>If declined, the user who declined the escalation request.</td>
</tr>
<tr>
<td><strong>De-escalated By</strong></td>
<td>The user who de-escalated the case or account escalation.</td>
</tr>
<tr>
<td><strong>Escalation Type</strong></td>
<td>The escalation type selected by the user who requested the escalation.</td>
</tr>
<tr>
<td><strong>Escalation Severity</strong></td>
<td>The escalation severity associated with this escalation, which defines the severity level for the escalation and the color used to highlighted the escalated record in the user interface.</td>
</tr>
<tr>
<td></td>
<td>• <strong>High Severity</strong>: escalated records are highlighted in red.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Medium Severity</strong>: escalated records are highlighted in orange.</td>
</tr>
<tr>
<td><strong>Escalation Trend</strong></td>
<td>The current state of the escalation:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Improving</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Same</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Declining</strong></td>
</tr>
<tr>
<td><strong>Escalation Justification</strong></td>
<td>Additional information that explains why this escalation is needed.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Administering case and account escalation

The system administrator creates escalation templates and escalation severity definitions that control the escalation process.

Escalation templates

An escalation template determines how an escalation request is processed. The escalation feature provides two standard escalation templates, one for case escalation and one for account escalation. If needed, the system administrator can modify these templates or create new templates.

An escalation template defines the following information:

- The type of escalation (case or account)
- If approval is required
  - If no, the escalation request is automatically approved.
  - If yes, provide the approver list required by the default approval workflow or provide a different approval workflow.
- The escalation watch list. Users added to the watch list receive email notifications when an escalation record is updated.

Escalation severity

An escalation severity record defines the severity level for the escalation and the color that is used to highlight the escalated case or account record in the user interface. This assigned severity allows agents to easily identify escalated cases and accounts on lists and forms. The escalation feature provides two escalation severity definitions:

- **High Severity**: escalated records are highlighted in red.
- **Medium Severity**: escalated records are highlighted in orange.

The user interface determines which fields are highlighted for escalated cases and accounts:

- **CSM Agent Workspace**: Field indicators and field highlights appear on the Short description field for escalated cases and on the Name field for escalated accounts.

  **Note**: You can move indicators and highlights to any field that is not a hyperlinked field.

- **Platform interface**: Escalated case and account numbers are indicated with a colored dot on a list and a colored background on a form.
In addition to defining the field indicator and field highlight of an escalated case or account, the severity can be used when configuring SLAs. To configure additional escalation severity definitions, the system administrator must configure a new style with the desired color. For more information, see Highlight list fields.

Escalation SLAs

Escalation SLAs are typically used to govern the frequency of updates required for different types and severities of escalations. An escalation SLA is associated with an escalation severity in the SLA definition. When a user creates an escalation request, the selection in the Escalation Severity field determines the SLA for the escalation record.

The escalation feature provides the following case escalation SLAs. On case escalations, because the escalation corresponds one-to-one with a case, the default SLAs are associated with the case:

- **Escalated case response - 4 hours**: de-escalate the case within four hours.
- **Escalated case response - 8 hours**: de-escalate the case within eight hours.

The escalation feature provides the following account escalation SLAs. On account escalations, because the escalation corresponds to an account which typically does not support SLAs, the SLAs are associated with the escalation.

- **Escalated account response - 4 hours**: de-escalate the account within four hours.
- **Escalated account response - 8 hours**: de-escalate the account within eight hours.
The system administrator can configure case and account escalation SLAs that are based on escalation attributes such as the escalation type, severity, and trend.

You can find escalation SLAs in these locations:

- For account records, on the Escalation form in the Task SLAs related list.
- For case records, on the Case form in the Task SLAs related list.

**Manage customer service case types**

You can manage the settings and configuration for a case type from the Case Type form.

After using the Customer Service Management Guided Setup to create and configure a case type, you can view and manage the configuration for the case type from the Case Type form. To access a Case Type form, navigate to Customer Service > Case Types > Manage Case Types and select a case type from the list.

**Case Type form related links**

The Case Type form includes the following related links.

<table>
<thead>
<tr>
<th>Related link</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Case Type Configuration</td>
<td>Displays the current configuration for this case type, including:</td>
</tr>
<tr>
<td></td>
<td>• Business rules</td>
</tr>
<tr>
<td></td>
<td>• Client scripts</td>
</tr>
<tr>
<td></td>
<td>• Dictionary entries and overrides</td>
</tr>
<tr>
<td></td>
<td>• Notifications</td>
</tr>
<tr>
<td></td>
<td>• UI actions</td>
</tr>
<tr>
<td></td>
<td>• Access controls</td>
</tr>
<tr>
<td></td>
<td>• UI policies</td>
</tr>
<tr>
<td></td>
<td>• Data policies</td>
</tr>
<tr>
<td></td>
<td>• Styles</td>
</tr>
<tr>
<td></td>
<td>• View rules</td>
</tr>
<tr>
<td></td>
<td>• Flows</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Launch Guided Setup for Case Types
Goes to the Case Types setup tasks in Customer Service Management Guided Setup.

Launch Guided Setup for AWA
Goes to the Advanced Work Assignment (AWA) setup tasks in Agent Workspace Guided Setup.

Launch Guided Setup for Agent Workspace
Goes to the Agent Workspace for CSM setup tasks in Customer Service Management Guided Setup.

**Case Type form related lists**
The Case Type form related lists display items configured for the case type table. Use the related lists to create additional configurations.

- Record Producers
- State Flows
- Special Handling Notes
- SLAs
- Email Templates
- Quick Messages
- Reports
- Case Type Selections

**Select an optional category and subtype for a case type**
The system administrator can assign an optional category and a subtype to a case type. When creating a case, agents can filter the available case types by category and subtype in the Select Case Type pop-up window. If an agent selects a category, the list of case types displayed are filtered by that category. If an agent selects a subtype, the list is further filtered by that subtype.

The Customer Service Case Types plugin includes several categories that the system administrator can select for a case type. These categories include:

- Onboarding
- Complaint
- Orders
- General
The **Subtype** field displays fields from the Case Type table that are of the following type:

- Choice list
- Reference

To select a category and a subtype for a case type:

1. Navigate to **Customer Service > Case Types > Manage Case Types** and click a case type.
2. Select a category in the **Category** field.
3. Select a field in the **Subtype** field.
4. Click **Update**.

**Case types in CSM Agent Workspace, CSM Configurable Workspace, and the platform interface**

Customer service agents can use the case types feature in CSM Agent Workspace, CSM Configurable Workspace, and the platform interface.

To make a case type available for selection with the **Create Case UI** action in the CSM workspaces requires one additional configuration step. The system administrator must enable the **Available in Workspace** field on the Case Type form.

⚠️ **Note:** This field applies only to the CSM workspaces. All case types are available for selection in the platform interface regardless of the setting in the **Available in Workspace** field.

**Case types and major cases**

The system administrator can enable the **Propose Major Case UI** action for different case types. If this UI action is available, an agent can propose a major case from the selected case type record. If the major case candidate is accepted, a major case is created and the case type record is added as a child case on the major case.

The major case is created on the base Case table. Updates to the major case are synchronized to the child case types. Multiple case type records can be added to the same major case.

**Enable the case type single select property**

Enable the case type single select property so that customer service agents can use the case type single select option and create cases of a specific type with one click.
Before you begin
Role required: admin

About this task
In CSM Configurable Workspace, there are two options available to agents when creating cases of a specific type.

• With the multi select option, the agent selects a case type and optionally selects a category and subtype to narrow the available choices before creating a case. This is the default functionality.

• With the single select option, the agent selects a case type and creates a case. The system populates some of the fields on the Case form with values that have been predefined in the selection configuration.

To use the single select option, enable the sn_csm_case_types.case_type_single_field_select property. You must also configure the selections that are available in the Select Case Type pop-up window.

Procedure
1. Navigate to sys_properties.list.
2. Click the sn_csm_case_types.case_type_single_field_select property in the Name field.
3. Set the Value to true.
4. Click Update.

Related information
Create a configuration for the case type single select option

Create a configuration for the case type single select option
Create a configuration for the case type single select option and define the fields and values that the system uses to auto-populate the Case form.

Before you begin
Role required: admin

About this task
In CSM Configurable Workspace, there are two options available to agents when creating cases of a specific type.
• With the multi select option, the agent selects a case type and optionally selects a category and subtype to narrow the available choices before creating a case. This is the default functionality.

• With the single select option, the agent selects a case type and creates a case. The system populates some of the fields on the Case form with values that have been predefined in the selection configuration.

To use the single select option, follow the procedure below to configure one or more selections that are available to agents in the Select Case Type pop-up window. You must also enable the `sn_csm_case_types.case_type_single_field_select` property.

**Procedure**

1. Navigate to Customer Service > Case Types > Manage Case Types.
2. Select a case type.
3. In the Case Type Selections related list, click **New**.
4. In the **Name** field, enter a descriptive name for the case type selection. This is the name that agents see in the **Case Type** field on the Select Case Type pop-up window.
5. In the **Default case type field values** fields, select the desired fields and the corresponding values.
   The system uses this field and value configuration to auto-populate those fields on the Case form when an agent creates a case of this type.
6. Click **Submit**.
   The system saves the configuration in the Case Type Selections (sn_case_type_selection) table and adds it to the Case Type Selections related list.
7. Repeat steps 3 through 6 to create additional selections.

**Related information**

 Enable the case type single select property

**Case action status overview**

Use the case action status feature to indicate the status of cases in the Case list. With this feature, customer service agents can easily identify cases that need attention and quickly prioritize their work.

Visual indicators in the **Action Status** column on the Case list highlight case status:
• A blue indicator highlights cases that need attention, such as cases that have been updated by customers or internal users and are waiting for input or review. In CSM Agent Workspace, cases that need attention also use a blue field highlight.

• A red indicator highlights cases that are blocked, such as cases that have open related task records or are waiting for customer feedback. In CSM Agent Workspace, cases that are blocked also use a red field highlight. Blocked cases can have the following status:
  ◦ Blocked internally
  ◦ Blocked by customer
  ◦ Blocked internally and by customer

In addition to the colored indicators, the **Action Status** column also displays a brief status message.

The case action status feature uses actionable case flows to automatically determine the action status for customer service cases. These flows create and resolve blocking tasks for different case-related actions and update the action status indicators. Certain agent actions trigger these case flows, which in turn create and resolve the blocking tasks.

Customer service agents and managers can also manually set the action status for cases by enabling the **Needs Attention** field on the Case form.

**Related information**

**Activate Case Action Status**

**Actionable case flows**

Actionable case flows contain predefined user actions that automatically create and resolve blocking tasks for customer service cases.

The Case Action Status plugin provides several actionable case flows that create and resolve blocking tasks for different case-related actions. These flows are enabled by default. If you do not want to create blocking tasks for a specific action, you need to disable the associated flow.

To view these flows, navigate to **Customer Service > Administration > Actionable Case Flows**.

**Flow Designer actions**

Case flows use the following predefined Flow Designer actions:
• Add Blocking Task
• Inactivate Blocking Task
• Set Needs Attention Flag

**Flows for customer service cases**
The case action status feature provides the following flows for customer service cases.
• Create blocked by record if case needs customer information
• Create blocked by record if Case Task is associated with case
• Create blocked by record if Change Request is associated with case
• Create blocked by record if SC Request is associated with case
• Create blocked by record if Work Order is associated with case
• Create blocked by record if Incident is associated with case
• Create blocked by record if Problem is associated with case
• Resolve blocked by record if Case Task is closed
• Resolve blocked by record if Change Request is closed
• Resolve blocked by record if Incident is closed
• Resolve blocked by record if Problem is closed or Fix is communicated
• Resolve blocked by record if Problem is closed or Fix/Workaround is communicated
• Resolve blocked by record if SC Request is closed
• Resolve blocked by record if user information is provided for case
• Resolve blocked by record if Work Order is closed or cancelled
• Set Needs Attention if additional comments are added by others
• Set Needs Attention when case is commented by others
• Update case when blocked by record is created
• Update case when Needs attention field is toggled

**Flows for customer service orders**
The case action status feature provides the following flows for customer service orders.
• Create blocked by record if order case needs customer information
• Resolve blocked by record if user information is provided for order case
• Set Needs Attention if additional comments are added by others on order case
• Update order case when Needs attention field is toggled

**Flows for problem records associated to a case**
If a problem is associated to a case with the **Need task resolution** blocking reason, a case flow is provided that resolves the blocking task when a fix is communicated or the problem record is closed or cancelled.

If a problem is associated to a case with the **Need PRB workaround** blocking reason, a case flow is provided that resolves the blocking task when a workaround is provided or the problem record is closed or cancelled.

**Blocking tasks**
Certain agent actions trigger case flows which create and resolve blocking tasks for customer service cases. These tasks determine the case action status.

When an agent performs certain actions, such as asking a customer for more information or associating a problem with a case, the system:
• Adds a blocking task to the case. This task appears on the Case form in the **Blocked by** form section.
• Updates the **Action Status** field on the Case form and Case list.

Additionally, there are actions that resolve these blocking tasks, such as the customer responding to an agent’s question or an internal user resolving a problem task. When one of these actions occur, the system:
• Updates the status of the blocking task on the Case form.
• Updates the **Action Status** field on the Case form and Case list.
• Enables the **Needs Attention** field on the Case form.

**Actions that create blocking tasks**
The following actions create blocking task for customer service cases:
• The agent sets the state of the case to **Needs More Information**.
• The agent associates one of the following to the case:
  ◦ Problem
  ◦ Request
  ◦ Change
  ◦ Incident
Actions that resolve blocking tasks
The following actions resolve blocking tasks for customer service cases:

- A customer provides the requested information.
- A fix or a workaround is associated with a related problem record.
- A related problem, request, change, or incident record is resolved.
- A related case task or work order is closed or cancelled.

Needs attention field
When the Needs attention field on the Case form is enabled, the Action Status column on the Case list displays a blue indicator.

The Needs attention field is enabled automatically when:

- A blocking task for a case is resolved.
- A customer or someone other than the case owner comments on a case.
- A work note is added to a case that is a child of a major case.

Customer service agents and managers can manually enable the Needs attention field if information is required from customers or internal users. This field can be disabled only by the agent assigned to the case or by the customer service manager or admin.

Case action status and major issue management
When using the case action status feature with major issue management, the following actions enable the Needs attention field for a major case:

- A customer provides comments for a case that is a child of a major case.
- An agent adds a work note to a case that is a child of a major case.

Blocked by related list
Blocking tasks that are created for a case are added to the Blocked by related list. Each blocking task is assigned one of the following blocking reasons:

- Need information from the customer
- Need task resolution
- Need PRB workaround
- Other
When a blocking task is created:

- The **Unblocked By** field displays the user who performed the unblocking action.
- The **Unblocked On** field displays the date that the blocking task was resolved.

**Blocking Tasks table**

Records that have blocking tasks are stored in the Blocked By table [sn_action_status_blocked_by]. Records are periodically removed from this table. Six months after a blocked record is closed, the entries in the Blocked By table related to the blocked record are removed.

**Case action status analytics**

The Customer Service Manager dashboard displays the percentage of the case backlog that is waiting for an agent response, customer input, or a response for other users.

The dashboard includes the **Blocked open cases** widget which breaks down the remaining work to show cases that are with the following users:

- Agent
- Customer
- Other Internal Stakeholder

As blocking tasks for a case get created and resolved, this dashboard widget tracks the case time spent with each of these users. The breakdown is set for:

- Blocked internally
- Blocked by customer
- Blocked internally and by customer

**Case action status logging**

Logging for the case action status feature uses a metric definition to view information about blocking tasks associated with customer service cases.

Defined metrics can track how long a specific field holds a certain value. The **Case Actor Duration** metric definition logs the events related to case blocking tasks.
When a case blocking task is created or resolved, the system logs the information. This information can be used to report on the duration of the case with the customer, the agent, or other internal stakeholders.

As a case gets blocked and unblocked by a customer or an internal user, the metric definition tracks the duration of the case with each of these actors.

The metrics include:

- Case number
- Metric definition
- Value
  - Needs attention
  - Blocked by customer
  - Blocked internally and by customer
- Start and end times
- Duration

**Major issue management overview**

Major issue management enables customer communication for issues that impact a wider audience. Use this feature to proactively identify impacted customers, provide information to these customers, and manage the resolution process.

This feature enables you to efficiently manage the communication and resolution process for issues that impact multiple customers. With major issue management, you can identify impacted customers who have not yet reported an issue and proactively create cases for these customers.

Major issue management introduces the concept of a major case which contains the details about a particular issue. Child cases can easily be created for a major case, with one child case created for each customer affected by the issue. These child cases contain the customer-specific information.

Identify affected customers by creating a recipients list of accounts or consumers and attaching it to the major case. Create this list using the Targeted Communications application. Build a recipients list by identifying dynamic conditions, running a script, or importing customer information into a template. Once attached to a major case, use the recipients list to create a child case for each customer included in the list.

A major case is created in one of two ways:
• A customer service manager can create a major case.
• A customer service manager or major issue manager can promote a major case candidate.

Major case candidates are created either by promoting an existing customer service case (for customer reported issues) or by creating a candidate case directly (for non-customer reported issues). Candidate cases require approval before being promoted to major cases.

Major issue management also provides properties that enable automatic synchronization from a major case to the associated child cases. Use these properties to enable synchronization and to identify the synchronized fields.

Major Issue Management menu can be used in the Now Platform interface and in the Agent Workspace interface.

Identifying issues and creating major cases
Customer service agents, managers, and major issue managers can use the following process to identify potential issues, create major cases, and identify impacted customers.

1. Create a major case candidate or flag an existing customer service case as a major case candidate.

2. Review the major case candidate and either approve it as a major case or reject it.
   • If approved, the candidate case becomes a child case of the major case.
   • If rejected, the candidate case returns to a normal case.

3. Associate other cases reported for the same issue as child cases of the major case.

4. Identify other customers impacted by the issue by creating a recipients list and attaching it to the major case.

5. Create child cases for the customers included in the recipients list.

6. Manage the issue to resolution using the major case.
   • Update the major case as needed, which automatically updates the child cases.
   • Close the major case when the issue is resolved. Closing the major case automatically closes all the child cases.
**Major, candidate, and child cases**

Major issue management uses major case candidates to identify potential customer issues. Approved candidate cases become major cases, which you can use to manage issues to resolution. Child cases are created for customers impacted by an issue and are associated with a major case.

**Major cases**

A major case contains information about a specific issue that impacts customers. It is not associated with any accounts, contacts, or consumers. This customer-specific information resides in the associated child cases.

The recipients list associated with the major case identifies customers impacted by the issue. Select a list in the **Affected Customers** field in the Major Case Information form section of the Major Case form. After adding the list, you can automatically create child cases for all customers on the list. These cases are added to the **Child Cases** related list on the major case form.

With synchronization enabled, updates to a parent case are automatically synchronized to the associated child cases. When a major case is closed, the associated child cases in the following states are also closed: New, Open, Awaiting Customer Info.

To identify major cases in the list view, check the value in the **Major case state** field.

- Major cases have a state of Accepted.
- Major case candidates have a state of either Proposed or Rejected.
- Regular cases have a blank value.

In the form view, major cases and major case candidates display the Major Case Information form section.

⚠️ **Note:** Related links on a major case form do not synchronize to associated child cases.

**Major case candidates**

A customer service agent uses a candidate case to flag an issue that may be a wider problem impacting multiple customers. An agent can create a major case candidate:

- By promoting an existing customer service case with a reported issue.
- By creating a major case candidate directly.
A major case candidate requires the approval of the customer service manager or major case manager before being promoted to a major case. When a major case candidate is approved, a major case is created.

- If the major case candidate was promoted from an existing case, a major case is created and the candidate case becomes a child case of that parent.
- If the major case candidate was created directly, that same case becomes the major case.

If a major case candidate is rejected, it reverts to a regular case.

**Child cases**

Child cases are associated with a major case. One child case is created for each account (B2B) or consumer (B2C) impacted by the major case issue. Child cases are created from the recipients list on the major case and can also be added manually by the major issue manager.

When child cases are created, the short description from the major case is copied to each of the child cases. Duplicate child cases are not created. If a child case already exists for an account or consumer, it is not created again.

As child cases are created, you can enter text in a pop-up window that is added to the **Additional comments** field on the child case form. These comments are added only to the newly created child cases. The major case and any existing associated child cases are not updated.

The primary contact for an account is the contact on the child case and is automatically added to the child case watchlist.

**Synchronization between major cases and associated child cases**

The system administrator can set system properties that enable or disable the synchronization between the major case and associated child cases and also define the fields to synchronize. Synchronization occurs from the major case to the child cases. If the state of a child case is Resolved, Closed, or Canceled, the synchronization does not take place.

A major case and the associated child cases maintain synchronization on the fields identified by the `sn_customerservice.case_fields_to_sync` property. This property specifies the list of fields to synchronize from the major case to the associated child cases. By default, these fields include:

- Priority
- State
- Comments
• Work notes
• Close notes
• Resolution code

If the State field is synchronized from the major case to the child cases, the Close notes and Resolution code fields must also be synchronized.

⚠️ Note: Child cases can be manually added to a major case at any time. There is no retroactive synchronization for newly added child cases.

When synchronization is enabled, saving changes to a major case results in a pop-up window. Verify the update by clicking OK.

Recipients lists
Use recipients lists that contain account or consumer information to create the child cases for a major case.

Major issue managers and customer service managers can select the desired list in the Affected Customers field on the Major Case form. Clicking Create Child Cases then creates a child case for each account or consumer in the recipients list.

Managers can change the recipients list before child cases are created. After child cases are created, the Affected Customers field becomes read only.

Creating recipients lists
Recipients lists are created using the Targeted Communications application. With this application, managers can select the type of list to create and the method used to create the list: by uploading files, selecting dynamic conditions, or using scripts.

The Targeted Communications application creates several types of recipients lists, including accounts, contacts, consumers, and internal users. The recipients list for a major case must be of type accounts or consumers. Recipients lists are limited to one specific type and cannot contain mixed types, for example accounts and consumers.

⚠️ Note: The Major Issue Management plugin is dependent on the Targeted Communications plugin. If Targeted Communications is active, recipients lists can be created for internal users. If Targeted Communications and Customer Service Management are both active, recipients lists can also be created for accounts, contacts, and consumers.
Manually editing a recipients list

Major issue managers and customer service managers can manually add or remove accounts or consumers from a recipients list by navigating to the Recipients List form, clicking **Edit** in the **Recipients** related list, and then using the arrows to add or remove records.

The **Recipients** related list includes the **Dynamically Added** column which displays either True or False, depending on how a record was added:

- True for records that are dynamically generated, either by using the condition builder or by running a script.
- False for records that are added manually, either by using the **Edit** button on the **Recipients** related list or by file upload.

The **Active Communication** column is set to True by default for both dynamically and manually added records. This field indicates whether or not the recipient requires active communication.

**Refreshing a recipients list**

Refresh a recipients list by clicking **Refresh Recipient List** on the Recipients List form. For major issue management, the following guidelines apply to refreshing a recipients list:

- Refreshing a recipients list does not impact manually created records.
- If you remove a manually created record from a recipients list, it does not reappear when the list is refreshed unless it meets the dynamic conditions used to filter the list.
- If you remove a dynamically generated record from a recipients list, it may reappear when the list is refreshed if it meets the dynamic conditions used to filter the list.
- If the **Active Communication** field is set to false for a record, this setting does not change when a recipients list is refreshed.
- If created using the Upload File method, you do not need to refresh the recipients list.

**Related information**

- Create a recipients list

**Major Case form view**

Major issue management provides the Major Case form view, which includes the Major Case Information form section and the Child Cases related list.
The Major Case form view does not display account-related information because a major case is not linked to a specific account, contact, or consumer. This information is stored in the child cases associated with a major case.

**Major Case Information form section**
Major cases and major case candidates include the Major Case Information form section which includes the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Major case state</td>
<td>A major case can be in one of these states:</td>
</tr>
<tr>
<td></td>
<td>• Proposed: the initial state when a candidate case is created or proposed by an agent or manager.</td>
</tr>
<tr>
<td></td>
<td>• Accepted: the Initial state when a major case is created by a manager or when a candidate case is promoted by a manager.</td>
</tr>
<tr>
<td></td>
<td>• Rejected: the candidate case is rejected by a manager.</td>
</tr>
<tr>
<td></td>
<td>• Cancelled: the case is cancelled.</td>
</tr>
<tr>
<td>Business impact</td>
<td>The business impact of the issue identified in the major case.</td>
</tr>
<tr>
<td>Probable cause</td>
<td>The probable cause of the issue identified in the major case.</td>
</tr>
<tr>
<td>Affected Customers</td>
<td>The recipients list selected for the major case. Child cases are created for the accounts or consumers included in the recipients list. This field is only visible when the major case state is Accepted.</td>
</tr>
</tbody>
</table>

Customer service agents can update the Business impact and Probable cause fields as well as add work notes. Major issue managers can update the Business Impact and Probable Cause fields and attach a recipients list. The Affected Customers field is only visible when the major case state is Accepted.

The Work notes field on the major case form is updated when a major case is proposed or a candidate case is created manually. The Work notes field on associated child cases is updated when a major case is accepted.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
When a major issue manager rejects a candidate case, the **Major Case State** field is set to Rejected and the **Work notes** field is updated with the case state. The candidate case reverts to a regular case.

**Child Cases related list**

Major issue management adds the **Child Cases** related list to the Customer Service Case form. All child cases associated with a major case are added to this list. Child cases are created automatically from the recipients list and can also be added or removed manually.

**Propose a case as a major case candidate**

Users with the customer service agent role can propose an existing customer service case as a major case candidate.

**Before you begin**

Role required: sn_customerservice_agent, sn_customerservice.consumer_agent, sn_customerservice_manager, sn_majorissue_mgt.major_issue_manager

**About this task**

Cases in these states can be proposed as a major case candidate:

- New
- Open
- Awaiting Info

Cases that are Resolved, Closed, or Canceled cannot be proposed as a major case candidate.

When proposing a case as a major case candidate, agents can specify the reason or justification for the case in the Propose Major Case popup window. Information provided in the **Work notes** and **Business Impact** fields are added to the Case form.

Users with the major issue manager role receive a notification email when a case is proposed as a major case candidate. These users can click the link in the notification email to open the major case candidate in the platform interface.

ℹ️ **Note:** You can also propose a case as a major case on Agent Workspace.

**Procedure**

1. Navigate to the desired customer service case.
2. Click **Propose Major Case** in the Additional Actions menu on the Case form.
3. In the Propose Major Case pop-up window, enter a reason for the proposal in the **Work notes** field. If desired, enter the business impact of the selected case in the **Business Impact** field.

   This information is added to the Case form in the **Work notes** field and the **Business Impact** field in the Major Case Information section.

4. Click **Propose**.

   An entry is added to the **Work notes** on the Case form that the case was proposed as a major case candidate. The information entered in the Propose Major Case pop-up window is also added to the Case form.

---

### Create a major case candidate

Users with the customer service agent role can create a major case candidate.

#### Before you begin

_role required:_ sn_customerservice_agent, sn_customerservice.consumer_agent, sn_customerservice_manager, sn_majorissue_mgt.major_issue_manager

#### About this task

Users with the major issue manager role receive a notification email when a major case candidate is created. These users can click the link in the notification email to open the major case candidate in the platform interface.

> **Note:** All major case candidates are automatically created as proactive cases as they are created internally and on behalf of the customer. To leverage the full capabilities of Proactive Customer Service Operations, install the Proactive Operations Management (com.snc.proactive_cs_ops) plugin.

   You can also create a major case candidate from Agent Workspace.

#### Procedure

1. Navigate to **Major Issue Management > Create Major Case Candidate**.
2. Enter a description in the **Short description** field.
3. In the Major Case Information form section, enter the relevant information in the **Business impact** and **Probable cause** fields.
4. Click **Submit**.

### Approve or reject a major case candidate

Users with the major issue manager role can approve or reject a major case candidate.
Before you begin  
Role required: sn_customerservice_manager, sn_majorissue_mgt.major_issue_manager

About this task  
You can also approve or reject a major case candidate from Agent Workspace.

Procedure  
2. Select the desired candidate case.  
3. Select one of the following from the Case form context menu.  

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Approve Major Case Candidate | Approves the current major case candidate as a major case.  
Upon approval:  
• If the candidate case was proposed from an existing case, a major case is created and the candidate case becomes a child case of that major case.  
• If the candidate case was created directly, the candidate case becomes the major case. |
| Reject Major Case Candidate | Rejects the current major case candidate as a major case.  
If rejected, provide a reason for rejecting the case in the Rejection Reason pop-up window. This information is added to the Work notes on the Case form. |

4. Click Update.

Create a major case  
Users with the customer service manager role can create a major case.  

Before you begin  
Role required: sn_customerservice_manager
About this task
You can also create a major case from the Agent Workspace.

Procedure
1. Navigate to Major Issue Management > Create Major Case.
2. Fill in the fields on the Case form.
3. In the Major Case Information form section, fill in the Business impact and Probable case fields.
4. Click Submit.

What to do next
You can view all cases by navigating to Customer Service > Cases > Proactive.

Create child cases for a major case
Users with the customer service manager role can create a child case for each of the customers included in the major case recipients list.

Before you begin
Role required: sn_majorissue_mgt.major_issue_manager, sn_customerservice_manager

About this task
The Create Child Cases button on the Major Case form creates a child case for each account or consumer in the recipients list selected in the Affected Customers field. If a child case for an account or consumer already exists, the system does not create a duplicate child case.

Note: Use caution when selecting the recipients list for a major case. Selecting the wrong recipients list can have a serious impact by creating a large number of cases for incorrect accounts or consumers. Ensure that you have selected the correct recipients list before clicking Create Child Cases.

You can also create child cases for a major case from Agent Workspace.

Once child cases have been created, you cannot change the recipients list. Any additional recipients must be added manually. After manually adding recipients to the list, click Create Child Cases again to create child cases for these new recipients.

Creating child cases copies information from the major case to each of the child cases. The field values that are copied to the child cases are identified by the sn_customerservice.case_fields_to_sync system property.
Procedure
1. Open the desired major case.
2. In the Major Issue Management form section, select a recipients list in the Affected Customers field.
3. Click Update.
4. Click Create Child Cases.
5. In the Create Child Cases pop-up window, enter information about the major case. This information is added as additional comments to each of the newly created child cases. If child cases for this major case already exist, these child cases are not updated.
6. Click Continue. The child cases are created and added to the Child Cases related list.

Related information
Recipients lists

Add an existing case as a child to a major case
Users with the customer service manager role can add an existing customer service case as a child to a major case.

Before you begin
Role required: sn_majorissue_mgt.major_issue_manager, sn_customerservice_manager

About this task
Identify and narrow a list of cases, then select the desired case or cases to add to the major case.
- Filter and narrow down the child case list.
- Select one or more cases and add as child to major case.
- Add work notes/activity log when a parent is added or removed

Messages on pop-up window:
You can also create child cases for a major case from Agent Workspace.
Procedure

1. Open the desired major case.

2. In the Child Cases related list, click Add to display the Add Child Cases pop-up window.
   The Add Child Cases pop-up window displays a list of customer service cases that are not major cases.

3. Optional: Use the filters to narrow the list of cases displayed in the window.

4. Select the cases to add to the major case by enabling the check box for each case.

5. Click Submit.
   The system evaluates the selected cases and adds none, some, or all of the cases to the Child Cases related list. A message on the major case form informs the user of the results by displaying one of the following:
   • No selected cases were added as child cases.
   • (x) of (y) selected cases were added as child cases.
   • All (y) selected cases were added as child cases.
   A work note is added to the Activities field for each child case added to the major case.

Related information

Recipients lists

Components installed with Major Issue Management

Several types of components are installed with the major issue management feature.

Roles installed with Major Issue Management

Major Issue Management provides these roles.

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains Roles</th>
</tr>
</thead>
</table>
| Major issue manager [sn_majorissue_mgt.major_issue_manager] | Users with this role can:  
  • Create major cases  
  • Approve or reject major case candidates | • sn_customerservice_agent  
• sn_customerservice_consumer_agent  
• sn_publications_recipients_user  
• sn_publications_recipients_list_user |
<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains Roles</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Add or remove child cases from major cases</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Add or remove impacted accounts (B2B) or consumers (B2C)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The customer service manager role [sn_customerservice_manager] contains the major issue manager role.</td>
<td></td>
</tr>
</tbody>
</table>

### Properties installed with Major Issue Management

Major Issue Management provides these properties.

To access these properties, navigate to **Customer Service > Administration > Properties**.

> **Note:** To open the System Property [sys_properties] table, enter `sys_properties.list` in the navigation filter.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synchronize fields from parent to child case sn_customerservice.parent_child_case_sync</td>
<td>Enable this property to synchronize fields to associated child cases.</td>
</tr>
<tr>
<td>• Type: true</td>
<td>false</td>
</tr>
<tr>
<td>• Default value: false</td>
<td></td>
</tr>
<tr>
<td>• Location: <strong>Customer Service &gt; Administration</strong></td>
<td></td>
</tr>
<tr>
<td>Comma-separated list of fields that synchronize from parent case to child cases sn_customerservice.case_fields_to_sync</td>
<td>Specifies the list of fields to synchronize from the major, or parent, case to the associated child cases.</td>
</tr>
<tr>
<td>• Type: string</td>
<td></td>
</tr>
<tr>
<td>• Default value: priority,state,comments,work_notes,assigned_to,close_notes,resolution_code</td>
<td></td>
</tr>
<tr>
<td>• Location: <strong>Customer Service &gt; Administration</strong></td>
<td></td>
</tr>
<tr>
<td>Processes SLA asynchronously during parent to child case creation and synchronization</td>
<td>Enables major issue management to process SLA asynchronously during child case creation and parent-to-child synchronization.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| sn_customerservice.parent_child_case_sla_async | • Type: true | false  
|  | • Default value: true  
|  | • Location: Customer Service > Administration |

**Automatically close customer service cases**

Customer service cases in the **Resolved** state can be closed automatically if customers do not take any action.

This feature uses the **Auto Close Resolved Cases** Flow Designer flow.

ℹ️ **Note:** This flow is not active by default.

The **Auto Close Resolved Cases** Flow Designer Flow identifies cases in the **Resolved** state that are waiting for a customer response and takes the following actions:

- Sends a reminder notification to the customer after 5 days with no response that the case is pending solution acceptance.
- Closes the case and sends a reminder notification to the customer after 10 days that the case has been auto closed.

The notifications are added to the **Additional comments** field on the Case form.

The system administrator can enable the **Auto Close Resolved Cases** flow and configure the timing of the reminder notifications. The default settings include two notifications that are sent at 5 days and 10 days after a case has been resolved. The system administrator can also create additional notifications to the flow.

The system administrator can also create a configuration that enables both the system and agents to exclude cases from auto closure.

**Using the Auto Close field on the Case form**

Customer service agents can use the **Auto Close** field on the Case form to exclude cases from auto closure. This field is hidden by default. To use this field, configure the Case form to display the **Auto Close** field.

**Configuring business rules for auto closure**

The system administrator can configure business rules to enable or disable the **Auto Close** field on the Case form.
<table>
<thead>
<tr>
<th>Business Rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mark for Auto Close</td>
<td>Use this business rule to configure when the system sets the Auto Close field to true. The default configuration is as follows:</td>
</tr>
<tr>
<td></td>
<td>• The case status is Resolved.</td>
</tr>
<tr>
<td></td>
<td>• The Needs attention field on the Case form is false.</td>
</tr>
<tr>
<td></td>
<td>• The case is not escalated.</td>
</tr>
<tr>
<td></td>
<td>• The account is not escalated.</td>
</tr>
<tr>
<td>Clear Auto Close</td>
<td>Use this business rule to configure when the system automatically sets the Auto Close field to false. The default configuration is as follows:</td>
</tr>
<tr>
<td></td>
<td>• If the solution is rejected and the case status returns to Open.</td>
</tr>
</tbody>
</table>

**Related information**

**Flow Designer**

**Notifications for resolved cases**

Customers receive notifications about resolved cases that will be automatically closed if no action is taken.

When an agent proposes a solution for a customer service case, the customer has a time window in which to accept or reject the solution. If the customer does not take action within this window, the case is automatically closed.

The system administrator can configure the settings for the notifications that are sent to the customer. The default settings include two notifications that are sent at 5 days and 10 days after a case has been resolved.

- After 5 days, the customer receives a reminder message about the resolved case on the Customer Service Portal: **This case is pending solution acceptance. It will be auto closed if you do not take action.**
- If the customer does not take any action after 10 days, the system automatically closes the case and adds the following message to the case: **This case was auto closed.**

For more information, see [Automatically close customer service cases](#).
Setting up Engagement Messenger

Understand the stages involved in setting up Engagement Messenger before you add it to your customer service web portal.

After you install Engagement Messenger application in your instance, you are ready to configure it.

The configuration process involves the following tasks:

1. **Install the Engagement Messenger application** from the ServiceNow® Store.

2. Create Engagement Messenger module. Next, you can do the following:
   - Configure the theme and styling of how Engagement Messenger appears to your customers
   - Configure how Engagement Messenger behaves when your customer uses it
   - Configure how Engagement Messenger works for your customers
   
   See Configure Engagement Messenger.

3. Create identity providers to enable authenticated user experience. For information, see Create an identity provider (IdP) for Engagement Messenger.

   If you want to enable only a guest user experience for your customer service portal, you can ignore this step and move on to step 4.

4. Create cross-origin resource sharing (CORS) rules for the REST API. For information, see Configure a CORS rule for Engagement Messenger.

5. Add HTTP response headers for your Engagement Messenger. For information, see Create HTTP response headers for Engagement Messenger.

6. Configure the system properties to enable virtual agent chat, multi-provider SSO, and to set a user session time-out value. For information, see Configuring system properties for Engagement Messenger.

7. (Optional) Configure Engagement Messenger in the safari browsers. For more information, see [https://community.servicenow.com/community?id=community_article&sys_id=ff764dc2db4b3cd480073ca8f496192e](https://community.servicenow.com/community?id=community_article&sys_id=ff764dc2db4b3cd480073ca8f496192e).

8. Activate Engagement Messenger module that you configured. For information, see Activate an Engagement Messenger module.

9. Embed your Engagement Messenger module code into your website. For information, see Embed Engagement Messenger in your web application.

Install the Engagement Messenger application

Install the Engagement Messenger application from the ServiceNow Store if you have the admin role.
Before you begin
Ensure that the application and all of its associated ServiceNow Store applications have valid ServiceNow entitlements. For more information, see Get entitlement for a ServiceNow product or application.

Role required: admin

Procedure
1. Navigate to System Applications > All Available Applications > All.

2. Find the Engagement Messenger application (sn_csm_ec) using the filter criteria and search bar.
   You can search for the application by its name or ID. If you can't find the application, you might have to request it from the ServiceNow Store.
   Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.

3. In the Application installation dialog box, review the application dependencies.
   Dependent plugins and applications are listed if they will be installed, are currently installed, or must be installed. If any plugins or applications must be installed, you must install them before you can install the Engagement Messenger application.

4. Optional: If demo data is available and you want to install it, click Load demo data.
   (Optional) Demo data comprises sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.
   **Important:** If you don’t load the demo data during installation, it’s unavailable to load later.

5. Click Install.

Results
The following items are installed with Engagement Messenger:

- Plugins
- Roles
- Tables
For more information, see Components installed with Engagement Messenger.

What to do next

• If you want to enable Virtual Agent chat support in the Engagement Messenger, activate the Glide Virtual Agent plugin (com.glide.cs.chatbot).
  For more information, see Activate Virtual Agent.
• Get started with Engagement Messenger. For more information on how to get started, see Setting up Engagement Messenger.

Configure Engagement Messenger

Create Engagement Messenger module and configure its behavior, appearance, and styling. By creating a messenger module, you can customize the appearance and behavior according to your organizational branding and to suit your customer needs.

Before you begin

• Install the Engagement Messenger application.
• Gather or prepare the following items:
  ◦ Image files for your logo and messenger launcher icon. The images must be in .jpg, .png, .bmp, .gif, .jpeg, .ico, or .svg file format.
  ◦ Color names and hex codes for branding to configure the styling of the messenger user interface.
• Role required: sn_csm_ec.ec_admin

Procedure

1. Navigate to Engagement Messenger > Modules.
2. Choose to create Engagement Messenger module or edit an existing module.
   • To create a module, click New.
   • To edit an existing module, click Edit in the Edit module column of your messenger module.
     The guided configuration view is displayed.
3. In the guided configuration view, navigate through the five steps (Module, Appearance, Behavior, Features, and Implement).
4. On the form, fill in the fields.
### Engagement Messenger module form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Module</strong></td>
<td></td>
</tr>
<tr>
<td>Module name</td>
<td>Unique name for your messenger module.</td>
</tr>
<tr>
<td>Short description</td>
<td>Brief description of the messenger module.</td>
</tr>
<tr>
<td><strong>Appearance</strong></td>
<td></td>
</tr>
<tr>
<td>Logo</td>
<td>Logo that is displayed in the header of the messenger on your website.</td>
</tr>
<tr>
<td></td>
<td>The recommended size and dimensions are:</td>
</tr>
<tr>
<td></td>
<td>• Size (in bytes): approximately equal to 2 KB</td>
</tr>
<tr>
<td></td>
<td>• Height (in pixels): 30–55</td>
</tr>
<tr>
<td></td>
<td>• Width (in pixels): 30–55</td>
</tr>
<tr>
<td><img src="https://via.placeholder.com/15/000000/ffffff?text=Note" alt="Note" /></td>
<td>If no logo is selected, the Home icon (🏠) is displayed as a default logo in the header of the messenger.</td>
</tr>
<tr>
<td>Launcher icon</td>
<td>Icon that is displayed as the messenger option on your website.</td>
</tr>
<tr>
<td></td>
<td>On your website, clicking this icon launches the messenger.</td>
</tr>
<tr>
<td></td>
<td>The recommended size and dimensions are:</td>
</tr>
<tr>
<td></td>
<td>• Size (in bytes): approximately equal to 1 KB</td>
</tr>
<tr>
<td></td>
<td>• Height (in pixels): 30–55</td>
</tr>
<tr>
<td></td>
<td>• Width (in pixels): 30–55</td>
</tr>
<tr>
<td>Primary color</td>
<td>Primary color for styling the header or buttons in your messenger.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Primary font color</td>
<td>Text color that is used on UI elements that use the primary color.</td>
</tr>
<tr>
<td>Secondary color</td>
<td>Secondary color for styling your messenger.</td>
</tr>
<tr>
<td></td>
<td>For example, this color is used for user action buttons such as Cancel or No.</td>
</tr>
<tr>
<td>Secondary font color</td>
<td>Text color that is used on UI elements that use the secondary color.</td>
</tr>
<tr>
<td>Tertiary color</td>
<td>Tertiary color for styling your messenger.</td>
</tr>
<tr>
<td></td>
<td>For example, this color is used to mark customer cases with tags such as Action required.</td>
</tr>
<tr>
<td>Tertiary font color</td>
<td>Text color that is used on UI elements that use the tertiary color.</td>
</tr>
<tr>
<td>Theme</td>
<td>Theme for other styling options of the messenger.</td>
</tr>
<tr>
<td></td>
<td>This field is automatically set to CWF Engagement Messenger Theme.</td>
</tr>
<tr>
<td></td>
<td>If you want to select a different theme, ensure that the theme that you select here must match certain criteria. For more information, see Engagement Messenger module theme requirements.</td>
</tr>
</tbody>
</table>

**Note:** If the value for the Primary color, Secondary color, or Tertiary color fields is set to color names, such as Pink, Engagement Messenger UI does not display these colors correctly. As a workaround, you can enter the hexadecimal values of these colors. For example, use #FFC0CB for Pink.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Launch icon position</td>
<td>Position of the messenger launch icon on your website.</td>
</tr>
<tr>
<td>Allow module to expand to full-height</td>
<td>Option for enabling the messenger module to expand to the full height of the browser tab.</td>
</tr>
<tr>
<td>Horizontal offset distance (in pixels)</td>
<td>Distance from the right or left of the browser tab for the placement of the messenger launcher icon. The distance is calculated from right or left based on your input for the field <strong>Launch icon position</strong>. For example, if you set the launch icon position as <strong>Right</strong> and the <strong>Horizontal offset</strong> as <strong>50</strong>, then the launch icon is placed at a distance of 50 px from the right of the browser tab. The maximum value for this field is 70 px.</td>
</tr>
<tr>
<td>Vertical offset distance (in pixels)</td>
<td>Distance from the bottom of the browser tab for the placement of the messenger launch icon. The maximum value for this field is 70 px.</td>
</tr>
<tr>
<td>Enable user behavior tracking</td>
<td>Option for enabling the collection of user experience analytics from users of your Engagement Messenger. This option is available only if you activate the Service Portal Analytics plugin (com.glide.service-portal.analytics) in your ServiceNow instance. For more information on using the User Experience Analytics, see <strong>Use User Experience Analytics</strong>.</td>
</tr>
</tbody>
</table>
### Field Description

**Note:** If you update your Engagement Messenger module name after user behavior tracking is enabled, the User Experience Analytics dashboard would show the original module name, not the updated name.

<table>
<thead>
<tr>
<th>Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>See Customize the feature configuration of Engagement Messenger.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Implement</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Website URLs</strong></td>
</tr>
</tbody>
</table>
| **Authentication type** | Authentication type for this embedded messenger. Select one of the following options:  
- None  
- Security assertion markup language (SAML)-based  
- Open ID connect (OIDC)-based  
If you want to enable only the guest user experience for the messenger in your website, set this field to **None**.  
Ensure that you create an identity provider (IdP) for the authentication type you select in this field. For more information, see Create an identity provider (IdP) for Engagement Messenger. |

5. Click **Save**.
6. Click **Email instructions** to notify your security administrator to complete the following tasks:

   a. Create an identity provider (IdP) for Engagement Messenger.
   
   b. Configure a CORS rule for Engagement Messenger.
   
   c. Create HTTP response headers for Engagement Messenger.

**Results**

A new messenger configuration is created and listed in the Modules module of Engagement Messenger application.

**What to do next**

1. Configuring system properties for Engagement Messenger.
2. Customize the feature configuration of Engagement Messenger.
3. Share the messenger module code with your developer using the **Email code** to embed Engagement Messenger in your website.
4. Following are the advanced formatting changes that are available as an optional configuration in Engagement Messenger:
   - Engagement Messenger module theme requirements to reuse Service Portal theme to customize visual appearance in Engagement Messenger.
   - Default font sizes for search result text in Engagement Messenger.

**Engagement Messenger module theme requirements**

You can set a theme that you can apply to an Engagement Messenger module. A theme enables you to define additional styling of Engagement Messenger in your website.

You can select the theme for your Engagement Messenger in the Appearance section of the guided configuration.
A theme that you want to use for your messenger module must meet the following criteria:

- The header must be set as **CWF EC Header**
- It must contain the JS include `/scripts/sn_csm_ec.js`
- It must contain the CSS includes `cwf_ec_theme_inline_css` and `sp-theme-lajolla.css`

**Default font sizes for search result text in Engagement Messenger**

Define normal and genius search result font sizes to change text appearance in Engagement Messenger on different devices.

**Note:** The `ec_admin` role is required to change the default configuration.

<table>
<thead>
<tr>
<th>Search type</th>
<th>Default configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal search for Knowledge Base and Catalog</td>
<td>The default normal search result font size settings are:</td>
</tr>
<tr>
<td>Search type</td>
<td>Default configuration</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Default configuration                            | • Large for title  
• Medium for summary                                                                                                                                                                                                                |
| ![i](note_icon) Note:                            | • This setting for knowledge bases is located in the [em_kb_search_template](#) template script.  
• This setting for Catalog is located in the [em_catalog_search_template](#) template script.   |
| The default auto spell correction text font size is medium. | ![i](note_icon) Note: The default configuration is set in the Faceted Search widget.                                                                                                                                                         |
| Genius search for Knowledge Base and Catalog     | The default genius search result font size settings are:  
• Small for identifier  
• Large for heading  
• Medium for summary                                                                                                                                                           |
| ![i](note_icon) Note:                            | • This setting for knowledge bases is located in the [em_qa_genius_results_template](#) template script.  
• This setting for Catalog is located in the [em_catalog_genius_results_template](#) template script.   |
Normal search result text appearance in Engagement Messenger.
Update Engagement Messenger launch URLs to the latest version

Update the version of Engagement Messenger in the code used to embed Engagement Messenger in your website or to automatically launch features with Engagement Messenger.

**Before you begin**
Role required: website administrator

**Procedure**
1. Open the HTML file of the web page on the website where you integrate Engagement Messenger.
2. Change the existing version number to $v=3.1$.
   For example:
3. Save the file.

**Configuring system properties for Engagement Messenger**

You can configure the system properties for your Engagement Messenger module so that you can enable Virtual Agent chat, multi-provider SSO, and set a user session time-out value.

After you configure an Engagement Messenger module, set the following system properties that are based on your configuration of the messenger module.

💡 **Tip:** In the navigation filter, enter `sys_properties.list` to view the list of all the system properties and search for the property that you want to update.

**Virtual Agent chat**

After activating the Glide Virtual Agent plugin (com.glide.cs.chatbot), you must use the `com.glide.cs.embed.csp_frame_ancestors` system property to enable the configuration of the frame-ancestors policy for the website where you want to host the Engagement Messenger.

The Virtual Agent plugin enables embedding of a client in an external web page. However, to embed the client page in the web page, the content security policy must allow the external page as a parent frame.

Set the value of the `com.glide.cs.embed.csp_frame_ancestors` system property `self <your website URL>`. For example, `self` https://www.example.com

For more information, see Virtual agent embedded client content security policy and Embed the Virtual Agent web client in an external web page.

**Multi-provider SSO**

Set the `glide.authenticate.multisso.enabled` system property to `true`.

If you want to enable only a guest user experience for your customer service portal, you can ignore this configuration.
User session time-out

Set a user session timeout value for the `glide.ui.session.timeout` system property to a value that is greater than or equal to your website time-out.

If you want to enable only a guest user experience for your customer service portal, you can ignore this configuration.

Base URL for customer support portal

Set the URL of your third-party customer support portal in the `sn_customerservice.emails.customportal` system property so that the notification emails that your customers get contain URLs that redirect them to the exact request record that they submitted.

These notification emails are sent in scenarios such as submitting a case, requesting a service, requesting a field technician, or booking a walk-up appointment.

When your customer visits the URL generated based on this property, they land on your third-party website with Engagement Messenger displaying that record.

For example, if your customer support portal is https://www.example.com/support, then set the property value to https://www.example.com/support.

Customize the feature configuration of Engagement Messenger

Customize the feature configuration of Engagement Messenger so that you can change the default settings to suit your customer needs.

Before you begin

- Configure Engagement Messenger.
- Role required: sn_csm_ec.ec_admin

About this task

Configure how the features of Engagement Messenger appear to your customers, their display arrangement, and their behavior.

Use the Features section of the guided configuration to customize the messenger configuration. View a live preview of how the Engagement Messenger would look like in your third-party website.
Procedure

1. Navigate to **Engagement Messenger > Modules**.

2. In the Edit module column of the messenger module that you want to configure, click **Edit**. The guided configuration view is displayed.

3. From the Features section of the guided configuration, enable or disable a feature by using the toggle (✓) on the feature card.

4. Open one of the following features and modify the values:
   - Greeting: See **Greeting feature configuration**.
   - Knowledge: See **Knowledge feature configuration**.
   - Search: See **Search feature configuration**.
   - Case: See **Case management feature configuration**.
   - Catalog: See **Catalog feature configuration**.
   - Field service: See **Field service feature configuration**.
   - Walk-up: See **Walk-up feature configuration**.
   - Chat with an agent: See **Live and Virtual Agent chat feature configuration**.

5. Click **Update**.

6. **Optional**: Change the display order of the features by reordering the feature cards.
   You can see the modified home page layout of your Engagement Messenger in the live preview of the module.
What to do next
Create an identity provider (IdP) for Engagement Messenger.

Greeting feature configuration
Understand the configuration of the Greeting feature in the Engagement Messenger so that you can configure the field values according to your customer needs.

Greeting feature configuration form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable for unauthenticated users</td>
<td>Option for enabling this feature for guest users who visit the website that hosts the messenger.</td>
</tr>
<tr>
<td>Unauthenticated user greeting</td>
<td>Text that is displayed in the header of the messenger home page to greet a guest user. For example, Hello!</td>
</tr>
<tr>
<td>Enable for authenticated users</td>
<td>Option for enabling this feature for users who sign in into the website that hosts the messenger.</td>
</tr>
<tr>
<td>Authenticated user greeting</td>
<td>Text that is displayed in the header of the messenger home page to greet a user who signs in into the website.</td>
</tr>
<tr>
<td></td>
<td>This field is automatically set to Hi, &lt;user&gt;!, where &lt;user&gt; indicates the name of the user who has logged in.</td>
</tr>
<tr>
<td></td>
<td>The other variables that you can use with &lt;user&gt; are the following:</td>
</tr>
<tr>
<td></td>
<td>• &lt;title&gt; which indicates the salutation such as Mr., Ms., or Dr. as per the details in the Users [sys_user] table.</td>
</tr>
<tr>
<td></td>
<td>• &lt;part_of_day&gt; which displays the greeting based on the part of the day of the user’s region. For example, Good morning, Good afternoon, or Good evening.</td>
</tr>
<tr>
<td>Greeting message</td>
<td>Tagline for the user greeting on the header of the messenger home page.</td>
</tr>
</tbody>
</table>
Knowledge feature configuration

Understand the configuration and related lists of the Knowledge feature in the Engagement Messenger so that you can configure the field values according to your customer needs.

### Knowledge feature configuration form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show articles by</td>
<td>Article category that is shown on the home page of the messenger. You can select one of the following categories:</td>
</tr>
<tr>
<td></td>
<td>• Featured articles: Articles that are based on the keywords that are associated with the articles.</td>
</tr>
<tr>
<td></td>
<td>For information on displaying articles in the Featured content section, see <a href="#">Add a knowledge article to featured content</a>.</td>
</tr>
<tr>
<td></td>
<td>• Most viewed articles: Articles that have the highest view among the articles of your knowledge base.</td>
</tr>
</tbody>
</table>
Knowledge feature configuration form (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The articles shown in the messenger are from the knowledge bases that you add in the <strong>Knowledge bases</strong> field.</td>
</tr>
<tr>
<td>Article count</td>
<td>Number of articles that are shown on the messenger home page. The articles are shown based on the option that you select in the <strong>Show articles by</strong> field.</td>
</tr>
<tr>
<td>Knowledge Bases</td>
<td>List of knowledge bases that are associated with your messenger module. Use the Edit option ( EDIT ) and search to add a knowledge base to your messenger module.</td>
</tr>
<tr>
<td>Enable copy permalink</td>
<td>Option for enabling your customer to copy the permalink of a knowledge article.</td>
</tr>
</tbody>
</table>

Knowledge feature widget

![Knowledge feature widget](image)

- **Article count set to '2'**
- **Show articles by field set to 'Featured Articles'**

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Note the following points while you are configuring the Knowledge feature on your Engagement Messenger module:

• To add knowledge bases to your messenger module, ensure that the knowledge_admin role is manually assigned to the user with the Engagement Messenger admin [sn_csm_ec.ec_admin] role.

• If the knowledge base that you added to the Engagement Messenger has no articles, then the homepage of the messenger UI does not display any knowledge article widget even when you select a value for the **Show articles by** and **Article count** fields.

Note the following points regarding the live preview of Knowledge feature. However, the actual functionality of the feature is not affected when the Engagement Messenger is deployed in your website.

• The list of articles that is shown in the messenger live preview depends on the application access that the knowledge_admin has to the articles.

  If the knowledge_admin does not have access to any articles, then no content is displayed in the preview. In such a case, only a title **Featured articles** or **Most viewed articles** is displayed.

• Changing the value of the **Show articles by** field refreshes only the title and not the content in the messenger preview.

**Search feature configuration**

Understand the configuration of the Search feature in the Engagement Messenger so that you can configure the field values according to your customer needs.

**Search feature configuration form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search message</td>
<td>Text that is used for this feature widget in the messenger.</td>
</tr>
<tr>
<td>Placeholder text</td>
<td>Text that is displayed in the Search box on the messenger user interface.</td>
</tr>
<tr>
<td>Enabled for unauthenticated users</td>
<td>Option for enabling this feature for guest users who visit the website that hosts the messenger.</td>
</tr>
</tbody>
</table>
### Search feature configuration form (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Note:</strong> You also need to configure EC AI Homepage Search widget, Typeahead Search widget, and AI Search Assist widget for public access to enable AI search for unauthenticated users. For more information, see <a href="#">Enable AI Search in Engagement Messenger for unauthenticated users</a>.</td>
</tr>
<tr>
<td>Enabled for authenticated users</td>
<td>Option for enabling this feature for users who sign in to the website that hosts the messenger.</td>
</tr>
<tr>
<td>Search application</td>
<td>Application that is used to power the search functionality in Engagement Messenger. This field is automatically set to <strong>Engagement Messenger AI Search Config</strong>.</td>
</tr>
</tbody>
</table>

### Search feature widget

In addition to configuring these fields for Engagement Messenger, you must configure AI Search in your ServiceNow instance and then enable Typeahead Search and AI Search Assist widgets so that the unauthenticated users can use the AI search feature from Engagement Messenger.
For more information on enabling Typeahead Search and AI Search Assist widgets for Engagement Messenger, see Enabling AI search in the Customer and Consumer Service Portals for unauthenticated users.

For more information of AI Search configuration, see Configuring AI Search.

For more information on the availability of AI Search in your instance, see the AI Search Availability [KB0867751] article.

Note: In Firefox browser, AI Search results are not displayed on the Engagement Messenger home page.

Enable AI Search in Engagement Messenger for unauthenticated users

Enable the AI Search experience in Engagement Messenger so unauthenticated users can see the most relevant set of search results.

Before you begin

You must configure AI Search for the Engagement Messenger before enabling AI Search for an unauthenticated user. For more information, see Search feature configuration.

Role required: admin

About this task

As an admin, you need to enable the EC AI Homepage Search, Typeahead Search, and AI Search Assist widgets in Engagement Messenger to enable the AI Search capability for unauthenticated users.

Procedure

1. Navigate to Service Portal > Widgets.
2. Search for and open the EC AI Homepage Search widget.
3. Select the Public check box.
4. Click Update.

What to do next

Enable the Typeahead Search and AI Search Assist widgets. For information, see Enabling AI search in the Customer and Consumer Service Portals for unauthenticated users.

Case management feature configuration

Understand the configuration of the Cases feature in the Engagement Messenger so that you can configure the field values according to your customer needs.
Cases feature configuration form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title text</td>
<td>Title for this feature widget in the messenger.</td>
</tr>
<tr>
<td>Subtitle text</td>
<td>Description for this feature widget in the messenger.</td>
</tr>
<tr>
<td>Feature launch message</td>
<td>Text for the Case form launcher widget in the messenger.</td>
</tr>
<tr>
<td></td>
<td>For example, if a user provides feedback to a knowledge article that it wasn't helpful, the messenger displays a widget to create a case. Clicking this widget launches a case form for the user to fill and submit.</td>
</tr>
<tr>
<td>Feature launch description</td>
<td>Description for the Case form launcher widget in the messenger.</td>
</tr>
</tbody>
</table>

⚠️ Note: This feature is not available for guest users.

Cases feature widget

Catalog feature configuration

Understand the configuration of the Catalog feature in the Engagement Messenger so that you can configure the field values according to your customer needs.
## Catalog feature configuration form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title text</td>
<td>Title for this feature widget in the messenger.</td>
</tr>
<tr>
<td>Subtitle text</td>
<td>Description for this feature widget in the messenger.</td>
</tr>
<tr>
<td>Catalogs</td>
<td>List of catalogs that are associated with your messenger.</td>
</tr>
<tr>
<td></td>
<td>Use the Edit option ( Modi ) and search for a catalog to add to your messenger.</td>
</tr>
</tbody>
</table>

## Catalog feature widget

![Catalog feature widget](image-url)

- **Title text**: "Hi, Teddy! Get help anytime you need"
- **Subtitle text**: "We have a range of services to help you."
Note: When you upgrade the Engagement Messenger application from v1.0.0 to a newer version, the Catalog feature is disabled for all the existing messenger modules. However, AI search results from the home page of the Engagement Messenger still show catalogs to the users. For more information, see the Known issues in Engagement Messenger [KB0952509] article.

Field service feature configuration

Understand the configuration of the field service feature in the Engagement Messenger module so that you can configure the values according to your preferences.

To enable the field service feature, ensure that you activate the Field Service Management - Customer Experience plugin (com.snc.fsm_customer_experience) in your ServiceNow instance.

Once the plugin is active, navigate to the Features section of the guided configuration view of your Engagement Messenger module and enable the field service feature.

Field service feature configuration fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title text</td>
<td>Title for this feature widget in the messenger.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Subtitle text</td>
<td>Description for this feature widget in the messenger.</td>
</tr>
</tbody>
</table>

**Enabling technician tracking from Engagement Messenger**

When a technician is assigned to resolve your customer's field service request, they can track their technician from Engagement Messenger.

To enable this functionality, ensure that you meet the following criteria:

- **Activate the Field Service Management - Customer Experience plugin** (com.snc.fsm_customer_experience).
- **in the sys_user table, enable the Geolocation tracked field** for all your field service agents who would be assigned to the customer work orders.

For more information, see [Location tracking](#).

**Walk-up feature configuration**

Understand the configuration of the Walk-up feature in the Engagement Messenger module so that you can configure the field values according to your preferences.
To enable walk-up feature for your customers, ensure that you activate the following plugins in your ServiceNow instance:

- Walk-up for CSM plugin (com.snc.walkup_for_csm) for authenticated users
- Guest Walk-up Experience for Customer Service plugin (sn_guest_walkup_cs) for unauthenticated users

Once the plugin is active, navigate to the Features section of the guided configuration view of your Engagement Messenger module and enable the **Features**.

Point your cursor to the field labels to see the

![Field service feature](image)

**Walk-up feature configuration fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title text</td>
<td>Title for this feature widget in the messenger.</td>
</tr>
<tr>
<td>Subtitle text</td>
<td>Description for this feature widget in the messenger.</td>
</tr>
<tr>
<td>Enable for unauthenticated users</td>
<td>Option for enabling this feature for guest users who visit the website that hosts the messenger.</td>
</tr>
</tbody>
</table>
Walk-up feature configuration fields (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable for authenticated users</td>
<td>Option for enabling this feature for users who sign in into the website that hosts the messenger.</td>
</tr>
</tbody>
</table>

Click **Configure walk-up here** to configure details of your customer support centres. For more information, see **Configure Walk-up Experience locations**.

**Live and Virtual Agent chat feature configuration**

Understand the configuration of the Chat feature in the Engagement Messenger so that you can configure the field values according to your customer needs.

To enable the chat feature, ensure that the Glide Virtual Agent plugin (com.glide.cs.chatbot) is active and the value of the `com.glide.cs.embed.csp_frame_ancestors` system property is set to 'self '<your website URL>. See Configuring system properties for Engagement Messenger.

Chat feature configuration form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title text</td>
<td>Title for this feature widget on the messenger home page.</td>
</tr>
<tr>
<td>Reference chat topic</td>
<td>Reference chat topic to use when a chat is launched from a case or work order. This field is automatically set to EC Contextual help.</td>
</tr>
</tbody>
</table>

If you want to update the default chat setup, click **Configure advanced chat options**.

<table>
<thead>
<tr>
<th>Enabled for unauthenticated users</th>
<th>Option for enabling this feature for guest users who visit the website that hosts the messenger.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled for authenticated users</td>
<td>Option for enabling this feature for users who sign in to the website that hosts the messenger.</td>
</tr>
<tr>
<td>Feature launch message</td>
<td>Text for the Chat launcher widget in the messenger.</td>
</tr>
</tbody>
</table>
Chat feature configuration form (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>For example, if a user provides</td>
<td>For example, if a user provides feedback to a knowledge article that it wasn’t helpful, the messenger displays a widget to start a chat with a support agent. Clicking this widget launches a chat window within the messenger.</td>
</tr>
<tr>
<td>feedback to a knowledge article</td>
<td></td>
</tr>
<tr>
<td>that it wasn’t helpful, the messenger displays a widget to start a chat with a support agent. Clicking this widget launches a chat window within the messenger.</td>
<td></td>
</tr>
<tr>
<td>Feature launch description</td>
<td>Description for the Chat launcher widget in the messenger.</td>
</tr>
</tbody>
</table>

**Agent chat widget**

**Chat feature launcher widget**

### Configuring chat branding and menu

If you want to change the chat branding and menu configuration from the default configuration, you can do so by navigating to the respective branding record for your Engagement Messenger module.

Navigate to Conversational Interfaces > Branding and Chat Menu and open the branding record of your Engagement Messenger module to edit the configuration. For example, if your Engagement Messenger module name is New module, a branding record with the name New module is listed in the Brandings list.
Chat Brandings list

For more information on the form fields for chat branding, see Configure chat branding and the chat menu.

Configuring chat setup

If you want to update the default chat setup, you can do so by navigating to Conversational Interfaces > Chat Setup and update the configuration for various features like live agent chat, chat notifications, and others.

For more information, see Configure live agent chat.

Create an identity provider (IdP) for Engagement Messenger

Create an IdP for your Engagement Messenger so that you can enable customer authentication. You can create an IdP for either the OpenID Connect (OIDC) or Security Assertion Markup Language (SAML) authentication type.

Before you begin
Role required: admin

About this task
If you previously configured an IdP, you can ignore this task and reuse the existing IdP.

Procedure
1. Navigate to Engagement Messenger > Modules > Administration > Identity Providers.
2. Click New.
3. Select either OpenID Connect or SAML.
   • If you select OpenID Connect, follow the procedure in Create an OpenID Connect (OIDC) configuration for Single Sign-On (SSO).
   • If you select SAML, follow the procedure from step 3 in Create and update identity providers.
What to do next

- When customers sign in to your website where the Engagement Messenger module is deployed, they must also be authenticated within the messenger. User authentication is done by using the same IdP that authenticated the customer's login into your website.

  You must ensure that the customers of your website are also added in your OIDC or SAML authentication provider for the ServiceNow instance.

- Enable cross-domain requests between Engagement Messenger and your website. See Configure a CORS rule for Engagement Messenger.

Related information

- How to set up OIDC provider on ServiceNow instance

Configure a CORS rule for Engagement Messenger

Configure a cross-origin resource sharing (CORS) rule to enable cross-domain requests between Engagement Messenger and your website where you want to deploy the messenger.

Before you begin

- Configure Engagement Messenger.
- Create an identity provider (IdP) for Engagement Messenger.
- Role required: admin

About this task

Use the Engagement Messenger API and your website URL to create a CORS rule.

Procedure

1. Navigate to Engagement Messenger > Modules > Administration > CORS Rules.
2. Click New.
3. On the form, fill in the fields.

CORS Rule form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the CORS rule.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope for this record.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>REST API</td>
<td>Engagement Messenger REST API that this CORS rule applies to.</td>
</tr>
<tr>
<td></td>
<td>Set this field to <strong>Engagement Center API</strong> [sn_csm_ec/engagement_center_api].</td>
</tr>
<tr>
<td>Domain</td>
<td>Domain that sends the request to this REST API. Set this field value to the URL of the website where you want to deploy the messenger. For example, <a href="https://www.example.com">https://www.example.com</a>.</td>
</tr>
<tr>
<td>Max age</td>
<td>Number of seconds to cache the client session. After an initial CORS request, further requests from the same client within this time do not require a preflight message. If you do not specify a value, the default value of 0 indicates that all requests require a preflight message.</td>
</tr>
<tr>
<td>HTTP Methods</td>
<td>Allowed HTTP methods. Enable the GET and POST methods.</td>
</tr>
<tr>
<td>HTTP Headers</td>
<td>Comma-separated list of HTTP headers to send in the response. You can leave this field empty.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**What to do next**
Create HTTP response headers for Engagement Messenger.

**Create HTTP response headers for Engagement Messenger**
Configure a name-value pair for HTTP response headers for the Engagement Messenger module. The ability to configure and pass response headers enables special handling of the page content by a client, which is most typically a browser.
Before you begin

- Configure Engagement Messenger.
- Create an identity provider (IdP) for Engagement Messenger.
- Configure a CORS rule for Engagement Messenger.
- Role required: admin

About this task

Use the Engagement Messenger API and your website URL to create a CORS rule.

Procedure

1. Navigate to Engagement Messenger > Modules > Administration > HTTP Response Headers.
2. Click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Option for indicating that this HTTP response header configuration is active.</td>
</tr>
<tr>
<td>Application</td>
<td>Application scope for this record.</td>
</tr>
<tr>
<td>Applies to</td>
<td>Type of record that the HTTP response header configuration applies to. Select <strong>Specific Type</strong> to indicate that this HTTP response header configuration is for the specific type and record that you select in the <strong>Type</strong> and <strong>Record</strong> fields.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of record that the HTTP response header configuration applies to. Select <strong>Service Portal</strong> to indicate that the records are related to the Service Portal.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Record      | Engagement Messenger module record that the HTTP response header configuration applies to. Select a record:  
  a. Click the Search (🔍) icon to access the Select the document pop-up form.  
  b. In the **Table name** field, ensure that the value is set to Service Portal.  
  c. In the **Document** field, click the Search (🔍) icon.  
  d. From the list of Service Portal records, select the messenger module that you configured.  
  e. Click OK. |
| Name        | Name for the name-value pair for the HTTP response header. Set this field value to **Content-Security-Policy**.                                |
| Value       | Value for the name-value pair for the HTTP response header. Set this field value to **frame-ancestors 'self' <enter your website URL>**.  
  For example, **frame-ancestors 'self' https://www.example.com**. |
| Description | Detailed description for the HTTP response header.                                                                                           |

**What to do next**  
Activate an Engagement Messenger module.

**Related information**  
HTTP Response Headers
Activate an Engagement Messenger module
Activate the Engagement Messenger module that you configured so that you can embed it in your website.

Before you begin
- Configure Engagement Messenger.
- Create an identity provider (IdP) for Engagement Messenger.
- Configure a CORS rule for Engagement Messenger.
- Create HTTP response headers for Engagement Messenger.
- Role required: sn_csm_ec.ec_admin

About this task
Unless you activate a messenger module, it would not be available for your customers to use from within your third-party website.

Procedure
1. Navigate to Engagement Messenger > Modules.
2. In the Edit module column of the messenger module that you want to activate, click Edit.
   The guided configuration view is displayed.
3. Select the Implement step.
4. Select Activate.

What to do next
Embed Engagement Messenger in your web application.

Embed Engagement Messenger in your web application
Embed the source code of the messenger module that you configured in your website so that you can enable your customers to start using Engagement Messenger in your website.
Before you begin
- Activate an Engagement Messenger module.
- Role required: sn_csm_ec.ec_admin

Procedure
1. Navigate to Engagement Messenger > Modules.
2. Open the Engagement Messenger module you want to install on your website.
3. Click Edit.
4. Click the Implement tab.
5. If you have made any changes in the Security settings section, click Save.
6. Scroll down to the Embed code section and click Copy code.
7. Open the HTML file of your website and paste the copied code before the closing body tag.
8. For a messenger module with OIDC-based or SAMl-based authentication, complete the following configuration.

<table>
<thead>
<tr>
<th>Authentication type</th>
<th>Action</th>
</tr>
</thead>
</table>
| OIDC-based          | a. Write code for the getTokenCallBack() function.  
|                     | b. Call the SN_CSM_EC.onLogin() function whenever users log in to your website.  
|                     | This function enables authenticated users to log in to Engagement Messenger seamlessly when they log in to your website.  
|                     | c. Call the SN_CSM_EC.onLogout() function whenever users log out from your website.  
|                     | This function enables authenticated users to seamlessly log out from Engagement Messenger and your website.  |
### Authentication type

<table>
<thead>
<tr>
<th>SAML-based</th>
</tr>
</thead>
</table>

#### Action

**a.** Call the `SN_CSM_EC.onLogin()` function whenever users log in to your website.

This function enables authenticated users to log in to Engagement Messenger seamlessly when they log in to your website.

**b.** Call the `SN_CSM_EC.onLogout()` function whenever users log out from your website.

This function enables authenticated users to seamlessly log out from Engagement Messenger and your website.

9. If you enabled the walk-up feature for unauthenticated users, uncomment the `//guestWalkupBaseUrl` code line and complete the configuration by entering the base URL of your customer support portal.

For example, if your customer support portal is `https://www.example.com/support`, then update the code to `guestWalkupBaseUrl = https://www.example.com/support`
10. **Optional:** Open the website to which you added the Engagement Messenger code to verify that the launcher icon is available and click the icon to verify that it launches Engagement Messenger.
Context-based workflow launch in Engagement Messenger

Set a workflow as a default launch screen in Engagement Messenger either using custom code or a parameterized URL.

The contextual launch capability enables you to customize the home page of Engagement Messenger so that you can launch a specified feature every time the messenger is accessed. The feature is launched through variables in a structured URL or in custom code through launch entries that contain substitution variables.

Launch a feature in Engagement Messenger using URL parameters

Use URL parameters in your website URL to enable context-based launch of a feature in Engagement Messenger integrated with your website.

Before you begin
Configure Engagement Messenger.

Embed Engagement Messenger in your web application.

Role required: ec_admin and website administrator
About this task
You can use URL parameters to display specific feature in Engagement Messenger. When the URL is accessed, it opens your website and automatically loads the specified feature in Engagement Messenger. For example, you can embed the URL in an email to share a knowledge article from Engagement Messenger.

Note:
If you are using existing Embed code, ensure that you update the script to include v=3.1. For example:

```html
<script src="https://example.service-now.com/scripts/sn_csm_ec.js?v=3.1"></script>
SN_CSM_EC.init({
    moduleId: "https://example.service-now.com/#aeff0547dd393010f87734cef087e2ba",
    loadFeature: SN_CSM_EC.loadEMFeature()
});
</script>
```

Procedure
1. Navigate to Engagement Messenger > Modules.
2. In the Configure Engagement Messenger Module, open the Implement tab.
3. Copy the code from the Embed code section.
4. In a text editor, open the HTML file of the web page on your website where you integrate Engagement Messenger.
5. Paste the code you copied before the closing body tag.
6. Save the file.
7. Modify the website URL to include the feature.

```
https://website/page.html?feature=<FEATURE_NAME>&<PARAM_NAME1>=<PARAM_VALUE1>&<PARAM_NAME2>=<PARAM_VALUE2>
```

**<FEATURE_NAME>**
The feature name. For information, see Feature context parameters supported in Engagement Messenger.

**<param_name1>=<param_value1>**
Name and value of a parameter associated with the feature.
To define multiple parameters, use the same format. For more information, see Feature context parameters supported in Engagement Messenger.

8. Optional: Verify that the URL launches the designated feature automatically.
Results
The feature you included in the URL is set as the default launch screen in Engagement Messenger.

Example:
The following sample URL includes a system identifier (sys_id) for a knowledge article that will automatically display when the website is launched.

https://mywebsite/page.html?feature=VIEW_ARTICLE
&sys_kb_id=ec7617461b01f01080df6247b04bcbaf

Launch a feature in Engagement Messenger using custom code
Use custom code to enable the context-based launch of a feature in Engagement Messenger integrated with your website.

Before you begin
Configure Engagement Messenger.
Embed Engagement Messenger in your web application.
Role required: ec_admin and website administrator

About this task
Note:
If you are using existing code, ensure that you update the script to show v=3.1. For example:

```
<script src="https://example.service-now.com/scripts/sn_csm_ec.js?v=3.1"></script>
<script>
SN_CSM_EC.init({
    moduleID: "https://example.service-now.com/#a5efcb2dd393010f87734c5e037e2ba",
    loadFeature: SN_CSM_EC.loadEMFeature()
});
</script>
```

Procedure
1. Navigate to Engagement Messenger > Modules.
2. In the Configure Engagement Messenger Module, open the Implement tab.
3. Copy the code from the Embed code section.
4. In a text editor, open the HTML file of the web page on your website where you integrate Engagement Messenger.
5. Paste the code you copied before the closing body tag.
6. Define the feature context and specify the variables for the feature.
Use the following format to define a feature context:

```json
{
  feature: "<feature_name>",
  openOnLoad: <true/false>,
  params: {
    "<param_name>": "<param_value>",
    "<param_name>": "<param_value>
  }
}
```

In the format, specify the feature variables.

**feature**

The feature name. For more information, see Feature context parameters supported in Engagement Messenger.

**openOnLoad**

Include this option and set it to true only if you want Engagement Messenger to open automatically. The default setting for this option is for Engagement Messenger not to open automatically.

**<param_name>: "<param_value>**

Name and value of a parameter associated with the feature. For more information, see Feature context parameters supported in Engagement Messenger.

7. Create a custom wrapper function to pass the feature context to the `SN_CSM_EC.init` function of the embed code.

For example, the following code uses the `chatFeatureContext()` custom wrapper function for the chat feature context.

```javascript
function chatFeatureContext(){
  return {
    feature: "CHAT",
    openOnLoad: false,
    params: {
      "topic_id": "8708db281bd5b81080df6247b04bcb79",
      "language": "fr"
    }
  }
}
```

8. Replace the `SN_CSM_EC.loadEMFeature()` function with custom wrapper function that you created in step 7.
For example, in the following code, the `chatFeatureContext()` wrapper function is passed as the value of the `loadFeature` attribute.

```javascript
SN_CSM_EC.init({
    moduleID: "https://example.service-now.com/#<module_id>",
    loadFeature: chatFeatureContext()
});
```

9. Save the file.

10. **Optional:** Verify that the designated feature launches.
    
    a. Open the website in which you embedded Engagement Messenger.
    
    b. Click the launcher icon.
    
    c. Verify that Engagement Messenger launches feature you configured in the embed code.

**Results**
The feature you specified in the embed code is launched by default when Engagement Messenger is opened in the website in which it is embedded.

**Example:**
The following code initiates the chat feature by default. It also shows how to trigger a Virtual Agent topic by default when chat is loaded by passing the system identifier (sys_id) of the topic. You can also specify a language to initiate chat in that language.

```html
<script src="https://example.servicenow.com/scripts/sn_csm_ec.js?v=3.1"></script>
<script>
function chatFeatureContext(){
    return {
        feature: "CHAT",
        openOnLoad: false,
        params: {
            "topic_id": "8708db281bd5b81080df6247b04bcb79",
            "language": "fr"
        }
    }
}

SN_CSM_EC.init({
    moduleID: "https://example.service-now.com/#d27c94d6db403810a2a6a0ced39619da",
    loadFeature: chatFeatureContext()
});
</script>
```
function
  chatFeatureContext(): The wrapper function for chat context.

feature
  CHAT: The chat feature for initiating Virtual Agent or Live Agent chat.

openOnLoad
  false: Disable the automatic launch of Engagement Messenger.

topic_id
  8708db281bd5b81080df6247b04bcb79: The module system identifier (sys_id).

topic_id
  fr: Sets the default chat language to French.

Configure Conversational Appointment Booking

Install and set up the Conversational Appointment Booking application to enable customers to book, reschedule, or cancel an appointment with a virtual agent.

Before you begin
Role required: va_admin

About this task
This procedure provides general steps to set up the Conversational Appointment Booking application so that your customers can book appointments on your ServiceNow instance with a Virtual Agent.

Procedure
1. Install the Conversational Appointment Booking application.
   For more information, see Install Conversational Appointment Booking.
2. Navigate to Virtual Agent > Designer.
3. Publish the following topics:
   • Schedule a Walk-up Appointment
   • Reschedule a Walk-up Appointment
   • Cancel a Walk-up Appointment
   For more information, see Publish a Virtual Agent topic.
   These topics are read-only by default. To add custom controls, duplicate the topics.
4. Confirm that the **Appointment Booking** custom control is published.

5. Confirm that the **Book or Update Appointment** and **Get Walk-up Location** topic blocks are published.

6. Test the topics.
   See [Test Virtual Agent topics](#) for more information.

### Install Conversational Appointment Booking

Install the Conversational Appointment Booking application (sn_va_appt_schedul) if you have the admin role. The application installs related ServiceNow® Store applications and plugins if they are not already installed.

#### Before you begin
- Ensure that the application and all of its associated ServiceNow Store applications have valid ServiceNow entitlements. For more information, see [Get entitlement for a ServiceNow product or application](#).

Role required: admin

**About this task**
Conversational Appointment Booking requires the following plugins. Ensure that these plugins are activated before you install Conversational Appointment Booking.

**Required ServiceNow plugins**

**Walk-Up for CSM (com.snc.walkup_for_csm)**

- **Note:** Conversational Appointment Booking can be used without the Walk-Up for CSM plugin. However, custom control and Virtual Agent topic blocks shown in **Configure Conversational Appointment Booking** cannot be used without this plugin.

The following items are installed with this plugin:
• NLU model for Conversational Appointment Booking.

  Note: In order to use the NLU model, you need to train and publish the model. See Natural Language Understanding for more information.

• Virtual Agent topics: Schedule a Walk-up appointment, Reschedule a Walk-up appointment, and Cancel a Walk-up appointment.

• Virtual Agent topic blocks: Get Walk-up location and Walk-up appointment scheduling.

Appointment Booking (com.snc.appointment_booking)

Enables the appointment booking feature for Walk-up Experience.

Glide Virtual Agent (com.glide.cs.chatbot)

Activates the Virtual Agent platform. Virtual Agent requires additional licensing. See Virtual Agent for more information.

NLU Workbench (com.snc.nlu_studio)

Enables the creation of custom ServiceNow Natural Language Understanding models used by Virtual Agent.

Studio (com.glide.dev-studio)

Used for adding and updating application files.

For information about plugin activation, see Activate a plugin.

Procedure

1. Navigate to System Applications > All Available Applications > All.

2. Find the Conversational Appointment Booking application (sn_va_appt_schedul) using the filter criteria and search bar.

   You can search for the application by its name or ID. If you cannot find the application, you might have to request it from the ServiceNow Store.

   Visit the ServiceNow Store website to view all the available apps and for information about submitting requests to the store. For cumulative release notes information for all released apps, see the ServiceNow Store version history release notes.
3. In the Application installation dialog box, review the application dependencies.

Dependent plugins and applications are listed if they will be installed, are currently installed, or need to be installed. If any plugins or applications need to be installed, you must install them before you can install Conversational Appointment Booking.

4. **Optional:** If demo data is available and you want to install it, click **Load demo data**.

(Optional) Demo data comprises sample records that describe application features for common use cases. Load demo data when you first install the application on a development or test instance.

> **Important:** If you don’t load the demo data during installation, it’s unavailable to load later.

5. Click **Install**.

**Configure Messaging Service**

Configure the ServiceNow Messaging Service so that you can send and receive SMS messages from your instance of the Messaging Service to third parties via a supported service provider. To configure the Messaging Service, use the three required catalog items.

**Before you begin**

Role required: Customer Admin

**Procedure**

1. Navigate to **Now Support > Automation Store**.
2. On the left navigation menu, click **Service catalog > Messaging Service**.
3. Use the catalog items to configure or modify your Messaging Service account. The following catalog items are required to configure your account. Complete the catalog items in the following order:

   a. Purchase a phone number
   b. Look up account SID and auth token

   **Note:** Looking up the account SID and auth token can be done at any time. This information is needed to configure the SMS adapter.

   c. Download and configure the SMS adapter
   d. Configure the webhook

**What to do next**

Once the required catalog items are complete, go to Conversational SMS Integration with Twilio to complete the setup for your Messaging Service account.

To manage your Messaging Service account, use the following catalog items:

- Port an existing phone number to Messaging Service.
- Release a phone number from Messaging Service.
- View phone numbers and mapped instances for Messaging Service.

**Related information**

Conversational SMS Integration with Twilio
Purchase a phone number for Messaging Service

Search and purchase a phone number to use with the Messaging Service. Make sure that the phone number is appropriate for your location.

Before you begin
Role required: Customer Admin

Procedure

1. Navigate to **Now Support > Automation Store**.
2. On the left navigation menu, click **Service catalog > Messaging Service**.
3. Click **2. Purchase phone number**.
   
   The service catalog item is displayed.

4. Choose the appropriate options on the form, such as the locality or the preferred area code.
5. Click **Search**.
   
   If there is an available phone number that matches your query, the number is displayed in the **Available Phone Numbers** field.
6. Select the number that you prefer.
7. To purchase the phone number, click **Submit**.
   A request record is created for the purchase.

8. **Optional:** To see the activity and transaction details for this request, click the request number.

9. Click **Done**.

**What to do next**

**Look up account SID and auth token.**

**Look up account SID and auth token for Messaging Service**

Look up the account security identifier (SID) and authentication (auth) token for your Messaging Service account. This information is required in order to set up the Twilio Spoke.

**Before you begin**

Role required: Customer Admin

**Procedure**

1. Navigate to **Now Support > Automation Store**.

2. On the left navigation menu, click **Service catalog > Messaging Service**.

3. Click **1. Lookup my Account SID and auth token**.
   The service catalog item is displayed. The item shows the company name and the friendly name. If you have more than one friendly name, then select the right friendly name from the Friendly Name list.
4. Click **Submit**.
   The SID and auth token are displayed.

5. Right-click the SID and auth token to copy and save them.
   You will need the SID and auth token when you download and configure the SMS adapter.

**What to do next**
Download and configure the SMS adapter.

**Configure the webhook for Messaging Service**
Configure the webhook to associate your phone number to a ServiceNow instance.

**Before you begin**
Role required: Customer Admin

- Complete the **Purchase a phone number** and **Lookup SID and auth token** catalog items.
- Download and configure the SMS adapter.
Procedure

1. Navigate to Now Support > Automation Store.
2. On the left navigation menu, click Service catalog > Messaging Service.
3. Click 3. Configure Webhook.
   The service catalog item is displayed.

Catalog item for configuring the webhook

4. Choose the appropriate friendly name and purchased phone number on the form.
5. Click Submit.
   A request record is created.
6. Optional: To see the activity details that show the webhook URL and the associated phone number, click the request number.
7. Click Done.

Port an existing phone number to Messaging Service

Move an existing phone number to your ServiceNow instance by using the Port existing phone number catalog item. Once the number is ported to
your ServiceNow instance, you can use the phone number to interact with customers.

**Before you begin**
Currently, only phone numbers from the continental United States can be ported.
Role required: Customer Admin

**About this task**
This process can take 2–4 weeks to complete. Once the process is complete, you can use the full set of Messaging Service features on this phone number.

**Procedure**

1. Navigate to **Now Support > Automation Store.**
2. On the left navigation menu, click **Service catalog > Messaging Service.**
3. Click **Port existing phone number.**
   The service catalog item is displayed.

   **Catalog item for porting a phone number**

   ![Catalog item for porting a phone number](image)

   **Port a Number**

   **1. Getting Started**

   You are about to port your phone number(s) into ServiceNow Messaging Service which means that we will work with your current provider to move your number(s) to ServiceNow. The process typically takes 2–4 weeks, and we will provide updates via email. Once complete, you will be able to use the full set of Messaging Service features on your current number(s).

   We are currently able to port in numbers from the continental United States only.

   * I will pay standard rates for my phone number and usage after my number ports. Details can be found on your contract.
   * I must keep all numbers in service with my current carrier until the port completes to avoid delays or rejections.
   * I must configure my number in Now Support 'Configure Webhook' catalog item, before my number ports.
   * I am responsible for any termination charges imposed by my current carrier for porting my numbers.
   * I may be unable to receive messages for up to 3 business days after the port completes.

4. Click the check boxes to agree to the terms and conditions.
5. Complete the form with the necessary information.
6. To release your number to Twilio, download and fill out a copy of the Letter of Authorization (PDF format only) from the provided link on the service catalog item.

7. To release your number to Twilio, upload your copy of the Letter of Authorization.

8. Upload your last billing statement for the phone number, or a screenshot showing the purchase of the phone number (PDF format only).

9. Click **Submit**. A request record is created.

10. **Optional:** To see the details of the request, click the request number.

11. Click **Done**.

**What to do next**
You will be notified by email once the request is complete.

**Release a phone number from Messaging Service**
If you have a phone number that you no longer want to use with your Messaging Service account, then remove the number by using the **Release phone number** service catalog item.

**Before you begin**
Role required: Customer Admin

**Procedure**
1. Navigate to **Now Support > Automation Store**.
2. On the left navigation menu, click **Service catalog > Messaging Service**.
3. Click **Release phone number**. The service catalog item is displayed.
4. Choose the **Company**, **Friendly Name**, and the phone number that you want to remove from the catalog item.

5. Click **Submit**.
   A request record is created.

6. To see the details of the request and to confirm that the phone number has been released, click the request number.

7. Click **Done**.

**View phone numbers and mapped instances for Messaging Service**

If you have multiple ServiceNow instances, then use the **View my phone numbers and mapped instances** catalog item to see which phone numbers are associated each instance account.

**Before you begin**
Role required: Customer Admin
Procedure

1. Navigate to **Now Support > Automation Store**.
2. On the left navigation menu, click **Service catalog > Messaging Service**.
3. Click **View my phone numbers and mapped instances**. The service catalog item is displayed.

   **Catalog item for viewing phone numbers and mapped instances**

<table>
<thead>
<tr>
<th>Phone Number and Mapped Instances</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phone Number</td>
</tr>
<tr>
<td>1458184782</td>
</tr>
<tr>
<td>1559173991</td>
</tr>
<tr>
<td>1408303414</td>
</tr>
</tbody>
</table>

4. Choose the appropriate **Company** and **Friendly name**.
5. Click **Submit**.

   The list of phone numbers on your account and the associated instance are displayed. If the phone number is not configured for an instance, then the **Instance** column shows **Not Configured**.

Integrating Customer Service Management with other applications

Extend the capabilities of Customer Service Management and connect with other departments to assist with case resolution by integrating with other applications.

Integrate with Service Management

Customer Service Management provides an integration with the Request, Incident, Problem, and Change Management applications. With this integration, users can create request, incident, problem, and change records from customer service cases. External users can view these records from the Customer and Consumer Service Portals.

**Before you begin**

Role required: admin
About this task
To configure the integration with the Request, Incident, Problem, and Change Management applications, use the Customer Service guided setup. The guided setup takes you through the setup and configuration process.

Procedure
1. Navigate to Customer Service > Administration > Guided Setup.
2. On the Getting Started page of the guided setup, click Get Started.
3. In the Integration with Service Management category, click Get Started.
   The Integration with Service Management page opens with a list of tasks to activate plugins and assign roles.
4. To perform a task, click Configure.
   This button opens the page in your instance where the configuration is completed.

Service Management configuration tasks

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
</table>
| Activate Customer Service Management with Service Management | Activate the Customer Service with Service Management plugin to enable the integration the following applications:  
  • Incident Management  
  • Problem Management  
  • Change Management |
| Activate Customer Service Management with Request Management | Activate the Customer Service with Request Management plugin to use the integration with the Request Management application. |
| Assign roles                                      | Assign the required roles to the customer service agents and managers who will be creating the request, incident, problem, and change records from customer service cases.  
For more information, see Assign CSM/ITSM integration roles. |
<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign access controls (ACLs)</td>
<td>Assign access controls (ACLs) to the external user roles to provide visibility to case-related request, problem, and change records from the Customer and Consumer Service Portals. For more information, see Provide external customers with access to problem, change, and request records.</td>
</tr>
</tbody>
</table>

5. Additionally, you can provide external customers with the ability to create and approve some types of records from the Customer and Consumer Service Portals.

**Additional Service Management configuration tasks**

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable users to create requests from the Customer and Consumer Service Portals</td>
<td>Assign roles to external customers which enable them to create requests. For more information, see Enable external customers to create requests.</td>
</tr>
</tbody>
</table>
| Enable users to approve changes and requests from the Customer Service Portal | To enable external customers to approve changes and requests:  
  - Add external users to approval groups or assign roles for approval users.  
  - Add the necessary ACLs to the snc_external role for the following table: |
<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>◦ Change Request (change_request)</td>
<td></td>
</tr>
<tr>
<td>◦ Request (sc_request)</td>
<td></td>
</tr>
<tr>
<td>◦ Request Item (sc_req_item)</td>
<td></td>
</tr>
</tbody>
</table>

For more information, see Enable external customers to approve requests and changes.

Related information

CSM integration with Service Management overview

Activate Customer Service Management with Service Management

Activate the Customer Service with Service Management plugin to use the integration with Service Management.

Before you begin

Instead of doing the configuration through this procedure, consider using guided setup. Navigate to Customer Service > Administration > Guided Setup > Get Started. Then click Get Started in the Integration with Service Management category.

Role required: admin

Procedure

1. Navigate to System Definition > Plugins.
3. Click Activate.

Activate Customer Service Management with Request Management

Activate the Customer Service with Request Management plugin to use the integration with Request Management.

Before you begin

Instead of doing the configuration through this procedure, consider using guided setup. Navigate to Customer Service > Administration > Guided Setup > Get Started. Then click Get Started in the Integration with Service Management category.
Role required: admin

Procedure
1. Navigate to System Definition > Plugins.
3. Click Activate.

Assign CSM/ITSM integration roles
To enable the Service Management integration features, assign the CSM/ITSM integration roles that are included with the Incident Management application.

Before you begin
Role required: admin

⚠ Note: If you are upgrading from the Madrid release, contact Customer Service and Support for access to these roles.

About this task
The Service Management integration plugins do not add any roles to the customer service agent role (sn_customerservice_agent). To enable the Service Management integration features, you must assign the CSM/ITSM integration roles included with the Incident Management application.

These roles enable customer service agents to view and create incident, problem, change, and request records for customer service cases.

### CSM/ITSM integration roles

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_incident_read</td>
<td>Customer service agents with this role can view information about an incident record associated with a customer service case.</td>
<td>• dependency_views&lt;br&gt;• workspace_agent&lt;br&gt;• view_changer&lt;br&gt;• sn_comm_management.comm_plan_viewer&lt;br&gt;• cmdb_read&lt;br&gt;• cmdb_query_builder_read</td>
</tr>
<tr>
<td>sn_incident_write</td>
<td>Customer service agents with this role can:</td>
<td>• sn_incident_read</td>
</tr>
</tbody>
</table>
### CSM/ITSM integration roles (continued)

<table>
<thead>
<tr>
<th>Role title</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
|             | • Create an incident record for a customer services case.  
|             | • Associate an existing incident record with a customer service case.  
|             | • Remove an incident record associated with a customer service case. | |
| sn_problem_read | Customer service agents with this role can view information about a problem record associated with a customer service case. | • dependency_views  
|             | • workspace_agent  
|             | • view_changer  
|             | • cmdb_read  
|             | • cmdb_query_builder_read | |
| sn_problem_write | Customer service agents with this role can:  
| | • Create a problem record for a customer services case.  
| | • Associate an existing problem record with a customer service case.  
| | • Remove a problem record associated with a customer service case. | • sn_problem_read |
| sn_change_read | Customer service agents with this role can view information about a change record associated with a customer service case. | • dependency_views  
| | • workspace_agent  
| | • view_changer  
| | • cmdb_read | |

© 2021 ServiceNow, Inc. All rights reserved.  
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
## CSM/ITSM integration roles (continued)

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_change_write</td>
<td>Customer service agents with this role can:</td>
<td>• sn_change_read&lt;br&gt; • template_editor&lt;br&gt; • cmdb_query_builder</td>
</tr>
<tr>
<td></td>
<td>• Create a change record for a customer services case.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Associate an existing change record with a customer service case.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Remove a change record associated with a customer service case.</td>
<td></td>
</tr>
<tr>
<td>sn_request_read</td>
<td>Customer service agents with this role can view information about request</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>records associated with a customer service case in the <strong>Requests</strong> related list.</td>
<td></td>
</tr>
<tr>
<td>sn_request_write</td>
<td>Customer service agents with this role can:</td>
<td>• sn_request_read&lt;br&gt; • task_editor&lt;br&gt; • dependency_views&lt;br&gt; • workspace_agent&lt;br&gt; • view_changer&lt;br&gt; • cmdb_read&lt;br&gt; • cmdb_query_builder_read</td>
</tr>
<tr>
<td></td>
<td>• Create request records for a customer services case.</td>
<td></td>
</tr>
</tbody>
</table>
Procedure

- You can assign roles to agents using guided setup.
- You can also assign roles to agents using the Now Platform user administration feature.
  - Assign a role to a user

Provide external customers with access to problem, change, and request records

With access to problem, change, and request records, external customers can view these records associated with their customer service cases from the Customer and Consumer Service Portals.

Before you begin
Role required: admin

About this task
Users with the snc_internal or snc_external role and with read access to the related problem, change, and request records can view these records from the Customer and Consumer Service Portals. After logging in, users can:

- Select a case and view the records related to that case in the Related Records list widget.
- Click a record in the Related Records list widget to open the record details in a pop-up window.

Procedure

1. Provide access to problem, change, and request records by configuring ACLs for the snc_external role.
   This access is not provided out of box. You must add these ACLs to the snc_external user role based on case access. For more information, see Access control list rules.
   - Note: Existing ACLs on the problem, change, and request records may impact the visibility for external users.

2. Configure the Case Related Records widget.
   By default, this widget is displayed for users with the snc_internal and snc_external roles. For more information, see Service Portal widgets.

3. Define the views for the problem, change, and request records and select the fields that are visible to external customers.
   For more information, see Create and delete views.
Enable external customers to create requests

Enable your external customers to create and track requests from the Customer and Consumer Service Portals.

Before you begin
Role required: admin

About this task
Each submitted request generates a case, with the request record associated to that case. Customer service agents can also create requests on behalf of contacts and consumers.

⚠ Note: This feature requires activation of the Customer Service with Request Management plugin (com.sn_cs_sm_request).

External user roles that can create requests from the Customer and Consumer Service Portals are listed in the following table.

<table>
<thead>
<tr>
<th>Role</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer administrator</td>
<td>Users with this role can:</td>
</tr>
<tr>
<td>[sn_customerservice.customer_admin]</td>
<td>• Browse the service catalog and catalog items and make a selection.</td>
</tr>
<tr>
<td></td>
<td>• Create requests for themselves, for other contacts from the same account, or for child accounts.</td>
</tr>
<tr>
<td></td>
<td>• View the request details.</td>
</tr>
<tr>
<td>Partner</td>
<td>Users with this role can:</td>
</tr>
<tr>
<td>[sn_customerservice.partner]</td>
<td>• Browse the service catalog and catalog items and make a selection.</td>
</tr>
<tr>
<td></td>
<td>• Create requests for themselves (if they also have the customer role).</td>
</tr>
<tr>
<td></td>
<td>• Create requests on behalf of the accounts with which they have established relationships.</td>
</tr>
<tr>
<td></td>
<td>• View cases and requests.</td>
</tr>
<tr>
<td>Customer case manager</td>
<td>Users with this role can:</td>
</tr>
<tr>
<td>Role</td>
<td>Actions</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>[sn_customerservice.customer_case_manager]</td>
<td>• Browse the service catalog and catalog items and make a selection.</td>
</tr>
<tr>
<td></td>
<td>• Create requests for themselves or for other contacts from the same account.</td>
</tr>
<tr>
<td></td>
<td>• View the request details.</td>
</tr>
<tr>
<td>Customer</td>
<td>Users with this role can:</td>
</tr>
<tr>
<td>[sn_customerservice.customer]</td>
<td>• Create a request.</td>
</tr>
<tr>
<td></td>
<td>• View the request details.</td>
</tr>
<tr>
<td>Proxy contact</td>
<td>Users with this role can:</td>
</tr>
<tr>
<td>[sn_customerservice.proxy_contact]</td>
<td>• Browse the service catalog and catalog items and make a selection.</td>
</tr>
<tr>
<td></td>
<td>• Create requests on behalf of customers.</td>
</tr>
<tr>
<td></td>
<td>• Add the account and contact information of the customers.</td>
</tr>
<tr>
<td></td>
<td>• View the details of the case and the related request.</td>
</tr>
</tbody>
</table>

**Procedure**

Configure the Case form to display the **Initiated as request** field. When a request is created from the portal, the system creates a case for the request and sets this field to true.

ℹ️ **Note:** The **Initiated as request** field is read-only for all users.

**Related information**

- Create a request on behalf of a customer or consumer
- Request an item or service from the Customer Service Portal

**Enable external customers to approve requests and changes**

Enable your external customers to approve change and request records related to customer service cases from the Customer Service Portal.
**Before you begin**
Role required: admin

**About this task**
Changes and requests related to a case typically require end user approval before the tasks can be completed. Use this feature to send approval requests and enable external customers with the snc_external role to approve those requests as part of the task approval workflow.

From the Customer Service Portal, external customers can:
- View and approve requests and change requests.
- View the details of the requested items in a request record.
- View the status of a request or change request in the Related Records widget.

**Procedure**
1. Add external users to approval groups or assign roles for approval users in order to see approval records on the Customer Service Portal.
2. Add the necessary ACLs to the snc_external role for the following tables.
   - Change Request (change_request)
   - Request (sc_request)
   - Request Item (sc_req_item)

**CSM integration with Service Management overview**
Customer Service Management provides an integration with the Incident, Problem, Change, and Request Management applications. With this integration, users can create request, incident, problem, and change records from customer service cases and external users can view these records from the Customer and Consumer Service Portals.

Integration with the Service Management applications provides the following functionality for internal and external users.
<table>
<thead>
<tr>
<th>User</th>
<th>Functionality</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agents</td>
<td>• Create incident, problem, change, and request records from open cases.</td>
</tr>
<tr>
<td></td>
<td>• Associate existing incident, problem, change, and request records with cases</td>
</tr>
<tr>
<td></td>
<td>• Remove associated records from cases.</td>
</tr>
<tr>
<td>Agents and managers</td>
<td>• View cases with Service Management-related indicators on the Customer Service dashboards.</td>
</tr>
<tr>
<td></td>
<td>• View updates to records associated with a case. These updates automatically update the case work notes.</td>
</tr>
<tr>
<td></td>
<td>• Use the updates to records associated with a case to communicate with customers.</td>
</tr>
<tr>
<td>External users</td>
<td>• View problem, change, and request records associated with cases from the Customer and Consumer Service Portals.</td>
</tr>
<tr>
<td></td>
<td>• Create requests from the Customer and Consumer Service Portals.</td>
</tr>
<tr>
<td></td>
<td>• Approve changes and requests from the Customer Service Portal.</td>
</tr>
</tbody>
</table>

**Plugins**
Customer Service Management integration with Service Management requires the following plugins:

- Customer Service with Service Management plugin (com.sn_cs_sm)
- Customer Service with Request Management plugin (com.sn_cs_sm_request)

For additional information, see [Integrate with Service Management](#).

**Roles**
The Service Management integration plugins do not add any roles to the customer service agent (sn_customerservice_agent) role. To enable the Service Management integration features, you must assign the CSM/ITSM integration roles included with the Incident Management application to the agents who need this capability. For more information, see [Assign CSM/ITSM integration roles](#).
Creating records for a case
The Service Management integration plugins add the following menu items to the Additional Actions menu on the Case form. Agents can use these menu items to create records for a case.

- Create Incident
- Create Problem
- Create Request
- Create Normal Change
- Create Standard Change

**Note:** Agents can create or associate one incident, problem, or change record with a case. After a record is created or associated with a case, the corresponding menu items are no longer available on the Additional Actions menu.

Viewing incident, problem, and change records related to a case
The Service Management integration plugins add the Related Records form section to the Case form. This section includes the following fields:

- Incident
- Problem
- Change Request
- Caused by Change

When an incident, problem, or change record is created from a case, or an existing record is associated with a case, the record number is added to the corresponding field in the Related Records form section.

Viewing requests related to a case
When a request is created from a case, or an existing request is associated with a case, the request record number is added to the Requests related list on the Case form.

**Note:** Agents can create multiple requests for a case.

Using case resolution codes
The Service Management integration plugins provide the following case resolution codes.

Agents can select these codes from the Resolution code field in the Resolution Information section on the Case form.
• Solved – Fixed by closing related PRB
• Solved – Workaround provided based on open PRB
• Solved – Fixed by closing related Change Request
• Solved – Fixed by closing related Incident
• Solved – Related Request is Closed Complete

Service Management integration and Major Issue Management

The major issue management feature works with the CSM integration with Service Management as follows:

• A major issue manager with the itil role can create incident, problem, change, and request records from a major case.
• When a major case candidate with an associated record is accepted as a major case:
  ◦ A new major case is created and the candidate becomes a child of the major case.
  ◦ The related record information is copied from the child case to the major case.
  ◦ For the child case, the options to create related records are removed from the Additional Actions menu.
  ◦ For the child case, the fields in the Related Records form section are read-only.
  ◦ Updates to the related records appear in the work notes of the major case. These updates are added to the child case when fields are synchronized from the major case to the child case.
• A major case and child cases can have different types of related records. This can happen when an existing case with a related incident, problem, change, or request record is added as a child of a major case. When updates are made to the record related to the child case, information about the update is added to the child case work notes.
• If a major case and child cases have the same related record, updates to that record are added to the major case work notes. These notes are copied from the major case to the child cases if:
  ◦ The `sn_customerservice.case_fields_to_sync` property is enabled.
  ◦ The field in the in the Related Records form section is added to the `sn_customerservice.case_fields_to_sync` property.
• If a major case and child cases have different related records of the same type, updates to the records are copied only to the respective cases.
CSM integration with Incident Management

Integration with the Incident Management application enables customer service agents to create incident records from cases or associate existing incident records to cases.

With this integration, customer service agents can:

• Create an incident from a case.
• Associate an existing open incident to a case.
• Remove an associated incident from a case.
• View the following in the case work notes:
  ◦ Incident state changes.
  ◦ Additional comments added to the incident record.

⚠️ Note: A case can be associated with one incident. If a case is already associated with an incident, the Create Incident item does not appear on the Additional Actions menu.

Plugins

Integration with Incident Management requires the Customer Service with Service Management plugin (com.sn_cs_sm).

Roles

The following roles enable customer service agents to view and create incidents for customer service cases.

• sn_incident_read
• sn_incident_write

For more information, see Assign CSM/ITSM integration roles.

Creating an incident from a case

An agent can create an incident from a case by selecting the Create Incident item from the Additional Actions menu. When the incident is created:

• The state of the incident is New.
• The incident number is added to the Incident field in the Related Records form section on the Case form.
• An update with the incident record number is added to the Work notes field on the Case form.
• The domain of the incident is mapped to the domain of the case.
• The following information is copied from the case to the incident record:

### Case to Incident field mapping

<table>
<thead>
<tr>
<th>Case fields</th>
<th>Incident fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Short description</td>
</tr>
<tr>
<td>Default impact</td>
<td>Impact</td>
</tr>
<tr>
<td>Urgency</td>
<td>Urgency</td>
</tr>
<tr>
<td>Contact</td>
<td>Caller</td>
</tr>
<tr>
<td>Configuration item (if available)</td>
<td>Configuration item</td>
</tr>
</tbody>
</table>

**Note:** The agent can manually change the incident impact and urgency to different values on the incident record as needed.

• If the case has an associated Problem, Change Request, or Caused by Change record, this information is also copied to the incident record.

**Determining the incident priority, impact, and urgency**

When creating an incident from a case:

• If the incident data lookup is active, the system copies the case priority to the incident priority and calculates the incident impact and urgency based on the Priority Data Lookup [dl_u_priority] table.

• If the Incident data lookup is inactive, the system uses these default settings for the incident fields:
  ◦ Priority: 5 - Planning
  ◦ Impact: 3 - Low
  ◦ Urgency: 3 - Low

**Synchronizing data between the incident and the case**

Work notes are synchronized from the incident to the case when:

• The incident state changes. If the incident state changes to On Hold, the hold reason is copied to the case work notes.

• The incident is resolved or closed. The incident resolution notes and resolution code are copied to the case work notes.

• Additional comments are added to the incident.
Note: When an incident is created or an existing incident is associated with a case, notification from the incident is suppressed if the caller is an external user (contact or consumer).

Using an extension point to map the Incident field
Customers can create the logic for mapping the Incident field by using the sn_cs_sm.CSMIncidentIntegrations extension point.

Related information
Using extension points to extend application functionality

CSM integration with Problem Management
Integration with the Problem Management application enables customer service agents to create problem records from cases or associate existing problem records to cases.

With this integration, customer service agents can:
• Create a problem from a case.
• Associate an existing open problem to a case.
• Remove an associated problem from a case.
• View problem state changes in the case work notes.

Note: A case can be associated with one problem. If a case is already associated with a problem, the Create Problem item does not appear on the Additional Actions menu.

Plugins
Integration with Problem Management requires the Customer Service with Service Management plugin (com.sn_cs_sm).

Roles
The following roles enable customer service agents to view and create problems for customer service cases.
• sn_problem_read
• sn_problem_write

For more information, see Assign CSM/ITSM integration roles.
Creating a problem from a case
An agent can create a problem from a case by selecting the Create Problem item from the Additional Actions menu. When the problem is created:

- The state of the problem is New.
- The problem is associated with the case and the problem number is added to the Problem field in the Related Records form section on the Case form.
- An update with the problem record number is added to the Work notes field on the Case form.
- The domain of the problem is mapped to the domain of the case.
- The following information is copied from the case to the problem record:

<table>
<thead>
<tr>
<th>Case fields</th>
<th>Problem fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Short description</td>
</tr>
<tr>
<td>Default impact</td>
<td>Impact</td>
</tr>
<tr>
<td>Urgency</td>
<td>Urgency</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority</td>
</tr>
<tr>
<td>Company</td>
<td>Company</td>
</tr>
<tr>
<td>Configuration item (if available)</td>
<td>Configuration item (if blank on case, agent can manually update on problem record)</td>
</tr>
<tr>
<td>Case sys_id (if the com.snc.best_practice.problem.madrid plugin is activated)</td>
<td>First reported by</td>
</tr>
</tbody>
</table>

Note: The agent can manually change the problem impact and urgency to different values on the problem record as needed.

- If the Problem Management Best Practice – Madrid plugin is activated, the case sys_id is added to the First reported by field on the problem record.

Synchronizing data between the problem and the case
With the Problem Management Best Practice – Madrid plugin activated, customer service agents can view the following information in the case work notes:
• When the state of a related problem is updated, the text of the work note includes a link to the problem.

• When Communicate Workaround is clicked from the related problem, the workaround text is copied to the case work notes.

• When Communicate Fix is clicked from the related problem, the fix text is copied to the case work notes.

• When the problem is resolved or closed with a specific resolution code:
  ◦ State is Closed and Resolution Code is Cancelled, the Cancelled Reason text is copied to the case work notes.
  ◦ State is Closed and Resolution Code is Risk Accepted, the Cause notes, Risk accepted reason, and Fix notes are copied to the case work notes.
  ◦ State is Resolved and Resolution Code is Fix Applied, the Cause notes and Fix notes are copied to the case work notes.
  ◦ State is Closed and Resolution Code is Fix Applied, the Cause notes and Fix notes are copied to the case work notes.

With the Problem Management Best Practice - Madrid - Knowledge Integration plugin activated, the customer service agent can view information in the case work notes when a Known Error Article is created for or associated to a related problem. The work note includes a link to the article.

Using an extension point to map the Problem field

Customers can create the logic for mapping the Problem field by using the sn_cs_sm.CaseProblemIntegrations extension point.

Related information

Using extension points to extend application functionality

CSM integration with Change Management

Integration with the Change Management application enables customer service agents to create change records from cases or associate existing change records to cases.

With this integration, customer service agents can:
• Create a change from a case.
• Associate an existing open change to a case.
• Remove an associated change from a case.
• View the following in the case work notes:
○ State changes for the change record.
○ Additional comments added to the change record.

⚠️ **Note:** A case can be associated with one change. If a case is already associated with a change, the **Create Normal Change** and **Create Standard Change** options do not appear on the Additional Actions menu.

**Plugins**
Integration with Change Management requires the Customer Service with Service Management plugin (com.sn_cs_sm).

**Roles**
The following roles enable customer service agents to view and create changes for customer service cases.

- sn_change_read
- sn_change_write

For more information, see Assign CSM/ITSM integration roles.

**Creating a normal change from a case**
An agent can create two types of change records from a case: normal change and standard change.

To create a normal change, select **Create Normal Change** from the Additional Actions menu. When the change is created:

- The state of the change state is New.
- The change is associated with the case and the change number appears in the **Change Request** field in the Related Records form section on the Case form.
- An update with the change record number is added to the **Work notes** field on the Case form.
- The **Requested by** field on the change record is updated with the case agent.
- The domain of the change is mapped to the domain of the case.
- The following information is copied from the case to the change record:

<table>
<thead>
<tr>
<th>Case fields</th>
<th>Change fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Short description</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Case fields
<table>
<thead>
<tr>
<th>Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Impact</td>
<td>Impact</td>
</tr>
<tr>
<td>Urgency</td>
<td>Urgency</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority</td>
</tr>
<tr>
<td>Company</td>
<td>Company</td>
</tr>
<tr>
<td>Contact</td>
<td>Caller</td>
</tr>
<tr>
<td>Configuration item (if available)</td>
<td>Configuration item</td>
</tr>
</tbody>
</table>

#### Note:
The change manager can update the configuration item on the change record. If the configuration item is not available, the agent can also manually update this information.

- Default values are added to the following fields on the change record:
  - **Type**: Normal
  - **State**: New
  - **Category**: Other
  - **Risk**: Moderate

### Creating a standard change from a case
An agent can create two types of change records from a case: normal change and standard change.

To create a standard change, select **Create Standard Change** from the Additional Actions menu. The change record is created using the Standard Change template, which is defined in the Standard Change catalog. The data mapping is created from the template; no data is copied from the case to the change record.

### Synchronizing data between the change and the case
Work notes are synchronized from the change to the case when:
- The change state or change type is updated.
- Additional comments are added to the change record.
• When the change associated with a case is put on hold, the work notes are updated with the hold reason.

• When a hold on the change associated with a case is removed, the work notes on the case are updated.

• When the change is resolved or closed.

**Change form related lists**
Integration with the Change Management application adds the following related lists to the Change form:

• Cases Fixed by Change

• Cases Caused by Change

**Standard change record producer behavior**
When a record producer for a standard change or normal change is created and exposed to customer service agents from the Customer or Consumer Service Portals:

• The record producer only appears in the portal after clicking the **Create Request** UI action.

• The record producer does not appear as part of Standard Change catalog items.

• If the agent chooses to create a Standard Change from the normal record producer, the Standard Change is created but the change record is not linked with the case.

**Using an extension point to map the Change Request field**
Extension points enable you to extend the functionality of an application and integrate customizations without altering the application code. Extension points are stored in the Extension Point [sys_extension_point] table.

The Customer Service with Service Management plugin (com.sn_cs_sm) adds the **CSMChangeIntegrations** extension point, which exposes generic APIs that are used for Case to Change integration.

<i>Note:</i> The **CSMChangeIntegrations** extension point is read-only. To modify this extension point, contact ServiceNow Customer Support.

The Customer Service with Service Management plugin also adds an implementation of the **CSMChangeIntegrations** extension point. This implementation can be modified and deactivated; however, this is not recommended.
If it is necessary to modify the APIs within the `CSMChangeIntegrations` extension point, users with the system administrator role can:

- Create an implementation of an extension point.
- Make the necessary changes in the implementation.
- Update the order of the implementation to a lower number. The system executes the implementation with the lowest order number.

**Note:** API names used in the implementation must remain exactly the same, otherwise the extension point will not be able to identify the implementation and will result in an error.

For example, the `CSMChangeIntegrations` extension point includes the following API for creating a change from a case record. The API name is displayed in red.

```
copyFieldsFromCaseToChange: function(changeGr, caseGr) {
  changeGr.short_description = caseGr.short_description;
  changeGr.cmdb_ci = caseGr.cmdb_ci;
  changeGr.impact = caseGr.impact;
  changeGr.urgency = caseGr.urgency;
  changeGr.priority = caseGr.priority;
  changeGr.company = caseGr.account;
  changeGr.sys_domain = caseGr.sys_domain;
}
```

To modify this API, create an implementation of the extension point and make the desired changes without changing the API name.

```
copyFieldsFromCaseToChange: function(changeGr, caseGr) {
  changeGr.abcd = caseGr.abcd;
}
```

**Related information**

Using extension points to extend application functionality

**CSM integration with Request Management**

Integration with the Request Management application enables customer service agents to create request records from cases or associate existing request records to cases. It also enables customers to create requests from the Customer and Consumer Service Portals.
With this integration, customer service agents can:

- Create one or more requests on behalf of a customer from an existing customer service case.
- Associate an existing request to a case.
- Remove an associated request from a case.
- View a list of requests associated with a case in the Requests related list.
- View the following in the case work notes:
  - Request state changes.
  - Additional comments added to the request record.

⚠️ **Note:** When creating a request from a case, if the agent chooses a catalog item that is using cart v1 (the use_sc_layout field is not checked), the case is not set as the parent of the request.

**Plugins**

Integration with Request Management requires the Customer Service with Request Management plugin (com.sn_cs_sm_request).

**Roles**

The following roles enable customer service agents to view and create requests for customer service cases.

- `sn_request_read`
- `sn_request_write`

For more information, see Assign CSM/ITSM integration roles.

**Creating a request from the Customer and Consumer Service Portals**

Customers can create and submit requests from the Customer and Consumer Service Portals. The request process is integrated with Service Catalog.

⚠️ **Note:** Partners, partner administrators, and proxy contacts can submit requests on behalf of other accounts or contacts with the addition of the following variable set to the desired catalog items: `csm_request_variable_set`. This variable set adds the Account and Contact fields. For more information, see Service catalog variable sets.

When the customer selects a catalog item and submits a request:
• A new case is created, which becomes the parent of the request. One request is associated with a case and a request contains one item.

• The case is used as the reference for the customer, who can see the request status and updates from the case on the Customer Service Portal.

• All cases associated with a request appear on the request record in the Cases related list.

• The following information is copied from the request to the case:

<table>
<thead>
<tr>
<th>Request to case field mapping</th>
</tr>
</thead>
<tbody>
<tr>
<td>Request fields</td>
</tr>
<tr>
<td>Short description</td>
</tr>
<tr>
<td>Requested for</td>
</tr>
<tr>
<td>Account</td>
</tr>
</tbody>
</table>

Creating a request using the Customer Service Management application
Customer service agents can browse the catalog and make a selection to create a request on behalf of a customer.

• From Agent Workspace, agents can create requests from case and interaction records.

• From the platform interface, agents can create requests from case records by selecting the Create Request item from the Additional Actions menu.

When the request is created:

• The state of the request is New.

• The case becomes the parent of the request. The case number is added to the Parent field on the Request form.

• The request is associated with the case and is added to the Requests related list on the Case form.

• An update with the request record number is added to the Work notes field on the Case form.

• The domain of the request is mapped to the domain of the case.

• The following information is copied from the case to the request record:
Case to request field mapping

<table>
<thead>
<tr>
<th>Case fields</th>
<th>Request fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Short description</td>
</tr>
<tr>
<td>Contact</td>
<td>Contact</td>
</tr>
</tbody>
</table>

**Synchronizing data between the request and the case**
Work notes are synchronized from the request to the case when:
- The request state changes.
- The request is closed.
- Additional comments are added to the request.

⚠️ **Note:** When a request is closed, the case does not automatically move to solution proposed.

**Communicating with the requester**
The task fulfiller can communicate with the requester if additional information is needed. Use the **Additional comments** field on the request to communicate with the requester through the case. Information added to the **Additional comments** field on the request is synchronized to the case work notes.

If the case is the parent of the request, notifications to the requester are suppressed when additional comments are added to the request by the fulfiller.

**Extension points**
Customers can create the logic for mapping the **Request** field by using the `sn_cs_sm_request.CSMRequestIntegrations` extension point.

**Related information**
- Using extension points to extend application functionality
- Create a request on behalf of a customer or consumer
- Request an item or service from the Customer Service Portal

**Service catalog integration with the Customer and Consumer Service Portals**
Users with the customer administrator role (`sn_customerservice.customer_admin`) can associate a portal with a service catalog.

The following catalog pages and widgets are provided as part of the Customer Service with Request Management integration.
For more information, see Associate a portal with a catalog.

CSM Catalog page
This is the display page for catalog items on the Customer and Consumer Service Portals. This page serves as the landing page for any service catalog item exposed on a CSM portal. All request items exposed on the CSM portals are either service catalog items or service catalog record producers. Navigate to Service Portal > Pages to view this page.

• Page ID: csm_sc_cat_item
• Update name: sp_page_7ea80b123bb31300bfe04d72f3efc4b7
• Available to roles: snc_internal, snc_external

CSM Catalog Item widget
This widget handles the redirection logic on submission of the catalog item and embeds the default catalog item widget. This widget listens to event $sp.sc_cat_item.submitted. On submission of a catalog item, it handles the portal redirection logic based on the page_id and the catalog portal URL. When there is no parent set in the Requests (sc_request) table, the URL is redirected to the default service portal ticket page. If a record producer has a redirect URL, this widget uses the redirect URL from the record producer instead of redirecting to the ticket page.

• Widget ID: csm-sc-cat-item
• Update name: sp_widget_ec837c713bbb1300bfe04d72f3efc4d1
• Available to roles: snc_internal, snc_external

Page route map
It is important to set up a page route map for any new Service Portals to handle the redirection to the Case ticket page. The redirection is based on the logic described in the CSM Catalog Item widget.

• CSM Catalog item page route map: for the Customer Service Portal, this page route map routes the URL redirect from the sc_cat_item page to the csm_sc_cat_item page.
• CSP Catalog item page route map: for the Consumer Service Portal, this page route map routes the URL redirect from the sc_cat_item page to the csm_sc_cat_item page.

Portal settings for catalog items
Once the catalog items are defined, visibility of the Submit/Add to Cart button can be controlled by navigating to Service Catalog > Catalog Definitions >
Maintain Items, selecting the desired item, and enabling or disabling the fields in the Portal Settings form section.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Request method</td>
<td>Select Order, Request, or Submit as the type of catalog item.</td>
</tr>
<tr>
<td>Hide ‘Add to Cart’</td>
<td>Enable if the Add to Cart button should be disabled for the catalog item.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The Add to Cart button is not currently supported on the Customer Service Portal or the Consumer Service Portal.</td>
</tr>
<tr>
<td>Hide Quantity</td>
<td>Enable if the Quantity of the catalog item should be hidden.</td>
</tr>
<tr>
<td>Hide Delivery Time</td>
<td>Enable if the Delivery Time of the catalog item should be hidden.</td>
</tr>
<tr>
<td>Hide ‘Add to Wish List’</td>
<td>Enable if the Add to Wish List button for the catalog item should be hidden.</td>
</tr>
<tr>
<td>Hide Attachment</td>
<td>Enable if the attachment of the catalog item should be hidden.</td>
</tr>
</tbody>
</table>

Enabling external customers to view problem, change, and request records

External customers can view the problem, change, and request records associated with their customer service cases from the Customer and Consumer Service Portals.

You can provide read-only access to external users so that they can view the problem, change, and request records that are related to their cases. After logging in to the Customer or Consumer Service Portal, users can select a case and view the related records in the Related Records list widget. They can also click a record in this list to open the record details in a pop-up window.

**Note:** The Related Records list shows data only if the logged in user has access to view the related records.
Customers, customer partners, and internal users with the proxy contact role (sn_customerservice.proxy_contact) can also create requests from the Customer and Consumer Service Portals. For more information about this feature, see Create cases as a proxy contact.

**Required roles**

Users with the snc_internal or snc_external role and with read access to the related records can see the problem, change, and request records related to a case.

**Configuration**

To enable external users to see the records related to a case, the system administrator needs to perform the following configuration tasks:

- Configure ACLs for the snc_external role.
- Configure the Case Related Records widget.
- Define the views for the problem, change, and request records.

For more information, see Viewing problem, change, and request records

**Viewing problem, change, and request records**

Customers can also view Known Error articles for a problem related to a case. These articles are displayed:

- If there is a KE article present for the problem record. If there are multiple articles associated with the problem, the customer has access to the primary article. If there are no articles, the customer does not see the link.
- If the customer has access to the KE article.

**Configuration**

To configure this feature, the system administrator can:

- Assign the required roles to the customer service agents and managers who will be creating the request, problem, and change records from customer service cases.
- Provide access to problem, change, and request records by configuring ACLs for the snc_external role. This access is not provided out of box. The admin must add these ACLs to the snc_external user role based on case access.

**Note:** Existing ACLs on the problem, change, and request records may impact the visibility for external users.
• Configure the Case Related Records widget. By default, this widget is displayed for users with the snc_internal and snc_external roles.

• Define the views for the problem, change, and request records and select the fields that are visible to external customers. For more information, see Create and delete views.

Related information
Assign CSM/ITSM integration roles

Related records list widget
When viewing a case on the Customer or Consumer Service Portal, external users can see other records that are associated with the case in the Related Records list widget.

These records can include problems, changes, and requests. Users can click a record in the Related Records widget to view additional details in a pop-up window.

Request records
For request records, users can:

• Expand or collapse a request and view a list of the items associated with the request.

• Click an item in this list to see additional information, including the state of the requested item.

⚠️ Note: If a case does not have any related records, the Related Records widget does not appear on the case view page.

From the Customer and Consumer Service Portals, users can view lists of cases and requests by doing one of the following:

• Clicking My Lists in the portal menu header.

• Clicking Requests > All Requests in the portal menu header.

The list view page includes a My Lists filter with the following options:

• All: displays all case and request records.

• Action Needed: displays cases in the Resolved state that are waiting for a customer response.

• My Issues: displays the cases that were not initiated as a request.

• My Requests: displays the cases that were created as a request.
Enabling users to approve changes and requests from the Customer Service Portal

Enable your contacts to approve change and request records related to customer service cases from the Customer Service Portal.

Changes and requests related to a case typically require end user approval before the tasks can be completed. The tasks can be initiated by customers and by external users. For example:

- A customer creates a change in order to apply a patch. This change requires approval from the contact before the patch can be applied.
- A contact requests a catalog item from the Customer Service Portal. This request requires approval by another employee within the contact's organization before the request can be fulfilled.

Use this feature to send approval requests to contacts and enable external customers with the snc_external role to approve those requests as part of the task approval workflow.

From the Customer Service Portal, external customers can:

- View and approve requests and change requests.
- View the details of the requested items in a request record.
- View the status of a request or change request in the Related Records widget.

Plugins

This feature requires the following plugins:

- Customer Service (com.sn_customerservice)
- Customer Service with Service Management (com.sn_cs_sm)
- Customer Service with Request Management (com.sn_cs_sm_request)

Configuration

To configure this feature, the system administrator must complete the following tasks:

- Add external users to approval groups or assign roles for approval users in order to see approval records on the Customer Service Portal.
- Add the necessary ACLs to the snc_external role for these tables:
  - Change Request (change_request)
  - Request (sc_request)
  - Request Item (sc_req_item)
Users with the snc_external role have access to the Approval table (sysapproval_approver).

**Extension points**

This feature includes an extension point that can be used to configure approval entities: global.CSMApprovalsManagement. Use this extension point to extend the approval functionality to any other entity, such as problem.

**Integration with Service Management applications**

Provides an integration between Customer Service Management and the Incident, Problem, Change, and Request Management applications.

Customer service agents with the itil role can create incident, problem, change, and request records from open cases in Agent Workspace.

**Create a request**

Agents can create one or more requests from a case. To create a request from a case in Agent Workspace:

1. Select **Create Request** from the Additional Actions menu to open a New Catalog Item tab.
2. Select the desired item from the catalog and click **Order now**.
3. Click **Checkout** on the Order Confirmation pop-up window.

The request number and some request information is displayed, with the option to view additional details or close the window. Clicking **View details** opens the request record.

Information about the request is added as follows:

- An update with the request number is added to the case work notes.
- The request record is added to the Requests related list.
- Updates to the Additional comments on the request record are copied to the case work notes.

**Create an incident**

Agents can create one incident from a case or associate one existing incident to a case. To create an incident from a case in Agent Workspace, select **Create Incident** from the Additional Actions menu to open an Incident record in a new tab.

The following information is copied from the case to the incident record:
Information about the incident is added as follows:

- An update with the incident number is added to the case work notes.
- The incident is added to the **Incident** field in the **Related Records** form section on the case form.
- Updates to the work notes on the incident are copied to the case work notes.

**Create a change**

Agents can create one change from a case or associate one existing change to a case. To create a change from a case in Agent Workspace, select **Create Normal Change** from the Additional Actions menu to open a Change record in a new tab.

The following information is copied from the case to the change record:

<table>
<thead>
<tr>
<th>Case fields</th>
<th>Change fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Short description</td>
</tr>
<tr>
<td>Description</td>
<td>Description</td>
</tr>
<tr>
<td>Impact</td>
<td>Impact</td>
</tr>
<tr>
<td>Urgency</td>
<td>Urgency</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority</td>
</tr>
<tr>
<td>Company</td>
<td>Company</td>
</tr>
<tr>
<td>Contact</td>
<td>Caller</td>
</tr>
<tr>
<td>Configuration item (if available)</td>
<td>Configuration item</td>
</tr>
</tbody>
</table>
Information about the incident is added as follows:

- An update with the change number is added to the case work notes.
- The change is added to the **Change Request** field in the **Related Records** form section on the case form.
- Updates to the work notes on the change are copied to the case work notes.
- If a change is put on hold, the hold reason is also copied to the case work notes.

**Create a problem**

Agents can create one problem from a case or associate one existing problem to a case. To create a problem from a case in Agent Workspace, select **Create Problem** from the Additional Actions menu to open a Problem record in a new tab.

The following information is copied from the case to the problem record:

<table>
<thead>
<tr>
<th>Case fields</th>
<th>Incident fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>Problem statement</td>
</tr>
<tr>
<td>Impact</td>
<td>Impact</td>
</tr>
<tr>
<td>Urgency</td>
<td>Urgency</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority</td>
</tr>
<tr>
<td>Company</td>
<td>Company</td>
</tr>
<tr>
<td>Configuration item (if available)</td>
<td>Configuration item (if blank on case, agent can manually update on problem record)</td>
</tr>
<tr>
<td>Case sys_id (if the com.snc.best_practice.problem.madrid plugin is activated)</td>
<td>First reported by</td>
</tr>
</tbody>
</table>
Information about the problem is added as follows:

- An update with the problem number is added to the case work notes.
- The problem is added to the Problem field in the Related Records form section on the case form.
- Updates to the work notes on the problem are copied to the case work notes.

Related information

Customer Service integration with Service Management

Integrate with Service Portfolio Management

Customer Service Management provides an integration with the Service Portfolio Management (SPM) application. This integration gives customer service managers, customer service agents, and service owners visibility into sold products and their associated service offerings.

About this task

For more details on the integration with Service Portfolio Management, see Customer Service Management integration with Service Portfolio Management.

To configure the integration with Service Portfolio Management, use the Customer Service guided setup. The guided setup takes you through the entire setup and configuration process.

Procedure

1. Navigate to Customer Service > Administration > Guided Setup.
2. On the Getting Started page of the guided setup, click Get Started
3. In the Integration with Service Portfolio Management (SPM) category, view the list of tasks to configure the feature.

Service Portfolio Management configuration tasks

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate Customer Service Management with SPM</td>
<td>Activate the Customer Service with SPM plugin to use the integration with Service Portfolio Management.</td>
</tr>
<tr>
<td>Configure form views</td>
<td>Configure the form layout and related lists for the Sold Product, Case, Account, and Service Offering forms to provide users with the</td>
</tr>
</tbody>
</table>
### Task Description

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>correct visibility into which service offerings are associated to which sold products.</td>
</tr>
<tr>
<td>Assign roles</td>
<td>Assign the required roles to customer service managers based on the roles and responsibilities in your organization.</td>
</tr>
</tbody>
</table>

4. To perform a task, click **Configure**.
   
   This button opens the page in your instance where the configuration is completed.

**Related information**

**Service Portfolio Management**

**Activate Customer Service Management with Service Portfolio Management**

Activate the Customer Service with Service Portfolio Management (SPM) plugin to use the integration with Service Portfolio Management.

**Before you begin**

Instead of doing the configuration through this procedure, consider using guided setup. Navigate to **Customer Service > Administration > Guided Setup > Get Started**.

Role required: admin

**Procedure**

1. Navigate to **System Definition > Plugins**.
2. Search for the plugin `sn_csm_spm`.
3. Click **Activate**.

**Configure form views for Service Portfolio Management integration**

Configure the form layout and related lists for the Sold Product, Case, Account, and Service Offering forms to provide users with the correct visibility into which service offerings are associated to which sold products.

**Before you begin**

Instead of doing the configuration through this procedure, consider using guided setup. Navigate to **Customer Service > Administration > Guided Setup > Get Started**.
Role required: admin

Procedure
2. Add the following fields to forms and related lists, as required.

<table>
<thead>
<tr>
<th>Form</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Offering</td>
<td>Add the Subscribed by Customers related list to provide service owners visibility into which customers have subscribed to which service offerings.</td>
</tr>
<tr>
<td>Product Model forms</td>
<td>Add the Offerings (Offering &gt; Model ID) related list on the Product Model/Service Model forms to enable customer service managers to associate service offerings to product models. To enable the Edit button on the Offerings related list:</td>
</tr>
<tr>
<td></td>
<td>a. Configure the list control and deselect the Omit Edit check box.</td>
</tr>
<tr>
<td></td>
<td>b. Add the sn_customerservice_manager role.</td>
</tr>
<tr>
<td></td>
<td>If you do not see the Edit button enabled, see Assign roles for Service Portfolio Management integration for more details.</td>
</tr>
<tr>
<td></td>
<td>Note: To configure catalog items for product models, add the Catalog Items related list. For more information, see Configure product model and catalog item relationships.</td>
</tr>
<tr>
<td>Sold Products on the Account form</td>
<td>Add the Service Offering column to the Sold Products related list to enable customer service agents or managers to view service offerings associated to the sold product for an account or consumer.</td>
</tr>
<tr>
<td>Case</td>
<td>Add the Service Offering field for the Sold Product to the Case form. This enables customer service agents dealing with customer issues to see the service offering associated to sold product for a case.</td>
</tr>
</tbody>
</table>
Add the **Service Offering** field to the Sold Product form to enable customer service managers to associate a service offering to a sold product for an account or consumer.

### Assign roles for Service Portfolio Management integration

Assign the required roles to customer service managers based on the roles and responsibilities in your organization.

**Before you begin**

Instead of doing the configuration through this procedure, consider using guided setup. Navigate to **Customer Service > Administration > Guided Setup > Get Started**.

Role required: admin

### Procedure

1. Assign the service_editor role to customer service managers if they need to update any service offerings they own.

2. Assign the portfolio_admin role to customer service managers if they need to associate service offerings to a product model.

### Customer Service Management integration with Service Portfolio Management

Customer Service Management provides an integration with the Service Portfolio Management (SPM) application. This integration gives customer service managers, customer service agents, and service owners visibility into sold products and their associated service offerings.

Using the integration between Customer Service Management and Service Portfolio Management has the following benefits:

- Increase customer service agent productivity: Empower customer service agents to quickly view the service offerings and associated definitions for sold products.

- Increase service owner productivity: Empower service owners to quickly identify customers subscribed to services.

The Customer Service Management integration with Service Portfolio Management can be used in the following ways.
1. Customer service managers can associate service offerings to product models. For more details, see Associate service offerings to product models.

2. Customer service managers can associate service offerings to sold products. For more details, see Associate service offerings with sold products.

3. Service owners can view service offerings and which customers have subscribed to them.

4. Customer service agents can view which service offerings are associated to the sold products affected by an issue. They can also see the service commitments and availability. For more details, see View sold product information in CSM workspaces.

Activation information
Activate the following plugin.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Service with Service Portfolio Management (SPM) [sn_csm_spm]</td>
<td>Enables integration with the Service Portfolio Management (SPM) application. This integration gives customer service managers, customer service agents, and service owners visibility into sold products and their service offerings.</td>
</tr>
</tbody>
</table>

Roles
Ensure that users can perform all the necessary actions by assigning roles.

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>service_editor</td>
<td>Assign this role to customer service managers if they need to update any service offerings they own.</td>
</tr>
<tr>
<td>portfolio_admin</td>
<td>Assign this role to customer service managers if they need to associate service offerings to a product model.</td>
</tr>
</tbody>
</table>

Integrate with Continual Improvement Management
Customer Service Management provides an integration with the Continual Improvement Management application. This integration enables you to request...
improvement opportunities and to implement phases and tasks to meet performance goals, track progress, and measure success.

**Before you begin**
Role required: admin

**Procedure**
1. Navigate to **System Definition > Plugins**.
2. Search for the Continual Improvement Management (com.sn_cim) plugin.
3. Click **Activate**.

**Integrating with Continual Improvement Management**
Use the Continual Improvement Management (CIM) application with Customer Service Management (CSM) to request improvement opportunities and to implement phases and tasks to meet performance goals, track progress, and measure success.

You can use CIM for improvements to Performance Analytics (PA) indicators and to service operations. For example, create a new improvement initiative to:
- Reduce the open case backlog.
- Improve the average case response time.

See **Continual Improvement Management** for more information about how CIM can help you with setting goals, organizing effort, and completing tasks.

**Use CIM with Customer Service Management**
To use CIM with Customer Service Management, you must request the Continual Improvement Management (com.sn_cim) plugin. For more information, see **Request Continual Improvement Management**.

**Related information**
- Continual Improvement Management overview
- Continual Improvement Management roles
- Requesting improvements
- Managing improvements
Integrate with Field Service Management

Customer Service Management provides an integration with the Field Service Management application. This integration enables you to view work order and work order task information from a case.

Before you begin
Role required: admin

Procedure
1. Navigate to System Definition > Plugins.
3. Click Activate.

Integrating with Field Service Management


Users can view account and contact information on work orders and work order tasks in the Field Service Management application. Customers and consumers can view case-related work orders from the Customer Service and Consumer Service Portals.

When an agent creates a work order from a customer service case, the work order and task forms include case-related information such as the account and contact.

When a customer or a consumer views a case from either the Customer or Consumer Service Portals, they can view the details of any work orders and tasks related to the case.

Product use rights included with this application

If you have purchased a subscription for the Field Service Management (FSM) application, Customer Service Management users can create and view all FSM work orders and appointments. External CSM users can create and view FSM work orders and appointments of their own or related accounts.

Changes to the Field Service Management application

In the Field Service Management application, this integration adds the following fields to the Work Order form. These fields are visible in the Case view. To display these fields, right-click the Work Order form header and select View > Case.
• Account
• Consumer
• Contact
• Asset
• Partner
• Partner Contact

Updating the **Account** field on the Work order form also updates the **Company** field. Updating the **Contact** field on the Work Order form updates the **Caller** field.

**Changes to the Customer Service Management application**

In the Customer Service Management application, this integration adds the **Work Orders** link to the Customer Service Portal and Consumer Service Portal headers. Click this link to view a list of work orders, including the work order number, priority, state, and short description. The work orders displayed in this list on the Customer Service Portal depend on the customer role: customer, customer admin, partner, or partner admin.

Click a work order in this list to display the work order details.

**Known Limitations**

There is no synchronization between the Work Order form and the associated Case form. If information changes on the Case form, it does not get updated on the Work Order form.

**Integrate with ITOM Event Management**

Customer Service Management provides an integration with the ITOM Event Management application. This integration enables you to create cases proactively from alerts either manually or through automation and track the accounts and the corresponding install base items affected by the alert.

**Before you begin**
Role required: admin
Procedure

1. Navigate to **System Definition > Plugins**.
3. Click **Activate**.

Integrating with IT Operations Management


This integration enables you to create cases proactively from alerts either manually or through automation and track the accounts and the corresponding install base items affected by the alert. It also enables you to view the service health status of their install base items.

For more information, see **Integration with Event Management**.

Integrate with Customer Project Management

You can configure a number of different processes and components for the Customer Project Management feature.

Use the Customer Service Management Guided Setup to configure Customer Project Management. Navigate to **Customer Service > Administration > Guided Setup > Customer Project Management**. The table below provides a description of the configuration steps included in this guided setup section.

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate Project Portfolio Suite</td>
<td>Activate the Project Portfolio Suite with Financials plugin (com.snc.financial_planning_pmo).</td>
</tr>
<tr>
<td>with Financials.</td>
<td></td>
</tr>
<tr>
<td>Management.</td>
<td></td>
</tr>
<tr>
<td>Configure form views.</td>
<td>Configure the Case form and add the following fields to the Case view, Workspace view, and Customer Self Service view:</td>
</tr>
<tr>
<td></td>
<td>• Project</td>
</tr>
<tr>
<td></td>
<td>• Project Task</td>
</tr>
<tr>
<td>Task</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Configure related lists. | Configure the Account form and add the **Projects** related list to the Case view and Workspace view.  
Configure the Contact form and add the **Projects** related list to the Case view and Workspace view.  
Configure the Customer Project Task form and add the following related lists to the **Default** view: **Work Order > Initiated From**.  

**Note:** This step can only be completed if the following plugins are active:  
• Customer Service with Field Service Management (com.snc.csm_fsm_integration)  
• Field Service with Project Management (com.snc.wm_ppm) |
| Configure notifications. | Configure the **Send Email to Contact when Customer Project Task is assigned** Flow Designer flow to send an email to the assigned contact when a customer project task is assigned.  
This notification includes the following details and can be configured as necessary:  
• Project number and name  
• Task number and short description  
• Task planned start and end dates and duration |
<p>| Configure Flow Designer flows. | Use Flow Designer flows provided with Customer Project Management to: |</p>
<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Project Issue from Case</td>
<td>When a project issue is created from a case, this flow copies the <strong>Priority</strong> and <strong>Short description</strong> fields from the case to the project issue record. This flow is active by default.</td>
</tr>
<tr>
<td>Create Project Change Request from Case</td>
<td>When a project change request is created from a case, this flow copies the <strong>Priority</strong> and <strong>Short description</strong> fields from the case to the project change request record. This flow is active by default.</td>
</tr>
</tbody>
</table>

**Update and Close Case Record on Issue Closure**: This flow enables you to automatically:

- Update the case work notes when the state of an associated issue is updated.
- Close a case if the state of the associated issue is set to Closed.

Activate this flow as needed.

**Update and Close Case Record on Project Change Closure**: This flow enables you to automatically:

- Update the case work notes when the state of an associated project change request is updated.
- Close a case if the state of the associated project change request is set to Closed.
<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate this flow as needed.</td>
<td></td>
</tr>
<tr>
<td>Assign Access Controls (ACLs)</td>
<td>Assign ACLs to the Customer Service Management user roles to provide access to the Project Portfolio Management tables, including the Project Change Request, Status Report, and Issues tables.</td>
</tr>
</tbody>
</table>

### Configure integration with Project Portfolio Management with Financials

Customer Service Management provides an integration with the Project Portfolio Suite with Financials application. This integration, Customer Project Management, enables customers to manage complex projects with multiple tasks and provide end users with visibility into these projects.

Customers can use this integration to create projects and project tasks for their customer accounts. Customers can also provide end users with visibility into their projects and tasks from the Customer Service Portal and enable them to request additional actions.

For more information about this feature, see [Customer Project Management](#).

### Product use rights included with this application

When subscribed to the IT Business Management (ITBM) Subscription Product, Customer Service Management users can create and edit projects. External CSM users can view projects and edit project tasks of their own or related accounts.

### Plugin

Users with the system administrator role can activate the Customer Project Management plugin (com.snc.csm_ppm).

**Note:** This plugin requires the Customer Service plugin (com.sn_customerservice) and the Project Portfolio Suite with Financials plugin (com.snc.financial_planning_pmo).

The Customer Project Management plugin adds the **Customer Service > Projects** module to the application navigator. Users with the customer project manager role can access this module.

### Customer Project Management

Customer Service Management provides an integration with the ServiceNow® PPM Standard application, earlier known as Project Portfolio Suite with Financials. This integration, Customer Project Management, enables ServiceNow customers...
to manage complex projects with multiple tasks and provide end users with visibility into these projects.

ServiceNow customers can use this integration to create projects and project tasks for their customer accounts. Customers can also provide end users with visibility into their projects and tasks from the Customer Service Portal and enable them to take additional actions.

**Plugin**

Users with the system administrator role can activate the Customer Project Management plugin (com.snc.csm_ppm).

ℹ️ **Note:** This plugin requires the Customer Service plugin (com.sn_customerservice) and the Project Portfolio Suite with Financials plugin (com.snc.financial_planning_pmo).

The Customer Project Management plugin adds the Customer Service > Projects module to the application navigator. Users with the customer project manager role can access this module.

**Customer Project Management Guided Setup**


**Customer Project Management personas, roles, and tasks**

An overview of the tasks that can be performed by the different Customer Project Management roles.

**Personas and roles**

<table>
<thead>
<tr>
<th>Persona</th>
<th>Description</th>
<th>Required roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer project manager</td>
<td>A user who creates and manages projects for customer accounts.</td>
<td>• it_project_manager</td>
</tr>
<tr>
<td></td>
<td>• Creates new projects.</td>
<td>• sn_customerservice.projectmanager</td>
</tr>
<tr>
<td></td>
<td>• Sets up project tasks and resource plans.</td>
<td></td>
</tr>
<tr>
<td>Persona</td>
<td>Description</td>
<td>Required roles</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>• Identifies customer contacts who have access to projects and project tasks.</td>
<td>• sn_customerservice.projectstakeholder</td>
</tr>
<tr>
<td></td>
<td>• Assigns and manages tasks and dependencies.</td>
<td>• At least one CSM role</td>
</tr>
<tr>
<td>Project stakeholder</td>
<td>A user who is responsible for activities that require viewing customer project details and project tasks.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Works on cases created from projects and project tasks.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Communicates with the customer on case status.</td>
<td></td>
</tr>
<tr>
<td>Customer service agent</td>
<td>A user who can create cases from projects and project tasks and resolve cases within the set SLA.</td>
<td>• sn_customerservice_agent</td>
</tr>
<tr>
<td></td>
<td>• Works on cases created from projects and project tasks.</td>
<td>• sn_customerservice.projectstakeholder</td>
</tr>
<tr>
<td></td>
<td>• Communicates with the customer on case status.</td>
<td></td>
</tr>
<tr>
<td>Customer</td>
<td>An external user who is responsible for overseeing the project delivery.</td>
<td>Any of the following CSM external roles:</td>
</tr>
<tr>
<td></td>
<td>• Reviews project status and progress on the Customer Service Portal.</td>
<td>• sn_customerservice.customer</td>
</tr>
<tr>
<td></td>
<td>• Completes assigned tasks.</td>
<td>• sn_customerservice.customer_admin</td>
</tr>
<tr>
<td></td>
<td>• Creates cases for project issues.</td>
<td>• sn_customerservice.partner</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• sn_customerservice.partner_admin</td>
</tr>
</tbody>
</table>

**Customer project manager tasks**

A customer project manager requires the following roles:
• it_project_manager
• sn_customerservice.projectmanager

With these roles, a customer project manager can perform the tasks described in the following table.

<table>
<thead>
<tr>
<th>Task</th>
<th>Details</th>
</tr>
</thead>
</table>
| Create a project for a customer account       | 1. Navigate to Customer Service > Projects > Create New.  
2. Enter a name for the project in the Project Name field.  
3. Select an account in the Account field.  
4. Fill in additional project information.  
5. Click Save.                                      |
| Create a project for a customer account from a project template | 1. Navigate to Customer Service > Projects > Create New.  
2. Click a template at the bottom of the form to apply the template to the project. If the templates do not appear at the bottom of the form, click the More options icon at the top of the form and select Toggle Template Bar.  
3. Enter a name for the project in the Project Name field.  
4. Select an account in the Account field.  
5. Fill in additional project information.  
6. Click Save.                                      |
| Create a project task for a customer project  | 1. Navigate to Customer Service > Projects > All.  
2. Select a project.  
3. In the Project Tasks related list, click New. |
<table>
<thead>
<tr>
<th>Task</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>4. Add a short description for the task. 5. Fill in additional project task information. 6. Click <strong>Save</strong>.</td>
<td><strong>Identify the project tasks on a project template that are visible to external customers</strong></td>
</tr>
<tr>
<td><strong>Identify project tasks that are visible to external users</strong></td>
<td>1. Navigate to <strong>Customer Service &gt; Projects &gt; Templates</strong>. 2. Select a template. 3. In the <strong>Project Template Tasks</strong> related list, select a task. 4. In the Data section of the Project Template Task form, add the <strong>Visible to customer</strong> field and set it to <strong>true</strong>. 5. Click <strong>Update</strong>. 6. Repeat for other project tasks as needed.</td>
</tr>
<tr>
<td><strong>Identify the account contacts who have access to a project</strong></td>
<td>1. Navigate to <strong>Customer Service &gt; Projects &gt; All</strong>. 2. Select a project. 3. In the <strong>Project Tasks</strong> related list, select a task. 4. Enable the <strong>Visible to customers</strong> field. 5. Click <strong>Save</strong>. To give customers visibility into projects from the Customer Service Portal, you must add one or more contacts to the project. • Contacts must belong to the account linked with the project. • Partner contacts must have access to the account linked with the project. • Contacts who have a relationship with the account can also be added to the project.</td>
</tr>
<tr>
<td>Task</td>
<td>Details</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Assign project tasks to internal users, customer contacts, or customer partner contacts | 1. Navigate to Customer Service > Projects > All.  
2. Select a project.  
3. In the Project Contacts related list, click New.  
4. Select a contact in the Contact field and click Submit. |
| See the cases that have been created for a project or project task   | View cases in the Cases related list on the Customer Project form and Customer Project Task form. Click a case to view the case details. |
| Note: The customer project manager has read-only access to the Case form. |                                                                                                                                          |
| Add a comment or an attachment to a case that has been created for a project or project task | 1. Navigate to Customer Service > Projects > All.  
2. Select a project.  
3. In the Cases related list, select a case.  
4. Add a comment in Additional comments field.  
5. Click the attachment icon, select a file, and attach it to the case.  
6. Click Update. |

Create project change requests and project issues for cases that have been created for a project or project task | See the following tasks:  
• Create a project issue for a case  
• Create a project change request for a case |

© 2021 ServiceNow, Inc. All rights reserved.  
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Task</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Save a customer project as a template</strong></td>
<td>1. Navigate to Customer Service &gt; Projects &gt; All.</td>
</tr>
<tr>
<td></td>
<td>2. Select a project.</td>
</tr>
<tr>
<td></td>
<td>3. Click the Save as New Template related link.</td>
</tr>
<tr>
<td></td>
<td>4. In the Create Template popup window, enter a template name and description.</td>
</tr>
<tr>
<td></td>
<td>5. Click OK.</td>
</tr>
<tr>
<td></td>
<td>6. Update the template as needed and click Update.</td>
</tr>
</tbody>
</table>

**Customer service agent tasks**
To view customer projects and create cases for customer projects and tasks, an agent must have the following roles:

- sn_customerservice_agent
- sn_customerservice.projectstakeholder

With these roles, an agent can perform the tasks described in the following table.

<table>
<thead>
<tr>
<th>Task</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>View customer projects</strong></td>
<td>Customer service agents can view a list of customer projects by navigating to Customer Service &gt; Projects &gt; All. Click a project in this list to view project details on the Customer Project form, including project tasks, project contacts, and sub projects.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Agents have read-only access to project details.</td>
</tr>
<tr>
<td><strong>View the projects and project tasks created for an account</strong></td>
<td>Customer service agents can see projects that are linked to customer accounts. From a customer account record, agents can see the projects</td>
</tr>
<tr>
<td>Task</td>
<td>Details</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| See the projects and project tasks associated with a contact | Customer service agents can see the projects and project tasks that are associated with a contact. Navigate to Customer Service > Customer > Contacts and select a contact.  
  • Click the Projects related list to see projects.  
  • Click the Project Tasks related list to see tasks.  
  ✪ Note: If necessary, configure the Contact form to add these related lists. |
| Create a case for a project               | Customer service agents and agent managers can create cases for customer projects. When creating a case, the agent selects a project in the Project field on the Case form.  
  • If an account has been selected in the Account field, the agent can select from the projects that are associated with that account.  
  • If the Account field is empty, the agent can select from all projects that have been created for an account. Upon selection, the Account field is populated with the associated account. |
<table>
<thead>
<tr>
<th>Task</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>When created from a project, these fields are automatically set on the Case form. Cases created for a project appear in the <strong>Cases</strong> related list on the Customer Project form.</td>
</tr>
</tbody>
</table>
| Create a case for a project task | Customer service agents and agent managers can create cases for customer project tasks. When creating a case, the agent selects a task in the **Project Task** field on the Case form.  
  - If a project has been selected in the **Project** field, the agent can select from the project tasks that have been created for that project.  
  - If the **Project** field is empty, the agent can select from the project tasks for all projects that have been created for an account. Upon selection, the **Project** and **Account** fields are populated with the associated project and account.  
  
  When created from a project task, these fields are automatically set on the Case form. Cases created for a project task appear in the **Cases** related list on the Customer Project form and the Customer Project Task form. |

**Customer tasks**
From the Customer Service Portal, external users can view projects, complete assigned tasks, and create cases for project issues with any of the following CSM external roles:
- **sn_customerservice.customer**
- **sn_customerservice.customer_admin**
- sn_customerservice.partner
- sn_customerservice.partner_admin

<table>
<thead>
<tr>
<th>Task</th>
<th>Details</th>
</tr>
</thead>
</table>
| View projects and project details | Customers can view the projects created for their accounts if they have been associated with the project as a project contact. Customers have read-only access to project details on the Customer Project form. Customers can also view records in the following related lists if the system administrator has configured the corresponding ACLs for each of the tables.  
  - Customer Project Tasks  
  - Project Change Requests  
  - Status Reports  
  - Sub Projects  
  - Work Orders  
  - Project Contacts  

**Note:** The Work Orders related list is displayed if the following plugins are active: Field Service with Project Management (com.snc.wm_ppm) and Customer Service with Field Service Management (com.snc.csm_fsm_integration).

To view projects:

1. Click **Support** in the Customer Service Portal header.
2. Click **Projects** and select a project from the Customer Projects list.
3. View the details in the Customer Project form.
<table>
<thead>
<tr>
<th>Task</th>
<th>Details</th>
</tr>
</thead>
</table>
| View and update project tasks | Customers can view project tasks for the projects that have been created for their accounts if:  
  - They have been associated with the project as a project contact.  
  - The project tasks have been marked as **Visible to customer**.  

Customers can view and update project tasks that have been assigned to them by the customer project manager.  
To view and update project tasks:  
1. Click **My Lists** in the Customer Service Portal header.  
2. Click **My Project Tasks** and select a task from the Customer Project Tasks list.  
3. View the details in the Customer Project Task form.  
4. Update the **Actual start date** and **Actual end date** fields as needed and click **Save**.  
5. Add a comment in the **Activity** field and click **Post**.  

**Note:** Customers can also view tasks directly from **Support > Projects > Project Tasks**. |
<p>| Complete project tasks      | When a customer completes the work for a project task, they can mark the task as complete.                                      |</p>
<table>
<thead>
<tr>
<th>Task</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create cases for projects and project</td>
<td>Customers can create cases for projects and project tasks if they have</td>
</tr>
<tr>
<td>tasks</td>
<td>been associated with a project as a project contact. Customers can</td>
</tr>
<tr>
<td></td>
<td>create cases in two ways:</td>
</tr>
<tr>
<td></td>
<td>• From a project or project task form.</td>
</tr>
<tr>
<td></td>
<td>• From the Case menu in the Customer Service Portal header.</td>
</tr>
<tr>
<td></td>
<td>To create a case from a project or project task:</td>
</tr>
<tr>
<td></td>
<td>1. Navigate to a Customer Project form or a Customer Project Task</td>
</tr>
<tr>
<td></td>
<td>form.</td>
</tr>
<tr>
<td></td>
<td>2. Click <strong>Create Case</strong> in the Actions widget.</td>
</tr>
<tr>
<td></td>
<td>3. Fill in the fields on the Create Project Case record producer. The</td>
</tr>
<tr>
<td></td>
<td><strong>Project</strong> and <strong>Project Task</strong> fields are auto populated.</td>
</tr>
<tr>
<td></td>
<td>4. Click <strong>Submit</strong>.</td>
</tr>
<tr>
<td></td>
<td>To create a case from the Case menu.</td>
</tr>
<tr>
<td></td>
<td>1. Click <strong>Case</strong> in the Customer Service Portal header and select **</td>
</tr>
<tr>
<td></td>
<td>Create Project Case**.</td>
</tr>
<tr>
<td></td>
<td>2. Fill in the fields on the Create Project Case record producer.</td>
</tr>
<tr>
<td></td>
<td>3. Click <strong>Submit</strong>.</td>
</tr>
<tr>
<td>Task</td>
<td>Details</td>
</tr>
<tr>
<td>------</td>
<td>---------</td>
</tr>
<tr>
<td>The Create Project Case record producer includes <strong>Project</strong> and <strong>Project Task</strong> fields. These fields are displayed if a customer has access to any of the project tasks. Project and project task selection is limited to the projects for the customer's account.</td>
<td></td>
</tr>
</tbody>
</table>
| View a list of cases created for the projects and project tasks for an account | Customer administrators, partner administrators, and customer case managers can see all of the cases that have been created for the projects and project tasks for an account.  
1. Click **My Lists** in the Customer Service Portal header.  
2. Click **All Cases** in the My Lists widget. |
| View the project change request and project issue records created for a case | Customer contacts can view the project change request and project issue records that have been created for a case if:  
• They have been added to a project as a project contact.  
• The system administrator has configured the corresponding ACLs for each of the tables.  
1. Click **My Lists** in the Customer Service Portal header.  
2. Click **All Cases** in the My Lists widget.  
3. Select a case from the Cases list.  
4. View the records in the Related Records widget. |

**Customer Project Management domain separation**

With Customer Project Management, you can create customer projects for customer accounts. Domain separation for customer projects is based on
the account domain. New projects are created in the same domain as the associated customer account.

Customer project child entities use the domain of the parent project. Child entities include:

- Project tasks
- Requirements
- Project budget
- Status reports
- Risks
- Issues
- Decisions
- Actions
- Project change requests
- Stakeholders
- Project contacts
- Expense lines
- Time cards

The project manager can add sub projects to a customer project if the sub projects belong to the following accounts:

- Accounts in the same hierarchy as the main project account.
- Accounts that have a relationship to the main project account.

**Customer Service Investment Portal**

The Customer Service Management integration with Project Portfolio Management provides access to a CSM-specific view of the Investment Portal, which displays customer projects.

To view the CSM Investment Portal, navigate to **Customer Service > Projects > Investment Portal**.

Use the CSM Investment Portal to do the following:

- Add CSM-specific columns to investment boards
- Add filters to CSM-specific columns on investment boards
You can view both customer projects and IT projects in the IT Investment Portal. To access the IT Investment Portal, navigate to **Project > Investment Portal**. For more information, see **Investment Portal** in the Project Management documentation.

**Create an investment board on the CSM Investment Portal**

Create an investment board on the CSM Investment Portal and add the desired customer service project-specific information.

**Before you begin**

Role required: customer project manager (it_project_manager + sn_customerservice.projectmanager)

**Procedure**

1. Navigate to **Customer Service > Projects > Investment Portal**.
2. Click **New**.
3. Fill in the fields on the Create New pop-up window.
   For more information about these fields, see **Create an investment board**.
4. Click **Create**.
   Once the investment board is created, it opens up in the CSM Investment Portal page.

**Components installed with Customer Project Management**

Several types of components are installed with the Customer Project Management feature.

**Tables installed with Customer Project Management**

Tables are added with activation of Customer Service Management.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Project [customer_project]</td>
<td>Stores customer projects.</td>
</tr>
<tr>
<td>Customer Project Task [customer_project_task]</td>
<td>Stores customer project tasks</td>
</tr>
<tr>
<td>Project Contact [project_contact]</td>
<td>Stores project contacts.</td>
</tr>
</tbody>
</table>

The following columns are added to the Case table:
• Customer Project
• Customer Project Task
• Issue
• Project Change Request

Assign a project task
The customer project manager can assign a customer project task to an internal user, a customer or partner contact, or a contact that has a relationship to the account.

Before you begin
Role required: customer project manager (it_project_manager + sn_customerservice.projectmanager)

About this task
Assigning a task to an external user enables the Visible to customer field on the Project Task form. Customers can view assigned tasks in the Project Tasks list on the Customer Service Portal. The system sends an email notification to the customer when a customer project task is assigned.

Procedure
1. Navigate to Customer Service > Projects > All.
2. Click a project in the Customer Projects list.
3. Click the Project Tasks related list on the Customer Project form.
4. Click a task to open the Customer Project Task form.
5. Select a contact or partner contact in the Assigned to field.
6. Click Update.
   The system sends an email notification to the assigned user.

Create a project issue for a case
The customer project manager can create project issues for cases that have been created for customer projects and project tasks.

Before you begin
Role required: customer project manager (it_project_manager + sn_customerservice.projectmanager)

About this task
The project manager can create one issue for a case.
Procedure

1. Navigate to Customer Service > Projects > All.
2. Click a project in the Customer Projects list.
3. In the Cases related list, click a case.
4. Click Create Issue on the Case form.
   The system creates a new issue for the project and copies the Short description and Priority from the case.
5. Fill in the details for the issue and click Save.
   The system does the following after you save the issue:
   • Adds the case number to the activity stream on the Issue form.
   • Adds the issue number to the activity stream on the Case form.
   • Adds the issue to the Issues related list on the Customer Project form.
   • Adds the issue to the Issue field in the Related Records section of the Case form.

Create a project change request for a case

The customer project manager can create project change requests for cases that have been created for customer projects and project tasks.

Before you begin
Role required: customer project manager (it_project_manager + sn_customerservice.projectmanager)

About this task
The project manager can create one project change request for a case.

Procedure

1. Navigate to Customer Service > Projects > All.
2. Click a project in the Customer Projects list.
3. In the Cases related list, click a case.
4. Click Create Project Change Request on the Case form.
   The system creates a new change request for the project, copies the case short description to the Title field, and the case priority to the Priority field.
5. Fill in the details for the change request and click Save.
   The system does the following after you save the change request:
• Adds the case number to the activity stream on the Project Change Request form.
• Adds the project change request number to the activity stream on the Case form.
• Adds the project change request to the Project Change Requests related list on the Customer Project form.
• Adds the project change request to the Project Change Request field in the Related Records section of the Case form.

Create a customer project from an idea
Create a customer project from an idea on the Idea Portal.

Before you begin
Role required: customer project manager (it_project_manager + sn_customerservice.projectmanager)

About this task
The Idea Portal provides a central location to collect, curate, and promote ideas into demand, project, epic, or story. With the Customer Service Management integration with Project Portfolio Management, you can also create a customer project from an idea. For more information, see Idea Portal.

Procedure
1. Navigate to Ideas > Idea Portal.
2. Click the title of an idea that you want to create a task for.
3. Open the idea in form view by clicking the More Options icon and selecting Open in platform.
4. In the Idea pop-up window, click Create Task.
5. In the Convert Idea to Task pop-up window, select Customer Project in the Select task type field and click OK.
   The system creates the project and displays the project number in an information message at the top of the Idea pop-up window. On the Customer Project form, the idea record is added to the Ideas related list.

Create a customer project from a demand
Create a customer project from a demand record.

Before you begin
Role required: customer project manager (it_project_manager + sn_customerservice.projectmanager)
Procedure
1. Create a demand record by navigating to Demand > Demands > Create New.
2. Fill in the fields on the Demand form and click Save.
   For more information about the fields on this form, see Create a demand.
3. Open the demand record and click the Create Project related link.
4. In the Create Project pop-up window, select Customer Project in the Project class field.
5. Click OK.
   The system creates the project and displays the project number in an information message at the top of the Demand form. On the Customer Project form, the demand record is added to the Demands related list.

Integrate with Financial Management
Customer Service Management provides an integration with the ServiceNow® Financial Management application as well as dashboards and reports.

Before you begin
Role required: admin

About this task

>i Note: The Financial Management For CSM plugin (com.snc.financial_management_for_csm) is no longer available for direct activation by the system administrator. You can request this plugin through the HI Customer Service system.

Procedure
1. Navigate to System Definition > Plugins.
3. Click Activate.

Integrating with Financial Management
Customer Service Management and Field Service Management provide an integration with the ServiceNow® Financial Management application as well as dashboards and reports.
The Financial Management application enables you to allocate, track, and report on expenses in your organization. When the Financial Management application allocates an expense, it breaks down the expense into detailed amounts of money called allocations. These allocations can be associated with specific segments and accounts for a specific cost model. The integration with Financial Management provides cost allocations for Customer Service Management and Field Service Management.

Use these cost allocations on the Financial Management workbench, which provides financial administrators with a graphical interface to allocate expenses. Access the workbench through the **Cost Transparency > Workbench** module.

**Plugins**

Two different plugins, one for Customer Service Management and one for Field Service Management, enable the integration with Financial Management. These plugins also add dashboards based on cost allocations.

- **Performance Analytics - Content Pack - Financial Management for Field Service Management plugin** (com.snc.pa.fm.fsm)

The Performance Analytics - Content Pack - Financial Management for Customer Service plugin includes demo data for FY16: Q1 through FY17: Q2. The demo data includes records with the CSFM prefix, which indicates that the records are for the Customer Service Management integration with Financial Management. Activating the plugin adds these records to the Case (sn_customerservice_case) table.

**Note:** The Performance Analytics - Content Pack - Financial Management for Field Service Management plugin does not include demo data.

**Cost models**

A cost model is a set of rules, methods, and metrics that determines the allocation of expenses. Select cost models on the Data Definitions tab of the Financial Management workbench.

For Customer Service Management, the integration with Financial Management provides these cost models:

- **CSM Allocation Model for Cost Account**: allocates expenses for individual B2B customer accounts.
- **CSM Allocation Model for Channels**: allocates expenses for communication channels.
For Field Service Management, the integration with Financial Management provides this cost model:

- **FSM Allocation Model for Company**: allocates expenses for companies.

**Segment hierarchy**

All accounts in the chart of accounts belong to segments which are structured in a hierarchy. This hierarchy enables the roll-up of expenses from lower-level accounts and segments to higher-level accounts and segments.

- **CSM Allocation Model for Cust Account** uses this segment hierarchy: Assignment Group > Product > Customer Account.
- **CSM Allocation Model for Channels** uses this segment hierarchy: Assignment Group > Product > Channels.
- **FSM Allocation Model for Company** uses this segment hierarchy: Assignment Group > Product > Company.

**Account buckets**

Use account buckets to categorize cleansed expenses before assigning them to accounts and segments. Account buckets can be organized in parent-child relationships so that several child buckets can refer to a single parent bucket.

The Customer Support and Field Service Support account buckets include:

- Facilities
- IT Chargeback
- Payroll and Labor Expenses
- Professional Fees & Services
- Supplies
- Training
- Other expenses

**Allocation metrics**

Allocation metrics are rules that you can create and use to split an allocation based on dimensions such as:

- Number of Customer Service cases: allocate expenses to a product based on the number of cases closed in a fiscal period.
- Total Customer Service case resolution time: allocate expenses to a product based on the total hours worked on cases closed in a fiscal period.
• Number of Field Service work order tasks: allocates expenses to a product based on the number of work order tasks completed in a fiscal period.

• Total work order completion time: allocates expenses to a product based on the total hours worked on tasks completed in a fiscal period.

For Customer Service Management, the integration with Financial Management provides these allocation metrics:

• CSM Allocate to Assignment Groups by Headcount
• CSM Allocate to Product by # Cases
• CSM Allocate to Product by Case Time Worked Duration
• CSM Rollup from AssgGrp to Product by # Cases
• CSM Rollup from AssgGrp to Product by Case Time Worked Duration
• CSM Rollup from Product to Account by # Cases
• CSM Rollup from Product to Account by Case Time Worked Duration

For Field Service Management, the integration with Financial Management provides these allocation metrics:

• FSM Allocate to Assignment Groups by Headcount
• FSM Allocate to Product by # Work Orders
• FSM Rollup from Product to Company by # Work Orders

**User roles**

These roles can access the Financial Management workbench *(Cost Transparency > Workbench)*:

• cost_transparency_analyst
• cost_transparency_admin
• financial_mgmt_user
• financial_mgmt_admin

**Dashboards and reports**

The Performance Analytics - Content Pack - Financial Management for Customer Service and Performance Analytics - Content Pack - Financial Management for Field Service Management plugins provide the following dashboards:

• CSM Financials Dashboard
• FSM Financials Dashboard
Navigate to Performance Analytics > Dashboards and select the desired dashboard from the Dashboard menu.

Related information

- Financial Management
- Financial Management Workbench

Integrate with Adobe Experience Manager

Deliver a pre-integrated web experience for external customers by using ServiceNow components in Adobe Experience Manager (AEM).

About this task

This task provides the general steps to integrate Customer Service Management and Knowledge Management capabilities with AEM. For more information, see Integrating with Adobe Experience Manager.

Procedure

1. Install the ServiceNow Components for AEM package on your AEM instance. You can download the package by using the direct download URL or accessing the package at https://experience.adobe.com/downloads. For more information, see Experience Cloud Software Distribution in the Adobe Help Center.

2. Configure authentication settings for ServiceNow services and components in AEM.

3. Configure integration settings for ServiceNow services and components in AEM.

Integrating with Adobe Experience Manager

Extend Customer Service Management and Knowledge Management capabilities through ServiceNow components in Adobe Experience Manager (AEM) to deliver a pre-integrated web experience for external customers.

When working with a website built on AEM, you can embed Customer Service Management and Knowledge Management capabilities related to customer service cases and knowledge articles respectively within the website. The integration with AEM provides the following advantages:

- Use ServiceNow knowledge and case components on your branded websites built on AEM.
- Ensure a unified and consistent experience for end users to access information when and where they need it.
Supported AEM versions

Beginning with AEM 6.5, you can add knowledge and case components to pages of your websites built on AEM and use pages available within the ServiceNow site in AEM as a reference to design your website content. For more information, see ServiceNow pages in Adobe Experience Manager, Display ServiceNow knowledge articles on an Adobe Experience Manager page, and Display ServiceNow cases on an Adobe Experience Manager page.

ServiceNow Components for AEM package

Install the ServiceNow Components for AEM package on your AEM instance. You can download the package by using the direct download URL or accessing the package at https://experience.adobe.com/downloads. For more information, see Experience Cloud Software Distribution in the Adobe Help Center.

After you install the package, configure authentication and integration settings for ServiceNow services and components in AEM. For more information, see Connect Adobe Experience Manager to ServiceNow using an OIDC provider and Adobe Experience Manager integration setup.

Connect Adobe Experience Manager to ServiceNow using an OIDC provider

Enable logging in to both the Adobe Experience Manager (AEM) instance of your website and the ServiceNow instance using a third-party OpenID Connect (OIDC) provider that supports both OIDC and single sign-on (SSO) protocols.

Before you begin
Select Okta or Microsoft Azure as the third-party OIDC provider that supports both OIDC and single sign-on (SSO) protocols.

Note: Your AEM instance must use the selected third-party OIDC provider as the SSO provider.

About this task
This task provides the general steps to set up the authentication.

Procedure
1. Register ServiceNow with a third-party OIDC provider.
2. Add the OIDC provider to your ServiceNow instance.
3. Configure the OIDC provider details in your AEM instance.

Register ServiceNow with a third-party OIDC provider

Register ServiceNow as a web application with a third-party OIDC provider to validate the identity of a user using a JSON Web Token (JWT).
Before you begin
ServiceNow identifies an end user by sending the JWT token containing the end user information to the OIDC provider. The process to register ServiceNow with the OIDC provider varies depending on the provider.

Note:
This topic uses Okta as an example, but you can substitute the details of your own OIDC provider.

Role required: Okta account (Third-party OIDC provider account)

Procedure
1. Log in to your Okta account.
2. Select the Applications menu.
3. On the Applications page, click Add Application.
5. Fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application label</td>
<td>Unique application name for your ServiceNow instance.</td>
</tr>
<tr>
<td>Authorization Code</td>
<td>Selected</td>
</tr>
<tr>
<td>Refresh Token</td>
<td>Selected</td>
</tr>
<tr>
<td>Login redirect URIs</td>
<td>Callback URL of your AEM instance.</td>
</tr>
<tr>
<td></td>
<td>The URL structure is: https://&lt;AEM-instance&gt;:&lt;AEM_port&gt;/bin/now/auth/callback</td>
</tr>
<tr>
<td>Login initiated</td>
<td>App Only</td>
</tr>
</tbody>
</table>

6. Click Done.

What to do next
In the Client Credentials section, record the Client ID and Client secret values for when you set up Okta as an OAuth provider in your ServiceNow and AEM instances.
Add an OIDC provider to the ServiceNow instance

Add a third-party OIDC provider service to your ServiceNow instance to verify the identity of end users.

Before you begin
You must have configured the third-party OIDC provider service as an OAuth provider and recorded your Client ID and Client secret values. For more information, see Register ServiceNow with a third-party OIDC provider.

Role required: oauth_admin

Procedure
1. Navigate to System OAuth > Application Registry.
2. Set up OAuth for your ServiceNow instance.
   • Click New, select Configure an OIDC provider to verify ID tokens, and then fill in the Application Registries form.
   • Select an existing template for your OIDC provider (Okta or Microsoft Azure), and then either accept the default values in the Application Registries form or modify them.

   Note: OIDC provider templates are available after loading demo data with the OAuth 2.0 plugin. For more information, see Create an OAuth OIDC provider.

Application Registries form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the OAuth provider.</td>
</tr>
<tr>
<td>Client ID</td>
<td>Client ID you recorded earlier for your ServiceNow instance registered in the third-party OIDC server. The ServiceNow instance uses the client ID when requesting an access token.</td>
</tr>
<tr>
<td>Client Secret</td>
<td>Client secret you recorded earlier for your ServiceNow instance registered in the third-party OIDC server.</td>
</tr>
<tr>
<td>OAuth OIDC Provider Configuration</td>
<td>OIDC provider with which you registered your ServiceNow instance.</td>
</tr>
</tbody>
</table>
Field Description

Note: Select the record of your OIDC provider configuration or create another configuration, if not available, to ensure that the OIDC Metadata URL field value is correct and the User Claim and User Field fields are mapped correctly.

3. Save your changes.
   - For an existing template, click Update.
   - For a new template, click Submit.

Configure OIDC provider details in Adobe Experience Manager

Configure the third-party OIDC provider details in your Adobe Experience Manager (AEM) instance to access the ServiceNow components as an authenticated user.

Before you begin
You must have configured the third-party OIDC provider service as an OAuth provider and recorded your Client ID and Client secret values (see Register ServiceNow with a third-party OIDC provider).

Role required: AEM administrator

About this task
Configure the OIDC provider details in AEM to enable the AEM users to access the ServiceNow instance as authenticated users. If you don’t configure the OIDC provider details in AEM, an AEM user is considered as a public user when accessing the ServiceNow instance.

Procedure
1. Access the web console in AEM with a URL in the following format: https://<AEM_hostname>:<AEM_port>/system/console/configMgr.
2. Search for ServiceNow OAuth Configuration.
3. In the Name column, click the ServiceNow OAuth Configuration link.
4. Provide values for the configuration settings.

ServiceNow OAuth Configuration settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ServiceNow Client ID</td>
<td>Client ID you recorded when setting up the OAuth for your ServiceNow instance.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ServiceNow Client Secret</td>
<td>Client secret you recorded when setting up the OAuth for your ServiceNow portal.</td>
</tr>
<tr>
<td>OAuth Provider Auth URL</td>
<td>Authorization server end point used for obtaining the authorization code. In the following URL structure, substitute the domain name of the authorization server of your third-party OIDC provider. Example: https://&lt;auth_server_domain&gt;/oauth2/authorize</td>
</tr>
<tr>
<td>OAuth Provider Access Token URL</td>
<td>Authentication server endpoint used for exchanging the authorization code for an access token. In the following URL structure, substitute the domain name of the authorization server of your third-party OIDC provider. Example: https://&lt;auth_server_domain&gt;/oauth2/token</td>
</tr>
<tr>
<td>Authorization request scope</td>
<td>List of scopes for limiting the authorization access.</td>
</tr>
<tr>
<td></td>
<td>Note: The default value <code>openid email profile offline_access</code> works for most OIDC providers (for example, Okta).</td>
</tr>
<tr>
<td>User property to store refresh token</td>
<td>Name of the user property to store the authentication refresh token.</td>
</tr>
<tr>
<td></td>
<td>Note: Once filled, this token is used to obtain access tokens for that user in all future requests.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

Adobe Experience Manager integration setup

You have to set up your ServiceNow services and components to integrate with your Adobe Experience Manager (AEM) instance.

Settings to enable use of ServiceNow services in AEM

You can define the following types of configuration settings for ServiceNow services in AEM:

- Authentication settings with a third-party OIDC provider (see [Configure OIDC provider details in Adobe Experience Manager](#)).
- Specific settings for ServiceNow services (see [Define OSGi configuration settings for ServiceNow services](#)).
- Log file settings for ServiceNow services (see [Configure log file settings for ServiceNow services in Adobe Experience Manager](#)).
Settings for using ServiceNow components in AEM

To use the Knowledge API endpoint on your AEM instance, you have to define the cross-origin resource sharing (CORS) rule on your ServiceNow instance. For more information, see Define a cross-origin resource sharing rule to access ServiceNow API endpoints from AEM.

Define OSGi configuration settings for ServiceNow services

Define OSGi configuration settings for ServiceNow services used by ServiceNow components in Adobe Experience Manager (AEM).

Before you begin
Role required: AEM administrator

Procedure

1. Access the web console in AEM using a URL in the following format: https://<AEM_hostname>:<AEM_port>/system/console/configMgr.
2. Search for ServiceNow Configuration.
3. In the Name column, click the ServiceNow Configuration link.
4. Provide values for the configuration settings.

ServiceNow Configuration settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base Instance URL</td>
<td>Complete URL of your ServiceNow instance.</td>
</tr>
<tr>
<td>Knowledge Bases</td>
<td>System identifier (sys_id) of a knowledge base that contains associated knowledge articles. For multiple entries, separate the knowledge bases with commas.</td>
</tr>
<tr>
<td>Note:</td>
<td>A blank value indicates articles from all knowledge bases in your ServiceNow instance are accessible to a user with appropriate permissions.</td>
</tr>
<tr>
<td>Show Articles in All Languages</td>
<td>Option to show knowledge articles in all languages for ServiceNow components.</td>
</tr>
</tbody>
</table>

5. Click Save.
Configure log file settings for ServiceNow services in Adobe Experience Manager

Configure log file settings for ServiceNow services in Adobe Experience Manager (AEM) to generate debug logs to help identify issues in the authentication process.

Before you begin
Role required: AEM administrator

Procedure
1. Access the web console in AEM using a URL in the following format: https://<AEM_hostname>:<AEM_port>/system/console/configMgr.
2. Navigate to OSGi > Configuration.
4. Verify the default field values, or fill in your own values for a custom configuration.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log Level</td>
<td>Debug</td>
</tr>
<tr>
<td>Log File</td>
<td>Path of the ServiceNow log file.</td>
</tr>
<tr>
<td>Message Pattern</td>
<td>Message-format pattern for formatting log messages.</td>
</tr>
<tr>
<td>Logger</td>
<td>Logger name for ServiceNow login services.</td>
</tr>
<tr>
<td>Additivity</td>
<td>Option to disable sending logs to an appender attached higher in the hierarchy.</td>
</tr>
</tbody>
</table>

5. Click Save.

Define a cross-origin resource sharing rule to access ServiceNow API endpoints from AEM

Define a cross-origin resource sharing (CORS) rule on your ServiceNow instance to access endpoints of the Knowledge Management REST API, Case API, or CSM Attachment API from your Adobe Experience Manager (AEM) instance.

Before you begin
Ensure that you have configured the API for which you are defining the CORS rule.
• Activate the Knowledge API plugin (sn_km_api) to use the Knowledge Management REST API endpoints for knowledge articles. For more information, see Knowledge Management REST API.

• Activate the Customer Service plugin (com.sn_customerservice) to use the Case API endpoints for customer service cases. For more information, see Case API.

• Configure the glide.rest.attachment_csm_api.allowed_tables system property and include the Case [sn_customerservice_case] table to use the CSM Attachment API end points for case attachments. For more information, see CSM Attachment API.

Role required: web_service_admin

About this task

Procedure
1. Navigate to System Web Services > CORS Rules.
2. Click New.
3. On the CORS Rule form, fill in the fields.

CORS Rule form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for identifying your CORS rule.</td>
</tr>
<tr>
<td>REST API</td>
<td>REST API this CORS rule applies to.</td>
</tr>
<tr>
<td></td>
<td>• For knowledge articles, select Knowledge Management REST API [sn_km_api/knowledge].</td>
</tr>
<tr>
<td></td>
<td>• For customer service cases, select Case [sn_customerservice/case].</td>
</tr>
<tr>
<td></td>
<td>• For case attachments, select CSM Attachment API [now/attachment_csm]</td>
</tr>
<tr>
<td>Domain</td>
<td>AEM instance that this CORS rule applies to.</td>
</tr>
<tr>
<td>Max age</td>
<td>Number of seconds to cache the client session.</td>
</tr>
</tbody>
</table>

4. In the HTTP Methods related list, select HTTP methods to send a request to a web service provider.
• For knowledge articles, select **GET**.
• For customer service cases, select **GET, PUT, POST**.
• For case attachments, select **GET, POST, DELETE**.

5. For Case API, in the **Exposed headers** field of the HTTP Headers related list, enter **X-Total-Count**.

6. Click **Submit**.

**Customizing the colors of ServiceNow components in AEM**

You can define the look and feel of the ServiceNow components in Adobe Experience Manager (AEM) by specifying colors for them. As an AEM administrator, you can either modify the color variables preconfigured for all components or use the `initializeCSS` function for customizing the colors of a particular component using a custom CSS class. You specify the custom CSS class for a component in the **Custom CSS Class** property. For more information, see Display ServiceNow knowledge articles on an Adobe Experience Manager page and Display ServiceNow cases on an Adobe Experience Manager page.

![Note:](Note.png) By default, the ServiceNow components are configured using the Bootstrap v4.4.1 CSS styles. If your AEM page uses a different Bootstrap version, the ServiceNow components style is overridden by the page style.

**Modify the color theme for all ServiceNow components in AEM**

Set the color theme for the ServiceNow components in Adobe Experience Manager (AEM) all at once by configuring the color variables.

**Before you begin**
Role required: AEM administrator

**About this task**

![Note:](Note.png) By default, the ServiceNow components are configured using the Bootstrap v4.4.1 CSS styles. If your AEM page uses a different Bootstrap version, the ServiceNow components style is overridden by the page style.

**Procedure**

1. **Open CRXDE Lite in your browser.**
   For example, in your browser, enter the URL in the format `http://<AEM_hostname>:<AEM_port>/crx/de`. The default URL for CRXDE Lite is `http://localhost:4502/crx/de`.

2. **Navigate to apps > servicenow-components > clientlibs > clientlib-common.**
3. Open the `variables.less` file.

4. Configure the color variables available for the HTML elements in the ServiceNow components.

<table>
<thead>
<tr>
<th>Color variable settings</th>
<th>Variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text content</td>
<td>@text-color</td>
</tr>
<tr>
<td>Hyperlinks</td>
<td>@link-color</td>
</tr>
<tr>
<td>Badges</td>
<td>@badge-text-color</td>
</tr>
<tr>
<td>Badges background</td>
<td>@badge-background-color</td>
</tr>
<tr>
<td>Primary color for visual emphasis</td>
<td>@primary-color</td>
</tr>
<tr>
<td>Color complementary to the primary color, for visual emphasis</td>
<td>@secondary-color</td>
</tr>
<tr>
<td>Component titles</td>
<td>@title-color</td>
</tr>
<tr>
<td>Primary button text</td>
<td>@primary-btn-text-color</td>
</tr>
<tr>
<td>Primary button background</td>
<td>@primary-btn-bkg-color</td>
</tr>
<tr>
<td>Secondary button text</td>
<td>@secondary-btn-text-color</td>
</tr>
<tr>
<td>Secondary button background</td>
<td>@secondary-btn-bkg-color</td>
</tr>
</tbody>
</table>
Note: You specify a color for a variable in one of the following ways:

- Color name
  For example, red
- HEX value
  For example, #FF0000
- RGB value
  For example, rgb(255,0,0)
- var function
  Use the var function to specify a custom property for a color. For example, var(--gray-dark).

5. From the CRXDE Lite menu, click Save All to save the changes on the AEM server.

Modify the color theme for a ServiceNow component in AEM

Override the color theme for a ServiceNow component in Adobe Experience Manager (AEM) by using the initialize function.

Before you begin
Role required: AEM administrator

About this task
The color variables you specify in the variables.less file are applied to all ServiceNow components in AEM. You can override the default colors for a particular component by setting the color variables for the component in the initializeCSS function.

Note: By default, the ServiceNow components are configured using the Bootstrap v4.4.1 CSS styles. If your AEM page uses a different Bootstrap version, the ServiceNow components style is overridden by the page style.

Procedure

1. Open CRXDE Lite in your browser.
   For example, in your browser, enter the URL in the format http://<AEM_hostname>:<AEM_port>/crx/de. The default URL for CRXDE Lite is http://localhost:4502/crx/de.

2. Navigate to apps > servicenow-components > clientlibs > clientlib-common.

3. Open the variables.less file.
4. Specify the `initializeCSS` function for a component in the format

```
<component_type>;<class_name>;<color_variable_1>;<color_variable_2>;<color_variable_n>.
```

- **component_type**: The type of the component on which you want to apply the custom color theme, for example, articlelist, articleview, casecards, and so on.
- **class_name**: The Custom CSS class you enter in the Custom CSS class property of your component.
- **color_variable_1, color_variable_2, color_variable_n**: The color variables you specify for the HTML elements in a component. For more information, see the Color variable settings table.

Use the following sample code as a reference for color styling at the component level.

```javascript
.componentType:articlelist;@className:now-article-list;@text-color:red;
@link-color:orange;@badge-text-color:blue;@badge-background-color:yellow;@title-color:magenta;@secondary-color:indigo;
.componentType:articleview; @className:now-article-view;@text-color:red;
@link-color:orange;@badge-text-color:blue;@badge-background-color:yellow;@secondary-color:indigo;
.componentType:casecards; @className:now-case-cards;
@text-color:red;@link-color:orange;@badge-text-color:blue;@badge-background-color:yellow;
@title-color:magenta;@secondary-color:indigo;
.componentType:caselist; @className:now-case-list; @text-color:red;
@link-color:orange;@title-color:magenta;@primary-color:green;@secondary-btn-text-color:white;
@secondary-btn-bkg-color:black;
.componentType:searchbox; @className:now-search-box; @text-color:red;
@link-color:orange;@title-color:magenta;@primary-color:green;@secondary-btn-text-color:white;
@secondary-btn-bkg-color:black;
.componentType:searchresults;@className:now-search-results;@text-color:gray;
@link-color:orange;@badge-text-color:blue;@badge-background-color:yellow;@title-color:magenta;@secondary-color:indigo;
.componentType:createcase;@className:now-create-case;@text-color:red;@link-color:orange;@primary-color:green;@secondary-color:indigo;@primary-btn-text-color:blue;@primary-btn-bkg-color:white;@secondary-btn-text-color:white;@secondary-btn-bkg-color:blue;
```

5. From the CRXDE Lite menu, click **Save All** to save the changes on the AEM server.
ServiceNow pages in Adobe Experience Manager

Use pages provided on the ServiceNow site in the Adobe Experience Manager (AEM) as a reference to organize your AEM-based websites and provide a consistent user experience.

An AEM page houses containers, which in turn contain components. By manipulating the layout of the page and the components within it, you can construct a consistent user experience.

By default, ServiceNow sites and pages aren’t accessible to public users, which are anonymous AEM users who are not logged in. For information about how to publish them and make them available to anonymous AEM users, see the Adobe documentation topic Publishing pages.

ServiceNow page in AEM for knowledge articles

The following table shows default pages available in the ServiceNow site in AEM and the knowledge components available on these pages.

<table>
<thead>
<tr>
<th>ServiceNow pages in AEM for knowledge articles</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Page</strong></td>
</tr>
<tr>
<td>---</td>
</tr>
</tbody>
</table>
| ServiceNow Article Search | Reference page to view knowledge article search results. | • Search Box  
• Search Results |
| ServiceNow Article View | Reference page to view a knowledge article. | Article View |
| ServiceNow Article List | Reference page to browse and search for knowledge articles. | • Search Box  
• Article List (one each for featured articles and the most viewed articles lists) |

ServiceNow page in AEM for customer service cases

The following table shows default pages available in the ServiceNow site in AEM and the case components available on these pages.
ServiceNow pages in AEM for customer service cases

<table>
<thead>
<tr>
<th>Page</th>
<th>Description</th>
<th>Case components on the page</th>
</tr>
</thead>
<tbody>
<tr>
<td>ServiceNow Create Case</td>
<td>Reference page to create a customer service case.</td>
<td>New Case</td>
</tr>
<tr>
<td>ServiceNow Case View</td>
<td>Reference page to view a customer service case.</td>
<td>Case View</td>
</tr>
<tr>
<td>ServiceNow Case List</td>
<td>Reference page to browse and search for customer service cases.</td>
<td>Case List</td>
</tr>
</tbody>
</table>

ServiceNow home page in AEM

The following table shows default home page available in the ServiceNow site in AEM and the knowledge and case components available on this page.

<table>
<thead>
<tr>
<th>Page</th>
<th>Description</th>
<th>ServiceNow components on the page</th>
</tr>
</thead>
</table>
| ServiceNow Home | Reference page to browse and search for knowledge articles and create a case. | • Article List  
• Search Box  
• Case Cards |

Display ServiceNow knowledge articles on an Adobe Experience Manager page

Use knowledge components available within Adobe Experience Manager (AEM) to access knowledge bases from the ServiceNow instance and display associated knowledge articles on an AEM-based website.

Before you begin

- Activate the Knowledge API plugin (sn_km_api) to use the Knowledge Management REST API endpoints for knowledge articles. For more information, see Knowledge Management REST API.
- Define the cross-origin resource sharing (CORS) rule to access the Knowledge API from your AEM instance. For more information, see Define a cross-origin resource sharing rule to access ServiceNow API endpoints from AEM.
Role required: AEM author

Procedure

1. Log in to your AEM instance.
2. Open your AEM page in Edit mode.
3. Open the components browser.
4. From the All list, select ServiceNow.
5. Drag a component to the required position on the page.

Note: If components are not available, update your template configuration to include the knowledge components. In addition, you must modify the properties of the site template and add each knowledge article component to the list of allowed components.

6. Open the component dialog for editing.

Note: By default, the knowledge components in the Edit mode of a page in AEM aren’t accessible by public users, which are anonymous AEM users who are not logged in. To change the default behavior, you must enable the Public property for each knowledge component.

7. Set the Search Results component properties to display knowledge search results that include a list of knowledge articles from the knowledge bases in the ServiceNow instance.

Search Results component properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Public</td>
<td>Option to make the content of the component visible to public users. When selected, the knowledge articles available to unauthenticated users included in the component are available to all users, including public users.</td>
</tr>
<tr>
<td>Knowledge Bases</td>
<td>System identifier (sys_id) of a knowledge base that contains associated knowledge articles.</td>
</tr>
<tr>
<td></td>
<td>Click Add field and enter the sys_id of a knowledge base. You can add multiple entries.</td>
</tr>
<tr>
<td>Note:</td>
<td>If you don’t add a value, knowledge bases from the OSGi configuration settings are used for ServiceNow components.</td>
</tr>
<tr>
<td>Language</td>
<td>Enables the display of knowledge article search results in different languages.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Select one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Select from ServiceNow OSGi Configuration</strong>: Knowledge articles are displayed in the language configured in the OSGi configuration for ServiceNow components. This value is selected by default.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Restrict to portal language</strong>: Knowledge articles are displayed in the language configured in the AEM site.</td>
</tr>
<tr>
<td></td>
<td>• <strong>All languages</strong>: Knowledge articles are displayed in all languages.</td>
</tr>
<tr>
<td>Search parameter</td>
<td>Parameter key for the search query.</td>
</tr>
<tr>
<td>Example: kb_query</td>
<td></td>
</tr>
<tr>
<td>Secondary fields</td>
<td>Metadata of a knowledge article that appear with the article. Metadata include information such as the author, the date the article was last updated, and the date the article was last viewed. For multiple entries, separate the fields by commas.</td>
</tr>
<tr>
<td>Example: author, sys_view_count, sys_updated_on, rating</td>
<td></td>
</tr>
<tr>
<td>Search results count</td>
<td>Maximum number of articles included in the search results list. Use the increment or decrement icons to increase or decrease the values. You can also manually enter a value. The value must be greater than 1.</td>
</tr>
<tr>
<td>Article page URL</td>
<td>Relative URL of the article page to redirect to.</td>
</tr>
<tr>
<td>Example: /content/NOWApp/now_article_view.html</td>
<td></td>
</tr>
<tr>
<td>Custom CSS class</td>
<td>Custom CSS class for applying custom styles to this component. For more information, see Customizing the colors of ServiceNow components in AEM.</td>
</tr>
</tbody>
</table>

8. Set the Search Box component properties to display a search box for users to enter search text and find knowledge articles in the ServiceNow instance matching the search text.

ℹ️ **Note**: Triggering a search from the Search Box component leads to the Search Results component.
### Search Box component properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Public</strong></td>
<td>Option to make the content of the component visible to public users. When selected, the knowledge articles available to unauthenticated users included in the component are available to all users, including public users.</td>
</tr>
<tr>
<td><strong>Placeholder</strong></td>
<td>Hint text displayed in the search box to provide information about what users can search for or conditions for the search text.</td>
</tr>
<tr>
<td></td>
<td>Example: <em>Search (minimum three characters)</em></td>
</tr>
<tr>
<td><strong>Knowledge Bases</strong></td>
<td>System identifier (sys_id) of a knowledge base that contains associated knowledge articles.</td>
</tr>
<tr>
<td></td>
<td>Click <em>Add field</em> and enter the sys_id of a knowledge base. You can add multiple entries.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you don’t add a value, knowledge bases from the OSGi configuration settings are used for ServiceNow components.</td>
</tr>
<tr>
<td><strong>Language</strong></td>
<td>Enables the display of knowledge articles in different languages in the search box.</td>
</tr>
<tr>
<td></td>
<td>Select one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• <em>Select from ServiceNow OSGi Configuration:</em> Knowledge articles are displayed in the language configured in the OSGi configuration for ServiceNow components. This value is selected by default.</td>
</tr>
<tr>
<td></td>
<td>• <em>Restrict to portal language:</em> Knowledge articles are displayed in the language configured in the AEM site.</td>
</tr>
<tr>
<td></td>
<td>• <em>All languages:</em> Knowledge articles are displayed in all languages.</td>
</tr>
<tr>
<td><strong>Search page URL</strong></td>
<td>Relative URL of the search page to redirect to.</td>
</tr>
<tr>
<td></td>
<td>Example: <code>/content/NOWApp/now_article_search.html</code></td>
</tr>
<tr>
<td><strong>Search parameter</strong></td>
<td>Parameter key for the search query.</td>
</tr>
<tr>
<td></td>
<td>Example: <code>kb_query</code></td>
</tr>
<tr>
<td><strong>Typeahead</strong></td>
<td>Option to enable typeahead search.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Typeahead search results count</td>
<td>Maximum number of articles to include in the typeahead search results list.</td>
</tr>
<tr>
<td></td>
<td>Use the increment or decrement icons to increase or decrease the values.</td>
</tr>
<tr>
<td></td>
<td>You can also manually enter a value. The value must be greater than 1.</td>
</tr>
<tr>
<td>Article page URL</td>
<td>Relative URL of the article page to redirect to.</td>
</tr>
<tr>
<td></td>
<td>Example: /content/NOWApp/now_article_view.html</td>
</tr>
<tr>
<td>Custom CSS class</td>
<td>Custom CSS class for applying custom styles to this component.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Customizing the colors of ServiceNow components in AEM.</td>
</tr>
</tbody>
</table>

9. Set the Article View component properties to display knowledge articles and their attachments, if available, from a ServiceNow instance.

**Article View component properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Public</td>
<td>Option to make the content of the component visible to public users. When selected, the knowledge articles available to unauthenticated users included in the component are available to all users, including public users.</td>
</tr>
<tr>
<td>Article parameter</td>
<td>Name of the URL query parameter for the article number.</td>
</tr>
<tr>
<td></td>
<td>Example: kb_article</td>
</tr>
<tr>
<td>Secondary fields</td>
<td>Metadata of a knowledge article that appear with the article. Metadata include information such as the author, the date the article was last updated, and the date the article was last viewed. For multiple entries, separate the fields by commas.</td>
</tr>
<tr>
<td></td>
<td>Example: author, sys_view_count, sys_updated_on, rating</td>
</tr>
<tr>
<td>Language parameter</td>
<td>Name of the URL query parameter containing the requested language for a knowledge article.</td>
</tr>
<tr>
<td></td>
<td>Example: kb_lang</td>
</tr>
<tr>
<td>Custom CSS class</td>
<td>Custom CSS class for applying custom styles to this component. For more information, see Customizing the colors of ServiceNow components in AEM.</td>
</tr>
</tbody>
</table>

10. Set the Article List component properties to display a list of knowledge articles depending on the list criteria.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Public</td>
<td>Option to make the content of the component visible to public users. When selected, the knowledge articles available to unauthenticated users included in the component are available to all users, including public users.</td>
</tr>
<tr>
<td>Title</td>
<td>Title corresponding to the articles list that appears as the component header. Example: most viewed articles</td>
</tr>
<tr>
<td>Knowledge Bases</td>
<td>System identifier (sys_id) of a knowledge base that contains associated knowledge articles. Click Add field and enter the sys_id of a knowledge base. You can add multiple entries. Note: If you don’t add a value, knowledge bases from the OSGi configuration settings are used for ServiceNow components.</td>
</tr>
<tr>
<td>Language</td>
<td>Enables the display of a knowledge article in different languages when viewing the article. Select one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• Select from ServiceNow OSGi Configuration: Knowledge articles are displayed in the language configured in the OSGi configuration for ServiceNow components. This value is selected by default.</td>
</tr>
<tr>
<td></td>
<td>• Restrict to portal language: Knowledge articles are displayed in the language configured in the AEM site.</td>
</tr>
<tr>
<td></td>
<td>• All languages: Knowledge articles are displayed in all languages.</td>
</tr>
<tr>
<td>Secondary fields</td>
<td>Metadata of a knowledge article that appear with the article. Metadata include information such as the author, the date the article was last updated, and the date the article was last viewed. For multiple entries, separate the fields by commas. Example: author, sys_view_count, sys_updated_on, rating</td>
</tr>
<tr>
<td>Criteria</td>
<td>List of criteria for the knowledge articles list. Select one of the following options:</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>• <strong>Featured</strong>: List of featured knowledge articles based on the keywords configured in the <code>glide.knowman.default_keyword</code> property. For information about featured articles, see <a href="#">Add a knowledge article to featured content</a> and <a href="#">Knowledge properties</a>.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Most Viewed</strong>: List of knowledge articles with the most views.</td>
<td></td>
</tr>
<tr>
<td>Article count</td>
<td>Maximum number of articles to include in the articles list. Use the increment or decrement icons to increase or decrease the values. You can also manually enter a value. The value must be greater than 1.</td>
</tr>
<tr>
<td>Article page URL</td>
<td>Relative URL of the article page to redirect to. Example: <code>/content/NOWApp/now_article_view.html</code></td>
</tr>
<tr>
<td>Hide component when empty</td>
<td>Option to hide the component when there are no knowledge articles to display.</td>
</tr>
<tr>
<td>Custom CSS class</td>
<td>Custom CSS class for applying custom styles to this component. For more information, see <a href="#">Customizing the colors of ServiceNow components in AEM</a>.</td>
</tr>
</tbody>
</table>

**Display ServiceNow cases on an Adobe Experience Manager page**

Use case components available within Adobe Experience Manager (AEM) to access customer service cases from the ServiceNow instance and display them on an AEM-based website.

**Before you begin**

Define the cross-origin resource sharing (CORS) rule to access the Case API and CSM Attachment API from your AEM instance. For more information, see [Define a cross-origin resource sharing rule to access ServiceNow API endpoints from AEM](#).

Role required: AEM author

**About this task**

The Case REST API enables you to create, retrieve, and update customer service case records. For more information, see [Case API](#).
The CSM Attachment API enables you to upload, download, and remove attachments associated with customer service cases and to retrieve attachment metadata. For more information, see CSM Attachment API.

**Procedure**

1. Log in to your AEM instance.
2. Open your AEM page in *Edit mode*.
3. Open the *components browser*.
4. From the *All* list, select *ServiceNow*.
5. Drag a component to the required position on the page.

   **Note:** If components are not available, update your template configuration to include the case components. In addition, you must modify the properties of the site template and add each case component to the list of allowed components.

6. Open the *component dialog for editing*.

   **Note:** The case components in the Edit mode of a page in AEM are accessible to all users, including public users. Public users are anonymous AEM users who are not logged in.

7. Set the Case Cards component properties to display all open customer service cases from your ServiceNow instance as column cards.

### Case Cards component properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Title of this component that appears on the AEM page.</td>
</tr>
<tr>
<td>Label parameters</td>
<td>Comma-separated label parameters for Case [sn_customerservice_case] table columns. Each parameter is specified in the format <em>label:column</em>. Where <em>label</em> is displayed on the component and <em>column</em> is the name of a column from the Case [sn_customerservice_case] table. Example: <code>Number:number,Priority:priority,Product:product</code></td>
</tr>
<tr>
<td>Case list page URL</td>
<td>Relative URL of the case list page to redirect to. Example: <code>/content/servicenow/en/now_case_list.html</code></td>
</tr>
<tr>
<td>Case view page URL</td>
<td>Relative URL of the case view page to redirect to. Example: <code>/content/servicenow/en/now_case_view.html</code></td>
</tr>
</tbody>
</table>
8. Set the New Case component properties for users to create a customer service case in your ServiceNow instance from your AEM page.

### New Case component properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Title of this component that appears on the AEM page.</td>
</tr>
<tr>
<td>Short description label</td>
<td>Label for the field to enter a brief description of the case.</td>
</tr>
<tr>
<td>Description label</td>
<td>Label for the field to enter a description of the case.</td>
</tr>
<tr>
<td>Product label</td>
<td>Semicolon-separated parameters to define the label and the placeholder text for the product list.</td>
</tr>
<tr>
<td>Asset label</td>
<td>Semicolon-separated parameters to define the label and the placeholder text for the asset list.</td>
</tr>
<tr>
<td>Number of list items</td>
<td>Maximum number of items to include in the product and asset lists. Use the increment or decrement icons to increase or decrease the values. You can also manually enter a value. The value must be greater than 1.</td>
</tr>
<tr>
<td>Show assets</td>
<td>Option to display the asset list on the component.</td>
</tr>
<tr>
<td>Case list page URL</td>
<td>Relative URL of the case list page to redirect to.</td>
</tr>
<tr>
<td></td>
<td>Example: /content/servicenow/en/now_case_list.html</td>
</tr>
<tr>
<td>Case view page URL</td>
<td>Relative URL of the case view page to redirect to.</td>
</tr>
<tr>
<td></td>
<td>Example: /content/servicenow/en/now_case_view.html</td>
</tr>
</tbody>
</table>
9. Set the Case View component properties to display customer service cases and any comments and attachments, if available, from a ServiceNow instance.

### Case View component properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case parameter</td>
<td>Name of the URL query parameter for the case number. Example: <code>case_no</code></td>
</tr>
<tr>
<td>Label parameters</td>
<td>Comma-separated label parameters for Case [sn_customerservice_case] table columns. Each parameter is specified in the format <code>label:column</code>. Where <code>label</code> is displayed on the component and <code>column</code> is the name of a column from the Case [sn_customerservice_case] table. Example: <code>Number:number,Priority:priority,Product:product</code></td>
</tr>
<tr>
<td>Activities count</td>
<td>Maximum number of activities such as comments and attachments to be displayed on the Activity tab. Use the increment or decrement icons to increase or decrease the values. You can also manually enter a value. The value must be greater than 1.</td>
</tr>
<tr>
<td>Attachment file size limit in MB</td>
<td>Maximum size limit for an attachment file that can be added to a case. Use the increment or decrement icons to increase or decrease the values. You can also manually enter a value. The value must be greater than 1.</td>
</tr>
<tr>
<td>Article page URL</td>
<td>Relative URL of the article page to redirect to. Example: <code>/content/servicenow/en/now_article_view.html</code></td>
</tr>
</tbody>
</table>
10. Set the Case List component properties to display a list of customer service cases.

### Case List component properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Title of this component that appears on the AEM page.</td>
</tr>
<tr>
<td>Label parameters</td>
<td>Comma-separated label parameters for Case [sn_customerservice_case] table columns. Each parameter is specified in the format label:column. Where label is displayed on the component and column is the name of a column from the Case [sn_customerservice_case] table. Example: Number:number,Priority:priority,Product:product</td>
</tr>
<tr>
<td>Case count</td>
<td>Maximum number of cases to display on the component. Use the increment or decrement icons to increase or decrease the values. You can also manually enter a value. The value must be greater than 1. The maximum value you can enter for this field is 50.</td>
</tr>
<tr>
<td>Show create case</td>
<td>Option to display the button to create a case on the component.</td>
</tr>
<tr>
<td>Create case button label</td>
<td>Label for the button to create a case.</td>
</tr>
<tr>
<td>Case create page URL</td>
<td>Relative URL of the case create page to redirect to. Example: /content/servicenow/en/now_case_create.html</td>
</tr>
</tbody>
</table>
Integrate with Computer Telephony Integration (CTI)

Customer Service Management provides an integration with Computer Telephony Integration (CTI). This integration enables the Customer Service application to support inbound and outbound telephone calls.

Before you begin
Role required: admin

About this task
Customer service agents can do the following with CTI:
- Make an outgoing call to a phone number.
- Receive an incoming call from a phone number or from another user within the system.
- Transfer a call to another user within the system.
- Place a call on mute.
- Set their availability status.

CTI does not require any specific user role except the OpenFrame user (sn_openframe_user) role. Roles are based on the application using CTI.

Procedure
Navigate to Application > Module.

OpenFrame overview
OpenFrame provides a communication frame that customer service agents use to place and receive customer calls.

Use OpenFrame to integrate telephony systems into the Now Platform®. Use the OpenFrame API to communicate between the Now Platform and the domain opened in the OpenFrame window.

OpenFrame includes these components:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Case view page URL</td>
<td>Relative URL of the case view page to redirect to.</td>
</tr>
<tr>
<td></td>
<td>Example: /content/servicenow/en/now_case_view.html</td>
</tr>
<tr>
<td>Custom CSS class</td>
<td>Custom CSS class for applying custom styles to this component.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Customizing the colors of ServiceNow components in AEM.</td>
</tr>
</tbody>
</table>
TopFrame, a ServiceNow application.

OpenFrame API, which gets sourced from the partner application. This API communicates with TopFrame and controls the OpenFrame visual features.

The location of the API is https://[servicenow instance]/scripts/openframe/1.0.5/openFrameAPI.min.js. This minified version includes other needed libraries and should be used for integration.

For API reference, you can use the un-minified version: https://[servicenow instance]/scripts/openframe/1.0.5/openFrameAPI.js. This version cannot be used directly for integration purposes.

Note:

- To stay current with reference to the OpenFrame library, use the following resource URL: https://[servicenow instance]/scripts/openframe/latest/openFrameAPI.min.js.
- To integrate softphone into the Now Platform using OpenFrame, add the third-party URLs of telephony services in the following property: glide.ui.concourse.onmessage_enforce_same_origin_whitelist. For more information see, Available system properties, and Enable URL allow list for cross-origin iframe communication in Instance Security Hardening Settings.

Using the OpenFrame window

OpenFrame provides support for embedded and contextual phone conversations, including:

- Context identification: incoming calls maximize the OpenFrame window and display details about the caller, including the account, contact or consumer name, and phone number.
- Links to forms: use the openFrameAPI (openServiceNowForm) to create links to forms. When an incoming call is received, an agent can click the account, contact, consumer, or case number in the OpenFrame window to open the corresponding record.
  - In Agent Workspace, records open in either a primary tab or a sub-tab depending on the tab configuration.
  - In the platform interface, records open in TopFrame (i.e., the current page).
- Click-to-call capability: click phone number fields to make a call.
In Agent Workspace, agents can click phone number fields on forms and in the Customer 360 ribbon component to make a call.

In the platform interface, agents can click the phone icon next to the Contact or Consumer fields.

- If a contact or consumer has one phone number, the call is placed to that number.
- If a contact or consumer has more than one phone number, a dialog box displays the available numbers. Click a number to place the call.

- OpenFrame window actions:

<table>
<thead>
<tr>
<th>User action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open the window</td>
<td>In Agent Workspace, click the phone icon:</td>
</tr>
<tr>
<td></td>
<td>◦ In the navigation bar.</td>
</tr>
<tr>
<td></td>
<td>◦ Next to the Contact or Consumer fields on the Case form.</td>
</tr>
<tr>
<td></td>
<td>In the platform interface, click the phone icon:</td>
</tr>
<tr>
<td></td>
<td>◦ In the banner frame.</td>
</tr>
<tr>
<td></td>
<td>◦ Next to the Contact or Consumer fields on the Case form.</td>
</tr>
<tr>
<td></td>
<td>With the admin role, you can configure the phone icon. For more information, see CTI integration with the Case form.</td>
</tr>
<tr>
<td>Hide the window</td>
<td>Click the X in the OpenFrame window header.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The OpenFrame window remains on top of other forms or pages until hidden.</td>
</tr>
<tr>
<td>Expand or collapse the window</td>
<td>Click the + / – buttons in the OpenFrame window header (if Enable collapsed view is set to True in the OpenFrame configuration).</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When collapsed, agents can still access call control actions.</td>
</tr>
<tr>
<td>Move the window</td>
<td>Click and drag the OpenFrame window header.</td>
</tr>
</tbody>
</table>
Using OpenFrame in Agent Workspace

In Agent Workspace, you can integrate OpenFrame with the Interaction Management System (IMS) and interaction records. This allows agents to manage the phone interaction life cycle. For more information, see Integration with Interaction Management System (IMS).

Creating an OpenFrame configuration

With the admin role, you can create or modify an OpenFrame configuration. This configuration stores information about the OpenFrame window settings, including:

- The window height and width.
- The icon, title, and subtitle displayed in the window header.
- Users and groups that have access to the window.

OpenFrame user roles

The OpenFrame window is available to agents with the sn.open.frame_user role and who belong to one of the user groups specified in the OpenFrame configuration.

Related information

openFrameAPI - Client

Computer Telephony Integration Workflows

Computer Telephony Integration (CTI) enables customer service agents to place and receive phone calls in ServiceNow applications.

The following sample workflows show how CTI can be integrated with Interaction Management System (IMS) and OpenFrame (OF) to support outgoing and incoming telephone calls.

CTI integration for outgoing call

The following workflow describes the logical sequence of actions when an outgoing call is triggered using the OpenFrame window.
CTI integration for incoming call
The following workflow describes the logical sequence of actions when an incoming call is received using the OpenFrame window.

CTI integration for transferring call
The following workflow describes the logical sequence of actions when an incoming call is transferred to an agent.
CTI call interactions operations

CTI integration with IMS and OF uses the OpenframeInteractionUtility script. You can use the createOrUpdateInteractionForOpenframe method from the utility script to create an interaction. For more information about creating interaction using APIs, see Interaction Management API.

CTI demo implementation

Use the CTI demo implementation to test the phone communication channel between customer service agents and external customers in a non-production instance.

The CTI Softphone plugin enables softphone functions and call center capabilities. This plugin provides integration between the ServiceNow platform and the Twilio Voice service using the Notify application. This plugin can be activated any time after activating Notify.

The CTI Softphone plugin includes one OpenFrame configuration, called CTI. This configuration specifies the necessary OpenFrame window settings as well as the URL to be launched within OpenFrame.

Note: The included CTI configuration does not have the Default field enabled. You must enable this field to use the CTI configuration as the default.

<table>
<thead>
<tr>
<th>Fields updated using CreateInteraction operation:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. channel</td>
</tr>
<tr>
<td>2. channel_metadata</td>
</tr>
<tr>
<td>3. context</td>
</tr>
<tr>
<td>4. state</td>
</tr>
<tr>
<td>5. assigned_to</td>
</tr>
<tr>
<td>6. closed_by</td>
</tr>
<tr>
<td>7. opened_for</td>
</tr>
<tr>
<td>8. worknotes</td>
</tr>
<tr>
<td>9. account</td>
</tr>
<tr>
<td>10. contact</td>
</tr>
<tr>
<td>11. consumer</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Fields updated using UpdateInteraction operation:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. sys_id</td>
</tr>
<tr>
<td>2. channel</td>
</tr>
<tr>
<td>3. channel_metadata</td>
</tr>
<tr>
<td>4. context</td>
</tr>
<tr>
<td>5. state</td>
</tr>
<tr>
<td>6. assigned_to</td>
</tr>
<tr>
<td>7. closed_by</td>
</tr>
<tr>
<td>8. opened_for</td>
</tr>
<tr>
<td>9. worknotes</td>
</tr>
<tr>
<td>10. account</td>
</tr>
<tr>
<td>11. contact</td>
</tr>
<tr>
<td>12. consumer</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Fields updated using UpdateInteractionState operation:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. sys_id</td>
</tr>
<tr>
<td>2. state</td>
</tr>
</tbody>
</table>
CTI demo installation and configuration

Before the phone communication channel between customer service agents and external customers can be used, the Notify, CTI Softphone, Customer Service Management, and Openframe plugins must be activated and configured, and a Twilio Voice account must be set up.

**Before you begin**
Role required: admin

**Procedure**

1. **Activate the Notify plugin (com.snc.notify).**
2. **Set up a Twilio Voice account.**
   You can create an account at [https://www.twilio.com](https://www.twilio.com).
3. **Configure Notify to use the Twilio Voice service.**
4. **Activate the CTI Softphone plugin (com.snc.cti).**
   If you want to load the demo data for CTI Softphone, you must also activate the Customer Service CTI Demo Data plugin (com.snc.customerservice_cti_demo). This demo data includes sample workflows.
5. **Activate the Customer Service plugin (com.sn_customerservice).**
6. **Activate the Openframe plugin (com.sn_openframe).**
   Activating the Customer Service Management plugin automatically activates the Openframe plugin.
7. **Create an OpenFrame configuration or use the default CTI configuration by enabling the Default field.**

**Answer an incoming call**

Use the OpenFrame window to answer an incoming call.

**Before you begin**
Role required: sn_customerservice_agent, sn_customerservice.consumer_agent, sn_open_frame, or admin

**About this task**
The OpenFrame window displays the incoming call, including the phone number and the customer contact or consumer information.
Procedure
1. Click Accept.
2. When the call is finished, click End.

Make an outgoing call
Use the OpenFrame window to make an outgoing call.

Before you begin
Role required: sn_customerservice_agent, sn_customerservice.consumer_agent, sn_open_frame, or admin

Procedure
1. Do one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click the phone icon in the banner frame.</td>
<td>Enter the phone number in the <strong>Number</strong> field and click <strong>Call</strong>.</td>
</tr>
</tbody>
</table>
| Click the phone icon next to the Contact or Consumer fields on the Case form. | Customer contacts and consumers can have multiple phone numbers.  
  • If only one phone field is populated, a call is placed to that number.  
  • If more than one phone field is populated, a dialog box displays the available numbers. Click the desired number to place the call and close the dialog box. |

2. When finished with the call, click **End**.

Transfer a call
After accepting an incoming call, a customer service agent can transfer a call to another agent.

Before you begin
Role required: sn_customerservice_agent, sn_customerservice.consumer_agent, sn_open_frame, or admin
Procedure
1. Answer an incoming call.
2. Click Transfer.
3. Select an agent from the drop-down list.
4. Click Call.

Set agent call status
Customer service agents can set their current call status.

Before you begin
Role required: sn_customerservice_agent, sn_customerservice.consumer_agent, sn_open_frame, or admin

Procedure
1. Click the phone icon in the banner frame.
2. Select your availability.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available</td>
<td>The agent is available to take a call.</td>
</tr>
<tr>
<td>Not Available</td>
<td>The agent is not available to take a call.</td>
</tr>
<tr>
<td>Busy</td>
<td>The agent is currently on a call with a customer.</td>
</tr>
<tr>
<td>Wrap Up</td>
<td>The agent is updating case information after completing a call.</td>
</tr>
<tr>
<td></td>
<td>After completing a call and the subsequent wrap up, an agent must manually change the status from Wrap Up to Available.</td>
</tr>
</tbody>
</table>

The Presence field in the OpenFrame > OpenFrame Agent Presence record is updated with the availability status set for the agent.

Computer Telephony demo integration with the Case form
Activating the CTI Softphone plugin enables call-related features on the Case form.
The customer service or consumer service agent can use the phone icon next to the **Contact** and **Consumer** fields on the Case form to make a phone call. The phone icon appears next to these fields if the entity record has at least one phone field (ph_number) and at least one of those phone fields contains a phone number.

The phone icon is a reference contribution that can be added to any reference field by modifying the dictionary and adding the following attribute: `ref_contributions=show_phone_customer_service`.

### Note:
If you are using a third-party provided CTI application, then you can integrate with the show_phone UI macro to make calls. For more information on UI macros, refer to [UI macros installed with OpenFrame](#).

Click the phone icon to place a call to a consumer or a contact.

- If only one phone field is populated, a call is placed to that number.
- If more than one phone field is populated, a dialog box displays the available numbers. Click the desired number to place the call and close the dialog box.

![Select Phone Number dialog box](image)

Incoming and outgoing calls are logged in the Phone Log [sn_openframe_phone_log] table. Call details are recorded in the **Activity** field on the Case form and in the **Phone** related list.

### CTI demo integration with case routing

An incoming call from a customer contact or a consumer can be routed to an available customer service agent.

Similar to the other communication channels, incoming calls from customer contacts and consumers can be routed to a specific agent by using matching rules. If an agent is not available, the call can be placed in a queue. After the agent is free, the matching call in the queue with the longest wait time is rerouted to the agent.

Case routing is enabled as an activity in a workflow. In the Call Center demo workflow (available with the Customer Service CTI Demo Data plugin), a call
is forwarded to an agent after the caller either creates a new case or enters a valid number for an existing case.

If no agents are available, the call goes into a queue and remains there until an agent becomes available. If a call is in the queue for longer than 10 minutes, it is forwarded to voice mail and the caller is asked to leave a message.

**Related reference**
- Routing and assigning customer service cases

**Related information**
- Notify workflow activities

**Computer Telephone demo integration with tasks**
The CTI Softphone component can be integrated with other task entities on the Now Platform.

A workflow can be implemented to operate on the Incident table.

ℹ️ **Note:** The Call Center for Incident Management workflow, a demo workflow, is available with the Customer Service CTI Demo Data plugin.

Incoming or outgoing calls are logged in the Phone Log [sn_openframe_phone_log] table. The call logs also appear in the activity history of the task.

**Associate a phone number with a workflow**
You can associate a Notify phone number with a workflow.

**Before you begin**
You must create a Twilio Voice account and configure Notify with Twilio Voice before you can associate a phone number with a number group and workflow. A number group allows you to group Notify phone numbers and then share workflows across grouped numbers. For each number group, you can specify a workflow for incoming and outgoing calls.

The CTI Softphone demo data includes these sample workflows:
- Call Center, for use with the Customer Service Management application
- Call Center for Incident Management

The Call Center workflow uses several Notify workflow activities that determine workflow functionality. Each activity performs a different task, such as playing a message greeting or creating a list of user input options. Activities can succeed or fail, which can result in actions performed by other activities.
You can use the default Call Center workflow or modify this workflow as needed.

Role required: admin

**Procedure**

1. Navigate to **Notify > Numbers**.
2. From the Notify Phone Numbers list, click the phone number that you want to edit.
3. Select a **Notify Group** that uses the incoming call workflow that you want to handle this phone number.
   The CTIDemo group uses the Call Center workflow for incoming calls.
4. Click **Update**.

**Related information**
- Numbers and number groups
- Notify workflow activities
- Configure Notify with Twilio

**Integrate with Microsoft Outlook**

Customer Service Management provides an integration with Microsoft Outlook. This integration enables you to manage workflows such as creating and updating contacts and cases from within Microsoft Outlook.

**Before you begin**

Role required: admin

**About this task**

⚠️ **Note:** You must be an Office 365 administrator to deploy the ServiceNow Add-in for Microsoft Outlook. This add-in is supported only for use with Microsoft Outlook 2016+ for MacOS and for Windows.

The following plugins are required to enable you to interact with the ServiceNow platform and customers from within Microsoft Outlook:

- ServiceNow Add-In for Microsoft Outlook (com.sn_outlook_addin)
- CSM Extension for Proxy Contacts (com.snc.csm_proxy_contacts)
Procedure
1. Navigate to System Definition > Plugins.
2. Search for the ServiceNow Add-In for Microsoft Outlook plugin (com.sn_outlook_addin).
3. Click Activate.
4. Search for the CSM Extension for Proxy Contacts plugin (com.snc.csm_proxy_contacts).
5. Click Activate.

Configure the ServiceNow Add-in for Microsoft Outlook
Configure user roles and download the office add-in manifest file in order to use the ServiceNow Add-in for Microsoft Outlook.

Before you begin
Role required: admin or both sn_customerservice.proxy_contact and sn_customerservice.contact_manager roles.

Procedure
1. Go to your ServiceNow instance.
2. Navigate to ServiceNow Add-Ins for Office > Office Add-In-Manifests.
3. Click ServiceNow for CSM.
4. Click Download Manifest to download the Microsoft Office add-in manifest file.
5. Provide the downloaded manifest.xml file to the account manager to enable the installation of the add-in.

Related information
Install the ServiceNow Add-in for Microsoft Outlook
Include a combined ITSM and CSM add-in icon in Microsoft Outlook
Configure a single add-in icon when a user has multiple applications installed so the user has access through one combined add-in icon instead of having many individual add-in icons.

Before you begin
Role required: sn_customerservice.contact_manager and sn_customerservice.proxy_contact
About this task
The View in ServiceNow header option appears in the header when you have configured the add-in icon only for CSM where you can perform the CSM tasks. If you configure an add-in for both CSM and ITSM, the ServiceNow for CSM/ITSM icon appears in the header and you can perform both the CSM and ITSM tasks.

Procedure
1. Go to your ServiceNow instance.
3. Download the manifest file for CSM and ITSM.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ServiceNow for CSM</td>
<td>Manifest file for CSM.</td>
</tr>
<tr>
<td>ServiceNow for ITSM</td>
<td>Manifest file for ITSM.</td>
</tr>
</tbody>
</table>

4. Click Download Manifest.
5. Install the ServiceNow Add-in for Microsoft Outlook add-in.
   Follow the procedure in Install the ServiceNow Add-in for Microsoft Outlook. Once you have installed the ServiceNow add-in, the ServiceNow for CSM/ITSM icon appears in the header. Click the icon to view both the ITSM and CSM tasks.

Install the ServiceNow Add-in for Microsoft Outlook
Installing the ServiceNow Add-in for Microsoft Outlook enables you to interact with the ServiceNow platform from within Microsoft Outlook.

Before you begin
Role required: sn_customerservice.contact_manager
Procedure

1. Navigate to Microsoft Outlook > Get Add-ins.
2. Select My add-ins.
3. Go to the Custom add-ins tile and select Add from file from the Add a custom add-in drop-down list.
4. Select the manifest.xml file that your admin provided.
5. Click Install.
6. Click View in ServiceNow in Microsoft Outlook and log in with the credentials your admin provided.
7. Click Allow.

Results
You can now connect to your account on your ServiceNow instance and interact with its records from within Microsoft Outlook.

Integrate Customer Service Management with Safe Workplace applications

Customer Service Management provides an integration with ServiceNow® Safe Workplace applications. This integration helps you safely reopen locations and support the health and safety of contacts and consumers after emergencies and pandemics.

Overview
Integrate with Safe Workplace applications, specifically with the Employee Health Screening application, to enable contacts or consumers to safely enter locations and comply with health and safety policies.

As a consumer or contact, verify that you understand and comply with requirements and policies by filling out the Health Verification form on the Consumer or Customer Service Portal.

As a customer or consumer service agent, screen contacts or consumers entering a location to ensure compliance with entry requirements such as a temperature check and Personal Protection Equipment (PPE).

For more information on the Employee Health Screening application, see Employee Health Screening.
Key features

- Access for consumers and contacts to the Health Verification form on the Consumer or Customer Service Portals.
- Ability for customer or consumer service agents to screen consumers and contacts on visiting a location.

Set up Customer Service Management with Safe Workplace applications

Enable the integration with Safe Workplace applications to help contacts or consumers safely enter locations and comply with health and safety policies.

Before you begin

Ensure that the Customer Service plugin (com.sn_customerservice) is installed.

If you are supporting business-to-consumer (B2C) customers, ensure that the Consumer Service Portal plugin (com.glide.service-portal.consumer-portal) is installed.

Role required: admin

Procedure

1. Install Employee Health Screening.
2. Give external users access to the Health Verification form.
   For more information, see the Allow external users access to "Health Verification" catalog item [KB0856301] article in the HI Knowledge Base.
3. Assign the sn_imt_monitoring.monitoring_user role to a customer or consumer service agent.
4. Optional: Configure the health screening form.
5. Optional: Create relationships to show health screening information on Agent Workspace.
6. Optional: Customize the Consumer or Customer Service Portal to display a link to the Health Verification form in the portal header menu.

Configure the health screening form

Provide additional information on contacts or consumers to health screeners by adding fields to the health screening form.

Before you begin

Role required: admin
Procedure
1. Navigate to Service Catalog > Catalog Definition > Record Producers.
   a. In the Record Producers list, search for Screen a person in the Name column.
   b. In the Variables related list, click New.
   c. Create a variable.
   d. Click Submit.
      Note: For more information about the different types of variables and how to configure them, see Creating variables.
   e. In the Catalog Client Scripts related list, open Show additional CSM fields.
   f. Add the variable to the client script as a consumer or contact field.
      Note: For more information on client scripts, see Client scripts.
2. Navigate to Activity Subscriptions > Script Includes.
   a. Add the variables to the HealthScreeningUtil script include.
      Note: For more information on script includes, see Script includes.

Using Customer Service Management with Safe Workplace applications
Screen consumers and contacts for compliance with health and safety policies to determine whether they are permitted to enter a location.

To ensure that consumers and contacts can enter a location safely after emergencies and pandemics, consumers or contacts fill out a Health Verification form and health screeners or customer or consumer service agents perform a health screening.

Note: Typically, you receive an email or a mobile notification with a link to the health verification form. Alternatively, you can search for the health verification form on the Consumer or Customer Service Portal.

Roles required
Users with the roles listed in the following table can use Customer Service Management with Safe Workplace applications.
<table>
<thead>
<tr>
<th>Role</th>
<th>Task</th>
</tr>
</thead>
</table>
| `sn_customerservice.consumer or sn_customerservice_customer` | Access and complete the Health Verification form on the Consumer or Customer Service Portals.  

**Note:** For more information on filling out the form, see Verify your health status and compliance. |
| `sn_imt_monitoring.monitoring_user` | Screen external users entering a location to ensure compliance with entry requirements.  

**Note:** Health screeners cannot view additional Customer Service Management information on the screening form.  

For more information on screening, see Conduct a health screen for entry. |
| `sn_customerserviceagent with the sn_imt_monitoring.monitoring_user role` | Screen contacts entering a location to ensure compliance with entry requirements.  

The **Accounts** field for contacts is displayed by default on the screening form. Other fields that have been configured for contacts are also visible. |
| `sn_customerservice.consumer_agent with the sn_imt_monitoring.monitoring_user role` | Screen consumers entering a location to ensure compliance with entry requirements.  

The **Suffix** field for consumers is displayed by default on the screening form. Other fields that have been configured for consumers are also visible. |
Integrate with consumer messaging apps

Deliver a conversational mobile messaging experience for consumers and customer contacts by integrating the CSM application with each consumer messaging app.

About this task

Engage customers wherever they are with useful conversations by enabling them to message anytime to your company's account using their choice of messaging apps. Consumers and customer contacts can start conversations with a virtual agent by sending messages to your company's designated mobile number. They can also select to chat with a live agent from the same messaging app.

You have the following options for integrating consumer messaging apps with the Customer Service Management application:

Procedure

- Integrate the WhatsApp messaging app with Customer Service Management through Twilio.
- Integrate the LINE messaging app with Customer Service Management.
- Integrate the Facebook Messenger app with Customer Service Management.

Integrating WhatsApp with Customer Service Management through Twilio

Deliver a pre-integrated chat conversation experience with the WhatsApp messaging app for consumers and customer contacts. Integrate WhatsApp by using the ServiceNow® Conversational Integration with WhatsApp (powered by Twilio) application.

As an administrator, if you have configured the Conversational Integration with WhatsApp (powered by Twilio) application, then your customer contacts and consumers can initiate a WhatsApp chat conversation with a virtual agent or live agent. An agent can initiate a conversation or accept a conversation initiated from a WhatsApp chat conversation. For more information, see Configure Conversational Integration with WhatsApp (powered by Twilio).

Note: As an administrator, you can also use any predefined Customer Service Virtual Agent conversations to capture information from customer contacts or consumers. For more information, see Customer Service Virtual Agent conversations.

Key features of the integration include the following:
• Initiate WhatsApp chat conversations with a virtual agent, live agent, or customer.

• Use the chat to search for articles in community posts and knowledge articles, access service catalogs, or create a customer service case.

• View the WhatsApp chat conversation details from which a work item was initiated in Agent Workspace.

• Indicate your presence in the Agent Workspace Inbox with the WhatsApp service channel.

• Make outbound chat conversations to connect with a customer's WhatsApp chat conversation, and automatically capture interaction details to simplify data entry.

Example workflows

The following example workflow shows the use of the Conversational Integration with WhatsApp (powered by Twilio) application in resolving a consumer issue:

1. A customer has an issue with a product and initiates a WhatsApp chat conversation using the Virtual Agent bot.

2. The Customer Service Management application identifies the customer and starts an interaction of type Messaging.

3. The customer selects the product and views the knowledge articles associated with the product.

4. The customer then selects to chat with a live agent.


6. The live agent creates a case on the product, and then closes the conversation.

The following example workflow shows the use of the Conversational Integration with WhatsApp (powered by Twilio) application in addressing customer feedback:

1. A customer purchases a new product and opts in to receive notifications from your business on the WhatsApp app.

2. The customer receives a welcome message from customer support.

3. After two months, the customer receives another message asking for feedback on the product.
4. The customer shares negative feedback.

5. An agent reviews the feedback and starts a conversation with the customer to offer help and find out more about the customer’s experience with the product.

**End users and roles**

The users with the roles listed in the following table can use the Conversational Integration with WhatsApp (powered by Twilio) application.

<table>
<thead>
<tr>
<th>Roles</th>
<th>Tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent_workspace_user</td>
<td>Accept an ongoing WhatsApp chat conversation with a customer through the WhatsApp service channel in Advanced Work Assignment.</td>
</tr>
<tr>
<td>sn_customerservice_manager</td>
<td>View details of a WhatsApp chat conversation by using interaction records of type <strong>Messaging</strong> and subtype <strong>WhatsApp</strong>.</td>
</tr>
<tr>
<td>sn_customerservice.consumer, sn_customerservice.customer</td>
<td>Initiate WhatsApp chat conversations with a virtual agent or live agent so that you can search for articles in Communities and Knowledge Management, access service catalogs, and create a customer service case.</td>
</tr>
</tbody>
</table>

**Integrating LINE with Customer Service Management**

Deliver a pre-integrated chat conversation experience with the LINE messaging app for consumers and customer contacts. Integrate LINE with the ServiceNow® Conversational Integration with LINE application.

As an administrator, if you have configured the Conversational Integration with LINE application, your customer contacts and consumers can initiate a LINE chat conversation with a virtual agent or live agent. An agent can initiate a conversation or accept a conversation initiated from a LINE chat conversation. You can configure system-initiated messages to be sent to the customer. For more information, see Configure Conversational Integration with LINE.

**Note:** As an administrator, you can also use any predefined Customer Service Virtual Agent conversations to capture information from customer contacts or consumers. For more information, see Customer Service Virtual Agent conversations.
Key features of the integration include the following:

• Initiate LINE chat conversations with a virtual agent, live agent, or customer.
• Use the chat to search for articles in community posts and knowledge articles, access service catalogs, or create a customer service case.
• View the LINE chat conversation details from which a work item was initiated in Agent Workspace.
• Indicate your presence in the Agent Workspace Inbox with the Line service channel.
• Make outbound chat conversations to connect with a LINE chat conversation from a customer contact or consumer, and automatically capture interaction details to simplify data entry.

Example workflows

The following example workflow shows the use of the Conversational Integration with LINE application in helping a customer to resolve an issue with the recently purchased router:

1. The customer initiates a LINE chat conversation using the Virtual Agent bot.
2. The Customer Service Management application identifies the customer and starts an interaction of type Messaging.
3. The customer selects the router as a product and finds knowledge articles associated with it.
4. The customer ends the conversation because the issue was resolved with the help of a knowledge article.

The following example workflow shows the use of the Conversational Integration with LINE application in addressing customer feedback:

1. A customer purchases a new product and opts in to receive notifications from your business on the LINE app.
2. The customer receives a welcome message from customer support.
3. After two months, the customer receives another message asking for feedback on the product.
4. The customer shares negative feedback.
5. An agent reviews the feedback and starts a conversation with the customer to offer help and find out more about the customer’s experience with the product.
End users and roles

Users with the roles listed in the following table can use the Conversational Integration with LINE application.

Roles required for Conversational Integration with LINE

<table>
<thead>
<tr>
<th>Roles</th>
<th>Tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent_workspace_user</td>
<td>Accept an ongoing LINE chat conversation with a customer through the LINE service channel in Advanced Work Assignment.</td>
</tr>
<tr>
<td>sn_customerservice_manager</td>
<td>View details of a LINE chat conversation by using interaction records of type <strong>Messaging</strong> and subtype <strong>Line</strong>.</td>
</tr>
<tr>
<td>sn_customerservice.consumer, sn_customerservice.customer</td>
<td>Initiate LINE chat conversations with a virtual agent or live agent so that you can search for articles in Communities and Knowledge Management, access service catalogs, and create a customer service case.</td>
</tr>
</tbody>
</table>

Integrating Facebook Messenger with Customer Service Management

Deliver a pre-integrated chat conversation experience with the Facebook Messenger app for consumers and customer contacts by using the Conversational Integration with Facebook Messenger application.

As an administrator, if you have configured the Conversational Integration with Facebook Messenger application, your customer contacts and consumers can initiate a Facebook Messenger chat conversation with a virtual agent or live agent. An agent can accept a conversation initiated from a Facebook Messenger chat conversation. For more information, see Configure Conversational Integration with Facebook Messenger.

**Note:** As an administrator, you can also use any predefined Customer Service Virtual Agent conversations to capture information from customer contacts or consumers. For more information, see Customer Service Virtual Agent conversations.

Key features

**Customer experience**

Initiate Facebook Messenger chat conversations with a virtual agent or live agent to search for articles in community posts and
knowledge articles, access service catalogs, or create a customer service case.

**Agent experience**

- View the Facebook Messenger chat conversation details from which the work item was initiated in Agent Workspace after accepting a work item associated with the Facebook Messenger service channel.
- Indicate your presence in the Agent Workspace Inbox with the Facebook Messenger service channel.
- Make outbound chat conversations to connect with a Facebook Messenger chat conversation from a customer contact or consumer and automatically capture interaction details to simplify data entry.

**End users and roles**

Users with the roles listed in the following table can use the Conversational Integration with Facebook Messenger application.

<table>
<thead>
<tr>
<th>Roles</th>
<th>Tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent_workspace_user</td>
<td>Accept an ongoing Facebook Messenger chat conversation with a customer through the Facebook Messenger service channel in Advanced Work Assignment.</td>
</tr>
<tr>
<td>sn_customerservice_manager</td>
<td>View details of a Facebook Messenger chat conversation using the interaction record of the type as <strong>Messaging</strong> and subtype as <strong>Facebook Messenger</strong>.</td>
</tr>
<tr>
<td>sn_customerservice.consumer,</td>
<td>Initiate Facebook Messenger chat conversations with a virtual agent or live agent to search for articles in Communities and Knowledge Management, access service catalogs, and create a customer service case.</td>
</tr>
<tr>
<td>sn_customerservice.customer</td>
<td></td>
</tr>
</tbody>
</table>

**Example workflow**

The following example workflow shows the use of the Conversational Integration with Facebook Messenger application in helping a customer to resolve an issue with the recently purchased router:
1. The customer initiates a Facebook Messenger chat conversation using the Virtual Agent bot.

2. The Customer Service Management application identifies the customer and starts an interaction of type **Messaging**.

3. The customer selects the router as a product and finds knowledge articles associated with it.

4. The customer ends the conversation because the issue was resolved with the help of a knowledge article.

**Using Customer Service Management**

Agents and managers can use Customer Service Management application to create cases for customers, route cases to agents with the required skills and availability, manage customer information and case activity, and connect with other applications and departments to assist with case resolution.

**Manage customer service cases**

Customers service agents and managers can create and route cases; manage customer information and interactions; monitor case activity, including case status and SLAs; and work to resolve customer issues.

**Manager tasks**

Customer service managers oversee agents and agent groups. Managers can perform tasks such as assigning cases, managing customer account teams, and maintaining special handling notes.

**Assign a case from the assignment workbench**

Users with the customer service manager role can assign a case to an agent from the assignment workbench.

**Before you begin**

Role required: sn_customerservice_manager

**Procedure**

1. Open a customer service case.

2. Click the Find Agents icon (🔍) next to the **Assigned to** field to open the assignment workbench.
   
   If the case has an **Assignment group**, the agents from that group are listed on the workbench. If the case does not have an assigned group, no agents are displayed.
Note: The state of the current record determines the availability of the Find Agents icon. The icon is available for records in the Open, Awaiting, and Cancelled states, and if the user has write access for the Assigned to field. The icon is not available for records in the New or Closed states or when the Assigned to field is read-only for the current user.

3. Optional: Select an assignment group from the Group list. The list of agents updates based on the selected group.

4. Optional: Add or remove skills from the Skills list. The selected skills appear in a list below this field. The Matching Skills column updates to reflect the selected skills.

Note: Mandatory skills cannot be changed.

5. Optional: Sort the agents by clicking the column header for the desired matching criteria.

6. Select an agent by enabling the check box by the agent’s name and then click Assign. The assignment workbench closes and the name of the selected agent appears in the Assigned to field on the Case form.

7. Click Update to save the agent assignment.

Related information
Assignment workbench overview

Create a special handling note
Create a special handling note for a record.

Before you begin
Role required: sn_shn.admin or sn_customerservice_manager

Procedure
1. Perform one of the following actions.
   • Navigate to the desired form and click the Create Special Handling Note related link.
   • Navigate to Special Handling Notes > Special Handling Notes and click New.

2. Fill in the fields, as necessary.
**Special Handling Notes form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short Description</td>
<td>A brief description of the note which is displayed in the Special Handling Notes list.</td>
</tr>
<tr>
<td>Message</td>
<td>The detailed content of the note.</td>
</tr>
<tr>
<td>Display as pop-up alert</td>
<td>Displays this note in the Special Handling Notes pop-up window.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of special handling note:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Standard</strong>: Create a note for a specific record, which you select in the Related record field.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Conditional</strong>: Create a note for multiple records which meet certain conditions. Select a Table name and then create Conditions.</td>
</tr>
<tr>
<td>Priority</td>
<td>The priority of the note:</td>
</tr>
<tr>
<td></td>
<td>• 1-Critical</td>
</tr>
<tr>
<td></td>
<td>• 2-High</td>
</tr>
<tr>
<td></td>
<td>• 3-Moderate</td>
</tr>
<tr>
<td></td>
<td>• 4-Low</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the special handling note:</td>
</tr>
<tr>
<td></td>
<td>• <strong>1-Active</strong>: The note is active and appears in the Notes list or pop-up window.</td>
</tr>
<tr>
<td></td>
<td>• <strong>2-Inactive</strong>: The note is inactive and does not appear in the Notes list or pop-up window.</td>
</tr>
<tr>
<td></td>
<td>Inactive notes are removed from the Notes list but can be seen by navigating to Special Handling Notes &gt; Special Handling Notes.</td>
</tr>
<tr>
<td></td>
<td>• <strong>3-Expired</strong>: The note has reached its expiration date.</td>
</tr>
<tr>
<td>Effective immediately</td>
<td>Check box to make the special notes effective immediately. The status is set to 1 -Active.</td>
</tr>
<tr>
<td></td>
<td>Deselect this check box to display the Effective on field.</td>
</tr>
<tr>
<td>Effective on</td>
<td>The date on which the special notes become effective.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Enter a date for the special notes to become effective and click <strong>Update</strong>. The status is set to <strong>2 - Inactive</strong> until the date is reached.</td>
<td></td>
</tr>
<tr>
<td>Expires on</td>
<td>The date on which the note expires. Select a date from the calendar and click <strong>Save</strong>. The <strong>Deactivate Special Handling notes</strong> scheduled job runs daily at midnight and checks all active alerts. If the notes have reached their expiration date, it sets the status to <strong>Expired</strong>. The <strong>Deactivate Special Handling notes</strong> scheduled job also checks the <strong>Effective on</strong> field. If the status is active or inactive and the expiry date has been reached, it sets the status to <strong>Expired</strong>. If the status is inactive and the effective on date has been reached, it sets the status to <strong>Active</strong>.</td>
</tr>
<tr>
<td>Related record</td>
<td>The record for which this note is created. This field appears when you select <strong>Standard</strong> in the <strong>Type</strong> field. If you access this form from the <strong>Create Special Handling Notes</strong> related link, the record number is automatically filled in. To select a record, select a <strong>Table name</strong> and a <strong>Document</strong> from the pop-up window. The tables available for selection have been configured to use special handling notes.</td>
</tr>
<tr>
<td>Table name</td>
<td>The table that stores the entity for which the note is being created. This field appears when you select <strong>Conditional</strong> in the <strong>Type</strong> field. The default is the first table which has been configured to use special handling notes. After you select a table, a link is displayed with the number of matching records. This link is updated after you select one or more conditions. Click the link to display these records in a list.</td>
</tr>
<tr>
<td>Conditions</td>
<td>This field appears when you select <strong>Conditional</strong> in the <strong>Type</strong> field. Use the buttons in this field to build one or more conditions on the selected table. A condition is made up of a selected field, an operator, and a value. Add conditions using the <strong>AND</strong> and <strong>OR</strong> buttons. Delete conditions by clicking the <strong>Delete</strong> button to the right of a condition.</td>
</tr>
</tbody>
</table>

**3. Click** **Submit**.
Delete a special handling note
Delete a special handling note for a record.

Before you begin
Role required: sn_customerservice_manager or sn_shn.admin

About this task
Users with the sn_customerservice_manager role can delete a special handling note if they can delete a record for the underlying table.

Procedure
1. Navigate to Special Handling Notes > Special Handling Notes.
   You can also delete a note from the Special Handling Notes list on a form.
2. In the Special Handling Notes list, click the note to be deleted.
3. Click Delete.

Delete a special handling note from a form
Delete a special handling note for a record from the Special Handling Notes list on the form.

Before you begin
Role required: sn_customerservice_manager or sn_shn.admin

About this task
Users with the sn_customerservice_manager role can delete a special handling note if they can delete a record for the underlying table.

Procedure
1. Navigate to an entity form.
2. In the Special Handling Notes list, click the red X to the left of the desired note.
Initially, the note remains in the Special Handling Notes list and the text of the note is crossed out. The note is removed from the list after the form is saved.

3. Click **Update**.

**Related information**

- Special handling notes overview
- Delete a special handling note

**Create a social media profile**

Users with the customer service manager role can create a social media profile for an account, contact, or consumer.

**Before you begin**

Role required: sn_customerservice_manager or admin

**Procedure**

1. Navigate to the **Social Profiles** related list on the desired entity form: Account, Contact, or Consumer.

2. Click **New**.

3. Fill in the fields on the Social Profile form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel</td>
<td>The social media channel for this profile. For example, Twitter or Facebook.</td>
</tr>
<tr>
<td>Social ID</td>
<td>The user's name or handle for the selected social media channel.</td>
</tr>
<tr>
<td>Contact</td>
<td>If created from the Contact form, this field displays the name of the contact.</td>
</tr>
<tr>
<td>Consumer</td>
<td>If created from the Consumer form, this field displays the name of the consumer.</td>
</tr>
<tr>
<td>Account</td>
<td>If created from the Account form, this field displays the name of the account.</td>
</tr>
<tr>
<td>Profile URL</td>
<td>The link to the user's social media account.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.
Create a social media log entry

Users with the customer service manager role can create a social media log entry for a case.

Before you begin
Role required: sn_customerservice_manager or admin

About this task
If necessary, a customer service manager or administrator can create an entry on the Social Logs related list. The entries on this list are typically populated by the social integration tool.

Procedure
1. Navigate to the desired Case form.
2. From the Social Logs related list, click New.
3. Fill in the fields on the Social Log form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Social Profile</td>
<td>The social profile for the customer contact or consumer.</td>
</tr>
<tr>
<td>Agent</td>
<td>The agent participating in the conversation.</td>
</tr>
<tr>
<td>Social URL</td>
<td>The URL for the social conversation. Clicking this URL opens the conversation in a new tab.</td>
</tr>
<tr>
<td>Document</td>
<td>The related case number.</td>
</tr>
<tr>
<td>Message</td>
<td>The details of the conversation.</td>
</tr>
</tbody>
</table>

4. Click Submit.

View team members assigned to an account
View the team members for a specific account.

Before you begin
Role required: sn_customerservice_agent, sn_customerservice_manager, or admin
Procedure
1. Navigate to Customer Service > Customer > Accounts or Partners.
2. Select an account.
3. Select the Account Team Members related list.
   This list displays the employees who have been assigned to the team as well as their responsibilities.

Add an agent to the chat support assignment group
Agents must be added to the chat support assignment group before they can receive chat requests. This assignment group is used by the Customer Service Management chat communication channel to route chat requests.

Before you begin
Role required: sn_customerservice_manager or admin

Procedure
1. Navigate to User Administration > Groups.
2. Select Customer Service Support.
3. In the Group Members related list, click Edit.
4. Select the agents that you want to receive chat requests, and move them to the Customer Service Support group members list.
5. Click Save.

Related information
   Connect Support

Approve a service contract
Approve a service contract for a customer account.

Before you begin
Role required: sn_customerservice_manager or admin

Procedure
1. Navigate to Self-Service > My Approvals.
2. Select a contract for review from the Approvals list that has a state of Requested.
3. Review the contract details in the summary at the bottom of the approval form.

4. Add review comments to the **Comments** field.

5. Click one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Approve</strong></td>
<td>The review state changes to <strong>Approved</strong> on the Approvals list.</td>
</tr>
<tr>
<td><strong>Reject</strong></td>
<td>The review state changes to <strong>Rejected</strong> on the Approvals list. If you reject a contract, you must enter a rejection reason in the <strong>Comments</strong> field.</td>
</tr>
</tbody>
</table>

**Agent tasks**

Customer service agents create cases, interact with customers, and work to resolve questions and issues. Agents have a number of tools that they can use to resolve and close cases.

**Create a customer service case**

Customer service agents and agent managers can create cases using the Customer Service Management application.

**Before you begin**

**Role required:** sn_customerservice_agent, sn_customerservice_manager, or admin

**Procedure**

1. Create a case.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CSM workspaces</strong></td>
<td>From the Interaction form, click <strong>Create Case</strong>.</td>
</tr>
<tr>
<td><strong>Platform interface</strong></td>
<td>Navigate to <strong>Customer Service &gt; Cases &gt; Create New</strong>. You can also create cases by:</td>
</tr>
</tbody>
</table>
2. Fill in the fields on the Create Case form.

**Create Case form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The automatically assigned case number.</td>
</tr>
<tr>
<td>Channel</td>
<td>The method by which the customer initiated contact and the case was opened.</td>
</tr>
<tr>
<td></td>
<td>• Web (default)</td>
</tr>
<tr>
<td></td>
<td>• Phone</td>
</tr>
<tr>
<td></td>
<td>• Email</td>
</tr>
<tr>
<td></td>
<td>• Chat</td>
</tr>
<tr>
<td></td>
<td>• Social</td>
</tr>
<tr>
<td>Contact Local Time</td>
<td>The local time of the contact assigned to the case.</td>
</tr>
<tr>
<td></td>
<td>It is automatically filled according to the time zone set on the Contact form. If no time zone is set on the Contact form, it is filled according to the Contact Timezone set on the case itself.</td>
</tr>
<tr>
<td></td>
<td>If no time zone is set on the Contact form or in the case, the field is left blank and is read-only.</td>
</tr>
<tr>
<td></td>
<td>If a case is closed or canceled, the Contact Local Time field is hidden.</td>
</tr>
</tbody>
</table>

**Note:** Configure the form layout to add this field to the Case form.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact time zone</td>
<td>The contact time zone if the customer is working in a different time zone for the case. It overrides the Contact form time zone.</td>
</tr>
<tr>
<td></td>
<td>If no contact local time or contact time zone is set, the instance time zone is displayed.</td>
</tr>
<tr>
<td></td>
<td>Once the case is created, the field is read-only.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Configure the form layout to add this field to the Case form.</td>
</tr>
<tr>
<td>Account</td>
<td>The name of the company associated with this case.</td>
</tr>
<tr>
<td></td>
<td>If you select a contact in the Contact field, this field is auto-filled if the account information is available in the contact record.</td>
</tr>
<tr>
<td>Contact</td>
<td>The name of the customer contact for this case.</td>
</tr>
<tr>
<td>Consumer</td>
<td>The name of the consumer for this case.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This field is active only when the Customer Data Models for B2B2C plugin is installed. Once Account is selected, only consumers belonging to the account are displayed.</td>
</tr>
<tr>
<td>Product</td>
<td>The product model of the asset. A model is a specific version or configuration of an asset (for example, Apple Mac Book Pro).</td>
</tr>
<tr>
<td></td>
<td>If you select an asset in the Asset field, this field is auto-filled if the associated product information is available in the asset record.</td>
</tr>
<tr>
<td></td>
<td>A product may be associated with multiple assets.</td>
</tr>
<tr>
<td>Asset</td>
<td>The asset tag number or the serial number of the asset associated with this case.</td>
</tr>
<tr>
<td>Partner Contact</td>
<td>The name of the partner contact for this case.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Partner</td>
<td>If you select a partner in the <strong>Partner</strong> field, the list of available partner contacts is based on this selection.</td>
</tr>
<tr>
<td>Follow the sun</td>
<td>A check box to indicate that a case should be handed-off for global follow-up. If a customer enters additional comments on a <strong>Priority 1 - Critical</strong> or a <strong>Priority 2 - High</strong> case, or if the case is escalated, the flag is automatically selected. You can also manually select the check box. The activity stream on the case form is updated with any changes.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the customer question, issue, or problem.</td>
</tr>
<tr>
<td>Opened</td>
<td>The date and time that the case was opened.</td>
</tr>
</tbody>
</table>
| Priority      | The assigned priority:  
- 1 - Critical  
- 2 - High  
- 3 - Moderate  
- 4 - Low (default)                                                                                                                                                                                                                                                                                           |
| Assignment group | The assigned customer service agent group.                                                                                                                                                                                                                                                                                                                     |
| Assigned to   | The assigned agent. This field displays all users with the sn_customerservice_manager and sn_customerservice_agent roles. If a group is selected in the **Assignment group** field, the assigned agent must belong to this group.                                                                                                                                   |

**Note:** Enable the **Follow the sun** check box on the Customer Service case form by setting the value of the property `sn_customerservice.FTS_flag_enabled` to `true`. Configure the form layout to add this field to the Case form.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigned on</td>
<td>The data and time when the case is assigned. This field is updated when a user is added or changed in the <strong>Assigned to</strong> field.</td>
</tr>
<tr>
<td>Contract</td>
<td>The contract number associated with this case. If you selected an asset in the <strong>Asset</strong> field, the <strong>Contract</strong> field displays those contracts that include a line item for that asset.</td>
</tr>
<tr>
<td>Entitlement</td>
<td>The service entitlement associated with this case. The available entitlements are filtered by the settings in the <strong>Account, Contract, Product, Asset,</strong> and <strong>Channel</strong> fields. If only one entitlement is available for this case, it is automatically added to the <strong>Entitlement</strong> field.</td>
</tr>
<tr>
<td>Partner</td>
<td>The name of the partner for this case.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

If available, the following information is associated with a newly created case:

- The name of the contact and the contact's company
- The product and contract details
- The SLA and entitlements

**Create a customer service case of a specific type**

When creating cases, customer service agents can select a specific case type.

**Before you begin**

Role required: sn_customerservice_agent

**About this task**

The types of cases that agents can create depends on the configuration of the case types feature. For more information, see the following topics:

- Configure customer service case types
- Manage customer service case types
The procedure for creating a case of a specific type varies slightly depending on the interface that you are using.

- In CSM Configurable Workspace and CSM Agent Workspace, use the Select Case Type pop-up window to select a case type and create a case.
- In the platform interface, select a case type from an interceptor.

**Procedure**

1. Create a case.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSM workspaces</td>
<td>From the Interaction form, click <strong>Create Case</strong>.</td>
</tr>
<tr>
<td>Platform interface</td>
<td>Navigate to <strong>Customer Service &gt; Cases &gt; Create New</strong></td>
</tr>
</tbody>
</table>

2. Select the case type.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>a. Select a <strong>Case Type</strong> in the Select Case Type popup window.</td>
</tr>
<tr>
<td></td>
<td>b. If desired, select an optional category and subtype to narrow the available choices.</td>
</tr>
<tr>
<td></td>
<td>c. Click <strong>Create Case</strong>.</td>
</tr>
<tr>
<td>CSM workspaces</td>
<td><strong>Note:</strong> If a subtype has not been configured for a case type, the field for the subtype is not displayed.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If the single select option has been enabled for CSM Configurable Workspace, the Select Case Type pop-up window only displays the <strong>Case Type</strong> field.</td>
</tr>
<tr>
<td>Platform interface</td>
<td>Select the type of case to create from the list of available types in the interceptor.</td>
</tr>
</tbody>
</table>

3. Fill in the fields on the Case form.
   For more information about these fields, see **Create a customer service case**.

4. Click **Save**.
Related information

Customer Service Case Types
Create a customer service case

Create an onboarding case

Create a case to onboard new customers or to onboard existing customers for new products.

Before you begin
Role required: sn_customerservice_agent

About this task
Onboarding cases appear in the Onboarding Cases module and use the ONB prefix in the case number. For example, ONB0001007.

If the case playbook for onboarding is available, you can use the playbook to guide you through the steps that need to be completed to resolve onboarding cases. For more information, see

Procedure

1. Create a case.

<table>
<thead>
<tr>
<th>Interface</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workspace</td>
<td>From the Interaction form, click <strong>Create Case</strong>.</td>
</tr>
<tr>
<td>Platform</td>
<td>Navigate to: <strong>Customer Service</strong> &gt; <strong>Cases</strong> and click <strong>Create New</strong>.</td>
</tr>
</tbody>
</table>

2. Select the case type.

<table>
<thead>
<tr>
<th>Interface</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workspace</td>
<td>In the Select Case Type popup window:</td>
</tr>
<tr>
<td></td>
<td>a. Select a <strong>Case Type</strong>.</td>
</tr>
<tr>
<td></td>
<td>b. In the <strong>Category</strong> field, select <strong>Customer Onboarding</strong>.</td>
</tr>
<tr>
<td></td>
<td>c. Click <strong>Create Case</strong>.</td>
</tr>
<tr>
<td>Platform</td>
<td>Select Customer Onboarding in the list of available case types in the interceptor.</td>
</tr>
</tbody>
</table>
3. Add the customer information.
   - If the onboarding case is for an existing customer, fill in the **Account** and **Contact** or **Consumer** fields.
   - If the onboarding case is for a new customer, enable the **New customer** check box and fill in the fields in the New Customer Information form section.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer type</td>
<td>The type of customer, either Business or Individual.</td>
</tr>
<tr>
<td>Business name</td>
<td>The name of the business. This field is displayed and is required when you select Business as the customer type.</td>
</tr>
<tr>
<td>Note: You can enter customer names in this field but not partner names.</td>
<td></td>
</tr>
<tr>
<td>User name</td>
<td>The name of the contact or consumer. This field is displayed and is required when you select Individual as the customer type.</td>
</tr>
<tr>
<td>Email address</td>
<td>The email address for the user. This address is used for notifications.</td>
</tr>
<tr>
<td>Phone number</td>
<td>The phone number for the user.</td>
</tr>
</tbody>
</table>

4. Optional: Add additional members to the case from the **Additional Members** related list.
   Use this related list to create the users or business entities that should be included in the onboarding case. Click **New** and fill in the fields on the Related Party form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Use the <strong>Type</strong> field to select the authorization type of the additional member. Example authorization types include:</td>
</tr>
<tr>
<td></td>
<td>• Joint Owner</td>
</tr>
<tr>
<td></td>
<td>• Signatory</td>
</tr>
</tbody>
</table>
### Field Description

- **Beneficiary**
- **Sub Account**
- Additional members can be accounts, contacts, or consumers. The selection in the **Type** field determines which of the following fields is displayed:
  - **User**
  - **Consumer**
  - **Account**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td>The name of the contact being added as an additional member.</td>
</tr>
<tr>
<td>Consumer</td>
<td>The name of the consumer being added as an additional member.</td>
</tr>
<tr>
<td>Account</td>
<td>The name of the account being added as an additional member.</td>
</tr>
</tbody>
</table>

5. **Fill in the fields on the Case form.**
   For more information and field descriptions, see [Create a customer service case](#).

6. **Click Save.**
   - If the **New customer** check box is enabled, the **Account** and **Contact** or **Consumer** fields are not required to save the case.
   - If the **New customer** check box is disabled, the **Account** and **Contact** or **Consumer** fields are required to save the case.

### Assign a customer service case

Agents can assign cases to themselves or to other customer service agents.

**Before you begin**

Role required: sn_customerservice_agent, sn_customerservice_manager, or admin

**About this task**

The **Assign to me** button is only visible if the current user has the customer service agent role and is not already assigned to the case.
Procedure

1. Open a customer service case.
2. Assign the case.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign the case to yourself</td>
<td>Click <strong>Assign to me</strong>.</td>
</tr>
<tr>
<td>Assign the case to another agent</td>
<td>Select an agent in the <strong>Assigned to</strong> field.</td>
</tr>
</tbody>
</table>

The agent's name appears in the **Assigned to** field. If the agent also belongs to an agent group, the group name appears in the **Assignment group** field.

Create a work order for a customer service case

Create a work order for a customer service case as part of the case resolution process.

**Before you begin**

sn_customerservice_agent, sn_customerservice_manager, or admin

**About this task**

After a work order is created, it appears in the **Work Orders** related list on the Case form. The case number is also referenced on the work order.

**Procedure**

1. Open the desired case.
2. From the **Work Orders** related list, click **New**.
3. Fill in the fields on the Work Order form.
   For more information, see Create a work order.
4. Click **Update**.

**Related information**

Manage work orders

**Respond to a customer chat request**

Select a chat request from the chat queue and respond to a customer's question or comment.
Before you begin
Role required: sn_customerservice_agent, sn_customerservice_manager, or admin

Procedure

1. Navigate to Connect > Connect Support.
   The Connect workspace opens in a new tab.

2. Click the support tab of the Connect sidebar, indicated by a headset icon.
   The support tab displays Queues to which you belong. It also displays your open support conversations under Cases. When a user starts a support conversation or an agent transfers a conversation to a queue, any agent who belongs to the associated queue can accept the conversation. An agent can also request to transfer a conversation directly to you.

3. Accept a conversation in one of the following ways.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept a conversation from a queue</td>
<td>Under Queues, click Accept by the queue.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Accept a transfer request</td>
<td>The conversation opens in the conversation pane and an entry appears in the Cases section of the sidebar. Under Cases, click Accept by a transfer request.</td>
</tr>
</tbody>
</table>

The conversation opens in the conversation pane. The agent who transferred the conversation can stay in the conversation.

4. Respond to the user and help resolve the issue. By default, your messages are added to the conversation record as comments and are visible to the user.

5. Optional: Initiate a Zoom meeting to help resolve customer issues faster. For more information, see Initiate Zoom meetings from chats.

What to do next
If necessary, you can open a new customer service case or incident from the conversation to track the issue. You can also transfer the conversation to a different agent or queue, escalate the conversation to a higher priority queue.

Related information
- Connect workspace
- Create an incident from a Connect Support conversation
- Transfer a Connect Support conversation to a different agent or queue
- Escalate a Connect Support conversation

Respond to a consumer chat request
Select a chat request from the chat queue and respond to a customer's question or comment.
Before you begin
Role required: sn_customerservice_agent or sn_customerservice_manager

Procedure

1. Navigate to Collaborate > Connect Support.
   The Connect workspace opens in a new tab.

2. Click the support tab of the Connect sidebar, indicated by a headset icon.
   The support tab displays Queues to which you belong. It also displays your open support conversations under Cases. When a consumer starts a support conversation or an agent transfers a conversation to a queue, any agent who belongs to the associated queue has the option to accept the conversation. An agent can also request to transfer a conversation directly to you.

3. Accept a conversation in one of the following ways.
   • Accept a conversation from a queue
   • Accept a transfer request

4. Respond to the consumer and help resolve the issue.
   By default, your messages are added to the conversation record as comments and are visible to the user.

   If necessary, you can open a new customer service case or incident from the conversation to track the issue. You can also transfer the conversation to a different agent or queue, escalate the conversation to a higher priority queue.

What to do next
If necessary, you can open a new customer service case or incident from the conversation to track the issue. You can also transfer the conversation to a different agent or queue, or escalate the conversation to a higher priority queue. For more information, see Connect Support.

Create a customer service case from a chat
If a customer chat results in the need to open a case, create the case directly from the conversation.

Before you begin
Role required: sn_customerservice_agent or sn_customerservice_manager

About this task
When you create a customer service case from a support conversation, the system copies the conversation history to the case activity stream as comments and work notes. Future messages are tracked in the case as well.
**Procedure**

1. Navigate to **Connect > Connect Support**.  
   The Connect workspace opens in a new tab.

2. Click the support tab of the Connect sidebar, indicated by a headset icon (جال). 

3. Under **Cases**, open a customer service conversation.

4. At the bottom of the conversation, click the menu icon (≡) to open the Connect actions menu.

5. In the Connect actions menu, select **Create Case**.  
   In the conversation tools area to the right of the conversation, a new case form opens in a record tab. The system automatically sets certain fields based on conversation details.

6. Complete the form as necessary and click **Submit**. 
   Any comments or work notes in the record conversation appear as comments on the incident form. Work notes do not appear in the chat for the ESS user. The chat agent can select whether a message is a Comment or Work Note in the conversation.

   a. In the record conversation, by the text entry field, click the message type icon (💬).

   b. Select **Comment** or **Work Note**.

   c. Enter a message. 
   By default, record conversation messages are added as comments.

   **Note:** If you add an attachment to a record conversation, it is attached to the underlying record as well.

   The system automatically shares the record in the conversation, copies the conversation to the record activity stream, and references the record on the Chat Queue Entry [chat_queue_entry] table. Any new journal fields added to the record do not appear in the chat. The system also changes the document ID for the conversation to reference the incident number instead of the entry in the Chat Queue Entry table.

**Related information**

Connect workspace
Create a consumer case from an anonymous chat

If an anonymous chat results in the need to create a consumer case, create the case directly from the conversation.

Before you begin
Role required: sn_customerservice.consumer_agent, sn_customerservice_manager, or admin

About this task
When you create a case from a support conversation, the system copies the conversation history to the case activity stream as comments and work notes. Future messages are tracked in the case as well.

Procedure
1. Respond to an anonymous chat request.
2. Chat with the user to determine the issue.
3. At the bottom of the conversation, click the menu icon to open the Connect actions menu.
4. In the Connect actions menu, select Create Case for Guest. In the conversation tools area to the right of the conversation, a new case form opens in a record tab. The system automatically sets certain fields based on conversation details. For a case created from a guest user chat, the Short description field displays the initial chat request from the user.
5. Complete the form as necessary and click Submit. The system automatically shares the record in the conversation, copies the conversation to the record activity stream, and references the record on the Chat Queue Entry [chat_queue_entry] table.

Create a consumer record from an anonymous chat

If an anonymous chat results in the need to create a consumer record, create the record directly from the conversation.

Before you begin
Role required: sn_customerservice.consumer_agent, sn_customerservice_manager, or admin
About this task

Procedure
1. Respond to an anonymous chat request.
2. Chat with the user to determine the issue.
3. At the bottom of the conversation, click the menu icon to open the Connect actions menu.
4. In the Connect actions menu, select **Create Consumer and Case for Guest**.
   In the conversation tools area to the right of the conversation, a new consumer form opens in a record tab. The system automatically sets certain fields based on conversation details. For a consumer record created from a guest user chat, the **First name**, **Last name**, and **Email** fields display information from the initial chat request.
   Selecting this option creates a consumer record using the information provided on the record producer and then associates the case with the newly created consumer. The Case form is also populated with the information provided on the record producer.
5. Complete the form as necessary and click **Submit**.

Create a consumer case from a chat
If a consumer chat results in the need to open a case, create the case directly from the conversation.

Before you begin
Role required: sn_customerservice.consumer_agent, sn_customerservice_manager, or admin

About this task
When you create a case from a support conversation, the system copies the conversation history to the case activity stream as comments and work notes. Future messages are tracked in the case as well.

Procedure
1. Navigate to **Collaborate > Connect Support**.
   The Connect workspace opens in a new tab.
2. Click the support tab of the Connect sidebar, indicated by a headset icon.
   The support tab displays **Queues** to which you belong. It also displays your open support conversations under **Cases**. When a consumer starts a support conversation or an agent transfers a conversation to a queue, any agent who
belongs to the associated queue has the option to accept the conversation. An agent can also request to transfer a conversation directly to you.

3. Under **Cases**, open a consumer conversation.

4. At the bottom of the conversation, click the menu icon to open the Connect actions menu.

5. In the Connect actions menu, select Create Case.
   In the conversation tools area to the right of the conversation, a new case form opens in a record tab. The system automatically sets certain fields based on conversation details. (For a case created from a consumer chat, the **Consumer** field is filled in and the **Short description** field displays the initial chat request from the consumer.)

6. Complete the form as necessary and click **Submit**.
   The system automatically shares the record in the conversation, copies the conversation to the record activity stream, and references the record on the Chat Queue Entry [chat_queue_entry] table.

---

**Create a consumer record**

Consumer service agents and managers can create consumer records from the Customer Service Management application.

**Before you begin**
Role required: sn_customerservice.consumer_agent, sn_customerservice_manager or admin

**Procedure**

1. Navigate to **Customer Service > Customer > Consumers**.

2. Click **New**.

3. Fill in the fields on the Consumer form as necessary.

4. Fill in the fields on the Primary Address tab.
   A consumer can have multiple addresses but only one primary address. The primary address is stored in the Primary Address tab on the Consumer form and in the **Addresses** related list.

5. If desired, fill in any of the fields on the Preferences tab.

6. Click **Submit**.
   The record is added to the Consumers table (csm_consumer). The primary address is added to the **Addresses** related list and the **Primary** field is set to true.
Related information

Create additional consumer addresses

Create additional consumer addresses
Consumers can have multiple addresses, including one primary address.

Before you begin
Role required: sn_customerservice.consumer_agent, sn_customerservice_manager, or admin

About this task
The primary address is stored in the Primary Address tab on the Consumer form and in the Addresses related list. When you fill in the fields in the Primary Address tab and click Submit, this information is added to the Addresses related list as the primary address, with the Primary field set to true. Any changes made to the Primary Address fields are also updated in the related list. A consumer can have only one primary address.

Other addresses, such as billing or shipping addresses, can be created and stored in the Addresses related list. For these other addresses, the Primary field is set to false.

Procedure
2. Click the number of the desired consumer.
3. In the Addresses related list, click New.
4. Fill in the fields on the Location form.
5. To denote this address as the primary address for the consumer, enable the Primary check box.
   A consumer can have multiple addresses but only one primary address.
6. Click Submit.

Create a request on behalf of a customer or consumer
Customer service agents can create requests on behalf of customers from Agent Workspace or from the platform interface.

Before you begin
Role required: sn_customerservice_agent, sn_customerservice.consumer_agent
**About this task**
Customer service agents can browse the catalog and make a selection to create a request on behalf of a customer.

- From Agent Workspace, agents can create requests from case and interaction records.
- From the platform interface, agents can create requests from case records.

**Procedure**

1. Open a customer service case.

2. To create a request, do one of the following:
   - Agent Workspace: Click the More UI Actions icon (*** ) and select **Create Request**.
   - Platform interface: Click the form context menu icon and select **Create Request**.

3. Select an item or a service from the catalog to display the item page.

4. **Optional:** Select the quantity.

5. To complete the request, do one of the following:

<table>
<thead>
<tr>
<th>Interface</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Agent Workspace</strong></td>
<td>Complete these steps:</td>
</tr>
<tr>
<td></td>
<td>a. Click <strong>Order Now</strong>.</td>
</tr>
<tr>
<td></td>
<td>b. Add or change the information in these fields on the Order Confirma-</td>
</tr>
<tr>
<td></td>
<td>tion pop-up window: <strong>Request for</strong>, <strong>Delivery information</strong>, <strong>Special instructions</strong>.</td>
</tr>
<tr>
<td></td>
<td>c. Click <strong>Checkout</strong>.</td>
</tr>
<tr>
<td></td>
<td>The system creates the request and displays the request number. Click</td>
</tr>
<tr>
<td></td>
<td><strong>View Details</strong> to open the request record.</td>
</tr>
<tr>
<td><strong>Platform interface</strong></td>
<td>Click <strong>Order Now</strong>.</td>
</tr>
<tr>
<td></td>
<td>The system creates the request and displays the request number. An infor-</td>
</tr>
</tbody>
</table>
6. From the Case form, click the **Requests** related list to see the requests associated with the case.

**Respond to a case using an email quick message**

Use predefined quick email messages to quickly draft replies to customers. Agents can select predefined quick messages to add content into the message body of emails.

**Before you begin**

Role required: sn_customerservice_agent

**About this task**

Business managers and admins can set up quick messages and predefine the content for replying to cases. For example, you can predefine personal greetings, disclaimers, different types of additional information, and signatures. You can also incorporate icons, business logos, pictures, HTML layout, and rich text format.

ℹ️ **Note:** You can configure quick messages so that only a certain user or a group can view them.

**Procedure**

1. Open a customer service case.

2. Click the more options icon (⋯) and select **Email**.

3. Click the Quick Messages selector and select a predefined message. The content of the quick message is inserted in the message body at the cursor location.

4. **Optional:** Select additional quick messages.

5. Click **Send**.

**Related information**

- Define a quick message
- Composing emails with quick messages
Initiate a conference call from a case
As part of resolving a customer service case, you can initiate a conference call between involved users.

Before you begin
Role required: sn_customerservice_agent, sn_customerservice_manager, admin

About this task
Customer service agents can initiate a conference call from a case and add participants, including on-call members of shift groups.

Note:
Notify must be set up before you can use Notify on task. Ensure there are Notify phone numbers (E.164 or short code) in number groups with phone call workflows. Also ensure the property `glide.notify.task.phone_number` is set to one of these Notify phone numbers.

Procedure
1. Open the desired case.
2. Click the Start Conference Call related link.
3. Select one or more Recipients to participate in the conference call. You can add individual participants, groups, or individual phone numbers.

Related information
Start a conference call
Start a conference call from a task

Use the Activity Stream
Enhancements in the Activity Stream help reduce cluttering in the Activity Stream and agent effort to know the case context.

About this task
Enhancements in the Activity Stream include the following:

• filtering by post type.
• sorting messages and events
• improved email representation
Procedure

1. Open a customer service case.
   You will see the Activity Stream with the filter options.

2. Click the Filter icon (▼).
   The Filter sets are displayed. The conversation filter sets such as emails, comments, and work notes

3. Select the Post types filters from the drop-down list. For example, if you select Work notes, only the notes are displayed in the Activity Stream.

   ☏ Note: Selecting only Field changes will display the fields in the Activity Stream.

4. Select the Field changes drop-down list to filter the fields. For example, if you select State, only the state changes are visible.

5. Click the Flagged tab to see only the flagged messages.

6. Click the sort icon (▼) to sort the events and messages based on the timeline.

7. Click the More Options icon (▼) and select Expand all posts to view the post details or select Collapse all posts to go back to the previous state.

8. Click Show more in an email to view the latest email response in an expanded form.

9. Click Show full conversation to view the whole email thread.

Related information

   Set up Activity Stream in Workspace

Communicate with requesters and agents

Use Compose to communicate with requesters and add comments or notes about the work you have done.

The Compose UI displays next to the Activity Stream when column space is adjusted to accommodate the side by side UI. For more information, see Using Compose.

Resolve cases with knowledge and community content

Enable agents to resolve a case more quickly by searching for information from the knowledge base and community and, if helpful, associating it to the case.
Before you begin
Role required: sn_customerservice_agent

About this task
The Case form displays contextual search results based on text entered in the Short Description field. These search results provide targeted knowledge articles, pinned articles, and community content to customer service agents. Customer service agents can search for information that is related to a case when opening a case or in a case that is already open. If the search results in any related content, the agent can preview the content. If the information is relevant, the agent can mark it as helpful. Knowledge articles can be also attached to the case.

By default, search results include knowledge articles, pinned articles, and solved community questions and blogs. Depending on the configuration, search results can also include other types of information, such as open and resolved cases and problems. With the Predictive Intelligence for Customer Service Management plugin (com.snc.csm_ml), you can also view similar cases and similar knowledge articles.

Customer service case managers can use the Demand Insights for Cases dashboard to identify which cases have no or insufficient knowledge coverage. For more information, see Demand Insights for Cases dashboard.

Procedure
1. Navigate to Customer Service > Cases.
2. Perform one of the following actions.
   • Open a new case and start typing in the Short description field.
   • Open an existing case and click Related Search Results. Any matching search results are displayed in the Related Search Results section. The content displayed depends on the permissions assigned to the agent in Knowledge and Communities.
3. Click one of the results to open the content in a pop-up window.
4. Perform any of the following optional steps.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attach a knowledge article to the case</td>
<td>a. Click Attach next to the knowledge article you want to attach to the case.</td>
</tr>
<tr>
<td></td>
<td>b. If you opened the knowledge article, click Attach to Case in the pop-up window.</td>
</tr>
<tr>
<td>To</td>
<td>Do this</td>
</tr>
<tr>
<td>----</td>
<td>---------</td>
</tr>
<tr>
<td>The knowledge article is displayed in <strong>Activities</strong> as a work note and is visible only to customer service agents. A link to the article is also entered in the <strong>Additional comments</strong> field.</td>
<td></td>
</tr>
<tr>
<td>c. To make the article visible to customers, click <strong>Post</strong>.</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** You cannot attach Communities content to the Case form.

<table>
<thead>
<tr>
<th>Mark the content as helpful for resolving the associated case</th>
<th>Click <strong>This helped</strong> in the pop-up window.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Scroll to previous or next result</th>
<th>Use the arrow keys to scroll up to the previous or down to the next result.</th>
</tr>
</thead>
</table>

5. Perform one of the following actions.

- If you opened a case, click **Submit**.
- If you updated an existing case, click **Update**.

### Manage skills for a customer service case

Add or remove optional and mandatory skills for a customer service case.

**Before you begin**

Role required: sn_customerservice_agent, sn_customerservice.consumer_agent, workspace_admin, admin

**About this task**

Agents can also change a skill between mandatory and optional.

**Procedure**

1. Open the desired case.
2. Click the **Task Skills** related list.
3. To create a new skill:
   a. Click **New**.
   b. Select a skill in the **Skill** field.
   c. If mandatory, click the **Mandatory** check box.
   d. Click **Save**.
4. To switch a skill between optional and mandatory:
   a. Click the desired skill.
   b. Enable or disable the Mandatory check box.
   c. Click Save.

Update a special handling note

Update a special handling note for a record.

Before you begin
Role required: sn_customerservice_agent, sn_customerservice_manager, sn_shn.editor, or sn_shn.admin

About this task
Users with the sn_customerservice_manager role can update a special handling note for a record if they can update a record for the underlying table.

Procedure
1. Navigate to Special Handling Notes > Special Handling Notes. You can also update a note from the Special Handling Notes list on a form.
2. In the Special Handling Notes list, click the note to be updated.
3. Make any necessary changes to the fields on the Special Handling Notes form.
4. Click Update.

Close a customer service case

Close a case at any time, except when it is in the Resolved state.

Before you begin
Role required: sn_customerservice_agent, sn_customerservice_manager, or admin

About this task
After an agent proposes a solution for a case, the state changes to Resolved and the customer can either choose to accept or reject the solution. If accepted, the case is closed. If rejected, the state reverts to Open.

An agent or agent manager can close a case at any time, except when it is in the Resolved state, when only a customer can accept or reject the proposed
solution. When an agent or agent manager closes a case, details must be included in the Resolution notes field.

Procedure
1. Open the desired case.
2. Depending on the user interface, navigate to the correct form section.
   
<table>
<thead>
<tr>
<th>Interface</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSM Configurable Workspace, CSM Agent Workspace</td>
<td>a. Click the Details tab.</td>
</tr>
<tr>
<td></td>
<td>b. Click the menu icon (≡) at the top of the Details section.</td>
</tr>
<tr>
<td></td>
<td>c. Select Closure Information.</td>
</tr>
<tr>
<td>Platform interface</td>
<td>Click the Resolution Information tab.</td>
</tr>
</tbody>
</table>

3. In the Resolution Code drop-down list, select the code that indicates the resolution state of the case.
4. Enter any information related to the closure in the Resolution notes field.
5. Click Close Case.

Customer service satisfaction surveys

Customers can complete a satisfaction survey when they accept a case solution or close a case from the Customer Service Portal.

When a customer accepts a proposed solution for a case by clicking Accept Solution on the case record or closes a case by clicking Close Case, they can access a satisfaction survey in the Customer Service Portal. Customers have the option of completing or skipping the survey.

If a customer is using the email communication channel, the system sends an email with a link to a customer satisfaction survey when an agent closes a case. The customer can click on this link to complete the survey.

⚠️ Note: One survey can be generated per case. If a survey has already been generated for a case, a second survey cannot be generated even if a case is reopened and closed again.

The Customer Service application includes a default survey that you can customize as needed. To customize the default survey, navigate to Survey > View Surveys and select Customer Service Satisfaction Survey from the list of
assessment metric types. To edit the default survey, open the survey and click the **Survey Designer** button.

You can also design your own survey using the survey designer tool. After designing a survey, be sure to select a condition for triggering the survey.

The Customer Service dashboard includes a Customer Satisfaction report that displays the survey results. You can also access the Customer Satisfaction report by navigating to **Reports > View/Run > Customer Satisfaction**.

**Related information**

- Get started with Survey Management
  - Service Manager homepage

**Using workspaces in Customer Service Management**

Use the CSM workspaces to interact with customers, create and work on cases, and resolve questions and issues.

Customer Service Management provides the following workspaces:
- CSM Configurable Workspace
- CSM Agent Workspace

Customer service agents can complete most tasks in these workspaces. Certain tasks apply to both CSM Configurable Workspace and CSM Agent Workspace, while other tasks only apply to individual workspaces or to the platform interface. This information is noted at the top of each task.

The tables below describe some of the basic tasks that agents can perform in the CSM Workspaces as well as additional features that are available for use.

For additional task information, see **Manage customer service cases**.

### Agent tasks

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
</table>
| Example workflow topics | These task topics illustrate how agents can use workspace features to assist customers. | Example: Create a case from a chat  
Example: Resolve a case using Knowledge |
| Use Knowledge to assist with cases | Search for knowledge articles and attach them to cases or open articles in sub-tabs for easier reading. | Search for knowledge articles  
Open a knowledge article |
### Agent tasks (continued)

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report a knowledge gap</td>
<td>Report a knowledge gap if you can't find relevant articles and, if permission is enabled, create articles directly from cases.</td>
<td>Report a knowledge gap Create a knowledge article</td>
</tr>
<tr>
<td>Respond to community discussions</td>
<td>If a case is created from a community discussion, you can respond to the discussion from the case.</td>
<td>Respond to a community thread from a case</td>
</tr>
<tr>
<td>Use response templates</td>
<td>Quickly respond to customers using different types of predefined information.</td>
<td>Use response templates to add information to cases and case tasks</td>
</tr>
<tr>
<td>Manage email tasks</td>
<td>Preview emails and compose and send responses from cases.</td>
<td>Compose an email from a case Compose an email from the ribbon component Send an email response from a case activity stream Preview an email from the Emails related list</td>
</tr>
</tbody>
</table>

### Additional features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a specific type of case</td>
<td>Create a case for a specific type of customer issue.</td>
<td>Create a customer service case of a specific type</td>
</tr>
<tr>
<td>Look up a customer</td>
<td>Quickly look up contacts or consumers using information such as the name, phone number, or record number.</td>
<td>Look up and verify a contact or consumer</td>
</tr>
<tr>
<td>Use Customer Central</td>
<td>Look up customer information and recent</td>
<td>Use Customer Central</td>
</tr>
</tbody>
</table>
### Additional features (continued)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>View product data</td>
<td>View details about customer instances, products, and components.</td>
<td>View install base information</td>
</tr>
<tr>
<td></td>
<td></td>
<td>View sold product information</td>
</tr>
<tr>
<td>Use playbooks</td>
<td>Use the step-by-step guidance provided by playbooks to complete tasks and resolve cases.</td>
<td>Interact with playbooks</td>
</tr>
<tr>
<td>Use guided decisions</td>
<td>A guided decision prompts you to answer questions and provide inputs and then provides recommendations on the steps needed to resolve a case.</td>
<td>Use guided decisions to resolve cases</td>
</tr>
<tr>
<td>Use trending case topics</td>
<td>Use trending case topics to identify cases with similar issues.</td>
<td>View trending case topics</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Add trending case topics to existing major cases</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Create major cases for trending case topics</td>
</tr>
<tr>
<td>Use estimated time to resolve a case (ETTR)</td>
<td>Use machine learning to predict the estimated time to resolve a case based on case attributes such as the short description, category, priority, and assignment group.</td>
<td>Estimated time to resolve a case</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Time to resolve ribbon component</td>
</tr>
</tbody>
</table>

### Example workflow topics

These example workflow topics illustrate how customer service agents can use CSM workspaces to assist customers.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Example: Create a case from a chat

As a chat agent, your primary role is to accept customer chat requests, evaluate customer issues, and create cases as needed. This example shows the steps involved in creating a case from a chat.

About this task
This example shows the typical steps involved in creating a case from a chat.
Procedure

1. Set your status so that you’re ready to accept chats.

   From your inbox, click **Status** and select **Available**. Make sure you’re available for both cases and chats.

   Now you’re online and ready to get to work.

2. When a chat comes in, accept it from your inbox and respond to the user.
Your organization probably has policies about what you can ask a user. In this example, the user is having issues with a router. Ask some basic questions to find out more information about the issue, such as when it started.

3. On the interaction record, add information about the customer and the issue.
When you engage in a chat with a user, the system automatically creates an interaction record. Use this record to save the details that you or another agent might need later.

**Tip:** Details in the interaction are carried over to the case record, so add as much useful information as possible. This can help other agents who might be assigned to the case.

4. Look up the user and verify their contact information.

The Lookup and Verify feature lets you look up the user's profile and verify their personal information, such as their phone number, email address, and location. You can flag the user as **Verified**, so other agents know that the user's information is legitimate.

Add important user information to the interaction record so that agents can reach the user for follow-up.

5. After you finish the chat and have all the information you need in the interaction record, decide if you need to create a case.
Click **Create Case** on the interaction record to open a new case with the details from the interaction. Fill in any additional details that another agent might need to resolve the case.

6. If necessary, assign the case to another agent.

   The case is automatically assigned to you but you can reassign it to another agent or leave it unassigned and let the routing feature make the assignment.

   See **Resolve a case using knowledge** for an example of how to work on a case and close it by attaching content from the Knowledge Base.

**Example: Resolve a case using Knowledge**

Resolve a customer service case by searching for related knowledge and attaching a knowledge article.

**About this task**

This example shows the typical steps involved in resolving a case using knowledge that you find with Agent Assist.
Procedure

1. Open a case from a landing page or list or from your Inbox.

   From the List view, click **Lists or My Lists** and click a case record.

   From your Inbox, click **Status** and select **Available**. Make sure you’re available on both cases and chats.

   Now you’re online and ready to get to work.

2. Deal with the special handling notes related to the customer or account.
3. Review the customer, timeline, and SLA information for the case in the ribbon.

Your organization most likely has policies in place regarding how quickly you should manage your cases, so you should be aware of how long the case has been open. The ribbon provides you with this information in easy-to-read tiles.

4. Review the case details in the activity stream.

The activity stream shows you all of the activity that has taken place on a case since it was created. Use the activity stream to understand how a case record has changed over time. This is especially useful when multiple agents have worked on a case.

5. Use Agent Assist to search for related knowledge.
When your administrator sets up Agent Assist, they can enable the ability to search multiple sources of information. If you already have a knowledge base with articles that provide solutions to common problems, you can search for the relevant article and attach it.

6. Select and preview the article that resolves the issue.
7. Click Attach and then Attach Article to attach the article to the case.

The system also adds the action to the activity stream.

From the Customer Service Portal, the customer can see the knowledge article attached to the case and can click the link to open the article in a new tab.

What to do next
Now that you have seen how a case can be resolved by attaching a knowledge article, check out what else you can do in your workspace:

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report a knowledge gap</td>
<td>If you cannot find relevant knowledge articles that could help resolve a case, report a knowledge gap and create a knowledge feedback task.</td>
</tr>
<tr>
<td>Create a knowledge article from a case</td>
<td>If you generate useful information as part of resolving a case, store that information by creating a knowledge article.</td>
</tr>
<tr>
<td>Respond to a community thread from a case</td>
<td>For cases created from community discussions, you can respond to a discussion in a new browser tab.</td>
</tr>
<tr>
<td>Task</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Open a knowledge article in a sub tab</td>
<td>After searching for a knowledge article in Agent Assist, open the article in a sub-tab.</td>
</tr>
</tbody>
</table>

**Open a CSM workspace**

Open the CSM Configurable Workspace or the CSM Agent Workspace so that you can work on customer service cases.

**Before you begin**

Role required: sn_customerservice_agent

**Procedure**

1. Navigate to **Workspace Experience > Workspaces**.
2. Select the desired workspace.
   - CSM Configurable Workspace Home
   - Agent Workspace Home
   The selected workspace opens in a new browser tab.

**Look up and verify a contact or consumer**

An agent can look up contact or consumer information from a saved interaction record, review and confirm the information, and then populate the information on the interaction record.

**Before you begin**

Role required: sn_customerservice_agent, sn_customerservice.consumer_agent, workspace_admin, admin

**About this task**

获批 Note: This task applies to both CSM Configurable Workspace and CSM Agent Workspace.

Agents can search for information such as name, phone number, email address, case number, or order number.

**Procedure**

1. Open your workspace.
2. From a saved interaction record, perform one of the following actions.
<table>
<thead>
<tr>
<th>Workspace</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSM Configurable Workspace</td>
<td>In the contextual side panel, click the Contact Verify icon or the Consumer Verify icon to access the lookup and verify feature.</td>
</tr>
<tr>
<td>CSM Agent Workspace</td>
<td>At the top of the interaction record, click Verify Contact or Verify Consumer to open the Verify Contact or Verify Consumer pop-up window.</td>
</tr>
</tbody>
</table>

3. Enter information such as the first few letters of a first or last name or the first few digits of a phone or case number.

<table>
<thead>
<tr>
<th>Workspace</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSM Configurable Workspace</td>
<td>Enter this information in the Verify Contact or Verify Consumer fields.</td>
</tr>
<tr>
<td>CSM Agent Workspace</td>
<td>Enter this information in the Look up field.</td>
</tr>
</tbody>
</table>

These fields use a type-ahead search feature that displays results in a list and narrows the results as more characters are entered. Multiple display fields in the search results help to differentiate contacts. When searching for a record number, the contact or consumer associated with the record is returned in the search results.

ℹ️ Note: Delete characters from the field to clear the search results.

4. Select the desired result from the list.
   This action displays information about the selected contact or consumer in a verification card. If the information is not correct, repeat steps 2 through 4.

5. Confirm the selected contact or consumer.

<table>
<thead>
<tr>
<th>Workspace</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSM Configurable Workspace</td>
<td>Click Verify.</td>
</tr>
<tr>
<td>CSM Agent Workspace</td>
<td>Click Done.</td>
</tr>
</tbody>
</table>

This action does the following:
• Populates the **Account** and **Contact** or **Consumer** fields on the interaction record.

• Enables the **Verified** check box.

6. **Optional:** In CSM Agent Workspace, click **Cancel** to close the pop-up window.
   
   If you cancel the search, the information on the interaction record remains unchanged.

7. **Optional:** You can look up and verify another contact or consumer by repeating steps 2 through 4 and entering different search information.

8. Click **Save** to save the interaction record and refresh the related lists.

**Related information**

**Lookup and verify**

**Create a contact or consumer using Lookup and verify**

An agent can create a contact or consumer from the Lookup and verify feature in the Contextual side panel.

**Before you begin**

Role required: sn_customerservice_agent, sn_customerservice.consumer_agent, workspace_admin, admin

**About this task**

ℹ️ **Note:** This task applies to CSM Configurable Workspace.

Agents can use the Lookup and verify feature to search for contacts and consumers. After verifying a user's information, agents can populate that information on the interaction record.

If an agent can't find a contact or consumer, they can create a record for that user from within the Lookup and verify feature.

**Procedure**

1. Open your workspace.

2. From a saved interaction record, click one of the following icons in the Contextual side panel to access the Lookup and verify feature.

   • **Verify Contact icon**  
   • **Verify Consumer icon**
3. Enter user information in one of the following fields: **Verify Contact** or **Verify Consumer**.
   This information can include the first few letters of a first or last name or the first few digits of a phone or case number.

4. If you cannot locate the contact or consumer and choose to create a record, click **Create Contact** or **Create Consumer**.
   The system displays the Create Contact or Create Consumer form in the Contextual side panel.
   If the **Account** field on the Interaction record is populated when you click **Create Contact**, the **Account** field on the Create contact form is populated with the same information.

5. Add information to the fields on the form and click **Create**.
   The system performs the following actions:
   • Saves the contact or consumer record.
   • Creates and displays the contact or consumer card.
   • Adds the information to the interaction record.

**Related information**
- Lookup and verify
- Look up and verify a contact or consumer

**View install base information in CSM workspaces**
View a customer’s install base in CSM workspaces to quickly identify the support they require as well as opportunities for adoption and upsell.

**Before you begin**
Ensure that the Customer Service Install Base Management plugin (com.snc.install_base) is activated.
Role required: sn_customerservice_agent

**About this task**

⚠️ **Note:** This task applies to both CSM Configurable Workspace and CSM Agent Workspace.

View information about the products and services a customer has purchased, how they are delivered, and additional components available with the product models.
Procedure

1. Open your workspace.
2. Click the account you want to view the install base for.
3. Click the Install Base related list.
4. Click through the Sold Products tree view to view details about the sold product and the list of install base items that belong to it.

5. On the form header, click the Hierarchy icon to see the full product model that the sold product is part of. The product model hierarchy opens in a separate window. Unpurchased product components have a shopping cart icon next to them.
View sold product information in CSM workspaces

Enable customer service agents or managers to view the sold products and the service offerings associated to the sold product for an account or consumer.

Before you begin
Role required: sn_customerservice_agent

About this task

⚠️ Note: This task applies to both CSM Configurable Workspace and CSM Agent Workspace.

Customer service agents can view which service offerings are associated to the sold products affected by an issue. They can also see the service commitments and availability.

Procedure

1. Open your workspace.
2. Open a customer service case.
3. Click **Sold Products** to view the sold product associated to the case and the service offering associated to it.
4. Click the service offering to view the service commitments associated to it.

Search for knowledge articles in CSM workspaces

Search for knowledge articles in Agent Assist, including similar knowledge articles.

Before you begin
Role required: sn_customerservice_agent, sn_customerservice.consumer_agent, workspace_admin, admin

About this task

⚠️ Note: This task applies to both CSM Configurable Workspace and CSM Agent Workspace.

Agent Assist displays contextual search results based on text entered in the **Short description** field on the Case form. These search results include knowledge articles and other types of information, such as open or resolved cases and community content. You can narrow the list of results by selecting a specific type of information to view.
Note: With the Predictive Intelligence for Customer Service Management plugin (com.snc.csm_ml), you can also view Similar Knowledge Articles.

Procedure

1. Open your workspace.
2. Open a customer service case.
3. In the Agent Assist panel, click the search resource icon ( ) and select a search source.
   • Knowledge Articles
   • Similar Knowledge Articles
4. Select a knowledge article.
5. Click Attach.
   Depending on your configuration, you can add a link or embed an article directly into the Additional comments (customer visible) portion of the activity stream.

Open a knowledge article in a sub-tab

Search for a knowledge article in Agent Assist and then open the article in a sub-tab.

Before you begin
Role required: sn_customerservice_agent, sn_customerservice.consumer_agent, workspace_admin, admin

About this task

Note: This task applies to both CSM Configurable Workspace and CSM Agent Workspace.

Procedure

1. Open your workspace.
2. Open a customer service case.
3. In the Agent Assist panel, select an article from the default search or search for something specific using the search bar.
4. Click the article link to open the article in a new sub-tab of the parent case.
Create a knowledge article from a case

Reuse information from a customer service case by creating knowledge articles from customer service cases.

Before you begin
Role required: sn_customerservice_agent, sn_customerservice.consumer_agent, workspace_admin, admin

About this task

 располагаем информация из предыдущих задач обслуживания клиентов. До начала выполнения задания вы должны обладать ролью sn_customerservice_agent, sn_customerservice.consumer_agent, workspace_admin, admin.

Процедура

1. Откройте ваш рабочий стол.
2. Откройте задачу обслуживания клиентов.
3. Нажмите на значок More UI Actions (более UI действий).
4. Нажмите на Create Knowledge Article (создать статью знаний).
   Это создает новую статью знаний в подпапке. По умолчанию, новая статья создается с помощью шаблона KCS Article (Статья KCS). Переданные данные из задачи в статью знаний:
   • Краткое описание
   • Источник
   • Причина
   • Заметки по закрытию
5. В поле Knowledge base (База знаний) введите имя базы знаний, в которой вы хотите отобразить эту статью.
6. Дополнительно: редактировать статью знаний.
7. Нажмите на Save (Сохранить).

Report a knowledge gap

Если вы не можете найти релевантные статьи знаний, которые могли бы помочь решить задачу, вы можете сообщить о знании.

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Before you begin
Role required: sn_customerservice_agent, sn_customerservice.consumer_agent, sn_customerservice_manager, workspace_admin, admin

About this task

❓ Note: This task applies to both CSM Configurable Workspace and CSM Agent Workspace. You can also report a knowledge gap for a case in the platform interface.

You can search for and attach knowledge articles to a customer service case. If you cannot find any relevant articles, you can report a knowledge gap. If you have permission, you can also create a knowledge article.

Customer service case managers can use the Demand Insights for Cases dashboard to identify which cases have no or insufficient knowledge coverage. For more information, see Demand Insights for Cases dashboard.

Procedure
1. Open a customer service case.
2. Optional: Search for existing knowledge articles or create a knowledge article to help resolve a case.
3. Click the More UI Actions icon (*** ) and then click Report Knowledge Gap. In the platform interface, click the Report Knowledge Gap related link on the Case form and provide information in the resulting pop-up window. The system opens a new knowledge feedback task in a sub-tab. The short description from the case is copied to the Description field on the task.
4. Optional: Edit the knowledge feedback task description.
5. Click Save.
   The task is added to the Knowledge Gaps related list on the Case form.

Respond to a community thread from a case
For cases that are created from a community discussion, customer service agents can view and respond to the discussion in a new browser tab.

Before you begin
Role required: sn_customerservice_agent, sn_customerservice.consumer_agent, workspace_admin, admin

About this task

❓ Note: This task applies to both CSM Configurable Workspace and CSM Agent Workspace.
Cases that have been created from a community discussion have the Channel field set to Community.

Procedure
1. Open your workspace.
2. Open a case that was created from a community discussion.
3. Click the More UI Actions icon (*** ) and select Show Community Thread. This UI action is only available if the Channel is Community.
4. View the community discussion in a new browser window and respond as necessary.

Use response templates to add information to cases and case tasks
Customer service agents can copy content from response templates and add it to cases and case tasks.

Before you begin
Role required: sn_customerservice_agent with the sn_templated_snip.template_snippet_reader role

About this task

Note: This task applies to both CSM Configurable Workspace and CSM Agent Workspace.

The contextual sidebar in CSM workspaces gives you access to information that can help you resolve customer service cases. It includes a column of icons that you can click to access different types of information. Clicking the response templates icon shows reusable messages that you can copy and paste into cases and case tasks.

Procedure
1. Open your workspace.
2. Open a customer service case or case task.
3. In the contextual sidebar, click the response templates icon ( ) to display a list of templates.
4. In the Response Templates side panel, search for a template.
5. Select a template and then click Copy to clipboard.
6. Paste the template text into the Work notes field or the Additional comments field.
Related information

Response templates

Use Customer Central

Get a quick overview of key customer information and recent customer activity to help you find out more about the customer contacting support.

Before you begin

Role required: sn_customerservice_agent

If using the Walk-up Experience for business locations:

sn_customerservice.svc_location_agent,

sn_customerservice.svc_location_manager, or

sn_customerservice.svc_location_consumer_agent

About this task

Note: This task applies to both CSM Configurable Workspace and CSM Agent Workspace.

If you are using CSM Agent Workspace and Customer Central is activated on your instance, you can click the Customer Information and Customer Activity tabs from within the Interaction record.

If you are using CSM Configurable Workspace, you can access Customer Central from within the Interaction, Contact, Account, or Consumer records.

Use customer central to get a quick insight into key customer information and recent activity from the customer, who is contacting support. You can filter by date or facet to access the information you require.

Note: Accounts require contact information to display account information in Customer Central.

Procedure

1. Open your workspace.

2. On the Interaction, Contact, Account, or Consumer record, click Customer Information to view key information on the customer.

3. On the Interaction, Contact, Account, or Consumer record, click Customer Activity to view recent activity from the customer.

4. Create a case or close the record.
**Use guided decisions to resolve cases**

Work your way through a guided decision to help you troubleshoot a case and get recommendations on next possible steps in solving the case.

**Before you begin**

Role required: sn_customerservice_agent

**About this task**

⚠️ **Note:** This task applies to both CSM Configurable Workspace and CSM Agent Workspace.

Depending on the context of the case you are working on, guided decisions appear in playbooks in the CSM workspaces.

**Procedure**

1. Open your workspace.
2. Open a customer service case.
3. Click Playbook.
4. Work your way through the guided decision, answering the questions, and providing inputs where required.
   The guided decision evaluates your answers and provides you with the next question or gives you guidance as to what to do next.
5. Accept or skip the guidance.
   Depending on the guidance accepted, the system updates the following.
   - A knowledge article is attached to the case.
   - Resolution notes are added to the case.
   - A work order task is created.
   In the case details, the Activity list is updated with the action taken.

**Use Next Best Action recommendations to resolve cases**

As a Customer Service Agent, use recommended next best actions to help resolve a case.

**Before you begin**

Role required: sn_nb_action.next_best_action_user

**About this task**

Depending on the type of case you are working on, guided decisions appear in the Agent Assist panel.
Procedure

1. Open your workspace.
   For more information, see, Open a CSM workspace.

2. Open a customer service case that you want to work on
   The record opens in a Record view.

3. Click the Next Best Action icon (📍) in the Agent Assist panel.

4. Click View Details.
   You will see either guidances or decision trees based on their state in the following order. Also, within each state, the last updated next best action appears on top except for the next best actions in Skipped state. For example, if there are two guidances in In Progress state and you act on one, that guidance appears at the top.
   • In Progress
   • New
   • Completed
   • Skipped

5. To work on a decision tree or a guidance, do one of the following:

   a. In a decision tree, answer the questions and provide input where required.
      Depending on your answers, either another question is displayed or guidance is provided on what to do next. For more information, see Guided Decisions for Customer Service Management.

   b. In a guidance, click the suggested guidance and accept or skip the guidance and move to the next decision node.
      For more information on decision nodes, see Guidance outputs and nested decision trees.
      Depending on the guidance you accepted, the system attaches a knowledge article to a case, adds resolution notes to a case, or creates a work order task.

6. Work on the recommended guided decisions or guidances until you resolve the issue.
View trending case topics
Analyze the backlog of cases and identify clusters of cases that point to similar underlying issues.

Before you begin
Role required: sn_majorissue_mgt.major_issue_manager

About this task

⚠️ Note: This task applies to both CSM Configurable Workspace and CSM Agent Workspace.

View a list of clusters and cluster concepts.
• Cluster concepts list the top ten most recurring words that appeared in the short description of the cases.
• Cluster size indicates the number of cases in the cluster.
• Cluster quality gives a percentage value of how similar the cases are.

Procedure
1. Open your workspace.
2. Navigate to Lists > Trending Case Topics > Last 1 week.

What to do next
Click a Cluster Id to view the Cluster Summary form details, Related Cases and Related Major Cases.

You can also create a major case for trending case topics.

Add trending case topics to existing major cases
Work through cases more efficiently and resolve similar cases at once by identifying any existing major cases that the backlog of cases can be linked to.

Before you begin
Role required: sn_majorissue_mgt.major_issue_manager

About this task

⚠️ Note: This task applies to both CSM Configurable Workspace and CSM Agent Workspace.
Procedure
1. Open your workspace.
2. Navigate to Lists > Trending Case Topics > Last 1 week.
3. Click a Cluster Id.
4. On the Related Major Cases related list, check if there are any existing related major cases.
5. On the Related Cases related list, select the cases you want to add as child cases in the existing major case.
6. Click Edit.
7. In the Parent field, copy the number of the major case to add the child cases to.
8. Click Update.

Create major cases for trending case topics
Work through cases more efficiently and resolve similar cases at once by creating major cases to add the backlog of cases to.

Before you begin
Role required: sn_majorissue_mgt.major_issue_manager

About this task
Note: This task applies to both CSM Configurable Workspace and CSM Agent Workspace.

If you didn’t find an existing major case to add the trending case topics to and you think the cluster qualifies as a major case, you can create a major case, as applicable.

Procedure
1. Open your workspace.
2. Navigate to Lists > Trending Case Topics > Last 1 week.
3. Click a Cluster Id.
4. On the Related Major Cases related list, check if there are any existing related major cases.
5. If there are no related major cases, click Create Major Case.
A major case is created. All related child cases are linked as child cases to the major case if the Parent field in the case is empty and the case is in Open state.

**What to do next**
To access the major case, click the link in the confirmation message that a major case has been created.

**Manage email tasks**
You can compose, reply to, and preview emails directly from cases in CSM workspaces. This capability helps you save time and effort instead of having to address and send a separate email message.

You can perform the following email tasks from cases in CSM workspaces:

- Compose an email from a case
- Compose an email from the ribbon component
- Send an email response from a case activity stream
- Preview an email from the Emails related list

**Compose an email from a case**
As an agent, you can compose emails directly from cases within a ServiceNow instance. This capability helps you view and send emails to two different customers simultaneously which saves time and effort.

**Before you begin**
Role required: sn_customerservice_agent

**About this task**

**Note:** This task applies to both CSM Configurable Workspace and CSM Agent Workspace.

You can compose large emails easily in a full screen view which opens up in a new tab.

**Procedure**
1. Open your workspace.
2. Select and open the case for which you want to compose an email.
   The case opens in a new top-level tab.
3. Click the More UI Actions icon and select **Compose Email**.
The New Email screen opens in full view in a new sub-tab below the Case tab. The To field is pre-filled with the customer’s email id and the Subject field contains the original case number and issue. For more information, see Compose an email.

4. Compose your email and click Send.

⚠️ Note: You can also click Save to save the email and send it later. These drafts are available in the Draft Emails related list.

Related information
Compose an email from the ribbon component

Compose an email from the ribbon component
As an agent you can compose emails directly from cases within CSM workspaces without having to use an external email client. This capability helps you view and send emails to two different customers simultaneously which saves time and effort instead of having to address and send a separate email message.

Before you begin
Role required: sn_customerservice_agent

About this task

⚠️ Note: This task applies to both CSM Configurable Workspace and CSM Agent Workspace.

You can compose large emails easily in a full screen view which opens up in a new tab.

Procedure

1. Open your workspace.
2. Select and open the case for which you want to compose an email.
   The case opens up in a new tab.
3. In the ribbon component, click the contact’s email address.
   The New Email screen opens in full screen in a new tab. The To field is pre-filled with the customer’s email id and the Subject field contains the original case number and issue. For more information, see Compose an email.
4. Compose your email and click Send.

⚠️ Note: You can also click Save to save the email and send it later. These drafts are available in the Draft Emails related list.
Related information

Compose an email from a case

Send an email response from a case activity stream

Responde to cases using options within a customer email thread. You may not require using another email client which saves time and effort.

Before you begin
Role required: sn_customerservice_agent

About this task

Note: This task applies to both CSM Configurable Workspace and CSM Agent Workspace.

You can read and respond to large emails easily in a full screen which opens up in a new tab. Responding to a customer’s email from within a case using the reply, reply all, or forward options, includes the content from previous conversation thread. These options are available by default. An admin can disable these options. For more information, see Disable email responses from the case activity stream.

Note:

Procedure

1. Open your workspace.
2. Select and open the case from the activity stream for which you want to send or forward a response. The case opens up in a new tab.
3. Click Reply in the Activity Stream to write a response to the customer or click the icon and select Reply All to reply to all the customer email ids mentioned in the original email or select Forward to forward the email to any other email ids not mentioned earlier. Based on the selection, the Reply Email, Reply All Emails, and Forward Email screens opens in full screen in a new tab.

Note: You can click the icon to add attachments from the file system or delete attachments already associated with the existing case.
4. Compose your email and click Send.
Related information

- Activity formatter
- Email properties
  - Configure signatures in quick messages and email client templates

Preview an email from the Emails related list

Preview emails directly from within cases. This capability helps you select related emails from a list and read big emails in full view which helps improve the reading experience.

Before you begin

Role required: sn_customerservice_agent

About this task

⚠️ Note: This task applies to both CSM Configurable Workspace and CSM Agent Workspace.

Procedure

1. Open your workspace.
2. Select and open the case for which you want to preview emails. The case opens up in a new tab.
3. Click Emails tab. A list of related emails is displayed.
4. Select an email to preview from the list. The email opens in a new tab and displays the email entity details as in the following screen.
5. Click **Message** tab to view the email details such as From, To, Cc, Bcc, Subject, and the message body.

6. Click **Reply** to reply to the message you are viewing.

**Workforce Optimization for CSM Agent Workspace**

Manage your profile and schedule using Agent Workspace. Use coaching to review and complete assigned training.

The Workforce Optimization for Customer Service features are accessible when the administrator activates the plugin (com.snc.wfo_csm). This plugin activates related plugins that enable agents to use the Channel Management, Scheduling, Coaching, and Teams applications in Workforce Optimization for Customer Service.

**Access your profile from CSM Agent Workspace**

Track and monitor the real-time status of your work by accessing your profile in CSM Agent Workspace. You can track information such as how many cases and interactions you have closed and how many you are actively working on. You can also view the roles and groups to which you belong and see information about your manager and teammates.

**Before you begin**

Role required: sn_wfo_csm.employee

**About this task**

Access your profile to analyze information such as:
• Key performance indicators that matter most to you.
• Pending training that has been assigned to you and when they’re due.
• The service channels you are assigned to and their current utilization.
• Skills and skill levels that you currently use and skill gaps that you may want to address.
• Upcoming PTO.

Procedure

1. Navigate to **Workspace Experience > Workspaces > Agent Workspace Home**.
2. Click the Lists icon.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Access your profile from a case record | a. Click **Cases** and select **Assigned to me**.  
b. In the **Assigned** column, select your name.  
The profile page appears. In that page, you can access all the information related to your profile. |
| Create your profile for centralized access | a. Select the **My Lists** tab.  
b. Click **New List**.  
c. In the **New List** screen, click **Create your own**.  
d. In the **List Name** field, enter a name for the list; for example, My Profile.  
e. In the **Select Source** field, select **User (sys_user)**.  
f. In the **Add Filters** condition builder, select **[Name] [is] [<your name>]**.  
g. Click **Create**.  
The workspace adds your profile to the **My Lists** tab.  
For information on creating a list, see **Create My Lists in Workspace**. |
Manage your schedule from CSM Agent Workspace

Look up your schedule, request time off, or swap your shift with your peers using the calendar in CSM Agent Workspace. If you can work during the requested shift, you can also approve your peer’s request for shift swap.

Before you begin
Role required: sn_shift_planning.agent

About this task
You can swap shifts with agents that are within your assignment group.

Procedure

1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. Click the Calendar icon.
   
   You can access your schedule in the My Calendar tab. If you want to see a list of all agents in your assignment groups and their schedules, click the Team Calendar tab.

   To view your schedule or another agent’s schedule, you can:
   
   • View your schedule by clicking the My Calendar tab. Then, use the list menu to select the schedule that you want to view by day, week, or month.
   
   • View another agent’s schedule by clicking the Team Calendar tab. Then, click an agent’s schedule to see that agent’s work and break times.

3. Make a request.
   
   You can communicate with other agents by using Connect Chat or the activity stream on the record to make sure that they would like to swap the requested shift with you.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Request a shift swap</td>
<td><strong>a.</strong> Click Request shift swap.</td>
</tr>
<tr>
<td></td>
<td><strong>b.</strong> From the Shift menu for your shift, select the shift that you want to swap with another agent.</td>
</tr>
<tr>
<td></td>
<td><strong>c.</strong> In the Agent field for the requested shift, select the agent that you want to swap with.</td>
</tr>
<tr>
<td></td>
<td><strong>d.</strong> From the Shift menu for the requested shift, select the agent’s shift that you want to swap with.</td>
</tr>
<tr>
<td></td>
<td><strong>e.</strong> Click Submit.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Request a time off</td>
<td>a. Click Request time off.</td>
</tr>
<tr>
<td></td>
<td>b. From the Start time field, enter the time that you want your time off to start.</td>
</tr>
<tr>
<td></td>
<td>c. From the End time field, enter the time that you want your time off to end.</td>
</tr>
<tr>
<td></td>
<td>d. Click Submit.</td>
</tr>
</tbody>
</table>

- The shift-swap request moves to the approval queue of the agent that you have requested to swap with. For more information, see Approve or reject a shift-swap from CSM Agent Workspace.
- The time-off request moves to your direct manager’s approval queue. For more information about approvals, see Track and manage your teams’ schedule.

Clock-in and clock-out your work shift

Clock in and clock out your work shifts using CSM Agent Workspace. You can track your details, such as time attendance and time worked summary, to know how close you are adhering to your schedules.

Before you begin
Role required: sn_shift_planning.agent

About this task
The clock-in event is generated when you either login or set your status as Available in CSM Agent Workspace. The clock-out event is generated when you either logout from CSM Agent Workspace or set your status as Offline or Break.

Procedure
1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. Click the Inbox icon.
   • To clock-in your shift, set your status to Available.
   • To clock-out from your shift, set your status to Offline or Break.

Results
You can view your time attendance and adherence in Lists > Schedule Adherence > Time Attendance and Time Worked Summary lists.
Approve or reject a shift-swap from CSM Agent Workspace

You can approve a shift swap requested by your peer if you are available to work for that time period. You can reject it if you are unable to work then.

Before you begin
Role required: sn_shift_planning.agent

Procedure
1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. Click the Lists icon.
3. Go to Approvals > My Approvals.
4. Select the request you want to approve or reject.
5. Review the details of the shift swap request and do one of the following:
   • To approve the request, click Approve.
   • To reject the request, click Reject.
     If you approve a shift swap, the application moves the request to your manager's approval queue. For more information, refer to Track and manage your teams' schedule.

Initiate SMS conversations from CSM Agent Workspace

Compose an SMS message from CSM Agent Workspace to interact with a customer contact or a consumer regarding customer service cases.

Before you begin
Ensure that an administrator has configured the Conversational SMS Integration with Twilio application. For more information, see Conversational SMS Integration with Twilio.

Role required: agent_workspace_user

Procedure
1. Navigate to Workspace Experience > Workspaces > Agent Workspace Home.
2. On the Agent Workspace Home page, navigate to Agent Workspace > Lists > Interactions > My Interactions.
3. In the My Interactions list, modify an existing interaction or create another interaction.
   • To modify an existing interaction, select the interaction number in Number column of the My Interactions list.
   • To create another interaction, click New in the My Interactions list.
4. On the Details tab of the workspace form, fill in the details for a new interaction or modify the details. For more information about the form, see CSM workspace form features.

Note: The user profile associated with an interaction is configured by an administrator by using the AgentInitiatedConversationUtil extension point. By default, the AgentInitiatedMessagingUtilExtPointImpl script include that implements the AgentInitiatedConversationUtil extension point is available for the Conversational SMS Integration with Twilio application. For more information, see Associate user profiles on messaging interactions.

5. Click Compose SMS.

6. On the form, fill in the fields.

**Compose SMS form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>From</td>
<td>Provider phone number of the SMS channel.</td>
</tr>
<tr>
<td></td>
<td>• If there is only one provider phone number, the From list is automatically set to the provider phone number.</td>
</tr>
<tr>
<td></td>
<td>• If there are multiple providers configured for the SMS channel, you can select a phone number in the From list.</td>
</tr>
<tr>
<td>To</td>
<td>Phone number of the consumer or customer contact.</td>
</tr>
<tr>
<td></td>
<td>The phone number is in the E.164 format and automatically set to the phone number of the consumer or customer contact associated with the interaction record.</td>
</tr>
<tr>
<td></td>
<td>By default, the user profiles for consumers and customer contacts and the format of their phone numbers are validated for the SMS channel.</td>
</tr>
<tr>
<td></td>
<td>If you select Other from the To list, you can manually enter a phone number of the consumer or customer contact. Any manually entered phone number is automatically converted to the E.164 format. For more information, see Phone number fields.</td>
</tr>
<tr>
<td>Message</td>
<td>Message to be sent to the consumer or customer contact.</td>
</tr>
<tr>
<td>Attachment</td>
<td>File to be sent as an attachment.</td>
</tr>
<tr>
<td></td>
<td>Click Attach File to browse and select a file.</td>
</tr>
</tbody>
</table>
7. Click **Send**.

**Results**
The interaction record of type messaging is created or updated based on the workflow as discussed in the following table.

<table>
<thead>
<tr>
<th>Workflow</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>No active interaction record available</td>
<td>• A new interaction record of type messaging for the SMS channel is automatically created and assigned to the agent.</td>
</tr>
<tr>
<td></td>
<td>• The agent is added to the Live Group Profile [live_group_profile] table.</td>
</tr>
<tr>
<td>An active interaction record associated with a live agent exists</td>
<td>• The interaction details are appended to the existing interaction record for the SMS channel.</td>
</tr>
<tr>
<td></td>
<td>• If the message was initiated by an agent not associated with the existing interaction record, the agent is added to the Live Group Profile [live_group_profile] table. However, there’s no change in assignment of the interaction.</td>
</tr>
<tr>
<td>An active interaction record associated with the virtual agent exists</td>
<td>• The existing interaction record with the virtual agent is closed.</td>
</tr>
<tr>
<td></td>
<td>• A new interaction record of type messaging for the SMS channel is automatically created and assigned to the agent.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Workflow</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>automatically created and assigned to the agent.</td>
<td>• The agent is added to the Live Group Profile [live_group_profile] table.</td>
</tr>
<tr>
<td>• The agent is added to the Live Group Profile [live_group_profile] table.</td>
<td>An active interaction record associated with a different user exists</td>
</tr>
<tr>
<td>• The existing interaction record with the earlier user is closed.</td>
<td>• A new interaction record of type messaging for the SMS channel is automatically created and assigned to the agent.</td>
</tr>
<tr>
<td>• A new interaction record of type messaging for the SMS channel is automatically created and assigned to the agent.</td>
<td>• The user profile associated with the existing interaction record is deactivated.</td>
</tr>
<tr>
<td>• The user profile associated with the existing interaction record is deactivated.</td>
<td>• The user profile currently associated with the new interaction record is created.</td>
</tr>
<tr>
<td>• The user profile currently associated with the new interaction record is created.</td>
<td>• The agent is added to the Live Group Profile [live_group_profile] table.</td>
</tr>
</tbody>
</table>

**Initiate messaging conversations from CSM Configurable Workspace**

Compose an SMS message from CSM Configurable Workspace to interact with a customer contact or a consumer regarding customer service cases.

**Before you begin**

Ensure that an administrator has completed the following tasks:

• Configured the Agent-Initiated Messaging Interface application. For more information, see Agent-Initiated Messaging Interface.

• Configured at least one qualifying messaging channel for the agent-initiated messages. For more information, see Determine whether messaging channels are available for agent-initiated messages.

Role required: agent_workspace_user
Procedure

1. Navigate to Workspace Experience > Workspaces > CSM Configurable Workspace Home.

2. On the CSM Configurable Workspace Home page, navigate to Lists > Interactions > My Interactions.

3. In the My Interactions list, select the interaction number in Number column of the My Interactions list.

   Note: Ensure that the interaction type is other than messaging and the interaction state is not closed complete or closed abandoned.

4. On the Details tab of the workspace form, fill in the details for a new interaction or modify the details.

   For more information about the form, see CSM workspace form features.

   Note: The user profile associated with an interaction is configured by an administrator by using the sn_agent_initiated.AgentInitiatedMessagingUserDocument extension point. The AgentMessagingInteractionUserDocument script include that implements the sn_agent_initiated.AgentInitiatedMessagingUserDocument extension point is available for the Agent-Initiated Messaging Interface application. For more information, see Associate user profiles with agent-initiated messages.

5. Click Compose Message.

6. On the form, fill in the fields.

Compose Message form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel</td>
<td>Messaging channel that is installed with the application available for a service channel. For example, select SMS to send an SMS message. The SMS messaging channel is available when an administrator has installed the Conversational SMS service channel application. An administrator can configure whether a messaging channel is available for agent-initiated messages. For more information, see Determine whether messaging channels are available for agent-initiated messages.</td>
</tr>
<tr>
<td>To</td>
<td>Recipient ID of the consumer or customer contact, or when both are not available the recipient ID of the user for which the interaction was opened. The recipient ID is pre-populated from</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Provider ID</td>
<td>Provider ID of the messaging channel.</td>
</tr>
<tr>
<td>Provider ID</td>
<td>• If there is only one provider configured for the channel, the Provider ID is automatically set to the provider ID.</td>
</tr>
<tr>
<td>Provider ID</td>
<td>• If there are multiple providers configured for the channel, you can select an ID in the From list.</td>
</tr>
<tr>
<td>Message</td>
<td>Message to be sent to the recipient.</td>
</tr>
<tr>
<td>Attachment</td>
<td>File to be sent as an attachment.</td>
</tr>
<tr>
<td>Click Attach</td>
<td>Click Attach File to browse and select a file.</td>
</tr>
</tbody>
</table>

**Note:** By default, you can attach only images to the message.  

7. Click **Send**.

**Results**  
The interaction record of type messaging is created or updated based on the workflow as discussed in the following table.
<table>
<thead>
<tr>
<th>Workflow</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>No active interaction record available</td>
<td>• A new interaction record of type messaging for the channel is automatically created and assigned to the agent.</td>
</tr>
<tr>
<td></td>
<td>• The agent is added to the Live Group Profile [live_group_profile] table.</td>
</tr>
<tr>
<td>An active interaction record associated with a live agent exists</td>
<td>• The interaction details are appended to the existing interaction record for the channel.</td>
</tr>
<tr>
<td></td>
<td>• If the message was initiated by an agent not associated with the existing interaction record, the agent is added to the Live Group Profile [live_group_profile] table. However, there's no change in assignment of the interaction.</td>
</tr>
<tr>
<td>An active interaction record associated with the virtual agent exists</td>
<td>• The existing interaction record with the virtual agent is closed.</td>
</tr>
<tr>
<td></td>
<td>• A new interaction record of type messaging for the channel is automatically created and assigned to the agent.</td>
</tr>
<tr>
<td></td>
<td>• The agent is added to the Live Group Profile [live_group_profile] table.</td>
</tr>
<tr>
<td>An active interaction record associated with a different user exists</td>
<td>• The existing interaction record with the earlier user is closed.</td>
</tr>
<tr>
<td></td>
<td>• A new interaction record of type messaging for the channel is automatically created and assigned to the agent.</td>
</tr>
<tr>
<td></td>
<td>• The user profile associated with the existing interaction record is deactivated.</td>
</tr>
</tbody>
</table>
Using Playbooks for Customer Service Management

Customer service agents can use playbooks to complete the tasks and activities that are needed to resolve specific types of cases.

A playbook provides step-by-step guidance through the lifecycle of a customer service case. In the CSM workspaces, agents can locate a playbook in the Playbook tab for a case record. In CSM Configurable Workspace, a playbook can also be configured to display in compact mode in the contextual side panel.

A playbook includes multiple stages and each stage includes one or more activities for an agent to complete. When using a playbook, agents can:

- View the playbook stages and activities.
- Select an activity and perform the work necessary to complete that activity.
- Mark an activity as complete and move to the next activity or stage.
- Complete the stages and activities necessary to resolve the case.

Several features are available to agents when using a playbook, depending on the playbook configuration. These features are covered in more detail in the following topics.

Create a record using a playbook

Create a record using a playbook activity instead of a record form.

**Before you begin**

Role required: sn_customerservice_agent

**About this task**

ℹ️ Note: This task applies to both CSM Configurable Workspace and CSM Agent Workspace.

If a playbook is configured to use the record generator feature, customer service agents can create a record using a playbook activity. Creating a record...
from a list or form, or from an activity in another playbook, opens the playbook and initiates the first activity. This activity guides an agent through the record creation process.

With additional configuration, you can also create a case from any of the following records that opens a playbook and initiates the first activity:

- Interaction
- Case
- Account
- Consumer

To create cases in this way, the following configuration is required:

- Enable the Create Case button from the Customer Service Case Types application for each of these records. This enables agents to create a specific type of case.

  See Configure customer service case types for more information about using the Customer Service guided setup and the Case Types category to configure case type UI actions.

- Configure the playbook to use the playbook record generator.

  For more information about configuring this feature, see Playbook record generator in the Workspace Playbook setup documentation.

**Procedure**

1. Navigate to a list or form in CSM Configurable Workspace or CSM Agent Workspace.
   For example, navigate to the All Onboarding Cases list.
2. Click New.
   If you clicked New from the All Onboarding Cases list, the Onboarding playbook opens and initiates the first activity for collecting customer information.
3. Fill in the fields on the Collect customer information activity card.
4. Click Continue.
   The system uses the customer information to create a case. The case number is added to the tab and the first activity in the first playbook stage is marked as complete. The second activity is highlighted as the current activity.
5. Collect additional customer information, if needed, and click Save.
6. Continue using the playbook stages and activities to resolve the customer’s issue and complete the case.
Filter playbook activities
Filter the activities in playbook stages by the selected user or activity state.

Before you begin
Role required: sn_customerservice_agent

About this task

Note: This task applies to both CSM Configurable Workspace and CSM Agent Workspace.

When an agent filters the activities in playbook stages:
• The stages containing activities that match the filter conditions are automatically expanded.
• The activities that match the filter conditions are displayed within the expanded stages.

If the current activity is included in the filtered results, it remains highlighted. If it is not included, the first activity in the filtered results is highlighted.

Procedure
1. Open a case record that has an associated Playbook and click the Playbook tab.
2. Click the filter icon (✓) at the top of the playbook lifecycle to open the context menu.
3. Select one or more of the following filter choices:
   • A user in the Assigned to section.
   • An activity state in the State section.
4. Click outside the context menu to close the menu and apply the filter.
5. To clear the playbook activity filter, click the filter icon and clear the current selections in the context menu.

Using the activity stream in the contextual side panel
Customer service agents can access the activity stream in the contextual side panel in CSM Configurable Workspace.

The activity stream enables agents to communicate with requesters and make internal notes about the work done on a record. The activity stream updates when the current activity in the playbook is updated.
Click the activity stream icon (≡) in the contextual side panel to access the activity stream.

Agents can perform the following tasks in the activity stream.

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View posts for the case or case task</td>
<td>The current activity in the playbook work area determines the information that is displayed in the activity stream. Scroll through the posts in the Activity section to view case or task information. Click <strong>Case</strong> or <strong>Task</strong> at the top of the activity stream to switch views.</td>
</tr>
<tr>
<td>Add work notes or comments</td>
<td>In the Compose section: 1. Select the type of activity: Work notes or Comments. 2. Add the information to the text field. 3. Click <strong>Post Work Notes</strong> or <strong>Post Comments</strong>. The post is added to the Activity section.</td>
</tr>
</tbody>
</table>
| Filter posts                               | Click the filter icon (✔️) at the top of the Activity section to display the filter selections:  
  - **Post types**: Select the types of posts to view, such as work notes or attachments.  
  - **Field changes**: Select specific fields to view information in posts for only those fields.  
  - **Flagged**: Enable this button to view posts that have been flagged as important.  
  - **Filter sets** |
### (continued)

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort posts</td>
<td>Click the sort icon (_DOWN ARROW) to sort posts by newest to oldest or oldest to newest.</td>
</tr>
<tr>
<td>Expand and collapse posts</td>
<td>Click the more options icon (... ) to expand and collapse posts.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Expand all posts</strong>: Expands posts to view additional details.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Collapse all posts</strong>: Returns posts to their previous state.</td>
</tr>
</tbody>
</table>

### Viewing dynamic related records in the contextual side panel

Customer service agents can view dynamic related records in the contextual side panel in CSM Configurable Workspace. This feature displays related records that dynamically change based on the context of the current record or playbook activity.

Agents can view, search, and sort the records in the Related Records tab in the contextual side panel. These records appear in the Related Records tab as read-only cards.

The Related Records tab displays related records that dynamically change based on the context of the current record or playbook activity. The records that are displayed in the Related Records tab depend on the following settings:

- The related record contexts and definitions that have been configured for a record or playbook activity.
- The agent’s access permissions to data.

Depending on the related record configuration for the source record or playbook activity, agents can see the following types of related records:

- SLAs
- Emails
- Escalations for the case or customer (account and contact or consumer).
- Blocked By
- Sold Products
- Install Base Items
- Active Contracts
- Active Entitlements
- Special Handling Notes
- Tasks

<table>
<thead>
<tr>
<th>Task</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>View related records in the contextual side panel</td>
<td>Click the Related Records tab (≡) to view the Related Records list. Related records appear in the list in a card format. The initial set of records displayed in the list is determined by the record type selected in the filter at the top of the list.</td>
</tr>
</tbody>
</table>
| Select the type of related record to view | Use the filter at the top of the Related Records list to select the type of related records to view. Agents can also use the filter to see the current selection.  
1. Click the filter icon (🔎).  
2. Select a record type from the dropdown menu.  
The dropdown menu includes the related lists that have been configured for the parent record. |
| Search the related records list          | Use the search field at the top of the Related Records list to perform a text search. Records that match the search text are highlighted.  
1. Enter the search text in the search field at the top of the Related Records list.  
2. Click the search icon.  
 isi Note: The search field is grayed out if search is not available for the selected type of related records. |
<p>| Open a related record in a sub-tab       | Click a card in the Related Records list to open the record in a sub-tab under the parent record. In the sub-tab, the agent can view the record details and perform available actions. |</p>
<table>
<thead>
<tr>
<th>Task</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open the related record list in a list view in a sub-tab</td>
<td>Click the list view icon (箩) to display the related records in a list view in a sub-tab under the parent record.</td>
</tr>
</tbody>
</table>
| Create a new record for the selected related list | Create a new record for the record type currently selected in the Related Records list. This action opens a new record form in a sub-tab under the parent record.  
   1. Click the create record icon (➕) at the top of the Related Records list.  
   2. Fill in the fields on the record form and click Save. |

**Viewing ribbon information in the contextual side panel**

Customer service agents can view ribbon information in the contextual side panel in CSM Configurable Workspace.

Click the record information icon ( mỡ) in the contextual side panel to view ribbon information.

Agents can see the following information:

- **Case overview:** Displays an overview of the case details, including the case priority and state.
- **Customer 360:** Displays customer information such as the contact or consumer name, email address, and phone numbers.
- **Timeline:** Displays a chronological summary of case activities, including case state changes and interactions between the agent and the customer. It also shows how much time that the agent and customer spent on the case.
- **SLAs:** Displays active SLAs for the case, including time remaining, the SLA state, and any breaches.

**Using Proactive Customer Service Operations**

Monitor your customers' products and services to identify issues proactively, inform the affected customers, and fix issues quickly.

**Before you begin**

**Role required:** There are various different roles required for Proactive Customer Service Operations based on the tasks you perform.
Some tasks only apply if you are using Event Management integration on CSM Agent Workspace or the Now Platform interface. This is noted at the top of each task.

Roles required

<table>
<thead>
<tr>
<th>Role</th>
<th>Tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>evt_mgmt_admin, evt_mgmt_operator</td>
<td>Create alerts and proactive cases from alerts.</td>
</tr>
<tr>
<td><strong>Note:</strong> These roles only apply if you are using the integration with Event Management.</td>
<td></td>
</tr>
<tr>
<td>sn_customerservice_agent</td>
<td>Propose proactive cases as major case candidates, work on, and close proactive cases.</td>
</tr>
<tr>
<td>sn_customerservice_manager</td>
<td>Review and accept a proactive case as a major case and create child cases. Associate outages to cases or create an outage for a case. Track Key Performance Indicators (KPIs) to understand how proactive the team was in identifying and communicating issues that impact customers. For more information, see Proactive Customer Service - Advanced dashboard.</td>
</tr>
<tr>
<td>sn_majorissue_mgt.major_issue_manager</td>
<td>Create proactive cases. Review and accept proactive cases as major cases and create child cases. Associate outages to cases or create an outage for a case.</td>
</tr>
</tbody>
</table>

Related information

- View install base information in CSM workspaces
- View install base information from the Customer Service Portal
- Create a case for install base from the Customer Service homepage
- View sold product information in CSM workspaces
Create a proactive case from an alert

Create a case for customer install base affected by an alert to anticipate customer issues and address them proactively.

Before you begin
Role required: evt_mgmt_admin, evt_mgmt_operator

About this task

Note: This task only applies if you are using Event Management integration on CSM Agent Workspace or the Now Platform interface.

A proactive case is a case created on behalf of customers, whose install base is directly affected by an alert. You can open a proactive case manually or through automation. Customer service agents then work on cases. From the Alert form, you can also track the install base items affected by the alert.

If the Create Proactive Case rule is enabled, a case is automatically created when an incident is created from an alert and the system has determined that there are external customer install base items affected. For more information, see Activate an alert rule to automatically create a proactive case from an alert.

ITOM Event Management calculates the services (CIs) impacted by an alert and populates the em_impacted_ci_table with the impacted services (CIs) and alert CI on the given alert.

The Affected Install Base related list on the Alert form displays the install base items that are linked to the impacted services (CIs).

The Refresh Affected Install Base Items button on the Alert form recalculates the impacted services (CIs) and updates the em_impacted_ci_table and affected install base items with the latest changes. For more details, see Alert Impact Calculation.

Procedure

1. Navigate to Agent Workspace > Agent Workspace Home > Lists > All Alerts.
2. Click an alert that you want to create a case for.
3. To trace the install base items affected by the alert, click Refresh Affected Install Base Items.
   These items are listed in the Affected Install Base Items related list on the Alert form. The Affected Install Base Items list is not updated automatically, so refresh the install base items each time you open an alert.
4. Click Create Case.

Note: If you don’t see the Create Case option, click ...
5. Fill out the **Short Description** and other fields, as required.

6. Click **Submit**.

A proactive case is created and the case number is added to the **Case** field on the Alert form. Case priority is set based on the severity of the alert. Customer service agents can then take action accordingly.

<table>
<thead>
<tr>
<th>Alert severity</th>
<th>Case priority</th>
</tr>
</thead>
<tbody>
<tr>
<td>Critical</td>
<td>Critical</td>
</tr>
<tr>
<td>Major</td>
<td>High</td>
</tr>
<tr>
<td>Minor</td>
<td>Moderate</td>
</tr>
<tr>
<td>Warning</td>
<td>Low</td>
</tr>
<tr>
<td>Info</td>
<td>Low</td>
</tr>
</tbody>
</table>

**Manage a proactive case created from an alert**

Work on a proactive case and resolve the proactive case as you would other customer service cases.

**Before you begin**

Role required:

- sn_customerservice_agent
- evt_mgmt_admin and evt_mgmt_operator have read-only access to a case created from an alert and can add work notes, as required.

**About this task**

ℹ️ **Note:** This task only applies if you are using Event Management integration on CSM Agent Workspace or the Now Platform interface.

Review proactive cases created from alerts using Agent Workspace. Identify customers, their corresponding install base items affected by the issue causing the alert as well as the service health for each affected install base item. Depending on the number of customers affected, you can propose a proactive case as a major case.
Procedure

1. Navigate to Agent Workspace > Agent Workspace Home > Lists > Cases. Alternatively, accept a proactive case from your Agent Workspace inbox.

2. Click the case you want to work on.

3. You can perform the following actions from the Case form.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click Refresh Install Base Health.</td>
<td>Update the health status of the affected install base items to see the real-time service status of the account’s install base items.</td>
</tr>
<tr>
<td>Note:</td>
<td>To see this UI action, there must be an account assigned to the case and at least one install base item attached to the case or account.</td>
</tr>
<tr>
<td>Click Affected Install Base Items.</td>
<td>View accounts and their corresponding install base items affected by the alert. If you don’t see this option, click more.</td>
</tr>
<tr>
<td>Click Add or Remove.</td>
<td>Add or remove an affected install base item.</td>
</tr>
<tr>
<td>Click Details.</td>
<td>View the sold product associated to the case as well as the alert that the case was created from.</td>
</tr>
<tr>
<td>Click Propose Major Case.</td>
<td>Propose a major case when multiple customers are affected.</td>
</tr>
<tr>
<td>Note:</td>
<td>If you don’t see this option, click the More UI Actions icon (***).</td>
</tr>
</tbody>
</table>

4. Resolve and close proactive cases in the same way as other customer service management cases.

   Note: If an alert is closed, a case is not automatically closed.
Related information

Propose a case as a major case candidate
Close a customer service case
AWA for CSM

Review and accept a proactive case as a major case

Review and accept proactive cases as major cases using the major issue management process.

Before you begin

Role required: sn_majorissue_mgt.major_issue_manager, sn_customerservice_manager

Procedure

1. Open your workspace.
3. Optional: Click Major Case Information > Affected Customers to view the automatically generated list of customers affected by the issue.
4. Optional: Click Create Child Cases to create a child case for each affected customer.
5. Accept or reject the proactive case as a major case.
6. Follow the major issue management process to resolve the proactive case.

Note: If the Proactive Customer Service Operations with Event Management plugin is activated, your system administrator may have configured workflows to automate the creation of major cases depending on the number of accounts affected by an issue. If your system administrator has configured workflows, major cases are created in either Accepted, Proposed, or Created state depending on the settings. If Accepted, child cases are automatically created.

Related information

Major issue management overview
Create a major case
Create a major case candidate
Approve or reject a major case candidate
Create child cases for a major case
AWA for CSM
Track the service health of install base items in Agent Workspace

Track the operational status of install base items belonging to an account, to better correlate customer issues and provide faster responses.

Before you begin
Role required: sn_customerservice_agent or sn_customerservice_manager

About this task
The service health status provides you with visibility into the service health of a customer's install base items. The service health status is based on the severity of the impacted services being monitored at the Network Operations Center. Refresh the service health status on the Account and Case forms to access the real-time health status of install base items.
As a customer service agent, you can view the service health status of install base items in a case or a customer account.

Procedure
1. Open your workspace.
2. Navigate to Lists.
3. Click an account or a case.
4. To refresh the health status of install base items on both the Account and Case form, click Refresh Install Base Health.
5. To view the health status of an install base item on the Account form, click the Install Base Items related list.
6. To view the health status of an affected install base item on the Case form, click the Affected Install Base Items related list.

Related information
Service health status for install base

Associate an outage to a major case
Associate an outage with a major case to keep customers informed about any issues affecting their install base items.

Before you begin
Role required: sn_customerservice_manager, sn_majorissue_mgt.major_issue_manager

About this task
If there are any existing outages for services (CIs) on install base items related to the case, a message is displayed at the top of the screen. Review the outages
and add them to the case to expose the information to customers and keep them up to date on any issues that might affect their install base items.

**Procedure**

1. Open your workspace.

2. Navigate to **Major Issue Management > All**.

3. Click the major case you want to add outages to.

4. On the **Outages** related list, click **Edit**.
   A filter displays the outages. Only those outages related to at least one of the services (CIs) for the install base items in the case is displayed. In this case, a CI is typically a service being used by the customer.

5. Add the outages you want to associate to the case.

6. Click **Save**.
   - The outage is associated to the case and the work notes are updated accordingly.
   - Customer service agents can view the outages for a case in the Outages related list.

**Create an outage from a major case**

Create an outage from a major case to keep customers informed about any issues affecting their install base items.

**Before you begin**

Role required: sn_customerservice_manager, sn_majorissue_mgt.major_issue_manager

**About this task**

If no outages exist, you can also create outages directly from a major case to inform affected customers.

**Procedure**

1. Open your workspace.

2. Navigate to **Major Issue Management**.

3. Create a major case or click an existing major case with no outages associated to it.

4. Click **Create Outage**.
Note: You can only create an outage from a case if there are no outages already associated to it and there is at least one affected install base item associated to the case. You cannot create an outage on a child case.

The Case view of the Outage form opens.

5. Fill out the fields on the form, as required.

6. Click Submit.
   All services (CIs) associated to the install base items in the case are associated to the outage as Affected CIs.

Track outages for install base items
View outages associated to a case to keep customers informed about any issues affecting their install base.

Before you begin
Role required: sn_customerservice_agent

About this task
Outages can be tracked using both proactive cases and customer-reported cases.

Procedure
1. Open your workspace.
2. Click Lists.
3. Click a proactive case.
4. Click the Outages related list to view all outage information related to the case.

   Note: If the Outages related list isn’t displayed, click more.

Using Walk-up Experience
Use the Walk-up Experience feature to check-in at a walk-up location, book appointments from the customer service portal, and monitor queues.

Users with roles including sn_walkup.walkup_login, sn_csm_walkup.walkup_technician, sn_csm_walkup.walkup_manager and walk-up users can use the Walk-up Experience feature.
Check-in at a walk-up location

As a store representative, you can enable customers to check-in on arrival at your service location. The user is added to the queue after filling in some details and reason for visit. The user joins the queue of other requesters.

Before you begin
Role required: sn_walkup.walkup_login

About this task
A screen is displayed as follows on the store device to run the Check-in application at a location.

The Check-in widget, allows the requester to add details in the following screen. Both guest users and registered users can check-in. If the system already has a contact/consumer with the same details, it associates the interaction with the particular contact in the system.
Welcome! Please check in below to add yourself to the queue.

Enter your full name

Enter your email

Reason for visit

Check in

Once the requester checks in, they can view the queue status on a heads-up display.
The Queue widget allows viewing the list of requesters at the walk-up location. For more information, see Monitor Walk-up Experience queues.

The Survey widget allows you to request the requester for feedback about the experience at the location. For more information, see CSM Walk-up Experience customer satisfaction surveys.

Schedule appointments or join a queue from the Customer Service Management portal

Customers need to invest time in coming to a physical location for service. Ability to book appointments at a specific time helps plan visits to the service location. A slot is pre-assigned based on the appointment booking.

Before you begin
Role required: sn_walkup.walkup_login

Procedure
1. Login to the customer portal.
2. Navigate to Support>Walk-up Check In from the portal header. The application searches for your nearest service center.
3. Click Change location and select the location you prefer from the drop-down list if you want to change the default location.

The default location is set to the nearest service center based on your location information, once you allow the browser to access your location. You can
pick the location manually if do now want to allow browser to detect your location.

4. Go to the **Schedule an appointment** tab to book an appointment.

5. Select a reason for your visit from the drop-down list.
   - Related content that may help with your issue is listed at the bottom of the screen.

6. Select a reason for your visit from the drop-down list.

7. Click the Calendar icon (📅) and select the date and time of appointment.

8. Click **Schedule Appointment**.
   - You will receive the following notifications by email when you perform the following actions:
     - Appointment confirmation, reminder, and cancellation.
     - Survey email.

   **Note:** You can come back to the portal to reschedule or cancel the appointment if the appointment date has not passed.

---

**Schedule a walk-up appointment as a guest user**

Schedule walk-up appointments as a guest user from either the Customer Service Portal or Consumer Service Portal.

**Before you begin**

Role required: none

**Procedure**

1. Go to the Customer Service Portal or Consumer Service Portal home page by adding the suffix `/csm` or `/csp` to your instance URL.

2. Click **Walk-up Check-in**.

3. Click **Allow** to use your current location or select the location you prefer from the **Select the location** drop-down list.
   - The Welcome to Walk-up Check-in screen is displayed.

   **Note:** A user with login credentials can also log in through the guest Walk-up Check-in link to book an appointment.

4. Select the **I'm not a robot** check box and verify that you are not a robot.

5. Fill in the fields.
**Field** | **Description**
--- | ---
Enter your name | Your first name and last name.
Enter your email address | Your email address.
Enter your phone number (optional) | Your phone number. **Note:** This field doesn’t accept alphabetical characters.
What is the reason for your visit? | The reason for your visit.
When do you want to visit? | The date you want to visit. Click the calendar icon, select the desired date and time for the appointment, and click **Select.**

The default location name, description, hours of operation, and **Get Directions** link are displayed on the right.

**Note:** If you have chosen to select a location, the **View on map** link appears instead.

6. **Optional:** Change the location manually.
   a. Click **Change Location.**
   b. Select a location from the drop-down list.

7. Click **Schedule appointment.**
   You will receive a verification email.

   **Note:** You can also click **Cancel appointment** on the same Welcome to Walk-up Check-in screen. Confirm the cancellation in the dialog box that appears and cancel the appointment.

8. Click **Verify** or click on the link to confirm your appointment from the email you receive.
   The appointment is confirmed and the details are displayed on the confirmation screen. If you want to verify your appointment once this screen is no longer displayed, you can click the link in the appointment confirmation email to display it again.

**Modify or cancel a walk-up appointment as a guest user**
Modify or cancel walk-up appointments that you have scheduled.
Before you begin
Role required: none

Procedure
1. Open the appointment confirmation email that you received.
2. Click the link in the email to modify or cancel your appointment.
   A One-time Passcode Verification tab opens in the browser and an email containing a one-time passcode (OTP) and a link to verify your appointment is sent.
3. Enter the OTP in the verification tab and click **Continue** or click **Verify your Appointment** in the email.
   The OTP option is useful when you are handling multiple devices to check emails and book appointments. For example, you can view the email with the OTP on your mobile and enter the OTP while booking an appointment on your desktop.

   ✨ Note: The link expires after a certain time.

   The Your Appointment details screen opens.

4. Either cancel the appointment or modify it.
   - To cancel the appointment, click **Cancel appointment**. You will receive an email to confirm that your appointment is cancelled.
   - To modify the appointment, modify the details and click **Update**.

Monitor Walk-up Experience queues
Once you check in at a location, you are notified of the wait time and your position in the queue. You can view the issues being serviced and the queue.

Before you begin
Role required: Customers

Procedure
1. Log in to the customer service portal.
2. Select your location.
3. Click the **Queue** widget.
4. You can view the following information:
   - queue of everyone waiting for service
   - names of people who are ahead of you
• status of people currently served and waiting in the queue
• respective agents who are serving the customers

CSM Walk-up Experience dashboard

As a service manager you can see key metric reports for walk-up interactions which helps in monitoring the performance of agents and service locations.

Access the dashboard by navigating to CSM Walk-up Experience > Dashboard. To view detailed information, hover over any report graphic. You can save graphs as PNG or JPEG files and attach them to emails or include in reporting presentations. All graphs can be refreshed for the latest data. The following screen is an example of how the dashboard appears.

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer service administrator: Can edit the dashboard and manage users, groups, and roles for the dashboard.</td>
<td>admin</td>
</tr>
<tr>
<td>Walk-up Experience administrator: Can edit the dashboard and manage users, groups, and roles for the dashboard</td>
<td>sn_csm_walkup.walkup_admin</td>
</tr>
<tr>
<td>End user and goal</td>
<td>Required role</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>Walk-up Experience manager: Can track the number of walk-ups, walk-up interactions with cases, average service and wait time and so on.</td>
<td>sn_csm_walkup.walkup_manager</td>
</tr>
</tbody>
</table>

## Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Completed Walk-ups for the Quarter</td>
<td>42</td>
<td>Total number of records created during the fiscal business quarter. Volume shown as a single score.</td>
</tr>
<tr>
<td>Exit Survey CSAT for this Year</td>
<td></td>
<td>Speedometer showing the average customer satisfaction sentiment (1 to 3) during the exit survey for the current calendar year.</td>
</tr>
<tr>
<td>Overall CSAT within Last Year</td>
<td></td>
<td>Speedometer showing the average customer satisfaction sentiment (1 to 5) captured by the email survey within the last year (364 days from current date).</td>
</tr>
<tr>
<td>Walk-ups by Location within Last Year</td>
<td></td>
<td>Total number of walk-up interactions, by location within the last year (364 days from current date). Volume shown as a spline distributed by month.</td>
</tr>
<tr>
<td>Walk-up Interactions with Cases by Location within Last Year</td>
<td></td>
<td>Total number of walk-up cases, by location within the last year (364 days from current date). Volume shown as a</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------------------------------</td>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Walk-up Reasons by Location within Last Year</td>
<td></td>
<td>Reasons for visiting the walk-up queue, by location within the last year (364 days from current date). Data shown as a bar chart.</td>
</tr>
<tr>
<td>Walk-ups by Day of the Week</td>
<td></td>
<td>Total number of walk-up interactions per day during the course of a week, by location. Data shown as a bar chart.</td>
</tr>
<tr>
<td>Walk-ups by Hour</td>
<td></td>
<td>Total number of walk-up interactions, by hour and by location. Data shown as a bar chart.</td>
</tr>
<tr>
<td>Average Service Time by Location</td>
<td></td>
<td>Average time it takes to close an interaction, by location. Time average shown as a spline by month.</td>
</tr>
<tr>
<td>Average Wait Time by Location</td>
<td></td>
<td>Average time a walk-up guest waits for service, by location. Data shown as a bar chart.</td>
</tr>
</tbody>
</table>

**Walk-up Experience queue and interaction management**

Walk-up Experience managers and technicians can efficiently manage all aspects of a walk-up location queue and interaction demand. Technicians can view assigned walk-up locations and interactions for walk-up fulfillment.

Walk-up Experience provides technicians with inclusive fulfiller resources to organize and manage a walk-up queue.

As a Technician you can access Agent Workspace to manage a walk-up interaction. Using Agent Workspace you can:
• Access a personal inbox to view work assigned from multiple service channels, including the Walk-up Service Channel.

• Get assignments automatically pushed to your inbox from the walk-up interaction queue.

• Work on concurrent or multiple interactions at the same time.

• Promote interactions to cases.

• Work with any requester in the queue at any time by pulling from anywhere in the queue list, as well as from the top of the list.

• Create cases for interactions

• Manually pick an interaction specific to a requestor

• Use Agent Assist to expedite fulfillment.

With Agent Workspace, as a technician you can typically fulfill interactions on a first-come-first-served basis as interactions are pushed to individual walk-up inbox. Interactions are distributed to the walk-up agent inbox based on assignment rule configurations in the Advanced Work Assignment feature.

Technicians can directly open cases in Agent Workspace when an issue is not resolved at the walk-up location.

Walk-up Experience also includes a Technician module in the application navigator where agents supporting a walk-up queue can perform the following actions:

• Access the personal walk-up inbox linking directly to Agent Workspace.

• View assigned walk-up interactions.

• Reassign and modify walk-up interactions when necessary.

• View all scheduled and upcoming appointments.

• View walk-up queue locations.

• Transfer walk-up interactions to other technicians or queue locations when necessary.

The following applications are included in the platform Technician module of the CSM Walk-up Experience navigation bar as well as viewed in the Agent Workspace under Walk-up:
## CSM Walk-up Experience technician applications

<table>
<thead>
<tr>
<th>UI view and application</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Platform: My Walk-up Inbox</strong>&lt;br&gt;Agent Workspace: Inbox</td>
<td>View walk-up interactions assigned to you in your personal inbox on Agent Workspace. Advanced Work Assignment pushes interactions to your inbox according to assignment rule configurations.</td>
</tr>
<tr>
<td><strong>Platform: My Walk-up Locations</strong>&lt;br&gt;Agent Workspace: Walk-up Locations</td>
<td>View walk-up queue locations that you are assigned to support by physical address.</td>
</tr>
<tr>
<td><strong>Platform and Agent Workspace: My Assigned Walk-ups</strong></td>
<td>View walk-up interactions you are assigned to resolve or fulfill. These interactions have a <strong>Work in Progress</strong> state. You can also see your assigned interactions in your personal inbox on Agent Workspace.</td>
</tr>
<tr>
<td><strong>Platform and Agent Workspace: Open - Unassigned</strong></td>
<td>View all open and unassigned walk-up interactions for your queue locations. These interactions have either a <strong>New, Queued</strong>, or <strong>Work in Progress</strong> state.</td>
</tr>
<tr>
<td><strong>Platform and Agent Workspace: Closed Walk-ups</strong></td>
<td>View all closed walk-up interactions. Closed interactions have either a <strong>Closed Complete</strong> or <strong>Closed Abandoned</strong> state.</td>
</tr>
<tr>
<td><strong>Platform: Scheduled Appointments</strong>&lt;br&gt;Agent Workspace: Appointments</td>
<td>View all upcoming appointments scheduled for your walk-up queue.</td>
</tr>
</tbody>
</table>
View assigned Walk-up Experience location

Walk-up Experience technicians can view a list of the walk-up queues they are assigned to support. Location queues reveal all the information a technician needs to know to operate the queue efficiently.

Before you begin
Role required: sn_csm_walkup.walkup_technician

About this task
There are two ways technicians can view the walk-up location queues they are assigned to support. Technicians primarily access Agent Workspace for all CSM Walk-up Experience-related information, including locations. However, technicians can also access CSM Walk-up Experience in the application navigator, or left navigation bar, to view assigned queue locations.

Procedure
1. To view walk-up locations using Agent Workspace, navigate to Workspace Experience > Agent Workspace Home. The Agent Workspace homepage opens, greeting you with your name.
2. Click List in the left navigation bar.
3. Under Walk-up, click Walk-up Locations. Walk-up locations you are assigned to support are listed.
4. Click a queue name to view details about the location, such as, interactions, appointments, reasons for visits, and more.
5. Alternatively, to view walk-up locations via the application navigator, navigate to CSM Walk-up Experience > Technician > My Walk-up Locations.
6. Click a queue name to see details about the location, such as, interactions, appointments, reasons for visits, and more. If interactions are leftover from a previous day or are still queued at the end of the day with no associated guests at the queue, you can click Abandon All to cancel these interactions.

View Walk-up Experience inbox

View a personal inbox of automatically assigned Walk-up Experience interactions using the Agent Workspace feature interface.

Before you begin
Role required: sn_csm_walkup.walkup_technician
About this task
There are two ways technicians can view the walk-up inbox. Technicians primarily access Agent Workspace for all Walk-up Experience related information, including the inbox. However technicians can also access CSM Walk-up Experience in the application navigator, or left navigation bar, to link to and view the inbox in Agent Workspace.

Procedure

1. To view the walk-up inbox using Agent Workspace, navigate to **Workspace Experience > Agent Workspace Home**.
   The Agent Workspace homepage opens, greeting you with your name.

2. Click **Inbox** in the left navigation bar of the interface.
   Automatically pushed interaction assignments appear in the inbox based on agent schedules and assignment rule configurations in the Advanced Work Assignment feature. Technicians can set an inbox status of **Available**, **Away**, and **Offline**.

3. Alternatively, to view the walk-up inbox via the application navigator, navigate to **CSM Walk-up Experience > Technician > My Walk-up Inbox**.
   You are linked directly to your personal inbox in Agent Workspace. Automatically pushed interaction assignments appear in the inbox based on agent schedules and assignment rule configurations in the Advanced Work Assignment feature.

Manage automatically assigned Walk-up Experience interactions
Technicians supporting CSM Walk-up Experience locations can view and manage interactions automatically pushed to the Agent Workspace inbox.

Before you begin
Role required: sn_csm_walkup.walkup_technician

About this task
Walk-up Experience interactions can be automatically pushed to a personal inbox in Agent Workspace based on agent schedules and assignment rule configurations in the Advanced Work Assignment feature. Technicians fulfill interactions on a first-come-first-served basis as they appear in the inbox.

To manually assign and manage interactions using the CSM Walk-up Experience Technician modules found in the application navigator, refer to **Manage Walk-up Experience interactions manually**.

Technicians set a status in the Agent Workspace inbox to indicate readiness to accept interactions. Status choices are **Available**, **Away**, and **Offline**.
Even though interactions are automatically pushed to the walk-up inbox, agents can work with anyone in the walk-up queue at any time.

View walk-up queue interactions assigned to you automatically in your walk-up inbox or in your My Assigned Walk-ups list. You can also view all Open-Unassigned interactions for the queue you support.

With Agent Workspace you can view lists of all your related walk-up interactions and appointments, your cases, customer accounts and contacts, incidents, requests, and more using one convenient interface. The Walk-up Experience related interaction list includes the following items:

<table>
<thead>
<tr>
<th>List item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Assigned Walk-ups</td>
<td>Interactions you assign to yourself when you accept an active interaction or that are assigned to you. Agents assign interactions to themselves when they accept a queued interaction. Managers can assign interactions to specific agents. These interactions are in a Work in Progress state. Once assigned, an agent can transfer the interaction to another agent or queue to complete the work, if necessary.</td>
</tr>
<tr>
<td>Open — Unassigned</td>
<td>All open but unassigned interactions associated with your specific walk-up queue location. When a guest checks into a walk-up queue, an interaction is created. The interaction is Queued until an agent accepts it or is assigned the interaction. At that point, the state changes to Work in Progress.</td>
</tr>
<tr>
<td>Closed Walk-ups</td>
<td>All Closed Complete and Closed Abandoned interactions assigned to a specific walk-up location queue. Agents can abandon an interaction when a guest leaves the queue before receiving support.</td>
</tr>
</tbody>
</table>

Procedure

1. To begin supporting a walk-up queue guest, navigate to Workspace > Agent Workspace Home. The Agent Workspace homepage opens, greeting you with your name.
2. Click Inbox and ensure your status is set to Available. View interactions in your inbox automatically pushed to you.
3. Select the interaction at the top of the list and begin resolving the issue or fulfilling the request.
When you create an associated case, a **New Case** tab opens next to the **Details** tab of the original interaction. Fill out the new case form. Click **Save** to save the new case.

a. If an interaction requires an unusual amount of time to resolve or fulfill, you can place the interaction on hold. The requester does not lose position in the queue and you can help another requester simultaneously. Placing an interaction on hold does not affect your capacity for new interactions. To put an interaction on hold, click **Put on Hold**.

b. You can associate the interaction with another record by selecting **Associate Record** from the more UI actions icon in the interaction header.

c. If you cannot resolve an issue, click the **Create Case** button in the interaction header.

When you create an associated case, a **New Case** tab opens next to the **Details** tab of the original interaction. Fill out the new case form. Click the **Save** button to save the new case.

4. When you finish resolving the interaction, click **Close** in the interaction header. Closing an interaction affects your capacity because a new interaction will be pushed to your inbox.

**Manage Walk-up Experience interactions manually**

Technicians supporting walk-up locations can manually manage queue requests with several CSM Walk-up Experience interaction-related modules.

**Before you begin**

Role required: sn_csm_walkup.walkup_technician

**About this task**

Manage interactions manually using the CSM Walk-up Experience Technician modules found in the application navigator. To manage automatically assigned interactions from the Agent Workspace inbox, refer to Manage automatically assigned Walk-up Experience interactions.

Walk-up queues support guests in the order that they check into the queue — first come, first served. Technicians supporting the queue can decide who will work the first interaction. As new guests enter the queue and submit interactions, technicians share the workload, assigning queued interactions to themselves.

View walk-up queue interactions using several Walk-up Experience modules:
Walk-up Experience interaction modules

<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Assigned Walk-ups</td>
<td>Interactions you assign to yourself when you accept an active interaction or that are assigned to you. Agents assign interactions to themselves when they accept a queued interaction. Managers can assign interactions to specific agents. These interactions are in a Work in Progress state. Once assigned, an agent can transfer the interaction to another agent or queue to complete the work, if necessary.</td>
</tr>
<tr>
<td>Open — Unassigned</td>
<td>All open but unassigned interactions associated with your specific walk-up queue location. When a guest checks into a walk-up queue, an interaction is created. The interaction is Queued until an agent accepts it or is assigned the interaction. At that point, the state changes to Work in Progress.</td>
</tr>
<tr>
<td>Closed Walk-ups</td>
<td>All Closed Complete and Closed Abandoned interactions assigned to a specific walk-up location queue. Agents can abandon an interaction when a guest leaves the queue before receiving support.</td>
</tr>
</tbody>
</table>

Procedure

1. To begin supporting a walk-up queue guest, navigate to CSM Walk-up Experience > Technician > Opened - Unassigned. The Interactions list opens.
2. Find the guest name under the Opened for column of the Interactions list.
3. Click the interaction Number associated with the guest. The Walk-up Interaction form opens with details about the issue or request.
4. Enter your name in the Assigned to field on the form, change the State to Work in Progress, and click Update.
   a. To close an interaction if the guest has left the queue, click Abandon in the form header or choose Closed Abandoned from the State form field and click Update.
   b. Alternatively, you can associate the interaction with another record by clicking the Associate Record button in the interaction header.
5. To resolve the interaction, navigate to Walk-up Experience > Technician > My Assigned Walk-ups.
6. Click the interaction number from the list to open the Walk-up Interaction form.

7. Resolve the issue or fulfill the request.
   a. Change the interaction status to On Hold if the requester is not present for an appointment or if the interaction entails a lengthy process, for example, an OS upgrade.
   b. If you cannot resolve the issue or fulfill the request, click the Create Case related link to create a case.

When you create a case, the associated related lists on the form populate. Related lists include the following details:
   • Cases for Interaction: Cases associated with the interaction
   • Cases by Same Caller: Cases created for a walk-up guest

8. When you finish resolving the interaction, change the interaction State to Closed Complete and click Update to update the interaction. Alternatively, you can click Close to complete the interaction.

View and manage Walk-up Experience appointments in Agent Workspace

Viewing upcoming scheduled CSM Walk-up Experience appointments provides technicians with an estimate of future queue demand and workload. Managers can view future appointments and adjust staffing at walk-up queue locations to best support demand.

Before you begin
Role required: sn_csm_walkup.walkup_technician

About this task
Technicians and managers primarily use Agent Workspace for all Walk-up Experience related information, including viewing and managing scheduled appointments.

Note: You can also view and manage scheduled appointments from the CSM Walk-up Experience in the application navigator, or left navigation bar.

Appointments are automatically routed to your Agent Workspace inbox based on availability. You can also view a list of scheduled appointments and choose which one to accept.

Upcoming appointments also display with a small calendar icon next to the user name on the onsite walk-up location queue wall monitor. The user with an appointment appears on the monitor a short time before the appointment is scheduled to begin.
Note: Upcoming appointments are also displayed on online check-in screen with the same calendar icon next to the user name.

Procedure
1. Navigate to Workspace Experience > Agent Workspace Home. The Agent Workspace homepage opens, greeting you with your name.
2. Click List in the left navigation bar.
3. Under Walk-up, click Appointments. Walk-up appointments assigned to your queue are listed.
4. Click an appointment number to view details, such as the requester name, the interaction number and description, and the appointment time.
   a. To open the associated interaction to view details, click the open record icon next to the interaction number.
   b. Click Accept appointment to begin working on the interaction. If necessary, you can assign the appointment to another agent and add work notes. If a significant amount of time has passed and the requester does not show up for the appointment, you can delete the appointment by clicking the more UI actions icon in the interaction header and choosing Delete.
   c. Click Save to save any changes you make to the appointment interaction.

View and manage Walk-up Experience-appointments from application navigator
Viewing upcoming scheduled Walk-up Experience appointments provides technicians with an estimate of future queue demand and workload. Managers can view future appointments and adjust staffing at walk-up queue locations to best support demand.

Before you begin
Role required: sn_csm_walkup.walkup_technician

About this task
Technicians and managers can view and manage scheduled walk-up appointments from Walk-up Experience in the application navigator, or left navigation bar.
Note: Primary access is through Agent Workspace for all Walk-up Experience related information, including scheduled appointments.

Upcoming appointments also display with a small calendar icon next to the user name on the onsite walk-up location queue wall monitor. The user with an appointment appears on the monitor a short time before the appointment is scheduled to begin.

Procedure

1. Navigate to **CSM Walk-up Experience > Technician > Scheduled Appointments**.
   All walk-up appointments scheduled for the upcoming 14 days display.

2. Click an appointment number to view details, such as the requester name, the interaction number and description, and the appointment time.

   a. If desired, to preview the associated interaction details, click the preview record icon next to the appointment number.

   b. To begin working on the interaction, click **Accept appointment** on the **Walk-up Appointment** form.

      If necessary, you can assign the appointment to an agent and add work notes.

      If a significant amount of time has passed and the requester does not show up for the appointment, you can delete the appointment by clicking **delete**.

   c. Click **Update** to save any changes you make to the interaction form.

Using Auto-Responder for case deflections

Deflect cases by automatically sending relevant content through the Auto-Responder feature after a customer contact or consumer creates a case.

Whenever a case is created, the Auto-Responder feature sends an email notification containing a list of relevant knowledge articles. The email notifications are sent to the case submitter and watchlist users associated with the case.

By default, the feature sends the email notification for customer service cases logged using emails by users with the snc_external role. Your administrator can also configure the feature for customer service cases logged using other
communication channels such as web, phone, chat, social, community, alert, and virtual agent.

The knowledge articles in an Auto-Responder email notification are included based on contextual search results of the short description of the case. By default, the articles that a case submitter viewed in the last 30 days aren’t included. Your administrator can configure the duration of last viewed content by using a scripted extension point. For more information, see Include advanced contextual search results in Auto-Responder notifications.

As a case submitter or watchlist user, you can determine whether you receive any Auto-Responder notifications by setting notification preferences. For more information, see Set Auto-Responder notification preferences.

**Activation information**

Activate the Predictive Intelligence for Customer Service Management plugin (com.snc.csm_ml) and enable the **Enable auto-responder recommendations** property (sn_customerservice.case.autoresponder.enable). For more information, see Configure Auto-Responder notifications.

**Close a case from a knowledge article recommended in an Auto-Responder notification**

View knowledge articles included in the email notification sent by the Auto-Responder feature for a customer service case and close the case from within a helpful knowledge article.

**Before you begin**

Log in to your portal containing the case.

Role required: snc_external role or watchlist users associated with the customer service case

**About this task**

By default, the Auto-Responder feature sends knowledge articles as helpful content to solve a customer service case submitted using an email.

**Procedure**

1. Open the knowledge article link from the email notification sent by Auto-Responder.
2. Read the knowledge article to see whether it resolves a case.
3. If the knowledge article provides a solution, in the Related Case section of the article, click Close Case.
4. In the message window that appears, click Close Case.
**Results**
An information message about the case being closed appears. If any case was closed by using a knowledge article link accessed from an Auto-Responder email notification, a **View Case** button appears in that article. Click the button to view the details of the case that was closed.

**Set Auto-Responder notification preferences**
Set notification preferences for receiving Auto-Responder recommendations on customer service cases you submitted or for which you are on the watchlist.

**Before you begin**
Ensure that an administrator has configured the Auto-Responder feature. For more information, see Configure Auto-Responder notifications.

Role required: snc_external role or watchlist users associated with the customer service case

**Procedure**
1. Navigate to your portal page.
2. Click your username or photo in the portal header, and then click **Profile**.
3. On the User Profile page, scroll down to the Actions section, and click **Notification Preferences**.
4. On the Notification Preference window, select or clear the **Case auto-responder recommendations** check box to turn the Auto-Responder notifications on or off for you.

**Using Outsourced Customer Service**
Outsourced Service Providers (OSPs) are organizations that an enterprise engages to provide customer service to external customers. The OSPs manage cases for customers associated to their organization.

**Before you begin**
Roles required: There are various roles required based on the tasks you perform.

**Roles required**

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_csm_ocs.ext_manager (external OSP manager)</td>
<td>Onboards or offboards agents from service providers they belong to along with managing case assignments.</td>
</tr>
</tbody>
</table>
Roles required (continued)

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_csm_ocs.ext_agent (external OSP agent)</td>
<td>Can fulfill the cases belonging to the service provider organization they belong to.</td>
</tr>
<tr>
<td>sn_csm_ocs.manager (internal OSP manager)</td>
<td>Manages and monitors all the activities performed by OSPs. The manager can also access the OSP dashboards and act as an internal point of contact for the organization.</td>
</tr>
</tbody>
</table>

Related information

- Outsourced Service Provider manager tasks
- Outsourced Service Provider agent tasks
- Configure Outsourced Customer Service
- Outsourced Customer Service
- Outsourced Customer Service dashboard

Outsourced Service Provider manager tasks

As an OSP manager you can perform various tasks such as onboarding OSP agents, viewing unassigned cases, and assigning cases to groups or agents managed by you.

Related information

- Onboard Outsourced Service Provider agent
- Assign a case to an agent

Onboard Outsourced Service Provider agent

An OSP manager can onboard OSP agents to manage and fulfill cases.

Before you begin

Role required: sn_csm_ocs.ext_manager

Procedure

1. Navigate to **Outsourced Customer Service > Onboard Agent**.
2. Fill in the fields on the Onboard Outsourced Service Provider agent or manager form, as appropriate.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td>The first name of the agent.</td>
</tr>
<tr>
<td>Last Name</td>
<td>The last name of the OSP agent.</td>
</tr>
<tr>
<td>User ID</td>
<td>A unique ID for the OSP agent.</td>
</tr>
<tr>
<td>Email</td>
<td>The OSP agent's email address.</td>
</tr>
<tr>
<td>Mobile Phone</td>
<td>The OSP agent's mobile phone number.</td>
</tr>
<tr>
<td>Business Phone</td>
<td>The OSP agent's business phone number.</td>
</tr>
<tr>
<td>Assignment Group</td>
<td>Select the group to which you belong.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

ℹ️ **Note:**

Once onboarding is complete, a password reset email is sent to the agent's email address.

**Assign a case to an agent**

As an Outsourced Customer Service external manager you can assign a case to an agent under your group.

**Before you begin**

Role required: sn_csm_ocs.ext_manager

**Procedure**

1. Navigate to **Outsourced Customer Service > Cases > Unassigned**.
2. Open a case.
3. Enter the name of the agent in the **Assigned to** field and select the agent from the list displayed. You can also click the Lookup using list icon (🔍) and select the agent.

ℹ️ **Note:** The **Assignment group** field is pre-populated with the group name. The list of agents belonging to that group is displayed when you lookup.

4. Click **Update**.
Outsourced Service Provider agent tasks
OSP agents can perform various tasks such as managing cases, scheduling appointments and so on.

Create work order
An OSP agent can create a work order so that it can be assigned to a Field Service agent.

Before you begin
Role required: sn_csm_ocs.ext_agent and you must have installed Customer Service Management with Field Service Management plugin.

Procedure
1. Go to My Cases and open a case.
2. Click Work Orders related list.
3. Click New.
4.
5. Click Submit.
6. View work order status to update the customer of the status.

Note: You cannot create a new work order until the previous one is closed or deleted.

Escalate a case
An OSP agent can escalate a case when unable to resolve or fulfil a case for various reasons such as

Before you begin
Role required: sn_csm_ocs.ext_agent

Procedure
1. Navigate to Outsourced Customer Service > Cases > My Cases.
2. Click Escalate Case related link.
3. Fill in the fields on the Escalation form, as appropriate.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Request Source</td>
<td>If Customer or Internal</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Reason</td>
<td>Reason for escalation such as inactivity, lack of progress, or customer-imposed deadline.</td>
</tr>
<tr>
<td>Escalation Severity</td>
<td>Severity of escalation such as high, medium, and so on.</td>
</tr>
<tr>
<td>Escalation Template</td>
<td>An escalation template determines how an escalation request is processed.</td>
</tr>
<tr>
<td>Watch list</td>
<td>Add users to the escalation template watch list. These users receive notifications for all escalations that use this escalation template.</td>
</tr>
<tr>
<td>Escalation Justification</td>
<td>Additional information that explains why this escalation is needed.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**View account or consumer assets**

An OSP agent can view the assets owned by an account or consumer which helps in creating or fulfilling a case.

**Before you begin**

Role required: sn_csm_ocs.ext_agent

**Procedure**

1. Navigate to **Outsourced Customer Service > Cases**.

2. Open a case and click the preview icon next to the **Account** or **Consumer** field.

3. Click **Open Record**.

4. Click **Assets** related list. The list of assets belonging to the account or consumer is visible.

5. Click on an asset to view the read-only fields.

**View account contracts**

As an OSP agent, you can view contracts owned by accounts or consumers in order to create or fulfill a case.
Before you begin
Role required: sn_csm_ocs.ext_manager/sn_csm_ocs.ext_agent

Procedure
1. Open the case form.
2. Click the Preview icon next to the Account or Consumer field.
3. Click Contracts related list.
4. View the list of assets belonging to an account or consumer and fulfill a case.

View customer or consumer data
As an OSP agent, you must view the customer or consumer data to fulfill cases.

Before you begin
Role required: sn_csm_ocs.ext_manager or sn_csm_ocs.ext_agent

Procedure
1. Navigate to Outsourced Customer Service > Cases > All.
2. Open a case and click the preview icon next to the Account or Contact field.
3. Click Open Record.
   The following related lists are visible for you to work on and fulfill the cases:
   • Contacts
   • Addresses
   • Cases
   • Assets
   • Contracts
   • Entitlements
   • Account Relationships
   • Sold Products and
   • Install Base

Create a case task
An OSP agent creates a case task after a case has been assigned. As an agent, you can work on the case adding work notes and additional comments.

Before you begin
Role required: sn_csm_ocs.ext_agent
Procedure

1. Navigate to **Outsourced Customer Service > Cases > My Cases** and open a case.

   ❗ **Note:** The timeline of the case is displayed at the top of the case form.

2. Click **Tasks** related list.

3. Click **New** to create a new task.
   The **Edit** button allows you to add existing case tasks to a case from the **Collection** list.

4. Fill in the fields on the new record form, as appropriate.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject</td>
<td>Subject for the case.</td>
</tr>
<tr>
<td>Description</td>
<td>Description for the case.</td>
</tr>
<tr>
<td>Work notes list</td>
<td>Work notes for the case</td>
</tr>
<tr>
<td>Email address</td>
<td>Email id of the customer.</td>
</tr>
<tr>
<td>Additional comments</td>
<td>Comments related to the case, if any.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

   ❗ **Note:** You can also close the case task.

Assign a case

Assign cases to yourself, work on them, and fulfill cases.

**Before you begin**
Role required: sn_csm_ocs.ext_agent

Procedure

1. Navigate to **Outsourced Customer Service > Cases > All.**

2. Click and open a case from the available list.

3. Click **Assign to me**.
   The case is assigned to you.

   ❗ **Note:** The **Assign to me** button is not available if a case is already assigned.
Create an appointment
As an agent, you can make an appointment with the requester of a case.

Before you begin
Role required: sn_csm_ocs.ext_manager or sn_csm_ocs.ext_agent

Procedure
1. Navigate to Outsourced Customer Service > My Cases.
2. Open a case.
3. Click Appointments related list.
4. Fill in the fields on the Appointment form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>The customer's name.</td>
</tr>
<tr>
<td>Enter email address</td>
<td>Email id of the customer.</td>
</tr>
<tr>
<td>Start time</td>
<td>Select the start time and date.</td>
</tr>
<tr>
<td>End time</td>
<td>Select the end time and date.</td>
</tr>
<tr>
<td>Reminder (minutes)</td>
<td>Select reminder for the appointment.</td>
</tr>
<tr>
<td>Subject</td>
<td>Enter the subject</td>
</tr>
<tr>
<td>Location</td>
<td>Enter location.</td>
</tr>
<tr>
<td>Message</td>
<td>Enter message for the appointment.</td>
</tr>
</tbody>
</table>

5. Click Submit and the appointment appears under Appointments related list in Ready state.
6. Edit the appointment and click Send activity to send the appointment to the specified email address.

⚠️ Note: You can also cancel the appointment using the Cancel appointment related link.

Transfer a case
The OSP agent or manager, if unable to resolve a case, transfers the case manually to an enterprise's internal agent.
Before you begin
Role required: sn_csm_ocs.ext_manager or sn_csm_ocs.ext_agent

About this task
You can transfer a case by selecting the reason for transfer, adding transfer notes, and transfer the case manually. The case is transferred based on the default assignment group setup while defining an OSP. Else, the case is transferred based on AWA or assignment rules, that have been previously setup.

Procedure
1. Navigate to **Outsourced Customer Service > Cases > My Cases**.
2. Open a case that you want to transfer.
3. Click **Transfer Case**.
4. Select the reason for transferring the case from the **Reason** drop-down list.
5. Enter additional information regarding the case in the **Notes** field.
6. Click **Save**.
   The case is transferred successfully to the enterprise’s internal manager.
   When you go back to **All** cases and view the case, you can view the transfer information under **Outsourced Case Transfer Request** related list.

View cases
As an OSP manager or agent, you must be able to view all application modules with the list of cases for customers, consumers, and products served by your organization.

Before you begin
Role required: sn_csm_ocs.ext_manager or sn_csm_ocs.ext_agent

Procedure
1. Navigate to **Outsourced Customer Service > Cases**.
   You must be able to see **My Cases**, **All**, **Open**, and **Unassigned** cases. Users who are not authorised or who do not belong to this OSP will not see any case.

   Note: As an OSP manager you can view cases that are assigned to groups you manage.

2. Click **All**, open a case and assign the case to yourself.
   The **Assigned to** field is pre-filled with your name.
View account contracts
As an OSP agent, you can view contracts owned by accounts or consumers in order to create or fulfill a case.

Before you begin
Role required: sn_csm_ocs.ext_manager/sn_csm_ocs.ext_agent

Procedure
1. Open the case form.
2. Click the Preview icon next to the Account or Consumer field.
3. Click Contracts related list.
4. View the list of assets belonging to an account or consumer and fulfill a case.

View case related emails and respond
As an OSP agent, you can view the list of emails related to a case that is assigned to you. You can respond to a case by creating a new email and sending it to the stakeholders.

Before you begin
Role required: sn_csm_ocs.ext_agent

Procedure
1. Navigate to Outsourced Customer Service > Cases > My Cases.
2. Open a case you want to respond to.
3. Click Emails related list.
   The list of emails sent earlier if any, are displayed.
4. Click New Email to create a new email.
   The recipient fields are pre-filled. You can add additional recipients if required.
5. Enter the body text in the Compose Email window.
6. Click the attachment icon (_attach) if you want to add an attachment to the email.
7. Click Send.

Report knowledge gap from a case
An OSP agent can report a knowledge gap for a case.

Before you begin
Role required: sn_csm_ocs.ext_agent.
Procedure
1. Navigate to Outsourced Customer Service > Cases > My Cases.
2. Open a case.
3. Is knowledge available for the case in the Knowledge Gaps related list.
5. Enter the description.
6. Click Submit.
   A knowledge gap is created and you can view it under the Knowledge Gaps related list.

Propose a major case
As an OSP agent, you can propose a major case from the existing customer service case assigned to you.

Before you begin
Role required: sn_csm_ocs.ext_agent

About this task
Cases in these states can be proposed as a major case candidate:
- New
- Open
- Awaiting Info

Cases that are Resolved, Closed, or Canceled cannot be proposed as a major case candidate.

When proposing a case as a major case candidate, agents can specify the reason or justification for the case in the Propose Major Case popup window. Information provided in the Work notes and Business Impact fields are added to the Case form.

Procedure
1. Navigate to Outsourced Customer Service > Cases > My Cases.
2. Open a case.
3. Right click on the case form.
4. Click Propose Major Case.
5. In the Propose Major Case pop-up window, enter a reason for the proposal in the Work notes field. If desired, enter the business impact of the selected case in the Business Impact field. This information is added to the Case form in the Work notes field and the Business Impact field in the Major Case Information section.

6. Click Propose. An entry is added to the Work notes on the Case form that the case was proposed as a major case candidate. The information entered in the Propose Major Case pop-up window is also added to the Case form.

Close a case

Users with OSP agent role can propose a solution to a case and close the assigned cases.

Before you begin
Role required: sn_csm_ocs.ext_agent

Procedure

1. Navigate to Outsourced Customer Service > Cases > My Cases.
2. Open a case.
3. Click the Closure information tab on the case form.
4. Select the Resolution code from the drop-down list.
5. Enter the cause for resolution and notes if any in the Cause and Resolution notes fields.
6. Select the Add resolution notes to comments check box, if desired.
7. Click Close Case.
   The case state changes to Closed state.

Contextual search

Users with OSP agent role can search for related information to fulfil a case. The search results returned are the list of entities that the agent is entitled to as per the data governance.

Before you begin
Role required: sn_csm_ocs.ext_agent
Procedure

1. Navigate to **Outsourced Customer Service > Cases > All.**
2. Open a case. See related search results as per the case description.

**View list of entitlements**

As an OSP manager or agent, you must view entitlements for an account or consumer to create or fulfill cases.

**Before you begin**

Role required: sn_csm_ocs.ext_manager or sn_csm_ocs.ext_agent

Procedure

1. Navigate to **Outsourced Customer Service > Cases > All.**
2. Open a case and click the preview icon next to the **Account** field. The customer account page is displayed.
3. Click **Entitlements** related list.
4. Open an entitlement and view the asset details to fulfill a case.

**Using Chat Zoom Connector**

Initiate a Zoom meeting directly from a chat by using the Chat Zoom Connector application.

As an agent you can initiate a Zoom meeting from a chat to understand and resolve customer issues faster through live interactions. For more information, see Initiate Zoom meetings from chats.

By default, for each interaction record for a Zoom meeting, a Notify conference call number is also generated. As an agent, you or the agent manager can access the recording URL of the Zoom meeting from the activity stream of the interaction record. For more information, see Interaction records in Agent Workspace.

As an agent manager, you can access the details of Zoom meetings initiated from a customer chat using the Zoom interaction record. The meeting recordings are available in the interaction record created for Zoom. For more information, see View details for Zoom meetings initiated from chats.

⚠️ **Note:** The conference call details of a Zoom meeting are stored in the Notify Conference Calls [notify_conference_call] table.

As a user in the notify_admin or notify_view role, you can access the details of a Zoom meeting by navigating to **Notify > Recordings,** and selecting the
corresponding conference call number. For more information, see Notify conference calls.

**Chat Zoom Connector user roles**

The users with the roles listed in the following table can use the Chat Zoom Connector application.

<table>
<thead>
<tr>
<th>Roles</th>
<th>Tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>agent_workspace_user</td>
<td>Initiate a Zoom meeting from a chat to understand customer issues and resolve issues faster through live interactions.</td>
</tr>
<tr>
<td>sn_customerservice_manager</td>
<td>View details for Zoom meetings initiated from a customer chat using the Zoom interaction record. The meeting recordings are available in the interaction record created for Zoom meetings.</td>
</tr>
<tr>
<td>notify_admin, notify_view</td>
<td>View details for Zoom meetings initiated from a customer chat by using Notify.</td>
</tr>
</tbody>
</table>

**Activation information**

Configure the Chat Zoom Connector application for initiating Zoom meetings from customer chats. For more information, see Configure Chat Zoom Connector.

**Related information**

Chat Zoom Connector

**Initiate Zoom meetings from chats**

Resolve issues faster by initiating a Zoom meeting directly from a customer chat using the Chat Zoom Connector application.

**Before you begin**

Ensure that an administrator has installed and set up the Chat Zoom Connector application. For more information, see Configure Chat Zoom Connector.

Role required: agent_workspace_user

**About this task**

You can use a Zoom meeting to host a screen-sharing or video conference. You can also record the meeting and save the recordings.
Procedure

1. Navigate to Agent Workspace.

2. Accept and respond to a chat from your agent inbox.

3. Optional: Ask questions and find out more about the issue.

4. To start a Zoom session with a customer, click the quick actions icon (/gif), and then select /zoom.

   Tip: You can also enter /zoom in the text field of the chat.

5. Click the send icon (').'</a>

   A message announcing that the Zoom meeting has started and one containing the meeting URL are posted in the chat window for both agent and customer. If the session was initiated through the Private Chat tab, the session's URL isn't shared with the customer.

6. Click the URL to host the Zoom meeting and request the customer to click the URL too.
   As a host of the meeting, you can admit participants by sharing the meeting URL with them. The number of participants you can admit depends on your Zoom account settings.

   The meeting topic is set to the number of the associated chat interaction record. The meeting description is set to the short description of the associated chat interaction record. If the short description of the associated chat interaction record is empty, the meeting description is shown as a dash (-).

7. Optional: Record the meeting.
   For more information, see the Zoom Help Center.

Results

An interaction record of type Zoom is generated for the meeting that captures the Notify conference call details for this Zoom session. A Notify administrator or agent manager can access the conference call details associated with the Zoom meeting from the interaction record.

Note: The conference call number is a value automatically generated in the Channel Metadata Record field on the Interaction form. For more information, see View details for Zoom meetings initiated from chats.

The recording URL of the Zoom meeting is added to the activity stream of the interaction record. For more information, see Interaction records in Agent Workspace.
View details for Zoom meetings initiated from chats

View details for a Zoom meeting initiated from a chat by accessing the associated interaction record.

Before you begin
Role required: sn_customerservice_manager

About this task
This task provides steps for a user with the sn_customerservice_manager role to access Zoom meeting details from an interaction record. For information about how users with other Notify roles view Zoom meeting details, see Using Chat Zoom Connector.

Procedure
1. Navigate to Interaction > All.
2. In the Interactions list, click the link to an interaction record of type Zoom from the Number column.

Results
The recording URL of the Zoom meeting, if available, is added as a work note and displayed in the activity stream of the Interaction form. On the Interaction form, you can view the details for a Zoom meeting.

Note: Your administrator might have configured the interaction record to show different application-specific field values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Unique number to identify the interaction record.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of channel communication. For a Zoom meeting, the field is automatically set to Zoom.</td>
</tr>
<tr>
<td>State</td>
<td>Different states through which the interaction proceeds for a resolution.</td>
</tr>
<tr>
<td>Opened for</td>
<td>Customer contact or consumer for whom the Zoom meeting was initiated. This field is automatically set to the Opened for field</td>
</tr>
</tbody>
</table>
### Interaction form (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Assigned to</strong></td>
<td>Agent the interaction record is assigned to. This field is automatically set to the <strong>Assigned to</strong> field value from the chat interaction record from which the Zoom meeting was initiated.</td>
</tr>
<tr>
<td><strong>Parent</strong></td>
<td>Number of the chat interaction record from which this Zoom meeting was initiated. This field is automatically set to the number of the chat interaction record. You may need to configure the form to add this field. For more information, see Configure the form layout.</td>
</tr>
<tr>
<td><strong>Channel Metadata Record</strong></td>
<td>Number of the Notify conference call. This field is automatically set to a conference call number associated with this meeting and stored in the Notify Conference Calls [notify_conference_call] table. Note: To view more details such as the meeting URL and participant details, click the preview this record icon (𐌀) for this field. You may need to configure the form to add this field. For more information, see Configure the form layout.</td>
</tr>
<tr>
<td><strong>Channel Metadata Table</strong></td>
<td>Table containing a list of conference calls started using Notify. This field is automatically set to <strong>Notify Conference Calls [notify_conference_call]</strong>. You may need to configure the form to add this field. For more information, see Configure the form layout.</td>
</tr>
<tr>
<td><strong>Consumer</strong></td>
<td>Consumer’s account automatically set to the <strong>Consumer</strong> field value from the chat.</td>
</tr>
</tbody>
</table>
Interaction form (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>interaction record from which the Zoom meeting was initiated. You may need to configure the form to add this field. For more information, see Configure the form layout.</td>
<td></td>
</tr>
<tr>
<td>Contact</td>
<td>Customer contact automatically set to the Contact field value from the chat interaction record from which the Zoom meeting was initiated. You may need to configure the form to add this field. For more information, see Configure the form layout.</td>
</tr>
<tr>
<td>Account</td>
<td>User's account automatically set to the Account field value from the chat interaction record from which the Zoom meeting was initiated. You may need to configure the form to add this field. For more information, see Configure the form layout.</td>
</tr>
<tr>
<td>Short Description</td>
<td>Short description of the interaction.</td>
</tr>
<tr>
<td>Note: The short description field is empty for a Zoom meeting.</td>
<td></td>
</tr>
</tbody>
</table>

Related information

Initiate Zoom meetings from chats

Using Microsoft Outlook with CSM

Integrate Customer Service Management with Microsoft Outlook to perform tasks such as managing contacts and cases from within Microsoft Outlook.

View Microsoft Outlook customer contact details in your ServiceNow instance

Once you have integrated Customer Service Management (CSM) with Microsoft Outlook, you can view customer details in an Outlook add-in panel to make communication easier.

Before you begin

Role required: sn_customerservice.contact_manager, sn_customerservice.proxy_contact
Procedure

1. In Microsoft Outlook, open an email message you received from the contact.
2. On the Microsoft Outlook Home tab, click View in ServiceNow.

   The Outlook add-in panel displays the contact details.

   Note: If the contact details are not available, the No contact was found message is displayed.

3. Optional: If you want to perform other contact tasks, access the contact information in the CSM portal page by clicking the Pop-out icon ( ).

Create a contact in Microsoft Outlook

As an account manager, you can create a new contact when you receive an email from a customer whose details are not in the Microsoft Outlook contacts list.

Before you begin
Role required: sn_customerservice.contact_manager and sn_customerservice.proxy_contact

Procedure

1. Open an email message you received from the contact.
2. On the Microsoft Outlook Home tab, click View in ServiceNow.

   The contact details are not available and the Outlook add-in panel displays the No contact was found message.

3. Click the more actions icon ( ) and select Create Contact.
4. Fill in the contact details in the case form and click Submit.
5. Optional: If you want to perform other contact tasks, access the CSM portal by clicking the Pop-out icon ( ).

View or modify existing cases in Microsoft Outlook

As an account manager, view the five most recent cases related to a Microsoft Outlook contact to understand contact-related issues, modify any case information, and communicate more efficiently with the contact.

Before you begin
Role required: sn_customerservice.contact_manager and sn_customerservice.proxy_contact
About this task
Although you can view or modify existing cases from Microsoft Outlook, https://servicenow.acrolinx.cloud:443 you can also access the CSM portal to work on open cases by clicking the Pop-out icon ( ).

Procedure
1. Open an email message you received from the contact.
2. On the Microsoft Outlook Home tab, click View in ServiceNow.
3. Click Cases in the Outlook add-in panel.
   The add-in panel lists the five most recent cases connected to the contact that are not closed. You can load more cases.
4. Click a case to open the case details.
5. Type your message.
6. Optional: If you have supporting information such as a message that you want to attach to a case, click the attachment icon ( ) and select the file.
7. Click Send.
   The newly added message is available in the activity stream.

Create a new case in Microsoft Outlook
If a customer whose contact details are available sends an email stating an issue, you can easily check whether a related case exists and check case details. If related case exists, you can create one in Microsoft Outlook.

Before you begin
Role required: sn_customerservice.contact_manager and sn_customerservice.proxy_contact

Procedure
1. Open an email message you received from a customer.
2. On the Microsoft Outlook Home tab, click View in ServiceNow.
   If a message No case was found appears in the Outlook add-in panel, then no cases related to the customer exist.
3. Click the more icon ( ) and select Create Case.
4. Fill in the case details in the case form and click **Submit**.

   Optionally, you can also use the ![icon] icon to view existing cases when you login from the CSM portal page.


With the B2B2C model, organizations across industries can easily configure multi-level customer relationships and support business customers who, in turn, support their end consumers.

Role required: There are various different roles required for Customer Data Models for B2B2C based on the tasks you perform.

<table>
<thead>
<tr>
<th>Role</th>
<th>Tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_customerservice_agent (customer service agent)</td>
<td>Create a case for an account consumer from platform or CSM workspaces to track issues. See <a href="#">Create cases for an account consumer</a>.</td>
</tr>
<tr>
<td>awa_agent and sn_customerservice_agent</td>
<td>Accept a chat request on CSM workspaces and create a case from the chat interaction.</td>
</tr>
</tbody>
</table>
| sn_customerservice_manager (customer service manager) | Associate consumers to an account to identify the end consumers who are using products or services.  
                                                   | Associate install base items/sold products with account consumers to keep track of end consumer issues. |
| sn_acct_consumer.consumer (account consumer)       | View sold products/install bases items to track the instances provisioned for your account and the products or services sold to your account.  
                                                   | Create a case for install base items or sold products issues from the CSM portal. You will get email notifications when a case is created, commented, resolved, or closed. See [Create a case from the CSM portal](#). |
### Roles required (continued)

<table>
<thead>
<tr>
<th>Role</th>
<th>Tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_customerservice.customer (account contact)</td>
<td>View sold products/install bases items to track end consumer issues. See View install base information from the Customer Service Portal and View products information from the Customer Service Portal. Create a case for an account consumer to keep track of consumer issues. See Create cases for an account consumer.</td>
</tr>
</tbody>
</table>

### Associate an account with consumers

Enable customer service managers to identify the end consumers who are using products or services and keep track of customer information.

**Before you begin**

Role required: sn_customerservice_manager

**Procedure**

1. Navigate to Customer Service > Accounts.
2. Select an account.
3. Click the Consumers related list.
4. Click New to add an existing or new consumer.

**Options and procedure**

<table>
<thead>
<tr>
<th>Option</th>
<th>Procedure</th>
</tr>
</thead>
</table>
| Add an existing consumer | a. In the Consumer field, click the Lookup using list icon (🔍).  
b. Select a consumer from the list. |
| Add a new consumer      | a. In the Consumer field, click the Lookup using list icon (🔍).  
b. Click New. |
### Procedure

1. Navigate to **Customer Service > Products > Sold Products**.
2. Select a product that does not have a consumer associated to it yet.
3. Either add an existing consumer or a new one.

### Associate sold products with account consumers

Enable customer service managers to track sold products or services by associating sold products or services with account consumers.

### Before you begin

Role required: sn_customerservice_manager

### Procedure

1. **Option**: Add an existing consumer
   - **Procedure**:
     - a. In the **Consumer** field, click the Lookup using list icon (🔍).
     - b. Select a consumer from the list.

2. **Option**: Add a new consumer
   - **Procedure**:
     - a. In the **Consumer** field, click the Lookup using list icon (🔍).
     - b. Click **New**.
     - c. On the Consumer form, fill in the fields.
     - d. Click **Submit**.

4. **Option**: Update

### Results

The selected consumer is associated with the account.
**Results**
The product is associated with the consumer.

**Associate install base items with account consumers**
Enable customer service managers to track the instances provisioned by associating install base items with account consumers.

**Before you begin**
Role required: sn_customerservice_manager

**Procedure**
1. Navigate to Customer Service > Products > Install Base Items.
2. Select an item that does not have a consumer associated to it yet.
3. Either add an existing consumer or a new one.

**Actions and procedure**

<table>
<thead>
<tr>
<th>Action</th>
<th>Procedure</th>
</tr>
</thead>
</table>
| Add an existing consumer    | a. In the **Consumer** field, click the Lookup using list icon (🔍).  
                               b. Select a consumer from the list. |
| Add a new consumer          | a. In the **Consumer** field, click the Lookup using list icon (🔍).  
                               b. Click **New**.  
                               c. On the Consumer form, fill in the fields.  
                               d. Click **Submit**. |

4. Click **Update** to save your changes.

**View install base information as an account consumer**
Track the instances provisioned for your account and which products or services run on them by viewing a list of install base items.

**Before you begin**
Role required: sn_acct_consumer.consumer
About this task
View the list of install base items information from the Customer Service Portal.

Note: The Entitlements widget and the Contracts widget are not visible for account consumers.

Procedure
1. Navigate to the Customer Service Portal.
2. Click Support > Install Base.
   The system displays a list of install base items that belong to your account.
3. Select an install base to view its details.

   Note: The default view is the form view. If you switch to the list view, the Account and Consumer fields are not displayed. See Configure the Install Base items and Sold Products lists for details.

View sold products information as an account consumer
Track the products or services sold to your account by viewing the list of sold products from the Customer Service Portal.

Before you begin
Role required: sn_acct_consumer.consumer

About this task
View a list of sold products to track the products or services sold to your account.

Note: The Entitlements widget and the Contracts widget are not visible for account consumers.

Procedure
1. Navigate to the Customer Service Portal.
2. Click Support > Products.
   The system displays a list of products that belong to your account.
3. Select a product to view its details.

   Note: The default view is the form view. If you switch to the list view, the Account and Consumer fields are not displayed. See Configure the Install Base items and Sold Products lists for details.
Using the Customer Service Portal

Search for information about a question or an issue, or request assistance from a customer service agent.

Your Customer Service Management Service Portal activity usually begins on the homepage. Organizations usually customize their homepages, and logged-in users often see different information than users who are not logged in.

**Note:** If any active outages exist for your install base, they are displayed on the homepage.

From the Customer Service Portal homepage, you can access and use the following features:

<table>
<thead>
<tr>
<th>Customer Service Portal homepage for logged-in users</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>UI component</strong></td>
</tr>
<tr>
<td>Knowledge</td>
</tr>
<tr>
<td>Requests</td>
</tr>
<tr>
<td>My Lists</td>
</tr>
<tr>
<td>Case</td>
</tr>
<tr>
<td>Support</td>
</tr>
<tr>
<td>Notification</td>
</tr>
<tr>
<td>Tours</td>
</tr>
<tr>
<td>Live Chat</td>
</tr>
<tr>
<td>Profile menu</td>
</tr>
<tr>
<td>UI component</td>
</tr>
<tr>
<td>---------------------------</td>
</tr>
<tr>
<td>Search</td>
</tr>
<tr>
<td>Ask the Community</td>
</tr>
<tr>
<td>Get help</td>
</tr>
<tr>
<td>Request something</td>
</tr>
<tr>
<td>Most viewed articles</td>
</tr>
<tr>
<td>Featured articles</td>
</tr>
<tr>
<td>Most useful articles</td>
</tr>
<tr>
<td>The following components</td>
</tr>
<tr>
<td>Recent solved discussion</td>
</tr>
<tr>
<td>Recent community blog</td>
</tr>
<tr>
<td>Community featured content</td>
</tr>
</tbody>
</table>

**Note:** You can view the metadata for each entry in the widgets, such as the number of views, number of days from the time the article or feature was published, and rating for the article.
Manage contacts from the customer portal

Users with the customer administrator role can create and update customer contacts; assign roles to contacts; and create, enable, or disable contact logins from the customer portal.

Administrators can also reset a password for a contact from the customer portal based on the Content Management System (CMS). The Customer Service Portal does not support the password reset feature. The system administrator can change and reset passwords using the ServiceNow Password Reset and Password Change applications.

*i Note:* The Related Links section at the bottom of the Contacts page includes several Service Portal links that are not currently supported by the Customer Service Portal.

Create a customer contact

Create a customer contact from the customer portal.

**Before you begin**

Role required: sn_customerservice.customer_admin, sn_customerservice.partner_admin, or admin

**Procedure**

1. Click Support > Contacts in the portal header.
2. From the Contacts list, click New.
3. Fill in the fields on the Contact form, as appropriate.

Contact form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First name</td>
<td>Customer's first name.</td>
</tr>
<tr>
<td>Last name</td>
<td>Customer's last name.</td>
</tr>
<tr>
<td>Title</td>
<td>Customer's job title.</td>
</tr>
<tr>
<td>Language</td>
<td>The language for this customer.</td>
</tr>
<tr>
<td>Time zone</td>
<td>The time zone for this customer's location.</td>
</tr>
<tr>
<td>Account</td>
<td>The user's account.</td>
</tr>
<tr>
<td>Email</td>
<td>Customer's email address</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Business phone</td>
<td>Customer's business phone.</td>
</tr>
<tr>
<td>Mobile phone</td>
<td>Customer's mobile phone.</td>
</tr>
<tr>
<td>Notification</td>
<td>Enable or disable notifications for this customer.</td>
</tr>
<tr>
<td></td>
<td>This field is displayed after you click <strong>Submit</strong> and create the contact.</td>
</tr>
<tr>
<td>User ID</td>
<td>A unique identifier for this user. The user ID should follow the format <strong>firstname.lastname</strong>.</td>
</tr>
<tr>
<td></td>
<td>This field is displayed after you click <strong>Submit</strong> and create the contact.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.
   After you create a new contact, you can create a login for the contact and enable or disable notifications.

Create a login for a new contact
After creating a new contact, you can create a login for that contact.

**Before you begin**
Role required: sn_customerservice.customer_admin, sn_customerservice.partner_admin, or admin

**Procedure**
1. Click **Manage Users** in the portal header.
2. Select the new contact from the Contacts list.
3. Click the **Create Login** related link.
   The system creates a login for this contact and fills in the **User ID** field on the Contact form with the user's first and last name in this format: **firstname.lastname**
   In the event that you create a new contact with the same first and last name as an existing contact, the **User ID** field is left blank and the **Create Login** related link does not appear on the contact form.
   To create a login for this contact, enter a unique login in the **User ID** field on the Contact form and click **Update**.
Update contact information for a user

Update the contact information for a user from the customer portal.

**Before you begin**

Role required: sn_customerservice.customer_admin, sn_customerservice.partner_admin, or admin

**Procedure**

1. Click **Support > Contacts** in the portal header.
2. Select a user from the Contacts list.
3. Make the desired changes to the fields on the Contact form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First name</td>
<td>Customer's first name.</td>
</tr>
<tr>
<td>Last name</td>
<td>Customer's last name.</td>
</tr>
<tr>
<td>Title</td>
<td>Customer's job title.</td>
</tr>
<tr>
<td>Language</td>
<td>The language for this customer.</td>
</tr>
<tr>
<td>Time zone</td>
<td>The time zone for this customer's location.</td>
</tr>
<tr>
<td>Account</td>
<td>The user's account.</td>
</tr>
<tr>
<td>Email</td>
<td>Customer's email address</td>
</tr>
<tr>
<td>Business phone</td>
<td>Customer's business phone.</td>
</tr>
<tr>
<td>Mobile phone</td>
<td>Customer's mobile phone.</td>
</tr>
<tr>
<td>Notification</td>
<td>Enable or disable notifications for this customer.</td>
</tr>
<tr>
<td>User ID</td>
<td>A unique identifier for this user. The user ID should follow the format <code>firstname.lastname</code>.</td>
</tr>
</tbody>
</table>

4. Click **Update**.

**Enable or disable the login for a contact**

Enable or disable the login for a contact.
Before you begin
Role required: sn_customerservice.customer_admin, sn_customerservice.partner_admin, or admin

Procedure
1. Click Manage Users in the portal header.
2. Select a contact from the Contacts list.
3. Click one of the following related links:
   - Disable login
   - Enable login
   If the login for this contact is currently enabled, the Disable login related link is displayed. If currently disabled, the Enable login related link is displayed. The system enables or disables the login for this contact and returns you to the Contact list. A disabled contact cannot access the customer portal.

Assign a user role to a contact
Assign one or more user roles to a contact from the customer portal.

Before you begin
Role required: sn_customerservice.customer_admin, sn_customerservice.partner_admin, or admin

About this task
Use the Edit Role pop-up window to manage the roles for a contact. Contacts must have at least one assigned user role. If there are no roles in the Selected column on the pop-up window, you cannot update the record.

Note: The roles available in the Edit Role pop-up window are configured using the sn_customerservice.contact_role_assignment property.

Procedure
1. Click Contacts in the Customer Service Portal header.
2. Select a user from the Contacts list.
3. Click the Edit Roles related link.
4. In the Edit Role pop-up window, select a role in the Available column and move it to the Selected column.
5. Click Update on the Edit Role pop-up window.
Note: If there are no roles in the Selected column, the system displays an error message and the column resets to display the originally assigned roles.

6. Click Save on the Contact form.

Reset a password for a contact
Reset a password for a contact from the customer portal.

Before you begin
Role required: admin

About this task
When you reset a password for a contact, the system sends an email to the contact that includes a new temporary password. The customer is asked to change this temporary password at the next login.

Note: Administrators can reset a password for a contact from the customer portal based on the Content Management System (CMS). The Customer Service Portal does not support the password reset feature.

Procedure
1. Click Manage Users in the portal header.
2. Select a contact from the Contacts list.
3. Click the Reset a password related link.
   This brings up the Password Reset Assistance dialog box.
4. Ensure that the correct user name is displayed in the Select User field.
5. Select a process in the Select process field.
6. Click Verify Identity.

Manage customer registration requests
Users with the customer administrator role can approve or reject registration requests that customers submit from the Customer Service Portal.

Approve a registration request with a valid registration code
Approve a registration request from a user that was submitted from the Customer Service Portal with a valid registration code.
Before you begin
Role required: sn_customerservice.customer_admin

Procedure
1. Navigate to the customer portal.
2. Click Approvals.
   The Approvals list displays registration requests with these states: Requested and No Longer Required.
3. Click a request in the Approvals list with a state of Requested.
4. If desired, add any Comments to this request.
5. Click Approve.
   A user account is created and an email is sent to the contact’s email address with a user ID and temporary password. The user is also assigned these roles: sn_esm_user and snc_external.

Approve a registration request with an invalid registration code
Approve a registration request from a user that was submitted from the Customer Service Portal with an invalid registration code.

Before you begin
Role required: sn_customerservice.customer_admin

Procedure
1. Navigate to Customer Service > Administration > Pending Contact Registrations.
2. Select a registration request with a state of Pending.
3. Select an Account for the requester.
4. Click Update.
   The registration request is sent to the customer administrator of the assigned account.

Reject a registration request
Reject a registration request from a user that was submitted from the Customer Service Portal.

Before you begin
Role required: sn_customerservice.customer_admin
Procedure
1. Navigate to the customer portal.
2. Click **My Approvals**.
3. Click a request in the Approvals list with a state of **Requested**.
4. Click **Reject**.
   An email regarding the rejection is sent to the requestor’s email address.

Assign a contact to an asset from the customer portal
Users with the customer administrator role can assign a contact to an asset from the customer portal.

**Before you begin**
Role required: sn_customerservice.customer_admin

Procedure
1. Log in to the customer portal.
2. Click **Support > Assets** from the portal header menu.
3. Click the desired asset.
4. Click **New** in the **Asset Contacts** related list.
   This displays a new Asset Contact form. The **Asset** field displays the selected asset and is read-only.
5. Select a **Contact**.
   The contacts available for selection are the contacts from the asset’s account.
6. Click **Submit**.
   The contact is added to the **Asset Contacts** related list.

Search for information using the customer portal
Use the search feature on the customer portal to find information about a question or an issue.

**Before you begin**
Role required: sn_customerservice.customer,
sn_customerservice.customer_admin, sn_customerservice.partner, or
sn_customerservice.partner_admin
About this task
The portal has a search feature that you can use to search for information across several repositories. Enter a search term in the Search field and then click Search to display a list of related articles.

Procedure
1. Enter a search term into the Search field.
2. Click Search.
   A list of articles related to the search term is displayed.
3. Click a link to view an article.

Search the knowledge base
Use the customer portal to search the knowledge base or view a list of popular knowledge base articles.

Before you begin
Role required: sn_customerservice.customer, sn_customerservice.customer_admin, sn_customerservice.partner, or sn_customerservice.partner_admin

About this task
The customer service portal includes a link to the knowledge base that you can use to search for information, read and rate articles, and submit feedback. Under this link, the portal displays a list of popular knowledge base articles. If the information that you need is not included in this list, you can search the knowledge base for the desired information.

Procedure
1. Navigate to the customer service portal.
2. Click Knowledge.
   The knowledge page displays a separate category for each of the products purchased by this customer. It also displays lists of articles by:
   - Featured content
   - Most useful
   - Most viewed
3. Do one of the following:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click a product to display more specific informa-</td>
<td>Displays a list of categories on the left and articles on the right. Click a category to drill down even further.</td>
</tr>
<tr>
<td>tion</td>
<td></td>
</tr>
<tr>
<td>Click a link from one of the lists</td>
<td>Displays the article.</td>
</tr>
<tr>
<td>Type a topic in the Search field and press the</td>
<td>Displays a list of related articles. Click a link to display the desired article.</td>
</tr>
<tr>
<td>Enter key</td>
<td></td>
</tr>
</tbody>
</table>

**Search the customer service community**

Use the customer service portal to search the community site or view a list of recent discussion topics.

**Before you begin**

Role required: sn_customerservice.customer, sn_customerservice.customer_admin, sn_customerservice.partner, or sn_customerservice.partner_admin

**Procedure**

1. Navigate to the customer service portal.
2. Click **Ask the Community**.
   - This brings up the Ask a Question page.
3. Enter a question in the **Title** field.
4. Select a knowledge base in the **Knowledge Base** field.
5. If desired, select a category in the **Category** field.
6. If desired, add one or more tags to your question in the **Tags** field.
7. Click **Post Question**.
   - The question appears on the search results page under the **Questions** category.

**Deflect cases with knowledge and community content**

Enable customers to search for information from the knowledge base and community and find solutions to their issues.

**Before you begin**

Role required: sn_customerservice_customer or sn_customerservice_consumer
About this task
The Service Portal Case form displays contextual search results based on text entered in the Subject field. These search results provide targeted solutions to customers. Customers can search for information that is related to a case when opening a case. If the search results in any related content, the customer can preview the content.

Note: By default, search results include knowledge articles, solved community questions and blogs, and pinned articles.

Procedure
1. Navigate to the Customer Service Management Service Portal and then Support > New Cases.
2. Click Product Case or Order Case.
3. Start typing in the Subject field.
   If there are any search results that match, they are displayed in the Related Search Results widget.

   Note: If embedded search has been enabled, the results are displayed inline in the Case form in a Knowledge results section and are read-only.

4. Perform one of the following actions.
   • Click one of the content links in the Related Search Results widget to enter the content directly.
   • Click one of the content links in the embedded Knowledge results section to open the content inline as read-only.

5. Optional: Click This helped to mark the content as helpful for resolving the associated case.
6. Click Submit.

View asset information from the Customer Service Portal
View a list of assets for the current user's account.

Before you begin
Role required: sn_customerservice.customer, sn_customerservice.customer_admin, sn_customerservice.partner, or sn_customerservice.partner_admin
Procedure

1. Click **Support > Assets** in the portal header. This displays a list of assets that belong to the current user's account, including the name and serial number of the asset and the product model category and account to which it belongs.

2. Click one of the following to view more information.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Displays the asset information.</td>
</tr>
<tr>
<td>Account</td>
<td>Displays the account information.</td>
</tr>
<tr>
<td>Model category</td>
<td>Displays the product model information for this asset.</td>
</tr>
</tbody>
</table>

3. Click the Back button to return to the list of assets.

View or update customer contact information

View or update your contact information from the customer portal.

Before you begin
Role required: sn_customerservice.customer, sn_customerservice.customer_admin, sn_customerservice.partner, or sn_customerservice.partner_admin

Procedure

1. Click your user name in the portal header to display your contact information.

2. Make any desired changes to the fields on the Contact form.

Contact form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First name</td>
<td>Customer's first name.</td>
</tr>
<tr>
<td>Last name</td>
<td>Customer's last name.</td>
</tr>
<tr>
<td>Title</td>
<td>Customer's job title.</td>
</tr>
<tr>
<td>Language</td>
<td>The language for this customer.</td>
</tr>
<tr>
<td>Time zone</td>
<td>The time zone for this customer's location.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Account</td>
<td>The user's account.</td>
</tr>
<tr>
<td>Email</td>
<td>Customer's email address</td>
</tr>
<tr>
<td>Business phone</td>
<td>Customer's business phone.</td>
</tr>
<tr>
<td>Mobile phone</td>
<td>Customer's mobile phone.</td>
</tr>
<tr>
<td>Notification</td>
<td>Enable or disable notifications for this customer.</td>
</tr>
<tr>
<td>User ID</td>
<td>A unique identifier for this user. The user ID should follow the format firstname.lastname.</td>
</tr>
</tbody>
</table>

3. Click Update.

Customer notification preferences

Customers can set preferences for email notifications.

Email notification preferences are set to control email notifications that are sent to the customer when an agent performs one of the following case activities:

- Opens a case for a customer
- Comments on a customer's case
- Provides a resolution for a customer's case
- Closes a customer's case

Set email notification preferences

Customers can set preferences for email notifications that are sent when customer service agents perform different actions on cases.

Before you begin

Ensure that you have received at least one email for the case to set the email notification preferences.

Role required: sn_customerservice.customer, sn_customerservice.customer_admin, sn_customerservice.partner, or sn_customerservice.partner_admin
Procedure

1. Navigate to the customer service portal.
2. Click your user name or photo in the portal header to display your user profile information.
3. Click the Notification Preferences related link to display the Notification Preferences form.

   Note: The Notification Preferences link is available only after receiving the first email for the case.

4. Enable or disable the following email notifications for your primary email address. The notifications are available based on the actions performed by customer service agents on the case.
   • Case closed for customer
   • Case commented for customer
   • Case opened for customer
   • Case resolved for customer

Change your password directly from the Customer Service Portal

Change your password directly from the Customer Service Portal. Users with the required roles can change their passwords from the Customer Service Portal.

Before you begin
Role required: nonen

   Note:

   About this task
Users with the required roles can change their passwords from the Customer Service Portal.

Procedure

1. Click your user name in the portal header to display the user profile information.
2. Click Change Password.
3. Fill in the fields on the Change Password form.
Change Password form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Old Password</td>
<td>The current password. This field is automatically filled in.</td>
</tr>
<tr>
<td>New Password</td>
<td>The new password, which must meet the following requirements:</td>
</tr>
<tr>
<td></td>
<td>• Be a minimum of eight characters long</td>
</tr>
<tr>
<td></td>
<td>• Include at least one uppercase and one lowercase letter</td>
</tr>
<tr>
<td></td>
<td>• Include at least one number</td>
</tr>
<tr>
<td>Retype Password</td>
<td>The new password.</td>
</tr>
</tbody>
</table>

4. Click Change Password.

Contact self-registration

The self-registration feature enables new customer contacts to submit registration requests from the customer portal.

Once the request is submitted, it goes through an approval process and is either accepted or rejected. If accepted, a user account is created and the contact receives an email with a user ID and a temporary password. When logging in to the portal for the first time, the contact is asked to change the temporary password. If rejected, the contact receives an email with this information.

A customer contact can submit a registration request with or without a registration code:

- If a request is submitted with a valid registration code, the contact’s account information is automatically detected and added to the contact record. The request is then sent to the customer administrator of that account for approval. If an account has multiple customer administrators, they all receive the registration request but only one is required to approve it. After a request has been approved, the state of the request changes to **No Longer Required** for the other customer administrators.

- If a request is submitted without a registration code or if the code is incorrect, the request is sent to the system administrator, who fills in the account information. Once this information is filled in, the request is sent to the customer administrator of that account for approval.
The system administrator creates a unique registration code for each account and stores it in the **Registration Code** field on the Account form. Once this code is created, customer administrators can distribute the code to customers as needed.

**Related information**

Example: The default self-service Password Reset process

**Submit a self-registration request**

Submit a registration request from the Customer Service Portal.

**Before you begin**

Role required: none

**Procedure**

1. Navigate to the customer portal login page.
2. Request a login by clicking **Register** from the portal header.
3. Fill in your **First Name**, **Last Name**, **Business Email**, and **Registration Code**.
4. Enable the check box to agree to the privacy policy and to the community terms and conditions.
   Click the links to access more information about these policies.
5. Enable the Security Code check box, complete the CAPTCHA validation, and click **Verify**.
   The Customer Service application uses the Google re-CAPTCHA service.
6. Click **Submit**.
   You are returned to the portal login page.
   If you entered a valid registration code, you see this message: “Your request has been submitted and is pending review. You will receive an email when your request is processed.”
   If the code was incorrect, you see this message: “Incorrect Registration Code.”

**Request a password reset**

If you forget your password, you can request a new password from the customer portal login screen.

**Before you begin**

Role required: none
Procedure
1. Navigate to the customer portal login page.
2. Click the reset your password here link.
3. Enter your User name and Email address.
4. Click Reset Password.
   The user name and email address are validated. If they match, the system
generates a temporary password and sends it to the user's email address.
5. Log in to the customer portal using the temporary password.
   You are required to create a new password before continuing.
6. Enter the new password in the Password field.
7. Enter the new password again in the Validate Password field.
8. Click Submit.

Log in to the Customer Service Portal for the first time
After a registration request is approved, the customer contact receives an email
with a user ID and temporary password. When logging in for the first time, the
contact is asked to change the password.

Before you begin
Role required: none

Procedure
1. Navigate to the Customer Service Portal login page.
2. Enter your user ID in the User name.
3. Enter your temporary password in the Password field.
4. Click Login.
   You are prompted to change your password.
5. Enter your temporary password in the Current Password field.
6. Enter your new password in the New Password field.
7. Re-enter your new password in the Confirm New Password field.
8. Click Submit.

View product information from the Customer Service Portal
View a list of products to track the products or services sold to your account and
manage your services using service catalogs.
Before you begin
Role required: sn_customerservice.customer, sn_customerservice.customer_admin, sn_customerservice.partner, or sn_customerservice.partner_admin

About this task
You can view a list of products or services that have been sold to your account. You can also view any cases created on the product and all active contracts and entitlements for the product.

Note: When the Customer Data Models for B2B2C plugin installed, contacts are able to access the list of sold products belonging to account consumers.

An entitlement is active if:
• Its end date is not in the past or it has no end date.
• The contract it is linked to is also active.

A contract is active if:
• Its state is set to active
• It is linked to a product with an active entitlement.

Note: You can modify the Active Entitlements widget to define your own filters for active entitlements.

If product catalog items have been set up in your instance, you can use the Service Catalogs widget to view context-sensitive service catalogs based on the services you are subscribed to. Extend your services using service catalogs and request additional items on the services you have subscribed to.

Procedure
1. Navigate to the Customer Service homepage.
2. Click Support > Products in the header menu.
   The system displays a list of products or services sold to your account.
3. Click a product to view the details and any cases created on the product in the last 30 days.
4. View all active contracts and entitlements for the sold product.
5. Optional: You can also create a case directly from the product details.
6. Optional: View all catalog items associated to sold products and request additional services, as required.
Create a product case from the Customer Service homepage

Create a case about a question or issue on a product from the Customer Service homepage.

Before you begin
Role required: sn_customerservice.customer, sn_customerservice.partner, sn_customerservice.customer_admin, or sn_customerservice.partner_admin

Procedure
1. Navigate to the Customer Service homepage.
2. Right-click in the form header and choose Case > Create Product Case.

⚠️ Note: Depending on your role, you might not see the Account and Contact fields.

Create Case form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>The account for which the case is being created.</td>
</tr>
<tr>
<td>Contact</td>
<td>The name of the customer contact for this case.</td>
</tr>
<tr>
<td>Consumer</td>
<td>The name of the consumer for this case.</td>
</tr>
</tbody>
</table>

⚠️ Note: This field is active only when the Customer Data Models for B2B2C plugin is installed. Once Account is selected, only consumers belonging to the account are displayed.

<table>
<thead>
<tr>
<th>Asset</th>
<th>The asset tag number or the serial number of the asset associated with this case.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product</td>
<td>The product model of the asset. A model is a specific version or configuration of an asset (for example, Apple Mac Book Pro). If you select an asset in the Asset field, this field is auto-populated if the associated product information is available in the asset record. A product may be associated with multiple assets.</td>
</tr>
<tr>
<td>Priority</td>
<td>The available assigned priorities are:</td>
</tr>
<tr>
<td></td>
<td>• 1 - Critical</td>
</tr>
<tr>
<td></td>
<td>• 2 - High</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• 3 - Moderate</td>
<td></td>
</tr>
<tr>
<td>• 4 - Low (default)</td>
<td></td>
</tr>
</tbody>
</table>

#### Subject
A brief description of the customer question, issue, or problem.

**Note:** When you start entering the subject, the application searches for relevant content in the knowledge bases configured for the portal. The results are displayed in the Related Content list.

#### Description
A detailed description of the customer question, issue, or problem.

3. Click **Submit**.
   The case is created, assigned a case number, and added to the creator's case list. To view this list, click **My Cases** at the top of the customer portal.

### Chat with an agent from the Customer Service Portal
Chat with a virtual agent or a customer service agent from the Customer Service Portal to resolve issues quickly.

#### Before you begin
Role required: sn_customerservice.customer, sn_customerservice.customer_admin, sn_customerservice.partner, sn_customerservice.partner_admin

#### Procedure
1. Click the chat icon (Chat) in the Customer Service Portal to start a conversation.
   A virtual agent or a customer service agent responds.

2. **Optional:** To talk to a person instead of a virtual agent, click and then **Contact Support**.

3. When you are finished with the chat, click **End Conversation**.

#### What to do next
If the agent creates a new case or links the discussion to an existing case, you can view these cases from the customer portal by clicking on **My Cases** and displaying the case list.
Get help using virtual agent conversations

Predefined Customer Service Virtual Agent chatbot conversations help your customers complete common self-service tasks, such as getting help with a product or checking the status of a case. Use predefined NLU with your virtual agent chatbot topics to enable the chatbot to assess the intent of the user input and provide the best response based on the context of the conversation.

Before you begin
If you are an anonymous user not logged into the application, you can get help by entering keywords for an issue and choose to get transferred to a live agent.

Role required: sn_customerservice.customer, sn_customerservice.consumer
A user with a proxy_contact role can also check the case status for a customer.

About this task
The information exchanged during the conversation flow (user inputs and bot responses) enables the chatbot to fulfill a user request or assist a user in completing a task. If the user has a question or an issue with an existing product or order, the virtual agent searches the keyword and displays relevant knowledge articles that can help resolve the issue. If there are no relevant articles, it creates a case.

ServiceNow NLU enables discovery of the chatbot topics based on either the keywords entered in the chat or the user-intent and matches an entity with the user input. It also makes the entity available to the topic if there is a match.

Procedure
1. Navigate to the Customer Service Management portal.
2. Click Chat.
   You can click Show Me Everything to display all available topics or enter keywords to narrow down the results to relevant topics.
3. If you are a logged-in user, enter keywords to get help on a case, an issue, or an order.
   • If NLU is enabled, it will guide you through the right topic based on the utterance.
   • If NLU is not enabled, it will display topics based on the match for the entered keywords. You can make a selection from all available topics displayed.

   Note: Contact your system administrator to determine whether the topics are NLU-enabled.
4. Use
<table>
<thead>
<tr>
<th>To</th>
<th>Follow these steps</th>
</tr>
</thead>
</table>
| **Check the status of a case** | **a.** Initiate checking the case status.  
  • If you are using the virtual agent conversation without enabling NLU, click **Check Case Status**.  
  • If you are using NLU in your virtual agent conversation, enter an utterance to check the status of a case.  
  
  **Note:** If you provide a case number, you will be presented with the details of the case.  |
|  | **b.** Select a case from the case list that you would like to get help for.  |
|  | **c.** When the case information displays, you can do one of the following:  
  • Add a comment  
  • Attach a picture  
  • Check another case  
  • Contact an agent.  |
| **Get help with a product** | Enter a keyword for your issue. The chatbot returns a list of related knowledge articles to help resolve your issue. If there are no matching articles associated with the description, a case is automatically created with the following information:  
  • Case identification number  
  • Short description  
  • State  
  • Priority  
  Take any of the following additional actions:  
  • Update the product and asset  
  • Add a comment  
  • Attach a picture  
  • Contact an agent.  |
<table>
<thead>
<tr>
<th>To</th>
<th>Follow these steps</th>
</tr>
</thead>
</table>
| Get help with an order | **a.** Initiate checking the status of your order.  
  - If you are using the virtual agent conversation without enabling NLU, click **Get Help with Order**.  
  - If you are using NLU in your virtual agent conversation, enter an utterance to get help on an order.  
  
  **Note:** If you provide an order number, you will be presented with the details of the order.  

  **b.** Select an order from the list of your orders that you would like to get help for.  

  **c.** Take any of the following additional actions:  
  - Add a comment  
  - Attach a picture  
  - Contact an agent |
| Get help | If you are an anonymous user not logged into the application, enter keywords for your issue. The chatbot returns a list of related knowledge articles that have been made public. If there are no matching articles that would help resolve the issue, you can choose to be transferred to a live agent. |
| Submit Request | **a.** Initiate submitting your request for one of the catalog items.  
  - If you are using the virtual agent conversation without enabling NLU, click **Show Me Everything** and then click **Submit a request**.  
  - If you are using NLU in your virtual agent conversation, enter an utterance for example open a request, that will identify that there is a NLU and intent associated.  

  **b.** Select the catalog item. The Search Catalog Item topic block searches for the catalog item and displays a link based on your search. For more information about search catalog item, see **Reusable ITSM Virtual Agent topic blocks** |
To Follow these steps

**Note:** Wherever the topic is opened, the records will display on the same portal.

c. Click on the link displayed and exit the virtual agent if you do not have any further request.

| Create Case | Updates a case from Virtual agent. You need the following 2 fields to update a case:
|--------------|------------------------------------------------------------------------------------------------|
|              | • case_sys_id (mandatory) - must be a valid case ID. If the ID is valid the following 4 options are displayed:
|              | ◦ Add product information is displayed only if enable_product_update is set to true.
|              | ◦ Add a comment
|              | ◦ Attach an image
|              | ◦ Cancel
|              | • enable_product_update - If set to true, the Add product information option is displayed. It updates the asset and model information. The topic block returns the variable case_sys_id

5. To exit a chat conversation, click **I'm done**.

**Related information**

Customer Service Virtual Agent conversations
**View or modify a case from the Customer Service Portal**

View or modify the information in a selected customer service case.

**Before you begin**

Role required: sn_customerservice.customer, sn_customerservice.customer_admin, sn_customerservice.partner, sn_customerservice.partner_admin

**About this task**

Depending on the role of the current user, the Case list displays:

- Cases created by the current user (sn_customerservice.customer)
- Cases related to the current user's account (sn_customerservice.customer_admin)
- Cases related to the current user's account as well as partner accounts (sn_customerservice.partner, sn_customerservice.partner_admin)

**Procedure**

1. Click **Case > All Cases** in the portal header.
   - Cases are ordered in the list with the most recently updated at the top.
2. Click the desired case number to open the Case form.
3. Make any necessary changes to the **Short description** or **Additional comments** fields.
   - All other fields on the form are read-only.
4. Click **Update**.

**View a publication on the Customer Service Portal**

View the details of a publication on the Customer Service Portal and download any attachments.

**Before you begin**

Role required: sn_customerservice.customer

**About this task**

The **Publications** link on the customer service portal displays a list of current publications. You can filter the publications on this list by category and you can further filter the list to show all publications or only those that are unread. You can sort the list by publish date or expiration date. You can also search for a specific term.
After a publication reaches its **Expiry Date**, it is automatically removed from the Publications list.

**Procedure**

1. Navigate to the customer service portal.
2. Click **Support > Publications** in the portal header. This displays a list of current publications. The information displayed for each publication includes the title, publish date, expiration date, and a brief description.
3. If desired, filter or sort the Publications list.
   - Select a category in the upper-left corner or select **All Categories**.
   - Select either **All Publications** or **Unread Publications** in the upper-right corner.
   - Select either **Publish Date** or **Expiry Date** in the Sort by field.
4. If desired, search the Publications list by entering the search term in the **Search Publications** field.
5. Click a publication name to open.
6. If the publication has attachments, click **Attachments** in the upper-right corner.
7. Select the attachments to download from the pop-up window.
8. Close the pop-up window.
9. Click the return arrow at the top of the publication to return to the Publications list.

**Complete a customer service satisfaction survey**

After accepting a proposed solution for a case, complete a customer service satisfaction survey.

**Before you begin**

When a customer accepts a proposed solution for a case by clicking **Accept Solution** on the case form, a satisfaction survey is displayed in the portal. The customer has the option of completing or skipping the survey. Either choice returns the customer to the list of cases on the self-service portal.

To complete the survey:
Procedure
1. Answer each of the survey questions.
2. Click Submit.

Request an item or service from the Customer Service Portal
Browse the catalog and create a request from the Customer or Consumer Service Portals.

Before you begin
Role required: sn_customerservice.customer_admin, sn_customerservice.partner, sn_customerservice.customer_case_manager, sn_customerservice.customer, sn_customerservice.consumer, sn_customerservice.proxy_contact

About this task
Customers and consumers can make requests from the Customer and Consumer Service Portals. Customer administrators, partners, and case managers can also make requests. For more information about these roles, see <ADD REFERENCE>.

ℹ️ Note: Creating a request from the Customer and Consumer Service Portals requires activation of the Customer Service with Request Management plugin (com.sn_cs_sm_request). It also requires that the system administrator provide external customers with access to request records.

Procedure
1. Do one of the following to create a request:
   • Click the Request Something link on the portal landing page.
   • Click Requests > Request Something in the portal menu header.
2. Browse the service catalog and select the desired item or service. You can also use the Category filters to filter the available items.
3. Fill in any necessary information related to the request.
4. Click Submit.
   The system processes the request, creates the request and any other related records, and displays the details in the Related Records widget on the case view page.

View records related to a case from the Customer and Consumer Service Portals
View records related to a case, such as requests, changes, or problems, from the Customer or Consumer Service Portals.
Before you begin
Role required: sn_customerservice.customer_admin, sn_customerservice.partner, sn_customerservice.customer_case_manager, sn_customerservice.customer, sn_customerservice.consumer

About this task
If a case has one or more related records, a Related Records widget is displayed on the case view page that lists those records.

Procedure
1. Navigate to the Customer or Consumer Service Portal.
2. Click My Lists in the portal header and then select a case.
   You can use the My Lists filter to narrow the list of records before selecting a case.
3. In the Related Records widget, click a record to view its details.
4. Optional: For request records, expand the Stage field to display more details about the request process.
5. Click the X in the upper corner to close the details window.

Close a case from the Customer Service Portal
Customers and consumers can close cases from the Customer and Consumer Service Portals.

Before you begin
Role required: sn_customerservice.customer, sn_customerservice.consumer

About this task
This feature is available for the Customer Service Portal (B2B) for product and order cases and for the Consumer Service Portal (B2C). The Close Case button is not available for cases in the Resolved or Closed states.

Procedure
1. Click Cases in the portal header to open the Case list.
2. Open the desired case.
3. In the Actions section, click Close Case.
4. In the confirmation pop-up window, click Close Case.
   When a case is closed from the portal:
• The case status in the Case details section is updated to **Closed**.

  ⚠ **Note:** You cannot add comments after the case is closed. You can only view the previous comments in the activity stream.

• The case additional comments and resolution notes are updated with **Closed by customer**.

• The case resolution code is set to **Solved by customer**.

• A message at the top of the portal confirms that the case has been closed.

• The system displays a customer satisfaction survey.

5. Complete the customer satisfaction survey.
   You can also choose to skip the survey. Either choice returns you to the case list on the portal.

---

**View install base information from the Customer Service Portal**

View a list of install base to track the instances provisioned for your account and which products or services run on them.

**Before you begin**
Role required: sn_customerservice.customer, sn_customerservice.customer_admin, sn_customerservice.partner, or sn_customerservice.partner_admin

**About this task**
You can view all cases and the service status from the last 30 days as well as all active, past, and planned outages. You can also view any active entitlements for the install base. An entitlement is active when its end date is not in the past or it has no end date. If it is linked to a contract, the contract must also be active.

⚠ **Note:** When the Customer Data Models for B2B2C plugin installed, contacts are able to access the list of install base items belonging to account consumers.

⚠ **Note:** You can modify the **Active Entitlements** widget to define your own filters for active entitlements.

**Procedure**

1. Navigate to the Customer Service Portal.

2. Click **Support > Install Base** in the header menu.
   The system displays a list of install base items that belong to your account.
3. Click an install base to view the details, including cases created on the install base in the last 30 days, active entitlements, as well as service status and outage history.

4. Optional: You can also create a case directly from the install base details.

Create a case for install base from the Customer Service homepage
Create a case about a question or issue on your install base from the Customer Service homepage.

Before you begin
Role required: sn_customerservice.customer, sn_customerservice.partner, sn_customerservice.customer_admin, or sn_customerservice.partner_admin

About this task
Install base enables you to track which instances have been provisioned for your account and the products and services that run on them.

Procedure
1. Navigate to the Customer Service homepage.
2. Click Create Case for Install Base.
3. Fill out the fields on the form, as required.

Create Case form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product</td>
<td>The sold product you have a question on or issue with.</td>
</tr>
<tr>
<td>Install Base</td>
<td>The install base item you have a question on or issue with.</td>
</tr>
<tr>
<td>Priority</td>
<td>The assigned priority:</td>
</tr>
<tr>
<td></td>
<td>• 1 — Critical</td>
</tr>
<tr>
<td></td>
<td>• 2 — High</td>
</tr>
<tr>
<td></td>
<td>• 3 — Moderate</td>
</tr>
<tr>
<td></td>
<td>• 4 — Low (default)</td>
</tr>
<tr>
<td>Subject</td>
<td>A brief description of the question, issue, or problem.</td>
</tr>
<tr>
<td>Description</td>
<td>A more detailed description of the customer question, issue, or problem.</td>
</tr>
</tbody>
</table>
4. Click **Submit**.
   The case is created, assigned a case number, and added to the user’s case list. Click **My Cases** at the top of the customer portal to view the Cases list.

**Approve a request, change request, or registration request**

Users with the snc_external role can view and approve requests and change requests from the Customer Service Portal.

**Before you begin**

Role required: snc_external

**About this task**

A request or change request may require approval from another employee within the same organization.

**Procedure**

1. In the Customer Service Portal header, click **Notification > View all notifications**.

2. Click a record in the Approvals section of the Notifications page.
   The system displays a read-only view of the record approval form. For requests that include one or more items, these items appear in a collapsible list at the bottom of the Request form.

3. **Optional:** Click a requested item at the bottom of the Request form to view the details in a pop-up window.

4. Click **Approve**.
   The system makes the following updates:
   - The record status is set to **Approved**.
   - The record status is displayed after the record number in the Related Records widget on the Case form.
   - The record status is added to the Case form.
     - If the record is approved by the customer administrator or if the customer self-approves the request, the change in status is added to the **Additional comments** field.
     - For other approvers, the change in status is added to the **Work notes** field.
   - The approval record is updated in the Approval table.

**View the status of a request, change request, or registration request**

Users with the snc_external role can view the status of requests and change requests from the Customer Service Portal.

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Before you begin
Role required: snc_external

Procedure
1. In the Customer Service Portal header, click My Lists.
2. In the My Lists filter, click My Cases.
3. Click a case in the Cases list.
4. View the record status after the record number in the Related Records widget.

Using the Consumer Service Portal
The Consumer Service Portal is a web interface that your company can use to provide information and support to consumers.

The Consumer Service Portal is based on the ServiceNow Service Portal application. Consumers can use the portal to search for information, get their questions answered by other registered members, or request assistance from a customer service agent.

From the Consumer Service Portal, consumers can:
• Search for information, browse knowledge articles, and engage with the community.
• Start a chat session with a customer service agent
• Register, create a login, and create a user profile.

After registering and logging in to the Consumer Service Portal, consumers can:
• Edit user profile information and change passwords.
• Register new products and view a list of currently registered products.
• Contact a consumer service agent about a question or issue.
• Create cases and view a list of current cases.
• Accept or reject proposed case solutions.

Your consumer service portal activity usually begins on the consumer service portal homepage. If you are a logged in user, you see different information than non-logged in users. Your organization can customize the homepage.
### Consumer Service Portal homepage for logged in users

<table>
<thead>
<tr>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge</td>
<td><strong>Knowledge</strong> on the header and the main page takes you to the kb_home page. The knowledge home page allows you to search the knowledge base or view a list of top-rated or most viewed knowledge base articles.</td>
</tr>
<tr>
<td>Requests</td>
<td>Displays all your requests and you can also request from the catalog for items and services.</td>
</tr>
<tr>
<td>My lists</td>
<td>Lists all your cases.</td>
</tr>
<tr>
<td>Get help menu</td>
<td>Click <strong>Get Help</strong> to open a product or order case.</td>
</tr>
<tr>
<td>Support menu</td>
<td>Navigate to cases, orders, my products, and other quick links.</td>
</tr>
<tr>
<td>Tours</td>
<td>View a tour for additional guidance on how the Customer Service Management application works. Tours appear when your administrator creates them on certain pages.</td>
</tr>
<tr>
<td>Chat</td>
<td>Click <strong>Chat</strong> to chat with a virtual agent or a customer service agent.</td>
</tr>
<tr>
<td>Profile menu</td>
<td>Click your profile photo to either view your profile or logout.</td>
</tr>
<tr>
<td>Search</td>
<td>Enter a search term and click <strong>Search</strong> to view the search results.</td>
</tr>
<tr>
<td>Ask the Community</td>
<td>Click <strong>Ask the Community</strong> to access the Community homepage.</td>
</tr>
<tr>
<td>Get help</td>
<td>Click <strong>Get help</strong> to make a request or report a problem by opening a case.</td>
</tr>
<tr>
<td>Most viewed articles</td>
<td>View a list of most viewed articles.</td>
</tr>
<tr>
<td>Featured articles</td>
<td>View featured community content.</td>
</tr>
<tr>
<td>Most useful articles</td>
<td>View most useful articles based on the usage count of the articles.</td>
</tr>
</tbody>
</table>

The following components are available if you have installed communities.
Consumer Service Portal homepage for logged in users (continued)

<table>
<thead>
<tr>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recent solved discussion</td>
<td>View a list of recently solved discussions.</td>
</tr>
<tr>
<td>Recent community blog</td>
<td>View a list of recently published community blogs.</td>
</tr>
<tr>
<td>Community featured content</td>
<td>View a list of featured community content.</td>
</tr>
</tbody>
</table>

**Note:** Metadata for each entry in the widgets such as the number of views, number of days from the time the article or feature was published, and rating for the article is displayed.

**Customizing the Consumer Service Portal**

To customize this portal, navigate to Service Portal > Portals and click Customer Service. See Service Portal for more information about creating a custom interface.

**Related reference**

Portal usage calculation

**Pre-chat from the Consumer Service Portal**

As a user on the consumer service portal, you can initiate a conversation with support by answering the Pre-chat survey. The survey questions vary based on the session type such as logged-in or anonymous.

**Before you begin**

Ensure that you are on the consumer service portal page.

**Procedure**

1. Click the Open chat window icon on the portal page or use Facebook messenger if you are a Facebook user.
2. Answer the questions that help set the context for an agent to resolve your issue.
   You will be routed to an agent queue.
Related information

Pre-chat surveys

Portal usage calculation
Portal usage enables you to track how your customers and employees are using the portal. The Customer Portal Usage dashboard provides information about portal visits resulting in session counts.

To view the Customer Portal Usage dashboard, navigate to Customer Service > Administration > Portal Usage.

Note: You can ignore the bot session usage that is captured as part of this dashboard.

A user session is a period of activity on the Customer or Consumer Service Portal by one of the following users:

- External: an external user, typically a customer or consumer, who is logged in.
- Anonymous: a user who is not logged in.

A user session times out after a specific period of inactivity.

User access to the self-service portals is tracked as follows: per session, per day, and per portal. If the same user logs in from multiple browsers or devices, each login is counted as a separate visit. Each first call of a portal page starts a session and, at midnight (server time), the system restarts another session. This means that a user cannot have a session longer than 24 hours.

The default session timeout is 30 minutes. This setting can be adjusted using a system property. For more information about modifying the session timeout setting, see Manage user sessions.

Site visit calculation examples
A user logs in, logs out, and then logs in again:

<table>
<thead>
<tr>
<th>Step</th>
<th>User activity</th>
<th>Billable count incremented</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>User visits the portal as an anonymous or guest user</td>
<td>Yes</td>
</tr>
<tr>
<td>2</td>
<td>User logs in</td>
<td>No</td>
</tr>
<tr>
<td>3</td>
<td>User logs out</td>
<td>No</td>
</tr>
<tr>
<td>4</td>
<td>User logs in immediately after logging out</td>
<td>Yes</td>
</tr>
</tbody>
</table>
A user logs in and continues the session past midnight:

<table>
<thead>
<tr>
<th>Step</th>
<th>User activity</th>
<th>Billable count incremented</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>User visits the portal as an anonymous or guest user</td>
<td>Yes</td>
</tr>
<tr>
<td>2</td>
<td>User logs in</td>
<td>No</td>
</tr>
<tr>
<td>3</td>
<td>User session continues past midnight</td>
<td>Yes</td>
</tr>
<tr>
<td>4</td>
<td>User logs out</td>
<td>No</td>
</tr>
</tbody>
</table>

**Register for the Consumer Service Portal**

Register for the Consumer Service Portal to gain access and create a consumer profile.

**Before you begin**
Role required: none

**Procedure**

1. Navigate to the Consumer Service Portal.
2. Click **Register** in the portal header.
3. Fill in the fields on the registration form.
   - Your email address must be unique. If you enter an address that is already in the system, you receive an error message. Try again with a different email address.
4. Enable the **Security Code** check box, complete the CAPTCHA validation, and click **Verify**.
5. Select the check box to agree to the privacy policy and to the community terms and conditions.
6. Click **Sign Up**.
   - A verification email is sent to the email address you provided.
7. Click the link in the email to verify your email address.
   - Your registration is complete. You can now log in to the Consumer Service Portal.
Log in to the Consumer Service Portal

Use the name and password that you created during the registration process to log in to the Consumer Service Portal.

Before you begin
Role required: sn_customerservice.consumer

Procedure
1. Navigate to the Consumer Service Portal.
2. Click Login in the portal header.
3. Fill in the fields on the Login popup window.
4. Click Login.
   You are logged in to the Customer Service Portal and your name appears in the portal header.

Change your password from the Consumer Service Portal

Change your password from the consumer portal.

Before you begin
Role required: sn_customerservice.customer

About this task

Procedure
1. Click your user name in the portal header to display the user profile information.
2. Click Change Password.
3. Fill in the fields on the Change Password form, as appropriate.

Change Password form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Password</td>
<td>The current password. This field is automatically filled in.</td>
</tr>
<tr>
<td>New Password</td>
<td>The new password. This password must:</td>
</tr>
<tr>
<td></td>
<td>• Be a minimum of eight characters in length</td>
</tr>
<tr>
<td></td>
<td>• Include at least one uppercase and one lowercase letter</td>
</tr>
<tr>
<td></td>
<td>• Include at least one number</td>
</tr>
</tbody>
</table>
### View or edit a consumer profile

Registered users with the consumer role can view their consumer profiles, edit the information as needed, and change passwords.

**Before you begin**
Role required: sn_customerservice.consumer

**Procedure**

1. Log in to the Consumer Service Portal.
2. Click your user name in the portal header and then click **Profile**.
3. To add a picture to your profile, click **Upload Picture** and select the desired image.
4. To update the personal information in your profile, including name, contact information, and address:
   a. Click the desired field.
   b. Enter the new information in the popup window.
   c. Click **Save**.
5. To change your password, click **Change Password**.
   The **Change Password** link appears on the consumer profile when the Self Service Password Reset plugin (com.snc.password_reset) is activated.
6. Fill in the fields on the Change Password popup window and click **Update**.

### Register a product from the Consumer Service Portal

Users with the consumer role can register their products from the Consumer Service Portal.

**Before you begin**
Role required: sn_customerservice.consumer
Procedure
1. Log in to the Consumer Service Portal.
2. Click Support in the portal header and then click Register Product.
3. Type a search term in the search field and press Enter to display a list of products.
4. Click the Select button on the card for the desired product.
5. Enter the Serial Number and the Purchase Date for the selected product.
6. Click Register.
   After the product is successfully registered, it appears in the My Products list, which includes the products registered to the current user.

View a list of products from the Consumer Service Portal
Users with the consumer role can view a list of their registered products from the Consumer Service Portal.

Before you begin
Role required: sn_customerservice.consumer

Procedure
1. Log in to the Consumer Service Portal.
2. Click Support > My Products in the portal header.
   This displays a list of products registered to the current user.
3. If desired, click a product to display more information about the product.

Create a case from the Consumer Service Portal
Users with the consumer role can create cases from the Consumer Service Portal.

Before you begin
Role required: sn_customerservice.consumer

Procedure
1. Log in to the Consumer Service Portal.
2. Click Get Help in the portal header.
4. Enter or search for a customer.
5. Enter a product or an order depending on what you selected above.

6. Enter a brief description in the **Subject** field.

   🔄 **Note:** When you start entering the subject, the application searches for the relevant content in the knowledge bases configured for portal and is displayed in the **Related Content** list.

7. If desired, add a more detailed **Description** and any attachments.

8. Click **Submit**.

   The new case is created and added to the Cases list. To view the case, click the link in the case creation message or click **Cases** in the portal header and then click the case number.

---

**View a case from the Consumer Service Portal**

Users with the consumer role can view a list of cases from the Consumer Service Portal and select individual cases to see more detail.

**Before you begin**

Role required: sn_customerservice.consumer

**About this task**

Selecting a case opens a form with the following sections:

- A conversation that displays the interaction between the consumer and the customer service agent.
- The action that needs to be taken on the consumer's part, such as accepting or rejecting a solution.
- The case details, including the case number and current status.
- Any attached files.

**Procedure**

1. Log in to the Consumer Service Portal.

2. Click **Support > Cases** in the portal header to view a list of cases related to the current user.

3. Click the case number to view more information about the case.

4. If desired, type a message to the agent and click **Send**.

   Your message becomes part of the case conversation. All responses from the agent are also included in the conversation.
Accept or reject a case solution from the Consumer Service Portal

Users with the consumer role can accept or reject the proposed solution for a case from the Consumer Service Portal.

Before you begin
Role required: sn_customerservice.consumer

About this task
When an agent proposes a solution to a consumer's case, buttons for accepting or rejecting the solution appear in the section of the form that shows the consumer actions.

Procedure
1. Log in to the Consumer Service Portal.
2. Click Support > Cases in the portal header to view a list of cases related to the current user.
3. Click a case number to view more information about the case.
4. Click one of the following buttons from the Actions drop-down list:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept Solution</td>
<td>Accepts the solution proposed by the agent and changes the case state to <strong>Closed</strong>.</td>
</tr>
<tr>
<td>Reject Solution</td>
<td>Rejects the solution proposed by the agent after entering the reason for rejecting the solution. The case state changes to <strong>Open</strong> state.</td>
</tr>
</tbody>
</table>

Chat with an agent from the Consumer Service Portal

Chat with a virtual agent or a customer service agent from the Consumer Service Portal to resolve issues quickly.

Before you begin
Role required: sn_customerservice.consumer
Procedure

1. Click the chat icon (Chat) in the Consumer Service Portal to start a conversation.
   A form opens that requests the type of issue and a brief description of the issue.
2. Fill in the information and click Submit.
   A virtual agent or a customer service agent responds.
3. Optional: To talk to a person instead of a virtual agent, click and then Contact Support.
4. When you are finished with the chat, click End Conversation.

What to do next
If the agent creates a new case or links the discussion to an existing case, you can view these cases from the Consumer Service Portal by clicking Cases and displaying the case list.

Chat anonymously with an agent from the Consumer Service Portal
Users that are not logged in can chat anonymously with an agent from the Consumer Service Portal to resolve issues more quickly.

Before you begin
Role required: none

Procedure

1. Click the chat icon (Chat) in the Consumer Service Portal to start a conversation.
   A form opens that requests some basic user information.
2. Fill in the information and click Submit.
   A virtual agent or a customer service agent responds.
3. Optional: To talk to a person instead of a virtual agent, click and then Contact Support.
4. When you are finished with the chat, click End Conversation.

View a publication on the Consumer Service Portal
View the details of a publication on the Consumer Service Portal and download any attachments.
Before you begin
Role required: sn_customerservice.consumer

About this task
The Support > Publications link on the Consumer Service Portal displays a list of current publications. You can filter the publications on this list by category and you can further filter the list to show all publications or only those that are unread. You can sort the list by publish date or expiration date. You can also search for a specific term.

After a publication reaches its Expiry Date, it is automatically removed from the Publications list.

Procedure
1. Navigate to the Consumer Service Portal.
2. Click Publications in the portal header. This displays a list of current publications. The information displayed for each publication includes the title, publish date, expiration date, and a brief description.
3. If desired, filter or sort the Publications list.
   - Select a category in the upper-left corner or select All Categories.
   - Select either All Publications or Unread Publications in the upper-right corner.
   - Select either Publish Date or Expiry Date in the Sort by field.
4. If desired, search the Publications list by entering the search term in the Search Publications field.
5. Click a publication name to open.
6. If the publication has attachments, click Attachments in the upper-right corner.
7. Select the attachments to download from the pop-up window.
8. Close the pop-up window.
9. Click the return arrow at the top of the publication to return to the Publications list.

Using Conversational Appointment Booking
Customers can initiate an appointment booking conversation in a chat on your support portal using a Virtual Agent, and Agents can use Autopilot to display Virtual Agent topics during conversations.
Conversational Appointment Booking for Customers
Customers can complete the following tasks with a Virtual Agent:

- Book a new appointment in CSM
- Reschedule an appointment in CSM
- Cancel an appointment in CSM

Conversational Appointment Booking for Agents
Agents can use Autopilot to display Virtual Agent topics during Agent Chat conversations. For more information, see Conversation Autopilot in Agent Chat.

Schedule an appointment with Conversational Appointment Booking
As a customer or consumer, schedule an appointment via chat with a Virtual Agent on the ServiceNow portal.

Before you begin
Role required: customer, consumer

About this task
You can only schedule one appointment per location. Only logged-in users can schedule appointments.

Procedure
1. Navigate to the Customer Service portal or Consumer Service portal home page by adding the suffix /csm or /csp to your instance URL.
   
   **Example**
   For example: https://yourportalurl.com/csm

2. Click the chat icon ( ).
   The chat window opens and the Virtual Agent begins the chat.
Start scheduling an appointment

Hi, I’m your Virtual Agent. Let me know how I can help you today.

What’s your issue or request? Or take a look at what I can help with.

Schedule a Walk-up Appointment

Your nearest facility is San Francisco Service Center. Would you like to schedule the appointment there?

Yes

Let us know the reason for this appointment.

Choose a reason

Other

3. Enter schedule appointment.
4. Choose a date from the calendar.

Results
The appointment is scheduled and the chat is complete.
Finished scheduling an appointment

Let us know the reason for this appointment.

Choose a reason

just now

Need replacement of device

Schedule an appointment

2021-08-31, 16:00

Got it. Your appointment was scheduled for 2021-08-31 at 16:00.

Thank you for using our support chat.

Related information

Reschedule an appointment
Cancel an appointment
Reschedule an appointment with Conversational Appointment Booking

As a customer or consumer, reschedule an appointment via chat with a Virtual Agent on the ServiceNow portal.

Before you begin
Role required: customer, consumer

About this task
You can only schedule one appointment per location. Only logged-in users can schedule appointments.

Procedure
1. Navigate to the Customer Service portal or Consumer Service portal home page by adding the suffix /csm or /csp to your instance URL.

   Example
   For example: https://yourportalurl.com/csm

2. Click the chat icon ( ).
   The chat window opens and the Virtual Agent begins the chat.
3. Enter `reschedule appointment`.
4. Choose the appointment that you want to reschedule.
5. Choose a date from the calendar for the new appointment time.

Results
The appointment is rescheduled.
Related information
  - Schedule an appointment
  - Cancel an appointment

Cancel an appointment with Conversational Appointment Booking

As a customer or consumer, cancel an appointment via chat with a Virtual Agent on the ServiceNow portal.

Before you begin
Role required: customer, consumer

Procedure

1. Navigate to the Customer Service portal or Consumer Service portal home page by adding the suffix /csm or /csp to your instance URL.

   **Example**
   For example: https://yourportalurl.com/csm

2. Click the chat icon ( ).
   The chat window opens and the Virtual Agent begins the chat.

3. Enter cancel appointment.
   The Virtual Agent shows the available appointments.
4. Confirm the cancellation.

**Results**
The appointment is canceled.
Related information

Schedule an appointment
Reschedule an appointment

Analytics and reporting for Customer Service Management

Customer Service Performance Analytics and Reporting Solutions contain preconfigured dashboards with actionable data visualizations to improve your business processes and quantify the value of self-service.

Customer Service Analytics and Reporting Solutions

Customer Service Performance Analytics and Reporting Solutions contain preconfigured dashboards with actionable data visualizations to improve your business processes.

Use the Performance Analytics widgets on the dashboard to visualize data over time, analyze your business processes, and identify areas of improvement. With Analytics and Reporting Solutions, you can use Performance Analytics for your application with minimal setup. You can also create your own objects.

**Important:** Set up and test Analytics and Reporting Solutions on a non-production instance before enabling them in production.

**Note:** Analytics and Reporting Solutions provide all the configuration records required to analyze default applications. Customize these records for use in your production environment. For more information, see Configure Analytics and Reporting Solutions.

Two Performance Analytics solutions are available for Customer Service:

- Customer Service (com.snc.pa.customer_service)
- Customer Service Management - Advanced (com.snc.pa.customer_service_advanced)

**Note:** Customer Service Performance Analytics solutions are an optional feature available for the Customer Service Management application. To use them, your license must also include Performance Analytics. Once licensed, enable the Performance Analytics Premium for Customer Service and the Customer Service Performance Analytics solutions on the instances where you wish to leverage the enhanced functionality. For more information about licensing Performance Analytics, see Activate your Performance Analytics subscription.
**Customer Service solution**
The Customer Service solution adds the following features.

⚠️ **Note:** Performance Analytics - Spotlight (com.snc.pa.spotlight) is automatically activated with this solution.

Spotlight groups:
- Case Spotlight

Dashboards:
- Customer Service Agent
- Customer Service Manager
- Customer Service Executive

**Customer Service Management - Advanced solution**
The Customer Service Management - Advanced solution adds the following features.

⚠️ **Note:** Performance Analytics - Spotlight (com.snc.pa.spotlight) is automatically activated with this solution.

Spotlight groups:
- Case Spotlight

Dashboards:
- Customer Service Agent - Advanced
- Customer Service Manager - Advanced
- Customer Service Executive - Advanced

These dashboards have all the information shown on the dashboards for the basic Customer Service solution, but also contain additional indicators for the following features. Activate all the plugins below in order to view the additional indicators.
- Major Issue Management
- Customer Service Case Action Status
- Customer Service with Request Management
- Customer Service with Service Management
- Agent Chat
• Advanced Work Assignment for CSM
• Performance Analytics - Content Pack - Advanced Work Assignment

ℹ️ **Note:** For more information about the Major Issue Management indicators, see **Major issue management analytics**.

The Customer Service Management - Advanced solution also adds additional Service Management indicators to the Analytics Hub. For more information, see **CSM integration with Service Management analytics**.

## Enable Performance Analytics for Customer Service Management

To enable Performance Analytics for Customer Service Management, a user with the admin role can navigate to **Performance Analytics > Guided Setup**. Click **Get Started** and then scroll to the section for Customer Service. The guided setup takes you through the entire setup and configuration process.

### Related information

- Analytics and Reporting Solutions
- Ranking records with Spotlight

### Customer Service Agent dashboard

The Customer Service Agent dashboard provides quick access to your cases based on criteria that help you prioritize your work. The dashboard also displays summary data on metrics for your organization.

To view the Customer Service Agent dashboard, navigate to **Performance Analytics > Dashboards**. Click the **All** tab and select **Customer Service Management** from the Group menu. Click the **Customer Service Agent** or **Customer Service Agent - Advanced** tile.


### End users and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer service agent: View and prioritize your assigned cases. View case trends for all agents.</td>
<td>sn_customerservice_agent</td>
</tr>
<tr>
<td>End user and goal</td>
<td>Required role</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------------</td>
<td>-------------------------------------------</td>
</tr>
<tr>
<td>Customer service manager: View and prioritize your assigned cases. View case trends for all agents.</td>
<td>sn_customerservice_manager</td>
</tr>
<tr>
<td>Content administrator: Can edit the dashboard and manage users, groups, and roles for the dashboard.</td>
<td>pa_admin</td>
</tr>
<tr>
<td>Content creator: Can view the dashboard.</td>
<td>pa_viewer</td>
</tr>
</tbody>
</table>

### My Work tab

<table>
<thead>
<tr>
<th>My Open Cases</th>
<th>My Cases With Problems</th>
<th>My New Cases</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>0</td>
<td>3</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>My Groups P3 Cases</th>
<th>My Groups Open Cases</th>
<th>My KIls Created</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>6</td>
<td>20</td>
</tr>
</tbody>
</table>

### Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Open Cases</td>
<td>Cases assigned to me that are not resolved, closed, or canceled.</td>
</tr>
<tr>
<td>My Cases With Problems</td>
<td>Cases assigned to me that are part of a parent case that is assigned to a system admin.</td>
</tr>
<tr>
<td>My New Cases</td>
<td>Cases that I have not yet responded to.</td>
</tr>
<tr>
<td>Title</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>My Group's P1 Cases</td>
<td>P1 cases that are assigned to a member of my group.</td>
</tr>
<tr>
<td>My Group's Open Cases</td>
<td>Cases assigned to a member of my group that are not resolved, closed, or canceled.</td>
</tr>
<tr>
<td>My KBs Created</td>
<td>List of all KB articles that I created.</td>
</tr>
</tbody>
</table>

### Organizational Trends tab

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSAT</td>
<td>Average customer satisfaction based on survey results. The percent change in the current period appears under the total percentage. For more information about CSAT, see Customer service satisfaction surveys.</td>
</tr>
<tr>
<td>Indicator</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>First Call Resolution</td>
<td>Percentage of cases that were resolved during first contact with the customer. The percent change in the current period appears under the total percentage.</td>
</tr>
<tr>
<td>Exceeding Chat Target</td>
<td>Percentage of all Chat work items that have exceeded the target wait time. For more information about the Chat service channel, see Advanced Work Assignment service channels.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This indicator is only viewable on the Customer Service Agent - Advanced dashboard.</td>
</tr>
<tr>
<td>Exceeding Case Target</td>
<td>Percentage of all Case work items that have exceeded the target wait time. For more information about the Case service channel, see Advanced Work Assignment service channels.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This indicator is only viewable on the Customer Service Agent - Advanced dashboard.</td>
</tr>
<tr>
<td>Avg. Time to Resolution</td>
<td>Average time for a case to be marked as closed or resolved.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> On the Customer Service Agent - Advanced dashboard, this indicator is called Mean Time to Resolve.</td>
</tr>
<tr>
<td>Backlog Growth</td>
<td>Number of backlogged cases for all agents over time.</td>
</tr>
</tbody>
</table>

**Customer Service Manager dashboard**

The Customer Service Manager dashboard displays charts and summary data on metrics like backlog, resolution rates, SLA, customer satisfaction, and per-agent KPIs.

To view the Customer Service Manager dashboard, navigate to Performance Analytics > Dashboards. Click the All tab and select Customer Service Management from the Group menu. Click the Customer Service Manager or Customer Service Manager - Advanced tile.

End users and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer service manager: View case metrics like backlog, resolution rates, SLA, customer satisfaction, and per-agent KPIs to understand the current performance of customer service at your organization.</td>
<td>sn_customerservice_manager</td>
</tr>
<tr>
<td>Content administrator: Can edit the dashboard and manage users, groups, and roles for the dashboard.</td>
<td>pa_admin</td>
</tr>
<tr>
<td>Content creator: Can view the dashboard.</td>
<td>pa_viewer</td>
</tr>
</tbody>
</table>

Dashboard breakdowns

The Customer Service Manager dashboard uses the Case Assignment Group breakdown. Select one or more groups to view data for only those groups. By default, data from all groups is shown on the dashboard.
Overview indicators

**Customer Service Manager - Advanced**

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSAT</td>
<td>Average customer satisfaction based on survey results. The percent change in the current period appears under the total percentage. For more information about CSAT, see Customer service satisfaction surveys.</td>
</tr>
<tr>
<td>First Call Resolution</td>
<td>Percentage of cases that were resolved during first contact with the customer. The percent change in the current period appears under the total percentage.</td>
</tr>
</tbody>
</table>
### Customer Service Manager - Advanced (continued)

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mean Time to Resolve</td>
<td>Average time for a case to be marked as closed or resolved. The percent change in the current period appears under the total percentage.</td>
</tr>
<tr>
<td>Customers Impacted by Major Case</td>
<td>Number of customers impacted by major cases.</td>
</tr>
<tr>
<td>Child Cases Auto Created from Major Case</td>
<td>Percentage of child cases that are automatically created from a major case.</td>
</tr>
<tr>
<td>Open Backlog - Blocked</td>
<td>Number of cases that are blocked and are not resolved.</td>
</tr>
<tr>
<td>Open Backlog - Unblocked</td>
<td>Number of cases that are not blocked and are not resolved.</td>
</tr>
<tr>
<td>Backlog Growth</td>
<td>Number of backlogged cases for all agents over time.</td>
</tr>
</tbody>
</table>

### Customer Service Manager

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSAT</td>
<td>Average customer satisfaction based on survey results. The percent change in the current period appears under the total percentage. For more information about CSAT, see Customer service satisfaction surveys.</td>
</tr>
<tr>
<td>First Call Resolution</td>
<td>Percentage of cases that were resolved during first contact with the customer. The percent change in the current period appears under the total percentage.</td>
</tr>
<tr>
<td>Open Cases with Breached SLAs</td>
<td>Percentage of cases that have remained open past the time required by the Service Level Agreement (SLA).</td>
</tr>
</tbody>
</table>
### Customer Service Manager (continued)

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unassigned Open Cases</td>
<td>Number of open cases that are not assigned to an agent.</td>
</tr>
<tr>
<td>Avg. Time to Resolution</td>
<td>Average time for a case to be marked as closed or resolved. The percent change in the current period appears under the total percentage.</td>
</tr>
<tr>
<td>Backlog Growth</td>
<td>Number of backlogged cases for all agents over time.</td>
</tr>
<tr>
<td>Open Case Backlog</td>
<td>Chart of cumulative open cases and case age over time.</td>
</tr>
<tr>
<td>Open Backlog</td>
<td>Number of cases that are not resolved.</td>
</tr>
</tbody>
</table>

#### Analysis tab

Trend chart of case backlog over time. Click and move your cursor to view data for any date. Indicators display data for the selected date.
### Analysis indicators

<table>
<thead>
<tr>
<th>State</th>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Backlog - Unblocked</td>
<td>% Not Updated in 5 Days</td>
<td>Percentage of open cases that agents have not updated within the last 5 days.</td>
</tr>
<tr>
<td></td>
<td>% Marked as Major</td>
<td>Percentage of open cases that are major.</td>
</tr>
<tr>
<td></td>
<td>% with Breached SLAs</td>
<td>Percentage of open cases that have remained open past the time required by the SLA.</td>
</tr>
<tr>
<td></td>
<td>% with Priority P1</td>
<td>Percentage of open cases that are critical priority.</td>
</tr>
<tr>
<td></td>
<td>% Escalated</td>
<td>Percentage of open cases that have been escalated.</td>
</tr>
<tr>
<td></td>
<td>% with Problem</td>
<td>Percentage of open cases connected to a problem.</td>
</tr>
<tr>
<td></td>
<td>% Agent Reassignment</td>
<td>Percentage of open cases where the Assigned to field has changed at least once.</td>
</tr>
<tr>
<td></td>
<td>% of Major Candidates</td>
<td>Percentage of open cases that have been proposed as major case candidates.</td>
</tr>
<tr>
<td></td>
<td>% Re-opened At Least Once</td>
<td>Percentage of open cases where the State was previously Resolved.</td>
</tr>
<tr>
<td></td>
<td>% with Request</td>
<td>Percentage of open cases connected to a request.</td>
</tr>
<tr>
<td>Resolved or Closed</td>
<td>% with Problem</td>
<td>Percentage of closed cases connected to a problem.</td>
</tr>
<tr>
<td></td>
<td>% Caused by Change</td>
<td>Percentage of closed cases caused by a change.</td>
</tr>
<tr>
<td></td>
<td>Closed in Same Day</td>
<td>Number of cases that were closed on the same day they were created.</td>
</tr>
<tr>
<td></td>
<td>% Re-opened At Least Once</td>
<td>Percentage of closed cases that were reverted to the open State at least once.</td>
</tr>
<tr>
<td>State</td>
<td>Indicator</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------------------------------</td>
<td>--------------------------------------------------------------------</td>
</tr>
<tr>
<td>% Resolved Major Cases</td>
<td>Percentage of closed cases that are major cases.</td>
<td></td>
</tr>
<tr>
<td>% Re-assigned</td>
<td>Percentage of closed cases that are reassigned.</td>
<td></td>
</tr>
<tr>
<td>% with Breached SLAs</td>
<td>Percentage of closed cases that remained open past the time required by the SLA.</td>
<td></td>
</tr>
<tr>
<td>% with Change</td>
<td>Percentage of closed cases connected to a problem.</td>
<td></td>
</tr>
<tr>
<td>% with Incident</td>
<td>Percentage of closed cases connected to an incident.</td>
<td></td>
</tr>
<tr>
<td>% with Request</td>
<td>Percentage of closed cases connected to a request.</td>
<td></td>
</tr>
</tbody>
</table>

**Analysis breakdowns**

Select a breakdown to view cases grouped by that breakdown.

Cases in the Open Backlog - Unblocked state can be grouped by the following breakdowns.

- Case Assignment Group
- Case Assigned To
- Account
- Product
- State
- Priority
- Category
- Channel

Cases in the Open Backlog - Blocked state can be grouped by the following breakdowns.

- Blocked Action Status
- Case Assignment Group

Cases in the Resolved or Closed state can be grouped by the following breakdowns.
Case Spotlight tab

**Case Spotlight breakdowns**
Select values for the breakdowns to filter the data shown on the dashboard.

- Assignment Group
- Case State
- Case Priority
- Opened

**Case Spotlight reports**

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cases Above Spotlight Threshold</td>
<td>Number of cases that exceed the Case Spotlight threshold. Every case where State is New, Open, or Awaiting info is scored based on priority and last updated date. The score is compared against the threshold value to put cases with high priority in the spotlight.</td>
</tr>
<tr>
<td>Note:</td>
<td>You can edit the Case Spotlight spotlight group threshold and criteria to put different types of cases in the spotlight based on your organization’s needs.</td>
</tr>
<tr>
<td>Spotlight Cases P1 - Critical</td>
<td>Number of cases that exceed the Case Spotlight threshold and are Priority 1.</td>
</tr>
<tr>
<td>Spotlight Cases - Unassigned</td>
<td>Number of cases that exceed the Case Spotlight threshold and are not assigned to an agent.</td>
</tr>
<tr>
<td>Case Spotlight</td>
<td>List of cases that exceed the Case Spotlight threshold.</td>
</tr>
</tbody>
</table>
Agent Analysis tab

Agent analysis indicators

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avg. Time to Resolution</td>
<td>Average time for a case to be marked as closed or resolved for each agent. Ranked from fastest to slowest.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> On the Customer Service Manager - Advanced dashboard, this indicator is called Mean Time to Resolve.</td>
</tr>
<tr>
<td>First Call Resolution</td>
<td>Percentage of cases for each agent that were resolved during first contact with the customer. Ranked from highest to lowest.</td>
</tr>
<tr>
<td>CSAT</td>
<td>Average customer satisfaction for each agent based on survey results. Ranked from highest to lowest. For more information about CSAT, see Customer service satisfaction surveys.</td>
</tr>
</tbody>
</table>
Indicator | Description
--- | ---
Agent Efficiency Trend (Mean Time to Resolve) | Average time for a case to be marked as closed or resolved for each agent shown over time.
Closed Cases by Agent and Account. | Number of cases closed by each agent for each account.

### Work Assignment Analytics tab

![Work Assignment Analytics tab](image)

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Chat Wait Time - Last Hour</td>
<td>Average amount of time that customers have spent waiting for an agent response in the past hour for chat work items.</td>
</tr>
</tbody>
</table>

**Note:** The Work Assignment Analytics tab can only be viewed on the Customer Service Manager - Advanced dashboard. Customer Service [com.sn_customerservice] and Performance Analytics - Content Pack - Advanced Work Assignment [com.snc.pa.awa] must be activated on your instance.

### Work Assignment Analytics reports
### Average Case Wait Time - Last Hour

Average amount of time that customers have spent waiting for an agent response in the past hour for case work items.

### Work Assignment Analytics indicators

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exceeding Target Work Items</td>
<td>Percentage of all work items that have exceeded the target wait time.</td>
</tr>
<tr>
<td>Assigned Work Items</td>
<td>Percentage of all work items that are assigned to agents.</td>
</tr>
<tr>
<td>Abandoned Work Items</td>
<td>Percentage of all work items that agents have abandoned.</td>
</tr>
</tbody>
</table>

### Text Analytics tab

The Text Analytics tab is visible only if the Performance Analytics Premium for Customer Service plugin [com.snc.pa.premium.cs] is installed.
Text Analytics displays a word cloud of most frequently used words and phrases in the short descriptions of open cases, providing insight into emerging issues reported by users.

- Drill down on a word to view other words associated with cases that contain that keyword.
- Search the word cloud for specific terms.

**Trend line:** Shows the frequency of top keywords over time. Click and move your cursor to view data for any date. **Related Records:** List of cases containing the keywords you selected from the word cloud.

**Customer Service Executive dashboard**

The Customer Service Executive dashboard provides a view of the operation and trends of the Customer Service function for your organization.

To view the Customer Service Executive dashboard, navigate to **Performance Analytics > Dashboards**. Click the **All** tab and select **Customer Service Management** from the Group menu. Click the **Customer Service Executive** or **Customer Service Executive - Advanced** tile.


**End users and roles**

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer service executive: View an overview of customer service cases at your organization to see areas that are doing well and areas that need attention.</td>
<td>sn_customerservice_manager</td>
</tr>
<tr>
<td>Content administrator: Can edit the dashboard and manage users, groups, and roles for the dashboard.</td>
<td>pa_admin</td>
</tr>
<tr>
<td>Content creator: Can view the dashboard.</td>
<td>pa_viewer</td>
</tr>
</tbody>
</table>
### Overview indicators

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSAT</td>
<td>Average customer satisfaction based on survey results. The percent change in the current period appears under the total percentage. For more information about CSAT, see Customer service satisfaction surveys.</td>
</tr>
<tr>
<td><strong>Avg. Time to Resolution</strong></td>
<td>Average time for a case to be marked as closed or resolved. The percent change in the current period appears under the total percentage.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>On the Customer Service Executive - Advanced dashboard, this indicator is called Mean Time to Resolve.</td>
</tr>
<tr>
<td>Open Backlog</td>
<td>Number of cases that are not resolved. The percent change in the current period appears under the total percentage.</td>
</tr>
<tr>
<td>Customer Satisfaction Stats</td>
<td>Summary statistics for customer satisfaction.</td>
</tr>
<tr>
<td>Closed Case Stats</td>
<td>Summary statistics for closed cases.</td>
</tr>
<tr>
<td>Indicator</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>------------------------------------------------------</td>
</tr>
<tr>
<td>Open Case Stats</td>
<td>Summary statistics for open cases.</td>
</tr>
<tr>
<td>Affected Customers and Deployments</td>
<td>Number of affected customers and deployments.</td>
</tr>
</tbody>
</table>

**Note:** This indicator is only viewable on the Customer Service Executive - Advanced dashboard.

---

**At Risk Accounts tab**

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSAT</td>
<td>Accounts with the lowest customer satisfaction.</td>
</tr>
<tr>
<td>Avg. Time to Resolution</td>
<td>Accounts with the worst average case resolution time.</td>
</tr>
</tbody>
</table>

**Note:** On the Customer Service Executive - Advanced dashboard, this indicator is called Mean Time to Resolve.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Case Backlog</td>
<td>Accounts with the highest number of unresolved cases.</td>
</tr>
</tbody>
</table>
Product Overview tab

Product Overview indicators

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSAT</td>
<td>Products with the lowest customer satisfaction.</td>
</tr>
<tr>
<td>Avg. Time to Resolution</td>
<td>Products with the worst average case resolution time.</td>
</tr>
<tr>
<td>Note: On the Customer Service Executive - Advanced dashboard, this indicator is called Mean Time to Resolve.</td>
<td></td>
</tr>
<tr>
<td>Open Case Backlog</td>
<td>Products with the highest number of unresolved cases.</td>
</tr>
</tbody>
</table>

Cost Information tab

Note: The Cost Information tab is visible only if the Performance Analytics - Content Pack - Financial Management for Customer Service plugin [com.snc.pa.fm.csm] is installed.

Cost Information indicators

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Cost</td>
<td>Total cost for all cases.</td>
</tr>
<tr>
<td>Cost Per Case - By Channel</td>
<td>Cost per case grouped by channel.</td>
</tr>
<tr>
<td>Cost Per Case - By Product</td>
<td>Cost per case grouped by product.</td>
</tr>
<tr>
<td>Cost Per Case - By Account</td>
<td>Cost per case grouped by account.</td>
</tr>
</tbody>
</table>
Text Analytics tab

The Text Analytics tab is visible only if the Performance Analytics Premium for Customer Service plugin [com.snc.pa.premium.cs] is installed.

Text Analytics displays a word cloud of most frequently used words and phrases in the short descriptions of open cases, providing insight into emerging issues reported by users.

- Drill down on a word to view other words associated with cases that contain that keyword.
- Search the word cloud for specific terms.

Trend line: Shows the frequency of top keywords over time. Click and move your cursor to view data for any date. Related Records: List of cases containing the keywords you selected from the word cloud.

Proactive Customer Service - Advanced dashboard

The Proactive Customer Service - Advanced dashboard helps customer service managers track key performance indicators (KPIs) to understand how proactive they were in identifying and communicating issues that impact customers. The dashboard also enables customer service managers to assess the business impact of outages over time.
Note:

- Upgrade customers can view the Proactive Customer Service Operations dashboard but should use the new Proactive Customer Service - Advanced dashboard.
- New customers on the Orlando and later releases can only view the Proactive Customer Service - Advanced dashboard.

Overview tab

![Overview tab image]
Note: The Proactive Operations - Event Management tab is only visible if the Proactive Customer Service Operations plugin (com.snc.proactive_cs_itom) is activated.
Outages tab

End user and roles

<table>
<thead>
<tr>
<th>End user</th>
<th>Required role</th>
<th>Benefits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Service Manager</td>
<td>sn_customerservice_manager</td>
<td>Can view the dashboard.</td>
</tr>
<tr>
<td>End user</td>
<td>Required role</td>
<td>Benefits</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Content administrator</td>
<td>pa_admin</td>
<td>Can edit the dashboard and manage users, groups, and roles for the dashboard.</td>
</tr>
<tr>
<td>Content creator</td>
<td>pa_viewer</td>
<td>Can view the dashboard.</td>
</tr>
</tbody>
</table>

**Indicators**
The Proactive Service - Advanced dashboard provides the following key performance indicators:

**Proactive Cases**
Number of active cases with critical and acknowledged alerts.

**Proactive Cases Promoted to a Major Case**
Percentage of proactive cases promoted to a major case.

**Affected Customers and Install Base Items**
Number of customers affected per month.

**Alerts that led to Proactive Case**
Percentage of critical or acknowledge alerts that triggered case creation.

**Active Case Outages**
Number of active case outages per day.

**Average Outage Duration**
Average outage duration per day.

**Outages and Affected Customers**
Number of outages and affected customers per month.

**Outages Types**
Number of outages for each outage type per month.

**Top Impacted Customers**
Customers most impacted by outages.

**Breakdowns**
The following breakdowns apply to the indicators on the dashboard:
• # of Affected Customers
• # of Affected Install Base Items
• # of Outages
• Planned Outages
• Unplanned Outages
• Degradations

Customer Service Management integration with Service Management analytics

The Customer Service Management - Advanced Performance Analytics solution provides indicators for incident, problem, change, and request records associated with customer service cases.

The Customer Service Management - Advanced Performance Analytics solution adds additional indicators. Some of these indicators are automatically displayed on the Customer Service Manager dashboard in the Analysis tab. All the indicators can be viewed in the Analytics Hub or can be manually added to a dashboard.

ℹ️ Note: To view the indicators, you must activate the Customer Service with Service Management plugin (com.sn_cs_sm) and the Customer Service with Request Management plugin (com.sn_cs_sm_request).

Incident indicators:
• Number of Open Cases with Incident
• Number of Closed Cases with Incident

Problem indicators:
• Number of Open Cases with Problem
• Number of Closed Cases with Problem

Change indicators:
• Number of Open Cases with Change
• Number of Closed Cases with Change

Request indicators:
• Number of Open Cases with Request
• Number of Closed Cases with Request
Caused By Change indicators:

- Number of Open Cases Caused By Change
- Number of Closed Cases Caused By Change

To view the indicators in the Analytics Hub, navigate to Performance Analytics > Analytics Hub and search for any of the above indicators.

To add an indicator to a dashboard, a user with the role pa_admin can navigate to the desired dashboard and then click the Add Widgets icon at the top right of the dashboard. Select Performance Analytics from the drop down menu, then click Insights in the list below. Search for the indicator using the search bar. Click the indicator, and then click Add.

**Service Manager homepage**

Use the Service Manager homepage to track and analyze customer service case data.

To view the Service Manager homepage, navigate to Customer Service > Overview.

The Service Manager homepage displays four case-related reports, which are created using the Reports application. You can drill down into these reports for more information about the related cases.
End users and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer service agent manager: Track status of cases and customer satisfaction.</td>
<td>sn_customerservice_manager</td>
</tr>
<tr>
<td>Customer service agent: Track status of cases and customer satisfaction.</td>
<td>sn_customerservice_agent</td>
</tr>
<tr>
<td>Customer service administrator: Can edit the dashboard.</td>
<td>sn_customerservice_admin</td>
</tr>
</tbody>
</table>

Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cases by SLA stage</td>
<td>Pie Chart</td>
<td>Displays the number of cases by SLA stage.</td>
</tr>
<tr>
<td>Open Cases By Priority</td>
<td>Donut</td>
<td>Displays the number of open cases by priority.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Click a priority to show the case list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Click a case from the list to view details.</td>
</tr>
<tr>
<td>Customer Satisfaction</td>
<td>Gauge</td>
<td>Displays the results of the customer satisfaction survey that a customer is asked to take after a case is closed.</td>
</tr>
<tr>
<td>Open Cases By Product</td>
<td>Semi-Donut</td>
<td>Displays the number of open cases for each product.</td>
</tr>
</tbody>
</table>

Major issue management analytics

Provides indicators on the Customer Service dashboards for major cases and child cases.
Action indicators are available on the Customer Service dashboards when the Performance Analytics - Content Pack - Customer Service Management - Advanced plugin (com.snc.pa.customer_service_advanced) is activated.

Note: Activate the Major Issue Management plugin (com.sn_majorissue_mgt) to view the related indicators. Without this plugin, the indicators may not display correctly.

Indicators:
- Number of Open Major Cases (by day, week, month)
- Percentage of Resolved Major Cases (by day, week, month)
- Number of Cases which are Child of Major Case
- Percentage of Major Case Candidates (by day, week, month)
- Percentage of Child Cases which are Auto Created from Major Case
- Number of customers impacted by major issue

Analytics and Reporting Solutions for Self-Service Analytics for Customer Service

Analytics and Reporting Solutions contain prepackaged Performance Analytics and Reporting content for use with other Now Platform products. This Analytics and Reporting Solution quantifies the value of self-service using the Self-Service Analytics dashboard for customer service.

The following roles and tasks are associated with this Solution:
- Now Platform administrator (admin): Install and activate this Analytics and Reporting Solution and make any necessary changes to system properties.
- Performance Analytics administrator (pa_admin): Review the indicators, breakdowns, widgets, and dashboards. Set up and start data collection. Share the dashboards with appropriate stakeholders.
- Customer service manager (sn_customerservice_manager): Use the Self-Service Analytics dashboard to view case metrics to understand the current performance of self-service at your organization.

Related information
- Configure the Analytics and Reporting Solution for Self-Service Analytics for Customer Service
- Analytics and Reporting Solutions
- Self-Service Analytics
Self-Service Analytics dashboard for customer service

Measure and track the effectiveness of self-service content through user activities on a self-service portal to enrich the content and address any self-service gaps.

Self-Service Analytics dashboard for customer service

To edit this dashboard, you must set the application scope to **Self-Service Analytics for Customer Service** using the application picker.

ℹ️ **Note:**
- On the Knowledge tab, you can report knowledge gaps for unsuccessful searches. For more information, see [Report knowledge gaps based on unsuccessful searches](#).
- The Communities tab is available when the Communities plugin (com.sn_communities) is activated.
- The Virtual Agent tab is available when the Glide Virtual Agent plugin (com.glide.cs.chatbot) is activated.

End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer service manager: Can view case metrics like backlog, resolution rates, SLA, customer satisfaction, and KPIs to understand the current performance of self-service at an organization.</td>
<td>sn_customerservice_manager</td>
</tr>
<tr>
<td>Content administrator: Can edit the dashboard and manage users, groups, and roles for the dashboard.</td>
<td>pa_admin</td>
</tr>
<tr>
<td>Content creator: Can view the dashboard.</td>
<td>pa_viewer</td>
</tr>
</tbody>
</table>

ℹ️ **Note:** You don’t need the pa_viewer role to view a dashboard if the user with the pa_admin role or the dashboard owner shares the dashboard with you or a group you belong to.
Use case

Example 1: A user faces an issue with a purchased product. To resolve the issue, the user logs in to the portal, and searches for and views content. However, the user does not find any content helpful and creates a case.

Example 2: A user faces an issue with a purchased product. To resolve the issue, the user logs in to the portal, searches for and views content, marks the content as helpful, and continues to do other activities without creating a case.

In both examples, the self-service content was available. However, in example 1, the user did not find the content helpful and therefore it did not help deflect the case creation. The Self-Service Analytics for Customer Service dashboard enables you to capture not deflected, deflected, or potentially deflected instances with details such as what the user was searching for using the searched terms, the content viewed, and the task created.

Indicators

Indicators define a performance measurement taken at regular intervals of a business service, an activity, or organizational behavior. These performance measurements result in a series of indicator scores over time.

When an administrator activates the Self-Service Analytics for Customer Service plugin (com.snc.pa.self_service_analytics_csm), the Self-Service Analytics PA (com.snc.pa.self_service_analytics) is also activated. Both plugins include indicators for the Self-Service Analytics dashboard for customer service.

The Self-Service Analytics for Customer Service plugin includes the following indicators:

Catalog: Deflections

A monthly count of catalog requests after which the primary activity (case creation) is either found (no deflection) or not found (confirmed or potential deflection) within an activity window.

Communities: Deflections

A monthly count of community content types after which the primary activity (case creation) is either found (no deflection) or not found (confirmed or potential deflection) within an activity window.

Knowledge: Deflections

A monthly count of knowledge articles after which the primary activity (case creation) is either found (no deflection) or not found (confirmed or potential deflection) within an activity window.

Number of cases resolved
A monthly count of resolutions addressed by customer service agents.

Note: The Resolutions by Channel widget on the Overview tab of the Self-Service Analytics dashboard for customer service displays this indicator as Assisted.

Number of Deflections
A monthly count of deflections for all self-service channels (Knowledge, Communities, Catalog, Virtual Agent).

Self-Service: Confirmed Deflections
A monthly count of deflections after which the primary activity (case creation) was not found depending on the activity type (helpful knowledge articles, helpful community content, catalog requests) within an activity window. An increase in value indicates better performance.

Self-Service: Cost Saved
A monthly calculation of the cost saving for a deflection. The score is calculated according to the formula 
$$\text{[[Self-Service: Confirmed Deflections]]} + \text{[[Self-Service: Potential Deflections]]} \times 20.$$  

Note: By default, the cost saved by each deflection is set to $20. However, you can modify the formula and set a different cost. To edit the formula, navigate to Performance Analytics > Formula Indicators, search for and click the Self-Service: Cost Saved indicator, and edit the numeric value in the Formula field. For more information, see Create a formula indicator.

Self-Service: Potential Deflections
A monthly count of deflections after which the primary activity (case creation) was not found depending on the activity type (knowledge articles views, community content views, Virtual Agent conversations) within an activity window. An increase in value indicates better performance.

VA: Deflections
A monthly count of Virtual Agent conversations after which the primary activity (case creation) is not found (potential deflection) within an activity window.

The Self-Service Analytics PA plugin includes the following indicators:

Catalog: Percentage of requests
A monthly calculation of the percentage of catalog usage compared with the use of other self-service channels. The score is calculated according to the formula

\[
\text{Catalog: Success Rate} = \frac{\text{Number of Catalog requests}}{\left(\frac{\text{Catalog: Views this month}}{\text{Knowledge: Articles viewed this month}} + \frac{\text{Communities: Views this month}}{\text{Number of Catalog requests}} + \frac{\text{VA: Conversations this month}}{100}\right)} \times 100.
\]

**Catalog: Views this month**

A monthly count of catalog item views. An increase in value indicates better performance.

**Communities: Helpful Feedback**

A monthly count of helpful Community content types.

**Communities: Percentage of community viewed**

A monthly calculation of the percentage of Community content types usage compared with the usage of other self-service channels. The score is calculated according to the formula

\[
\text{Communities: Views this month} = \frac{\text{Communities: Views this month}}{\left(\frac{\text{Communities: Views this month}}{\text{Knowledge: Articles viewed this month}} + \frac{\text{Knowledge: Articles viewed this month}}{\text{Number of Catalog requests}} + \frac{\text{VA: Conversations this month}}{100}\right)} \times 100.
\]

**Communities: Views this month**

A monthly count of Community content type views. An increase in value indicates better performance.

**Knowledge: Articles viewed this month**

A monthly count of knowledge articles views. An increase in value indicates better performance.

**Knowledge: Helpful Feedback**

A monthly count of knowledge articles marked as helpful or rated either 4 or 5.

**Knowledge: Percentage of articles viewed**

A monthly calculation of the percentage of knowledge articles usage compared with the usage of other self-service channels. The score is calculated according to the formula

\[
\text{Knowledge: Articles viewed this month} = \frac{\text{Knowledge: Articles viewed this month}}{\left(\frac{\text{Knowledge: Articles viewed this month}}{\text{Knowledge: Articles viewed this month}} + \frac{\text{Knowledge: Articles viewed this month}}{\text{Knowledge: Articles viewed this month}} + \frac{\text{Knowledge: Articles viewed this month}}{100}\right)} \times 100.
\]
**Number of Catalog requests**

A monthly count of catalog requests.

**Percentage of helpful Community Content**

A monthly calculation of the percentage indicating the success of Communities as a self-service channel. The score is calculated according to the formula:

\[
\text{Percentage of helpful Community Content} = \frac{\text{Communities: Helpful Feedback}}{\text{Communities: Views this month}} \times 100.
\]

**Percentage of helpful Knowledge Articles**

A monthly calculation of the percentage indicating the success of Knowledge as a self-service channel. The score is calculated according to the formula:

\[
\text{Percentage of helpful Knowledge Articles} = \frac{\text{Knowledge: Helpful Feedback}}{\text{Knowledge: Articles viewed this month}} \times 100.
\]

**Self-Service: Engagements**

A monthly calculation of the total of views from all self-service channels. The score is calculated according to the formula:

\[
\text{Self-Service: Engagements} = \text{Knowledge: Articles viewed this month} + \text{Communities: Views this month} + \text{Catalog: Views this month} + \text{VA: Conversations this month}.
\]

**Self-Service: Success Rate**

A monthly calculation of the percentage indicating the success of self-service channels. The score is calculated according to the formula:

\[
\text{Self-Service: Success Rate} = \frac{\text{Self-Service: Successful Engagements}}{\text{Self-Service: Engagements}} \times 100.
\]

**Self-Service: Successful Engagements**

A monthly count of helpful content from all self-service channels. The score is calculated according to the formula:

\[
\text{Self-Service: Successful Engagements} = \text{Knowledge: Helpful Feedback} + \text{Communities: Helpful Feedback} + \text{Number of Catalog requests} + \text{VA: Successful Conversations}.
\]

**VA: Conversations this month**

A monthly count of Virtual Agent conversations. An increase in value indicates better performance.

**VA: Percentage of Conversations**

A monthly calculation of the percentage of Virtual Agent conversation usage compared with the usage of other self-service channels. The score is calculated according to the formula:

\[
\text{VA: Percentage of Conversations} = \frac{\text{VA: Successful Conversations}}{\text{Self-Service: Engagements}} \times 100.
\]
Conversations this month] / (((Knowledge: Articles viewed this month] + [Communities: Views this month] + [Catalog: Views this month] + [VA: Conversations this month]) * 100.

**VA: Success Rate**

A monthly calculation of the percentage indicating the success of Virtual Agent as a self-service channel. The score is calculated according to the formula \[[VA: Successful Conversations]] / [[VA: Conversations this month]] * 100

**VA: Successful Conversations**

A monthly count of Virtual Agent conversations that were not directed to live agents. An increase in value indicates better performance.

**Breakdowns**

Breakdowns enable you to group or filter indicator scores by a qualitative attribute.

This dashboard includes the following breakdowns:

**Channel**

Enables you to view indicator scores by a self-service channel such as Knowledge, Communities, Catalog, or Virtual Agents.

**Communities Content Type**

Enables you to view indicator scores by a Community content type such as answer, blog, comment, document, event, question, or video.

**Knowledge Base**

Enables you to view indicator scores by knowledge base.

**Knowledge Category**

Enables you to view indicator scores by knowledge article category.

**Type of Deflection**

Enables you to view indicator scores by deflection type: no deflection, confirmed deflection, and potential deflection.
Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unsuccessful Searches</td>
<td>Bar</td>
<td>A monthly collection of searches for knowledge articles with no results or results with no clicks.</td>
</tr>
</tbody>
</table>

Related information

Self-Service Analytics

Report knowledge gaps based on unsuccessful searches

Report a knowledge gap from the Unsuccessful Searches report in the Self-Service Analytics dashboard for customer service.

Before you begin

Role required: sn_customerservice_manager

About this task

The Unsuccessful Searches report in the Self-Service Analytics dashboard for customer service reports a collection of searches for knowledge articles with no results or results with no clicks. You can report a knowledge gap for such unsuccessful searches.

Procedure

1. Navigate to Self-Service > Dashboards.
2. Click Self-Service Analytics.
3. On the Knowledge tab, on the Unsuccessful Searches report, click a bar.
5. In the Description field, describe the knowledge gap.
   By default, the Description field shows frequently appearing words in the associated collection. You can also enter custom instructions for addressing the knowledge gap. When entering instructions, you can provide a summary of your analysis so that knowledge authors have the necessary information to create an article from the feedback task.
6. Click Submit.

Results

If a collection is reported as a knowledge gap, a feedback task of type Unsuccessful search is created in the Knowledge Management application.
If the assignment rules are set, the feedback task is assigned to an ownership group or an author.

Related information
Self-Service Analytics dashboard for customer service

Customer Service Management reference
Reference topics provide additional information about Customer Service Management cases, including lists and forms.

Customer service cases list
The Cases list displays a list of customer service cases for the current user.

Users with the sn_customerservice_agent or sn_customerservice_manager roles can view the Cases list in the Customer Service Management application. The default view of the Cases list includes the following columns:

- Number
- Short description
- Contact
- Account
- Channel
- State
- Priority
- Assigned to
- Updated
- Case Report (add a column to access this table if needed)

External customers can view a list of cases from the customer portal. For external users with the sn_customerservice.customer or sn_customerservice.customer_admin roles, the Cases list displays a subset of case information, including:

- Number
- Short description
- Product
- Priority
• State
• Updated

For external users with the sn_customerservice.partner or sn_customerservice.partner_admin roles, the Account column is also displayed.

**Cases displayed in the Case list by user role**
The cases included in the Case list are determined by user role.

<table>
<thead>
<tr>
<th>User Role</th>
<th>Cases Included in Case List</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal roles</td>
<td></td>
</tr>
<tr>
<td>sn_customerservice_admin</td>
<td>All cases</td>
</tr>
<tr>
<td>sn_customerservice_manager</td>
<td>All cases</td>
</tr>
<tr>
<td>sn_customerservice_agent</td>
<td>All cases</td>
</tr>
<tr>
<td>External roles</td>
<td></td>
</tr>
<tr>
<td>sn_customerservice.customer_admin</td>
<td>• Cases created for the customer administrator’s account</td>
</tr>
<tr>
<td></td>
<td>• Cases created by contacts who have a contact relationship with the customer administrator’s account</td>
</tr>
<tr>
<td>Note: A contact relationship enables a contact with the customer role or customer admin role to manage the account for which the contact relationship has been established.</td>
<td></td>
</tr>
<tr>
<td>sn_customerservice.customer</td>
<td>• Cases created by the customer</td>
</tr>
<tr>
<td></td>
<td>• Cases created by an agent for the customer</td>
</tr>
<tr>
<td>User Role</td>
<td>Cases Included in Case List</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>---------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>sn_customerservice.partner_admin</td>
<td>• Cases created by the partner:</td>
</tr>
<tr>
<td></td>
<td>◦ For their own account</td>
</tr>
<tr>
<td></td>
<td>◦ For a customer account</td>
</tr>
<tr>
<td></td>
<td>• Cases created for the partner administrator’s account</td>
</tr>
<tr>
<td>sn_customerservice.partner</td>
<td>• Cases created by the partner</td>
</tr>
<tr>
<td></td>
<td>• Cases created by an agent for the partner</td>
</tr>
<tr>
<td></td>
<td>• Cases created for the same account</td>
</tr>
<tr>
<td></td>
<td>• Cases created from a partner account</td>
</tr>
</tbody>
</table>

**Customer service case form**

The Case form displays detailed information about a customer issue or problem.

A customer service agent creates a case to identify a customer's question or issue and to track the activities related to resolving the issue. An agent also uses a case to track communication to and from the customer, including the communication channels being used.

Case activities include any action that is taken to resolve an issue. This can include phone calls or emails, knowledge base research, conversations with subject matter experts, and dispatch requests to field service agents, as well as other activities.

From the Case form, an agent can associate and store the related information, such as the customer's name, phone number, and company; account information; product and asset information; service contract and entitlement details, and any associated service level agreements (SLAs).

There are several key features to a case.
• Communication between an agent and the customer or an agent and other employees within the organization. Details of all internal and external communication are recorded on the Case form.

• Any additional tasks that result from a case, such as a work order. Tasks are tracked from a related list on the Case form. These tasks may be internal to the organization or they may involve the customer.

• Information from the case that can be included in the knowledge base and used to help resolve other cases.

There are two different Case form views: a detailed view that is available to agents and agent managers in the Customer Service Management application and a simplified view that is available to external customers from the Customer and Consumer Service Portals.

Agent view
The agent view of the Case form includes the following components:

• A timeline that provides a visual display of case activities.

• Referenced entities for the case including account and contact information, product and asset information, service contract and service entitlement details, and any pertinent SLAs. Except for SLAs, this information exists in the system and can be associated with the case by the agent or agent manager.

• All communication about the case, both external and internal. This information is stored in the Additional comments field (external communication), the Work notes field (internal communication), the Resolution notes field. The Resolution notes field stores details about the case resolution, and the Activity field, which stores all communication in a chronological list.

Agents and managers can view a Case form by navigating to Customer Support > Cases and selecting one of the following menu options:

• My Cases
• All
• Open
• Unassigned

From the Case list, click a case number to display the Case form.
### Customer Service Case form (agent view)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The automatically assigned case number.</td>
</tr>
<tr>
<td>Channel</td>
<td>The method by which the customer initiated contact and the case was opened.</td>
</tr>
<tr>
<td></td>
<td>• Web (default)</td>
</tr>
<tr>
<td></td>
<td>• Phone</td>
</tr>
<tr>
<td></td>
<td>• Email</td>
</tr>
<tr>
<td></td>
<td>• Chat</td>
</tr>
<tr>
<td></td>
<td>• Social</td>
</tr>
<tr>
<td>Contact Local Time</td>
<td>The local time of the contact assigned to the case.</td>
</tr>
<tr>
<td></td>
<td>It is automatically filled according to the time zone set on the Contact form. If no time zone is set on the Contact form, it is filled according to the Contact Timezone set on the case itself.</td>
</tr>
<tr>
<td></td>
<td>If no time zone is set on the Contact form or in the case, the field is left blank and is read-only.</td>
</tr>
<tr>
<td></td>
<td>If a case is closed or canceled, the Contact Local Time field is hidden.</td>
</tr>
<tr>
<td></td>
<td>Note: Configure the form layout to add this field to the Case form.</td>
</tr>
<tr>
<td>Contact time zone</td>
<td>The contact time zone if the customer is working in a different time zone for the case. It overrides the Contact form time zone.</td>
</tr>
<tr>
<td></td>
<td>If no contact local time or contact time zone is set, the instance time zone is displayed.</td>
</tr>
<tr>
<td></td>
<td>Once the case is created, the field is read-only.</td>
</tr>
<tr>
<td></td>
<td>Note: Configure the form layout to add this field to the Case form.</td>
</tr>
<tr>
<td>Account</td>
<td>The name of the contact’s company. This field is filled automatically if the information is available in the contact record.</td>
</tr>
<tr>
<td>Contact</td>
<td>The name of the customer contact for this case.</td>
</tr>
<tr>
<td>Product</td>
<td>The product model of the asset. A model is a specific version or configuration of an asset (for example, Apple Mac Book Pro).</td>
</tr>
</tbody>
</table>
### Customer Service Case form (agent view) (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Asset</strong></td>
<td>The asset tag number or the serial number of the asset involved in this case.</td>
</tr>
<tr>
<td><strong>Partner Contact</strong></td>
<td>The name of the partner contact for this case.</td>
</tr>
<tr>
<td><strong>Follow the sun</strong></td>
<td>A check box to indicate that a case should be handed-off for global follow-up.</td>
</tr>
<tr>
<td></td>
<td>If a customer enters additional comments on a <strong>Priority 1 - Critical</strong> or a <strong>Priority 2 - High</strong> case, or if the case is escalated, the flag is automatically selected. You can also manually select the check box. The activity stream on the case form is updated with any changes.</td>
</tr>
<tr>
<td><strong>Short description</strong></td>
<td>A brief description of the issue or problem.</td>
</tr>
<tr>
<td><strong>Opened</strong></td>
<td>The date and time that the case was opened.</td>
</tr>
<tr>
<td><strong>Priority</strong></td>
<td>The assigned priority:</td>
</tr>
<tr>
<td></td>
<td>• 1 — Critical</td>
</tr>
<tr>
<td></td>
<td>• 2 — High</td>
</tr>
<tr>
<td></td>
<td>• 3 — Moderate</td>
</tr>
<tr>
<td></td>
<td>• 4 — Low (default)</td>
</tr>
<tr>
<td><strong>State</strong></td>
<td>Customer service case states:</td>
</tr>
<tr>
<td></td>
<td>• New</td>
</tr>
<tr>
<td></td>
<td>• Open</td>
</tr>
<tr>
<td></td>
<td>• Awaiting Info</td>
</tr>
</tbody>
</table>

---

**Note:** Enable the **Follow the sun** check box on the Customer Service case form by setting the value of the property `sn_customerservice.FTS_flag_enabled` to **true**. Configure the form layout to add this field to the Case form.
**Customer Service Case form (agent view) (continued)**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Resolved</td>
<td></td>
</tr>
<tr>
<td>• Closed</td>
<td></td>
</tr>
<tr>
<td>• Canceled</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Configure the form layout to add this field to the Case form

<table>
<thead>
<tr>
<th>Assignment group</th>
<th>The assigned customer service agent group.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigned to</td>
<td>The assigned agent. If a group is selected in the <strong>Assignment group</strong> field, the assigned agent must belong to this group.</td>
</tr>
<tr>
<td>Assigned on</td>
<td>The data and time when the case is assigned. This field is updated when a user is added or changed in the <strong>Assigned to</strong> field.</td>
</tr>
<tr>
<td>Contract</td>
<td>The contract number associated with this case.</td>
</tr>
<tr>
<td>Entitlement</td>
<td>The entitlement associated with this case. The entitlements available for selection in the reference list channel matches the case creation channel. The available entitlements are filtered by the settings in the <strong>Account</strong>, <strong>Contract</strong>, <strong>Product</strong>, <strong>Asset</strong> fields. If only one entitlement is available for this case, it is automatically added to the <strong>Entitlement</strong> field.</td>
</tr>
<tr>
<td>Partner</td>
<td>The name of the partner company.</td>
</tr>
<tr>
<td>Notes</td>
<td></td>
</tr>
<tr>
<td>Watch list</td>
<td>Users who receive notifications about this case when additional comments are added or if the state of a case is changed to <strong>Resolved</strong> or <strong>Closed</strong>. Click the add me icon to add yourself to the watch list.</td>
</tr>
<tr>
<td>Work notes list</td>
<td>Internal users who receive a notification about this case when work notes are added. You can only add internal users to the work notes list. Click the add me icon to add yourself to the work notes list.</td>
</tr>
</tbody>
</table>
### Customer Service Case form (agent view) (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Contributor Users**| When a user with the case task agent role (sn_customerservice.case_task_agent) is assigned to a case task, the user is added to the **Contributor Users** field.  
If this user is removed from the **Assigned to** field on the Case Task form, and they are not assigned to any other tasks for the case, they are also removed from the **Contributor Users** field. |
| **Contributor Groups**| When a user with the case task agent role (sn_customerservice.case_task_agent) is assigned to a case task, the user's assignment group is added to the **Contributor Groups** field.  
If this user is removed from the **Assigned to** field on the Case Task form, and no other member of their assignment group is assigned to any other tasks for the case, the assignment group is removed from the **Contributor Groups** field.  
If a group is removed from the **Assignment group** field on the Case Task form, and the group is not assigned to any other tasks for the case, the assignment group is removed from the **Contributor Groups** field. |
| **Additional comments**| Customer-viewable comments. Each comment is inserted into the **Activity** field when the user clicks the **Post** button.                                                                                                          |
| **Work notes**       | Information about how to resolve the case, or steps taken to resolve it, if applicable.  
Internal users who have been added to the Work notes list receive the Case work notes added notification containing the work notes when added.  
You can configure the notification, as required. The notes are viewable by the admin, agent, and agent manager.                                                                                   |
| **Activities**       | Records all activity associated with this case.                                                                                                                                                                                  |
| **Resolution Information** |                                                                                                                                                                                                                           |
| **Resolved by**      | The agent to whom the case is assigned when the case is resolved.                                                                                                                                                      |
| **Closed by**        | The name of the user who closed the case.                                                                                                                                                                                      |
Customer Service Case form (agent view) (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution Code</td>
<td>Choice list indicating the resolution states for the case.</td>
</tr>
<tr>
<td></td>
<td>This field is mandatory when an agent proposes a solution for a case.</td>
</tr>
<tr>
<td>Cause</td>
<td>Details about the cause of the resolution.</td>
</tr>
<tr>
<td>Resolution notes</td>
<td>Details about how the case was closed. This field is mandatory if an</td>
</tr>
<tr>
<td></td>
<td>customer service agent or agent manager closes a case. If an agent</td>
</tr>
<tr>
<td></td>
<td>closes a case, it is not mandatory.</td>
</tr>
<tr>
<td>Add resolution notes</td>
<td>A check box to determine if the resolution notes are added to</td>
</tr>
<tr>
<td>to comments</td>
<td>customer-viewable comments when the case is resolved. If selected, the</td>
</tr>
<tr>
<td></td>
<td>resolution notes are added to the Additional comments (customer-visible)</td>
</tr>
<tr>
<td></td>
<td>field. By default, the check box is cleared.</td>
</tr>
<tr>
<td>Resolved</td>
<td>The date and time that the case was resolved.</td>
</tr>
<tr>
<td>Closed</td>
<td>The date and time that the case was closed.</td>
</tr>
</tbody>
</table>

**Customer view**

Customers can view a Case form by clicking **My Cases** on the customer portal and then clicking a case number from their Case list.

The customer view of the Case form includes the following components:

- A process flow formatter that indicates the current state of the case.
- The related entity information, including account and contact information, product and asset information, and service contract information.
- An **Activity** field that stores all communication for the case in a chronological list.

**Customer service case timeline**

The timeline provides a visual display of case activities. The timeline appears at the top of the Case form when viewed by an agent or manager in the Customer Service Management application.

The timeline uses blue circles to represent case state changes and markers to represent case activities. The information included in the timeline is also shown on the Case form in the **Activity** history.
Customer Service Case Timeline

Header
The timeline header displays the time that the case began. It also displays the time that the case was either last updated or closed.

State changes and case activities
Each state change for a case is represented by a blue circle on the timeline. Pointing to these circles provides more information about the state change in a tooltip. For example, pointing to the first blue circle that represents the New state displays the name of the user who created the case and the approximate time that the case was created.

Activity lines above and below the timeline represent other case activities, including comments, information requests, close notes, email, and phone calls. Activities performed by an agent are shown above the timeline and activities performed by a customer are shown below. Pointing to these activities on the timeline displays additional information.

Overlapping states and conversations are represented by thicker borders and thicker lines. Pointing to overlapped states and conversations results in grouped tooltips.

If a case is ongoing, the end of the timeline shows the last updated activity or state change. If a case is closed, the end of the timeline shows a blue circle that represents the Closed state.

Time metric
The metric to the right of the timeline tracks the amount of time that a case is open. The date and time that the case was opened is used as the start of the time calculation. When a case is ongoing, the current time is used as the end time calculation. When a case is closed, the close time is used as the end time calculation.

The metric breaks down the time by the number of minutes and hours that a case is with the agent or with the customer. A case is considered to be with the agent when it is in the New, Open, or Closed state.

When a case is in the Awaiting Info or Resolved state, it is considered to be with the customer.
Use the Customer Service case timeline with other applications

You can use the Customer Service case timeline with other ServiceNow applications by creating a configuration for each application and adding the ResolutionShaper field to the desired form.

Before you begin
Role required: admin

Procedure
1. Ensure that the Customer Service plugin (com.sn_customerservice) has been activated.
2. Navigate to the Resolution Shaper Configs page (sys_resolutionshaper_config_list.do) and click New.
3. Select a table in the Task Table field.
4. Add the desired states in the Requestor States field using a comma-separated list. For example, New,Active,Resolved,Closed.
5. Make any necessary changes to the remaining fields and click Submit.
6. Navigate to the desired form.
7. Right-click the form header and select Configure > Form Layout.
8. Using the slushbucket, select ResolutionShaper and move it to where you want the timeline to appear.
9. Click Save.

Customer service case process flow formatter
The process flow formatter provides a graphical summary of the stages of a customer service case.

The process flow formatter appears at the top of the Case form. It highlights the current state of the case and checks off the states through which the case has passed.
By default, the process flow formatter displays the following states:

- New
- Open
- Resolved
- Closed

**Related information**

**Process flow formatter**

**Customer service case form related lists**

The Case form includes related lists that store case information and that agents can use to perform case-related tasks.

<table>
<thead>
<tr>
<th>Related List</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLAs</td>
<td>The service level agreements that are associated with this case.</td>
</tr>
</tbody>
</table>
| Tasks        | Tasks that have been created for this case by the customer service agent or agent manager. When you create a task or change the state of a task, the information is recorded in the case **Activity** field. When you create a case task, the system generates a task number with a prefix. Following upgrade to the New York release:
  - New case tasks use the CSTASK prefix.
  - Existing tasks, regardless of state, use the TASK prefix. |
| Phone        | The case phone log. A list of incoming or outgoing phone calls associated with this case. |
| Appointments | Appointments that the customer service agent makes with the customer or others as part of resolving this case. When you create an appointment, an appointment creation message is recorded in the case **Activity** field. The user selected in the **To** field on the appointment form receives an email with the appointment details. |
### Customer service case form related lists (continued)

<table>
<thead>
<tr>
<th>Related List</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Emails</td>
<td>The case email log. A list of the emails that are sent or received as part of resolving this case. The customer service agent or agent manager can send email from within the case, such as updates and inquiries to customers or other employees. A change in the state of the case triggers an automatic email to be sent to the customer. Customer contacts can create and update cases by email as well as receive updates from customer service agents.</td>
</tr>
<tr>
<td>Related Cases</td>
<td>A list of cases created for the same account or contact.</td>
</tr>
<tr>
<td>Problems</td>
<td>A list of problems related to this case.</td>
</tr>
<tr>
<td>Work Orders</td>
<td>A list of work orders created for this case.</td>
</tr>
<tr>
<td>Social Logs</td>
<td>A list of the communication with customers or consumers that takes place through social media channels. The Social Log form includes the Social Profile of the user that created the communication and the Social URL for the conversation. Click the URL to open the conversation in a new tab.</td>
</tr>
<tr>
<td>Attached Knowledge</td>
<td>Knowledge articles attached as a proposed solution to the case.</td>
</tr>
<tr>
<td>Knowledge Gaps</td>
<td>Feedback tasks that are created when a knowledge gap is reported.</td>
</tr>
<tr>
<td>Escalations</td>
<td>A list of escalation records that are related to this case.</td>
</tr>
<tr>
<td>Child Cases</td>
<td>A list of child cases associated with this case</td>
</tr>
<tr>
<td>Requests</td>
<td>A list of requests associated with this case.</td>
</tr>
<tr>
<td>Blocked by</td>
<td>A list of blocking tasks that have been created for this case.</td>
</tr>
</tbody>
</table>

### Customer service case states

A customer service case can be in one of several states.
## Customer service case states

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>The initial state for a new case, which is created through any one of the channels: customer portal, email, chat, telephone, or from the Customer Service application. Actions the agent can take:</td>
</tr>
<tr>
<td></td>
<td>• Assign to me: The case is assigned to the agent and the state changes to <strong>Open</strong>.</td>
</tr>
<tr>
<td></td>
<td>• Accept: If assigned by the customer service manager, the agent accepts the case and the state changes to <strong>Open</strong>.</td>
</tr>
<tr>
<td></td>
<td>• Update: updates the case.</td>
</tr>
<tr>
<td></td>
<td>• Close Case: Closes the case.</td>
</tr>
<tr>
<td></td>
<td>• Delete: Deletes the case.</td>
</tr>
<tr>
<td></td>
<td>Actions the customer can take:</td>
</tr>
<tr>
<td></td>
<td>• Update: updates the case.</td>
</tr>
<tr>
<td></td>
<td>• Close Case: Closes the case</td>
</tr>
<tr>
<td>Open</td>
<td>The case is assigned to an agent and the agent clicks <strong>Accept</strong> or an agent opens a case and clicks <strong>Assign to me</strong>. Both of these actions change the state from <strong>New</strong> to <strong>Open</strong>. Actions the agent can take:</td>
</tr>
<tr>
<td></td>
<td>• Update: Updates the case.</td>
</tr>
<tr>
<td></td>
<td>• Request Info: The agent requests additional information from the customer. The state changes to <strong>Awaiting Info</strong>.</td>
</tr>
<tr>
<td></td>
<td>• Propose Solution: The agent proposes a solution for the case.</td>
</tr>
<tr>
<td></td>
<td>🔄 Note: The Resolution Code and Resolution notes must be entered in the Resolution Information tab.</td>
</tr>
<tr>
<td></td>
<td>The state changes to <strong>Resolved</strong>.                                                                ---------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>• Close Case: Closes the case.</td>
</tr>
<tr>
<td></td>
<td>• Delete: Deletes the case.</td>
</tr>
<tr>
<td>Awaiting Info</td>
<td>An agent clicks <strong>Request Info</strong>, changing the state from <strong>Open</strong> to <strong>Awaiting Info</strong>. Actions the agent can take:</td>
</tr>
</tbody>
</table>
### Customer service case states (continued)

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Case</td>
<td>Changes the state back to <strong>Open</strong>.</td>
</tr>
<tr>
<td>Update</td>
<td>Updates the case</td>
</tr>
<tr>
<td>Close Case</td>
<td>Closes the case</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the case</td>
</tr>
</tbody>
</table>

Actions the customer can take:
- **Update**: Once the customer updates the case, the state changes to **Open**.
- **Close Case**: Closes the case.

Resolved

An agent provides a resolution code and enters resolution notes in the **Resolution Information** tab and clicks **Propose Solution**, changing the state from **Awaiting Info** to **Resolved**.

The **Resolution code** and **Resolution notes** fields are mandatory when an agent proposes a solution for the case.

Actions the agent can take:
- **Update**: Updates the case
- **Close Case**: Closes the case.

Actions the customer can take:
- **Accept Solution**: The customer accepts the solution proposed by the agent. The state changes to **Closed** and a survey is displayed.
- **Reject Solution**: The customer rejects the solution proposed by the agent and the state changes to **Open**.
- **Delete**: Deletes the case.

Closed

After proposing a solution, an agent waits for the customer to respond.

- If the customer clicks **Accept Solution**, the state changes from **Resolved** to **Closed**.
- If the customer clicks **Reject Solution**, the state changes from **Resolved** to **Open**.

An agent, agent manager, or a customer can close a case at any time, except when it is in the **Resolved** state. When it is in the
Customer service case states (continued)

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolved state</td>
<td>only a customer can accept or reject the proposed solution. When an agent or agent manager closes a case, details must be included in the Resolution notes. This is not required when a customer closes a case.</td>
</tr>
<tr>
<td></td>
<td>A case cannot be updated once it is closed.</td>
</tr>
</tbody>
</table>

Related information
State flows

Customer Service Case Report form

The Case Report form includes reporting-related fields that are derived from case records.

The Case Report table (sn_customerservice_case_report) extends from the Customer Service Case table (sn_customerservice_case). This table stores KPIs and metrics for case records and includes the following calculated metrics which are displayed on the Customer Service Manager dashboard.

- Agent Reassignment Count
- First Contact Resolution
- Reopen Count

The Customer Service Manager dashboard includes the First Call Resolution indicator, which shows the percentage of cases that were resolved during the first contact with the customer. The percent change in the current period appears under the total percentage. The value for the First Call Resolution indicator is returned by the CaseReportUtils script include.

Customer Service Case Report form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The automatically generated case report number.</td>
</tr>
<tr>
<td>First Contact Resolution</td>
<td>Records whether a case was resolved during a customer’s first contact with an agent. This field can have one of the following values:</td>
</tr>
</tbody>
</table>
### Customer Service Case Report form fields (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• 0: None (default value)</td>
</tr>
<tr>
<td></td>
<td>• 1: True</td>
</tr>
<tr>
<td></td>
<td>• 2: False</td>
</tr>
<tr>
<td></td>
<td>For more information about how this field is calculated, see First Call Resolution (FCR) metric below.</td>
</tr>
<tr>
<td>Agent Reassignment Count</td>
<td>The number of times that a case has been reassigned to a different agent. The default value is 0.</td>
</tr>
<tr>
<td>Reopen Count</td>
<td>The number of times a case has been closed and reopened. The default value is 0.</td>
</tr>
<tr>
<td>Skipped by Prediction</td>
<td>Used to identify cases that are skipped by the Predictive Intelligence feature. The default value is false (disabled).</td>
</tr>
<tr>
<td>Case</td>
<td>The case for which this case report was generated.</td>
</tr>
<tr>
<td>Customer Satisfaction Score</td>
<td>The customer gives the customer satisfaction score on accepting the case resolution.</td>
</tr>
<tr>
<td>Time to Resolve</td>
<td>Time taken by an agent to resolve the case. Calculated as the difference between the case resolved time and case created time.</td>
</tr>
</tbody>
</table>

---

### First Call Resolution (FCR) metric

The First Call Resolution (FCR) metric relates to the number of times that a customer request is resolved during the first contact with an agent. Out of box, the First Call Resolution script returns a value of true or false.

FCR is true if a record has one update. For example, if the state of a new case is set to Closed and then updated or saved, the FCR value is True.

FCR is false if:
- A case is reopened.
- The state of a case is updated to Awaiting Info.
- An Openframe phone record exists for the case and the date of that record is prior to the case resolution date.
• An email log exists for the case, the email was not created by the system, and the email creation date is prior to the case resolution date.

• A work order entry exists for the case and the date of that work order is prior to the case resolution date.

Customer Service Case Type form

Use the Case Type form to manage the settings for a case type.

To access a Case Type form, navigate to Customer Service > Case Types > Manage Case Types and select a case type from the list.

Customer Service Case Type form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>The table for the case type that extends the Case table (sn_customerservice_case).</td>
</tr>
</tbody>
</table>
| Category    | An optional category for a case type. When creating cases, customer service agents can filter the available case types by category in the Select Case Type popup window. The Customer Service Case Types plugin (com.snc.csm_case_types) includes the following categories:  
  • Onboarding  
  • Complaint  
  • Orders  
  • General  |
| Subtype     | An optional sub-category for a case type. When creating cases, customer service agents can filter the available case types by category and then by subtype in the Select Case Type popup window. The Subtype field displays fields from the selected Table that are of the following type:  
  • Choice list  
  • Reference  |
| Short description | A brief description of the case type.                                      |

Related links

The Case Type form includes the following related links:
• **View Case Type Configuration**: View the current configuration for this case type table.

• **Launch Guided Setup for Case Types**: Go to the Case Types setup tasks in Customer Service Guided Setup.

• **Launch Guided Setup for AWA**: Go to the Advanced Work Assignment (AWA) setup tasks in Agent Workspace Guided Setup.

• **Launch Guided Setup for Agent Workspace**: Go to the Agent Workspace for CSM setup tasks in CSM Guided Setup.

**Related lists**
The Case Type form related lists display items configured for the case type table. Use the related lists to create additional configurations.

- Record Producers
- State Flows
- Special Handling Notes
- Notification Triggers
- SLAs
- Email Templates
- Quick Messages
- Reports

**Customer Service Account form**
The Customer Service Management application uses the Account form to store customer account information.

**Customer Service Account form fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the company.</td>
</tr>
<tr>
<td>Number</td>
<td>The automatically generated account number for this customer.</td>
</tr>
<tr>
<td>Primary Contact</td>
<td>The name of a user who is the main contact for this company.</td>
</tr>
<tr>
<td>Parent Account</td>
<td>The parent account for this account. Use this field to create an Account hierarchy.</td>
</tr>
</tbody>
</table>
### Customer Service Account form fields (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Registration Code</td>
<td>A unique code for this account. The customer administrator can provide this code to customers for use when requesting a login on the customer portal. The registration code provides a method for validating the customer and the company before the login request is granted. Enter an alphanumeric code in this field or click the Generate Code icon to generate a unique code.</td>
</tr>
<tr>
<td>Customer</td>
<td>Denotes this account as a customer account.</td>
</tr>
<tr>
<td>Note:</td>
<td>If you are creating a customer account, this field is enabled by default.</td>
</tr>
<tr>
<td>Partner</td>
<td>Denotes this account as a partner account. A partner can report and manage cases on behalf of customers. A partner can also be a customer.</td>
</tr>
<tr>
<td>Note:</td>
<td>If you are creating a partner account, this field is enabled by default.</td>
</tr>
<tr>
<td>Website</td>
<td>The web address for the company.</td>
</tr>
<tr>
<td>Phone</td>
<td>The phone number for the company.</td>
</tr>
<tr>
<td>Street</td>
<td>The street address of the company.</td>
</tr>
<tr>
<td>City</td>
<td>The city in which the company is located.</td>
</tr>
<tr>
<td>State/Province</td>
<td>The state or province in which the company is located.</td>
</tr>
<tr>
<td>Zip/Postal code</td>
<td>The zip code or postal code for the company.</td>
</tr>
<tr>
<td>Country</td>
<td>The country in which the company is located</td>
</tr>
<tr>
<td>Notes</td>
<td>Any additional information about the company.</td>
</tr>
</tbody>
</table>

### Customer Service Contact Relationship form

The Customer Service Management application uses the Contact Relationship form to store information about the account, contact, and assigned responsibility in a contact relationship.
<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>The account to which the contact is assigned. This field is automatically filled in.</td>
</tr>
<tr>
<td>Contact</td>
<td>The customer contact selected to fulfill the role or responsibility. The Contacts list includes contacts from any related partner or account as well as contacts from the account hierarchy.</td>
</tr>
<tr>
<td>Responsibility</td>
<td>The role or responsibility selected for this customer contact.</td>
</tr>
</tbody>
</table>

**Note:** As part of creating a responsibility definition, the admin can specify if the responsibility is unique. If so, the responsibility can only be assigned to one contact per account. For more information, see Create account teams.

### Asset form

The Asset Management application uses the Asset form to store asset information.

### Asset record fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the asset as it appears in record lists. Automatically set when asset is created, based on Asset Tag and Model fields.</td>
</tr>
<tr>
<td>Model category</td>
<td>Model grouping of the asset. Based on the model category selected, the asset can be linked to a configuration item.</td>
</tr>
<tr>
<td>Model</td>
<td>Specific product model of the asset.</td>
</tr>
<tr>
<td>Configuration Item</td>
<td>CI automatically created when this asset is created. The name that appears in this field is based on Serial number and Model. Point to the reference icon to see the configuration item details inherited from the asset record.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Number of items this asset represents. An asset always has a quantity of one unless one or more of these points are true.</td>
</tr>
</tbody>
</table>
## Asset record fields (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• It is a consumable. Quantity is unrestricted because consumables are tracked in groups.</td>
</tr>
<tr>
<td></td>
<td>• It is pre-allocated. Quantity is unrestricted when Model category and Model are defined and Substate is set to Pre-allocated.</td>
</tr>
<tr>
<td>General</td>
<td>Not all fields are available for each type of asset.</td>
</tr>
<tr>
<td>Asset tag</td>
<td>Alphanumeric information assigned by your organization to help track the asset.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the asset, such as On order or In use.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Person using or primarily responsible for this item. This field is visible when the asset state is In Use.</td>
</tr>
<tr>
<td>Managed by</td>
<td>Person who maintains the asset. This can be different from the person in the Owned by field.</td>
</tr>
<tr>
<td>Owned by</td>
<td>Person who has financial ownership of the asset. This can be different from the person in the Managed by field.</td>
</tr>
<tr>
<td>Parent</td>
<td>Parent asset of the asset. For example, a monitor or peripheral can have a workstation as their parent asset. When a parent link is defined,</td>
</tr>
<tr>
<td></td>
<td>the fields related to assignment and state of the child assets is set to read-only and are populated based on the parent assignment and state</td>
</tr>
<tr>
<td></td>
<td>fields. For more information, see Creating Bundled Models.</td>
</tr>
<tr>
<td>Class</td>
<td>Asset group, for example, base, hardware, license, or consumable.</td>
</tr>
<tr>
<td>Comments</td>
<td>Information about the asset that would be helpful for others to know.</td>
</tr>
<tr>
<td>Serial number</td>
<td>Serial number of this asset.</td>
</tr>
<tr>
<td>Substate</td>
<td>Current substate of the asset. The available substate settings depend on the state selected. For example, the Retired state contains the</td>
</tr>
<tr>
<td></td>
<td>Substate options Disposed, Sold, Donated, and Vendor credit.</td>
</tr>
<tr>
<td>Location</td>
<td>Current physical location of the asset.</td>
</tr>
</tbody>
</table>
**Asset record fields (continued)**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department</td>
<td>Department to which the asset belongs.</td>
</tr>
<tr>
<td>Company</td>
<td>Company or organization to which this asset belongs.</td>
</tr>
<tr>
<td>Assigned</td>
<td>Date on which the asset was assigned to a user.</td>
</tr>
<tr>
<td>Installed</td>
<td>Date on which the asset was installed.</td>
</tr>
<tr>
<td><strong>Financial</strong></td>
<td></td>
</tr>
<tr>
<td>Request line</td>
<td>Requested item to which the asset is linked.</td>
</tr>
<tr>
<td>Invoice number</td>
<td>Invoice under which the asset was billed.</td>
</tr>
<tr>
<td>Cost</td>
<td>Price at which the asset was purchased.</td>
</tr>
<tr>
<td>Vendor</td>
<td>Vendor from which the asset was purchased. For assets automatically created from purchase orders in Procurement, the default value of the Vendor field is the vendor specified on the purchase order.</td>
</tr>
<tr>
<td>Opened</td>
<td>Date on which the requested item record was opened. The system automatically populates the field when a request line is specified.</td>
</tr>
<tr>
<td>GL account</td>
<td>General ledger account number with which the asset is associated.</td>
</tr>
<tr>
<td>Cost center</td>
<td>Group financially responsible for the asset.</td>
</tr>
<tr>
<td>Acquisition method</td>
<td>How the asset was acquired. Base system choices are Purchase, Lease, Rental, and Loan. For assets automatically created from purchase orders in Procurement, the default value is Purchase.</td>
</tr>
<tr>
<td>Expenditure type</td>
<td>The type of expenditure.</td>
</tr>
<tr>
<td>• Capex:</td>
<td>Capital expenditure is a one-time expenditure, where the value is realized over the years. For example, a photocopier.</td>
</tr>
<tr>
<td>• Opex:</td>
<td>Operational expenditure is an on-going expenditure. For example, toners for the photocopier.</td>
</tr>
</tbody>
</table>
### Asset record fields (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disposal order number</td>
<td>A unique number assigned to the asset disposal order.</td>
<td>This field appears only if you have installed Hardware Asset Management from the ServiceNow Store.</td>
</tr>
<tr>
<td>Disposal vendor</td>
<td>The vendor assigned to carry out the asset disposal order.</td>
<td>This field appears only if you have installed Hardware Asset Management from the ServiceNow Store.</td>
</tr>
<tr>
<td>Vendor disposal order ID</td>
<td>Order number assigned by the vendor assigned to carry out the asset disposal order.</td>
<td>This field appears only if you have installed Hardware Asset Management from the ServiceNow Store.</td>
</tr>
<tr>
<td>Disposal date</td>
<td>The date when the asset disposal order process is completed.</td>
<td>This field appears only if you have installed Hardware Asset Management from the ServiceNow Store.</td>
</tr>
<tr>
<td>Disposal reason</td>
<td>Text explaining why the asset is being retired.</td>
<td></td>
</tr>
<tr>
<td>Beneficiary</td>
<td>Organization that receives the asset when it is retired.</td>
<td></td>
</tr>
<tr>
<td>Resale price</td>
<td>Value of the asset when it is retired. For example, if the asset is donated, the value used when reporting taxes.</td>
<td></td>
</tr>
<tr>
<td>Scheduled retirement</td>
<td>Scheduled date on which the asset is retired.</td>
<td></td>
</tr>
<tr>
<td>Retired date</td>
<td>Actual date on which the asset was retired.</td>
<td></td>
</tr>
<tr>
<td>Depreciation</td>
<td>The Depreciation section is only available for hardware and facility assets.</td>
<td></td>
</tr>
<tr>
<td>Depreciation method</td>
<td>Depreciation method that is applied. Base system choices are <strong>Declining Balance</strong> and <strong>Straight Line</strong>. The depreciation value is defaulted from the associated Model.</td>
<td></td>
</tr>
</tbody>
</table>
## Asset record fields (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Depreciation effective date</td>
<td>Date on which the specified depreciation method begins.</td>
</tr>
<tr>
<td>Salvage value</td>
<td>Estimated value of an asset at the end of its useful life. This value must be less than or equal to the Cost of the asset.</td>
</tr>
<tr>
<td>Residual date</td>
<td>Number of days that have passed since the Depreciation effective date.</td>
</tr>
<tr>
<td>Residual value</td>
<td>Value in the Cost field with the depreciation method applied.</td>
</tr>
<tr>
<td>Depreciated amount</td>
<td>Amount the asset has depreciated.</td>
</tr>
</tbody>
</table>

### Contracts

The Contract section is only available for hardware, software entitlement, or facility assets.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lease contract</td>
<td>Name of the lease contract that applies to the asset.</td>
</tr>
<tr>
<td>Warranty expiration</td>
<td>Expiration date of the asset warranty.</td>
</tr>
<tr>
<td>Support group</td>
<td>Group managing the contract covering the asset.</td>
</tr>
<tr>
<td>Supported by</td>
<td>Person managing the contract covering the asset.</td>
</tr>
</tbody>
</table>

### Activities

Work notes are updated for the following cases:

- Updates to **Assigned To**, **Managed To State**, **Substate**, and **Reserved** fields of asset. The columns for these fields are audited by default and any update is recorded in the work notes.

- Work notes for hardware and software assets are updated when asset is received by a purchase order and transfer order. These work notes help in tracking life cycle of the asset.
Asset record fields (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculate Depreciation</td>
<td>Click to calculate the depreciation amount and residual value.</td>
</tr>
<tr>
<td>Delete Assets Only</td>
<td>Click to delete the assets and not the associated CI.</td>
</tr>
</tbody>
</table>

Related lists

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assets</td>
<td>Assets that are related to the asset you created.</td>
</tr>
<tr>
<td>Expense lines</td>
<td>Expense line associated with the asset</td>
</tr>
</tbody>
</table>

Internal Business Location form

Industry data models uses the Internal Business Location form to store information about an internal business location, including the staff members assigned to that location, cases created for customers at that location, and relationships created between staff and customers at that location.

Internal Business Location form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The automatically generated number of the business location. By default, location numbers start with the prefix IBL.</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the business location.</td>
</tr>
<tr>
<td>Manager</td>
<td>The manager of the business location. This is a mandatory field.</td>
</tr>
<tr>
<td></td>
<td>• When a user is added to the Manager field, the sn_customerservice.svc_location_manager role is automatically added to that user.</td>
</tr>
<tr>
<td></td>
<td>• Users with the manager role can access cases and information for their location hierarchy.</td>
</tr>
<tr>
<td></td>
<td>• A user can be added as the manager for multiple business locations.</td>
</tr>
</tbody>
</table>

⚠️ Note: Only internal users can be added as managers for internal business locations.
**Internal Business Location form fields (continued)**

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent Internal Business Location</td>
<td>A business location can have a parent business location. Use this field to create a parent-child hierarchy.</td>
</tr>
<tr>
<td>Street</td>
<td>The street address of the business location.</td>
</tr>
<tr>
<td>City</td>
<td>The city in which the business location resides.</td>
</tr>
<tr>
<td>State/Province</td>
<td>The state or province in which the business location resides.</td>
</tr>
<tr>
<td>Zip/Postal code</td>
<td>The ZIP code or postal code for the business location.</td>
</tr>
</tbody>
</table>

**Internal business location related lists**
The Internal Business Location form includes the following related lists.

<table>
<thead>
<tr>
<th>Related list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Members</td>
<td>Internal users (users with the snc_internal role) who have been added as staff members at this business location.</td>
</tr>
<tr>
<td></td>
<td>• Staff members can create cases for customers at their business locations.</td>
</tr>
<tr>
<td></td>
<td>• Staff members can access customer cases and information where the <strong>Service Organization</strong> field on the Case form matches their business locations.</td>
</tr>
<tr>
<td>Cases</td>
<td>Cases that have been created for customers at this location.</td>
</tr>
<tr>
<td>Account Staff Relationships</td>
<td>Relationships that have been created between staff members and accounts at this location.</td>
</tr>
<tr>
<td></td>
<td>Account staff relationships are created using the Account Manager responsibility.</td>
</tr>
</tbody>
</table>
### Consumer Staff Relationships

Relationships that have been created between staff members and consumers at this location.

Consumer staff relationships are created using the Relationship Manager responsibility.

### Household Staff Relationships

Relationships that have been created between staff members and households at this location.

Household staff relationships are created using the Relationship Manager responsibility.

---

**Related reference**

Industry data model relationships

**Related information**

Create an internal business location

---

### Household form

Industry data models uses the Household form to store information about a consumer household, including the household members; relationships created for the household and members; and cases, entitlements, and contracts created for the household and members.

#### Household form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the household.</td>
</tr>
<tr>
<td>Number</td>
<td>The automatically generated number of the household. By default, household numbers start with the prefix HOLD.</td>
</tr>
<tr>
<td>Head of household</td>
<td>The consumer in charge of the household.</td>
</tr>
<tr>
<td></td>
<td>• When creating a new household record, select a consumer from the Consumer table.</td>
</tr>
<tr>
<td></td>
<td>• When updating an existing household record, select a consumer from the current members of the household.</td>
</tr>
<tr>
<td>Street</td>
<td>The street address of the household.</td>
</tr>
</tbody>
</table>
Household form fields (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>City</td>
<td>The city in which the household resides.</td>
</tr>
<tr>
<td>State/Province</td>
<td>The state or province in which the household resides.</td>
</tr>
<tr>
<td>Zip/Postal code</td>
<td>The ZIP code or postal code for the household.</td>
</tr>
<tr>
<td>Country</td>
<td>The country in which the household resides.</td>
</tr>
<tr>
<td>Notes</td>
<td>Additional information about the household.</td>
</tr>
</tbody>
</table>

Household related lists
The Household form includes the following related lists.

<table>
<thead>
<tr>
<th>Related list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Members</td>
<td>The consumers who are current members of the household.</td>
</tr>
<tr>
<td>All Members</td>
<td>Current and past members of a household.</td>
</tr>
<tr>
<td></td>
<td>As members are added or removed from a household, the member history is</td>
</tr>
<tr>
<td></td>
<td>retained in this related list.</td>
</tr>
<tr>
<td>Member Relationships</td>
<td>Relationships that have been created between members of this household.</td>
</tr>
<tr>
<td></td>
<td>Member relationships are created using the Authorized Representative</td>
</tr>
<tr>
<td></td>
<td>responsibility.</td>
</tr>
<tr>
<td></td>
<td>Household members that have an Authorized Representative relationship with</td>
</tr>
<tr>
<td></td>
<td>another household member can act on behalf of that member and can manage</td>
</tr>
<tr>
<td></td>
<td>cases for that member.</td>
</tr>
<tr>
<td>Household Team</td>
<td>Relationships that have been created between internal users and this</td>
</tr>
<tr>
<td></td>
<td>household.</td>
</tr>
</tbody>
</table>
### Household staff relationships

<table>
<thead>
<tr>
<th>Related list</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Household staff relationships are created using the Relationship Manager responsibility. Internal users that have a Relationship Manager relationship with a household can manage all of the cases for that household.</td>
<td></td>
</tr>
</tbody>
</table>

### Cases

Cases that have been created for this household and the members of this household.

### Related information

- **Create or update a household**

### CSM query rules

Query rules are used to filter the records in CSM-related tables that are accessible by users with CSM roles. These filters, which are applied in query business rules and READ ACLs on CSM-related tables, are stored in a metadata table.

Starting with the London release, query rules and filters were defined in the CSQueryBRUtilOOBConstants script include. In the Quebec release, these filters have been moved to the Query Rule (sn_query_rule) table.

This change applies to Query business rules (QBRs) and read ACLs on CSM-related tables. Each data table that used QBRs prior to Quebec now has a new QBR that uses the new logic. Tables with read ACLs that used filters from the CSQueryBRUtilOOBConstants script include now have one more read ACL that uses the filters from the Query Rule table.

### Availability

The CSM query filters feature is active on zBoot instances. Existing customers must contact ServiceNow Customer Support to enable this feature.

### Query rules property

The `sn_cs_queryrules.use_query_rules` property determines whether to use the Query Rule table or the CSQueryBRUtilOOBConstants script include. This property is set to true for zBoot instances and false for upgraded instances.
• If true, the instance uses rules and filters from the Query Rule table to determine read access to the CSM tables for the logged-in user.

• If false, the instance uses rules and filters from the CSQueryBRUtilOOBConstants and its extensions to determine read access to the CSM tables for the logged-in user.

**Query Rule table**
The Query Rule (sn_query_rule) table extends the sys_metadata table and stores filters for the following tables:

- Case (sn_customerservice_case)
- Affected Install Bases (sn_install_base_m2m_affected_install_base)
- Install Base Items (sn_install_base_item)
- Installed Products (sn_install_base_m2m_installed_product)
- Sold Products (sn_install_base_sold_product)
- Order Case (csm_order_case)
- Sold Product Covered (sn_install_base_m2m_contract_sold_product)
- Orders (csm_order)
- Asset (alm_asset)
- Entitlement (service_entitlement)
- Account (customer_account)
- Work Order (wm_order)
- Contact (customer_contact)
- Contract (ast_contract)

**Components installed with Customer Service Management**
Several types of components are installed with the Customer Service Management application.

**Tables installed with Customer Service Management**
Tables are added with activation of Customer Service Management.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Relationship Access</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>[sn_customerservice_account_relationship_access]</td>
<td></td>
</tr>
<tr>
<td>Account Relationship Type [sn_customerservice_account_relationship_type]</td>
<td>Stores the relationship types that are created for bi-directional account relationships.</td>
</tr>
<tr>
<td>Account Team Member [sn_customerservice_team_member]</td>
<td>Stores the team members that are assigned to account teams.</td>
</tr>
<tr>
<td>Agent Token [sn_customerservice_agent_token]</td>
<td>This table is not currently used.</td>
</tr>
<tr>
<td>Appointment [sn_customerservice_appointment]</td>
<td>Stores appointments that have been created for customer service cases.</td>
</tr>
<tr>
<td>Asset Contact [sn_customerservice_m2m_asset_contact]</td>
<td>Stores asset contact relationship records.</td>
</tr>
<tr>
<td>Case [sn_customerservice_case]</td>
<td>Stores customer service case records.</td>
</tr>
<tr>
<td>Case Report [sn_customerservice_case_report]</td>
<td>Stores KPIs and metrics for case records.</td>
</tr>
<tr>
<td>Channel Configurations [sn_customerservice_channel_config]</td>
<td>Stores customer service email channel configuration records.</td>
</tr>
<tr>
<td>Consumers [csm_consumer]</td>
<td>Stores consumer records.</td>
</tr>
<tr>
<td>Consumer Users [csm_consumer_user]</td>
<td>Stores consumer registration records that are created when consumers complete the self-registration process from the Consumer Service Portal. This table extends the Users table (sys_user).</td>
</tr>
</tbody>
</table>
### Table

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact Relationship</td>
<td>[sn_customerservice_contact_relationship] Stores contact relationship records.</td>
</tr>
<tr>
<td>Customer Interaction</td>
<td>[sn_customerservice_customer_interaction] Stores interaction records for CSM.</td>
</tr>
<tr>
<td>Registration Request</td>
<td>[sn_customerservice_registration] Stores the customer portal self-registration requests.</td>
</tr>
<tr>
<td>Responsibility Definition</td>
<td>[sn_customerservice_responsibility_def] Stores the responsibility definitions that are created to support customer accounts.</td>
</tr>
<tr>
<td>Task</td>
<td>[sn_customerservice_task] Stores tasks that have been created for customer service cases.</td>
</tr>
</tbody>
</table>

### Properties installed with Customer Service Management

Properties are added with activation of Customer Service Management.

**Note:** To open the System Property [sys_properties] table, enter `sys_properties.list` in the navigation filter.

You can also navigate to **Customer Service > Administration > Properties** to view a list of the most frequently used properties that you can configure for Customer Service Management.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.cs.email.case_queue_address</td>
<td>Email case queue address.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> string</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value:</strong> none</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location:</strong> Customer Service</td>
</tr>
<tr>
<td>glide.cs.email.new_case_prefix</td>
<td>Email subject prefix format for new case.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>sn_customerservice.email.create_case_for_non_matched_user</td>
<td>Create case for non matched user.</td>
</tr>
<tr>
<td>glide.cs.company_name</td>
<td>Your company name.</td>
</tr>
<tr>
<td>glide.ui.activity.email_roles</td>
<td>Roles that can view mail in &quot;Sent/Received Emails&quot;</td>
</tr>
<tr>
<td>glide.ui.sn_customerservice_case_activity.fields</td>
<td>Case activity formatter fields</td>
</tr>
<tr>
<td>sn_customerservice.FTS_flag_enabled</td>
<td>Enable the follow the sun flag on the Customer Service Case form.</td>
</tr>
<tr>
<td>sn_customerservice.glide.script.block.client_globals</td>
<td></td>
</tr>
<tr>
<td>sn_customerservice.shn_asset</td>
<td>Special Handling Notes for assets</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>sn_customerservice.shn_contact</td>
<td>Special Handling Notes for contacts</td>
</tr>
<tr>
<td>sn_customerservice.shn_product</td>
<td>Special Handling Notes for products</td>
</tr>
<tr>
<td>sn_customerservice.shn_account</td>
<td>Special Handling Notes for accounts</td>
</tr>
<tr>
<td>sn_customerservice.shn_case</td>
<td>Special Handling Notes for cases</td>
</tr>
<tr>
<td>sn_customerservice.portal.chat_queue</td>
<td>• Type: string</td>
</tr>
<tr>
<td>csm.captcha.google.enabled</td>
<td>Enable the Google Captcha tool on the customer portal self-service portal self-registration form.</td>
</tr>
<tr>
<td>sn_customerservice.use_asset_contact_relationship</td>
<td>Restrict assets based on the</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>sn_customerservice.account_relationship_access_roles</td>
<td>Roles which need to be shown in the reference qualifier for the Account Relationship Access table.</td>
</tr>
<tr>
<td>sn_customerservice.contact_role_assignment</td>
<td>External roles that can be assigned to contacts from the Customer Service Portal. The roles stored in this property are displayed in the Available column on the Edit Role pop-up window.</td>
</tr>
<tr>
<td>sn_customerservice.registration_workflow_id</td>
<td>The default registration workflow ID.</td>
</tr>
<tr>
<td>consumer_max_attachments_per_record</td>
<td>Maximum consumer attachable items per record.</td>
</tr>
<tr>
<td>consumer_max_open_cases</td>
<td>Maximum open cases per consumer.</td>
</tr>
<tr>
<td>consumer_max_products</td>
<td>Maximum registered products per consumer.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>consumer_max_new_cases_daily</td>
<td>Maximum new cases per consumer per day.</td>
</tr>
<tr>
<td>consumer_max_comments_per_case_daily</td>
<td>Maximum consumer comments per case per day.</td>
</tr>
<tr>
<td>com.snc.cs_base.last.generated.code.tree.path</td>
<td>This property gets created when the first customer_account record is inserted into an instance. It stores the Account Code value for the most recently created customer account in the Account (customer_account) table. When a new customer account record is created, the system uses this property to determine a unique account code value for the account. The property is then updated with this latest assigned value so that the next account code value can be set as a unique value for the next account record insert. See [Set the account code property][1] for more details.</td>
</tr>
<tr>
<td>sn_customerservice.enable_knowledge_kcs</td>
<td>Enable Knowledge Centered Services (KCS) for Customer Services Management.</td>
</tr>
<tr>
<td>skills_management.migration</td>
<td>Lists the task tables to migrate to the Task Skills [task_m2m_skill] table when an admin runs the [Migrate Skills to Task Skill M2M][2] script.</td>
</tr>
</tbody>
</table>

[1]: https:// servicenow. com/help/41103636
[2]: https:// servicenow. com/help/41103636
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| com.snc.skills_management.task_skill_migrated_tables | Contains a list of tables for which the Skills field has been migrated and will not be migrated again.  
  - **Type**: choice list  
  - **Default value**: none  
  - **Location**: System Property |
| case_fields_to_sync | Comma-separated list of fields that synchronize from parent case to child cases.  
  - **Type**: string  
  - **Default value**: priority, state, comments, work_notes, close_notes, resolution_code  
  - **Location**: Customer Service > Administration > Properties |
| parent_child_case_sync | Synchronize fields from parent to child cases.  
  - **Type**: true | false  
  - **Default value**: false  
  - **Location**: Customer Service > Administration > Properties |
| glide.ui.sn_customerservice_escalation_activity.fields | Escalation activity formatter fields.  
  - **Type**: true | false  
  - **Default value**: false  
  - **Location**: System Property |
| sn_customerservice.kcs.enable_template_on_case_workspace | Enables creation of knowledge articles using a knowledge article template from a customer service case in Agent Workspace.  
  - **Type**: true | false  
  - **Default value**: false  
  - **Location**: System Property |
| sn_customerservice.case.autoresponder.enable | Enables sending content as recommendations for closing cases using the Auto-Responder feature.  
  - **Type**: true | false  
  - **Default value**: false  
  - **Location**: Customer Service > Administration > Properties |
| sn_customerservice.case.autoresponder.customportal | Custom portal URL containing the knowledge article parameter such as sys_kb_id or kb_number.  
  - **Type**: System Property |
### Roles installed with Customer Service Management

The Customer Service Management application uses roles to identify internal and external users, establish different types of relationships between users, provide access to information, and maintain data security.

Customer Service Management includes both internal and external user roles.

- **Internal roles** are assigned to users within your organization. These roles are for agents and managers using the Customer Service Management application to support customers.
- **External roles** are assigned to users outside your organization. These roles are for customers, customer partners, and consumers using the self-service portals.

With these roles, you can give both internal and external users access to your instance. This role structure gives you the flexibility to provide different levels of access to different users. As an additional security measure, every user must have at least one role so that the instance can distinguish between internal and external users.

Customer Service Management also provides roles for the following business models:

- **Business-to-business (B2B)**: With this business model, you can support accounts and contacts. Additionally, you can create relationships and account teams to support your customers.
- **Business-to-consumer (B2C)**: With this business model, you can support individual consumers.

<table>
<thead>
<tr>
<th>Internal Roles</th>
<th>External Roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business-to-business (B2B)</td>
<td>Business-to-business (B2B) Customer</td>
</tr>
<tr>
<td>Internal Roles</td>
<td>External Roles</td>
</tr>
<tr>
<td>---------------------------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>• sn_customerservice_agent</td>
<td>• sn_customerservice.customer</td>
</tr>
<tr>
<td>• sn_customerservice_manager</td>
<td>• sn_customerservice.customer_admin</td>
</tr>
<tr>
<td></td>
<td>• sn_customerservice.customer_case_manager</td>
</tr>
<tr>
<td><strong>Business-to-consumer (B2C)</strong></td>
<td></td>
</tr>
<tr>
<td>• sn_customerservice.consumer_agent</td>
<td>• sn_customerservice.partner</td>
</tr>
<tr>
<td>• sn_customerservice_manager</td>
<td>• sn_customerservice.partner_admin</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Business-to-business (B2B) Partner</strong></td>
<td></td>
</tr>
<tr>
<td>• sn_customerservice.consumer_agent</td>
<td></td>
</tr>
<tr>
<td>• sn_customerservice_manager</td>
<td></td>
</tr>
</tbody>
</table>

**Explicit roles**

You may have business requirements that change the use of these roles. In addition, the Explicit Roles in CSM feature may assign both internal and external roles to external users. It is important to regularly review user role assignments to ensure that they are set according to your business requirements.

For more information about reviewing and updating user role assignments, see KB0829930.

**Roles and descriptions**

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent [sn_customerservice_agent]</td>
<td>Customer service agent who assists customers and partners with questions, issues, and problems. This user creates cases, views and edits cases, and works with customers and subject matter experts to resolve cases. An agent typically supports a specific set of products across one or more communication channels. An agent can</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• knowledge</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• chat_admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• sn_customerservice.deescalation_requester</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• timecard_user</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• template_editor</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• sn_esm_agent</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• sn_shn.editor</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• domain_expand_scope</td>
</tr>
</tbody>
</table>

**Note:** The sn_esm_agent role contains the cmdb_read role.
<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Agent manager [sn_customerservice_manager] | Customer service agent with the additional responsibility for managing agents or agent groups and overriding agent actions. | • sn_customerservice_agent  
• timecard_manager  
• timecard_approver  
• skill_admin  
• sn_app_cs_social_social_profile_user  
• sam  
• approval_admin  
• sn_customerservice.consumer_agent  
• asset  
• sn_shn.admin  
• sn_publications.approver  
• contract_manager  
• sn_app_cs_social_log_user  
• awa_manager  
• notify_view  |
| Customer [sn_customerservice.customer]   | Customer role for researching questions, issues, or problems. Customers can create cases and view and edit existing cases for themselves. They can also view a list of | • sn_esm_user  
• snc_external  |

**Note:** The notify_view role is added to the sn_customerservice_manager role only when the Chat Zoom Connector application is installed.
<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer case manager</td>
<td>Customer role for managing the cases in an account and any related child accounts. The customer case manager role includes the privileges of the customer role and adds the following privileges:</td>
<td>• sn_customerservice.customer_case_manager</td>
</tr>
<tr>
<td></td>
<td>• Create a case on behalf of another contact in the account.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• View a list of cases belonging to the account.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Edit cases belonging to the account.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The customer case manager role is not automatically added to the sn_customerservice.contact_role_assignment system property. To expose this role to customer and partner administrators, navigate to Customer Service &gt; Administration &gt; Properties and add it to this property.</td>
<td></td>
</tr>
<tr>
<td>Customer administrator</td>
<td>Administrator role for a customer account. This user has access to all</td>
<td>• sn_customerservice.customer_admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• sn_customerservice.customer_admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• sn_esm_user_admin</td>
</tr>
<tr>
<td>Role title [name]</td>
<td>Description</td>
<td>Contains roles</td>
</tr>
<tr>
<td>---------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Partner [sn_customerservice.partner]</td>
<td>Partner who is serving customer accounts. A partner can create a case for their own account or on behalf of a customer account. A partner can view and edit all of the cases that they have created: • For their own account. • On behalf of customer accounts that they are related to.</td>
<td>• sn_customerservice.customer • sn_esm_partner</td>
</tr>
<tr>
<td>Partner administrator [sn_customerservice.partner_admin]</td>
<td>Administrator role for a partner account. The partner administrator can do the following:</td>
<td>• sn_customerservice.partner • sn_customerservice.customer_admin • sn_esm_partner_admin</td>
</tr>
<tr>
<td>Role title [name]</td>
<td>Description</td>
<td>Contains roles</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td></td>
<td>• Access the data within the partner account.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Access the data created by the contacts in their company in the customer account.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Manage users for the partner account and for customer accounts.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• View all of the cases created by a partner.</td>
<td></td>
</tr>
<tr>
<td>Consumer</td>
<td>Consumer role for researching questions, issues, or problems. Consumers can create cases and view and edit existing cases for products that they have purchased. They can also view a list of their products.</td>
<td>• sn_esm_user</td>
</tr>
<tr>
<td>[sn_customerservice.consumer]</td>
<td></td>
<td>• snc_external</td>
</tr>
<tr>
<td>Consumer agent</td>
<td>Consumer service agent who assists consumers with questions, issues, and problems. This user creates, views, and edits cases and works with consumers to resolve cases. An agent typically supports a specific set of products across one or more communication channels. An agent can belong to one or more agent groups.</td>
<td>• sn_esm_agent</td>
</tr>
<tr>
<td>[sn_customerservice.consumer_agent]</td>
<td></td>
<td>• chat_admin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• sn_shn.editor</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• template_editor</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• knowledge</td>
</tr>
<tr>
<td>Contact manager</td>
<td>User who can manage contacts.</td>
<td></td>
</tr>
<tr>
<td>Role title [name]</td>
<td>Description</td>
<td>Contains roles</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>[sn_customerservice.contact_manager]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Escalation requester</td>
<td>User who can request an escalation for a case or account.</td>
<td>• sn_customerservice.consumer_agent</td>
</tr>
<tr>
<td>(sn_customerservice.escalation_requester)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>De-escalation requester</td>
<td>User who can deescalate a case or account when the cause of the escalation is resolved.</td>
<td>• sn_customerservice.escalation_requester</td>
</tr>
<tr>
<td>[sn_customerservice.deescalation_requester]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Proxy case creator</td>
<td>Users with the proxy case creator role can create customer service cases directly from community questions created by contacts or consumers</td>
<td></td>
</tr>
<tr>
<td>[sn_customerservice.proxy_case_creator]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Proxy contact</td>
<td>Role that enables employees to create cases for customer accounts and contacts. Employees can also be proxy case contacts on behalf of customers. Assign this role to employees in your company who are not fulfillers or do not have other CSM-specific roles. Users with this role can:</td>
<td></td>
</tr>
<tr>
<td>[sn_customerservice.proxy_contact]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Create customer service cases using a record producer.
- Add work notes and comments to any case.
- Update the watch list of any case.
<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong> The CSM Extension for Proxy Contacts (com.snc.csm_proxy_contacts) plugin adds this role.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Case viewer [sn_customerservice.case_viewer]</td>
<td>This role provides read-only access to all cases.</td>
<td></td>
</tr>
</tbody>
</table>
| Data viewer [sn_customerservice.customer_data_viewer] | User with read-only access to customer data entities such as:  
  • Install base items  
  • Contracts  
  • Entitlements  
  • Accounts, contacts, and account team members  
  • Assets  
  • Consumers  
  • Sold product | |
| Customer project manager [sn_customerservice.projectmanager] | A user who creates and manages projects for customer accounts.  
  • Creates new projects.  
  • Sets up project tasks and resource plans.  
  • Identifies customer contacts who have access to projects and project tasks.  
  • Assigns and manages tasks and dependencies. |  
  • sn_customerservice.customer_data_viewer |
<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer project stakeholder [sn_customerservice.projectstakeholder]</td>
<td>A user who is responsible for activities that require viewing customer project details and project tasks.</td>
<td>Note: This role is added with the Customer Project Management plugin (com.snc.csm_ppm)</td>
</tr>
<tr>
<td>Case task viewer [sn_customerservice.case_task_viewer]</td>
<td>This role provides read-only access to all case task records.</td>
<td>Note: When combined with the case viewer role (sn_customerservice.case_viewer), a user can access all customer service cases and all case tasks.</td>
</tr>
<tr>
<td>Case contributor viewer [sn_customerservice.case_contributor_viewer]</td>
<td>This role provides read-only access to all of the tables associated with a case. With this role, a user can view the information in the related lists for a case if:</td>
<td>• sn_shn.user • wm_read</td>
</tr>
<tr>
<td></td>
<td>• The user has been added to the <strong>Contributor User</strong> field or the <strong>Contributor Group</strong> field on the Case form.</td>
<td></td>
</tr>
<tr>
<td>Role title [name]</td>
<td>Description</td>
<td>Contains roles</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------</td>
<td>----------------</td>
</tr>
<tr>
<td>• The user has read-only access to cases through another role, such as the case viewer role (sn_customerservice.case_viewer) or the case task agent role (sn_customerservice.case_task_agent).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>With this role, a user can access the following modules in CSM Agent Workspace:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• <strong>All tasks I participate in</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| Case task agent [sn_customerservice.case_task_agent] | This role provides access to case tasks and related case information. A user with this role can work on the following case tasks: | • sn_customerservice.customer_data_viewer  
• sn_customerservice.csm_workspace_user  
• sn_customerservice.case_contributor_editor |
<p>| • Tasks that are assigned to the user or to the user's assignment groups. | |  |
| • Tasks that have been created by the user. | |  |
| With this role, the user can: | |  |
| • View and update assigned case tasks. | |  |
| • Create case tasks and assign those task to other users. | |  |
| • View and update created case tasks. | |  |
| • Add work notes, comments, and | |  |</p>
<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>attachments to case tasks.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Update the status of case tasks.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Perform additional actions from a case task such as sending email.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>With this role, users have read-only access to customer information for the case:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Account and contact records (for B2B cases)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Consumer and household records (for B2C cases)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Service organization records (business location cases)</td>
<td></td>
</tr>
<tr>
<td>Case contributor editor</td>
<td>This role provides limited write access to the fields on the Case form.</td>
<td></td>
</tr>
<tr>
<td>[sn_customerservice.case_contributor_editor]</td>
<td>It provides limited write access to those cases for which the user already has read access provided by another role.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Limited write access is available for the following fields:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Work notes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Additional comments</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Attachments</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• State or stage changes</td>
<td></td>
</tr>
<tr>
<td>Role title [name]</td>
<td>Description</td>
<td>Contains roles</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------</td>
<td>----------------</td>
</tr>
</tbody>
</table>
| • Contributor users  
• Contributor groups  
• Watchlist  
• Work notes list | | |
| **Workspace user**  
[sn_customerservice.csm_workspace_user] | This role provides access to case tasks from the following modules in CSM Agent Workspace:  
• My Case Tasks  
• My Group’s Case Tasks  
Users can also:  
• Use Agent Assist to search for knowledge articles (if the User Criteria is set to provide access to knowledge).  
• Create email (if the user has write access to the record and the email_composer role).  
• View response templates (if response templates have been configured for the record.) | |

**Note:** By default, this role is added to the case task agent role (sn_customerservice.case_task_agent).
## Roles installed with the Customer Service Base Entities plugin

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Service management agent [sn_esm_agent] | • assignment_workbench  
• wm_read  
• cmdb_read  
• agent_schedule_user  
• interaction_agent |
| Service management partner [sn_esm_partner] | • sn_esm_user |
| Service management user admin [sn_esm_user_admin] | • sn_esm_user |
| Service management admin [sn_esm_admin] | None |
| Service management user [sn_esm_user] | • snc_external  
• sn_apptmnt_booking.appointment_booking_user |
| Service management partner admin [sn_esm_partner_admin] | • sn_esm_user_admin  
• sn_esm_admin |
| Role for REST APIs related to CSM web services [csm_ws_integration] | • snc_internal |

### Related information

**Fix external user role assignments**

### Explicit Roles in CSM

You can give both internal users and external users access to your instance. However, you might not want both types of users to have the same level of access. To provide added security, every user must have at least one role so that the instance can distinguish between internal and external users.

As of the Paris release, no user can have both of the explicit roles (snc_internal and snc_external). Groups and role containment cannot include both roles, either, since that would cause any group member or user who is assigned to
such a group or such a role to automatically have both roles. The Now Platform aborts any operation that would create such a scenario.

External users must obtain, at minimum, the snc_external role. The snc_external role indicates that the user is external to your organization. They should not have any access to resources unless explicitly allowed through ACLs for the snc_external role or additional roles that inherit the snc_external role. By default, users with the snc_external role cannot access:

- Scripted REST API resources that are not marked external.
- Tables without the role that inherits the snc_external role or the public role.
- Non-record type resources, such as processors and UI pages without the snc_external role or a role that inherits the snc_external role.
- Now Intelligence dashboards.

Do not mark the snc_internal role as elevated. Otherwise, internal users cannot access the instance.

⚠️ Note: You can set up encryption contexts with the snc_internal and snc_external roles. However, adding encryption contexts to more detailed roles is recommended. For more information, see Set up encryption contexts.

Recommended CSM roles for internal and external users

Customers (external users) using the Customer Service Management application should be assigned either the sn_customerservice.customer or the sn_customerservice.consumer role. Customer service agents (internal users) should be assigned either the sn_customerservice_agent or sn_customerservice_consumer_agent role. The system ensures that the same user is not assigned both a customer (external) and agent (internal) role.

Explicit Roles plugin

The Customer Service plugin (com.sn_customerservice) activates the Explicit Roles plugin (com.glide.explicit_roles), which adds the snc_external and snc_internal roles. When the plugin is activated:

- All users must have either the snc_internal role to access internal resources or the snc_external role to access external resources.
- All existing users are automatically assigned the snc_internal role. This role does not change existing access levels or system behavior. Instead, it provides a category to differentiate internal users from external users. All internal users maintain the same level of access as before the plugin was activated.
To prevent changing existing functionality for users, activating the Explicit Roles plugin assigns the snc_internal user role to all existing users in the instance. This includes any external users added before the Explicit Roles plugin was activated. After the Explicit Roles plugin is activated, do the following for all external users added before the Explicit Roles plugin was activated:

- Remove the snc_internal role.
- Add the snc_external role.

Doing the preceding ensures that external users added before activating the Explicit Roles plugin do not have access to internal resource that should be available only to internal users.

- Newly created users are automatically assigned the snc_internal role when they first attempt to log in to the instance, unless they have been explicitly assigned the snc_external role. You can add the snc_external role to a new user before they first log in to the instance to provide external user rights.

**Important:** Activate this plugin during a maintenance window or when few users are logged in. Users currently logged in when the plugin is activated will not be dynamically assigned the snc_internal role. Rather, users must log out and log back in to be assigned the snc_internal role. Once the plugin is activated, you can add or remove the snc_internal and snc_external roles at any time to change user rights.

- All existing ACLs that do not have a role requirement are automatically assigned the snc_internal role. Because both existing ACLs and roles are assigned the snc_internal role, existing access levels do not change.

- Newly created ACLs that do not have a role requirement are automatically assigned the snc_internal role. This role assignment does not apply to a newly created ACL with a role assigned.

- For all existing Processor [sys_processor] records or newly created Processor [sys_processor] records with `Type=script`, the snc_internal role is automatically added to the Roles field if the field is empty.

- To restrict access to UI pages to internal users, the plugin automatically assigns the snc_internal role to the * ACL with a `Type` of `ui_page`.

- To restrict access to processors to internal users, the plugin automatically assigns the snc_internal role to the * ACL with a `Type` of `processor`.

- External users must obtain, at minimum, the snc_external role to access the instance. This role is automatically assigned to external Customer Service Portal contacts. If the Customer Service Portal is not activated, this role must
be manually granted to external users’. Access to records is granted through ACLs.

⚠️ **Note:** You can use the `isPublic()` function in scripts for Customer Service Portal to change the privacy setting for a single client-callable script include. For more detail, see **Script includes**.

- **Content Management System** site access is also affected. CMS is set up with Sites (content_site), Pages (content_page), and other resources. Some of the sites may have the **Login page** configured.
  - If CMS sites do not have the **Login page** configured, the public role is automatically added to the **Read Roles** field on Pages (content_page) if the field is empty.
  - If CMS sites have the **Login page** configured, the snc_internal role is automatically added to the **Read Roles** field on Pages (content_page) if the field is empty.

- **Service Portal** site access is also affected.
  - The snc_internal role is not automatically added to sp_page, sp_widget or sp_instance records. If desired, you can give new records the role by assigning snc_internal as a default value in the **Roles** field for these records. For details on this process see **Specify a default field value**.

Do not move **System update sets** among instances with and without the Explicit Roles plugin enabled.

⚠️ **Note:** This plugin also requires the **Contextual Security Manager** plugin.

**The glide.security.explicit_roles.internal_user_blacklist property**

The Explicit Roles plugin assumes that all existing users in the sys_user table at the time the plugin is installed are internal customers. A fix script assigns the snc_internal role to all existing users and to any ACL that does not have a role. The fix script may fail or may not finish in time for a user who has not been updated with the role and who attempts to access a resource. To bridge this potential gap, the Contextual Security Manager (CSM) auto-assigns the snc_internal role to any user who logs in and does not have an explicit role (either internal or external).

Additionally, CSM has a business rule process that assigns the snc_external role to a classification of their users. However, when importing large sets of CSM external customers, workflow is set to false, so business rules don’t run. As those users attempt to access a resource, they do not have any explicit roles. The Contextual Security Manager assigns the snc_internal role through a scheduled job called On-Call Gaps Conflicts Report that runs every 7 days.
When the Explicit Roles plugin is active, this job assigns the snc_internal role to the CSM external user, since the user does not have either the snc_internal or snc_external role.

To prevent inadvertently providing the snc_internal role to external users, the Explicit Roles plugin includes a `glide.security.explicit_roles.internal_user_blacklist` property to exclude user types from ever becoming snc_internal. If there are no user types in the `glide.security.explicit_roles.internal_user_blacklist` table, the Contextual Security Manager assigns all users the snc_internal role by default. If there are classnames in the blacklist table, and if the sys_user class type is in the blacklist table, CSM assigns the snc_external role. Otherwise, CSM assigns the default snc_internal role as usual.

For the Paris release, this property is enabled by default for zBoot instances and and disabled by default for upgrades.

**Providing table access to external users**

You can provide external users access to a table by adding a role to the table that inherits the snc_external role. For more information, see [Provide external users access to a table](#).

**The hasRoles() method**

The `hasRoles()` method is still available, but is deprecated in the Geneva release. Use the `hasRole(role name)` method instead.

If you do use the `hasRoles()` method, note these changes:

- This method automatically excludes the default snc_internal role when it checks for roles. This means that if a user has only the snc_internal role, the `hasRoles()` method still returns `false`.
- If the user has the snc_external role, the method returns `false` because the instance considers external users to be without a role.

**Mutual exclusion: snc_external versus snc_internal**

The Now Platform prevents users from having both the snc_external role and the snc_internal role. The Now Platform applies this mutual exclusion everywhere in the system and writes error messages to the logs for each conflict.

⚠️ **Note:** ACLs can have both roles if the ACL resources should be accessible to all users.

Example: Adding both explicit roles to a user (direct collision):

1. Assign user Abel Tuter the snc_internal role.
2. Assign user Abel Tuter the snc_external role.
Result: Adding the snc_external role fails because Abel Tuter has the snc_internal role.

Example: Adding both explicit roles to a group (direct collision):

1. Consider a group called Test Group that currently has no explicit roles assigned to the group.
2. Add Abel Tuter to the Test Group.
3. Add the snc_external role to Test Group.

Result: Adding the snc_external role fails because Abel Tuter already has the snc_internal role and can't have both roles.

Example: Adding an explicit role to a group where a group member has the conflicting explicit role (indirect collision):

1. Assign user Abel Tuter the snc_internal role.
2. Consider a group called Test Group that currently has no explicit roles assigned to the group.
3. Add Abel Tuter to the Test Group.
4. Add the snc_external role to the Test Group.

Result: Adding the snc_external role to the group fails because Abel Tuter would inherit the snc_external role through group membership. Both explicit roles would be assigned to the same user, which isn't allowed.

For other examples, see the following table:

<table>
<thead>
<tr>
<th>Role</th>
<th>Attempted action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Direct collision</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The user has the snc_internal role.</td>
<td>Add the snc_external role.</td>
<td>The action is aborted.</td>
</tr>
<tr>
<td>The user has the snc_external role.</td>
<td>Add the snc_internal role.</td>
<td>The action is aborted.</td>
</tr>
<tr>
<td>The user has no explicit role.</td>
<td>Add the snc_internal or snc_external role.</td>
<td>The role is added.</td>
</tr>
<tr>
<td>The user has both explicit roles (existing collision).</td>
<td>Add the user to a group with no roles.</td>
<td>The action is aborted.</td>
</tr>
<tr>
<td>Role</td>
<td>Attempted action</td>
<td>Result</td>
</tr>
<tr>
<td>------</td>
<td>------------------</td>
<td>--------</td>
</tr>
<tr>
<td>A role not associated with any users contains the snc_internal role.</td>
<td>Add the snc_external role.</td>
<td>The action is aborted.</td>
</tr>
<tr>
<td>A role not associated with any users contains the snc_external role.</td>
<td>Add the snc_internal role.</td>
<td>The action is aborted.</td>
</tr>
<tr>
<td>A role contains both explicit roles (existing collision).</td>
<td>Add the role to a user, role, or group.</td>
<td>The action is aborted.</td>
</tr>
<tr>
<td>A group with no members has the snc_internal role.</td>
<td>Add the snc_external role.</td>
<td>The action is aborted.</td>
</tr>
<tr>
<td>A group with no members has the snc_external role.</td>
<td>Add the snc_internal role.</td>
<td>The action is aborted.</td>
</tr>
<tr>
<td>A group with no members has no roles.</td>
<td>Add the snc_internal or snc_external role.</td>
<td>The role is added.</td>
</tr>
</tbody>
</table>

**Indirect collision**

**Role containment with collision**

1. Grant a role called Test Role to a user with the snc_internal role.
2. Add the snc_external role Test Role.

The action is aborted.

**Role containment without collision**

1. Grant a role called Test Role to a user with no roles.
2. Add the snc_external role to Test Role.

The role is added to both the user and Test Role.
<table>
<thead>
<tr>
<th>Role</th>
<th>Attempted action</th>
<th>Result</th>
</tr>
</thead>
</table>
| Group containment with collision                | 1. Add a user who has the snc_internal role to a group called Test Group 2 (child of Test Group 1).  
2. Add the snc_external role to Test Group 2.  
3. Add the snc_external role to a parent group called Test Group 1 (parent of Test Group 2). | The action is aborted.                           |
| Group containment without collision             | 1. Add a user with no roles to a group called Test Group 2 (child of Test Group 1).  
2. Add the snc_external or snc_internal role to Test Group 1 (parent of Test Group 2). | The role is added to the parent group, the child group, and the user. |
| Group containment plus role containment with collision | Add contains_external to Test Group 1, the parent of Test Group 2.  
Add the snc_internal role to Test Group 2, the child of Test Group 1. | Test Group 1 and Test Group 2 both get contains_external, but don't explicitly get the snc_external role.  
The action is aborted. |
| Group parent change plus group containment      | 1. Remove Test Group 1 as the parent of Test Group 2.  
2. Add the snc_internal role to Test Group 1.  
3. Add the snc_external role to Test Group 2.  
4. In Test Group 2, set Test Group 1 as the parent group and save. | The action is aborted.  
Repeat for already nested groups, with the same expectation. |
The cause of an aborted action appears in the error message and must be addressed before another attempt succeeds.

For direct cases, such as adding an explicit role to an individual user, verify which explicit role the user should have. If the user has the wrong explicit role, it must first be removed, and then the correct explicit role must be added.

For indirect cases, such as adding an explicit role to a group (so that a group member would be assigned both explicit roles), evaluate whether that user should be in the group. Also determine whether the group should be given the explicit role, including any inheritance through group hierarchy and role containment.

Note that the Now Platform reports only the first potential collision encountered. If repeated attempts continue to fail after remediation, with a new root cause each time, re-evaluate the relevant user/group/role interdependence more broadly. You may want to rethink how groups and role containments are structured.

**Provide external users access to a table**

To enable users with only the snc_external role to access the list view of a table, you must create a series of ACLs.

**Before you begin**

Role required: security_admin

**Procedure**

1. Elevate to the security_admin role.

2. Create a new ACL with the following settings:
   - **Type**: ui_page
   - **Operation**: read
   - **Name**: {table_name}_list
   - **Required role**: snc_external

3. On the default read ACL for the table, add **snc_external** in the Required role list. Create the ACL if it does not already exist.

4. Use these settings to create another ACL:
   - **Type**: ui_page
   - **Operation**: read
   - **Name**: {table_name}
   - **Required role**: snc_external
5. Use these settings to create another ACL to give the user write access to a field in the table:
   • **Type**: record
   • **Operation**: create
   • **Name**: `{table_name} {column_name}`
   • **Required role**: snc_external

   Repeat this step for every field that you want to give the user write access to. Use an asterisk `*` instead of the column name to provide access to all fields at once.

**Creating custom user roles**

System administrators can create custom roles or modify the access of existing roles by using script includes and extension points/instances.

The Customer Service Management application utilizes platform ACLs and query business rules to restrict data access based on user roles. If needed, users with the system administrator role can create custom roles or modify the access of existing roles by using script includes and extension points/instances.

   • Script includes store JavaScript functions and classes to handle the role access control logic.
   • Extension points/instances designate places where custom scripts can be called and then processed to extend base functionality.

The system administrator can use the extension points/instances to create their own role access constants file similar to CSQueryBRUtilOOBConstants.

The system administrator can create a new extension instance for the existing extension point and use it to define custom role configuration constants.

The following items are included with the Customer Service Management application:

   • `global.CSQeryExtensionPoint`: the provided extension point for CSM role configuration
   • `instance.CSQueryExtensioninstanceOOB`: the provided extension instance for CSM role configuration

To create a new role:
1. Create a new constant file to hold the configurations for the new role similar to CSQueryBRUtilOOBConstants. For example:

```python
CSQueryBRUtilOOBConstantstest.ROLE_PERMISSIONS_POOL = {
    'sn_customerservice.customer_new_role': {'sn_customerservice_case': {'condition': ['my_new_condition']}},
}
```

2. Create a new extension instance to hold the logic returning this new constant file to CSQueryBRUtil.

3. Make sure this role is on the instance and contains the sn_esm_user role.

4. Assign this new role to a contact.

5. Create or modify the ACLs and query business rules for this role as necessary.

For more information about modifying ACLs and query business rules, see KB0685767.

**Related information**

- Using extension points to extend application functionality
- Using scripted extension points in server-side scripts
- Using UI extension points in server-side UI macros
- Using client extension points in client-side UI scripting

**Script includes installed with Customer Service Management**

Script includes are added with activation of Customer Service Management.

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSEMailUtil</td>
<td>Used for customer service case email actions and notifications.</td>
</tr>
<tr>
<td>CSPortalUtil</td>
<td>Helper functions for the customer self-service portal.</td>
</tr>
<tr>
<td>AccountTeamUtil</td>
<td>Util APIs for the Customer Service Management account team responsibility module.</td>
</tr>
<tr>
<td>AjaxCustomerServiceSearch</td>
<td>Ajax class that provides the knowledge base search results.</td>
</tr>
</tbody>
</table>
Client scripts installed with Customer Service Management

Client scripts are added with activation of Customer Service Management.

<table>
<thead>
<tr>
<th>Client script</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel and State readonly for customer</td>
<td>Case [sn_customerservice_case]</td>
<td>Sets the <strong>Channel</strong> and <strong>State</strong> fields to read-only on the Case form that the customer can view from the customer portal.</td>
</tr>
<tr>
<td>Check Contextual Security Installed</td>
<td>Contact [customer_contact]</td>
<td>Checks if the Contextual Security plugin (com.glide.role_management) is installed before creating a customer contact.</td>
</tr>
<tr>
<td>Customer Case View</td>
<td>Case [sn_customerservice_case]</td>
<td>Hides certain elements in the view.</td>
</tr>
<tr>
<td>Empty Case form on Account Change</td>
<td>Case [sn_customerservice_case]</td>
<td>When a user makes a change in the Account field on the Case form, the following fields are cleared: <strong>Partner</strong>, <strong>Partner contact</strong>, <strong>Asset</strong>, <strong>Entitlement</strong>, <strong>Contract</strong>, and <strong>Contact</strong>.</td>
</tr>
<tr>
<td>Empty Partner Contact on Partner Change</td>
<td>Case [sn_customerservice_case]</td>
<td>When a user makes a change in the Partner field on the Case form, the <strong>Partner contact</strong> field is also cleared.</td>
</tr>
<tr>
<td>Hide Activity Stream</td>
<td>Contact [customer_contact]</td>
<td>Hides the activity stream on the header.</td>
</tr>
<tr>
<td>Hide attachment icon</td>
<td>Registration Request [sn_customerservice_registration]</td>
<td>Hides the attachment icon on the header.</td>
</tr>
<tr>
<td>Hide Icons Form Header</td>
<td>Case [sn_customerservice_case]</td>
<td>Hides the email icon from the more options menu and the activity stream icon at the top of the form header. Also hides the icon next to the <strong>Short Description</strong> field.</td>
</tr>
<tr>
<td>Hide Suggestion</td>
<td>Case [sn_customerservice_case]</td>
<td>Hides the suggestion icon next to the <strong>Short description</strong> field.</td>
</tr>
<tr>
<td>Client script</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-----------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>next to Short</td>
<td>Account Relationship Type [sn_customerservice_account_relationship_type]</td>
<td>Sets the <strong>From</strong> and <strong>To</strong> fields only once a record is created in the Account Relationship Type table (sn_customerservice_account_relationship_type).</td>
</tr>
<tr>
<td>Make field readonly</td>
<td>Appointment [sn_customerservice_appointment]</td>
<td>Opens the glide list to select an appointment for new records.</td>
</tr>
<tr>
<td>Open the glide list for new</td>
<td>Appointment [sn_customerservice_appointment]</td>
<td>Opens the glide list to select an appointment for new records.</td>
</tr>
<tr>
<td>Open the glide list for new</td>
<td>Appointment [sn_customerservice_appointment]</td>
<td>Opens the glide list to select an appointment for new records.</td>
</tr>
<tr>
<td>Appointment</td>
<td>Appointment [sn_customerservice_appointment]</td>
<td>Opens the glide list to select an appointment for new records.</td>
</tr>
<tr>
<td>Appointment</td>
<td>Appointment [sn_customerservice_appointment]</td>
<td>Opens the glide list to select an appointment for new records.</td>
</tr>
<tr>
<td>Populate Contact Company</td>
<td>Case [sn_customerservice_case]</td>
<td>When a user name is selected in the <strong>Contact</strong> field, the <strong>Account</strong> field is populated with the contact’s account information.</td>
</tr>
<tr>
<td>Populate Contract</td>
<td>Case [sn_customerservice_case]</td>
<td>Populates the <strong>Contract</strong> field when the <strong>Account</strong> field is filled.</td>
</tr>
<tr>
<td>Populate contract and entitlement</td>
<td>Case [sn_customerservice_case]</td>
<td>Populates the <strong>Contract</strong> and <strong>Entitlement</strong> fields when the <strong>Account</strong> field is filled.</td>
</tr>
<tr>
<td>Populate Entitlement</td>
<td>Case [sn_customerservice_case]</td>
<td>Populates the <strong>Entitlement</strong> field when the <strong>Account</strong> field is filled.</td>
</tr>
<tr>
<td>Populate Product</td>
<td>Case [sn_customerservice_case]</td>
<td>When an asset is selected in the <strong>Asset</strong> field, the <strong>Product</strong> field is populated with the asset’s product model.</td>
</tr>
<tr>
<td>Registration code read-only</td>
<td>Registration Request [sn_customerservice_registration]</td>
<td>Sets the <strong>Registration code</strong> field to read-only.</td>
</tr>
<tr>
<td>Set account read on load</td>
<td>Account Team Member [sn_customerservice_team_member]</td>
<td>Sets the <strong>Account</strong> field to read-only when the account is not empty on form load.</td>
</tr>
<tr>
<td>Set asset readonly</td>
<td>Asset Contact [sn_customerservice_m2m_asset_contact]</td>
<td>Sets the <strong>Asset</strong> field to read-only when the asset value is not empty.</td>
</tr>
<tr>
<td>Show partner field</td>
<td>Case [sn_customerservice_case]</td>
<td>Shows the <strong>Opened by</strong> field.</td>
</tr>
</tbody>
</table>
### Business rules installed with Customer Service Management

Business rules are added with activation of Customer Service Management.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account query for customer</td>
<td>Account [customer_account]</td>
<td>Queries the account for the customer contact.</td>
</tr>
<tr>
<td>Account relationship display rule</td>
<td>Account Relationship [account_relationship]</td>
<td>Displays the correct values in the bi-directional diagram on the Account Relationship form.</td>
</tr>
<tr>
<td>Add customer role to contacts</td>
<td>Contact [customer_contact]</td>
<td>Adds the customer role (sn_customerservice.customer) to a customer contact if the contact has no assigned role or if the user ID for the contact is set.</td>
</tr>
<tr>
<td>Add snc external role to contacts</td>
<td>Contact [customer_contact]</td>
<td>Adds the snc_external user role to each contact.</td>
</tr>
<tr>
<td>Add Primary Contact to Asset</td>
<td>Asset [alm_asset]</td>
<td>When an asset is assigned a new primary contact, the primary contact is added to the asset contact.</td>
</tr>
<tr>
<td>Approver query for customer</td>
<td>Approval [sysapproval_approver]</td>
<td>Queries the approver for a customer contact.</td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>--------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Asset query for customer</td>
<td>Asset [alm_asset]</td>
<td>Queries the assets for a customer contact.</td>
</tr>
<tr>
<td>Auto assessment business rule</td>
<td>Case [sn_customerservice_case]</td>
<td>Triggers a customer satisfaction survey when a case is set to <strong>Closed</strong>.</td>
</tr>
<tr>
<td>Case query for customer</td>
<td>Case [sn_customerservice_case]</td>
<td>Queries the cases for a customer contact.</td>
</tr>
<tr>
<td>Case display rule</td>
<td>Case [sn_customerservice_case]</td>
<td>A display business rule on the Case form which passes some values to the browser when a case is displayed.</td>
</tr>
<tr>
<td>Change Awaiting to Open</td>
<td>Case [sn_customerservice_case]</td>
<td>Changes the case state from <strong>Awaiting Info</strong> to <strong>Open</strong>.</td>
</tr>
<tr>
<td>Check duplicate</td>
<td>Asset Contact [sn_customerservice_m2m_asset_contact]</td>
<td>Checks for duplicate records before creating a new asset contact.</td>
</tr>
<tr>
<td>Check duplicate for responsibility</td>
<td>Contact Relationship [sn_customerservice_contact_relationship]</td>
<td>Checks for duplicate responsibilities before creating a new contact relationship.</td>
</tr>
<tr>
<td>Check duplicate for responsibility</td>
<td>Asset Contact [sn_customerservice_m2m_asset_contact]</td>
<td>Checks for duplicate responsibilities before creating a new asset contact.</td>
</tr>
<tr>
<td>Check snc_external roles exist</td>
<td>Contact [customer_contact]</td>
<td>Checks if the com.glide.security_schema plugin is activated.</td>
</tr>
<tr>
<td>Contact query for customer</td>
<td>Contact [customer_contact]</td>
<td>Queries the contacts for a customer.</td>
</tr>
<tr>
<td>Contract query for customer</td>
<td>Contract [ast_contract]</td>
<td>Queries the contracts for a customer.</td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Create bi-direction relationship</td>
<td>Account Relationship [account_relationship]</td>
<td>After an account relationship is created, this business rule creates the bi-directional account relationship record.</td>
</tr>
<tr>
<td>Delete Account Contacts and Assets</td>
<td>Account Relationship [account_relationship]</td>
<td>When an account relationship is deleted, this business rule deletes the corresponding account and asset contacts.</td>
</tr>
<tr>
<td>Delete relationship type</td>
<td>label [account_relationship_type]</td>
<td>Checks to see if any relationship records are using a relationship type before that relationship type is deleted.</td>
</tr>
<tr>
<td>Delete responsibility definition</td>
<td>Responsibility Definition [sn_customerservice_responsibility_def]</td>
<td>Checks to see if any account team members are using a responsibility definition before that responsibility definition is deleted.</td>
</tr>
<tr>
<td>Display request message</td>
<td>Registration Request [sn_customerservice_registration]</td>
<td>After registration request submittal, shows info message to user.</td>
</tr>
<tr>
<td>Display rule</td>
<td>Registration Request [sn_customerservice_registration]</td>
<td>Shows message to remind users to enter a correct registration code.</td>
</tr>
<tr>
<td>Entitlement query for customer</td>
<td>Entitlement [service_entitlement]</td>
<td>Queries the entitlements for customer contact.</td>
</tr>
<tr>
<td>Insert Case Work Notes</td>
<td>Appointment [sn_customerservice_appointment]</td>
<td>Updates the case work notes with the appointment details when an an appointment is created.</td>
</tr>
<tr>
<td>Populate company for case</td>
<td>Case [sn_customerservice_case]</td>
<td>Populates the Company field on the Case form based on the name entered in the Contact field.</td>
</tr>
<tr>
<td>Set First Response Time</td>
<td>Case [sn_customerservice_case]</td>
<td>When a case is created or updated, this rule sets the current time in the</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>first_response_time field. Also used when a case is set to Resolved or Awaiting Info or when comments or close notes are added.</td>
<td></td>
<td>Note: The first_response_time field is not used.</td>
</tr>
<tr>
<td>Update account based on reg code</td>
<td>Registration Request [sn_customerservice_registration]</td>
<td>Validates the registration registration code and assigns the account associated with the registration code.</td>
</tr>
<tr>
<td>Update account relationship labels</td>
<td>Account Relationship Type [sn_customerservice_account_relationship_type]</td>
<td>When the labels for an account relationship type are updated, this business rule updates all of the related account relationship records.</td>
</tr>
<tr>
<td>Update case entitlement on Close</td>
<td>Case [sn_customerservice_case]</td>
<td>Updates the associated entitlement when the state of a case is set to Closed.</td>
</tr>
<tr>
<td>Update Case Work notes</td>
<td>Appointment [sn_customerservice_appointment]</td>
<td>Adds work notes to the case when an appointment for the case is updated.</td>
</tr>
<tr>
<td>Update Case Work Notes</td>
<td>Knowledge [kb_knowledge]</td>
<td>Adds work notes to the case when a knowledge article associated with the case gets updated.</td>
</tr>
<tr>
<td>Update Parent Case for new task</td>
<td>Task [sn_customerservice_task]</td>
<td>Updates the case when a case task is created.</td>
</tr>
<tr>
<td>Update Parent case for state change</td>
<td>Task [sn_customerservice_task]</td>
<td>Updates the case when a case task is changed.</td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Update relationship label</td>
<td>Account Relationship [account_relationship]</td>
<td>Updates the relationship labels for bi-directional account relationships.</td>
</tr>
<tr>
<td>Update User Task State</td>
<td>Case [sn_customerservice_case]</td>
<td>Calculates the workload for the agent based on the number of cases assigned to the agent. Also updates the last assigned time. This rule is used by the matching rule engine.</td>
</tr>
<tr>
<td>Validate registration</td>
<td>Registration Request [sn_customerservice_registration]</td>
<td>Checks if the registration is valid based on the user’s email address. If the user exists in the system or a request has already been submitted and is in the pending state, the registration request is not allowed.</td>
</tr>
</tbody>
</table>

**Components installed with CSM workspaces**

Several types of components are installed with CSM workspaces.

**Roles**

The agent workspace user role (agent_workspace_user) is added to the Service Management agent (sn_esm_agent) role. The role is required to access Agent Workspace for CSM.

**Form views**

Customer service agents see forms in the CSM Workspace form view (workspace_csm), if they exist for certain record types. Otherwise, agents see forms in the Workspace form view.

**Tables**

In CSM workspaces, a number of Customer Service Management tables are provided with the Workspace and CSM Workspace view layouts.

**Tables in Workspace view**

The Workspace view is provided for the following tables:
• Case (sn_customerservice_case)
• Consumer (csm_consumer)
• Account (customer_account)
• Contact (customer_contact)
• Account Relationship (account_relationship)
• Asset (alm_asset)
• Contract (ast_contract)
• Product Model (cmdb_model)
• Entitlement (service_entitlement)
• Task (sn_customerservice_task)
• Appointments (sn_customerservice_appointment)
• Contact Relationship (sn_customerservice_contact_relationship)
• Escalation (sn_customerservice_escalation)
• Order (csm_order)
• Order Case (csm_order_case)
• Special Handling Notes (sn_shn_notes)
• Order Line Item (csm_order_line_item)
• Asset Contact (sn_customerservice_m2m_asset_contact)
• Account Team Member (sn_customerservice_team_member)
• Social Profiles table (sn_app_cs_social_social_profile)
• Social Logs table (sn_app_cs_social_social_log)
• Knowledge Applied to Tasks table (m2m_kb_task)

Tables in CSM Workspace view

The CSM Workspace view (workspace_csm) is provided for the following tables:

• Interaction (interaction)
• Location (cmn_location)

The CSM Workspace view for these tables is similar to the respective default platform interface view.
## Lists
The list categories and filtered lists that have been configured for customer service agents in CSM workspaces.

<table>
<thead>
<tr>
<th>List Category</th>
<th>Filtered Lists</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cases</td>
<td>My Cases</td>
<td>Cases assigned to the customer service agent.</td>
</tr>
<tr>
<td></td>
<td>My Open</td>
<td>Open cases assigned to the customer service agent.</td>
</tr>
<tr>
<td></td>
<td>Unassigned for my groups</td>
<td>Cases that belong to any of the customer service agent’s groups but have not been assigned to an agent.</td>
</tr>
<tr>
<td></td>
<td>All</td>
<td>All customer service cases.</td>
</tr>
<tr>
<td>Major Issue Management</td>
<td>Major Cases</td>
<td>Major cases that have been accepted.</td>
</tr>
<tr>
<td>Customer</td>
<td>Accounts</td>
<td>A list of customer accounts.</td>
</tr>
<tr>
<td></td>
<td>Partners</td>
<td>A list of partner accounts.</td>
</tr>
<tr>
<td></td>
<td>Contacts</td>
<td>A list of customer contacts.</td>
</tr>
<tr>
<td></td>
<td>Consumers</td>
<td>A list of consumers.</td>
</tr>
<tr>
<td>Interactions</td>
<td>My Interactions</td>
<td>Interactions that are assigned to the customer service agent (agent’s name appears in the <strong>Assigned to</strong> field on the interaction record).</td>
</tr>
<tr>
<td>Knowledge</td>
<td>My Knowledge Articles</td>
<td>Knowledge articles authored by the customer service agent (agent’s name appears in the <strong>Author</strong> field).</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> This list appears in the list panel when the Knowledge Management Advanced Installer plugin (com.snc.knowledge_advanced.installer) is activated.</td>
</tr>
<tr>
<td>Catalog Tasks</td>
<td>Assigned to my groups</td>
<td>Catalog tasks assigned to the current agent’s groups.</td>
</tr>
</tbody>
</table>
Note: Additional filtered lists appear in the list panel when a customer service agent also has the itil role.

Components installed with additional plugins for Customer Service Management

Several types of components are installed with the additional plugins for the Customer Service Management application.

Components installed with CTI Softphone

Several types of components are installed with CTI Softphone.

Tables installed with CTI Softphone

Tables are added with activation of CTI Softphone.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User CTI Status</td>
<td>Stores the agent's availability status.</td>
</tr>
</tbody>
</table>

Script includes installed with CTI Softphone

Script includes are added with activation of CTI Softphone.

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTIAjaxUtility</td>
<td>Ajax class that provides helper functions to set and get user states, get incoming call context, log a call, and queue and dequeue a call.</td>
</tr>
</tbody>
</table>

Business rules installed with CTI Softphone

Business rules are added with activation of CTI Softphone.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Route available user for Incident Task</td>
<td>User CTI Status [user_cti_status]</td>
<td>Demo business rule to dequeue a call based on matching rules whenever an agent becomes available.</td>
</tr>
</tbody>
</table>
Components installed with Customer Service CTI Demo Data
Several types of components are installed with Customer Service CTI Demo Data.

Business rules installed with Customer Service CTI Demo Data
Business rules are added with activation of Customer Service CTI Demo Data.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Route available user for Case Task</td>
<td>User CTI Status [user_cti_status]</td>
<td>Used to dequeue a call whenever an agent becomes available.</td>
</tr>
</tbody>
</table>

Components installed with OpenFrame
Several types of components are installed with OpenFrame.

Tables installed with OpenFrame
Tables are added with activation of OpenFrame.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phone Log [sn_openframe_phone_log]</td>
<td>A log of the incoming and outgoing phone calls. This table can be used to log any phone call made or received.</td>
</tr>
<tr>
<td>OpenFrame Configuration [sn_openframe_configuration]</td>
<td>Stores the OpenFrame configuration. This is the configuration used to load the OpenFrame in the TopFrame.</td>
</tr>
</tbody>
</table>

Roles installed with OpenFrame
The OpenFrame user role is automatically added when you activate OpenFrame.

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>User [sn_openframe_user]</td>
<td>The OpenFrame user role.</td>
<td>• None</td>
</tr>
</tbody>
</table>
Script includes installed with OpenFrame
The OpenFrameAjaxUtility script include is added when you activate OpenFrame.

<table>
<thead>
<tr>
<th>Script Include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OpenFrameAjaxUtility</td>
<td>OpenFrame AJAX utility class that provides functions to get the OpenFrame configuration and also to get and set the last opened frame location.</td>
</tr>
</tbody>
</table>

Business rules installed with OpenFrame
Some related business rules are added when you activate OpenFrame.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Agent</td>
<td>Phone Log [sn_openframe_phone_log]</td>
<td>Sets the agent in the Phone Log [sn_openframe_phone_log] table as the current logged-in user if a phone call is logged without an agent.</td>
</tr>
<tr>
<td>One Default Configuration</td>
<td>OpenFrame Configuration [sn_openframe_configuration]</td>
<td>Checks that there is only one default OpenFrame configuration. You cannot have two OpenFrame configurations if the default option is set to true.</td>
</tr>
<tr>
<td>Update Task Work Notes</td>
<td>Phone Log [sn_openframe_phone_log]</td>
<td>Updates the work notes for a specific task whenever a phone call is logged for that task.</td>
</tr>
</tbody>
</table>

UI macros installed with OpenFrame
Related UI macros are added when you activate the OpenFrame plugin.

The UI macros added when you activate OpenFrame plugin are supported under the following conditions:
- The **doctype** property is set to true and the device is not a tablet or mobile.
- The web browser is Internet Explorer 10 or above.
As a system administrator, you can add the following UI macro scripts:

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
</table>
| show_phone                      | • This macro requires the activation of the OpenFrame plugin.  
• By configuring this UI macro using the `ref_contribution` parameter, you can display a phone icon next to the sys_user reference field if the phone field in the sys_user record is populated with the user's contact number. |
| show_phone_customer_service     | • This macro requires the activation of the Customer Service Management and the OpenFrame plugins.  
• By configuring this UI macro using the `ref_contribution` parameter, you can display a phone icon next to the Contact customer_account reference field on the case form if the phone field in the Contact customer_account record is populated with the user's contact number. |

Displaying the phone icon enables you to make calls using the click-to-call capability in the OpenFrame window. For more information on how to use OpenFrame, refer to OpenFrame overview.

Components installed with Special Handling Notes
Several types of components are installed with Special Handling Notes.

Tables installed with Special Handling Notes
The tables included with the Special Handling Notes plugin (com.sn_shn).

The Special Handling Notes plugin adds the following tables.

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Special Handling Notes [sn_shn_notes]</td>
<td>Stores the special handling notes.</td>
</tr>
<tr>
<td>Special Handling Configuration</td>
<td>Stores the special handling notes table configurations.</td>
</tr>
</tbody>
</table>
### Roles installed with Special Handling Notes

The user roles included with the Special Handling Notes plugin (com.sn_shn).

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_shn.admin</td>
<td>Can read, create, update, and delete special handling notes. This role contains the sn_shn.editor role.</td>
</tr>
<tr>
<td></td>
<td>The sn_customerservice_manager role contains the sn_shn.admin role.</td>
</tr>
<tr>
<td>sn_shn.editor</td>
<td>Can read and update special handling notes. This role contains the sn_shn.user role.</td>
</tr>
<tr>
<td></td>
<td>The sn_customerservice_agent role contains the sn_shn.editor role.</td>
</tr>
<tr>
<td>sn_shn.user</td>
<td>Can read special handling notes.</td>
</tr>
</tbody>
</table>

### Properties installed with Special Handling Notes

The properties included with the Special Handling Notes plugin (com.sn_shn).

The Special Handling Notes plugin adds the following properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum number of notes displayed in the</td>
<td>• <strong>Type</strong>: integer &lt;br&gt;• <strong>Default value</strong>: 20 &lt;br&gt;• <strong>Location</strong>: Special Handling Notes &gt; Properties &lt;br&gt;• <strong>Learn more</strong>: Configure special handling notes properties</td>
</tr>
<tr>
<td>Special Handling Notes pop-up window</td>
<td>Special handling notes are displayed each time you access a record. Enable this property to display special handling notes only once per session.</td>
</tr>
<tr>
<td>[sn_shn.max_num_alerts]</td>
<td></td>
</tr>
<tr>
<td>Display special handling notes only once per</td>
<td></td>
</tr>
<tr>
<td>session</td>
<td></td>
</tr>
</tbody>
</table>
### Property Description

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• <strong>Type</strong>: true</td>
<td>false</td>
</tr>
<tr>
<td>• <strong>Default value</strong>: false</td>
<td></td>
</tr>
<tr>
<td>• <strong>Location</strong>: Special Handling Notes &gt; Properties</td>
<td></td>
</tr>
<tr>
<td>• <strong>Learn more</strong>: Configure special handling notes properties</td>
<td></td>
</tr>
</tbody>
</table>

**Width of the Special Handling Notes pop-up window in pixels**

[sn_shn.popup_width]

The width of the Special Handling Notes pop-up window in pixels. The default width is 500. If you specify less than 300, the window automatically uses the minimum width of 300 pixels.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• <strong>Type</strong>: integer</td>
<td></td>
</tr>
<tr>
<td>• <strong>Default value</strong>: 500</td>
<td></td>
</tr>
<tr>
<td>• <strong>Location</strong>: Special Handling Notes &gt; Properties</td>
<td></td>
</tr>
<tr>
<td>• <strong>Learn more</strong>: Configure special handling notes properties</td>
<td></td>
</tr>
</tbody>
</table>

## Business rules installed with Special Handling Notes

The business rules included with the Special Handling Notes plugin (com.sn_shn).

The Special Handling Notes plugin adds the following business rules.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Updating the table field</td>
<td>Special Handling Notes [sn_shn_notes]</td>
<td>Populates the <strong>Table</strong> field with the table label rather than the whole table name.</td>
</tr>
<tr>
<td>SHN Cache Table Entry</td>
<td>Special Handling Notes Configuration [sn_shn_configuration]</td>
<td>Stores the entries in the configuration table in a cache to avoid repeated queries.</td>
</tr>
</tbody>
</table>

## Client scripts installed with Special Handling Notes

The client scripts included with the Special Handling Notes plugin (com.sn_shn).

The Special Handling Notes plugin adds the following client scripts.
### Client script | Table | Description
---|---|---
On Load Message | Special Handling Notes Configuration [sn_shn_configuration] | On Load Message describing what the Special Handling Notes Configuration table is for. Create a configuration by selecting a table for which special handling notes can be created and displayed. Include notes for related entities by selecting the desired fields and adding them to the configuration.

#### Script includes installed with Special Handling Notes

The script includes included with the Special Handling Notes plugin (com.sn_shn).

The Special Handling Notes plugin adds the following script includes.

| Script include | Description |
---|---|
SHNProcessor | A collection of APIs for special handling notes. |
SHNTTable | Provides a list of tables for which the user can create special handling notes. |

#### Components installed with Targeted Communications

Several types of components are installed with the Targeted Communications application.

#### Tables installed with Targeted Communications

Tables are added with activation of Targeted Communications.

| Table | Description |
---|---|
Recipients (Users) [sn_publications_recipientslist_user_m2m] | Stores recipients lists of type Internal Users. |
Recipients (Accounts) [sn_publications_recipientslist_account_m2m] | Stores recipients lists of type Accounts. |
<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recipients (Consumers)</td>
<td>Stores recipients lists of type Consumers.</td>
</tr>
<tr>
<td>[sn_publications_recipientslist_consumer_m2m]</td>
<td></td>
</tr>
<tr>
<td>Publication Recipients</td>
<td>Stores recipients lists of type Contacts.</td>
</tr>
<tr>
<td>[sn_publications_publication_contact_m2m]</td>
<td></td>
</tr>
<tr>
<td>Workflow Config</td>
<td>Workflow configuration page.</td>
</tr>
<tr>
<td>[sn_publications_workflow_config]</td>
<td></td>
</tr>
<tr>
<td>Publication</td>
<td>Stores all of the publications.</td>
</tr>
<tr>
<td>[sn_publications_publication]</td>
<td></td>
</tr>
<tr>
<td>Recipients List</td>
<td>Stores the recipient lists.</td>
</tr>
<tr>
<td>[sn_publications_recipients_list]</td>
<td></td>
</tr>
<tr>
<td>Recurrence</td>
<td>Stores all of the publication recurrences.</td>
</tr>
<tr>
<td>[sn_publications_recurrence]</td>
<td></td>
</tr>
</tbody>
</table>

**Business rules installed with Targeted Communications**

Business rules are added with activation of Targeted Communications.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create email notification</td>
<td>Publication</td>
<td>Generates the email notification after a new publication is created.</td>
</tr>
<tr>
<td>[sn_publications_publication]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create publication recipients</td>
<td>Publication</td>
<td>Builds the recipient list after the state of a publication changes to Published.</td>
</tr>
<tr>
<td>[sn_publications_publication]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create Recurrence Publications</td>
<td>Recurrence</td>
<td>Generates duplicate publications from the original publication and calculates the start and end dates for each recurrence.</td>
</tr>
<tr>
<td>[sn_publications_recurrence]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Date validation</td>
<td>Publication</td>
<td>Validates the publication and expiration dates. Also validates that the start and end dates for a recurring</td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Delete email notification</td>
<td>Publication</td>
<td>Deletes the email notification if a publication is deleted, cancelled, or expired.</td>
</tr>
<tr>
<td>Delete Recipients List</td>
<td>Recipients List</td>
<td>Prevents a recipient list from being deleted if the list has one or more associated publications.</td>
</tr>
<tr>
<td>Fields validation</td>
<td>Recurrence</td>
<td></td>
</tr>
<tr>
<td>Initialize Publication</td>
<td>Publication</td>
<td>Changes the stage of a publication to Author and the visited_state field to empty whenever a new publication is created.</td>
</tr>
<tr>
<td>Make approver list required</td>
<td>Workflow Config</td>
<td>Makes the Approver field mandatory for articles that require approval prior to publishing.</td>
</tr>
<tr>
<td>Make recipient list required</td>
<td>Publication</td>
<td>Makes the Recipient list field mandatory and ensures that the recipient list is populated.</td>
</tr>
<tr>
<td>Reset error state</td>
<td>Publication</td>
<td>Resets the error_state field to false when a publication is updated.</td>
</tr>
<tr>
<td>Restrict User Access</td>
<td>Publication</td>
<td>Restricts access to published articles to a targeted set of users.</td>
</tr>
<tr>
<td>Show error state message:</td>
<td>Publication</td>
<td>Displays an error message at the top of the form when a publication's error_state field is true.</td>
</tr>
<tr>
<td>Show state message</td>
<td>Publication</td>
<td>Displays a status message when the recipient list is being generated.</td>
</tr>
<tr>
<td>Business rule</td>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Start publication workflow</td>
<td>Publication [sn_publications_publication]</td>
<td>Starts the workflow after a publication is generated.</td>
</tr>
<tr>
<td>Track Customer Publication Views</td>
<td>Publication [sn_publications_publication]</td>
<td>Updates when a user has viewed the article.</td>
</tr>
<tr>
<td>Update Recipients</td>
<td>Recipients List [sn_publications_recipients_list]</td>
<td>Builds or updates a recipient list for a publication.</td>
</tr>
<tr>
<td>Update Visited States on state change</td>
<td>Publication [sn_publications_publication]</td>
<td>Updates the stage changes as a publication moves through the creation, review, and approval process.</td>
</tr>
</tbody>
</table>

**Roles installed with Targeted Communications**

Roles are added with activation of Targeted Communications.

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publications administrator [sn_publications.admin]</td>
<td>The publications administrator can:</td>
<td>• sn_publications.author</td>
</tr>
<tr>
<td></td>
<td>• read all publications</td>
<td>• sn_publications.approver</td>
</tr>
<tr>
<td></td>
<td>• create, update, and delete publications</td>
<td>• workflow_publisher</td>
</tr>
<tr>
<td></td>
<td>• create recurring publications</td>
<td>• image_admin</td>
</tr>
<tr>
<td></td>
<td>• create recipient lists</td>
<td></td>
</tr>
<tr>
<td>Role title [name]</td>
<td>Description</td>
<td>Contains roles</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>• add or remove approvers to workflows</td>
<td></td>
</tr>
<tr>
<td>Publications author [sn_publications.author]</td>
<td>The publications author can:</td>
<td>• sn_publications_recipients_list_user</td>
</tr>
<tr>
<td></td>
<td>• read all publications</td>
<td>• sn_publications_recipients_user</td>
</tr>
<tr>
<td></td>
<td>• create, update, and delete publications</td>
<td>• workflow_publisher</td>
</tr>
<tr>
<td></td>
<td>• create recurring publications</td>
<td>• image_admin</td>
</tr>
<tr>
<td></td>
<td>• create recipient lists</td>
<td>• sn_esm_agent</td>
</tr>
<tr>
<td>Publications approver [sn_publications.approver]</td>
<td>The publications approver can approve publications.</td>
<td>• approver_user</td>
</tr>
<tr>
<td>Recipients list user [sn_publications_recipients_list_user]</td>
<td>The recipients list user can create and view recipient lists.</td>
<td>None</td>
</tr>
<tr>
<td>Recipients user [sn_publications_recipients_user]</td>
<td>The recipients user can view recipient lists.</td>
<td>None</td>
</tr>
</tbody>
</table>

**Client scripts installed with Targeted Communications**

Client scripts are added with activation of Targeted Communications.
<table>
<thead>
<tr>
<th>Client script</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Conditions Table/Field onchange</td>
<td>Recipients List</td>
<td>For recipient lists:</td>
</tr>
<tr>
<td></td>
<td>[sn_publications_recipients_list]</td>
<td>• If the type is Internal Users, this script assigns the User [sys_user] table to the Table field and sys_id to the User Field field.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If the type is Customers, this script assigns the Customer Product [customer_products] table to the Table field sys_id to the User Field field.</td>
</tr>
<tr>
<td>Set Conditions Table/Field onload</td>
<td>Recipients List</td>
<td>For recipient lists:</td>
</tr>
<tr>
<td></td>
<td>[sn_publications_recipients_list]</td>
<td>• If the type is Internal Users, this script assigns the User [sys_user] table to the Table field and sys_id to the User Field field.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If the type is Customers, this script assigns the Customer Product [customer_products] table to the Table field sys_id to the User Field field.</td>
</tr>
<tr>
<td>Switch Publication View</td>
<td>Approval</td>
<td>Validate start date</td>
</tr>
<tr>
<td></td>
<td>[sysapproval_approver]</td>
<td>[sn_publications_publication] Validates that the start date of a publication is after the current date and before the end date.</td>
</tr>
<tr>
<td>Validate start date</td>
<td>Publication</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[sn_publications_publication]</td>
<td>Validates that the start date of a publication is after the current date and before the end date.</td>
</tr>
<tr>
<td>Validate end date</td>
<td>Publication</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[sn_publications_publication]</td>
<td>Validates that the end date of a publication is after the start date.</td>
</tr>
<tr>
<td>Validate start date</td>
<td>Recurrence</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[sn_publications_recurrence]</td>
<td>Validates that the start date of a recurrence publication is after the current date and before the end date.</td>
</tr>
</tbody>
</table>
### Client script

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recurrence [sn_publications_recurrence]</td>
<td>Validates that the end date of a recurrence publication is after the start date.</td>
</tr>
</tbody>
</table>

### Script includes installed with Targeted Communications

Script includes are added with activation of Targeted Communications.

<table>
<thead>
<tr>
<th>Script Include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PublicationAjax</td>
<td></td>
</tr>
<tr>
<td>RecipientsListApi</td>
<td></td>
</tr>
<tr>
<td>RecipientsListApi.getRecipientsListCount</td>
<td>Calculates the total number of recipients for a publication.</td>
</tr>
<tr>
<td>RecipientsListApi.buildRecipientsList for Publication</td>
<td>Builds the recipient list for a publication based on the recipient list’s type and condition.</td>
</tr>
<tr>
<td>PublicationsApi</td>
<td>API functions for publications functionality</td>
</tr>
<tr>
<td>PublicationsQueryProcessor</td>
<td>Ajax helper for showing publications listing.</td>
</tr>
</tbody>
</table>

### Properties installed with Targeted Communications

Properties are added with activation of Targeted Communications.

ℹ️ **Note:** To open the System Property [sys_properties] table, enter `sys_properties.list` in the navigation filter.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_publications.max_email</td>
<td>Limits the number of email recipients.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value:</strong> 100000</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location:</strong> System Property [sys_properties] table</td>
</tr>
</tbody>
</table>
Components installed with Knowledge Product Entitlements

Several types of components are installed with the Knowledge Product Entitlements application.

Business rules installed with Knowledge Product Entitlements

Business rules are added with activation of Knowledge Product Entitlements.

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge Product Entitlement</td>
<td>Knowledge [kb_knowledge]</td>
<td>Implements the needed access controls for users with the sn_customerservice.customer role.</td>
</tr>
<tr>
<td>KB Product Entitlements</td>
<td>Knowledge Base [kb_knowledge_base]</td>
<td></td>
</tr>
</tbody>
</table>

Properties installed with Knowledge Product Entitlements

Properties are added with activation of Knowledge Product Entitlements.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>kb_product_entitlement.knowledge_base.enable</td>
<td>Enable access control of Knowledge Bases based on product entitlements. If enabled, customers can access all of the knowledge bases related to the products for which they have entitlements.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>property</td>
<td>Allow access to Knowledge Bases with empty Related Products field. If enabled, customers can access all knowledge bases even if no products have been specified in the Related Products field on the Knowledge Base form.</td>
</tr>
<tr>
<td>kb_product_entitlement.knowledge_base.allow_empty_products</td>
<td>true/false, default value: false, location: Knowledge Product Entitlements &gt; Properties</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>kb_product_entitlement.article.enable</strong></td>
<td>Enable access control of Knowledge Articles based on product entitlements. If enabled, customers can access all of the knowledge articles related to the products for which they have entitlements.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type</strong>: true/false</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value</strong>: false</td>
</tr>
<tr>
<td></td>
<td>• <strong>Location</strong>: Knowledge Product Entitlements &gt; Properties</td>
</tr>
<tr>
<td><strong>kb_product_entitlement.article.allow_empty_products</strong></td>
<td>Allow access to Knowledge Articles with empty Related Products field.</td>
</tr>
</tbody>
</table>
Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>If enabled, customers can access all knowledge articles even if no products have been specified in the Related Products field on the Knowledge form.</td>
</tr>
<tr>
<td></td>
<td>• Type: true/false</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td></td>
<td>• Location: Knowledge Product Entitlements &gt; Properties</td>
</tr>
</tbody>
</table>

Components installed with Self Service Password Reset

Several types of components are installed with Self Service Password Reset.

Script includes installed with Self Service Password Reset

Script includes are added with activation of Self Service Password Reset.

<table>
<thead>
<tr>
<th>Script include</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PasswordResetAJAX</td>
<td>AJAX Script to process a password reset from a UI Page as guest.</td>
</tr>
<tr>
<td>ResetPwdAjaxProcessor</td>
<td></td>
</tr>
</tbody>
</table>
Components installed with Engagement Messenger

Several types of components are installed with activation of the Engagement Messenger application, including plugins, tables, and user roles.

Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Engagement Messenger admin [sn_csm_ec.ec_admin]</td>
<td>Creates and edits configurations for Embedded Messenger modules</td>
<td>• sn_csm_ec.ec_read&lt;br&gt;• snc_platform_rest_api_access&lt;br&gt;• virtual_agent_admin&lt;br&gt;• image_admin&lt;br&gt;• sp_admin&lt;br&gt;• ais_admin&lt;br&gt;• catalog_builder_editor</td>
</tr>
<tr>
<td>Engagement Messenger read [sn_csm_ec.ec_read]</td>
<td>Can view existing configurations for Embedded Messenger modules</td>
<td>None</td>
</tr>
</tbody>
</table>

Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chat Feature Instance [sn_csm_ec_chat_instance]</td>
<td>Stores configuration details of the Chat feature of the messenger modules.</td>
</tr>
<tr>
<td>Engagement Messenger Module [sn_csm_ec_engmnt_center_module]</td>
<td>Stores the list of all messenger modules.</td>
</tr>
<tr>
<td>Feature [sn_csm_ec_feature]</td>
<td>Stores the feature definitions for the messenger.</td>
</tr>
<tr>
<td></td>
<td>Every feature instance of a messenger module is created from its feature definition.</td>
</tr>
<tr>
<td>Feature Instance [sn_csm_ec_feature_instance]</td>
<td>Stores the details of feature instances of the messenger module.</td>
</tr>
</tbody>
</table>
Table

<table>
<thead>
<tr>
<th>Feature Instance</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Greeting Feature Instance [sn_csm_ec_greeting_instance]</td>
<td>Stores configuration details of the Greeting feature of the messenger modules.</td>
</tr>
<tr>
<td>Knowledge Feature Instance [sn_csm_ec_knowledge_instance]</td>
<td>Stores configuration details of the Knowledge feature of the messenger modules.</td>
</tr>
<tr>
<td>Search Feature Instance [sn_csm_ec_search_instance]</td>
<td>Stores configuration details of the Search feature of the messenger modules.</td>
</tr>
</tbody>
</table>

Plugins installed

- Customer Service (com.sn_customerservice)
- Integration - Multiple Provider Single Sign-On Installer (com.snc.integration.sso.multi.installer)

Feature context parameters supported in Engagement Messenger

Features for contextual launch capability enable you to set the default launch screen in Engagement Messenger.

Embed code and parameters for a feature context

<table>
<thead>
<tr>
<th>Feature</th>
<th>Embed code</th>
<th>Feature parameter description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHAT</td>
<td>`{</td>
<td>&lt;sys_id&gt;</td>
</tr>
<tr>
<td></td>
<td>feature: &quot;CHAT&quot;,</td>
<td>Identifies the Virtual Agent topic to be included in the chat.</td>
</tr>
<tr>
<td></td>
<td>params: {</td>
<td>&lt;language_name&gt;</td>
</tr>
<tr>
<td></td>
<td>&quot;topic_id&quot;: &quot;&lt;sys_id&gt;&quot;,</td>
<td>Default chat language. For example, for French, specify fr</td>
</tr>
<tr>
<td></td>
<td>&quot;language&quot;: &quot;&lt;language_name&gt;&quot;,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;sysparm_&lt;param_name&gt;&quot;: &quot;&lt;param_value&gt;&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>}</td>
<td>}</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
### Embed code and parameters for a feature context (continued)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Embed code</th>
<th>Feature parameter description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WORK_ORDER</td>
<td>{ feature: &quot;WORK_ORDER&quot;, params: { &quot;table&quot;: &quot;wm_order&quot;, &quot;sys_id&quot;: &quot;&lt;sys_id&gt;&quot; } }</td>
<td>Any additional parameters to be passed to the Virtual Agent topic. The name of the parameter should start with <code>sysparm</code>. For example, <code>sys_param_product_name</code>.</td>
</tr>
<tr>
<td>CASE</td>
<td>{ feature: &quot;CASE&quot;, params: { &quot;table&quot;: &quot;sn_customerservice_case&quot;, &quot;sys_id&quot;: &quot;&lt;sys_id&gt;&quot; } }</td>
<td>System identifier (<code>sys_id</code>) of a case.</td>
</tr>
<tr>
<td>NEW_CASE</td>
<td>{ feature: &quot;NEW_CASE&quot;, params: { } }</td>
<td>None</td>
</tr>
<tr>
<td>CASE_LIST</td>
<td>{ feature: &quot;CASE_LIST&quot;, params: { } }</td>
<td>None</td>
</tr>
<tr>
<td>Feature</td>
<td>Embed code</td>
<td>Feature parameter description</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------------------------------------------------------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>VIEW_ARTICLE</td>
<td>{</td>
<td>&lt;sys_id&gt; System identifier (sys_id) of a knowledge article.</td>
</tr>
<tr>
<td></td>
<td>feature: &quot;VIEW_ARTICLE&quot;,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>params: {</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;sys_kb_id&quot;: &quot;&lt;sys_id&gt;&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>}</td>
<td></td>
</tr>
<tr>
<td>SEARCH</td>
<td>{</td>
<td>&lt;search_term&gt; Term to be searched for in a search results query.</td>
</tr>
<tr>
<td></td>
<td>feature: &quot;SEARCH&quot;,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>params: {</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;q&quot;: &quot;&lt;search_term&gt;&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>}</td>
<td></td>
</tr>
<tr>
<td>CASE_SEARCH</td>
<td>{</td>
<td>&lt;search_term&gt; Term to be searched for in a case results query.</td>
</tr>
<tr>
<td></td>
<td>feature: &quot;CASE_SEARCH&quot;,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>params: {</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;q&quot;: &quot;&lt;search_term&gt;&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>}</td>
<td></td>
</tr>
<tr>
<td>CATALOG_ITEM</td>
<td>{</td>
<td>&lt;sys_id&gt; System identifier (sys_id) of a catalog item.</td>
</tr>
<tr>
<td></td>
<td>feature: &quot;CATALOG_ITEM&quot;,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>params: {</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&quot;sys_id&quot;: &quot;&lt;sys_id&gt;&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>}</td>
<td></td>
</tr>
<tr>
<td>NEW_APPOINTMENT</td>
<td>{</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>feature: &quot;NEW_APPOINTMENT&quot;,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>params: {</td>
<td></td>
</tr>
<tr>
<td></td>
<td>}</td>
<td></td>
</tr>
</tbody>
</table>
Embed code and parameters for a feature context (continued)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Embed code</th>
<th>Feature parameter description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NEW_WORK_ORDER</td>
<td>{</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>feature: &quot;NEW_WORK_ORDER&quot;,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>params: {</td>
<td></td>
</tr>
<tr>
<td></td>
<td>}</td>
<td></td>
</tr>
<tr>
<td>HOME</td>
<td>{</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>feature: &quot;HOME&quot;,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>params: {</td>
<td></td>
</tr>
<tr>
<td></td>
<td>}</td>
<td></td>
</tr>
</tbody>
</table>

Related information

Launch a feature in Engagement Messenger using URL parameters
Launch a feature in Engagement Messenger using custom code

Engagement Messenger translation tables

Engagement Messenger uses the [sys_translated_text] and [sys_ui_message] tables to store translated text.

Each translated field on every row has one or more entries in the this table, one per language for which ServiceNow provides a translation.

Translation tables used by Engagement Messenger

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
</table>
| Translated Text [sys_translated_text] | Stores translations for configurable fields such as User Greeting and Search Message. These fields are configured in Engagement Messenger module configuration and have the field type translated_text. The main fields of this table are:  
  • **Document**: Internal identifier of the feature instance record this translation applies to.  
  • **Field name**: Title or subtitle field from feature instance record. |
Translation tables used by Engagement Messenger (continued)

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• <strong>Language</strong>: Language the text is translated into.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Table Name</strong>: Name of the feature instance.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Value</strong>: Translated text that the user sees.</td>
</tr>
<tr>
<td></td>
<td>For details about translating text content into different languages, see</td>
</tr>
<tr>
<td></td>
<td>Translated text table and Translating text fields.</td>
</tr>
</tbody>
</table>

For more information about the Message table, see Message table.

⚠️ **Note:** For information about Virtual Agent chat translation, see Virtual Agent translation tables

### Vaccine Administration Management

The ServiceNow® Vaccine Administration Management application provides a workflow for users, healthcare providers, and clinicians to manage vaccinations for infectious diseases, such as COVID-19, from start to finish.

The Vaccine Administration Management application accelerates the immunization process by delivering predefined content to manage vaccinations.

#### Vaccine portal for users

Users can learn more about vaccines and schedule vaccinations through a self-service portal that is accessible from mobile devices or web browsers.

- Self-register and sign up for vaccinations.
- Ask the ServiceNow® Virtual Agent for help.
- Read Knowledge content about infectious diseases, such as COVID-19.
- Answer a pre-vaccine questionnaire to determine vaccine eligibility.
- Schedule appointments by day and time. Users can also reschedule and cancel appointments.
- View previous and upcoming appointments.
• Receive a QR code for vaccine appointments.
• Receive notifications about appointments.

Healthcare provider administration
Requests for vaccinations initiate vaccination tasks so that provider administrators can track the vaccination process to completion. Use additional Vaccine Administration Management features to prepare users, healthcare providers, and clinicians for requesting and administering vaccinations during pandemics and emergencies like COVID-19.

• Maintain up-to-date information about vaccines, such as models, programs, and availability.
• Manage lists of vaccination centers for use in administering vaccinations and programs.
• Manage the self-service portal that users can use to request vaccinations.
• Provide base system Knowledge content or create articles that users can access to learn more about vaccines.
• Provide base system Virtual Agent conversations so that users can get help.
• Request vaccinations for individual users or mass-schedule appointments.
• Configure location-specific and inventory-based appointment scheduling.

Clinician appointment management
Clinicians can scan a QR code to quickly find the vaccination task and administer the vaccination.

Clinicians can create, read, and update vaccination requests, vaccination tasks, and vaccination questionnaires. A clinician can verify a user’s eligibility prior to administering and recording the vaccination. Clinicians can consume inventory after the vaccine is administered.

When scheduling issues or problems arise, clinicians can cancel appointments. If the user doesn’t show up to a scheduled appointment, clinicians can mark the appointment as a no-show.

Additional information
• Vaccine Administration Management requires instances that are upgraded to Paris Patch 7 or Quebec Patch 1.
• Localization is supported for the following languages:
• Brazilian Portuguese
• Deutsch (German)
• French
• Italian
• Japanese
• Korean
• Simplified Chinese
• Spanish

To learn more about localization and how to activate a language, see System localization and Activate a language.

• Both the vaccine and clinician portals are compatible with WCAG 2.1.

Notice regarding use by organizations

All decisions in connection with the implementation of this application are at the sole decision of the Organization utilizing this application. Organizations agree that use of the application is not a representation by ServiceNow regarding the application’s compliance with any law or regulation and any suggested language provided out of the box with the application does not constitute legal advice by ServiceNow.

Organizations remain solely responsible for complying with their legal obligations under applicable law, including (but not limited to) data protection and employment laws, and should modify any language within the templates provided to meet the Organizations’ specific requirements.

Notice regarding use by government agencies

ServiceNow is offering this application to government agencies and their authorized users, not to government employees in their individual capacities. Use of the application does not modify any existing, or future entitlements or payment obligations for ServiceNow software or applications otherwise purchased by the government agency. ServiceNow shall not be responsible for any implementation or configuration costs associated with use of the application unless separately purchased. Government customers are solely responsible to confirm with the agency’s Ethics Office or its authorized representative that acceptance and usage of the application is permissible.

All decisions in connection with the implementation of this application are at the sole decision of the government agency utilizing this application. Agencies remain solely responsible for complying with their legal obligations under applicable laws and regulations, including (but not limited to) data protection
and employment laws and regulations, and should modify any language within
the templates provided to meet the agency’s specific requirements.

Install Vaccine Administration Management

Vaccine Administration Management (VAM) is available on the ServiceNow Store.

Before you begin

Vaccine Administration Management requires the ServiceNow® Customer Service Management application, the Appointment Booking plugin (com.snc.appointment_booking). The Virtual Agent plugin (com.glide.cs.chatbot) can optionally be installed to enable chatbot conversations in the self-service portal.

If you don’t have a Customer Service Management license, contact your ServiceNow account representative. The ServiceNow platform provides support for column-level encryption (CLE) for the tables under the Vaccine Administration Management application. However, it is not activated as part of the initial app installation.

Note:

- The customer is responsible for configuring the implementation to meet local compliance rules, regulations, and laws.
- If your instance is already set up to use encryption contexts for column-level encryption, migration is required to use encryption modules. Contact Now Support for assistance with the migration.
- To use Column Level Encryption Enterprise, customers must purchase the Column Level Encryption Enterprise SKU. The customer can install and activate Column Level Encryption Enterprise on a single instance (and not on all account instances) if the customer does not share data contained in the Column Level Encryption Enterprise encrypted fields between instances. To avoid fees for using Column Level Encryption Enterprise, existing ServiceNow customers can use column-level encryption (CLE) that is provided at no additional cost or use a third-party encryption solution.
- For further details on installing CLE with Encryption support for Vaccine Administration Management, see Installing CLE with Encryption support for VAM [KB0952557].
- Records under the sys_platform_encryption_configuration table are added as part of VAM that encrypts fields which contain sensitive data. These records must be activated to enable encryption on the corresponding fields.
Role required: admin

**Procedure**

1. Navigate to **System Applications > All Available Applications > All.**
2. Search for **Vaccine Administration Management.**
3. Click **Install.**
   
   The Application installation dialog box opens.

4. Click **Activate.**

   **Note:** The customer is responsible for configuring the implementation to meet local compliance rules, regulations, and laws, including to address protecting sensitive data on its production and non-production instances. This Vaccine Administration Management app is designed to utilize the CLE and KMF encryption that is enabled by installing the plugin. The customer may determine that it desires to skip this step for its instances that do not contain sensitive data (such as an instance for testing that contains only dummy data).

5. Enable Column Level Encryption Enterprise.
a. Go to Now Support and choose Service Catalog from the menu.

b. Click Activate Plugin.

Activate Plugin

Use this form to request activation of a plugin. ServiceNow administrators can activate the plugins that are listed in Product Documentation.
c. In the #What is your target instance field, specify your instance.

d. Select #Plugin I'm looking for is not listed.

e. Under #Specify the name of the plugin, enter #Platform Encryption plugin (com.glide.now.platform.encryption).

f. In the #Reason/Comments field, state that you need the Column Level Encryption Enterprise plugin (com.glide.now.platform.encryption) for #Vaccine Administration Management.

![Reason/Comments field](image)

![Select Maintenance Start Time field](image)

h. Click Submit.

The Key Management Framework plugin (com.glide.kmf.global) is now active on your new instances.

6. Optional: If you're using the CLE and KMF plugins, generate a key so that fields can be encrypted.

   Important: Make sure that the admin has the sn_kmf.cryptographic_manager role to get access to the required tables.

   a. Navigate to Key Management > Cryptographic Modules > All.

   b. Click the sn_vaccine_sm.vm_crypto_module crypto module record.

   c. In the Crypto Specifications related list, click the record that appears in the list.

   d. Navigate to Algorithm Definition > Lifecycle Definition > Key Origin > Key Creation.
e. Click **Generate Key**.
A key is created in the Module Keys related list on the sn_vaccine_sm.vm_crypto_module crypto module record.

**Note:** To view the fields that are encrypted, navigate to **System Security > Field Encryption > Encrypted Field Configurations.**

**Important:** Users with the admin role must have elevated roles to access the Field Encryption menu.

You can encrypt additional data fields based on your requirements and configurations. For information about additional encryption capabilities including edge encryption, database encryption, and full disk encryption, see the *Data encryption white paper.*

**Components installed with Vaccine Administration Management**

Several types of components are installed with Vaccine Administration Management, including user roles and tables.

**Note:** The Application Files table lists the components that are installed with this application. For instructions on how to access this table, see *Find components installed with an application.*
## Roles installed

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Vaccine Administration Management admin [sn_vaccine_sm.admin] | Application-specific admin for Vaccine Administration Management. Important: By default, the admin role contains the sn_vaccine_sm.admin role. The sn_vaccine_sm.admin role should be reassigned to another user and then removed from the admin role. This process protects sensitive application data by restricting access to the application. | • sn_vaccine_sm.clinician  
• sn_vaccine_sm.manager  
• sn_apptmnt_booking.  |
| Clinician [sn_vaccine_sm.clinician]     | Can create, read, and update vaccination requests, vaccination tasks, and vaccination questionnaires. | • sn_vaccine_sm.viewer  
• agent_workspace_user  
• sn_apptmnt_booking.  |
| Vaccine Administration Management manager [sn_vaccine_sm.manager] | Can create, read, and update vaccination programs, phases, centers, methods, and dosages. | • sn_vaccine_sm.viewer  
• sn_vaccine_sm.model_manager  
• agent_workspace_user  
• sn_apptmnt_booking.  |
| Vaccine Administration Management model manager [sn_vaccine_sm.model_manager] | Can create, read, and update vaccine models and vaccine consumables. | • sn_vaccine_sm.model_viewer  
• None  |
| Vaccine Administration Management model viewer | Read-only access to vaccine models and vaccine consumables. | • None  |
## Role title [name]

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>[sn_vaccine_sm.model_viewer]</td>
<td>Read-only access to vaccination programs, phases, centers, methods, and dosages.</td>
<td>• sn_vaccine_sm.model_viewer</td>
</tr>
<tr>
<td>Vaccine Administration Management viewer [sn_vaccine_sm.viewer]</td>
<td>Can request a vaccination and manage appointments.</td>
<td>• sn_apptmnt_booking.appointment_booking_user</td>
</tr>
<tr>
<td>Vaccine Administration Management self-service portal user [sn_vaccine_sm.user]</td>
<td>Can read and edit the appointment dashboard.</td>
<td>• sn_vaccine_sm.report_manager</td>
</tr>
<tr>
<td>Vaccine Administration Management dashboard manager [sn_vaccine_sm.report_manager]</td>
<td>Can read the appointment dashboard.</td>
<td>• None</td>
</tr>
<tr>
<td>Vaccine Administration Management dashboard viewer [sn_vaccine_sm.report_viewer]</td>
<td>Can read the appointment dashboard.</td>
<td>• None</td>
</tr>
<tr>
<td>Vaccine Administration Management inventory manager [sn_vaccine_sm.inventory_manager]</td>
<td>Can maintain vaccine supply information and distribution.</td>
<td>• sn_vaccine_sm.inventory_viewer</td>
</tr>
<tr>
<td>Vaccine Administration Management inventory viewer [sn_vaccine_sm.inventory_viewer]</td>
<td>Can read the vaccine inventory management tables.</td>
<td>• None</td>
</tr>
</tbody>
</table>

### Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details - Personal Information [sn_vaccine_sm_personal_info]</td>
<td>Contains information captured from the user during the vaccination sign-up process, including occupation, demography, address, and identity document.</td>
</tr>
<tr>
<td>Dosage [sn_vaccine_sm_dosage]</td>
<td>Contains the table of vaccine dosages, such as the first or second dose.</td>
</tr>
<tr>
<td>Mass Booking Config [sn_vaccine_sm_mass_booking_config]</td>
<td>Lists Mass Booking configurations used to mass schedule vaccinations.</td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Method</td>
<td>Contains records about the methods available to vaccinate someone within a program, such as using the Pfizer or Moderna COVID-19 vaccines.</td>
</tr>
<tr>
<td>[sn_vaccine_sm_method]</td>
<td></td>
</tr>
<tr>
<td>Phase</td>
<td>Shows the stage of release that a vaccine program is in and when it is available to administer. Includes the start date, end date, additional eligibility criteria, and number of vaccines available.</td>
</tr>
<tr>
<td>[sn_vaccine_sm_phase]</td>
<td></td>
</tr>
<tr>
<td>Program</td>
<td>Lists available programs used to administer vaccinations.</td>
</tr>
<tr>
<td>[sn_vaccine_sm_program]</td>
<td></td>
</tr>
<tr>
<td>Program Center</td>
<td>Lists vaccination centers that are a part of a vaccine program.</td>
</tr>
<tr>
<td>[sn_vaccine_sm_program_center_mtom]</td>
<td></td>
</tr>
<tr>
<td>Terms and Conditions</td>
<td>Lists the terms and conditions records that users agree to when logging in to the self-service portal, such as a privacy policy. Only one Terms and Conditions record can be active at a time.</td>
</tr>
<tr>
<td>[sn_vaccine_sm_terms_conditions]</td>
<td></td>
</tr>
<tr>
<td>User Options</td>
<td>Lists the users who have accepted the privacy policy and when they accepted it. This table is automatically populated when a portal user accepts the privacy policy.</td>
</tr>
<tr>
<td>[sn_vaccine_sm_user_options]</td>
<td></td>
</tr>
<tr>
<td>Vaccination Center</td>
<td>Lists vaccination centers, the vaccination center location, contact information, and the vaccination center stockroom.</td>
</tr>
<tr>
<td>[sn_vaccine_sm_center]</td>
<td></td>
</tr>
<tr>
<td>Vaccination Questionnaire</td>
<td>Stores the responses to a questionnaire sent to users who have booked a vaccination appointment.</td>
</tr>
<tr>
<td>[sn_vaccine_sm_questionnaire]</td>
<td></td>
</tr>
<tr>
<td>Vaccination Request</td>
<td>Contains vaccination requests and the associated Vaccination Task</td>
</tr>
<tr>
<td>[sn_vaccine_sm_request]</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Vaccination Task</td>
<td>Contains all Vaccination Tasks, including Vaccination Requests.</td>
</tr>
<tr>
<td>[sn_vaccine_sm_task]</td>
<td></td>
</tr>
<tr>
<td>Vaccine</td>
<td>Contains vaccine stock, including information about the model, quantity, and availability. A user with the sn_vaccine_sm.manager role can add or remove records to reflect the vaccines that are currently available to request. By default, this table contains several generic COVID-19 vaccines.</td>
</tr>
<tr>
<td>[sn_vaccine_sm_consumable]</td>
<td></td>
</tr>
<tr>
<td>Vaccine Model</td>
<td>Contains the model of the vaccine type, such as the Moderna COVID-19 vaccine. View information such as the manufacturer and model number.</td>
</tr>
<tr>
<td>[sn_vaccine_sm_product_model]</td>
<td></td>
</tr>
</tbody>
</table>

### Configuring Vaccine Administration Management

Complete all configuration tasks to confirm that Vaccine Administration Management is set up correctly for your organization.

#### Create vaccine models

Create a vaccine model to track and manage different vaccines under Vaccine Administration Management.

**Before you begin**

Role required: sn_vaccine_sm.model_manager

**About this task**

Vaccine Administration Management includes vaccine models for the Moderna COVID-19 vaccine and the Pfizer-BioNTech COVID-19 vaccine. To track and manage any other vaccines, create vaccine models.
Procedure
1. Navigate to Vaccine Administration > Administration > Vaccine Models, and click New.
2. In the Model categories field, select Vaccine.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Model form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the model. A system property called glide.cmdb_model.display_name.shorten controls how software model display names are generated.</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>The company that built the model.</td>
</tr>
<tr>
<td>Name</td>
<td>The manufacturer-assigned name of the model or abstract name specified by the model manager, such as Field Agent Laptop.</td>
</tr>
<tr>
<td>Short description</td>
<td>A brief description of the model.</td>
</tr>
<tr>
<td>Model categories</td>
<td>The categories that the model is assigned to. This field is a Glide list and cannot be used to create reports.</td>
</tr>
</tbody>
</table>
| Asset tracking strategy | The process by which the model can be tracked. Choose from the following:
  - **Leave to Category:** The model is transparent and the category defines the asset class.
  - **Create Consumable Asset:** The model forces the asset class to be consumable, regardless of what the category defines as the asset class.
  - **Don’t create assets:** The model blocks asset instantiation, regardless of what the category defines as the asset class. |
<p>| Asset tracking unit | The unit that is used to measure the asset. |
| Acquisition method | The method for purchasing the model. The options are Both, Buy, or Lease. |
| Cost | The cost of a single unit of the model. |
| Depreciation | The depreciation scheme for the model. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Salvage value</td>
<td>The estimated value that an asset realizes on its sale at the end of its useful life. This value must be less than or equal to the cost of the asset.</td>
</tr>
<tr>
<td>Model number</td>
<td>The model number assigned to the item by the manufacturer.</td>
</tr>
<tr>
<td>Barcode</td>
<td>The barcode number assigned to the model. Barcodes are assigned by the manufacturer.</td>
</tr>
<tr>
<td>Owner</td>
<td>The person responsible for the model.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the model. The options are In Production, Retired, and Sold.</td>
</tr>
<tr>
<td>Expenditure type</td>
<td>The type of expenditure. Choose from the following:</td>
</tr>
<tr>
<td></td>
<td>• Capex: Capital expenditure is a one-time expenditure, where the value is realized over the years. For example, a photocopier.</td>
</tr>
<tr>
<td></td>
<td>• Opex: Operational expenditure is an on-going expenditure. For example, toners for the photocopier.</td>
</tr>
<tr>
<td>Certified</td>
<td>The option that determines whether the model is approved for use.</td>
</tr>
<tr>
<td>Comments</td>
<td>Information about the model that would be helpful for others to know.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.

**Create vaccine consumable assets**
Create a vaccine consumable asset and associate it with a vaccine model.

**Before you begin**
Role required: sn_vaccine_sm.model_manager

**Procedure**
1. Navigate to Vaccine Administration > Administration > Vaccines, and click **New**.
2. In the **Model category** field, select Vaccine.
3. In the **Model** field, select the vaccine model that you want to associate the vaccine consumable asset with.
4. On the form, fill in the fields.
## Consumable record form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display name</td>
<td>Name of the consumable asset.</td>
</tr>
<tr>
<td>Model category</td>
<td>Model categories that the model can be associated with. Model categories are used to create configuration items (CIs) and assets.</td>
</tr>
<tr>
<td>Model</td>
<td>Product model of the asset.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Amount of items the asset represents.</td>
</tr>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>State</td>
<td>State of the asset.</td>
</tr>
<tr>
<td>Parent</td>
<td>Parent asset. When a parent asset is defined, the <strong>Assignment</strong> and <strong>State</strong> fields of the child asset are automatically populated based on the <strong>Assignment</strong> and <strong>State</strong> fields of the parent asset and are read-only.</td>
</tr>
<tr>
<td>Class</td>
<td>Type of asset.</td>
</tr>
<tr>
<td>Expenditure type</td>
<td>Type of expenditure. Choose from the following options:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Capex</strong>: Capital expenditure is a one-time expenditure, where the value is realized over the years. For example, a photocopier.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Opex</strong>: Operational expenditure is an on-going expenditure. For example, toners for the photocopier.</td>
</tr>
<tr>
<td>Substate</td>
<td>Sub-state of the asset.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>The user assigned to the record.</td>
</tr>
<tr>
<td>Location</td>
<td>Location of the asset.</td>
</tr>
<tr>
<td>Cost</td>
<td>Price that the asset was purchased for.</td>
</tr>
<tr>
<td>Cost center</td>
<td>Cost center financially responsible for the asset.</td>
</tr>
<tr>
<td>Disposal</td>
<td></td>
</tr>
<tr>
<td>Disposal reason</td>
<td>Text explaining why the asset is being retired.</td>
</tr>
<tr>
<td>Beneficiary</td>
<td>Organization that receives the asset when it is retired.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Resale price</td>
<td>Value of the asset when it is retired. For example, if the asset is donated, the value used when reporting taxes.</td>
</tr>
<tr>
<td>Scheduled retirement</td>
<td>Scheduled date on which the asset is retired.</td>
</tr>
<tr>
<td>Retired date</td>
<td>Actual date on which the asset was retired.</td>
</tr>
<tr>
<td>Activities</td>
<td></td>
</tr>
<tr>
<td>Work notes</td>
<td>Work notes related to the asset.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

**Create vaccination programs**

Create vaccination programs to track and manage vaccinations.

**Before you begin**

Role required: sn_vaccine_sm.manager

**About this task**

To manage Covid-19 vaccinations, use the provided Covid-19 Vaccination Program. To manage any other vaccinations, create a program. The Covid-19 Vaccination Program includes predefined vaccine methods, but you must add centers and phases to the program.

**Procedure**

1. Navigate to **Vaccine Administration > Administration > Programs** and click **New**.

2. On the form, fill in the fields.

**Program form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the vaccination program.</td>
</tr>
<tr>
<td>Catalog item</td>
<td>Vaccine appointment scheduling.</td>
</tr>
</tbody>
</table>
3. Click **Save**.

4. In the Centers related list, add the locations where the vaccine will be administered.
   - To create a new center with a location and a stockroom, click **New**.
   - To add existing centers to the program, click **Edit**.

   **Note:**
   If required, you can also remove the existing centers from the program. When you remove an existing center from the program, no more appointments can be booked for that center. However, there will be no changes to the pre-booked appointments.

   For each location center, you can specify the appointment schedule configuration, as well as configure the scheduling based on available inventory. For details, see:
   - Configure advanced appointment scheduling for a center
   - Configure inventory-based scheduling for a center

5. In the Phases related list, define the phases for when the vaccine will be administered.

   a. Enter a name for the phase.
      For example, **Phase 1**.

   b. Select the start and end dates for the phase.

   c. Add conditions to the eligibility criteria to define who receives the vaccine during this phase.
      For example, Phase 1 could be limited to people in the senior age group.
6. In the Methods related list, add each version of the vaccine that is available through the vaccination program.

   a. Click New.

   b. Enter a name for the vaccine method.

   c. In the Applicable to field, add filter conditions to define who can receive the vaccine method.
      For example, the vaccination may only be suitable for specific age groups, or it may only be provided at specific centers.

   d. Click Save.

7. In the Dosages related list, create a dosage record for each required dose.

   a. Click New.

   b. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the dose. For example, First dose.</td>
</tr>
<tr>
<td>After</td>
<td>The dose that must be administered before this dose. If this dose is the</td>
</tr>
</tbody>
</table>
<pre><code>            | first dose, don't select a value for this field.                            |
</code></pre>
<p>| Lead time   | The minimum number of days that this dose can be administered after        |
| receiving the preceding dose. If this dose is the first dose, don't select |
| a value for this field. This field appears only when a value is selected   |
| from the After field.                                                      |
| Max time    | The maximum number of days that this dose can be administered after        |
| receiving the preceding dose. If this dose is the first dose, don't select |
| a value for this field. This field appears only when a value is selected   |
| from the After field.                                                      |
| Method      | The vaccine method for the dose. This field is automatically set.           |
| Order       | The order of the dose. For example, 100 for a first dose and 200 for a      |
| second dose.                                                                |</p>
Configure the eligibility criteria for a vaccination program

Configure the eligibility criteria that users must meet to be eligible for a vaccination program.

Before you begin
Role required: sn_vaccine_sm.admin

About this task
After users register and provide personal information in the portal, the information is compared with the vaccination program's eligibility criteria to determine whether the users are eligible for the program. If the users are eligible, then the user will be able to proceed to the next stage and schedule the vaccinations. If no eligibility criteria is provided, then all registered users are eligible to schedule vaccinations.

Procedure
1. Navigate to Vaccine Administration Management > Administration > Programs.
2. Open the vaccination program record that you want to configure the eligibility criteria for.
3. In the Eligibility Criteria condition builder, add one or more filter conditions to define the criteria that users must meet to be eligible for the vaccination program.
   For example, the following eligibility criteria is defined for users that are above the age of 60 or are a healthcare worker. When users provide their personal information in the portal, the user must meet one of these conditions to be eligible for the vaccination program.
4. Click Update.

Configure advanced appointment scheduling for a center

Configure advanced appointment scheduling for a center. Advanced appointment scheduling enables you to configure different vaccination schedules, weekly, daily, and more, and the capacity to meet the changing needs of different location centers and programs.
Before you begin
Navigate to Vaccine Administration Management > Administration > Properties, and make sure that the Enable Vaccine Administration Management location specific Appointment Configuration property (sn_vaccine_sm.enable_vam_appointment_config) is selected.

⚠ Warning: Once you've enabled the property and your advanced appointment scheduling configurations are live, avoid disabling the property to prevent any data inconsistencies.

Role required: sn_vaccine_sm.admin

About this task
Configure advanced appointment scheduling for a center. You can create appointment configurations for use at a specific location or for reuse across multiple location centers and programs.

For each appointment configuration, you can create one or more vaccination schedules to configure the daily start and end time, the days that appointments can be booked, the inclusion of a daily break, and more. Appointment configurations apply for both self-scheduled and mass-booked appointments.

⚠ Important: When you enable this feature, it replaces the default appointment scheduling configuration that is applied across all centers. For further information about the default configuration, see Configure vaccine appointment scheduling.

Procedure
1. Navigate to Vaccine Administration Management > Administration > Programs.
2. Open a program record.
3. In the Center related list, click the preview icon (i) to open the program center record.
4. In the Appointment configuration field, click the lookup icon (q).
5. Click New.
6. On the form, fill in the fields.
Vaccination Appointment Configuration form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the appointment configuration.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the appointment configuration.</td>
</tr>
<tr>
<td>Holiday schedule</td>
<td>Holiday schedule to associate with the appointment configuration.</td>
</tr>
<tr>
<td>Appointment duration</td>
<td>Appointment duration for the appointment configuration, which can range from 10 minutes to 8 hours.</td>
</tr>
<tr>
<td>Lead time</td>
<td>Time after which the first available appointment slot is shown to the user. For example, say that the lead time is four hours. If the current time is 7 AM, then the next available slot that the user would see would be for 11 AM.</td>
</tr>
<tr>
<td>Future bookable max days</td>
<td>Range of days that the user can view available slots to book their appointment. For example, say that the value is 14 days. When the user is scheduling the appointment, the user sees available slots for the next 14 days.</td>
</tr>
<tr>
<td>Reschedule/Cancel by time</td>
<td>Time until the user can reschedule or cancel their appointment. For example, say that the value is six hours. If the appointment is scheduled for Monday at 3 PM, then the user must reschedule or cancel the appointment by 9 AM that same day.</td>
</tr>
<tr>
<td>Active</td>
<td>Option to activate the appointment configuration for use. If enabled, then the appointment configuration applies for both self-scheduled and mass booked appointments.</td>
</tr>
</tbody>
</table>
7. Right-click the form header and click **Save**.

8. In the Vaccination Schedules related list, create one or more vaccination schedules for the appointment configuration.

   a. Click **New**.

   b. On the form, fill in the fields.

   **Vaccination Schedule form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the vaccination schedule.</td>
</tr>
<tr>
<td>Start date</td>
<td>Start date for the schedule.</td>
</tr>
<tr>
<td>Appointments per window</td>
<td>Number of appointments per window.</td>
</tr>
<tr>
<td>Daily start time</td>
<td>Daily start time for the schedule.</td>
</tr>
<tr>
<td>Bookable days</td>
<td>Days that appointments can be booked.</td>
</tr>
<tr>
<td>Include daily break</td>
<td>Option to include a daily break. If enabled, you can specify the start and end time of the daily break.</td>
</tr>
<tr>
<td>Appointment configuration</td>
<td>This field is automatically set to the associated appointment configuration record.</td>
</tr>
<tr>
<td>End date</td>
<td>End date of the schedule.</td>
</tr>
<tr>
<td>Appointment duration</td>
<td>This field is automatically set to the appointment duration that was set in the associated appointment configuration record.</td>
</tr>
<tr>
<td>Daily end time</td>
<td>Daily end time of the schedule.</td>
</tr>
<tr>
<td>Appointment booking preview</td>
<td>Preview of the vaccination schedule.</td>
</tr>
</tbody>
</table>

   c. Click **Submit**.

   d. Repeat the procedure to create vaccination schedules, as needed.
What to do next
Once the configuration is finalized, changing some of the configuration values can have undesired side effects on both existing and future appointment scheduling. For details on how to handle advanced appointment scheduling configurations for a center, see Guidance for configuring advanced appointment scheduling for a vaccination center.

Guidance for configuring advanced appointment scheduling for a vaccination center

Advanced appointment scheduling configuration enables administrators to configure appointment durations, daily schedule, holiday schedule, and so on. This configuration is used to identify the available slots as well as a location’s capacity for a given day and enable users to select appointment slots based on the parameters that you configure.

Be mindful that changing some of the configuration values for a finalized vaccination center configuration can have undesired side effects on both existing and future appointments.

The following forms and tables provide some helpful guidance for handling advanced appointment scheduling configurations for a vaccination center and some of the impacts of making certain changes. However, this guidance does not address an exhaustive list of all possible side effects.

### Vaccination Appointment Configuration form

<table>
<thead>
<tr>
<th>Field</th>
<th>Recommendation and Impact</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>You can change the name field without causing undesired side effects.</td>
</tr>
</tbody>
</table>
### Vaccination Appointment Configuration form (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Recommendation and Impact</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>You can change the description field without causing undesired side effects.</td>
</tr>
</tbody>
</table>
| Holiday schedule       | • Do not add a new holiday schedule when there are existing appointments in the current location. It invalidates existing appointments.  
                          | • Do not add more holidays to the existing holiday schedule. New holidays may already contain booked appointments. |
| Appointment duration    | • Do not modify the appointment duration when appointments have already been created in the current location.  
                          | • Impact: Changing the total capacity of a location causes overlapping slots that result in overbooked appointments.  
                          | • For example:  
                          | 1. In your old configuration, if the appointment window was 5 minutes, the daily schedule would have looked like: 9:00 to 9:05, 9:05 to 9:10, 9:10 to 9:15, and 9:15 to 9:20. In this configuration, you have appointments booked from 9:00 to 9:05 and from 9:05 to 9:10, and appointments available from 9:10 to 9:15 and from 9:15 to 9:20.  
                          | 2. If you create a new configuration with an appointment window of 10 minutes, then your daily appointment schedule would look like: 9:00 to 9:10, 9:10 to 9:20, 9:20 to 9:30, and 9:30 to 9:40. In this configuration, you would have overlapping slots from 9:10 to 9:20, which would result in overbooked appointments. |

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Vaccination Appointment Configuration form (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Recommendation and Impact</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>schedule would look like: 9 to 9:10, 9:10 to 9:20 with available slots from 9:10 to 9:20, and actual slots are displayed in the same 10-minute increments.</td>
</tr>
<tr>
<td>3.</td>
<td>The configuration change causes an overbooking in the 9:00 to 9:10 slot, because it was booked for two appointments in the previous configuration.</td>
</tr>
<tr>
<td>Lead time</td>
<td>You can change the lead time value without impacting any existing appointments.</td>
</tr>
<tr>
<td>Future bookable max days</td>
<td>• Do not decrease the value because appointments may have been booked on the last day in the current location. Decreasing the value invalidates appointments booked on the last day.</td>
</tr>
<tr>
<td></td>
<td>• You can increase the value without impacting any existing appointments.</td>
</tr>
<tr>
<td>Reschedule or cancel by time</td>
<td>• You can conditionally change the value.</td>
</tr>
<tr>
<td></td>
<td>• If there is any work flow that impacts existing appointments or users, it is not safe to change the value.</td>
</tr>
<tr>
<td>Active</td>
<td>• Do not deactivate the configuration when there are existing appointments. It invalidates existing appointments.</td>
</tr>
</tbody>
</table>
### Vaccination Appointment Configuration form (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Recommendation and Impact</th>
</tr>
</thead>
<tbody>
<tr>
<td>• You can activate the previously inactive configuration without impacting any appointments.</td>
<td></td>
</tr>
</tbody>
</table>

### Vaccination Schedule form

<table>
<thead>
<tr>
<th>Field</th>
<th>Recommendation and Impact</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>You can change the name field without causing undesired side effects.</td>
</tr>
<tr>
<td>Start date</td>
<td>• Do not increase the value because appointments may be booked between the old start date and the new start date. Increasing the value invalidates appointments booked between the old start date and the new start date.</td>
</tr>
<tr>
<td>• You can decrease the value only when there are no overlapped slots configured in the other schedule under the same appointment configuration.</td>
<td></td>
</tr>
</tbody>
</table>
### Vaccination Schedule form (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Recommendation and Impact</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• For example:</td>
</tr>
<tr>
<td></td>
<td>1. Say that your old schedule has a start date of April 8, 2021 and bookable days from Monday to Friday from 09:00 to 18:00.</td>
</tr>
<tr>
<td></td>
<td>2. Suppose that you created another schedule under the same appointment configuration which has a start and end date of March 1, 2021 to March 31, 2021.</td>
</tr>
<tr>
<td></td>
<td>3. Now, if you change the schedule start date to March 31, 2021, it creates an overlapped bookable slot with the existing schedule on March 31, 2021 and the system will create an error.</td>
</tr>
<tr>
<td>End date</td>
<td>• Do not decrease the value because appointments may be booked between the new end date and the old end date. Increasing the value invalidates appointments booked between the new end date and the old end date.</td>
</tr>
<tr>
<td></td>
<td>• You can increase the value only when there are no overlapped slots configured in the other schedule under the same appointment configuration.</td>
</tr>
<tr>
<td>Appointments per window</td>
<td>• Do not set the number of appointments per window to 0.</td>
</tr>
<tr>
<td></td>
<td>• You can increase the number of appointments per window.</td>
</tr>
</tbody>
</table>
## Vaccination Schedule form (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Recommendation and Impact</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Do not decrease the number of appointments per window for a service configuration when appointments have already been created.</td>
</tr>
<tr>
<td></td>
<td>• Impact: Reducing the total number of appointments per window results in overbooked appointments per slot for the appointments that were created before the change.</td>
</tr>
<tr>
<td></td>
<td>• For example:</td>
</tr>
<tr>
<td></td>
<td>1. Old configuration: You had 4 appointments per window. If the total number of windows = 2, then your total capacity is 2<em>4, or 8. If you had 4 appointments created per slot, the total capacity used is 4</em>2, or 8.</td>
</tr>
<tr>
<td></td>
<td>2. New configuration: You have 2 appointments per window. If you have two total windows, then your new total capacity is 2<em>2, or 4. But if you had 4 appointments already created per slot (based on a past configuration), then your total capacity is 4</em>2, or 8.</td>
</tr>
<tr>
<td></td>
<td>3. With this configuration, the total capacity, 8, exceeds the new total capacity of 4, causing overbooked appointments.</td>
</tr>
<tr>
<td>Daily start time</td>
<td>Do not modify the daily start time when appointments are already present. Modification creates overbooked slots and invalidates previous appointments.</td>
</tr>
</tbody>
</table>
## Vaccination Schedule form (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Recommendation and Impact</th>
</tr>
</thead>
</table>
| **Daily end time**   | - You can increase the daily end time. The increase is only valid when the appointment duration and daily start values are not changed.  
                          - Do not make the daily end time earlier when appointments are already present. Doing so creates overbooked slots and invalidates previous appointments. |
| **Bookable days**    | - You can add days without impacting existing appointments.  
                          - Removing the bookable days when appointments have already been created invalidates past appointments.  
                          - For example:  
                            1. In your old configuration, suppose that Saturday is bookable and appointments are booked on Saturday.  
                            2. If you create a new configuration in which Saturday is not bookable, any appointments previously booked for Saturday are no longer valid. |
| **Include daily break** | - Do not change the value of the Include daily break check box.  
                           - Do not add the daily break time if this check box is cleared. |
Vaccination Schedule form (continued)

<table>
<thead>
<tr>
<th>Field</th>
<th>Recommendation and Impact</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Do not change the duration of the break.</td>
</tr>
<tr>
<td></td>
<td>• Do not set the break start time and end time to be the same as the daily start time and daily end time because it will not generate bookable slots.</td>
</tr>
</tbody>
</table>

Configure inventory-based scheduling for a center

Configure scheduling based on available inventory for a center. Inventory-based scheduling enables you to limit appointment booking based on the available inventory for that day. For example, say that a center has 200 available doses and 500 available appointment slots for a particular day. Because there are only 200 doses, appointment booking would be capped at 200 appointments for that day.

Before you begin
Navigate to Vaccine Administration Management > Administration > Properties, and make sure that the Enables vaccine inventory management property (sn_vaccine_sm.enable_inventory_management) is selected.

⚠️ Warning: Once you’ve enabled the property and your inventory-based configurations are live, avoid disabling the property to prevent any data inconsistencies.

Role required: sn_vaccine_sm.admin or sn_vaccine_sm.inventory_manager

About this task
Configure scheduling based on available inventory for a center. When you receive a vaccine supply lot at a particular center, you can provide details about the lot for the vaccine type, number of doses, expiration date, and so on, and add it to your inventory. You can then automate or manually distribute the inventory over a specified date range. You can also manually track wasted doses.

⚠️ Important: This feature is only available for user-scheduled appointments. It is not currently supported for mass booking.
Procedure

1. Navigate to Vaccine Administration Management > Administration > Programs.

2. Open a program record.

3. In the Center related list, open a vaccination center record.

4. In the Vaccine Supply Lots related list, create a new record for each vaccine supply lot that you receive at that location.

   a. Click **New**.

   b. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lot number</td>
<td>Number of the lot.</td>
</tr>
<tr>
<td>Vaccine model</td>
<td>Vaccine model of the lot.</td>
</tr>
<tr>
<td>Center</td>
<td>Program center that the lot is located at.</td>
</tr>
<tr>
<td>Available from</td>
<td>Date that the lot is available from.</td>
</tr>
<tr>
<td>Expires on</td>
<td>Date that the lot expires, as specified by the manufacturer.</td>
</tr>
<tr>
<td>Notes</td>
<td>Notes about the lot.</td>
</tr>
<tr>
<td>Total number of doses</td>
<td>Total number of doses in the lot. This number must be manually calculated by the inventory manager.</td>
</tr>
<tr>
<td>State</td>
<td>State of the lot:</td>
</tr>
<tr>
<td></td>
<td>• Not available</td>
</tr>
<tr>
<td></td>
<td>• Available</td>
</tr>
</tbody>
</table>

c. Right-click the form header and click **Save**.

d. To confirm that the lot was received and is included in the inventory for that location, click **Make Available**.
5. To distribute the lot automatically.

   a. Open the vaccine supply lot record.

   b. Click Distribute.

   The lot is evenly distributed over a specified number of business days based on the location's appointment scheduling configuration. For example, say that the lot is distributed over seven days at a center that is closed on Saturday and Sunday. If the lot distribution begins on Monday, then it is evenly distributed over the next seven business days (Monday through Friday of that week, and then the following Monday and Tuesday).

   **Note:** By default, the number is set to seven days. To change the number of days, navigate to Vaccine Administration Management > Administration > Properties, and update the Number of days to distribute a lot property (sn_vaccine_sm.im_lot_distribution_day_count).

   **Tip:** When you distribute the lot automatically, you have the option to then manually adjust the allocated doses for an individual day. Open the Vaccine Availability by Lot record for the day that you want to update the doses for, and then update the Allocated Doses field.

6. To distribute the lot manually.

   a. Open the vaccine supply lot record.

   b. In the Vaccine Availability related list, click New.

   c. On the form, fill in the fields.

   **Vaccine Availability form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Center</td>
<td>Center that the vaccine is available from.</td>
</tr>
<tr>
<td>Available on</td>
<td>Date that the vaccine is available from.</td>
</tr>
<tr>
<td>Vaccine model</td>
<td>Vaccine model of the program.</td>
</tr>
<tr>
<td>Allocated doses</td>
<td>This field value is automatically set.</td>
</tr>
<tr>
<td>Booked doses</td>
<td>This field value is automatically set.</td>
</tr>
</tbody>
</table>
### Vaccine Availability By Lot form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Used doses</td>
<td>This field value is automatically set.</td>
</tr>
<tr>
<td>Wasted doses</td>
<td>Number of wasted doses per day. This number must be manually entered by the inventory manager.</td>
</tr>
<tr>
<td>Notes</td>
<td>Notes about the availability of the vaccine.</td>
</tr>
</tbody>
</table>

d. Right-click the form header and click **Save**.

e. In the Availability By Lot related list, click **New**.

f. On the form, fill in the fields.

### Vaccine Availability By Lot form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supply Lot</td>
<td>Lot to associate with the vaccine availability.</td>
</tr>
<tr>
<td>Available On</td>
<td>Date that the vaccine is available from. The date must be within the availability and expiration range of the associated lot.</td>
</tr>
<tr>
<td>Allocated Doses</td>
<td>Number of allocated doses. The number of allocated doses must be less than the total number of doses available in the associated lot.</td>
</tr>
<tr>
<td>Notes</td>
<td>Notes about the vaccine availability for this lot.</td>
</tr>
</tbody>
</table>

g. Click **Submit**.

h. To create more records for vaccine availability, repeat the Availability By Lots procedure, as needed.

### Configure vaccine appointment scheduling

Appointments are automatically scheduled when users request a vaccination through the portal or when using mass booking. Define a schedule for the
automatic appointment creation to follow, such as only creating appointments on specific days of the week or during specific time frames.

Before you begin
Role required: sn_vaccine_sm.admin

About this task
Vaccine Administration Management provides an appointment configuration that you can modify to meet your organization's requirements.

Appointments are automatically scheduled for users according to the configuration that you set up. However, users can select a different appointment time in the portal if the automatically scheduled time is not convenient.

Important: This default appointment scheduling configuration is applied across all centers. Beginning with version 4 of Vaccine Administration Management, advanced appointment scheduling configuration is available. To learn more about how to enable and configure the feature, see Configure advanced appointment scheduling for a center.

Procedure
1. Navigate to Vaccine Administration > Administration > Service Configurations.
2. Click the Schedule Vaccine Appointment record.
3. Update the information in each section of the form to modify the configuration as needed.
   For detailed instructions on how to fill in each section, see Configure appointment booking.
   For details on how to handle appointment booking configurations after appointments start getting scheduled, see Recommendations on Appointment Booking configuration for Vaccine Administration Management [KB0953615].
4. Click Update.

Multi-vaccine appointment bookings configuration
Administer multi-vaccine appointment bookings based on auto-selection and manual selection of the vaccine method. You can select your preferred vaccine method based on the eligibility criteria, order of method selection, and inventory availability.

You can manage multi-vaccine appointment bookings after making configuration changes to the Vaccine Administration Management system.
properties. Multi-vaccine functionality can be broadly categorized into auto-
selection of the vaccine method and manual selection of the vaccine method.

**Note:** If your first appointment has been completed, you cannot change
the method. However, you have the flexibility to change the method while
rescheduling your first dose. While rescheduling your appointment, if you
change the method, it automatically applies to the second dose as well.

Among other criteria, the multi-vaccine method also supports age-based
eligibility and assignment by specifying the age groups in the eligibility criteria
for the method. The list of methods is visible only if you are eligible for more than
one vaccine method.

For example, say that only age groups over 60 are eligible to receive the Pfizer
vaccine. If you are not in this age group, you will not be assigned the Pfizer
vaccine despite availability. Instead, the system evaluates other methods that
meet the eligibility criteria defined for the program and the method.

### Auto-selection of method

**Note:** Auto-selection of the vaccination method only applies if the
`sn_vaccine_sm.enable_inventory_management` system property value is `true`.

When you try to book an appointment, the system auto-assigns the
method of vaccine based on the order of method selection and inventory
availability. In other words, if the inventory management system property
(`sn_vaccine_sm.enable_inventory_management`) is `true`, the vaccination request
auto-assigns the method with the lowest order that has inventory availability.

For example, if a vaccination center has the Moderna vaccine in the inventory,
the request is created using Moderna instead of Pfizer, even when Pfizer is the
method with the lowest order.

### Manual selection of method

You can manually select the preferred vaccination method while booking an
appointment. Manual selection of the method works with or without vaccine
inventory management.

If the slot selection system property
(`sn_vaccine_sm.enable_appointment_slot_choice`) is `false`, the vaccine method
selected is kept as the preference. If there is no availability for the second dose,
the system books the slot at the closest vaccination center having the same
method. For example, if you select a vaccination site and the site has only one
week of the Pfizer vaccine available, the second dose is selected in the nearest
center having the same method.
Note: For the functionality to run properly, make sure that both the inventory management system property (sn_vaccine_sm.enable_inventory_management) and the enable multi-vaccine system property (sn_vaccine_sm.enable_multi_vaccine) values are true.

Book appointments for subsequent doses after a previous dose is complete
Define whether to enable booking for all doses of the vaccine, for both mass booking and self-service, or to enable booking for the first dose, with subsequent appointments booked after the first dose is administered.

Before you begin
Role required: sn_vaccine_sm.admin

Procedure
1. Navigate to Vaccine Administration Management > Administration > Properties.
   For the sn_vaccine_sm.book_subsequent_doses property:
   • If set to true, appointments are booked for all doses of the vaccine, both in mass scheduling and self-service.
   • If set to false, only the appointment for the first dose is booked and subsequent appointments are booked only after the previous dose is administered.

   2. Click Save.

Set up a privacy policy
Set up a vaccination privacy policy for users that can be modified to meet the requirements of your organization.

Before you begin
Role required: sn_vaccine_sm.admin

About this task
Vaccine Administration Management provides a vaccination privacy policy that you can modify to meet your organization's requirements.

Users must agree to the privacy policy before they can request a vaccination appointment.
Procedure

1. Navigate to Vaccine Administration > Administration > Privacy Policy.
2. Open the Privacy Policy for COVID-19 record.
3. Select the Active option.
   Only one privacy policy is active at a time.
4. In the Content field, edit the policy according to your organization’s requirements.
5. Click Update.

What to do next
If you need to update the privacy policy after users have already agreed to it, click the Prompt users to review and accept related link. Clicking this link prompts users to accept the new version of the policy.

Customize vaccination notification emails

Customize the vaccination notification emails that are sent to users about vaccination appointments. Using the customizations, you can keep users informed about activities, such as updates to vaccination booking appointments.

Vaccine Administration Management includes the following email notifications.

<table>
<thead>
<tr>
<th>Email notifications</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vaccine Appointment Confirmed</td>
<td>An email notification sent to the user as confirmation when an appointment is created.</td>
</tr>
<tr>
<td>Vaccine Appointment Reminder</td>
<td>An email reminder sent to the user before the scheduled appointment.</td>
</tr>
<tr>
<td>Vaccine Appointment Canceled</td>
<td>An email notification sent to the user when an appointment is canceled.</td>
</tr>
<tr>
<td>Vaccine Appointment Rescheduled</td>
<td>An email notification sent to the user when an appointment is rescheduled.</td>
</tr>
</tbody>
</table>

The email notifications are automatically sent to users once the appointment is created, canceled, or rescheduled. The notifications can be used without modifications. However, as a user with the sn_vaccine_sm.admin role, you can also choose to customize them for your organization. For more information about creating and editing email notifications, see Create an email notification.
Mass book vaccine appointments

Schedule appointments for multiple users at the same time instead of having users individually request appointments in the self-service portal.

Before you begin

Navigate to **Vaccine Administration Management > Administration > Properties**.

Set the following property values in the System Property [sys_property] table.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_vaccine_sm.vaccine.management.booking.max_distance</td>
<td>The maximum distance, in miles, that is searched for an available vaccination location if there is no appointment slot available at the user's preferred center. The default value is <strong>50</strong>.</td>
</tr>
<tr>
<td>sn_vaccine_sm.vaccine.management.booking.distance_unit</td>
<td>The unit of measurement for the distance considered for vaccine appointment mass booking. The options are <strong>mi</strong> and <strong>km</strong>. The default value is <strong>mi</strong>.</td>
</tr>
<tr>
<td>sn_vaccine_sm.vaccine.management.booking.max_locations</td>
<td>The maximum number of alternate locations</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>that are searched for a vaccination if there is no appointment slot available at the user's preferred location. A higher value for this property increases the time that it takes to complete mass booking. The default value is 5.</td>
</tr>
</tbody>
</table>

Role required: sn_vaccine_sm.admin and admin

About this task

Important: Mass booking does not currently support inventory-based scheduling.

Procedure

1. Create a temporary table. The table should either:
   - Extend sys_user.
   - The user field in the table should have a reference to the sys_user.

   Note: For more information about extending tables, see Create a table.

2. Import the following health history data for each user into the temporary table.
   - User
   - Preferred vaccination center
   - Age group
   - Allergies to medications, food, a vaccine component, or latex (Yes/No)
• Serious reaction or fainted or nearly fainted during or after vaccination (Yes/No)
• Seizures or history of brain or nervous system problems (Yes/No)
• Long-term health problem with heart disease, lung disease, asthma, kidney disease, metabolic disease, (for example, diabetes), anemia, or other blood disorder (Yes/No)

**Note:** This data is required to book appointments for users. If users book the appointments in the self-service portal, the users provide this information at the time of booking. When a user with the admin role mass-books appointments for users, the data must be imported instead.

For more information about importing data, see Import sets.

3. Navigate to Vaccine Administration Management > Administration > Mass Booking Configurations and click New.

4. Enter a name to describe the users included in the configuration.

5. In the Program field, select the vaccination program to book appointments for.

6. In the Table Name field, select the temporary table that you created.

7. In the following fields, select the corresponding column from the temporary table to map the user data from the temporary table to the user's appointment.
   - Health history
   - Vaccine reaction
   - Age group
   - Preferred center
   - User
   - Long term health issues
   - Allergies

8. In the Conditions field, add filter conditions to define which users to book appointments for.

9. To complete the configuration, click Submit.
   The configuration is saved but the appointments are not scheduled yet.

**What to do next**
When you're ready to schedule the appointments, return to the configuration record and click Process Booking.
Note: Whenever you process a booking, a new record gets created on the Mass Booking Jobs tab. Use this tab to view the progress of the scheduled appointments, for example, you can view the number of total appointments booked, appointments booked in a preferred center, the number of bookings failed for users, and so on.

Cancel appointments in a given date range
Cancel multiple appointment bookings at a location in a given date range.

Before you begin
Role required: sn_vaccine_sm.admin or sn_vaccine_sm.manager

Procedure
1. Navigate to Vaccine Administration Management > Administration > Centers.
2. Open the vaccination center record that you want to modify.
3. To cancel all appointments at the current location in a given date range along with subsequent doses, if any, click Cancel Appointments.
   A pop-up window appears that enables you to cancel the appointments by choosing the start date and the end date.

   Note: If the end date is empty, all appointments after the start date get canceled.

4. Click Yes.

Vaccine Administration Management system properties
Vaccine Administration Management booking uses the following system properties. Users with the admin role can access the property settings by navigating to Vaccine Administration Management > Administration > Properties.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_vaccine_sm.enable_appointment_slot_choice</td>
<td>Enable or disable appointment slot choice. When set to true, users can choose the slot. When set to false, the system books an appointment automatically. The default value is false.</td>
</tr>
</tbody>
</table>
## Vaccine Administration Management system properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_vaccine_sm.self_booking_slots_fetched</td>
<td>Set the number of slots fetched by the system to book an appointment in user self-booking. The higher value reduces any chance of failed appointments in high concurrency scenarios. The default value is 1.</td>
</tr>
<tr>
<td>➤ Note:</td>
<td>The system property only applies if the sn_vaccine_sm.enable_appointment_slot_choice value is false.</td>
</tr>
<tr>
<td>sn_vaccine_sm.vaccine.management.booking.distance_unit</td>
<td>Define the unit of measurement for the distance considered for vaccine appointment mass booking. The options are mi or km. The default value is mi.</td>
</tr>
<tr>
<td>sn_vaccine_sm.vaccine.management.booking.max_distance</td>
<td>Set the maximum distance, in miles, that is searched for an available vaccination location if there is no appointment slot available at the user's preferred center. The default value is 50.</td>
</tr>
<tr>
<td>sn_vaccine_sm.vaccine.management.booking.max_locations</td>
<td>Set the maximum number of alternate locations that are searched for a vaccination if there is no appointment slot available at the user’s preferred location. A higher value for this property increases the time that it takes to complete mass booking. The default value is 5.</td>
</tr>
<tr>
<td>sn_vaccine_sm.vaccine.management.default_program</td>
<td>Define the default program for the Vaccine Administration Management portal.</td>
</tr>
<tr>
<td>sn_vaccine_sm.book_subsequent_doses</td>
<td>Enable booking for all doses of the vaccine, for both mass booking and self-service, or enable booking for the first dose, with subsequent appointments booked after the first dose is administered. When set to true, appointments are booked for all doses of the vaccine, both in mass scheduling and self-service. When set to false, only the appointment for the first dose is booked and subsequent appointments are not booked.</td>
</tr>
</tbody>
</table>
## Vaccine Administration Management system properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>appointments are booked only after the previous dose is administered.</td>
<td>The default value is <strong>true</strong>. For more information about booking subsequent doses, see <a href="#">Book appointments for subsequent doses after a previous dose is complete</a>.</td>
</tr>
<tr>
<td>sn_vaccine_sm.enable_vam_appointment_config</td>
<td>Enable Vaccine Administration Management location-specific appointment scheduling configuration. The default value is <strong>true</strong>. For more information about enabling location-specific appointment configuration, see <a href="#">Configure advanced appointment scheduling for a center</a>.</td>
</tr>
<tr>
<td>sn_vaccine_sm.fetch_next_available_slot</td>
<td>Enable or disable fetching for the next available slot when opening the appointment booking calendar. The default value is <strong>true</strong>.</td>
</tr>
<tr>
<td>sn_vaccine_sm.strict_check_lead_max_time</td>
<td>Display the time after which the first available appointment slot is shown to the user. When set to <strong>true</strong>, slots for subsequent doses are calculated to accuracy, measured in seconds, using lead or max times. When set to <strong>false</strong>, the second slot can be booked at any time. For example, if the first dose is administered on June 1, 5:00 PM and the lead time is 21 days, the second slot can be booked after June 22, 5:00 PM. However, if the property is <strong>false</strong>, the second slot can be booked at any time on June 22. This system property affects mass booking. The default value is <strong>true</strong>.</td>
</tr>
<tr>
<td>sn_vaccine_sm.enable_self_registration</td>
<td>Enable or disable self-registration for booking appointments. When set to <strong>true</strong>, the user can register and sign up for the vaccine. When set to <strong>false</strong>, only existing users can sign up and book appointments.</td>
</tr>
</tbody>
</table>
## Vaccine Administration Management system properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>sn_vaccine_sm.show_location_filters</strong></td>
<td>Show or hide the location filters in the Schedule your vaccination page. When set to <strong>true</strong>, the list of preferred vaccination sites is filtered automatically using the personal information shared by the user. However, you can also look for other vaccination sites based on your preferred choice of state, city, or zip code. When set to <strong>false</strong>, the location filters are inactive. The default value is <strong>true</strong>.</td>
</tr>
<tr>
<td><strong>sn_vaccine_sm.mass_booking_parallelism</strong></td>
<td>Configure the number of parallel queues used to process mass booking. The allowed values are <strong>1 to 8</strong>. <strong>Note:</strong> A maximum of 8 queues can be used for mass booking. Even if a user with the admin role sets the property to a value greater than 8, only 8 queues are created. The default value is <strong>4</strong>. For more information about enabling mass booking parallel processing, see <a href="#">Manage a high number of concurrent bookings</a>.</td>
</tr>
</tbody>
</table>
### Vaccine Administration Management system properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_vaccine_sm.search_assist_accessibility</td>
<td>Minimizes the search assist section and view the search results even at 200% zoom. To expand the search assist section, click <strong>Show search assist</strong>. When set to <strong>true</strong>, clicking <strong>Search</strong> automatically minimizes the search assist section. When set to <strong>false</strong>, the system returns to its default behavior.</td>
</tr>
<tr>
<td>sn_vaccine_sm.enable_inventory_management</td>
<td>Enable scheduling based on available inventory for a program location center. The default value is <strong>false</strong>. For more information about enabling inventory management, see <a href="#">Configure inventory-based scheduling for a center</a>.</td>
</tr>
<tr>
<td>sn_vaccine_sm.im_batch_distribution_day_count</td>
<td>Distribution method to distribute a supply lot. You can distribute the inventory evenly over a specified date range. The default value is <strong>7</strong>.</td>
</tr>
<tr>
<td>sn_vaccine_sm.enable_multi_vaccine</td>
<td>Change in the order of method selection while scheduling your vaccinations. When set to <strong>true</strong>, the auto-selected method is based on the lowest method order and inventory availability. When set to <strong>false</strong>, the method with the lowest order is selected. <strong>Note:</strong> The system property only applies if the <strong>sn_vaccine_sm.enable_inventory_management</strong> value is <strong>true</strong>. The default value is <strong>false</strong>.</td>
</tr>
<tr>
<td>sn_vaccine_sm.multi_vaccine_availability_check_days_count</td>
<td>Set the number of days to check for the availability in the method selection. <strong>Note:</strong> The system property only applies if the <strong>sn_vaccine_sm.enable_multi_vaccine</strong> value is <strong>true</strong>. The default value is <strong>7</strong>.</td>
</tr>
</tbody>
</table>
Vaccine Administration Management system properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_vaccine_sm.allow_user_selection_of_vaccine_method</td>
<td>When set to true, users can choose the method while scheduling and rescheduling their appointments. When set to false, the system auto-selects the method based on the configuration of the sn_vaccine_sm.enable_multi_vaccine system property. The default value is false.</td>
</tr>
</tbody>
</table>

Turn off automatic email notifications for mass booking

Turn off automatic email notifications by first turning off the default notification for the appointment configuration, then turn off the corresponding business rule. By default, email notifications are automatically sent to users when the appointments are scheduled as part of mass booking.

Before you begin
Role required: sn_vaccine_sm.admin or admin

About this task
Emails are auto-generated and shared when users request a vaccination through the self-service portal. Vaccine Administration Management provides an appointment configuration that you can modify to stop emails from being sent for mass scheduling vaccine appointments.

As a user with the admin role, you can configure and modify the business rules to meet your organization’s requirements.

Procedure
To turn off the default notification for the appointment configuration.

a. Navigate to Vaccine Administration Management > Administration > Appointment Configurations.

b. Open the Schedule Vaccine Appointment record.

c. Select the Ignore Default Notifications option.

d. Click Update.
You cannot disable email notifications for mass booking alone. If you disable the email notification events for mass booking, it applies to the self-service booking as well.

To turn off email notifications during mass booking.

a. Navigate to System Notification > Email > Notifications.
b. Open the Vaccine Appointment Confirmed record.
c. In the Active field, select False.
d. Click Update.

Configure an appointment reminder and pre-appointment questionnaire

By default, appointment reminders are not sent to the user. To enable appointment reminders, you must configure the appointment reminder in the appointment configuration record. You can also configure the pre-appointment questionnaire for users.

Before you begin
Role required: admin

About this task
The appointment reminder sends a reminder email and a pre-appointment questionnaire to the user at a specified time.

Procedure
1. To configure the appointment reminder.
   a. Navigate to Vaccine Administration Management > Administration > Appointment Configurations.
   b. Open the Schedule Vaccine Appointment record.
   c. In the Appointment reminder field, select the reminder time.

   Note: If the field doesn't appear on the form, a user with the admin role must configure the form layout to include it. In the form header, click the form context menu icon (≡). Navigate to Configure > Form Layout and move the Appointment reminder field to the Selected list, then click Save.
By default, appointment reminders are not sent to the user. If you want the user to receive the email reminder, configuration of both the appointment reminder and the pre-appointment questionnaire is required.

d. Click Update.

2. Configure the pre-appointment questionnaire.

a. Navigate to Vaccine Administration Management > Administration > Pre-appointment Questionnaire.
   The Pre-appointment Questionnaire record producer is displayed.

b. In the Variable Sets related list, open the Pre-vaccination screening record. The Pre-vaccination screening variable set is displayed.

c. In the Variables related list, create or update variables for the questionnaire. For details on how to configure a variable, see Service catalog variables.

   **Important:** Do not configure the task_id and is_portal variables.

   ![Variable set screenshot]

   d. Click Update.

**Virtual Agent conversations with Vaccine Administration Management**

Virtual Agent conversations enable users to get help with vaccination.

Vaccine Administration Management provides Virtual Agent conversation topics if the Virtual Agent plugin (com.glide.cs.chatbot) is installed. A conversation topic defines the dialog between the Virtual Agent (chatbot) and the user to accomplish a specific goal.
## Conversation topics

<table>
<thead>
<tr>
<th>Conversation</th>
<th>Description</th>
<th>Default status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Book Appointment</td>
<td>Enables users to book vaccination appointments through the chatbot.</td>
<td>Active</td>
</tr>
<tr>
<td></td>
<td>The questions asked in this topic are the default questions that a user must answer when booking an appointment in the self-service portal.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>✉️ <strong>Note:</strong> This topic is a placeholder conversation topic. You can change the questions according to your requirements.</td>
<td></td>
</tr>
<tr>
<td>My Vaccination Phase Eligibility</td>
<td>Informs users about vaccination eligibility and enables users to book an appointment if the user is eligible.</td>
<td>Active</td>
</tr>
<tr>
<td></td>
<td>✉️ <strong>Note:</strong> This topic is a placeholder conversation topic. You can change the questions according to your requirements.</td>
<td></td>
</tr>
<tr>
<td>COVID-19 Vaccine resources</td>
<td>Shows targeted knowledge articles to the user.</td>
<td>Inactive</td>
</tr>
<tr>
<td></td>
<td>✉️ <strong>Note:</strong> To use this topic, you must activate the ServiceNow® Service Management Topic Blocks plugin (com.glideapp.cs.sm_topic_blocks).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The articles shown in this topic are set by a keyword. By default, the topic shows all articles that contain the keyword “vaccine.” To change the keyword, navigate to this topic in the ServiceNow® Virtual Agent Designer. In the topic, click the Contextual Search block. In the Topic Block Properties panel, set the value of the query field to the new keyword.</td>
<td></td>
</tr>
</tbody>
</table>

To activate, deactivate, or edit conversation topics, navigate to Collaboration > Virtual Agent > Designer. In the Topics page, select the Vaccine Management category. Click a topic that you want to update. Use the Active toggle button to activate or deactivate a topic.

### Retry booking for skipped appointment records

Book vaccination requests for skipped appointment records for users whose appointments were unsuccessful or skipped due to missing data.

© 2021 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.

Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Procedure

1. Navigate to Vaccine Administration > Administration > Mass Booking Configurations.
2. Locate and open the mass booking configuration record based on your requirement.
   Requests and appointments that have been created appear on the Vaccination Requests tab.
3. Correct the data and click Retry Booking.
   The Retry Booking option will only run for the users that you selected initially. If you want to make another selection, create a new configuration.

Results

All requests and appointments that have been created appear on the Vaccination Requests tab.

Encrypt search fields to appear in search assist

Encrypt search fields to search from a field other than the first name, last name, and phone fields. By encrypting search fields, you can configure them to appear in search assist.

Before you begin

Role required: security_admin

About this task

You can encrypt fields such as the street, city, state, and zip code based on your organization's requirement. Decrypted fields are kept hidden from the search assist. By default, the first name, last name, and phone fields are visible to users.

Procedure

1. Navigate to System Security > Field Encryption > Encrypted Field Configurations.
2. In the Search field, enter sn_vaccine_sm_personal_info.
   In the Encrypted Field Configurations table, you can see multiple sn_vaccine_sm_personal_info fields.
3. Right-click the Active column and select Group By Active.
4. In the Active field, select False.
5. Click Update.
6. To encrypt or decrypt fields, repeat steps 3 through step 5, as needed.
Manage a high number of concurrent bookings

Manage multiple parallel queues to help process mass booking appointments run in a parallel mode. You can distribute the mass booking event processors to different nodes rather than keeping the load on a single node.

Before you begin
Role required: sn_vaccine_sm.admin

About this task
The `sn_vaccine_sm.mass_booking_parallelism` property helps you implement the appointment booking flow in a parallel mode. With parallel processing, the job creates separate events for each vaccination center. It helps dispatch the events into the available parallel queues evenly. There are a total of eight mass booking event processors.

Note: A maximum of eight queues can be used for mass booking. Even if a user with the admin role sets the property to a value greater than 8, only eight queues are created. However, the default value is set to 4.

To avoid performance-related issues, configuration changes are required to pin to a specific node. As a user with the admin role, you can choose which thread to point to a specific node so that the load is distributed evenly across all the nodes. For example, if you are using a multi-node instance, you can change the configuration to pin to a specific node by using the system ID field to select the specific node where you want your mass booking event processor to hit. This configuration change can improve the system performance.

Procedure
1. In the navigation filter, enter `sys_trigger.list`.
2. In the Search field, enter `*mass booking event processor`.
   In the Schedule table, you can see eight mass booking event processor records.
3. Optional: If you have a multi-node instance, locate the mass booking event processor record and choose a node from the System ID column field.
4. Double-click the empty area of the System ID field.
   a. Choose a node from the list of available nodes.
   b. Save the record by clicking the green checkmark icon (✓).
      The mass booking event processor record is assigned to a specific node.
5. To assign different mass booking event processor records to specific nodes, repeat step 3 and step 4, as needed.
Manage processing for a high number of concurrent vaccine events

Manage multiple parallel queues to help process vaccine events run in a parallel mode. You can distribute the vaccine queue events process to different nodes rather than keeping the load on a single node.

**Before you begin**
Role required: sn_vaccine_sm.admin

**About this task**
You can implement the vaccine queue events process flow in a parallel mode. With parallel processing, the job creates separate events for each vaccine queue. This processing helps distribute the events to all active nodes instead of being processed in a single node.

**Procedure**
1. In the navigation filter, enter `sys_trigger.list`.
2. In the **Search** field, enter `vaccine_queue_events_process`.
3. Select the vaccine queue events process record.
4. Set the **System ID** field to **Active Nodes**.
5. Click **Update**.
   - This configuration creates multiple `sys_trigger` records for each node.

Configure the questionnaire text for the user and clinician portals

Configure the questionnaire text that is displayed in the user and clinician portals for Vaccine Administration Management.

**Before you begin**
Role required: admin

**Procedure**
1. Navigate to **Catalog > Catalog Definitions > Maintain Catalogs**.
2. Open the Vaccination Catalog record.
3. From the Catalog Items related list, update the questionnaire text by updating the corresponding variables from the following catalog items.

   **Note:** The questionnaire text is distributed across the following catalog items and variables.
### Vaccination Catalog

<table>
<thead>
<tr>
<th>Catalog item</th>
<th>Variable set</th>
<th>Variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pre-appointment questionnaire</td>
<td>Pre-vaccination screening</td>
<td>recently_sick</td>
</tr>
<tr>
<td></td>
<td></td>
<td>recent_vaccination</td>
</tr>
<tr>
<td></td>
<td></td>
<td>pregnant</td>
</tr>
<tr>
<td>Schedule your vaccination</td>
<td>Disclose any conditions</td>
<td>long_term_health_issues</td>
</tr>
<tr>
<td></td>
<td></td>
<td>long_term_health_history</td>
</tr>
<tr>
<td></td>
<td></td>
<td>any_reaction</td>
</tr>
<tr>
<td>Enter your personal info</td>
<td>Your demographic info</td>
<td>age_group</td>
</tr>
</tbody>
</table>

For details on how to configure a variable, see [Service Catalog variables](#).

**Important:**

- Updating the questionnaire text updates that text in both the user and clinician portals.
- If you deactivate a variable, then the question will be hidden in both the user and clinician portals.
- If you're creating a question, the new question is not displayed in the clinician portal by default. You must also update the pre-vaccine_questionnaire widget by navigating to Service Portal > Widgets. For details on how to configure a widget, see Service Portal widgets.

4. Click **Update**.

### Using Vaccine Administration Management

Learn how users, clinicians, and provider admins use Vaccine Administration Management.

### Vaccine portal experience

As a user, you can register for a vaccination program, provide your personal information, schedule and manage your vaccination appointments, provide health updates, and more, all from within a single, self-service portal.
On the landing page, you can configure the articles that are displayed in the announcements and frequently asked questions widgets. Navigate to **Vaccine Administration Management > Administration > VAM Knowledge Base**. In the Featured Content related list, create or update the articles. For announcements, make sure that the keyword is set to announcement. For frequently asked questions, make sure that the keyword is set to homepage.

**Note:** The vaccine portal is optimized for both tablet and mobile.

If you are on version 2 of Vaccine Administration Management, the vaccine portal is based on the Consumer Service Portal, and is marked public by default. You can make the registration and landing page non-public. For configuration details, see [Use the Consumer Service Portal and Service Portal security](#).

**Note:** If users are unable to self-register on the portal, see [Self-registration is not allowed from VAM (Vaccine Administration Management) portal](#) [KB0955268](#) for further details.

If users self-register through the Vaccine Administration Management portal, the records are created under consumer users. To register the internal users, organizations must upload their user records. Users can later reset passwords and schedule appointments using the Vaccine Administration Management portal.
Register for a vaccination program

Register for a vaccination program. On the landing page, click **Register now** and then provide your information on the registration form. After you submit your information, a verification link with instructions for the next step is emailed to you.
Provide your personal information

Once registered, you can provide your personal information to help organizations determine when you’re eligible for appointment scheduling.

**Note:** You can configure what user information is collected by updating the Enter your personal info record producer. For details on how to configure a record producer, see Record Producer. You can configure user eligibility for vaccination program appointment scheduling. For details, see Configure the eligibility criteria for a vaccination program.

If you have taken your first dose of the vaccine outside of the Vaccine Administration Management application, indicate the vaccination method and the date of receiving your first dose.
Schedule and manage your vaccinations

If you are eligible, schedule your vaccination appointments. You can choose your preferred vaccination method. However, the availability depends on the order of method selection as well as the inventory availability.

>Note: To choose from your preferred vaccination method while scheduling or rescheduling your appointments, the `sn_vaccine_sm.allow_user_selection_of_vaccine_method` system property value must be set to `true`. For details on how to configure multi-vaccine appointment bookings, see Multi-vaccine appointment bookings configuration.

You can either choose the same vaccination site for both the doses, or you can choose a different vaccination site for each dose. After you schedule your appointments, an appointment confirmation with a QR code is emailed to you.

>Note: You can configure location-specific and inventory-based appointment scheduling. For details, see:

- Configure advanced appointment scheduling for a center.
- Configure inventory-based scheduling for a center.

You can configure the scheduling by updating the Schedule vaccine appointment record producer. For details on how to configure a record producer, see Record Producer.
View all of your upcoming appointments in the portal.

⚠️ Note: You can configure an appointment reminder and pre-appointment questionnaire. For details, see Configure an appointment reminder and pre-appointment questionnaire.
View the details of an individual appointment.

You can also:

- Reschedule an appointment

  **Note:** If your first appointment has been completed, you cannot change the method. However, you have the flexibility to change the method while rescheduling your first dose. If you change the method while rescheduling your appointment, it automatically applies to the second dose as well.

- Choose different locations for both appointments

- Cancel an appointment

  **Note:** If you cancel an appointment, all of your open appointments for that vaccination program are canceled. For example, if you cancel the second appointment out of a three-dose vaccination program, then both the second and third appointment are canceled.
Provide any updates on your health

Organizations have the option to send an appointment reminder and pre-appointment questionnaire to you at a specified time before their vaccination appointment. This configuration is an optional configuration. To configure the appointment reminder and pre-appointment questionnaire, see Configure an appointment reminder and pre-appointment questionnaire.

Clinician portal experience

Clinicians can find vaccination appointments for users, view all of their upcoming appointments for a particular location, view, and work on a vaccination record, mark an appointment as a no-show, cancel an appointment, and more, all from within a single portal.
 Clinician portal

Manage your appointments

Select a location to get started.
Berger Drive Auditorium

Note: The clinician portal is optimized for both tablet and mobile. However, the mobile view does not currently support the selection of more than one appointment at a time for bulk updates.
Clinicians can find vaccination appointments by scanning the user’s QR code, entering the code manually, or looking up the appointment in the portal.

Clinicians can view the appointments for a particular location from the list. To view all upcoming appointments, click **See all appointments**. Upcoming appointments include all appointments for that day at the selected location, as well as appointments from the previous hour. For example, if the clinician views the upcoming appointments at 9:00 AM, they see all the assigned appointments from 8:00 AM through the end of the day.

**Note:** Once the clinician selects a location, it remains selected throughout the session.
View and search appointments

From the list view, clinicians can view all appointments for a particular location, search for users by name, and filter for appointments. By default, the dates for appointment filters are set for a week's time.

⚠️ Note: Using the search by name filter, clinicians can view only the appointments booked for the registered users. However, the clinician can still scan the QR code of an internal user and can administer the vaccine.
View and work on an appointment

Clinicians can view and work on an appointment record, including:

- Verify the user’s ID
- Verify the user’s details
- Fill in screening questions
- Provide comments and work notes
- Verify that the user has verbally consented to the vaccine
- Verify that the user was provided with information about the vaccine

The clinician can also:

- Assign an appointment to oneself
- Mark an appointment as a no-show
- Cancel an appointment
- Mark an appointment as complete

Vaccine Administration Management dashboard

Use the Vaccine Administration Management dashboard to view vaccine appointments by day, week, and month. You can view scheduled, completed, and no-show appointments, as well as filter appointments by the vaccine center, date, method, and clinician.
Required Now Platform roles

- The `sn_vaccine_sm.report_manager` role is required to view and edit the dashboard and reports.
- The `sn_vaccine_sm.report_viewer` role is required to view the dashboard and reports.

Access the Vaccine Administration Management dashboard

To open the dashboard, navigate to **Vaccine Administration Management > Dashboard**.

Use cases

For examples of how different people in your organization would use this dashboard, see these use cases.

<table>
<thead>
<tr>
<th>User</th>
<th>Dashboard use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vaccine Administration Management dashboard manager</td>
<td>Can view and edit the Vaccine Administration Management dashboard.</td>
</tr>
</tbody>
</table>
User | Dashboard use
--- | ---
Vaccine Administration Management dashboard viewer | Can view the Vaccine Administration Management dashboard.

### Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Source table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scheduled Appointments</td>
<td>Single Score</td>
<td>Vaccination Task [sn_vaccine_sm_task]</td>
<td>Number of scheduled appointments.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="42" /></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Completed Appointments</td>
<td>Single Score</td>
<td>Vaccination Task [sn_vaccine_sm_task]</td>
<td>Number of completed appointments.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="42" /></td>
<td></td>
<td></td>
</tr>
<tr>
<td>No-Show Appointments</td>
<td>Single Score</td>
<td>Vaccination Task [sn_vaccine_sm_task]</td>
<td>Number of users who fail to turn up to the scheduled appointments.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="42" /></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Appointments Trending</td>
<td>Column</td>
<td>Vaccination Task [sn_vaccine_sm_task]</td>
<td>Segregation of number of scheduled, completed, and no-show appointments.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="30 31 1 2" /></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Filters

<table>
<thead>
<tr>
<th>Name</th>
<th>Filter type</th>
<th>UI control type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vaccine Center</td>
<td>Reference</td>
<td>Select Multiple Input</td>
<td>Filter the report results based on the selected vaccine center.</td>
</tr>
<tr>
<td>Name</td>
<td>Filter type</td>
<td>UI control type</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Date</td>
<td>Date</td>
<td>Select Single Input</td>
<td>Filter the report results based on the selected date.</td>
</tr>
<tr>
<td>Method</td>
<td>Reference</td>
<td>Select Multiple Input</td>
<td>Filter the report results based on the selected vaccine method.</td>
</tr>
<tr>
<td>Clinician</td>
<td>Reference</td>
<td>Select Multiple Input</td>
<td>Filter the report results based on the selected clinician.</td>
</tr>
</tbody>
</table>

**Manage user appointments as a clinician or a customer service agent**

Manage user appointments as a clinician or as a customer service agent for creating consumer users, booking vaccination appointments, and choosing a desired slot. To better manage user appointments, some additional configurations are performed for the customer service agent.

**Search user records**

Search for a user record to check if the user record exists, before creating consumer users.

**Before you begin**

Role required: sn_vaccine_sm.clinician

**Procedure**

1. Navigate to **Vaccine Administration Management > Agent > Search Assist**.
2. Select **Consumer**.
3. Search for the consumer record using the search options provided such as first name, last name, and phone, and click **Search**.
   If the user record exists, you can find the user record under Personal information.

**Note:** Records of internal users who have provided personal information through the Vaccine Administration Management portal will be included in the search results. However, a clinician or a customer service agent will not be able to book appointments on behalf of the internal users.
Create consumer users
Clinicians and customer service agents can create consumer records using the Vaccine Administration Management application.

Before you begin
Note: A clinician or a customer service agent cannot create internal users and then book appointments on behalf of the users.

Role required: sn_vaccine_sm.clinician

Procedure
1. Navigate to Vaccine Administration Management > Agent > Search Assist.
2. Click Create User.
3. Provide the user's personal information to help organizations determine the eligibility for appointment scheduling.
   If the user has taken the first dose of the vaccine outside of the Vaccine Administration Management application, indicate the vaccination method and the date that the user received the first dose of the vaccine.
4. Click Submit.
   A new information record for the consumer user is created. The vaccination can be scheduled on behalf of the user.

Search existing appointments
Search for an existing appointment on behalf of the consumer user.

Before you begin
Role required: sn_vaccine_sm.clinician

Procedure
1. Navigate to Vaccine Administration Management > Agent > Search Assist.
2. Select Appointment.
3. Search for the vaccination appointments using the appointment code or contact.
4. Click Search.
If the vaccination record exists, you can find it under Vaccination Tasks.

**Note:** As a clinician or as a customer service agent, you can search for an existing appointment using the contact filter only for consumer users and not for internal users. If you want to search for an existing appointment for an internal user, you must navigate to Vaccination Tasks and filter the list by the user name.

**Schedule an appointment**

Schedule vaccination appointments on behalf of the consumer user.

**Before you begin**

**Note:** A clinician or a customer service agent cannot create an appointment on behalf of internal users.

Role required: sn_vaccine_sm.clinician

**Procedure**

1. Navigate to **Vaccine Administration Management > Agent > Search Assist**.
2. Select **Consumer**.
3. Search for the new consumer user record using the search options provided such as first name, last name, and phone, and click **Search**.
   
   You can find the new information record under Personal information.
4. Select the record to book an appointment.
5. From the consumer user record, select **Book Vaccine Appointment**.
   
   The **Book Vaccine Appointment** button is not visible for the internal user.
6. Schedule the vaccination appointments by choosing your preferred method and site for vaccination. You can either choose the same vaccination site for both doses, or you can choose a different vaccination site for each dose.
   
   To choose from your preferred vaccination method while scheduling or rescheduling your appointments, the **sn_vaccine_sm.allow_user_selection_of_vaccine_method** system property value must be set to **true**. For details on how to configure multi-vaccine appointment bookings, see **Multi-vaccine appointment bookings configuration**.
7. Fill in the required details, and click **Submit**.
   
   The vaccination appointment is scheduled for the user and separate emails for both vaccination appointments are shared with the user.
8. Click **Close**.
   
   In the Appointment related list, two separate vaccination tasks are created.
Cancel existing appointments

Cancel existing appointments on behalf of the consumer user.

**Before you begin**
Role required: sn_vaccine_sm.clinician

**Procedure**
1. Navigate to Vaccine Administration Management > Agent > Search Assist.
2. Select Appointment.
3. Search for the vaccination appointments using the appointment code or contact, and click Search.
   You can find the vaccination records under Vaccination Tasks.
4. Select the user record that you want to cancel, and click Cancel Appointment.

**What to do next**
Reschedule existing appointments.

Reschedule existing appointments

Reschedule existing appointments and choose the preferred method, date, time slot, or vaccination center.

**Before you begin**
Role required: sn_vaccine_sm.clinician

**Procedure**
1. Navigate to Vaccine Administration Management > Agent > Search Assist.
2. Select Appointment.
3. Search for the vaccination appointments using the appointment code or contact, and click Search.
   You can find the vaccination records under Vaccination Tasks.
4. Select the user record that you want to reschedule, and click Reschedule Appointment.
5. In the Reschedule Appointment pop-up window, select a vaccination center, date, and appointment time slot, and click Submit.
   The Reschedule Appointment pop-up window displays the confirmation of the scheduled appointment.
What to do next
As a user with the sn_vaccine_sm.clinician role, you can also perform the following actions on behalf of the users.

• Delete
• Update
• Mark as complete
• Mark as no-show

Domain separation and Vaccine Administration Management
Domain separation is unsupported for Vaccine Administration Management. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

Support level: No support
• The domain field may exist on data tables but there is no business logic to manage the data.
• This level is not considered domain-separated.

For more information on support levels, see Application support for domain separation.

Workforce Optimization for Customer Service
Manage and maintain the productivity of your workforce from a single application using Workforce Optimization for Customer Service. With this application, you can efficiently route work to your team, manage your team’s skills and schedules, and monitor their performance.

Workforce Optimization for Customer Service enables you to do these tasks:
• Assess real-time operations and performance of teams and agents across different channels and queues.
• Keep track of ongoing work and provide real-time help to team members for better customer experience.
• Helps organizations ensure that their managers only see the data and views of relevant teams
• Monitor and measure team performance and provide feedback using assessments.
• Predict and recommend skills for agents.
• Identify opportunities to coach and train your teams.

**Workforce Optimization for Customer Service in action**

Watch this short video to see how managers use Workforce Optimization for Customer Service. Workforce Optimization for Customer Service

**Key Features**

**Managing work using channels and queues**

Manage pending work items from customers, daily work routine of agents, and balance work load between agents adhering to promised SLAs. Automatically route and assign work items to agents based on availability, capacity, and skills. Monitor the health of your queues reviewing real-time performance and jump in to help with escalations.

**Automating employee coaching and training**

Assess your team's performance and set coaching plans to improve their skills.

**Integrated application data**

Drive workforce optimization effectively by managing schedules, shifts, and queues for your teams. You can assess skills, automate agent recommendations based on those skills, and provide mentoring opportunities for employees.

**Get started**

<table>
<thead>
<tr>
<th>Explore</th>
<th>Configure</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Learn about how managers use Workforce Optimization for Customer Service.</td>
<td>Plan and configure your implementation.</td>
<td>Schedule, coach and train your agents to work on customer cases.</td>
</tr>
</tbody>
</table>
Exploring Workforce Optimization for Customer Service

Use Workforce Optimization for Customer Service to optimize your workforce and manage your teams efficiently.

Manage and monitor the real-time work being done by your agents across different channels and queues. Provide timely help to your team members to solve cases faster and help with complex customer issues. Coach your teams so that they gain the skills that let you address the demands from your customers. Efficiently schedule your teams to provide better coverage with integrated channel management.

As a manager, you can monitor the demand for agents and skills in your organization to resolve issues. Assess agent skills, identify areas where they need improvement and provide training to enhance their skills set. Track your teams performance, and manage the schedule of all agents in your assignment group—all from a unified location.

As an agent, you can manage your own schedule, access the schedule of your peers and request time off or shift swaps.

Get an overview of how you can set up Workforce Optimization for Customer Service in this video. Workforce Optimization for Customer Service

Manager workspace landing page

The landing page provides a real-time overview of the current workload and the team performance. View real-time data of the reports for cases that are currently assigned to their team such as:

- Metrics Cases Resolved, Need Attention, Escalated, and SLA Breached of your assignment groups.
- On-going work with numbers displaying total open cases, cases closed this week, and chats completed this week.
- Agent distribution, waiting work items, and available agents.
- Chats that are in-progress and work items that needs help.

For more information, see Manager Workspace Landing Page.

Channel management

Monitor your teams in real time and jump in their chat conversations to help when there is a need.

Using Channels, you can also:
• Review the real-time performance of your teams across various channels and queues.
• Review pending work items and manually allocate some of the work items to available agents.
• Monitor actual work being performed by your team members.
• Monitor the status of the queues.
• Track real-time presence and capacity utilization of in your team members (or agents in your team)

For more information, see Channel Management in Workforce Optimization for Customer Service.

Scheduling
Access your teams' calendar to know which agents are scheduled for coverage and which agents have taken time off.

Using Scheduling, you can also:
• Assign agents to shifts.
• Define break time.
• Preview and publish team schedule.
• Approve agent time-off or shift-swap requests.
• Create on-call shifts and assign primary, secondary rotation groups to handle escalation scenarios.

For more information, see Scheduling in Workforce Optimization for Customer Service.

Schedule Adherence
Access your teams' calendar to know which agents adhered to their planned schedules and make timely decisions to increase your team's performance by setting expected adherence targets.

Using Schedule Adherence, you can also:
• Configure and tweak the schedule adherence and conformance formulas and properties so that you can customize them for your organization.
• Access the schedule of all of your teams from one location and gain insights on whether your team is complying with published schedules.
• Analyze the historical time attendance of your team members.
• View planned versus actual historical data for your team and individual agents.

For more information, see Schedule Adherence in Workforce Optimization for Customer Service.

Demand Forecasting
Forecast the demand for teams and predict resources based on historical data. Using Demand Forecasting, you can also:
• Setup demand forecast configurations that creates metrics to forecast the number of agents you need for interactions and resolve cases throughout a given day.
• Analyze staff alignment and view the predicted demand on the team calendar.

For more information, see Demand Forecast in Workforce Optimization for Customer Service.

Teams
Monitor performance trends for your teams using KPI groups. Create a set of KPIs and apply them to all groups within a team and assess team performance from one location.

Using Teams, you can also:
• Identify all the teams you manage as well as the ones you have visibility into.
• Analyze the KPIs that are crucial for your team.
• Drill into agents within each team and monitor their performance.
• Access each agent’s profile to view details such as their manager, peers, and assignment groups.
• Drill down into each agent’s skills or recommend them for coaching.

For more information, see Teams in Workforce Optimization for Customer Service.

Coaching and Skills Assessment
Enhance the quality of work done by your agents using Coaching. Assess agent skills and recommend the ones that they require to resolve issues. Identify
coaching opportunities based on the recommendation and train the agents to acquire those skills.

Using Coaching, you can also:

- Automate the scoring, grading, and assessment of agent skills.
- Use coaching opportunities to create assessments.
- Track training assigned to agents based on their assessments.
- Analyze the skill gap and recommend training.

For more information, see Coaching in Workforce Optimization for Customer Service

**Manager Workspace landing page**

The Manager Workspace landing page displays metrics of the on-going work and helps managers to take informed decisions.

The landing page provides the real-time data of the current workload and the team performance such as:

- Important reports for cases that are currently assigned to their team.
- Chats that are currently in progress
- Work Assignment that gives instant visibility into the distribution of agents across presence statuses, work items waiting in queues, and number of agents available.
- Statistics on team performance, such as total open Cases, Cases Closed and Chats Completed.

Get an overview of the Manager Workspace landing page and also learn on how to configure it using UI Builder as per your business needs.

Workforce Optimization for Customer Service Manager workspace landing page

**Related information**

- Create a Manager Workspace landing page
- Workforce Optimization for Customer Service manager workspace landing page
Channel Management in Workforce Optimization for Customer Service

Learn how you can use channel management capabilities to monitor important metrics across different channels and queues.

Monitor the real-time health of your channels and queues by reviewing waiting customers, available agents, the work being done by your team members (or agents in your teams) and collaborate with them to solve complex issues faster.

The following channel management snapshots provide you with a quick overview of the real-time performance monitoring and drill-down capabilities.

As a channel management user, you can:

• Track real-time performance of your teams using key performance indicator reports in service channels and queues.

• Review real-time performance as the team is actively working on tasks across channels and queues.
• Drill down on work items and jump in to provide timely help to team members via chat whisper or by adding work notes to a task.
• View agents’ availability and their workload.
• Monitor pending work items in the queue and act when required.
• Assign work items manually to agents.

As a channel management administrator, you can:
• Create service channels and queues.
• Associate assignment rules to queues.
• Configure KPIs for service channels and queues.
• Configure the supervisor lists.

Related information
Setting up service channels and queues
Using Channel Management in Workforce Optimization for Customer Service

Example: Channel management using Workforce Optimization for Customer Service

Understand how you can monitor important metrics (or key process indicators) across different channels and queues. Manage the work being done by your team members (or agents in your teams) and collaborate with them to solve complex issues for your end-customers.

Amy Jones manages Customer Service operations for a large organization and has 12 teams reporting to her. Each of her teams has anywhere from 8 through 15 agents. She must ensure that incoming work gets effectively routed to the right groups across all channels. This can be done by setting up Advanced Work Assignment as per the business requirement.

Once Amy has configured Advanced Work Assignment (AWA) appropriately, she can add key performance indicators (KPIs) to the channels and queues, and monitor the operational performance of her teams in real time.

Amy can then keep a track of her teams’ ongoing work, assign pending work items manually to agents, and join chat conversations to assist agents.

Get an overview on how you can monitor teams by looking at the real-time data in service channels and queues.

Workforce Optimization for Customer Service Monitor Team Work
Get an overview on how you can manually assign work items, monitor ongoing cases, and join the chat conversations.
Workforce Optimization for Customer Service Manage Work Items

Get an overview on how administrators can add service channels, queues, and configure KPIs.

Workforce Optimization for Customer Service Set up Service Channels and Queues

**Scheduling in Workforce Optimization for Customer Service**

Learn how you can plan shifts that include break time for your agents to effectively manage their schedule in Workforce Optimization for Customer Service. Publish schedules for the next scheduling period to get a snapshot of which agent is lined up to solve issues for that time period.

Manage the scheduling for your organization from a central location.
Scheduling

Ensure that you have the coverage you need and dedicated agents to resolve issues as they arise.

Scheduler

sn_shift_planning.admin

Agent

sn_shift_planning.agent

Plan

Create shift plans that automatically stagger breaks to maximize coverage.

Schedule

Assign agents to shifts and publish a schedule for the next scheduling period.

Request time-off

Send a request for the time period you want to take off.

Swap shifts

Trade shifts with your peers.
As a manager, you can:

• Create shifts to ensure customer coverage for the required span of time.
• Add breaks to the shifts that automatically stagger agent availability for those shifts.
• Preview the schedule and make necessary changes before publishing it to your agents.
• Access the schedule of all of your teams from one location.
• Modify the planned schedules when your team members inform you about their changed availability.
• Manage the schedules of team members working across different time zones.
• Monitor schedule adherence of your agents looking at the time worked summary and time attendance.
• Filter the members based on location, skills and assignment groups.
• Adjust the planned schedules and manage approvals through mobile application.
• Create on-call shifts and assign primary, secondary rotation groups to handle escalation scenarios.

As an agent, you can:

• Look up your schedule and request time off when required.
• Swap your shift with one of your peers.
• View your calendar and your team’s calendar across the weeks to plan your work.

Related information

Setting up Scheduling in Workforce Optimization for Customer Service
Scheduling in Workforce Optimization for Customer Service

Example: Scheduling using Workforce Optimization for Customer Service

Understand how you can set up and publish agent schedules and how your agents can manage their own schedule based on an example.

Amy Jones manages Customer Service operations for a large organization and has 12 teams reporting to her. Each of her teams has anywhere from 8 through 15 agents. At any given point, she needs visibility into her teams’ schedule. She must also be able to create shifts, and approve or reject shift-swap or time-off requests from her agents.
As a manager, Amy Jones can manage her entire team's schedule using **Scheduling**. Amy’s team members can manage their own schedule effectively by requesting shift-swaps or time off.

Amy Jones and managers in her team can manage schedules by performing the following steps from one central location:

1. Create shift plan.
2. Create a schedule plan.
3. Assign agents to work shifts.
4. Publish the schedule.
5. Approve teams' requests.

Agents make requests to change the schedule or take time off. For more information, refer to CSM Agent Workspace - Scheduling.

Get an overview of how to you can create shift plans and assign agents to the shifts using the schedule plan in this video.

**Workforce Optimization for Customer Service Create Shift Plans**

Get an overview of how you can monitor shifts and schedule for your entire team from a single location in this video.

**Workforce Optimization for Customer Service Monitor Team Schedule**

Get an overview of how agents use the workspace to manage their schedule.

**Workforce Optimization for Customer Service Agent Schedule**

For detailed information on creating and managing schedules using Workforce Optimization for Customer Service, refer to **Scheduling in Workforce Optimization for Customer Service**.

**Schedule Adherence in Workforce Optimization for Customer Service**

You can use schedule adherence to monitor whether your team members are adhering and conforming to the schedules and to improve the operational efficiency of your organization.

Schedule adherence helps your organization to do the following actions:
• Measure whether the effort spent on demand forecasting and scheduling team members is used in an optimal manner.

• Plan for more effective staffing needs in the future based on your insights into the historical use of agent resources.

• Discover coaching opportunities for your agents when there are gaps in their adherence. For more information, see Coaching in Workforce Optimization for Customer Service.

As a manager, you can do the following actions:

• Access the schedule of all of your teams from one location and gain insights on whether your team is complying with published schedules.

• Increase your team’s performance by setting expected adherence targets.

• View the time attendance of your agents by looking at such details as clock-in and clock-out times.

• Analyze the historical time attendance of your team members.

• View planned versus actual historical data for your team and individual agents.

• Modify the clock-in and clock-out times of your agents.

As an administrator, you can set the threshold percentages and change the formulas for calculating schedule adherence and conformance.

As an agent, you can clock-in and clock-out your work shift.

Schedule Adherence for Customer Service in action

Watch this short video to understand how managers and agents use Schedule Adherence in Workforce Optimization for Customer Service.

Schedule Adherence for Customer Service

Consider the following steps to determine the schedule adherence and conformance:

1. The administrator sets the Agent Time Work Event Trigger business rule as active to record the clock-in and clock-out times of customer service agents.

2. An agent works for the Customer Service operations team and reports to a manager. Let’s assume this scenario is a typical work day:

   a. The agent logs in to CSM Agent Workspace.

   b. The agent changes the presence status to Available and starts work. The clock-in event gets generated.
c. The agent changes the presence status to **Break** and goes for lunch. The clock-out event gets generated.

d. When the agent comes back from lunch and answers a phone call, the presence state becomes **Busy** and the clock-in event gets generated.

e. The agent then logs out from CSM Agent Workspace or changes the presence status to **Offline**. The clock-out event gets generated.

f. At the end-of-the-day, the agent's time worked summary is generated with key performance indicators (KPIs), such as Start Time, End Time, Planned Work, Time Not Worked, Available Non Planned Time, Time Worked, and Adherence%, Conformance %.

3. The agent's manager logs in to Manager Workspace to view the agent's time worked in the **Team Calendar**. The manager can also view the agent's actual time worked and working pattern for all historical days. If required, the manager can coach the agent to a desired performance that fits in with the team culture.

**Related information**

- Configure properties for schedule adherence and conformance
- Modify schedule adherence and conformance formulas by using extension points
- Monitor schedule adherence of your agents
- Analyze adherence and conformance from the time worked summary

**Demand Forecast in Workforce Optimization for Customer Service**

Learn how you can use Demand Forecast to predict resources based on historical data.

Here's an overview of the Demand Forecast application. Demand Forecast for Workforce Optimization for Customer Service

The Demand Forecast application uses **MetricBase** to forecast the demand for teams.

When you create demand forecast configurations, the application creates metrics:

- To forecast the number of agents you need for interactions.
- To resolve cases throughout a given day.

**Note:** You can create forecast configurations for any table.
Analyzing Demand Forecast resource prediction

Demand Forecast - Model Demand Scenarios

As a manager with the forecast admin role, you can create forecast parameters in the Manager Workspace. **Modify forecast parameters to visualize forecast data** and preview time-series data before publishing it. You can create any number of forecasts to preview the time-series data in real time.

You can also make manual adjustments to tweak the forecast and analyze the forecast pattern. You can overlay the manual adjustments on the visualized forecast data and view the time-series data to analyze the forecast model. For example, if you have a specific pattern for the upcoming week but you know that a national holiday falls in the middle of the week where you need more agents because you expect the sales to go up, you can manually tweak the forecast to increase it by 10% and analyze that data.

**Demand Forecast**
The Demand Forecast application includes the following four modules:

<table>
<thead>
<tr>
<th>Demand forecast application modules</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Module Name</strong></td>
</tr>
<tr>
<td>Data Collection Definitions</td>
</tr>
<tr>
<td>Formula Parameters</td>
</tr>
<tr>
<td>Resource Conversion Formula</td>
</tr>
<tr>
<td>Group Forecast Configuration</td>
</tr>
</tbody>
</table>

As a forecast admin (sn_agent_forecast.admin), you can forecast the number of agents you need for a shift.

To forecast the demand:

1. Collect data by defining data collection definitions
2. Set values for forecast parameters.
3. Create formulas to convert forecasting number of cases into the number of resources you need to respond to those cases.
4. Associate the formulas to assignment groups.
5. View the predicted demand on the calendar.

Note: Refer to the Demand Forecast section in Components installed with Workforce Optimization for Customer Service for information on the default components and configurations.

Collect data by defining data collection definitions
Use the Data Collection Definitions application to define the data you want to collect for forecasting agents.

- Use the Collect daily data for automated forecast configurations scheduled job to gather data for the metrics defined in the data collection definitions. The scheduled job fetches the records from the previous day for each hour for every assignment group and stores it in the MetricBase.

You can access the time series for the collected data using the MetricBase list on the Group [sys_user_group] table. For more information on accessing MetricBase data, refer to Access MetricBase data using the list command.

- Use the Collect historical data for automated forecast configurations on-demand job to collect hourly historical data. This job collects data for the past three years.

- Use the Forecast resources for future scheduled job to forecast the resources based on the collected data and stores the data in the Agent Forecast metric in MetricBase. Refer to Forecast properties to set the collection frequency such as number of days you need to collect the data to calculate the forecast or the time period for which you want to store the data.

Note: The time series metrics created for data collection definitions use the WFO Forecast retention policy. This policy stores data at a one-hour interval for the past three years.

Create forecast parameters
Use numeric values or a script to define parameters to use in the formula for forecasting. Refer to Forecast parameters for the parameters available by default.

Create formula to convert forecast to resources
Build formulas to convert the forecast to resources. Refer to Resource Forecast Configurations for the configured resource forecast formulas available by default.
Associate formulas to assignment groups

Associate assignment groups with the resource conversion formula to convert number of cases to agents.

View the predicted demand on the calendar

The data collected by the Agent Forecast metric in MetricBase is used to forecast the agents you need for each hour in a day on the team calendar. In a Week view for the calendar, it displays the staffing levels for a given week.

Related information

Configure the data collection to forecast the demand for resources
Analyze staff alignment using Demand Forecast

Teams in Workforce Optimization for Customer Service

Learn how you can organize each of your teams into assignment groups. You can define a set of key Performance Indicators (KPIs) to analyze the performance of all groups within that team. Drill into the metrics for a group, an agent, or an incident within that team—all from a central location.

Drill down into your reports.
As an administrator for **Teams**, you can:

- Create a KPI group for a common set of indicators (KPIs) you use to measure your teams' performance.

  **Note:** Your teams are defined as **assignment groups** within the **Teams** application.

- Add the KPIs to the KPI group.

- Add assignment groups to the KPI group.

  **Note:** Ensure that you have a manager added to each assignment group. The manager is the one that either directly manages the assignment group or one that needs visibility into the assignment group.

As a manager, you can:

- Analyze the performance trends for your teams.

- Drill down into the performance of teams, agents, or cases.
Related information

Setting up Teams Workforce Optimization for Customer Service
Teams in Workforce Optimization for Customer Service

Example: Teams using Workforce Optimization for Customer Service

Understand how you can manage your teams from a single location using an example.

Amy Jones is the manager of Customer Service Desk and manages 15 teams. She is an additional manager of most teams, so that she has visibility into the operations although the agents don’t directly report to her.

To effectively analyze the performance of her teams from one location, she sets up the Teams as follows:

1. Organizes her teams into groups called assignment groups. The teams either directly report to her or she may have visibility into their performance.
2. Creates a KPI group with a set of indicators that matter most to measure the performance of her assignment groups.
3. Adds all assignment groups that use the set of KPIs to the KPI group.

With this set up, she can effectively analyze the performance of her teams grouped by KPI groups.

Amy Jones can set up and use Teams by performing the following steps:

1. Create a KPI group
2. Add KPIs to that group
3. Add managers to assignment groups
4. Add assignment groups to the KPI group
5. Drill down into a KPI, agent, or an incident to analyze performance

Get an overview of how you can set up team performance and how KPI aggregates are calculated.

Workforce Optimization for Customer Service Set Up Team Performance
Get an overview of how you can analyze team performance in this video.
Workforce Optimization for Customer Service Analyze Team Performance
For detailed information on how to setup and use Teams, see teams.
Coaching in Workforce Optimization for Customer Service

Learn how you can review and assess the quality of completed interactions and tasks. Enhance your teams' skills set by assigning them training based on the assessments and add skills to their profile when they get trained.
Here's an example of how Workforce Optimization for Customer Service uses Predictive Intelligence to recommend skills for agents:

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Predictive Intelligence associates the cases that were closed using similar skills and then groups the tasks by the agents who resolved them.</td>
<td>Predictive Intelligence looks at the similarity between the tasks that were resolved using the skill Firewall.</td>
</tr>
<tr>
<td>2.</td>
<td>When agents resolve cases, the Skill Recommendation application stores the skill and agent associations.</td>
<td>Agent A completes a task that requires the skill Firewall, but that skill is not in the agent's user profile yet.</td>
</tr>
<tr>
<td>3.</td>
<td>System administrators set the threshold for the skill and agent associations. When the threshold is reached, the Skill Recommendation application recommends to the agent's manager that the skill be added to an agent's profile.</td>
<td>The system administrator sets the threshold at 10. That means the agents have to complete at least 10 tasks that require a specific skill, before the predictive intelligence engine can recommend that specific skill for the agents. Agent A completes 10 tasks that required the skill Firewall, and currently Agent A is not assigned skill Firewall. The Skill Recommendation application recommends the skill Firewall for Agent A to the agent's manager.</td>
</tr>
<tr>
<td>4.</td>
<td>The manager approves and adds the skill to the agent's profile.</td>
<td>Agent A's manager approves the skill Firewall and adds that skill to Agent A's profile.</td>
</tr>
<tr>
<td>5.</td>
<td>Advanced work assignment (AWA) uses the new skills that were added to the agent's profile, looks up tasks that require those skills, and assigns the agents to complete those tasks.</td>
<td>When a task requires the skill Firewall, Agent A is automatically considered for that task assignment.</td>
</tr>
<tr>
<td>Step</td>
<td>Description</td>
<td>Example</td>
</tr>
<tr>
<td>------</td>
<td>----------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>6.</td>
<td>Over time, the Predictive Intelligence machine learning algorithms learn which skills were assigned to the agents to resolve the cases.</td>
<td></td>
</tr>
</tbody>
</table>

The infographic shows how you can use Predictive Intelligence to recommend skills for your agents.
Skill recommendation using Predictive Intelligence

1. Predictive Intelligence (PI) compares cases closed in the last 90 days with skills data for similarity

![Diagram showing tasks and skills comparison]

PI groups the cases based on skills agents used to resolve them

2. Skills Recommendation Application stores the skill and agent associations

![Diagram showing agent skills and tasks]

Admin sets threshold for this association

3. When the threshold is met, Skill Recommendation Application recommends the skill to the agent's manager

4. Manager approves the recommendation

![Diagram showing agent skills assigned]

5. Advanced Work Assignment

6. PI algorithms learn from the data collected
As a coach, you can:

- Use surveys to evaluate your team’s performance.
- Recognize improvement opportunities and assign training tasks.
- Assess a trainee’s ability to resolve cases.
- Assign training that is based on the assessments.
- Add skills to a trainee’s profile that is based on a recommendation from Predictive Intelligence.

As a trainee, you can get trained to address your skill gaps.

**Related information**

- Setting up skill prediction in Workforce Optimization for Customer Service
- Coaching in Workforce Optimization for Customer Service

**Example: Coaching using Workforce Optimization for Customer Service**

Understand how you can assess your agents performance, identify skill gaps, and train them to enhance their skill sets with Coaching.

Amy Jones manages Customer Service operations for a large organization and has 12 teams reporting to her. Each of her teams has anywhere from 8 through 15 agents. She is also added as a manager of other teams where she needs visibility.

She wants a single location where she can:

- Monitor the skills that her teams use the most to solve issues
- Analyze metrics and monitor pending coaching assessments and training for the teams
- Add skills used for resolving issues or when Predictive Intelligence Workbench recommends them.

Amy Jones can manage all of these actions by doing the following:

1. Set conditions that trigger coaching opportunities.
2. Assess her agents’ skills and assign training.
3. Add skills to agent profile when they complete training or using recommendations from Predictive Intelligence.

Get an overview on coaching, creating assessments, taking surveys, assigning training, and adding skills.
Get an overview of how you can add skills manually or the ones recommended using Predictive Intelligence and the Skill Recommendation application.

Workforce Optimization for Customer Service Skill Recommendation

For detailed instructions to use Coaching in Workforce Optimization for Customer Service, see Coaching.

Configuring Workforce Optimization for Customer Service

Enable Workforce Optimization for Customer Service and configure settings to use the Channel Management, Scheduling, Teams, and Coaching applications.

Activate Workforce Optimization for Customer Service

Workforce Optimization for Customer Service solution is highly modular, offering a wide range of capabilities such as Channel Management, Scheduling, Coaching, and Teams applications in CSM Manager Workspace. Workforce Optimization for Customer Service (com.snc.wfo.csm) plugin activates all other dependent plugins to enable users to the Channel Management, Scheduling, Coaching, and Teams applications in Workforce Optimization for Customer Service.

Before you begin
Role required: admin

Procedure

1. Navigate to System Applications > All Available Applications > All.
2. Find the plugin using the filter criteria and search bar.
   
   You can search for the plugin by its name or ID. If you cannot find a plugin, you might have to request it from ServiceNow personnel. For more information, see Request a plugin.

3. Click Install, and then in the Activate Plugin dialog box, click Activate.

   Note: When domain separation and delegated admin are enabled in an instance, the administrative user must be in the global domain. Otherwise, the following error appears: Application installation is unavailable because another operation is running: Plugin Activation for <plugin name>.
**Components installed with Workforce Optimization for Customer Service**

Several types of components are installed with activation of the Workforce Optimization for Customer Service (com.snc.wfo.csm) plugin, including user roles, key performance indicators (kpis), scheduled jobs, properties, and tables.

**Workforce Optimization for Customer Service**

### Roles

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workforce Optimization User [sn_wfo.user]</td>
<td>Grants read access to primary group and additional managers.</td>
<td>pa_analyst</td>
</tr>
<tr>
<td>Workforce Optimization Admin [sn_wfo.admin]</td>
<td>Grants administrative rights to create, read, update, and delete (CRUD) additional managers.</td>
<td>sn_wfo.user</td>
</tr>
</tbody>
</table>
| Workforce Optimization CSM Manager [sn_wfo_csm.manager] | Grants rights to create, read, or update, coaching, scheduling, teams, or channel management applications. | • sn_mgr_workspace.manager  
• sn_customerservice_manager  
• sn_wfo.user  
• sn_channel_mgmt.user  
• sn_shift_planning.admin  
• sn_coaching.coach  
• sn_sre.user  
• sn_team_perf.team_performance_user |
| Workforce Optimization CSM Admin [sn_wfo_csm.admin] | Grants administrative rights to create, read, update, coaching, scheduling, teams, or channel management applications. | • sn_team_perf.team_performance_admin  
• sn_coaching.admin  
• skill_model_admin  
• sn_channel_mgmt.admin  
• sn_wfo_csm.manager |
### Roles

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Management        | management applications. | • sn_mgr_workspace.admin  
|                   |             | • sn_sre.admin    |

### Scheduled jobs

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WFO data collection</td>
<td>Runs the job on demand and collects data for all Workforce Optimization for Customer Service indicators.</td>
</tr>
</tbody>
</table>

### Filter Configuration

<table>
<thead>
<tr>
<th>Module Name</th>
<th>Module Tables / Database View</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manager Workspace</td>
<td>Stores filter configurations for all applications such as Channels, Schedule, and Coaching. [sn_mgr_workspace_filter_configuration]</td>
</tr>
</tbody>
</table>
| Schedule        | • User [sys_user]  
|                 | • User Skill [sys_user_has_skill]  
|                 | • Agent Schedule [sys_shift_planning_agent_schedule]  
|                 | • Schedule Event [sn_shift_planning_event]  
|                 | • Manager Groups database view [sn_wfo_manager_group] |
| Coaching        | • Skill [cmn_skill]  
|                 | • Skill Category M2M [cmn_skill_m2m_category]  
|                 | • Group Member [sys_user_grmember] |
| Channels        | Manager Groups database view [sn_wfo_manager_groups] |
Manager Workspace

Roles

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manager Workspace User [sn_mgr_workspace.user]</td>
<td>Grants read access to home and list modules.</td>
<td>workspace_user</td>
</tr>
<tr>
<td>Manager Workspace Manager [sn_mgr_workspace.manager]</td>
<td>Grants read access to primary group, additional managers, and the approval button.</td>
<td>• sn_mgr_workspace.user&lt;br&gt;• sn_wfo.user</td>
</tr>
<tr>
<td>Manager Workspace Admin [sn_mgr_workspace.admin]</td>
<td>Grants administrative rights to create, read, update, and delete (CRUD) all applications and settings in Manager Workspace.</td>
<td>• sn_mgr_workspace.manager&lt;br&gt;• workspace_admin&lt;br&gt;• ui_builder_admin</td>
</tr>
</tbody>
</table>

Properties

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cnm_skills.ws_max_users_swap_skill_matrix</td>
<td>The maximum limit for the number of users that allows you to swap axes in the skill matrix.</td>
</tr>
<tr>
<td></td>
<td>• Type: Integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 50</td>
</tr>
</tbody>
</table>

Reports

<table>
<thead>
<tr>
<th>Indicator Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Critical Open Cases</td>
<td>Number of critical open cases.</td>
</tr>
<tr>
<td>Unassigned Cases</td>
<td>Number of unassigned cases.</td>
</tr>
<tr>
<td>Escalated Cases</td>
<td>Number of escalated cases.</td>
</tr>
<tr>
<td>SLAs Breached</td>
<td>Number of SLA breached cases.</td>
</tr>
</tbody>
</table>
### Reports (continued)

<table>
<thead>
<tr>
<th>Indicator Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cases not updated in 7 days</td>
<td>Number of cases that are not updated since 7 days.</td>
</tr>
<tr>
<td>Cases open for 30 days</td>
<td>Number of cases that are not updated since 30 days.</td>
</tr>
<tr>
<td>In-progress chats</td>
<td>Number of in-progress chats.</td>
</tr>
<tr>
<td>Help Requested chats</td>
<td>Number of chats that requested help.</td>
</tr>
<tr>
<td>Agent Distribution</td>
<td>Number of work items that are distributed among agents.</td>
</tr>
<tr>
<td>Waiting Work Items</td>
<td>Number of waiting work items.</td>
</tr>
<tr>
<td>Available Agents</td>
<td>Number of available agents.</td>
</tr>
<tr>
<td>Total Open Cases</td>
<td>Total number of open cases.</td>
</tr>
</tbody>
</table>

### Performance Analytics Indicators

<table>
<thead>
<tr>
<th>Indicator Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cases closed this week</td>
<td>Number of cases that are closed in this week.</td>
</tr>
<tr>
<td>Chats completed this week</td>
<td>Number of chats completed this week.</td>
</tr>
</tbody>
</table>

### Scheduled jobs

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[CSM Manager Workspace] Daily Data Collection</td>
<td>Runs the job daily and collects data for all teams indicators.</td>
</tr>
<tr>
<td>[CSM Manager Workspace] Historic Data Collection</td>
<td>Runs the job and collects historic data for all teams indicators.</td>
</tr>
<tr>
<td>[CSM Manager Workspace] Weekly Data Collection</td>
<td>Runs the job weekly and collects data for all indicators in Manager Workspace.</td>
</tr>
</tbody>
</table>
Channel Management

Roles

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel Management User [sn_channel_mgmt.user]</td>
<td>Grants read access to channel reports, channel view, and queue report tables.</td>
<td>awa_manager</td>
</tr>
<tr>
<td>Channel Management Admin [sn_channel_mgmt.admin]</td>
<td>Grants administrative rights to create, read, update, and delete (CRUD) channel reports, channel view, and queue report tables.</td>
<td>sn_channel_mgmt.user, awa_admin, sn_wfo.admin, report_admin</td>
</tr>
</tbody>
</table>

Interactive Filters for Reports

<table>
<thead>
<tr>
<th>Interactive Filter Name</th>
<th>Description</th>
<th>Reference Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel Management Agent Filter</td>
<td>Filters reports based on an agent.</td>
<td>[sys_user]</td>
</tr>
<tr>
<td>Channel Management Group Filter</td>
<td>Filters reports based on groups.</td>
<td>[sys_user_group]</td>
</tr>
<tr>
<td>Channel Management Queues Filter</td>
<td>Filters reports based on queues.</td>
<td>[awa_queue]</td>
</tr>
<tr>
<td>Channel Management Service Channel Filter</td>
<td>Filters reports based on service channels.</td>
<td>[awa_service_channel]</td>
</tr>
</tbody>
</table>

Reports for Service Channels and Queues

<table>
<thead>
<tr>
<th>Report Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agents available to take case work items</td>
<td>Number of available agents to take case work items.</td>
</tr>
</tbody>
</table>
### Reports for Service Channels and Queues (continued)

<table>
<thead>
<tr>
<th>Report Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interaction Work Items</td>
<td>Number of interaction work items assigned on any given day.</td>
</tr>
<tr>
<td>Assigned Today</td>
<td></td>
</tr>
<tr>
<td>Abandoned Interaction Work Items</td>
<td>Number of abandoned interaction work items.</td>
</tr>
<tr>
<td>Case Work Items Assigned Today</td>
<td>Number of case work items assigned on any given day.</td>
</tr>
<tr>
<td>Average CSAT Score</td>
<td>Average customer satisfaction score.</td>
</tr>
<tr>
<td>Case Work ItemsResolved Today</td>
<td>Number of case work items resolved on any given day.</td>
</tr>
<tr>
<td>Interaction Work ItemsResolved Today</td>
<td>Number of interaction work items resolved on any given day.</td>
</tr>
<tr>
<td>Average Handling time for Interaction Work Items</td>
<td>Average time for handling interaction work items.</td>
</tr>
<tr>
<td>Agents Available to take Interaction Work Items</td>
<td>Number of available agents to take interaction work items.</td>
</tr>
<tr>
<td>Case Work Items Closed Today</td>
<td>Number of case work items closed on any given day.</td>
</tr>
</tbody>
</table>

### Reports for Agents

<table>
<thead>
<tr>
<th>Report Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Chats</td>
<td>Number of ongoing chat conversations.</td>
</tr>
<tr>
<td>Chats Completed Today</td>
<td>Number of chats completed on any given day.</td>
</tr>
<tr>
<td>Chat Rejections Today</td>
<td>Number of chats rejected on any given day.</td>
</tr>
<tr>
<td>Active Cases</td>
<td>Number of ongoing cases.</td>
</tr>
<tr>
<td>Cases Resolved Today</td>
<td>Number of resolved cases on any given day.</td>
</tr>
</tbody>
</table>
### Scheduled jobs

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Channel Management] Reset Temporary Capacity Override</td>
<td>Runs the job every two minutes check the invalid or expired overridden capacity and resets to the previous channel capacity.</td>
</tr>
</tbody>
</table>

### Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| sn_channel_mgmt.list_auto_refresh.enable                                | Select to disable auto-refresh of lists in Channel Management.  
  - **Type**: True or False  
  - **Default value**: True |
| sn_channel_mgmt.channels_card_auto_refresh.enable                       | Select to disable auto-refresh of lists in Channel Management.  
  - **Type**: True or False  
  - **Default value**: True |
| sn_channel_mgmt.list_auto_refresh.interval.seconds                      | Define the auto-refresh interval for the channel management list.  
  - **Type**: Integer  
  - **Default value**: 30 |
| sn_channel_mgmt.kpi_auto_refresh.interval.seconds                       | Set the frequency for refreshing data on channel management indicators.  
  - **Type**: Integer  
  - **Default value**: 5 |
| sn_channel_mgmt.filter_config.enable                                    | Displays **Assignment Group** interactive filter in channels.  
  - **Type**: True or False  
  - **Default value**: True |
| sn_channel_mgmt.awa_agent_temporary_override.minutes                    | Duration for the channel capacity that is overridden. |
Properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Type</td>
<td>Integer</td>
</tr>
<tr>
<td>• Default value</td>
<td>12 hours</td>
</tr>
</tbody>
</table>

Note: Channel management properties are not visible by default in the [sys_properties] table. To use any of the channel management properties, you must add the required property to the System Property [sys_properties] table. For more information, refer to Add a system property.

Scheduling

Roles

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift Planning User [sn_shift_planning.user]</td>
<td>Grants read access for scheduling including the ability to view schedules and shifts.</td>
<td></td>
</tr>
<tr>
<td>Shift Planning Agent [sn_shift_planning.agent]</td>
<td>Grants agents access to their calendar and request shift swap or time-off.</td>
<td>sn_shift_planning.user</td>
</tr>
<tr>
<td>Shift Planning Admin [sn_shift_planning.admin]</td>
<td>Grants administrative access to create, read, update, and delete (CRUD) schedules and work shifts.</td>
<td>sn_shift_planning.approver sn_shift_planning.user sn_shift_planning.agent</td>
</tr>
</tbody>
</table>

Tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_shift_planning_time_worked_summary</td>
<td>Stores the time worked summary of an agent.</td>
</tr>
<tr>
<td>sn_shift_planning_agent_time_worked</td>
<td>Stores the agent's time worked, such as clock-in and clock-out timings. If an agent logs in early or logs out late, then the shift start and shift end times are stored in place of clock-in and clock-out timings.</td>
</tr>
</tbody>
</table>
## Tables (continued)

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_shift_planning_agent_time_attendance</td>
<td>Stores the clock-in and clock-out timings of agents. Data is retrieved when an agent logs in, logs out or changes the presence state.</td>
</tr>
</tbody>
</table>

## Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_shift_planning.number_of_days_to_cache</td>
<td>Number of days to cache agent schedules.</td>
</tr>
<tr>
<td></td>
<td>• Type: Integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 5</td>
</tr>
<tr>
<td>sn_shift_planning.enable_schedule_adherence</td>
<td>Calculates and displays schedule adherence information for your agents.</td>
</tr>
<tr>
<td></td>
<td>• Type: Boolean</td>
</tr>
<tr>
<td></td>
<td>• Default value: True</td>
</tr>
<tr>
<td>sn_shift_planning.early_clockin_threshold</td>
<td>Threshold settings indicate how many minutes early or late an agent can clock-in or clock-out to the scheduled time without being considered non-adherent. This is the acceptable duration of time flexibility for an agent to start work before the scheduled start time.</td>
</tr>
<tr>
<td></td>
<td>• Type: Integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 60 min</td>
</tr>
<tr>
<td>sn_shift_planning.adherence_threshold</td>
<td>Set the percentage for a threshold in adherence. The agents who do not qualify to be above the defined threshold value (70%) are considered non-adherent agents.</td>
</tr>
<tr>
<td></td>
<td>• Type: Integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 70%</td>
</tr>
<tr>
<td>sn_shift_planning.conformance_lower_threshold</td>
<td>Set the threshold percentage for flexibility in conformance. The agents who do not qualify for the defined lower and upper</td>
</tr>
</tbody>
</table>
## Properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>conformance threshold values (80-120) are considered non-conformance agents.</td>
<td></td>
</tr>
<tr>
<td>• Type: Integer</td>
<td></td>
</tr>
<tr>
<td>• Default value: 80%</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>sn_shift_planning.conformance_upper_threshold</th>
<th>Set the threshold percentage for flexibility in conformance. The agents who do not qualify for the defined lower and upper conformance threshold values (80-120) are considered non-conformance agents.</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Type: Integer</td>
<td></td>
</tr>
<tr>
<td>• Default value: 120%</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>sn_shift_planning.auto_clockout_threshold</th>
<th>Threshold time for the system to wait and generate automatic clock-out events when agents forgets to clock-out. For example, if an agent’s planned work shift is 8 AM to 5 PM and fails to clock out at 5 PM, the system waits for 60 min as threshold time and generates an automatic clock-out event.</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Type: Integer</td>
<td></td>
</tr>
<tr>
<td>• Default value: 60 min</td>
<td></td>
</tr>
</tbody>
</table>

## Business rule

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent Time Work Event Trigger</td>
<td>Agent Presence [awa_agent_presence]</td>
<td>Sets the clock-in and clock-out events whenever there is a change in agent’s presence state.</td>
</tr>
</tbody>
</table>
## Scheduled Jobs

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift Planning - Delete All Agent Schedules Cache</td>
<td>Deletes cache from the <code>sn_shift_planning_agent_availability</code> table.</td>
</tr>
<tr>
<td></td>
<td>• Runs automatically everyday at 2:30 am</td>
</tr>
<tr>
<td></td>
<td>• Run this job on-demand when you import data.</td>
</tr>
<tr>
<td>Clock-out event generation (For scenarios where clock-out event does not get triggered)</td>
<td>Generates clock-out events every 4 hours if agents haven’t clocked-out.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Consider an agent’s work shift timings are from 8 AM to 5 PM and <code>sn_shift_planning.auto_clockout_threshold</code> property value is set to 60 minutes. The agent clocks-in and fails to clock out, the scheduled job waits till 6 PM (5 PM + 60 minutes) and if there is no clock out till 6 PM, the system generates a clock-out event with agent’s shift end time.</td>
</tr>
<tr>
<td>Populate Agent Time Worked Summary</td>
<td>Runs daily to calculate the time worked, adherence and conformance based on agent’s planned and actual work shift timings of the previous day. The values are stored in <code>[sn_shift_planning_time_worked_summary]</code> table.</td>
</tr>
<tr>
<td>Update Wrapper End Time for Actual Work Events</td>
<td>Runs daily to make sure the actual work wrapper end-time is equal to last clock-out time.</td>
</tr>
<tr>
<td>[Schedule Adherence] Daily Data Collection</td>
<td>Runs the job daily and collects data for all teams indicators.</td>
</tr>
<tr>
<td>[Schedule Adherence] Historic Data Collection</td>
<td>Runs the job and collects historic data for all teams indicators.</td>
</tr>
</tbody>
</table>
### Scheduled Jobs (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Schedule Adherence] Weekly Data Collection</td>
<td>Runs the job weekly and collects data for all indicators in Manager Workspace.</td>
</tr>
</tbody>
</table>

### Setting the due date for time-off and shift-swap request approvals

Administrators can configure the due date logic for the Time Off Request and Shift Swap Request approval flows. The approval due date is set as the number of days before the request start date. The default is set to two days which means if the approval is not approved two days before the request start date, it will be auto-rejected. For information on configuring flows, refer to Build your first flow in Flow Designer.

### Demand Forecast

#### Forecast configurations

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cases Assigned</td>
<td>Collects data for cases.</td>
</tr>
<tr>
<td>Chat Interactions Created</td>
<td>Collects data for chat interactions.</td>
</tr>
</tbody>
</table>

The **WFO Forecast** time series metric retention policy is available by default for all forecast configurations. By default, this retention policy stores data at a one-hour interval for the past three years.

### Resource Forecast Configurations

<table>
<thead>
<tr>
<th>Name</th>
<th>Formula to create this resource forecast configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resources for Sales Support</td>
<td>([FC:Chat Interactions Created] * [FP:AVERAGE CHAT WORK TIME - SALES SUPPORT])</td>
</tr>
<tr>
<td>Resources for Service Support</td>
<td>([FC:Cases Assigned]<em>[FP:AVERAGE CASE WORK TIME - SERVICE SUPPORT]) + ([FC:Chat Interactions Created]</em>[FP:AVERAGE CHAT WORK TIME - SERVICE SUPPORT])</td>
</tr>
<tr>
<td>Resources for Tech Support</td>
<td>([FC:Cases Assigned]<em>[FP:AVERAGE CASE WORK TIME - TECH SUPPORT]) + ([FC:Chat Interactions Created]</em>[FP:AVERAGE CHAT WORK TIME - TECH SUPPORT])</td>
</tr>
</tbody>
</table>
### Forecast Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Support: Average Case Work Time</td>
<td>Average time a service support agent worked on a case. Time is measured in hours. The default value is 0.5.</td>
</tr>
<tr>
<td>Service Support: Average Chat Work Time</td>
<td>Average chat duration a service support agent had for each interaction. Time is measured in hours. The default value is 0.25.</td>
</tr>
<tr>
<td>Tech Support: Average Case Work Time</td>
<td>Average time a tech support agent worked on a case. Time is measured in hours. The default value is 1.</td>
</tr>
<tr>
<td>Tech Support: Average Chat Work Time</td>
<td>Average chat duration a tech support agent had for each interaction. Time is measured in hours. The default value is 0.5.</td>
</tr>
<tr>
<td>Sales Support: Average Chat Work Time</td>
<td>Average chat duration a sales support agent had for each interaction. Time is measured in hours. The default value is 0.5.</td>
</tr>
</tbody>
</table>

If you create forecast parameters for a forecast configuration, the values set in the configuration are used instead of the default forecast parameters listed in the forecast properties section. For information on configuring forecast parameters, see Modify forecast parameters to visualize forecast data.

### Forecast Properties

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_agent_forecast.historical_data_points</td>
<td>The hourly historical data points to be used for the forecast. The maximum allowed data points is 26280. The default value is 8760 and represents the hourly data points for a one year time. For example: 24 hours x 365 days x 3 years = 26280</td>
</tr>
</tbody>
</table>
### Forecast Properties (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_agent_forecast.seasonal_frequency</td>
<td>The seasonal frequency of a repeated pattern. The default value is 168 and represents weekly data pattern.</td>
<td>For example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Daily data pattern = 1*24 = 24</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Weekly data pattern = 7 * 24 = 168</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Monthly data pattern = 30 * 24 = 720</td>
</tr>
<tr>
<td>sn_agent_forecast.forecast_periods</td>
<td>The number of periods to forecast where a period is the length of a season. The default value is 5.</td>
<td>For example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If the length of a season is daily which is equal to 24 hours (1 day) and the forecast period is 30 days, then the number of periods to forecast is equal to 24 * 30 = 720 hours.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If the length of a season is weekly which is equal to 168 hours (1 week) and the forecast period is 5 weeks, then the number of periods to forecast is equal to 168 * 5 = 840 hours.</td>
</tr>
</tbody>
</table>
### Roles for Demand Forecast

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forecast admin [sn_agent_forecast.admin]</td>
<td>Grants administrative rights to create, read, update, and delete (CRUD) forecast configuration tables.</td>
<td>• sn_agent_forecast.users</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• clotho_admin</td>
</tr>
<tr>
<td>Forecast user [sn_agent_forecast.user]</td>
<td>Grants read access to forecast configuration tables.</td>
<td></td>
</tr>
</tbody>
</table>

### Tables for Demand Forecast

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forecast Configuration [sn_agent_forecast_configuration]</td>
<td>Define data collection definition and resource conversion formula configurations.</td>
</tr>
<tr>
<td>Forecast Configuration group [sn_agent_forecast_configuration_m2m_sys_user Group]</td>
<td>Associate resource conversion formula with assignment groups.</td>
</tr>
</tbody>
</table>

By default, forecast configurations are available for the following groups:

- Sales Support
- Service Support
- Tech Support

### Schedule jobs for Demand Forecast

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collect historical data for automated forecast configurations</td>
<td>Runs on demand. Collects historical data daily for every hour for the past three years for automated forecast configuration.</td>
</tr>
<tr>
<td>Collect daily data for automated forecast configurations</td>
<td>Runs daily at 2 am. For any table defined in the Data Collection Definition configuration, it counts the number of records from the</td>
</tr>
</tbody>
</table>
Schedule jobs for Demand Forecast (continued)

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>previous day for each hour for every group and stores it in the MetricBase.</td>
</tr>
<tr>
<td>Forecast resources for future</td>
<td>Runs daily at 3 am. Calculates the forecast resources for the future based on the collected data and stores the data in the Agent Forecast metric in MetricBase.</td>
</tr>
</tbody>
</table>

Teams

Roles

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
</table>
| Teams User [sn_team_perf.team_performance_user] | Grants access to read KPI tables. | • sn_wfo.user  
• pa_analyst |
| Teams Admin [sn_team_perf.team_performance_admin] | Grants access to create and configure KPIs, KPI groups, and assignment groups in the Teams module. | • sn_wfo.admin  
• sn_team_perf.team_performance_user |

Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_team_perf.kpi_group.max_parent_kpis</td>
<td>The maximum number of parent indicators that you can add to one KPI group.</td>
</tr>
<tr>
<td>sn_team_perf.kpi_group.max_supporting_kpis</td>
<td>The maximum number of supporting KPIs you can define for a parent KPI.</td>
</tr>
<tr>
<td>sn_team_perf.ws.max_assignment_groups</td>
<td>The maximum number of assignment groups prioritized by order number to</td>
</tr>
</tbody>
</table>
### Properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_team_perf.default_date_range</td>
<td>The default date range set in the date range picker.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> Integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value:</strong> 30</td>
</tr>
</tbody>
</table>

### Performance Analytics Indicators

<table>
<thead>
<tr>
<th>Indicator Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td># of cases resolved on first contact</td>
<td>Number of cases resolved on first contact.</td>
</tr>
<tr>
<td># of P1 cases resolved on first contact</td>
<td>Number of P1 cases resolved on first contact.</td>
</tr>
<tr>
<td># of P2 cases resolved on first contact</td>
<td>Number of P2 cases resolved on first contact.</td>
</tr>
<tr>
<td># of P3 cases resolved on first contact</td>
<td>Number of P3 cases resolved on first contact.</td>
</tr>
<tr>
<td># of P4 cases resolved on first contact</td>
<td>Number of P4 cases resolved on first contact.</td>
</tr>
<tr>
<td>MTTR for Cases</td>
<td>Mean time to resolve the cases.</td>
</tr>
<tr>
<td>MTTR for P1 Cases</td>
<td>Mean time to resolve the P1 cases.</td>
</tr>
<tr>
<td>MTTR for P2 Cases</td>
<td>Mean time to resolve P2 cases.</td>
</tr>
<tr>
<td>MTTR for P3 Cases</td>
<td>Mean time to resolve the P3 cases.</td>
</tr>
<tr>
<td>MTTR for P4 Cases</td>
<td>Mean time to resolve P4 cases.</td>
</tr>
<tr>
<td>CSAT for Cases</td>
<td>Customer satisfaction score for cases.</td>
</tr>
<tr>
<td>CSAT for P1 Cases</td>
<td>Customer satisfaction score for P1 cases.</td>
</tr>
<tr>
<td>CSAT for P2 Cases</td>
<td>Customer satisfaction score for P2 cases.</td>
</tr>
</tbody>
</table>
Performance Analytics Indicators (continued)

<table>
<thead>
<tr>
<th>Indicator Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSAT for P3 Cases</td>
<td>Customer satisfaction score for P3 cases.</td>
</tr>
<tr>
<td>CSAT for P4 Cases</td>
<td>Customer satisfaction score for P4 cases.</td>
</tr>
<tr>
<td>Number of Closed Cases</td>
<td>Number of closed cases.</td>
</tr>
<tr>
<td>Number of Closed P1 Cases</td>
<td>Number of closed P1 cases.</td>
</tr>
<tr>
<td>Number of Closed P2 Cases</td>
<td>Number of closed P2 cases.</td>
</tr>
<tr>
<td>Number of Closed P3 Cases</td>
<td>Number of closed P3 cases.</td>
</tr>
<tr>
<td>Number of Closed P4 Cases</td>
<td>Number of closed P4 cases;</td>
</tr>
<tr>
<td>Average Wait Time for Chats</td>
<td>Average waiting time for chats.</td>
</tr>
<tr>
<td>Number of Chats Handled</td>
<td>Number of chats handled.</td>
</tr>
<tr>
<td>Average Handling Time for Chats</td>
<td>Average handling time for chats.</td>
</tr>
<tr>
<td>Number of Abandoned Chats</td>
<td>Number of abandoned chats.</td>
</tr>
<tr>
<td>Number of Incoming Cases</td>
<td>Number of incoming cases.</td>
</tr>
<tr>
<td>Schedule Adherence</td>
<td>Agents schedule adherence percentage.</td>
</tr>
<tr>
<td>Schedule Conformance</td>
<td>Agents schedule adherence percentage.</td>
</tr>
<tr>
<td>Summed duration of Time Worked</td>
<td>Agents total duration of time worked.</td>
</tr>
<tr>
<td>Summed Duration of Planned Time</td>
<td>Agents total duration of planned time.</td>
</tr>
<tr>
<td>Summed duration of Time Not Worked</td>
<td>Agents total duration of time not worked.</td>
</tr>
<tr>
<td>Summed duration of Available Non Planned Time</td>
<td>Agents total duration of available non planned time.</td>
</tr>
</tbody>
</table>

Coaching

Roles

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coaching Admin [sn_coaching.admin]</td>
<td>Grants administrative rights to create, read, update, and delete (CRUD)</td>
<td>sn_coaching.coach</td>
</tr>
</tbody>
</table>
### Roles (continued)

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>coaching opportunities, assessments, training, and skills.</td>
<td></td>
</tr>
<tr>
<td>Coaching Coach [sn_coaching.coach]</td>
<td>Grants administrative rights to create, read, or update coaching opportunities, assessments, training, and skills.</td>
<td>• sn_coaching.trainee</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• pa_viewer</td>
</tr>
<tr>
<td>Coaching Trainee [sn_coaching.trainee]</td>
<td>Grants access to add training, assessments, and skill records.</td>
<td>• skill_user</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• pa_viewer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• survey_reader</td>
</tr>
</tbody>
</table>

### Business rule

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculate coaching survey score</td>
<td>Assessment Instance [asmt_assessment_instance]</td>
<td>Sets the feedback rating based on the survey score.</td>
</tr>
</tbody>
</table>

### Coaching opportunities

<table>
<thead>
<tr>
<th>Coaching Opportunity Name</th>
<th>Description</th>
<th>Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coaching Opportunity for SLA Breach</td>
<td>Coaching opportunity for the agents who worked on the critical and high priority cases that breached SLA.</td>
<td>Task SLA [task_sla]</td>
</tr>
<tr>
<td>Coaching Opportunity for low CSAT</td>
<td>Coaching Opportunity for the agents who worked on cases that has a customer satisfaction score less than 4.</td>
<td>Case Report [sn_customerservice_case_report]</td>
</tr>
<tr>
<td>Coaching Opportunity for skills award verification</td>
<td>Coaching Opportunity for verification of skills awarded to agents.</td>
<td>Case [sn_customerservice_case]</td>
</tr>
</tbody>
</table>
## Coaching opportunities (continued)

<table>
<thead>
<tr>
<th>Coaching Opportunity Name</th>
<th>Description</th>
<th>Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knowledge Management Process: Coaching on quality of knowledge articles</td>
<td>Coaching Opportunity for the agents who need to improve the quality of a knowledge article by reviewing the assessment.</td>
<td>Case [sn_customerservice_case]</td>
</tr>
<tr>
<td>Coaching Opportunity for high TTR</td>
<td>Coaching Opportunity for the agents who worked on a case that had time to resolution more than 3 days.</td>
<td>Case Report [sn_customerservice_case_report]</td>
</tr>
<tr>
<td>Interaction: Coaching Opportunity for Handling Time</td>
<td>Coaching Opportunity for the agents who worked had handle time more than 10 mins on an interaction.</td>
<td>Interaction [interaction]</td>
</tr>
</tbody>
</table>

⚠️ **Note:** You can customise the coaching opportunities for low CSAT, high TTR, SLA breach, and handling time based on your business needs.

### Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_coaching.learning_default_duration</td>
<td>Number of days to read the knowledge article or complete training. The admin (sn_wfo.admin) sets the number of days for the trainee to complete reading the article or complete the training. The number of days is converted to the due date for the trainee to complete the training. It is calculated from the current date taking the trainee's time zone into consideration.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Type:</strong> Integer</td>
</tr>
<tr>
<td></td>
<td>• <strong>Default value:</strong> 5</td>
</tr>
</tbody>
</table>
Properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_coaching.exclude_weekends_on_training_due_date</td>
<td>Excludes weekends when the due date is set for trainees to complete training.</td>
</tr>
<tr>
<td>• Type: true</td>
<td>false</td>
</tr>
<tr>
<td>• Default value: true</td>
<td></td>
</tr>
</tbody>
</table>

Skill Recommendation

Roles

<table>
<thead>
<tr>
<th>Role title [name]</th>
<th>Description</th>
<th>Contains roles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Skill Recommendation User [sn_sre.user]</td>
<td>Grants rights to view skill recommendation tables.</td>
<td>wfo.user</td>
</tr>
</tbody>
</table>
| Skill Recommendation Admin [sn_sre.admin] | Grants administrative rights to edit the properties for skill recommendation. | • wfo.admin  
• sn_sre.user |

Navigate to **Skill Recommendation > Configuration** to configure these properties.

Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable skill recommendation. sn_sre.enable_skill_recommendation</td>
<td>Enable this property to start recommending skills for agents.</td>
</tr>
<tr>
<td>• Type: true</td>
<td>false</td>
</tr>
<tr>
<td>• Default value: true</td>
<td></td>
</tr>
<tr>
<td>Maximum number of skills to predict based on supervised learning. sn_sre.max_supervised_skills</td>
<td>Using supervised learning, the maximum number of skills to predict for each incident ordered by confidence of prediction.</td>
</tr>
<tr>
<td>• Type: Integer</td>
<td></td>
</tr>
<tr>
<td>• Default value: 3</td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Max number of skills to predict based on supervised learning.</td>
<td>Using unsupervised learning, the maximum number of skills to predict for each incident ordered by confidence of prediction.</td>
</tr>
<tr>
<td>sn_sre.max_unsupervised_skills</td>
<td></td>
</tr>
<tr>
<td><strong>Type:</strong> Integer</td>
<td><strong>Default value:</strong> 3</td>
</tr>
<tr>
<td>Number of resolved similar tasks to use for predicting skills.</td>
<td>The number of resolved similar incidents to use to predict skills using supervised learning, ordered by confidence of prediction, to resolve similar types of incidents.</td>
</tr>
<tr>
<td>sn_sre.number_of_similar_incidents</td>
<td></td>
</tr>
<tr>
<td><strong>Type:</strong> Integer</td>
<td><strong>Default value:</strong> 15</td>
</tr>
<tr>
<td>Number of times Predictive Intelligence must predict the same skill for an agent before recommending it for the agent.</td>
<td>The number of times Predictive Intelligence must predict the same skill for an agent before recommending the skill for the agent.</td>
</tr>
<tr>
<td>sn_sre.user_predicted_skill_threshold</td>
<td></td>
</tr>
<tr>
<td><strong>Type:</strong> Integer</td>
<td><strong>Default value:</strong> 20</td>
</tr>
<tr>
<td>Similarity solution definition to recommend skills from similar incidents.</td>
<td>Name of the Predictive Intelligence solution definition used for predicting skills to resolve incidents using unsupervised learning. If you have created your own solution definition, you can replace the default one with the one you have created.</td>
</tr>
<tr>
<td>sn_sre.unsupervised_solution_definition_for_incidents</td>
<td></td>
</tr>
<tr>
<td><strong>Type:</strong> String</td>
<td><strong>Default value:</strong> ml_sn_sn_sre_global_recommend_similar_skills_for_incidents</td>
</tr>
<tr>
<td>Similarity solution definition to recommend skills for incidents.</td>
<td>Name of the Predictive Intelligence solution definition used for predicting skills to resolve incidents using supervised learning. If you have created your own solution definition,</td>
</tr>
<tr>
<td>sn_sre.supervised_solution_definition_for_incidents</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>you can replace the default one with the one you have created.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Type:</strong> String</td>
<td></td>
</tr>
<tr>
<td>• <strong>Default value:</strong> <code>ml_sn_sn_sre_global_recommend_skills_from_similar_incidents</code></td>
<td></td>
</tr>
</tbody>
</table>

**Similarity solution definition to recommend skills from similar cases.**

- **sn_customerservice.unsupervised_solution_definition_for_cases**
  - Name of the Predictive Intelligence solution definition used for predicting skills to resolve cases using unsupervised learning. If you have created your own solution definition, you can replace the default one with the one you have created.
  - **Type:** String
  - **Default value:** `ml_sn_sn_customerservice_global_recommend_similar_skills_for_cases`

**Similarity solution definition to recommend skills for cases.**

- **sn_customerservice.supervised_solution_definition_for_cases**
  - Name of the Predictive Intelligence solution definition used for predicting skills to resolve cases using supervised learning. If you have created your own solution definition, you can replace the default one with the one you have created.
  - **Type:** String
  - **Default value:** `ml_sn_sn_customerservice_global_recommend_skills_from_similar_cases`

## Scheduled job

<table>
<thead>
<tr>
<th>Scheduled job</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start skill prediction</td>
<td>Runs the job every day at 1 AM on all incidents that were closed the previous day. Recommends the skills used to close the incidents to resolve similar open incidents.</td>
</tr>
</tbody>
</table>
### Domain separation and Workforce Optimization for Customer Service

Domain separation is supported in Workforce Optimization for Customer Service. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data. Domain separation in Workforce Optimization for Customer Service is configured to apply to all features of the application. Separation of data is configured along with separation of logic and process.

**Support level: Basic**

- **Business logic:** Ensure that data goes into the proper domain for the application’s service provider use cases.
- **The application supports domain separation at run time.** The domain separation includes separation from the user interface, cache keys, reporting, rollups, and aggregations.
- **The owner of the instance must set up the application to function across multiple tenants.**

Sample use case: When a service provider (SP) uses chat to respond to a tenant-customer’s message, the client must be able to see the SP’s response.

For more information on support levels, see [Application support for domain separation](#).
How domain separation works in Workforce Optimization for Customer Service

Domain separation in Workforce Optimization for Customer Service does not require any setup or configuration.

Domain separation for Channel Management in Workforce Optimization for Customer Service

The work items, such as cases, interactions, and their associated actions, appear based on the selected domain. For information on how work assignments are routed based on domain in Channel Management, refer to Domain separation and Advanced Work Assignment.

The domain-separated tables for Channel Management are as follows:

- Service Channel Reports [m2m.awa.service_channel_report]
- Queue Reports [m2m.awa.queue_report]

Domain separation for Scheduling in Workforce Optimization for Customer Service

When an agent schedule is generated and assigned to an agent, the schedule is only available in the domain that agent belongs to.

The domain-separated tables for Scheduling are as follows:

- sn_shift_planning_agent_schedule
- sn_shift_planning_agent_schedule_request
- sn_shift_planning_break
- sn_shift_planning_day
- sn_shift_planning_event
- sn_shift_planning_schedule_plan
- sn_shift_planning_schedule_shift
- sn_shift_planning_schedule_shift_agent
- sn_shift_planning_shift_plan
- sn_shift_planning_shift_swap_request

Domain separation for Teams in Workforce Optimization for Customer Service

The sn.wfo.add_manager table is domain separated. When users are added as additional managers, those users can only view users within that domain.
Domain separation for Coaching in Workforce Optimization for Customer Service

For information on how domain separation works in Coaching for Workforce Optimization for ITSM, refer to Domain separation and Coaching.

Related information
- Domain separation for service providers

Create a Manager Workspace landing page

Create a landing page based on your business requirement.

Before you begin
Create reports and key performance indicators that are required to set up the landing page.
Role required: sn_mgr_workspace.admin

About this task
The landing page displays a set of reports that are the initial view of your workspace. You can enhance the Workforce Optimization experience by customizing the landing page to monitor metrics and trends that matter most to you. Use the User Interface (UI) Builder to add data visualization components to display widgets and reports that you want to track and monitor. For more information, see Creating custom landing pages for workspaces.

Using UI Builder, you can:
- Clone the existing CSM landing page.

  Note: The application scope can be set to CSM Workspace, CSM Manager Workspace or Workforce Optimization. The Clone Page action is not available in the Global scope.

- Add or edit containers in the page.
- Add or edit visualizations for each container.
- Edit the layout of a page or container.

Procedure
1. Navigate to Workspace Experience > Administration > Landing Pages.
2. Click the CSM Landing Page.
3. Click Clone Page.

  Note: The Clone Page action is available when the application scope is CSM workspace.
4. Fill out the form.

The settings in the **Layout** and **Available Child Slots** fields determine how the content renders on the page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of your landing page.</td>
</tr>
<tr>
<td>Component</td>
<td>The component defaults to sn-page and is read-only.</td>
</tr>
<tr>
<td>Order</td>
<td>The order for the landing page. If you have multiple landing pages, the order determines the landing page precedence. Pages with a lower-order value take precedence over pages with a higher-order value.</td>
</tr>
<tr>
<td>Active</td>
<td>Determines whether the landing page is active. Enable for a landing page to be displayed.</td>
</tr>
<tr>
<td>Optional Page Title</td>
<td>A title to display on the page.</td>
</tr>
<tr>
<td>Available Child Slots</td>
<td>A predefined style of child slots.</td>
</tr>
<tr>
<td>Layout</td>
<td>The layout of the columns on the page.</td>
</tr>
</tbody>
</table>

5. Click **Update** to save your landing page.

6. **Optional:** Configure permissions for users to access the landing page.

   a. Click the **UX Page Element Permissions** related list.

   b. Click **New**.

   c. Select the role or group for the landing page to be visible.

   d. Click **Submit** to save your permissions.

   Any page element (including sub elements) can have a restriction to a given set of roles or groups. If there are no element permissions set on roles or groups, then all users see the element. If there are some element permissions set, then a user needs just one role or group assignment to see the element.

7. Configure a container:
a. Click the **UX Page Elements** related list.

b. Click **New Container** or select an existing container.

c. Fill out the form.

### Container attributes and layout

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of your container.</td>
</tr>
<tr>
<td>Component</td>
<td>The component defaults to sn-page-container and is read-only.</td>
</tr>
<tr>
<td>Parent element</td>
<td>The landing page your container resides.</td>
</tr>
<tr>
<td>Slot</td>
<td>The component placement within the parent element's slot configuration.</td>
</tr>
<tr>
<td>Order</td>
<td>The order the page shows.</td>
</tr>
<tr>
<td>Border</td>
<td>Enable if you want a border around your container.</td>
</tr>
<tr>
<td>Optional Container Title</td>
<td>A title to display on the container.</td>
</tr>
<tr>
<td>Type</td>
<td>Select a type of styling for your visualization.</td>
</tr>
<tr>
<td>Available Child Slots</td>
<td>A predefined style of child slots.</td>
</tr>
<tr>
<td>Layout</td>
<td>The layout of the columns on the page.</td>
</tr>
</tbody>
</table>

8. Configure a widget:

a. Click **New Visualization** or select an existing widget.

b. Fill out the form.

### Widget attributes and layout

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of your widget.</td>
</tr>
<tr>
<td>Component</td>
<td>The component defaults to sn-page-widget-visualization and is read-only.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Parent element</td>
<td>The container that your widget resides in.</td>
</tr>
<tr>
<td>Slot</td>
<td>The component placement within the parent element’s slot configuration.</td>
</tr>
<tr>
<td>Order</td>
<td>The order the component shows.</td>
</tr>
</tbody>
</table>
| Report                | Select the report you want to render:  
  • Single score  
  • Trend by  
  • List  

  Note: Choose and populate either Report or PA Widget, but you cannot display both.                                                                                                      |
| PA Widget             | Select the PA widget you want to render:  
  • Single score  
  • Time series  

  Note: Choose and populate either Report or PA Widget, but you cannot display both.                                                                                                      |
| Optional Widget Label | A label to display on the widget.                                                                                                                                                                           |
| Size Variant          | Select the size of the widget. Choices include:  
  • Small  
  • Medium  
  • Large  
  • Extra Large  

  Note: Not all size variants apply to all widgets.                                                                                                                                                                      |
| Border                | Check if you want a border around your widget.                                                                                                                                                              |
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh Interval</td>
<td>Determines the number of minutes before a widget refreshes with new data. The interval begins when a user navigates away from a landing page, and ends when the user comes back to the landing page.</td>
</tr>
<tr>
<td></td>
<td>Note: There is no auto-refresh, but a user can click a refresh button at any time.</td>
</tr>
<tr>
<td>Additional Details</td>
<td>Any additional information to note about the widget.</td>
</tr>
<tr>
<td>Visualization SysID [Read Only]</td>
<td>Designated ID for the widget.</td>
</tr>
<tr>
<td>Report Type [Read Only]</td>
<td>The type of report that renders.</td>
</tr>
</tbody>
</table>

9. Click **Update** or **Submit** to save changes to the page element.

10. Click **Update** to save changes to the landing page.

**Set the default landing page**

You can set a default landing page to surface the information that is most relevant for your business.

**Before you begin**

Role required: sn_mgr_workspace.admin

**Procedure**

1. Navigate to **Workspace Experience > Administration > All Workspaces**.
2. Click **Manager Workspace**.
3. Drag and drop the PA indicators or containers.
4. Set the refresh rate interval for the reports or indicators.
5. In the Landing Pages related list, set the value of the **Order** field of the landing page that you want to set as the default to minimum.

   **Note:** The landing page with the minimum order value is considered to be the default landing page.
6. Optional: Verify the default landing page assignment by navigating to
Workspace Experience > Administration > Landing Pages
Ensure the landing page that you want to set default has the minimum Order value.

Configuring filters for Manager Workspace

Configure filters for scheduling and coaching applications and use the default filter for channel management to refine your search results.

Before you begin
Role required: sn_mgr_workspace.admin

About this task
View and analyze data in scheduling and coaching applications based on the filters configured. You can only use the default filters for channel management and cannot configure new filters.

Procedure
2. Click New.
3. On the form, fill in the fields.

Filter Configuration form

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter Name</td>
<td>Unique name for the filter configuration.</td>
</tr>
<tr>
<td>Table</td>
<td>Table for which the filter is configured.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can filter only on specific tables or database views for each module.</td>
</tr>
<tr>
<td></td>
<td>Refer to Filter Configuration Tables in Manager Workspace for a list of tables and database views you can use for each application.</td>
</tr>
<tr>
<td>Field</td>
<td>Field on which to filter.</td>
</tr>
<tr>
<td>Filter Query</td>
<td>Query to narrow down the filter options.</td>
</tr>
<tr>
<td>Type</td>
<td>• <strong>Choice:</strong> choice type field.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Reference:</strong> reference type field.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Order</td>
<td>Filter display order in Manager Workspace.</td>
</tr>
<tr>
<td>Workspace Module</td>
<td>Workforce Optimization for Customer Service module that displays the filter configuration.</td>
</tr>
<tr>
<td>Active</td>
<td>Enables the filter configuration in Manager Workspace.</td>
</tr>
</tbody>
</table>

4. Click Submit.

Setting up service channels and queues

You can set up service channels, queues, and key performance indicators (KPIs) to route work items automatically to agents based on an agent's availability, capacity, and skills.

With Workforce Optimization for Customer Service, you, as a channel administrator, can set up service channels and work item queues so that managers can view the real-time operational metrics for the work that is being done by their teams and the specific items that their teams are working on. You can also configure real-time refresh intervals for the metrics and lists so that managers can always see the latest information about their teams.

Configure filters to refine the search and view targeted results. Filters are persisted across all channel management pages in the session. To view a list of the default interactive filters and the KPI reports for channels, queues, agents, and groups that you can map to the interactive filters, see Interactive Filters under the Channel Management section. By default, the assignment group filter is applied to all lists and groups that you manage. You can disable interactive filters by using the `sn_channel_mgmt.filter_config.enable` property.

Add service channels and queues

Add service channels and queues to automatically route incoming work items to agents.

Before you begin
Role required: sn_channel_mgmt.admin

About this task
A service channel is a means of assigning a specific type of work items to agents. You can modify the existing service channels or create your own custom service channel.
Procedure
1. To create a service channel, do the following:
   b. Click New and see Create a service channel to create the service channel.
   c. Click Submit.
      The service channel is created.
2. To create a queue, do the following:
   a. Navigate to Workforce Optimization for Customer Service > Channel Management > Queues or select the service channel and click the Queues tab.
   b. Click New and see Create a work item queue to create the queue.
      The queue is created in the service channel.

Create assignment rules and groups
Define agent assignment rules and specify groups of agents who are eligible to receive overflow work assignments for a queue.

Before you begin
You must first create a new assignment rule before you create a service channel. For more information, see create a service channel. Use Advanced Work Assignment (AWA) to route work items automatically to agents based on an agent's availability, capacity, and skills.

Role required: sn_channel_mgmt.admin

About this task
An eligible assignment group can consist of one or more groups of agents available to work on items in the queue.

Procedure
1. Navigate to Workforce Optimization for Customer Service > Channel Management > Queues.
2. Click the queue to which you want to define an assignment rule.
3. In the Assignment Eligibility tab, click New.
4. On the form, fill in the fields.
### Assignment Eligibility form

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent assignment rule</td>
<td>Name of the rule that determines how work items are to be assigned. Select an assignment rule from the list.</td>
</tr>
<tr>
<td>Eligible at</td>
<td>Length of time in seconds before AWA considers the next set of agents for assignment.</td>
</tr>
<tr>
<td>Groups</td>
<td>Groups that are eligible for assignment.</td>
</tr>
<tr>
<td></td>
<td>• Click the lock icon to unlock it and select the agent groups in the eligible assignment pool.</td>
</tr>
<tr>
<td></td>
<td>• Click the icon to lock it.</td>
</tr>
</tbody>
</table>

5. Click **Submit**. The Queues [awa_queues] table is updated with the eligible assignment group.

### Configure KPIs for service channels

Configure key performance indicators (KPIs) in service channels to your managers’ teams to track the ongoing work and real-time performance of teams.

**Before you begin**

Role required: sn_channel_mgmt.admin

**About this task**

Add the channel Management reports that are by default configured with Workforce Optimization for Customer Service or create a new KPI report that matters the most to you. Key performance indicators help managers perform the following actions:

- Review real-time performance as the team is actively working on tasks across channels and queues.
- Track progress against KPIs and drill down into agents, team, and individual performance.
• Drill down into all queues and monitor ongoing cases, interactions, and tasks.
• Jump in and support agents for help-requested work items using chat whisper or add work notes to a task.
• Refine data in the dashboard using the Assignment Group interactive filter without modifying the reports. For more information, see Interactive Filters.

The KPI scores are automatically refreshed at an interval of five seconds. However, you can modify the refresh interval by adding the `sn_channel_mgmt.kpi_auto_refresh.interval.seconds` property or choose to not automatically refresh using the `sn_channel_mgmt.channels_card_auto_refresh.enable` property. You can also refresh the service channel cards manually by clicking the refresh (🔄) icon.

**Procedure**

1. Navigate to Workforce Optimization for Customer Service > Channel Management > Service Channels.
2. Click the service channel to which you want to add KPIs.
3. In the Reports tab, click Edit.
4. Select and add the Channel Management reports that are by default configured with Workforce Optimization for Customer Service.

   👌 **Note:** Review the report's definition and add the corresponding filters that are applicable to the service channel that matters the most to you.

5. Click Save.

6. **Optional:** To create a KPI report that is explicitly applicable to your teams, do the following:

   a. Navigate to Reports > Create New.

   b. Fill in the details. For more information, see Create a single score report.

   c. Click Save.

      The KPI report is created.

   d. Navigate to Reports > Administration > Interactive Filters.

   e. Click Channel Management Groups Filter.
f. Select the Interactive filter references related list and click **New**.  
The Interactive Filter Reference - Channel Management Groups Filter page appears.

g. Select the KPI report's table name and field name. For more information, see [Create a reference field interactive filter](#).

h. Click **Submit**.

i. Repeat steps 1 to 4 for each KPI report to be added in the service channel.

• KPI reports are added with an **Order** being shown as 100, 200 and so on. You can also change the order of a KPI report during selection.

• By default, the report name is considered as the **Display Name**. However, you can change the display name per your business needs.

**Results**
The KPIs are added to the service channel and appear in the Channels page. The first five KPIs with the lowest order number appear in the service channel cards.

**Configure KPIs for queues**
Configure key performance indicators (KPIs) for queues so that you can track the incoming work by category in a service channel.

**Before you begin**
Role required: sn_channel_mgmt.admin

**Procedure**
1. To add KPIs to a queue, do one of the following:

<table>
<thead>
<tr>
<th>To Add from a service channel</th>
<th>Do This</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>a. Navigate to <strong>Workforce Optimization for Customer Service &gt; Channel Management &gt; Service Channel</strong>.</td>
</tr>
<tr>
<td></td>
<td>b. Select a service channel.</td>
</tr>
<tr>
<td></td>
<td>c. Click the <strong>Queue</strong> tab.</td>
</tr>
<tr>
<td></td>
<td>d. Select a queue.</td>
</tr>
<tr>
<td>To Add from a queue</td>
<td>Do This</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------</td>
</tr>
<tr>
<td></td>
<td>a. Navigate to <strong>Workforce Optimization for Customer Service</strong> &gt; Channel Management &gt; Queues.</td>
</tr>
<tr>
<td></td>
<td>b. Select a queue.</td>
</tr>
</tbody>
</table>

2. In the **Reports** tab, click **Edit**.

   - **Note**: You may have to configure the related list to display the **Reports** tab.

3. Add the **Channel Management reports** that are by default configured with Workforce Optimization for Customer Service.

   - **Note**: Review the report’s definition and add the corresponding filters applicable to the service channel that matter the most to you.

4. Click **Save**.

5. **Optional**: To create a KPI report that is explicitly applicable to your teams, do the following:

   a. Navigate to **Reports** > **Create New**.

   b. Fill in the details. For more information, see Create a single score report.

   c. Click **Save**.
      The KPI report is created.

   d. Navigate to **Reports** > **Administration** > **Interactive Filters**.

   e. Click **Channel Management Queues Filter**.

   f. Select the Interactive filter references related list and click **New**.
      The Interactive Filter Reference - Channel Management Queues Filter page appears.

   g. Select the KPI report's table name and field name. For more information, see Create a reference field interactive filter.

   h. Click **Submit**.

   i. Repeat steps 1 to 4 for each KPI report to be added in the queue.
Results
The key performance indicators are added to the queue and appear in the All Queues tab in the Channels page. By default, the KPI scores are automatically refreshed at an interval of five seconds. However, you can modify the refresh interval by adding the sn_channel_mgmt.kpi_auto_refresh.interval.seconds property.

Configure KPIs for agents
Configure key performance indicators (KPIs) in service channels for your agents so that you can track the agents’ ongoing work and real-time performance.

Before you begin
Role required: sn_channel_mgmt.admin

About this task
Add key performance indicators to channels to help managers perform the following actions:

• Review real-time performance of agents who are actively working on tasks across channels and queues.
• Track progress against KPIs and drill down into agents and individual performance.

The KPI scores are automatically refreshed at an interval of 30 seconds. However, you can modify the refresh interval by adding the sn_channel_mgmt.kpi_auto_refresh.interval.seconds property. You can also refresh the service channel cards manually by clicking the refresh (⟳) icon.

Procedure
1. Navigate to Workforce Optimization for Customer Service > Channel Management.
2. Click the service channel that you want to add KPIs to.
3. Click the Agents Reports related list.
4. Add the Reports for Agents in Channel Management that are by default configured with Workforce Optimization for Customer Service.
   
   Note: Review the report’s definition and add the corresponding filters that are applicable to the service channel that matters the most to you.
5. Click Save.
6. Optional: To create a KPI report that is explicitly applicable to your teams, do the following:
a. Navigate to Reports > Create New.

b. Fill in the details. For more information, see Create a single score report.

c. Click Save.
The KPI report is created.

d. Navigate to Reports > Administration > Interactive Filters.

e. Click Channel Management Agent Filter.

f. Select the Interactive filter references related list and click New.
The Interactive Filter Reference - Channel Management Agent Filter page appears.

g. Select the KPI report's table name and field name. For more information, see Create a reference field interactive filter.

h. Click Submit.

i. Repeat steps 1 to 4 for each KPI report to be added in the service channel.

• KPI reports are added with an Order being shown as 100, 200, and so on. You can also change the order of a KPI report during selection.

• By default, the report name is considered as the Display Name. However, you can change the display name per the business needs.

Results
The KPIs that are configured in the service channel appear in the Current Work section of the agent's Overview page. For more information, see Track and analyze agents’ performance.

Configure supervisor lists for service channels
Configure supervisor lists in a service channel to view the list of active work items across service channels and queues.

Before you begin
Role required: sn_channel_mgmt.admin
About this task
A database view that defines table joins is used for generating reports for a supervisor list. For example, you can create a database view that can join the Case table to the Interaction and Metric tables. When you use this database view, and create a supervisor list to report on the active work items, you may include fields from any of these three tables. For more information, see Database views.

⚠️ Note: You can configure three supervisor lists for each service channel. The first three lists with the lowest order number appear in Channel Management.

Procedure
1. Navigate to Workforce Optimization for Customer Service > Channel Management > Service Channels.
2. Select the service channel to which you want to add a supervisor list.
3. Click the Supervisor Lists tab.
4. Click New.
5. On the form, fill in the fields.

**Supervisor Lists form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>List Title</td>
<td>Display name for the list.</td>
</tr>
<tr>
<td>Tab Title</td>
<td>Title for the tab that appears in the manager workspace.</td>
</tr>
<tr>
<td>Service Channel</td>
<td>Service channel in which the list appears.</td>
</tr>
<tr>
<td>View Name</td>
<td>Database view for the service channel.</td>
</tr>
<tr>
<td>Order</td>
<td>Number that displays the order.</td>
</tr>
</tbody>
</table>
### Results

The supervisor list is added to the service channels and appears in Channel Management.

<table>
<thead>
<tr>
<th>Number</th>
<th>Help Requested</th>
<th>Opened for</th>
<th>Assigned to</th>
<th>Assignment group</th>
<th>Wait time</th>
<th>Short description</th>
<th>Updated</th>
</tr>
</thead>
<tbody>
<tr>
<td>123456</td>
<td>John Doe</td>
<td>Nancy</td>
<td>Sales</td>
<td>Sales Support</td>
<td>7 Seconds</td>
<td></td>
<td>2023-04-15</td>
</tr>
<tr>
<td>234567</td>
<td>Jane Smith</td>
<td>Peter</td>
<td>Marketing</td>
<td>Marketing Support</td>
<td>5 Seconds</td>
<td></td>
<td>2023-04-16</td>
</tr>
<tr>
<td>345678</td>
<td>William Brown</td>
<td>Jennifer</td>
<td>Operations</td>
<td>Operations Support</td>
<td>3 Seconds</td>
<td></td>
<td>2023-04-17</td>
</tr>
</tbody>
</table>

### Use extension points to configure the sort order

Use scripted extension points to configure the sort order for the columns in the All Agents and All Queues lists for Channel Management.

### Before you begin

**Role required:** admin

### About this task

Use the `sn_channel_mgmt.ChannelMgmtExtensionPoint` extension point and create an implementation to configure the sorting mechanism for the All Agents and All Queues lists in Channel Management. You can create multiple implementations; however, the implementation with the lowest order number is executed.

### Procedure

1. Navigate to **System Extension Points > Scripted Extension Points**.
2. Search for `sn_channel_mgmt.ChannelMgmtExtensionPoint`.
3. On the form banner, click the link **here** to edit the record.
4. Click **Create Implementation** in the related links to create your sorting mechanism extension point script.
5. Add or modify the columns and sort directions in the `vardata` section.
6. Click **Update**.

**Results**
The sorting mechanism is applied to the defined columns in the All Queues and All Agents lists in Channel Management.

**Example:**
The Presence State column with **ASC** as a sort direction in the extension script displays the Presence State records in an ascending order in the All Agents list. For more information, see *Track and analyze agents' performance*.

**Schedule a daily report**
Generate and distribute a daily scheduled report that summarizes the agent's work performance via email.

**Before you begin**
Role required: sn_channel_mgmt.admin

**About this task**
The scheduled job **Send Daily Agents Report** executes the event **sn_channel_mgmt.agents_report**, which then triggers the **Daily Agents Report** notification. Next, the notification **Daily Agents Report** executes an email script **daily_agents_reports** to send an email to all managers. To change the existing report, modify the **daily_agents_reports** email script.

**Procedure**
1. Navigate to **System Definition > Scheduled Jobs**.
2. Click **Send Daily Agents Report**.
   The scheduled script **Send Daily Agents Report** form appears.
3. Click **Active**.
4. In the **Run** field, ensure that the option **Daily** is selected.
The script, by default, sends the agents' work summary report daily to the managers.

5. Select the **Time zone**.

6. Click **Update** to update the scheduled job or **Execute Now** to execute the scheduled script immediately.

**Results**

All managers and additional managers of the teams receive an email notification that summarizes their agents' performance.

**Setting up Scheduling in Workforce Optimization for Customer Service**

Manage events using the team calendar. Create different types of event categories. Use scripted extension points to customize event types.

**Configure event categories for Manager Workspace**

Add an event category. Create or update field configurations for events. You can also specify if an event category must be excluded when the shift coverage for agents are calculated.

**Before you begin**

Role required: sn_shift_planning.admin

The following event category configurations are available by default:

- Work
- Meeting
- Training
- Time Off
- Break

**Procedure**

1. Navigate to **Workforce Optimization for Customer Service > Scheduling > Event Categories**.

2. In the **Event Categories** list, click **New**.

3. In the **Name** field, enter a name for the event category.

4. If you want to exclude this event category for agent coverage calculation, enable the **Exclude from coverage** check box.

5. In the **Event field configuration** dialog box, edit the following configuration as necessary:
Note: You can remove any property that does not apply to a type of event.

```json
{
    "create": {  // Creates an event type form
        "attendees": {  // Adds the Attendees field
            "mandatory": true,  // Sets this field as mandatory
            "readOnly": false,  // Sets this field as read-only
            "allowAllUsers": false  // Allows you to only add users managed by the logged-in user; to add any user, set this value to true
        },
        "startDate": {
            "mandatory": true,
            "readOnly": false
        },
        "endDate": {
            "mandatory": true,
            "readOnly": false
        },
        "additionalSelectors": []  // Add custom fields to the form
    },
    "edit": {  // Edit an event type form
        "attendees": {
            "mandatory": true,
            "readOnly": false,
            "allowAllUsers": false
        },
        "startDate": {
            "mandatory": true,
            "readOnly": false
        }
    }
}
```
Create event types to display them on the team calendar

Create multiple events from the same category and add them to the team calendar.

Before you begin
Role required: sn_shift_planning.admin

Procedure

1. Navigate to Workforce Optimization for Customer Service > Scheduling > Event Types.
2. Click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the event type.</td>
</tr>
<tr>
<td>Priority Order</td>
<td>Priority of the event type that you want to exclude from the coverage. The higher the number means the higher the priority. For example, let's say you are attending a work event for four hours in a day. You have marked that time window as both a time off and as a meeting event type. If time off has a higher priority, it will be excluded from the coverage.</td>
</tr>
</tbody>
</table>
### Configure properties for schedule adherence and conformance

Configure schedule adherence properties to calculate the adherence and conformance of your agents so that you can improve the operational efficiency of your organization.

**Before you begin**

Role required: admin

**About this task**

The threshold settings for adherence and conformance indicate how many minutes early or late an agent can clock in or clock out to a scheduled work shift without being considered as non-adherent.

**Procedure**

1. Navigate to **Workforce Optimization for Customer Service > Schedule Adherence > Settings**

2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Enable Schedule Adherence</strong></td>
<td>Calculation and information about the agents' adherence to the schedules.</td>
</tr>
<tr>
<td><strong>Threshold for early checkin for planned shift (in Minutes)</strong></td>
<td>Time that you can set for early check in. This time is the acceptable time for an agent to start the work shift before the actual shift time. The default value is 60 minutes. For example, if an agent's planned work shift is 8 a.m. to 5 p.m. and the agent clocks in at 7 a.m., the threshold time allows flexibility and the agent is not considered as a non-adherent agent.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Threshold for adherence% of Time Worked Summary</td>
<td>Percentage that you can set for a threshold in adherence. The agents who do not qualify to be above the defined threshold value (70%) are considered non-adherent agents.</td>
</tr>
<tr>
<td>Lower threshold conformance % of Time Worked Summary</td>
<td>Lower threshold percentage that you can set for flexibility in conformance. The agents who do not qualify for the defined lower and upper conformance threshold values (80-120) are considered as non-conformant agents. The default value is 80%.</td>
</tr>
<tr>
<td>Upper threshold for conformance % of Time Worked Summary</td>
<td>Upper threshold percentage that you can set for flexibility in conformance. The agents who do not qualify for the defined lower and upper conformance threshold values (80-120) are considered as non-conformant agents. The default value is 120%.</td>
</tr>
<tr>
<td>Default threshold time for clock-out event generation (in Minutes)</td>
<td>Default threshold time to generate an automatic clock-out event if an agent fails to clock out. The default value is 60 minutes. For example, if an agent’s planned work shift is 8 a.m. to 5 p.m. and the agent fails to clock out at 5 p.m., the system waits for 60 minutes as the threshold time and generates an automatic clock-out event.</td>
</tr>
</tbody>
</table>

3. Click **Save**.

**Related information**

- Scheduling in Workforce Optimization for Customer Service
- Monitor schedule adherence of your agents
- Analyze adherence and conformance from the time worked summary

**Modify schedule adherence and conformance formulas by using extension points**

Configure and tweak the schedule adherence and conformance formulas using scripted extension points so that you can customize them for your organization.

**Before you begin**

Role required: admin
About this task
Use the `sn_shift_planning.ScheduleAdherenceExtPt` extension point and create an implementation to configure the formulas. You can create multiple implementations. However, the implementation with the lowest order number is executed.

Procedure
1. Navigate to System Extension Points > Scripted Extension Points.
3. On the form banner, click the link here to edit the record.
4. To create your extension point script, click Create Implementation in the related links.
5. Modify the formulas for calculating the schedule adherence and conformance in the `getAdherencePercentage` and `getConformancePercentage` methods.

```javascript
var ScheduleAdherenceExtPtImp = Class.create();
ScheduleAdherenceExtPtImp.prototype = {
  initialize: function() {
  },
  getAdherencePercentage: function(plannedTime, timeNotWorked, availableNonPlannedTime, totalTimeWorked) {
    var adherencePercentage = ((plannedTime - timeNotWorked) / (plannedTime + availableNonPlannedTime)) * 100;
    return adherencePercentage;
  },
  getConformancePercentage: function(plannedTime, timeNotWorked, availableNonPlannedTime, totalTimeWorked) {
    var conformancePercentage = (totalTimeWorked / plannedTime) * 100;
    return conformancePercentage;
  },
  type: 'ScheduleAdherenceExtPtImp'
};
```

6. Click Update.

Results
The schedule adherence and conformance calculations are based on the formulas in the implementation.

Event type extension points in Workforce Optimization for Customer Service
Use extension points to call scripts for event categories such as meeting, time off, or work time.

To see a list of extension points that you can use for Workforce Optimization for Customer Service, navigate to System Extension Points > Scripted Extension Points. In the Extension Points list, open the `sn_shift_planning.EventManager` extension point.
Use scripted extension points to integrate customizations without altering the core components in the application code. When customizing a base application, you implement the scripted extension points by creating the custom script includes and registering them against the scripted extension points.

**Extension points for event types**

<table>
<thead>
<tr>
<th>Extension point name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_shift_planning.EventManager</td>
<td>Implement this extension point to customize the logic for the event categories that you create.</td>
</tr>
</tbody>
</table>

You can use extension points to create events such as meeting, training, and time-off requests. For example extension point implementations, see the following extension instances in the Implementations related list:

<table>
<thead>
<tr>
<th>Category</th>
<th>Extension Script</th>
</tr>
</thead>
<tbody>
<tr>
<td>Meeting</td>
<td>AgentScheduleMeetingEventManager</td>
</tr>
<tr>
<td>Break</td>
<td>AgentScheduleBreakEventManager</td>
</tr>
<tr>
<td>Training</td>
<td>AgentScheduleTrainingEventManager</td>
</tr>
<tr>
<td>Time off</td>
<td>AgentScheduleTimeOffEventManager</td>
</tr>
<tr>
<td>Work</td>
<td>AgentScheduleWorkEventManager</td>
</tr>
</tbody>
</table>

**Related information**

Using extension points to extend application functionality

**Setting up Teams Workforce Optimization for Customer Service**

Organize your teams into assignment groups and create reports for those groups so that you can gain visibility into the team’s performance.

As an administrator, you can configure KPIs as well as child KPIs. The child KPIs appear when you drill-down into top level KPIs. For example, Closed Cases KPI has P1 Cases, P2 Cases as child KPIs.

**Create KPI groups to monitor team performance**

Create key performance indicator (KPI) groups with the KPIs that matter most to your teams. When you associate your KPI groups with assignment groups, you can monitor your team’s performance.
Before you begin
Role required: sn_team_perf.team_performance_admin

About this task
By default, the KPIs that are associated with your KPI assignment groups are scheduled to collect data daily. The KPIs must have the following indicator breakdown:

• Assignment groups
• Assigned to

Procedure
1. Create a KPI group.
   b. Click New.
   c. In the Name field, enter a name for the KPI group.
   d. In the Type menu, select Teams.
   e. Right-click the form header and click Save.
      You can add up to five KPIs to a KPI group. For more information about KPIs and how the aggregates are calculated, see the overview video in the Teams example section.

2. Add KPIs to a KPI group.
   a. In the KPIs related list, click New.
   b. In the KPI field, select the KPI to apply for this group.
   c. Click Submit.

3. Add KPI assignment groups to the KPI group.

   Note:
   • You can associate a KPI assignment group only to one KPI type.
   • You can add additional managers to each assignment group.
   • You can associate a user with a KPI group as the primary assignment group for that user.
a. In the **Assignment Groups** tab, click **Edit**.

b. Move the desired assignment groups from the Collection to the Assignment Groups list.

c. Click **Save**.

**Add managers to a KPI assignment group**

Assign one or more managers to each KPI assignment group so that they can gain visibility into the group and monitor the team's performance.

**Before you begin**

Role required: sn_wfo_admin or admin

**About this task**

You can associate a user with a primary assignment group by selecting the group in the user record.

**Procedure**

1. Navigate to **Workforce Optimization > Additional Managers**.

2. Click **New**.

3. In the **Assignment Group** field, select an assignment group.

4. In the **Manager** field, select a manager you want to add for this assignment group.

5. Click **Submit**.

**What to do next**

Analyze the performance trends for your teams.

**Setting up skill prediction in Workforce Optimization for Customer Service**

Collect skill data based on skills agents have used for case resolution. Use supervised learning to recommend these skills for agents to resolve similar open case. You can also find patterns in how skills are used for case resolution and use unsupervised learning to recommend skills for agents.

**Before you begin**

Set up skills. For more information, see **Skills Management**.

Predictive Intelligence must be set up and configured on your instance to train the models. For more information, see **Predictive Intelligence**.
Activate the Skill Recommendation application plugin (com.snc.sre) to use predictive intelligence for recommending skills.

Role required: sn_sre.admin

Procedure

1. Configure the properties for the Skill Recommendation application.

2. Run the solution definition models such as **Recommend similar skills for cases** or **Recommend skills from similar cases** to train the supervised and unsupervised solutions. For more information on training a solution, refer to Create and train a similarity solution.

3. Run the **Start skill prediction** scheduled job everyday to start predicting skills for cases or agents.
   This scheduled job is inactive by default. When you activate it, the job runs daily at 1:00 AM on all cases resolved the previous day. The job then adds the skills to the User Predicted Skill [sn_sre_user_predicted_skill] table and Task Predicted Skill [sn_sre_task_predicted_skill] table.

   **Note:** Recommended skills will start appearing once the number of records in [sn_sre_task_predicted_skill] table exceeds the value defined in the [sn_sre.user_predicted_skill_threshold] Properties.

Use extension points for skill prediction

Use scripted extension points to customize skill prediction for tasks.

Before you begin

The Skill Recommendation extension point is included with the Skill Recommendation (com.snc.sre) plugin.

Role required: admin

About this task

You can create multiple implementations for each extension point and provide an order number for each implementation. The implementation that has the lowest order number is executed.

Procedure

1. Navigate to **System Extension Points > Client Extension Points**.

2. From the Extension Points list, select **Skill Recommendation (sn_sre.SkillPredictionAPI)**.

3. Do one of the following:
• To create a new skill recommendation implementation, click **Create Implementation**.

• To modify an existing implementation, from the **Implementations** related list, select a class.

4. Modify the script as required.

5. Click **Update**.

### Setting up Demand Forecast in Workforce Optimization for Customer Service

Configure the data you want to collect, modify forecast parameters and calibrate manual adjustments using Demand Forecast.

#### Configure the data collection to forecast the demand for resources

Define the data you want to collect for cases, interactions, or any table to forecast the number of agents that you require for your staffing needs.

**Before you begin**

You must have the MetricBase plugin [com.snc.clotho] enabled to use Demand Forecast in Workforce Optimization for Customer Service. For more information, see [Requesting the MetricBase product](#).

**Note:**

- When you change the forecast parameters or resource conversion formula, the new values for resource forecasts will not reflect on the team calendar until the **Forecast resources for future** scheduled job is executed. Your administrator can run the scheduled job on-demand to view the changes in the team calendar.

- Once the **Historical data collection** job is run for specific data collection definitions, the flag is set to true. Hence, the historical data collection will not run even if you add data for the past dates from the back-end.

Role required: sn_agent_forecast.admin

**Procedure**

1. Navigate to **Workforce Optimization for Customer Service > Demand Forecast**

2. Define the data you want to collect for forecasting agents to resolve cases.

   a. Click **Data Collection Definitions**.

   See the **Forecast Configuration table in Scheduling** for the list of configurations that are available by default.
b. Click **New**.

c. On the form, fill in the fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the collection forecast configuration.</td>
</tr>
<tr>
<td>Type</td>
<td>Data Collection Definition type is set to <strong>Collection</strong> by default and collects data using a scheduled job.</td>
</tr>
<tr>
<td>Table</td>
<td>Table that is used for collecting data.</td>
</tr>
<tr>
<td></td>
<td>From the list, do one of the following:</td>
</tr>
<tr>
<td></td>
<td>• To collect data to forecast cases, select <strong>Cases</strong>.</td>
</tr>
<tr>
<td></td>
<td>• To collect data to forecast interactions, select <strong>Interactions</strong>.</td>
</tr>
<tr>
<td>Condition</td>
<td>Conditions that you can set so that you can capture the data that you need.</td>
</tr>
<tr>
<td>Date Field</td>
<td>Data that you can add to forecast for the future.</td>
</tr>
</tbody>
</table>

d. Click **Submit**.

e. Create an index for the table you have created using the date field and the conditions you have added to the table. For information on creating a table index, see [Create a table index](#).

3. Add parameters to be defined in the formula to calculate agent count per hour in a day.

a. Click **Formula Parameters**.

b. In the **Name** field, enter a name for the parameter.

c. Do one of the following:

   • If you need to add a value to be calculated for the formula, in the **Value** field, enter the value.

   • If you want to use the performance analytics score card API or a custom API, click **Advanced**, and add the script.

The Average Case Work Time and Average Chat Work Time forecast parameters provided by default are examples of how you can use scripts to add the parameters. For a list of parameters provided by default, see [Forecast Parameters in Scheduling](#).

d. Click **Submit**.

4. Configure the resource conversion formula.
a. Click Resource Conversion Formula.

b. Click New.

c. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the resource forecast configuration.</td>
</tr>
<tr>
<td>Type</td>
<td>Type is set to Resource Conversion Formula.</td>
</tr>
<tr>
<td>Formula</td>
<td>Formula to calculate the forecasted number of agents that you need.</td>
</tr>
</tbody>
</table>

In the Related Links section, do the following:

- Click Browse Forecast Configuration, select the forecast configuration to add to the formula and click Add.
- Click the Browse Forecast Parameter, select the forecast parameter to add to the formula and click Add.

Note: FC refers to Forecast Configuration and FP refers to Forecast Parameter.

d. Click Submit.

5. Associate an assignment group with a Resource Conversion Formula.

You can assign a forecast configuration to multiple assignment groups, but an assignment group can have only one forecast configuration.

a. Click Group Forecast Configurations.

b. Click New and do the following:

- In the Assignment Group field, click the search icon and select the group to which you want to associate a forecast configuration.
- In the Forecast Configuration field, click the search icon and select a Resource Conversion Formula.

What to do next

Run the Collect historical data for automated forecast configurations scheduled job. For more information, see Schedule jobs for Demand Forecast.

Related information

Use Demand Forecast
Modify forecast parameters to visualize forecast data

Configure and tweak forecast parameters to see how the forecast behaves when you vary the period length, periods to forecast, or algorithm. You can view the modified forecast on the time-series visualization.

Before you begin
Role required: sn_agent_forecast.admin and sn_wfo_csm.manager
The user with these roles must also be a manager of the assignment group that is associated with the resource conversion formula.

About this task
You can define the start and end dates for which you want to visualize the forecast data. The start date for a forecast configuration is based on the number of historical days you want to consider for data visualization. This is set using the \texttt{sn\_agent\_forecast.number\_of\_historical\_days\_in\_timeseries\_chart} system property.

The published forecast is reflected on the team calendar only when the Forecast resources for future job is executed.

The default start date is set to 90 days ago starting from the day before the current day. The end date is calculated based on the period length and the periods to forecast represented in days. For example, if the period length is 7 days and the periods to forecast is 5, then the end date is 35 days including the current day.

Procedure
2. Click the Schedule (📅) icon.
3. Click Forecasts.
4. Select the forecast model for which you want to view the time-series data. You can visualize each of the forecast parameters that were created for the forecast model.
5. Click the gear icon.
6. Click the plus (+) sign.
7. Configure the forecast parameter.
a. From the Period length unit list, select the unit for the length of the period to forecast.

b. In the Period length list, select the unit for the length of the period to forecast.

c. In the Periods to forecast field, enter the number of seasons, which is the period length, for which you want to forecast.

d. In the Algorithm field, select an algorithm you want to use to calculate the forecast.

e. Click Update.
The forecast is created in Draft state. The forecast is calculated and displays in the forecast model. You can analyze the forecast with the new forecast parameters before you publish it.

8. To preview a forecast before publishing it, click Preview. The forecast is calculated using the algorithm and parameters configured in the forecast parameter. When you create a manual adjustment to predict future resources, Demand Forecast overlays the adjustment in the time-series chart.

<table>
<thead>
<tr>
<th>When you</th>
<th>Then the forecast</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unpublish a published forecast</td>
<td>Become inactive.</td>
</tr>
<tr>
<td>Preview an inactive forecast parameter</td>
<td>Displays for the date range for which the forecast parameter was active.</td>
</tr>
<tr>
<td>Preview an active forecast</td>
<td>Displays the time-series data for the future time-period.</td>
</tr>
</tbody>
</table>

9. Publish the forecast parameters.

a. To publish a newly created forecast parameter, click Save and then click Publish.

b. To publish an active forecast parameter, click Publish.

Note: You can only have one forecast in Published state, which is used to calculate the resources.

When the forecast parameter is published:

- The state of the record changes to Published.
- The Forecast resources for future job runs daily and uses the published forecast parameters to calculate the agent forecast. The calculation uses the resource conversion formula to calculate the forecast data from the...
current point forward. You can view the updated resources in the team calendar.

- Any other forecast parameters that were created would be unpublished and inactive.

What to do next
Create a manual adjustment for a forecast

Create a manual adjustment for a forecast

Adjust forecasts manually to fine-tune them for greater accuracy. Create the adjustment for a specified time period and analyze how it impacts your forecast.

Before you begin
Role required: sn_agent_forecast.admin and sn_wfo_csm.manager

The user with these roles must also be a manager of the assignment group that is associated with the resource conversion formula.

Procedure

2. Click the Schedule ( lịch sử ) icon.
3. Click Forecasts.
4. Select the forecast model for which you want to make a manual adjustment.
5. Click the Manual Adjustments ( chỉnh sửa ) icon.
   a. Click the plus (+) sign.
   b. Fill in the following fields.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name for the manual adjustment.</td>
</tr>
<tr>
<td>Start Date Time</td>
<td>Date and time when the manual adjustment for the forecast must start.</td>
</tr>
<tr>
<td>End Date Time</td>
<td>Date and time when the manual adjustment for the forecast must end.</td>
</tr>
<tr>
<td>Adjustment Unit</td>
<td>Unit for the manual adjustment.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Field Name | Description
--- | ---
| **Available values:** |  
- **Percentage**—adjustment value percentage. For example, if the forecast data shows case count and if the adjustment value is 15, the manual adjustment shows a 15% increase in case count than the forecast data.
- **Number**—adjustment value count. For example, if the forecast data shows case count and if the adjustment value is 15, the manual adjustment shows 15 more cases than the forecast data.
| **Adjustment Value** | The numeric value for which you want to adjust the forecast. The value is applied to each group in the Groups [sys_user_groups] table. The manual adjustment visualization on the time-series chart displays the data for your groups. For example, let's assume that the value is 15 and the unit is number. On a given day, if you have two groups for a forecast model and both have 2 agents each before you do the manual overlay, when you enter the value as 15, it is applied to each of the two groups and the total value displays as 34. This is calculated as follows:
  - Two agents for group A + the adjustment value 15 = 17
  - Two agents for group B + the adjustment value 15 = 17
  The total is 34.

**c. Click Save.**
The manual adjustment is created in **Draft** state. The manual adjustment is calculated and displays as a green line in the forecast model. You can analyze or update the forecast with this manual adjustment before you publish it.

**7. Publish the manual adjustment.**

**a. Click the saved manual adjustment that you want to use for forecasting resources.**

**b. Click Publish.** The state changes to **Ready to Publish.**
When the Forecast resources for future job is run, it calculates the forecast, checks for manual adjustments, applies those values if any, and moves it to the Published state.

Note:
- When you unpublish a forecast, it moves to Draft state. You can delete a forecast that is in Draft state.
- If you want to end a manual adjustment after it has started and before its end date, you can click End Now. The forecast will no longer be used in the resource conversion formula.

When the manual adjustment is published:
- The state of the record changes to Published.
- The adjusted values will be used in the resource conversion formula and the demand forecast displayed on the calendar.
- Any other manual adjustment configurations that were created would be unpublished and moved to Draft state.

Using Workforce Optimization for Customer Service

Enhance the quality and efficiency of your teams using channel management capabilities, smart scheduling, team structure, and real-time refreshing single scores. Monitor chat conversations and help agents on cases. Assess the quality of tasks completed, recommend skills for agents, and train them to address skill gaps.

Workforce Optimization for Customer Service manager workspace landing page

Monitor your teams' work and organizational performance using Workforce Optimization for Customer Service.
End user and roles

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>As a workspace manager, you can:</td>
<td>sn_mgr_workspace.manager</td>
</tr>
<tr>
<td>• Analyze the cases your team is currently working on or cases that have not yet been assigned.</td>
<td></td>
</tr>
<tr>
<td>• Monitor cases with SLAs that have been breached, escalated, or the ones not been open since 30 days.</td>
<td></td>
</tr>
<tr>
<td>• Track team's work, chats, and work assignments to analyze the performance of your whole organization.</td>
<td></td>
</tr>
</tbody>
</table>

Use case

Monitor your agent’s work when you start your day, view reports that need your attention, and navigate to the cases on which you want to take action.

Indicators

**Cases closed**
Number of closed cases.

**Chats completed**
Number of chats completed.

**Breakdowns**
- Assignment Group

**Reports**

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Cases By State</td>
<td>Single score</td>
<td>Number of open cases based on the state such as new, on-hold, queued, work in progress, and pending accept.</td>
</tr>
<tr>
<td>Critical Open Cases</td>
<td>Single score</td>
<td>Top priority cases.</td>
</tr>
<tr>
<td>Unassigned Cases</td>
<td>Single score</td>
<td>Cases not assigned to agents.</td>
</tr>
<tr>
<td>Escalated Cases</td>
<td>Single score</td>
<td>Cases that are escalated to other agents.</td>
</tr>
<tr>
<td>SLA Breached</td>
<td>Single score</td>
<td>Cases that breached the service level agreement of your business.</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Open Cases not updated for 7 days</td>
<td>Single score</td>
<td>Cases that are not updated for the last 7 days.</td>
</tr>
<tr>
<td>Open Cases older than 30 days</td>
<td>Single score</td>
<td>Cases that are in open state for the last 30 days.</td>
</tr>
<tr>
<td>In-Progress Chats</td>
<td>Single score</td>
<td>Number of chats that are in progress with agents</td>
</tr>
<tr>
<td>Help requested interactions</td>
<td>Single score</td>
<td>Number of work items that requested help from manager</td>
</tr>
<tr>
<td>Agent Distribution by Presence State</td>
<td>Horizontal Bar</td>
<td>Current status of agents distributed on work assignments (Available, Lunch, and Offline).</td>
</tr>
<tr>
<td>Waiting Work Items</td>
<td>Single score</td>
<td>Number of work items in waiting state.</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Available Agents</td>
<td>Single score</td>
<td>Number of available agents.</td>
</tr>
<tr>
<td>Total open cases</td>
<td>Horizontal Bar</td>
<td>Number of cases categorized by state such as new, resolved, awaiting info, and open cases.</td>
</tr>
</tbody>
</table>

**Channel Management in Workforce Optimization for Customer Service**

Use Channel Management to keep a track of the real-time performance of work done by your team members through channels and queues views. You can also drill down into specific cases and chats and collaborate with your team members to achieve better results.

**Using Channel Management in Workforce Optimization for Customer Service**

Route work items to assigned groups using channels. Use skill-based routing to ensure that the right work goes to the right agent. Review real-time performance as your team is actively working on tasks across channels. When you see escalations, you can help your agents resolve issues without the requester being aware of it.

Monitor ongoing work and track your agents' performance of your direct reporting teams and teams that you manage additionally. Work items are allocated to qualified agents using work item queues, routing conditions, and assignment criteria that you define.

Review real-time performance as your team is actively working on tasks across channels in the following sections.

- The **Overview** section displays the most important key performance indicators (KPIs) for each of the service channels in the form of cards. The KPIs appear as per the configuration order in the service channels. The KPI scores are real-time information and automatically refreshed at a regular interval of 5 seconds or as configured in the `sn_channel_mgmt.kpi_auto_refresh.interval.seconds` system property. Also, you can refresh the service channel cards manually by clicking the 🔄 icon.
• **Assignment Group** refines reports on all pages of channels and queues as per the groups selected. Interactive filter based on the assignment group configuration, you can select the assignment group on which you want to refine the data directly from the dashboard. You can disable the **Assignment Group** interactive filter using the `sn_channel_mgmt.filter_config.enable` system property.

• The **Queued Work** tab displays the active work interactions being done within each service channel and queues.

• The **All Queues** tab displays the list of work items from queue-based routing. You can drill into specific queues and see the active interactions, work items and agents. Track real-time performance of your teams using key performance indicator reports in service channels and queues. Respond to incoming support requests by changing queues as per the priorities.

• The **All Agents** tab displays your agents’ ongoing work, presence statuses, channels, work load, and open capacity. You can drill into specific agents to view the agent’s profile, on-going tasks, presence state’s history, and override channel capacity.

**Note:**

• All lists display the real-time information and are automatically refreshed at a regular interval of 30 seconds or as set in the `sn_channel_mgmt.list_auto_refresh.interval.seconds` system property. You can also refresh the service channel cards manually by clicking the refresh icon.

• The **All Queues** and **All Agents** lists offer a default sorting and filtering mechanism that lets you to view the records of the selected fields based on a default sort order. Click a column heading to toggle between ascending and descending order. The sorting order turns to the default configuration as you leave the page. Administrator can customize the default sort order by creating an implementation using the extension points. For more information, see [Use extension points to configure the sort order](#).

• You will also receive an email notification of your agents’ work summary at the end of each day if a scheduled report is configured.

**Assist agents by joining their chat conversations with their end users**

Assist agents in real time by joining their chat conversation and collaborate on any record by connecting with the right people instantly to achieve faster resolution.
Before you begin
Role required: sn_wfo_csm.manager

About this task
View the work-in-progress chat interactions and see if any of the agents has set the Help Requested flag as Yes. You can then open the interaction record and view all messages exchanged between the end user and agent, gain the context and choose to join the conversation by either sending private messages or joining the conversation in public.

Procedure
2. Do one of the following:
   - Click the Help Requested indicator's score on the landing page.
   - Click the Channels icon, select a queue and then click the Queued Work tab.
   - In the Lists page, click Conversation Monitoring > Help Requested.
3. Click the interaction record for which you want to join the conversation.
4. Click Join Conversation to start an interaction with the agent or click Send Private Message to send a private message only to the agent.

Results
A chat conversation is established.

Track and analyze the queue health
Monitor your agents' workload and the status of their work items against each service channel and queue so that you can get an idea of how efficiently work is moving through the queue and to your agents.

Before you begin
Role required: sn_wfo_csm.manager

About this task
Track the real-time performance of each queue within your service channels. You can drill into specific queues so that you can see the real-time reports, waiting work items, available agents, and status of the on-going work. This information can give you an idea of how efficiently work moves through the queue and to your agents. With this information, you can determine which queues are doing well and which queues could use a few more agents on
board. For example, if you see lots of agents and not much work, you can recommend skills for your agents for other queues.

⚠️ Note:

• The records in the list appear based on the column’s default sort order. Click a column heading to toggle between ascending and descending order. The sorting order turns to the default configuration as you leave the page. For example, the **Available agents** column is by default in descending sort order. The administrator can change it to ascending order by creating an implementation using the `sn_channel_mgmt.ChannelMgmtExtensionPoint` extension point. For more information, see [Use extension points to configure the sort order](#).

• The records in the list refresh at a regular interval of 30 seconds. The administrator can change the interval using the `sn_channel_mgmt.list_auto_refresh.interval.seconds` property.

**Procedure**

1. Navigate to **Workforce Optimization for Customer Service > Manager Workspace**.

2. Click the Channels (📸) icon.

3. Click the **All Queues** tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Queue name that was used to assign and route the work to the agent. Click to view the work items and agents that are associated with the queue.</td>
</tr>
<tr>
<td>Service Channel</td>
<td>Service channel name to which the queue is categorized. Click to view the work items and agents that are associated with the channel.</td>
</tr>
<tr>
<td>Waiting work items</td>
<td>Number of waiting work items in the queue.</td>
</tr>
<tr>
<td>Average wait time</td>
<td>Average amount of time that the work items are waiting for an agent.</td>
</tr>
<tr>
<td>Available agents</td>
<td>Number of available agents.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Agents not available</td>
<td>Number of non-available agents.</td>
</tr>
<tr>
<td>Work items assigned today</td>
<td>Number of work items that were assigned on a particular day.</td>
</tr>
<tr>
<td>Work items canceled today</td>
<td>Number of work items that were canceled on a particular day.</td>
</tr>
</tbody>
</table>

Allocate work items manually to agents
Allocate pending work items to agents to complete the work.

Before you begin
Role required: sn_wfo_csm.manager
Ensure that the agent has the relevant skills, availability, and access to at least one queue in the service channel.

About this task
The active work items remain in the queue and are pending manual allocation for one of the following reasons:
- The agent has already reached the maximum capacity.
- Available agents have not accepted the allocated work items.
- Agents with required skills are not available.

Procedure
2. Click the Channels icon.
3. Select the work item using one of the following actions:
   - Queued Work tab
     - Select the work item.
   - Service Channel page
     - a. Click a service channel. For example, Chat.
     - b. Click the Work Items tab.
     - c. Select the work item.
<table>
<thead>
<tr>
<th>Navigate To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Queues</td>
<td>[a. Click a queue.]</td>
</tr>
<tr>
<td></td>
<td>[b. Click the <strong>Work Items</strong> tab.]</td>
</tr>
<tr>
<td></td>
<td>[c. Select the work item.]</td>
</tr>
</tbody>
</table>

The list of available agents appears with details such as presence state, availability, capacity, assignment groups (common groups between manager and agents), and matching skills.

> Note: The availability hours are the current shift timings of an agent, excluding the break time. However, if the shift hasn't started, then the next shift available hours are displayed.

4. Select the agent that you want to assign the work item to. For example, if the capacity is 0/4, it means that the agent's maximum capacity is four work items.

> Note: You can allocate one work item at a time to the agent that you select.

5. Click **Allocate**. A confirmation message appears that shows that the work item is allocated to the selected agent. You can customize the confirmation message by adding the `[glide.awa.manual_assignment_message]` system property to the `sys_properties.list [sys_properties]` table. The agent gets an alert on the assigned work item as follows:

![Agent Alert](image-url)
• If the agent accepts the work item, the status changes from **Pending Accept** to the **Accepted** state. The **Assigned To** field is updated with the agent's name and the relevant KPI is updated.

• If the agent rejects the work item, the status changes to the **Queued** state.

• If the agent does not accept the work item for a long time, the status remains in the **Pending Accept** state. You then need to reallocate the work item.

**Track and analyze agents' performance**
Track your agent's performance in overview so that you can analyze and review how that agent is doing.

**Before you begin**
Role required: sn_wfo_csm.manager

**About this task**
View all agents and their real-time status. Drill down into a specific agent to view the following details.

• Real-time information of KPIs such as active cases, interactions, and other rejections.

• Override channel capacity.

• Agents' availability and their presence states' history.

• Work items which are in **Pending Accept** state.

• Interactions that are new, work in progress, and on hold states.

• Cases that are in new, open, and awaiting info states.

• Skill set, schedule, and profile.

• Assigned training tasks.

• User details and groups assigned.
Note:

- The records in the list appear based on the column’s default sort order. Click a column heading to toggle between ascending and descending order. The sorting order turns to the default configuration as you leave the page. For example, the agent’s Presence State column is by default in ascending sort order. The administrator can change it to descending order by creating an implementation using the `sn_channel_mgmt.ChannelMgmtExtensionPoint` extension point. For more information, see Use extension points to configure the sort order.

- The records in the list refresh at a regular interval of 30 seconds. The administrator can change the interval using the `sn_channel_mgmt.list_auto_refresh.interval.seconds` system property.

Procedure


2. Click the Channels icon.

3. Click the All Agents tab.

4. Track and analyze agents’ performance.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent</td>
<td>First and last name of the agent. Click the agent’s name to view the agent’s profile summary.</td>
</tr>
<tr>
<td>Service Channel</td>
<td>Agent’s associated service channel, so you know what type of work the available agent can handle. Click the channel to view the list of work items.</td>
</tr>
<tr>
<td>Total Capacity</td>
<td>Number of maximum work items that can be automatically assigned to agents (pending overrides).</td>
</tr>
<tr>
<td></td>
<td>- Chat: The default is 4.</td>
</tr>
<tr>
<td></td>
<td>- Incident: The default is 2.</td>
</tr>
<tr>
<td>Capacity in use</td>
<td>Number of ongoing work items. Click the score to view the ongoing work of an agent.</td>
</tr>
<tr>
<td>Utilization</td>
<td>Agent workload/capacity in percentage. The percentage is calculated from the Total Capacity and Capacity in Use.</td>
</tr>
</tbody>
</table>
## Override channel capacity for an agent

Change the default number of work items that an agent can handle for a service channel.

### Before you begin

**Role required:** sn_wfo_csm.manager

### About this task

By default, the override capacity is valid for 12 hours. Administrator can change the duration using the `sn_channel_mgmt.awa_agent_temporary_override_time.minutes` system property. The capacity resets to the previous value after the specified time. The scheduled job Reset Temporary Capacity Override is executed every two minutes to check the invalid or expired overridden capacity and resets to the previous value.

You can override the channel capacity for a single agent at a time. Ensure that an agent to whom you want to override the channel capacity needs to be associated with Advanced Work Assignment and the required channels.

### Procedure

1. Navigate to **Workforce Optimization for Customer Service > Manager Workspace**.
2. Navigate to an agent's profile page.

<table>
<thead>
<tr>
<th>To set the override capacity</th>
<th>Do this</th>
</tr>
</thead>
</table>
| **From Channels**            | a. Click the Channels ( unfold) icon.  
b. Click the **All Agents** tab.  
c. Click an agent's record. |
To set the override capacity

<table>
<thead>
<tr>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>a. Click the Teams (👥) icon.</td>
</tr>
<tr>
<td>b. Click the KPI group.</td>
</tr>
<tr>
<td>c. Select Group Members tab.</td>
</tr>
<tr>
<td>d. Click an agent's record.</td>
</tr>
</tbody>
</table>

From Teams

The agent profile page appears.

3. Click the Overview tab.

4. In the Channels section, select the service channel for which you want to override the capacity.

5. Click Capacity Override. The Agent Capacity Override page appears.

6. In the Override Capacity field, enter the new capacity.

7. Click Apply.

Results

The following snapshot shows an example of an agent's capacity override. A message appears indicating the capacity update is valid for the defined duration. The capacity resets to the previous value after the specified time.

Using Cloud Call Center with Workforce Optimization for Customer Service

Use Cloud Call Center to deflect cases away from your human agents using bots. You can record phone interactions when agents resolve issues. Also, you
can monitor those interactions to evaluate and improve the quality of case resolutions.

With the Cloud Call Center application, you can:

- Enable your workforce to work using the voice channel and get call recordings, call transcripts, and reports of sentiment analysis when agents interact with callers. You can visualize all of this information within the Channel Management application in Workforce Optimization for Customer Service.
- Analyze the call transcripts and sentiments of users after an interaction is complete so that you can create assessments, provide feedback, and training for agents.
- Synchronize agent presence within the queue.

Note: You can integrate any third-party telephony service with the Cloud Call Center application. By default, the Cloud Call Center provides you with the ability to integrate with the Amazon Connect application.

You can visualize the metrics from the Amazon Connect phone queues that are routed through Cloud Call Center using the Channel Management application in Workforce Optimization for Customer Service. The Cloud Call Center application uses Advanced Work Assignment to report data from the Amazon Connect queues.

**Cloud Call Center Amazon Connect integration workflow**

Here’s how the Cloud Call Center integrates with Amazon Connect:
Let's try and deflect the call
Cloud Call Center recognizes this is Zeke and identifies that there is a wifi issue in his office location

There is a wifi issue in San Diego. Is this why you are calling?

"No, can you please tell me the status of my request?"

Zeke

I will look up the status of your request.

Data lookup
Operation handlers find Zeke's request

Your request should be completed in 5 days.

That's way too long! Please transfer me to an agent.

Zeke

Transferring you to a live agent...

Agent receives interaction with the needed information and resolves the request
Benefits of using Cloud Call Center with Workforce Optimization for Customer Service

As a manager, you can:

• Monitor agents’ calls as they resolve customer issues.
• View synchronized agent presence states within the Channel Management application in Workforce Optimization for Customer Service.
• Assess your agents by reviewing recordings of agent interaction and call transcripts.
• Analyze sentiments from the call transcripts and use that to coach and train your agents.

As an agent, you can:

• Get information about the caller before you answer an incoming call.
• Analyze call transcripts and listen to recordings after you complete an interaction.
• Place outbound calls using automated outbound dialing.

Associate Amazon Connect queues for CSM to a ServiceNow instance

Set up phone queues for Amazon Connect to gain visibility into the queues using Workforce Optimization for Customer Service.

Before you begin

Enable the Advanced Work Assignment plugin (com.glide.awa) to create the Amazon Connect queues. You must activate this plugin before you activate the Cloud Call Center Core (sn_cti_core) plugin so that you can successfully integrate the two applications.

After you install the Cloud Call Center applications, when you enable the Advanced Work Assignment plugin (com.glide.awa), the Amazon Connect (phone) service channel appears in the Workforce Optimization for Customer Service.

Role required: sn_wfo_csm.admin and sn_cti_amzn_cct.admin

About this task

After an agent completes a call, using Workforce Optimization for Customer Service, you can learn:

• Who was on hold and how long they were on hold
• How long calls are taking
• Which agents are available and when
• How many agents are available and what is their current utilization

You can see the Basic queue when you install the demo data with the sample contact flow:
The Basic queue is available when you install the demo data to get the calls routed to this queue when an utterance is generic, such as, "I want to talk to an agent".

Every agent must have a routing profile in the Amazon Connect instance that is integrated with the ServiceNow instance. For more information, see create a routing profile.

Note:
• You can associate each profile with multiple Amazon Connect agent queues.
• You must associate each of these agent queues with the corresponding agent queue in your ServiceNow instance using an Amazon Connect ARN number. This association enables you to report on queue statistics and call metrics within Workforce Optimization for ITSM.

Procedure
1. Create placeholder queues for an Amazon Connect (phone) service channel if you need additional queues. For more information on creating the queue, refer to Create a work item queue.

   Note: Do not add work item routing conditions when you create the placeholder queues.

2. Associate the ServiceNow Advanced Work Assignment (AWA) queue record with the Amazon Web Services (AWS) queue ARN.

3. Add assignment groups to a queue.
   a. Select a work item queue.
   b. Click Group Queue Priorities related list.

      Note: You must configure the form to display this related list.
   c. Click New.
   d. In the Group field, add an assignment group that include agents who can handle this queue.
e. In the Order field, select the order number for the assignment group. This is the order of assignment group priority in which the incoming calls are handled.

f. Click Submit.

Listen in to an agent call

Monitor your customer service agents' calls when they are resolving issues for external callers by using Workforce Optimization for Customer Service.

Before you begin
Role required: sn_wfo_csm.manager

You must also have an active session with Amazon Connect and be able to monitor live conversations. For more information, refer to Monitor live conversations.

About this task

When the Amazon Connect application answers a call from an external source, an interaction record is created.

Procedure

1. Monitor your agent’s call queue when an agent is talking to an external caller in Workforce Optimization for Customer Service.

2. Open the active interaction when the phone call is in progress.

3. Click Monitor Call and listen into the call in Amazon Connect.

Analyze transcripts and sentiments for the Amazon Connect phone channel

Analyze your agent's call recordings, transcripts, and sentiment reports. With this information, you can assess the call quality and train your agents to handle calls better in the future.

Before you begin
Role required: sn_cti_core.user_manager

About this task

When an agent interacts with an external caller, the call gets recorded and transcribed. The application tags every statement within a transcript with a sentiment score. After a call has been completed, a sentiment report is automatically generated.
Note: The manager must have an active session with Amazon Connect to view the transcripts and sentiments. The transcripts and sentiments are generated in the Amazon Connect application. They are then displayed in the Channel Management application in Workforce Optimization for Customer Service.

**Procedure**

1. Navigate to **Workforce Optimization for Customer Service > Manager Workspace**.

2. Select an interaction record to analyze transcripts and sentiments.

<table>
<thead>
<tr>
<th>To analyze call transcripts and sentiments</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>From Channels</strong></td>
<td><strong>Note:</strong> You can view call transcripts and sentiments for all interactions that were closed today.</td>
</tr>
<tr>
<td>a. Click the Channels icon.</td>
<td></td>
</tr>
<tr>
<td>b. Click <strong>Amazon Connect (Phone)</strong>.</td>
<td></td>
</tr>
<tr>
<td>c. Select an interaction record.</td>
<td></td>
</tr>
<tr>
<td><strong>From Teams</strong></td>
<td>a. Click the Teams icon.</td>
</tr>
<tr>
<td>b. Select a team.</td>
<td></td>
</tr>
<tr>
<td>c. Select a user.</td>
<td></td>
</tr>
<tr>
<td>d. Select a KPI.</td>
<td></td>
</tr>
<tr>
<td>e. Select an interaction record.</td>
<td></td>
</tr>
<tr>
<td><strong>From Coaching</strong></td>
<td>a. Click the Coaching icon.</td>
</tr>
<tr>
<td>b. Click the <strong>Active Assessments</strong> tab.</td>
<td></td>
</tr>
<tr>
<td>c. Select an assessment.</td>
<td></td>
</tr>
<tr>
<td><strong>From Lists</strong></td>
<td><strong>Note:</strong> When you have assessments triggered from calls, you can view call transcripts and sentiments for those interactions.</td>
</tr>
<tr>
<td><strong>To analyze call transcripts and sentiments</strong></td>
<td><strong>Do this</strong></td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td></td>
<td>a. Click the Lists (_lists) icon.</td>
</tr>
<tr>
<td></td>
<td>b. Select an interaction record.</td>
</tr>
</tbody>
</table>

3. Click **Call Analysis**.
   The report displays all interactions and sentiment analysis of those interactions that are generated by Amazon Connect.

4. **Optional**: Assess the quality of completed interactions and assign training to coach the agents.

**Scheduling in Workforce Optimization for Customer Service**

By using Scheduling, you can manage your workforce resources efficiently by planning and managing schedules, staffing, and shifts across your teams all from one location. You can also integrate with on-call scheduling and create shifts and schedule for on-call rotations.

With Scheduling, you can do the following:

- Add meetings, training, time-off requests, or ad hoc work shifts by using the team calendar.
- Filter agents in the team calendar based on their location, region, assignment groups, or any field in the agent's record.
- Create shift and schedule plans for agents.
- Approve or reject agents' time-off and shift-swap requests.
- Track and manage the team's schedule on the team calendar by viewing the planned shifts versus the actual clock-in and clock-out times for the selected day or week.
- Analyze whether your team members are following the schedules. If you see a potential issue, you can easily alert your team so that they can take immediate action.
- Use historical adherence reports to analyze and recommend coaching opportunities for your agents.

**Create a shift plan**

Schedule shifts for your team so that you can make sure that you are covering all work assignments and breaks. You can also specify the days of the week that you might need to override scheduled shifts.
Before you begin
Role required: sn_shift_planning.admin

About this task
In the Shifts tab, the shifts are grouped by active and inactive shifts. The contextual side panel displays the active and then the inactive shifts in the order it is displayed in the Shifts tab.

Procedure
2. Click the Schedule ( ) icon.
3. Click the Shifts tab.
4. Click the plus (+) icon.
5. Create a shift.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>a. Create a work shift.</td>
<td></td>
</tr>
<tr>
<td>i. Click Work shift.</td>
<td></td>
</tr>
<tr>
<td>ii. In the Name field, enter a name for the shift.</td>
<td></td>
</tr>
<tr>
<td>iii. Select the time window for the shift.</td>
<td></td>
</tr>
<tr>
<td>1. In the Time Zone field, select the time zone of the users that you want to allocate to the shift.</td>
<td></td>
</tr>
<tr>
<td>Note: To add a shift for agents working in their local time zones, select the Use agent time zone option. The system uses the time zone that is specified in the agent's user record.</td>
<td></td>
</tr>
<tr>
<td>2. In the Start Time field, enter the time of day when you want to start the shift.</td>
<td></td>
</tr>
<tr>
<td>3. In the End Time field, enter the time of day when you want to end the shift.</td>
<td></td>
</tr>
<tr>
<td>iv. Select the days of the week for which you want to add this shift.</td>
<td></td>
</tr>
<tr>
<td>v. Click Save.</td>
<td></td>
</tr>
<tr>
<td>b. Add schedule breaks to the shift.</td>
<td></td>
</tr>
</tbody>
</table>
To | Do this
---|---
i. Select the shift that you created.
ii. Click **Add break**.
iii. In the **Name** field, enter a name for the break.
iv. Set a duration for the break.
1. In the **Duration** field, enter the length of time for the break.
2. In the **Earliest Start Time** field, enter the earliest time to start the break.
3. In the **Latest End Time** field, enter the latest time to end the break.
   For example, you can set the earliest start time as 11:00, the latest end time as 15:00, and the duration of the break as one hour. If you add four agents to that work shift, the Scheduling application automatically staggered the break duration for each agent. Stagger breaks to ensure that your four agents can cover the entire shift span.
4. Click **Save**.
   You can view the number of agents for each hour or day on the shift span window.

Create an on-call shift

a. Create an on-call shift.
i. Click **On-call shift**.
ii. In the **Name** field, enter a name for the shift.
iii. From the **Group** field, select a group that you want to assign for the shift.
iv. Select the time window for the shift.
   1. In the **Start Time** field, enter the time of day when you want to start the shift.
   2. In the **End Time** field, enter the time of day when you want to end the shift.
   3. From the **Time Zone** menu, select the time zone of the users that you want to allocate to the shift.
v. Select the days of the week for which you want to apply the shift.

vi. In the Rotation start date field, click the calendar icon, select the on-call rotation start date for the shift and click OK.

vii. Click Save.

b. Create the on-call rotation.

i. Select the shift that you created.

ii. Click Create Rotation.

iii. From the Agents field, select the names of the agents you would like to be part of the shift. When you click the field, the name of all agents that belong to the group that the on-call shift is being created for is displayed.

iv. From the Rotate interval field, select if you want the rotation to be daily or weekly.

v. Click Save.

Note: The Escalation Type field is auto-populated with Rotate through rosters field value if multiple rosters have been created for the rotation. If not, it is populated with Rotate through members field value.

c. Click Publish to make the shift active and publish it on the schedule.

Note:

- You can select an active on-call shift and click Unpublish to make the shift inactive and remove it from the schedule.

- You can view all on-call shifts that have been published on the schedule in the agent and team calendar. When you add new agents to the on-call rotation, it might take some time to refresh the data on the team calendar.

- You can click on an on-call shift in the team calendar to see more details.
<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>You can view the name of the primary agent for each on-call shift on the shift calendar.</td>
</tr>
</tbody>
</table>

6. Click **Submit**.

### Create a schedule plan

Manage your team's schedule by creating a schedule plan that covers a span of time and includes your team's work shifts. You can also assign agents to shifts based on their skills and availability. This way, you can make sure that you are using your resources in the best way possible for your organization.

#### Before you begin

Role required: **sn_shift_planning.admin**

#### About this task

You can set the number of days to cache agent schedules using the **sn_shift_planning.number_of_days_to_cache** system property. The **Total coverage/demand** row displays the number of agents covering each shift in a day. The day view displays the demand for the number of agents forecast for every hour in a day. For example, 4/5 shows that you have four agents scheduled for an hourly time slot, 11 AM to 12 PM and the agent demand forecast for that hour is 5.

#### Procedure

1. Navigate to **Workforce Optimization for Customer Service > Manager Workspace**
2. Click the Schedule ( sacrificenow-icon) icon.
3. Select the time zone
4. Create a schedule plan.

<table>
<thead>
<tr>
<th>To create the schedule plan</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>From the Calendar tab</td>
<td>a. Click sacrificenow-icon to view the Schedules panel.</td>
</tr>
<tr>
<td></td>
<td>b. In the Schedules panel, click sacrificenow-icon.</td>
</tr>
<tr>
<td>From the Schedule tab</td>
<td>a. Click <strong>New</strong>.</td>
</tr>
</tbody>
</table>
5. In the **Name** field, enter a name for the schedule plan.

6. From the **Start Date** field, select a date to start the schedule plan and click **OK**.

7. From the **End Date** field, select a date to end the schedule plan and click **OK**.

8. Click **Save**.

9. Add a work shift to the schedule plan.

<table>
<thead>
<tr>
<th>To create a work shift</th>
<th>Do this</th>
</tr>
</thead>
</table>
| **From the Calendar tab** | a. Click **Add Shift**.  
  b. In the **Shift** field, select the work shift that you want to assign for the schedule plan.  
  c. Click **Save**. |
| **From the Schedule tab** | a. Click the **Work Shifts** tab.  
  b. Click **New**.  
  c. In the **Shift** field, select the work shift that you want to assign for the schedule plan.  
  d. Click **Save**. |

**Note:** The **Total coverage/demand** row displays the number of agents covering each shift in a day. The day view displays the demand for the number of agents forecast for every hour in a day. For example, 4/5 shows that you have four agents scheduled for an hourly time slot, 11 AM to 12 PM and the agent demand forecast for that hour is 5.

10. Add agents to the work shift.

<table>
<thead>
<tr>
<th>To add agents to a shift</th>
<th>Do this</th>
</tr>
</thead>
</table>
| **From the Calendar tab** | a. In the **Agents** field, search for agents and add one or more agents to add to the shift.  
  b. Click **Save**. |
| **From the Schedule tab** | a. Click the **Agents** tab  
  b. Click **Add Agents**.  
  c. Select the agents that you want to add to the schedule shift. |
To add agents to a shift  

<table>
<thead>
<tr>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>d. Click Add.</td>
</tr>
<tr>
<td>e. Click Save.</td>
</tr>
</tbody>
</table>

Publish a schedule plan for visibility into team coverage

Generate a preview of your schedule plan and publish it so that your agents can see their shifts and schedules ahead of time. You can unpublish a schedule to make changes and then publish it again.

Before you begin
Role required: sn_shift_planning.admin

About this task
You can make a copy of a schedule and update it to create a new schedule. Updates could include modifying the schedule start and end dates as well as adding or removing shifts or agents.
When you make a copy of the schedule, the following updates are automatically made to the schedule copy:

- The start date is set to the current date and the end date to 30 days from the current date.
- The schedule state changes to Draft. You can make the necessary changes to the shift and click Save.
- The schedule only displays agents in the assignment group of the current logged in user.

You can also unpublish a schedule make updates, and then publish it again.
- If the start date is the either the current date or had occurred in the past, the schedule state remains as Published and the end date changes to tomorrow.
- If the start date is in the future, the scheduler changes the schedule state and agent schedules to Draft.

Procedure
2. Click the Schedule ( ) icon.
3. Generate a schedule preview.
a. Click the Team Calendar tab.

b. Click the Show Schedules ( ) icon to display in the contextual side panel. The team calendar refreshes and generates the preview when you save a work shift.

4. Publish a schedule.
   a. Select a schedule and edit the schedule if necessary.
   b. Edit the schedule if necessary and click Save.
   c. Click Publish.

   Note: You can click Delete in Draft state and delete the schedule if you no longer need it.

Results
All the schedules that are in Draft state move to Published state. You can view the published schedule in the team calendar.

Track and manage your teams' schedule
Create, update, or monitor your teams' schedule from one location. You can approve or reject requests for swapping shifts or time off for agents within your assignment group.

Before you begin
Role required: sn_shift_planning.admin

About this task
Using the calendar, you can do the following:
• View all of your agents by assignment group.
• Get insights into team compliance with published schedules.
• View agent's work schedule that is actual shift time vs clock-in and clock-out times.
• Filter the team calendar based on the Assignment Group, Location, Skills, Shift Plan, and Events for a customized view.
• Modify agent's shift, clock-in, and clock-out timings if required.
**Procedure**

1. Navigate to **Workforce Optimization for Customer Service > Manager Workspace**.

2. Click the Schedule (📅) icon.

3. Track and manage your agents' schedule.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Modify an agent's shift timings | a. In the Calendar tab, navigate and point to the shift for the agent that you want to modify the schedule for.  

b. In the shift pop-up window, click the Edit icon.  

c. Modify the agent's shift time as desired. |

| Modify an agent's clock-in and clock-out timings | a. In the Calendar tab, navigate and point to the actual time worked event of an agent for whom you want to modify the timings for.  

b. In the Time Worked pop-up window, click the Edit icon.  

c. Modify the agent's clock-in or clock-out time as required. |

| Filter the team calendar based on the selected events | a. Click the Filter (🔎) icon.  

b. Click the component and select a value on which you want to filter the calendar. For example, Click Events and select Actual Work. The Team Calendar appears with the actual work events. |

| Approve or reject an agent's time off or shift-swap with another agent | a. Click Approvals. You can view all agent requests in your queue and the details for each request.  

b. Select a request that you want to approve or reject and do one of the following:  

• To approve a request, click Approve.  

• To reject a request, click Reject. |
4. Click **Save**.

The following snapshot helps you to view the time worked summary for the selected agent.

**Monitor schedule adherence of your agents**

Use schedule adherence to evaluate whether or not your agents are adhering to their assigned schedules. You can look for areas where low-value activity can be eliminated or reduced and further analyze staffing levels throughout the day.

**Before you begin**

Role required: sn_shift_planning.admin

**About this task**

- Adherence is a metric to analyze how closely agents follow their schedule in completing the work assignments. Conformance measures the work completed, regardless of when it was completed.

- A high adherence rate indicates that agents are sticking to their schedules and offering customer service when expected. Low adherence suggests...
changing the processes or decisions to manage the team efficiently. The numbers are highlighted in red for non-adherent agents.

- Schedule adherence and conformance calculations are based on the formulas, agents' actual and planned work timings. The following are the default formulas that are used to calculate adherence and conformance for agents. However, your administrator can change the formulas, as required. The following components and formulas are used to calculate adherence and conformance:

  - The **shift_planning_clock-in** and **shift_planning_clock-out** scripts generate the agents' clock-in and clock-out events from the login and logout sessions. The business rule **Agent Time Work Event Trigger** generates clock-in and clock-out events whenever there is a change in agent's presence state.

  - **Schedule Adherence** = \( \frac{\text{Minutes worked in shift}}{\text{Scheduled shift time in minutes} + \text{Overtime}} \)

  - **Conformance** = \( \frac{\text{Minutes worked in shift} + \text{Overtime}}{\text{Scheduled shift time in minutes}} \)

- The ideal adherence percentage by default is above 70, and conformance is between 80 to 120. However, your administrator can change the threshold values. For more information, see Configure properties for schedule adherence and conformance. The agents who do not qualify to the defined threshold values are considered as non-adherent and are highlighted in red.

**Procedure**

1. Navigate to **Workforce Optimization for Customer Service > Manager Workspace**.

2. Click the Schedule icon.

3. Monitor the schedule adherence of your agents.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| View schedule adherence at organization or team level | **a.** Click the **Schedule Adherence** tab. The bar chart appears with the schedule adherence percentage and conformance percentage of your teams.  
  
  **b.** Click on the bar to view the graph and drill down further to view the analytics of your team members. |
To | Do this
---|---
Analyze planned vs actual scheduling for your team members | **a.** Click the **Team Calendar** tab.  
**b.** Select the date.  
**c.** Click on the bar representing the agent’s actual time worked of an agent to further view the **Time Worked** summary.

⚠️ **Note:** The clock-in and clock-out timings are the actual work timings of your agents. The events are generated based on the agent’s login, logout actions, and presence state. If an agent forgets to clock-out, the system automatically generates the clock-out event after 60 min, by default. However, your administrator can change it using the **Default threshold time for clock-out event generation (in Minutes)** system property.

Example: A clock-in event gets generated when an agent logs in or changes the presence status to **Available**. Similarly, a clock-out event gets generated when an agent logs out of the system or changes the presence status to either **Offline** or **Break**. If an agent fails to clock-out even after 60 min of the shift end time, the system automatically generates the clock-out event.

The following team calendar snapshot helps you to measure how well your team members are adhering to their work schedules. The blue bar indicates the planned work shift time and next to that is the actual worked time. The default representations are purple for clock-in time, green for agent’s...
available duration, red for the clock-out time, and grey for agent's non-available time.

**Analyze adherence and conformance from the time worked summary**

View the time worked summary of your team members to determine if your teams are adhering to the planned schedules. You can also use historical adherence, which is a reporting view of real-time adherence, to see how well your agents have followed their schedules in the past.

**Before you begin**

Role required: sn_shift_planning.admin

**About this task**

Adherence and conformance calculations are based on the defined configuration and your agents' actual and planned work schedules.

**Note:** Your administrator can disable schedule adherence or change the configuration for adherence and conformance. For more information, see Configure properties for schedule adherence and conformance.
Procedure

2. Drill down to view the time attendance and time worked summary of your agents.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| **Analyze time worked summary of your team** | **a. Click the Lists ( ) icon.**  
**b. Under Schedule Adherence, click Time Worked Summary.** |
| **View your agents’ time attendance** | **a. Click the Lists ( ) icon.**  
**b. Under Schedule Adherence, click Time Attendance.** |

The following schedule adherence example helps you to measure how well your team is adhering and conforming with their work schedules.
Example:
To understand the computations of the fields in a time worked summary, let's consider Fatima Alonzo's work day:

• Shift time begins at 8 a.m. and goes to 5 p.m. = 8 hours
• Planned time = 8 hours = 480 minutes
• Clocks in 8 a.m. and clocks out at 12 p.m. for a break. Back from the break, clocks in at 12:30 p.m. and clocks out at 5:05 p.m.
• Minutes worked in shift = 480 - 30 = 450 minutes
• Schedule adherence = (minutes worked in shift/scheduled shift time in minutes + overtime) = 450/(480+65) = 82.57%
• Conformance = (minutes worked in shift + overtime)/scheduled shift time in minutes = (450 + 65) / 480 = 107.29 percent.

Note: Fatima Alonzo is adherent because the schedule adherence and conformance are within the threshold. To see which agents are non-adherent, look for the numbers that are highlighted in red.

Related information
- Schedule Adherence in Workforce Optimization for Customer Service

Analyze staff alignment using Demand Forecast
Use Demand Forecast to plan the number of staff members that you require so that you have enough agents to do the job.

Before you begin
Role required: sn_agent_forecast.user

About this task
Using Demand Forecast, you can:
• Monitor agent or team shift coverage for any day or week.
• Analyze if you are overstaffed, understaffed, perfectly staffed, or not aligned well with your staffing needs.
• Adjust the staff alignment depending on the coverage you need and the schedule of your teams.
• Analyze staff alignment as you are creating a schedule.
Procedure


2. Click the Schedule ( ) icon.

3. Click the Calendar tab.

4. Analyze staff alignment for each shift.

<table>
<thead>
<tr>
<th>To analyze staff alignment</th>
<th>Do the following</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select <strong>Day</strong> from the list.</td>
<td>The <strong>Total coverage/demand</strong> row displays the number of agents covering each shift in a day. It also shows the demand for the number of agents forecast for that day.</td>
</tr>
</tbody>
</table>

**For each day**

For example, 24/20 shows the following:

- you have 24 agents scheduled for all shifts for that week.
- the agent demand forecast for that day is 20.

**a. Select **Week** from the list.**

The **Total coverage/demand** row has indicators for the staff alignment.

<table>
<thead>
<tr>
<th>If the row displays</th>
<th>Then</th>
</tr>
</thead>
<tbody>
<tr>
<td>An arrow points downward</td>
<td>The predicted forecast is lower than the number of agents you need for that day</td>
</tr>
<tr>
<td>An arrow points upward</td>
<td>The predicted forecast is higher than the number of agents you need for that day</td>
</tr>
<tr>
<td>A checkmark</td>
<td>shows perfect alignment of the</td>
</tr>
<tr>
<td>To analyze staff alignment</td>
<td>Do the following</td>
</tr>
<tr>
<td>---------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td></td>
<td>If the row displays</td>
</tr>
<tr>
<td></td>
<td>predicted forecast</td>
</tr>
</tbody>
</table>

b. Click any of the indications displayed in the **Total coverage/demand** row to analyze further details on the forecast.

The following scheduling snapshots provide you an example to analyze staff alignment using Demand Forecast. The misaligned staffing indicator in the pop-up shows that the forecast manager has scheduled certain number of agents for each shift but they need more agents to cover them.

---

**Add events to the team calendar**

Create a meeting, training, time-off request, or an adhoc work event from the team calendar.

**Before you begin**

Role required: sn_shift_planning.admin
About this task
You can create custom event types and add or remove the desired fields. For more information, see.

Procedure
2. Click the Schedule icon.
3. Click the Calendar tab.
4. Click +New.
5. Create an event.

<table>
<thead>
<tr>
<th>To Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>a.</strong> Do one of the following:</td>
</tr>
<tr>
<td>• To schedule a meeting, select <strong>Meeting</strong>.</td>
</tr>
<tr>
<td>• To create a training event, select <strong>Training</strong>.</td>
</tr>
<tr>
<td>• To create a time-off request, select <strong>Time-off</strong>.</td>
</tr>
<tr>
<td><strong>b.</strong> Fill in the event form.</td>
</tr>
<tr>
<td>i. In the <strong>Title</strong> field, enter a name for the meeting.</td>
</tr>
<tr>
<td>ii. In the <strong>Attendees</strong> field, start typing the name of each of the attendees for the meeting and select the name.</td>
</tr>
<tr>
<td>iii. In the <strong>Start date</strong> field, click the calendar icon and select the date you want to start the meeting and click <strong>OK</strong>.</td>
</tr>
<tr>
<td>iv. In the <strong>End date</strong> field, click the calendar icon and select the date you want to end the meeting and click <strong>OK</strong>.</td>
</tr>
</tbody>
</table>
To Do this

| v. | If the meeting spans for the whole day, click the All Day slider. |
| vi. | In the Description field, enter a description for the meeting. |

Create a work shift

| a. | Click Work. |
| b. | In the Attendees field, start typing the name of each of the attendees for the meeting and select the name. |
| c. | In the Start date field, click the calendar icon and select the date you want to start the meeting and click OK. |
| d. | In the End date field, click the calendar icon and select the date you want to end the meeting and click OK. |
| e. | Click the Select Shift field and select a shift. |

6. Click Save.

Teams in Workforce Optimization for Customer Service

Use Teams to track and analyze performance trends for your teams from a single location. You can monitor the trends for each agent within your team and compare your agents or team members with one another.

With Teams, you can do the following:

- Identify skill gaps so that you can recommend which skills are needed to coach your agents.
- Organize your teams into assignment groups. You can add a set of key performance indicators (KPIs) to help you measure team performance consistently across the groups. For example, the Customer Service Desk unit contains multiple teams, such as Hardware and Network Support. You can create a KPI group for the Customer Service Desk unit and then add Hardware and Network Support as assignment groups to this KPI group. Next, you add a set of KPIs to the KPI group. With this data, you can measure the performance trends across the Hardware and Network Support teams.
- Compare KPIs between multiple teams belonging to the same KPI group.
- View the KPIs between the selected date range.
• Drill down into a Team level KPI to view the split of KPIs across all individual team members.

• View the KPI trend to analyze the future forecasts for each of the KPIs, if the date range has the latest values.

• Targets can be set on the KPIs through the team performance page at the global or individual level. When such targets are set, the trendline reflects the targets.

• Drill down to the individual agent level to view a 360 degree view of the current work, historical KPIs, presence history, channel capacity utilization, skills, and upcoming time-offs.

Analyze the performance trends for your teams
Analyze trends to monitor your team's performance and adherence within a KPI group.

Before you begin
Role required: sn_mgr_workspace.manager

About this task
Analyze the data by drilling down into the data for a team, a specific team member, an indicator, or a case.

Procedure
2. Click the Teams icon.
3. Select a date range to view your teams' performance for that time period.
   You can set the default date range using the sn_team_perf.default_date_range system property.
   All teams that you manage are identified with a My team highlight in the group header. You can also see the team that you have visibility into.
   a. Select a team.
   b. In the Performance tab, track and analyze the overall indicator performance for all members in the team.
   c. Drill down into the data for this team:
<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyze indicator performance</td>
<td>• To analyze the indicator performance for the team, click an indicator value for the team in the header row.</td>
</tr>
<tr>
<td></td>
<td>• To analyze indicator performance for a team member, click an indicator value for the team member.</td>
</tr>
<tr>
<td>Track cases</td>
<td>Click the <strong>Tasks</strong> tab and analyze all cases related to the team.</td>
</tr>
<tr>
<td></td>
<td>• To view the cases details, select a case.</td>
</tr>
<tr>
<td></td>
<td>• To view the team member's details, select a team member.</td>
</tr>
</tbody>
</table>

You can also review cases, details of assignment groups, additional managers, and information relevant to the team.

**Related information**

Setting up Teams Workforce Optimization for Customer Service

**Coaching in Workforce Optimization for Customer Service**

By using Coaching in Workforce Optimization for Customer Service, you can assess your team's abilities to efficiently resolve cases by reviewing their work at critical moments of customer service.

With Coaching, you can do the following:

• Provide training for your agents to address skill gaps.

• Use the coaching opportunities that are available by default to coach your agents. You can also create a coaching opportunity using the Coaching application specific to your agent needs.

• Use assessments and surveys to apply consistent, measurable scores across teams.

• Use Predictive Intelligence to recommend skills for your agents and provide training to address those skill gaps.

**Skills Overview in Workforce Optimization for Customer Service**

Use Skills Overview to analyze skill data such as how many skills are assigned to users and tasks. You can also see how many experts you have for a particular skill and the overall skill coverage by your teams.
Skills Overview from Manager Workspace:

User

<table>
<thead>
<tr>
<th>User</th>
<th>Landing page use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Skill Admin</td>
<td>• Analyze all experts available for each skill.</td>
</tr>
<tr>
<td>[skill_admin]</td>
<td>• Drill down into the skill hierarchy.</td>
</tr>
<tr>
<td></td>
<td>• Number of skills assigned to users and tasks.</td>
</tr>
<tr>
<td></td>
<td>• The mean time taken to resolve incidents for that skill.</td>
</tr>
<tr>
<td></td>
<td>• Visualize how many users you have at different skill levels.</td>
</tr>
</tbody>
</table>

Indicators

- **MTTR of incidents of skill**
  Mean time taken to resolve incidents with this skill.

Breakdowns

The indicator is broken down by Skill.
## Now Experience Components

<table>
<thead>
<tr>
<th>Component Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| Skill Overview Container [sn-manager-skill-overview-container] | Visualization components | Contains the following components:  
- Reports  
- Mean Time to Resolution (MTTR) indicator  
- Skill Coverage pie chart  
- Content tree  
- Skill Experts components |
| Skill Tree Connected [sn-manager-skill-tree-connected] | Tree         | Displays the skill hierarchy. If the selected skill does not have a skill hierarchy then the component will not display on the Skill Overview page. |
| Skill Experts [sn-manager-skill-experts-connected] | List         | Displays all users who are at the expert level for the skill.                                                                               |
| Skill Coverage [now-uxf-visualization-connected] | Pie-chart    | Displays the percentage as well as the number of users with different levels of expertise for the skill.                                        |

## Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Source table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigned Users</td>
<td>42</td>
<td>User Skill [sys_user_has_skill]</td>
<td>The number of users who have the selected skill assigned to them.</td>
</tr>
<tr>
<td>Assigned Tasks</td>
<td>42</td>
<td>Task Skill [task_m2m_skill]</td>
<td>The number of tasks for which this skill has been assigned.</td>
</tr>
</tbody>
</table>
Assess the quality of completed tasks
Assess the ability of your agents to resolve cases or the quality of their completed tasks.

Before you begin
You can create an assessment from an interaction or any task type. When you manually create an assessment, you can add a survey to it. Coaching assessments also get created and assigned to the coach based on the trigger conditions that are defined in coaching opportunities.

Role required: sn_coaching.coach
Watch this short video to get an overview on coaching, assessments, and trainings.

Workforce Optimization for Customer Service Coaching Overview

About this task
If the coaching opportunity includes a survey, you can opt to take the survey and the assessment. When you use a survey to assess a trainee, the score for the survey is automatically calculated when you complete the survey. The assessment rating is then updated based on that score.

The Coaching Overview screen displays the average quality of the tasks that were completed in the past 30 days for your assignment groups.

- The donut chart displays the number of assessments in various states of completion. You can point to one of the states and click to open all assessments in that state.
- The bar chart displays assessments created by coaching opportunities. You can click on any of the data in the graph to access the assessments.
- You can click on the graph that displays the indicator data and access detailed information on the indicator.

Procedure
2. Click the Coaching (🎓) icon.
3. Do any of the following:
To | Do this
---|---
**Perform adhoc assessments**

**a.** Click the List (CLUD) icon.  
**b.** Select any record, such as a case or interaction, for which you want to create an assessment.  
**c.** Select the Assessments (CLUD) icon. The assessment screen appears in the right panel.  
**d.** Click the plus (+) icon.

**Use assessments triggered by coaching opportunities**

**a.** Click the Coaching (CLUD) icon.  
**b.** Select any record for which you want to create an assessment.  
**Note:** Click the Active Assessments tab to view assessments of all teams for which you are a manager or an additional manager.  
**c.** Select a case to assess.

4. On the form, fill in the fields to assess the agent.

**Assessment form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opportunity</td>
<td>Coaching opportunity that is associated with the coaching assessment.</td>
</tr>
</tbody>
</table>
| State       | State of the assessment.  
  * Open: New coaching opportunity  
  * Work in progress: Trainee is being coached  
  * Resolved: Trainee is assigned coaching programs and training modules. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• <strong>Closed Complete</strong>:</td>
<td>Assessment has been resolved and closed.</td>
</tr>
<tr>
<td>• <strong>Closed Incomplete</strong>:</td>
<td>Assessment that has been closed but not completed, typically because the coaching assessment <strong>Due Date</strong> has expired.</td>
</tr>
<tr>
<td>Assessment Rating</td>
<td>How well the agent resolved the incident. The Coaching application automatically populates this field when a coach completes a survey for the trainee.</td>
</tr>
<tr>
<td>Follow up</td>
<td>Whether the coach must take further action to improve the trainee performance.</td>
</tr>
<tr>
<td>Comments</td>
<td>Notes, if any, to add about the assessment.</td>
</tr>
<tr>
<td>Survey taken by coach</td>
<td>Survey for the trainee taken by the coach. You can add a survey for an assessment when you create the assessment manually or when the coaching opportunity triggers an assessment that does not have a survey. When a coaching opportunity triggers an assessment and contains a survey, the survey is automatically added to the assessment and cannot be changed by the coach.</td>
</tr>
<tr>
<td>Survey taken by trainee</td>
<td>Survey for the coach taken by the trainee.</td>
</tr>
<tr>
<td>Add skills</td>
<td>Skills to add to the trainee profile when the assessment is complete. When you click this field, it displays all skills and the skill levels that are not in the trainee profile.</td>
</tr>
<tr>
<td>Add training</td>
<td>Training to assign to the trainee. You can also assign learning tasks from course items.</td>
</tr>
</tbody>
</table>

5. Do the following:

• To complete the adhoc assessment, click **Save**.

• To complete assessments creating using coaching opportunities, click **Complete assessment**.
Manage skills using Workforce Optimization for Customer Service

Add or update skills for an agent. You can approve predicted skills if the skill is necessary for the agent to complete assigned tasks. You can also reject a skill if it doesn’t apply to the agent.

Before you begin
Role required: skill_manager

About this task
The Predictive Intelligence application for skills displays the recommended skills on each agent’s profile. The application uses sample cases that the agent has worked on to recommend skills for an agent.

Procedure


2. Click the Coaching (🎓) icon.

3. Click the Skills tab.
   You can view the list of all assigned skills and the skill level for each agent on your team. For more information on skills and skills levels, see Skills Management.
   You can also filter the skill matrix based on users, groups, skill type, skill level, or skill category. Reset the filter if you want to view the skills for all users.

4. Add a skill or skill level.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a skill</td>
<td>a. In the skill matrix, click Add for the skill that you want to add to the agent.</td>
</tr>
<tr>
<td></td>
<td>b. Select the Skill Level field and choose a level for the skill.</td>
</tr>
<tr>
<td></td>
<td>c. Click OK. The skill gets automatically added to the agent.</td>
</tr>
<tr>
<td>Update a skill level</td>
<td>a. In the skill matrix, select a skill level for an agent.</td>
</tr>
<tr>
<td></td>
<td>b. Select the skill level that you want to add for the agent.</td>
</tr>
<tr>
<td></td>
<td>c. Click OK.</td>
</tr>
</tbody>
</table>

5. Approve or reject a skill that is recommended by Predictive Intelligence.
a. In the skill matrix, click **Recommended** to approve and recommend a skill for the user.

b. In the **Details** tab, review the request for skill approval, the sample case resolutions that were used to predict the skill, and the activity stream.

- To approve a skill, click **Approve**. The skill is added to the agent and the lowest level for the skill is automatically associated with the added skill. The state for the request changes to **Approved** and the skill is added to the agent.

- To reject a skill, click **Reject**. The state for the request changes to **Rejected**. Predictive Intelligence does not recommend the skill for the user again and the field changes to **Add**.

- Click the More Options (⋯) icon and select **Save**. The application assigns the skill to the user. If the assigned skill does not have a skill level, the application adds the basic skill level to the user.

### Mobile experience for Workforce Optimization for Customer Service

Manage customer service cases from your mobile device with the Now Mobile Agent application. You can stay connected and access information in real time so that you can complete your tasks quickly.

If you’re an agent (sn_customerservice_agent) or a manager (sn_wfo_csm.manager), you both can use real-time notifications from the application to take action on an issue. Before you can do so, you must activate the Customer Service Mobile Plugin (com.sn_cs_mobile). For more information about the Now Mobile for Customer Service Management, see [Mobile experience for Customer Service Management](#).

- To get started with this application, follow the instructions in **Get started with the Customer Service mobile application**.

- You can learn about the agent and manager tasks that you can perform in **Use the mobile application to perform agent and manager tasks**. Additionally, you can also perform the following tasks for Workforce Optimization for Customer Service.
### Agent tasks

<table>
<thead>
<tr>
<th>Agent tasks</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approve or reject shift-swap request</td>
<td>• Tap the notification.</td>
<td>Agent receives notification that the shift swap request is either approved or rejected.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Approve</strong> or <strong>Reject</strong> the shift-swap request.</td>
<td></td>
</tr>
</tbody>
</table>

### Manager tasks

<table>
<thead>
<tr>
<th>Manager tasks</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approve or reject time-off request</td>
<td>• Tap the notification.</td>
<td>Agent receives notification that the time-off request is either approved or rejected.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Approve</strong> or <strong>Reject</strong> the time-off request.</td>
<td></td>
</tr>
<tr>
<td>Approve or reject shift-swap request</td>
<td>• Tap the notification.</td>
<td>Agent receives notification that the shift swap request is either approved or rejected.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Approve</strong> or <strong>Reject</strong> the shift-swap request.</td>
<td></td>
</tr>
<tr>
<td>View critical and high priority cases</td>
<td>• Tap the notification.</td>
<td>Review the case record and take appropriate action.</td>
</tr>
<tr>
<td>that breached SLA</td>
<td>• The case record appears.</td>
<td></td>
</tr>
</tbody>
</table>

### Communities

With the ServiceNow® Communities application, connect, engage, and collaborate with your employees, customers, partners, and prospects. Your users get quick responses to their issues by posting questions, reviewing blogs or videos, and searching for previous discussions. It is an essential component of your self-service strategy along with Knowledge Base and Service Catalog.

### Explore
- Communities roles
- Community content types
- Configure community forums
- Forum and user permissions management

### Set up
- Activate Communities plugins
- Properties installed with Communities
- Community setup guide for admins

### Administer
- Create a forum
- Create a forum user
- Create a forum permission
- Invite users to become members of a forum
<table>
<thead>
<tr>
<th>Use</th>
<th>Develop</th>
<th>Troubleshoot and get help</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Community subscriptions</td>
<td>• Configure the community profile</td>
<td>• Search the Known Error Portal for known error articles</td>
</tr>
<tr>
<td>• Gamification</td>
<td>• Enable users to self-register to a community</td>
<td>• Contact Customer Service and Support</td>
</tr>
<tr>
<td>• Domain separation and Communities</td>
<td>• Enable knowledge harvesting</td>
<td>• Ask or answer questions in the Now Community.</td>
</tr>
<tr>
<td></td>
<td>• View the Communities performance dashboard</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Make an announcement to community members</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Moderate a community</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Administer gamification</td>
<td></td>
</tr>
<tr>
<td>Use</td>
<td>Develop</td>
<td>Troubleshoot and get help</td>
</tr>
<tr>
<td>• Community homepage features for logged in users</td>
<td>• Developer training</td>
<td>• Search the Known Error Portal for known error articles</td>
</tr>
<tr>
<td>• Request membership to a forum</td>
<td>• Developer documentation</td>
<td>• Contact Customer Service and Support</td>
</tr>
<tr>
<td>• Search the community</td>
<td></td>
<td>• Ask or answer questions in the Now Community.</td>
</tr>
<tr>
<td>• Subscribe to content</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Ask a question in the community</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Post a blog in the community</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Post a video in the community</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Post a document in the community</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Post a community event</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Bookmark community content</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Provide feedback on community content</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Report inappropriate community content</td>
<td></td>
<td></td>
</tr>
<tr>
<td>© 2021 ServiceNow, Inc. All rights reserved.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.</td>
<td></td>
<td>1436</td>
</tr>
</tbody>
</table>
• Manage your community profile
• Follow a community user
• Harvest knowledge from a community
• View a list of questions and create a case
• Moderate gamification

Activate Communities plugins
Activate the Customer Communities plugin to use the Communities application.

Before you begin
Role required: sn_communities.admin

About this task
Communities is available for customers who are:
• Licensed for the Customer Service Management application.
• Licensed for HR Service Delivery.

To activate Communities, activate the Customer Communities plugin (com.sn_customer_communities). This plugin is not active by default. When you activate the Customer Communities plugin, the following plugins automatically activate:
• External User Registration plugin (com.sn_external_user_register)
• Communities plugin (com.sn_communities)
• Gamification plugin (com.snc.gamification)
• Subscriptions and Activity Feed Framework plugin (com.snc.activity_subscriptions)

To activate Communities demo data, activate the Communities Demo Data plugin (com.sn_communities_demo).
To activate the Communities dashboard, activate the Performance Analytics — Content Pack — Communities plugin (com.snc.pa.communities).
Procedure
1. Navigate to **System Definition > Plugins**.
2. Search for the plugin com.sn_communities.
3. Click **Activate**.

Properties installed with Communities
Community administrators can use properties to configure Communities behavior.

The following properties are available for further configuration. To list the properties, enter `sys_properties.list` in the filter navigator and search for the property to configure.

ℹ️ **Note:** You can also view **Community Properties** and **Forum Properties** from the application navigator. These modules contain a list of the most frequently used properties that you can configure for your community.

### Communities properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_communities.adminNoReplyEmail</td>
<td>Email address for community-related notifications.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: <a href="mailto:communityadmin@servicenow.com">communityadmin@servicenow.com</a></td>
</tr>
<tr>
<td>sn_communities.additional_search_sources</td>
<td>List of additional search sources</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: &quot;community-forums, community-topics, community-user-profiles&quot;</td>
</tr>
<tr>
<td>sn_communities.scheduling.allow_authors</td>
<td>Allow or restrict authors to schedule the content.</td>
</tr>
<tr>
<td></td>
<td>• Type: boolean</td>
</tr>
<tr>
<td></td>
<td>• Default value: Yes</td>
</tr>
<tr>
<td>sn_communities.attachments.max_allowed_size</td>
<td>Maximum file size of an attachment</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: 5 MB</td>
</tr>
<tr>
<td>sn_communities.attachments.document.max_allowed_size</td>
<td>Maximum file size of a community document</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: 5 MB</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Communities properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>sn_communities.blog_count</strong></td>
<td>Number of blogs that a user can post per day.</td>
</tr>
<tr>
<td><strong>sn_communities.content.meta_description</strong></td>
<td>When generating SEO data for an entity, the number of characters that are fetched from the meta_description column of the record to generate a portion of the SEO &lt;description&gt; tag for the record.  Typically, the SEO &lt;description&gt; tag for a Community entity is the combination of ‘forum name’, ‘topics’ and ‘meta description’ of the actual record in the following format: “&lt;forum&gt; - &lt;topics&gt; - &lt;sub string of configured length of the actual description&gt;”.</td>
</tr>
<tr>
<td><strong>sn_communities.content.views.count.limit</strong></td>
<td>Number of views for content pages that are allowed per session within a time window specified by sn_communities.content.views.time.limit.</td>
</tr>
<tr>
<td><strong>sn_communities.content.views.time.limit</strong></td>
<td>Duration, in seconds, during which a specific number of views are allowed. The number of views allowed during this time is set by sn_communities.content.views.count.limit parameter.</td>
</tr>
<tr>
<td><strong>sn_communities.disable_terms_conditions_role</strong></td>
<td>Comma-separated list of roles that bypass the terms and conditions and profile name request.</td>
</tr>
<tr>
<td><strong>sn_communities.edit_content_explicit_role</strong></td>
<td>Comma-separated list of roles with permission to edit existing content, but not to create content.</td>
</tr>
<tr>
<td><strong>sn_communities.enable_session_cache</strong></td>
<td>Enables or disables session cache for the community. If True: The permissions of any non-admin users of the community are stored as a part of the session. They are used to determine access to the various forums and community content. Any changes to the community permissions do not take effect until the user logs out. If False: The permissions of any non-admin users of the community are not stored as a part of the session.</td>
</tr>
</tbody>
</table>
### Communities properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>sn_communities.enable_topics</strong></td>
<td>Enables or disables topics within a community. If the property is set to false and gamification is enabled, topic information does not appear on the leaderboard page.</td>
</tr>
<tr>
<td><strong>sn_communities.enable_user_mentions</strong></td>
<td>Enables or disables the user-mentions functionality in Communities content.</td>
</tr>
<tr>
<td><strong>sn_communities.glide.script.block.client.globals</strong></td>
<td>Set the value to true to re-enable most of the inaccessible Client APIs in a scoped application.</td>
</tr>
<tr>
<td><strong>sn_communities.implicit_access_mapping</strong></td>
<td>Assign access implicitly to users based on the permissions they have. For example:</td>
</tr>
<tr>
<td></td>
<td>• If a user is given forum_admin access, they can automatically administer, read, write to, and moderate the forum.</td>
</tr>
<tr>
<td></td>
<td>• If a user is given forum moderation rights, they can read, write to, and moderate the forum for all content types.</td>
</tr>
<tr>
<td><strong>sn_communities.instance_base_url</strong></td>
<td>Vanity URL for your instance to be used in email notifications to redirect users to the community pages. Set a value only if you want the URL to be different to the instance name.</td>
</tr>
<tr>
<td><strong>sn_communities.is_content_write_allowed_for_guest_user</strong></td>
<td>Determines whether Content_write access is allowed for a public or guest user.</td>
</tr>
<tr>
<td></td>
<td>False: Content_write access is not given to a public or guest user.</td>
</tr>
<tr>
<td></td>
<td>True: Content_write access is given to a public or guest user.</td>
</tr>
<tr>
<td><strong>sn_communities.knowledge_base_id</strong></td>
<td>All questions created in Communities are entered in this knowledge base.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>sn_communities.logging.destination</td>
<td>Location of the log messages.</td>
</tr>
<tr>
<td>sn_communities.log.verbosity</td>
<td>Code Search log verbosity for the community.</td>
</tr>
<tr>
<td>sn_communities.logging.verbosity</td>
<td>Category for writing log messages.</td>
</tr>
<tr>
<td>sn_communities.max_topic_limit</td>
<td>Maximum number of topics that can be associated to any content type.</td>
</tr>
<tr>
<td>sn_communities.minimum_activity</td>
<td>Minimum number of activities required to make the activity feed the preferred feed.</td>
</tr>
<tr>
<td>sn_communities.portal_default_config</td>
<td>Community portal default configuration.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>sn_communities.public_forum_user</td>
<td>sys_id of the public forum user. Used to calculate access permissions to forums.</td>
</tr>
<tr>
<td>sn_communities.registered_forum_user</td>
<td>sys_id of the registered forum user. This value is used to calculate access permissions to forums.</td>
</tr>
<tr>
<td>sn_communities.video_count</td>
<td>Number of videos a user can post per day.</td>
</tr>
<tr>
<td>sn_communities.default_permission_for_forum_memberships</td>
<td>Sets the default permission for forum memberships.</td>
</tr>
<tr>
<td>sn_communities.forumListBatchSize</td>
<td>Default number of forums to show on the topics list page on the community portal.</td>
</tr>
<tr>
<td>sn_communities.topicListBatchSize</td>
<td>Default number of topics to show on the topics list page on the community portal.</td>
</tr>
<tr>
<td>sn_communities.disableForumInvitesForExternalEmails</td>
<td>Determines if forum invites from the forum page can be sent to external users.</td>
</tr>
</tbody>
</table>

⚠️ Note: Do not change this value manually because it may affect forum email invite functionality.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_communities.attachments.document.max_size</td>
<td>Maximum attachment file size in MB. (1 MB = 1024 KB)</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: 5</td>
</tr>
<tr>
<td>sn_communities.attachments.file_extensions</td>
<td>Supported file extensions for community attachments.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: PPT,PPTX,XLS,XLSX,DOC,DOCX,TXT,PDF,PNG,BMP,JPG,JPEG,GIF,ZIP</td>
</tr>
<tr>
<td>sn_communities.attachments.max_attachment_count</td>
<td>Maximum number of attachments that can be attached to community content.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: 3</td>
</tr>
<tr>
<td>sn_communities.attachments.max_file_size</td>
<td>Maximum attachment file size in MB.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: 2</td>
</tr>
<tr>
<td>sn_communities.attachments.max_invalid_attempts</td>
<td>Maximum number of invalid attempts a user can make to upload an attachment.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: 3</td>
</tr>
<tr>
<td>sn_communities.attachments.max_total_size</td>
<td>Maximum total size (in GB) of attachments.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: 500</td>
</tr>
<tr>
<td>sn_communities.attachments.total_size</td>
<td>Total size (in KB) of attachments</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: 3680.04</td>
</tr>
<tr>
<td>sn_communities.attachments.user.day_limit</td>
<td>Maximum number of attachments that can be attached to community content per user per day.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: 20</td>
</tr>
<tr>
<td>sn_communities.days_to_keep_search_logs</td>
<td>Sets the number of days to keep search logs.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Communities properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_communities.minimum_characters_to_search</td>
<td>Number of characters before a search engine starts working in a community. This number must be greater than or equal to 3.</td>
</tr>
<tr>
<td>sn_communities.search.blog.enable_acl</td>
<td>Sets how permissions are evaluated for blog type content. True: Permission is evaluated for that specific content type and user. False: Permission is evaluated at the forum and content level.</td>
</tr>
<tr>
<td>sn_communities.search.document.enable_acl</td>
<td>Sets how permissions are evaluated for document type content. True: Permission is evaluated for that specific content type and user. False: Permission is evaluated at the forum and content level.</td>
</tr>
<tr>
<td>sn_communities.search.event.enable_acl</td>
<td>Sets how permissions are evaluated for event type content. True: Permission is evaluated for that specific content type and user. False: Permission is evaluated at the forum and content level.</td>
</tr>
<tr>
<td>sn_communities.search.video.enable_acl</td>
<td>Sets how permissions are evaluated for video type content. True: Permission is evaluated for that specific content type and user. False: Permission is evaluated at the forum and content level.</td>
</tr>
</tbody>
</table>

- Type: integer
- Default value: 180
- Type: integer
- Default value: 3
- Type: boolean
- Default value: false
- Type: boolean
- Default value: false
- Type: boolean
- Default value: false
## Communities properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_communities.user.document_count</td>
<td>Number of documents a user can post per day.</td>
</tr>
<tr>
<td>sn_communities.video_count</td>
<td>Number of videos a user can post per day.</td>
</tr>
<tr>
<td>sn_communities.view_log_sources</td>
<td>JSON string that provides a mapping of view log source to a static source type.</td>
</tr>
<tr>
<td>sn_communities.knowledge.enable_harvesting</td>
<td>Enables knowledge harvesting.</td>
</tr>
</tbody>
</table>

## Activity Subscription properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.actsub.activities.api.fetch.limit</td>
<td>Number of activities in the activity feed.</td>
</tr>
<tr>
<td>com.snc.actsub.activity.rate.count.limit</td>
<td>Number of activities that can be created within a certain time frame.</td>
</tr>
</tbody>
</table>
### Activity Subscription properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.actsub.activity.rate.time.limit</td>
<td>Duration, in seconds, during which activities can be created. Activities are no longer created after the limit.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 3600</td>
</tr>
<tr>
<td>com.snc.actsub.activity.stream.user.limit</td>
<td>Enter the limit on number of activities stored for a user in the activity feed. The oldest activities are deleted when the limit is reached.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 2000</td>
</tr>
<tr>
<td>com.snc.actsub.core.disable_plugin</td>
<td>Enable (true) or disable (false) the plugin functionality.</td>
</tr>
<tr>
<td></td>
<td>• Type: boolean</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
<tr>
<td>com.snc.actsub.activity.stream.inactive.disabled</td>
<td>Disable pull model for activity feed so that the activity fanouts are disabled and not pushed to the inactive user streams.</td>
</tr>
<tr>
<td></td>
<td>• Type: boolean</td>
</tr>
<tr>
<td></td>
<td>• Default value: false</td>
</tr>
</tbody>
</table>

**Note:** When disabled, run the Manage Activity fanouts scheduled job for the changes to take immediate effect.

<table>
<thead>
<tr>
<th>com.snc.actsub.activity.stream.inactive.duration</th>
<th>The duration after which fanouts will be disabled for inactive user streams.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 30</td>
</tr>
<tr>
<td>com.snc.actsub.activity.stream.inactive.streams</td>
<td>Enter comma separated stream names which can be considered</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| inactive when not accessed for a certain duration. | • Type: string  
• Default value: default |
| com.snc.actsub.activity.enable_fanout_config | Enable the property to trigger Activity Fanouts based on the configuration at Activity Type. Confirm if they are properly configured and then enable the flag.  
  • Type: boolean  
  • Default value: false  

  ⚠ Note: For zboot, this property is enabled by default. You must create this property for upgrade scenarios. |

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| sn_ext_usr_reg.allowed_email_domains        | Comma-separated list of email domains that can be used to register. By default, the value is empty, indicating that all email domains are allowed.  
  • Type: string  
  • Default value: none |
| sn_ext_usr_reg.captchaEnabled               | Enables Google re-CAPTCHA on the self-registration page.  
  • Type: boolean  
  • Default value: true |
| sn_ext_usr_reg.eur_user_role                | Adds a role when a sys_user record is created through self-registration. |
### External User Registration properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: sn_communities.community_user</td>
</tr>
<tr>
<td>sn_ext_usr_reg.Reg_link_expiration_days</td>
<td>Number of days that the registration link remains active. Links which are older than the specified number of days are deactivated and cannot be used for completing the registration process.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 3</td>
</tr>
<tr>
<td>sn_ext_usr_reg.request_count</td>
<td>Maximum number of times a registration link can be requested.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 3</td>
</tr>
<tr>
<td>sn_ext_usr_reg.Temp_user_record_purge_days</td>
<td>Number of days that a registration record is maintained in the User Registration Request [user_registration_request] table. Records older than the specified number of days are deleted.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 30</td>
</tr>
</tbody>
</table>

### Gamification properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_communities.enable_gamification</td>
<td>Enables or disables the gamification feature for the community and controls the appearance of gamification-related widgets on the Community portal.</td>
</tr>
</tbody>
</table>
### Gamification properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_communities.content.show_gamification_level</td>
<td>the gamification level that is displayed next to the Community user's name on the Content pages.</td>
</tr>
<tr>
<td>sn_gamification.days_to_keep_activity_records</td>
<td>number of days to keep the gamification activity records in the database. Records created or updated prior to the specified number of days are purged.</td>
</tr>
<tr>
<td>sn_gamification.enable_debug_logs</td>
<td>Enables the debug logs for the gamification feature.</td>
</tr>
</tbody>
</table>

- **Property**: sn_communities.content.show_gamification_level
- **Description**: When set to false, no gamification components are displayed. User point totals and badge assignments are not affected.
  - Type: boolean
  - Default value: true

- **Property**: sn_gamification.days_to_keep_activity_records
- **Description**: Controls the gamification level that is displayed next to the Community user's name on the Content pages.
  - Type: choice list
  - Choices:
    - **none**: Do not display the user's level
    - **sn_gamification_modules**: Show the user's level in the Community
    - **sn_communities_forum**: Show the user's level for the forum to which the content belongs
  - Default value: sn_gamification_modules

- **Property**: sn_gamification.enable_debug_logs
- **Description**: Enables the debug logs for the gamification feature.
  - Type: boolean
  - Default value: false
### Gamification properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_gamification.levels_limit</td>
<td>Maximum number of levels that can be defined for the gamification feature.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 10</td>
</tr>
</tbody>
</table>

### Questions to case properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn.communities.enable_csm_case_creation_from_question</td>
<td>This property provides access to the “Create Case” option on the Community Question widget and the “Question to Case” option on the Community header list menu.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
</tbody>
</table>

### Communities roles

Ensure that users can perform all necessary actions by assigning roles.

**Roles**

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Access via</th>
</tr>
</thead>
<tbody>
<tr>
<td>Community administrator [sn_communities.admin]</td>
<td>Administer and manage all sections in the community.</td>
<td>• Platform UI</td>
</tr>
<tr>
<td>Community moderator [sn_communities.community_moderator]</td>
<td>Moderate content associated with the community.</td>
<td>• Platform UI</td>
</tr>
<tr>
<td>Forum administrator [sn_communities.forum_admin]</td>
<td>Administer and manage forum permissions, content types, and topics associated to the forum.</td>
<td>• Platform UI</td>
</tr>
<tr>
<td>Role</td>
<td>Description</td>
<td>Access via</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Forum moderator</td>
<td>Moderate content within specified forums.</td>
<td>• Platform UI</td>
</tr>
<tr>
<td>[sn_communities.forum_moderator]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Moderation administrator</td>
<td>Administer moderation settings and moderate content associated forums.</td>
<td>• Platform UI</td>
</tr>
<tr>
<td>[sn_communities.moderation_admin]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gamification administrator</td>
<td>Administer gamification settings and configure gamification rules. Contains the sn_gamification.moderator role.</td>
<td>• Platform UI</td>
</tr>
<tr>
<td>[sn_gamification.admin]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gamification moderator</td>
<td>Review and edit the gamification points earned by community users.</td>
<td>• Platform UI</td>
</tr>
<tr>
<td>[sn_gamification.moderator]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Community user</td>
<td>Any user who has signed up and accepted the community Terms &amp; Conditions. Their access to forums depends on the permissions set up for each specific forum.</td>
<td>• Communities Portal</td>
</tr>
<tr>
<td>[sn_communities.community_user]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Knowledge harvester</td>
<td>A community user who can harvest knowledge articles from a community. Community administrators, and community moderators inherit this role by default. The knowledge harvester role must be granted to other users.</td>
<td>• Communities Portal</td>
</tr>
<tr>
<td>[sn_communities.knowledge_harvester]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Proxy case creator</td>
<td>A community user who can create a customer</td>
<td>• Communities Portal</td>
</tr>
<tr>
<td>[sn_customerservice.proxy_case_creator]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Roles (continued)

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Access via</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>service case from a community discussion.</td>
<td></td>
</tr>
</tbody>
</table>

Community setup guide for admins

Define your requirements with community and forum stakeholders and set up your forums for community users to start creating content.

Requirements

Role required: sn_communities.admin or sn_communities.forum_admin

Before you begin

Meet with the stakeholders

<table>
<thead>
<tr>
<th>Stakeholder</th>
<th>Responsibilities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forum administrators</td>
<td>Define and oversee the forum processes for day-to-day operations related to topic creation, user management, and moderation.</td>
</tr>
<tr>
<td>Community administrators</td>
<td>Configure advanced settings for Communities features.</td>
</tr>
<tr>
<td>Community users</td>
<td>Contribute content in the form of questions, answers, blogs, and comments.</td>
</tr>
</tbody>
</table>

With stakeholders, determine your community requirements

- Who are the consumers of the community content?
- Which content types can users contribute?
- Who can contribute content and who should have read-only access?
- What should the names of the initial forums be?
- Within these forums, what should the names of the initial topics be?
• Which keywords should be banned?
• How should the system moderate content and users?
• What should the default notifications that users receive for various community activities be?

What to do
Use the following steps as guidance to setting up your community.

1. **Create a forum user**: Create a forum user to use to define memberships to a forum.

2. **Create a permission**: Create a permission to use to define a user's access to a forum and its content types.

3. **Add access and content types to your permission**: Add access types to a permission to determine the access that users have to certain forums and content.

4. **Create a forum**: Create a forum to provide a place for users to share content and configure the forum to allow registered users to request access to join.

5. **Configure content types for a forum**: Configure content types for a forum to define which types of content to use in a particular forum.

6. **Create a forum permission**: Create a forum permission by adding a forum user and a permission to a forum.

If required, perform the following actions:

**Invite users to join the forum**

Invite users to become members of a forum to encourage greater community involvement.

**Create permission exceptions**

Create a permission exception for users who require specific permissions for a forum.

**Copy permissions**

• Copy permissions from a forum to copy all permissions and content types from one forum to another.

• Copy permissions from a parent forum.

**Debug user permissions**

Debug user permissions to investigate and diagnose problems with user access to forums.
Next steps
Create a topic for users to create and share content.
Add a topic to a forum so that users can associate content to that topic.
Moderate a community to set up how the system moderates content and users.

Using guided setup to implement Communities
Communities guided setup provides a sequence of tasks that help you configure Communities on your ServiceNow instance. To open Communities guided setup, navigate to Community > Administration > Guided Setup.
For more information about using the guided setup interface, see Using guided setup.

Domain separation and Communities
Domain separation is unsupported in Communities. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can control several aspects of this separation, including which users can see and access data.

Support level: No support
• The domain field may exist on data tables but there is no business logic to manage the data.
• This level is not considered domain-separated.

For more information on support levels, see Application support for domain separation.

Related information
Domain separation for service providers

Quick start tests for Communities
Validate that Communities still work after you make any configuration change, such as apply an upgrade or develop an application. Copy and customize these quick start tests to pass when using your instance-specific data.

Communities quick start tests require activating the Customer Communities plugin (com.sn_customer_communities) and the Communities Demo Data plugin (com.sn_communities_demo).
## Communities: Community test suite

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Post question and validate feed</td>
<td>Verify that a question is posted in the community and validate whether it appears in the content feed.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Post video</td>
<td>Verify that a video is posted in the community.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Forum membership approval</td>
<td>Verify that a membership request to a forum is approved.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Forum membership reject</td>
<td>Verify that a membership request to a forum is rejected.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Approve a moderation task</td>
<td>Verify that a moderation task is approved.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Reject a moderation task</td>
<td>Verify that a moderation task is rejected.</td>
<td>Madrid</td>
</tr>
<tr>
<td>Topic subscription and activity feed validation</td>
<td>Verify that a topic is subscribed to and the topic activities appear in the activity feed.</td>
<td>New York</td>
</tr>
<tr>
<td>Approve content approval workflow task on question</td>
<td>Verify the content approval workflow of a question.</td>
<td>New York</td>
</tr>
<tr>
<td>Question auto-subscription and activity feed validation</td>
<td>Verify that the author is automatically subscribed to the question and the question activities appear in the activity feed.</td>
<td>New York</td>
</tr>
<tr>
<td>Follow a user</td>
<td>Verify that a community user is able to follow another community user.</td>
<td>New York</td>
</tr>
</tbody>
</table>
### Communities: Community test suite (continued)

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
<th>Release version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reject content approval workflow task on question</td>
<td>Verify the content approval workflow of a question when content is rejected.</td>
<td>New York</td>
</tr>
<tr>
<td>Gamification on video posting</td>
<td>Verify the gamification points gained when posting a video.</td>
<td>New York</td>
</tr>
<tr>
<td>Forum subscription and activity feed validation</td>
<td>Verify that a forum is subscribed to and the forum activities appear in the activity feed.</td>
<td>New York</td>
</tr>
<tr>
<td>Question subscription and activity feed validation</td>
<td>Verify that a question is subscribed to and the question activities appear in the activity feed.</td>
<td>New York</td>
</tr>
<tr>
<td>Post a video with 'Disable comment' option</td>
<td>Verify a video is posted with disable comments option as selected.</td>
<td>Orlando</td>
</tr>
<tr>
<td>Pin a video as Featured</td>
<td>Verify that a video is marked as featured by community administrator in the forum and community home page.</td>
<td>Orlando</td>
</tr>
</tbody>
</table>

### Related information

**Quick start tests**

**Configure a community**

You can configure various aspects of Communities based on the specific requirements of your organization.

**Before you begin**

Role required: sn_communities.admin or sn_communities.forum_admin
About this task
Access the Community menus and use the modules to configure your community.

Procedure
1. Navigate to Community and choose the menu and module you require.
2. Configure one or more of the following aspects for your community.

Community content types
There are seven supported content types: Answer, Blog, Comment, Document, Event, Question, and Video.

Community administrators and forum administrators can configure content types at the community and forum levels.
User access to content is based on the permissions that users have. Community users can add content to the different content types and provide feedback on the content.

<table>
<thead>
<tr>
<th>Content type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Question</td>
<td>Post a question about an issue or a challenge and get answers from other users. You can submit your question on the Community homepage and choose a forum or a topic to post it in. A question can be tagged to more than one topic.</td>
</tr>
<tr>
<td>Answer</td>
<td>Reply to a user question or another answer with a possible solution or statement.</td>
</tr>
<tr>
<td>Blog</td>
<td>Post a blog on a topic of interest to share with other users. You can include images and videos.</td>
</tr>
<tr>
<td>Comment</td>
<td>Enter a comment to express an opinion or to react to a video or a blog.</td>
</tr>
</tbody>
</table>
| Video        | Upload a video on a topic of interest for other users. Videos appear as web
## Content types (continued)

<table>
<thead>
<tr>
<th>Content type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>URLs</strong> that link to the most popular video sites. Communities supports playback from:</td>
<td><strong>Note:</strong> Videos can be included in other types of content, including questions, answers, blogs, and comments.</td>
</tr>
<tr>
<td>- YouTube – youtube.com</td>
<td></td>
</tr>
<tr>
<td>- Vimeo – vimeo.com</td>
<td></td>
</tr>
<tr>
<td>- DailyMotion – dailymotion.com</td>
<td></td>
</tr>
<tr>
<td>- Facebook – facebook.com</td>
<td></td>
</tr>
</tbody>
</table>

| **Document** | Post a document to share with other community members. You can post your document from within a forum, choose a topic to post it in, and tag it to more than one topic. |
| **Event** | Create an event that other community users can register for and attend. |

## Configure community content types

Configure content types, such as videos and blogs, for the community.

### Before you begin

**Role required:** sn_communities.admin

### About this task

You can configure content types at both the community and forum level. At the community level, content types are active by default. Based on your requirements, you can deactivate content types.
Procedure
1. To configure content types at the community level, navigate to Community > Administration > Content Types.
2. Click a content type.
3. To deactivate a content type, clear the Active check box.
4. Click Update.
   The content type is no longer visible to the community.
5. To configure content types at the forum level, navigate to Community > Administration > Forums.
6. Click a forum.
7. Click the Content Types related list.
8. In the Active column, double-click a row.
9. To activate a content type, select True. To deactivate a content type, select False.

Community feedback types
There are two supported feedback types: Upvote and Helpful.
Community users can provide feedback on the content they have access to in the community.

<table>
<thead>
<tr>
<th>Feedback type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Helpful</td>
<td>Helpful feedback is associated to the following content types when a community user marks content as helpful: Blog, Video, Documents, Answer, Comment.</td>
</tr>
<tr>
<td>Upvote</td>
<td>Upvote feedback is associated to the Question content type when a community user marks a question as helpful.</td>
</tr>
</tbody>
</table>

Community access types
Access types are used to control access to a forum or a content type.
You can define the access types for a forum and a content type in a permission. There are four access types available by default.

### Access types

<table>
<thead>
<tr>
<th>Access type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forum Admin</td>
<td>Applies to forums.</td>
</tr>
<tr>
<td>Forum Moderator</td>
<td>Applies to forums.</td>
</tr>
<tr>
<td>Content Read</td>
<td>Applies to all content types.</td>
</tr>
<tr>
<td>Content Write</td>
<td>Applies to all content types. Content Read access is automatically included</td>
</tr>
</tbody>
</table>

**Note:** It is not recommended that you create your own access types. Advanced knowledge of Communities architecture and scripting code to support and interpret the new access type is required.

Contact Customer Service and Support for further information.

To see all available access types, navigate to **Community > Administration > Access Types**.

### Configure video sources for a community

Configure additional sources that can be used for uploading a video to the community.

**Before you begin**
- **Role required:** sn_communities.admin

**Procedure**

1. Navigate to **Community > Administration > Video Configuration**.
2. Click **New**.
3. On the form, fill in the fields.

### Video Configurations form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>A video source website, for example, youtube.com.</td>
</tr>
<tr>
<td>Domain</td>
<td>The domain is set to <strong>global</strong> by default.</td>
</tr>
</tbody>
</table>
Configure community forums

An application is a place for users to share content, exchange notes, ask and answer questions, and so on. Before community users can contribute content, configure a forum with content types and permissions, and create and add topics to one or more forums.

**Before you begin**
*Role required: sn_communities.admin or sn_communities.forum_admin*

**About this task**
A forum is the container for user-created content. A forum must be configured with content types and permissions before becoming available for users to contribute content. Forums can be organized hierarchically using the **Parent** field. Once forums are set up, they are visible on the Community homepage based on user permissions.

A topic is an area of interest that users can discuss. Topics are visible from the Community homepage and also appear within forums. They can be organized hierarchically using the **Parent** field.

- The community admin creates topics and can associate a topic with one or many forums.
- Forum admins can associate topics with their own forums.
- If a user has access to a particular forum, they also have access to all its topics.

**Procedure**
Configure one or more of the following for community forums and topics.

**Create a forum**
Create a forum to provide a place for users to share content. You can configure forums for membership that registered community users request access to.
join. You can also configure forums to convert unstructured conversations to structured knowledge articles.

Before you begin
Role required: sn_communities.admin

About this task
A forum can be configured in the following ways.

<table>
<thead>
<tr>
<th>Public</th>
<th>Visible to all users, including non-logged in users. All users have content_read access to questions and answers in public forums. Configure public forms by adding a forum user of the type public.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Private</td>
<td>Visible only to users who have been assigned the required permissions in the forum. Configure private forums by adding a forum user of the type custom and adding specific users or user groups to that forum user.</td>
</tr>
<tr>
<td>Membership</td>
<td>The forum title is visible to registered community users. Community users must request membership to get full access to the content in the forum. Configure membership forums by selecting the Enable Membership for this Forum check box.</td>
</tr>
</tbody>
</table>

Procedure
1. Navigate to Community > Administration > Forums.
2. In the Forums list, click New.
3. Fill in the fields on the form as appropriate.

<table>
<thead>
<tr>
<th>Forum form</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the forum.</td>
</tr>
<tr>
<td>Description</td>
<td>A short description that defines the forum.</td>
</tr>
<tr>
<td>Image</td>
<td>An image that provides a visual reference to describe the forum.</td>
</tr>
<tr>
<td>Order</td>
<td>The order that forums are displayed in. By default, the display is alphabetical. Enter a numerical value to set the order that forums are displayed in. You can combine both options.</td>
</tr>
<tr>
<td>Parent</td>
<td>The parent forum, if required. This lists the forum as a sub forum of the parent forum.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Enable Membership for this Forum</td>
<td>Check box to make the forum membership only, and enable registered forum users to request to join the forum. If you select this check box, the forum title is visible to all registered community users. Community users must request access to join the forum to see the content.</td>
</tr>
<tr>
<td>Note:</td>
<td>The Approval Workflow for Membership field appears when you select this check box.</td>
</tr>
<tr>
<td>Approval Workflow for Membership</td>
<td>The workflow for approving new members of a forum.</td>
</tr>
<tr>
<td>Knowledge Base used for harvesting</td>
<td>The knowledge base used for harvesting community discussions to knowledge articles.</td>
</tr>
</tbody>
</table>

4. To allow registered forum users to view and request to join a forum, select the **Enable Membership for this Forum** check box and complete the following steps.

   a. Right-click the form header and click **Save**.  
      Two default permissions are added to the forum in the **Forum Permissions** related list.
      
      - **Default Permission for Memberships**: Read and write access to questions and answers for users who are forum members.
      
      - **Forum Visible**: Read access to the name and description of the forum for registered users. To access content, users must request forum membership.

   b. If required, you can add a **new forum permission** and set it as the default using the `sn_communities.default_permission_for_forum_memberships` property.

      **Example**
      If you want public users to view content in the forum to attract them to become members, create a forum permission as follows:
      
      - **Forum User**: Public.
      
      - **Permission**: Question & Answer Read.

   c. In the **Approval Workflow for Membership** field, perform one of the following options.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Leave the Approval Workflow for Membership field blank.</td>
<td>Membership requests to the forum are automatically approved.</td>
</tr>
<tr>
<td>Select the preconfigured approval workflow</td>
<td>A task is created and sent to the community or forum administrator for approval.</td>
</tr>
<tr>
<td>Forum Membership Approval.</td>
<td>A task is created and sent to the users defined in your workflow for approval.</td>
</tr>
<tr>
<td>Select a workflow that you have created.</td>
<td></td>
</tr>
</tbody>
</table>

5. Click **Update**.

**Related information**

- Add a topic to a forum
- Configure community content types
- Create a forum permission

**Configure content types for a forum**

Define which types of content to use in a particular forum and associate a workflow so that content is reviewed before becoming visible to other community users.

**Before you begin**

Role required: sn_communities.forum_admin

**Procedure**

1. Navigate to **Community > Administration > Forums**.
2. Click a forum.
3. In the **Content Types** related list, click **New**.
4. In the Content Types list, select a **Content Type**.
5. Select an **Approval Workflow**.
   - You can select the **Community - Content Approval** workflow or a workflow that you have created.
6. Click **Submit**.
Results
The selected content type is added to the Content Types related list in the forum. The following secondary content types are automatically added when creating a primary content type.

<table>
<thead>
<tr>
<th>Primary content type</th>
<th>Secondary content type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Question</td>
<td>Answer</td>
</tr>
<tr>
<td>Blog, Document, Event, Video</td>
<td>Comment</td>
</tr>
</tbody>
</table>

Invite users to become members of a forum
Invite users to become members of a particular forum to encourage greater community involvement.

Before you begin
Role required: sn_communities.admin or sn_communities.forum_admin

Procedure
1. Navigate to Community > Forums.
2. Choose a forum from the list that has been configured for membership.
3. Select the Invite Users to Join this Forum related link.
4. Complete the following steps to invite internal and external users.
   a. If the users to send the email invitation to are internal, click Edit Users.
   b. If external user registration is enabled, the Enter email address field is shown.
      Enter the email addresses of the external users to send the email invitation to.
      You can enter both internal and external users to your email invitation.
5. Enter Comments to personalize the text in the email invitation.
6. Click Submit.
   An email is generated and sent to the users in the list. The approval workflow set in the forum determines the approval of membership from an email invitation. You can view all email invitations in the forum on the Forum Email Invites related list.

Approve forum memberships
Manage forum membership approvals when registered community users request membership to a forum.
Before you begin
Role required: sn_communities.admin or sn_communities.forum_admin

About this task
There are two ways of approving forum memberships.

Procedure
1. Perform one of the following actions.
   • Navigate to Community > Forums.
     a. Choose a forum from the list that has been configured for membership.
     b. Click the Membership Approvals related list.
   • Navigate to Self-Service > My Approvals.
2. Accept or reject the membership requests.
   Only one approval is required for each task.
   Once the task has been approved or rejected, an email notification is sent to
   the user.

Create a topic
Create a topic for users to create and share content.

Before you begin
Role required: sn_communities.admin

Procedure
1. Navigate to Community > Administration > Topics.
2. Click New.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the topic.</td>
</tr>
<tr>
<td>Description</td>
<td>A short description to define what the topic is.</td>
</tr>
<tr>
<td>Parent</td>
<td>The parent topic, if required. If you enter a parent topic, the topic is listed as a subtopic of the parent topic.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Image</td>
<td>An image that provides a visual reference that describes the topic.</td>
</tr>
<tr>
<td>Knowledge category used for harvesting</td>
<td>The knowledge category used to categorize community discussions harvested to knowledge articles.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.
   The topic is created and added to the list of topics.

**What to do next**
Add a topic to a forum.

**Add a topic to a forum**
Add a topic to a forum so that users can associate content to that topic.

**Before you begin**
Role required: sn_communities.forum_admin

**About this task**
A topic can belong to more than one forum.

**Procedure**
1. Navigate to **Community > Administration > Forums**.
2. In the list, click the forum name.
3. Click the **Forum Topics** related list.
4. Click **New**.
5. From the **Topic** list, select a topic.
6. Click **Submit**.
   The selected topic is added to the Forum Topics list in the forum. The topic is available to users in this forum.

**Disable topics in a community**
Disable the topics feature so that no topic information is visible in your community.

**Before you begin**
Role required: sn_communities.admin
About this task
The administrator can change the `sn_communities.enable_topics` property so that all topic information is hidden in the community. The data is not deleted.

Procedure
1. Enter `sys_properties.list` in the filter navigator and search for the `sn_communities.enable_topics` property.
2. In the Value field, enter `false`.
3. Click Update.
   • No topic information is displayed in the Activity Feed or Notifications and Subscriptions.
   • No topic information is displayed on the Forums or Topics landing pages.
   • No topic information is displayed on Gamification pages and widgets.
   • Topic fields do not appear when creating, editing, or viewing content.
   • Topics do not appear in the search results page.

Create a sub forum
Create a sub forum and map it to a parent forum to establish a forum hierarchy.

Before you begin
Role required: `sn_communities.forum_admin`

About this task
There are two ways of creating a sub forum in Communities.

Procedure
1. Navigate to Community > Administration > Forums.
   • On the Forums list page, click New.
   • Locate the forum to create a sub forum in, click its name, and then click the Sub Forums related list.
2. Fill in the fields on the form as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the sub forum.</td>
</tr>
<tr>
<td>Description</td>
<td>A short description that defines the sub forum.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Image</td>
<td>An image that provides a visual reference to describe the sub forum.</td>
</tr>
<tr>
<td>Order</td>
<td>The order that sub forums are displayed in. By default, the display is alphabetical. Enter a numerical value to set the order that forums are displayed in. You can combine both options.</td>
</tr>
<tr>
<td>Parent</td>
<td>The parent forum. This lists the forum as a sub forum of the parent forum.</td>
</tr>
<tr>
<td>Enable Membership for this Forum</td>
<td>Check box to make the forum membership only, and enable registered forum users to request to join the forum. If you select this check box, the forum title is visible to all registered community users. Community users must request access to join the forum to see the content.</td>
</tr>
<tr>
<td>Approval Workflow for Membership</td>
<td>The workflow for approving new members of a forum.</td>
</tr>
<tr>
<td>Knowledge Base used for harvesting</td>
<td>The knowledge base used for harvesting community discussions to knowledge articles.</td>
</tr>
</tbody>
</table>

**Results**

The forum hierarchy of forums and sub forums is displayed on the community home page, forum landing page, when creating questions, blogs, or events, and in the search filters.

**Move forum content**

Move community content posts from one forum to another.

**Before you begin**

Role required: sn_communities.admin, sn_communities.community_moderator, sn_communities.forum_admin, sn_communities.forum_moderator

**About this task**

Access to content is based on permissions to a specific forum. If content is moved, the author of the content and other community users might lose access to it, depending on their forum permissions.
**Note:** Draft content cannot be moved. If the content type is not supported in the new forum, it cannot be moved.

**Procedure**

1. Navigate to the community homepage.
2. Click the content you want to move.
3. Click ... and Edit.
4. Select the forum you want to move the content to.
5. Click Save.

An email notification is sent to the author of the content, subscribers to the content, and subscribers to the forum.

**Forum and user permissions management**

Community and forum administrators can give users and groups of users different levels of access to forums and forum content.

There are three components that make up the security settings for forums: forum users, permissions, and forums.

**Forum users**

A forum user is a logical group of users, user groups, or both. This group is used to define memberships to a forum.

**Permissions**

A permission is a combination of:

- access types for a forum
- access types for a given content type
You can create your own permission or use one of the default permissions that the Communities application delivers.

### Default permissions

<table>
<thead>
<tr>
<th>Permission</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blog Read</td>
<td>Read access to blogs.</td>
</tr>
<tr>
<td>Blog Read and Comment Write</td>
<td>Read access to blogs and write access to comments.</td>
</tr>
<tr>
<td>Blog Write</td>
<td>Write access to blogs.</td>
</tr>
<tr>
<td>Blog Write and Comment Write</td>
<td>Write access to blogs and comments.</td>
</tr>
<tr>
<td>Default Permission for Memberships</td>
<td>Default permissions for forums that are marked as <strong>Enable Membership for this Forum</strong>.</td>
</tr>
<tr>
<td>Default permissions for public user</td>
<td>Public access to forums.</td>
</tr>
<tr>
<td>Default permissions for registered user</td>
<td>Permissions for registered and logged in users.</td>
</tr>
<tr>
<td>Document Read and Comment Write</td>
<td>Read access to documents and write access to comments.</td>
</tr>
<tr>
<td>Document Write and Comment Write</td>
<td>Write access to documents and comments.</td>
</tr>
<tr>
<td>Event Read and Comment Write</td>
<td>Read access to events and write access to comments.</td>
</tr>
<tr>
<td>Event Write and Comment Write</td>
<td>Write access to events and comments.</td>
</tr>
<tr>
<td>Forum Admin</td>
<td>Full access to a forum.</td>
</tr>
<tr>
<td>Forum Moderator</td>
<td>Moderation access to a forum.</td>
</tr>
<tr>
<td>Forum Name and Description Read</td>
<td>Read access to the name and description of a forum. To access content or topics, other permissions are required.</td>
</tr>
<tr>
<td>Full Access</td>
<td>Write and read access to all content types.</td>
</tr>
<tr>
<td>Question and Answer Read</td>
<td>Read access to questions and answers.</td>
</tr>
</tbody>
</table>
Default permissions (continued)

<table>
<thead>
<tr>
<th>Permission</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Question and Answer Write</td>
<td>Write access to questions and answers.</td>
</tr>
<tr>
<td>Question Write</td>
<td>Write access to questions.</td>
</tr>
<tr>
<td>Video Read and Comment Write</td>
<td>Read access to videos and write access to comments.</td>
</tr>
<tr>
<td>Video Write and Comment Write</td>
<td>Write access to videos and comments.</td>
</tr>
</tbody>
</table>

Forums

A forum is the container for user-created content. A forum must be configured with content types and permissions before becoming available for users to contribute content.

To assign permissions to users and user groups, create associations between forum users and permissions for a specific forum.

Note: Forum permissions are not inherited in the forum hierarchy. Each subforum must be configured with its own set of permissions and content types.

- You can use forum users and permissions in multiple forums.
- You can add multiple forum users and permissions to one forum.
• You can copy permissions from a parent forum to a child forum or from another forum altogether.
• You can also define user-specific permission exceptions and debug user permissions.

Create a forum user
You can create forum users, which you then use to define memberships to a forum.

Before you begin
Role required: sn_communities.forum_admin

About this task
A forum user is a set of users and user groups. Forum users are reusable. Multiple forum users can be used in any given forum.

Note: Before creating a forum user, check whether an existing forum user matches your requirements.

Types of forum user

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Public</td>
<td>Public users can view the community without logging in. By default, public users have content_read access to questions and answers in public forums.</td>
</tr>
<tr>
<td>Registered</td>
<td>Users who have signed up to the community and accepted the Terms &amp; Conditions. Once logged in, their access to forum content depends on the permissions set up for each specific forum.</td>
</tr>
<tr>
<td>Custom</td>
<td>Specific users and user groups that are added as members to the current forum user.</td>
</tr>
<tr>
<td>Membership</td>
<td>A group of members who have joined a specific forum. Once logged in, their access to forums depends on the permissions set up for each specific forum.</td>
</tr>
</tbody>
</table>

Procedure
1. Navigate to Community > Administration > Forum Users.
2. Click New.
3. On the form, fill in the fields.
### Forum User form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the user.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the user.</td>
</tr>
<tr>
<td>User type</td>
<td>Type of user.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.
The forum user is created and added to the Forum Users list.

### Add members to a forum user

Add members to a forum user. Members can be individual users or user groups.

**Before you begin**
Role required: sn_communities.forum_admin

**Procedure**

1. Navigate to **Community > Administration > Forum Users**.
2. Click the forum user to add members to.
3. In the Members related list, click **New**.
4. On the form, fill in the fields.

### Members form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forum User</td>
<td>Forum user name. The name is automatically filled.</td>
</tr>
<tr>
<td>Membership Type</td>
<td>Membership type. Choose either <strong>User</strong> or <strong>Group</strong>.</td>
</tr>
<tr>
<td>Member</td>
<td>User or user group to add to the forum user. If you selected Membership Type &gt; User, the Table name is automatically filled with sys_user. If you selected Membership Type &gt; Group, the Table name</td>
</tr>
</tbody>
</table>
Create a permission
Create a permission to use to define a user's access to a forum and the content in the forum.

Before you begin
Role required: sn_communities.admin

About this task
Permissions are reusable. Before creating a permission, check if any existing permissions match your requirements.

Procedure
1. Navigate to Community > Administration > Permissions.
2. Click New.
3. On the form, fill in the fields.

Permission form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name for the permission.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the permission.</td>
</tr>
</tbody>
</table>

4.
5. Click Submit.

Add access types to a permission
Access types for a permission determine the access that users have to certain forums.

Before you begin
Role required: sn_communities.forum_admin
Procedure

1. Navigate to **Community > Administration > Permissions**.
2. In the **Permissions** list, click the permission you created.
3. Click the **Forum Access** related list.
4. Click **New**.
5. Select an access type.
6. Click **Submit**.

What to do next
Create a forum permission.

Related information
- Community content types
- Community access types

Add content types to a permission
Content types for a permission determine the access that users have to certain content in a forum.

Before you begin
Role required: sn_communities.forum_admin

Procedure

1. Navigate to **Community > Administration > Permissions**.
2. In the **Permissions** list, click the permission you created.
3. Click the **Content Type Access** related list.
4. Click **New**.
5. Select a content type and an access type.
6. Click **Submit**.

Create a permission exception
Create a permission exception for users who require specific permissions for a forum.

Before you begin
Role required: sn_communities.forum_admin
About this task
Permission exception records are created for users who require specific permissions for a particular forum, for example, a forum manager. Any other permissions that the user has are no longer valid once an exception is created.

Procedure
1. Navigate to Community > Administration > Forums.
2. Click a forum.
3. Click the Permission Exceptions related list.
   The list of users who have extra permissions for this forum is displayed.
4. Click New.
5. In the User field, enter the name of the user to create a permission exception for.
6. In the Permission field, enter a permission.
7. Click Submit.
   A permission exception is created and added to the list of Permission Exceptions on the forum.

Clone a permission
Clone a permission if an existing permission record cannot be modified and you require a permission record with similar settings.

Before you begin
Role required: sn_communities.forum_admin

Procedure
1. Navigate to Community > Administration > Permissions.
2. Click the permission you want to clone.
3. Click the Clone related link.
   A new permission with the same access types as the source permission is created. The permission record name starts with Clone of.

Create a forum permission
Add a forum user and a permission to a forum to create a forum permission.

Before you begin
Role required: sn_communities.forum_admin
About this task
Forum permissions are a combination of a forum, forum users, and permissions. Associate forum users and permissions within a specific forum. You can add multiple combinations of forum users and permissions to a forum.

Procedure
1. Navigate to Community > Administration > Forums.
2. Click a forum.
3. In the Forum Permissions related list, click New.
4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forum</td>
<td>Name of the forum.</td>
</tr>
<tr>
<td>Forum Users</td>
<td>User or group of users to give access to the forum.</td>
</tr>
<tr>
<td>Permission</td>
<td>Permission to give to the forum users in the forum.</td>
</tr>
</tbody>
</table>

5. Click Submit.

Copy permissions from a parent forum
You can copy permissions from a parent forum to a child forum.

Before you begin
Role required: sn_communities.forum_admin

Procedure
1. Navigate to Community > Administration > Forums.
2. Click a forum.
3. Click the Copy Permissions from Parent Forum related link.
   All permissions and content types are copied from the parent to the child forum. A summary of the results is displayed at the top of the form.

What to do next
Configure the forum users and permissions as required.
Copy permissions from a forum
You can copy all permissions and content types from one forum to another.

Before you begin
Role required: sn_communities.forum_admin

About this task
You can copy permissions from one source forum to multiple target forums.

Procedure
1. Navigate to Community > Administration > Forums.
2. Click the name of the forum that you want to copy permissions from.
3. Click the Copy Permissions to Forum(s) related link.
4. On the form, fill in the fields.

   **Copy Permissions**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy Permissions From</td>
<td>Name of the forum you want to copy permissions from. The name is automatically filled.</td>
</tr>
<tr>
<td>Copy Permissions To</td>
<td>Name of the forum you want to copy the permissions to. You can enter more than one forum.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

Debug user permissions
Investigate and diagnose problems with user access to forums.

Before you begin
Role required: sn_communities.forum_admin

Procedure
1. Navigate to Community > Administration > Forums.
2. Click the name of the forum to investigate.
3. Click the Debug Forum Permissions related link.
4. Enter the name of the user you want to check the permissions for.
   The forum user permissions information indicates which content and access types the user has for a particular forum.
Configure the community profile
Set up the community profile by configuring profile fields and deciding which fields to display in the personal information section of the community profile.

Before you begin
Role required: sn_communities.admin

Procedure
Configure one or more of the following for the community profile.

Create a persona for the community profile
Create a persona and associate it to a role to manage which data users can modify.

Before you begin
Role required: sn_communities.admin

About this task
A persona is associated to a user role and can be mapped to specific fields for display on the community profile. The base system contains a default persona, which is not associated to a role and is used for all community users. You can create a new persona or add a role to the default persona.

Procedure
1. Navigate to **Community > User Profile > Persona**.
2. Click **New** and then complete the Persona form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A name for the persona.</td>
</tr>
<tr>
<td>Order</td>
<td>The order, in numerical value, in which the system should evaluate the roles for the persona.</td>
</tr>
<tr>
<td>Associated Role</td>
<td>The role to associate the persona to.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.
Create a community profile field
Create a field to display on the community profile.

Before you begin
Role required: sn_communities.admin

Procedure
1. Navigate to Community > User Profile > Profile Fields.
2. Click New and then complete the Profile Fields form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Label</td>
<td>A label for the field.</td>
</tr>
<tr>
<td>Field Name</td>
<td>A name for the field.</td>
</tr>
</tbody>
</table>

3. Click Submit.

Configure persona field mapping for the community profile
Configure which fields appear in the community profile and manage the settings associated with those fields.

Before you begin
Role required: sn_communities.admin

Procedure
1. Navigate to Community > User Profile > Persona Field Mapping.
2. Click New and then complete the Persona Field Mapping form.

Persona Field Mapping form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Persona</td>
<td>Name of the persona.</td>
</tr>
<tr>
<td>Source Value Table</td>
<td>Source table of the field to be added to the persona. Any table that is used as the Source Value Table should have a reference to the sys_user table.</td>
</tr>
<tr>
<td>Source User Field</td>
<td>Field from the source value table.</td>
</tr>
<tr>
<td>Privacy Read Only</td>
<td>Select the check box to allow the community user to change the</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Profile Field</td>
<td>Display name of the community profile field.</td>
</tr>
<tr>
<td>Source Value Field</td>
<td>Name of the field from the source table.</td>
</tr>
<tr>
<td>Read Only</td>
<td>Select the check box to not allow the community user to edit the value of this field.</td>
</tr>
<tr>
<td>Privacy Default</td>
<td>Privacy default setting for the field.</td>
</tr>
</tbody>
</table>

3. Click **Submit**.

**Enable users to self-register to a community**

Once users have accessed public forums and decided they want to join the community, they can self-register to the community. External user registration provides a way of validating users and requires them to accept the community Terms and Conditions.

Community administrators perform the following tasks to configure external user registration.

- Configure the **external user registration properties**.
- Configure moderation filters to enter banned words for the user name.
- Configure the required strength for passwords
- Change email templates and content. The email template that you can change is **confirmation.link.sent.html**
- If not already configured, create community terms and conditions that each community user must review and accept. Communities delivers preconfigured Terms and Conditions that you can modify according to your needs.
- To enable external users to update their time zone when registering, add ACLs to external users in the User table [sys_user].

**Create community Terms and Conditions**

Community members must follow the community rules of conduct. Create community Terms and Conditions and them share to build a successful
community. Every community user must review and accept the Terms and Conditions before contributing to a community.

**Before you begin**
Role required: sn_communities.admin

**About this task**
The Communities application includes preconfigured Terms and Conditions that you can modify according to your needs.

You can disable Terms and Conditions using the `sn_communities.disable_terms_conditions_role` property.

**Procedure**
1. Navigate to **Community > Administration > Communities Terms and Conditions**, click **New**, and then fill in the fields.

<table>
<thead>
<tr>
<th>Terms and Conditions form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field</td>
</tr>
<tr>
<td>Number</td>
</tr>
<tr>
<td>Short Description</td>
</tr>
<tr>
<td>Content</td>
</tr>
</tbody>
</table>

2. Complete one of the following actions to save the Terms and Conditions.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Submit</td>
<td>Click <strong>Submit</strong> to save your Terms and Conditions.</td>
</tr>
<tr>
<td></td>
<td><strong>a. Click Activate.</strong> Your Terms and Conditions are activated and any existing Terms and Conditions are deactivated.</td>
</tr>
<tr>
<td></td>
<td><strong>b. Select the check box on the warning message if you want all community users who log on to accept to the new Terms and Conditions. The check box is selected by default.</strong></td>
</tr>
<tr>
<td>To</td>
<td>Do this</td>
</tr>
<tr>
<td>----</td>
<td>---------</td>
</tr>
<tr>
<td>c.</td>
<td>Deselect the check box if you want users to accept the new Terms and Conditions at a later point in time. You can then select your Terms and Conditions and click Prompt users to review and accept.</td>
</tr>
<tr>
<td>d.</td>
<td>Click OK.</td>
</tr>
</tbody>
</table>

You can view which community users have accepted the Terms and Conditions and when. Navigate to Community > User Profile > Community Profiles. View or add, if necessary, the Accepted TC, Accepted TC Date, and Accepted TC Number fields.

**Community Service Portal**

The Community Service Portal is a web interface that is based on the ServiceNow Service Portal application.

The Community Service Portal is designed to allow you to have control over the behavior of your portal and help create an attractive and engaging user experience.

To customize this portal, navigate to Service Portal > Portals and click Community.

**Configure Community Service Portal header menus**

Configure Community Service Portal header menus to create a consistent user experience across all your end-user facing service portals using a modern interface and a unified navigation menu structure.

**Before you begin**

Role required: The admin role for your service portal, for example, sn_communities.admin.

**About this task**

Add a theme and header menu to your service portal to define its look and behavior.
Procedure

1. Navigate to Service Portals > Portals and click the module for the portal you want to modify.
2. You have to be in the Global application to edit. If a message appears, click here to edit.
3. In the Theme field, enter CSM Default.
4. In the Main Menu field, enter CSM Unified Portal Header Menu.
5. Click the information icon next to the Main menu field and click Open Record.
6. Click the Settings icon and System Settings > Developer.
7. Change the Application to Customer Service Management Unified Theme and click the Refresh icon.
   You only have to change this setting once. The New button is displayed next to Menu Item.
8. To display the names of the menu items, personalize the Menu Items related list and add Display name.
9. Click New from the Menu Items related list.
10. Fill in the fields on the form.

Menu Item form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Name that appears for the item in the menu.</td>
</tr>
<tr>
<td>Parent Menu</td>
<td>This field should already contain the name of the menu you are adding items to. You can change the value as required to other menus.</td>
</tr>
<tr>
<td>Parent Menu Item</td>
<td>Use this field to nest menu items within other menu items.</td>
</tr>
<tr>
<td>Order</td>
<td>Value that determines where the item appears in the menu in relation to other menu items.</td>
</tr>
<tr>
<td>Type</td>
<td>The kind of page the item links to. For example, you can link to another page in the portal, or an external URL. Form fields vary depending on the option you select from this list.</td>
</tr>
<tr>
<td>Page</td>
<td>Name of the portal page the item links to.</td>
</tr>
<tr>
<td>Condition</td>
<td>Determines what conditions are required for menu items to show in the header.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Glyph</td>
<td>Icon that appears beside the menu item</td>
</tr>
</tbody>
</table>

11. Click **Submit**.

**Make an announcement to community members**

Global announcements appear in the banner and broadcast messages to all community members. Forum announcements appear in the Announcements section on the forum page. You can also send the announcement by email.

**Before you begin**

Role required:

- `sn_communities.admin` can manage Global announcements and Forum announcements
- `sn_communities.forum_admin` can manage Forum announcements for own forums only. The announcement appears only in the forum that the admin owns.

**About this task**

This example shows how a community user experiences announcements and how you can configure the appearance and operation of announcements.
Procedure

Navigate to Community > Administration > Global Announcements or Forum Announcements, click New, and then fill in the form.

<table>
<thead>
<tr>
<th>Announcement type</th>
<th>Read-only. Set to Global Announcement or Forum Announcement, depending on what you are working on.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Select the check box to publish the announcement to members. Clear the check box to cancel the announcement.</td>
</tr>
<tr>
<td>Title</td>
<td>Display title of the announcement.</td>
</tr>
<tr>
<td></td>
<td>• The text appears above the Summary text.</td>
</tr>
<tr>
<td></td>
<td>• In email, the text is the subject of the message.</td>
</tr>
<tr>
<td>Summary</td>
<td>Content of the announcement.</td>
</tr>
</tbody>
</table>
<ul><li>The text appears below the **Title** text.</li><li>In email, the text is the body of the message.</li></ul>

<table>
<thead>
<tr>
<th><strong>From / To</strong></th>
<th>&lt;ul&gt;&lt;li&gt;<strong>From</strong>: Date and time that the announcement should appear.&lt;/li&gt;&lt;li&gt;<strong>To</strong>: Date and time that the announcement should no longer appear.&lt;/li&gt;&lt;/ul&gt;</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th><strong>Send email notification</strong></th>
<th>Select the check box to send the announcement to members as an email message in addition to broadcasting the announcement.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th><strong>Display first</strong></th>
<th>Select the check box to display the announcement as the first announcement in the list.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th><strong>Public</strong></th>
<th>Select the check box to enable forum members that are not logged in to view the announcement.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th><strong>Portals</strong></th>
<th>Portals that display the announcement. Default: <strong>Community</strong>.</th>
</tr>
</thead>
</table>

**Note**: If no value is specified, the announcement does not appear in any portal.

<table>
<thead>
<tr>
<th><strong>Click target</strong></th>
<th>The <strong>Click target</strong> setting creates a link for the announcement.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>None</strong></td>
<td>No link.</td>
</tr>
<tr>
<td><strong>Page</strong></td>
<td>Opens a Service Portal page in the current browser tab.</td>
</tr>
<tr>
<td><strong>URL in current browser tab</strong></td>
<td>Opens the specified URL in the current browser tab.</td>
</tr>
<tr>
<td><strong>URL in new browser tab</strong></td>
<td>Opens the specified URL in a new browser tab.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Details URL</strong></th>
<th>If you select a URL option for <strong>Click target</strong>, then enter the URL in the <strong>Details URL</strong> field.</th>
</tr>
</thead>
</table>

| **Details link text** | Appears only if **Click target** is not **None**. |
• To display a link under the **Summary** text, enter the text of the link in the **Details link text** field.

• To use the **Title** text of the announcement as the link, leave **Details link text** blank.

### Forums

This setting appears for Forum announcements only. Slushbucket of forums that you are admin for.

Move a forum into the **Selected** list to display the announcement on the forum.

### Dismiss options

This setting appears for Global announcements only. Determines how the user can dismiss the announcement.

---

**What to do next**

• To update an announcement, update any setting as needed and then click **Update**. If you specified **Send email notification**, then you are prompted to send the updated email message.

• To cancel an announcement, clear the **Active** check box.

---

**Add featured content in a community**

Add or edit featured content in a community to appear in the Featured Content section on the community homepage, forum homepage, or both.

---

**Before you begin**

Set the following properties as required.

### Featured content properties

<table>
<thead>
<tr>
<th>Property name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_communities.default_featured_days</td>
<td>Default number of days for content to be featured. End date is calculated from the date the content is featured on.</td>
</tr>
<tr>
<td>sn_communities.max_featured_limit</td>
<td>Maximum amount of featured content at forum or at global level.</td>
</tr>
<tr>
<td>sn_communities.featured_global_notify_user</td>
<td>Send notifications to community users when content is featured on the</td>
</tr>
</tbody>
</table>
Featured content properties (continued)

<table>
<thead>
<tr>
<th>Property name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>community homepage. This property is inactive by default.</td>
<td></td>
</tr>
</tbody>
</table>

Note: Notifications are always sent to community administrators and moderators.

To send out email notifications when featured content expires, set the Featured Content Expire scheduled job to Active.

Role required: sn_communities.admin, sn_communities.community_moderator, sn_communities.forum_admin, or sn_communities.forum_moderator

Procedure

1. Navigate to the community homepage.
2. Click the content you want to feature.

   Note: Question and Answer content types are not enabled for featuring by default. To enable Question or Answer content types for featuring, navigate to Community > Administration > Content Types. Click the content type you want to enable and select the Allow Featuring check box. In the same way, you can also disable content types for featuring.

3. Click ... and Mark as featured.

4. On the Feature Content pop-up window, select whether to feature the content on the community homepage or in a specific forum. A notification that content has been featured is sent out to the author of the content, community users who commented on the post, and community users who are subscribed to the post. If featured content has expired or is removed from the featured content list by another user, community and forum administrators are notified.

Email a community user

Send a private message to a community user directly from the community.

Before you begin

An email client must be configured.

Role required: sn_communities.admin, sn_communities.community_moderator, sn_communities.forum_admin, or sn_communities.forum_moderator
About this task
Uses for private messaging can include warning a user about use of a banned word, welcoming a new user, or informing users about incorrectly placed content in a forum. You can privately message a user from any community content, a comment, the Leaderboard, or the Community Profile page.

Procedure
1. Navigate to the community homepage.
2. Point to the community user name.
3. Click Email User.

Note: The email opens in your local email client.

Community pages that support SEO data
To improve search results for community members using external search engines, the Communities application generates SEO meta tags and injects the tags into questions, topics, forums, and other page types.

Note: If the auto-generated SEO tags in a page does not meet your needs, you can change the SEO tags. See Modify SEO in community pages.

Pages that include auto-generated SEO data
The Communities application auto-generates SEO meta tags for the following pages in the Community service portal. The table provides details on the data that is generated.

- community_question
- community_blog
- community_document
- community_video
- community_event
- community_forum
- community_topic
Auto-generated SEO tags

<table>
<thead>
<tr>
<th>Searchable page type</th>
<th>Auto-generated tags in the page</th>
</tr>
</thead>
</table>
| Question, Blog, Document, Video, and Event | • The **title** meta tag is populated with the text "<forum name> - <content short description>"
• The **description** meta tag is populated with the text "<forum name> - <topic names> - <first 100 characters of the body of the content>"
| Forum | • The **title** meta tag is populated with the text "<forum name>"
• The **description** meta tag is populated with the text "<forum description>"
| Topic | • The **title** meta tag is populated with the text "<topic name>"
• The **description** meta tag is populated with the text "<topic description>"
| Leaderboard page | The Title meta tag is populated with the text "<community name>"

Modify SEO in community pages

If an auto-generated SEO meta tag does not meet your needs, you can modify or replace the tag.

**Before you begin**
Role required: sn_communities.admin

**About this task**
The source code for this example question page (ID `community_question`) shows the **description** meta tag (highlighted in yellow) that the Communities application injected into the page.
Router overheating after firmware upgrade

by George Warren
created 29d ago in Routing and Switching

My 5000 series router has been overheating since I upgraded the firmware couple of days ago. Anybody else facing a similar issue?
• The **description** meta tag text is made up of three data fields that are taken from the *community_question* record. In the tag, the values are separated by a hyphen character.

  ◦ The first portion of the **description** meta tag is the value of the *forum name* field in the question record. In the example, the forum name is **Routing and Switching**.

  ◦ The second portion of the tag is the value of the *topic* field in the record — **Tomahawk (5000 Series)** in the example.

  ◦ The third portion of the tag is generated from the first 100 characters of the *body* field in the record — **My 5000 series router has been overheating since I upgraded the firmware couple of days ago. Anybody.**

In addition to the **description** meta tag for a question page, the Communities application injects a **title** tag (highlighted in blue). The title is generated dynamically using two values from the *community_question* record:

• Forum name (**Routing and Switching** in the example)

• Short description (**Router overheating after firmware upgrade** in the example)

**Procedure**

1. Navigate to **Service Portal > Pages**.
2. In the list of portal pages, click the **ID** of the page to update (in the example, **community_question**).
   
   See the list of **pages in Communities that support SEO data**.
3. On the Page form:
• Modify or add meta tags in the **Meta tags** related list.

• Modify the **Dynamic page title** by modifying the structure of the title text or by modifying or replacing the variables that generate the text. The variable definitions appear in the **Dynamic page title variables** related list.
Analytics and Reporting Solutions for Communities

Analytics and Reporting Solutions contain preconfigured dashboards. These dashboards contain actionable data visualizations that help you improve your business processes and practices.

Use the Performance Analytics widgets on the dashboard to visualize data over time, analyze your business processes, and identify areas of improvement. With solutions, you can get value from Performance Analytics for your application with minimal setup.

Note: Solutions include some dashboards that are inactive by default. You can activate these dashboards to make them visible to end users according to your business needs.

To enable the solution for Communities, an admin navigates to System Definitions > Plugins and activates the Performance Analytics - Content Pack - Communities plugin.

Related information
- Analytics and Reporting Solutions
- Activate your Performance Analytics subscription

View the Communities performance dashboard

The Communities dashboard displays up-to-date status on community usage, membership, content type and activity, and trends by forum and by topic.

Before you begin
Role required: pa_admin

Procedure
1. Navigate to Performance Analytics > Dashboards.
2. In the list, select Community > Communities Dashboard.
   - On dashboard tabs:
     - Content types are question, answer, comment, blog, video, or document.
     - "Social activity" is any response (answer, comment, blog, video, or document) to a topic that is added by a user other than the originator.
     - Content score data is for content created during the last 30 days.
     - Click a scorecard to view detailed data or a trend chart.
In each scorecard, the percentage change in the current period appears under the total over the lifetime of the community.

- Number of current members and total number of questions.
- Percentage of questions that have been marked as *Solved* by the user who asked the question.
- Percentage of questions that have not been answered.
- Total number of attachments (blogs, videos, and documents).

### Charts

- **Community Activity**: new community members and total sessions for the month.
- **New content** of any type.
- **Top 3 Forums and Topics by Social Activity**: Topics and forums that have received responses from other members. Hold the cursor over an area to view the count of activity.

<table>
<thead>
<tr>
<th>Content Analytics tab</th>
<th>For any chart, you can focus on the most popular content types, forums, or topics by selecting a Breakdown.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- New content and count of active members who contributed content for the most recent months for the selected breakdown.</td>
</tr>
<tr>
<td></td>
<td>- The top 10 items with the highest number of views for the selected breakdown.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Forum Analytics tab</th>
<th>• Heat maps display data for <strong>Content</strong> (total current content volume), <strong>Views</strong> (total unique user views), and <strong>Social Activity</strong>. Forums are listed on the vertical axis and content types appear on the horizontal axis.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• <strong>Additional KPIs</strong>: key performance indicator data for forums.</td>
</tr>
</tbody>
</table>
Topic Analytics tab

- Heat maps display data for Content (total current content volume), Views (total unique user views), and Social Activity. Topics are listed on the vertical axis and content types appear on the horizontal axis.

- Additional KPIs: key performance indicator data for topics.

Admin Analytics tab

- Heat maps display data for Number of Posts Moved and Featured Content.

Related information

Performance Analytics scorecards
Performance Analytics widgets

Communities dashboard

The Communities dashboard displays up-to-date status on community usage, membership, content type and activity, and trends by forum, topic, and admin.
Overview tab

Content tab
### Forum tab

| Access right management | 1 | 100% | 0% | 0 | 0.0% | 0.00 | 1 | 1 | 0 | 0 | 0 | 0 | 0 |
| DHCP request | 0 | 0 | 0 | 1 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 |
| DHCPv6 | 1 | 100% | 0% | 0 | 0.0% | 0.00 | 1 | 0 | 0 | 0 | 0 | 0 | 0 |
| Fault tolerance | 1 | 10% | 0% | 0 | 0.0% | 0.00 | 2 | 0 | 0 | 0 | 0 | 0 | 0 |
| Firewalling | 0 | 0 | 0 | 1 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 |
| Honey Pot Solutions | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 |
| Intrusion Prevention Systems/IDS | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 |
| IPv6 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 |

### Topic tab

| Patriot (3040 Series) | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 |
| Scud (4000 Series) | 1 | 0.0% | 0.00 | 0.00 | 0.00 | 2 | 0 | 12.00 | 0 | 0 | 0 | 0 | 0 |
| Sidewinder (5100 Series) | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 |
| Tomahawk (5000 Series) | 0 | 2 | 0.0% | 0.00 | 0.00 | 2 | 0 | 3.00 | 0 | 0 | 0 | 0 | 0 |
| Trident (5100 Series) | 1 | 100% | 0% | 0 | 0.0% | 0.00 | 2 | 0 | 3.00 | 0 | 0 | 0 | 0 | 0 |
Admin tab

End user and roles

<table>
<thead>
<tr>
<th>End user</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Community moderator</td>
<td>sn_communities.community_moderator</td>
</tr>
<tr>
<td>Moderation administrator</td>
<td>sn_communities.moderation_admin</td>
</tr>
<tr>
<td>Community administrator</td>
<td>sn_communities.admin</td>
</tr>
<tr>
<td>Forum administrator</td>
<td>sn_communities.forum_admin</td>
</tr>
<tr>
<td>Forum moderator</td>
<td>sn_communities.forum_moderator</td>
</tr>
<tr>
<td>Content creator</td>
<td>pa_viewer, pa_admin</td>
</tr>
</tbody>
</table>

Indicators
The Communities dashboard presents the following key performance indicators:

**# of members**
Total number of members.

**# of Questions**
Number of questions created in the last 30 days.

**% Marked as Solved**
Number of questions created in the last 30 days, which are marked as solved.

% Not Answered
Number of questions created in the last 30 days, which were not answered.

# of Blogs, Documents, and Video
Number of blogs, documents, and videos created in the last 30 days.

Non-question content
Number of blogs, videos, and documents posted.

% With activity
Percentage of primary or secondary community content with at least one response or feedback.

Avg. # of social activities per content
Average number of activities (mark as helpful, upvote, comments, and replies) on any active primary or secondary community content.

# of contributors
Number of contributors.

New content this month
Number of new content posts in the last 30 days.

Avg. # of views per content
Average number of views of the content.

Avg. # of comments per content
Average number of comments of the content.

# of featured content
Number of content posts that have been featured.

# of Content moved from activities
Number of content posts moved from activities.

# of Content moved to activities
Number of content posts moved to activities.

Breakdowns
The following breakdowns apply to the indicators on the dashboard:
• Communities Content Type
• Communities Forum
• Communities Topic

Reports
The dashboards include the following reports:

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Community Activity</td>
<td>Column</td>
<td>View the number of new community members and total of sessions on the community per month.</td>
</tr>
<tr>
<td>New Content by Month</td>
<td>Column</td>
<td>View the number of new content posts per month.</td>
</tr>
<tr>
<td>Top 3 Forums by Social Activity</td>
<td>Pie</td>
<td>View forums that have received responses from other members. Social activity is any response (answer, comment, blog, video, or document) to a topic added by a user other than the user that originally posted the content.</td>
</tr>
<tr>
<td>Top 3 Topics by Social Activity</td>
<td>Pie</td>
<td>View topics that have received responses from other members.</td>
</tr>
<tr>
<td>New Content by Month</td>
<td>Single Score</td>
<td>View the amount of new content, forums, or topics created per month. For any chart, you can focus on the most popular content types, forums, or topics by selecting a Breakdown.</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Total Content Views</td>
<td>Column</td>
<td>View the number of views for each content type per month.</td>
</tr>
<tr>
<td>Forum KPIs</td>
<td>Single Score</td>
<td>View different indicators for the forums.</td>
</tr>
<tr>
<td>Topic KPIs</td>
<td>Single Score</td>
<td>View different indicators for the topics.</td>
</tr>
<tr>
<td>Number of Contents Moved</td>
<td>Single Score</td>
<td>View the number of content posts that have been moved by community</td>
</tr>
<tr>
<td></td>
<td></td>
<td>administrators and community moderators per month.</td>
</tr>
<tr>
<td>Featured Content</td>
<td>Single Score</td>
<td>View the number of posts featured by different users per month.</td>
</tr>
</tbody>
</table>

**Migrate Social Q&A data to Communities**

If you want to migrate existing Social Q&A content to Communities, you can use a script to migrate the data.

**Before you begin**
Role required: sn_communities.admin
The Customer Communities plugin (com.sn_customer_communities) must be activated.

**Procedure**

1. Navigate to System Definition > Fix Scripts.
2. Search for the script Migrate Social QA to Community and open it.
3. To enable the script, select the Active check box and click Update.
   The script is deactivated by default.
4. Click Run Fix Script.
   The Run Fix Script popup appears.
5. Click Proceed in Background.
Always use this option for long-running scripts, or if you do not know the expected execution time.

6. Check the status of the fix script and review the results from the Show Progress Workers related list.

What to do next
Verify the following information.
• A new forum is created for every knowledge base that has Social Q&A content.
• All questions, answers, comments, helpful votes, and upvotes are migrated.
• All view counts, answer counts, and comment counts are migrated.
• The accepted solution to a question in Social Q&A is Marked as Correct Answer in Communities.
• Social Q&A is deactivated for every knowledge base that contained Social Q&A data. Social Q&A content is no longer visible for these knowledge bases.

View community logs
Community logs display information about who has viewed or searched for content in a community. The list view displays all log entries, unless filtered.

Before you begin
Role required: sn_communities.admin

Procedure
1. Navigate to Community > Administration > Search Logs or View Logs.
2. View the logs.

<table>
<thead>
<tr>
<th>Log</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search Log</td>
<td>View who has searched for what and where in the community.</td>
</tr>
<tr>
<td>View Log</td>
<td>View who has viewed what and where in the community.</td>
</tr>
</tbody>
</table>

View community feedback and bookmarks tables
View feedback and bookmarks tables to view which community content was given feedback or was bookmarked.
Before you begin
Role required: sn_communities.admin, sn_communities.community_moderator, sn_communities.moderation_admin, sn_communities.forum_admin, or sn_communities.forum_moderator

Procedure
1. Navigate to Community > Feedback.
2. Choose one of the following options.
   • Click Feedback to view the content feedback was given for, the type of the feedback, and who provided it.
   • Click Bookmarks to view the content that was bookmarked and who added it.

Create a case from a discussion
In order to engage your internal experts to reply to discussion threads, you can create cases directly from community questions.

Creating cases from community questions requires activation of the Customer Service Management (com.sn_customerservice) plugin.

This feature is available for questions that have been posted by community users who are also contacts or consumers in the Customer Service Management application. Questions can be either answered or unanswered.

⚠️ Note: Cases can be created only from questions.

Two sets of users can create cases from questions:
• Customer service agents, consumer service agents, and customer service managers.
• Users with the sn_customerservice.proxy_case_creator role. Community administrators and community moderators inherit this role.

Administer create case from discussion
Configure parameters for the case generated from the community discussion so that it can be routed accordingly.

Creating a case from a discussion requires a configuration that maps information from the question in the community to fields on the Case form. The Create Case configuration is included with the feature. This configuration defines the source and destination tables and maps source fields to destination fields.
This configuration is stored in the CSM Table Map table [csm_table_map]. The system administrator can modify this configuration as needed.

The **Create Case** configuration uses the Social Q&A Question table [kb_social_qa_question] as the source table and the Case table [sn_customerservice_case] as the destination table. It includes the following mapping information.

<table>
<thead>
<tr>
<th>Question information</th>
<th>Case information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Question</td>
<td>Short description</td>
</tr>
<tr>
<td>Question author</td>
<td>Contact or consumer</td>
</tr>
<tr>
<td>Question author's account</td>
<td>Account</td>
</tr>
<tr>
<td>Opened by</td>
<td>Logged in community user</td>
</tr>
<tr>
<td>Priority</td>
<td>Low (priority = 4)</td>
</tr>
<tr>
<td>Channel</td>
<td>Community</td>
</tr>
</tbody>
</table>

To create additional mapping between these tables, add the additional fields to the **Create Case** configuration in the CSM Table Map table. Include these fields as needed on the **Create case from question** record producer.

**Enable knowledge harvesting**

Configure knowledge harvesting from a community to convert unstructured conversations to structured knowledge articles and make the information more accessible.

Community administrators perform the following tasks to configure knowledge harvesting.

- Enable the Knowledge Management Service Portal plugin (com.snc.knowledge_serviceportal).
- Add a knowledge base to a forum to store the knowledge article in a specific knowledge base.

<i>Note:</i> You can only add one knowledge base to a forum. The same knowledge base can be used for multiple forums.

- Add a knowledge category to a forum topic to categorize the harvested content.
Moderate a community

Community moderators can manage content quality by reducing the inappropriate content that is posted on the community.

Before you begin
Role required: sn_communities.community_moderator, sn_communities.forum_moderator, or sn_communities.moderation_admin

Procedure
1. Define your requirements for Community moderation.
   - Should first-time posters receive automatic moderation?
   - Which words should be banned from user content?
   - Should the system prevent content containing banned words from being posted?
   - Should users be able to report inappropriate content?
   - How many offenses can a user commit before the system bans them automatically?

2. Navigate to Community and choose the Moderation or Moderation Tasks menu and the module you require.

3. Configure one or more of the following aspects for your community.

Configure general moderation settings
Configure when to moderate content for users and user groups.

Before you begin
Role required: sn_communities.admin, or sn_communities.moderation_admin

Procedure
1. Navigate to Community > Moderation > Moderation Settings.
2. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Users Never Moderated</td>
<td>Content is never moderated for these users.</td>
</tr>
</tbody>
</table>
Configure moderation settings for a new user

Configure the system to prevent inappropriate user contributions.

**Before you begin**
Role required: sn_communities.admin or sn_communities.moderation_admin

**Procedure**
1. Navigate to **Community > Moderation > Moderation Settings**.
2. Click the **New User** related list.
3. On the form, fill in the fields.

**Moderation Settings form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New User Content Threshold</td>
<td>Number of user posts to be moderated.</td>
</tr>
<tr>
<td>User Exception List</td>
<td>New users that are not included in the new user content threshold for moderation.</td>
</tr>
<tr>
<td>User Group Exception List</td>
<td>User groups that are not included in the new user content threshold for moderation.</td>
</tr>
</tbody>
</table>

4. Click **Update**.
Configure abuse reporting

Configure whether users can report content and profile abuse, set an abuse reporting threshold, and define reasons for abuse reporting.

Before you begin

Role required: sn_communities.admin or sn_communities.moderation_admin

Procedure

1. Navigate to Community > Moderation > Moderation Settings.
2. Click the Abuse related list.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Content Abuse Reporting</td>
<td>Check box to enable users to report inappropriate content.</td>
</tr>
<tr>
<td>Enable Profile Abuse Reporting</td>
<td>Check box to enable users to report inappropriate profiles.</td>
</tr>
<tr>
<td>Abuse Reporting Threshold</td>
<td>Number of abuse reports on a specific content (question, blog, video, answer, comment) that lead to the content being hidden from other users.</td>
</tr>
<tr>
<td>Content Abuse Reporting Reasons List</td>
<td>Phrases that are possible reasons for the user to report inappropriate content contributions. Separate each phrase using the pipe symbol</td>
</tr>
<tr>
<td>Profile Abuse Reporting Reasons List</td>
<td>Phrases that are possible reasons for the user to report an inappropriate user profile. Separate each phrase using the pipe symbol</td>
</tr>
</tbody>
</table>

4. Click Update.
Configure user banning
Set the number of offenses a user can make before they are banned from creating or editing content.

Before you begin
Role required: sn_communities.admin or sn_communities.moderation_admin

Procedure
1. Navigate to Community > Moderation > Moderation Settings.
2. Click the User Banning related list.
3. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Banning Users</td>
<td>Check box to enable the banning of users.</td>
</tr>
<tr>
<td>Offense Threshold</td>
<td>Number of offenses a user can make before being automatically banned.</td>
</tr>
</tbody>
</table>

4. Click Update.

Configure moderation filters
Create moderation filters to manage how content is moderated.

Before you begin
Role required: sn_communities.admin or sn_communities.moderation_admin

Procedure
1. Navigate to Community > Moderation > Moderation Filters.
2. Click New.
3. Click Banned Keyword Filter.
4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter Name</td>
<td>Name of the filter.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Active</td>
<td>Check box to make the filter active.</td>
</tr>
<tr>
<td>Synchronous</td>
<td>Check box to automatically moderate content when it is submitted. Any content that includes the banned words defined in the filter is not posted. If the check box is cleared, the system creates a moderation task when banned words are used. The content is visible until it is moderated.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.

6. From the Moderation Filters list, click the name of your filter.

7. Add a banned keyword word to the list:
   a. In the **Keywords** list, click **New**.
   b. In the Keyword field, enter your keyword.
   c. Click **Submit**.
   d. If required, repeat to add more keywords to the list.

8. Click **Update**.

**Ban a user**

You can ban a user from creating or editing content, for example, a user can be banned for posting inappropriate content.

**Before you begin**

Role required: sn_communities.admin, sn_communities.moderation_admin, or sn_communities.community_moderator

**Procedure**

1. Navigate to **Community > User Profile > Community Profiles**.

2. Click the Preview icon next to the user and then click **Ban User**. The user is banned. In the Community Profiles list, the value in the Banned column is set to **true**.
Revoke a user ban
Revoke a user ban to allow a user to create and edit content again.

Before you begin
Role required: sn_communities.admin, sn_communities.moderation_admin, or sn_communities.community_moderator

Procedure
1. Perform either of the following actions.
   • Navigate to Community > User Profile > Community Profiles.
   • Navigate to Community > Moderation > Users Banned by Moderation.
2. Click the Preview icon next to the user and then select Revoke User Ban. The user ban is revoked. In the Community Profiles list, the value in the Banned column is set to false.

Approve or reject content
Approve or reject content that a user reported as inappropriate or that is associated with a particular community profile.

Before you begin
Role required: sn_communities.community_moderator, sn_communities.moderation_admin

About this task
A moderation task is generated when a community user reports inappropriate content or community profiles. By default, the system assigns the task to the community moderator group. You can also configure your system to always require content moderation for a particular user or group. Each task requires the moderator to approve or reject the reported item. If the moderator rejects content, it is counted as an offense against the community user who contributed the content.

Procedure
1. Navigate to Community > Moderation Tasks > Assigned to me.
2. Click a moderation task.
3. On the form, fill in the fields.
Moderation Task form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigned to</td>
<td>Person assigned to the task.</td>
</tr>
<tr>
<td>Moderation Notes</td>
<td>Notes entered by the user when reporting the content.</td>
</tr>
<tr>
<td>Resolution Notes</td>
<td>Your comment as you moderate the content.</td>
</tr>
<tr>
<td>Work Notes</td>
<td>Work notes entered by users working on the task.</td>
</tr>
<tr>
<td>Approve Content</td>
<td>Approve content that conforms to community rules. The content state changes to Closed Complete.</td>
</tr>
<tr>
<td>Reject Content</td>
<td>Reject content or a profile. The content state changes to Closed Complete and the content is hidden in the community.</td>
</tr>
</tbody>
</table>

ℹ️ Note: You can review the outcome of existing and past moderation tasks by navigating to Community > Moderation > Moderation Outcomes. Click a task to view the details of the moderation task.

Disable comments

Disable comments on a blog, document, video, event, or question to prevent users from posting comments.

Before you begin

Role required: sn_communities.forum_moderator, sn_communities.community_moderator, sn_communities.moderation_admin, or sn_communities.forum_admin

About this task

There are two ways of disabling comments on the community content. You can disable comments while posting new content or restrict users from posting comments on existing content.

ℹ️ Note: You can disable replies on an existing question to restrict users from posting further comments. You cannot post a new question when replies are disabled.
Procedure

Navigate to the community home page.

- To disable comments on new community content:
  a. Choose the content type that you want to post.
  b. Select the **Disable Comments** check box.
  c. Click **Publish**.

- To disable comments on existing community content:
  a. Choose the content that you want to disable the comments for.
  b. Click the more options icon ( ⋮ ) and then click **Edit**.
  c. Select the **Disable Comments** check box.
  d. Click **Save**.

A confirmation message appears stating that you’ve disabled comments. The comments on the existing content are displayed. You cannot edit an existing comment or post a new comment. All community and forum administrators and the content author receive an email notification when you disable or enable comments.

Related information

- Post and respond to content in the community

Remove content

Remove content that does not meet community standards.

Before you begin

Role required: sn_communities.admin

Procedure

1. Navigate to **Community > Content > Contents**.
2. Click the content to remove.
3. Click **Actions on selected rows > Delete** and confirm that you want to delete the item.
Harvest knowledge from a community

Harvest knowledge from a community and create structured knowledge articles from unstructured discussions around a question.

Before you begin
Knowledge harvesting must be enabled.
Role required: sn_communities.knowledge_harvester, sn_communities.admin, or sn_communities.moderation_admin

About this task
You can only harvest solved questions with accepted solutions into a knowledge article.

Procedure
1. From the Communities homepage, perform one of the following actions.
   • Go to the Content List.
   • Click a forum.
   • Search for a discussion thread (Question and Answer).
2. Click **Question State > Solved** to filter for all discussions that can be converted into knowledge articles.
3. Click a question.
4. Click the ... icon and then **Harvest Knowledge**.
5. Fill in the fields on the Harvest Knowledge form.

Harvest Knowledge form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short description</td>
<td>The original question is automatically entered in the <strong>Short description</strong> field. You can edit the short description, as required.</td>
</tr>
<tr>
<td>Attachments</td>
<td>All attachments associated with the question and accepted solution are automatically added to the knowledge article. You can add and remove attachments.</td>
</tr>
<tr>
<td>Text</td>
<td>The body of the original question and accepted solution is automatically entered in the <strong>Text</strong> field. You can edit the text, as required.</td>
</tr>
<tr>
<td>Knowledge base</td>
<td>The knowledge base to which the knowledge article has been added. It is added by default based on the knowledge base</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Field</td>
<td>associated to the forum from which article was harvested. If required, you can change the knowledge base.</td>
</tr>
<tr>
<td>Category</td>
<td>The category of the knowledge article. It is entered by default based on the category associated to the topic from which the article was harvested. If required, you can change the category.</td>
</tr>
<tr>
<td>Number</td>
<td>A KB (Knowledge Base) number is automatically assigned to the article. You cannot edit the <strong>Number</strong> field.</td>
</tr>
</tbody>
</table>

6. Perform one of the following actions:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publish</td>
<td>Click <strong>Publish</strong> to initiate the workflow associated with the knowledge base. A link to the knowledge article is displayed on the community question from which it was harvested. A link to the community question and to the community profile of the person who answered the question is displayed in the knowledge article.</td>
</tr>
<tr>
<td>Note:</td>
<td>You can only see the links if you are a logged-in community user and have been assigned the correct permissions in the forum.</td>
</tr>
<tr>
<td>Save</td>
<td>Click <strong>Save</strong> to save the knowledge article as a draft. To publish the knowledge article at a later point in time, navigate to the platform UI and then <strong>Knowledge &gt; Articles &gt; Unpublished</strong>.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click <strong>Delete</strong> to delete the knowledge article and all records associated with the KB number.</td>
</tr>
</tbody>
</table>
Use a community

Participate in your community by sharing content, asking and answering questions, creating events, giving feedback, and so on.

Before you begin
Role required: sn_communities.community_user

Procedure
Use a community in one or more of the following ways.

Community homepage features for logged in users
Your community activity usually begins on the community homepage. If you are a logged in user, you see different information than non-logged in users. Your organization can customize the homepage.

Note: The Community Service Portal header menu is not enabled by default. For more information, see Configure Community Service Portal header menus.

From the community homepage, you can access and use the following features:

<table>
<thead>
<tr>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Announcements</td>
<td>View announcements targeted to the entire community.</td>
</tr>
<tr>
<td>Community menu</td>
<td>Navigate to all forums and all topics and other quick links.</td>
</tr>
<tr>
<td>Tours</td>
<td>View a tour for additional guidance on how the Communities application works. Tours appear when your administrator creates them on certain pages.</td>
</tr>
<tr>
<td>Profile photo</td>
<td>Click your profile photo to either view your community profile or logout.</td>
</tr>
<tr>
<td>Search</td>
<td>Enter a search term. You can enter a keyword to use the type-ahead search or enter one or more words to view all search results.</td>
</tr>
<tr>
<td>Browse Forums</td>
<td>Click the + icon to view up to eight available forums.</td>
</tr>
<tr>
<td>UI component</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Community homepage for logged in users (continued)</td>
<td>Click <strong>View all Forums</strong> to go to the Forums list page and search for the forum you require. If sub forums exist, they are listed on the parent forum tile along with a count of how many there are. Click the link to access a list of the sub forums.</td>
</tr>
<tr>
<td>Have a question? Click here to start typing and Post Content</td>
<td>Contribute to the community by posting a question. Click Question, Blog, Video, Document, or Event to add your content and assign it to a forum.</td>
</tr>
<tr>
<td>Featured Content</td>
<td>View featured community content.</td>
</tr>
<tr>
<td>Question filters</td>
<td>Filter by question to view solved, unsolved, and unreplied questions.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The content options are displayed according to the permissions you are assigned in the forum.</td>
</tr>
<tr>
<td>Content List and Activity Feed</td>
<td>Toggle between the Content List and Activity Feed. You can filter according to content type, forum, most recent or popular, and when the content was created.</td>
</tr>
<tr>
<td></td>
<td>• Content List: Lists all content added to the community. Displays when updates were made to replies, comments, and answers marked as correct and which user made the updates.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong></td>
</tr>
<tr>
<td></td>
<td>◦ Updates are not displayed for new or existing comments or replies due for moderation.</td>
</tr>
<tr>
<td></td>
<td>◦ Updates are displayed for approved changes made to comments or replies as a result of moderation.</td>
</tr>
</tbody>
</table>
Community homepage for logged in users (continued)

<table>
<thead>
<tr>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity Feed</td>
<td>Lists all activity in the community based on your posts and subscriptions.</td>
</tr>
</tbody>
</table>

**Note:**
- All activities per content item are grouped. Only the most recent activity is listed per content item. For example, an upvote to a question.
- To view all activity associated with a content item, click the content item. All activities, regardless of your subscriptions, are displayed.

Navigating the activity feed

The activity feed provides a central place for community users to view information and interact. It lists the most recent activity in the community based on your network, posts, and subscriptions. You can reply, comment, and give feedback directly from the activity feed.

**Activity feed**

<table>
<thead>
<tr>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Levels</td>
<td>View the most recent levels you have earned in the community as a result of points accumulated. You can also view the most recent badge you have earned for your achievements or areas of expertise within the community.</td>
</tr>
<tr>
<td>Content added by another user</td>
<td>View the most recent contributions by another user that you are following or content that you have subscribed to.</td>
</tr>
<tr>
<td>Content added by you</td>
<td>View the most recent content that you created in the community.</td>
</tr>
<tr>
<td>Feedback</td>
<td>Provide feedback on content that you find useful. There are four supported types of content feedback: comment, upvote, helpful, and mark as correct answer.</td>
</tr>
<tr>
<td>Reply</td>
<td>Reply to a question or another reply.</td>
</tr>
</tbody>
</table>
Navigating the forum homepage

While in a forum, you can navigate the forum homepage and perform tasks, such as posting content.

<table>
<thead>
<tr>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forum name and description</td>
<td>Displays the name and description of the forum. Click <strong>Show more</strong> to read more of the description.</td>
</tr>
<tr>
<td>Subscribe</td>
<td>Subscribe to content in the community.</td>
</tr>
<tr>
<td>Sub Forums</td>
<td>If sub forums exist, they are listed. Click a link to access a sub forum. If more than three sub forums exist, click <strong>View all</strong> to view the list of all sub forums and click the one you want to access.</td>
</tr>
<tr>
<td>Search Forum</td>
<td>Type a keyword and click the Search icon to view the matching content within a forum.</td>
</tr>
<tr>
<td>Have a question? Click here to start typing</td>
<td>Contribute to the community by posting a question.</td>
</tr>
<tr>
<td>Question filter</td>
<td>Filter by question to view solved, unsolved, and unreplied questions.</td>
</tr>
<tr>
<td>Content List</td>
<td>Lists all content added to the community. Displays when updates were made to replies, comments, and answers marked as correct and which user made the updates. Filter according to content type or sort by most recent or popular, and when the content was created.</td>
</tr>
<tr>
<td>Note:</td>
<td></td>
</tr>
<tr>
<td>• Updates are not displayed for new or existing comments or replies due for moderation.</td>
<td></td>
</tr>
<tr>
<td>• Updates are displayed for approved changes made to comments or replies as a result of moderation.</td>
<td></td>
</tr>
<tr>
<td>Post Content</td>
<td>Click Question, Blog, Video, Document, or Event to add your content and assign it to a forum.</td>
</tr>
</tbody>
</table>
Forum homepage (continued)

<table>
<thead>
<tr>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note:</td>
<td>The content options are displayed according to the permissions you are assigned in the forum.</td>
</tr>
<tr>
<td>Announcements</td>
<td>View forum-specific announcements.</td>
</tr>
<tr>
<td>Topics</td>
<td>Click a topic to navigate to a particular topic.</td>
</tr>
<tr>
<td>Leaderboard</td>
<td>View the leaderboard to find community experts for the forum.</td>
</tr>
<tr>
<td>Most viewed content</td>
<td>Displays the top three posts according to number of views.</td>
</tr>
</tbody>
</table>

Community homepage features for non-logged in users

Your community activity usually begins on the Community homepage. If you are a non-logged in user, you see different information than logged in users. Your organization can customize the homepage.

Community homepage for non-logged in users

<table>
<thead>
<tr>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Community announcement</td>
<td>View announcements targeted to the entire community.</td>
</tr>
<tr>
<td>Community menu</td>
<td>Navigate to all forums, all topics, and other quick links.</td>
</tr>
<tr>
<td>Sign up/Login</td>
<td>Sign up or log in to the community.</td>
</tr>
<tr>
<td>Search</td>
<td>Enter a search term. You can enter a keyword to use the type-ahead search or enter one or more words to view all search results.</td>
</tr>
<tr>
<td>Browse community forums</td>
<td>Click the + icon to view up to eight available forums.</td>
</tr>
<tr>
<td></td>
<td>Click <strong>View all Forums</strong> to go to the Forums list page and search for the forum you require.</td>
</tr>
<tr>
<td></td>
<td>If sub forums exist, they are listed. Click a link to access a sub forum.</td>
</tr>
<tr>
<td></td>
<td>If more than three sub forums exist, click <strong>View all</strong> to view the list of all sub forums and click the one you want to access.</td>
</tr>
</tbody>
</table>
Community homepage for non-logged in users (continued)

<table>
<thead>
<tr>
<th>UI component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Question filter</td>
<td>Filter by question to view solved, unsolved, and unreplied questions.</td>
</tr>
<tr>
<td>Content List</td>
<td>View content posted in public forums in the community. Filter according to content type or sort by most recent or popular, and when the content was created.</td>
</tr>
<tr>
<td>Why Join?</td>
<td>View some of the advantages of joining the community.</td>
</tr>
<tr>
<td>View Leaderboard</td>
<td>View the leaderboard to find community experts on specific forums or topics.</td>
</tr>
<tr>
<td>Ask a Question</td>
<td>Click Ask a Question and a message appears indicating that you must be a logged-in user to perform this action. You can Login/Sign Up directly from here.</td>
</tr>
<tr>
<td>Topics</td>
<td>Click a topic to navigate to a particular topic.</td>
</tr>
<tr>
<td>Show More</td>
<td>View an expanded list of content available in the community.</td>
</tr>
</tbody>
</table>

Self-register to a community

Once you have accessed a public forum and decided to join the community, you can self-register by signing up and accepting the community Terms and Conditions.

Before you begin
Role required: none

About this task
Every community user has to have a community account. Existing users who access a community for the first time have to accept the Terms and Conditions. An account is created once the Terms and Conditions have been accepted. New users sign up to the community and accept the Terms and Conditions. If the community Terms and Conditions are updated, all community users are prompted to review and accept them when they log in the next time.

Procedure
1. If you are a new user, navigate to the community homepage.
   a. Click Sign up/Login.
      The Sign Up screen opens.
b. Fill out the fields on the **Sign Up** form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email address</td>
<td>The email address to send the email validation to.</td>
</tr>
<tr>
<td>Username</td>
<td>A user name for your account.</td>
</tr>
<tr>
<td>First Name</td>
<td>Your first name.</td>
</tr>
<tr>
<td>Last Name</td>
<td>Your last name.</td>
</tr>
<tr>
<td>Phone Number</td>
<td>Your phone number.</td>
</tr>
<tr>
<td>Password</td>
<td>A password for your account.</td>
</tr>
<tr>
<td>Confirm Password</td>
<td>A confirmation of your password.</td>
</tr>
<tr>
<td>I agree to the Community Terms and Conditions</td>
<td>A check box to agree to the community Terms and Conditions.</td>
</tr>
</tbody>
</table>

c. Click **Sign Up**.  
An email is sent to the email address you entered.

d. Open the email and click the validation link.

e. Click the **Click here to login** message.

f. Log in with your user name and password.  
The **Welcome** pop-up opens.

g. Confirm your time zone.

h. Click **User Profile** or **Notification Preferences** to edit your community profile or your notification and subscription settings.

2. If you are an existing user, but visiting the community for the first time, click any community page.
a. If required, change your Display Name on the Setting up your account pop-up.

b. Select the check box to agree to the community Terms and Conditions. The Welcome pop-up opens.

c. Confirm your time zone.

d. Click User Profile or Notification Preferences to edit your community profile or your notification and subscription settings.

Search the community
Enter a keyword to use the type-ahead search on the Community homepage or enter one or more words to view all search results.

Before you begin
Role required: sn_communities.community_user

Procedure
1. Navigate to the community homepage.
2. Press the Spacebar to use the type-ahead search and enter a keyword in the Search Community field.
3. Choose from the following options:
   a. Click a content item, topic, forum, or profile that matches your search.
   b. To enter your question, blog, or video if no matching content is displayed, click Ask the Community.
   c. To display all search results, click View all Results.
4. Alternatively, enter one or more keywords in the Search Community field and press the Enter key.
   A list of matching search results appears.

Refine your search results
Refine your search results to narrow down the content displayed.

Before you begin
Role required: sn_communities.community_user
Procedure

1. Navigate to the community homepage.
2. Enter a keyword in the Search field.
3. From the Refine Results panel, choose from the following options.
   - To filter and customize your search results, click any option under Types. For example, click Profile to view the profiles that matches with the search keyword. The details of the profile such as display name, gamification information-points and badges, bio, user title and company appear. To reverse this action, click the x icon of the corresponding item. To remove all filters, click Clear All.
   - Select any item from the Forums, Topics, or Authors fields to filter by forum, sub forum, topic, or author. You can add multiple forums, sub forums, topics, and authors and click anywhere on the screen to display the results.
   - To filter by the time period that the content was posted, click any Last Updated item.
   - Click the – icon of any category to collapse the category and save space. Click the + icon to restore a collapsed category. The search results page displays content based on the filter criteria.

Sort your search results

Sort your community search results to narrow down the content displayed.

Before you begin

Role required: sn_communities.community_user

About this task

The search results are sorted according to Relevance by default.

Procedure

1. Navigate to the community homepage.
2. Enter a keyword in the Search field.
3. To display the most recent results, click Sort By: Newest. The results are displayed in descending order.
4. To display the results in ascending order, click Newest.
Use a community profile
The community profile displays an overview of a user's personal information as well as their contributions, network, achievements, expertise, and events they are attending. You can view and edit your own profile. You can also view another user's profile and perform actions, such as following them or reporting inappropriate content.

Before you begin
Role required: sn_communities.community_user

Procedure
Perform one or more of the following tasks from the community profile.

Manage your community profile
View and edit your own community profile, which displays your contributions, network, achievements, expertise, and events you are attending.

Before you begin
Role required: sn_communities.community_user

About this task
There are two ways of accessing your community profile.

Procedure
1. From the Community homepage, perform one of the following actions.
   • Click the Community menu and then Community Profile.
   • Click your name or profile photo and then Profile.
2. View the sections on your community profile.

<table>
<thead>
<tr>
<th>Community profile</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile header</td>
<td>An overview of your personal information.</td>
</tr>
<tr>
<td></td>
<td>• Click Edit Profile to change your profile photo and edit your personal information.</td>
</tr>
<tr>
<td></td>
<td>• Click Edit Profile to change your user preferences. Update your</td>
</tr>
<tr>
<td>Section</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>time zone to view when events are occurring in your selected time zone.</td>
<td>• Click the ... icon and then <strong>Display Settings</strong> to set your display settings and determine who can view which sections of your profile.</td>
</tr>
<tr>
<td>If the gamification feature is enabled, the profile header includes your current gamification achievements, including:</td>
<td>• The top three badges that you have been awarded</td>
</tr>
<tr>
<td>• The total number of points that you have earned</td>
<td>• The current level that you have achieved based on your point total (for example, Enthusiast or Champion)</td>
</tr>
<tr>
<td>Content tab</td>
<td>An overview of the published and draft content you have created and the content you have bookmarked.</td>
</tr>
<tr>
<td>• Authored: Content you contributed. You can select the content type and the forum, and sort by state.</td>
<td>• <strong>Drafts</strong>: Content you contributed that is in draft state. You can select the content type and the forum. Open a draft to publish it.</td>
</tr>
<tr>
<td>• Bookmarks: Content that you have bookmarked. You can select the content type, the forum, and sort by recent or oldest. You can also remove bookmarks.</td>
<td></td>
</tr>
<tr>
<td>Section</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Activity tab</td>
<td>The most recent actions performed by you in the community, for example, commenting on a post or providing feedback.</td>
</tr>
<tr>
<td>Network tab</td>
<td>A record of your network in the community.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Followers</strong>: The users that are following you.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Following</strong>: The users that you are following.</td>
</tr>
<tr>
<td></td>
<td>• Click <strong>Follow</strong> to start following a user, who is following you.</td>
</tr>
<tr>
<td></td>
<td>• Point to <strong>Following</strong> and click <strong>Unfollow</strong> to stop following a user.</td>
</tr>
<tr>
<td>Achievements tab</td>
<td>An overview of your gamification achievements.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Levels</strong>: A list of the available levels that you can achieve, including the starting point value, with your current level highlighted in blue.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Badges</strong>: A list of the badges that you have been awarded as well as available badges. Awarded badges appear at the top of the list and available badges appear below. You can filter this list to view awarded badges or all badges.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Points</strong>: A history of the points that you have earned and the activities performed that earned the points. This information also includes the forum in which the activity was performed. This list includes your last 50 activities. Click <strong>Show more</strong> to display additional pages.</td>
</tr>
<tr>
<td>Events tab</td>
<td>A list of events that you created, are attending, or past events you have ordered in the community.</td>
</tr>
<tr>
<td>Section</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Contributions</td>
<td>The number of your content and feedback contributions to the community.</td>
</tr>
<tr>
<td>Forum Expertise</td>
<td>A display of your expertise at forum level. You can view your level within the forum and the number of points you have gained through contributing to that forum. Click the information icon to view the point ranges required to reach each forum level.</td>
</tr>
<tr>
<td>Topic Expertise</td>
<td>A display of your expertise at topic level. You can view your level within the topic and the number of points you have gained through contributing to that topic. Click the information icon to view the point ranges required to reach each topic level.</td>
</tr>
</tbody>
</table>

**View another user's community profile**

View another user's community profile to see their contributions, network, expertise, and so on. You can also manage your network by following and unfollowing other community users.

**Before you begin**

Role required: sn_communities.community_user or sn_communities.admin  

**Procedure**

1. Click the user’s name or profile photo for the community profile that you want to view.  
2. View the sections of the user's community profile.
## Community profile

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Profile header** | The sections of the community profile that the user has made visible.  
- To start following the user, click **Follow**.  
- To report any inappropriate content on the user’s community profile, click the ... icon and then **Report Profile**.  
- To assign a user points for a specific contribution to the community as a community administrator, click the ... icon and then click **Assign Points**.  
- To hide content from the community until it is corrected as a community administrator, click **Display Settings**. You can also click **Ban User** to ban a user from creating or editing content. |
| **Content** |  
- **Authored**: Content that the user contributed.  
- **Featured**: Content the user posted that has been featured.  
- **Drafts**: Content the user contributed that is in draft state.  

**Note**: Only community administrators can view draft content of another user.  
- **Bookmarks**: Content that the user has bookmarked. |
<p>| <strong>Activity</strong> | The most recent actions performed by the user in the community, for example, commenting on a post or providing feedback. |</p>
<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network</td>
<td>• <strong>Followers</strong>: The users that are following the user's community profile.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Following</strong>: The users that the community profile user is following.</td>
</tr>
<tr>
<td></td>
<td>• You can manage your own network from another user's profile. To start following a user, click <strong>Follow</strong>. To stop following a user, point to <strong>Following</strong> and click <strong>Unfollow</strong>.</td>
</tr>
<tr>
<td>Achievements</td>
<td>An overview of the user's gamification achievements.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Levels</strong>: A list of the available levels that the user can achieve, including the starting point value, with the user's current level highlighted in blue.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Badges</strong>: A list of the badges that have been awarded to this user.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Points</strong>: A history of the points that this user has earned and the activities performed that earned the points. If the user has earned points in a forum that you do not have access to, the name of the forum is replaced with <strong>Private forum</strong>.</td>
</tr>
<tr>
<td>Events</td>
<td>A list of events that the user has created, is attending, or past events that the user has attended. Click an event to view the event details and respond.</td>
</tr>
<tr>
<td>Forum Expertise</td>
<td>A display of the user's expertise at the forum level. You can view their level within the forum and the number of points they have gained through contributing to that forum.</td>
</tr>
<tr>
<td>Section</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>To view the point ranges required to reach each forum level, click the information icon.</td>
</tr>
<tr>
<td>Topic Expertise</td>
<td>A display of the user's expertise at the topic level. You can view their level within the topic and the number of points they have gained through contributing to that topic. To view the point ranges required to reach each forum level, click the information icon.</td>
</tr>
<tr>
<td>Contributions</td>
<td>The contributions the user has made to the community.</td>
</tr>
</tbody>
</table>

**Follow a community user**

Manage your network by following other community users and tracking their activity in the community.

**Before you begin**

Role required: sn_communities.community_user

**About this task**

There are several ways of following users in the community.

**Procedure**

1. From the Communities homepage, perform one of the following actions.
   - Click your profile name or photo.
   - Click your profile name or photo and then the **Network** tab.
   - Click another user's profile name or photo and then the **Network** tab.

2. Click **Follow** for every user you want to follow.
   The state changes to **Following**. Your Activity Feed is updated with the activity those users have taken in the community.

3. **Optional:** Point to **Following** and click **Unfollow** to stop following a user.
Edit your community profile photo and personal information

You can change your community profile photo and edit your personal information.

Before you begin
You can only edit your community profile if you are logged in to the community.
Role required: sn_communities.community_user

About this task
There are two ways of accessing your community profile.

Procedure
1. From the Community homepage, perform one of the following actions.
   • Click the Community menu and then click Profile on the Community homepage.
   • Click your name or profile photo and then click Profile.
2. Click Edit Profile.
3. Click Change Profile Photo.
   A file system upload is initiated. Choose an image in .png or .jpg format.
4. On the form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Country</td>
<td>The country in which you work or reside.</td>
</tr>
<tr>
<td>Title</td>
<td>Your job title.</td>
</tr>
<tr>
<td>Phone</td>
<td>The telephone number where people can reach you.</td>
</tr>
<tr>
<td>Company</td>
<td>Name of your employer.</td>
</tr>
<tr>
<td>Email</td>
<td>Your email address.</td>
</tr>
<tr>
<td>Note:</td>
<td>Use the email address used in your instance profile or the reset password features cannot be used.</td>
</tr>
<tr>
<td>State</td>
<td>The state, province, or jurisdiction in which you work or reside.</td>
</tr>
</tbody>
</table>

© 2021 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>City</td>
<td>The city in which you reside.</td>
</tr>
<tr>
<td>Display name</td>
<td>Your name as you want others to see it.</td>
</tr>
<tr>
<td>Bio</td>
<td>A short description about yourself.</td>
</tr>
</tbody>
</table>

5. Click **Save**.

**Edit your community profile display settings**

Edit your display settings to determine who can view each profile section.

**Before you begin**

Role required: sn_communities.community_user, sn_communities.admin or sn_communities.moderation_admin

**About this task**

You can edit your own display settings for your community profile. If a community administrator finds inappropriate content on your profile, they can edit your display settings to hide the content from the community until it is corrected.

**Procedure**

1. On the community homepage, click the **Community** menu and then click **Community Profile**.
2. Click the ... icon and then click **Display Settings**.
3. Open the choice lists and select display settings for any section.
4. Choose the privacy level to apply.

**Privacy levels**

<table>
<thead>
<tr>
<th>Privacy level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Everyone</td>
<td>Visible to all users, including non-logged in users.</td>
</tr>
<tr>
<td>Only me</td>
<td>Visible to yourself and administrators. If an administrator finds inappropriate content on your profile, the administrator can change the display</td>
</tr>
<tr>
<td>Privacy level</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Only me</td>
<td>settings to <strong>Only me</strong> until the content is modified. You receive an email notification detailing the display settings that were modified for which sections. Update the content and adjust the display settings accordingly.</td>
</tr>
<tr>
<td>Everyone after logging in</td>
<td>Visible to all users who access the community after logging in.</td>
</tr>
<tr>
<td>Followers</td>
<td>Visible to users who are following your profile.</td>
</tr>
</tbody>
</table>

5. Click **Save Settings**.

**Report a community profile**
Report a community profile to alert community moderators that there is offensive or inaccurate information in the profile.

**Before you begin**
Role required: sn_communities.community_user

**Procedure**
1. Click the name or photo of the user to report.
2. Click the ... icon and select **Report Profile**.
3. From the list, select the reason you are reporting the user and add **Additional Comments**.
4. Click **Submit**.
   - A confirmation message indicating that the abuse report has been received and will be reviewed is displayed.
   - A moderation task is created and assigned to a moderator for resolution.

**Community subscriptions**
Using subscriptions, you can choose specific areas of interest. Your activity feed and notifications are personalized according to your subscriptions.
Subscription types

<table>
<thead>
<tr>
<th>Subscription type</th>
<th>Description/Features</th>
</tr>
</thead>
</table>
| Subscription      | • Subscribe or unsubscribe to forums, topics, and community content (questions, answers, blogs, and video).  
• Auto-subscribe: Whenever you post content, you are automatically subscribed to the content itself. You are also automatically subscribed when you post a reply or a comment. |
| Activity feed     | • Displays activities based on your subscriptions with the most recent at the top. |
| Notification settings | • Manage your subscriptions using Notification Settings.  
• For each of your subscriptions, set email notifications using Notification Preferences. |

Subscribe to content

Subscribe to forums, topics, questions, blogs, and videos. You are automatically subscribed to content that you create.

Before you begin
Role required: sn_communities.community_user

Procedure

1. To find the content of interest, use the search field or navigation to find the content of interest, such as a forum, topic blog, or video.
2. On the content page, click Subscribe.
• A confirmation message indicating that you have successfully subscribed to the content is displayed at the top of the screen.

• You receive a notification whenever there is an update to this content, for example, an answer to a question or a comment on a blog entry.

• You can view updates in your activity feed.

3. Optional: To remove a subscription, return to the content and click **Subscribed**. When you point to this option, it becomes **Unsubscribed**. You can also view your subscriptions and enable or disable them from the Community homepage by clicking your photo or name and clicking **Notification Settings**. Toggle **Receive Notifications** to turn all notifications on or off.

Related information

Set notification preferences
Community subscriptions

Set notification preferences
Set notification preferences to receive updates via email on the content that you are following.

Before you begin
Role required: sn_communities.community_user

About this task
The Communities application separates the notion of subscriptions from notifications. It is possible to subscribe to an item and disable notifications. You can also turn off all notifications.

Procedure
1. On the Community homepage, click **Community > Notification Settings**.
2. Click **Notification Preferences**.
3. To manage your notifications in those areas, choose your category, such as **Forums, Topics, Blogs**, or **Videos**.

   Choose the **Network** category and then choose **View Network** to view the community users, who are following you, or the community users that you are following.

4. In the **Email** column, toggle any item that should or should not send updates.
5. Optional: To turn all notifications on or off, toggle Receive Notifications.

Note:
Activity subscription modules will not be displayed in the Navigations and Subscriptions page, when you enable the disable_notifications flag.
The isNotificationDisabled API checks the value of the disable_notifications flag. This API can also be used for blocking notification of other activity subscription modules.

Request membership to a forum
You must be a registered member of the community to request membership to a forum that is marked for membership only.

Before you begin
Role required: sn_communities.community_user

Procedure
1. Perform either one of the following actions:
   • Navigate to Community > Homepage. Open Browse Community Forums and then select the forum.
   • Navigate to Community > All Forums and then select the forum in the list. If you requested membership earlier, the status of your request appears.

2. Click Request Access.
   If approval is required, Status changes to Requested. You receive an approval or rejection email. If approved, you are immediately subscribed to the forum and Status changes to Private Member.
   If no approval is required, the request is auto-approved and Status changes to Private Member.

3. Optional: To cancel a request, point to the Requested status and click Cancel.

4. Optional: To leave a forum, click ... within the forum and then select Leave Forum.
   Status changes to Request Access.
Accept an invitation to join a forum

An invitation to join a forum is sent as an email message. The method that you use to accept an invitation depends on whether you are a registered community user.

Before you begin
Role required: none

Procedure

1. Open the email invitation and click **Join Forum**.
   - If you are a registered and logged-in community user, the forum opens.
   - If you are a registered community user but have not accepted the community Terms & Conditions, a message appears to accept the Terms & Conditions. The forum opens after you accept the Term & Conditions.

2. If the login page appears, take one of the following actions:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you are a registered user and not logged in.</td>
<td>Enter your login credentials to access the forum.</td>
</tr>
<tr>
<td>If you are not a registered user.</td>
<td>a. Click <strong>Sign Up</strong> on the login page.</td>
</tr>
<tr>
<td></td>
<td>b. Enter your email address, a user name, and a password to create a community account.</td>
</tr>
<tr>
<td></td>
<td>c. The system sends a verification email. Click the verification link in the email to confirm your credentials.</td>
</tr>
<tr>
<td></td>
<td>d. Reopen the email invitation and click <strong>Join Forum</strong>.</td>
</tr>
</tbody>
</table>

Forum membership is auto-approved and you are subscribed to the forum. **Status** changes to **Leave Forum**.

Post and respond to content in the community

Post and respond to content in the community to get answers or share information.
Before you begin
Role required: sn_communities.community_user

Procedure
Perform one or more of the following tasks from the community homepage.

Ask a question in the community
Ask a question in a forum to get an answer from other community users.

Before you begin
You can only ask a question in a forum if you have been assigned the correct permissions.
Role required: sn_communities.community_user

About this task
If you ask a question, you can edit or delete it. If you created the question and reply with an answer, your answer is labeled Author.

There are three ways of asking questions in Communities.

Procedure
1. From the Communities homepage, perform one of the following actions.
   - Locate the forum to ask a question in, click its name, and then click Have a question? Click here to start typing. Type-ahead search shows related posts. Click to open a related post in another page.
   - Locate the forum to ask a question in and click Post > Question.
   - If you do not see a forum, click Have a question? Click here to start typing.
2. Click Question.
3. On the form, fill in the fields.

Ask a question form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Question</td>
<td>Your question.</td>
</tr>
<tr>
<td>Forum</td>
<td>Forum to add the question to.</td>
</tr>
</tbody>
</table>

Note: If you created the question by clicking a forum from the Communities homepage, this forum is automatically entered in this field.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Topic (s) (optional)</td>
<td>Topic to add the question to. Note: You can repeat this previous step for as many topics as you want. If you change your mind about a particular topic, click its corresponding xicon.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Content of the question. To insert an image, click the <strong>Insert Image</strong> button ( <img src="https://servicenow.com/images/doc/insert_image.png" alt="Insert Image" />), navigate to the .png or .jpg file, and then click <strong>Open</strong>. To insert a video, click the <strong>Insert Video</strong> button ( <img src="https://servicenow.com/images/doc/insert_video.png" alt="Insert Video" />), enter the video URL, and then click <strong>Upload</strong>.</td>
</tr>
<tr>
<td>Add attachments</td>
<td>To attach a file, click <strong>Add attachments</strong> and then drag the file into the <strong>Attach Document</strong> box or click the box and then navigate to the file. • You can add up to three attachments. • File types supported are PPT, PPTX, XLS, XLSX, DOC, DOCX, TXT, PDF, PNG, BMP, JPG, JPEG, GIF, ZIP. • Maximum file size is 2 MB. • Supported file types are listed. • Click the X icon to delete an attached file. Note: Your system administrator may have set a limit on the total number of attachments allowed across the community. When you click <strong>Add</strong>, your attachments are added and displayed in the question. If a user attaches a file to your question, you receive an email notification. Note: If antivirus protection is enabled, all attachments are automatically scanned for viruses once the question is posted.</td>
</tr>
</tbody>
</table>

4. Click **Post**.
• The question is added and is available to users in this forum. You are automatically subscribed to this question. When there is a reply, you receive a notification.

• Community users who are subscribed to the forum receive a notification that content has been posted. Activity and content feeds are updated accordingly.

• If you have added attachments to your question and your community administrator has enabled antivirus protection, a scan automatically runs in the background.

⚠️ Note:

◦ If the scan is successful, the attachments are available to download.

◦ If the scan is in process or unsuccessful, the file is unavailable for download.

◦ Question authors and community administrators receive a notification that an attachment is infected.

• Click Edit to remove the infected file and upload the attachment again. You cannot add any more attachments until the infected file is removed.

• If you are a user whose content is due to be moderated, the content is not posted until approved by a community moderator.

Related information

Disable comments

Reply to a question in the community

Reply to a question or another reply.

Before you begin

You can only reply to a question or another reply in a forum or sub forum if you have been assigned the correct permissions.

Role required: sn_communities.community_user

Procedure

1. To find the question or a reply to respond to, use search or navigation from the community homepage.

   You can also reply to a question or a reply from the activity feed on the homepage.

2. Click Reply.
3. Enter your reply.

4. **Optional:** If required, you can add an image to your reply.
   a. Click the Insert image-editing control.
   b. Choose your .png or .jpg format image file.
   c. Click Open.

5. **Optional:** If required, you can add a video to your reply.
   a. Click the Insert Video button ()
   b. Enter the video URL.
   c. Click Upload.

6. **Optional:** You can add attachments to your post.
   a. Click Add Attachments.
   b. Drag your file into the Add Attachments box or click Click to Upload.
   c. Click Add.
   Your attachment is added and displayed in your post. If a user attaches a file to your content, you receive an email notification.

   **Note:**
   - You can add up to three attachments per post.
   - The maximum file size per attachment is 2 MB.
   - Your system administrator may have set a limit on the total number of attachments allowed across the community.
   - File types supported are PPT, PPTX, XLS, XLSX, DOC, DOCX, TXT, PDF, PNG, BMP, JPG, JPEG, GIF, ZIP
   - If antivirus protection is enabled, all attachments are automatically scanned for viruses once the reply is posted.

7. Click Reply.
   The reply is added below the question and any other replies. The reply is available to users in this forum.
   Community users who are subscribed to the forum receive a notification that content has been posted. Activity and content feeds are updated accordingly.

   **Note:** If you are a user whose content is due to be moderated, the content is not posted until approved by a community moderator.
If you have added attachments to your reply and your community administrator has enabled antivirus protection, a scan automatically runs in the background.

- If the scan is successful, the attachments are available to download.
- If the scan is in process or unsuccessful, the file is unavailable for download.
- Reply authors and community administrators receive a notification that an attachment is infected.
- Click Edit to remove the infected file and upload the attachment again. You cannot add any more attachments until the infected file is removed.

**Post a blog in the community**

Create a blog post and publish it immediately, schedule to publish at a specified date, or save it as a draft.

**Before you begin**

You can only post a blog in a forum or sub forum if you have been assigned the correct permissions in the parent forum.

Role required: sn_communities.community_user

**About this task**

You can post, edit, and delete a blog. If you comment on the blog that you create, your answer is labeled as Author.

**Procedure**

1. Locate the forum to create a blog in and click its name.
2. Click Post and then click Blog.
3. On the form, fill in the fields.

**Post a blog form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blog Title</td>
<td>Title for your blog.</td>
</tr>
<tr>
<td>Forum</td>
<td>The forum or sub forum to add the blog to.</td>
</tr>
</tbody>
</table>

**Note:** When you create the blog by clicking a forum or sub forum from the Community homepage, the forum or sub forum name is automatically displayed in the field.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Topic(s) (optional)</td>
<td>Topic to add the blog to.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can repeat this step to add as many topics as you want. To delete a particular topic, click its corresponding x icon.</td>
</tr>
<tr>
<td>Description</td>
<td>Content of the blog.</td>
</tr>
<tr>
<td></td>
<td>To insert an image, click the <strong>Insert Image</strong> button (.getDrawable), navigate to the .png or .jpg file, and then click <strong>Open</strong>.</td>
</tr>
<tr>
<td></td>
<td>To insert a video, click the <strong>Insert Video</strong> button (getDrawable), enter the video URL, and then click <strong>Upload</strong>.</td>
</tr>
<tr>
<td>Add attachments</td>
<td>Click <strong>Add attachments</strong> and then drag the file into the <strong>Attach Document</strong> box. Alternatively, click the box and then navigate to the file.</td>
</tr>
<tr>
<td></td>
<td>• You can add up to three attachments with supported file types.</td>
</tr>
<tr>
<td></td>
<td>• File types supported are PPT, PPTX, XLS, XLSX, DOC, DOCX, TXT, PDF, PNG, BMP, JPG, JPEG, GIF, ZIP.</td>
</tr>
<tr>
<td></td>
<td>• Maximum file size is 2 MB.</td>
</tr>
<tr>
<td></td>
<td>• Click the X icon to delete an attached file.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Your administrator may have set a limit on the total number of attachments allowed across the community.</td>
</tr>
<tr>
<td></td>
<td>Click <strong>Add</strong>. If a user attaches a file to your blog, you receive an email notification.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If antivirus protection is enabled, all attachments are automatically scanned for viruses when the blog is posted.</td>
</tr>
<tr>
<td>Schedule Publish</td>
<td>Click the check box to publish the blog on a specified date. Select the date, time, and time zone of the blog. The scheduled blog is only visible for author and administrator until it is published.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> For a blog that has approval workflow, the blog state changes to &quot;Ready to publish&quot; when it is approved before the scheduled time. If a blog is approved after the scheduled time, the state changes to &quot;Published&quot;.</td>
</tr>
</tbody>
</table>
4. Complete one of the following actions to save your blog.

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Save as Draft | Review and publish your blog later. The blog appears as a draft on your profile page under Content > Drafts.  
  Note: Community and forum administrators can edit, delete, and publish drafts. If a community or forum administrator edits, deletes, or publishes your draft, you receive an email notification.  
  From your profile page, you have the following options.  
  a. To review your blog before publishing, click Edit.  
  b. • Click the corresponding ellipsis *** icon and then Publish.  
  • Click the corresponding ellipsis *** icon and then Delete. |
| Schedule     | Click Schedule to post a blog on the specified date. You can edit or disable the schedule until the blog is published.  
  Note: This option appears for a blog for which Schedule Publish option is selected. |
| Post         | Publish your blog directly. The forum subscribers receive an email notification. Activity and content feeds are updated accordingly. |
To | Do this
---|---
Note: If you are a user whose content is due to be moderated, the content is not posted until approved by a community moderator.

If you have added attachments to your blog and your community administrator has enabled antivirus protection, a scan automatically runs in the background.

- You can download the attachments only when the scan is successful.
- Blog authors and community administrators receive a notification for an infected attachment.
- Click Edit to remove the infected file and upload the attachment again. You cannot add any more attachments until you remove the infected attachment.

**Related information**

Disable comments

**Post a video in the community**

Post a video in a forum or sub forum.

**Before you begin**

You can only post a video in a forum or sub forum if you have been assigned the correct permissions in the parent forum.

Role required: sn_communities.community_user

**About this task**

You can post videos on their own or add them to a question or a blog. If you are the creator of the video or a community administrator, forum administrator, forum moderator, or community moderator, you can edit the videos once posted.
Procedure

1. While in a forum, click **Post > Video**.
2. On the form, fill in the fields.

### Post a video form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Click here to Insert a Video | • URL of your video.  
• Click **Upload**. The video is added to your post.  
• To edit and replace the current video with another one, click **Select a different Video**. |
| Video Title            | Title for the video.                                                        |
| Forum                  | Read-only. The forum or sub forum is automatically entered in this field.   |
| Topic(s) (optional)    | Topic to add the video to.                                                  |
|                        | 📌 **Note**: You can repeat this step for as many topics as you want. If you change your mind about a particular topic, click its corresponding ✗ icon. |
| Description (optional) | Description for your video.                                                 |

3. Click **Post**.

4. **Optional**: If you have permission to edit or delete the video, click a video, click the corresponding ⌫ icon, and then click **Edit** or **Delete**.

Once a video is uploaded, other community users can comment on it, give feedback, subscribe to the video, bookmark it, and report any inappropriate content in the video.

### Related information

- **Disable comments**

### Comment on a blog or a video in the community

Comment on a blog or a video or comment on another comment.
Before you begin
You can only comment in a forum or sub forum if you have been assigned the correct permissions in the parent forum.
Role required: sn_communities.community_user

About this task
If you create a comment, you can edit or delete it. If you created the blog or video and add a comment, your comments are labeled Author.

Procedure
1. To find the blog or video entry to comment on, use the search field or navigation.
2. Click Comment, and enter your answer.
3. You can add attachments to your post.
   a. Click Add Attachments.
   b. Drag your file into the Add Attachments box or Click to Upload.
   c. Click Add.
      Your attachment is added and displayed in your post. If a user attaches a file to your comment, you receive an email notification.

Note:
- You can add up to three attachments per post.
- The maximum file size per attachment is 2 MB.
- Your system administrator may have set a limit on the total number of attachments allowed across the community.
- File types supported are PPT, PPTX, XLS, XLSX, DOC, DOCX, TXT, PDF, PNG, BMP, JPG, JPEG, GIF, ZIP.
- If the attachment size is large or you have a slow connection, a progress indicator is displayed.
- If antivirus protection is enabled, all attachments are automatically scanned for viruses once the reply is posted.
4. Click Comment.
   The comment is added below the blog or video entry and any other comments. The answer is available to users in this forum.
Community users who are subscribed to the forum receive a notification that content has been posted. Activity and content feeds are updated accordingly.

ℹ️ Note: If you are a user whose content is due to be moderated, the content is not posted until approved by a community moderator.

If you have added attachments to your comment and your community administrator has enabled antivirus protection, a scan automatically runs in the background.

- If the scan is successful, the attachments are available to download.
- If the scan is in process or unsuccessful, the file is unavailable for download.
- Comment authors and community administrators receive a notification that an attachment is infected.
- Click Edit to remove the infected file and upload the attachment again. You cannot add any more attachments until the infected file is removed.

### Post a document in the community

If you have the proper permissions in a forum, you can share a document with colleagues, experts, or other community users. You can associate the document with as many topics as needed.

**Before you begin**

Role required: sn_communities.community_user

**Procedure**

1. While in a forum, click **Post > Document** and then fill in the form:

<table>
<thead>
<tr>
<th>Document title</th>
<th>Enter a descriptive title for the document.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forum</td>
<td>Read-only. The current forum or sub forum is selected.</td>
</tr>
<tr>
<td>Topics</td>
<td>Select a topic from the list. Repeat for as many topics as needed.</td>
</tr>
<tr>
<td>Attach document</td>
<td>To attach a file, drag the file into the Attach Document box or click the box and then navigate to the file.</td>
</tr>
</tbody>
</table>

- You can attach only one document.
- Maximum file size is 5 MB.
• File types supported are PPT, PPTX, XLS, XLSX, DOC, DOCX, TXT, PDF, PNG, BMP, JPG, JPEG, GIF, ZIP.

• Click the X to delete an attached file.

**Note:** Your administrator may have set a limit on the total number of attachments allowed across the community.

If antivirus protection is enabled, all attachments are automatically scanned for viruses when you click **Post**.

| Description | Enter a useful description for the document. |

2. **Click Post.**

• The document appears in the forum. The author of a document can edit or delete the post.

• Community users who are subscribed to the forum receive a notification that content has been posted. Activity and content feeds are updated accordingly.

**Note:** If you are a user whose content is due to be moderated, the content is not posted until approved by a community moderator.

If your community administrator has enabled antivirus protection, a scan automatically runs in the background.

**Note:**

• You can download the attachments only when the scan is successful.

• The user who posted the document and community administrators receive a notification that an attachment is infected.

**Related information**

Disable comments

**Mention a user in the community**

Draw attention to your content in the community by mentioning other community users in the post.

**Before you begin**

Role required: sn_communities.community_user
About this task
You can mention users in questions, blogs, events, comments, and answers.

Note: The user mentions feature is not enabled for document or video content types.

You can mention users in Communities in the following ways.

Procedure
1. From the community, perform one of the following actions.
   • Post content to the community and place your cursor in the script editor.
   • Click the content you want to comment on or reply to.
2. Enter the @ symbol followed by the user’s name.

   Note: You can mention multiple community users in the post.

An email notification is sent to the community users you selected and their followers, any community users that follow the user. The activity feed is also updated.

   Note: Followers can set their notification preferences to enable or disable notifications of user mentions.

Community events
Create, manage, and participate in events to encourage engagement across the community.

Before you begin
Role required: sn_communities.admin or sn_communities.community_user

Procedure
Perform one or more of the following tasks.

Post a community event
You can create a community event that other community users, colleagues, or experts can register for and attend.

Before you begin
You must have permission to create events (Event Write and Comment Write) and be a member of the forum to create the event in. The Event content type must be active in the forum for the event.
Role required: sn_communities.community_user

Procedure
1. While in a forum, click Post > Event and then fill in the form.

Create an event

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event title</td>
<td>A title for your event.</td>
</tr>
<tr>
<td>Forum</td>
<td>Read-only. The forum is automatically entered in this field.</td>
</tr>
<tr>
<td>Topic(s) optional</td>
<td>A topic to add the event to.</td>
</tr>
<tr>
<td>Note: You can add as many topics as needed. To remove a topic, click the x.</td>
<td></td>
</tr>
<tr>
<td>Set guest limit / Total allowed</td>
<td>Select the check box to specify the maximum number of guests that can attend in the Total allowed field. When the number of guests reaches to the limit, additional users are added to the wait list.</td>
</tr>
<tr>
<td>Display guest list to the public</td>
<td>Select the check box to enable forum members to view the guest list for the event.</td>
</tr>
<tr>
<td>This is an online event</td>
<td>For an online event, click the check box.</td>
</tr>
<tr>
<td>Name of location</td>
<td>For an online event, the text specified in the Name of Location appears as a label with a hyperlink to the specified Web URL. For example, enter the text as 'Click Here to Join the meeting' to facilitate your subscribers to join the meeting. For an offline event, enter the Name of location, Address, City, State, Zip/Postal Code, and Country to mention the venue.</td>
</tr>
<tr>
<td>Web URL</td>
<td>Enter the Web URL of an online event for your subscribers to click and join.</td>
</tr>
<tr>
<td>Date and time</td>
<td>The date and time of the event. Date must be in the future.</td>
</tr>
<tr>
<td>Note: If you change the Duration, the End Time is auto-updated.</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td><strong>Click</strong></td>
<td><strong>Change time zone</strong> to set the time zone for the event. Default: Your local time zone. The time zone changes according to the time zone of the user viewing the event.</td>
</tr>
<tr>
<td><strong>Duration</strong></td>
<td>The duration of the event.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>If you change the <strong>End Time</strong>, the <strong>Duration</strong> is auto-updated.</td>
</tr>
<tr>
<td></td>
<td>By default, the duration is 30 minutes.</td>
</tr>
<tr>
<td><strong>Send reminder to</strong></td>
<td>Select the check box to send an email reminder one day before the event to all users that responded <strong>Attend</strong>.</td>
</tr>
<tr>
<td><strong>guests one day before</strong></td>
<td></td>
</tr>
<tr>
<td><strong>the event</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>The description of the event.</td>
</tr>
<tr>
<td></td>
<td>To insert an image, click the <strong>Insert Image</strong> button ( <img src="image.png" alt="image" /> ), navigate to the .png or .jpg file, and then click <strong>Open</strong>.</td>
</tr>
<tr>
<td></td>
<td>To insert a video, click the <strong>Insert Video</strong> button ( <img src="video.png" alt="video" /> ), enter the video URL, and then click <strong>Upload</strong>.</td>
</tr>
<tr>
<td><strong>Add attachments</strong></td>
<td>Click <strong>Add attachments</strong> and drag the file into the <strong>Attach Document</strong> box or click the box and then navigate to the file.</td>
</tr>
<tr>
<td></td>
<td>• You can add up to three attachments.</td>
</tr>
<tr>
<td></td>
<td>• File types supported are PPT, PPTX, XLS, XLSX, DOC, DOCX, TXT, PDF, PNG, BMP, JPG, JPEG, GIF, ZIP.</td>
</tr>
<tr>
<td></td>
<td>• Maximum file size is 2 MB.</td>
</tr>
<tr>
<td></td>
<td>• Click the X icon to delete an attached file.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Your system administrator may have set a limit on the total number of attachments allowed across the community.</td>
</tr>
<tr>
<td></td>
<td>When you click <strong>Add</strong>, your attachments are added and displayed in the event. If a user attaches a file to your event, you receive an email notification.</td>
</tr>
<tr>
<td><strong>Schedule Publish</strong></td>
<td>Click the check box to publish an event on a specified date. Select the date and time of the event. By default, the schedule time zone is same as event time zone. The</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>scheduled event is only visible for author and administrator until it is published.</td>
</tr>
<tr>
<td></td>
<td>⚠️ <strong>Note:</strong> For an event that has approval workflow, the event state changes to &quot;Ready to publish&quot; when it is approved before the scheduled time. If an event is approved after the scheduled time, the state changes to &quot;Published&quot;. You cannot schedule a published event.</td>
</tr>
</tbody>
</table>

2. Perform one of the following actions:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save as Draft</td>
<td>Click <strong>Save as Draft</strong> to save the event as a draft on your profile page under <strong>Content &gt; Drafts</strong>.</td>
</tr>
<tr>
<td></td>
<td>⚠️ <strong>Note:</strong> Community and forum admins can edit and publish drafts. If a community or forum admin edits, deletes, or publishes the draft, you receive an email notification.</td>
</tr>
<tr>
<td></td>
<td>From your profile page, you have the following options.</td>
</tr>
<tr>
<td></td>
<td>a. Click <strong>Edit</strong> to review the event before publishing.</td>
</tr>
<tr>
<td></td>
<td>b. • Click the corresponding ellipsis ⋮ icon and then click <strong>Publish</strong>.</td>
</tr>
<tr>
<td></td>
<td>• Click the corresponding ellipsis ⋮ icon and then click <strong>Delete</strong>.</td>
</tr>
<tr>
<td>Schedule</td>
<td>Click <strong>Schedule</strong> to publish an event on the specified date.</td>
</tr>
<tr>
<td></td>
<td>⚠️ <strong>Note:</strong> This option appears for an event for which <strong>Schedule Publish</strong> option is selected.</td>
</tr>
</tbody>
</table>
To | Do this
--- | ---
| **Publish** | Click **Publish** to publish the event directly. As an author, you can edit or delete the event. Community users who are subscribed to the forum receive a notification that content has been posted. Activity and content feeds are updated accordingly.

**Note:** If you are a user whose content is due to be moderated, the content is not posted until approved by a community moderator.

Related information
- Edit an event
- Disable comments

**Edit an event**
Edit the details of past and upcoming events. By editing a past event, you can attach a document or share the meeting recording link with your event subscribers.

**Before you begin**
Role required: `sn_communities.community_user`, `sn_communities.moderation_admin`, `sn_communities.community_moderator`, `sn_communities.forum_moderator`, or `sn_communities.forum_admin`

**Procedure**
1. Search for an event that you want to modify.
2. Click the More Options icon (*** ) and then click **Edit**.
3. On the form, edit the fields as required.
## Update Event form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Subscriber receives an email notification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event title</td>
<td>Title for past and upcoming events.</td>
<td>Yes</td>
</tr>
<tr>
<td>Forum</td>
<td>Forum name in which the event is posted. You cannot modify the forum.</td>
<td>NA</td>
</tr>
<tr>
<td>Topic(s)</td>
<td>Topics that are associated with the event. Add or modify topics as needed. To remove a topic, click x.</td>
<td>No</td>
</tr>
<tr>
<td>Set guest limit</td>
<td>Option to increase the guest limit to confirm the participants on the waiting list for an upcoming event. You cannot modify the guest limit for a past event.</td>
<td>Yes - for a confirmed participant</td>
</tr>
<tr>
<td>Display guest list to users</td>
<td>Option to enable or disable the display of the guest list of an upcoming event for forum members.</td>
<td>No</td>
</tr>
<tr>
<td>This is an online event</td>
<td>Option to change the event type to online or offline for an upcoming event. You cannot change a past event.</td>
<td>Yes</td>
</tr>
<tr>
<td>Name of location</td>
<td>Name of the location for past and upcoming events.</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>• For an online event, the text specified in the Name of Location</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Subscriber receives an email notification</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>Field</td>
<td>field appears as a label with a hyperlink to the specified Web URL. For example, to share the meeting recording link of a past event, change the text to Download the meeting recording.</td>
<td></td>
</tr>
<tr>
<td>Web URL</td>
<td>Web URL for past and upcoming events.</td>
<td>Yes</td>
</tr>
<tr>
<td>Date and time</td>
<td>Date and time for an event. You can change the date and time to a future date for past and upcoming events. When you change the date of a past event to a future date, the past event becomes an upcoming event. You can edit all other details</td>
<td>Yes</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Subscriber receives an email notification</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
<td>------------------------------------------</td>
</tr>
</tbody>
</table>
|       | as applicable for an upcoming event. Click **Change time zone** to set the time zone for the event. The default is your local time zone. The time zone changes according to the time zone of the user viewing the event.  

**Note:** If you change the **Duration** field, the **End Time** field is auto-updated. | |
| Duration | Duration of the event.  

**Note:** If you change the **End Time**, the **Duration** is auto-updated.  
By default, the duration is **30 minutes**. | Yes |
<p>| Send reminder to guests one day before the event | Option to send an email reminder one day before the event to all users that responded <strong>Attend</strong>. This check box only appears for upcoming events and not for past events. | No |
| Description | Description for past and upcoming events. You can insert an image or a video as required. | Yes |
| Add attachments | Attachments for past and upcoming events. | Yes |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Subscriber receives an email notification</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Edit an attachment if required.</td>
<td></td>
</tr>
<tr>
<td>Schedule Publish</td>
<td>Option to publish an event. This check box appears only for a scheduled event and not for a published event.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• To reschedule, change the scheduled date and time as required. By default, the schedule time zone is the same as the event time zone. Selecting this check box publishes an event directly at the scheduled date and time.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• To delete the schedule, clear the check box.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

4. Perform one of the following actions:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
<td>To save the details, click <strong>Save</strong>.</td>
</tr>
<tr>
<td>Schedule</td>
<td>To publish an event on the specified date, click <strong>Schedule</strong>.</td>
</tr>
</tbody>
</table>

**Note:** This option appears for a draft event that the **Schedule Publish** check box is selected for.
To publish an event draft, click **Publish**. As an author, you can edit or delete the event.

**Note:** If you’re a user whose content is due to be moderated, the content is not posted until it’s approved by a community moderator. For an event that has approval workflow, the event state is Review. Other users cannot view the event until it’s approved.

### Related information

- Post a community event
- Disable comments

### View and participate in a community event

You can view details for published events and perform tasks such as responding to the event or adding it to your calendar.

### Before you begin

You must be a registered member of the community and have permission to read events (**Event Read and Comment Write**) to be able to respond to events.

Role required: sn_communities.community_user

### Procedure

1. From the community homepage, perform one of the following actions:
   - Navigate to the Content List.
   - Navigate to the Activity Feed.
   - Navigate to a forum or topic.
   - Navigate to the community profile of another user and click the **Events** tab.
   - Click **Community > Events**.

2. Click an event.
   The Event details page displays the following information.
Event header

- View the name of the event, who created it, and when.
- If the event organizer chose to display the guest list to the public, you can view how many community users have responded **Attending** or **Maybe** and click the numbers to see the names.
- If the guest list is private, you can view how many community users have responded **Attending** or **Maybe**, but you cannot see the names.
- View the number of spots still available in the event or your position on the waitlist.
- If the event is taking place in the same time zone as you set in your user preferences, the **Event time zone** is displayed.
- If the event is taking place in a different time zone to the one that you set in your user preferences, both **Event time zone** and **Your time zone** are displayed.

Event overview

- When and where the event is taking place.
- Description of the event.
- Topics associated with the event.
- Comments on the event.
- Number of times the event has been viewed.

Upcoming Events

Next five upcoming events.

Popular Past Events

Top five most popular past events and the number of community users that were interested in the event. Interested community users include users who either attended or were waitlisted for the event.

3. Optional: Click **Attending**, **Maybe**, or **Declined** to view or search the guest list and their responses.

4. Optional: Click **Subscribe** to subscribe to the event and receive notifications when the event is updated. If your response is **Attending** or **Maybe**, you are auto-subscribed to the event.

5. Optional: Click **Respond** to indicate whether you are attending or maybe attending the event, to decline, or to add yourself to the waitlist.

- You can also respond to an event directly from the Activity Feed.
- If the event is full, a message stating that you can join the waitlist is displayed. The **Attend** option replaces **Waitlist**. If you are waitlisted, your position on the waitlist is displayed. Once a position becomes available in the event, you move up in the list.
Depending on your selection, the status changes to either **Attending**, **Maybe**, **Declined**, or **Waitlisted**. You can update your response as needed.

- If an event creator or community admin deletes an event and you responded **Yes**, **Waitlist**, or **Maybe**, you receive an email notification based on your notification preferences.
- If an event is updated, and you responded **Yes**, **Waitlist**, or **Maybe**, you receive an email notification based on your notification preferences.

6. Optional: Click ... to perform one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add to calendar</td>
<td>Downloads an .ics file that you can add to your calendar. The file includes the title and description of the event, the event location, start and end dates, the event time, and any attachments. If guests have chosen not to share details, the information is not displayed in the file.</td>
</tr>
<tr>
<td>Bookmark</td>
<td>The event appears in your bookmarks list on your profile page. Click <strong>Remove Bookmark</strong> to delete a bookmark.</td>
</tr>
<tr>
<td>Report content</td>
<td>Click <strong>Report content</strong> to report inappropriate content in the event.</td>
</tr>
</tbody>
</table>

View the community events landing page

The Events landing page provides an overview of all events that you have access to in the community. You can filter events, view your status for the event, see how many other community users are attending an event, and so on.

**Before you begin**

Community users must have permission to view events (**Event Read**).

Role required: sn_communities.community_user

**Procedure**

1. Navigate to **Community > Events**.

   The Events landing page displays a list of all events that you have access to and a list of the five most popular past events.
2. Filter the list for events that you created or according to attendance status, by forum, and by date.  
The list displays the following information.  
• The event creator, last update, and location.  
• Your status, if you have already responded to the event.  
• The number of community users who are interested in the event. Interested community users include users who are attending or have been waitlisted for the event.  
• The number of community users who have viewed the event.

3. Click an event to perform tasks related to the event.

**Manage a community event**

View additional response information on the event, edit or delete events, and download a guest list.

**Before you begin**

You must be a registered member of the community and have permission to read events (**Event Read and Comment Write**) to be able to respond to events.

Role required: sn_communities.community_user who created the event or sn_communities.admin.

**About this task**

You can access published events from several places within the community.

**Procedure**

1. From the community homepage, perform one of the following actions.
   • Navigate to the Content List.
   • Navigate to the Activity Feed.
   • Navigate to a forum or a topic.
   • Navigate to another user's community profile and click the Events tab.
   • Click Community > Events.

2. Click an event.
   The Event details page displays the following information.
Event header

- View the name of the event, who created it, and when.
- View how many community users are attending or maybe attending.
- View how many community users declined the event.
- View the number of spots still available in the event or your position on the waitlist.

Event overview

- When and where the event is taking place.
- The description of the event.
- The topics associated with the event.
- Comments on the event.
- The number of times the event has been viewed.

Upcoming Events

Shows the next five upcoming events.

Popular Past Events

Shows the top five most popular past events and the number of community users that were interested in the event. Interested community users include users who either attended or were waitlisted for the event.

3. Optional: Click the ... icon.

4. You have the following options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit</td>
<td>Click Edit. The Update Event page opens. An email notification is sent to all community users who responded Yes, Maybe, or Waitlist.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click Delete. A warning message appears asking if you are sure that to delete the event. An email notification is sent to all community users who responded Yes, Maybe, or Waitlist.</td>
</tr>
<tr>
<td>Add to calendar</td>
<td>An .ics file is downloaded that you can add to your calendar. The file includes the title and description of the event, the event location, start and end dates, the event time, and any attachments. If guests have chosen</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>not to share their details, the information is not displayed in the file download.</td>
<td></td>
</tr>
<tr>
<td>Bookmark</td>
<td>The event appears in your bookmarks list on your profile page. If you have already bookmarked the event, you can click <strong>Remove Bookmark</strong>.</td>
</tr>
<tr>
<td>Report content</td>
<td>As a community admin, click <strong>Report content</strong> to report inappropriate content in the event.</td>
</tr>
<tr>
<td>Download Guest List</td>
<td>Download a .csv file of the guest list. View the file to see the list of community users attending the event, their RSVP status, and email address.</td>
</tr>
</tbody>
</table>

**Bookmark community content**

You can bookmark your favorite questions, blogs, videos, documents, and events. You cannot bookmark content in draft state or replies or comments.

**Before you begin**

Role required: sn_communities.community_user

**Procedure**

1. Click the content to bookmark.
2. Click the ... icon and then select **Bookmark**. The bookmarked content is added to the **Bookmarks** tab on your community profile.
3. To view your bookmarks, perform one of the following actions.
   - Navigate to your community profile and then click **Content > Bookmarks**.
   - Click your name or profile photo and then click **My Bookmarks**.
4. You can search for bookmarks and, if required, select a bookmark and then click **Remove Bookmark**.

**Provide feedback on community content**

Provide feedback on content that you find useful.
Before you begin
Role required: sn_communities.community_user

About this task
There are four supported types of content feedback: comment, upvote, helpful, and mark as correct answer. You can enter feedback directly in the Activity Feed on the Community homepage or navigate to the content you want to provide feedback on.

Content Feedback

<table>
<thead>
<tr>
<th>Content feedback</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comment</td>
<td>Comment on blogs and videos. You can also comment on a comment. The count of comments is displayed.</td>
</tr>
<tr>
<td>Upvote</td>
<td>Upvote questions. The count of upvotes is displayed.</td>
</tr>
<tr>
<td>Helpful</td>
<td>Mark answers, blogs, comments, and videos as Helpful. The count of helpful marks is displayed.</td>
</tr>
<tr>
<td>Mark as Correct Answer</td>
<td>If you are a community or forum administrator, community or forum moderator, or the author of the question, you can mark one answer as Mark as Correct Answer. There is only one correct answer for each question. If you later mark a different answer as correct, the current answer loses this status.</td>
</tr>
</tbody>
</table>

Procedure

1. From the Community homepage, perform one of the following actions.
   - Click a forum and then click the content, for example, a blog or a question.
   - Use search and then click the content.
   - Navigate to the content on the homepage Activity Feed and provide your feedback directly from here.

2. Enter your feedback.
   The following feedback is displayed.
Report inappropriate community content

Report content to alert community moderators that the content is inappropriate or spam.

Before you begin
Role required: sn_communities.community_user

Procedure
1. Use the search field or navigation to find the content to report.
2. Click the ... icon and then click Report Content.
3. From the list, select the reason you are reporting the content from the list and add Additional Comments.
4. Click Submit.
   A moderation task is created and assigned to a moderator for resolution. Depending on the moderation settings created for your community, the content may be hidden until a moderator has reviewed it.

View a list of questions and create a case

To easily view questions that can potentially be converted to cases, the community portal provides a page with a list of questions created by contacts or consumers.
Before you begin
Role required: sn_customerservice_manager, sn_customerservice_agent, sn_customerservice.consumer_agent, sn_communities.admin, or a user with the proxy_case_creator role

About this task
This page displays questions from the forums to which the user has access.

Procedure
1. From the community portal, click Community > Questions to Case to open the list of questions.
   This list includes questions that have been posted by a contact or a consumer and for which a case has not yet been created.

2. Use the filters on this page to filter the question list:
   • View questions for all forums or for the selected forum
   • View questions posted within the selected time frame: 7, 15, or 30 days
   • Sort by the most recent questions or older questions
   • Sort by the question status: all, solved, unsolved, or unreplied

3. To create a case from one of the questions in the list, click a question to open the question page.

4. Click the overflow icon (...) and then click Create Case to open a Create Case form.
   The Create Case action is available if a case has not yet been created from a question. Once a case has been created, this action is no longer available.
   Information from the question is mapped to the fields on the case.

5. Enter any additional information in the fields on the Create Case form. For example, add Description for the case.

6. If necessary, attach a file to the case.

7. Click Submit.
   You are returned to the question content page. The case number appears in the question header after the case is created. The question author, the customer service agent or consumer service agent, or any user with the proxy_case_creator role can see the case number.

   The contact or consumer who posted the question can also view the case by navigating to My Cases on the Customer Service Portal or Consumer Service Portal.
Gamification

Encourage users to participate and contribute content in the community by providing incentives in the form of points, achievement levels, and badges.

Use the gamification framework to:

• Configure point values associated with specific user activities.
• Define achievement levels based on earned points.
• Create and assign badges to recognize users.

Community administrators can:

• Create rules and configure points that users receive for activities on the community.
• Create tracks to logically separate points assigned in the communities into different areas.
• Create levels in the community where users can achieve expertise or a reputation and then configure level ranges within each level definition.
• Create badges to award to users for different achievements.

Community users can:

• Perform activities and accrue points.
• Achieve levels based on point totals.
• View leaderboards to find community experts on specific forums or topics.
• See their own standing within the community.
• See gamification achievements on their user profiles.

Gamification components

The gamification feature includes several components, such as rules, levels, and tracks, that enable users to earn points and badges for community activities.

Rules

Gamification rules allow you to configure points that users receive for activities on the community.

Gamification includes several pre-defined rules. The gamification administrator can use these rules, modify them as needed, or create new rules. These pre-defined rules include:
Comment marked as helpful: 5 points
Document marked as helpful: 5 points
Video marked as helpful: 5 points
Blog marked as helpful: 5 points
Answer marked as helpful: 20 points
Document bookmarked: 20 points
Blog bookmarked: 20 points
Video bookmarked: 20 points
Answer marked correct for a question: 40 points

When a user performs an activity that has a gamification rule, the user profile identified in the rule receives points. Points received through a gamification rule can be configured to accumulate toward:

• Overall points across the entire community
• Points in forums associated with the activity
• Points in topics associated with the activity
• Points in a track
• Points assigned for a combination of forums, topics, and tracks

If users revert previous activities, the points associated with these activities are removed. As an example, if a rule has been defined and a user creates a blog, they are awarded points. The points are deducted when the blog is deleted. If a rule has not been defined and a user creates a blog, no points are awarded. If the user removes it once a rule has been defined, points are deducted even though none were awarded in the first place.

Related information
Create a gamification rule

Tracks
Tracks provide a way to logically separate points assigned in the communities into different areas.

Gamification includes two pre-configured tracks:
• Community Expertise
• Community Participation
While the application is configured to accumulate points by tracks, gamification does not currently display tracks in the community portal.

**Related information**

Create a gamification track

**Levels and level ranges**

Points accumulated by community users can help them achieve different reputation levels.

The system is pre-configured with levels where community users can earn points and achieve expertise or a reputation:

- **Global**: overall points accumulated across the entire community
- **Forum**: points accumulated in forums associated with the activity
- **Topic**: points accumulated in topics associated with the activity

Gamification administrators can configure level ranges within each level. These level ranges progress from a starting point value to a higher value (point ranges do not overlap) and have unique, configurable names. For example, in the Global level, a user that has earned 100–499 points is a Newbie while a user that has earned 500–999 points is an Enthusiast.
In the community portal, users can see level range names and point totals in the gamification user interface components.

- On the leaderboard page and leaderboard widgets
- At the top of a user’s profile below the user name and title
- On the user profile page in the Achievements tab
- On content pages

Related information

- Manage gamification levels
- Manage gamification level ranges

Badges

Users can earn badges for achievements or areas of expertise within the community. Gamification moderators manually assign badges to users.

Gamification includes several predefined badges. Each badge includes:
Gamification administrators and moderators can award badges to community users and also remove badges. A badge can be awarded to a user one time. If a badge is removed from a user, it can be awarded to that user again.

Earned badges are visible in the community portal in the gamification user interface components. Community users can see earned badges and available badges on their own user profile page in the Achievements tab.

Related information
Create a gamification badge

Points
Users earn gamification points by performing activities in the community.

Users can earn points within a community, a forum, or a topic. As users accrue points, they achieve level ranges. Point totals appear on leaderboards and on user profiles, in the profile header, and in the Achievement tab. After points are awarded to a user, an entry appears at the top of the Points list and the user's point total is updated.

The Points list has a widget instance option to Show points for private forum.

- When set to true, the point record displayed in the user profile does not show the forum name if the user performing the action does not have forum access. It displays "Private Forum" in place of the forum name.
- When set to false, the point record does not display in the user profile.

The Points list also has a widget instance options for the Page size, which determines the number of results displayed in the list. If there are more results than the number specified in this option, a button to show additional results appears at the bottom of the points page.

Gamification user interface components
Gamification information appears on leaderboards, the user profile page, and content pages.
Leaderboard page

The leaderboard page displays the top contributors in the community, in a forum, or in a topic.

Users appear on the leaderboard based on the number of earned points and are ranked in descending order. You can filter the leaderboard to display information for the current month or all-time and by a specific forum or topic.

To display the leaderboard, navigate to Community > Leaderboard. You can also click Show Leaderboard on the leaderboard widget. When navigating to the leaderboard from a leaderboard widget on a forum/topic landing page, the leaderboard shows the top point earners for that forum/topic.

For each user, the leaderboard displays:

- Rank: shows the rank depending upon the selected filters (time, forum or topic)
- Name
- Profile photo (if available) or initials
- Current level: shows global, forum, or topic level depending upon the selected filter
By default, the leaderboard displays 10 users per page. Users can use the pagination controls to view additional pages. Pointing to a user name in the leaderboard displays a pop-up window with more information about the user.

**Leaderboard widgets**

Leaderboard widgets appear on the Community homepage and on forum and topic landing pages. These widgets display the users with the highest point totals within the community, forum, or topic.

The leaderboard widget shows the top five users. If there are more than five users that have earned points within the community, forum, or topic, **Show Leaderboard** appears at the bottom. Click this button to display all of the users on the **leaderboard page**.

For forums and topics, the leaderboard widget header displays the forum or topic name. When navigating to the leaderboard page from a forum/topic, the leaderboard shows the top point earners for that forum/topic.

System administrators can configure settings for the leaderboard widget:

- The number of users displayed in the widget (default is 5, maximum is 10)
- The time period (overall or current month)
- The leaderboard type (community, forum, or topic)
- Anchor to a specific forum or topic (not recommended)
**User profile page**

The user profile page displays gamification information that showcases the user's expertise.

The gamification information is shown in three sections of the user profile page:

- In the header area
- In the Achievements tab
- In the forum and topic expertise widgets

**User profile header area**

When the gamification feature is enabled, the user profile header area includes the user's current gamification achievements. This information appears just below the user name and title:

- The top three badges that have been awarded to the user. Pointing to a badge displays the badge name.
- The total number of points earned by the user.
- The current global level achieved.

**Achievements tab**

Users can view details about gamification levels, badges, and points on the user profile page in the Achievements tab.

<table>
<thead>
<tr>
<th>Levels</th>
<th>A list of the levels available to the user, with the current level highlighted. This tab includes a link to the Community page How to Earn Points.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Badges</td>
<td>A list of the earned badges and available badges for the user. Earned badges appear at the top of the list. Earned badges are sorted by the most recently earned. Available badges appear below earned badges. Users can filter this list to view all badges or earned badges. When viewing another user's profile, only the earned badges are displayed and are sorted by the most recently earned.</td>
</tr>
<tr>
<td>Points</td>
<td>A history of the points earned and the activities performed by the user. This list</td>
</tr>
</tbody>
</table>
includes the last 10 activities. Click Show more to display additional pages.
Gamification moderators can award and remove points for community users. This tab includes a link to the Community page How to Earn Points.

**Forum and topic expertise widgets**

The forum and topic expertise widgets on the user profile page provide a visual representation of the user's top areas of expertise. The number within the circle and the blue highlight around the circle represent the number of levels completed. For example, 2 of 5. The number below the circle indicates the total number of points that the user has earned within the forum or topic. The widget displays up to five items and the system administrator can configure the widget to show up to a maximum number of 10 items. Clicking the info icon displays the forum or topic levels and the point ranges.

![Forum and topic expertise widgets](image)

© 2021 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Community content pages

The user's gamification level and badges are displayed on the content pages, so that other community users can view the reputation of the content contributor.

Pointing to a user name on content pages such as questions, blogs, and videos displays a pop-up window with gamification information including badges earned, point total, and level name. This information is available for the author or a user who has replied or commented on that content.

The community administrator can change the displayed level to show either the global level or the forum level. This display can be controlled by the `sn_communities.content.show_gamification_level` property.

Depending upon the information available, there can be three different versions for the pop-up:

- Profile photo and name
- Profile photo and name with global points
- Profile photo and name with global points and badges

Gamification notifications

Community users receive notifications about badge assignments and levels achieved through the activity feed.
This includes global, forum, and topic levels achieved. A user, or any of their followers, are notified through an activity feed update in the following scenarios:

- When a user advances a level (global, forum, or topic)
- When a user earns a badge

**How to earn points**

In order to be transparent to your users about gamification rules, you can share the points received for community activities.

Navigate to **Community > How to Earn Points** for a description of the activities that users can perform to earn points. This page has links to the user's profile page. If gamification rules are modified, then this page shows the updated information.

**Administer gamification**

Users with the gamification administrator role can create the rules and other entities that award points to users based on their participation within the community.

**Configure gamification properties**

Configure gamification properties to meet your company's needs.

**Before you begin**

Role required: sn_gamification.admin

**Procedure**

1. Navigate to **Community > Gamification Administration > Gamification Properties**.
2. Enter the number of days to store the gamification activity history. The default is 180 days. A scheduled job purges the points history that is older than 180 days. This purge does not delete the aggregated data.
3. Enter the maximum number of levels that can be defined.
4. Click **Save**.

   Additional properties can be configured for the gamification feature. For more information, see **Gamification properties**.
Create a gamification rule
Create gamification rules so that users can earn points for community activities.

Before you begin
Role required: sn_gamification.admin

Procedure
1. Navigate to Community > Gamification Administration > Rules.
2. Click New.
3. Fill in the fields on the Gamification Rule form as necessary.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rule Name</td>
<td>A descriptive name for the gamification rule.</td>
</tr>
<tr>
<td>Gamification Module</td>
<td>The application to which this rule applies. Click the lookup icon to select a module from the Gamification Modules list. The default is Community.</td>
</tr>
<tr>
<td>Activity Type</td>
<td>The user activity for which this rule applies. Click the lookup icon to select one of the available types from the Activity Types list.</td>
</tr>
<tr>
<td>Profile Receiving Points</td>
<td>The type of user profile that earns points for performing the activity defined in this rule. Click the lookup icon to select a profile corresponding to the activity.</td>
</tr>
<tr>
<td>Exclude Self-Award</td>
<td>Check box to ensure that the activity performer is not the same as the profile receiving points.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable this check box to activate the rule. The default is set to active.</td>
</tr>
<tr>
<td>Gamification Track</td>
<td>The gamification track to which this rule belongs. Click the lookup icon to select one of the available tracks from the Gamification Tracks list. By default, two tracks are available: Community Expertise, Community Participation</td>
</tr>
<tr>
<td>Points</td>
<td>The number of points earned by performing the activity defined in this rule.</td>
</tr>
<tr>
<td>Points for Areas of Expertise</td>
<td>The points accrued can be used towards a forum or topic level expertise. Click the lock icon to expand the field and...</td>
</tr>
</tbody>
</table>
4. Click **Submit**.
   The newly created rule appears on the Gamification Rules list. This rule appears on the How to Earn Points page.

**Create a gamification track**
Create tracks to provide a logical way to separate points assigned in the communities into different areas.

**Before you begin**
Role required: sn_gamification.admin

**Procedure**
1. Navigate to **Community > Gamification Administration > Tracks**.
2. Click **New**.
3. Fill in the fields on the Gamification Track form as necessary.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Track Name</td>
<td>A descriptive name for the gamification track.</td>
</tr>
<tr>
<td>Gamification Module</td>
<td>The module to which this track applies. Click the lookup icon to select a module from the Gamification Modules list. By default the module is set to Community.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable this check box to activate the track. By default this field is set to active.</td>
</tr>
<tr>
<td>Application</td>
<td>The application to which this track applies. By default the module is set to Community.</td>
</tr>
<tr>
<td>Track Display Order</td>
<td>The order in which the track appears.</td>
</tr>
</tbody>
</table>

4. Click **Submit**.
   The newly created track appears on the Gamification Tracks list.

**Note:** While tracks can be configured, it is not currently displayed anywhere on the Community portal.
Create a gamification badge

Create gamification badges that users can earn for achievements within the community.

Before you begin
Role required: sn_gamification.admin

About this task
The gamification feature includes several predefined badges.

Procedure
1. Navigate to **Community > Gamification Administration > Badges**.
2. Click **New**.
3. Fill in the fields on the Gamification Badge form as necessary.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gamification Module</td>
<td>The application to which the badge applies. The default module is <strong>Community</strong>.</td>
</tr>
<tr>
<td>Badge Name</td>
<td>The name of the badge as it appears on the Community portal.</td>
</tr>
<tr>
<td>Badge Display Order</td>
<td>The order of the badge indicates the rank. If a community user has multiple badges assigned to them, this field determines the sequence in which the badges are displayed.</td>
</tr>
<tr>
<td>Active</td>
<td>Enable this check box to activate the badge.</td>
</tr>
<tr>
<td>Description</td>
<td>A brief description of the badge as it appears on the Community portal.</td>
</tr>
<tr>
<td>Badge Icon</td>
<td>The image file for the badge. Click to add the icon, choose the desired image file, and then click <strong>OK</strong>.</td>
</tr>
</tbody>
</table>

Note: The recommended image size for ideal performance is 50 pixels by 50 pixels and less than 500KB.

4. Click **Submit**. The newly created badge appears on the Gamification Badges list.

Manage gamification levels
Manage the predefined levels for global, forum, and topic expertise.
Before you begin
Role required: sn_gamification.admin

About this task
Gamification includes predefined global, forum, and topic levels.

Procedure
1. Navigate to **Gamification > Configuration > Levels**.
2. View the existing definitions for global, forum, and topic levels.
3. Change the **Level Name** if required.
4. Click **Submit**.
   Adding new level definitions is not recommended unless there is a strong use case. If you need to add or modify level ranges in existing level definitions, see **Manage gamification level ranges**.

Manage gamification level ranges
Manage level ranges for a gamification level definition, to recognize the expertise level of your community users.

Before you begin
Role required: sn_gamification.admin

About this task
Gamification includes predefined global, forum, and topic levels. Each level definition can have several level ranges and the system is predefined with 10 ranges for global level and five ranges each for the forum and topic levels. Each range should not overlap and must have a unique start value.

Procedure
1. Navigate to **Gamification > Levels**.
2. Select the desired level (global, forum, or topic).
3. Modify the **Level Range Name**.
4. Modify the **Points Start** field.
   Each range should not overlap and must have a unique start value.
5. Click **Submit**.
   Level ranges are updated on the Community portal.
Moderate gamification
Monitor points earned by users and award points and badges to users based on their participation within the community.

Award or remove points for a community user
Award points to a user to recognize their contributions to the community. Remove points for a user if you observe that they are cheating the gamification system.

Before you begin
Role required: sn_gamification.moderator

Procedure
1. Navigate to the Community homepage.
2. Go to Community > Leaderboard.
3. Click the name of the user on the leaderboard to open the user profile.
4. Click the profile overflow icon (…) and select Assign Points.
5. In the Assign Points pop-up window, enter the number of Points, a Reason for awarding the points, and select a Track.
   a. To assign points, the points entered should be a positive value. For example, 100.
   b. To remove points, the points entered should be a negative value. For example, -100.
   The maximum number of points that can be awarded or removed at one time is 1000.
6. Click Assign Points.
   An entry for the point assignment activity shows at the top of the Points list and the user’s point total is updated.

Award a badge to a user
Award gamification badges to community users to recognize their community activities.

Before you begin
Role required: sn_gamification.moderator, sn_gamification.admin

About this task
A badge can be awarded to a user only once. If a badge is removed from a user, it can then be awarded to that user again.
Procedure

1. Navigate to Community > Gamification Data > Profile Badges.
2. Click New.
3. Select a Badge from the Gamification Badges list.
4. In the Live Profile field, add the name of the user.
5. Click Submit.
   The badge is assigned to the user and it appears on the community portal.

Remove a badge from a user

Remove a gamification badge from a community user if it is no longer relevant for that user.

Before you begin
Role required: sn_gamification.moderator, sn_gamification.admin

Procedure

1. Navigate to Community > Gamification Data > Profile Badges.
2. Select the Active field for the desired user and badge.
3. Change the Active field to false.
4. Click Update.
   The badge is removed for that user and is no longer visible on the community portal.
Index

A
Access types
  overview
  1459
account escalation
  172, 172, 174, 175, 433, 435, 709, 711, 711, 712, 714
account hierarchy
  create
  355
  overview
  353
account relationships
  create account relationship record
  352
  create account relationship type
  350
  overview
  348
account teams
  assign team members
  384
  view team members
  921
ACLs
  explicit roles
  1190
  hasRoles()
  1190, 1198
  internal and external users
  1190
  mandatory roles
  1198
  provide access to users
  1198
  snc_internal
  1190, 1198
activate communities plugin
  1437
Activate Workforce Optimization for Customer Service
  1327
administer communities
  1435
agent calendar
  add event
  296
  configure
  288
  create config
  288
  create personal event
  292
  create schedule
  294
  create user work schedule
  291
  move event
  299
  overview
  285
  show or hide events
  299
  use
  296
Agent Workspace for CSM
  228
anonymous chat
  create matching rule
  668
  modify record producer
  667
  overview
  664
  start chat
  669, 1092
Anonymous Connect Support
  activate
  328
asset contact relationships
assign a contact
375, 1058
assign a primary contact
374
overview
374
set property
375
assignment workbench
assign a case
915
create configuration
427
create criteria
424
matching criteria
700
matching rules
703
overview
696
properties
429

B
bookmarks
1567

C
case escalation
172, 172, 174, 175, 433, 435, 709, 711, 711, 712, 714
Channel Management in Workforce Optimization for Customer Service
1307
Channels in Workforce Optimization for Customer Service
1307
Communities
1435
clone permission
1477
create event
1553

donor user registration
1482
follow community user
1533
gamification
1570, 1575, 1581, 1581, 1581, 1581, 1583, 1583, 1584, 1585, 1585, 1586, 1586, 1587
manage event
1565
properties
1438
view and participate event
1562
view events homepage
1564
view logs
1505
Communities configure
1456
Communities forums
overview
1461
Communities forums (set up)
1452
Communities homepage
logged in users
1518
non-logged in users
1522
Communities roles
1450
Communities)
case management
integration
1506, 1506, 1569
harvest knowledge
Configure data collection to forecast the demand for resources

Configure Workforce Optimization for Customer Service

Consumer address

Consumer Service Portal accept case solution

anonymous chat

change password

create a case

create case from anonymous chat

create case from chat

create consumer record from anonymous chat

edit profile

log in

properties

register

register products

reject case solution

start a chat

view a case

view profile

view registered products

contact relationships

create a relationship

overview

create a case

CSM Agent Workspace

CTI softphone installed components

business rules

script includes

tables

CTI Softphone activate

Customer Communities accept invite forum

add content type forum

add member

add topic forum

add user

announcements

approve forum membership
approve reject content
1513
ban user
1512
configure abuse reporting
1509
configure banning
1510
configure general moderation settings
1508
configure moderation filters
1511
configure persona field mapping
1481
configure profile
1480
content types
enable
1458
copy permissions from another forum
1478
copy permissions from parent forum
1478
create blog
1545
create community profile field
1480
create document
1551
create forum
1461
create forum permission
1477
create permission
1475
create persona
1480
create question
1541
create Terms and Conditions
1482
create topic
1466
customize profile
1533
debug user permissions
1479
define access type permission
1475
define moderation new users
1509
disable topics
1467
events
1553
forum and user permissions
1470
invite users to a forum
1465
manage display settings
1535
manage permission exceptions
1476
manage subscriptions
1538
modify SEO
1492
performance dashboard
1496
post video
1548
provide feedback
1567
refine search
1525
remove content
1515
reply comment blog
1549
reply question
apply for membership forum
revise user ban
search
self-register
SEO data
sort
subscribe to content
use community profile
view another user's community profile
view user profile
Customer Communities
Moderation
overview
customer portal
assign role to contact
change password
community
create contact
create contact login
customer satisfaction survey
email notification preferences
enable or disable contact login
knowledge base
restrict access
manage registration requests
manage users
update contact information
notification preferences
reset password for contact
search feature
self-registration
approve request
login
password reset
reject request
submit request
view assets
view contact information
view or modify a case
customer service
account hierarchy
create
overview
agent calendar
create personal event
assignment workbench
   properties 429

case form
   timeline 1149

case timeline
   use with other applications 1149

contact relationships
   create a relationship 355
   overview 355

create schedule
   create personal event 294

CTI softphone
   installed components 1210, 1210, 1210

CTI Softphone
   installed components 1210

customer service CTI demo

data
   installed components 1210, 1211

knowledge product entitlements
   add related products 678
   business rules 1223
   installed components 1222
   overview 677
   properties 679, 1223

OpenFrame
   installed components 1211, 1211, 1211, 1212

special handling note create

916
special handling notes 704

business rules 1215
client scripts 1215
configuration 430
delete 919, 919
display on form 431
installed components 1213
properties 431, 1214
script includes 1216
tables 1213
update 947
user roles 1214

targeted communications
   add approver 186
   approve publication 196
   business rules 1217
cancel publications 199
client scripts 1220
create publication 190
create recipient list 187, 189
dynamic recipient list 185edit publications 195
expire publications
669
change password
1088
chat
934
create a case
1089
create case from
anonymous chat
936
create case from chat
938
create consumer record
939
create consumer record
from anonymous chat
937
edit profile
1088
log in
1086
register
1086
register products
1088
reject case solution
1090
start a chat
1091
view a case
1090
view profile
1088
view registered products
1089
Consumer Service Portal
anonymous chat
664, 667, 668, 669, 1092
properties
486
create a case
from the application
923
from the customer portal
1068
create a product model
358
create an asset
373
create entitlement
378
create work order for case
932
CSM virtual agent chatbot
topics
465
customer portal
assign role to contact
1055
change password
1064
create contact
1052
create contact login
1053
enable or disable contact
login
1054
manage registration
requests
1056
manage users
1051
notification preferences
1063
password reset
1066
reset password for
contact
1056
self-registration
1056, 1057, 1057, 1065,
1066, 1067
update contact
information
1053
view assets
1061
view case
1075
view contact information
1062
customer portal search
1058
  community
1060
  knowledge base
  679, 1059
Customer Service Portal
  limit access to product
model data
  491
  user roles
  489
define case SLA
  417
domain separation
  671, 674
e-mail address configuration
  469
e-mail communication
  469
e-mail properties
  471
entitlement
  associate with entity
  380
Flow Designer actions
  670
Get help using virtual agent
conversations
  1070
import customer account
information
  340
installed components
  1170
  business rules
  1203
client scripts
  1200
properties
  1172
roles
  1178
script includes
  1200
  tables
  1170
installed components for
additional plugins
  1210
integration with Field
Service Management
  837
integration with Financial
Management
  860
integration with Service
Management
  807, 824
major issue management
  437, 727, 728, 731, 732, 734,
  735, 736, 737, 738, 739,
  739, 740
Mandatory skills
  457
matching rules
  693
Migrate skills to the task skill
table
  460
openFrame configuration
  475
phone communication
  475, 889, 899, 900, 901
  answer incoming call
  897
  configure workflow
  901
make outgoing call
  898
set call status
  899
transfer call
  898
phone configuration
  475, 896
phone installation
  896
relationships overview 347
resource matching engine 695
responsibility definitions create 382
set up communication channels 461
social media integration 481
create social profile 920, 920
time recording 300, 302, 304, 305, 306, 307
use the Customer Service Portal 1049
Customer Service Management Demo Data activate 328
Customer Service Management for Orders 307
activate 328
Customer Service Managements assign a case 1046
Customer Service Portal limit access to product model data 491
use 1049
user roles 489

Demand Forecast in Workforce Optimization for Customer Service 1315
Demand Forecasting 1315
domain separation Customer Service Management 671, 674

E
Explore Manager Workspace landing page 1307
Explore Workforce Optimization for Customer Service 1303

F
field service special handling note create 916
special handling notes 704
business rules 1215
client scripts 1215
configuration 430
delete 919, 919
display on form 431
properties 431, 1214
script includes 1216
tables 1213
update 947
user roles 1214
Field Service Management integration with Customer Service Management 837
integration with Financial Management 860
Flow Designer
Customer Service Management actions 670
forum homepage logged in users 1520

G
gamification components 1571, 1572, 1573, 1574, 1575, 1580
UI components 1575, 1577, 1577, 1579, 1581
Gamification administer 1575, 1581
award points 1586
configure properties 1581
create level definition 1584
create level range 1585
enable 1581, 1583, 1583, 1586, 1587
moderate 1585

I
Incident Assignment Workbench Demo activate 328

K
knowledge product entitlements add related products

L
Lookup and Verify 228

M
major issue management 727
approve or reject a major case candidate 735
configure case synchronization 437
create child cases 737, 738
create major case 736
create major case candidate 735
installed components 739
major case form view 732
major, candidate, child cases 728
properties 740
propose a major case candidate 734
recipients lists
Manage Channels in Workforce Optimization for Customer Service
Manager Workspace
migrate social Q&A data communities
moderate communities

OpenFrame
installed components
business rules
roles
script includes
tables
UI macros

Performance Analytics - Content Pack - Customer Service
activate
Performance Analytics - Content Pack - Customer Service (New)
activate
Performance Analytics - Context Sensitive Analytics for Customer Service
activate

report community content communities
report user profile communities
responsibility definitions create
reverse matching limit

Scheduling in Workforce Optimization for Customer Service
self service password reset
installed components
script includes
Self Service Password Reset activate
Set up channels and queues in Workforce Optimization for Customer Service
Set up Scheduling in Workforce Optimization for Customer Service
Set up skill prediction in Workforce Optimization for Customer Service
Set up Teams in Workforce Optimization for Customer Service
social media entry create log entry
social media integration
1092
view on portal
1075
Targeted Communications
activate
328
installed components
properties
1222
Targeted Communications
Demo Data
activate
328
Teams in Workforce
Optimization for Customer
Service
1318, 1320
Time recording for Customer
Service Management
300, 302, 304, 304, 305, 305,
306, 307
Use Channels in Workforce
Optimization for Customer
Service
1391
Use Coaching in Workforce
Optimization for Customer
Service
1427
use communities
1435
Use Scheduling in Workforce
Optimization for Customer
Service
1407
Use Teams in Workforce
Optimization for Customer
Service
1425
Use Workforce Optimization
for Customer Service
1387
Using Cloud Call Center with
Workforce Optimization for
Customer Service
1400
W
Workforce Optimization
1302
Workforce Optimization for
Customer Service
1302
Add an event to the
calendar
1423
Analyze the performance
trends for your teams
1426
Assess the quality of
completed tasks
1429
Create a schedule plan
1411
Create a shift plan
1407
Domain Separation and
Workforce Optimization for
Customer Service
1351
Generate a preview of a
schedule plan
1413
Manage skills using
Workforce Optimization for
Customer Service
1432
Track and manage your
teams' schedule
1414, 1416
Workforce Optimization for
Customer Service - Scheduling
1310
Workforce Optimization for
Customer Service - Teams
1318, 1320